Contents

JIRA Documentation ............................................................... 10
  JIRA 101 ........................................................................... 11
    Set up a JIRA site .......................................................... 12
    Add users ...................................................................... 14
    Create a project ............................................................ 16
    Create an issue .............................................................. 19
    Search for issues and create reports ................................. 22
    Configure permissions .................................................... 26
    Configure workflows and screens .................................... 30
  Extend JIRA ....................................................................... 33
JIRA User's Guide ................................................................. 38
  JIRA Concepts .................................................................. 41
    What is a Project ............................................................ 41
    What is Workflow .......................................................... 42
    What is an Issue ............................................................ 43
  Getting Started ................................................................. 46
    Logging in to JIRA ......................................................... 47
    Exploring the JIRA Workspace ....................................... 48
    Using Keyboard Shortcuts .............................................. 48
    Using JIRA on a Mobile Device ....................................... 55
    Getting started with Bamboo ......................................... 56
  Working with an Issue ....................................................... 56
    Adding a field to an issue ............................................... 56
    Attaching a File ............................................................. 61
    Attaching a Screenshot ................................................... 63
    Cloning an Issue ............................................................ 65
    Commenting on an Issue ................................................ 66
    Creating an Issue ........................................................... 68
    Creating a Sub-Task ....................................................... 69
    Creating issues using the CSV importer ............................ 72
    Editing an Issue ............................................................. 77
    Editing Rich-Text Fields ................................................ 78
    Emailing an Issue .......................................................... 80
    Labeling an Issue ........................................................... 82
    Linking Issues ............................................................... 83
    Logging Work on an Issue .............................................. 87
    Modifying Multiple (Bulk) Issues .................................... 94
    Moving an Issue ............................................................ 100
    Scheduling an Issue ....................................................... 101
    Setting Security on an Issue ............................................ 103
    Viewing an Issue's Change History ................................. 103
    Watching and Voting on an Issue .................................... 104
    Viewing the Code Development Information for an Issue .... 106
      Viewing an Issue's Crucible Reviews .............................. 111
      Viewing an Issue's FishEye Changesets ......................... 111
      Viewing the Bamboo Builds related to an Issue ............... 112
  Searching for Issues .......................................................... 112
    Basic Searching ............................................................ 114
    Using Quick Search ...................................................... 117
    Advanced Searching ...................................................... 119
      Advanced Searching - Fields Reference ......................... 167
      Advanced Searching - Keywords Reference .................... 201
      Advanced Searching - Operators Reference .................... 203
    Advanced Searching Functions ....................................... 212
    Performing Text Searches .............................................. 238
    Using the Issue Navigator .............................................. 243
<table>
<thead>
<tr>
<th>Customizing your Issue Navigator</th>
<th>247</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Filters</td>
<td>249</td>
</tr>
<tr>
<td>Working with Search Result Data</td>
<td>257</td>
</tr>
<tr>
<td>Displaying Search Results as a Chart</td>
<td>258</td>
</tr>
<tr>
<td>Displaying Search Results in XML</td>
<td>261</td>
</tr>
<tr>
<td>Exporting Search Results to Microsoft Excel</td>
<td>265</td>
</tr>
<tr>
<td>Exporting Search Results to Microsoft Word</td>
<td>268</td>
</tr>
<tr>
<td>Receiving Search Results as an RSS Feed</td>
<td>270</td>
</tr>
<tr>
<td>Receiving Search Results via Email</td>
<td>271</td>
</tr>
<tr>
<td>Sharing a Search Result</td>
<td>275</td>
</tr>
<tr>
<td>Generating Reports</td>
<td>276</td>
</tr>
<tr>
<td>Workload Pie Chart Report</td>
<td>278</td>
</tr>
<tr>
<td>User Workload Report</td>
<td>281</td>
</tr>
<tr>
<td>Version Workload Report</td>
<td>282</td>
</tr>
<tr>
<td>Time Tracking Report</td>
<td>284</td>
</tr>
<tr>
<td>Single Level Group By Report</td>
<td>288</td>
</tr>
<tr>
<td>Created vs Resolved Issues Report</td>
<td>289</td>
</tr>
<tr>
<td>Resolution Time Report</td>
<td>293</td>
</tr>
<tr>
<td>Pie Chart Report</td>
<td>297</td>
</tr>
<tr>
<td>Average Age Report</td>
<td>300</td>
</tr>
<tr>
<td>Recently Created Issues Report</td>
<td>303</td>
</tr>
<tr>
<td>Time Since Issues Report</td>
<td>306</td>
</tr>
<tr>
<td>Browsing a Project</td>
<td>309</td>
</tr>
<tr>
<td>Browsing a Project's Summary</td>
<td>310</td>
</tr>
<tr>
<td>Browsing a Project's Issues</td>
<td>312</td>
</tr>
<tr>
<td>Browsing a Project's Road Map</td>
<td>312</td>
</tr>
<tr>
<td>Browsing a Project's Change Log</td>
<td>313</td>
</tr>
<tr>
<td>Browsing a Project's Versions</td>
<td>314</td>
</tr>
<tr>
<td>Browsing a Project's Components</td>
<td>315</td>
</tr>
<tr>
<td>Browsing a Project's Bamboo Builds</td>
<td>316</td>
</tr>
<tr>
<td>Browsing a Project's Bamboo Builds</td>
<td>317</td>
</tr>
<tr>
<td>Browsing a Project's FishEye Changesets</td>
<td>317</td>
</tr>
<tr>
<td>Browsing a Project's Crucible Reviews</td>
<td>319</td>
</tr>
<tr>
<td>Viewing a Project's Burndown Chart</td>
<td>319</td>
</tr>
<tr>
<td>Checking the progress of a version</td>
<td>320</td>
</tr>
<tr>
<td>Customizing the Dashboard</td>
<td>324</td>
</tr>
<tr>
<td>Managing Multiple Dashboard Pages</td>
<td>330</td>
</tr>
<tr>
<td>Displaying a Dashboard as a Wallboard</td>
<td>335</td>
</tr>
<tr>
<td>Changing the Look and Behavior of a Gadget</td>
<td>337</td>
</tr>
<tr>
<td>Adding the Activity Stream Gadget</td>
<td>339</td>
</tr>
<tr>
<td>Adding the Administration Gadget</td>
<td>342</td>
</tr>
<tr>
<td>Adding the Assigned To Me Gadget</td>
<td>342</td>
</tr>
<tr>
<td>Adding the Average Age Gadget</td>
<td>343</td>
</tr>
<tr>
<td>Adding the Bamboo Charts Gadget</td>
<td>347</td>
</tr>
<tr>
<td>Adding the Bamboo Plan Summary Chart Gadget</td>
<td>348</td>
</tr>
<tr>
<td>Adding the Bamboo Plans Gadget</td>
<td>351</td>
</tr>
<tr>
<td>Adding the Bugzilla ID Search Gadget</td>
<td>352</td>
</tr>
<tr>
<td>Adding the Calendar Gadget</td>
<td>352</td>
</tr>
<tr>
<td>Adding the Clover Coverage Gadget</td>
<td>354</td>
</tr>
<tr>
<td>Adding the Created vs Resolved Gadget</td>
<td>355</td>
</tr>
<tr>
<td>Adding the Crucible Charts Gadget</td>
<td>359</td>
</tr>
<tr>
<td>Adding the Favorite Filters Gadget</td>
<td>361</td>
</tr>
<tr>
<td>Adding the Filter Results Gadget</td>
<td>362</td>
</tr>
<tr>
<td>Adding the FishEye Charts Gadget</td>
<td>365</td>
</tr>
<tr>
<td>Adding the FishEye Recent Changesets Gadget</td>
<td>367</td>
</tr>
<tr>
<td>Adding the In Progress Gadget</td>
<td>368</td>
</tr>
<tr>
<td>Adding the Introduction Gadget</td>
<td>370</td>
</tr>
<tr>
<td>Adding the Issue Statistics Gadget</td>
<td>370</td>
</tr>
<tr>
<td>Adding the Pie Chart Gadget</td>
<td>373</td>
</tr>
<tr>
<td>Adding the Projects Gadget</td>
<td>375</td>
</tr>
<tr>
<td>Adding the Quick Links Gadget</td>
<td>377</td>
</tr>
<tr>
<td>Adding the Recently Created Chart Gadget</td>
<td>377</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Adding the Resolution Time Gadget</td>
<td>380</td>
</tr>
<tr>
<td>Adding the Road Map Gadget</td>
<td>384</td>
</tr>
<tr>
<td>Adding the Text Gadget</td>
<td>385</td>
</tr>
<tr>
<td>Adding the Time Since Issues Gadget</td>
<td>387</td>
</tr>
<tr>
<td>Adding the Two-Dimensional Filter Statistics Gadget</td>
<td>391</td>
</tr>
<tr>
<td>Adding the Voted Issues Gadget</td>
<td>392</td>
</tr>
<tr>
<td>Adding the Watched Issues Gadget</td>
<td>393</td>
</tr>
<tr>
<td>Adding the Heat Map Gadget</td>
<td>395</td>
</tr>
<tr>
<td>Adding the Labels Gadget</td>
<td>395</td>
</tr>
<tr>
<td>Managing your User Profile</td>
<td>397</td>
</tr>
<tr>
<td>Adding a User Avatar</td>
<td>401</td>
</tr>
<tr>
<td>Allowing OAuth Access</td>
<td>403</td>
</tr>
<tr>
<td>Changing your Password</td>
<td>406</td>
</tr>
<tr>
<td>Choosing a Language</td>
<td>406</td>
</tr>
<tr>
<td>Using Hover Profile</td>
<td>406</td>
</tr>
<tr>
<td>Choosing a Time Zone</td>
<td>407</td>
</tr>
<tr>
<td>Changing your JIRA Home Page</td>
<td>407</td>
</tr>
<tr>
<td>Requesting Add-ons</td>
<td>408</td>
</tr>
<tr>
<td>Project navigation options</td>
<td>408</td>
</tr>
<tr>
<td>Data collection policy</td>
<td>409</td>
</tr>
<tr>
<td>JIRA Administrator's Guide</td>
<td>410</td>
</tr>
<tr>
<td>Getting Help</td>
<td>413</td>
</tr>
<tr>
<td>Configuring the Layout and Design</td>
<td>415</td>
</tr>
<tr>
<td>Customizing the Look and Feel</td>
<td>415</td>
</tr>
<tr>
<td>Choosing a Default Language</td>
<td>420</td>
</tr>
<tr>
<td>Translating JIRA</td>
<td>422</td>
</tr>
<tr>
<td>Configuring the Default Issue Navigator</td>
<td>422</td>
</tr>
<tr>
<td>Configuring the Default Dashboard</td>
<td>423</td>
</tr>
<tr>
<td>Using Dashboard Gadgets</td>
<td>424</td>
</tr>
<tr>
<td>Adding a Gadget to the Directory</td>
<td>427</td>
</tr>
<tr>
<td>Subscribing to Another Application's Gadgets</td>
<td>429</td>
</tr>
<tr>
<td>Configuring an Announcement Banner</td>
<td>431</td>
</tr>
<tr>
<td>Enabling Logout Confirmation</td>
<td>432</td>
</tr>
<tr>
<td>Creating Links in the Application Navigator</td>
<td>433</td>
</tr>
<tr>
<td>Configuring Issue Table Columns</td>
<td>434</td>
</tr>
<tr>
<td>Configuring Project Navigation</td>
<td>436</td>
</tr>
<tr>
<td>User and Group Management</td>
<td>437</td>
</tr>
<tr>
<td>Managing Users</td>
<td>437</td>
</tr>
<tr>
<td>Managing Groups</td>
<td>442</td>
</tr>
<tr>
<td>Configuring User Directories</td>
<td>445</td>
</tr>
<tr>
<td>Configuring the Internal Directory</td>
<td>447</td>
</tr>
<tr>
<td>Connecting to an LDAP Directory</td>
<td>448</td>
</tr>
<tr>
<td>Connecting to an Internal Directory with LDAP Authentication</td>
<td>470</td>
</tr>
<tr>
<td>Connecting to Crowd or Another JIRA Server for User Management</td>
<td>476</td>
</tr>
<tr>
<td>Managing Multiple Directories</td>
<td>481</td>
</tr>
<tr>
<td>Synchronising Data from External Directories</td>
<td>483</td>
</tr>
<tr>
<td>Managing Nested Groups</td>
<td>485</td>
</tr>
<tr>
<td>Diagrams of Possible Configurations for User Management</td>
<td>488</td>
</tr>
<tr>
<td>User Management Limitations and Recommendations</td>
<td>494</td>
</tr>
<tr>
<td>Allowing Other Applications to Connect to JIRA for User Management</td>
<td>498</td>
</tr>
<tr>
<td>Migrating Users between User Directories</td>
<td>500</td>
</tr>
<tr>
<td>Viewing User Sessions</td>
<td>503</td>
</tr>
<tr>
<td>User access logging</td>
<td>504</td>
</tr>
<tr>
<td>Clearing 'Remember my login' Tokens</td>
<td>507</td>
</tr>
<tr>
<td>Disabling Remember My Login on this Computer</td>
<td>509</td>
</tr>
<tr>
<td>Enabling Public Signup and CAPTCHA</td>
<td>509</td>
</tr>
<tr>
<td>Changing the User Default Settings</td>
<td>511</td>
</tr>
<tr>
<td>Project Management</td>
<td>512</td>
</tr>
<tr>
<td>Defining a Project</td>
<td>512</td>
</tr>
<tr>
<td>Editing a Project Key</td>
<td>516</td>
</tr>
<tr>
<td>Simple Issue Tracking project</td>
<td>519</td>
</tr>
<tr>
<td>Software Development project</td>
<td>520</td>
</tr>
</tbody>
</table>
Managing Project Role Membership ................................................................. 522
Defining a Component .................................................................................. 523
Managing Versions ......................................................................................... 525
   Running a Bamboo Build when Releasing a Version ......................... 527
Creating Release Notes .............................................................................. 528
Configuring Security ..................................................................................... 528
Configuring Issue-level Security ................................................................. 531
Managing Project Permissions .................................................................... 535
Managing Project Roles ............................................................................... 542
Managing Global Permissions ...................................................................... 547
Configuring Secure Administrator Sessions ............................................. 551
Preventing Security Attacks ......................................................................... 552
JIRA Cookies ................................................................................................. 554
JIRA Admin Helper ....................................................................................... 556
Password Policy for JIRA ............................................................................. 559
Configuring Fields and Screens ................................................................... 561
   Configuring Built-in Fields ....................................................................... 564
      Defining Issue Type Field Values ....................................................... 564
      Defining Priority Field Values ......................................................... 571
      Defining Resolution Field Values .................................................... 573
      Defining Status Field Values ......................................................... 574
   Translating Resolutions, Priorities, Statuses and Issue Types .................. 575
Adding a Custom Field .................................................................................. 576
   Configuring a Custom Field ..................................................................... 579
   Creating Help for a Custom Field ............................................................ 583
Specifying Field Behavior ............................................................................ 584
   Associating Field Behavior with Issue Types ......................................... 589
   Configuring Renderers ............................................................................ 593
Defining a Screen .......................................................................................... 600
   Associating a Screen with an Issue Operation ....................................... 605
   Associating Screen and Issue Operation Mappings with an Issue Type ... 609
Configuring Workflow ................................................................................... 615
   Activating workflow ............................................................................... 620
   Configuring workflow schemes ............................................................. 622
   Working in text mode ............................................................................. 625
   Sharing your workflow ......................................................................... 629
Advanced workflow configuration ............................................................... 634
   Adding a custom event ........................................................................... 645
   Configuring the initial status .................................................................. 648
   Configuring JIRA with HipChat ............................................................... 651
   Using validators with custom fields ....................................................... 653
   Using XML to create a workflow ............................................................ 653
   Workflow properties ............................................................................. 654
   Configuring workflow triggers ............................................................... 655
Configuring Email ........................................................................................ 665
   Configuring Email Notifications ............................................................ 665
      Configuring JIRA’s SMTP Mail Server to Send Notifications .......... 668
      Creating a Notification Scheme ......................................................... 674
      Customizing Email Content .............................................................. 680
   Creating Issues and Comments from Email .......................................... 681
      Configuring JIRA to Receive Email from a POP or IMAP Mail Server .. 694
Migrating from Other Issue Trackers ............................................................ 695
   Importing Data from Bugzilla ............................................................... 697
   Importing Data from FogBugz for Your Server ..................................... 704
   Importing Data from FogBugz On Demand .......................................... 710
   Importing Data from Mantis .................................................................. 712
   Importing Data from Pivotal Tracker .................................................... 717
   Importing Data from Trac ...................................................................... 720
   Importing Data from CSV ..................................................................... 722
      Commonly Asked CSV Questions and Known Issues ...................... 729
      How to Import CSV Data with PVCS Command .............................. 731
   Importing Data from Redmine ............................................................... 731
JIRA 6.4 Documentation

Importing Data from Bitbucket ............................................. 733
Importing Data from Github .................................................... 734
Importing Data from JSON ..................................................... 736
Moving or Archiving Individual Projects .................................. 745
Archiving a Project ............................................................. 745
Splitting a JIRA instance ...................................................... 746
Integrating JIRA with Code Development Tools .......................... 747
  Version matrix for code development tools ................................ 748
  Integrating JIRA with Stash ................................................. 748
  Integrating JIRA with Bamboo ............................................. 749
  Integrating JIRA with FishEye ............................................. 749
  Integrating JIRA with Subversion ....................................... 749
  Integrating JIRA with Perforce ......................................... 750
Configuring Global Settings .................................................. 750
  Configuring Time Tracking ................................................ 751
  Configuring JIRA Options .................................................. 754
    Configuring Advanced Settings ........................................ 758
Setting Properties and Options on Startup ................................ 760
  Recognized System Properties for JIRA ................................ 766
Advanced JIRA Configuration ................................................ 768
  Changing the constraints on historical time parameters in gadgets .. 769
  Changing the Default Order for Comments from Ascending to Descending 770
  Limiting the number of issues returned from a search view such as an RSS feed . 770
Configuring File Attachments .................................................. 771
Configuring Issue Cloning .................................................... 776
Configuring Issue Linking .................................................... 776
Configuring the Whitelist ..................................................... 778
Configuring Sub-tasks .......................................................... 779
Managing Shared Filters ...................................................... 781
Managing Shared Dashboards ................................................ 783
Linking to Another Application .............................................. 785
Server Administration .......................................................... 786
  Finding your Server ID ..................................................... 786
  Increasing JIRA Memory ..................................................... 787
  Using the Database Integrity Checker ..................................... 793
  Precompiling JSP pages ..................................................... 794
Logging and Profiling ........................................................ 795
  Logging email protocol details .......................................... 798
Restoring Data ................................................................. 800
  Restoring a Project from Backup .......................................... 802
  Optimizing Performance .................................................... 811
  Backing Up Data ............................................................ 812
    Automating JIRA Backups ................................................. 814
    Preventing users from accessing JIRA during backups .............. 816
Search Indexing ................................................................. 816
  Re-Indexing after Major Configuration Changes ...................... 818
Using robots.txt to hide from Search Engines ......................... 819
Updating your JIRA License Details ....................................... 820
Viewing your System Information ......................................... 821
Monitoring Database Connection Usage .................................. 826
Viewing JIRA’s Instrumentation Statistics .............................. 828
Generating a Thread Dump .................................................... 831
Finding the JIRA Support Entitlement Number (SEN) .................... 838
Performance Testing Scripts ................................................ 839
Auditing in JIRA ............................................................... 847
Lockout recovery process .................................................... 849
Appendix A - Extending JIRA ................................................ 849
  Managing Add-ons ......................................................... 850
    Using the Issue Collector ................................................. 851
      Advanced Use of the JIRA Issue Collector .......................... 855
  Listeners ........................................................................ 866
  Services .......................................................................... 868

Creative Commons Attribution 2.5 Australia License.
Integrating JIRA with IIS ................................................................. 107
Integrating JIRA with Apache .................................................... 107
Securing JIRA with Apache HTTP Server .................................... 109
Using Apache to Limit Access to the JIRA Administration Interface .......................................................................................................................... 109
Using Fail2Ban to limit login attempts ...................................... 111
How To Disable SSLv3 to Mitigate Against POODLE Exploit for JIRA ......................................................................................................................... 111
Deployment Planning Activity ..................................................... 111
JIRA Releases .............................................................................. 111
JIRA Release Summary ............................................................... 111
Production Releases .................................................................. 112
JIRA 6.4 Release Notes ............................................................... 112
JIRA 6.4 Upgrade Notes .............................................................. 113
JIRA 6.4.1 Release Notes ............................................................. 113
JIRA 6.4.2 Release Notes ............................................................. 113
JIRA 6.4.3 Release Notes ............................................................. 113
JIRA 6.4.4 Release Notes ............................................................. 113
JIRA 6.3 Release Notes ............................................................... 113
JIRA 6.3.15 Release Notes ........................................................... 114
JIRA 6.3.14 Release Notes ........................................................... 114
JIRA 6.3.13 Release Notes ........................................................... 114
JIRA 6.3.12 Release Notes ........................................................... 114
JIRA 6.3.11 Release Notes ........................................................... 114
JIRA 6.3.10 Release Notes ........................................................... 115
JIRA 6.3.9 Release Notes ............................................................. 115
JIRA 6.3.8 Release Notes ............................................................. 115
JIRA 6.3.7 Release Notes ............................................................. 115
JIRA 6.3.6 Release Notes ............................................................. 115
JIRA 6.3.5 Release Notes ............................................................. 115
JIRA 6.3.3 Release Notes ............................................................. 115
JIRA 6.3.4 Release Notes ............................................................. 116
JIRA 6.3.1 Release Notes ............................................................. 116
JIRA 6.3 Upgrade Notes ............................................................. 116
JIRA 6.2 Release Notes ............................................................... 116
JIRA 6.2 Upgrade Notes ............................................................. 117
JIRA 6.2.7 Release Notes ............................................................. 117
JIRA 6.2.6 Release Notes ............................................................. 117
JIRA 6.2.5 Release Notes ............................................................. 117
JIRA 6.2.4 Release Notes ............................................................. 118
JIRA 6.2.3 Release Notes ............................................................. 118
JIRA 6.2.2 Release Notes ............................................................. 118
JIRA 6.2.1 Release Notes ............................................................. 118
JIRA 6.1 Release Notes ............................................................... 118
JIRA 6.1 Upgrade Notes ............................................................. 119
JIRA 6.1.9 Release Notes ............................................................. 119
JIRA 6.1.8 Release Notes ............................................................. 119
JIRA 6.1.7 Release Notes ............................................................. 119
JIRA 6.1.6 Release Notes ............................................................. 119
JIRA 6.1.5 Release Notes ............................................................. 119
JIRA 6.1.4 Release Notes ............................................................. 120
JIRA 6.1.3 Release Notes ............................................................. 120
JIRA 6.1.2 Release Notes ............................................................. 120
JIRA 6.1.1 Release Notes ............................................................. 120
JIRA 6.0 Release Notes ............................................................... 120
JIRA 6.0 Upgrade Notes ............................................................. 121
JIRA 6.0.8 Release Notes ............................................................. 121
JIRA 6.0.7 Release Notes ............................................................. 121
JIRA 6.0.6 Release Notes ............................................................. 122
JIRA 6.0.5 Release Notes ............................................................. 122
JIRA 6.0.4 Release Notes ............................................................. 122
JIRA 6.0.3 Release Notes ............................................................. 122
JIRA 6.0.2 Release Notes ............................................................. 122
JIRA 6.0.1 Release Notes ............................................................. 122
JIRA Documentation

Get started

JIRA 101 guide
The complete JIRA user's guide
Install JIRA
Create a project
Create an issue
Find issues
Gather information on a project

Are you evaluating JIRA for your team? Check out the JIRA 101 guide.

Administer JIRA

The complete JIRA administrator's guide
Migrate from another issue tracker
Add more users
Customize screens
Customize fields
Customize workflows

Need more resources? Check out the JIRA Resources page.
Do more with JIRA

Learn about Git Essentials
Use JIRA in an enterprise environment
Install add-ons for JIRA
Make JIRA agile with JIRA Agile
Test web applications with JIRA Capture
Contribute to the JIRA Documentation

Do you want to customize JIRA for your team? Check out the documentation for developers.

What's new in JIRA? »

JIRA 101

Welcome to the JIRA 101 guide! This is a hands-on tutorial. You'll be setting up your own JIRA site and trying it out, as we take you on a tour of the basic concepts in JIRA. Along the way, we will highlight some of the key JIRA features and point you to a number of helpful resources.

Roll up your sleeves. We're about to get started!

Watch this video for an overview of JIRA in 4 minutes:

Using this tutorial
This tutorial will teach you about the basic concepts in JIRA. It is ideal for someone who is evaluating JIRA for purchase, but anyone can use it. Throughout this tutorial we will highlight whether you need to be a JIRA administrator to complete a stage, or whether it is available to all JIRA users.

You must be a JIRA administrator to complete this stage.

Anyone can complete this stage.
We recommend that you do each of the stages in order. It will take about an hour to complete this entire tutorial. However, you can stop after any stage and resume it later, if you don't have time to complete the tutorial in one go.

Other resources

If you are already comfortable with the basic JIRA concepts, try these other resources:

- **Atlassian University**: Atlassian University is a paid learning resource for you and your organisation. Each course uses hands-on interactive tutorials to walk you through key functionality in JIRA, like inline editing or issue filters.
- **Atlassian Answers**: Got a question about JIRA? Atlassian Answers has a large community of users that can help you find an answer. Atlassian staff are also active on Atlassian Answers.

**So what is a 101 anyway?**

*In US universities a "101" course is a general course that is often used as an introduction to a particular subject area - it covers the basics, and gives you a taste of what you're in for... just like this tutorial!*

Set up a JIRA site

You will need your own JIRA instance for this Getting started guide. Let's get you set up with a JIRA Cloud site. JIRA Cloud is our hosted JIRA offering. You will be up and running with your own JIRA instance in a few minutes without installing a thing! If you have a JIRA site already, you can skip this stage.

**STEP 1 OF 8**

Step 1. Sign up for a JIRA Cloud site

Signing up for a JIRA Cloud trial will provide you with a fully-functional JIRA Cloud site for seven days. The JIRA Cloud trial is totally free! No credit card required.

2. Choose the Free Trial for the For projects package.
3. Read the FAQs at the bottom of the page. Don't skip this step, the FAQs have important information about what you are signing up for.
4. Click Next at the top right of the page.
5. Fill in the form and submit it. Note down the site address and site administrator details.
Can’t use JIRA Cloud?

If you cannot use JIRA Cloud, instructions for installing JIRA Server on your own server are available below.

- Installing JIRA on Windows
- Installing JIRA on Linux
- Installing JIRA on Mac OS X
  (note, Mac OS X recommended for evaluations only)

Tips for filling in your JIRA Cloud form:

- Don’t add any other applications. You won’t need them for this tutorial and you can always add them later.
- Stick with 10 users for now. You won’t need more than 10 users for this tutorial and you can always add more later.
- You can choose to keep your site after your trial. Keep this in mind when picking a site address.
- If you don’t have a my.atlassian.com account, you will set one up during the signup process. This account is used to manage your licenses for Atlassian products. It is different to the administrator account that you also create during signup: the administrator account is used to access your new JIRA Cloud site.

That’s it! Grab a quick coffee — it will take about 10 minutes for your JIRA Cloud instance to be provisioned. You will receive an email when your JIRA instance is ready.

Step 2. Create the demonstration project

Access your new site via your browser, using the site address that you entered when signing up (e.g. https://jira101.atlassian.net). Log in to your new site using the site administrator credentials that you entered when signing up (e.g. jsmith).

This is the first screen that you will see when accessing your new JIRA Cloud site:

You will see this dialog whenever you create a new project. This allows you to set up different types of projects with a single click, including Scrum and Kanban.

Choose Demo Project and click Next. This will create a new project that has sample data. We won’t be using the Demo Project for this tutorial, however the issues in the project contain handy information about JIRA. Take a few minutes to browse through them.

Note, if you have already created projects in your JIRA site, the Demo Project won’t be available. Don’t worry, you won’t need it for this tutorial.
Congratulations! You now have a new JIRA Cloud site set up with the sample 'Demonstration' project.

Next steps

Next you will be adding users to your new JIRA site and learning about how JIRA's licensing works. Stopping here? Please leave us your feedback before you go!

Click to give feedback...

Add users

It will get pretty lonely if you are the only JIRA user. You can add users, invite users, or allow new users to sign themselves up. Get your team involved!

In this stage, you will add new users to JIRA. We will also explain JIRA user-based licensing and show you how it works.

Step 1. Add a few users

You will be adding three users to JIRA in this step: alana, emma and william. You add more or choose your own usernames if you like, but please note that we will be referring to these usernames later in the tutorial.

You should be logged in to JIRA as an administrator after setting up your site. If not, log in under your administrator account.
1. Navigate to the User Management screen using the quick operation: `.+ users`.
2. Choose Create User to add a new user. Specify the username as `alana` and tick the Add to developers group checkbox. Set the rest of the fields to whatever you want.
3. Create two more users with the usernames `emma` and `william`, following the same process outlined in previous step. Don't forget to tick the Add to developers group checkbox.

![Create New User](image)

**How do quick operations work?**

"Use the quick operation: `.+ abc`"

This means press the `.` key on your keyboard, type `abc` in the dialog that appears, then press the `Enter` key on your keyboard.

You can manually navigate to any page instead of using quick operations, but this guide will use quick operations to make it easier for you to find your way around.

---

**Step 2. Remove one user from your license**

JIRA has user-based licensing. This allows you to manage your costs as your team grows or shrinks, by adding or removing users from your license.

Every user that can access JIRA is counted towards your license. New users are granted access by default. If you exceed the number of users allowable by your license, no one will be allowed to create issues in JIRA.

The user count is managed in JIRA Cloud by configuring the application access for each user. In this step, we will show you how to remove one user's access to JIRA.

1. Navigate to the 'Application Access' screen using the quick operation: `.+ application access`. The screen will show that you have six remaining users available under your license.

   *Your trial Cloud license permits 10 users for JIRA. You have created four users so far: your administrator account and accounts for Alana, Emma and William.*

2. Uncheck the checkbox in the JIRA column for `emma` and choose the Update button. The screen will show that you have seven remaining users available under your license.

   Emma will not be able to log in to JIRA anymore. Feel free to try, if you want to check.
Congratulations! You have added three new users to JIRA and removed JIRA access from one!

Next steps

Next you will be creating your own project in JIRA and customizing the look and feel.

Stopping here? Please leave us your feedback before you go!

Click to give feedback...

Create a project

In this stage, you will create a project. A JIRA project is a collection of issues. Your team could use a JIRA project to coordinate the development of a product, track a project, manage a help desk, and more, depending on your requirements.

You will also be customizing the JIRA look and feel in this stage. We have provided sample data below for you to use. You can use your own data and pictures, but the screenshots in this tutorial will show the sample data.

What is JIRA Junior?

You will notice that the sample data in this tutorial refers to the "JIRA Junior" product:

We invented JIRA Junior as an April's Fools joke. Sadly, it is not a real product.
Step 1. Create a project
In this step, you will be creating a project for your team to use. You should still be logged in to JIRA as an administrator, from the previous stage. If not, log in under that administrator account.

1. Choose Projects > Create Project and choose JIRA Classic.
2. Enter JIRA Junior as the project name. Leave the project key set to its default value of JJ.
3. Choose Submit to create your new project.

The project for “JIRA Junior” will be created and you will be shown the project summary page.

Looking good! Let’s make a few tweaks to really make your new project stand out.

About project keys
Each project has a unique name (e.g. JIRA Junior) and a unique key (e.g. JJ). The project key becomes the first part of that project’s issue keys, e.g. JJ-1, JJ-2, etc.

Step 2. Customize your project
In this step, you will be customizing the project details and logo for your new project. Customizing your project helps your users to identify it more easily, particularly if you have many projects in your JIRA site.

You should be on the project summary page for the JIRA Junior project from the previous step, if not go to Projects > JIRA Junior (JJ).

1. Choose the Administration tab > Edit Project button.
2. Click the Project Avatar image and choose the Choose file button on the dialog that appears.
3. Upload an image for the project avatar. Here’s a sample image that you can use:
4. Add a few more details, like a URL and a Description. These fields are only for display, so you can enter anything you want.
5. Choose Update to save your changes.

We are not done yet. Let's polish up your site and user profile, so you can see how easy it is to customize the look and feel of JIRA.

Step 2. Customize your site

JIRA gives you control over the look and feel of your entire site. You can change the color scheme, logo, favicon, starting page (default dashboard) and more, to enhance the branding of your organisation or make it consistent with other systems.

In this step, you will be changing the site logo and the color scheme for your JIRA site.

1. Navigate to the Look and Feel configuration for your JIRA site using the quick operation: + look and feel.
2. In the Logo section > Upload from File field, choose the Choose File button.
3. Choose an image for your JIRA logo in the dialog that appears. Here's a sample image that you can use:

4. Choose the Upload Logo button on the Look and Feel screen. Your logo will be uploaded. Note that the color scheme for your site will also be automatically changed to match the colors of your logo.

   About the color scheme
   You can also manually change the colors of different elements of JIRA in the Colors section of the Look and Feel screen, if you don't like the automatic color scheme.

Step 3. Update your user avatar

Now that your site is branded, let's get you a better picture for your user avatar. JIRA has a set of default avatar images to choose from, but in this step, you will be adding your own avatar picture.

Adding an avatar picture helps other users identify you at a glance, when you interact with JIRA. For example, when you comment on an issue, your avatar picture will display next to your comment.

1. Choose the user dropdown in the JIRA header. It will look like this: . Choose Profile from the menu.
2. Click the Avatar image and choose the Choose file button on the dialog that appears.
3. Upload an image for your avatar. You will be able to crop it before it is resized for you. Here's a sample image that you can use:

4. Navigate back to the JIRA Junior project summary to see all of your new changes: Projects > JIRA Junior (JJ).
Gravatars for user avatars
JIRA also supports Gravatars for user avatars. If you enable Gravatar support for your site, JIRA will automatically use the Gravatar associated with each user’s email address in JIRA.

✅ Congratulations! You have created a new project and customized the look and feel of JIRA.

Next steps
Next you will learn how to create an issue in JIRA.

Stopping here? Please leave us your feedback before you go!
Click to give feedback...

Create an issue
An issue is the most basic entity in JIRA. Issues can represent different things depending on your team and project. For example, your development team could use issues to represent feature stories, development tasks and bugs for a product.

In this stage, you will create an issue. We will show you how to manage this issue through its lifecycle and how you can involve your team members along the way.

STEP 4 OF 8

Step 1. Create an issue
Let’s start by creating your first issue.
1. Choose Create in the JIRA header to open the ‘Create Issue’ dialog.
2. Fill out the fields using the sample data is shown below. Only the fields with * are mandatory.
   - **Project**: JIRA Junior
   - **Issue Type**: Story
   - **Summary**: As a kid, I want to have fun creating issues
   - **Description**: Make everything fun!
   - Leave all other fields blank or at their default values.

3. Choose Create to create your new issue. A confirmation message will display for a few seconds. Note, the issue key of your new issue: **JJ-1**.

Create another issue with an **Issue Type** of Bug and **Summary** of JIRA Junior logo is not pink enough. Set the rest of the fields to anything you like.

**Step 2. Edit the issue**

In this step, we will show you how to find an existing issue using the quick search, and how to edit it using inline editing. For example, you may want to add more information to an issue, attach new files or screenshots, and more.

Inline editing is the quickest way to edit an issue. However, please note that blank fields are hidden on the View Issue screen. You can only edit these via the Edit Issue dialog (Edit button on View Issue screen), which provides you access to all issue fields.

1. In the Quick Search box in the JIRA header, type JJ-1 and press Enter on your keyboard. The first issue that you created will display. The quick search is only one of the search methods in JIRA. We will cover the others in the next stage.

2. Hover over the **Priority** field. A pencil icon will appear with a **Click to edit** label.
3. Click the **Priority** field and change it to **Critical**. A tick and cross icon will appear.
4. Click on the tick icon or anywhere outside of the field to save your change.

**Step 3. Resolve the issue**

Every issue has a lifecycle. In JIRA, the lifecycle of an issue is managed by a workflow. A workflow consists of the issue statuses (e.g. Open) and the transitions between each status (e.g. Start progress). Here is the default workflow used in JIRA:

![Workflow Diagram](image)

**About workflows**

JIRA ships with a default workflow. However, you can import workflows or configure your own. We will show you how to do this later in this guide.
In this step, you will be resolving your issue. To do this, you will use the *Start Progress* transition to take your issue from *Open* to *In Progress*, then the *Resolve* transition to take your issue from *In Progress* to *Resolved*.

You should be viewing the issue *JJ-1*. If not, open it using the Quick Search. You will notice that all of the workflow-related controls are grouped together:

1. Choose the *Start Progress*. The status of your issue will be changed to *In Progress*.
3. Leave the fields at their default values and click the *Resolve* button in the bottom right corner of the issue screen. The status of your issue will be changed to *Resolved*.

Notice that resolving an issue prompted you to enter more information, whereas starting progress on the issue did not. Some issue transitions have screens associated with them in the default JIRA workflow. JIRA allows you to prompt the user with screens for any transition, if you configure your own workflow.

**Step 4. Assign the issue to another user**

You won’t be managing every issue in your project, if you are using JIRA for your team. Let’s get another user involved by assigning them an issue.

1. Find and open the issue *JJ-2* by entering *JJ-2* in the *Quick Search* box and pressing Enter on your keyboard.
2. Choose *Assign* on the issue. You can also use the quick operation: . + assign
3. Type *alana* in the *Assignee* field and select her as the assignee from the dropdown list that appears.
4. Type (don’t copy and paste) the following text in the *Comment* field, then choose *Assign*.

   Hi @william JIRA Junior is *super fun* now (see JJ-1). Alana is going to fix the logo.

   You will notice a few things when you enter the comment:
   - When you start typing after the @ symbol, you will be prompted to choose a user: william, in this example. William will be sent an email notification that links to the issue, when you save. This feature is called mentioning a user.
   - On choosing Assign:
     - The issue is assigned to Alana with a comment added to it.
     - A link is automatically created to the issue JJ-1 in the issue comment.
     - super fun is shown as bold text in the issue comment. If you edit an issue description or comment and click the help icon, you will see other text formatting options.

   Congratulations! You have learned the basics of working with an issue.
Next steps

Next you will learn how to search for issues and create reports.

Stopping here? Please leave us your feedback before you go!

Click to give feedback...

Search for issues and create reports

Knowing how to create an issue is important, but your team is going to be working with more than one issue! You will need to know how your team is tracking, as well as help them stay on top of their backlog.

In this stage, we will show you how to work with multiple issues. You will learn how to use different search techniques to find issues. We will also show you how to share search results with your team and report on issues.

Before you start, you are going to need a few more issues. Create a few more in your JIRA Junior project, using the sample data below.
Tip: Tick the Create another checkbox before you click Create, when you need to create multiple issues.

- **Issue Type** = Story and **Summary** = As a kid, I want to hide things from dad and mum
- **Issue Type** = Bug and **Summary** = Can't set priority to Super Duper
- **Issue Type** = Story, **Summary** = As a kid, I want to share issues with my friends and **Assignee** = alana
- **Issue Type** = Story, **Summary** = As a kid, I want to groom my backlog and **Assignee** = william

Step 1. Search for issues

In this example, we are going to tackle a common scenario: searching for all unresolved issues assigned to you. You might regularly run a search like this to check your backlog of work.

1. Choose **Issues > Search for Issues**. You should see all 13 issues (including issues from the Demo project) in your JIRA site.
2. Set **Assignee** = **Current User** in the search criteria.

   ![Search for Issues](image)

   Notice that the search results refresh when you select new criteria.

3. Choose **More** > type **Resolution** then select it.

   What does it look like?

4. Set **Resolution** = **Unresolved**. The search results will show the nine issues that are unresolved and assigned to you.

   ![Search Results](image)
About the advanced search (JQL)

Power users may like to try the advanced search (similar to SQL), by clicking the Advanced link next to the search criteria. For example, enter assignee = currentUser() to find all issues assigned to you. See Advanced Searching

A simple query in JQL (also known as a 'clause') consists of a field, followed by an operator, followed by one or more values or functions. For example, the following simple query will find all issues in the "JIRA Junior" project:

```
project = "JIRA Junior"
```

(This example uses the Project field, the EQUALS operator, and the value "JIRA Junior".)

If you are thinking that it would be handy to be able to rerun this search, we have got you covered! Hover over the icon in the top left and choose My Open Issues. Keep this screen open for the next step.

Saved searches, like this default one, are referred to as filters. You can also save your own searches instead of choosing from the default ones. We are just about to tackle this: see the next step below.

Step 2. Save your search

If you run a search with the same criteria frequently, you may want to save it as a filter. This lets you run the search again with a single click, rather than selecting the same criteria every time. For example, you may use a filter to review your open tasks for the day.

In this step, you will find all stories in the JIRA Junior project, then save it as a filter.

2. Set Project = JIRA Junior and Type = Story as the criteria. You should have four issues in your results: JJ-1, JJ-3, JJ-5 and JJ-6.
3. Choose Save As (above the search criteria), enter JIRA Junior stories as the Filter Name and save it.

That's it! Hover over the icon in the top left. You can see your new filter under the Favorite Filters section. Just click it to run it.

Let's look at some of the ways that you can use your new issue filter.

Step 3. Share your search results

Getting your team on the same page is easy with shared filters. You could share a filter with your team that shows the unresolved stories for a development iteration, or the critical issues in a support backlog.

Here are two ways that you can share search results:

Email the search results

Run the desired filter, then choose Share. Enter the
users that you want to share the filter with and they will be emailed a link to your filter (if you have email notifications set up).

What does it look like?

Share the search results via a dashboard

The dashboard is the screen that all JIRA users see when they first log in. You can show a filter's results on a dashboard and share it with other users.

Show me how...

1. Choose Dashboards > Manage Dashboards, then choose Create new dashboard.
2. Name your dashboard JIRA Junior and choose the +Add button next to Add Shares to share it with everyone.
3. Leave the other fields and choose Add.
4. Choose JIRA Junior in the Favorite Dashboards section to configure it.
5. Choose add a new gadget to open the 'Gadget Directory'.
6. Enter filter results in the search box and choose Add It Now.
7. Enter JIRA Junior stories in the Saved filter field and choose Save.

Other users can now add this dashboard by choosing it as a favourite.

Step 4. Create a report

JIRA provides you with a number of different reports to help you track your team's progress. You can view the time tracking data, time taken to resolve issues, workload by user, and more.

In this example, you will create a simple report based on the 'JIRA Junior stories' filter that you created previously. The report will show all JIRA Junior stories by assignee.

1. Choose Projects > JIRA Junior.
2. On the project summary page, choose Single Level Group By Report in the Reports section (you may need to scroll down).
3. Set Filter to JIRA Junior stories. Leave Statistic Type set to Assignee.
4. Choose Next. The 'Single Level Group By Report' for the 'JIRA Junior stories' filter will be displayed.

Try creating a few other reports in the Reports section of the JIRA Junior project summary.
Congratulations! You have created an issue filter, shared it and used it in a report.

Next steps

Next you will learn how to configure a project.

Stopping here? Please leave us your feedback before you go!

Click to give feedback...

Configure permissions

You won’t want every user in your team to have the same level of access to JIRA. For example, you may want to restrict who can administer JIRA, or prevent users from viewing a project. In this stage, you will learn about the different permissions in JIRA and try setting permissions for a project.

Before we start, it is important to understand how JIRA permissions work. There are two levels of permissions in JIRA: global permissions and project permissions.

Global permissions cover a small set of functions that affect all projects in JIRA. For example, permission to administer JIRA. They can only be assigned to groups.

Show me...
Project permissions cover a set of more granular functions that affect a single project in JIRA. For example, permission to create issues in a project. They can be assigned to groups, users and roles.
About Roles, Groups and Users

A role is a project-specific set of groups and/or individual users. Roles are a way of abstracting users/groups from project permissions.

For example, in your team, you may have ‘scrum masters’ who are responsible for assigning issues in projects. Your product managers (PM) are ‘scrum masters’ on every project, but individual developers may also be ‘scrum masters’ on specific projects.

In JIRA, you can define a ‘scrum master’ role that includes the PM team on all new projects. You can then define a set of permissions that grant the ‘assign issue’ permission to this role, and apply this set of permissions to all projects. Individual developers can be added to the ‘scrum master’ role on each project, as needed.

This is much easier to manage than defining different sets of permissions for each project.

Let’s try it out! In the following steps, you will use project permissions to hide a new project from some of your users.

Step 1. Create a new project role

This project role will only contain users that you want to view a particular project. We will assign permissions to this role in the next step.

1. Navigate to the ‘Project Role Browser’ screen using the quick operation: . + roles.
2. Add a new project role: Big Kids.
3. Add yourself and Alana to the Managers project role via Manage Default Members > Edit (under Default Users). Do not add William.

Step 2. Configure a new permission scheme

The ‘Browse Projects’ permission controls whether a user can browse a project, i.e. whether they can view the
project. You will assign this permission to your new role.
1. Navigate to the 'Permission Schemes' screen using the quick operation: + permission schemes.
2. Copy the Default Permission Scheme, then edit the copied scheme and change the name to Confidential Permission Scheme.
3. Click Permissions for Confidential Permission Scheme. For the Browse Projects permission:
   • Choose Delete for 'Project Role (Users).
   • Choose Add, select Big Kids in the Project Role field and save.

### Step 3. Associate the scheme with a project

Finally, let's associate the permission scheme with a new project.

1. Choose Project > Create Project and choose the Project Management project.
2. Name the project Top Secret Project and Submit.
3. Choose Administration (tab) > Permissions (left menu) > Actions > Use a different scheme.
4. Set the Scheme to Confidential Permission Scheme and Associate.

The only users that can browse your new project are Alana and yourself (note, default members are only added to a role for new projects). Try browsing the project with William. You could also use this approach to restrict users from creating issues, adding comments, closing issues, etc, in a project.

> Congratulations! You configured project permissions to hide a project from users.

### Next steps

Next you will learn how to edit workflows and screens in JIRA.

Stopping here? Please leave us your feedback before you go!

Click to give feedback...
Configure workflows and screens

Every team works differently. The process for one project may differ from other projects. If the default JIRA workflow, screens and fields don't suit, you can customize them.

In this stage, you will import a new workflow and configure it with a new screen that has a custom field. We will also explain how workflows, screens and fields relate in JIRA.

**Step 1. Import a workflow**

If you don't want to use the default workflow (described in a previous step) for your project, you can use a custom workflow instead. In this step, we will show you how to import a custom workflow from the Atlassian Marketplace. You could also configure a workflow manually, but we won't tackle that in this tutorial.

1. In the 'Top Secret Project', choose **Administration** (tab) > **Workflows**.
2. Choose **Add Workflow** > **Choose from Marketplace**.
3. Choose the **Import** button for **IT Service Desk Workflow (ITIL)** and complete the wizard (leave all values at defaults).
4. On the 'Assign Issue Types to "It Service Desk Workflow (itl)"' dialog, tick the checkbox next to **Issue Type**. All issue types will be selected, just ignore the warning symbols. Choose the **Finish** button.

**What is the Atlassian Marketplace?**

The Atlassian Marketplace hosts over 1,000 add-ons (free and commercial) that can enhance your Atlassian applications. These range from add-ons that provide a suite of new functionality to ones that tweak individual features in your product. For example, the JIRA Agile add-on turns JIRA into an Agile planning tool.

You will see the new workflow on the 'Workflows' page in 'DRAFT' status. Any time you change a workflow for a project, it will create a draft copy of the workflow. Choose the **Publish** button.
That's it! If you had issues in your project, JIRA would have helped you migrate them to the new workflow. Try creating a new issue and transitioning it through the new workflow to see it in action.

Step 2. Configure a custom field and a screen

Configuring the workflow steps still may not be enough to fit your processes. You may want to prompt users to enter certain information during the lifecycle of an issue. JIRA lets you configure the fields and screens that display during a workflow to do this.

In the previous step, you would have noticed a screen appeared during the 'Triage' transition of your new workflow:

In this step, you are going to replace this screen with your own screen that has a new custom field. Before you try this, it is helpful to understand the relationships between workflow, screens and fields:
It looks complicated, but don't be alarmed. You will see how it fits together as you try it out.

1. Navigate to the 'Screens' screen using the quick operation: . + screens.
2. Choose Add Screen.
3. Enter the Name as Assign Tester Screen, and click Add. Don't add any fields for now.
4. Navigate to the 'Custom Fields' screen using the quick operation: . + custom fields.
5. Choose Add Custom Field.
6. Choose the User Picker field type, then click Next.
7. Enter the Field Name as Tester. Leave the rest of the fields at their default values (note how you can change the context of the field, if you wanted), and click Finish.
8. Associate your new field to the Assign Tester Screen, and click Update.

You now have a new screen with a new custom field. Let's add it to the your project's workflow.

1. Choose Projects > Top Secret Project (TSP) > Administration > Workflows
2. Choose the Edit button (hover over the workflow diagram to enable it).
3. Hover over the Triage box in the diagram, then choose the cog icon > Edit transition.
4. Set the Transition View to Assign Tester Screen, then click OK.
5. Choose Publish Draft to save your changes (no need to save a backup copy).

That's it! Try creating a new issue and transitioning it through the new workflow. When you triage your issue, you should see this screen:
Using the admin helper to troubleshoot problems

If you can't find your custom field on the View, Create or Edit Issue screens, choose Where is my field? under More Actions or Configure Fields and enter your field to find out why it is not displaying.

The admin helper can also help you troubleshoot permissions and notifications (quick operation: .+ permission helper or .+ notification helper).

✔ Congratulations! You have configured your project to use a new workflow and a new screen with a custom field.

Next steps

Next you will learn how to extend JIRA.

Stopping here? Please leave us your feedback before you go!

Click to give feedback...

Extend JIRA

We are almost there! You have covered all the core concepts of JIRA, however we have only looked at the
basics of what you can do with JIRA. In this stage, we will show you how to get the most out of your new JIRA site. This includes using JIRA on your mobile device, installing add-ons and integrating JIRA with other applications.

Some of these features are powerful but complex, so we will only show you how to get started, then point you to detailed documentation elsewhere. By the end of this stage, you should have a better idea of how you can extend JIRA to suit your team's needs.

**Step 1. Use JIRA on the go**

Simply browse to the URL for your JIRA Cloud site, using the mobile browser on your iPhone or an Android phone. JIRA will display the mobile-optimised version of the page.

**Step 2. Enable add-ons**

Is your team using Scrum or Kanban? Do you manage timesheets and resources for the team? Does your team need better testing tools? Add-ons can help you extend JIRA to fit your needs.

An add-on (or plugin) is an installable component that supplements or enhances the functionality of JIRA in some way. In this step, we will show you how to enable add-ons. Let's start with the JIRA Suite Utilities add-on that adds a range of workflow-related functionality to JIRA.

1. Navigate to the 'Manage add-ons' screen using the quick operation: . + manage add-ons.
2. Choose JIRA Suite Utilities > Enable.

That's it! This is a free add-on, so you don't need a license to use it.

Next, let's add a commercial add-on: Atlassian's JIRA Agile add-on that turns JIRA into an Agile planning tool. Don't worry about the cost, you will get a one-month free trial and can cancel at any time.

1. Navigate to the 'Manage add-ons' screen using the quick operation: . + manage add-ons.
2. Choose JIRA Agile > Free Trial.
3. You will be redirected to my.atlassian.com. The ‘Configure Your JIRA Cloud Instance’ page will show a JIRA Agile license for 10 users. Choose Apply Changes at the bottom of the page to add JIRA Agile to your site.
4. You will be redirected back to your JIRA Cloud site. JIRA Agile will be added (this may take a few minutes). Choose Get Started on the ‘Licensed and Ready to Go’ confirmation dialog to try it out when it is ready.

That's it! You may also want to enable other commercial plugins for JIRA, like JIRA Capture (bug reporting) or Tempo (timesheets).

Step 3. Add Confluence to your Cloud site

JIRA helps your team manage a fundamental part of any project: tracking work. However, your team may also need help managing code, automating builds, organizing documentation, etc. JIRA seamlessly integrates with other Atlassian applications that help solve these problems.

In this step, we will show you how to add Confluence to your Cloud site. Atlassian's Confluence is a wiki-based tool that helps your team create, share and collaborate on content (e.g. business requirements, software specifications, test plans, etc). Don't worry about the cost, you will get a one-month free trial and can cancel at any time.

1. Log in to your my.atlassian.com account. This is the account that you created in the first stage of this tutorial.
2. Find the Licenses section on the account page and choose the + (plus sign) of your Atlassian OnDemand subscription.
3. In the Actions section, choose Configure Products & Users.
4. Choose Start a Free Trial for Confluence to add a license for 10 users to your Cloud site, and choose Apply Changes.

You have added Confluence to your Cloud site (you may need to wait a few minutes). Try accessing it via https://<your_site_name>.atlassian.net/wiki/
Step 4. Integrate JIRA with a source control system

In this step, we will show you how to integrate JIRA Cloud with Bitbucket: Atlassian's code hosting tool for Git and Mercurial. This will allow you to do things like see code commits in JIRA and move a JIRA issue through a workflow via commit messages. We are just going to show you how to connect the two services to get you started.

1. Log in to your my.atlassian.com account. Start a free trial for Bitbucket, similar to how you started a free trial for Confluence in the previous step.
2. You'll receive an email from Bitbucket inviting you to join the Bitbucket team linked to your JIRA Cloud. Find it and click Join your new team.
3. On the invitation page, sign up for a new Bitbucket account to join the team (or log in, if you already have a Bitbucket account). Your team account URL will be https://bitbucket.org/<cloud-account_name> or https://bitbucket.org/<cloud-account_name>-cloud (e.g. https://bitbucket.org/jira101).
4. Check that JIRA Cloud is connected to Bitbucket: In JIRA Cloud, use the quick operation: .+ dvcs accounts. You should see your Bitbucket account listed on the 'DVCS Accounts' screen.
JIRA and code hosting

If you have JIRA Server on your own servers, you may also want to consider integrating it with Stash: Atlassian's behind the firewall Git management for your source. Both JIRA Server and JIRA Cloud also integrate with GitHub.

JIRA Cloud to Bitbucket are now connected. You will need to do further configuration in Bitbucket to use it with JIRA effectively, such as add your team members to your Bitbucket team and create repositories. The full procedure is here: Getting started with Bitbucket and Atlassian OnDemand (start at step 3).

What next?

So that's it — we hope this guide has helped you get a feel for JIRA.

Your Cloud trial is free for one month and then you have a couple of options:

- **Keep this Cloud instance**
  You don't need to do anything if you want to keep your Cloud instance. When the evaluation expires your credit card will be charged and you can continue using your Cloud site. You can manage your account at my.atlassian.com.

- **Cancel your Cloud trial**
  Decided not to continue? You can cancel at any time during the first month.
  To cancel your Cloud trial, log in to your my.atlassian.com account and choose **Cancel evaluation** for your Atlassian Cloud Evaluation. This will include the JIRA, JIRA Agile, Confluence and Bitbucket licenses that you set up during this tutorial.

- **Switch to JIRA Server**
  If you want the greater flexibility that comes with hosting your own JIRA instance, you can cancel your Cloud trial and switch to JIRA Server. Refer to the JIRA Installation and Upgrade Guide for information about installing JIRA Server.
  If you want to keep the content you created in your Cloud instance, see Migrating from JIRA Cloud to JIRA Server.
  If you were evaluating JIRA Server, you might find the information on Switching Databases useful.

You can find more information about managing your Cloud subscription at www.atlassian.com/licensing/cloud

Feedback

Let us know what you thought of this tutorial via this quick five minute survey:

Click to give feedback...

Resources for topics covered in this guide
JIRA User's Guide

This manual contains information on how to use JIRA, the issue tracking and project management system that you access from your web browser.

JIRA Concepts

- What is a Project
- What is Workflow
- What is an Issue
Getting Started

- Logging in to JIRA
- Exploring the JIRA Workspace
- Using Keyboard Shortcuts
- Using JIRA on a Mobile Device
- Getting started with Bamboo

Working with an Issue

- Adding a field to an issue
- Attaching a File
- Attaching a Screenshot
- Cloning an Issue
- Commenting on an Issue
- Creating an Issue
- Creating a Sub-Task
- Creating issues using the CSV importer
- Editing an Issue
- Editing Rich-Text Fields
- Emailing an Issue
- Labeling an Issue
- Linking Issues
- Logging Work on an Issue
- Modifying Multiple (Bulk) Issues
- Moving an Issue
- Scheduling an Issue
- Setting Security on an Issue
- Viewing an Issue's Change History
- Watching and Voting on an Issue
- Viewing the Code Development Information for an Issue
  - Viewing an Issue's Crucible Reviews
  - Viewing an Issue's FishEye Changesets
  - Viewing the Bamboo Builds related to an Issue

Searching for Issues

- Basic Searching
- Using Quick Search
- Advanced Searching
  - Advanced Searching - Fields Reference
  - Advanced Searching - Keywords Reference
  - Advanced Searching - Operators Reference
  - DRAFT op rec - Advanced Searching
- Advanced Searching Functions
- Performing Text Searches
- Using the Issue Navigator
  - Customizing your Issue Navigator
- Using Filters
- Working with Search Result Data
  - Displaying Search Results as a Chart
  - Displaying Search Results in XML
  - Exporting Search Results to Microsoft Excel
  - Exporting Search Results to Microsoft Word
  - Receiving Search Results as an RSS Feed
  - Receiving Search Results via Email
  - Sharing a Search Result

Generating Reports

- Workload Pie Chart Report
- User Workload Report
- Version Workload Report
- Time Tracking Report
- Single Level Group By Report
• Created vs Resolved Issues Report
• Resolution Time Report
• Pie Chart Report
• Average Age Report
• Recently Created Issues Report
• Time Since Issues Report

**Browsing a Project**
• Browsing a Project's Summary
• Browsing a Project's Issues
• Browsing a Project's Road Map
• Browsing a Project's Change Log
• Browsing a Project's Versions
  • Browsing a Version's Bamboo Builds
• Browsing a Project's Components
• Browsing a Project's Bamboo Builds
• Browsing a Project's FishEye Changesets
• Browsing a Project's Crucible Reviews
• Viewing a Project's Burndown Chart
• Checking the progress of a version

**Customizing the Dashboard**
• Managing Multiple Dashboard Pages
• Displaying a Dashboard as a Wallboard
• Changing the Look and Behavior of a Gadget
• Adding the Activity Stream Gadget
• Adding the Administration Gadget
• Adding the Assigned To Me Gadget
• Adding the Average Age Gadget
• Adding the Bamboo Charts Gadget
• Adding the Bamboo Plan Summary Chart Gadget
• Adding the Bamboo Plans Gadget
• Adding the Bugzilla ID Search Gadget
• Adding the Calendar Gadget
• Adding the Clover Coverage Gadget
• Adding the Created vs Resolved Gadget
• Adding the Crucible Charts Gadget
• Adding the Favorite Filters Gadget
• Adding the Filter Results Gadget
• Adding the FishEye Charts Gadget
• Adding the FishEye Recent Changesets Gadget
• Adding the In Progress Gadget
• Adding the Introduction Gadget
• Adding the Issue Statistics Gadget
• Adding the Pie Chart Gadget
• Adding the Projects Gadget
• Adding the Quick Links Gadget
• Adding the Recently Created Chart Gadget
• Adding the Resolution Time Gadget
• Adding the Road Map Gadget
• Adding the Text Gadget
• Adding the Time Since Issues Gadget
• Adding the Two-Dimensional Filter Statistics Gadget
• Adding the Voted Issues Gadget
• Adding the Watched Issues Gadget
• Adding the Heat Map Gadget
• Adding the Labels Gadget

**Managing your User Profile**
• Adding a User Avatar
• Allowing OAuth Access
Data collection policy

Note: for information on configuring JIRA, please see the JIRA Administrator's Guide.

JIRA Concepts

Read the following pages for information about key concepts in JIRA:

- What is a Project
- What is Workflow
- What is an Issue

What is a Project

A JIRA project is a collection of issues, and is defined according to your organisation's requirements. For example, a JIRA project could be:

- a software development project
- a marketing campaign
- a helpdesk system
- a leave request management system
- a website enhancement request system

Every issue belongs to a project. Each project has a name (e.g. Website Issues) and a key (e.g. WEB). The project key becomes the first part of that project's issue keys, e.g. WEB-101, WEB-102, etc:

Project: Website Issues (Key: WEB)

What is a component?

A project component is a logical grouping of issues within a project. Each project may consist of various components (or none), depending on your organisation's needs.

For example, a software development project could consist of components called 'Documentation', 'Backend', 'Email Subsystem', 'GUI'. A website enhancement request system might consist of components called 'Products', 'Contact Us', etc:
An issue can belong to zero, one or multiple components within a project.

What is a version?

For some types of projects, particularly software development, it is useful to be able to associate an issue with a particular project version (e.g. 1.0 beta, 1.0, 1.2, 2.0).

Issues have two fields that relate to versions:

- **Affects Version(s)** — this is the version(s) in which the issue is manifesting. For instance, a software bug might affect versions 1.1 and 1.2.
- **Fix Version(s)** — this is the version(s) in which the issue was (or will be) fixed. For instance, the bug affecting versions 1.1 and 1.2 might be fixed in version 2.0. Note that issues which do not have a Fix Version are classified as Unscheduled.

Versions can be in one of three states: Released, Unreleased or Archived. Versions can also have a Release Date, and will automatically be highlighted as 'overdue' if the version is Unreleased when this date passes.

Additional Resources

- See 'Browsing a Project' for information on looking up a project's structure and issues.
- See the JIRA Administrator's Guide for information on defining projects, components and versions.

What is Workflow

A JIRA workflow is the set of statuses and transitions that an issue goes through during its lifecycle. The following diagram shows JIRA's built-in workflow:
What is an Issue

Different organizations use JIRA to track different kinds of issues. Depending on how your organization is using JIRA, an issue could represent a software bug, a project task, a helpdesk ticket, a leave request form, etc.

✔ You can access an issue in JIRA from a search result or from a dashboard gadget that provides access to issues.

A JIRA issue typically looks like this (click to enlarge image):

JIRA's system workflow can be customized by your JIRA administrator.
The fields shown in the above screenshot are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>The parent project to which the issue belongs. In this case, Angry Nerds.</td>
</tr>
<tr>
<td>Key</td>
<td>A unique identifier for this issue, in the example above: ANGRY-304. (The characters to the left of the hyphen represent the project to which this issue belongs.)</td>
</tr>
<tr>
<td>Summary</td>
<td>A brief one-line summary of the issue. For example, &quot;Red Angry Nerd is scary.&quot;</td>
</tr>
<tr>
<td>Type</td>
<td>See below for a list of types.</td>
</tr>
<tr>
<td>Status</td>
<td>The stage the issue is currently at in its lifecycle (workflow). See below for a list of statuses.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Priority</td>
<td>The importance of the issue in relation to other issues. (See below for a list of priorities).</td>
</tr>
<tr>
<td>Resolution</td>
<td>A record of the issue's resolution, if the issue has been resolved or closed. (See below for a list of resolutions).</td>
</tr>
<tr>
<td>Affects Version(s)</td>
<td>Project version(s) for which the issue is (or was) manifesting.</td>
</tr>
<tr>
<td>Fix Version(s)</td>
<td>Project version(s) in which the issue was (or will be) fixed.</td>
</tr>
<tr>
<td>Component(s)</td>
<td>Project component(s) to which this issue relates.</td>
</tr>
<tr>
<td>Labels(s)</td>
<td>Labels to which this issue relates.</td>
</tr>
<tr>
<td>Environment</td>
<td>The hardware or software environment to which the issue relates.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the issue.</td>
</tr>
<tr>
<td>Links</td>
<td>A list of links to related issues. (Strikethrough text, like this, indicates that an issue has been resolved.)</td>
</tr>
<tr>
<td>Assignee</td>
<td>The person to whom the issue is currently assigned.</td>
</tr>
<tr>
<td>Reporter</td>
<td>The person who entered the issue into the system.</td>
</tr>
<tr>
<td>Votes</td>
<td>The number shown indicates how many votes this issue has.</td>
</tr>
<tr>
<td>Watchers</td>
<td>Number shown indicates how many people are watching this issue.</td>
</tr>
<tr>
<td>Due</td>
<td>The date by which this issue is scheduled to be completed.</td>
</tr>
<tr>
<td>Created</td>
<td>The time and date on which this issue was entered into JIRA.</td>
</tr>
<tr>
<td>Updated</td>
<td>The time and date on which this issue was last edited.</td>
</tr>
<tr>
<td>Resolved</td>
<td>The time and date on which this issue was resolved.</td>
</tr>
<tr>
<td>Estimate</td>
<td>The Original Estimate of the total amount of time required to resolve the issue, as estimated when the issue was created.</td>
</tr>
<tr>
<td>Remaining</td>
<td>The Remaining Estimate, i.e. the current estimate of the remaining amount of time required to resolve the issue.</td>
</tr>
<tr>
<td>Logged</td>
<td>The sum of the Time Spent from each of the individual work logs for this issue.</td>
</tr>
<tr>
<td>Development</td>
<td>If you use Bitbucket or Stash to manage your code repositories, you can create code branches in your code development tools directly from JIRA issues. See Integrating JIRA with Code Development Tools for details.</td>
</tr>
<tr>
<td>Agile</td>
<td>Let's you view your issue on your Scrum or Kanban board.</td>
</tr>
</tbody>
</table>

Some of the most important fields are described as below.
JIRA can be used to track many different types of issues. The default types are listed below, but please note that your JIRA administrator may have customized this list to suit your organization.

- **Bug** — A problem which impairs or prevents the functions of the product.
- **Improvement** — An enhancement to an existing feature.
- **New Feature** — A new feature of the product.
- **Task** — A task that needs to be done.
- **Custom Issue** — A custom issue type, as defined by your organization if required.

### Priority

An issue’s priority indicates its relative importance. The default priorities are listed below; note that both the priorities and their meanings can be customized by your JIRA administrator to suit your organization.

- **Highest** — Highest priority. This problem will block progress.
- **High** — Indicates that this issue is causing a problem and requires urgent attention.
- **Medium** — Indicates that this issue has a significant impact.
- **Low** — Indicates that this issue has a relatively minor impact.
- **Lowest** — Lowest priority.

### Status

Each issue has a status, which indicates where the issue currently is in its lifecycle (‘workflow’). An issue starts as being ‘Open’, then generally progresses to ‘Resolved’ and then ‘Closed’; or, depending on circumstances, it may progress to other statuses. Please also note that your JIRA administrator may have customized the available statuses to suit your organization.

- **Open** — This issue is in the initial ‘Open’ state, ready for the assignee to start work on it.
- **In Progress** — This issue is being actively worked on at the moment by the assignee.
- **Resolved** — A Resolution has been identified or implemented, and this issue is awaiting verification by the reporter. From here, issues are either ‘Reopened’ or are ‘Closed’.
- **Reopened** — This issue was once ‘Resolved’ or ‘Closed’, but is now being re-examined. (For example, an issue with a Resolution of ‘Cannot Reproduce’ is Reopened when more information becomes available and the issue becomes reproducible). From here, issues are either marked In Progress, Resolved or Closed.
- **Closed** — This issue is complete.

### Resolution

An issue can be resolved in many ways, only one of them being ‘Fixed’. A resolution is usually set when the status is changed. The default resolutions are listed below; note that your JIRA administrator may have customized these to suit your organization.

- **Fixed** — A fix for this issue has been implemented.
- **Won’t Fix** — This issue will not be fixed, e.g., it may no longer be relevant.
- **Duplicate** — This issue is a duplicate of an existing issue. Note: it is recommended you create a link to the duplicated issue.
- **Incomplete** — There is not enough information to work on this issue.
- **Cannot Reproduce** — This issue could not be reproduced at this time, or not enough information was available to reproduce the issue. If more information becomes available, please reopen the issue.
- **Won’t Do** — This issue won’t be actioned. (This resolution is the same as Won’t Fix, and is only available for software projects by default)

Note that once an issue has been resolved (that is, the issue’s Resolution field is not empty), textual references to that issue will show the key in strikethrough text.

### Getting Started

The following pages contain information to help you get started using JIRA:

- Logging in to JIRA
- Exploring the JIRA Workspace
Using Keyboard Shortcuts
Using JIRA on a Mobile Device
Getting started with Bamboo

Logging in to JIRA

Many JIRA instances will have permissions implemented that restrict issues and issue actions to certain users and user groups. Some JIRA instances may not permit anonymous access. In these scenarios, you will be prompted to log in to JIRA.

The Login panel will be displayed if you have not logged in to JIRA.

On this page:
- Log in to JIRA
- Cannot remember either your username or password
- Sign up for an account

Log in to JIRA

1. Enter your **Username** and **Password** and click the **Log In** button.
2. If you have not **changed your JIRA home page**, the dashboard will be displayed. Otherwise, your chosen JIRA home page will be displayed instead.

Please Note:
- Selecting the **Remember my login on this computer** check box will prevent you from being automatically logged out of JIRA on a given browser and computer. However, your session will not be preserved, e.g. last search, current project, etc.

Cannot remember either your username or password

1. Click **Can't access your account?**
2. Fill in the fields on the 'Can't access your account?' page, as follows:
   - If you cannot remember your password, select the **Password** option and **Enter your username** in the field provided.
   - If you cannot remember your username, select the **Username** option and **Enter your email** address specified in your JIRA user profile.
3. Click **Send**. A new password will emailed to the email address specified in your user profile.

If you have forgotten the email address specified in your user profile, you will need to contact your JIRA administrator for help.

Sign up for an account
If you do not have a user account and your JIRA administrator has enabled public signup, you can create your own user account.

1. Click the Sign up link in 'Not a member? Sign Up for an account'.
2. Enter your details.
3. Click the Sign up button to create your account.

Exploring the JIRA Workspace

The Dashboard is the first page you see (by default) after logging in to JIRA.

- The navigation bar (at the top of the screen) is the same on every screen in JIRA. It contains links which give you quick access to many of JIRA’s most useful functions.
- The white area of the screen, below the top navigation bar, can be customized to display ‘gadgets’ showing many different types of information, depending on your areas of interest.

Please Note:

- Your JIRA dashboard page may look different from the one in this screenshot, as the logo and colours may have been customized by your JIRA administrator. The links in the navigation bar, however, will be the same.
- If you have changed your JIRA home page from the default (dashboard), the page you see after logging in to JIRA will be different.

Screenshot: JIRA dashboard (click to enlarge)

Using Keyboard Shortcuts

Keyboard shortcuts provide a quick and easy way of navigating though JIRA and performing fundamental actions on issues without having to take your fingers off the keyboard.

You may not have permission to perform all the keyboard shortcut actions described on this page. This
depends on how your JIRA administrator(s) have configured permissions for your user account.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Keyboard Shortcuts</td>
</tr>
<tr>
<td>• Modifier Keys</td>
</tr>
<tr>
<td>• Accessing the Keyboard Shortcuts Dialog Box</td>
</tr>
<tr>
<td>• Disabling and Re-enabling Keyboard Shortcuts</td>
</tr>
</tbody>
</table>

### Keyboard Shortcuts

#### Global Shortcuts

These shortcuts are available from any JIRA screen.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Dashboard</td>
<td>g then d</td>
<td>Directs you to the Dashboard screen.</td>
</tr>
<tr>
<td>Browse to a Project</td>
<td>g then p</td>
<td>Directs you to your current project browser screen.</td>
</tr>
<tr>
<td>Find Issues</td>
<td>g then i</td>
<td>Opens the Issue Navigator, where you can search for issues using either the Simple Search or Advanced Search features.</td>
</tr>
<tr>
<td>Quick Search</td>
<td>/</td>
<td>Directs your cursor to the Quick Search text field in the top right-hand corner. In 'Administration' mode, this keyboard shortcut directs your cursor to the 'Administration Quick Search' text field (also in the top right-hand corner), whose functionality is identical to the Administration Search Dialog Box (below).</td>
</tr>
<tr>
<td>Create an Issue</td>
<td>c</td>
<td>Opens the Create Issue dialog box for creating an issue.</td>
</tr>
<tr>
<td>Open shortcut help</td>
<td>?</td>
<td>Opens the keyboard shortcuts dialog box (described below). To close this dialog box, press the 'Esc' key or click 'Close' in the lower-right of the box.</td>
</tr>
<tr>
<td>Dashboards drop-down menu</td>
<td>Modifier key(s) + d</td>
<td>Opens the 'Dashboards' drop-down menu in the top navigation bar. You can then use the arrow keys to navigate to an item, then press 'Enter' to select it. Modifier Keys are specific to each combination of browser and operating system. Refer to the Modifier Keys section below for more details.</td>
</tr>
<tr>
<td>Projects drop-down menu</td>
<td>Modifier key(s) + p</td>
<td>Opens the 'Projects' drop-down menu in the top navigation bar. You can then use the arrow keys to navigate to an item, then press 'Enter' to select it.</td>
</tr>
<tr>
<td>Issues drop-down menu</td>
<td>Modifier key(s) + i</td>
<td>Opens the 'Issues' drop-down menu in the top navigation bar. You can then use the arrow keys to navigate to an item, then press 'Enter' to select it.</td>
</tr>
</tbody>
</table>
Administration Search dialog box  
(Only available if you have the JIRA Administrators global permission.)  
g then g  
Opens the Administration Search dialog box.  
- Press the 'Cursor Down' key to show a list of all Administration options, then:  
  1. use the cursor keys to select an Administration option, and  
  2. press 'Enter' to choose your selected option.  
- Type one to a few letters of the Administration option's name to restrict the list down to options whose names match the series of letters you entered, then:  
  1. if there is more than one option in the restricted list, use the cursor keys to select one, and  
  2. press 'Enter' to choose your selected option.

⚠️ Keyboard shortcuts are not available on JIRA's Workflow Designer page.

'View Issue' and 'Issue Navigator' Shortcuts

These shortcuts are available from JIRA's View Issue and Issue Navigator screens only.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View selected Issue</td>
<td>o or Enter</td>
<td>Opens the currently selected issue on the Issue Navigator.</td>
</tr>
<tr>
<td>Next Issue</td>
<td>j</td>
<td>Navigates to the next issue. This keyboard shortcut only applies to a View Issue screen if you got there via the Issue Navigator.</td>
</tr>
<tr>
<td>Previous Issue</td>
<td>k</td>
<td>Navigates to the previous issue. This keyboard shortcut only applies to a View Issue screen if you got there via the Issue Navigator.</td>
</tr>
<tr>
<td>Back to the Navigator</td>
<td>u</td>
<td>Returns to the Issue Navigator from the View Issue screen. This keyboard shortcut only applies to a View Issue screen if you got there via the Issue Navigator.</td>
</tr>
<tr>
<td>Hide/Show Left Section</td>
<td>[ (left square bracket)</td>
<td>Hides or shows the left section on the Issue Navigator.</td>
</tr>
<tr>
<td>Next Activity</td>
<td>n</td>
<td>Navigates to the next item in the activity section of the View Issue screen.</td>
</tr>
<tr>
<td>Previous Activity</td>
<td>p</td>
<td>Navigates to the previous item in the activity section of the View Issue screen.</td>
</tr>
<tr>
<td>Focus search field</td>
<td>f</td>
<td>Focuses the cursor in the Advanced Search text field or the Simple Search's Qu text field.</td>
</tr>
</tbody>
</table>
| Escape field            | Esc               | Escapes the cursor out of the current text field so that you can use more keyboard shortcuts. Pressing the 'Esc' key can also be used to Close or Cancel JIRA's dialog boxes.  
  ⚠️ If the auto-complete dropdown list is visible on the Advanced Search text field you must press the 'Esc' key twice to escape the cursor out of this text field. |
| Edit Issue              | e                 | Opens the Edit Issue dialog box (if you have appropriate permission), where you edit the issue. |
### Assign Issue

 Opens the **Assign** dialog box (if you have appropriate permission), where you can assign the issue to another JIRA user.

### Comment on Issue

 On the **View Issue** screen, this opens the comment panel at the top of the page focuses on the comment text box.

 On the **Issue Navigator**, this opens the **Add Comment** dialog box for adding a comment to the currently selected issue.

### Edit Issue Labels

**L** (lower-case 'L')

 Opens the **Labels** dialog box, where you can edit the labels associated with the issue.

### Share Issue

 Opens the **Share** bubble, which allows you to send a link to an issue or search result (with an optional note) to the email address of any JIRA user, or any arbitrary email address. See **Sharing an Issue** or **Sharing a Search Result** for details.

### Operations dialog box

**.** (full-stop/period)

 Opens the **Operations** dialog box, from which you can perform any permitted issue operation on the current JIRA issue by doing either of the following:

- Press the 'Cursor Down' key, then:
  1. use the cursor keys to select an issue operation, and
  2. press 'Enter' to choose your selected operation.
- Type one to a few letters of the issue operation's name to restrict the list down to operations whose names match the series of letters you entered, then:
  1. if there is more than one operation in the restricted list, use the cursor keys to select one, and
  2. press 'Enter' to choose your selected operation.

**Screenshot: The 'Operations' dialog box**

![Screenshot: The 'Operations' dialog box](image)

The list of issue operations available in the drop-down menu are split into the following categories:
• **Workflow Transitions** — Choose the appropriate workflow transition to change the issue's status. The workflow transitions available depend on the current issue's status and on how your JIRA administrator has customized your JIRA workflow. The default JIRA workflow transitions include:
  • **Start Progress** — Set the issue's **Status** to **In Progress**.
  • **Resolve issue** — Set the issue's **Status** to **Resolved** and select the appropriate **Resolution**.
  • **Close issue** — Set the issue's **Status** to **Closed** and if the issue has not already been **Resolved**, select the appropriate **Resolution**.
  • **Reopen issue** — Set a **Resolved** or **Closed** issue’s **Status** to **Reopen**.

• **Actions** — Choose the appropriate action to perform on the issue.
  • **Edit** — Edit the issue's details (**Summary**, **Description**, etc).
  • **Assign** — Select an assignee for the issue.
  • **Assign To Me** — Assign the issue to yourself.
  • **Comment** — Add a comment to the issue.
  • **Log Work** — Record the work done and time spent on the issue. This option is only available if **Time Tracking** has been activated on your JIRA site.
  • **Attach Files** — Select a file, upload it and attach it to the issue.
  • **Attach Screenshot** — Select a file, upload it and attach it to the issue.
  • **Voters** — Opens the **Voters list** of the issue, where you can manage your vote and see others who have voted on the issue too.
  • **Add Vote** — Adds your vote to the issue. (This option is only available if you did not create the issue.)
  • **Watch Issue** — Become a **watcher** of the issue.
  • **Stop Watching** — Stop watching the issue. (This option is only available if issues you are currently watching.)
  • **Watchers** — Opens the **Watchers List**, where you can manage watchers of the issue.
  • **Create Sub-Task** — Create a new issue which is a **sub-task** of the issue.
  • **Convert to Issue** — If the issue is a sub-task, **convert** it to a standalone issue.
  • **Convert to Sub-Task** — If the issue is a standalone issue, **convert** it to a sub-task.
  • **Move** — **Move** the issue to a different project.
  • **Link** — Create a **link** between the issue and another issue. This option is available if **Issue Linking** has been enabled on your JIRA site.
  • **Clone** — Create a new issue which is an **identical copy** of the issue.
  • **Labels** — Edit the issue's **labels**.
  • **Delete** — Permanently remove the issue.

---

**Form Shortcuts**

These shortcuts are available on JIRA forms, including those involved in editing an issue's fields, such as the Create Issue or Edit Issue forms and JIRA login forms.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note that some options in the <strong>Actions</strong> menu will only be available if you have the necessary <strong>permissions</strong>, or if certain features have been enabled by your JIRA administrator.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Submit Form

<table>
<thead>
<tr>
<th>Modifier key(s) + s (Alt + s only in Chrome on Windows or Linux/Solaris)</th>
<th>Submits any currently open form in JIRA. The keyboard shortcuts dialog box will show which modifier key (or keys) are required for your combination of web browser and operating system.</th>
<th>Notice: Modifier Keys are specific to each combination of browser and operating system. Refer to the Modifier Keys section below for more details.</th>
</tr>
</thead>
</table>
| Cancel Form

<table>
<thead>
<tr>
<th>Modifier key(s) + ` (backquote)</th>
<th>Cancels any currently open form in JIRA.</th>
</tr>
</thead>
</table>
| Escape Field

<table>
<thead>
<tr>
<th>Esc</th>
<th>Escapes the cursor out of any field on the currently open form, so that you can use more keyboard shortcuts. Pressing the 'Esc' key can also be used to Close or Cancel JIRA's dialog boxes.</th>
</tr>
</thead>
</table>
| Back

<table>
<thead>
<tr>
<th>u</th>
<th>Returns to the View Issue screen from any form that results from an action performed on that issue. You must have escaped out of all fields on the form (by pressing 'Esc') before using this keyboard shortcut.</th>
</tr>
</thead>
</table>
| 'Remember my login' check box

<table>
<thead>
<tr>
<th>Modifier key(s) + r</th>
<th>Automatically selects the 'Remember my login on this computer' check box. This shortcut only applies to JIRA's login forms.</th>
</tr>
</thead>
</table>

**Modifier Keys**

If a keyboard shortcut requires modifier keys, one or two of these modifier keys (for example, 'Shift', 'Alt' or 'Ctrl') must be pressed simultaneously, along with a single 'action' key. In the shortcuts dialog box, these keystrokes are indicated as 'modifier (+ modifier) + x', where 'x' is an action key, with the exception of a 'Shift + x' key combination.

Modifier keys differ depending on your combination of operating system and web browser. For example, when running Firefox on Mac OS X, you will need to press 'Ctrl' + 'S' to submit a form, while on Windows, you will need to press 'Alt' + 'S'. The following table identifies the modifier keys for the various combinations of supported web browsers and operating systems:

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Mac OS X</th>
<th>Windows</th>
<th>Linux/Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox</td>
<td>Ctrl</td>
<td>Alt + Shift</td>
<td>Alt + Shift</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>Alt</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Safari</td>
<td>Ctrl + Alt/Option</td>
<td>Ctrl</td>
<td></td>
</tr>
<tr>
<td>Chrome</td>
<td>Ctrl + Alt/Option</td>
<td>Alt + Shift</td>
<td>Alt + Shift</td>
</tr>
</tbody>
</table>

Please note:

- **Modifier key shortcuts** differ from two-key shortcuts. For the latter, one discrete keystroke follows another (without the keys being pressed simultaneously). In the shortcuts dialog box, two-key shortcuts are indicated as 'x then y', where 'x' is the first keystroke and 'y' is the second.
- In Internet Explorer, typing a 'Modifier key shortcut' that leads to a link results in the link being highlighted only. Hence, after typing a modifier key shortcut, you will then need to press the 'Enter' key to complete the action - for example, to open a link's drop-down menu. The actions of modifier key shortcuts that lead to buttons, however, are fully completed.
- In Firefox, it is possible to customize 'Modifier key shortcuts'. Please read Mozilla's [ui.key.contentAccess documentation](#) for more information.

**Accessing the Keyboard Shortcuts Dialog Box**

The keyboard shortcuts dialog box shows an overview of JIRA actions that are available as keyboard shortcuts.
and the combination of keystrokes required to perform them.

To open the keyboard shortcuts dialog box:

Choose ☰ > Keyboard Shortcuts.
You can also open this dialog by pressing ? (Shift + /) on your keyboard. Note, your cursor must not be focused in a JIRA text field for ? to work.

To open the keyboard shortcuts dialog box:

Choose ☰ > Keyboard Shortcuts.
You can also open this dialog by pressing ? (Shift + /) on your keyboard. Note, your cursor must not be focused in a JIRA text field for ? to work.

If you have JIRA plugins installed, you may have additional keyboard shortcuts available. For example, if you have JIRA Agile installed, you will see a series of Agile keyboard shortcuts in the lower-right of this dialog box (and some additional Global keyboard shortcuts specific to JIRA Agile in the upper-left section). However, the keyboard shortcuts in the Agile Shortcuts section only function in JIRA Agile and not in a JIRA context.

Please Note:

- Be aware that when you press ‘?’, the keyboard shortcuts dialog box will not appear if your cursor is already focused inside any JIRA text entry field. Press ‘Esc’ first to escape from a field.
- If you have JIRA Agile 6.7 installed, you will see a series of Agile keyboard shortcuts in the lower-right of this dialog box (and some additional Global keyboard shortcuts specific to JIRA Agile in the upper-left section). However, the keyboard shortcuts in the Agile Shortcuts section only function in JIRA Agile and not in a JIRA context.

Disabling and Re-enabling Keyboard Shortcuts

Keyboard shortcuts are enabled by default. However, you can disable them on a per-user basis via the Keyboard Shortcuts dialog box.
To disable or re-enable keyboard shortcuts:

1. Ensure you are logged in to JIRA and open the Keyboard Shortcuts dialog box (described above).
2. At the bottom of the Keyboard Shortcuts dialog box, click 'Disable Keyboard Shortcuts' or 'Enable Keyboard Shortcuts' to respectively disable or re-enable keyboard shortcuts for the currently logged in user.

Alternatively, you can disable or re-enable keyboard shortcuts by editing the Preferences section of the Summary Tab of your User Profile.

Using JIRA on a Mobile Device

When you view a JIRA page on a mobile device, such as an iPhone or an Android phone, JIRA will display an optimised version of the page. JIRA chooses the mobile or desktop interface based on your device.

The JIRA mobile interface is designed for viewing and interacting with issues on the go. If you need full access to JIRA, you can always switch to the JIRA desktop interface via the mobile menu (shown in the screenshots below).

What does JIRA look like on a mobile device?

What can you do in JIRA on a mobile device?

The JIRA mobile interface has been designed to give users quick access to their issues on the go. This includes;

- Viewing issues, comments, attachments, issue links and your favourite filters.
- Performing basic operations like adding comments, watching or voting on issues and assigning issues to users.

If you need to create or modify issues on the go, you can still do so by switching to the desktop interface via the mobile menu (shown in the screenshots above).

Frequently asked questions

- What mobile devices are supported?
- Do I need to install an app to view JIRA on a mobile device?
- Can I access my JIRA Cloud site via a mobile device?
- Why can't I view my custom field in JIRA on my mobile?

What mobile devices are supported?

See Supported Platforms for details of supported mobile devices.
Do I need to install an app to view JIRA on a mobile device?

No, JIRA is viewed on a mobile device via a web interface (optimised for mobile devices), not an app. Simply browse to your JIRA server's URL using your mobile browser to bring up the mobile interface for JIRA.

Can I access my JIRA Cloud site via a mobile device?

Yes, just enter the URL of your JIRA Cloud site in your mobile web browser.

Why can't I view my custom field in JIRA on my mobile?

The JIRA Mobile interface will show custom fields in the issue details screen. Custom fields that have their own custom field renderer will not display on the JIRA Mobile interface. You will need to switch to the desktop interface to view these fields.

Can I disable JIRA mobile for my site?

You can disable JIRA mobile for your site, so that users will only be able to access the desktop view of JIRA on their mobile device.

JIRA mobile is implemented as a add-on in JIRA, so you can disable it by disabling the add-on. For instructions on disabling add-ons, see Managing Add-ons. Note, JIRA mobile is a System Plugin.

Getting started with Bamboo

Bamboo is a continuous integration (CI) server. Bamboo assists software development teams by providing:

- automated building and testing of software source-code status.
- updates on successful/failed builds.
- reporting tools for statistical analysis.

Please see the following page for information about getting started with Bamboo:

- Understanding the Bamboo CI Server - a conceptual overview of using Bamboo for continuous integration (CI).

Working with an Issue

The following pages contain information on working with an issue:

- Adding a field to an issue
- Attaching a File
- Attaching a Screenshot
- Cloning an Issue
- Commenting on an Issue
- Creating an Issue
- Creating a Sub-Task
- Creating issues using the CSV importer
- Editing an Issue
- Editing Rich-Text Fields
- Emailing an Issue
- Labeling an Issue
- Linking Issues
- Logging Work on an Issue
- Modifying Multiple (Bulk) Issues
- Moving an Issue
- Scheduling an Issue
- Setting Security on an Issue
- Viewing an Issue's Change History
- Watching and Voting on an Issue
- Viewing the Code Development Information for an Issue

Adding a field to an issue

JIRA Admins can add an existing field or create a custom field while in View Issue with the Admin > Add field option. You can even configure the options for that custom field without having to leave the screens you are presented with.
Custom fields enable JIRA administrators to quickly customize the way issues look. In addition to adding this new field to the View issue screen, it is also added to the Create and Edit screens as well. This means you can edit the field you just created instantly, and input data into that field the next time you add an issue.

Finally, when creating a custom field, you can choose between Standard and Advanced types. For Standard types, a preview image is shown for each type, so you can see what you are creating in advance.

Adding a new field

Use this procedure to add a new field while in the View issue screen.

1. Select the Admin > Add field option. You are presented with this screen, where you can enter your field name (as shown here):

   ![Add Field](image)

2. Once you have entered an acceptable field name (it cannot be the name of a field that already exists), click Create.
3. Select a field type from the displayed list and click Next.
4. Configure the selection criteria for your field, as shown in the example below:
Click **Create** when you are happy with your field options.

5. You are presented with your options. Make a selection and click **Submit**. This field now displays on your issue screen:
Adding a field that already exists

Use this procedure to add a field that already exists while in the View issue screen.

1. Select the **Admin > Add field** option. Click the down arrow on the Name selection box, as shown here:
1. **Note:** Only fields that aren’t already in use on the displayed issue are available.
2. Select a field from the list and click **Add**.
3. If necessary, select any display options and click **Submit**.

You will see a message display briefly on your View issue screen that tells you the issue was added.

### Attaching a File

JIRA allows you to attach files to an issue.

To be able to attach files, your JIRA administrator must have enabled file attachments.

### On this page:

- Attaching a File to an Issue
- Viewing an Image Gallery
- Sorting Attachments
- Accessing ZIP-format File Contents
- Exporting All Attachments as a ZIP File
- Removing a File Attachment from an Issue

Attaching a File to an Issue
To attach files to an issue, you need the Create Attachments project permission in that issue's project.

To attach a file to a JIRA issue:

1. Open the JIRA issue to which you wish to attach a file.
2. Select More > Attach Files.
3. The Attach Files dialog box is displayed.
4. Click Browse to search for your files.
   - You can attach more than one file at a time: after you select a file, it will appear at the top of the 'Attach Files' dialog box, followed by each subsequent file you add.
   - If you use Firefox 3.6 or later or Chrome browsers, you can select multiple files in the browser dialog box.
   - If you select a file by mistake, clear its check box to prevent the file from being attached to the issue.
   - By default, the maximum size of any one file is 10MB, although this limit can be customized by your JIRA administrator. See Configuring File Attachments for more information.
   - File names cannot contain any of these characters: '"', '/','"', '%', ':','\', '?' , '*'.

5. Optional: Enter a comment about the files(s) you are attaching.
   - If you enter a comment, then you can also set the security level for the comment by selecting the appropriate value from the padlock icon dropdown. The security level for the comment is 'All Users' by default.
6. Click the Attach button. All selected files will be attached to the issue.

Viewing an Image Gallery

By default, JIRA displays image files (ie. GIFs, JPGs, PNGs) attached to an issue, including any screenshots, as thumbnails.

If your JIRA administrator has disabled Thumbnails in JIRA's Attachment Settings, then the image files will be part of the list of attached files instead.

Click on an image's thumbnail to preview a larger version of it in a popup. If multiple images are attached to an issue, click the left and right arrows to see previews of the adjacent attached images.

Sorting Attachments

You can sort the list of attachments on JIRA issues in ascending or descending order according to the attachment file name or date of attachment to the issue.

To sort your list of attachments:

1. Open a JIRA issue with attachments.
2. Click the down-arrow icon to the right of the Attachments section and select the required sort criteria or order options provided in the list.
   - Your final sort criteria and order options will also apply to image thumbnails and all subsequent issues viewed.

Accessing ZIP-format File Contents

When viewing an issue, JIRA allows you to browse and access the contents of any ZIP-format file (such as those with a '.zip' or '.jar' file name extension) attached to an issue.

To browse the contents of a zipped attachment and access its files:

1. Open a JIRA issue with an attached zipped file.
2. Click the right-arrow icon to the left of the zipped file's name.
3. The contents of the zipped file are listed. From this expanded list, you can access the zipped file's individual files by clicking their linked names or you can download the whole zipped file in its entirety by...
clicking the **Download Zip** link.

If a file is located within a subdirectory of the zipped file, then the path to that file is indicated in the content of the zipped file. For example, the content of **Files.zip** listed in the screenshot above shows that **File 5.txt** is located within the **Folder 1** subdirectory of **Files.zip**.

If your JIRA Administrator has disabled ZIP support in JIRA's Attachment Settings, then this feature will not be available and you must download the zip file to your computer before accessing its individual files.

### Exporting All Attachments as a ZIP File

To download all the files attached to an issue as a single ZIP file:

1. Open the JIRA issue from which you wish to export all attachments as a zip file.
2. Click the down-arrow icon to the right of the **Attachments** section and select Download All from the dropdown menu.

### Removing a File Attachment from an Issue

To remove attachments from an issue, you need either of the following the **project permissions** in that issue's project:

- **Delete Own Attachments** — to delete files which you have added to the issue.
- **Delete All Attachments** — to delete files which anyone has added to the issue.

**To remove a file attachment from a JIRA issue:**

1. Open the JIRA issue from which you wish to remove a file.
2. Click the down-arrow icon to the right of the ‘Attachments’ section and select **Manage Attachments** from the dropdown menu.
   
   The Manage Attachments page will appear:
   
   ![Manage Attachments](image)
   
   **Note:** Only users with the appropriate **Delete Issues** project permissions can remove attachments.

   3. Locate the file you wish to delete and click the **Delete Attachment** icon: 

### Attaching a Screenshot

JIRA allows you to attach screenshots to an issue.

This feature is only available if:

- Your JIRA administrator has **file attachments enabled** (you also need the **Create Attachments** permission in the appropriate projects),

- You are using a Windows or Mac client (if you use another operating system, you can attach a screenshot using the **file attachment feature** instead, or for Linux users please see our article for enabling this feature)

**Browser compatibility notes:** If you are using Internet Explorer versions 8-10, the computer you are using will need to be running Java version 1.7+ platform. If you are using Google Chrome, Mozilla Firefox or Internet Explorer 11, the screenshot capability takes advantage of HTML5 compatibility. Safari is not supported.
Capturing screenshots

The method for capturing screenshots differs on each operating system, as described below:

**Capturing a screenshot on Windows**

- New screenshot capture — To capture a screenshot onto the system clipboard, use either of the following keyboard combinations:
  - Press **ALT-PRINTSCREEN** to capture your currently selected window; or
  - Press **CTRL-ALT-PRINTSCREEN** to capture the whole desktop
- Existing image — Open your existing image in your favorite imaging application and select the copy option from the appropriate menu to capture the image into the system clipboard.

**Capturing a screenshot on Mac OSX**

- New screenshot capture — To capture a screenshot into the system clipboard, use either of the following keyboard combinations:
  - Press **CTRL-CMD-SHIFT-4** to capture a selected area of your desktop; or
  - Press **CTRL-CMD-SHIFT-3** to capture the whole desktop
- Existing image — Open your existing image in your favorite imaging application and select the copy option from the appropriate menu to capture the image onto the system clipboard.

Attaching a screenshot

To attach a screenshot:

1. Open the JIRA issue to which you wish to attach a file.
2. Select More > Attach Screenshot.
3. The Attach Screenshot dialog box opens. Note that if you take a screenshot at this point it will include the Attach Screenshot dialog box.
4. Paste the image from your clipboard using the relevant keyboard shortcut. (For Max OSX use **CMD+V**, for Windows use **Ctrl+V**)
5. Enter a file name for the screenshot you are attaching. (The file name defaults to **screenshot-1**.)
   - A valid file name cannot contain any of these characters: `'`, `/`, `\`, `:`, `'`, `\`, `*`.
6. Click Upload to attach the captured image to your JIRA issue.

Deleting a screenshot

To delete a screenshot from an issue:

1. Open the JIRA issue you wish to delete the screenshot from.
2. Locate the attached screenshot in the Attachments section.
3. Highlight the screenshot you want to delete by hovering your mouse over it. A trash can will appear at the bottom left side of the screenshot.
4. Click on the **trash can**. A **Remove Attachment** confirmation box displays.
5. Click **Delete** to confirm you want to delete the screenshot.

**Known issues**

- Attach screenshot does not work with Java 7 and Chrome. See this [KB article](#).

**Cloning an Issue**

Cloning, or copying, an issue lets you quickly create a duplicate of an issue within the same project. The clone issue is a replica of the original issue, containing the same information stored in the original issue — e.g. Summary, Affects Versions, Components, etc. The clone issue can also be linked to the original issue.

A clone issue is a separate entity from the original issue. Operations on the original issue have no effect on the clone issue and vice versa. The only connection is a link – if created – between the original and the clone issue.

**On this page:**
- Creating a Clone Issue
- Cloned Issue Linking Behavior
- Cloned Issue Summary Field Prefix
- Cloning and Sub-Tasks

A clone issue retains the following information:

- Summary
- Description
- Assignee
- Environment
- Priority
- Issue Type
- Security
- Reporter
  (If you do not have the **Modify Reporter** permission, the clone issue will be created with you as the Reporter.)
- Components
- Affects Versions
- Fix For Versions
- Issue Links (optional)
- Attachments (optional)
- Project
  (Once the clone has been saved, you can move it to another project as described in [Moving an Issue](#).)

The content of custom fields is also cloned.

**Things that aren't cloned:**

- Time tracking
- Comments
- Issue history

**Creating a Clone Issue**

**To clone an issue:**

1. Open the JIRA issue you wish to clone.
2. Select **More > Clone**. The **Clone Issue** screen will appear.
   - You can edit the clone issue's **Summary** if you wish.
   - If the issue contains **links to other issue(s)**, you can select whether or not to include the links in the new clone issue.
   - If the issue contains **sub-tasks**, you can select whether or not to create the sub-tasks in the new clone issue.
• If the issue contains attachments, you can select whether or not to include the attachments in the new clone issue.

3. Click Create.

Cloned Issue Linking Behavior

By default, when an issue is cloned, JIRA automatically creates a link between the original and cloned issue using the pre-existing link type name 'Cloners'.

Cloned Issue Summary Field Prefix

By default, the Summary field of a cloned issue is prefixed with the string 'CLONE - ' to indicate that the issue is a clone.

Cloning and Sub-Tasks

Sub-Tasks can be cloned in the same manner as other issue types.

If the original issue has associated sub-tasks, that issue's sub-tasks will also be cloned. The summary of a cloned sub-task will also include the prefix specified in the properties file.

Commenting on an Issue

Adding comments to an issue is a useful way to record additional detail about an issue, and collaborate with team members. Comments are shown in the Comments tab of the Activity section when you view an issue.

Note:

• When adding a comment, you can set the comment to be Viewable by members of a particular project role or user group only; or you can allow all users to view it.

• For users to view a comment, they must have the Browse Project project permission to view the issue and for each comment, they must be a member of the Viewable by users (see Adding a Comment below). You automatically become a watcher of the issues that you comment on. You can disable this via the Preferences > Autowatch option in your profile.

## On this page:

- Adding a comment
- Collapsing and expanding a comment
- Editing a comment
- Deleting a comment
- Linking to a comment

### Adding a comment

To add comments to an issue, i.e. to see the Comment button, you must have both of the following permissions for the issue's relevant project:

- **Browse Project** project permission — to view the issue to be commented on
- **Add Comments** project permission — to add a comment to the issue.

To add a comment:

1. Open the issue on which to add your comment.
2. Click the Comment button.

   **Keyboard shortcut:** m

3. In the Comment text box, type your comment, using as many lines as you require. You can use wiki markup in this text box if the Wiki Style Renderer is enabled.

   • To apply viewing restrictions to a comment: click the open padlock icon next to Viewable by...
e by... and select which users will be able to view this comment. The Viewable by... list also includes all project roles and groups to which you belong. (Note that All Users means everybody who uses JIRA, while Users means everybody who is a member of the Users project role in this project.) Depending on how your JIRA administrator has configured 'Comment visibility', the Viewable by... list may include groups as well as project roles.

Once viewing restrictions have been applied to a comment, the padlock icon closes and Viewable by... is replaced by Restricted to... and indicates the user, project role or group, who can view this comment, for example: Viewing by All Users

- **To email other users about your comment:** simply mention these users in the Comment text box. An email message will be sent to the user's email address (registered with their JIRA account) upon clicking the Update button. See Emailing an issue to users by mentioning them for details on the correct syntax.

4. Click the Add button to save the comment.

For each comment on an issue, a small version of the comment author's user avatar appears to the left of their full name.

**Collapsing and expanding a comment**

**To collapse or expand a comment:**

1. Locate the comment in the Activity section at the bottom of the issue.
2. Browse to the comment you wish to collapse/expand.
3. To collapse or expand a comment, click the arrow icon, located on the comment:

Collapsing or expanding a comment does not relate in any way to a comment's 'viewing restrictions' applied when adding or editing a comment.

**Editing a comment**

You can edit your own comments if you have been granted the Edit Own Comments project permission.

You can edit other people's comments if you have been granted the Edit All Comments project permission.

**To edit a comment:**

1. Locate the comment in the Activity section at the bottom of the issue.
2. Browse to the comment you wish to edit.
3. Click the Edit (pencil) icon, located on the comment:
4. Edit the comment's text and/or Viewable by list as required.
5. Click the Save button.
6. The word 'edited' will be displayed to indicate that the comment has been edited. You can hover your mouse over the word 'edited' to see who edited the comment and when.
Deleting a comment

You can delete your own comments if you have been granted the **Delete Own Comments** project permission.

You can delete other people's comments if you have been granted the **Delete All Comments** project permission.

**To delete a comment:**

1. Hover your mouse over the comment you wish to delete.
2. Click the **Delete** (trash-can) icon, located on the comment:
3. Confirm the deletion by clicking the **Delete** button.

Linking to a comment

Sometimes you may want to link to a specific comment within a JIRA issue.

1. Browse to the comment you wish to link to.
2. Click the **Permalink** (link) icon, located on the comment:
3. The comment will now be highlighted in pale blue, e.g.:
   ![Permalink Icon](image)
4. Copy the link from the Permalink icon and paste it into wherever you want to link from (e.g. an email). The link will look something like this:
   http://jira.atlassian.com/browse/TST-123?focusedCommentId=94796#action_94796
5. The URL in your browser's address bar will now look something like this:
   http://jira.atlassian.com/browse/TST-123
   but the comment still will be correctly located and highlighted.

Related topics

**Emailing an Issue**

**Creating an Issue**

To create a **JIRA issue**, you need the **Create Issue** project permission for the issue's relevant project. If you do not have this permission, please contact your JIRA administrator.

**To create a new JIRA issue:**

1. Click **Create** at the top of the screen to open the **Create Issue** dialog box.
   ![Create Issue Dialog](image)
2. Select the relevant **Project** and **Issue Type** on the **Create Issue** dialog box.
3. Type a **Summary** for the issue and complete any appropriate fields — at least required ones which are marked by an asterisk.
   ![Create Issue Form](image)
   If you want to access fields that are not shown on this dialog box or you want to hide existing fields:
   a. Click the **Configure Fields** button at the top right of the screen.
   b. Click **Custom** and select the fields you want to show or hide by selecting or clearing the relevant check boxes, respectively, or click **All** to show all fields.
   ![Configure Fields](image)
   When you next create an issue, JIRA remembers your last choice of selected fields.
4. Optional: To create a series of similar issues — with the same **Project** and **Issue Type** — select the **Create another** check box at the bottom of the dialog.
5. When you are satisfied with the content of your issue, click the **Create** button.

   ![Create Issue Confirmation](image)

   If you selected the **Create another** check box (above), a new **Create Issue** dialog appears. Depending on your configuration, some of the fields may be pre-populated. Make sure you check they're all correct before
Creating the next issue.

✅ Tips:

- You can mention other users in the **Description** or **Comment** field so that an email message will be sent to the user’s email address (registered with their JIRA account) upon clicking the **Update** button. See Emailing an issue to users by mentioning them for details.
- In certain text fields for an issue, you can link to other issues, insert macros, insert images and more. For more information, see Editing Rich-Text Fields.
- To see a list of all issues that you have created, which have not yet been resolved, go to your user name and select **Profile** and on your profile, click **Filters** > **Reported & Open**.
- You may automatically become a watcher of the issues that you create, depending on the **Autowatch** setting in your user profile. Note, if you have not changed this setting, you will inherit the global Autowatch settings set by your JIRA administrator (in > **System** > **User Preferences**).
- With appropriate configuration by your JIRA administrator, it is also possible to create issues via email.
- If you are using agile Scrum boards for planning, you can easily add an issue to your backlog by using inline issue create.

Screenshot: Example 'Create Issue' dialog box

Related topics

Sharing a Search Result

Creating a Sub-Task

*Sub-task issues* are useful for splitting up a parent issue into a number of smaller tasks that can be assigned and tracked separately. This can provide a better picture of the progress on the issue, and allows each person involved in resolving the issue to better understand what part of the process they are responsible for.

All the sub-tasks related to a parent issue are summarised on the parent issue's main screen (see 'Working with Sub-Tasks' below). Sub-tasks always belong to the same project as their parent issue.

Sub-tasks have all the same fields as **standard issues**, e.g. Summary, Description, Reporter, Assignee, Status. Note that sub-tasks have a different set of **issue types** from the standard issue types.

Sub-tasks cannot have sub-tasks of their own. However, if you need to break up a sub-task into smaller sub-tasks, you could achieve this by first converting the sub-task to a standard issue. You would then be able to create sub-tasks for it.
Creating a sub-task

To create sub-tasks, you need to have the Create Issue permission in the parent issue's project. There is no option to set security on a sub-task, as sub-tasks inherit their parent issue's security levels if any have been set.

Sub-tasks can only be created if your JIRA administrator has enabled sub-tasks and added the sub-task issue type to the project's issue type scheme.

To create a sub-task:

1. Navigate to the issue you would like to be the parent issue of the sub-task you are about to create.
2. Select More > Create Sub-Task. You will see the Create Subtask screen.
3. Fill in the details as needed, and then click Create at the bottom of the page.

Tip: You can customize the Create Subtask dialog to show fields you use most often. To do this, click Configure Fields at the top right corner of the dialog, and use the All and Custom links to switch between the default screen and your custom settings. Your changes are saved for future use.

Working with sub-tasks

If an issue has sub-tasks, the issue screen displays a list of all the issue's sub-tasks:

- **Show open sub-tasks only** – The sub-task list has two views: Show All and Show Open. Show All lists all sub-tasks, regardless of status, while Show Open only shows sub-tasks that have not been resolved (i.e. do not have a Resolution).
- **Time Tracking** – The colored bars show the time-tracking data for the issue and its sub-tasks.

- **Perform actions on sub-tasks** – Click on the right side of the sub-task in the list to display the Actions dropdown menu:

  Tip: You can also type a period '.' to access issue actions.
• Quickly create sub-tasks – Once an issue has one or more sub-tasks, you can quickly create additional sub-tasks by clicking the ‘+’ icon.

Searching for sub-tasks

When sub-tasks are enabled, two extra entries appear in the Issue Type dropdown list in the search form.

- To search standard issues only, click All Standard Issue Types.
- To search sub-task issues only, click All Sub-Task Issue Types.
- To search for one specific type of issue or sub-issue, select just one Issue Type or one Sub-Task Issue Type.

If no entries are selected from the Issue Type list, the search returns all the standard and sub-task issues that meet the search criteria.

Converting a standard issue to a sub-task

1. Navigate to the issue you would like to convert.
2. Select More > Convert to Sub-Task.
3. In the Step 1. Select Parent Issue and Sub-Task Type screen, type or select the appropriate parent issue type and the new issue type (i.e. a sub-task issue type). Click Next.
4. If the issue's current status is not an allowed status for the new issue type, the Step 2. Select New Status screen is displayed. Select a new status and click Next.
5. In the Step 3. Update Fields screen you will be prompted to enter any additional fields if they are required. Otherwise, you will see the message 'All fields will be updated automatically'. Click Next.
6. The Step 4. Confirmation screen is displayed. If you are satisfied with the new details for the issue, click Finish.
7. The issue will be displayed. You will see that it is now a sub-task, that is, its parent's issue number is now displayed at the top of the screen.

Note: You will not be able to convert an issue to a sub-task if the issue has sub-tasks of its own. You first need to convert the issue’s sub-tasks to standalone issues (see below); you can then convert them to sub-tasks of another issue if you wish. Sub-tasks cannot be moved directly from one issue to another — you will need to convert them to standard issues, then to sub-tasks of their new parent issue.

Converting a sub-task to a standard issue

1. Navigate to the sub-task issue you would like convert.
2. Select More > Convert to Issue.
3. In the Step 1. Select Issue Type screen, select a new issue type (i.e. a standard issue type) and click Next.
4. If the sub-task's current status is not an allowed status for the new issue type, the **Step 2. Select New Status** screen is displayed. Select a new status and click **Next**.
5. In the **Step 3. Update Fields** screen you will be prompted to enter any additional fields if they are required. Otherwise, you will see the message 'All fields will be updated automatically'. Click **Next**.
6. The **Step 4. Confirmation** screen is displayed. If you are satisfied with the new details for the issue, click **Finish**.
7. The issue will be displayed. You will see that it is no longer a sub-task, that is, there is no longer a parent issue number displayed at the top of the screen.

### Creating issues using the CSV importer

If you have the **Create Issue** project permission and the **Bulk Change** global permission for the relevant projects, you can create issues in bulk using a comma-separated value (CSV) file. CSV files are text files that represent tabulated data, and are supported by most systems that handle tabulated data such as spreadsheets (MS Excel, Numbers) and databases.

The CSV importer allows you to import data from external systems that can export their data in a tabulated format. It also allows you to create your own CSV file to perform bulk issue creation and updates.

There are two steps to using the CSV importer, and an optional third step:

1. Preparing your CSV file,
2. Running the CSV import wizard, and
3. Saving your configuration for future use.

### Preparing your CSV file

The JIRA Importers plugin assumes that your CSV file is based off a default Microsoft Excel-styled CSV file. Fields are separated by commas and any content that must be treated literally, such as commas and new lines/'carriage returns' themselves are enclosed in quotes.

**i** For Microsoft Excel and OpenOffice, it is not necessary to quote values in cells as these applications handle this automatically.

**CSV file requirements**

In addition to being 'well-formed', CSV files have the following requirements.

**Each CSV file must possess a heading row with a Summary column**

The CSV file import wizard uses a CSV file's header row to determine how to map data from the CSV file's 2nd row and beyond to fields in JIRA.

The header row **should avoid containing any punctuation** (apart from the commas separating each column) or the importer may not work correctly.

The header row **must** contain a column for 'Summary' data.

**Commas (as column/field separators) cannot be omitted**

For example, this is valid:

```
Summary, Assignee, Reporter, Issue Type, Description, Priority
"Test issue", admin, admin, 1, ,
```

... but this is not valid:
Encapsulating JIRA data structure in your CSV file

Capturing data that spans multiple lines

Use double-quote marks (") in your CSV file to capture data that spans multiple lines. For example, upon import, JIRA will treat the following as a valid CSV file with a single record:

<table>
<thead>
<tr>
<th>Summary, Description, Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Login fails&quot;, &quot;This is on a new line&quot;, Open</td>
</tr>
</tbody>
</table>

Treating special characters literally

Use double-quote marks (") around a section of text to treat any special characters in that section literally. Once this data is imported into JIRA, these special characters will be stored as part of JIRA's field data. Examples of special characters include carriage returns/enter characters (as shown in the example above), commas, etc.

To treat a double quote mark literally, you can 'escape' them with another double quote mark character. Hence, the CSV value:

- "Clicking the "Add" button results in a page not found error"

once imported, will be stored in JIRA as:

- Clicking the "Add" button results in a page not found error

Aggregating multiple values into single JIRA fields

You can import multiple values into a JIRA field that accepts multiple values (e.g. Fix (for) Version, Affects Version, Component, Labels). To do this, your CSV file must specify the same column name for each value you wish to aggregate into the mapped JIRA field. The number of column names specified must match the maximum number of values to be aggregated into the mapped field. For example:

<table>
<thead>
<tr>
<th>IssueType, Summary, FixVersion, FixVersion, FixVersion, Component, Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>bug, &quot;First issue&quot;, v1, , Component1,</td>
</tr>
<tr>
<td>bug, &quot;Second issue&quot;, v2, , Component1, Component2</td>
</tr>
<tr>
<td>bug, &quot;Third issue&quot;, v1, v2, v3, Component1,</td>
</tr>
</tbody>
</table>

In the above example, the Component field of the second issue and the Fix Version field of the third issue will generate multiple values in appropriate JIRA fields upon import.

⚠️ Be aware that only a limited number of JIRA fields support multiple values. The CSV importer will not allow you to import aggregated data into JIRA fields which only support a single value.

Importing attachments

You can attach files to issues created from your CSV file. To do this, specify the URL of your attachment in an 'Attachments' column within your CSV file.
Assignee, Summary, Description, Attachment, Comment
Admin, "Issue demonstrating the CSV attachment import", "Please check the attached image below.", "https://jira-server:8080/secure/attachment/image-name.png", "01/01/2012 10:10;Admin; This comment works"
Admin, "CSV attachment import with timestamp, author and filename", "Please check the attached image below.", "01/01/2012 13:10;Admin;image.png;file://image-name.png", "01/01/2012 10:10;Admin; This comment works"

URLs for attachments support the HTTP and HTTPS protocols and can be any location that your JIRA server must be able to access. You can also use the FILE protocol to access files in the import/attachments subdirectory of your JIRA Home Directory.

Importing issues into multiple JIRA projects

You can import issues from your CSV file into different JIRA projects through a CSV file import. To do this:

- Your CSV file requires two additional columns whose headings should be named similarly to Project Name and Project Key.
- Ensure that every issue represented in your CSV file contains the appropriate name and key in these columns for the JIRA projects to which they will be imported.

The project name and key data is the minimum JIRA project data required for importing issues from a CSV file into specific JIRA projects.

```
IssueType, Summary, Project Name, Project Key
bug, "First issue", Sample, SAMP
bug, "Second issue", Sample, SAMP
task, "Third issue", Example, EXAM
```

In the example above, the first and second issues will be imported into the 'Sample' project (with project key 'SAMP') and the third issue will be imported into the 'Example' project (with project key 'EXAM'), assuming you match the 'Project Name' and 'Project Key' fields in your CSV file to the Project name and Project key JIRA fields, respectively during the CSV file import wizard.

Importing worklog entries

Your CSV file can contain worklog entries. For example:

```
Summary, Worklog
Only time spent (one hour), 3600
With a date and an author, 2012-02-10 12:30:10; wseliga; 120
With an additional comment, Testing took me 3 days; 2012-02-10 12:30:10; wseliga; 259200
```

To track time spent, you need to use seconds.

Importing multi select custom fields

Your CSV file can contain multiple entries for the one Multi Select Custom Field. For example:

```
Summary, Multi Select, Multi Select, Multi Select
Sample issue, Value 1, Value 2, Value 3
```

This will populate the Multi Select Custom Field with multiple values.

Importing cascading choice custom fields
You can import values to a cascading choice custom field using the following syntax:

```
Summary, My Cascading Custom Field
Example Summary, Parent Value -> Child Value
```

The '->' separator allows you to import the hierarchy.

**NOTE:** Currently JIRA does not support importing multi-level cascading select fields via CSV (JIRA-34202 - Allow CSV import to support Multi-Level Cascading Select fields [OPEN]).

### Running the CSV file import wizard

**Before you begin:** If your JIRA installation has existing data — Back up your existing JIRA data.

1. Select Issues > Import Issues from CSV to open the Bulk Create Setup page. (If you do not have the option Import issues from CSV, your JIRA Admin must update the JIRA Importers plugin to version 6.2.3 or above.)

2. On the Setup page, select your CSV Source File. Leave the Use an existing configuration file check box cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between column names in your CSV file's header row and fields in your JIRA installation.
   - If you select this option, you will be asked to specify an Existing Configuration File.
   - If you do not select this option, then at the end of the CSV file import wizard, JIRA will ask if you want create a configuration file which you can use for subsequent CSV imports.

3. Click the Next button to proceed to the Settings step of the CSV file import wizard. Complete the required fields.
   - If your CSV file uses a different separator character other than a comma, specify that character in the CSV Delimiter field. If the separator is a 'Tab', this can be entered using the format 't'.

4. Click the Next button to proceed to the Map fields step of the CSV file import wizard. Here, you can map the column headers of your CSV file to the fields in your selected JIRA project. If you want to select specific JIRA field values to map specific CSV values to, tick the check-box for Map field value.

   **Note:** You must map a CSV field to the JIRA summary field. This ensures the issues created have a summary.

5. Click the Next button to proceed to the Map values step of the CSV file import wizard. On this step of the import wizard you can select which specific CSV field values you want to map to which specific JIRA field value. For example, your issue types you may have a CSV field value of "Feature Request", which you may want to map to the JIRA issue type field value "New Feature".

   **Please Note:**
   - Any fields whose Map field value check boxes were selected in the previous step of the CSV file import wizard will be presented on this page.
   - Leave a field cleared or clear any content within it if you wish to import the value 'as is'.
   - If you are importing a username-based CSV field (e.g. Reporter or Assignee) and you do not select the Map field value check box for this field in the previous step of the CSV file import wizard, then the importer will automatically map imported usernames from the CSV file to (lowercase) JIRA usernames.

   **Regardless of whether or not you select the Map field value check box, JIRA will automatically create usernames based on the data in your CSV file if they have not already been defined in JIRA.**

6. Click the Begin Import button when you are ready to begin importing your CSV data into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.

7. If you're confident your import is correctly setup, click the Begin Import button. Your import will begin and once complete you will be informed of any errors. If you'd like to check your import first, click the Validate button and JIRA will validate your import and inform you of any expected errors or warnings. You can then go back and correct these before running your full import.

   **Note:**
   - If you experience problems with the import (or you are curious), click the download a detailed log link to reveal detailed information about the CSV file import process.
   - If you need to import another CSV file with the same (or similar) settings to what you used through
this procedure, click the **save the configuration** link to download a CSV configuration file, which you can use at the first step of the CSV file import wizard.

Congratulations, you have successfully imported your CSV data into JIRA! If you have any questions or encounter any problems, please contact [Atlassian support](https://www.atlassian.com/contact).

**Tips for importing CSV data into JIRA fields**

Below are some helpful tips when importing data from your CSV file into specific JIRA fields:

<table>
<thead>
<tr>
<th>JIRA Field</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>CSV data is imported on a per-project basis. You can either specify an existing JIRA project(s) as the target, or the importer will automatically create a new project(s) for you at time of import.</td>
</tr>
<tr>
<td>Summary</td>
<td>This is the only required field.</td>
</tr>
<tr>
<td>Component(s)</td>
<td>You can import issues with multiple components by entering each component in a separate column.</td>
</tr>
<tr>
<td>Affects Version(s)</td>
<td>You can import issues with multiple 'Affects Versions' by entering each version in a separate column.</td>
</tr>
<tr>
<td>Fix Version(s)</td>
<td>You can import issues with multiple 'Fix Versions' by entering each version in a separate column.</td>
</tr>
<tr>
<td>Comment Body</td>
<td>You can import issues with multiple comments by entering each comment in a separate column.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Please use the date format specified on the second step of the CSV import wizard.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>If not specified in your CSV file, imported issues will be given the default (i.e. first) Issue Type as specified in your JIRA system <a href="https://confluence.atlassian.com/jirahandbook/importing-issues-with-standard-data-into-jira-733568903.html">Defining 'Issue Type' Field Values</a>. You can also create new JIRA values on-the-fly during the import process.</td>
</tr>
<tr>
<td>Labels</td>
<td>You can import issues with multiple labels by entering each label in a separate column.</td>
</tr>
<tr>
<td>Priority</td>
<td>If not specified in your CSV file, imported issues will be given the default (i.e. first) Priority as specified in your JIRA system <a href="https://confluence.atlassian.com/jirahandbook/importing-issues-with-standard-data-into-jira-733568903.html">Defining 'Priority' Field Values</a>. You can also create new JIRA values on-the-fly during the import process.</td>
</tr>
<tr>
<td>Original Estimate</td>
<td>The value of this field needs to be specified as number of seconds.</td>
</tr>
<tr>
<td>Remaining Estimate</td>
<td>The value of this field needs to be specified as number of seconds.</td>
</tr>
<tr>
<td>Time Spent</td>
<td>The value of this field needs to be specified as number of seconds.</td>
</tr>
</tbody>
</table>
## Users

You can choose to have the importer automatically create JIRA users for any values of the Assignee or Reporter field.

- Users will be created as active accounts in JIRA. Users will need to get their passwords emailed to them the first time they log into JIRA.
- Users with no real name will get the portion of their email address (login name) before the "@" character as their Full Name in JIRA.
- If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before commencing the import.
- If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will be displayed showing a list of users that can't be created.
- If Assignee and Reporter are not mapped, then no usernames are created.

## Other fields

If you wish to import any other fields, you can choose to map them to specific JIRA custom field(s). If your custom fields don't yet exist in JIRA, the importer can automatically create them for you. If your custom field is a date field, please use the date format specified on the second step of the CSV import wizard.

### Editing an Issue

To edit a JIRA issue, you need the Edit Issue project permission for the issue's relevant project. If you do not have this permission, please contact your JIRA administrator.

#### To edit an existing JIRA issue:

1. Locate the issue you want to edit.
2. Click the Edit button (at the top-left of the 'view issue' page) to open the Edit Issue dialog box.
   - **Keyboard shortcut:** `e`
   
   Alternatively, hover your mouse over a field and click the pencil icon to edit it inline.
   - **Keyboard shortcut:** `;`, then enter the desired field name.
3. Modify your issue's details in the appropriate fields of the Edit Issue dialog box.
   - **Tip:** If you want to access fields which are not shown on this dialog box or you want to hide existing fields:
     a. Click the Configure Fields button.
     b. Click Custom and select the fields you want to show or hide by selecting or clearing the relevant check boxes, respectively, or click All to show all fields.
     
     When you next edit an issue for a given project, JIRA remembers your last choice of selected fields.
4. Click the Update button to save your changes.

**Tips:**

- You can mention other users in the Description or Comment field so that an email message will be sent to the user's email address (registered with their JIRA account) upon clicking the Update button. See Emailing an issue to users by mentioning them for details.
- In certain text fields for an issue, you can link to other issues, insert macros, insert images and more. For more information, see Editing Rich-Text Fields.

*Screenshot: Customizing the fields on the Edit Issue dialog*
Related topics

Linking Issues

Emailing an Issue

Editing Rich-Text Fields

When you create, edit or comment on a JIRA issue, some fields may display two small icons at the bottom of the text area; a blue screen (the Preview icon), and a question-mark (the Help icon), and a toolbar (the simple Wiki editor). The presence of these icons and toolbar indicates that this field supports JIRA's Text Formatting Notation, which allows you to use rich-text features such as:

- Italic, bold, underlined text.
- Multiple levels of headings.
- Bullets, numbered lists, tables and quotations.
- Images.
- Macros (see below).

You can click the Help icon to see a popup window containing the Text Formatting Notation Help, or you can choose to highlight the text you wish wish to format, and click the relevant button in the toolbar to apply the appropriate styling.

Using Macros

The JIRA Text Formatting Notation and macros will only be available if your JIRA administrator has configured the relevant renderers.
JIRA ships with the following macros:

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
<th>Enabled by default</th>
</tr>
</thead>
</table>
| Anchor Macro | Create an anchor that allows people to link to a specific point in a page. Usage:  
{anchor:bookmark1}  
... text here ...  
[#bookmark1]     | yes                                             |
| Code Macro   | Format blocks of source-code or XML. The default language is Java but you can specify JavaScript, ActionScript, XML, HTML and SQL too. Usage:  
--- Java example ---  
{code:title=Bar.java|borderStyle=solid}  
// Some comments here  
public String getFoo()  
{  
   return foo;  
}  
{code}  
*--- XML example ---*  
{code:xml}  
<test>  
   <another tag="attribute"/>  
</test>  
{code} | yes                                             |
| Quote Macro  | Generate blockquotes that may contain multiple paragraphs or complex markup. Usage:  
{quote}  
This is text from another source  
{quote} | yes                                             |
| No Format Macro | Create blocks of text where other wiki formatting is not applied. Usage:  
{noformat}  
This is text 
\#&@!@(!&@!)@\  
{macros} _wont_work_here  
{noformat} | yes                                             |
<table>
<thead>
<tr>
<th>Panel Macro</th>
<th>Draw a panel with the following optional parameters:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• title: Title of the panel</td>
</tr>
<tr>
<td></td>
<td>• borderStyle: The style of the border this panel uses (solid, dashed and other valid CSS border styles)</td>
</tr>
<tr>
<td></td>
<td>• borderColor: The color of the border this panel uses</td>
</tr>
<tr>
<td></td>
<td>• borderWidth: The width of the border this panel uses</td>
</tr>
<tr>
<td></td>
<td>• bgColor: The background color of this panel</td>
</tr>
<tr>
<td></td>
<td>• titleBGColor: The background color of the title section of this panel</td>
</tr>
</tbody>
</table>

```html
{panel}
Some text
{panel}
{panel:title=My Title}Some text with a title{panel}
{panel:title=My Title| borderStyle=dashed| borderColor=#ccc| titleBGColor=#F7D6C1| bgColor=#FFFFCE}
a block of text surrounded with a *panel*
yet _another_ line
{panel}
```

<table>
<thead>
<tr>
<th>Color Macro</th>
<th>Change the color of the contained text. Usage:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>{color:red}look ma, red text!{color}</td>
</tr>
</tbody>
</table>

You can use any of the sixteen standard HTML colors ('aqua','black','blue','fuschia','green','gray','lime', 'maroon','navy','olive','purple','red','silver','teal','white','yellow'), or any hexadecimal color code (e.g. '#336699').

<table>
<thead>
<tr>
<th>Lorem Ipsum Macro</th>
<th>Insert paragraphs of &quot;lorem ipsum&quot; space-filler text. Usage:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>{loremipsum}</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HTML Macro</th>
<th>Use HTML code within a Jira Issue. Usage:</th>
</tr>
</thead>
</table>
|           | {html}
<p>You'll find a lot more in <A href="chapter2.html">chapter two</a>.
See also this <a href="../images/forest.gif">map of the enchanted forest.</A></p>{html} |

**Emailing an Issue**

You can email other JIRA users a link to an issue either by **sharing** the issue with them or by **mentioning** them in an issue's **Description** or **Comment** field.

You can also email an issue any email address — not only just JIRA users — using the **Share** option. This is useful on JIRA sites where projects can be accessed anonymously.
Sharing an issue

To email other JIRA users a link to an issue, use the Share option. This feature also allows you to add an optional note to the email message.

To share an issue with one or more JIRA users or any email addresses:

1. View the issue you want to share.
2. Click the Share button at the top-right.  
   Keyboard shortcut: s
3. Specify JIRA users (by typing their usernames or part/all of their full names as registered with their JIRA user accounts) or type any email addresses of individuals you wish to share the issue with.  
   When you begin typing a JIRA user's username or name, or a previously specified email address, an autocomplete dropdown list of users appears.

4. Add an optional Note.  
5. Click the Share button at the bottom of the displayed window.

Note:
- Any specified recipients will receive an email message whose body contains the content of the Note (if one was included) as well as a link to the issue.
- A shared issue sent to JIRA users specified in the User name or email field will be sent to the email addresses registered with these user's respective JIRA accounts.
- The subject line of the email message will specify you as the JIRA user who 'shared' the issue with the recipients.
- You can also share a search result. For details, see Sharing a Search Result.

Emailing an issue to users by mentioning them

When creating, editing or commenting on an issue, you can easily email other JIRA users a link to the issue by mentioning these users in the issue's Description or Comment field.

To mention a user on an issue:

1. Create, edit or comment on an issue.  
2. In the issue's Description or the Comment field, type '@' and then the first few characters of the JIRA user's username or part or all of their full name (registered with their JIRA user account).  
   As you start typing, a list of suggested users will appear in a dropdown list below the field (if you have the Browse Users global permission).  
3. Complete typing the JIRA user's username or choose from the list of suggested users in the dropdown list.  
   When you submit the field, JIRA will send that user an email message indicating that you mentioned them on that issue.
Notes:

- Upon submitting your Description or Comment field that mentions one or more JIRA users, an email message will be sent to the email addresses registered with these user’s respective JIRA accounts.
- If either the Description or Comment field does not use the Wiki Style Renderer, you can still mention users (who will receive email notifications) but once the field is submitted, the users’ usernames will not be converted to links leading to their profile pages. Instead, any mentioned users will appear ‘literally’ in wiki markup style, i.e. [username].
- JIRA will only send an email message to JIRA users upon each unique mention. Hence, if you edit an issue’s Description or Comment and do not mention a user a second time, that user will not receive a notification once the field is submitted.
- When you mention users, they will not be automatically added to the watcher list. If you mention users who are already watchers of the issue, they receive one email notification only when you save the edits that have their names mentioned.
- If an username is changed, existing mentions will continue to show the older username. One reason for this is because mentions are used mostly in the short-term, to get a user’s attention at the time the mention is made.

Related topics

- Watching and Voting on an Issue
- Sharing a Search Result
- Labeling an Issue

Labeling allows you to categorize an issue(s) in a more informal way than assigning it to a version or component. You can then search for issues that have been given a particular label.

When viewing an issue, the issue's labels appear in the 'Details' section:

**Screenshot: the 'Details' section within an issue**

You can click a label (e.g. 'doc' in the above screenshot) to jump to the Issue Navigator and see a list of all issues that have this label. You can also:

- search for issues that have been given a particular label (use the 'Labels' field in a Simple Search or an Advanced Search), and create saved filters.
- add the Labels Gadget to your dashboard, and/or use the 'Labels' field with any field-focused gadget (e.g. Heat Map, Issue Statistics, Filter Results, 2D Filter Statistics).

If your JIRA administrator has added any custom fields of type 'Label', they will be shown below the 'Labels' field.

**Related topics:*

- Adding the Labels Gadget

Adding and removing labels for an issue

1. View the issue you wish to label.
3. Keyboard shortcut: I
3. Add or remove the desired label(s) and click **Update**.  
   **Note:** You can add multiple labels by typing them separated by spaces.

**Linking Issues**

**Issue linking** allows you to create an association between two existing issues on either the same or different JIRA servers. For example:

- An issue may *relate to* another.
- An issue may *duplicate* another.
- An issue may *block* another.

(Your JIRA administrator can customize the types of links that you can create.)

**Issue linking** also allows you to:

- Create an association between a JIRA issue and a Confluence page.
- Link a JIRA issue to any other web page.

**On this page:**

- Creating a link to another issue on the same JIRA site
- Creating a link to an issue on another JIRA site
- Creating a link to a Confluence page
- Creating a link to any web page URL
- Deleting a link
- Searching for linked issues

Issue links within an issue look like this:

**Screenshot: the 'Issue Links' section within an issue**
Creating a link to another issue on the same JIRA site

To create a link to another issue on the same JIRA site:

1. Open the issue you wish to link to another issue in the same JIRA site.
2. Select More > Link to display the Link dialog box.
   - Keyboard Shortcut: '.+' start typing link
3. Ensure that the JIRA Issue item is selected at the left of the dialog box and then choose the type of link to be created from the This issue dropdown list.
   - If your JIRA system administrator has configured fully reciprocal application links between your JIRA site and another one, a Server dropdown list may appear above the This issue list. If this is the case, ensure your JIRA site appears or has been selected from the Server list.
4. In the Issues field, specify the issue(s) to be linked to your currently viewed/selected issue. There are two ways to do this:
   - Type the full issue key (e.g. ABC-123) — or to link to multiple issues, press the ‘Enter’ key between each typed issue key.
   - If you have previously browsed an issue, you can quickly find the issue by typing the first few letters of the issue key (or part of the Summary), which will appear in an ‘autocomplete’ drop-down list for selection:
   - OR:
   - Click the search for an issue link to use the Find JIRA issues popup, which allows you to perform either a simple text search or an advanced search for issues.
5. Optional: Add a Comment to describe why you are linking these issues.
6. Click the Link button at the bottom of the dialog.

Creating a link to an issue on another JIRA site

To create this type of link, your JIRA system administrator should have configured fully reciprocal application links.
**links** between your JIRA site and the other JIRA site containing the issue(s) you want to link to.

This feature is **not available in Atlassian Cloud.**

### To create a link to an issue on another JIRA site:

1. Open the issue you wish to link to another issue.
2. Select More > Link to display the Link dialog box.
   - **Keyboard Shortcut:** `.' + start typing **link**
3. Ensure that the **JIRA Issue** item is selected at the left of the dialog box.
   - **Note:**
     - This option will not be available if your JIRA system administrator has not configured an application link between your JIRA site and the remote JIRA site.
     - If, after selecting this option, you are prompted for authorisation, you may be required to log in to the remote JIRA site, which will allow your JIRA site to access the remote JIRA site *on behalf of your account on the remote JIRA site.***
   - **Note:** This behavior means the application links configured between your JIRA site and the remote JIRA site use OAuth authentication.
4. If your JIRA site is connected to multiple remote JIRA sites, choose the relevant JIRA site from the **Serve** dropdown list.
5. Choose the type of link to be created from the **This issue** dropdown list.
6. Type the **Issue** key of the issue on the remote JIRA site that you want to link to. Alternatively, you can search for issues on the remote JIRA site by clicking the search for an issue link, which opens the Find JIRA issues popup.
   - **Note:** You can link to any issue on the remote JIRA site to which you have access on that site.
7. Select the Create reciprocal link check box to create the complementary link on the remote issue you are linking to, back to your issue. For example, if you create a blocks link type to a remote issue, the reciprocal link generated on the remote issue will be a is blocked by link type back to your local issue.
8. Optional: Add a Comment to describe why you are linking these issues.
9. Click the Link button at the bottom of the dialog.

### Troubleshooting

**Problem:** If you selected the Create reciprocal link check box but after clicking the Link button, discover that a reciprocal link from the remote JIRA issue back to your JIRA issue has not been created, then your JIRA system administrator has most likely created only a one-way link from your JIRA site to the remote JIRA site.

**Solution:** Ask your JIRA system administrator to configure fully reciprocal application links between your JIRA site and the remote JIRA site.

**Problem:** If you attempted to create a reciprocal link but received the following message:

*A reciprocal link from issue ‘XYZ-123’ back to this issue was not created as the remote JIRA server returned the following error: No Link Issue Permission for issue ‘XYZ-123’.‘ (where ‘XYZ-123’ is the issue key on the remote JIRA site),

then a reciprocal link on the remote JIRA site will not have been created, because the user account through which you authenticated on the remote JIRA site (at step 3 above) does not have the Link Issues project permission.

**Solution:**

- Ask the JIRA project administrator(s) on the remote JIRA site to grant your user account the Link Issues project permission for the relevant project(s) to which you need to create issue links.
- Alternatively, if the application link between your JIRA site and the remote JIRA site use OAuth authentication and you suspect you may have authenticated on the remote site with another user account that does not have the Link Issues project permission, repeat the procedure above but during the authorisation step (at step 3), authenticate on the remote site with a user account which has this permission.
- If you are not prompted for authentication during authorisation, try clearing your browser's cookies first and repeat the procedure again.

### Creating a link to a Confluence page

This feature is **only supported in Confluence versions 4.0 or later.**

---

*Created in 2015 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).*
To create this type of link, your JIRA system administrator needs to have configured an application link between your JIRA site and the Confluence site containing the pages you want to link to.

To create a link to a Confluence page:

1. Open the issue you wish to link to another issue.
2. Select More > Link to display the Link dialog box.
   - Keyboard Shortcut: '.' + start typing link
3. Click the Confluence Page option at the left of the dialog box.
   - This option is not available if your JIRA system administrator has not configured an application link between your JIRA site and the Confluence site.
4. If more than one application link has been configured between your JIRA site and other Confluence sites, then choose the appropriate Confluence site from the Server dropdown list.
5. Specify the Confluence page to be linked to your currently viewed issue. There are two ways to do this:
   - In the Page URL field, enter the URL of a page on the Confluence site you want to link to. For example:
     - http://<confluence-server>/display/ds/Welcome+to+the+Confluence+Demonstration+Space
   - Click the search for a page link. The Link dialog box is replaced by the Find a Confluence page dialog box.
     - If you are prompted for authorisation, you may be required to log in to the Confluence site, which will allow your JIRA site to access the Confluence site on behalf of your account on the Confluence site.
     - This behavior means the application links configured between your JIRA site and the remote Confluence site use OAuth authentication.
       - In the first Search field, specify one or more search terms that appear in the page you want to link to. This field is mandatory.
       - Optional: In the second Search field, select the Confluence space to further narrow down the search.
       - Click the Search button and then the title of the page you want to link to.
6. Optional: Add a Comment to describe why you are linking these issues.
7. Click the Link button at the bottom of the dialog.

Troubleshooting

**Problem:** If Confluence page links you create show Failed to load on the JIRA issue or if you attempted to search for a Confluence page but received the following message:

'Content on the Confluence site could not be accessed because the Confluence server’s 'Remote API' feature is disabled. The Confluence system administrator must enable this 'Remote API' feature for JIRA to successfully access this content.'

then JIRA was unable to communicate with the Confluence server to either:

- retrieve information about the link or
- conduct a Confluence page search in the Find a Confluence page dialog box.

**Solution:**

Ask the Confluence system administrator to enable the Remote API (XML-RPC & SOAP) feature, since this Confluence feature is disabled by default. See Enabling the Remote API in the Confluence documentation for details.

Creating a link to any web page URL

To create a link to any web page URL:

1. Open the issue you wish to link to another issue.
2. Select More > Link to display the Link dialog box.
   - Keyboard Shortcut: '.' + start typing link
3. Click the **Web Link** option at the left of the dialog box.
4. Specify the **URL** of the web page you want to link to.
5. Specify the **Link Text** that will appear in the **Issue Links** section of the 'view issue' page and will be hyperlinked to your URL.
6. Optional: Add a **Comment** to describe why you are linking these issues.
7. Click the **Link** button at the bottom of the dialog.

**Deleting a link**

**To delete a link:**

1. Go to an issue that contains links, and locate the **Issue Links** section (see screenshot above).
2. Hover your mouse over the link you wish to delete, and click the **Delete** (trashcan) icon that appears.

**Searching for linked issues**

You can search for issues that are linked to a particular issue. For details, please see the documentation on **Advanced Searching**.

Be aware that this functionality does not extend to issues on a remote JIRA server.

**Logging Work on an Issue**

**On this page:**

- About time tracking
- Specifying time estimates
- Logging work on an issue
  - Logging work when viewing an issue
  - Logging work while resolving or closing an issue
- Editing a work log entry
- Deleting a work log entry
- Customized JIRA installations
  - Logging work and/or specifying time estimates on the same JIRA screen
- See also

**About time tracking**

You can only specify time estimates and log work on an issue if your JIRA administrator has granted you the **Work On Issues** permission in the project to which the issue belongs. **Note:** Anyone with the **Browse Project** permission can view an issue's time tracking information.

If an issue (or its sub-tasks) has had work logged and/or an **Original Estimate** value specified, three coloured bars will be displayed representing the following amounts of time:

- **Original Estimate** (blue) — the amount of time originally anticipated to resolve the issue. (This is indicated as **Estimated** when viewing an issue.)
- **Remaining Estimate** (orange) — the remaining amount of time currently anticipated to resolve the issue. (This is indicated as **Remaining** when viewing an issue.)
- **Time Spent** (green) — the amount of time logged working on the issue so far. (This is indicated as **Logged** when viewing an issue.)

**Screenshot: the Time Tracking section of an issue**
If your issue has one or more sub-tasks, then:

- To see aggregated times for your issue plus all of its sub-tasks, ensure that the Include sub-tasks check box is selected.
- To see times for just your issue only, ensure that the Include sub-tasks check box is cleared.

When you log work on an issue (see below), you:

1. Log the time you have spent, in weeks/days/hours/minutes (you can use fractions if you wish, e.g. `5.5h`).
   - This time will be added to the issue's total Time Spent.
2. Enter a description of the work you have done.
3. Adjust the Remaining Estimate value (i.e. the remaining amount of time you think the issue will take to resolve).

The work logged on an issue is shown in the Log Work dialog, shown below:
Additionally, once work has been logged on an issue, various reports based on the time-tracking information become available.

Specifying time estimates

Prior to logging work on an issue, you may want to specify an Original Estimate for an issue (i.e. the total amount of time you think it will take to resolve the issue).

When work is first logged against the issue, the Time Spent is subtracted from the Original Estimate and the resulting value is automatically presented in the Remaining Estimate. When subsequent work is logged, any Time Spent is subtracted away from the Remaining Estimate.

Throughout the lifecycle of an issue, however, you can modify the Original Estimate and/or Remaining Estimate values manually if you wish. To do this:

1. Navigate to an existing issue, view it and click the Edit button at the top of the screen to edit that issue. OR
   Create a new issue by clicking Create Issue at the top of the screen and complete the required field details.
2. Edit the following Time Tracking fields:
   • Original Estimate — the amount of time you originally believe is required to resolve the issue. Typically, this is specified when creating an issue or before work is first logged against an issue.
   • Remaining Estimate — the amount of time you believe is required to resolve the issue in its current state.

   You may see only one of these fields if JIRA's Time Tracking feature is running in Legacy Mode.

   If JIRA's Time Tracking feature is in Legacy Mode and work has not yet been logged on the issue, you will see the Original Estimate field. However, once work has been logged, you will only see the Remaining Estimate field.

3. Enter or modify your time tracking details in the Original Estimate and/or Remaining Estimate fields. Use 'w', 'd', 'h' and 'm' to specify weeks, days, hours or minutes. For example, to specify 'six hours', type '6h'.
If both of these fields are available and are mandatory (indicated by red asterisks), you can just enter one value and leave the other value blank. When you submit the form, the field with a value will be copied to the field that was left blank.

4. Click **Update** at the bottom of the screen.

If you cannot change **Original Estimate** values on issues after work has been logged on them but you wish to do so, request that your JIRA administrator **disables Legacy Mode** on Time Tracking.

If your JIRA administrator has added the ability to specify/modify time estimates on other workflow transition screens in JIRA’s **default workflow** (or a d workflow), you will be able to specify/modify time estimates during those workflow transitions too. Additionally, if your JIRA administrator has added this ability to **JIRA screens** used by other issue types, you can also specify time estimates when creating or editing these types of issues.

---

**Logging work on an issue**

**Logging work when viewing an issue**

To log work when viewing an issue:

1. Navigate to the issue and view its details.
2. Select **More > Log Work**.
3. The **Log Work** dialog box is displayed.

*The Log Work Dialog Box*
4. In the **Time Spent** field, enter the amount of time to be logged. Use 'w', 'd', 'h' and 'm' to specify weeks, days, hours or minutes. For example, to log two hours of work, type '2h'.

If you type a number without specifying a time unit (e.g. if you type '2' instead of '2h'), the **default time unit** as specified by your JIRA administrator will apply.

5. In the **Date Started** field, click the calendar icon to select the date/time when you started work. The calendar popup will be displayed, where you can:
   - use the month scroll back ('<') or forward ('>') icons to choose a different month.
   - use the year scroll back ('<<') or forward ('>>') icons to choose a different year.
     If you click and hold one of these scroll icons, a dropdown menu appears, allowing you to select a month or year from the list of options provided.
   - click the hour to increase it (or <Shift> click to decrease it).
   - click the minute to increase it (or <Shift> click to decrease it).
   - click 'am' / 'pm' to toggle between them.

6. The **Remaining Estimate** field affects the value of the issue's **Remaining Estimate** value. Select one of the following:
   - **'Adjust Automatically'** — Select this if you want to automatically subtract your **Time Spent** from the issue's current Remaining Estimate value.
   - **'Leave Estimate Unset'** — Select this if you do not want to specify any time estimates for the issue.
     This option is only displayed if no time estimates have been specified.
   - **'Use existing estimate of ...'** — Select this if you do not want to change the issue's Remaining Estimate value.
This option is displayed if a time estimate has been specified.

- **'Set to ...'** — Select this if you want to manually set the issue’s Remaining Estimate value to the amount specified. If you select this option, enter your new estimate into the blank field below. Use 'w', 'd', 'h' and 'm' to specify weeks, days, hours or minutes. For example, to specify 'thirty minutes', type '30m'.
- **'Reduce by ...'** — Select this if you want to manually reduce the issue's Remaining Estimate value by the amount specified. If you select this option, enter your new estimate into the blank field below. Use 'w', 'd', 'h' and 'm' to specify weeks, days, hours or minutes. For example, to specify 'thirty minutes', type '30m'.

7. In the **Work Description** field, type a description or comment about the work you have done.
8. Click the padlock icon to either set this work log to be viewable only by members of a particular project role or group; or you can allow all users to view it.
   - For users to view a work log, they must have the **Browse Project** permission to view the issue and be a member of the project role or group selected in this step.
9. Click **Log** at the bottom of the dialog to submit the form and close this window.
   - the Time Spent that you just entered has been added to the issue’s total Time Spent field.
   - the Remaining Estimate value that you just entered (or chose) matches the issue’s Remaining Estimate field.

### Logging work while resolving or closing an issue

In addition to logging work when viewing an issue, you can also log work when resolving or closing an issue.

To log work on an issue while resolving or closing the issue:

1. Navigate to the issue and view its details.
2. Select either **Workflow > Resolve Issue** or **Workflow > Close Issue**.
3. Edit the Log Work fields as described under the Logging work when viewing an issue section above.

   By default, JIRA should automatically copy the contents of your Comments to the Workflow Description. In doing so, the work log will be visible to members of the project role or group selected in the padlock icon dropdown.

   If this is not happening and you would like comments to be copied to workflow descriptions, request that your JIRA administrator enables JIRA's **Copy Comments to Workflow Descriptions** setting.

   If this setting is disabled:
   - The work log entry may be visible to anyone. If this is a concern, you need to edit this work log entry after creating it to modify its visibility.
   - Copying comments to workflow descriptions must be done manually after logging work.

4. Click **Resolve** (or the appropriately named button for your workflow transition or action) to return to the issue and verify that:
   - The Time Spent that you just entered has been added to the issue's total Time Spent field.
   - The Remaining Estimate value that you just entered (or chose) matches the issue's Remaining Estimate field.

   If your JIRA administrator has added the ability to log work on other workflow transition screens in JIRA's default workflow (or a different workflow), you will be able to log work during those workflow transitions too. Additionally, if your JIRA administrator has if your JIRA administrator has added this ability to JIRA screens used by other issue types, you can log work when creating or editing these types of issues.

### Editing a work log entry

1. Navigate to the issue and view its details.
2. Locate the **Activity** section and select the **Work Log** tab.
3. Locate the work log entry you wish to edit.
4. Click the **Edit** (pencil) icon, located at the right of the work log entry.
5. The **Edit Work Log** screen is displayed. Edit the fields as described under the Logging work when
viewing an issue section above.

Be aware that when you are editing a work log entry, you cannot specify an amount of time by which to reduce the Remaining Estimate. Hence, the 'Reduce By...' field is not available on the Edit Work Log screen.

6. Click Log to return to the issue, and verify that:
   - the word edited is displayed to indicate that the work log entry has been edited. You can hover over this word to see who edited the work log and when this was edited.
   - the issue's total Time Spent field has been adjusted as per the Time Spent that you just edited.
   - the issue's Remaining Estimate value field has been adjusted as per the Remaining Estimate value that you just edited.

You can edit your own work log entries if you have been granted the Edit Own Work Logs permission. You can edit other people's work log entries if you have been granted the Edit All Work Logs permission.

Deleting a work log entry

1. Navigate to the issue and view its details.
2. Locate the Activity section and select the Work Log tab.
3. Locate the work log entry you wish to delete.
4. Click the Delete icon, located at the right of the work log entry.
5. The Delete Worklog screen is displayed. The Adjust Estimate field affects the value of the issue's Remaining Estimate. Select one of the following:
   - 'Auto Adjust' — Select this if you want to automatically add the work log entry's Time Spent value back to the issue's current Remaining Estimate value.
   - 'Leave existing estimate of ...' — Select this if do not want to change the issue's Remaining Estimate value.
   - 'Set estimated time remaining to ...' — Select this if you want to manually set the issue's Remaining Estimate value to the amount specified. If you select this option, enter your new estimate into the blank field below. Use 'w', 'd', 'h' and 'm' to specify weeks, days, hours or minutes. For example, to specify 'thirty minutes', type '30m'.
   - 'Increase estimated time remaining by ...' — Select this if you want to ...
6. Click Delete to confirm the deletion and return to the issue. Verify that:
   - the issue's Work Log tab no longer displays the work log entry that you just deleted.
   - the issue's History tab displays the Worklog Id (but not the description) of the deleted work log entry.
   - the issue's Time Spent field has been decreased by the value of the deleted work log entry's Time Spent.
   - the issue's Remaining Estimate field has been adjusted according to your choice in Step 5 (above).

You can delete your own work log entries if you have been granted the Delete Own Work Logs permission. You can delete other people's work log entries if you have been granted the Delete All Work Logs permission.

Customized JIRA installations

Logging work and/or specifying time estimates on the same JIRA screen

As described above, you can log work when viewing, resolving or closing an issue or specify time estimates when creating or editing an issue.

However, JIRA can be customized to allow work logging and specifying time estimates on the same JIRA screen when performing any JIRA operation, such as editing or creating an issue, or transitioning an issue to another status. To do this, your JIRA administrator must add both the Log Work and Time Tracking fields to the appropriate screen used by that operation.

To log work and/or specify time estimates on the same JIRA screen:
1. Navigate to the issue and view its details.
2. Perform the customized JIRA operation that allows you to log work and specify time estimates on the same JIRA screen. For example, assuming that your JIRA administrator has added the Time Tracking fields to the Resolve Issue Screen (and assuming this screen also retains the default Log Work fields), select Workflow > Resolve Issue at the top of the issue.
3. If logging work is optional (because your JIRA administrator has configured the Log Work fields as optional), then you can choose whether or not to log work during your JIRA operation, using the Log Work check box.
   - If you select the Log Work check box, the Log Work fields become available and the Remaining Estimate field changes to the Remaining Estimate options for logging work.
   - If the Log Work fields are mandatory (because your JIRA administrator has configured them so), then the Log Work check box will not be available and you must log work during the workflow transition.

   For more information about how to modify these fields, please refer to the Logging work when viewing an issue section above.

   If you are not creating an issue or Sub-Task or not explicitly using the Log Work action (above), only the Comment field (not the Work Description field) will be available for entering a description of the work activity logged.

   By default, JIRA should automatically copy the contents of your Comment to the Workflow Description. In doing so, the work log will be visible to members of the project role or group selected in the padlock icon dropdown.

   If this is not happening and you would like comments to be copied to workflow descriptions, request that your JIRA administrator enables JIRA’s Copy Comments to Workflow Descriptions setting.

   If this setting is disabled:
   - The work log entry may be visible to anyone. If this is a concern, you need to edit this work log entry after creating it to modify its visibility.
   - Copying comments to workflow descriptions must be done manually after logging work.

See also
- Workload Pie Chart Report
- User Workload Report
- Version Workload Report
- Time Tracking Report

Modifying Multiple (Bulk) Issues

Bulk Operations enable operations to be performed on multiple issues at once. These operations are performed on the result set of a search. The following list details the available bulk operations:

- **Workflow Transition**
  Lets you transition multiple issues through a workflow at once — e.g. resolve a collection of issues.
- **Delete**
  Lets you delete multiple issues at once.
- **Move**
  Lets you move multiple issues between projects and/or issue types. Please see the Bulk Move section for further details.
- **Edit**
  Lets you edit multiple fields in multiple issues at once. Please see the Bulk Edit section for further details.
- **Watch / Stop Watching**
  Lets you start or stop watching multiple issues.
About the 'Bulk Change' Global Permission

In order to execute a bulk operation, you will need to be granted the appropriate project-specific permission and the global Bulk Change permission by your JIRA administrator. For example, you would need to be granted both the Move Issue and Bulk Change permissions in order to execute the Bulk Move operation.

The project-specific permissions are still respected for the collection of issues selected for the bulk operation.

Disabling Mail Notification for Bulk Operations

To disable mail notification for a particular bulk operation, deselect the Send Notification checkbox in the bulk operation wizard. In order for this option to be available, you must be an administrator or project administrator of all the associated projects on whose issues the bulk operation is being performed.

Performing a Bulk Operation

1. Perform a search with the required filters to produce an issue result set.
2. Select Tools > Bulk Change.
3. The next screen allows the selection of the issues on which to perform the bulk operation.
4. The next screen allows the bulk operation to be selected, see the table below for the operation you are performing.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>The final step is confirmation of the delete operation on the selected issues.</td>
</tr>
<tr>
<td>Edit</td>
<td>The next screen provides a list of the available edit operations that can be performed on the issues selected. After selecting the required Edit operation(s), the final step is confirmation of the edit operation(s) on the selected issues.</td>
</tr>
<tr>
<td>Move</td>
<td>The next screens allow a target project and issue type to be selected, with the ability to migrate workflow statuses and update required fields as necessary. Further details can be found in the Bulk Move section.</td>
</tr>
<tr>
<td>Workflow Transition</td>
<td>The next screen shows the available workflow transitions that can be performed on the issues. The transitions are grouped by workflow — along with a list of the affected issues for each workflow transition. Once an operation is selected, the appropriate field screen for that operation is displayed — allowing any necessary field edits that are required to complete the transition. It should be noted that only those issues associated with the selected transition will be updated. It is only possible to select one transition per bulk workflow transition operation.</td>
</tr>
<tr>
<td>Watch</td>
<td>The final step is a confirmation of the watch operation on the selected issues.</td>
</tr>
<tr>
<td>Stop Watching</td>
<td>The final step is a confirmation of the unwatch operation on the selected issues.</td>
</tr>
</tbody>
</table>

Bulk Operation Screens
See the images below for examples of the Bulk Operation workflow.

**Step One**

**Step Two**

**Step Three**

**Step Four**
Bulk Move

The **Bulk Move** operation allows multiple issues to be moved at once. It is possible to move a selection of issues to a new project, with the ability to select a new issue type in certain cases.

The operation is completed as follows:

1. Select Projects and/or Issue Types
2. Select Projects and/or Issue Types for Sub-Tasks
3. Select status migration mappings for invalid statuses
4. Select values for required fields and fields with invalid values
5. Confirm changes to be made and complete the operation
   Note that steps 3 and 4 will occur once for each different target project and issue type combination.

Select Issues

The bulk move operation can be performed on both standard issues and sub-task issues. Standard issues can be moved to another project and issue type, whereas a sub-task can only have its issue type changed. (Note that it is possible to convert a sub-task to an issue, and vice versa.)

It is not possible to select both a sub-task and its parent to bulk move. This is so as to adhere to the parent/sub-task relationship (i.e. the sub-task is always located in the same project as the parent issue). Any sub-tasks of selected parent issues which were also selected will be automatically discarded from the move.

For example, you have issue B being a sub-task of issue A and you try to bulk move both A and B simultaneously. You will see a warning message (see below) and will be prompted to select a target project and issue type for issue A. If you select a new project for A, you will be prompted to move the sub-task to a new issue type based on issue A's new project. If you don't change the project for issue A, the sub-task will not be required to be moved.

Select Projects and Issue Types

The first step of the Bulk Move wizard is to choose which projects and issue types you will move your issues to. The target project and issue type will determine whether extra steps will be required to migrate statuses and fields.

Selected issues are grouped by their current project and issue type. You can either select a new project and issue type for each one or choose to move all standard issues to a single project and issue type.

   Note: This does not apply to sub-tasks since they cannot be moved to a standard issue type.

Select Projects and Issue Types for Sub-Tasks

If you are moving issues with sub-tasks to another project, you will also need to move the sub-tasks to the new project. You can also elect to change the issue types of the sub-tasks being moved if you need to.

Workflow Status Mapping

As multiple workflows can be active simultaneously, some statuses associated with the collection of selected issues may not be valid in the target workflow. In this case, JIRA allows you to specify a mapping from invalid statuses to those available in the target workflow.

Field Updates

In order to adhere to the field configuration scheme associated with the target project and issue type, it may be necessary to update/populate required fields (e.g. fields that are required in the target project, but may not have been in the original project).

For each field that needs to be populated, you will be prompted to supply a value. This value will be applied to all issues that are being Bulk Moved together.

For the following fields, JIRA provides a list of possible values for you to select from:

- Component
- Affects Version
- Fix Version
- Custom fields of type 'Version-Picker'

Note that versions which have been archived in the target project cannot be selected as the target when performing a bulk move. If you need to move issues into an archived version, you will need to first unarchive the version in the target project.

Retain Original Values

It is possible to retain original field values that are valid in the target destination by checking the Retain check box associated with the field. For example, some issues may already include a valid custom field value — these values can be retained, while issues that require an update will adopt the value specified on the Field Update
reen.

- **Checked**: the original value is retained where possible¹. The field will not be updated with the specified new value.
- **Unchecked**: all fields will be updated with the specified new value.

Note that the 'Retain' checkbox is not available for the following fields, since an explicit mapping is required:

- Component
- Affects Version
- Fix Version
- Custom fields of type 'Version-Picker'

**Bulk Move Confirmation**

When all move parameters — e.g. target project, status mappings and field updates — have been specified for all issues, you will be presented with a confirmation screen displaying all changes that will be made to the issues being moved. The following details are displayed as applicable:

- **Issue Targets**: the target project and issue type
- **Workflow**: the target workflow and invalid status mappings
- **Updated Fields**: new values for fields that require updating
- **Removed Fields**: values to be removed in fields that are not valid in the target

The issues will only be moved once the **Confirm** button is clicked from the confirmation page. If the operation is exited anytime before this step, no changes will be made to the issues.

**Bulk Edit**

The **Bulk Edit** operations available depend on the issues selected and the nature of the field it changes.

**Available Operations**

The following table lists out the possible operations. Please note that **all** the conditions must be true for the corresponding operation to be available.

<table>
<thead>
<tr>
<th>Available Operations</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Affects Version/s</td>
<td>Selected issues belong to one project, and that project has version/s</td>
</tr>
<tr>
<td></td>
<td>This field is not hidden in any field configurations the selected issues belong to</td>
</tr>
<tr>
<td></td>
<td>Current user has 'edit issue' permission for all the selected issues</td>
</tr>
<tr>
<td>Change Assign To</td>
<td>This field is not hidden in any field configurations the selected issues belong to</td>
</tr>
<tr>
<td></td>
<td>Current user has 'assign issue' permission for all the selected issues</td>
</tr>
<tr>
<td>Change Comment</td>
<td>This field is not hidden in any field configurations the selected issues belong to</td>
</tr>
<tr>
<td></td>
<td>Current user has 'comment issue' permission for all the selected issues</td>
</tr>
<tr>
<td>Change Component/s</td>
<td>Selected issues belong to one project, and that project has component/s</td>
</tr>
<tr>
<td></td>
<td>This field is not hidden in any field configurations the selected issues belong to</td>
</tr>
<tr>
<td></td>
<td>Current user has 'edit issue' permission for all the selected issues</td>
</tr>
<tr>
<td>Change Due Date</td>
<td>This field is not hidden in any field configurations the selected issues belong to</td>
</tr>
<tr>
<td></td>
<td>Current user has 'edit issue' permission for all the selected issues</td>
</tr>
<tr>
<td></td>
<td>Current user has 'schedule issue' permission for all the selected issues</td>
</tr>
<tr>
<td>Change Fix For Version/s</td>
<td>Selected issues belong to one project, and that project has version/s</td>
</tr>
<tr>
<td></td>
<td>This field is not hidden in any field configurations the selected issues belong to</td>
</tr>
<tr>
<td></td>
<td>Current user has 'edit issue' permission for all the selected issues</td>
</tr>
<tr>
<td>Change Issue Type</td>
<td>Current user has 'edit issue' permission for all the selected issues</td>
</tr>
</tbody>
</table>
| Change Priority | • This field is not hidden in any field configurations the selected issues belong to  
  • Current user has ‘edit issue’ permission for all the selected issues |
| Change Reporter | • This field is not hidden in any field configurations the selected issues belong to  
  • Current user has ‘edit issue’ permission for all the selected issues  
  • Current user has ‘modify reporter’ permission for all the selected issues |
| Change Security Level | • This field is not hidden in any field configurations the selected issues belong to  
  • All the selected projects are assigned the same issue level security scheme  
  • Current user has ‘edit issue’ permission for all the selected issues  
  • Current user has ‘set issue security’ permission for all the selected issues |
| Change Custom Fields | The ‘Change Custom Fields’ operation is available only if:  
  • a global custom field exists OR  
  • an issue type custom field exists and the issues are all of this specific issue type OR  
  • a project custom field exists and the issues are all of the same project |
| Edit a Closed Issue | • Your workflow must allow editing of closed issues |
| Change Sprint | You need to specify the sprint ID, even if you are using JIRA Agile 6.3.9 (which has the new Sprint field) or later with JIRA.  
  • This operation only affects active and future sprints, i.e. closed/completed sprints are not included when bulk editing the Sprint field. |

**Unavailable Operations**

The fields listed in this section have no operations for bulk editing. This is because there is an alternative method or it is not logical to perform bulk edit on them.

The following system fields are unavailable for bulk editing:

- Attachments
- Summary
- Description
- Environment
- Project — Please use ‘Bulk Move’ to move issues between projects
- Resolution — Please use ‘Bulk Workflow Transitions’ to modify the resolution of issues
- Time Tracking fields — Original Estimate, Remaining Estimate, Time Spent

The following custom field types are unavailable for bulk editing:

- Import Id
- Read Only Text

**Troubleshooting**

- Restricted comments appear to be removed after moving issues. See this article: Restricted comments disappear after moving an issue to a new project.

**Moving an Issue**

JIRA allows you to easily move an issue from one project to another by using the Move Issue wizard.

Please note that you must have the appropriate project permissions to move an issue from one project to another, i.e.

- You must have the Move Issues permission for the project which has the issue that you want to move.
- You must have the Create Issues permission for the project that you wish to move your issue to.

If you do not have either of these permissions, please contact your JIRA administrator to have these added to your user profile.
Moving an Issue

The Move Issue wizard allows you to specify another project in your JIRA instance to move your selected issue to. As there may be significant differences in the configuration of your original project and target project, the Move Issue wizard allows you to change certain attributes of the issue. These include:

- **Issue Type** — If your issue is a custom issue type that does not exist in your target project, you must select a new issue type. You can also choose to arbitrarily change the issue type, if you wish.
- **Issue Status** — You may have set up custom issue statuses as part of a workflow. If you have assigned a custom status to your issue and it does not exist in your target project, you must select a new issue status for your issue. You cannot arbitrarily change the issue status, i.e. the option to change the issue status will only appear if you are required to change it.
- **Custom Fields** — If you have defined required custom fields for your issue, which do not exist in your target project, you must set values for them. You will only be prompted to change the enter values for required custom fields in the target project, that are missing values. If you wish to change the existing values for other fields on your issue, you can do this after the move is complete.

To move an issue:

1. View the issue that you wish to move.
2. Select More > Move.
3. The first page of the Move Issue wizard is displayed. Select the project that you wish to move your issue to, and if required/desired, change the issue type. Click Next to continue.

4. If you are required to change the status of your issue (see explanation above), the Select Status page appears. Select the new status for your issue and click Next to continue.
5. If you are required to specify the values for any required custom fields (see explanation above), the Update Fields page is displayed. Specify the desired values for each field, and click Next to continue.
6. The confirmation page will display with all of your changes. If you wish to revise any of your changes, you can click the appropriate step in the left-hand menu to return to that page of the wizard. Once you are happy with your changes, click Move to move the issue to the target project.
7. Your issue will be moved to the target project and displayed on screen. You can now edit the issue to make further changes, if you wish.

**Moving related issues**

- If your issue has sub-tasks, the 'Move Issue' wizard will also move the sub-tasks to the target project.
- If you are moving an epic, the 'Move Issue' wizard will not move the issues in the epic. The epic and the issues in the epic will still be linked to each other, but the issues in the epic will remain in the original project. You will need to move them separately.

**Troubleshooting**

- Restricted comments appear to be removed after moving the issue. See this article: Restricted comments disappear after moving an issue to a new project.

**Scheduling an Issue**

**Scheduling An Issue**
To schedule an issue, populate its **Due** date field. This can be done either when **creating an issue**, or at a later stage by editing the issue.

To enable Issue Scheduling, at least one group or project role must be given the **Schedule Issues permission** by your JIRA administrator. Only users with the Schedule Issues permission can populate the **Due** date field.

**Searching by Due Date**

You can used either **simple search** or **advanced search** to search for issues by their Due Date.

Using Simple Search

You can search for issues using the search form Issue Navigator (see **Searching for Issues**. There are two ways to search for issues based on the **Due** date field. The first way is using fixed date values, the second is using periods that are relative to the current date.

**Fixed Date Searches**

There are two text fields in the search form that allow searching based on the **Due** date field.

- To search for all issues that are due after a certain date, enter the date into the Due After text field. For example to find all issues that are due after 1st June 2010, enter 1-6-2010 into the Due After field. You can also use the Calendar popup to select a date by clicking the calendar icon to the right of the field.
- To search for issues that are due before a certain date, enter the date into the Due Before text field. For example, to find all issues that are due before 1st July 2010, enter 1-7-2010 into the Due Before field.

To search for issues that are due between two dates by populating both the Due After and the Due Before fields.

**Relative Period Search**

It is possible to perform a search that is relative to the time when it is run. For example, it is possible to do a search for issues that are due seven days from now. To do this, enter 7d into the Due Date To text field of the Issue Navigator. If the search is saved and run the next day, the issues that are due in seven days from the time that the search is run will be retrieved. Thus, this search will find all issues that are due within a week every time it is run.

The values that are entered into the Due Date From and Due Date To fields have to conform to a special syntax (described below). However, it is also possible to use the Due Date popup by clicking the icon to the right of the Due Date To text field to specify the search period.

**Due Date Popup**

Use the Due Date popup to do the following:

- To search for issues that are overdue at the time of the search select the first radio button and click **OK**.
- To search for issues that are overdue by more than a certain number of days, populate the text field in the second row, and click **OK**.
- To search for issues that are due in the next certain amount of days and are not overdue at the time of the search, populate the text field in the third row with the number of days, and choose **and not** from the select box in the third row. Select the third radio button and click **OK**.
- To search for issues that are due in the next certain amount of days and are overdue at the time of the search, populate the text field in the third row with the number of days, and choose **and** from the select box in the third row. Select the third radio button and click **OK**.
- The fourth row of the popup is used for arbitrary period searches. Use the **to** text field to specify the upper bound of the search, and the **from** text field to specify the lower bound of the search. A blank text field means no bound. Populating the text fields in the fourth row, actually has the same effect as populating the Due Date From and Due Date To text boxes. The syntax is described below.

**Relative Period Search Syntax**

The Due Date From and Due Date To fields use a special syntax to denote time period bounds. The syntax uses numbers and abbreviations that follow the numbers to represent what the numbers actually mean.
abbreviations are "w" for weeks, "d" for days, "h" for hours and "m" for minutes. For example, to specify 10 days in the future use "10d" or "1w and 3d". To specify a period bound in the past prefix the value with the "-" sign. For example to specify 2 days, 4 hours and 3 minutes ago, use "-2d 4h 3m".

Using Advanced Search

You can also use JIRA Query Language (JQL) to search for issues by Due Date — see Advanced Searching, and particularly the documentation on the Due field.

Setting Security on an Issue

Setting the Security Level on an issue restricts the access of that issue to only people who are a member of the chosen Security Level. If you are not a member of that Security Level then you cannot access that issue and it will not appear in any filters, queries or statistics.

The Security Level of an issue can be set either when the issue is being created or afterwards when the issue is being edited.

To be able to set the Security Level for an issue, your administratior must add you to the appropriate Issue Security Level, and also grant you the 'Set Issue Security' permission for the appropriate project(s).

Setting Security on an Issue

1. Create/edit the relevant issue.
2. In the Security Level dropdown field, select the desired security level for the issue.
   - You can only see the Security Levels you belong to.
3. Save the issue. It is now only accessible to members of the specified Security Level.

Note:

- A person can only set an issue to a Security Level of which they are a member. This prevents the issue from being set to a Security Level of which nobody is a member and effectively becoming 'lost'.
- If the person does not have the Set Issue Security permission then the default Security Level is used. This may mean that the issue created is not visible to the person that created it. (Issue Level Security should be configured by your administrator such that this does not happen.)

Viewing an Issue's Change History

An issue's change history is a record of changes made to an issue, including:

- creator of the issue (this may be the same as the reporter, but can be distinct)
- changes to an issue field
- attachment of a file
- deletion of a comment
- deletion of a worklog
- creation or deletion of an issue link

For each change, the following is recorded:

- the person who made the change
- the time at which the change was made
- if an issue field was changed, the new and old values of the field

To view an issue's change history,

1. Open the relevant issue in JIRA.
2. Open the History tab in the Activity section.
3. The list of changes to the issue will display, similar to the screen shot below.

Screen shot: An Issue's History
Watching and Voting on an Issue

JIRA allows you to vote for a particular issue — "voicing" your preference for that issue to be resolved or completed.

JIRA also allows you to watch a particular issue, signing up for notifications of any updates relating to that issue (provided an appropriate notification scheme has been set up for the project by your JIRA administrator).

If you have the correct permissions (see below), you can also view the voter and watcher lists for an issue and, you can manage the watcher list — that is, add other people to the watcher list. This is useful if you need to draw someone’s attention to a particular issue.

### On this page:
- Issue voting
- Issue watching
- Permissions
  - Mandatory project permissions
  - Optional global permissions

The voter and watcher lists are shown in at the right of the screen when viewing an issue:

### Issue voting

**To vote for an issue:**

1. Search for or view the issue you want to vote on and access its 'view issue' page.
2. Click **Vote for this issue** to instantly vote for the issue.
   - At any subsequent time when logged in, click this again to remove your vote.
To view a list of people who have already voted on an issue:

1. Search for or view the issue you want to vote on and access its 'view issue' page.
2. Click the number of votes to view the list of people who have voted for the issue.

Issue watching

To watch an issue:

1. Search for or view the issue you want to watch and access its 'view issue' page.
2. Click Start watching this issue to instantly become a watcher of the issue.
   - At any subsequent time when logged in, click this again to stop watching the issue.

To view existing users of, add new users to or remove existing users from an issue:

1. Search for or view the issue you want to watch and access its 'view issue' page.
2. Do either of the following:
   - Click the number of watchers to open the Add Watchers popup.
   - Select More Actions > Watchers to open the Watchers page.

![Add Watchers popup]

- Keyboard shortcut: '.' + start typing watchers
3. Use the Add Watchers popup or Watchers page to:
   - View the list of existing users who are watching the issue,
   - Add users as new watchers of the issue or
   - Remove existing watchers.

Tips:

- If you have the optional global permissions (below), an autocompleted list of users appears as you begin typing a username or full name in either the Add Watchers popup (or Add Watchers field on the Watchers page), from which you can select a user via your keyboard's cursor keys.
- When using the Add Watchers popup, you can remove an existing watcher from an issue by moving your mouse pointer over their name and clicking the 'bin' icon that appears to the right of their name.
- When using the Watchers page, if you have the optional global permissions, click the 'user-picker' icon to open the User Picker popup, from which you can select users.
Permissions

Mandatory project permissions

JIRA incorporates the following project permissions to govern who may view/edit the voter and watcher lists:

- **View Voters and Watchers** — permits a user to view both the voter and watcher lists
- **Manage Watcher List** — permits a user to view/edit the watcher list.

These project permissions are granted by your JIRA administrator, through a Permission Scheme.

Optional global permissions

When adding watchers to an issue, to access:

- An autocompleted list of users in the Add Watchers popup, or
- The User Picker popup on the Watchers page,

your JIRA administrator must have granted you the Browse Users Global Permission. If you do not have this permission, however, you can still add users by specifying their usernames in either:

- The Add Watchers popup or
- The Add Watchers field on the Watchers page.

On top of this, your JIRA administrator must also ensure that JIRA’s Allow users to vote on issues setting has not been switched off. (See Configuring JIRA Options for more information.)

⚠️ Please note: It is not possible to edit the voter list.

Viewing the Code Development Information for an Issue

If your administrator has connected JIRA to a compatible development tool, a Development panel will be displayed on the View Issue screen. Depending on which tools JIRA is connected to, the Development panel provides the following functionality:

- **Bitbucket** or **Stash**: view and create branches, view commits, view and create pull requests
- **FishEye/Crucible** (Git/Subversion/Perforce/CVS): view branches (not create), view commits, view and create reviews
- **Bamboo**: view the status of builds and deployments
- **GitHub** or **GitHub Enterprise**: view branches (not create), view commits, view and create pull requests

Starting in JIRA 6.2.2 the Source and Reviews tabs are only displayed if JIRA is unable to display the associated information in the Development Tools panel.
Before you begin

- Your JIRA administrator needs to have set up JIRA and your development tools correctly. Refer your administrator to Integrating JIRA with Code Development Tools.
- You must have the 'view development tools' permission to be able to see the Development panel.

Make your development information available in JIRA

You must tag information in your code/development tool appropriately, if you want it to be made available in JIRA (e.g. display as a link in the Development panel).

- **Commits**: Include the issue key* in the commit message.
- **Branches**: Include the issue key* in the branch name.
- **Pull requests**: Include the issue key* in the pull request's title or in the source branch name.
- **Reviews**: Include the issue key* in the title of the review.
- **Builds**: A build is automatically linked to a JIRA issue if a commit involved in the build has the JIRA issue key in its commit message.
- **Deployments**: A deployment is linked to a JIRA issue if a commit involved in the deploy has the issue key in its commit message.

* Note, the JIRA issue key must conform to the default JIRA key format, that is, two or more uppercase letters \([A-Z]\) \([A-Z]\)+, followed by a hyphen and the issue number, for example EG-123.

View the Development panel

If everything has been set up correctly, you will see a Development panel on each of your issues, similar to the screenshot below. The Development panel provides you with just enough information to evaluate the status of an issue's development, at a glance.
As a developer, I can update story and task status with drag and drop (click the triangle at far left of this story to show sub-tasks)

**Notes:**

**What does the status lozenge next to the pull requests mean?**

The pull request(s) status in the Development panel is:

- **OPEN** if there is at least one open pull request.
- **MERGED** if there are no open pull requests, and at least one pull request has been merged.
- **DECLINED** if there are no open or merged pull requests, and at least one pull request has been declined.

**What does the status lozenge next to the reviews mean?**

The review(s) status in the Development panel is:

- **REVIEW** if there is at least one review in 'Review' status.' (yellow with black writing)
- **APPROVAL** if there are no reviews in 'Review' status, and at least one review is in 'Approval' status. (black)
- **SUMMARIZE** if there are no reviews in 'Review' or 'Approval' statuses, and at least one review is in 'Summarize' status. (black)
- **REJECTED** if there are no reviews in 'Review', 'Approval' or 'Summarize' statuses, and at least one review is in 'Rejected' status. (red)
- **APPROVAL** all reviews are in 'Closed' status.

Note, 'Draft' and 'Abandoned' reviews are not shown.

**What does the status lozenge next to the builds mean?**

The build(s) status in the Development panel is:
if all the different builds (for example, unit tests, functional tests, deploy to staging) have passed.

⚠️ if at least one run failed for any build by any linked build server.

Investigate and action the information

If you want to investigate something on the the Development panel, you can click the item to display a dialog with more details. The dialog provides links for you to action or drill into. Note, you may be prompted to authenticate with the linked application first.

For example, say that the development panel was showing this: 3 builds ⚠️. You could click 3 builds to open a dialog showing which of the three builds are failing. If you wanted to investigate further, then you could click the build plan or build result to view it in Bamboo.

Here are the actions you can do, via the Development panel:

- Create feature branches

  Click Create branch in the Development panel to open your connected SCM and start the process for creating a branch. If you have multiple applications connected, then you can choose where you'd like to create the branch. The key for the JIRA issue will be automatically added to the name of the branch.

- See repository branches

  Click n branches in the Development panel to open a dialog in JIRA that shows the branches for the linked SCM. If JIRA has been linked to more than one SCM, a tab will show for each SCM product (e.g. Stash). The branches will be grouped under each SCM in these tabs.

- See commits to repositories

  Click n commits in the Development panel to open a dialog in JIRA that shows the commits and related files for the linked SCM. If JIRA has been linked to more than one SCM, a tab will show for each SCM product (e.g. Stash). The commits will be grouped under each SCM in these tabs. If a commit is greyed out, it has been merged through a pull request.
- Click a repository or commit to open the SCM at the relevant repository/branch.
- If JIRA is linked to more than one SCM, the dialog may show duplicate commits across tabs. For example, you may have pointed FishEye and Stash to the same repository.
- *(Stash and Bitbucket only)* If the commits belong to a fork of a repository, they will be grouped under the fork. The fork will also have a link to the original repository, "Fork of <repository name>".

### Create pull requests

BITBUCKET  
STASH  
GITHUB

See the 'See repository branches' section above.

### See the status of pull requests

BITBUCKET  
STASH  
GITHUB

Click **n pull requests** in the Development panel to open a dialog on JIRA that shows the pull requests for the linked SCM(s). If JIRA has been linked to more than one SCM, a tab will show for each SCM product (e.g. Stash). The pull requests will be grouped under each SCM in these tabs.

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
<th>Status</th>
<th>Author</th>
<th>Reviewer</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>#125</td>
<td>SSP-10 qunit test stability</td>
<td>MERGED</td>
<td></td>
<td></td>
<td>16/Dec/13 4:20 AM</td>
</tr>
<tr>
<td>#123</td>
<td>Attempt to stabilize Build/Deployment/Environment webdriver tests</td>
<td>MERGED</td>
<td></td>
<td></td>
<td>11/Dec/13 7:19 PM</td>
</tr>
<tr>
<td>#114</td>
<td>Build details dialog post-bltz fixes</td>
<td>MERGED</td>
<td>2</td>
<td></td>
<td>11/Dec/13 1:46 AM</td>
</tr>
<tr>
<td>#167</td>
<td>Builds detail dialog</td>
<td>MERGED</td>
<td>5</td>
<td></td>
<td>26/Nov/13 11:21 AM</td>
</tr>
</tbody>
</table>

- Click a pull request to open it in the linked SCM.
- Hover over a user icon to show the user's name.

### See the status of reviews

CRUCIBLE

Click **n reviews** in the Development panel to open a dialog on JIRA that shows the reviews.

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
<th>Status</th>
<th>Author</th>
<th>Reviewers</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>CR-BAK-5665</td>
<td>SSP-10 - filtering by permissions, 401 not authorised if ...</td>
<td>CLOSING</td>
<td></td>
<td>3</td>
<td>19/Nov/13 9:18 AM</td>
</tr>
<tr>
<td>CR-BAK-5661</td>
<td>SSP-10 - latest <em>relevant</em> test, not just latest</td>
<td>CLOSING</td>
<td></td>
<td>2</td>
<td>18/Nov/13 12:13 PM</td>
</tr>
<tr>
<td>CR-BAK-5672</td>
<td>SSP-10 - REST 4 build details (zip)</td>
<td>CLOSING</td>
<td></td>
<td>7</td>
<td>13/Nov/13 12:55 PM</td>
</tr>
</tbody>
</table>

- Click a review to open it in Crucible.

### See the status of builds

BAMBOO

Click **n builds** in the Development panel to open a dialog on JIRA that shows the builds.

<table>
<thead>
<tr>
<th>SSL-10: 1 build</th>
</tr>
</thead>
</table>

**Sample Scrum Project**

<table>
<thead>
<tr>
<th>Plan</th>
<th>Latest build</th>
<th>Result</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI JIRA DevStatus Plugin WebDriver Qunit Func Tests</td>
<td>#15</td>
<td>1055 tests passed in 32 minutes</td>
<td>10/Dec/13 2:20 AM</td>
</tr>
</tbody>
</table>

- Click a plan or build result to view it in Bamboo.

### See the status of deployments

BAMBOO

Click **Deployed (to environment)** in the Development panel to open a dialog on JIRA that shows the deployment.
Click an environment or release to view it in Bamboo.

Putting it all together

Want to know how this information can help your development team do their work better? Check out the following guide:

- **Streamlining your development with JIRA**

### Viewing an Issue's Crucible Reviews

If you are using compatible versions of JIRA and Crucible, you can view the reviews related to an issue via the Development panel. You should only use the information on this page, if you have older versions of JIRA and Crucible.

JIRA allows you to view the reviews related to an issue (that is, where the JIRA issue key was referenced in the commit message), if you are using Atlassian Crucible.

The **Reviews** tab provides you with an expandable list of code reviews related to the issue. This allows you to view the commit message and list of source-code files in each commit. You can also:

- view diffs and history for a file.
- download files.
- create a Crucible review and see the review status, if you are using Atlassian Crucible.

#### Viewing an Issue's Reviews

1. Open the relevant issue in JIRA.
2. Click the **Reviews** tab in the **Activity** section.
3. The list of code reviews related to the issue will display.

**See also**

- Browsing a Project's Crucible Reviews

### Viewing an Issue's FishEye Changesets

If you are using compatible versions of JIRA and FishEye, you can view the changesets related to an issue via the Development panel. You should only use the information on this page, if you have older versions of JIRA and FishEye.

JIRA allows you to view the changesets related to an issue (that is, where the JIRA issue key was referenced in the commit message), if you are using a source-code repository together with Atlassian FishEye. The regular expression used for matching the JIRA issue key in the commit message is:

```
(^|[^a-zA-Z0-9-])
```

So the key will need to be at the start of the string, or a character on each side that is not a-z, A-Z, 0-9 or the dash '-' character.

The **Source** tab provides you with an expandable list of changesets for the issue. This allows you to view the
commit message and list of source-code files in each commit. You can also:

- view diffs and history for a file.
- download files.
- create a Crucible review and see the review status, if you are using Atlassian Crucible.

**Viewing an Issue’s Changesets**

1. Open the relevant issue in JIRA.
2. Click the Source tab in the Activity section.
3. The list of changesets related to the issue will display.

**See also**

- Browsing a Project's FishEye Changesets
- Viewing the Bamboo Builds related to an Issue

*You will need the 'View Development Tools’ permission in the appropriate projects, if you want to view the 'Builds' tab for issues.*

**Search for Issues**

JIRA provides a powerful issue search facility. You can search for issues across projects, versions and components using a range of search criteria. JIRA also makes custom fields available as search criteria, allowing you to refine your searches even further.

The search can be saved as a filter in JIRA, allowing you to recall the same search and run it again or even share it with other users.

With JIRA searches, you can:

- Modify and reuse search results
- Sort and action individual issues
- Share and export issues
- Display issues on your dashboard

**On this page:**

- Step 1. Define your search criteria
- Step 2. Modify the search results
- Step 3. Save your search
- Step 4. Working with search result data

**Related Topics:**

- Basic Searching
- Advanced Searching
- Using the Issue Navigator
- Using Filters

**Step 1. Define your search criteria**

The first step in searching for issues is to define the criteria for your new search. You can define your search criteria in three different ways: using the quick search, using the basic search or using the advanced search.

If you have saved a search previously (i.e. as a filter) and want to run it again, you can run the filter to load the saved search criteria.
### Search methods

<table>
<thead>
<tr>
<th>Search method</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Quick search** | The quick search is the fastest way to define search criteria. However, it is less precise than other search methods for complex queries (e.g. `project = JIRA AND status = Open AND priority = High`). The quick search is in the navigation bar.  
For instructions, see Using Quick Search. |
| **Basic search** | The basic search is more precise than the quick search, but easier to use than the advanced search. It provides a user-friendly interface that lets you define complex queries, without needing to know how to use JQL.  
For instructions, see Basic Searching. |
| **Advanced search** | The advanced search is the most powerful of the three search methods. You can specify criteria that cannot be defined in the other searches (e.g. `ORDER BY` clause). However, you need to know how to construct structured queries using the JIRA Query Language (JQL) to use this feature.  
For instructions, see Advanced Searching. |

### About filters

A JIRA filter is a saved set of search criteria, similar to a bookmark. Some filters are predefined in JIRA – such as **My Open Issues**, **Reported by Me**, **Recently Viewed**, **All Issues** – these are known as system filters. A filter may also be a set of search criteria defined and saved by a user.

To use a filter, simply click it. Your favorite filters are shown in the panel on the left. You can view all of your filters as well as find filters shared with you here.

When you run a filter, the saved search criteria is loaded for you in the displayed issue view. The criteria is displayed in either the basic search or advanced search, depending the search you are using at the time.

For more information about filters, see Using Filters.

### Step 2. Modify the search results

Once you have defined and run your search, you can optionally modify the search results. JIRA lets you change the sort order of the search results, as well as action each of the individual issues.

For instructions, see Using the Issue Navigator.

**Screenshot: Example search results in the issue navigator**

### Step 3. Save your search

To run your search again in future, save your search as a filter. Simply click **Save as** and enter a name for the filter. The filter is created and added to your favorite filters.

For more information, see Using Filters.

### Step 4. Working with search result data
You can export or share the search results in a number of different formats. Search results can be shared via email or RSS. You can export the search results to a number of formats (e.g. Microsoft Excel). You can also display the search results on your dashboard as a list or a chart.

For more information, see Working with Search Result Data.

Basic Searching

This page describes how to define and execute a basic search. You can also define and execute a search using the quick search or using JQL (advanced searching).

Screenshot: Basic search (click to view full size image)

On this page:
- Performing a basic search
- Saved search
- Troubleshooting
- Next steps

Related topics:
- Searching for Issues
- Advanced Searching
- Using Filters

Performing a basic search

To perform a new basic search in JIRA:

   - If there are existing search criteria, click the New filter button to reset the search criteria.
   - If the Basic link is showing (in other words, you are in the Advanced searching mode), click Basic to switch search modes. This is what you should see:

2. Enter the criteria for the search. You can search against specific fields and/or search for specific text, as described below:
   - **Searching against specified fields** — To search against specified fields, you need to select the fields then specify the fields values that you want to find.
     a. Select fields as criteria — The Project, Issue Type, Status and Assignee fields are always available as criteria. If you want to search using additional fields as criteria, click More and tick the desired fields.
     i. Can't find the field you want? Field is displaying greyed out text? See the Troubleshooting section below.
     b. Specify the value for each field — Click the field criterion and tick/enter the desired value in the dropdown. If the desired value is not shown in the list, start typing the name of value the to filter the list, as shown here:
About the suggested users/groups for the Assignee and Reporter fields — A user/group will be suggested if you have recently selected them in an Assignee/Reporter field for an issue, or viewed the user’s profile page.

- **Searching against specified text** — Enter the desired text in the Contains text text box and press Enter. The Summary, Description, Comments, Environment fields and all text-based custom fields will be searched. You can use modifiers in your search text, such as wildcards and logical operators, see Performing Text Searches.

3. The search results will automatically update, unless your administrator has disabled automatic updates of search results. If so, you need to click the Update button on the field dropdown after every change.

**Saved search**

Search results are saved as filters. For details, see Using Filters.

**To perform a saved search:**

2. Choose any filter from the list on the left:
   - System filter — My Open Issues, Reported by Me, Recently Viewed, All Issues
   - Favorite filters (listed alphabetically)
   - Find filters lets you search for any filter that’s been shared, which you can then subscribe to (adding it to your Favorite Filters).
3. After selecting a filter, the search results are displayed. The search criteria for the filter is also displayed. If you choose the Recently Viewed system filter, this switches you to advanced search due to the fact that basic search cannot represent the ORDER BY clause in this filter.
4. You can add, remove or modify the search criteria to refine the search results. You can also save the modified search criteria (if you are updating your own filter), or save a copy of the search criteria as a new filter.

Screenshot: List of filters
Troubleshooting

- **Why can’t I find the field I want to choose?** Some fields are only valid for a particular project/issue type context, see Configuring Fields and Screens for details. For these fields, you must select the applicable project/issue type. Otherwise, the field is not available for selection.

- **Why are the field criteria displaying in grey text?** Some fields are only valid for a particular project/issue type context, see Configuring Fields and Screens for details. If you choose a field in your search, then remove all projects/issue types that reference the field, then the field is invalid. The invalid field does not apply to your search and displays in grey text.

- **Why is there a red exclamation mark in my field?** Some field values are only valid for a particular project/issue type context. For example, you may have configured a project to use a status In QA Review in its workflow. If you select this project and status in your search, then change the search to filter for a project that doesn't use In QA Review, the status will be invalid and ignored in the search.

- **Why don’t my search results automatically update?** Your search results will always update automatically whenever any fields are changed, provided that your administrator has not disabled automatic updates of search results. Ask your administrator whether they have disabled automatic updates of search results.
Next steps

- Read Using the Issue Navigator to find out how to sort with the issues displayed in the search results, or view individual issues.
- Skip to Working with Search Result Data to find out how to save your search results as an issue filter, export your search results and share your search results.

Using Quick Search
Sometimes you just want to be able to get to the particular issue that you are interested in. Other times you can't remember what the issue was, but you remember that it was an open issue, assigned to you. Quick search can help you.

On this page:
- Jump to an issue
- Smart querying
- Free-text searching
- Searching JIRA issues from your browser’s search box

Jump to an issue

The Quick Search box is located at the top right of your screen. If you type in the key of an issue, you will jump straight to that issue. For example, if you type in ‘ABC-107’ (or ‘abc-107’), and press the Enter you will be redirected to the JIRA issue ‘ABC-107’.

In many cases, you do not even need to type in the full key, but just the numerical part. If you are currently working on the ‘ABC’ project, and you type in ‘123’, you will be redirected to ‘ABC-123’.

Smart querying

Quick search also enables you to perform 'smart' searches with minimal typing. For example, to find all the open bugs in the ‘TEST’ project, you could simply type ‘test open bugs’ and quick search would locate them all for you.

Your search results will be displayed in the Issue Navigator, where you can view them in a variety of useful formats (Excel, XML, etc).

The search terms that quick search recognises are:

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>my</td>
<td>Find issues assigned to me.</td>
<td>my open bugs</td>
</tr>
<tr>
<td>r:</td>
<td>Find issues reported by you, another user or with no reporter, using the prefix r: followed by a specific reporter term such as me, a username or none. Note that there can be no spaces between &quot;r:&quot; and the specific reporter term.</td>
<td>r:me — finds issues reported by you. r:samuel — finds issues reported by the user whose username is &quot;samuel&quot;. r:none — finds issues with no reporter.</td>
</tr>
<tr>
<td>&lt;project name&gt; or &lt;project key&gt;</td>
<td>Find issues in a particular project,</td>
<td>test project TST tst</td>
</tr>
<tr>
<td>overdue</td>
<td>Find issues that were due before today.</td>
<td>overdue</td>
</tr>
<tr>
<td><strong>created:</strong></td>
<td>Find issues with a particular Created, Updated, or Due Date using the prefixes <code>{created}; {updated}; or {due};</code> respectively. For the date range, you can use <code>today</code>, <code>tomorrow</code>, <code>yesterday</code>, a single date range (e.g. <code>-1w</code>), or two date ranges (e.g. <code>-1w,1w</code>). Note that date ranges cannot have spaces in them. Valid date/time abbreviations are: 'w' (week), 'd' (day), 'h' (hour), 'm' (minute).</td>
<td></td>
</tr>
</tbody>
</table>
| **updated:** | created:today  
updated:yesterday |
| **due:** | created:today  
updated:-1w — finds issues updated in the last week.  
due:1w — finds issues due in the next week.  
due:-1d,1w — finds issues due from yesterday to next week.  
created:-1w,-30m — finds issues created from one week ago, to 30 minutes ago.  
created:-1d updated:-4h — finds issues created in the last day, updated in the last 4 hours. |
| `<priority>` | Find issues with a particular Priority. |
| | blocker  
major  
trivial |
| `<issue type>` | Find issues with a particular Issue Type. Note that you can also use plurals. |
| | bug  
task  
bugs  
tasks |
| `<resolution>` | Find issues with a particular Resolution. |
| | fixed  
duplicate  
cannot reproduce |
| **c:** | Find issues with a particular Component(s). You can search across multiple components.  

*Note that there can be no spaces between "c:" and the component name.* |
| **v:** | Find issues with a particular Affects Version(s). To find all issues belonging to a 'major' version, use the wildcard symbol `'*'`.  

*Note that there can be no spaces between "v:" and the version name.* |
| **v:** | v:3.0 — finds issues that match the following versions (for example):  

- 3.0  
- 3.0 eap  
- 3.0 beta  

...but will not match against the following versions (for example):  

- 3.0.1  
- 3.0.0.4  

That is, it will match against any version that contains the string you specify followed immediately by a space, but not against versions that do not contain a space immediately after the string you specify. |
**Free-text searching**

You can search for any word within the issue(s) you are looking for, provided the word is in one of the following fields:

- Summary
- Description
- Comments

Note that, unlike the keywords listed under 'Smart Querying' above, free-text search works in both the Quick Search box and the simple search Query box.

Note that you can combine free-text and keywords together. For example, 'my closed tst tasks', 'open test bugs pear', 'closed test bugs ' are all valid search queries.

**Searching JIRA issues from your browser’s search box**

If you are using Firefox or Internet Explorer 8, you can add your JIRA site as a search engine/provider via the dropdown menu next to the browser's search box. Once you add your JIRA site as a search engine/provider in your browser, you can use it at any time to conduct a Quick Search for issues in that JIRA site.

**OpenSearch**

JIRA supports this browser search feature as part of the autodiscovery part of the OpenSearch standard, by supplying an OpenSearch description document. This is an XML file that describes the web interface provided by JIRA’s search function. Any client applications that support OpenSearch will be able to add JIRA to their list of search engines.

**Advanced Searching**

The instructions on this page describe how to define and execute a search using the advanced search. You can also define and execute a search using the quick search or using basic searching.

**What is an Advanced Search?**

An advanced search allows you to use structured queries to search for JIRA issues. Your search results will be displayed in the Issue Navigator, where you can export them to MS Excel and many other formats. You can also
save and subscribe to your advanced searches if you wish.

When you perform an advanced search, you are using the JIRA Query Language (JQL).

A simple query in JQL (also known as a ‘clause’) consists of a **field**, followed by an **operator**, followed by one or more **values** or **functions**. For example, the following simple query will find all issues in the “TEST” project:

```
project = "TEST"
```

(This example uses the **Project field**, the **EQUALS operator**, and the **value "TEST"**.)

Be aware that it is not possible to compare two **fields**.

JQL gives you some SQL-like syntax, such as the **ORDER BY SQL keyword** and **ISNULL() SQL function** (i.e. the **NULL keyword** in JQL). However, JQL is not a database query language. For example, JQL does not have a **SELECT statement**.

### On this page:
- What is an Advanced Search?
- How to Perform an Advanced Search
  - Performing Text Searches
  - Using Auto-complete
  - Switching between ‘Advanced’ and ‘Simple’ Search
  - Setting Precedence of Operators
- Keywords Reference
- Operators Reference
- Fields Reference

### Related topics:
- Basic Searching
- Using Quick Search
- Performing Text Searches
- JQL: The most flexible way to search JIRA (on the Atlassian blog)

### How to Perform an Advanced Search

1. Choose **Issues > Search for Issues**. The issue navigator will be displayed.
   - If there are existing search criteria, click the **New filter** button to reset the search criteria.
   - If the **Advanced** link is showing, click it to switch to advanced searching.
2. Type your query using the **fields**, **operators** and **field values** or **functions**.
3. Click the **Search** button to run your query.

### Performing Text Searches

You can use Lucene's text-searching features when performing searches on the following fields, using the **CONTAINS operator**:

- **Summary**
- **Description**
- **Environment**
- **Comments**
- **custom** fields which use the "Free Text Searcher"; this includes custom fields of the following built-in **Custom Field Types**
  - Free Text Field (unlimited text)
The JQL field "text" as in `text ~ "some words"` searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g. `Summary ~ "some words" OR Description ~ "some words"

For details, please see the page on [Performing Text Searches](#).

### Using Auto-complete

As you type your query, JIRA will recognise the context and offer a list of "auto-complete" suggestions as follows:

The list of auto-complete suggestions is displayed alphabetically and includes the first 15 matches. Note that auto-complete suggestions are not offered for function parameters.

---

**Please note:**

- If no auto-complete suggestions are offered, your administrator may have disabled the "JQL Auto-complete" feature for your JIRA instance.
- If you prefer not to be offered auto-complete suggestions, click the "Turn off auto-complete" link below the "Query" box.

Auto-complete suggestions are not offered for all fields. Check the fields reference to see which fields support auto-complete.

### Switching between 'Advanced' and 'Simple' Search

In general, a query created using 'Simple Search' will be able to be translated to 'Advanced Search' (i.e. JQL), and back again.

However, a query created using 'Advanced Search' may not be able to be translated to 'Simple Search', particularly if:

- the query contains an OR operator (note you can have an IN operator and it will be translated, e.g. `project in (A, B)`)  
  * i.e. even though this query: `(project = JRA OR project = CONF)` is equivalent to this query: `(project in (JRA, CONF))`, only the second query will be translated.

- the query contains a NOT operator

- the query contains an EMPTY operator

- the query contains any of the comparison operators: `!=, IS, IS NOT, >, >=, <, <=`

- the query specifies a field and value that is related to a project (e.g. version, component, custom fields) and the project is not explicitly included in the query (e.g. `fixVersion = "4.0"` without the AND `project=JRA`). This is especially tricky with custom fields since they can be configured on a Project/Issue Type basis. The general rule of thumb is that if the query cannot be created in the 'Simple Search' form, then if it is created using 'Advanced Search' it will not be able to be translated to 'Simple Search'.

### Setting Precedence of Operators

You can use parentheses in complex JQL statements to enforce the precedence of operators.

For example, if you want to find all resolved issues in the SysAdmin project as well as all issues (any status, any project) currently assigned to the system administrator (bobsmith), you can use parentheses to enforce the precedence of the boolean operators in your query, i.e.:

```
(status=resolved AND project=SysAdmin) OR assignee=bobsmith
```
Note that if you do not use parentheses, the statement will be evaluated left-to-right.
You can also use parentheses to group clauses, so that you can apply the NOT operator to the group.

Keywords Reference

A keyword in JQL is a word or phrase that does (or is) any of the following:
- joins two or more clauses together to form a complex JQL query
- alters the logic of one or more clauses
- alters the logic of operators
- has an explicit definition in a JQL query
- performs a specific function that alters the results of a JQL query.

List of Keywords:
- AND
- OR
- NOT
- EMPTY
- NULL
- ORDER BY

AND

Used to combine multiple clauses, allowing you to refine your search.

Note that you can use parentheses to control the order in which clauses are executed.

Examples
- Find all open issues in the "New office" project:
  ```jql
  project = "New office" and status = "open"
  ```
- Find all open, urgent issues that are assigned to jsmith:
  ```jql
  status = open and priority = urgent and assignee = jsmith
  ```
- Find all issues in a particular project that are not assigned to jsmith:
  ```jql
  project = JRA and assignee != jsmith
  ```
- Find all issues for a specific release which consists of different version numbers across several projects:
  ```jql
  project in (JRA,CONF) and fixVersion = "3.14"
  ```
- Find all issues where neither the Reporter nor the Assignee is Jack, Jill or John:
  ```jql
  reporter not in (Jack,Jill,John) and assignee not in (Jack,Jill,John)
  ```

OR

Used to combine multiple clauses, allowing you to expand your search.

Note that you can use parentheses to control the order in which clauses are executed.
Examples

- Find all issues that were created by either jsmith or jbrown:
  
  ```
  reporter = jsmith or reporter = jbrown
  ```

- Find all issues that are overdue or where no due date is set:
  
  ```
  duedate < now() or duedate is empty
  ```

**NOT**

Used to negate individual clauses or a complex JQL query (a query made up of more than one clause) using parentheses, allowing you to refine your search.

Examples

- Find all issues that are assigned to any user except jsmith:
  
  ```
  not assignee = jsmith
  ```

- Find all issues that were not created by either jsmith or jbrown:
  
  ```
  not (reporter = jsmith or reporter = jbrown)
  ```

**EMPTY**

Used to search for issues where a given field does not have a value. See also **NULL**.

Note that EMPTY can only be used with fields that support the IS and IS NOT operators. To see a field's supported operators, check the individual field reference.

- Find all issues without a DueDate:
  
  ```
  duedate = empty
  ```
  or
  
  ```
  duedate is empty
  ```

**NULL**
Used to search for issues where a given field does not have a value. See also EMPTY.

Note that NULL can only be used with fields that support the IS and IS NOT operators. To see a field's supported operators, check the individual field reference.

Examples

- Find all issues without a DueDate:

  
  duedate = null

  or

  duedate is null

ORDER BY

Used to specify the fields by whose values the search results will be sorted.

By default, the field's own sorting order will be used. You can override this by specifying ascending order ("asc") or descending order ("desc").

Examples

- Find all issues without a DueDate, sorted by CreationDate:

  duedate = empty order by created

- Find all issues without a DueDate, sorted by CreationDate, then by Priority (highest to lowest):

  duedate = empty order by created, priority desc

- Find all issues without a DueDate, sorted by CreationDate, then by Priority (lowest to highest):

  duedate = empty order by created, priority asc

Ordering by Components or Versions will list the returned issues first by Project and only then by the field's natural order (see JRA-31113).

Operators Reference

An operator in JQL is one or more symbols or words which compares the value of a field on its left with one or more values (or functions) on its right, such that only true results are retrieved by the clause. Some operators may use the NOT keyword.

List of Operators:

- EQUALS: =
- NOT EQUALS: !=
- GREATER THAN: >
- GREATER THAN EQUALS: >=
Less than: <
Less than equals: <=
In
Not in
Contains: ~
Does not contain: !~
Is
Is not
Was
Was in
Was not in
Was not
Changed

Equals: =

The "=" operator is used to search for issues where the value of the specified field exactly matches the specified value. (Note: cannot be used with text fields; see the CONTAINS operator instead.)

To find issues where the value of a specified field exactly matches multiple values, use multiple "=" statements with the AND operator.

Examples

- Find all issues that were created by jsmith:
  
  reporter = jsmith

- Find all issues that were created by John Smith:
  
  reporter = "John Smith"

Not equals: !=

The "!=" operator is used to search for issues where the value of the specified field does not match the specified value. (Note: cannot be used with text fields; see the DOES NOT MATCH ("!~") operator instead.)

Note that typing field != value is the same as typing NOT field = value, and that field != EMPTY is the same as field IS_NOT EMPTY.

The "!=" operator will not match a field that has no value (i.e. a field that is empty). For example, component != fred will only match issues that have a component and the component is not "fred". To find issues that have a component other than "fred" or have no component, you would need to type: component != fred or component is empty.

Examples

- Find all issues that are assigned to any user except jsmith:
  
  not assignee = jsmith

  or:

  assignee != jsmith

- Find all issues that are not assigned to jsmith:
The `=` operator is used to search for issues where the value of the specified field is equal to the specified value. Cannot be used with text fields.

Note that the `=` operator can only be used with fields which support ordering (e.g. date fields and version fields). To see a field's supported operators, check the individual field reference.

Examples

- Find all issues where priority is higher than "Normal":

  ```
  priority > normal
  ```

GREATER THAN EQUALS: `>=`

The `>=` operator is used to search for issues where the value of the specified field is greater than or equal to the specified value. Cannot be used with text fields.

Note that the `>=` operator can only be used with fields which support ordering (e.g. date fields and version fields).

Examples

- Find all issues with more than 4 votes:

  ```
  votes > 4
  ```

- Find all overdue issues:

  ```
  duedate < now() and resolution is empty
  ```

- Find all issues where priority is higher than "Normal":

  ```
  priority > normal
  ```
fields). To see a field's supported operators, check the individual field reference.

Examples

- Find all issues with 4 or more votes:
  
  votes >= 4

- Find all issues due on or after 31/12/2008:
  
  duedate >= "2008/12/31"

- Find all issues created in the last five days:
  
  created >= "-5d"

LESS THAN: <

The "<" operator is used to search for issues where the value of the specified field is less than the specified value. Cannot be used with text fields.

Note that the "<" operator can only be used with fields which support ordering (e.g. date fields and version fields). To see a field's supported operators, check the individual field reference.

Examples

- Find all issues with less than 4 votes:
  
  votes < 4

LESS THAN EQUALS: <=

The "<=" operator is used to search for issues where the value of the specified field is less than or equal to than the specified value. Cannot be used with text fields.

Note that the "<=" operator can only be used with fields which support ordering (e.g. date fields and version fields). To see a field's supported operators, check the individual field reference.

Examples

- Find all issues with 4 or fewer votes:
  
  votes <= 4

- Find all issues that have not been updated in the past month (30 days):
  
  updated <= "-4w 2d"

IN

The "IN" operator is used to search for issues where the value of the specified field is one of multiple specified
values. The values are specified as a comma-delimited list, surrounded by parentheses.

Using "IN" is equivalent to using multiple EQUALS (=) statements, but is shorter and more convenient. That is, typing \texttt{reporter IN (tom, jane, harry)} is the same as typing \texttt{reporter = "tom" OR reporter = "jane" OR reporter = "harry"}.

Examples

- Find all issues that were created by either jsmith or jbrown or jjones:
  \begin{verbatim}
  reporter in (jsmith, jbrown, jjones)
  \end{verbatim}

- Find all issues where the Reporter or Assignee is either Jack or Jill:
  \begin{verbatim}
  reporter in (Jack,Jill) or assignee in (Jack,Jill)
  \end{verbatim}

- Find all issues in version 3.14 or version 4.2:
  \begin{verbatim}
  affectedVersion in ("3.14", "4.2")
  \end{verbatim}

\textbf{NOT IN}

The "NOT IN" operator is used to search for issues where the value of the specified field is not one of multiple specified values.

Using "NOT IN" is equivalent to using multiple NOT_EQUALS (!=) statements, but is shorter and more convenient. That is, typing \texttt{reporter NOT IN (tom, jane, harry)} is the same as typing \texttt{reporter != "tom" AND reporter != "jane" AND reporter != "harry"}.

The "NOT IN" operator will not match a field that has no value (i.e. a field that is empty). For example, \texttt{assignee not in (jack,jill)} will only match issues that have an assignee and the assignee is not "jack" or "jill".

To find issues that are assigned to someone other than "jack" or "jill" or are unassigned, you would need to type: \texttt{assignee not in (Jack,Jill,John) or assignee is empty}.

Examples

- Find all issues where the Assignee is someone other than Jack, Jill or John:
  \begin{verbatim}
  assignee not in (Jack,Jill,John)
  \end{verbatim}

- Find all issues where the Assignee is not Jack, Jill or John:
  \begin{verbatim}
  assignee not in (Jack,Jill,John) or assignee is empty
  \end{verbatim}

- Find all issues where the FixVersion is not ‘A’, ‘B’, ‘C’ or ‘D’:
  \begin{verbatim}
  FixVersion not in (A, B, C, D)
  \end{verbatim}

- Find all issues where the FixVersion is not ‘A’, ‘B’, ‘C’ or ‘D’, or has not been specified:
  \begin{verbatim}
  FixVersion not in (A, B, C, D) or FixVersion is empty
  \end{verbatim}
CONTAINS: ~

The "~" operator is used to search for issues where the value of the specified field matches the specified value (either an exact match or a "fuzzy" match — see examples below). For use with text fields only, i.e.:

- Summary
- Description
- Environment
- Comments
- custom fields which use the "Free Text Searcher"; this includes custom fields of the following built-in Custom Field Types
  - Free Text Field (unlimited text)
  - Text Field (< 255 characters)
  - Read-only Text Field

The JQL field "text" as in `searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g.

```
Summary ~ "some words" OR Description ~ "some words"
```

Note: when using the "~" operator, the value on the right-hand side of the operator can be specified using JIRA text-search syntax.

Examples

- Find all issues where the Summary contains the word "win" (or simple derivatives of that word, such as "wins"):
  ```
  summary ~ win
  ```

- Find all issues where the Summary contains a wild-card match for the word "win":
  ```
  summary ~ "win*"
  ```

- Find all issues where the Summary contains the word "issue" and the word "collector":
  ```
  summary ~ "issue collector"
  ```

- Find all issues where the Summary contains the exact phrase "full screen" (see Reserved Characters for details on how to escape quote-marks and other special characters):
  ```
  summary ~ "\"full screen\"
  ```

DOES NOT CONTAIN: !~

The "!~" operator is used to search for issues where the value of the specified field is not a "fuzzy" match for the specified value. For use with text fields only, i.e.:
The JQL field "text" as in `text ~ "some words"` searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g. `Summary ~ "some words" OR Description ~ "some words"`

Note: when using the "!~" operator, the value on the right-hand side of the operator can be specified using JIRA text-search syntax.

Examples

- Find all issues where the Summary does not contain the word "run" (or derivatives of that word, such as "running" or "ran"):
  ```jql```
  summary !~ run
  ```jql```

**^top of operators | ^^top of topic**

IS

The "IS" operator can only be used with EMPTY or NULL. That is, it is used to search for issues where the specified field has no value.

Note that not all fields are compatible with this operator; see the individual field reference for details.

Examples

- Find all issues that have no Fix Version:
  ```jql```
  fixVersion is empty
  ```jql```
  or
  ```jql```
  fixVersion is null
  ```jql```

**^top of operators | ^^top of topic**

IS NOT

The "IS NOT" operator can only be used with EMPTY or NULL. That is, it is used to search for issues where the specified field has a value.

Note that not all fields are compatible with this operator; see the individual field reference for details.

Examples

- Find all issues that have one or more votes:
  ```jql```
  votes is not empty
  ```jql```
  or
  ```jql```
  votes is not null
  ```jql```

**^top of operators | ^^top of topic**
WAS

The "WAS" operator is used to find issues that currently have, or previously had, the specified value for the specified field. This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

Examples

- Find issues that currently have, or previously had, a status of 'In Progress':

  status WAS "In Progress"

- Find issues that were resolved by Joe Smith before 2nd February:

  status WAS "Resolved" BY jsmith BEFORE "2011/02/02"

- Find issues that were resolved by Joe Smith during 2010:

  status WAS "Resolved" BY jsmith DURING ("2010/01/01","2011/01/01")

^top of operators | ^^top of topic

WAS IN

The "WAS IN" operator is used to find issues that currently have, or previously had, any of multiple specified values for the specified field. The values are specified as a comma-delimited list, surrounded by parentheses.

Using "WAS IN" is equivalent to using multiple WAS statements, but is shorter and more convenient. That is, typing status WAS IN ('Resolved', 'Closed') is the same as typing status WAS "Resolved" OR status WAS "Closed".

This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

Examples

- Find all issues that currently have, or previously had, a status of 'Resolved' or 'In Progress':

  status WAS IN ('Resolved', 'In Progress')
The "WAS NOT IN" operator is used to search for issues where the value of the specified field has never been one of multiple specified values.

Using "WAS NOT IN" is equivalent to using multiple WAS_NOT statements, but is shorter and more convenient. That is, typing status WAS NOT IN ("Resolved","In Progress") is the same as typing status WAS NOT "Resolved" AND status WAS NOT "In Progress".

This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

**Examples**

- Find issues that have never had a status of 'Resolved' or 'In Progress':

  ```
  status WAS NOT IN ("Resolved","In Progress")
  ```

- Find issues that did not have a status of 'Resolved' or 'In Progress' before 2nd February:

  ```
  status WAS NOT IN ("Resolved","In Progress") BEFORE "2011/02/02"
  ```

The "WAS NOT" operator is used to find issues that have never had the specified value for the specified field. This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

**Examples**

- Find issues that do not have, and has never had, a status of 'In Progress':

  ```
  status WAS NOT IN ("Resolved","In Progress")
  ```
status WAS NOT "In Progress"

- Find issues that did not have a status of 'In Progress' before 2nd February:

  status WAS NOT "In Progress" BEFORE "2011/02/02"

^top of operators | ^^top of topic

CHANGED

The "CHANGED" operator is used to find issues that have a value which had changed for the specified field.

This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"
- FROM "oldvalue"
- TO "newvalue"

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

Examples

- Find issues whose assignee had changed:

  assignee CHANGED

- Find issues whose status had changed from 'In Progress' back to 'Open':

  status CHANGED FROM "In Progress" TO "Open"

- Find issues whose priority was changed by user 'freddo' after the start and before the end of the current week.

  priority CHANGED BY freddo BEFORE endOfWeek() AFTER startOfWeek()
• Assignee
• Attachments
• Category
• Comment
• Component
• Created
• Creator
• Custom Field
• Description
• Due
• Environment
• Epic Link
• Filter
• Fix Version
• Issue Key
• LastViewed
• Level
• Original Estimate
• Parent
• Priority
• Project
• Remaining Estimate
• Reporter
• Resolution
• Resolved
• Sprint
• Status
• Summary
• Text
• Type
• Time Spent
• Updated
• Voter
• Votes
• Watcher
• Watchers
• Work Ratio

Affected Version

Search for issues that are assigned to a particular Affects Version(s). You can search by version name or version ID (i.e. the number that JIRA automatically allocates to a version).

It is safer to search by version ID than by version name
Different projects may have versions with the same name, so searching by version name may return issues from multiple projects. It is also possible for your JIRA administrator to change the name of a version, which could break any saved filters which rely on that name. Version IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.
Syntax

```
affectedVersion
```

Field Type

VERSION

Supported Operators
Note that the comparison operators (e.g. ">") use the version order that has been set up by your project administrator, not a numeric or alphabetic order.

**Supported Functions**

When used with the **IN** and **NOT IN** operators, this field supports:

- releasedVersions()
- latestReleasedVersion()
- unreleasedVersions()
- earliestUnreleasedVersion()
- versionMatch()

**Examples**

- Find issues with an AffectedVersion of 3.14:
  
  ```
  affectedVersion = "3.14"
  ```

  (Note that full-stops are reserved characters, so they need to be surrounded by quote marks.)

- Find issues with an AffectedVersion of "Big Ted":
  
  ```
  affectedVersion = "Big Ted"
  ```

- Find issues with an AffectedVersion ID of 10350:
  
  ```
  affectedVersion = 10350
  ```

**Assignee**

Search for issues that are assigned to a particular user. You can search by the user's Full Name, ID or Email Address.

Note: this field supports auto-complete.

**Syntax**

```
assignee
```

**Field Type**

**USER**

**Supported Operators**

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN NOT</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>

**Supported Functions**

When used with the **IN** and **NOT IN** operators, this field supports:

- membersOf()

When used with the **EQUALS** and **NOT EQUALS** operators, this field supports:

- currentUser()

**Examples**
• Find issues that are assigned to John Smith:

assignee = "John Smith"

or

assignee = jsmith

• Find issues that are currently assigned, or were previously assigned, to John Smith:

assignee WAS "John Smith"

or

assignee WAS jsmith

• Find issues that are assigned by the user with email address "bob@mycompany.com":

assignee = "bob@mycompany.com"

(Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.)

Attachments

Search for issues which have or do not have attachments. You can only use the EMPTY or IS NOT EMPTY operators for this field.

Note: this field supports auto-complete.

Syntax

attachments

Field Type

ATTACHMENT

Supported Operators

<table>
<thead>
<tr>
<th>=</th>
<th>%=</th>
<th>~</th>
<th>!=</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>✔</td>
<td>✔</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Supported Functions

None

Examples

• Search for issues which have attachments
• Search for issues which do not have attachments

```
attachments IS EMPTY
```

^top of fields | ^top of topic

**Category**

Search for issues that belong to projects in a particular Category.

Note: this field supports auto-complete.

**Syntax**

```
category
```

**Field Type**

**CATEGORY**

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT | IN | WAS | IN | WAS | NOT | WAS | NOT | IN | CHANGED |
| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

**Supported Functions**

n/a

**Examples**

• Find issues that belong to projects in the "Alphabet Projects" Category:

```
category = "Alphabet Projects"
```

^top of fields | ^top of topic

**Comment**

Search for issues that have a Comment which contains particular text.

**JIRA text-search syntax** can be used.

Note: this field does not support auto-complete.

**Syntax**

```
comment
```

**Field Type**

**TEXT**

**Supported Operators**
Supported Functions

n/a

Examples

- Find issues where a Comment contains text that matches "My PC is quite old" (i.e. a "fuzzy" match):

  ```
  comment ~ "My PC is quite old"
  ```

- Find issues where a Comment contains the exact phrase "My PC is quite old":

  ```
  comment ~ "\"My PC is quite old\""
  ```

^top of fields | ^^top of topic

Component

Search for issues that belong to a particular component(s) of a project. You can search by component name or component ID (i.e. the number that JIRA automatically allocates to a component).

**It is safer to search by component ID than by component name**

Different projects may have components with the same name, so searching by component name may return issues from multiple projects. It is also possible for your JIRA administrator to change the name of a component, which could break any saved filters which rely on that name. Component IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.

Syntax

```
component
```

Field Type

COMPONENT

Supported Operators

Supported Functions

When used with the IN and NOT IN operators, component supports:

- `componentsLeadByUser()`

Examples

- Find issues in the "Comp1" or "Comp2" component:

  ```
  component in (Comp1, Comp2)
  ```

- Find issues in the "Comp1" and"Comp2" components:
Find issues in the component with ID 20500:

component = 20500

Search for issues that were created on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the JIRA server’s time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks (""); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.

Syntax

created

Alias:

createdDate

Field Type

DATE

Supported Operators

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Supported Functions: When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
Examples

- Find all issues created before midnight 00:00 12th December 2010:
  
  ```
  created < "2010/12/12"
  ```

- Find all issues created on or before 12th December 2010 (but not 13th December 2010):
  
  ```
  created <= "2010/12/13"
  ```

- Find all issues created on 12th December 2010 before 2:00pm:
  
  ```
  created > "2010/12/12" and created < "2010/12/12 14:00"
  ```

- Find issues created less than one day ago:
  
  ```
  created > "-1d"
  ```

- Find issues created in January 2011:
  
  ```
  created > "2011/01/01" and created < "2011/02/01"
  ```

- Find issues created on 15 January 2011:
  
  ```
  created > "2011/01/15" and created < "2011/01/16"
  ```

Creator

Search for issues that were created by a particular user.

You can search by the user's Full Name, ID or Email Address.

Note: this field supports auto-complete.

Syntax

```
creator
```
Supported Functions

When used with the `IN` and `NOT IN` operators, this field supports:

- `membersOf()`

When used with the `EQUALS` and `NOT EQUALS` operators, this field supports:

- `currentUser()`

Examples

- Search for issues that were created by Jill Jones:

  ```
  creator = "Jill Jones"
  ```

  or

  ```
  creator = jjones
  ```

- Search for issues that were created by the user with email address "bob@mycompany.com":

  ```
  creator = "bob@mycompany.com"
  ```

  (Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.)

Custom Field

Only applicable if your JIRA administrator has created one or more Custom Fields.

Search for issues where a particular Custom Field has a particular value.

You can search by Custom Field name or Custom Field ID (i.e. the number that JIRA automatically allocates to an Custom Field).

It is safer to search by Custom Field ID than by Custom Field name

It is possible for a Custom Field to have the same name as a built-in JIRA system field, in which case JIRA will search on the system field (not your custom field). It is also possible for your JIRA administrator to change the name of a Custom Field, which could break any saved filters which rely on that name.

Custom Field IDs, however, are unique and cannot be changed.

Note:

- JIRA text-search syntax can be used with Custom Fields of type 'Text'.
- `auto-complete` is supported for Custom Fields of type picker, group picker, select, check-box and radio button fields.

Syntax

```
CustomField\_Name
```

Alias:
Field Type

Depends on the Custom Field's configuration

Supported Operators

Different types of Custom Fields support different operators. For the default Custom Field Types, the following operators are supported:

- Number and date/time fields:

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
</tr>
</tbody>
</table>

- Picker, select, check-box and radio button fields:

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
</tr>
</tbody>
</table>

- Text fields:

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
</tr>
</tbody>
</table>

Supported Functions

Different types of Custom Fields support different functions. For the default Custom Field Types, the following functions are supported:

- Date/time fields: When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:
  - currentLogin()
  - lastLogin()
  - now()
  - startOfDay()
  - startOfWeek()
  - startOfMonth()
  - startOfYear()
  - endOfDay()
  - endOfWeek()
  - endOfMonth()
  - endOfYear()

- Version picker fields: When used with the IN and NOT IN operators, this field supports:
  - releasedVersions()
  - latestReleasedVersion()
  - unreleasedVersions()
  - earliestUnreleasedVersion()
  - versionMatch()

Examples

- Find issues where the value of the "Location" Custom Field is "New York":

  cf[CustomFieldID]
location = "New York"

- Find issues where the value of the Custom Field with ID 10003 is "New York":

  `cf[10003] = "New York"

- Find issues where the value of the "Location" Custom Field is "London" or "Milan" or "Paris":


- Find issues where the "Location" Custom Field has no value:

  `location != empty`

^top of fields | ^^top of topic

Description

Search for issues where the Description contains particular text.

JIRA text-search syntax can be used.

Note: this field does not support auto-complete.

Syntax

```
description
```

Field Type

TEXT

Supported Operators

|  |  |  |  |  |  |  |  |  |  |  |  |  |
|---|---|---|---|---|---|---|---|---|---|---|---|
|  |  |  |  |  |  |  |  |  |  |  |  |  |
|  |  |  |  |  |  |  |  |  |  |  |  |  |

Supported Functions

n/a

Examples

- Find issues where the Description contains text that matches "Please see screenshot" (i.e. a "fuzzy" match):

  `description ~ "Please see screenshot"

- Find issues where the Description contains the exact phrase "Please see screenshot":

  `description ~ "\"Please see screenshot\"

^top of fields | ^^top of topic
Due

Search for issues that were due on, before or after a particular date (or date range). Note that Due Date relates to the date only (not to the time).
Use one of the following formats:

"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks) or "d" (days) to specify a date relative to the current date. Be sure to use quote-marks (").

Note: this field does not support auto-complete.

Syntax

due

Alias:

dueDate

Field Type

DATE

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✗ |

Supported Functions

When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
- endOfWeek()
- endOfMonth()
- endOfYear()

Examples

- Find all issues due before 31st December 2010:

  due < "2010/12/31"

- Find all issues due on or before 31st December 2010:

  due <= "2011/01/01"

- Find all issues due tomorrow:
• Find all issues due in January 2011:

due >= "2011/01/01" and due <= "2011/01/31"

• Find all issues due on 15 January 2011:

due = "2011/01/15"

**Environment**

Search for issues where the Environment contains particular text.

**JIRA text-search syntax** can be used.

Note: this field does not support auto-complete.

**Syntax**

```
environment
```

**Field Type**

**TEXT**

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| X | X | ✓ | ✓ | X | X | X | X | ✓ | ✓ | X | X | X | X | X | X | X |

**Supported Functions**

n/a

**Examples**

• Find issues where the Environment contains text that matches "Third floor" (i.e. a "fuzzy" match):

```
environment ~ "Third floor"
```

• Find issues where the Environment contains the exact phrase "Third floor":

```
environment ~ ""Third floor"
```

**Epic Link**

ℹ️ Only available if you are using JIRA Agile 6.1.2 or later.

Search for issues that belong to a particular Epic in JIRA Agile. The search is based on either the epic’s Name, Issue Key or Issue ID (i.e. the number that JIRA automatically allocates to an Issue).
Note: this field does not support auto-complete.

Syntax

"epic link"

Field Type

Epic Link Relationship (this is a custom type created by JIRA Agile).

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>❌</td>
<td>❌</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td>❌</td>
<td></td>
<td>❌</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Supported Functions

When used with the IN or NOT IN operators, epic link supports:

- issueHistory()
- linkedIssues()
- votedIssues()
- watchedIssues()

Examples

- Find issues that belong to epic "Jupiter", which has issue key ANERDS-317:

  "epic link" = ANERDS-317
  
or

  "epic link" = Jupiter

Filter

You can use a saved filter to narrow your search. You can search by filter name or filter ID (i.e. the number that JIRA automatically allocates to a saved filter).

It is safer to search by filter ID than by filter name

It is possible for a filter name to be changed, which could break a saved filter that invokes another filter by name. Filter IDs, however, are unique and cannot be changed.

Note:

- An Advanced Searching - Fields Reference statement in your typed query will override an ORDER BY statement in the saved filter.
- You cannot run or save a filter that would cause an infinite loop (i.e. you cannot reference a saved filter if it eventually references your current filter).
- This field supports auto-complete.

Syntax

filter

Aliases:
Field Type
FILTER
Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Supported Functions
n/a
Examples
- Search the results of the filter "My Saved Filter" (which has an ID of 12000) for issues assigned to the user jsmith:

  filter = "My Saved Filter" and assignee = jsmith

  or

  filter = 12000 and assignee = jsmith

Fix Version
Search for issues that are assigned to a particular Fix Version. You can search by version name or version ID (i.e. the number that JIRA automatically allocates to a version).

It is safer to search by version ID than by version name
Different projects may have versions with the same name, so searching by version name may return issues from multiple projects. It is also possible for your JIRA administrator to change the name of a version, which could break any saved filters that rely on that name. Version IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.
Syntax

fixVersion

Field Type
VERSION
Supported Operators
Note that the comparison operators (e.g. ">") use the version order that has been set up by your project administrator, not a numeric or alphabetic order.

Supported Functions
When used with the IN and NOT IN operators, this field supports:

- releasedVersions()
- latestReleasedVersion()
- unreleasedVersions()
- earliestUnreleasedVersion()
- versionMatch()

Examples

- Find issues with a Fix Version of 3.14 or 4.2:

  ```plaintext```
  fixVersion in ("3.14", "4.2")
  ```plaintext```

  (Note that full-stops are reserved characters, so they need to be surrounded by quote marks.)

- Find issues with a Fix Version of "Little Ted":

  ```plaintext```
  fixVersion = "Little Ted"
  ```plaintext```

- Find issues with a Fix Version ID of 10001:

  ```plaintext```
  fixVersion = 10001
  ```plaintext```

- Find issues with a Fix Version of 15.2 or sub-versions

  ```plaintext```
  fixVersion in (versionMatch("15.2.*"))
  ```plaintext```
Field Type
ISSUE
Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!=~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Supported Functions
When used with the IN or NOT IN operators, *issueKey* supports:

- issueHistory()
- linkedIssues()
- votedIssues()
- watchedIssues()

Examples
- Find the issue with key "ABC-123":

  ```
  issueKey = ABC-123
  ```

 LastViewed

Search for issues that were last viewed on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the JIRA server's time zone).

Use one of the following formats:

- "yyyy/MM/dd HH:mm"
- "yyyy-MM-dd HH:mm"
- "yyyy/MM/dd"
- "yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ('); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.
Syntax

```
lastViewed
```
Supported Functions

When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- `currentLogin()`
- `lastLogin()`
- `now()`
- `startOfDay()`
- `startOfWeek()`
- `startOfMonth()`
- `startOfYear()`
- `endOfDay()`
- `endOfWeek()`
- `endOfMonth()`
- `endOfYear()`

**Examples**

- Find all issues last viewed before 12th December 2010:
  
  ```
  lastViewed < "2010/12/12"
  ```

- Find all issues last viewed on or before 12th December 2010 (but not 13th December 2010):
  
  ```
  lastViewed <= "2010/12/13"
  ```

- Find all issues last viewed on 12th December 2010 before 2:00pm:
  
  ```
  lastViewed > "2010/12/12" and created < "2010/12/12 14:00"
  ```

- Find issues last viewed less than one day ago:
  
  ```
  lastViewed > "-1d"
  ```

- Find issues last viewed in January 2011:
  
  ```
  lastViewed > "2011/01/01" and created < "2011/02/01"
  ```

- Find issues last viewed on 15 January 2011:
  
  ```
  lastViewed > "2011/01/15" and created < "2011/01/16"
  ```

^top of fields | ^top of topic

**Level**

*Only available if Issue Level Security has been enabled by your JIRA administrator.*

Search for issues with a particular Security Level. You can search by Issue Security Level name or Issue Security Level ID (i.e. the number that JIRA automatically allocates to an Issue Security Level).

---

**It is safer to search by Security Level ID than by Security Level name**

It is possible for your JIRA administrator to change the name of a Security Level, which could break any saved filter which rely on that name. Security Level IDs, however, are unique and cannot be changed.
Note: this field supports auto-complete.

Syntax

```
level
```

Field Type

**SECURITY LEVEL**

Supported Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Supported Functions

n/a

Examples

- Search for issues with a Security Level of "Really High" or "level1":

  ```
  level in ("Really High", level1)
  ```

- Search for issues with a Security Level ID of 123:

  ```
  level = 123
  ```

^top of fields | ^top of topic

**Original Estimate**

*Only available if time-tracking has been enabled by your JIRA administrator.*

Search for issues where the Original Estimate is set to a particular value (i.e. a number, not a date or date range).

Use "w", "d", "h" and "m" to specify weeks, days, hours or minutes.

Note: this field does not support auto-complete.

Syntax

```
originalEstimate
```

Alias:

```
timeOriginalEstimate
```
### Parent

*Only available if sub-tasks have been enabled by your JIRA administrator.*

Search for all sub-tasks of a particular issue. You can search by Issue Key or by Issue ID (i.e. the number that JIRA automatically allocates to an issue).

Note: this field does not support auto-complete.

**Syntax**

```
parent
```

### Priority

Search for issues with a particular Priority. You can search by Priority name or Priority ID (i.e. the number that JIRA automatically allocates to a Priority).

It is safer to search by Priority ID than by Priority name

It is possible for your JIRA administrator to change the name of a Priority, which could break any saved filter which rely on that name. Priority IDs, however, are unique and cannot be changed.
Note: this field supports auto-complete.

Syntax

priority

Field Type

PRIORITY

Supported Operators

| = | !| ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✗ | ✗ | ✓ | ✓ | ✓ | ✓ | ✗ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

Supported Functions

n/a

Examples

- Find issues with a Priority of "High":

  priority = High

- Find issues with a Priority ID of 10000:

  priority = 10000

Project

Search for issues that belong to a particular Project.

You can search by Project Name, by Project Key or by Project ID (i.e. the number that JIRA automatically allocates to a project). In the rare case where there is a project whose project key is the same as another project's name, then the project key takes preference and hides results from the second project.

Note: this field supports auto-complete.

Syntax

project

Field Type

PROJECT

Supported Operators

| = | !| ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✗ | ✗ | ✓ | ✓ | ✓ | ✓ | ✗ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

Supported Functions

When used with the IN and NOT IN operators, project supports:

- projectsLeadByUser()
- projectsWhereUserHasPermission()
• projectsWhereUserHasRole()

Examples

• Find issues that belong to the Project that has the name "ABC Project":

```java
project = "ABC Project"
```

• Find issues that belong to the Project that has the key "ABC":

```java
project = "ABC"
```

• Find issues that belong to the Project that has the ID "1234":

```java
project = 1234
```

Remaining Estimate

*Only available if time-tracking has been enabled by your JIRA administrator.*

Search for issues where the Remaining Estimate is set to a particular value (i.e. a number, not a date or date range).

Use "w", "d", "h" and "m" to specify weeks, days, hours or minutes.

Note: this field does not support auto-complete.

Syntax

```java
remainingEstimate
```

Alias:

```java
timeEstimate
```

Field Type

DURATION

Supported Operators

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>

Supported Functions

n/a

Examples

• Find issues with a Remaining Estimate of more than 4 hours:

```java
remainingEstimate > 4h
```
Reporter

Search for issues that were reported by a particular user. This may be the same as the creator, but can be distinct.

You can search by the user's Full Name, ID or Email Address.

Note: this field supports auto-complete.

Syntax

```
reporter
```

Field Type

USER

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ |

Supported Functions

When used with the **IN** and **NOT IN** operators, this field supports:

- `memberOf()`

When used with the **EQUALS** and **NOT EQUALS** operators, this field supports:

- `currentUser()`

Examples

- Search for issues that were reported by Jill Jones:

```
reporter = "Jill Jones"
```

or

```
reporter = jJones
```

- Search for issues that were reported by the user with email address "bob@mycompany.com":

```
reporter = "bob@mycompany.com"
```

(Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.)

Resolution

Search for issues that have a particular Resolution

You can search by Resolution name or Resolution ID (i.e. the number that JIRA automatically allocates to a Resolution).

It is safer to search by Resolution ID than Resolution name

It is possible for your JIRA administrator to change the name of a Resolution, which could break any saved filter which rely on that name. Resolution IDs, however, are unique and cannot be changed.
Note: this field supports auto-complete.
Syntax

```
resolution
```

Field Type
RESOLUTION

Supported Operators

```
=  !=  ~  !=  >  >=  <  <=  IS  IS NOT  IN  NOT IN  WAS  WAS IN  WAS NOT  WAS NOT IN  CHANGED
```

Supported Functions
n/a

Examples

- Find issues with a Resolution of "Cannot Reproduce" or "Won't Fix":

  ```
  resolution in ("Cannot Reproduce", "Won't Fix")
  ```

- Find issues with a Resolution ID of 5:

  ```
  resolution = 5
  ```

- Find issues that do not have a Resolution:

  ```
  resolution = unresolved
  ```

Resolved

Search for issues that were resolved on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the JIRA server's time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks (""); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.
Syntax

```
resolved
```

Alias:
resolutionDate

Field Type
DATE

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN NOT</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✗</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>

Supported Functions
When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
- endOfWeek()
- endOfMonth()
- endOfYear()

Examples

- Find all issues that were resolved before 31st December 2010 (but not on 31st December 2010):

  ```
  resolved <= "2010/12/31"
  ```

- Find all issues that were resolved before 2.00pm on 31st December 2010:

  ```
  resolved < "2010/12/31 14:00"
  ```

- Find all issues that were resolved on or before 31st December 2010:

  ```
  resolved <= "2011/01/01"
  ```

- Find issues that were resolved in January 2011:

  ```
  resolved > "2011/01/01" and resolved < "2011/02/01"
  ```

- Find issues that were resolved on 15 January 2011:

  ```
  resolved > "2011/01/15" and resolved < "2011/01/16"
  ```

- Find issues that were resolved in the last hour:
Sprint

Only available if you are using JIRA Agile.

Search for issues that are assigned to a particular sprint in JIRA Agile. This works for active sprints and future sprints. The search is based on either the sprint name or the sprint ID (i.e. the number that JIRA automatically allocates to a sprint).

Syntax

sprint

If you have multiple sprints with similar (or identical) names, you can simply search by using the sprint name — or even just part of it. The possible matches will be shown in the autocomplete drop-down, with the sprint dates shown to help you distinguish between them. (The sprint ID will also be shown, in brackets).

Field Type

Number

Supported Operators

|  | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
|✓ | ✓ | X | ✓ | X | X | X | ✓ | ✓ | ✓ | ✓ | ✓ | ✗ | ✗ | ✗ | ✗ |

Supported Functions

- openSprints()
- closedSprints()

Examples

- Find issues that belong to sprint 999:

  ```
sprint = 999
  ```

- Find issues that belong to sprint "February 1":

  ```
sprint = "February 1"
  ```

- Find issues that belong to either "February 1", "February 2" or "February 3":

  ```
sprint in ("February 1", "February 2", "February 3")
  ```

- Find issues that are assigned to a sprint:

  ```
sprint is not empty
  ```
Status

Search for issues that have a particular Status.

You can search by Status name or Status ID (i.e. the number that JIRA automatically allocates to a Status).

It is safer to search by Status ID than Status name

It is possible for your JIRA administrator to change the name of a Status, which could break any saved filter which rely on that name. Status IDs, however, are unique and cannot be changed.

Please note, though, that the WAS, WAS_NOT, WAS_IN and WAS_NOT_IN operators can only be used with the name (not the ID).

Note: this field supports auto-complete.

Syntax

status

Field Type

STATUS

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>NOT</th>
<th>IN</th>
<th>NOT</th>
<th>WAS</th>
<th>WAS</th>
<th>WAS</th>
<th>WAS</th>
<th>WAS</th>
<th>NOT</th>
<th>NOT</th>
<th>IN</th>
<th>NOT</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>☑</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Supported Functions

n/a

Examples

- Find issues with a Status of "Open":

  status = Open

- Find issues with a Status ID of 1:

  status = 1

- Find issues that currently have, or previously had, a Status of "Open":

  status WAS Open

Summary

Search for issues where the Summary contains particular text.

JIRA text-search syntax can be used.

Note: this field does not support auto-complete.
Syntax

```
summary
```

Field Type
TEXT

Supported Operators

<table>
<thead>
<tr>
<th>Supported Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>=</code></td>
</tr>
<tr>
<td>✔️</td>
</tr>
</tbody>
</table>

Supported Functions
n/a

Examples

- Find issues where the Summary contains text that matches "Error saving file" (i.e. a "fuzzy" match):
  ```
  summary ~ "Error saving file"
  ```

- Find issues where the Summary contains the exact phrase "Error saving file":
  ```
  summary ~ "\"Error saving file\"
  ```

^top of fields | ^^top of topic

Text

This is a "master-field" that allows you to search all text fields, i.e.:

- Summary
- Description
- Environment
- Comments
- custom fields which use the "Free Text Searcher"; this includes custom fields of the following built-in Custom Field Types
  - Free Text Field (unlimited text)
  - Text Field (< 255 characters)
  - Read-only Text Field

The JQL field "text" as in `text ~ "some words"` searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g.

```
Summary ~ "some words" OR Description ~ "some words"
```

Notes:

- The `text` master-field can only be used with the `CONTAINS` operator ("~").
- JIRA text-search syntax can be used with these fields.

Syntax

```
text
```

Field Type
TEXT
Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| X | X | X | X | X | X | X | X | X | X | X | X | X | X | X | X |

Supported Functions

n/a

Examples

- Find issues where a text field matches the word "Fred":

  text ~ "Fred"

  or

  text ~ Fred

- Find all issues where a text field contains the exact phrase "full screen":

  text ~ "\"full screen\""

^top of fields | ^^top of topic

Type

Search for issues that have a particular Issue Type.

You can search by Issue Type name or Issue Type ID (i.e. the number that JIRA automatically allocates to an Issue Type).

It is safer to search by Type ID than Type name

It is possible for your JIRA administrator to change the name of a Type, which could break any saved filter which rely on that name. Type IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.

Syntax

```plaintext
type
```

Alias:

```plaintext
issueType
```

Field Type

ISSUE_TYPE

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✔ | X | X | X | X | X | ✔ | ✔ | ✔ | ✔ | ✔ | X | X | X | X | X |
Supported Functions

n/a

Examples

- Find issues with an Issue Type of "Bug":

  type = Bug

- Find issues with an Issue Type of "Bug" or "Improvement":

  issueType in (Bug, Improvement)

- Find issues with an Issue Type ID of 2:

  issueType = 2

**Time Spent**

*Only available if time-tracking has been enabled by your JIRA administrator.*

Search for issues where the **Time Spent** is set to a particular value (i.e. a number, not a date or date range).

Use "w", "d", "h" and "m" to specify weeks, days, hours or minutes.

Note: this field does not support auto-complete.

**Syntax**

```
timeSpent
```

**Field Type**

DURATION

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | x | x | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | x | x | x |

**Supported Functions**

n/a

**Examples**

- Find issues where the Time Spent is more than 5 days:

  timeSpent > 5d

**Updated**

Search for issues that were last updated on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured **time zone** (which is by default the JIRA server’s time zone).
Use one of the following formats:
"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.
Syntax

updated

Alias:

updatedDate

Field Type

DATE

Supported Operators

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!=</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>❌</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>❌</td>
</tr>
</tbody>
</table>

Supported Functions

When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
- endOfWeek()
- endOfMonth()
- endOfYear()

Examples

- Find issues that were last updated before 12th December 2010:

  updated < "2010/12/12"

- Find issues that were last updated on or before 12th December 2010 (but not 13th December 2010):

  updated < "2010/12/13"

- Find all issues that were last updated before 2.00pm on 31st December 2010:
Find issues that were last updated more than two weeks ago:

\[
\text{updated < "-2w"}
\]

Find issues that were last updated on 15 January 2011:

\[
\text{updated > "2011/01/15" and updated < "2011/01/16"}
\]

Find issues that were last updated in January 2011:

\[
\text{updated > "2011/01/01" and updated < "2011/02/01"}
\]

Voter

Search for issues for which a particular user has voted. You can search by the user's Full Name, ID or Email Address. Note that you can only find issues for which you have the "View Voters and Watchers" permission, unless you are searching for your own votes. See also votedIssues.

Note: this field supports auto-complete.

Syntax

\[
\text{voter}
\]

Field Type

USER

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT | IN | WAS | WAS | WAS | NOT | WAS | NOT | IN | CHANGED |
| ☑ | ☑ | ✗ | ✗ |   |   |   |   | ☑ | ☑ | ☑ | ☑ | ☑ | ☑ | ☑ |   |   |   |   |   |   |

Supported Functions

When used with the IN and NOT IN operators, this field supports:

- membersOf()

When used with the EQUALS and NOT EQUALS operators, this field supports:

- currentUser()

Examples

- Search for issues for which you have voted:

\[
\text{voter = currentUser()}
\]

- Search for issues for which the user "jsmith" has voted:
voter = "jsmith"

- Search for issues for which a member of the group "jira-developers" has voted:

voter in membersOf("jira-developers")

**Votes**

Search for issues with a specified number of votes.

Note: this field does not support auto-complete.

**Syntax**

`votes`

**Field Type**

NUMBER

**Supported Operators**

- `=`  
- `!`  
- `~`  
- `!~`  
- `>`  
- `>=`  
- `<`  
- `<=`  
- `IS`  
- `IS NOT`  
- `IN`  
- `NOT IN`  
- `WAS`  
- `WAS IN`  
- `WAS NOT`  
- `WAS NOT IN`  
- `CHANGED`

**Supported Functions**

n/a

**Examples**

- Find all issues that have 12 or more votes:

  `votes >= 12`

**Watcher**

Search for issues that a particular user is watching. You can search by the user's Full Name, ID or Email Address. Note that you can only find issues for which you have the "View Voters and Watchers" permission, unless you are searching for issues where you are the watcher. See also `watchedIssues`.

Note: this field supports auto-complete.

**Syntax**

`watcher`

**Field Type**

USER

**Supported Operators**
Supported Functions

When used with the **IN** and **NOT IN** operators, this field supports:

- `membersOf()`

When used with the **EQUALS** and **NOT EQUALS** operators, this field supports:

- `currentUser()`

Examples

- Search for issues that you are watching:

  ```java
  watcher = currentUser()
  ```

- Search for issues that the user "j smith" is watching:

  ```java
  watcher = "j smith"
  ```

- Search for issues that are being watched by a member of the group "jira-developers":

  ```java
  watcher in membersOf("jira-developers")
  ```

**Watchers**

Search for issues with a specified number of watchers.

Note: this field does not support auto-complete.

**Syntax**

```java
watchers
```

**Field Type**

**NUMBER**

**Supported Operators**

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
</tr>
</tbody>
</table>

**Supported Functions**

n/a

**Examples**

- Find all issues that are being watched by more than 3 people:

  ```java
  watchers > 3
  ```
Work Ratio

Only available if time-tracking has been enabled by your JIRA administrator.

Search for issues where the Work Ratio has a particular value.

Work Ratio is calculated as follows: \( \text{workRatio} = \frac{\text{timeSpent}}{\text{originalEstimate}} \times 100 \)

Note: this field does not support auto-complete.

Syntax

\[
\text{workRatio}
\]

Field Type

NUMBER

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ |

Supported Functions

n/a

Examples

- Find issues on which more than 75% of the Original Estimate has been spent:

\[
\text{workRatio} > 75
\]

Advanced Searching - Fields Reference

A field in JQL is a word that represents a JIRA field (or a custom field that has already been defined in JIRA). In a clause, a field is followed by an operator, which in turn is followed by one or more values (or functions). The operator compares the value of the field with one or more values or functions on the right, such that only true results are retrieved by the clause.

List of Fields:
- Affected Version
- Assignee
- Attachments
- Category
- Comment
- Component
- Created
- Creator
- Custom Field
- Description
- Due
- Environment
- Epic Link
- Filter
- Fix Version
- Issue Key
- LastViewed
- Level
- Original Estimate
• Parent
• Priority
• Project
• Remaining Estimate
• Reporter
• Resolution
• Resolved
• Sprint
• Status
• Summary
• Text
• Type
• Time Spent
• Updated
• Voter
• Votes
• Watcher
• Watchers
• Work Ratio

Affected Version

Search for issues that are assigned to a particular Affects Version(s). You can search by version name or version ID (i.e. the number that JIRA automatically allocates to a version).

It is safer to search by version ID than by version name
Different projects may have versions with the same name, so searching by version name may return issues from multiple projects. It is also possible for your JIRA administrator to change the name of a version, which could break any saved filters which rely on that name. Version IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.
Syntax

affectedVersion

Field Type

VERSION

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ❌ | ❌ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✗ | ✗ | ✗ |

Note that the comparison operators (e.g. ">") use the version order that has been set up by your project administrator, not a numeric or alphabetic order.

Supported Functions
When used with the IN and NOT IN operators, this field supports:

• releasedVersions()
• latestReleasedVersion()
• unreleasedVersions()
• earliestUnreleasedVersion()
• versionMatch()

Examples

• Find issues with an AffectedVersion of 3.14:
affectedVersion = "3.14"

(Note that full-stops are reserved characters, so they need to be surrounded by quote marks.)

- Find issues with an AffectedVersion of "Big Ted":

  affectedVersion = "Big Ted"

- Find issues with an AffectedVersion ID of 10350:

  affectedVersion = 10350

Assignee

Search for issues that are assigned to a particular user. You can search by the user's Full Name, ID or Email Address.

Note: this field supports auto-complete.

Syntax

assignee

Field Type

USER

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT IN | WAS | IN | WAS | NOT | WAS NOT | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✗ | ✗ | ✓ | ✗ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

Supported Functions

When used with the IN and NOT IN operators, this field supports:

- membersOf()

When used with the EQUALS and NOT EQUALS operators, this field supports:

- currentUser()

Examples

- Find issues that are assigned to John Smith:

  assignee = "John Smith"

  or

  assignee = jsmith

- Find issues that are currently assigned, or were previously assigned, to John Smith:

  assignee WAS "John Smith"
or

```
assignee WAS jsmith
```

- Find issues that are assigned by the user with email address "bob@mycompany.com":

```
assignee = "bob@mycompany.com"
```

(Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.)

Attachments

Search for issues which have or do not have attachments. You can only use the EMPTY or IS NOT EMPTY operators for this field.

Note: this field supports auto-complete.

Syntax

```
attachments
```

Field Type

ATTACHMENT

Supported Operators

```

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
```

Supported Functions

None

Examples

- Search for issues which have attachments

```
attachments IS NOT EMPTY
```

- Search for issues which do not have attachments

```
attachments IS EMPTY
```

Category

Search for issues that belong to projects in a particular Category.

Note: this field supports auto-complete.

Syntax
Field Type

**CATEGORY**

Supported Operators

|   | != | ~ | != | >= | <= | IS | NOT | IN | NOT | WAS | WAS | WAS | NOT | WAS | NOT IN | CHANGED |
|---|----|---|----|----|----|----|-----|----|-----|-----|-----|-----|------|--------|---------|
|   | ✔  | ✔ | ✗  | ✔  | ✔  | ✗  | ✔   | ✔  | ✗   | ✗   | ✔   | ✔   | ✗    | ✗      |        |

Supported Functions

n/a

Examples

- Find issues that belong to projects in the "Alphabet Projects" Category:

```plaintext
category = "Alphabet Projects"
```

^top of fields | ^^top of topic

**Comment**

Search for issues that have a Comment which contains particular text.

**JIRA text-search syntax** can be used.

Note: this field does not support auto-complete.

Syntax

```plaintext
comment
```

Field Type

**TEXT**

Supported Operators

|   | != | ~ | != | >= | <= | IS | NOT | IN | NOT | WAS | WAS | WAS | NOT | WAS | NOT IN | CHANGED |
|---|----|---|----|----|----|----|-----|----|-----|-----|-----|-----|------|--------|---------|
|   | ✗  | ✗ | ✔  | ✔  | ✔  | ✗  | ✔   | ✔  | ✗   | ✗   | ✔   | ✔   | ✗    | ✗      |        |

Supported Functions

n/a

Examples

- Find issues where a Comment contains text that matches "My PC is quite old" (i.e. a "fuzzy" match):

```plaintext
comment ~ "My PC is quite old"
```

- Find issues where a Comment contains the exact phrase "My PC is quite old":

```plaintext
comment ~ "\"My PC is quite old\"
```
Component

Search for issues that belong to a particular component(s) of a project. You can search by component name or component ID (i.e. the number that JIRA automatically allocates to a component).

It is safer to search by component ID than by component name
Different projects may have components with the same name, so searching by component name may return issues from multiple projects. It is also possible for your JIRA administrator to change the name of a component, which could break any saved filters which rely on that name. Component IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.
Syntax

```
component
```

Field Type
COMPONENT

Supported Operators

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td></td>
<td>✗</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Supported Functions

When used with the IN and NOT IN operators, component supports:

- `componentsLeadByUser()`

Examples

- Find issues in the "Comp1" or "Comp2" component:

  ```
  component in (Comp1, Comp2)
  ```

- Find issues in the "Comp1" and "Comp2" components:

  ```
  component in (Comp1) and component in (Comp2)
  ```

  or

  ```
  component = Comp1 and component = Comp2
  ```

- Find issues in the component with ID 20500:

  ```
  component = 20500
  ```
Search for issues that were created on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the JIRA server’s time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.

Syntax

```
created
```

Alias:

```
createdDate
```

Field Type

DATE

Supported Operators

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
</table>

Supported Functions

When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
- endOfWeek()
- endOfMonth()
- endOfYear()

Examples

- Find all issues created before midnight 00:00 12th December 2010:

```
created < "2010/12/12"
```

- Find all issues created on or before 12th December 2010 (but not 13th December 2010):

```
created <= "2010/12/13"
```

- Find all issues created on 12th December 2010 before 2:00pm:
Find issues created less than one day ago:

created > "-1d"

Find issues created in January 2011:

created > "2011/01/01" and created < "2011/02/01"

Find issues created on 15 January 2011:

created > "2011/01/15" and created < "2011/01/16"

Creator

Search for issues that were created by a particular user.
You can search by the user's Full Name, ID or Email Address.
Note: this field supports auto-complete.
Syntax

creator

Field Type

USER

Supported Operators

Supported Functions

When used with the IN and NOT IN operators, this field supports:

- membersOf()

When used with the EQUALS and NOT EQUALS operators, this field supports:

- currentUser()

Examples

- Search for issues that were created by Jill Jones:

  creator = "Jill Jones"

  or
creator = jjones

- Search for issues that were created by the user with email address "bob@mycompany.com":

creator = "bob@mycompany.com"

(Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.)

Custom Field

Only applicable if your JIRA administrator has created one or more Custom Fields.

Search for issues where a particular Custom Field has a particular value.

You can search by Custom Field name or Custom Field ID (i.e. the number that JIRA automatically allocates to an Custom Field).

It is safer to search by Custom Field ID than by Custom Field name

It is possible for a Custom Field to have the same name as a built-in JIRA system field, in which case JIRA will search on the system field (not your custom field). It is also possible for your JIRA administrator to change the name of a Custom Field, which could break any saved filters which rely on that name. Custom Field IDs, however, are unique and cannot be changed.

Note:

- JIRA text-search syntax can be used with Custom Fields of type ‘Text’.
- auto-complete is supported for Custom Fields of type picker, group picker, select, check-box and radio button fields.

Syntax

CustomFieldName

Alias:

cf[CustomFieldID]

Field Type

Depends on the Custom Field's configuration

Supported Operators

Different types of Custom Fields support different operators. For the default Custom Field Types, the following operators are supported:

- Number and date/time fields:

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
</tbody>
</table>

- Picker, select, check-box and radio button fields:
Supported Functions

Different types of Custom Fields support different functions. For the default Custom Field Types, the following functions are supported:

- **Date/time fields:** When used with the `EQUALS`, `NOT EQUALS`, `GREATER THAN`, `GREATER THAN EQUALS`, `LESS THAN` or `LESS THAN EQUALS` operators, this field supports:
  - `currentLogin()`
  - `lastLogin()`
  - `now()`
  - `startOfDay()`
  - `startOfWeek()`
  - `startOfMonth()`
  - `startOfYear()`
  - `endOfDay()`
  - `endOfWeek()`
  - `endOfMonth()`
  - `endOfYear()`

- **Version picker fields:** When used with the `IN` and `NOT IN` operators, this field supports:
  - `releasedVersions()`
  - `latestReleasedVersion()`
  - `unreleasedVersions()`
  - `earliestUnreleasedVersion()`
  - `versionMatch()`

Examples

- Find issues where the value of the "Location" Custom Field is "New York":

  ```java
  location = "New York"
  ```

- Find issues where the value of the Custom Field with ID 10003 is "New York":

  ```java
  cf[10003] = "New York"
  ```

- Find issues where the value of the "Location" Custom Field is "London" or "Milan" or "Paris":

  ```java
  ```

- Find issues where the "Location" Custom Field has no value:

  ```java
  location != empty
  ```
Description

Search for issues where the Description contains particular text.

**JIRA text-search syntax** can be used.

Note: this field does not support auto-complete.

**Syntax**

```
description
```

**Field Type**

TEXT

**Supported Operators**


**Supported Functions**

n/a

**Examples**

- Find issues where the Description contains text that matches "Please see screenshot" (i.e. a "fuzzy" match):

  ```
description ~ "Please see screenshot"
```

- Find issues where the Description contains the exact phrase "Please see screenshot":

  ```
description ~ "\"Please see screenshot\""
```

^top of fields | ^^top of topic

Due

Search for issues that were due on, before or after a particular date (or date range). Note that Due Date relates to the date only (not to the time).

Use one of the following formats:

"yyyy/MM/dd"

"yyyy-MM-dd"

Or use "w" (weeks) or "d" (days) to specify a date relative to the current date. Be sure to use quote-marks (")

Note: this field does not support auto-complete.

**Syntax**

```
due
```

**Alias:**

```
dueDate
```
Field Type

**DATE**

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>✗</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Supported Functions

When used with the **EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN** or **LESS THAN EQUALS** operators, this field supports:

- `currentLogin()`
- `lastLogin()`
- `now()`
- `startOfDay()`
- `startOfWeek()`
- `startOfMonth()`
- `startOfYear()`
- `endOfDay()`
- `endOfWeek()`
- `endOfMonth()`
- `endOfYear()`

Examples

- Find all issues due before 31st December 2010:

  ```
  due < "2010/12/31"
  ```

- Find all issues due on or before 31st December 2010:

  ```
  due <= "2011/01/01"
  ```

- Find all issues due tomorrow:

  ```
  due = "1d"
  ```

- Find all issues due in January 2011:

  ```
  due >= "2011/01/01" and due <= "2011/01/31"
  ```

- Find all issues due on 15 January 2011:

  ```
  due = "2011/01/15"
  ```

^top of fields | ^^top of topic

Environment

Search for issues where the **Environment** contains particular text.

**JIRA text-search syntax** can be used.

Note: this field does not support **auto-complete**.

**Syntax**
Field Type
TEXT

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| x | x | ✓ | ✓ | x | x | x | x | ✓ | ✓ | x | x | x | x | x | x |

Supported Functions
n/a

Examples
- Find issues where the Environment contains text that matches “Third floor” (i.e. a “fuzzy” match):

  \[ \text{environment} \sim \text{"Third floor"} \]

- Find issues where the Environment contains the exact phrase “Third floor”:

  \[ \text{environment} \sim \text{"\"Third floor\""} \]

Epic Link

Only available if you are using JIRA Agile 6.1.2 or later.

Search for issues that belong to a particular Epic in JIRA Agile. The search is based on either the epic's Name, Issue Key or Issue ID (i.e. the number that JIRA automatically allocates to an Issue).

Note: this field does not support auto-complete.

Syntax

\[ \text{"epic link"} \]
• Find issues that belong to epic "Jupiter", which has issue key ANERDS-317:

   "epic link" = ANERDS-317

or

   "epic link" = Jupiter

Filter

You can use a saved filter to narrow your search. You can search by filter name or filter ID (i.e. the number that JIRA automatically allocates to a saved filter).

It is safer to search by filter ID than by filter name

It is possible for a filter name to be changed, which could break a saved filter that invokes another filter by name. Filter IDs, however, are unique and cannot be changed.

Note:

• An Advanced Searching - Fields Reference statement in your typed query will override an ORDER BY statement in the saved filter.
• You cannot run or save a filter that would cause an infinite loop (i.e. you cannot reference a saved filter if it eventually references your current filter).
• This field supports auto-complete.

Syntax

filter

Aliases:

request

savedFilter

searchRequest

Field Type

FILTER

Supported Operators

 Supported Functions

n/a

Examples

• Search the results of the filter "My Saved Filter" (which has an ID of 12000) for issues assigned to the
Fix Version

Search for issues that are assigned to a particular Fix Version. You can search by version name or version ID (i.e. the number that JIRA automatically allocates to a version).

**It is safer to search by version ID than by version name**
Different projects may have versions with the same name, so searching by version name may return issues from multiple projects. It is also possible for your JIRA administrator to change the name of a version, which could break any saved filters that rely on that name. Version IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.

Syntax

```plaintext
fixVersion
```

Field Type

VERSION

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

Note that the comparison operators (e.g. "~") use the version order that has been set up by your project administrator, not a numeric or alphabetic order.

Supported Functions

When used with the IN and NOT IN operators, this field supports:

- releasedVersions()
- latestReleasedVersion()
- unreleasedVersions()
- earliestUnreleasedVersion()
- versionMatch()

Examples

- Find issues with a Fix Version of 3.14 or 4.2:

  ```plaintext
  fixVersion in ("3.14", "4.2")
  ```

  (Note that full-stops are reserved characters, so they need to be surrounded by quote marks.)

- Find issues with a Fix Version of "Little Ted":

  ```plaintext
  fixVersion = "Little Ted"
  ```
• Find issues with a Fix Version ID of 10001:

```java
fixVersion = 10001
```

• Find issues with a Fix Version of 15.2 or sub-versions

```java
fixVersion in (versionMatch("15.2.*"))
```

^top of fields | ^top of topic

**Issue Key**

Search for issues with a particular Issue Key or Issue ID (i.e. the number that JIRA automatically allocates to an Issue).

Note: this field does not support auto-complete.

**Syntax**

```java
issueKey
```

**Aliases:**

```java
id

issue

key
```

**Field Type**

**ISSUE**

**Supported Operators**

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✗</td>
<td>☑</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

**Supported Functions**

When used with the **IN** or **NOT IN** operators, **issueKey** supports:

- issueHistory()
- linkedIssues()
- votedIssues()
- watchedIssues()

**Examples**

- Find the issue with key "ABC-123":

```java
issueKey = ABC-123
```
LastViewed

Search for issues that were last viewed on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the JIRA server's time zone).

Use one of the following formats:

"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.

Syntax

lastViewed

Field Type
DATE

Supported Operators

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
</tr>
</tbody>
</table>

Supported Functions

When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
- endOfWeek()
- endOfMonth()
- endOfYear()

Examples

- Find all issues last viewed before 12th December 2010:

  lastViewed < "2010/12/12"

- Find all issues last viewed on or before 12th December 2010 (but not 13th December 2010):

  lastViewed <= "2010/12/13"
• Find all issues last viewed on 12th December 2010 before 2:00pm:

   lastViewed > "2010/12/12" and created < "2010/12/12 14:00"

• Find issues last viewed less than one day ago:

   lastViewed > "-1d"

• Find issues last viewed in January 2011:

   lastViewed > "2011/01/01" and created < "2011/02/01"

• Find issues last viewed on 15 January 2011:

   lastViewed > "2011/01/15" and created < "2011/01/16"

It is safer to search by Security Level ID than by Security Level name
It is possible for your JIRA administrator to change the name of a Security Level, which could break any saved filter which rely on that name. Security Level IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.

Syntax

   level

Field Type
SECURITY LEVEL

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Supported Functions

n/a

Examples

• Search for issues with a Security Level of "Really High" or "level1":

   level in ("Really High", level1)

• Search for issues with a Security Level ID of 123:
Original Estimate

*Only available if time-tracking has been enabled by your JIRA administrator.*

Search for issues where the **Original Estimate** is set to a particular value (i.e. a number, not a date or date range).

Use "w", "d", "h" and "m" to specify weeks, days, hours or minutes.

Note: this field does not support auto-complete.

**Syntax**

```
originalEstimate
```

**Alias:**

```
timeOriginalEstimate
```

**Field Type**

DURATION

**Supported Operators**

|  | = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT IN | WAS | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

**Supported Functions**

n/a

**Examples**

- Find issues with an Original Estimate of 1 hour:

  ```
  originalEstimate = 1h
  ```

- Find issues with an Original Estimate of more than 2 days:

  ```
  originalEstimate > 2d
  ```

**Parent**

*Only available if sub-tasks have been enabled by your JIRA administrator.*

Search for all sub-tasks of a particular issue. You can search by Issue Key or by Issue ID (i.e. the number that JIRA automatically allocates to an Issue).

Note: this field does not support auto-complete.

**Syntax**
### Field Type

**ISSUE**

**Supported Operators**

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>NOT</th>
<th>IN</th>
<th>NOT</th>
<th>WAS</th>
<th>WAS</th>
<th>WAS</th>
<th>NOT</th>
<th>WAS</th>
<th>NOT</th>
<th>IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

**Supported Functions**

n/a

**Examples**

- Find issues that are sub-tasks of issue TEST-1234:

  ```
  parent = TEST-1234
  ```

- Find issues with a Priority of "High":

  ```
  priority = High
  ```

- Find issues with a Priority ID of 10000:

---

### Priority

Search for issues with a particular Priority. You can search by Priority name or Priority ID (i.e. the number that JIRA automatically allocates to a Priority).

**It is safer to search by Priority ID than by Priority name**

It is possible for your JIRA administrator to change the name of a Priority, which could break any saved filter which rely on that name. Priority IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.

**Syntax**

```
priority
```
priority = 10000

Project

Search for issues that belong to a particular Project.

You can search by Project Name, by Project Key or by Project ID (i.e. the number that JIRA automatically allocates to a project). In the rare case where there is a project whose project key is the same as another project's name, then the project key takes preference and hides results from the second project.

Note: this field supports auto-complete.

Syntax

project

Field Type

PROJECT

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
|☑ |☑ | ☒ | ☒ | ☒ | ☒ | ☒ | ☒ | ☑ | ☑ | ☑ | ☒ | ☒ | ☒ | ☒ | ☒ |

Supported Functions

When used with the IN and NOT IN operators, project supports:

- projectsLeadByUser()
- projectsWhereUserHasPermission()
- projectsWhereUserHasRole()

Examples

- Find issues that belong to the Project that has the name "ABC Project":

  ```
  project = "ABC Project"
  ```

- Find issues that belong to the Project that has the key "ABC":

  ```
  project = "ABC"
  ```

- Find issues that belong to the Project that has the ID "1234":

  ```
  project = 1234
  ```

Remaining Estimate

Only available if time-tracking has been enabled by your JIRA administrator.

Search for issues where the Remaining Estimate is set to a particular value (i.e. a number, not a date or date
range). Use "w", "d", "h" and "m" to specify weeks, days, hours or minutes.

Note: this field does not support auto-complete.

Syntax

```python
remainingEstimate
```

Alias:

```python
timeEstimate
```

Field Type

**DURATION**

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ |

Supported Functions

n/a

Examples

- Find issues with a Remaining Estimate of more than 4 hours:

```python
remainingEstimate > 4h
```

Reporter

Search for issues that were reported by a particular user. This may be the same as the creator, but can be distinct.

You can search by the user's Full Name, ID or Email Address.

Note: this field supports auto-complete.

Syntax

```python
reporter
```

Field Type

**USER**

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ |

Supported Functions

When used with the IN and NOT IN operators, this field supports:

- membersOf()
When used with the **EQUALS** and **NOT EQUALS** operators, this field supports:

- currentUser()

Examples

- Search for issues that were reported by Jill Jones:

  ```java
  reporter = "Jill Jones"
  ```
  
or

  ```java
  reporter = jJones
  ```

- Search for issues that were reported by the user with email address "bob@mycompany.com":

  ```java
  reporter = "bob@mycompany.com"
  ```

  (Note that full-stops and "@" symbols are reserved characters, so the email address needs to be surrounded by quote-marks.)

**Resolution**

Search for issues that have a particular Resolution

You can search by Resolution name or Resolution ID (i.e. the number that JIRA automatically allocates to a Resolution).

> It is safer to search by Resolution ID than Resolution name

It is possible for your JIRA administrator to change the name of a Resolution, which could break any saved filter which rely on that name. Resolution IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.

**Syntax**

```java
resolution
```

**Field Type**

RESOLUTION

**Supported Operators**

| = | != | ~ | != | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✅ | ✅ | ✖ | ✖ | ✅ | ✅ | ✅ | ✅ | ✅ | ✅ | ✅ | ✅ | ✅ | ✅ | ✅ | ✅ |

**Supported Functions**

n/a

Examples

- Find issues with a Resolution of "Cannot Reproduce" or "Won't Fix":

  ```java
  resolution in ("Cannot Reproduce", "Won't Fix")
  ```
• Find issues with a Resolution ID of 5:

```
resolution = 5
```

• Find issues that do not have a Resolution:

```
resolution = unresolved
```

Resolved

Search for issues that were resolved on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the JIRA server’s time zone).

Use one of the following formats:

```
"yyyy/MM/dd HH:mm"
"yyyy-MM-dd HH:mm"
"yyyy/MM/dd"
"yyyy-MM-dd"
```

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("); if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.

Syntax

```
resolved
```

Alias:

```
resolutionDate
```

Field Type

DATE

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ☑ | ☑ | ✗ | ✗ | ☑ | ☑ | ☑ | ☑ | ☑ | ☑ | ☑ | ☑ | ☑ | ✗ | ✗ |

Supported Functions

When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
Examples

- Find all issues that were resolved before 31st December 2010 (but not on 31st December 2010):
  
  ```
  resolved <= "2010/12/31"
  ```

- Find all issues that were resolved before 2.00pm on 31st December 2010:
  
  ```
  resolved < "2010/12/31 14:00"
  ```

- Find all issues that were resolved on or before 31st December 2010:
  
  ```
  resolved <= "2011/01/01"
  ```

- Find issues that were resolved in January 2011:
  
  ```
  resolved > "2011/01/01" and resolved < "2011/02/01"
  ```

- Find issues that were resolved on 15 January 2011:
  
  ```
  resolved > "2011/01/15" and resolved < "2011/01/16"
  ```

- Find issues that were resolved in the last hour:
  
  ```
  resolved > -1h
  ```

^top of fields | ^^top of topic

Sprint

ℹ️ Only available if you are using JIRA Agile.

Search for issues that are assigned to a particular sprint in JIRA Agile. This works for active sprints and future sprints. The search is based on either the sprint name or the sprint ID (i.e. the number that JIRA automatically allocates to a sprint).

**Syntax**

```
sprint
```
Supported Functions

- `openSprints()`
- `closedSprints()`

Examples

- **Find issues that belong to sprint 999:**
  
  ```java
  sprint = 999
  ```

- **Find issues that belong to sprint "February 1":**
  
  ```java
  sprint = "February 1"
  ```

- **Find issues that belong to either "February 1", "February 2" or "February 3":**
  
  ```java
  sprint in ("February 1","February 2","February 3")
  ```

- **Find issues that are assigned to a sprint:**
  
  ```java
  sprint is not empty
  ```

\^top of fields | ^\^top of topic

**Status**

Search for issues that have a particular **Status**.

You can search by Status name or Status ID (i.e. the number that JIRA automatically allocates to a Status).

It is safer to search by Status ID than Status name

It is possible for your JIRA administrator to change the name of a Status, which could break any saved filter which rely on that name. Status IDs, however, are unique and cannot be changed.

Please note, though, that the `WAS`, `WAS_NOT`, `WAS_IN` and `WAS_NOT_IN` operators can only be used with the name (not the ID).

Note: this field supports auto-complete.

**Syntax**

```java
status
```
Supported Functions

n/a

Examples

- Find issues with a Status of "Open":

  \[
  \text{status} = \text{Open}
  \]

- Find issues with a Status ID of 1:

  \[
  \text{status} = 1
  \]

- Find issues that currently have, or previously had, a Status of "Open":

  \[
  \text{status WAS Open}
  \]

Summary

Search for issues where the Summary contains particular text.

JIRA text-search syntax can be used.

Note: this field does not support auto-complete.

Syntax

\[
\text{summary}
\]

Field Type

TEXT

Supported Operators

<p>| | | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>=</td>
<td>!=</td>
<td>~</td>
<td>!~</td>
<td>&gt;</td>
<td>&gt;=</td>
<td>&lt;</td>
<td>&lt;=</td>
<td>IS</td>
<td>IS NOT</td>
<td>IN</td>
<td>NOT IN</td>
</tr>
<tr>
<td>✔</td>
<td>✔</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Supported Functions

n/a

Examples

- Find issues where the Summary contains text that matches "Error saving file" (i.e. a "fuzzy" match):

  \[
  \text{summary ~ "Error saving file"}
  \]

- Find issues where the Summary contains the exact phrase "Error saving file":

  \[
  \text{summary: "Error saving file"}
  \]
This is a "master-field" that allows you to search all text fields, i.e.:

- **Summary**
- **Description**
- **Environment**
- **Comments**
- Custom fields which use the "Free Text Searcher"; this includes custom fields of the following built-in Custom Field Types
  - Free Text Field (unlimited text)
  - Text Field (< 255 characters)
  - Read-only Text Field

The JQL field "text" as in `text ~ "some words"` searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g.

```
Summary ~ "some words" OR Description ~ "some words"
```

**Notes:**

- The text master-field can only be used with the **CONTAINS** operator ("~~").
- JIRA text-search syntax can be used with these fields.

### Syntax

```
text
```

### Field Type

**TEXT**

### Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✗ | ✗ | ✓ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ |

### Supported Functions

n/a

### Examples

- Find issues where a text field matches the word "Fred":

  ```
text ~ "Fred"
  ```

  or

  ```
text ~ Fred
  ```

- Find all issues where a text field contains the exact phrase "full screen":

  ```
text ~ "full screen"
  ```
Type

Search for issues that have a particular Issue Type.

You can search by Issue Type name or Issue Type ID (i.e. the number that JIRA automatically allocates to an Issue Type).

It is safer to search by Type ID than Type name

It is possible for your JIRA administrator to change the name of a Type, which could break any saved filter which rely on that name. Type IDs, however, are unique and cannot be changed.

Note: this field supports auto-complete.

Syntax

type

Alias:

issueType

Field Type

ISSUE_TYPE

Supported Operators

| = | !| ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT IN | WAS | IN | WAS | NOT | WAS | NOT IN | CHANGED |
| ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | ✔ | ✔ | ✔ | ✔ | ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ |

Supported Functions

n/a

Examples

- Find issues with an Issue Type of "Bug":

  type = Bug

- Find issues with an Issue Type of "Bug" or "Improvement":

  issueType in (Bug, Improvement)

- Find issues with an Issue Type ID of 2:

  issueType = 2
**Time Spent**

*Only available if time-tracking has been enabled by your JIRA administrator.*

Search for issues where the Time Spent is set to a particular value (i.e. a number, not a date or date range).

Use "w", "d", "h" and "m" to specify weeks, days, hours or minutes.

Note: this field does not support auto-complete.

**Syntax**

```
timeSpent
```

**Field Type**

DURATION

**Supported Operators**

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

**Supported Functions**

n/a

**Examples**

- Find issues where the Time Spent is more than 5 days:

  ```
timeSpent > 5d
  ```

^top of fields | ^^top of topic

**Updated**

Search for issues that were last updated on, before or after a particular date (or date range). Note that if a time-component is not specified, midnight 00:00 will be assumed. Please note that the search results will be relative to your configured time zone (which is by default the JIRA server's time zone).

Use one of the following formats:

- "yyyy/MM/dd HH:mm"
- "yyyy-MM-dd HH:mm"
- "yyyy/MM/dd"
- "yyyy-MM-dd"

Or use "w" (weeks), "d" (days), "h" (hours) or "m" (minutes) to specify a date relative to the current time. The default is "m" (minutes). Be sure to use quote-marks ("), if you omit the quote-marks, the number you supply will be interpreted as milliseconds after epoch (1970-1-1).

Note: this field does not support auto-complete.

**Syntax**

```
updated
```

**Alias:**

```
updatedDate
```
Field Type
DATE
Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>! =</th>
<th>~</th>
<th>!=</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Supported Functions
When used with the EQUALS, NOT EQUALS, GREATER THAN, GREATER THAN EQUALS, LESS THAN or LESS THAN EQUALS operators, this field supports:

- currentLogin()
- lastLogin()
- now()
- startOfDay()
- startOfWeek()
- startOfMonth()
- startOfYear()
- endOfDay()
- endOfWeek()
- endOfMonth()
- endOfYear()

Examples

- Find issues that were last updated before 12th December 2010:
  
  ```
  updated < "2010/12/12"
  ```

- Find issues that were last updated on or before 12th December 2010 (but not 13th December 2010):
  
  ```
  updated < "2010/12/13"
  ```

- Find all issues that were last updated before 2.00pm on 31st December 2010:
  
  ```
  updated < "2010/12/31 14:00"
  ```

- Find issues that were last updated more than two weeks ago:
  
  ```
  updated < "-2w"
  ```

- Find issues that were last updated on 15 January 2011:
  
  ```
  updated > "2011/01/15" and updated < "2011/01/16"
  ```

- Find issues that were last updated in January 2011:
  
  ```
  updated > "2011/01/01" and updated < "2011/02/01"
  ```
Search for issues for which a particular user has voted. You can search by the user's Full Name, ID or Email Address. Note that you can only find issues for which you have the "View Voters and Watchers" permission, unless you are searching for your own votes. See also votedIssues.

Note: this field supports auto-complete.

Syntax

```
voter
```

Field Type

USER

Supported Operators

```
<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
```

Supported Functions

When used with the IN and NOT IN operators, this field supports:

- membersOf()

When used with the EQUALS and NOT EQUALS operators, this field supports:

- currentUser()

Examples

- Search for issues for which you have voted:

  ```
  voter = currentUser()
  ```

- Search for issues for which the user "jsmith" has voted:

  ```
  voter = "jsmith"
  ```

- Search for issues for which a member of the group "jira-developers" has voted:

  ```
  voter in membersOf("jira-developers")
  ```

Votes

Search for issues with a specified number of votes.

Note: this field does not support auto-complete.

Syntax

```
votes
```

Field Type

NUMBER

Supported Operators
Supported Functions

n/a

Examples

- Find all issues that have 12 or more votes:

  ```
  votes >= 12
  ```

^top of fields | ^top of topic

**Watcher**

Search for issues that a particular user is watching. You can search by the user's Full Name, ID or Email Address. Note that you can only find issues for which you have the "View Voters and Watchers" permission, unless you are searching for issues where you are the watcher. See also watchedIssues.

Note: this field supports auto-complete.

Syntax

```
watcher
```

Field Type

USER

Supported Operators

Supported Functions

When used with the IN and NOT IN operators, this field supports:

- `membersOf()`

When used with the EQUALS and NOT EQUALS operators, this field supports:

- `currentUser()`

Examples

- Search for issues that you are watching:

  ```
  watcher = currentUser()
  ```

- Search for issues that the user "j smith" is watching:

  ```
  watcher = "j smith"
  ```

- Search for issues that are being watched by a member of the group "jira-developers":

  ```
  watcher in membersOf("jira-developers")
  ```
Watchers

Search for issues with a specified number of watchers.

Note: this field does not support auto-complete.

Syntax

```
watchers
```

Field Type

NUMBER

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | x | x | ✓ | x | x | x | x |

Supported Functions

n/a

Examples

- Find all issues that are being watched by more than 3 people:

```
watchers > 3
```

Work Ratio

*Only available if time-tracking has been enabled by your JIRA administrator.*

Search for issues where the Work Ratio has a particular value.

Work Ratio is calculated as follows: $\text{workRatio} = \frac{\text{timeSpent}}{\text{originalEstimate}} \times 100$

Note: this field does not support auto-complete.

Syntax

```
workRatio
```

Field Type

NUMBER

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | x | x | ✓ | x | x | x | x |

Supported Functions

n/a

Examples

- Find issues on which more than 75% of the Original Estimate has been spent:
Advanced Searching - Keywords Reference

A keyword in JQL is a word or phrase that does (or is) any of the following:

- joins two or more clauses together to form a complex JQL query
- alters the logic of one or more clauses
- alters the logic of operators
- has an explicit definition in a JQL query
- performs a specific function that alters the results of a JQL query.

List of Keywords:
- **AND**
- **OR**
- **NOT**
- **EMPTY**
- **NULL**
- **ORDER BY**

**AND**

Used to combine multiple clauses, allowing you to refine your search.

Note that you can use parentheses to control the order in which clauses are executed.

Examples

- Find all open issues in the "New office" project:

  ```jql
  project = "New office" and status = "open"
  ```

- Find all open, urgent issues that are assigned to jsmith:

  ```jql
  status = open and priority = urgent and assignee = jsmith
  ```

- Find all issues in a particular project that are not assigned to jsmith:

  ```jql
  project = JRA and assignee != jsmith
  ```

- Find all issues for a specific release which consists of different version numbers across several projects:

  ```jql
  project in (JRA,CONF) and fixVersion = "3.14"
  ```

- Find all issues where neither the Reporter nor the Assignee is Jack, Jill or John:

  ```jql
  reporter not in (Jack,Jill,John) and assignee not in (Jack,Jill,John)
  ```
Used to combine multiple clauses, allowing you to expand your search.

Note that you can use parentheses to control the order in which clauses are executed.

(Note: also see IN, which can be a more convenient way to search for multiple values of a field.)

Examples

- Find all issues that were created by either jsmith or jbrown:

  ```jql
  reporter = jsmith or reporter = jbrown
  ```

- Find all issues that are overdue or where no due date is set:

  ```jql
  duedate < now() or duedate is empty
  ```

NOT

Used to negate individual clauses or a complex JQL query (a query made up of more than one clause) using parentheses, allowing you to refine your search.

(Note: also see NOT EQUALS ("!="), DOES NOT CONTAIN ("!~"), NOT IN and IS NOT.)

Examples

- Find all issues that are assigned to any user except jsmith:

  ```jql
  not assignee = jsmith
  ```

- Find all issues that were not created by either jsmith or jbrown:

  ```jql
  not (reporter = jsmith or reporter = jbrown)
  ```

EMPTY

Used to search for issues where a given field does not have a value. See also NULL.

Note that EMPTY can only be used with fields that support the IS and IS NOT operators. To see a field's supported operators, check the individual field reference.

⚠️ EMPTY is not equivalent to NOT EQUALS ("!=")

Examples

- Find all issues without a DueDate:

  ```jql
  duedate = empty
  ```
  or

  ```jql
  duedate is empty
  ```
**NULL**

Used to search for issues where a given field does not have a value. See also **EMPTY**.

Note that NULL can only be used with fields that support the **IS** and **IS NOT** operators. To see a field's supported operators, check the individual **field** reference.

Examples

- Find all issues without a **DueDate**:

  \[
  \text{duedate = null}
  \]
  
or
  \[
  \text{duedate is null}
  \]

**ORDER BY**

Used to specify the fields by whose values the search results will be sorted.

By default, the field's own sorting order will be used. You can override this by specifying ascending order ("asc") or descending order ("desc").

Examples

- Find all issues without a **DueDate**, sorted by **CreationDate**:

  \[
  \text{duedate = empty order by created}
  \]

- Find all issues without a **DueDate**, sorted by **CreationDate**, then by **Priority** (highest to lowest):

  \[
  \text{duedate = empty order by created, priority desc}
  \]

- Find all issues without a **DueDate**, sorted by **CreationDate**, then by **Priority** (lowest to highest):

  \[
  \text{duedate = empty order by created, priority asc}
  \]

Ordering by **Components** or **Versions** will list the returned issues first by **Project** and only then by the field's natural order (see JRA-31113).

**Advanced Searching - Operators Reference**

An operator in JQL is one or more symbols or words which compares the value of a **field** on its left with one or more values (or **functions**) on its right, such that only true results are retrieved by the clause. Some operators may use the **NOT** keyword.

**List of Operators:**

- **EQUALS**: =
- **NOT EQUALS**: !=
- **GREATER THAN**: >
GREATER THAN EQUALS: >=
LESS THAN: <
LESS THAN EQUALS: <=
IN
NOT IN
CONTAINS: ~
DOES NOT CONTAIN: !~
IS
IS NOT
WAS
WAS IN
WAS NOT IN
WAS NOT
CHANGED

EQUALS: =
The "=" operator is used to search for issues where the value of the specified field exactly matches the specified value. (Note: cannot be used with text fields; see the CONTAINS operator instead.)

To find issues where the value of a specified field exactly matches multiple values, use multiple "=" statements with the AND operator.
Examples

- Find all issues that were created by jsmith:
  
  reporter = jsmith

- Find all issues that were created by John Smith:
  
  reporter = "John Smith"

NOT EQUALS: !=
The "!=" operator is used to search for issues where the value of the specified field does not match the specified value. (Note: cannot be used with text fields; see the DOES NOT MATCH ("!~") operator instead.)

Note that typing field != value is the same as typing NOT field = value, and that field != EMPTY is the same as field IS_NOT EMPTY.

The "!=" operator will not match a field that has no value (i.e. a field that is empty). For example, component != fred will only match issues that have a component and the component is not "fred". To find issues that have a component other than "fred" or have no component, you would need to type: component != fred or component is empty.

Examples

- Find all issues that are assigned to any user except jsmith:
  
  not assignee = jsmith

  or:

  assignee != jsmith

- Find all issues that are not assigned to jsmith:
assignee != jsmith or assignee is empty

• Find all issues that were reported by me but are not assigned to me:

reporter = currentUser() and assignee != currentUser()

• Find all issues where the Reporter or Assignee is anyone except John Smith:

assignee != "John Smith" or reporter != "John Smith"

• Find all issues that are not unassigned:

assignee is not empty

or

assignee != null

^top of operators | ^^top of topic

GREATER THAN: >

The ">" operator is used to search for issues where the value of the specified field is greater than the specified value. Cannot be used with text fields.

Note that the ">" operator can only be used with fields which support ordering (e.g. date fields and version fields). To see a field's supported operators, check the individual field reference.

Examples

• Find all issues with more than 4 votes:

votes > 4

• Find all overdue issues:

duedate < now() and resolution is empty

• Find all issues where priority is higher than "Normal":

priority > normal

^top of operators | ^^top of topic

GREATER THAN EQUALS: >=

The ">=" operator is used to search for issues where the value of the specified field is greater than or equal to the specified value. Cannot be used with text fields.

Note that the ">=" operator can only be used with fields which support ordering (e.g. date fields and version fields). To see a field's supported operators, check the individual field reference.
fields). To see a field's supported operators, check the individual field reference.

Examples

- Find all issues with 4 or more votes:

```
votes >= 4
```

- Find all issues due on or after 31/12/2008:

```
duedate >= "2008/12/31"
```

- Find all issues created in the last five days:

```
created >= "-5d"
```

### LESS THAN: <

The "<" operator is used to search for issues where the value of the specified field is less than the specified value. Cannot be used with text fields.

Note that the "<" operator can only be used with fields which support ordering (e.g. date fields and version fields). To see a field's supported operators, check the individual field reference.

Examples

- Find all issues with less than 4 votes:

```
votes < 4
```

### LESS THAN EQUALS: <=

The "<=" operator is used to search for issues where the value of the specified field is less than or equal to that specified value. Cannot be used with text fields.

Note that the "<=" operator can only be used with fields which support ordering (e.g. date fields and version fields). To see a field's supported operators, check the individual field reference.

Examples

- Find all issues with 4 or fewer votes:

```
votes <= 4
```

- Find all issues that have not been updated in the past month (30 days):

```
updated <= "-4w 2d"
```

### IN

The "IN" operator is used to search for issues where the value of the specified field is one of multiple specified
values. The values are specified as a comma-delimited list, surrounded by parentheses.

Using "IN" is equivalent to using multiple EQUALS (=) statements, but is shorter and more convenient. That is, typing REPORTER IN (tom, jane, harry) is the same as typing REPORTER = "tom" OR REPORTER = "jane" OR REPORTER = "harry".

Examples

- Find all issues that were created by either jsmith or jbrown or jjones:

  reporter in (jsmith, jbrown, jjones)

- Find all issues where the Reporter or Assignee is either Jack or Jill:

  reporter in (Jack, Jill) or assignee in (Jack, Jill)

- Find all issues in version 3.14 or version 4.2:

  affectedVersion in ("3.14", "4.2")

^top of operators | ^^top of topic

NOT IN

The "NOT IN" operator is used to search for issues where the value of the specified field is not one of multiple specified values.

Using "NOT IN" is equivalent to using multiple NOT_EQUALS (!=) statements, but is shorter and more convenient. That is, typing REPORTER NOT IN (tom, jane, harry) is the same as typing REPORTER != "tom" AND REPORTER != "jane" AND REPORTER != "harry".

The "NOT IN" operator will not match a field that has no value (i.e. a field that is empty). For example, assignee not in (jack, jill) will only match issues that have an assignee and the assignee is not "jack" or "jill". To find issues that are assigned to someone other than "jack" or "jill" or are unassigned, you would need to type: assignee not in (jack, jill) or assignee is empty.

Examples

- Find all issues where the Assignee is someone other than Jack, Jill or John:

  assignee not in (Jack, Jill, John)

- Find all issues where the Assignee is not Jack, Jill or John:

  assignee not in (Jack, Jill, John) or assignee is empty

- Find all issues where the FixVersion is not 'A', 'B', 'C' or 'D':

  FixVersion not in (A, B, C, D)

- Find all issues where the FixVersion is not 'A', 'B', 'C' or 'D', or has not been specified:

  FixVersion not in (A, B, C, D) or FixVersion is empty
CONTAINS: ~

The "~" operator is used to search for issues where the value of the specified field matches the specified value (either an exact match or a "fuzzy" match — see examples below). For use with text fields only, i.e.:

- Summary
- Description
- Environment
- Comments
- custom fields which use the "Free Text Searcher"; this includes custom fields of the following built-in Custom Field Types
  - Free Text Field (unlimited text)
  - Text Field (< 255 characters)
  - Read-only Text Field

The JQL field "text" as in `text ~ "some words"` searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g. `Summary ~ "some words" OR Description ~ "some words"

Note: when using the "~" operator, the value on the right-hand side of the operator can be specified using JIRA text-search syntax.

Examples

- Find all issues where the Summary contains the word "win" (or simple derivatives of that word, such as "wins"):
  ```jql
  summary ~ win
  ```

- Find all issues where the Summary contains a wild-card match for the word "win":
  ```jql
  summary ~ "win*"
  ```

- Find all issues where the Summary contains the word "issue" and the word "collector":
  ```jql
  summary ~ "issue collector"
  ```

- Find all issues where the Summary contains the exact phrase "full screen" (see Reserved Characters for details on how to escape quote-marks and other special characters):
  ```jql
  summary ~ "\"full screen\"
  ```

DOES NOT CONTAIN: !~

The "!~" operator is used to search for issues where the value of the specified field is not a "fuzzy" match for the specified value. For use with text fields only, i.e.:

- Summary
- Description
- Environment
- Comments
- custom fields which use the "Free Text Searcher"; this includes custom fields of the following built-in Custom Field Types
Free Text Field (unlimited text)
Text Field (< 255 characters)
Read-only Text Field

The JQL field "text" as in text ~ "some words" searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g.
Summary ~ "some words" OR Description ~ "some words"

Note: when using the "!~" operator, the value on the right-hand side of the operator can be specified using JIRA text-search syntax.
Examples

- Find all issues where the Summary does not contain the word "run" (or derivatives of that word, such as "running" or "ran"):

  ```
  summary !~ run
  ```

IS

The "IS" operator can only be used with EMPTY or NULL. That is, it is used to search for issues where the specified field has no value.

Note that not all fields are compatible with this operator; see the individual field reference for details.
Examples

- Find all issues that have no Fix Version:

  ```
  fixVersion is empty
  ```
  or

  ```
  fixVersion is null
  ```

IS NOT

The "IS NOT" operator can only be used with EMPTY or NULL. That is, it is used to search for issues where the specified field has a value.

Note that not all fields are compatible with this operator; see the individual field reference for details.
Examples

- Find all issues that have one or more votes:

  ```
  votes is not empty
  ```
  or

  ```
  votes is not null
  ```
The "WAS" operator is used to find issues that currently have, or previously had, the specified value for the specified field.

This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

Examples

- Find issues that currently have, or previously had, a status of 'In Progress':

  ```
  status WAS "In Progress"
  ```

- Find issues that were resolved by Joe Smith before 2nd February:

  ```
  status WAS "Resolved" BY jsmith BEFORE "2011/02/02"
  ```

- Find issues that were resolved by Joe Smith during 2010:

  ```
  status WAS "Resolved" BY jsmith DURING ("2010/01/01","2011/01/01")
  ```

The "WAS IN" operator is used to find issues that currently have, or previously had, any of multiple specified values for the specified field. The values are specified as a comma-delimited list, surrounded by parentheses.

Using "WAS IN" is equivalent to using multiple WAS statements, but is shorter and more convenient. That is, typing `status WAS IN ('Resolved', 'Closed')` is the same as typing `status WAS "Resolved" OR status WAS "Closed"`.

This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

Examples

- Find all issues that currently have, or previously had, a status of 'Resolved' or 'In Progress':

  ```
  status WAS IN ('Resolved', 'In Progress')
  ```
status WAS IN ("Resolved","In Progress")

^top of operators | ^^top of topic

WAS NOT IN

The "WAS NOT IN" operator is used to search for issues where the value of the specified field has never been one of multiple specified values.

Using "WAS NOT IN" is equivalent to using multiple WAS_NOT statements, but is shorter and more convenient. That is, typing status WAS NOT IN ("Resolved","In Progress") is the same as typing status WAS NOT "Resolved" AND status WAS NOT "In Progress".

This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

Examples

- Find issues that have never had a status of 'Resolved' or 'In Progress':

  status WAS NOT IN ("Resolved","In Progress")

- Find issues that did not have a status of 'Resolved' or 'In Progress' before 2nd February:

  status WAS NOT IN ("Resolved","In Progress") BEFORE "2011/02/02"

^top of operators | ^^top of topic

WAS NOT

The "WAS NOT" operator is used to find issues that have never had the specified value for the specified field. This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1","date2")
- ON "date"

This operator will match the value name (e.g. "Resolved"), which was configured in your system at the time that the field was changed. This operator will also match the value ID associated with that value name too — that is, it will match "4" as well as "Resolved".

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

Examples

- Find issues that do not have, and has never had, a status of 'In Progress':
Find issues that did not have a status of 'In Progress' before 2nd February:

```
status WAS NOT "In Progress" BEFORE "2011/02/02"
```

**CHANGED operators**

The "CHANGED" operator is used to find issues that have a value which had changed for the specified field.

This operator has the following optional predicates:

- AFTER "date"
- BEFORE "date"
- BY "username"
- DURING ("date1", "date2")
- ON "date"
- FROM "oldvalue"
- TO "newvalue"

(Note: This operator can be used with the Assignee, Fix Version, Priority, Reporter, Resolution and Status fields only.)

**Examples**

- Find issues whose assignee had changed:
  
  ```
  assignee CHANGED
  ```

- Find issues whose status had changed from 'In Progress' back to 'Open':
  
  ```
  status CHANGED FROM "In Progress" TO "Open"
  ```

- Find issues whose priority was changed by user 'freddo' after the start and before the end of the current week:
  
  ```
  priority CHANGED BY freddo BEFORE endOfWeek() AFTER startOfWeek()
  ```

**Advanced Searching Functions**

The instructions on this page describe how to use functions in JQL to define structured search queries to search for JIRA issues. Your search results will be displayed in the Issue Navigator, where you can export them to MS Excel and many other formats. You can also save and subscribe to your advanced searches if you wish.

When you perform an advanced search, you are using the JIRA Query Language (JQL).

**Functions Reference**

A function in JQL appears as a word followed by parentheses which may contain one or more explicit values or
JIRA fields. In a clause, a function is preceded by an operator, which in turn is preceded by a field. A function performs a calculation on either specific JIRA data or the function's content in parentheses, such that only true results are retrieved by the function and then again by the clause in which the function is used.

This document also covers the reserved characters and words that JIRA uses.

On this page:
- Functions Reference
- List of Functions
- Reserved Characters
- Reserved Words

List of Functions
- cascadeOption()
- closedSprints()
- componentsLeadByUser()
- currentLogin()
- currentUser()
- earliestUnreleasedVersion()
- endOfDay()
- endOfMonth()
- endOfWeek()
- endOfYear()
- issueHistory()
- issuesWithRemoteLinksByGlobalId()
- lastLogin()
- latestReleasedVersion()
- linkedIssues()
- membersOf()
- now()
- openSprints()
- projectsLeadByUser()
- projectsWhereUserHasPermission()
- projectsWhereUserHasRole()
- releasedVersions()
- standardIssueTypes()
- startOfDay()
- startOfMonth()
- startOfWeek()
- startOfYear()
- subtaskIssueTypes()
- unreleasedVersions()
- votedIssues()
- watchedIssues()

cascadeOption()

Search for issues that match the selected values of a 'cascading select' custom field.

The parentOption parameter matches against the first tier of options in the cascading select field. The childOption parameter matches against the second tier of options in the cascading select field, and is optional.

The keyword "none" can be used to search for issues where either or both of the options have no value.

Syntax
cascadeOption(parentOption)

or

cascadeOption(parentOption,childOption)

Supported Fields

- custom fields of type 'Cascading Select'

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ |

Examples

- Find issues where a custom field ("Location") has the value "USA" for the first tier and "New York" for the second tier:

  location in cascadeOption("USA","New York")

- Find issues where a custom field ("Location") has the value "USA" for the first tier and any value (or no value) for the second tier:

  location in cascadeOption("USA")

- Find issues where a custom field ("Location") has the value "USA" for the first tier and no value for the second tier:

  location in cascadeOption("USA",none)

- Find issues where a custom field ("Location") has no value for the first tier and no value for the second tier:

  location in cascadeOption(none)

- Find issues where a custom field ("Referrer") has the value "none" for the first tier and "none" for the second tier:

  referrer in cascadeOption("\"none\"","\"none\"")

- Find issues where a custom field ("Referrer") has the value "none" for the first tier and no value for the second tier:

  referrer in cascadeOption("\"none\"",none)
closedSprints()

ℹ️ Only available if you are using JIRA Agile 6.7.

Search for issues that are assigned to a completed Sprint. (Note that it is possible for an issue to belong to both a completed Sprint(s) and an incomplete Sprint(s).)

See also openSprints().

Syntax

```java
closedSprints()
```

Supported Fields

- **Sprint**

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Examples

- Find all issues that are assigned to a completed Sprint.

```java
sprint in closedSprints()
```

^top of functions | ^^top of topic

componentsLeadByUser()

Find issues in components that are lead by a specific user.

You can optionally specify a user, or if the user is omitted the current user (i.e. you) will be used.

Note that if you are not logged in to JIRA, a user must be specified.

Syntax

```java
componentsLeadByUser()
```

or

```java
componentsLeadByUser(username)
```

Supported Fields

- **Component**

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Examples
Find open issues in components that are lead by you:

```
classroom in componentsLeadByUser() AND status = Open
```

Find open issues in components that are lead by Bill:

```
classroom in componentsLeadByUser(bill) AND status = Open
```

**currentLogin()**

Perform searches based on the time at which the current user's session began. See also `lastLogin`.

**Syntax**

```
currentLogin()
```

**Supported Fields**

- Created
- Due
- Resolved
- Updated
- custom fields of type Date/Time

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHA |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) |

**Examples**

- Find issues that have been created during my current session:

  ```
  created > currentLogin()
  ```

**currentUser()**

Perform searches based on the currently logged-in user.

Note that this function can only be used by logged-in users. So if you are creating a saved filter that you expect to be used by anonymous users, do not use this function.

**Syntax**

```
currentUser()
```

**Supported Fields**

- Assignee
- Reporter
- Voter
• **Watcher**
• custom fields of type User

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ |

**Examples**

• Find issues that are assigned to me:

```java
assignee = currentUser()
```

• Find issues that were reported to me but are not assigned to me:

```java
reporter = currentUser() and assignee != currentUser()
```

---

**earliestUnreleasedVersion()**

Perform searches based on the earliest unreleased version (i.e. next version that is due to be released) of a specified project. See also unreleasedVersions.

Note that the "earliest" is determined by the ordering assigned to the versions, not by actual Version Due Dates.

**Syntax**

```java
earliestUnreleasedVersion(project)
```

**Supported Fields**

• AffectedVersion
• FixVersion
• custom fields of type Version

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ |

**Examples**

• Find issues whose FixVersion is the earliest unreleased version of the ABC project:

```java
fixVersion = earliestUnreleasedVersion(ABC)
```

• Find issues that relate to the earliest unreleased version of the ABC project:

```java
affectedVersion = earliestUnreleasedVersion(ABC) or fixVersion = earliestUnreleasedVersion(ABC)
```
endOfDay()

Perform searches based on the end of the current day. See also endOfWeek, endOfMonth and endOfYear; and startOfDay, startOfWeek, startOfMonth and startOfYear.
Syntax

```
endOfDay()
```

or

```
endOfDay("inc")
```

where `inc` is an optional increment of `(+/-) nn {y|M|w|d|h|m}`

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. `endOfDay("+1")` is the same as `endOfDay("+1d")`.
- If the plus/minus `(+/-)` sign is omitted, plus is assumed.

Supported Fields
- Created
- Due
- Resolved
- Updated
- custom fields of type Date/Time

Supported Operators

| Supported Operators | = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT | WAS | WAS IN | WAS NOT | WAS NOT IN | CHA |
|---------------------|---|----|---|----|---|-----|---|-----|-----|--------|----|-----|-----|----------|----------|-----|
|                     | ✔ | ✔  | ✔ | ✔  | ✔ | ✔   | ✔ | ✔   | ✔   | ✔      | ✔  | ✔   | ✔   | ✔        | ✔        | ✔   |
|                     |   |     |   |     |   |      |   |      |     |        |     |      |     |          |           |     |
|                     | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) |

Examples

- Find issues due by the end of today:

  ```
  due < endOfDay()
  ```

- Find issues due by the end of tomorrow:

  ```
  due < endOfDay("+1")
  ```

endOfMonth()

Perform searches based on the end of the current month. See also endOfDay, endOfWeek and endOfYear; and startOfDay, startOfWeek, startOfMonth and startOfYear.
Syntax

```
endOfMonth()
```

or

```
endOfMonth("inc")
```

`endOfMonth()` is similar to `endOfDay()` with the exception that it performs searches based on the end of the current month. It allows for increments specified as `(+/-) nn {y|M|w|d|h|m}`.
endOfMonth("inc")

where \texttt{inc} is an optional increment of \((+/-) \texttt{nn(y|M|w|d|h|m)}\)

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. \texttt{endOfMonth("+1")} is the same as \texttt{endOfMonth("+1M")}.
- If the plus/minus \((+/-)\) sign is omitted, plus is assumed.

Supported Fields
- \texttt{Created}
- \texttt{Due}
- \texttt{Resolved}
- \texttt{Updated}
- custom fields of type Date/Time

Supported Operators

| \ = \ | \ != \ | \ ~ \ | \ !\~ \ | \ > \ | \ >= \ | \ < \ | \ <= \ | \ IS \ | \ NOT \ | \ IN \ | \ NOT \ IN \ | \ WAS \ | \ WAS \ IN \ | \ WAS \ NOT \ | \ WAS \ NOT \ IN \ | \ CHANGE |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) |

Examples

- Find issues due by the end of this month:

  \texttt{due < endOfMonth()}

- Find issues due by the end of next month:

  \texttt{due endOfMonth("+1")}

- Find issues due by the 15th of next month:

  \texttt{due endOfMonth("+15d")}

\texttt{^top of functions | ^\texttt{top of topic}}

\texttt{endOfWeek()}

Perform searches based on the end of the current week. See also \texttt{endOfDay}, \texttt{endOfMonth} and \texttt{endOfYear}; and \texttt{startOfDay}, \texttt{startOfWeek}, \texttt{startOfMonth} and \texttt{startOfYear}.

For the \texttt{endOfWeek()} function the result depends upon your locale. For example, in Europe the first day of the week is generally considered to be Monday, while in the USA it is considered to be Sunday.

Syntax

\texttt{endOfWeek()}

or

\texttt{endOfWeek("inc")}
where \( inc \) is an optional increment of \((+/-) nn\) \( y | M | w | d | h | m \)

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. \(\) is the same as \(\)
- If the plus/minus \((+/-)\) sign is omitted, plus is assumed.

Supported Fields

- Created
- Due
- Resolved
- Updated
- custom fields of type Date/Time

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | | NOT | IN | NOT | IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHA |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ☒ | ☒ | ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ |

Examples

- Find issues due by the end of this week:

  ```
  due < endOfWeek()
  ```

- Find issues due by the end of next week:

  ```
  due < endOfWeek("+1")
  ```

endOfYear()

Perform searches based on the end of the current year. See also startOfDay, startOfWeek and startOfMonth; and endOfDay, endOfWeek, endOfMonth and endOfYear.

```endOfYear()``` or

```endOfYear("inc")``` where \( inc \) is an optional increment of \((+/-) nn\) \( y | M | w | d | h | m \)

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. \(\) is the same as \(\).
- If the plus/minus \((+/-)\) sign is omitted, plus is assumed.

Supported Fields

- Created
- Due
- Resolved
- Updated
- custom fields of type Date/Time

Supported Operators
Examples

- Find issues due by the end of this year:

  ```
  due < endOfYear()
  ```

- Find issues due by the end of March next year:

  ```
  due < endOfYear("+3M")
  ```

^top of functions | ^^top of topic

**issueHistory()**

Find issues that you have recently viewed, i.e. issues that are in the 'Recent Issues' section of the 'Issues' drop-down menu.

Note:

- `issueHistory()` returns up to 50 issues, whereas the 'Recent Issues' drop-down returns only 5.
- if you are not logged in to JIRA, only issues from your current browser session will be included.

**Syntax**

```
issueHistory()
```
issuesWithRemoteLinksByGlobalId()

Supported Fields

- **Issue**

Supported Operators

<table>
<thead>
<tr>
<th>Supported Operators</th>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Examples

- Find issues that are linked to remote links that have globalId "abc":

  ```
  issue in issuesWithRemoteLinksByGlobalId(abc)
  ```

- Find issues that are linked to remote links that have either globalId "abc" or "def"

  ```
  issue in issuesWithRemoteLinksByGlobalId(abc, def)
  ```

^top of functions | ^^top of topic

lastLogin()

Perform searches based on the time at which the current user's previous session began. See also currentLogin.

Syntax

```
lastLogin()
```

Supported Fields

- **Created**
- **Due**
- **Resolved**
- **Updated**
- **custom** fields of type Date/Time

Supported Operators

- **Supported Operators**

Examples

- Find issues that have been created during my last session:

  ```
  created > lastLogin()
  ```

^top of functions | ^^top of topic

latestReleasedVersion()
Perform searches based on the latest released version (i.e. the most recent version that has been released) of a specified project. See also releasedVersions().

Note that the "latest" is determined by the ordering assigned to the versions, not by actual Version Due Dates. Syntax

```
latestReleasedVersion(project)
```

Supported Fields

- **AffectedVersion**
- **FixVersion**
- custom fields of type Version

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT | WAS | IN | WAS | NOT | WAS | NOT | IN | CHANGED |
| x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x |

Examples

- Find issues whose **FixVersion** is the latest released version of the ABC project:

```
fixVersion = latestReleasedVersion(ABC)
```

- Find issues that relate to the latest released version of the ABC project:

```
affectedVersion = latestReleasedVersion(ABC) or fixVersion = latestReleasedVersion(ABC)
```

linkedIssues()

Perform searches based on issues which are linked to a specified issue.

You can optionally restrict the search to links of a particular type. Note that LinkType is case-sensitive. Syntax

```
linkedIssues(issueKey)
```

or

```
linkedIssues(issueKey,linkType)
```

Supported Fields

- **Issue**

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT | WAS | IN | WAS | NOT | WAS | NOT | IN | CHANGED |
| x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x | x |

Examples
• Find issues that are linked to a particular issue:

```java
issue in linkedIssues(ABC-123)
```

• Find issues that are linked to a particular issue via a particular type of link:

```java
issue in linkedIssues(ABC-123,"is duplicated by")
```

```
top of functions | top of topic
```

membersOf()

Perform searches based on the members of a particular group.

**Syntax**

```java
membersOf(_GROUP_)
```

**Supported Fields**

• Assignee
• Reporter
• Voter
• Watcher
• custom fields of type User

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT | IN | WAS | WAS | WAS | WAS | WAS | NOT | NOT | IN | WAS | NOT | NOT | WAS | WAS | CHANGED |
| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

**Examples**

• Find issues where the Assignee is a member of the group "jira-developers":

```
assignee in membersOf("jira-developers")
```

• Search through multiple groups and a specific user, e.g:

```
reporter in membersOf("jira-developers") or reporter in membersOf("jira-administrators") or reporter=jsmith
```

• Search for a particular group, but exclude a particular member or members, e.g:

```
assignee in membersOf(QA) and assignee not in ("John Smith","Jill Jones")
```

• Exclude members of a particular group:

```
assignee not in membersOf(QA)
```

```
top of functions | top of topic
```
**now()**

Perform searches based on the current time.

**Supported Fields**

- Created
- Due
- Resolved
- Updated
- custom fields of type Date/Time

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✗ | ✗ | ✓ | ✓ | ✓ | ✓ | ✗ | ✗ | ✗ | ✓ | ✓ | ✓ | ✓ | ✓ | (+ predicate) | (+ predicate) | (+ predicate) | (+ predicate) | (+ predicate) |

**Examples**

- Find issues that are overdue:

  ```sql
duedate < now() and status not in (closed, resolved)
  ```

**openSprints()**

ℹ️ Only available if you are using JIRA Agile 6.7.

Search for issues that are assigned to a Sprint which has not yet been completed. (Note that it is possible for an issue to belong to both a completed Sprint(s) and an incomplete Sprint(s).)

See also closedSprints().

**Syntax**

```sql
openSprints()
```

**Supported Fields**

- Sprint

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✗ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | (+ predicate) |

**Examples**

- Find all issues that are assigned to a Sprint which has not yet been completed.

  ```sql
  sprint in openSprints()
  ```
projectsLeadByUser()

Find issues in projects that are lead by a specific user.
You can optionally specify a user, or if the user is omitted the current user will be used.
Note that if you are not logged in to JIRA, a user must be specified.
Syntax

```
projectsLeadByUser()
```

or

```
projectsLeadByUser(username)
```

Supported Fields

- **Project**

Supported Operators

<p>| | | | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>!</td>
<td>~</td>
<td>!=</td>
<td>&gt;</td>
<td>&gt;=</td>
<td>&lt;</td>
<td>&lt;=</td>
<td>IS</td>
<td>NOT</td>
<td>IN</td>
<td>NOT</td>
<td>IS</td>
<td>NOT</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Examples

- Find open issues in projects that are lead by you:

  ```
  project in projectsLeadByUser() AND status = Open
  ```

- Find open issues in projects that are lead by Bill:

  ```
  project in projectsLeadByUser(bill) AND status = Open
  ```

projectsWhereUserHasPermission()

Find issues in projects where you have a specific permission.

Note: This function operates at the project level. This means that if a permission (e.g. "Edit Issues") is granted to the reporter of issues in a project, then you may see some issues returned where you are not the reporter and therefore don't have the permission specified.

Also note that this function is only available if you are logged in to JIRA.
Syntax

```
projectsWhereUserHasPermission(permission)
```

For the permission parameter you can specify any of the following:
<table>
<thead>
<tr>
<th><strong>Project Permissions</strong></th>
<th><strong>Explanation</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer Projects</td>
<td>Permission to administer a project in JIRA. This includes the ability to edit project role membership, project components, project versions and some project details ('Project Name', 'URL', 'Project Lead', 'Project Description').</td>
</tr>
<tr>
<td>Browse Projects</td>
<td>Permission to browse projects, use the Issue Navigator and view individual issues (except issues that have been restricted via Issue Security). <strong>Many other permissions are dependent on this permission</strong>, e.g. the 'Work On Issues' permission is only effective for users who also have the 'Browse Projects' permission.</td>
</tr>
<tr>
<td>View Development Tools</td>
<td>Permission to view the project's 'read-only' workflow when viewing an issue. This permission provides the 'View Workflow' link against the 'Status' field of the 'View Issue' page.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Issue Permissions</strong></th>
<th><strong>Explanation</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign Issues</td>
<td>Permission to assign issues to users. Also allows autocompletion of users in the Assign Issue drop-down. (See also Assignable User permission below)</td>
</tr>
<tr>
<td>Assignable User</td>
<td>Permission to be assigned issues. (Note that this does not include the ability to assign issues; see Assign Issue permission above).</td>
</tr>
<tr>
<td>Close Issues</td>
<td>Permission to close issues. (This permission is useful where, for example, developers resolve issues and testers close them). Also see the Resolve Issues permission.</td>
</tr>
<tr>
<td>Create Issues</td>
<td>Permission to create issues in the project. (Note that the Create Attachments permission is required in order to create attachments.) Includes the ability to create sub-tasks (if sub-tasks are enabled).</td>
</tr>
<tr>
<td>Delete Issues</td>
<td>Permission to delete issues. Think carefully about which groups or project roles you assign this permission to; usually it will only be given to administrators. Note that deleting an issue will delete all of its comments and attachments, even if the user does not have the Delete Comments or Delete Attachments permissions. However, the Delete Issues permission does not include the ability to delete individual comments or attachments.</td>
</tr>
<tr>
<td>Edit Issues</td>
<td>Permission to edit issues (excluding the 'Due Date' field — see the Schedule Issues permission). Includes the ability to convert issues to sub-tasks and vice versa (if sub-tasks are enabled). Note that the Delete Issue permission is required in order to delete issues. The Edit Issue permission is usually given to any groups or project roles who have the Create Issue permission (perhaps the only exception to this is if you give everyone the ability to create issues — it may not be appropriate to give everyone the ability to edit too). Note that all edits are recorded in the Issue Change History for audit purposes.</td>
</tr>
<tr>
<td>Link Issues</td>
<td>Permission to link issues together. (Only relevant if Issue Linking is enabled).</td>
</tr>
<tr>
<td>Modify Reporter</td>
<td>Permission to modify the 'Reporter' of an issue. This allows a user to create issues 'on behalf of' someone else. This permission should generally only be granted to administrators.</td>
</tr>
<tr>
<td>Move Issues</td>
<td>Permission to move issues from one project to another, or from one workflow to another workflow within the same project. Note that a user can only move issues to a project for which they have Create Issue permission.</td>
</tr>
<tr>
<td>Resolve Issues</td>
<td>Permission to resolve and reopen issues. This also includes the ability to set the 'Fix For version' field for issues. Also see the Close Issues permission.</td>
</tr>
<tr>
<td>Schedule Issues</td>
<td>Permission to <strong>schedule</strong> an issue — that is, to edit the 'Due Date' of an issue. In older versions of JIRA this also controlled the permission to view the 'Due Date' of an issue.</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Issue Security</td>
<td>Permission to set the <strong>security level</strong> on an issue to control who can access the issue. Only relevant if issue security has been <strong>enabled</strong>.</td>
</tr>
<tr>
<td>Transition Issues</td>
<td>Permission to <strong>transition</strong> (change) the status of an issue.</td>
</tr>
<tr>
<td>Voters &amp; Watchers Permissions</td>
<td><strong>Explanation</strong></td>
</tr>
<tr>
<td>Manage Watcher List</td>
<td>Permission to manage (i.e. view/add/remove users to/from) the <strong>watcher list</strong> of an issue.</td>
</tr>
<tr>
<td>View Voters and Watchers</td>
<td>Permission to view the <strong>voter list</strong> and <strong>watcher list</strong> of an issue. Also see the Manage Watcher List permission.</td>
</tr>
<tr>
<td>Comments Permissions</td>
<td><strong>Explanation</strong></td>
</tr>
<tr>
<td>Add Comments</td>
<td>Permission to <strong>add comments</strong> to issues. Note that this does not include the ability to edit or delete comments.</td>
</tr>
<tr>
<td>Delete All Comments</td>
<td>Permission to delete any <strong>comments</strong>, regardless of who added them.</td>
</tr>
<tr>
<td>Delete Own Comments</td>
<td>Permission to delete <strong>comments</strong> that were added by the user.</td>
</tr>
<tr>
<td>Edit All Comments</td>
<td>Permission to edit any <strong>comments</strong>, regardless of who added them.</td>
</tr>
<tr>
<td>Edit Own Comments</td>
<td>Permission to edit <strong>comments</strong> that were added by the user.</td>
</tr>
<tr>
<td>Attachments Permissions</td>
<td><strong>Explanation</strong></td>
</tr>
<tr>
<td>Create Attachments</td>
<td>Permission to <strong>attach files</strong> to an issue. (Only relevant if attachments are <strong>enabled</strong>). Note that this does not include the ability to delete attachments.</td>
</tr>
<tr>
<td>Delete All Attachments</td>
<td>Permission to delete any <strong>attachments</strong>, regardless of who added them.</td>
</tr>
<tr>
<td>Delete Own Attachments</td>
<td>Permission to delete <strong>attachments</strong> that were added by the user.</td>
</tr>
<tr>
<td>Time Tracking Permissions</td>
<td><strong>Explanation</strong></td>
</tr>
<tr>
<td>Work On Issues</td>
<td>Permission to <strong>log work</strong> against an issue, i.e. create a worklog entry. (Only relevant if <strong>Time Tracking</strong> is enabled).</td>
</tr>
<tr>
<td>Delete All Worklogs</td>
<td>Permission to delete any <strong>worklog entries</strong>, regardless of who added them. (Only relevant if <strong>Time Tracking</strong> is enabled). Also see the Work On Issues permission.</td>
</tr>
<tr>
<td>Delete Own Worklogs</td>
<td>Permission to delete <strong>worklog entries</strong> that were added by the user. (Only relevant if <strong>Time Tracking</strong> is enabled). Also see the Work On Issues permission.</td>
</tr>
</tbody>
</table>
Supported Fields
- **Project**

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✗ | ✗ | ✓ | ✓ | ✗ | ✗ | ✓ | ✓ | ✓ | ✓ | ✗ | ✓ | ✓ | ✗ |

Examples
- Find open issues in projects where you have the "Resolve Issues" permission:

```
project in projectsWhereUserHasPermission("Resolve Issues") AND status = Open
```

^top of functions | ^^top of topic

`projectsWhereUserHasRole(rolename)`

Find issues in projects where you have a specific role.

Note that this function is only available if you are logged in to JIRA.

Syntax

```
projectsWhereUserHasRole(rolename)
```

Supported Fields
- **Project**

Supported Operators

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✗ | ✗ | ✓ | ✓ | ✗ | ✗ | ✓ | ✓ | ✓ | ✓ | ✗ | ✓ | ✓ | ✗ |

Examples
- Find open issues in projects where you have the "Developers" role:

```
project in projectsWhereUserHasRole("Developers") AND status = Open
```

^top of functions | ^^top of topic

`releasedVersions()`

Perform searches based on the released versions (i.e. versions that your JIRA administrator has released) of a specified project.

You can also search on the released versions of all projects, by omitting the `project` parameter.

See also `latestReleasedVersion()`.

Syntax
releasedVersions()

or

releasedVersions(project)

**Supported Fields**

- **AffectedVersion**
- **FixVersion**
- custom fields of type Version

**Supported Operators**

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Examples**

- Find issues whose **FixVersion** is a released version of the ABC project:

  ```
  fixVersion in releasedVersions(ABC)
  ```

- Find issues that relate to released versions of the ABC project:

  ```
  (affectedVersion in releasedVersions(ABC)) or (fixVersion in releasedVersions(ABC))
  ```

---

**standardIssueTypes()**

Perform searches based on "standard" **Issue Types**, that is, search for issues which are not **sub-tasks**.

See also **subtaskIssueTypes()**.

**Syntax**

```
standardIssueTypes()
```

**Supported Fields**

- **Type**

**Supported Operators**

<table>
<thead>
<tr>
<th>=</th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Examples**

- Find issues that are not subtasks (i.e. issues whose Issue Type is a standard issue type, not a subtask issue type):
issuetype in standardIssueTypes()

^top of functions | ^^top of topic

startOfDay()

Perform searches based on the start of the current day. See also startOfWeek, startOfMonth and startOfYear; and endOfDay, endOfWeek, endOfMonth and endOfYear.

Syntax

```java
startOfDay()
```

or

```java
startOfDay("inc")
```

where `inc` is an optional increment of `(+/-)nn(y|M|w|d|h|m)`

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. `startOfDay("+1")` is the same as `startOfDay("+1d")`.
- If the plus/minus `(+/-)` sign is omitted, plus is assumed.

Supported Fields
- Created
- Due
- Resolved
- Updated
- custom fields of type Date/Time

Supported Operators

| = | != | ~ | !~ | > | >= | <= | IS | IN | NOT | IS NOT | IN NOT | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✗ | ✔ | ✗ | ✔ | ✔ | ✗ | ✔ | ✔ | ✗ | ✔ | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) | (only in predicate) |

Examples

- Find new issues created since the start of today:

  ```java
  created > startOfDay()
  ```

- Find new issues created since the start of yesterday:

  ```java
  created > startOfDay("-1")
  ```

- Find new issues created in the last three days:

  ```java
  created > startOfDay("-3d")
  ```

^top of functions | ^^top of topic
startOfMonth()

Perform searches based on the start of the current month. See also startOfDay, startOfWeek and startOfYear; and endOfDay, endOfWeek, endOfMonth and endOfYear.

Syntax

```
startOfMonth()
```

or

```
startOfMonth("inc")
```

where inc is an optional increment of (+/-)nn(y|M|w|d|h|m)

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. `startOfMonth("+1")` is the same as `startOfMonth("+1M")`.
- If the plus/minus (+/-) sign is omitted, plus is assumed.

Supported Fields

- Created
- Due
- Resolved
- Updated
- custom fields of type Date/Time

Supported Operators

```
| = | != | ~ | =~ | > | >= | < | <= | IS | IS NOT | IN | NOT | IN | WAS | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |
```

Examples

- Find new issues since the start of this month:

```
created > startOfMonth()
```

- Find new issues since the start of last month:

```
created > startOfMonth("-1")
```

- Find new issues since the 15th of this month:

```
created > startOfMonth("+14d")
```

startOfWeek()

Perform searches based on the start of the current week. See also startOfDay, startOfMonth and startOfYear; and endOfDay, endOfWeek, endOfMonth and endOfYear.

For the startOfWeek() function the result depends upon your locale. For example, in Europe the first day of the week is generally considered to be Monday, while in the USA it is considered to be Sunday.

ℹ️ See Setting Locale in JIRA for more information.
Syntax

\[
\text{startOfWeek()}
\]

or

\[
\text{startOfWeek("inc")}
\]

where \textit{inc} is an optional increment of \((+/-)\)nn\{y|M|w|d|h|m\}

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. \text{startOfWeek("+1")} is the same as \text{startOfWeek("+1w")}.
- If the plus/minus \((+/-)\) sign is omitted, plus is assumed.

Supported Fields

- \text{Created}
- \text{Due}
- \text{Resolved}
- \text{Updated}
- \text{custom} fields of type Date/Time

Supported Operators

\[
\begin{array}{cccccccc}
= & \ne & \sim & \ne & > & >= & < & <= & \text{IS} & \text{IS} & \text{NOT} & \text{IN} & \text{NOT IN} & \text{WAS} & \text{WAS IN} & \text{WAS NOT} & \text{WAS NOT IN} & \text{CHA}
\end{array}
\]

Examples

- Find new issues since the start of this week:

\[
\text{created} > \text{startOfWeek()}
\]

- Find new issues since the start of last week:

\[
\text{created} > \text{startOfWeek("-1")}
\]

^top of functions | ^^top of topic

\text{startOfYear()}

Perform searches based on the start of the current year. See also \text{startOfDay}, \text{startOfWeek} and \text{startOfMonth}; \text{endOfDay}, \text{endOfWeek}, \text{endOfMonth} and \text{endOfYear}.

\[
\text{startOfYear()}
\]

or

\[
\text{startOfYear("inc")}
\]

where \textit{inc} is an optional increment of \((+/-)\)nn\{y|M|w|d|h|m\}

- If the time unit qualifier is omitted it defaults to the natural period of the function, e.g. \text{startOfYear("+1")} is the same as \text{startOfYear("+1y")}.
") is the same as `startOfYear("+1y")`.

- If the plus/minus (+/-) sign is omitted, plus is assumed.

Supported Fields

- `Created`
- `Due`
- `Resolved`
- `Updated`
- `custom` fields of type Date/Time

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Examples

- Find new issues since the start of this year:

  ```
  created > startOfYear()
  ```

- Find new issues since the start of last year:

  ```
  created > startOfYear("-1")
  ```

^top of functions | ^^top of topic

`subtaskIssueTypes()`

Perform searches based on issues which are sub-tasks.

See also `standardIssueTypes()`.

Syntax

```
subtaskIssueTypes()
```

Supported Fields

- `Type`

Supported Operators

<table>
<thead>
<tr>
<th></th>
<th>!=</th>
<th>~</th>
<th>!~</th>
<th>&gt;</th>
<th>&gt;=</th>
<th>&lt;</th>
<th>&lt;=</th>
<th>IS</th>
<th>IS NOT</th>
<th>IN</th>
<th>NOT IN</th>
<th>WAS</th>
<th>WAS IN</th>
<th>WAS NOT</th>
<th>WAS NOT IN</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Examples

- Find issues that are subtasks (i.e. issues whose Issue Type is a subtask issue type):

  ```
  issuetype in subtaskIssueTypes()
  ```

^top of functions | ^^top of topic

`unreleasedVersions()`
Perform searches based on the unreleased versions (i.e. versions that your JIRA administrator has not yet released) of a specified project.

You can also search on the unreleased versions of all projects, by omitting the project parameter.

See also earliestUnreleasedVersion().

Syntax

unreleasedVersions()

or

unreleasedVersions(project)

Supported Fields

- AffectedVersion
- FixVersion
- custom fields of type Version

Supported Operators

|  |  |  |  | IS | IS NOT | IN | NOT IN | WAS | WAS IN | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|
| x | x | x | x | x | x | x | x | x | x | x | x | x |

Examples

- Find issues whose FixVersion is an unreleased version of the ABC project:

  fixVersion in unreleasedVersions(ABC)

- Find issues that relate to unreleased versions of the ABC project:

  affectedVersion in unreleasedVersions(ABC)

  or

  fixVersion in unreleasedVersions(ABC)

votedIssues()

Perform searches based on issues for which you have voted. Also see the Voter field.

Note that this function can only be used by logged-in users.

Syntax

votedIssues()

Supported Fields

- Issue

Supported Operators
Examples

- Find issues that you have voted for:

  ```java
  issue in votedIssues()
  ```

^top of functions | ^^top of topic

**watchedIssues()**

Perform searches based on issues which you are watching. Also see the **Watcher** field.

Note that this function can only be used by logged-in users.

Syntax

```java
watchedIssues()
```

**Supported Fields**

- **Issue**

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| × | × | × | × | × | × | × | × | ✔ | ✔ | × | × | × | × | × | × |

Examples

- Find issues that you are watching:

  ```java
  issue in watchedIssues()
  ```

**Supported Fields**

- **Issue**

**Supported Operators**

| = | != | ~ | !~ | > | >= | < | <= | IS | IS NOT | IN | NOT IN | WAS | WAS | WAS NOT | WAS NOT IN | CHANGED |
|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|---|
| × | × | × | × | × | × | × | × | ✔ | ✔ | × | × | × | × | × | × |

Examples

- Find issues that you have recently viewed:

  ```java
  issue in issueHistory()
  ```

^top of functions | ^^top of topic

**Reserved Characters**
JQL has a list of reserved characters:

- space (" ")
- " + =
- ", =
- "/ =
- " =
- ": =
- " ? =
- "| =
- " * =
- "/ =
- " % =
- " ^ =
- " $ =
- " # =
- " @ =
- " [ =
- " ] =

If you wish to use these characters in queries, you need to:

- surround them with quote-marks (you can use either single quote-marks (' ) or double quote-marks (" ));
  - and, if you are searching a text field and the character is on the list of reserved characters for Text Searches,
  - precede them with two backslashes.

The text fields are:

- Summary
- Description
- Environment
- Comments
- Custom fields which use the "Free Text Searcher"; this includes custom fields of the following built-in Custom Field Types
  - Free Text Field (unlimited text)
  - Text Field (< 255 characters)
  - Read-only Text Field

The JQL field "text" as in text ~ "some words" searches an issue's Summary, Description, Environment, Comments. It also searches all text custom fields. If you have many text custom fields you can improve performance of your queries by searching on specific fields, e.g.

Summary ~ "some words" OR Description ~ "some words"

For example:

```jql
version = "[example]"
```

```jql
version = "4.2"
```

```jql
summary ~ "\[example\]"
```

```jql
summary ~ "4.2"
```

Reserved Words
JQL has a list of reserved words. These words need to be surrounded by quote-marks if you wish to use them in queries:

"abort", "access", "add", "after", "alias", "all", "alter", "and", "any", "as", "asc",
"audit", "avg", "before", "begin", "between", "boolean", "break", "by", "byte", "catch", "cf",
"char", "character", "check", "checkpoint", "collate", "collation", "column", "commit", "connect", "continue",
"count", "create", "current", "date", "decimal", "declare", "decrement", "default", "defaults", "define", "delete",
"delimiter", "desc", "difference", "distinct", "divide", "do", "double", "drop", "else", "empty", "encoding",
"first", "float", "for", "from", "function", "go", "goto", "grant", "greater", "group", "having",
"identified", "if", "immediate", "in", "increment", "index", "initial", "inner", "inout", "input", "insert",
"int", "integer", "intersect", "intersection", "into", "is", "isempty", "isnull", "join", "last", "left",
"less", "like", "limit", "lock", "long", "max", "min", "minus", "mode", "modify",
"modulo", "more", "multiply", "next", "noaudit", "not", "notin", "nowait", "null!", "number", "object",
"of", "on", "option", "or", "order", "outer", "output", "power", "previous", "prior", "privileges",
"public", "raise", "raw", "remainder", "rename", "resource", "return", "returns", "revoke", "right", "row",
"rowid", "rownum", "rows", "select", "session", "set", "share", "size", "sqrt", "start", "strict",
"string", "subtract", "sum", "synonym", "table", "then", "to", "trans", "transaction", "trigger", "true",
"uid", "union", "unique", "update", "user", "validate", "values", "view", "when", "whenever", "where",
"while", "with"

You can use either single quote-marks (') or double quote-marks (").

(Note for JIRA administrators: this list is hard coded in the JqlStringSupportImpl.java file.)

| = | != | ~ | !~ | > | >= | < | <= | IS | NOT | IN | NOT | IN | WAS | WAS | WAS | WAS | NOT | NOT | IN | CHANGED |
| ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✔ | ✔ | ✔ | ✗ | ✗ | ✔ | ✔ | ✗ | ✗ | ✗ | ✗ | ✔ | ✗ | ✗ | ✗ | ❌ |

• This function accepts 1 to 100 globalIds. Specifying 0 or more than 100 globalIds will result in errors.

Performing Text Searches

This page provides information on how to perform text searches. It applies to both basic searches and advanced searches (when used with the CONTAINS operator). This page also applies to quick search when performing a text search on the fields that this feature supports.

Acknowledgements:

JIRA uses Apache Lucene for text indexing, which provides a rich query language. Much of the information on this page is derived from the Query Parser Syntax page of the Lucene documentation.

Query terms

A query is broken up into terms and operators. There are two types of terms: Single Terms and Phrases.

A Single Term is a single word such as "test" or "hello".

A Phrase is a group of words surrounded by double quotes such as "hello dolly".

Multiple terms can be combined together with Boolean operators to form a more complex query (see below). If you combine multiple terms without specifying any Boolean operators, they will be joined using AND operators.

Note: All query terms in JIRA are case insensitive.
Term modifiers

JIRA supports modifying query terms to provide a wide range of searching options.

**Wildcard searches:** ? and *  |  **Fuzzy searches:** ~  |  **Proximity searches**

**Wildcard searches:** ? and *

JIRA supports single and multiple character wildcard searches.

To perform a single character wildcard search use the "?" symbol.

To perform a multiple character wildcard search use the "*" symbol.

Wildcard characters need to be enclosed in quote-marks, as they are reserved characters in advanced search. Use quotations, e.g. summary ~ "cha?k and che*"

The single character wildcard search looks for terms that match that with the single character replaced. For example, to search for "text" or "test" you can use the search:

```
t??t
```

Multiple character wildcard searches looks for 0 or more characters. For example, to search for Windows, Win95 or WindowsNT you can use the search:

```
win*
```

You can also use the wildcard searches in the middle of a term. For example, to search for Win95 or Windows9 you can use the search

```
wi*95
```

You cannot use a * or ? symbol as the first character of a search. The feature request for this is JRA-621.

**Fuzzy searches:** ~
JIRA supports fuzzy searches. To do a fuzzy search use the tilde, "~", symbol at the end of a single word term. For example to search for a term similar in spelling to "roam" use the fuzzy search:

roam~

This search will find terms like foam and roams.

Note: Terms found by the fuzzy search will automatically get a boost factor of 0.2

Proximity searches

JIRA supports finding words that are within a specific distance away. To do a proximity search use the tilde, "~", symbol at the end of a Phrase. The word order should be the same as it appears in the field you are searching. For example to search for "atlassian" and "jira" within 10 words of each other in a document use the search:

text ~ "atlassian jira"~10'

If you use more than 2 search words, the distance number should be the minimum number of non matching words in between all the search words. For example, if you are searching for the string oink werewolf giraffe and coyote dotty not sloop then the following would be the right query:

text ~ "oink and sloop"~5'

Boosting a term: ^

JIRA provides the relevance level of matching documents based on the terms found. To boost a term use the caret, "^", symbol with a boost factor (a number) at the end of the term you are searching. The higher the boost factor, the more relevant the term will be.

Boosting allows you to control the relevance of a document by boosting its term. For example, if you are searching for atlassian jira and you want the term "atlassian" to be more relevant boost it using the ^ symbol along with the boost factor next to the term. You would type:

atlassian^4 jira

This will make documents with the term atlassian appear more relevant. You can also boost Phrase Terms as in the example:

"atlassian jira"^4 querying

By default, the boost factor is 1. Although, the boost factor must be positive, it can be less than 1 (i.e., .2)

Boolean operators

Boolean operators allow terms to be combined through logic operators. JIRA supports AND, "+", OR, NOT and "-" as Boolean operators.
**OR**
The OR operator is the default conjunction operator. This means that if there is no Boolean operator between two terms, the OR operator is used. The OR operator links two terms and finds a matching document if either of the terms exist in a document. This is equivalent to a union using sets. The symbol `||` can be used in place of the word OR.

To search for documents that contain either "atlassian jira" or just "confluence" use the query:

```
"atlassian jira" || confluence
```

or

```
"atlassian jira" OR confluence
```

**AND**
The AND operator matches documents where both terms exist anywhere in the text of a single document. This is equivalent to an intersection using sets. The symbol `&&` can be used in place of the word AND.

To search for documents that contain "atlassian jira" and "issue tracking" use the query:

```
"atlassian jira" AND "issue tracking"
```

**Required term: +**
The "+" or required operator requires that the term after the "+" symbol exist somewhere in a the field of a single document.

To search for documents that must contain "jira" and may contain "atlassian" use the query:

```
+jira atlassian
```

**NOT**
The NOT operator excludes documents that contain the term after NOT. This is equivalent to a difference using sets. The symbol `!` can be used in place of the word NOT.

To search for documents that contain "atlassian jira" but not "japan" use the query:

```
"atlassian jira" NOT "japan"
```

**Note:** The NOT operator cannot be used with just one term. For example, the following search will return no results:

```
NOT "atlassian jira"
```

Usage of the NOT operator over multiple fields may return results that include the specified excluded term. This is due to the fact that the search query is executed over each field in turn and the result set
for each field is combined to form the final result set. Hence, an issue that matches the search query based on one field, but fails based on another field, will be included in the search result set.

**Excluded term:** -

The "-" or prohibit operator excludes documents that contain the term after the "-" symbol.

To search for documents that contain "atlassian jira" but not "japan" use the query:

"atlassian jira" -japan

**Grouping**

JIRA supports using parentheses to group clauses to form sub queries. This can be very useful if you want to control the boolean logic for a query.

To search for bugs and either atlassian or jira, use the query:

bugs AND (atlassian OR jira)

This eliminates any confusion and makes sure you that bugs must exist and either term atlassian or jira may exist.

**Do not use the grouping character '(' at the start of a search query, as this will result in an error. For example, "(atlassian OR jira) AND bugs" will not work.**

**Escaping special characters:** \ or \\

JIRA supports the ability to search issues for special characters by escaping them in your query syntax. The current list of such characters is:

```
+ - & | ! ( ) { } [ ] ^ ~ * ? : 
```

To escape these characters, type a backslash character '\\' before the special character (or if using Advanced Searching, type two backslashes '\\\' before the special character).

For example, to search for \(1+1\) in either a simple or quick search, use the query:

```
\(1\+1\)
```

and to search for \[example\] in the summary of an advanced search (in JIRA Query Language or JQL), use the query:

```
summary ~ "\\[example\\]"
```

**Please note:** If you are using Advanced Searching — please see Reserved Characters for more information about how these characters and others are escaped in JIRA Query Language.

**Reserved words**

To keep the search index size and search performance optimal in JIRA, the following English reserved words (al
so known as 'stop words') are ignored from the search index and hence, JIRA's text search features:

"a", "and", "are", "as", "at", "be", "but", "by", "for", "if", "in", "into", "is", "it", "no", "not", "of", "on", "or", "s", "such", "t", "that", "the", "their", "then", "there", "these", "they", "this", "to", "was", "will", "with"

Be aware that this can sometimes lead to unexpected results. For example, suppose one issue contains the text phrase "VSX will crash" and another issue contains the phrase "VSX will not crash". A text search for "VSX will crash" will return both of these issues. This is because the words will and not are part of the reserved words list.

Your JIRA administrator can make JIRA index these reserved words (so that JIRA will find issues based on the presence of these words) by changing the Indexing Language to Other (under Administration > System > General Configuration).

Word stemming

Since JIRA cannot search for issues containing parts of words (see below), word 'stemming' allows you to retrieve issues from a search based on the 'root' (or 'stem') forms of words instead of requiring an exact match with specific forms of these words. The number of issues retrieved from a search based on a stemmed word is typically larger, since any other issues containing words that are stemmed back to the same root, will also be retrieved in the search results.

For example, if you search for issues using the query term 'customize' on the Summary field, JIRA stems this word to its root form 'custom' and will retrieve all issues whose Summary field also contains any word that can be stemmed back to 'custom'. Hence, the following query:

```
summary ~ "customize"
```

will retrieve issues whose Summary field contains the following words:

- customized
- customizing
- customs
- customer
- etc.

Please Note:

- Your JIRA administrator can disable word stemming (so that JIRA will find issues based on exact matches with words) by changing the Indexing Language to Other (under Administration > System > General Configuration).
- Word stemming applies to all JIRA fields (as well as text fields).
- When JIRA indexes its fields, any words that are 'stemmed' are stored in JIRA's search index in root form only.

Limitations

Please note that the following limitations apply to JIRA's search:

Whole words only

JIRA cannot search for issues containing parts of words but on whole words only. The exception to this are words which are stemmed.

This limitation can also be overcome using fuzzy searches.

Using the Issue Navigator

JIRA is optimized to let you quickly navigate lists of issues, switch to a detail view from the basic list view and back again, and take action on those items that need your immediate attention.
List View

If you've used JIRA for some time, the list view is the view you are used to seeing; namely, the search results from a filter, a basic search, a quick search, or an advanced search. You only see one set of search results at any given time, even if you have multiple browser windows open. And with stable search, your search results remain constant until you choose to refresh them. This provides you with a constant set of search results that you can work from when triaging issues. Since your search results don't change as you are making changes to the list, you maintain the original list you started with.

Detail View

JIRA is optimized to let you quickly navigate lists of issues, switch to a detail view from the basic list view and back again, and take action on those items that need your immediate attention. The detail view lets you view an issue within the context of the filter it’s a part of. This is great when you are triaging issues and you need a bit more context.

Filters

You can easily save your searches, then display them as needed. In JIRA, we call these filters. Filters are basically bookmarked collections of issues.

Example basic search results in the issue navigator (click to view full size image)

You can also hide the filter panel to gain more screen real estate. Simply click Undock at the top right of the panel. The filter panel collapses as show below:
Docking and undocking the filter panel (click to view full size image)

To redisplay the panel, click the arrow and then select the word Dock that appears. This puts the filter panel back in its place.

On this page:
- List View
- Detail View
- Filters
- Working with issues
- Viewing individual issues

Related topics:
- Advanced Searching
- Basic Searching
- Customizing your Issue Navigator
- Using Filters
- Sharing a Search Result
- Working with Search Result Data

Working with issues

To get started, go to Issues > Search for Issues. From this point, there are many different ways to work with issues and filters, described below.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced</td>
<td>Switches from basic to advanced search, or JIRA Query Language (JQL) search. For details, see Advanced Searching.</td>
</tr>
<tr>
<td>Basic</td>
<td>Switches from advanced to basic search, or User Interface search. For details, see Basic Searching.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Keyboard shortcuts</td>
<td>Use the 'j' and 'k' keys on your keyboard to move between issues. The row for the currently selected issue is highlighted in blue and any keyboard shortcuts are performed on this issue.</td>
</tr>
</tbody>
</table>
| Sort | Click any field header in the search results to sort by that field in ascending order. Click again to sort in descending order. **Note:**  
  - You cannot sort by the 'Images' column nor the sub-task aggregate columns (i.e. all columns beginning with ").  
  - If you sort the search results from an advanced search, an 'ORDER BY' clause will be added to your JQL query to reflect the order of issues in your search results. If the JQL query already has an 'ORDER BY' clause, it will be updated.  
  - You can choose different fields to display in your Issue Navigator. See Customizing your Issue Navigator. |
| Filters | Click a filter name to run the filter. The JIRA system filters – **My Open Issues, Reported by Me, Recently Viewed, All Issues** – and your favorite filters are displayed in the list. For details, see Using Filters. |
| Share | Click to email the search results to other users or email addresses. From the Share dialog, you can also find a permanent link to the search results. For details, see Sharing a Search Result. |
| Export | Click and select from the dropdown menu to view/export your search results in various formats, e.g. XML, MS Excel, etc. For details, see Working with Search Result Data. |
Tools

This is the actions menu for the search results, not for individual issues.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bulk Change</td>
<td>Enables operations to be performed on multiple issues at once. These</td>
</tr>
<tr>
<td></td>
<td>operations are performed on the result set of a search. The following list</td>
</tr>
<tr>
<td></td>
<td>details the available bulk operations:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Workflow Transition</strong></td>
</tr>
<tr>
<td></td>
<td>This operation allows multiple issues to be transitioned through workflow</td>
</tr>
<tr>
<td></td>
<td>at once — e.g. resolve a collection of issues.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delete</strong></td>
</tr>
<tr>
<td></td>
<td>This operation allows multiple issues to be deleted at once.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Move</strong></td>
</tr>
<tr>
<td></td>
<td>This operation allows multiple issues to be moved between projects</td>
</tr>
<tr>
<td></td>
<td>and/or issue types at once.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Edit</strong></td>
</tr>
<tr>
<td></td>
<td>This operation allows multiple fields in multiple issues to be edited at</td>
</tr>
<tr>
<td></td>
<td>once.</td>
</tr>
<tr>
<td></td>
<td>For details, see <a href="#">Modifying Multiple ('Bulk') Issues</a>.</td>
</tr>
<tr>
<td>Configure</td>
<td>You can customize your Issue Navigator by choosing:</td>
</tr>
<tr>
<td>Columns</td>
<td>• the <strong>columns</strong> (i.e. issue fields) to display</td>
</tr>
<tr>
<td></td>
<td>• how many <strong>rows</strong> (i.e. issues) to display</td>
</tr>
<tr>
<td></td>
<td>For details, see <a href="#">Customizing your Issue Navigator</a>.</td>
</tr>
<tr>
<td>Set filters</td>
<td>Lets you set an associated Column Order with a saved filter. Displays the</td>
</tr>
<tr>
<td>column order</td>
<td>same screen discussed in <a href="#">Customizing your Issue Navigator</a>.</td>
</tr>
</tbody>
</table>

Issue actions

This is the actions menu for an issue – located next to an issue in the search results – not for all of the search results.

Click and select from the dropdown menu to action the issue. If the icon is not showing, hover over the issue. For details, see [Working with an Issue](#).

Some options in this menu will only be available if you have the necessary permissions, or if certain features have been enabled by your JIRA administrator.

Viewing individual issues

When an issue from a search result set is selected and displayed, a mini-navigator is shown at the right of the issue's title bar:

This mini-navigator indicates the current issue's position within the result set. It also provides linked arrow icons to the previous and next issues in the result set (as shown in the image above), along with a Return to search link that leads you back to the search results. You can also navigate through the search results by using the shortcut keys: 'p' (previous) and 'n' (next).

Customizing your Issue Navigator
JIRA lets you change the columns of the table of search results for any search results displayed using the List view (as opposed to the Detail View). Click **Columns** at top right of the issue table to open the column configuration dialog, shown below.

![Column Configuration Dialog](image)

This displays the list of the columns used in the current table of results. Choose the columns you want with checkboxes and click **Done** to finish. Notice that the Filter option is greyed out, this is because the the issue table results are not coming from a filter. See [Changing the column configuration for your own filters](#) for an example of using this dialog to set the displayed columns for your own filters.

**Sorting and rearranging columns**

- To sort issues, just click on a column header.
- To rearrange the column layout, press and hold the mouse button to enter "column drag mode."

**My Defaults, Filter, and System**

If the currently selected button is **My Defaults**, this indicates that the columns you are seeing are from your user account preferences. **Filter** is an available option whenever the issue search results come from a saved filter. If you are a JIRA Admin, you will also see the **System** tab, where you can change the columns for all users who have not set their own defaults.

JIRA administrators can configure the columns that appear in the Issue Navigator for all users that do not have personal column filters defined. When administrators are configuring default columns, their permissions are ignored, so that they can add a project-specific custom field from a project that they do not have permissions to browse. The field would never be actually shown to users that do not have permissions to see it.
Changing the column configuration for your own filters

If you are searching using a saved filter and if the filter is owned by you, use the Filter button to customize the columns displayed when users see results from that filter. When sharing a filter with other users, it's sometimes helpful to choose the relevant columns for those results. For example, if your filter searches for issues that are open bugs, you may decide to remove the columns for status and issue type for that filter since they will all be the same. Filters don't always have columns configured, but when they do, those columns will be shown unless the user chooses to use their defaults using the My Defaults button.

For any JIRA filters that you own, you can change the displayed columns as follows.

1. Click on the name of a JIRA filter you own.
2. Click the Columns button at top right of the currently displayed columns. This opens the column configuration dialog.
3. Select or deselect checked items in the list.
4. Click Done when you are finished.

Troubleshooting

If you cannot find a column, please make sure that you haven't run in to any of the following restrictions:

- You can only see columns for issue fields that have not been hidden and that you have permissions to see.
- It is possible to add any of the existing custom fields to the column list, as long as the fields are visible and you have the right permissions.
- Some custom fields, even if selected, do not appear in the Issue Navigator for all issues. For example, project-specific custom fields will be shown only if the filter has been restricted to that project only. Issue type custom fields will only appear if the filter has been restricted to that issue type.

Using Filters

JIRA's powerful issue search functionality is enhanced by the ability to save searches, called filters in JIRA, for later use. You can do the following with JIRA filters:

- Share and email search results with your colleagues as well as people outside of your organization
- Create lists of favorite filters
- Have search results emailed to you according to your preferred schedule
- View and export the search results in various formats (RSS, Excel, etc)
- Display the search results in a report format
- Display the search results in a dashboard Gadget

Screenshot: Issue filter results in list view (click to view full size image)
To redisplay the panel, click the arrow and then select the word **Dock** that appears. This puts the filter panel back in its place.
Running a filter

Run a filter by clicking it. System filters – *My Open Issues, Reported by Me, Recently Viewed, All Issues* – and your favorite filters are shown on the left of the issue navigator. You can also find and run filters using the Manage Filters page.

To perform a saved search:

2. Choose any filter from the list on the left:
   - **System filter** — *My Open Issues, Reported by Me, Recently Viewed, All Issues*
   - **Favorite filters** (listed alphabetically)
   - **Find filters** lets you search for any filter that's been shared, which you can then subscribe to (adding it to your **Favorite Filters**).
3. After selecting a filter, the search results are displayed. The search criteria for the filter is also displayed.
   - **i** If you choose the *Recently Viewed* system filter, this switches you to advanced search due to the fact that **basic search** cannot represent the **ORDER BY** clause in this filter.
4. You can add, remove or modify the search criteria to refine the search results. You can also save the modified search criteria (if you are updating your own filter), or save a copy of the search criteria as a new filter.

For instructions on adding, removing or modifying filters, see the following sections.

Saving a search as a filter

To save a search as a filter:

1. Define and run your search as described in **Searching for Issues**.
2. Click the **Save as** link above the search results. The **Save Filter** dialog is displayed.

3. Enter a name for the new filter and click **Submit**. Your filter is created.

About saved filters:

- Your new filter is added to your favorite filters.
- Your new filter is shared according to the sharing preference in your user profile.
  - **i** If you have not specified a personal preference, then the global default for sharing applies (i.e. **Private**, unless it’s been changed by your JIRA Administrator).
- You need the Create Shared Object global permission to be able to share your filter. If you do not see the Share field, contact your JIRA Administrator to have this permission added to your profile.
- To change how your new filter is shared, refer to the instructions on sharing filters.
Managing your existing filters

The Manage Filters page allows you to view and configure filters that you have created, as well as work with filters that other users have shared with you. You can access this page by selecting Find filters or through the Issues > Manage Filters menu option.

In this section:
- Searching for a filter
- Updating a filter
- Deleting a filter
- Cloning a Filter
- Adding a filter as a favorite
- Sharing a filter
- Defining a filter-specific column order
- Subscribing to a Filter

Searching for a filter

Filters that you have created or that have been shared by other users can be found using the Manage Filters page. If the filter has been added as a favorite by many users, you also may be able locate it on the Popular tab of the Manage Filters page. This tab lists the top 20 most popular filters.

To search for an existing filter:

1. Choose Issues > Manage Filters.
2. Click the Search tab. The issue filter Search will display.
   - Tip: You can navigate to this screen via the Find filters link on the issue navigator.
3. Enter your search criteria and click Search to run the search.

4. Your search results are displayed on the same page. Click the name of any issue filter to run it. You can also sort the search results by clicking the column headers.
Updating a filter

You can update the details – name, description, sharing, favorite – as well as the search criteria of an existing filter.

Please note that you can only update filters that you have created. To edit a filter that was shared with you, either clone (aka copy) the shared filter or ask your JIRA administrator to change the filter’s ownership.

To update an existing filter:

1. Choose Issues > Manage Filters.
2. Click the My tab. This tab displays all the filters that have been created by you.
3. Locate the filter you wish to update, click the cog icon and select Edit from the dropdown menu.
4. The Edit Current Filter page displays, where you can update the filter details as required. To change the sharing or favorite settings, refer to the relevant instructions below.
If the filter sharing functions shown above are not available to you, you probably do not have the Create Shared Object global permission assigned to you. Please contact your JIRA administrator to obtain this permission.

5. Click **Save** to save your changes.

**To update the search criteria of one of your existing filters:**
1. Choose Issues > Manage Filters.
2. Click the My tab. This tab displays the filters that you've created.
3. Click the name of the filter to run it and display the search results.
4. Update the search criteria as desired and rerun the query to ensure the update is valid. You will see the word Edited displayed next to your filter name.
5. Click Save to overwrite the current filter with the updated search criteria. If you want discard your changes instead, click the arrow next to the save button and select Discard changes.

Deleting a filter

You can delete any filter that you've created using this procedure.

To delete an existing filter:

1. Choose Issues > Manage Filters.
2. Click the My tab. This tab displays all the filters that have been created by you.
3. Locate the filter you wish to update, click the cog icon and select Delete from the dropdown menu.

Cloning a Filter

You can clone any filter – which is just a way of making a copy that you own – that was either created by you or shared with you.

To clone an existing filter:

1. Choose Issues > Manage Filters.
2. Locate the filter you wish to clone, and click the name of the issue filter to run it and display the search results.
3. Update the search criteria as desired. Click the arrow next to the Save button, and select Save > Save as to create a new filter from the existing filter:

To discard your changes instead, click Save > Discard changes.

Adding a filter as a favorite

Filters that you've created or that have been shared by others can be added to your favorite filters. Favorite filters are listed in the menu under Issues > Filters and in the left panel of the issue navigator. You can also add them to your dashboard using the Favorite Filters gadget.

Keep in mind:

- Filters that are already favorites are shown with a star.
- Filters that are not currently your favorites are shown without a star.

There are two ways you can add an existing shared filter as a favorite, described below.

To add a filter as a favorite using the Manage Filters page:

1. Choose Issues > Manage Filters.
2. Locate the filter you wish to add as a favorite. If you created the filter, it is listed under the My tab, otherwise use the Search tab to find it.
3. Click the star icon next to the filter name to add it to your favorites.

To add the filter that you are currently viewing as a favorite:
• Click the star icon next to the filter name.

Sharing a filter

Filters that you have created can be shared with other users via user groups, projects and project roles. They can also be shared globally. Any filter that is shared is visible to users who have the JIRA Administrators global permission via the Shared Filters feature. See Managing Other User’s Shared Filters below for details.

To share an existing filter using the Details button:

1. Choose Issues > Manage Filters.
2. Click the My tab. This tab displays all the filters that have been created by you.
3. Locate the filter you wish to share and click on it.
4. Click the Details link to the right of the filter’s name, as shown here:

5. Click Edit permissions to open the Edit Current Filter screen:

6. Update the Add Shares field by selecting the group, project or project role that you want to share the filter with, and clicking the Add link to add the share. You can add further share permissions if you wish.

   Note that you can only share filters with groups/roles of which you are a member.

   If the filter sharing functions shown above are not available to you, you probably do not have the Create Shared Object global permission assigned to you. Please contact your JIRA administrator to obtain this permission.

7. Click Save to save your changes.

To share an existing filter using Manage Filters:

1. Choose Issues > Manage Filters.
2. Click the My tab. This tab displays all the filters that have been created by you.
3. Locate the filter you wish to update, click the cog icon and select Edit from the dropdown menu.
4. Follow steps 6 and 7 in the previous procedure.

Defining a filter-specific column order

You can add a defined column order to a saved filter, which displays the filter results according to the saved column order. Otherwise, the results are displayed according to your personal column order (if you have set this) or the system default.

To display your configured column order in a filter subscription, select HTML for the Outgoing email format in your User Profile. If you receive text emails from JIRA, you won’t be able to see your configured column order.

To add a column layout to a saved filter:
1. Choose Issues > Manage Filters.
2. Click the My tab. This tab displays all the filters that have been created by you.
3. Locate the filter you wish to update; click the filter’s name to display the results. Be sure you are viewing the filter in the List view so that you see the columns.
4. Configure the column order as desired by clicking on the column name and dragging it to the new position. Your changes are saved and will be displayed the next time you view this filter.

To remove a filter’s saved column layout:
1. Choose Issues > Manage Filters.
2. Click the My tab. This tab displays all the filters that have been created by you.
3. Locate the filter you wish to update; click the filter’s name to display the results. Be sure you are viewing the filter in the List view so that you see the columns.
4. Click the Columns option on the top right of the displayed columns and select Restore Defaults in the displayed window.

Exporting Column Ordered Issues

When the results of a saved filter are exported to Excel, the column order and choice of columns are those that were saved with the filter. Even if a user has configured a personal column order for the results on the screen, the saved configuration is used for the Excel export. To export using your own configuration, save a copy of the filter along with your configuration and then export the results to Excel.

Subscribing to a Filter

Please see Receiving Search Results via Email.

Managing other user’s shared filters

A shared filter is a filter whose creator has shared that filter with other users. Refer to Sharing a Filter above for details. When a shared filter is created by a user, that user:
- Initially ‘owns’ the shared filter.
- Being the owner, can edit and modify the shared filter.

If you have the JIRA Administrators global permission, you can manage shared filters that were created by other users. For instructions, see Managing Shared Filters in the JIRA Administrator’s Guide.

Working with Search Result Data

- Displaying Search Results as a Chart
- Displaying Search Results in XML
- Exporting Search Results to Microsoft Excel
- Exporting Search Results to Microsoft Word
- Receiving Search Results as an RSS Feed
- Receiving Search Results via Email
Sharing a Search Result
Displaying Search Results as a Chart
You can view any search results from the Issue Navigator in a variety of charting formats. You can also save them as a Charting gadget on your dashboard, as described below.

The Charts display visual representations of a filter in a variety of ways. In general, charts are:

- for a period of X days previous to the current date.
- broken down into incremental periods of hours, days, weeks, months, quarters or years.
- hyperlinked to relevant issues in the Issue Navigator.

On this page:
- What do they look like?
- Displaying a chart on your dashboard
- Configuring your Internet Explorer cache settings

Related topics:
- Using Dashboard Gadgets
- Viewing a Chart

What do they look like?
The 'Created vs Resolved Issues' chart, for example, appears as follows:

Screenshot: 'Created vs Resolved Issues' chart

This is just one of the available charting gadgets, which include:

- 'Created vs Resolved Issues'— a difference chart showing the issues created vs resolved over a given period.
  - This chart can either be cumulative or not.
  - Areas in red show periods where more issues were created than resolved, areas in green show periods where more were resolved than created.
  - Versions can also be added to this chart, showing you how issue creation and resolution related to version releases.
- 'Resolution Time'— a bar chart showing the average resolution time (in days) of resolved issues.
  - This is useful to show you over time whether your team is getting better or worse at resolving
issues in a timely fashion.

- 'Pie Chart' — displays issues grouped by a statistic type in pie-chart format
  - The issues can be grouped by any statistic type (e.g. Status, Priority, etc.)
- 'Average-Age Open Issues' — a bar chart showing the average number of days that issues have been unresolved
  - This chart displays the average of how long issues remain open on a specified interval (e.g. daily, weekly, etc.)
- 'Recently Created Issues' — a chart showing the issues recently created.
  - The green portion of the bar shows the created issues which are resolved, the red portion shows created but as yet unresolved issues.
  - This visually shows both how quickly you're creating issues, as well as how many of those created issues are resolved.
- 'Time Since Issues' — displays a bar chart showing the number of issues for which your chosen date field (e.g. 'Created', 'Updated', 'Due', 'Resolved', or a date custom field) was set on a given date.
- 'Average Time in Status' — displays the average number of days issues have spent in a status.
- 'Average Number of Times in Status' ¹ — displays the average number of times an issues has been in a status.
- 'Time to First Response' — displays the average number of times an issues has been in a status.

¹ This particular chart will only be available if your JIRA administrator has installed the JIRA Charting plugin.

### Displaying a chart on your dashboard

To view your search results as a chart:

1. Choose **Issues > Search for Issues**.
2. Refine your search, as described in **Searching for Issues**, then choose the **Export** menu.
3. Choose **Charts** from the dropdown menu.
4. Your search results will be displayed as the default chart.

5. Click **Save to Dashboard**.
6. Select a project dashboard and name your gadget in the **Filter Name** field.
7. Click **Save**. Your new dashboard gadget is displayed.

Further information on all JIRA dashboard gadgets is available in the **Using Dashboard Gadgets** documentation.

### Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

**Configuring your Internet Explorer cache settings**

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:
1. Select 'Internet Options' from the 'Tools' menu:

![Internet Options window](image)

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:

![Temporary Internet files settings](image)

3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.
Displaying Search Results in XML

The JIRA Issue Navigator enables you to display your search results in XML format, suitable for use with the Confluence JIRA Issues Macro, for example. (Also suitable for use as an RSS 0.9.2 feed. Note: for an RSS 2.0 feed, please see 'Receiving Search Results via RSS'.)

You can choose which fields to include in the XML output, as described below.

**Exporting to XML**

To display your search results in XML format:

1. Choose **Issues > Search for Issues**.
2. Refine your search, as described in **Searching for Issues**, then choose the **Export** menu.
3. Choose **XML** from the dropdown menu.
4. Your search results will be displayed in XML format. Note:
   - If you wish to restrict which fields are included in the XML output, use the `field` parameter as described below.
   - To choose how many issues are included in the XML output, change the value of the `tempMax` parameter. The default is 1,000 issues (i.e. `tempMax=1000`).
5. Copy the URL that is currently displayed on your screen.
6. If you are using the Confluence JIRA Issues Macro, paste the URL into your Confluence document as described in the Confluence documentation.

### Choosing which fields to include

To restrict which issue fields are returned in the XML export, specify the `field` parameter in your URL. For example, to include only the Issue key and Summary, add `&field=key&field=summary` to the URL.

Note:

- If the `field` parameter is not specified, the XML output will include all the issue fields.
- If one or more `field` parameters are specified, the XML output will contain only the Issue key plus your chosen field(s).

The complete list of available values for the `field` parameter is as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Sample XML output</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td><code>&lt;title&gt;[TEST-4] This is a test&lt;/title&gt;</code></td>
</tr>
<tr>
<td>link</td>
<td><code>&lt;link&gt;https://extranet.atlassian.com:443/jira/browse/</code></td>
</tr>
<tr>
<td><strong>project (or pid)</strong></td>
<td>&lt;project id=&quot;10330&quot; key=&quot;TST&quot;&gt;Test&lt;/project&gt;</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td><strong>description</strong></td>
<td>&lt;description&gt;This is a detailed description of the is</td>
</tr>
<tr>
<td></td>
<td>&lt;/description&gt;</td>
</tr>
<tr>
<td><strong>environment</strong></td>
<td>&lt;environment&gt;Sydney network&lt;/environment&gt;</td>
</tr>
<tr>
<td><strong>key</strong></td>
<td>&lt;key id=&quot;22574&quot;&gt;TEST-4&lt;/key&gt;</td>
</tr>
<tr>
<td><strong>summary</strong></td>
<td>&lt;summary&gt;This is a test&lt;/summary&gt;</td>
</tr>
<tr>
<td><strong>type (or issuetime)</strong></td>
<td>&lt;type id=&quot;3&quot; iconUrl=&quot;https://extranet.atlassian.com:443/jira/images/icons/task.gif&quot;&gt;Task&lt;/type&gt;</td>
</tr>
<tr>
<td><strong>parent</strong></td>
<td>&lt;parent id=&quot;22620&quot;&gt;TEST-5&lt;/parent&gt;</td>
</tr>
<tr>
<td><strong>priority</strong></td>
<td>&lt;priority id=&quot;4&quot; iconUrl=&quot;https://extranet.atlassian.com:443/jira/images/icons/priority_minor.gif&quot;&gt;Minor&lt;/priority&gt;</td>
</tr>
<tr>
<td><strong>status</strong></td>
<td>&lt;status id=&quot;5&quot; iconUrl=&quot;https://extranet.atlassian.com:443/jira/images/icons/status_resolved.gif&quot;&gt;Resolved&lt;/status&gt;</td>
</tr>
<tr>
<td><strong>resolution</strong></td>
<td>&lt;resolution id=&quot;1&quot;&gt;Fixed&lt;/resolution&gt;</td>
</tr>
<tr>
<td><strong>labels</strong></td>
<td>&lt;labels&gt; focus &lt;/labels&gt;</td>
</tr>
<tr>
<td><strong>assignee</strong></td>
<td>&lt;assignee username=&quot;jsmith&quot;&gt;John Smith&lt;/assignee&gt;</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>reporter</td>
<td>&lt;assignee username=&quot;jsmith&quot;&gt;John Smith&lt;/assignee&gt;</td>
</tr>
<tr>
<td>security</td>
<td>&lt;security id=&quot;10021&quot;&gt;Private&lt;/security&gt;</td>
</tr>
<tr>
<td>created</td>
<td>&lt;created&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT)&lt;/created&gt;</td>
</tr>
<tr>
<td>updated</td>
<td>&lt;updated&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT)&lt;/updated&gt;</td>
</tr>
<tr>
<td>resolved</td>
<td>&lt;resolved&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT)&lt;/resolved&gt;</td>
</tr>
<tr>
<td>due</td>
<td>&lt;due&gt;Mon, 1 Sep 2008 17:30:03 -0500 (CDT)&lt;/due&gt;</td>
</tr>
<tr>
<td>version</td>
<td>&lt;version&gt;2.4.7&lt;/version&gt;</td>
</tr>
<tr>
<td>fixfor</td>
<td>&lt;fixVersion&gt;2.6&lt;/fixVersion&gt;</td>
</tr>
<tr>
<td>component</td>
<td>&lt;component&gt;Documentation&lt;/component&gt;</td>
</tr>
<tr>
<td>votes</td>
<td>&lt;votes&gt;1&lt;/votes&gt;</td>
</tr>
<tr>
<td>comments</td>
<td>&lt;comments&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;comment id=&quot;39270&quot; author=&quot;jsmith&quot; created=&quot;Tue, familiar&quot;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;comment id=&quot;39273&quot; author=&quot;jbrown&quot; created=&quot;Tue, too&quot;&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/comments&gt;</td>
</tr>
</tbody>
</table>
| attachments (or attachment) | <attachments>
|                           |   <attachment id="30318" name="Issue Navigator - Atlassian JIRA-2.png" size="16161" author="yoz" created="Mon, 9 Feb 2009 13:32:58 -0600 (CST)"/>
|                           |   <attachment id="30323" name="Windows XP (with Firefox 3.0).jpg" size="5802" author="vbharara" created="Tue, 10 Feb 2009 00:30:11 -0600 (CST)"/>
|                           | </attachments> |

| timeoriginalestimate | <timeoriginalestimate seconds="600">10 minutes</timeoriginalestimate> |

| timeestimate | <timeestimate seconds="300">5 minutes</timeestimate> |

| timespent | <timespent seconds="300">5 minutes</timespent> |

| aggregatetimeoriginalestimate | <aggregatetimeoriginalestimate seconds="36000">10 hours</aggregatetimeoriginalestimate> |

| aggregatetimeestimate | <aggregatetimeremainingestimate seconds="18000">5 hours</aggregatetimeremainingestimate> |

| aggregatetimespent | <aggregatetimespent seconds="18000">5 hours</aggregatetimespent> |

| timetracking | <timeoriginalestimate seconds="600">10 minutes</timeoriginalestimate>
|              | <timeestimate seconds="300">5 minutes</timeestimate>
|              | <timespent seconds="300">5 minutes</timespent>
|              | <aggregatetimeoriginalestimate seconds="36000">10 hours</aggregatetimeoriginalestimate>
|              | <aggregatetimeremainingestimate seconds="18000">5 hours</aggregatetimeremainingestimate>
|              | <aggregatetimespent seconds="18000">5 hours</aggregatetimespent> |

| issuelinks | <issuelinks>
|           |   <issuelinktype id="10020">
|           |     <name>Duplicate</name>
|           |     <inwardlinks description="is duplicated by">  
|           |       <issuelink>
|           |         <issuekey id="22477">INTSYS-1009</issuekey>
|           |     </issuelink>
|           |   </inwardlinks>
|           | </issuelinktype>
|           | </issuelinks> |
Accessing protected data

When accessing data generated from JIRA, you may find that access to some resources requires user authentication (i.e. requires you to login). There are three options for this:

1. To enable access to data without logging in, your JIRA administrator may specify the 'Browse' permission for Anyone.
2. You can provide the parameters os_username and os_password in the request URL (e.g. http://jira.atlassian.com/browse/TST-1?os_username=tester&os_password=tstpassword). The problem with this method is that it transmits your username and password across the wire in clear text, which may not be an option for some users.
3. You can provide the request parameter os_authType=basic (e.g. http://mycompany.com/anypage?os_authType=basic). This will force the server to issue a challenge for user credentials (i.e. a login prompt) via the basic http authentication protocol. If you are running over SSL, you still need to specify the os_authType=basic parameter if you require the user to authenticate.

Viewing a Chart

Exporting Search Results to Microsoft Excel

JIRA enables you to easily export your search results from the Issue Navigator to Microsoft Excel. This can be a useful way to format data and create your own customized reports, graphs and charts.
Related topics:
  • Exporting Search Results to Microsoft Word

Exporting to Microsoft Excel

Before you begin:

  • Large exports (e.g. many hundreds of issues) are not recommended.
  • To change the number of issues that are exported, change the value of the `tempMax` parameter in the URL.

To export search results to Microsoft Excel:

2. Refine your search, as described in Searching for Issues, then choose the Export menu.
3. Choose one of the following from the dropdown menu:
   - 'Excel (All fields)' — this will create a spreadsheet column for every issue field (excluding comments).
     • Note: This will only show the custom fields that are available for all of the issues in the search results. For example, if a field is only available for one project and multiple projects are in the search results then that field will not appear in the Excel document. The same goes for fields that are only available for certain issue types.
   - 'Excel (Current fields)' — this will create a spreadsheet column for the issue fields that are currently displayed in your Issue Navigator.
4. A file called `<My company's JIRA> - <My project>.xls` will be created. Edit this file using Microsoft Excel and/or save it as required.

Here is a sample exported file, viewed in Microsoft Excel:
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Type</td>
<td>Key</td>
<td>Summary</td>
<td>Assignee</td>
<td>Reporter</td>
<td>Status</td>
<td>Resolution</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-125</td>
<td>The One Minute Manager - Blanchard &amp; Johnson</td>
<td>Alyce Tinyow</td>
<td>Nicholas Muldoon</td>
<td>Open</td>
<td>UNRESOLVED</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-126</td>
<td>Java Persistence with Hibernate by Christian Bauer and Gain King</td>
<td>Alyce Tinyow</td>
<td>Shihab Hamid</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-127</td>
<td>Beginning iPhone Development: Exploring the iPhone SDK (Paperback)</td>
<td>Alyce Tinyow</td>
<td>Andreas Knaecht</td>
<td>In Progress</td>
<td>UNRESOLVED</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-128</td>
<td>Please enter 10 copies of Mike Cohen's &quot;User Stories Applied&quot;</td>
<td>Alyce Tinyow</td>
<td>Melanie Carasso</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-130</td>
<td>Groundwater</td>
<td>Alyce Tinyow</td>
<td>Robyn Munro</td>
<td>Open</td>
<td>UNRESOLVED</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-131</td>
<td>Web Security Testing Cookbook</td>
<td>Alyce Tinyow</td>
<td>Andrew Prentice</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-132</td>
<td>Book request, Pulling Strings with Puppet</td>
<td>Alyce Tinyow</td>
<td>David Chaney</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-133</td>
<td>Book request, Automating Linux System Administration</td>
<td>Alyce Tinyow</td>
<td>David Chaney</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-134</td>
<td>Please order 4 (four) copies of &quot;Do you Matter: How Great Design will make People Love your Company&quot; for Design Team</td>
<td>Alyce Tinyow</td>
<td>Jay Rogers</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-135</td>
<td>User Stories Applied: For Agile Software Development (Addison-Wesley Signature Series) (Paperback)</td>
<td>Alyce Tinyow</td>
<td>Audra Eng</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-136</td>
<td>Practical API Design</td>
<td>Alyce Tinyow</td>
<td>Wesley Smith</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-137</td>
<td>The First 90 Days: Critical Success Strategies for New Leaders at All Levels</td>
<td>Alyce Tinyow</td>
<td>Jay Rogers</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>Book Request</td>
<td>BOOK-138</td>
<td>Adrenaline Junkies and Template Zombies Understanding Patterns of Project Behavior</td>
<td>Alyce Tinyow</td>
<td>Jay Rogers</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Exporting Search Results to Microsoft Word

JIRA enables you to easily export your search results from the Issue Navigator to Microsoft Word. This can be a useful way to create reports in your own customized format.

**Related topics:**
- Exporting Search Results to Microsoft Excel

### Exporting to Microsoft Word

**Before you begin:**

- The export will include Description, Comments and all other issue data, not just the issue fields that are currently configured in your Issue Navigator.
- Large exports (e.g. hundreds of issues) are not recommended.

**To export search results to Microsoft Word:**

1. Choose **Issues > Search for Issues**.
2. Refine your search, as described in **Searching for Issues**, then choose the **Export** menu.
3. Choose **Word** from the dropdown menu.
4. A file called `<My company's JIRA> - <My project>.doc` will be created. Edit this file using Microsoft Word and/or save it as required.

Here is a sample exported file, viewed in Microsoft Word:

<table>
<thead>
<tr>
<th>Issue Key</th>
<th>Issue Title</th>
<th>Assignee</th>
<th>Status</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOK-15</td>
<td>Please order another copy of Java Power Tools [ILLUSTRATED] (Paperback)</td>
<td>Alyce Tinyow</td>
<td>Closed</td>
<td>Task created</td>
</tr>
<tr>
<td>BOOK-114</td>
<td>Programming-Collective Intelligence</td>
<td>Alyce Tinyow</td>
<td>Nick Pellow</td>
<td>Task completed</td>
</tr>
<tr>
<td>BOOK-113</td>
<td>Please buy this book</td>
<td>Alyce Tinyow</td>
<td>Stephen Russell</td>
<td>Open</td>
</tr>
<tr>
<td>BOOK-112</td>
<td>SOA Using Java Web Services for UUG sponsorship</td>
<td>Alyce Tinyow</td>
<td>Robyn Munro</td>
<td>Closed</td>
</tr>
<tr>
<td>BOOK-111</td>
<td>Quarterly marketing books</td>
<td>Rochell Lopez</td>
<td>Ben Neftzger</td>
<td>Closed</td>
</tr>
<tr>
<td>BOOK-110</td>
<td>2 Copies of Maven: The Definitive Guide</td>
<td>Rochell Lopez</td>
<td>James Dunay</td>
<td>Closed</td>
</tr>
<tr>
<td>BOOK-109</td>
<td>Book request: Greensmonkey Hacks</td>
<td>Alyce Tinyow</td>
<td>Jim Severino</td>
<td>Closed</td>
</tr>
<tr>
<td>BOOK-108</td>
<td>The Pragmatic Programmer: From Journeyman to Master (ISBN 3-201-61622-3)</td>
<td>Alyce Tinyow</td>
<td>Eric Delgineas</td>
<td>Closed</td>
</tr>
<tr>
<td>BOOK-106</td>
<td>Request for How Your Customers' book by Jack Mitchell</td>
<td>Alyce Tinyow</td>
<td>Scott Harwood</td>
<td>Resolved</td>
</tr>
<tr>
<td>BOOK-105</td>
<td>Ajax Security by Addison-Wesley Professional</td>
<td>Alyce Tinyow</td>
<td>Steve Smith</td>
<td>Closed</td>
</tr>
<tr>
<td>BOOK-104</td>
<td>Network Warrior [ILLUSTRATED] (Paperback)</td>
<td>Alyce Tinyow</td>
<td>Steve Smith</td>
<td>Closed</td>
</tr>
<tr>
<td>BOOK-103</td>
<td>Practice of System and Network Administration, The (2nd Edition) (Paperback)</td>
<td>Alyce Tinyow</td>
<td>Steve Smith</td>
<td>Closed</td>
</tr>
</tbody>
</table>
**BOOK-129** *The One Minute Manager - Blanchard & Johnson*

<table>
<thead>
<tr>
<th>Status:</th>
<th>Open</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project:</td>
<td>Book Request</td>
</tr>
<tr>
<td>Type:</td>
<td>Book Request</td>
</tr>
<tr>
<td>Reporter:</td>
<td>Nicholas Muldoon</td>
</tr>
<tr>
<td>Assignee:</td>
<td>Alyce Timsow</td>
</tr>
<tr>
<td>Resolution:</td>
<td>Unresolved</td>
</tr>
<tr>
<td>Votes:</td>
<td>0</td>
</tr>
<tr>
<td>Remaining Estimate:</td>
<td>Not Specified</td>
</tr>
<tr>
<td>Time Spent:</td>
<td>Not Specified</td>
</tr>
<tr>
<td>Original Estimate:</td>
<td>Not Specified</td>
</tr>
</tbody>
</table>

**Description**

Hello,

Can you please obtain *The One Minute Manager* by Kenneth Blanchard and Spencer Johnson.


Thanks Alyce.

Nick
Receiving Search Results as an RSS Feed

JIRA enables you to subscribe to an RSS 2.0 feed that is based on any issue filter (saved search), or on your chosen search results, as displayed in the Issue Navigator.

You can choose either an RSS feed that contains issue data (Summary, Description, etc), or one that contains comments.

Note that the tempMax parameter can be used to control the maximum number of issues that are returned, e.g. sample RSS feed of the latest 15 issues reported on jira.atlassian.com.

On this page:
- Subscribing to an RSS Feed
- Accessing protected data

Related topics:
- Exporting Search Results to XML
- Adding the Activity Stream Gadget

Subscribing to an RSS Feed

Before you begin:
- Tip: If you only want to receive current comments in an RSS feed, use the Date Updated field when doing a search. For example, to only receive comments created in the last week, add the Date Update field and set it to updated within the last 1 week.
- The tempMax parameter in the RSS URL can be used to control the maximum number of issues returned in your RSS feed.
- If you are getting an empty RSS feed, make sure you have logged in to JIRA — see Accessing protected data (below).

To subscribe to an RSS feed:

2. Refine your search, as described in Searching for Issues, then choose the Export menu.
3. Choose one of the following from the dropdown menu:
   - ‘RSS (Issues)’ — this will create an RSS feed that contains just issue data.
   - ‘RSS (Comments)’ — this will create an RSS feed that contains comments.
4. Copy the URL that is currently displayed on your Issue Navigator screen.
5. Paste the URL into your RSS reader.

Here is a sample RSS feed:
Accessing protected data

When accessing data generated from JIRA, you may find that access to some resources requires user authentication (i.e. requires you to log in). There are three options for this:

1. To enable access to data without logging in, your JIRA administrator may specify the 'Browse' permission for Anyone.
2. You can provide the parameters os_username and os_password in the request URL (e.g. http://jira.atlassian.com/browse/TST-1?os_username=tester&os_password=tstpassword). The problem with this method is that it transmits your username and password across the wire in clear text, which may not be an option for some users.
3. You can provide the request parameter os_authType=basic (e.g. http://mycompany.com/anypage?os_authType=basic). This will force the server to issue a challenge for user credentials (i.e. a login prompt) via the basic http authentication protocol. If you are running over SSL, you still need to specify the os_authType=basic parameter if you require the user to authenticate.

Receiving Search Results via Email
JIRA enables you to *subscribe* to an *issue filter* (a saved search). JIRA will then run the search according to your specified schedule, and will email the results to you.

You can specify when and how often you would like to receive the search results, e.g. 'Every hour between 9.00AM-5.00PM, Monday-Friday', or 'The last Friday of every month at 7.00AM'.

Emails can only be sent if your administrator has configured an *SMTP mail server*. The filter results will only send the first 200 results of a filter.

---

**On this page:**
- Subscribing to a Filter
- Advanced scheduling ('cron')
- Subscription Context
- Managing Other User's Shared Filters

---

**Subscribing to a Filter**

1. Choose *Issues > Manage Filters*.
2. A list of available filters is displayed:

3. Locate the filter you are interested in and click on its *Subscribe* link. The *Filter Subscription* form is displayed:
4. In the Recipients box, either choose 'Personal Subscription' (if you only wish to subscribe yourself), or select a group of recipients from the dropdown list. **Note:** You cannot select a group unless your JIRA administrator has granted you the 'Manage Group Filter Subscriptions' global permission.

5. Select one of the following types of schedule:
   - **Daily** — choose this if you want to receive one or more emails every day.
   - **Days per Week** — choose this if you want to receive one or more emails on particular days of every week.
   - **Days per Month** — choose this if you want to receive an email on a particular day of every month.
   - **Advanced** — see Advanced scheduling ('cron') below.

6. Click **Subscribe**.
7. You will now be shown a subscription summary page. If you wish, click **Run now** to test your subscription.

**Advanced scheduling ('cron')**

You can use a **Cron Expression** to specify a custom schedule to suit your particular requirements.

Cron expressions consist of the following fields, separated by spaces:

<table>
<thead>
<tr>
<th>Field</th>
<th>Allowed values</th>
<th>Allowed special characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second</td>
<td>0-59</td>
<td>, - * /</td>
</tr>
<tr>
<td>Minute</td>
<td>0-59</td>
<td>, - * /</td>
</tr>
<tr>
<td>Hour</td>
<td>0-23</td>
<td>, - * /</td>
</tr>
<tr>
<td>Day-of-month</td>
<td>1-31</td>
<td>, - * / ? L W C</td>
</tr>
<tr>
<td>Month</td>
<td>1-12 or JAN-DEC</td>
<td>, - * /</td>
</tr>
<tr>
<td>Special character</td>
<td>Usage</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>,</td>
<td>Specifies a list of values. For example, in the <strong>Day-of-week</strong> field, 'MON,WED,FRI' means 'every Monday, Wednesday, and Friday'.</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>Specifies a range of values. For example, in the <strong>Day-of-week</strong> field, 'MON-FRI' means 'every Monday, Tuesday, Wednesday, Thursday and Friday'.</td>
<td></td>
</tr>
<tr>
<td>*</td>
<td>Specifies all possible values. For example, in the <strong>Hour</strong> field, '*' means 'every hour of the day'.</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td>Specifies increments to the given value. For example, in the <strong>Minute</strong> field, '0/15' means 'every 15 minutes during the hour, starting at minute zero'.</td>
<td></td>
</tr>
<tr>
<td>?</td>
<td>Specifies no particular value. This is useful when you need to specify a value for one of the two fields <strong>Day-of-month</strong> or <strong>Day-of-week</strong>, but not the other.</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>Specifies the last possible value; this has different meanings depending on context. In the <strong>Day-of-week</strong> field, 'L' on its own means 'the last day of every week' (i.e. 'every Saturday'), or if used after another value, means 'the last xxx day of the month' (e.g. 'SATL' and '7L' both mean 'the last Saturday of the month). In the <strong>Day-of-month</strong> field, 'L' on its own means 'the last day of the month', or 'LW' means 'the last weekday of the month'.</td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>Specifies the weekday (Monday-Friday) nearest the given day of the month. For example, '1W' means 'the nearest weekday to the 1st of the month' (note that if the 1st is a Saturday, the email will be sent on the nearest weekday <strong>within the same month</strong>, i.e. on Monday 3rd). 'W' can only be used when the day-of-month is a single day, not a range or list of days.</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Specifies the nth occurrence of a given day of the week. For example, 'TUES#2' (or '3#2') means 'the second Tuesday of the month'.</td>
<td></td>
</tr>
</tbody>
</table>

Here are some sample cron expressions:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 15 8 ? * *</td>
<td>Every day at 8.15 pm.</td>
</tr>
<tr>
<td>0 15 8 * * ?</td>
<td>Every day at 8.15 am.</td>
</tr>
<tr>
<td>0 * 14 * * ?</td>
<td>Every minute starting at 2.00 pm and ending at 2:59 pm, every day.</td>
</tr>
<tr>
<td>0 0/5 14 * * ?</td>
<td>Every 5 minutes starting at 2.00 pm and ending at 2:55 pm, every day.</td>
</tr>
<tr>
<td>0 0/5 14,18 * * ?</td>
<td>Every 5 minutes starting at 2.00 pm and ending at 2:55 pm, AND every 5 minutes starting at 6.00 pm and ending at 6:55 pm, every day.</td>
</tr>
<tr>
<td>0 0–5 14 * * ?</td>
<td>Every minute starting at 2.00 pm and ending at 2:05 pm, every day.</td>
</tr>
<tr>
<td>0 0/10 * * * ?</td>
<td>Every 10 minutes, forever.</td>
</tr>
<tr>
<td>0 10,44 14 ? 3 WED</td>
<td>2:10 pm and 2:44 pm every Wednesday in the month of March.</td>
</tr>
<tr>
<td>0 15 8 ? * MON–FRI</td>
<td>8:15 am every Monday, Tuesday, Wednesday, Thursday and Friday.</td>
</tr>
<tr>
<td>0 15 8 15 * ?</td>
<td>8:15 am on the 15th day of every month.</td>
</tr>
<tr>
<td>Cron expression</td>
<td>Subscription time description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>0 15 8 * ?</td>
<td>8:15 am on the last day of every month.</td>
</tr>
<tr>
<td>0 15 8 LW * ?</td>
<td>8:15 am on the last weekday of every month.</td>
</tr>
<tr>
<td>0 15 8 ? * 6L</td>
<td>8:15 am on the last Friday of every month.</td>
</tr>
<tr>
<td>0 15 8 ? * 6#2</td>
<td>8:15 am on the second Friday of every month.</td>
</tr>
</tbody>
</table>

Cron expressions are not case-sensitive

**Subscription Context**

Each time that a subscription is activated, the saved filter for the subscription is used to find the relevant issues. This search is executed for each user in the group that will receive the subscription email. This means that any filter that uses JQL function such as `currentUser()` will be evaluated with a different user each time. This also means that if one user doesn't have permission to see some of the issues returned by the search then the list of issues that they receive in email will be different from other users' email. This has two other consequences:

- If you share a subscription with a group with many members it can take a long time to generate the emails to be sent. This can make JIRA very slow for minutes. This is a good reason be careful with allowing the **Manage Group Filter Subscriptions** permission.
- If a group contains a user whose email address is actually a distribution list (i.e. a group email alias), then everyone on that distribution list will receive the same email, since JIRA doesn't know who the users on the list are.

**Managing Other User’s Shared Filters**

A shared filter is a filter whose creator has shared that filter with other users. Refer to **Sharing a Filter** for details. When a shared filter is created by a user, that user:

- Initially 'owns' the shared filter.
- Being the owner, can edit and modify the shared filter.

If you have the “JIRA Administrators” global permission, you can manage shared filters that were created by other users.

**To access the 'Shared Filters’ feature:**

1. Ensure that you are logged in as a user with the JIRA Administrators global permission.
2. On the top navigation bar, click the ‘Issues’ dropdown and select ‘Shared Filters’ from the list.

**Sharing a Search Result**

You can easily email other JIRA users (including any email address) a link to a search result or shared filter by sharing the search result (or shared filter) with them. You can also add an optional note to the email message.

**Related topics:**

- Searching for Issues

**To share a search result with one or more JIRA users or any email addresses:**

1. Choose **Issues** > **Search for Issues**.
2. Refine your search, as described in Searching for Issues, then choose the share icon.
   ![Keyboard shortcut](s)
3. Specify JIRA users (by typing their usernames or part/all of their full names as registered with their JIRA user accounts) or type any email addresses of people you want to share the issue with.
When you begin typing a JIRA user's username or name, or a previously specified email address, an autocomplete dropdown will appear.

4. Add an optional Note.
5. Click the Share button.

⚠️ Please Note:

- Recipients specified in the User name or email field will receive an email message whose body contains the content of the Note (if one was specified) as well as a link to the search result.
- A shared search result sent to JIRA users specified in the User name or email field will be sent to the email addresses registered with these user's respective JIRA accounts.
- The subject line of the email message will specify you as the JIRA user who 'shared' the issue with the recipients.
- If you are viewing a shared filter on the issue navigator and use the Share button to share that filter with other JIRA users who can also view this filter, then the email message that these JIRA users receive will contain a link to the filter instead of its search results. All other recipients will receive an email message containing a link to that filter's search results instead.
- You can also share an issue from the view issue page. See Sharing an issue for details.

Generating Reports

JIRA provides reports that show statistics for particular people, projects, versions, or other fields within issues. You can access these reports directly from your project browser screen:
Reports might also be located in the project Overview Summary screen below the issues graph.

You can access these reports directly from your project Overview Summary screen below the issues graph:

The following reports are included with JIRA:

- **Average Age Report** — Shows the average age (in days) of unresolved issues.
- **Created vs Resolved Issues Report** — Shows the number of issues created vs number of issues resolved over a given period of time.
- **Pie Chart Report** — Shows the search results from a specified issue filter (or project) in a pie-chart, based on a statistic of your choice.
- **Resolution Time Report** — Shows the average time taken to resolve issues.
- **Recently Created Issues Report** — Shows the rate at which issues are being created.
- **Single Level Group By Report** — Shows the search results from an issue filter, grouped by a field of your choice.
- **Time Since Issues Report** — Shows the number of issues for which your chosen date field (e.g. 'Created') was set on a given date.
- **Time Tracking Report** — Shows time tracking information on issues for a particular version of a project.
• **User Workload Report** — Shows how much work a user has been allocated, and how long it should take.
• **Version Time Tracking Report** — Shows progress towards completing a given version, based on issues' work logs and time estimates.
• **Version Workload Report** — Shows how much outstanding work there is (per user and per issue) before a given version is complete.
• **Workload Pie Chart Report** — Shows the relative workload for assignees of all issues in a particular project or issue filter.

* Only available if your JIRA administrator has enabled Time Tracking.

---

**Additional Reporting is available!**

- In addition to the built-in reports, other reports (e.g. Gantt Chart Report, Timesheet Report, JIRA SQL Plugin) are available for download from the [Atlassian Marketplace](https://marketplace.atlassian.com).
- JIRA administrators can also create new reports with the plugin API — see our [Plugin Tutorial – Creating a JIRA Report](https://docs.atlassian.com/display/JIRADEV/Plugin+Tutorial). If you don't want to build a plugin yourself, [Atlassian Experts](https://www.experts.com) are available for custom projects.
- Issue Filters can be exported to Microsoft Excel, where they can be further manipulated into charts and reports. See [Exporting Search Results to Microsoft Excel](https://docs.confluence.com/x/0x0Qj). Confluence can work as a tool for business reporting. See [Confluence Reporting HOWTO](https://docs.atlassian.com/display/CONFL/Confluence+Reporting+HOWTO), in conjunction with [Confluence's SQL plugin](https://docs.confluence.com/x/0x0Qj) and [Example SQL queries for JIRA](https://docs.confluence.com/x/0x0Qj).

---

**Workload Pie Chart Report**

The 'Workload Pie Chart' report displays the relative workload for assignees of all issues in a particular project or issue filter.

---

**Note:** this report is only available if your JIRA administrator has enabled time-tracking and installed the JIRA Charting Plugin.

---

**On this page:**

- What does the Workload Pie Chart report look like?
- Generating a Workload Pie Chart report
- Configuring your Internet Explorer cache settings

---

What does the Workload Pie Chart report look like?

The report generated will look something like this:

**Screenshot: 'Workload Pie Chart' report**
Report: Workload Pie Chart Report

Project: JIRA (Assignee)

Chart

Data Table

<table>
<thead>
<tr>
<th>Name</th>
<th>Hours</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andreas Knecht</td>
<td>1180</td>
<td>15%</td>
</tr>
<tr>
<td>Nick Monier</td>
<td>900</td>
<td>11%</td>
</tr>
<tr>
<td>Michael Tokar</td>
<td>832</td>
<td>10%</td>
</tr>
<tr>
<td>Mark Lassau</td>
<td>747</td>
<td>9%</td>
</tr>
<tr>
<td>Dushan Hanuska</td>
<td>587</td>
<td>7%</td>
</tr>
<tr>
<td>Chris Muenchard</td>
<td>461</td>
<td>6%</td>
</tr>
<tr>
<td>Scott Hammond</td>
<td>424</td>
<td>5%</td>
</tr>
<tr>
<td>Toby Rafferty</td>
<td>204</td>
<td>2%</td>
</tr>
<tr>
<td>Brenden Bohn</td>
<td>197</td>
<td>2%</td>
</tr>
<tr>
<td>Brad Baker</td>
<td>187</td>
<td>2%</td>
</tr>
<tr>
<td>Other</td>
<td>136</td>
<td>1%</td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Generating a Workload Pie Chart report

**To generate the report:**

1. Navigate to the desired project.
2. Choose **Summary (tab) > Reports section > Workload Pie Chart Report.**

![Workload Pie Chart Report](image)

3. Choose the project or issue filter for which you wish to generate a Workload Pie Chart report.
4. In the **Statistic** drop-down list, select the field on which the pie chart will be based (this will usually be **Assignee**).
5. Click **Next** to generate the report (see screenshot in previous section above).

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select **'Internet Options'** from the **'Tools'** menu:

![Internet Explorer Options](image)

2. The **'Internet Options'** window will display. Click the **'Settings'** button in the **'Temporary Internet files'** (i.e. cache) section:
3. The 'Settings' window will display. Ensure that you do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

User Workload Report

The 'User Workload' report displays useful time tracking information on issues assigned to a particular user. It shows the number of unresolved issues assigned to the specified user, and the workload remaining, on a per-project basis.

**Note:** this report is only available if time tracking has been enabled by your JIRA administrator.
On this page:

- What does the User Workload report look like?
- Generating a User Workload report

What does the User Workload report look like?

The report generated will look something like this:

**Screenshot: 'User Workload' report**

<table>
<thead>
<tr>
<th>Projects</th>
<th>Assigned Issues</th>
<th>Workload</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>3</td>
<td>1 week, 3 days</td>
</tr>
<tr>
<td>Door</td>
<td>1</td>
<td>2 weeks</td>
</tr>
<tr>
<td>Total</td>
<td>4</td>
<td>3 weeks, 3 days</td>
</tr>
</tbody>
</table>

The table shows the number of unresolved issues assigned to the specified user, and the workload remaining, on a per-project basis. The last line in the table shows the total the number of issues and the total workload remaining for this user.

Generating a User Workload report

**To generate the report:**

1. Navigate to the desired project.
3. Select or type the name of the user for whom you wish to generate a User Workload report.
4. In the Sub-task Inclusion drop-down list (note, this will only appear if sub-tasks are enabled), choose which sub-tasks will be included in the report, for all parent issues that belong to this version:
   - Select *Only including sub-tasks assigned to the selected user* to only include an issue's sub-tasks if the sub-tasks are assigned to the selected user; or
   - Select *Also including unassigned sub-tasks* to include an issue's sub-tasks regardless of whether the sub-tasks are assigned to the selected user or not.
5. Click Next to generate the report.

Version Workload Report

The Version Workload Report displays useful time tracking information on the current workload for a specific version within a specific project. For the specified version, it shows a list of unresolved issues assigned to each user, each user's workload, and a summary of the total workload remaining for the version.

**Note:** this report is only available if time tracking has been enabled by your JIRA administrator.
What does the Version Workload report look like?

The report generated will look something like this:

Screenshot: Version Workload Report

The first table summarises the workload for each user, broken down by issue type, for the specified version. Following the summary, the report is composed of individual sections for each user --- with workload broken down by issue type. Each individual section begins with the workload total for the specific user. Finally, all unassigned issues (if any exist) are displayed.

Generating a Version Workload Report

To generate the report:

1. Navigate to the desired project.
3. In the **Version** drop-down list, select the version on which you wish to report. The report will include all issues that belong to this version, that is, all issues whose **Fix Version** is this version.

4. In the **Display unestimated issues** drop-down list, choose which issues will be included in the report:
   - Select **Yes** to show all unresolved issues, regardless of the value of their **Estimated Time Remaining** or **Original Estimate** fields.
   - Select **No** to exclude issues which are not time-tracked (i.e. do not have an **Original Estimate** specified).

5. In the **Sub-task Inclusion** drop-down list (note, this will only appear if sub-tasks are enabled), choose which sub-tasks will be included in the report, for all parent issues that belong to this version:
   - Select **Only include sub-tasks with the selected version** to only include an issue’s sub-tasks if the sub-tasks belong to the same version as the issue; or
   - Select **Also include sub-tasks without a version set** to include an issue's sub-tasks if the sub-tasks belong to either the same version as the issue or to no version; or
   - Select **Include all sub-tasks** to include all of an issue's sub-tasks, regardless of whether the sub-tasks belong to the same version, some other version or no version.

Note: sub-tasks which belong to this version, but whose parent issues do not belong to this version, will always be included in the report.

**Time Tracking Report**

The Time Tracking Report displays useful time tracking information on issues for a particular version of a project. This report shows original and current time estimates for all the issues, and whether they are ahead of or behind the original schedule. (Note: this report is only available if time tracking has been enabled by your JIRA administrator).

On this page:

- What does the Time Tracking report look like?
- Generating a Time Tracking report
- See Also

Time tracking add-ons for JIRA in the Atlassian Marketplace can offer even more detailed, powerful reports. Check them out here.

![Atlassian Marketplace](image)

What does the Time Tracking report look like?

The report generated will look something like this:

*Screenshot: 'Time Tracking' report*
Or, if sub-tasks are enabled, the report will look something like this:
The table in the report shows the issues within the version:

- There are four *time tracking* fields as follows:
  - **Original Estimate** - The original estimate of the total amount of time it would take to complete this issue.
  - **Estimated Time Remaining** - The current estimate of the remaining amount of time it would take to complete this issue.
  - **Time Spent** - The amount of time spent on the issue. This is the aggregate amount of time which has been logged against this issue.
  - **Accuracy** - The accuracy of the original estimate compared to the current estimate for the issue. It is the difference between the sum of the *Time Spent* and *Estimated Time Remaining* fields, and the *Original Estimate* field.

- If sub-tasks are enabled, the """"column at the right of the field shows the aggregate time tracking information for each 'parent' issue (i.e. the sum of the issue's own values plus those of its sub-tasks).
- The last line of the table shows the aggregate time tracking information for the whole version.

The report also includes two bar-graphs (above the table) which represent the aggregate time tracking information for the version:
The first bar-graph (‘Progress’) shows the percentage of completed issues (green) and incomplete issues (orange) in this version:

```
Progress: 40%
```

The second bar-graph (‘Accuracy’ -blue) shows the accuracy of the original estimates.

The length of the Accuracy bar compared to the Progress bar indicates whether the issues in this version are ahead of or behind schedule. There are three cases:

1. The issues are on schedule with the original estimate. The Accuracy bar is completely blue and is the same length as the Progress bar above it.

2. The issues are behind the original estimate (i.e. will take longer than originally estimated). The Progress graph is longer than the Accuracy graph. The blue region represents the original estimated time, and the light-grey region is the amount of time by which issues are behind.

```
Progress: 42%
Accuracy: 4%
```

3. The issues are ahead of the original estimate (i.e. will take less time than originally estimated). The Accuracy graph is longer than the Progress graph. The blue bar represents the original estimated time, and the light-grey region represents the amount of time by which the original estimates were overestimated.

```
Progress: 47%
Accuracy: 8%
```

Generating a Time Tracking report

To generate a Time Tracking Report:

1. Navigate to the desired project.
2. Choose Summary (tab) > Reports section > Time Tracking Report.

3. In the Version drop-down list, select the version on which you wish to report. The report will include all issues that belong to this version, that is, all issues whose ‘Fix Version’ is this version.
4. In the Sorting drop-down list, choose how the issues in the report will be sorted:
   - Select Least completed issues first to show issues with the highest Estimated Time Remaining first; or
   - Select Most completed issues first to show issues with the lowest Estimated Time Remaining first.
5. In the Issues drop-down list, choose which issues will be included in the report:
   - Select All to include all issues assigned to this version; or
   - Select Incomplete issues only to exclude issues which are either completed (i.e. have an Estimated Time Remaining of zero), or are not time-tracked (i.e. do not have an Original Estimate). Note that issue status does not affect which issues are displayed.
6. In the Sub-task Inclusion drop-down list (note: this will only appear if sub-tasks are enabled), choose which sub-tasks will be included in the report, for all parent issues that belong to this version:
   - Select Only include sub-tasks with the selected version to only include an issue’s sub-tasks if the sub-tasks belong to the same version as the issue; or
• Select **Also include sub-tasks without a version set** to include an issue's sub-tasks if the sub-tasks belong to either the same version as the issue or to no version; or
• Select **Include all sub-tasks** to include all of an issue's sub-tasks, regardless of whether the sub-tasks belong to the same version, some other version or no version. Note: sub-tasks which belong to this version, but whose parent issues do not belong to this version, will always be included in the report.

See Also

- In addition to the built-in JIRA reports, other reports (e.g. Gantt Chart Report, Timesheet Report) are available for download from the Atlassian Marketplace site. JIRA administrators can also create new reports with the plugin API — see [How to create a JIRA Report](#).
- You may also find the Dashboard Gadgets useful, e.g. the Two-Dimensional Filter Statistics Gadget displays statistical data based on a specified **issue filter**, in a configurable table format.

**Single Level Group By Report**

The **Single Level Group By** report displays issues returned from a specified **issue filter** of your choice, grouped by a specified field. For example, an issue filter can be created to retrieve all open issues for a particular version of a particular project. The **Single Level Group By** report can then be used to display these issues grouped by a specified field (e.g. Assignee).

**On this page:**

- What does the Single Level Group By report look like?
- Generating a Single Level Group By report

What does the Single Level Group By report look like?

The report generated will look something like this:

**Screenshot: Single Level Group By Report**

The report displays the issues returned by the specified filter, grouped by the specified field.

Generating a Single Level Group By report
1. Navigate to the desired project.
2. Choose **Summary** (tab) > **Reports** section > **Single Level Group By Report**.

   ![Configure - Single Level Group By Report](image)

3. Select the desired issue filter.
4. In the **Statistic Type** field, select the field by which the report will group the issues returned from your chosen issue filter.

---

**Related topics:**

The following gadgets can be added to your **dashboard** to display similar information to the ‘Single Level Group By’ report:

- Filter Results Gadget
- Issue Statistics Gadget
- Two-Dimensional Filter Statistics Gadget

**Created vs Resolved Issues Report**

The ‘Created vs Resolved Issues’ report is a difference chart showing the number of issues created vs number of issues resolved over a given period of time. The report is based on your choice of **project** or **issue filter**, and the chart can either be cumulative or not.

**On this page:**

- What does the ‘Created vs Resolved Issues’ report look like?
- Generating a Created vs Resolved Issues report
- Configuring your Internet Explorer cache settings

What does the ‘Created vs Resolved Issues’ report look like?

The report generated will look something like this:

*Screenshot: 'Created vs Resolved Issues' report*
Report: Created vs Resolved Issues Report

Project: Book Request

Chart

This chart shows the number of issues created vs the number of issues resolved in the last 30 days.

Data Table

<table>
<thead>
<tr>
<th>Period</th>
<th>Created</th>
<th>Resolved</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-January-2009</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>8-January-2009</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>9-January-2009</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10-January-2009</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>11-January-2009</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Areas in red show periods where more issues were created than resolved. Areas in green show periods where more were resolved than created.

Generating a Created vs Resolved Issues report

1. Navigate to the desired project.
2. Choose Summary (tab) > Reports section > Created vs Resolved Issues Report.
3. Click Select Filter or Project.
4. The popup Filter or Project Picker will appear. Select the project, or issue filter, in which you are interested. You will then be returned to the form.
5. In the Period field, select the timeframe on which the report will be based:
6. In the Days Previously field, enter the number of days’ worth of data (counting backwards from today) to be included in the report.
7. In the Cumulative Totals? field, choose either:
   - Yes to progressively add data to the preceding column; or
   - No to show just a single value in each column.
8. In the Display the trend of Unresolved? field, choose either:
   - Yes to show the number of unresolved issues over time in a subplot; or
   - No otherwise.
9. In the Display Versions? field, choose either:
   - All versions to show version release dates on the chart, for all released versions; or
   - Only major versions to show version release dates on the chart, for released versions that are named ‘x.x’ only; or
   - None to not show version release dates on the chart.

Configuring your Internet Explorer cache settings
If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:

   ![Internet Options Menu](image1.png)

   Select 'Internet Options' from the Tools menu.

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:

   ![Internet Options Window](image2.png)

   The Internet Options window will display. Click the 'Settings' button in the 'Temporary Internet files' section.

3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

   ![Settings Window](image3.png)

   The Settings window will display. Ensure that the 'Every visit to the page' option is not selected.

   If it is, select the 'Automatically' option instead.
Resolution Time Report

The ‘Resolution Time’ report is a bar chart showing the average time taken to resolve issues. This is useful to show you the trends in resolution time. The report is based on your choice of project or issue filter, and your chosen units of time (i.e. hours, days, weeks, months, quarters or years).

On this page:

- What does the Resolution Time report look like?
- Generating a Resolution Time report
- Configuring your Internet Explorer cache settings

What does the Resolution Time report look like?

The report generated will look something like this:

Screenshot ‘Resolution Time’ report:
Report: Resolution Time Report

Project: Book Request

Chart:
This chart shows the average number of days issues took to be resolved. Issues were resolved in the last 30 days.
Generating a Resolution Time report

1. Navigate to the desired project.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:
2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:

![Internet Options window](image)

3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.
Pie Chart Report

The 'Pie Chart' report displays issues returned from a specified project or issue filter, grouped by a specified field. For example, an issue filter can be created to retrieve all open issues for a particular version of a particular project. The 'Pie Chart' report can then be used to display these issues grouped by a specified field (e.g. Assignee).

On this page:

- What does the Pie Chart report look like?
- Generating a Pie Chart report
- Configuring your Internet Explorer cache settings

What does the Pie Chart report look like?

The report generated will look something like this:

Screenshot: 'Pie Chart' report
Generating a Pie Chart report

1. Navigate to the desired project.
2. Choose Summary (tab) > Reports section > Pie Chart Report.

3. Choose the desired filter/project.
4. In the Statistic Type field, select the field on which the pie chart will be based. (Note that you can choose only fields which have finite values).

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:
3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

Average Age Report

The 'Average Age' report is a bar chart showing the average age (in days) of unresolved issues at given points in time. The report is based on your choice of project or issue filter, and your chosen units of time (i.e. hours, days, weeks, months, quarters or years).

On this page:

- What does the Average Age report look like?
- Generating an 'Average Age' report
- Configuring your Internet Explorer cache settings

What does the Average Age report look like?

The report generated will look something like this:

Screenshot: 'Average Age' report
**Report: Average Age Report**

**Project: Book Request**

**Chart:**

This chart shows the average number of days issues were unresolved for on a given day over the past 30 days.

**Data Table**

<table>
<thead>
<tr>
<th>Period</th>
<th>Issues Unresolved</th>
<th>Total Age</th>
<th>Avg. Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-January-2009</td>
<td>17</td>
<td>2082</td>
<td>157</td>
</tr>
<tr>
<td>8-January-2009</td>
<td>17</td>
<td>2689</td>
<td>158</td>
</tr>
<tr>
<td>9-January-2009</td>
<td>15</td>
<td>2553</td>
<td>170</td>
</tr>
<tr>
<td>10-January-2009</td>
<td>15</td>
<td>2568</td>
<td>171</td>
</tr>
<tr>
<td>11-January-2009</td>
<td>15</td>
<td>2583</td>
<td>172</td>
</tr>
<tr>
<td>12-January-2009</td>
<td>15</td>
<td>2598</td>
<td>173</td>
</tr>
<tr>
<td>13-January-2009</td>
<td>14</td>
<td>2545</td>
<td>181</td>
</tr>
<tr>
<td>14-January-2009</td>
<td>15</td>
<td>2560</td>
<td>170</td>
</tr>
<tr>
<td>15-January-2009</td>
<td>15</td>
<td>2575</td>
<td>171</td>
</tr>
</tbody>
</table>

Generating an 'Average Age' report

1. Navigate to the desired project.
2. Choose **Summary** (tab) > **Reports** section > **Average Age Report**.
3. Choose the desired filter/project.
4. In the **Period** field, select the timeframe on which the report will be based.
5. In the **Days Previously** field, enter the number of days’ worth of data (counting backwards from today) to be included in the report.

### Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. **Select 'Internet Options' from the 'Tools' menu:**

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:
3. The 'Settings' window will display. Ensure that you do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

Recently Created Issues Report

The 'Recently Created Issues' report is a bar chart showing the rate at which issues are being created, as well as how many of those created issues are resolved. The report is based on your choice of project or issue filter, and your chosen units of time (i.e. hours, days, weeks, months, quarters or years).

On this page:

- What does the Recently Created Issues report look like?
Generating a Recently Created Issues report
Configuring your Internet Explorer cache settings

What does the Recently Created Issues report look like?

The report generated will look something like this:

Screenshot: 'Recently Created Issues' report

Report: Recently Created Issues Report
Project: SysAdmin

Chart
This chart shows the issues created in the last 30 days

Data Table

<table>
<thead>
<tr>
<th>Period</th>
<th>Created Issues (Unresolved)</th>
<th>Created Issues (Resolved)</th>
</tr>
</thead>
<tbody>
<tr>
<td>11-January-2009</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>12-January-2009</td>
<td>0</td>
<td>12</td>
</tr>
<tr>
<td>13-January-2009</td>
<td>1</td>
<td>10</td>
</tr>
<tr>
<td>14-January-2009</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>15-January-2009</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>16-January-2009</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>17-January-2009</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>18-January-2009</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>19-January-2009</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>20-January-2009</td>
<td>n</td>
<td>n</td>
</tr>
</tbody>
</table>

The green portion of the bar shows the created issues which are resolved. The red portion shows created but as yet unresolved issues.
Generating a Recently Created Issues report

1. Navigate to the desired project.
2. Choose **Summary** (tab) > **Reports** section > **Recently Created Issues Report**.

   ![Report: Recently Created Issues Report](image)

3. Choose the desired filter/project.
4. In the **Period** field, select the timeframe on which the report will be based:
5. In the **Days Previously** field, enter the number of days of data (counting backwards from today) to be included in the report.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select **Internet Options** from the **Tools** menu:

   ![Internet Options](image)

2. The **Internet Options** window will display. Click the **Settings** button in the **Temporary Internet files** (i.e. cache) section:
3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

**Time Since Issues Report**

The 'Time Since Issues' report is a bar chart showing the number of issues for which your chosen date field (e.g. 'Created', 'Updated', 'Due', 'Resolved', or a custom field) was set on a given date. The report is based on your choice of project or issue filter, and your chosen units of time (ie. hours, days, weeks, months, quarters or years).
On this page:

- What does the Time Since Issues report look like?
- Generating a Time Since Issues report
- Configuring your Internet Explorer cache settings

What does the Time Since Issues report look like?

The report generated will look something like this:

*Screenshot: ‘Time Since Issues’ report*

**Report:** Time Since Issues Report  
**Project:** Book Request

**Chart:**

This chart shows the number of issues based on the Created field on a given date over the past 30 days.

**Data Table**

<table>
<thead>
<tr>
<th>Period</th>
<th>Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-January-2009</td>
<td>0</td>
</tr>
<tr>
<td>8-January-2009</td>
<td>0</td>
</tr>
<tr>
<td>9-January-2009</td>
<td>0</td>
</tr>
<tr>
<td>10-January-2009</td>
<td>0</td>
</tr>
<tr>
<td>11-January-2009</td>
<td>0</td>
</tr>
<tr>
<td>12-January-2009</td>
<td>1</td>
</tr>
<tr>
<td>13-January-2009</td>
<td>0</td>
</tr>
<tr>
<td>14-January-2009</td>
<td>0</td>
</tr>
</tbody>
</table>

Generating a Time Since Issues report

1. Navigate to the desired project.
2. Choose **Summary (tab) > Reports section > Time Since Issues Report.**

![Report: Time Since Issues Report](image)

**Description:**
A report showing time since a chosen field for each issue for a project or saved filter.

- **Project or Saved Filter:** Select Filter or Project...
  Project or saved filter to use as the basis for the graph.

- **Date Field:**
  The date field that should be used to graph the issues.

- **Period:**
  The length of periods represented on the graph.

- **Days Previously:**
  Days (including today) to show in the graph.

- **Cumulative Totals?**
  Progressively add totals (1..2..3), or show individual values (1..1..1).

3. Choose the desired project/filter.
4. In the **Date Field** field, select the desired date. Note, only available if time tracking has been enabled by your JIRA administrator.
5. In the **Period** field, select the timeframe on which the report will be based.
6. In the **Days Previously** field, enter the number of days of data (counting backwards from today) to be included in the report.
7. In the **Cumulative Totals?** field, choose either:
   - **Yes** to progressively add data to the preceding column; or
   - **No** to show just a single value in each column.

### Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select **Internet Options** from the **Tools** menu:

![Internet Options](image)

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:
Browsing a Project

The project browser screen allows you to browse a project or its components or versions, the latter of which shows summaries of your project's progress.

This screen provides a general overview of your project, with a variety of easily accessible reports for your project's issues, builds and source code reviews, from which you can 'dig down' into further detail.

From the project browser screen, you can browse the following:

- **Project:**
  - **Summary** — Shows recent activity in your project, unreleased versions and a chart showing issue activity. Reports are also located here.
  - **Issues** — Shows a summary of all issues in a project grouped by Status. Also shows summaries of all unresolved issues, grouped by Assignee, Priority, Version and Component.
  - **Road Map** — Shows unresolved issues for upcoming versions of a project.
  - **Change Log** — Shows resolved issues for previous versions of a project.
  - **Versions** * — Shows a summary of recent versions for a given project.
  - **Components** * — Shows a summary of all components for a given project.

3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.
- **Builds** * — Shows recent Bamboo builds for a given project.
- **Reports** — Shows reports on statistics for particular people, projects, versions, or other fields within issues.

- **Version:**
  - **Version Summary** — Shows recent activity in a given version of a project, plus a list of issues that are due soon.
  - **Version Issues** — Shows issues belonging to a given version of a project.
  - **Version Builds** * — Shows recent Bamboo builds for a given version.

- **Component:**
  - **Component Summary** — Shows recent activity in a given component of a project, plus a list of issues that are due soon.
  - **Component Issues** — Shows issues belonging to a given component of a project.
  - **Component Road Map** — Shows unresolved issues for a given component, for upcoming versions of the project.
  - **Component Change Log** — Shows resolved issues for a given component, for previous versions of the project.

**Browsing a Project's Summary**

- The **Summary** page for a project in JIRA shows recent activity in the project, plus a list of versions and issues that are due soon.

**Browsing a project's summary**

**To browse a project’s summary,**

1. On the top navigation bar, click the white triangle next to **Projects**. The projects dropdown will display.
   - **Tip:** You can access your current project directly by simply clicking the **Projects** link instead of the triangle.
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click **View All Projects**, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
3. Ensure that the ‘Summary’ tab page is displayed (see screenshot below). If not, click the **Summary** tab on the left to show this page.

**Screenshot: ‘Summary’ page for a Project**

If you are concerned about screen real estate, you can display the Project Summary page as a single column. Simply resize your browser window and content automatically reformats into a single column display.
### Function | Instructions | Description
--- | --- | ---
**Reports** | Click the relevant report in the **Reports** section. | See [Generating Reports](#) for more information.
**Versions** | Click the relevant version in the **Versions** section. | See [Browsing a Project's Versions](#) for more information.
**Activity Stream** | • Click the RSS icon to generate an RSS feed of information that is relevant to this project.  
• Click any item to jump to recent activity associated with this project. | The Activity Stream can include:  
• Issues in your local JIRA Server system.  
• Issues in another JIRA Server system, provided your administrator has configured a [two-way Application Link](#).  
• Activity from another Atlassian application, such as:  
  • document updates (from Confluence)  
  • code commits (from FishEye)  
  • code reviews (from Crucible)  
  • builds (from Bamboo)  
  - Note that this requires your administrator to configure a [two-way Application Link](#), unless you are using Atlassian OnDemand.  
• Activity from remote applications. Your administrator will need to set this up via the [REST API](#) or the [provider plugin API](#), or locally via [Java](#).

---

**Extending your project summary**

The Project Summary page can be easily extended via plugins. For example, you can add a Calendar tab or a Labels tab via the [JIRA Calendar plugin](#) and [JIRA Labels plugin](#) respectively. Check out the [Atlassian Marketplace](#) for more information.

---

*Created in 2015 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](#).*
Browsing a Project's Issues

- JIRA's Issues report shows a summary of all issues in a project grouped by Status, as well as summaries of all unresolved issues, grouped by Assignee, Priority, Version and Component.

To browse a project's Issues,

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display.
   
   Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.

2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.

3. Click the 'Issues' tab on the left of the page. The summary of issues for your project will display (see screenshot below):

   Screenshot: Viewing the Issues Summary for a Project

To see which issues have a particular priority, assignee or status, or belong to a particular component or version of the project, click the name of the relevant priority/assignee/status/component/version.

Related Topics

- Browsing a Project
- JIRA Reports Overview

Browsing a Project's Road Map

JIRA provides a Road Map for each project, which shows issues scheduled for the next ten unreleased versions (whereas the Change Log shows released versions). The Road Map provides an overview of progress made towards releasing a version; therefore, the versions appear in the opposite order of the way they appear on the Versions screen for the project.

If your administrator has hidden the ‘Fix For Version’ field, the Road Map report is not available.
To browse a project’s Road Map,

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display. 
   Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
3. Click Road Map in the left column. The road map for your project is displayed (see screenshot below).
   - Click the issues link next to any version to expand the list of issues related to that version.
   - Click the release notes link to see the tasks, bugs, and other information for that version.

Screenshot: Viewing a project’s road map

---

Related Topics

- The Change Log — looking back at recent releases rather than forward
- Browsing a Project
- JIRA Reports Overview

Browsing a Project's Change Log

JIRA’s Change Log report shows resolved issues in the last ten released versions of a project. Whereas the Road Map looks forward, the Change Log looks back, giving an overall view of issues resolved in recent versions.

If your administrator has hidden the ‘Fix Version/s’ field, the Change Log report will not be available.

To browse a project’s Change Log,

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display.
Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.

2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.

3. Click the 'Change Log' tab on the left of the page. The change log for your project will display (see screenshot below).

| Screenshot: Viewing a project's change log |

A live version of this example can be seen online.

Related Topics

- The Road Map — looking forward to future releases
- Browsing a Project
- JIRA Reports Overview

**Browsing a Project's Versions**

- JIRA’s Versions report shows a summary of all versions (if any have been created) in a project.

To browse a project’s versions:

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display.

   Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.

2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.

3. Click Versions on the left of the page. A list of versions for your project is displayed (see screenshot below).
   - If specified, the Start Date is used by the Version Report. This gives you a more accurate report in cases where you might plan a version many weeks (or even months) in advance, but not actually commence work until closer to the release date.
   - Click the link for a version to browse that version.

| Screenshot: 'Versions' page for a Project |
A live version of this example can be seen online.

For each version, see also:

- Browsing a Version's Bamboo Builds

**Related Topics**

- Browsing a Project
- JIRA Reports Overview
- Version Report

**Browsing a Version's Bamboo Builds**

If your organisation uses Atlassian's Bamboo and your administrator has integrated Bamboo with JIRA, JIRA enables you to view the Bamboo build plan status and recent build activity for a version of a project. The Builds tab provides you with a list of the builds which are related to the project version, including:

- The list of the builds related to the version, i.e. builds that have issues from the project version linked to them (either as 'Fixed' or 'Related'). See the Bamboo documentation for instructions on linking issues to builds.
- The latest status of the build plans for the related builds, i.e. the build plan contains a build that has a project issue linked to it. The status of a build plan for a version is determined as follows:
  - If the project version has not been released — the build plan status is the status of the latest build in the Bamboo build plan, regardless of whether the latest build is related to the version (i.e. has issues from the project version linked to it).
  - If the project version has been released — the build plan status is the status of the latest build in the Bamboo build plan, that is related to the version (i.e. has issues from the project version linked to it) and is prior to or equal to the release date (or current date, if there is no release date).

**To view the Bamboo build information related to a version,**

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display. **Tip:** You can access your current project directly by simply clicking the Projects link instead of the triangle.
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
3. Click Versions on the left to display the list of versions. Click the name of the version you wish to view.
4. Click **Builds** to view the following information:
   - **Builds related to the Project** (default)
   - **Status of Build Plans related to the Project** (click **Latest plan status** at the top of the **Builds** page)

   You will need the 'View Development Tools' permission in the appropriate projects, if you want to view the 'Builds' tab.

**Viewing the Builds related to the Project Version**

By default, **Builds** displays the related builds, ordered by build date in descending order.

**Setting up an RSS feed to track Builds related to the Version**

You can set up an RSS feed to track this information by clicking on the RSS icon 📰. Each entry in the list will display information about the related build, including:

- the build name and name of the build plan
- when the build was last run
- summary information, such as related builds, duration of the build, tests passed
- build labels (if any)
- links to build artifacts (if any)

**Viewing the Status of Build Plans related to the Project Version**

To view the status of build plans related to the project version, click **Latest plan status**. The build plans listed show the status of the Build Plan, including information about the latest build in the plan (similar to the diagram above). Build plans will be sorted by plan name.

**Related Topics**

- Viewing the Bamboo Builds related to an Issue
- Browsing a Project's Bamboo Builds

**Browsing a Project's Components**

- JIRA's **Components** report shows a summary of all components (if any have been created) in a project.

  **To browse a project's components,**
  1. On the top navigation bar, click the white triangle next to **Projects**. The projects dropdown will display.
     💡 **Tip:** You can access your current project directly by simply clicking the **Projects** link instead of the triangle.
  2. Click the project you wish to browse. If the project is not displayed in the dropdown, click **View All Projects**, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
  3. Click **Components** on the left of the page. A list of components for your project will display (see screenshot below).
     - Click the name of a component to browse that component.

**Screenshot: 'Components' page for a Project**

![Components screenshot](image)
A live version of this example can be seen online.

For each component, see also:

Related Topics
- Browsing a Project
- JIRA Reports Overview

Browsing a Project's Bamboo Builds

If your organisation uses Atlassian's Bamboo and your administrator has integrated Bamboo with JIRA, JIRA enables you to view the Bamboo build plan status and recent build activity for a project. The Builds tab provides you with the build information related to the project, including:

- the list of the builds which are related to the project, i.e. builds that have issues from the project linked to them (either as 'Fixed' or 'Related'). See the Bamboo documentation for instructions on linking issues to builds.
- The latest status of the build plans for the related builds, i.e. the build plan contains a build that has an issue from the project linked to it.

To view the Bamboo build information related to a project,

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display. Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
3. Click Builds on the left to view the following information:
   - Builds related to the Project (default)
   - Status of Build Plans related to the Project (click Latest plan status at the top of the Builds page)

You will need the 'View Development Tools' permission in the appropriate projects, if you want to view the 'Builds' tab.

Builds related to the Project

By default, Builds displays the related builds, ordered by build date in descending order.

Setting up an RSS feed to track Builds related to the Project

You can set up an RSS feed to track this information by clicking on the RSS icon in the top left section of the page. Each entry in the list will display information about the related build, including:

- the build name and name of the build plan
- when the build was last run
- summary information, such as related builds, duration of the build, tests passed
- build labels (if any)
- links to build artifacts (if any)

Status of Build Plans related to the Project

The build plans listed will show the status of the build plan, (i.e. status of the latest build), including information about the latest build in the plan. Build plans are sorted by the plan name.

Related Topics
- Viewing the Bamboo Builds related to an Issue
- Browsing a Version's Bamboo Builds
- Browsing a Project's FishEye Changesets
JIRA’s Changeset report allows you to view recent changeset activity for a project (that is, where a JIRA issue key belonging to the project was referenced in the commit message), if you are using a source-code repository together with Atlassian FishEye. You can:

- View all ‘Recent Changesets’ for all repository changesets across the entire project.
- View ‘Activity Statistics’ on LOC (lines-of-code), files or commits for the project, issue or author.
- Search the FishEye repository linked to the JIRA project currently being browsed.

To view the changeset activity for a project,

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display.
   Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
3. Click Source on the left of the page. The recent changesets for your project will display (see screenshot below). By default, you will see a listing of the most recent changesets for a project:

   Screenshot: Viewing the recent changesets for a project

   ![Screenshot: Viewing the recent changesets for a project](image_url)

Click Statistics to view the Activity Statistics on LOC, Files or Commits for the project.

   Screenshot: Viewing the activity statistics for a project

![Screenshot: Viewing the activity statistics for a project](image_url)
JIRA's Reviews report allows you to view recent code reviews activity for a project (that is, where a JIRA issue key belonging to the project was referenced in the review's description), if you are using a source-code repository together with Atlassian Crucible.

To view the Reviews for a project:

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display. Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
3. Click Reviews on the left of the page. The recent changesets for your project will display. By default, you will see a listing of the most recent changesets for a project.
Viewing a Project's Burndown Chart

JIRA’s Agile report allows you to view information about a project's Backlog and its various 'Burndown' Charts, if you are using the JIRA Agile plugin.

To view information about a project's Backlog and Burndown Charts:

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display.
   Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.
3. Click Agile on the left of the page. The backlog for your project will display.

On this page, you can:

- Use the Version dropdown to display the backlog for a different project version.
- Use the Context dropdown to select a different JIRA Agile context.
- Select Info to display more information about the backlog for the selected project version.
- Select one of the chart tabs (Hours, Issues, Burndown, Burnup or Velocity) to view the JIRA Agile chart for your selected project version and context.

Velocity Charts are also known more generically as Value Charts.

Checking the progress of a version

Screenshot: Release page for a JIRA version

About the Version Release page

The Release page for a version shows the progress of your version, so you can determine which issues are likely to ship, at a glance. If you have JIRA connected to your development tools, the release page will also warn you about potential development issues that could cause problems for your release.

When you are ready to ship, you can also release your version from the release page: marking the version as complete, moving incomplete issues to other versions, and triggering the release builds (if JIRA is connected to Bamboo).
Viewing the Release page

To view the Release page for a version:

- If the project sidebar is enabled, navigate to your project > Releases > click the desired version.
- If the project sidebar is not enabled, either:
  - Navigate to the Versions tab in Plan mode for your Agile board > expand the desired version > click Details.
  - Navigate to Projects > the desired project > Versions > click the desired version.

Understanding the Release page

**Issues**

Issues are grouped into tabs depending on whether they are "To Do", "In Progress" or "Done". These groupings are reflected in the progress bar. Also, issue warnings (see below) are evaluated depending on whether an issue is "done" or not.

"To Do", "In Progress" or "Done" map to the status category of an issue's status. The status category of an status is defined when you create a status, see Defining Status Field Values. For example, the status "Open" may have its status category set to "To Do". Therefore, it will display on the Release page in the "Issues to do" tab.

If you want to work with the issues shown on any of the tabs, click View in Issue Navigator (while viewing the tab) to see the issues in the issue navigator. You can also click the individual issues to view them and make changes.

*Viewing the development information for an issue*
The 'Development' column for the list of issues will display the commits, builds and deployments related to each issue, if:

- you have the 'View Development Tools' permission for the project, and
- JIRA is connected to the required development tool. See Installing Atlassian Tools for Integration with JIRA.

<table>
<thead>
<tr>
<th>Information</th>
<th>Required development tool</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull Requests, Reviews, Commits, Branches*</td>
<td>Stash, Bitbucket, FishEye</td>
<td>3 commits</td>
</tr>
<tr>
<td>Builds</td>
<td>Bamboo</td>
<td></td>
</tr>
</tbody>
</table>
Deployments | Bambooo

* Only one of these will be displayed — the most recent one. If multiple items have the same timestamp, the one that will be displayed is determined by this priority:  
   pull requests > reviews > commits > branches.

Click on any of the symbols to view a detailed dialog describing the information. The dialog will also provide links to the commits, builds, or deployments in the relevant development tool.

**Viewing warnings from your development tools**

The 'Warnings' tab be shown if:

- you have the 'View Development Tools' permission for the project, and  
- JIRA is connected to your development tools. See [Installing Atlassian Tools for Integration with JIRA](#).

These warnings in this tab tell you when your issue data is potentially out of sync with your development data. Depending on which development tools are connected to JIRA, the Release page will display the following warnings:

<table>
<thead>
<tr>
<th>Warning type</th>
<th>Required development tool</th>
<th>When will a warning display?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open pull requests</td>
<td>Bitbucket, Stash</td>
<td>An issue is done, but has an open pull request.</td>
</tr>
<tr>
<td>Open reviews</td>
<td>Crucible</td>
<td>An issue is done, but has an open review.</td>
</tr>
<tr>
<td>Unreviewed code</td>
<td>Crucible, Bitbucket, Stash</td>
<td>An issue is done and has related commits, however some of the issue’s commits are not part of a pull request or Crucible code review.</td>
</tr>
<tr>
<td>Failing builds</td>
<td>Bamboo</td>
<td>An issue is done, but is linked to a failing build.</td>
</tr>
</tbody>
</table>

You can hide or show each of these warning types by clicking the **Manage warnings** button.

**Releasing a version**

To release a version, just click **Release**. Note, this button will only display if:

- you have the 'View Development Tools' permission for the project, and  
- you are a project administrator for the project.

Releasing the version will mark it as "Released" in JIRA. You will have the option of setting a release date and moving any incomplete issues to another version. If JIRA is connected to Bamboo, you can also choose a build to run when the version is released.

**Troubleshooting**
Why does a “Syncing” message display next to my version’s status?
JIRA regularly synchronizes issues with their related development data. However, to ensure that you are viewing the most recent data when you visit the Release page for the version, JIRA will perform another check and synchronize any data that is not up to date.

Why can’t I see any warnings?
Warnings will only display on the Release page if:

- JIRA is connected to your Atlassian development tools, i.e. Stash, Bitbucket, Bamboo, FishEye/Crucible.
- You have the ‘View Development Tools’ permission.
- Warnings are enabled. You can see which warnings are enabled by clicking the Manage warnings button.

Why can’t I filter out sub-tasks?
The Version Release page is designed to include sub-tasks. There is currently no functionality to exclude sub-tasks. The only workaround for this is to bulk edit the sub-tasks and remove the Fix Version.

Customizing the Dashboard

About Dashboards and Gadgets
The JIRA Dashboards is the first screen you see when you log in to JIRA. It can be configured to display many different types of information, depending on your areas of interest.

If you are anywhere else in JIRA, you can access your JIRA Dashboards view by clicking Dashboards at the top of your screen.

The information boxes on the dashboard are called Gadgets:
You can easily customize your dashboard by choosing a different layout, adding more gadgets, dragging the
gadgets into different positions, and changing the look of individual gadgets.

You can also create more pages for your dashboard, share your pages with other people and choose your favorites pages, as described in Managing Multiple Dashboard Pages. Each page can be configured independently, as per the instructions below.

### Available Gadgets

<table>
<thead>
<tr>
<th>Gadget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream Gadget</td>
<td>The <strong>Activity Stream</strong> gadget displays a summary of your recent activity.</td>
</tr>
<tr>
<td>Administration Gadget</td>
<td>The <strong>Administration (Guide for JIRA Administrators)</strong> gadget displays checklist of common administration tasks and links to administrative functions and documentation.</td>
</tr>
<tr>
<td>Assigned To Me Gadget</td>
<td>The <strong>Assigned To Me</strong> gadget displays all open issues in all projects assigned to the current user viewing the dashboard.</td>
</tr>
<tr>
<td>Average Age Gadget</td>
<td>The <strong>Average Age</strong> gadget displays a bar chart showing the average number of days that issues have been unresolved.</td>
</tr>
<tr>
<td>Bamboo Charts Gadget *</td>
<td>The <strong>Bamboo Charts</strong> gadget displays various charts and plan statistics from a particular Bamboo server.</td>
</tr>
<tr>
<td>Bamboo Plan Summary Chart Gadget</td>
<td>The <strong>Bamboo Plan Summary</strong> gadget displays a graphical summary of a build plan.</td>
</tr>
<tr>
<td>Bamboo Plans Gadget *</td>
<td>The <strong>Bamboo Plans</strong> gadget displays a list of all plans on a Bamboo server, and each plan's current status.</td>
</tr>
<tr>
<td>Bugzilla ID Search Gadget</td>
<td>The <strong>Bugzilla ID Search</strong> gadget allows the user to search all JIRA issues for references to Bugzilla IDs.</td>
</tr>
<tr>
<td>Calendar Gadget *</td>
<td>The <strong>Issue Calendar</strong> gadget shows issues and versions in a calendar format based on their due date. Calendars can be based on an issue filter or on a project.</td>
</tr>
<tr>
<td>Clover Coverage Gadget *</td>
<td>The <strong>Clover Coverage</strong> gadget displays the Clover coverage of plans from a particular Bamboo server.</td>
</tr>
<tr>
<td>Created vs Resolved Gadget</td>
<td>The <strong>Created vs Resolved</strong> gadget displays a difference chart showing the issues created vs resolved over a given period.</td>
</tr>
<tr>
<td>Crucible Charts Gadget *</td>
<td>The <strong>Crucible Charts</strong> gadget displays various charts showing statistical summaries of code reviews.</td>
</tr>
<tr>
<td>Favorite Filters Gadget</td>
<td>The <strong>Favorite Filters</strong> gadget displays a list of all the issue filters that have currently been added by you as a favorite filter.</td>
</tr>
<tr>
<td>Filter Results Gadget</td>
<td>The <strong>Filter Results</strong> gadget displays the results of a specified issue filter.</td>
</tr>
<tr>
<td>FishEye Charts Gadget *</td>
<td>The FishEye Charts gadget displays two charts showing showing statistics about a given sourcecode repository.</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FishEye Recent Changesets Gadget *</td>
<td>The FishEye Recent Changesets gadget displays a number of recent changesets from a FishEye repository.</td>
</tr>
<tr>
<td>In Progress Gadget</td>
<td>The In Progress gadget displays all issues that are currently in progress and assigned to the current user viewing the dashboard.</td>
</tr>
<tr>
<td>Introduction Gadget</td>
<td>The Introduction gadget displays a configurable introduction message on the dashboard.</td>
</tr>
<tr>
<td>Issue Statistics Gadget</td>
<td>The Issue Statistics gadget displays the collection of issues returned from a specified filter, broken down by a specified field.</td>
</tr>
<tr>
<td>Pie Chart Gadget</td>
<td>The Pie Chart gadget displays issues from a project or issue filter, grouped by a statistic type, in pie-chart format. The issues can be grouped by any statistic type (e.g. Status, Priority, Assignee, etc).</td>
</tr>
<tr>
<td>Projects Gadget</td>
<td>The Projects gadget provides information and various filters related to a specified project(s).</td>
</tr>
<tr>
<td>Quick Links Gadget</td>
<td>The Quick Links gadget displays a number of useful links to issues associated with the current user.</td>
</tr>
<tr>
<td>Recently Created Issues Gadget</td>
<td>The Recently Created Issues gadget displays a bar chart showing the rate at which issues are being created, as well as how many of those created issues are resolved.</td>
</tr>
<tr>
<td>Resolution Time Gadget</td>
<td>The Resolution Time gadget displays a bar chart showing the average resolution time (in days) of resolved issues.</td>
</tr>
<tr>
<td>Road Map Gadget</td>
<td>The Road Map gadget shows versions which are due for release within a specified period of time, and a summary of progress made towards completing the issues in those versions.</td>
</tr>
<tr>
<td>Text Gadget *</td>
<td>The Text gadget displays a configurable HTML text on the dashboard.</td>
</tr>
<tr>
<td>Time Since Issues Gadget</td>
<td>The Time Since Issues gadget displays a bar chart showing the number of issues that something has happened to within a given time period. The 'something has happened' is based on a date field that you choose, such as 'Created', 'Updated', 'Due', 'Resolved' or a custom field.</td>
</tr>
<tr>
<td>Two Dimensional Filter Statistics Gadget</td>
<td>The Two Dimensional Filter Statistics gadget displays statistical data based on a specified filter in a configurable table format.</td>
</tr>
<tr>
<td>Voted Gadget</td>
<td>The Voted Issues gadget shows issues for which you have voted.</td>
</tr>
<tr>
<td>Watched Gadget</td>
<td>The Watched Issues gadget shows issues which you are watching.</td>
</tr>
</tbody>
</table>

See the big list of all Atlassian gadgets for more ideas.

* This gadget will only be available if it has been installed by your JIRA administrator.

The Firebug add-on for Firefox can significantly degrade the performance of web pages. If JIRA is
Creating a Dashboard

The dashboard that you see when you first start using JIRA is a "default" dashboard that has been configured by your JIRA administrator. You cannot edit the default dashboard; but you can easily create your own dashboard, which you can then customize as you wish.

To create your own dashboard:

1. At the top right of the Dashboard, click the 'Tools' menu.
2. Select either 'Create Dashboard' to create a blank dashboard, or 'Copy Dashboard' to create a copy of the dashboard you are currently viewing.

You can now customize your dashboard as follows:

- Choosing a Dashboard Layout
- Adding a Gadget
- Moving a Gadget
- Removing a Gadget

If you are using multiple dashboard pages, you can only configure dashboard pages that you own.

Choosing a Dashboard Layout

To choose a different layout for your dashboard page (e.g. three columns instead of two):

1. At the top right of the Dashboard, click the 'Edit Layout' link. A selection of layouts will be displayed:

   ![Edit Layout](image)

2. Click your preferred layout.

Adding a Gadget

1. At the top right of the Dashboard, click the 'Add Gadget' link.
2. A selection of gadgets will be displayed:
Select a category on the left to restrict the list of gadgets on the right to that category.
3. Click the ‘Add it now’ button beneath your chosen gadget.
4. Click the ‘Finished’ button to return to your Dashboard.
5. If the gadget you have selected requires configuration, you will be presented with the gadget’s configuration page. Configure appropriately and click ‘Save’.

Moving a Gadget
To move a gadget to a different position on your dashboard:
- Click the gadget and drag it into its new position.

Removing a Gadget
To remove a gadget from your dashboard:
1. Hold your mouse over the top right corner of the gadget, until a down-arrow appears.
2. Click the down-arrow to display the following menu:
3. Click 'Delete'.

RELATED TOPICS

Displaying a Dashboard as a Wallboard

The big list of Atlassian gadgets

Managing Multiple Dashboard Pages

JIRA allows you to configure more than one dashboard page. Each dashboard page can be configured independently, allowing you to neatly organize related information by context. You can also share your dashboard pages with other users, as well as adding dashboards shared by other users as favorites.

You can view a dashboard page by simply clicking its name.

On this page:

- Managing your Dashboard
- Creating new dashboard pages
- Displaying a dashboard page on your dashboard ('Favorite Dashboards')
- Sharing Dashboard Pages
- Finding an existing Dashboard Page
- Editing an existing Dashboard Page's details
- Copying an existing Dashboard Page
- Deleting an existing Dashboard Page
- Managing Other User's Shared Dashboards

Managing your Dashboard

The 'Manage Dashboards' page allows you to view and configure dashboard pages that you have created, as well as work with dashboard pages that other users have shared with you.

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. The 'Manage Dashboards' page will display. From this page, you can:
   - Create a new dashboard page.
   - Add a dashboard page as a favorite.
• **Share a dashboard page** that you have created, with other users.
• **Search for dashboard pages** that has been created by you or shared with you by other users.
• **Configure an existing dashboard** or **edit an existing dashboard's details** of a dashboard that you have created.
• **Copy a dashboard page** that has been created by you or shared with you by other users.
• **Delete a dashboard page** that you have created.

Click the above links for further details on each function.

You can also reorder your dashboard pages on this page, by using the arrow icons:

| Move a dashboard up | Click the up arrow for the dashboard that you wish to move. |
| Move a dashboard down | Click the down arrow for the dashboard that you wish to move. |
| Move a dashboard to the top of the list | Click the curly up arrow for the dashboard that you wish to move. |
| Move a dashboard to the bottom of the list | Click the curly down arrow for the dashboard that you wish to move. |

### Creating new dashboard pages

To create a new dashboard page please follow these steps:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu. The 'Manage Dashboards' page will display. This page lists all currently configured dashboard pages.
2. Click the 'Create new dashboard' link. The 'Create new dashboard' page will display.
Provide a name for the new dashboard page and optionally enter a short description. You can also choose an existing page as a starting point for the new page. This means that the configuration of the existing page will be duplicated for the newly created page. Alternatively, if you would like to create a page with no gadgets, leave the 'Blank dashboard' option selected.

3. Your new dashboard page will be added as a 'favorite' dashboard page by default upon creation, which means that it will display as a tab on your JIRA dashboard. If you do not wish to display this dashboard page as a tab on your JIRA dashboard, deselect the star icon. You can add the dashboard page as a favorite after it has been created. Read more about adding an existing dashboard page as a favorite.

4. The sharing of your new dashboard page depends on your sharing preference in your user profile. If you have not specified a personal preference, then the global default for sharing will apply (i.e. 'Private', unless changed by your JIRA Administrator under 'User Defaults' in the Administration menu). If you wish
to change the sharing of your dashboard page, refer to the instructions on sharing dashboard pages below.

Please note, you need the 'Create Shared Object' global permission to be able to share your dashboard page. If you cannot see any dashboard sharing functionality, contact your JIRA Administrator to be granted this permission.

5. Click the 'Add' button. Your new page will be listed under the 'My' tab of the 'Manage Dashboards' page. If you selected the new dashboard page as a favorite, it will also appear under the 'Favorite' tab and will be displayed as a tab on your JIRA dashboard.

6. You can now customize your new dashboard page, and add gadgets to it, as described in Customizing the Dashboard.

Displaying a dashboard page on your dashboard (‘Favorite Dashboards’)

Dashboard pages that you have created, or that have been shared by other people, can be added as a ‘favorite’. This means that the dashboard page will appear as a tab on the left side of your browser window, when viewing your JIRA dashboards. There is no restriction on the number of dashboards that you can add as a ‘favorite’ and each of these will appear on an individual tab when viewing your JIRA dashboards.

To add an existing dashboard page to your dashboard:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. The 'Manage Dashboards' page will display. Locate the dashboard page that you wish to display on your dashboard. If you created the dashboard, it will be listed under the 'My' tab, otherwise you can search for dashboards shared by other users via the 'Search' tab.
   - Your favorite dashboards are shown with a gray star.
   - Dashboards that are not currently your favorites are shown with the outline of a star.
3. Click the gray star icon next to the name of the desired dashboard page to add it as a favorite.

Please note, if you have added another user's shared dashboard as a favorite and a gadget(s) is not displaying correctly, the gadget(s) may be using an issue filter that is not shared with you. You will need to contact the author of the issue filter to change the filter sharing.

To remove a dashboard page from your dashboard:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. The 'Manage Dashboards' page will display. Locate the dashboard page that you wish to remove from your dashboard under the 'favorites' tab.
3. Click the star icon next to the name of the dashboard page. The dashboard page will be removed from your main dashboard.

Please note, if you do not have any dashboard pages added as favorites, the default dashboard will be displayed on your dashboard with an error message. You can choose to keep the default dashboard displayed on your dashboard, but you will need to add it as a favorite to stop the error message from showing. You may need to search for the 'System Default' dashboard to add it as a favorite.

Sharing Dashboard Pages

JIRA also allows you to share any dashboard pages that you have configured. Dashboard pages can be shared with other users via user groups, projects and project roles. Dashboard pages can also be shared globally. Sharing a dashboard page allows other users to display it on their JIRA dashboard, by selecting it as a favorite.

Please note, you may need to review the sharing permissions for any issue filters used in portlets on your shared dashboard. If another user adds your dashboard as a favorite, but cannot access a filter for a portlet, then the portlet will display with an error message.
To share an existing dashboard page to the dashboard, please follow these steps:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. The 'Manage Dashboards' page will display. Locate the dashboard page that you wish to display on your dashboard under the 'My' tab and click the 'Edit' link for the dashboard in the 'Operations' column.
3. The 'Edit Dashboard' page will display. Select the group, project or project role that you want to share the dashboard with, or share it with all users, if you wish. Click the 'Add' link to add the share. You can add further share permissions if you wish.
4. Click the 'Update' button to save your changes.

Finding an existing Dashboard Page

Dashboard pages that you have created or have been shared by other users, can be found via the dashboard Search function of the 'Manage Dashboards' page. If it is a popular dashboard (i.e. added as a favorite by many users), you can also locate it on the 'Popular' tab of the 'Manage Dashboards' page which lists the top twenty most popular dashboards.

To search for an existing dashboard page, please follow the steps below:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. Click the 'Search' tab. The dashboard Search will display. Enter your search criteria and click 'Search' to run the search.
3. Your search results will be displayed on the same page. You can sort the search results by any of the columns, by clicking the column headers. Click the name of any dashboard page to temporarily display it on your dashboard (i.e. it will be removed from your dashboard when you navigate away). To keep the dashboard page as a tab on your dashboard, click the 'add it as a favorite' link.

Editing an existing Dashboard Page's details

You can always update the details, i.e. Name, Description, Sharing, favorite, of an existing dashboard page after its creation. Please note that you can only update the details of dashboard pages which you have created.

To update the details of one of your existing dashboard pages, please follow the steps below:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. The 'Manage Dashboards' page will display. Locate the dashboard page that you wish to update and click the 'Edit' link for the dashboard in the 'Operations' column.
3. The 'Edit Dashboard' page will display. Update the details of the dashboard page as desired. If you wish to change the sharing or favorite settings for the dashboard page, refer to the relevant instructions above.
4. Click the 'Update' button to save your changes.

Copying an existing Dashboard Page

You can make a copy of an existing dashboard page (created by you or shared with you), which creates a new dashboard page with the same gadget configuration as the existing dashboard page.

To update the details of one of your existing dashboard pages, please follow the steps below:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. The 'Manage Dashboards' page will display. Locate the dashboard page that you wish to copy and click the 'Copy' link for the dashboard in the 'Operations' column.
3. The 'Create New Dashboard' page will display. Update the details of the dashboard page as desired. If you wish to change the sharing or favorite settings for the dashboard page, refer to the relevant instructions above.
4. Click the 'Update' button to save your changes. Please note, you are able to share your dashboard only with the groups that you are member of.
Deleting an existing Dashboard Page

Please note that you can only delete dashboard pages that you created.

To delete a dashboard pages, please follow the steps below:

1. At the top left of the dashboard, click the down-arrow on the 'Dashboards' tab and select 'Manage Dashboard' from the drop-down menu.
2. The 'Manage Dashboards' page will display. Locate the dashboard page that you wish to copy and click the 'Delete' link for the dashboard in the 'Operations' column.
3. A confirmation message box will appear. This message will also inform you if (and how many) other users have selected this dashboard as a favorite. If you wish to continue with the deletion, click the 'Delete' button. Otherwise, click the 'x' in the top right of the message box to cancel this action.

Managing Other User's Shared Dashboards

A shared dashboard is a dashboard whose creator has shared that dashboard with other users. Refer to Sharing Dashboard Pages above for details. When a shared dashboard is created by a user, that user:

- Initially 'owns' the shared dashboard.
- Being the owner, can edit and modify the shared dashboard.

If you have the 'JIRA Administrators' global permission, you can manage shared dashboards that were created by other users.

To access the 'Shared Dashboards' feature:

1. Ensure that you are logged in as a user with the JIRA Administrators global permission.
2. On the top navigation bar, click the 'Dashboards' dropdown and select 'Shared Dashboards' from the list.

Displaying a Dashboard as a Wallboard

A Wallboard is a type of information radiator that displays vital data about the progress of the development team. Similar to a scoreboard at a sporting event, Wallboards are large, highly visible and easy to understand for anyone walking by.

Traditional Wallboards are made of paper or use sticky notes on a wall. Electronic Wallboards are very effective since they update automatically with real-time data ensuring that people check back regularly.

Screenshot: Example Wallboard
What is an information radiator?

An information radiator is a large, highly visible display used by software development teams to show anyone walking by what's going on. The term was first coined by Alistair Cockburn. In his book, Alistair describes information radiators as follows: An Information radiator is a display posted in a place where people can see it as they work or walk by. It shows readers information they care about without having to ask anyone a question. This means more communication with fewer interruptions. A good information radiator

- Is large and easily visible to the casual, interested observer
- Is understood at a glance
- Changes periodically, so that it is worth visiting
- Is easily kept up to date

Setting up a Wallboard

Explore different layouts for your Wallboard to see which suits your needs best.

1. Create a dashboard, as described in [Customizing the Dashboard](#).
3. Click the Wallboard tab on the left-hand side to show only Wallboard-capable gadgets in the list. You can use gadgets that are not listed under the 'Wallboard' tab, however, JIRA will style these gadgets in a 'best efforts' manner (fonts and colour schemes may not match) and some features will be unavailable.
4. Add the desired gadgets to your dashboard and configure them.
   - (Optional) Make the color of the individual gadgets in one column the same. This enables cycling of gadgets within Wallboards for some cool effects.
5. Click Tools > View as Wallboard.

Tip: Want to get a JIRA Agile Wallboard set up quickly? Create a new dashboard and add the Agile Wallboard Gadget. This gadget displays a board as a Wallboard.
Configuring multiple dashboards as a Wallboard slideshow

1. Create/configure your dashboards to display as Wallboards, as described in the 'Setting up a Wallboard' section above.
2. Navigate to one of the dashboards and click **Tools > Set Up Wallboard Slideshow**.
3. Select the dashboards you wish to include as well as any display options, then click **Done**.
4. Click **Tools > View Wallboard Slideshow** to view your new Wallboard Slideshow.

Note: If you have too many items in a column on a wallboard, the items in the column will cycle as well, this is not configurable and not related to the Cycle Period.

Changing the Look and Behavior of a Gadget

On this page:
- Hiding or Changing the Color of the Gadget's Frame
- Minimising and Expanding a Gadget
- Opening the Maximized or Canvas View of a Gadget
- Editing a Gadget's Settings

Hiding or Changing the Color of the Gadget's Frame

You can change the color of the frame surrounding a gadget on your dashboard. You can even hide the gadget's frame altogether, so that it only shows when you move your mouse pointer over the gadget. In the screenshot below, the top two gadgets have hidden frames. The frame for the top gadget on the left is not visible. The frame for the top gadget on the right is currently visible because the mouse pointer is hovering over the gadget.

**To hide or change the color of a gadget's frame,**

1. Go to the dashboard by clicking the 'Dashboard' link or the 'Home' link at the top left of the screen.
2. The dashboard will appear, looking something like the screenshot below. Move your mouse pointer over the gadget you want to change. If the gadget's frame is hidden, the frame will appear now.
3. Click the dropdown menu icon at top right of the gadget frame.
4. The dropdown menu will appear, as shown in the screenshot below. Click the color you want for your gadget's frame. To hide the gadget's frame, select the white color box with the red line through it.

**Screenshot: Hiding or changing the color of a gadget's frame**

![Admin Dashboard](image)
Minimising and Expanding a Gadget

You can shrink (minimize) a gadget on your dashboard so that it displays only the top bar of the gadget frame.

- If you minimize a gadget that has a hidden frame, the gadget will not be visible on the dashboard until you move your mouse pointer over the gadget. See the section above on hiding or changing the color of the gadget frame.
- You can minimize/expand a gadget even if you do not have update permissions on the dashboard.
- The minimize/expand setting is stored in a cookie, and is not saved to the dashboard server.

To minimize a gadget,

1. Move your mouse pointer over the gadget you want to change.
2. The gadget menu icons will appear. Click the dropdown menu icon at top right of the gadget frame.
3. The dropdown menu will appear, as shown in the screenshot above. Click ‘Minimize’.

To expand a gadget that has been minimized,

1. Move your mouse pointer over the gadget you want to change.
2. The gadget menu icons will appear. Click the dropdown menu icon at top right of the gadget frame.
3. The dropdown menu will appear. Click ‘Expand’.

Screenshot: A minimized gadget (Introduction Gadget)

Opening the Maximized or Canvas View of a Gadget

Some gadgets allow you to expand themselves so that they take up the entire space allowed by the dashboard. This is also known as ‘canvas view’.

- The maximized or canvas view of a gadget often provides additional functionality, i.e. more than is available in the standard view of the gadget.
- This is not the same as minimising and then expanding a gadget (see above).
- Only some gadgets provide the maximized or canvas view.
- You can open the canvas view of a gadget even if you do not have update permissions on the dashboard.
- The maximized/canvas view setting is stored in a cookie, and is not saved to the dashboard server.

To open the maximized or canvas view of a gadget,

1. Move your mouse pointer over the gadget you want to change.
2. The gadget menu icons will appear. Click the maximize icon at top right of the gadget frame. This icon will appear only if the gadget provides a maximized or canvas view.
3. The gadget's maximized view will open, as shown in the screenshot below.

To close the canvas view and return to your dashboard,
1. Click the 'Restore' option at the top right of the screen, or the 'Restore' icon at top right of the gadget frame.

Screenshot: The maximized or canvas view of a gadget

Editing a Gadget's Settings

Some gadgets provide specific properties or settings that you can edit. These settings will be different for each gadget. For example, a gadget may allow you to customize its welcome message, or to define the server where the gadget will find its information.

To edit a gadget's settings,

1. Move your mouse pointer over the gadget you want to change.
2. The gadget menu icons will appear. Click the dropdown menu icon at top right of the gadget frame.
3. The dropdown menu will appear. Click 'Edit'.
4. A panel will open, showing the settings offered by the selected gadget.
5. Adjust the settings as required then click 'Save'.

Adding the Activity Stream Gadget

The Activity Stream gadget displays a summary of recent activity in particular projects (and/or by particular people) in which you are interested. This can include:

- Issues in your local JIRA Server system.
- Issues in another JIRA Server system, provided your administrator has configured a two-way Application Link.
- Activity from another Atlassian application, such as:
  - document updates (from Confluence)
  - code commits (from FishEye)
  - code reviews (from Crucible)
  - builds (from Bamboo)
  
  Note that this requires your administrator to configure a two-way Application Link, unless you are using Atlassian OnDemand.
- Activity from remote applications. Your administrator will need to set this up via the REST API or the provider plugin API, or locally via Java.
The **Activity Stream** gadget also provides an RSS feed, allowing you to create very specific RSS feeds of only the information that is most relevant to you. Simply add the **Activity Stream** gadget to your dashboard, specify the people/projects of interest (see instructions below), then click the RSS icon: 📣

**What does it look like?**

The **Activity Stream** gadget should appear as follows on the dashboard:

![Activity Stream gadget on JIRA dashboard](image)

**Adding the 'Activity Stream' gadget to your Dashboard**

1. Go to your JIRA dashboard and click **Add Gadget**.
2. The **Gadget Directory** will appear. Locate the **Activity Stream** gadget and click the **Add it Now** button. Then click the **Finished** button at the bottom of the Gadget Directory.
3. The Activity Stream gadget will appear on your dashboard as follows, ready for you to configure:
4. **Title** — type a heading for this gadget.

5. **Apply filters** — by default, the gadget will display all activity for all projects. If you wish to refine this, select the **Apply filters** check-box, then select the '+ ' signs to filter the activity by:
   - **Project**
   - **JIRA Issue Key**
   - **Update Date**
   - **Username** — the user(s) whose activity you wish to monitor. You can specify multiple usernames
delimited by spaces, e.g. "jsmith tjones dbrown".

6. **Available Streams** — select the applications whose activity you wish to monitor. This can include Atlassian applications (e.g. JIRA, Confluence) as well as remote applications.

7. **Limit to _ items** — type the number of activities that you want the gadget to display.

8. **Automatically refresh this activity stream** — select this check-box if you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Administration Gadget**

The Administration (Guide for JIRA Administrators) gadget displays handy checklist of common tasks. Click on any task and you'll be taken to the relevant administration screen to complete it. The gadget also provides other helpful information for new administrators, such as links to the JIRA administrator documentation. This gadget displays on the default dashboard for people who have the 'JIRA Administrators' or the 'JIRA System Administrators' global permission.

What does it look like?

The **Administration** gadget should appear as follows on the dashboard:

**Adding the Administration gadget to your Dashboard**

The Administration gadget is automatically displayed on the default dashboard. If you have removed it and want to restore it to the default dashboard, or you want to add it to a new dashboard, follow the instructions below:

1. Go to your JIRA dashboard and click Add Gadget. The 'Gadget Directory' will appear.
2. Locate the Guide for JIRA Administrators gadget and click the Add it Now button. Then click the Finish button at the bottom of the Gadget Directory.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Assigned To Me Gadget**

The **Assigned To Me** gadget displays all open issues in all projects assigned to the current user viewing the dashboard.

What does it look like?

The **Assigned to Me** gadget should appear as follows on the dashboard:

<table>
<thead>
<tr>
<th>Assigned to Me</th>
</tr>
</thead>
<tbody>
<tr>
<td>T Key Summary</td>
</tr>
<tr>
<td>QA-23 QA version 2.0 bacon issue fixed 2.0 - Would i get notified????</td>
</tr>
<tr>
<td>BULK-43 Sub-Task of Death!!!!!!</td>
</tr>
<tr>
<td>QA-40 would u show up in my inbox?</td>
</tr>
<tr>
<td>BULK-70 Description testing</td>
</tr>
<tr>
<td>BULK-118 BULK-116 / Cross-Site Request Forgery</td>
</tr>
<tr>
<td>BULK-5 Unknown Unknown issue fixed 2.0</td>
</tr>
<tr>
<td>BULK-4 Version 1.1.1 cheese issue fixed 1.1.1why did summary vanish? saving</td>
</tr>
<tr>
<td>BULK-5 BULK-4 / version 2.0 bacon issue fixed 2.0</td>
</tr>
<tr>
<td>BULK-8 addaddadd us</td>
</tr>
<tr>
<td>QA-24 QA bacon 1.1.1 unknown</td>
</tr>
</tbody>
</table>

1-10 of 124 1 2 3 4 5 6 7 8 9
Note: This gadget only displays issues that are unresolved.

Adding the 'Assigned To Me' gadget to your Dashboard

1. Go to your JIRA dashboard and click Add Gadget.
2. The Gadget Directory will appear. Locate the Watched Issues gadget and click the Add it Now button. Then click the Finished button at the bottom of the Gadget Directory.
3. The 'Assigned To Me' gadget will appear on your dashboard as follows:

![Assigned To Me gadget screenshot]

- **Number of Results** — type the number of issues you would like the gadget to display per page (maximum 50).
- **Fields to display** — select the issue fields to display as columns. Drag and drop to re-order.
- **Refresh Interval** — select how often you want the gadget to update the list of issues (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the Save button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the Average Age Gadget

The 'Average Age' gadget displays a bar chart showing the average age (in days) of unresolved issues at given points in time. The report is based on your choice of project or issue filter, and your chosen units of time (ie. hours, days, weeks, months, quarters or years). For the purposes of this gadget an issue is defined as unresolved if it has no value in the system Resolution field. The age of an issue is the difference between the current date and the created date of the issue.

What does it look like?

The 'Average Age' gadget will appear as follows on the dashboard:
Adding the 'Average Age' gadget to your Dashboard

To add the 'Average Age' gadget to your dashboard:

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Average Age' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Average Age gadget will appear on your dashboard as follows, ready for you to configure:

A report showing this information is also available.
a. **Project or Saved Filter** — start typing the name of the project (or saved filter) on whose issues the chart will be based. Alternatively, if you’re unsure of the name of the project or filter you’re looking for, click **Advanced Search** to search for a project (or saved filter) whose name contains particular text; or a saved filter that was created by a particular user and/or is shared with particular users.

b. **Period** — select the timeframe on which the chart will be based:
   - ‘Hourly’
   - ‘Daily’
   - ‘Weekly’
   - ‘Quarterly’
   - ‘Yearly’

c. **Days Previously** — enter the number of days’ worth of data (counting backwards from today) to be included in the chart.

d. **Refresh Interval** — select how often you want the gadget to update the chart (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the **Save** button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts.
correctly:

1. Select 'Internet Options' from the 'Tools' menu:

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:

3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.
Adding the Bamboo Charts Gadget

The **Bamboo Charts** gadget displays various charts and plan statistics from a particular Bamboo server.

What does it look like?

The **Bamboo Charts** gadget should appear as follows on the dashboard:

*Screenshot: ‘Bamboo Charts’ gadget*

![](image)

Your JIRA administrator must have **configured the Bamboo plugin on your JIRA server** (.), if you want to add the Bamboo Charts gadget to your dashboard. If you have added multiple Bamboo servers in JIRA there will be one Bamboo Charts gadget available per server, e.g. ‘Bamboo Charts Gadget from http://172.20.5.83:8085’, ‘Bamboo Charts Gadget from http://172.19.6.93:8085’, etc. ()

Adding the ‘Bamboo Charts’ gadget to your Dashboard

1. Go to your JIRA **dashboard** and click ‘**Add Gadget**.’
2. The **Gadget Directory** will appear. Locate the **Bamboo Charts** gadget and click the **Add it Now** button. Then click the **Finished** button at the bottom of the Gadget Directory. The **Bamboo Charts** gadget will appear on your dashboard as follows, ready for you to configure.
3. Click the arrow in the top right corner of the gadget to open the configuration menu and click ‘**Edit**’. Configure the Bamboo information to be displayed on your gadget as follows:
   - ‘**Select Report Type**’ — Select the **Bamboo report** that you would like to display as a chart.
   - ‘**Select Plans**’ — Select the plans that you would like included in the chart.
   - ‘**Group By**’ — Select the time interval to group by in your chart.
   - ‘**Show Builds From**’ — Select how many days worth of builds you would like to include.
4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

### Authorising JIRA to Display Bamboo Gadgets

When you add this gadget to your JIRA dashboard, you may see a message similar to this:

> The website (container) you have placed this gadget on is unauthorised. Please contact your system administrator to have it approved.

To fix this problem, you will need to configure your Bamboo site to allow JIRA to draw information from it via gadgets on the JIRA dashboard. To do this, your JIRA administrator first needs to define your JIRA site as an OAuth consumer in Bamboo. You will then be required to perform a once-off authentication before your gadget will display correctly.

### Adding the Bamboo Plan Summary Chart Gadget

The **Bamboo Plan Summary Chart** gadget displays a graphical summary of a Bamboo build plan from a particular Bamboo server.

#### What does it look like?

There are two graph types available with the **Bamboo Plan Summary Chart** gadget:

1. **Group By Time Period**

   This graph displays the percentage of successful builds over time and the average duration of the builds in each time period:

   ![Plan Summary for MASTERONE-UNIT](https://example.com)

   Your JIRA administrator must have configured the Bamboo plugin on your JIRA server, if you want to add the Bamboo Plan Summary gadget to your dashboard. If you have added multiple Bamboo servers
Adding the 'Bamboo Plan Summary Chart' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Bamboo Plan Summary Chart' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory. The 'Bamboo Plan Summary Chart' gadget will appear on your dashboard as follows, ready for you to configure.
3. Click the arrow in the top right corner of the gadget to open the configuration menu and click 'Edit'. Configure the Bamboo information to be displayed on your gadget as follows:
   - 'Select Plan' — Select the Bamboo plan for which you would like to show a summary.
   - 'Select Chart Type' — Select the chart which you would like displayed for the plan, i.e. 'Success Rate & Duration' by desired interval (group by time period) or 'Duration and Failed Tests' by build number (group by build).
   - 'Show Builds From' — Select how many days worth of builds you would like to include.
   - 'Refresh Interval' — Select how often you would like the information on the gadget to update.
4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:

![Internet Options](image)

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:
3. The ‘Settings’ window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the ‘Automatically’ option instead.

Authorising JIRA to Display Bamboo Gadgets
When you add this gadget to your JIRA dashboard, you may see a message similar to this:

The website (container) you have placed this gadget on is unauthorised. Please contact your system administrator to have it approved.

To fix this problem, you will need to configure your Bamboo site to allow JIRA to draw information from it via gadgets on the JIRA dashboard. To do this, your JIRA administrator first needs to define your JIRA site as an OAuth consumer in Bamboo. You will then be required to perform a once-off authentication
Adding the Bamboo Plans Gadget

The **Bamboo Plans** gadget displays a list of all plans on a particular Bamboo server and each plan's current status.

What does it look like?

The **Bamboo Plans** gadget should appear as follows on the dashboard:

![Screenshot: 'Bamboo Plans' gadget](https://jira.bamboo.atlassian.com)

Your JIRA administrator must have [configured the Bamboo plugin on your JIRA server](https://jira.bamboo.atlassian.com), if you want to add the Bamboo Plans gadget to your dashboard. If you have added multiple Bamboo servers in JIRA there will be one Bamboo Plans gadget available per server, e.g. 'Bamboo Plans Gadget from http://172.20.5.83:8085', 'Bamboo Plans Gadget from http://172.19.6.93:8085', etc. ()

Adding the 'Bamboo Plans' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Bamboo Plans' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory. The 'Bamboo Plans' gadget will appear on your dashboard as follows, ready for you to configure.
3. Click the arrow in the top right corner of the gadget to open the configuration menu and click 'Edit'. Configure the Bamboo information to be displayed on your gadget as follows:
   - 'Select Plans' — Select the Bamboo plan which you would displayed on your gadget.
   - 'Refresh Interval' — Select how often you would like the information on the gadget to update.
4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Authorising JIRA to Display Bamboo Gadgets

When you add this gadget to your JIRA dashboard, you may see a message similar to this:

*The website (container) you have placed this gadget on is unauthorised. Please contact your system administrator to have it approved.*
To fix this problem, you will need to configure your Bamboo site to allow JIRA to draw information from it via gadgets on the JIRA dashboard. To do this, your JIRA administrator first needs to define your JIRA site as an OAuth consumer in Bamboo. You will then be required to perform a once-off authentication before your gadget will display correctly.

Adding the Bugzilla ID Search Gadget

The **Bugzilla Issue ID Search** gadget allows you to search all JIRA issues for references to Bugzilla issue IDs. If the specified ID is not found within JIRA, the gadget redirects to the Bugzilla issue (if a Bugzilla server URL has been specified). This allows JIRA to become the one interface for all JIRA and Bugzilla issues.

Please note that this gadget does not work if the Bugzilla issues were imported using the [JIRA Importers Plugin](https://confluence.atlassian.com/display/JIRA/Importing+Data+into+JIRA+via+Plugins) (which replaced the built-in JIRA importer at the release of JIRA 4.4). Instead, please use JIRA's Simple/Advanced Search to find your Bugzilla issue IDs.

**What does it look like?**

The **Bugzilla Issue ID Search** gadget should appear as follows on the dashboard:

![Bugzilla Issue ID Search](image)

**Adding the 'Bugzilla Issue ID Search' gadget to Dashboard**

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Bugzilla Issue ID Search' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The 'Bugzilla Issue ID Search' gadget will appear on your dashboard as follows, ready for you to configure:

![Bugzilla Issue ID Search](image)

4. Optionally enter the URL of the Bugzilla server you wish to search.
5. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Calendar Gadget**

The **JIRA Issues Calendar** gadget shows issues and versions in a calendar format based on their due date. Calendars can be based on an issue filter or on a project.

Please note the JIRA Calendar plugin is required for this Gadget to be available.

**What does it look like?**

The **JIRA Issues Calendar** gadget should appear as follows on the dashboard:
Adding the 'Calendar' gadget to your Dashboard

1. Go to your JIRA dashboard and click Add Gadget.
2. The Gadget Directory will appear. Locate the JIRA Issues Calendar gadget and click Add it Now. Then click Finished.
3. The JIRA Issues Calendar gadget will appear on your dashboard as follows, ready for you to configure:
a. **Project or Filter** — click the ‘Select’ link to choose the project or filter on whose issues the calendar will be based.

b. **Date to Display** — select the date field (e.g. Due Date; Created Date; Updated Date) on which the calendar will be based.

c. **Display Project Versions** — select whether the calendar will display the **Release Date** of each **Project Version**.

d. **Number of Issues** — select the maximum number of issues to be displayed on the calendar for any one day.

e. **Refresh Interval** — select how often you would like this calendar to be updated.

4. Click **Save**.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Clover Coverage Gadget**

The **Clover Coverage** gadget displays the Clover coverage of plans from a particular Bamboo server.

What does it look like?

The **Clover Coverage** gadget should appear as follows on the dashboard:

*Screenshot: ‘Clover Coverage’ gadget*
Adding the 'Clover Coverage' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The ‘Gadget Directory’ will appear. Locate the ‘Clover Coverage’ gadget and click the ‘Add it Now’ button. Then click the ‘Finished’ button at the bottom of the Gadget Directory. The ‘Clover Coverage’ gadget will appear on your dashboard as follows, ready for you to configure.
3. Click the arrow in the top right corner of the gadget to open the configuration menu and click ‘Edit’. Configure the information to be displayed on your gadget as follows:
   - ‘Select Plans’ — Select the Bamboo plans for which you would like code coverage information displayed on your gadget.
   - ‘Refresh Interval’ — Select how often you would like the information on the gadget to update.
4. Click the ‘Save’ button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Authorising JIRA to Display Bamboo Gadgets

When you add this gadget to your JIRA dashboard, you may see a message similar to this: The website (container) you have placed this gadget on is unauthorised. Please contact your system administrator to have it approved.

To fix this problem, you will need to configure your Bamboo site to allow JIRA to draw information from it via gadgets on the JIRA dashboard. To do this, your JIRA administrator first needs to define your JIRA site as an OAuth consumer in Bamboo. You will then be required to perform a once-off authentication before your gadget will display correctly.

Adding the Created vs Resolved Gadget

The 'Created vs Resolved' gadget displays a difference chart showing the number of issues created vs number of issues resolved over a given period of time. The chart is based on your choice of project or issue filter, and the chart can either be cumulative or not. An issue is marked as resolved in a period if it has a resolution date in that period. The resolution date is the last date that the system Resolution field was set to any non-empty value.
What does it look like?

The 'Created vs Resolved' gadget will appear as follows on the dashboard:

![Created vs Resolved Chart Design](image)

A report showing this information is also available.

Adding the 'Created vs Resolved Issues' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Created vs Resolved' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The 'Created vs Resolved' gadget will appear on your dashboard as follows, ready for you to configure:
<table>
<thead>
<tr>
<th>Created vs Resolved Chart: Book Request</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project or Saved Filter:</strong> Book Request</td>
</tr>
<tr>
<td>Quick Find</td>
</tr>
<tr>
<td><strong>Advanced Search</strong></td>
</tr>
<tr>
<td><strong>Period:</strong> Daily</td>
</tr>
<tr>
<td>The length of periods represented on the graph.</td>
</tr>
<tr>
<td><strong>Days Previously:</strong></td>
</tr>
<tr>
<td>100</td>
</tr>
<tr>
<td>Days (including today) to show in the graph.</td>
</tr>
<tr>
<td><strong>Cumulative Totals:</strong> Yes</td>
</tr>
<tr>
<td>Progressively add totals (1..2..3), or show individual values (1..1..1).</td>
</tr>
<tr>
<td><strong>Display the Trend of Unresolved:</strong> No</td>
</tr>
<tr>
<td>Show the number of unresolved issues over time in a subplot.</td>
</tr>
<tr>
<td><strong>Display Versions:</strong> Only major versions</td>
</tr>
<tr>
<td>Show when versions were released on the chart.</td>
</tr>
<tr>
<td><strong>Refresh Interval:</strong> Never</td>
</tr>
<tr>
<td>How often you would like this gadget to update</td>
</tr>
</tbody>
</table>

a. **Project or Saved Filter** — start typing the name of the project (or saved filter) on whose issues the chart will be based. Alternatively, if you're unsure of the name of the project or filter you're
looking for, click 'Advanced Search' to search for a project (or saved filter) whose name contains particular text; or a saved filter that was created by a particular user and/or is shared with particular users.

b. 'Period' — select the timeframe on which the chart will be based:
   - 'Hourly'
   - 'Daily'
   - 'Weekly'
   - 'Quarterly'
   - 'Yearly'

c. 'Days Previously' — enter the number of days' worth of data (counting backwards from today) to be included in the chart.

d. 'Cumulative Totals?' — choose either:
   - 'Yes' to progressively add data to the preceding column; or
   - 'No' to show just a single value in each column.

e. 'Display the Trend of Unresolved?' — choose either:
   - 'Yes' to display an additional line graph showing the number of unresolved issues over time; or
   - 'No' to show just the difference chart of issues created vs issues resolved.

f. 'Display Versions?' — choose either:
   - 'All versions' to show version release dates on the chart, for all released versions; or
   - 'Only major versions' to show version release dates on the chart, for released versions that are named 'x.x' only; or
   - 'None' to not show version release dates on the chart.

g. 'Refresh Interval' — select how often you want the gadget to update the chart (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:
3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

Adding the Crucible Charts Gadget

The **Crucible Charts** gadget displays various charts showing statistical summaries of your code reviews.

What does it look like?

The **Crucible Charts** gadget should appear as follows on the dashboard:
Adding the 'Crucible Charts' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Crucible Charts' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The 'Crucible Charts' gadget will appear on your dashboard as follows, ready for you to configure.
a. **Crucible URL** — type the URL of your Crucible server.
b. **Crucible Project Key** — type the project key of the Crucible project in which you are interested.
c. **Chart Type** — select from the following:
   - **Open Review Age** — the age of open reviews, broken down by status.
   - **Defect Classification** — the number of defects raised, broken down by classification.
   - **Open Review Volume** — the volume of open reviews over the specified time period.
   - **Comment Volume** — the volume of comments authored over the specified time period.
   - **Defect Rank** — the number of defects raised, broken down by rank.
d. **Number of Days** — type the number of days' worth of data (backwards from today) that you want the gadget to display.
e. **Refresh Interval** — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Favorite Filters Gadget**

The **Favorite Filters** gadget displays a list of all the issue filters that have currently been added by you as a 'favorite' filter.

*Read more about adding an issue filter as a favorite filter in the issue filters documentation.*
What does it look like?

The Favorite Filters gadget should appear as follows on the dashboard:

<table>
<thead>
<tr>
<th>Favorite Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Project Epics for ADG</td>
</tr>
<tr>
<td>Ignite docs</td>
</tr>
<tr>
<td>Kickass docs</td>
</tr>
<tr>
<td>PDL Needs Docs</td>
</tr>
<tr>
<td>PDL-Page</td>
</tr>
<tr>
<td>Red Nerd</td>
</tr>
<tr>
<td>The Red Nerd needs modifications</td>
</tr>
</tbody>
</table>

| Create Filter | Manage Filters |

Adding the 'Favorite Filters' gadget to your Dashboard

1. Go to your JIRA dashboard and click ‘Add Gadget’.
2. The 'Gadget Directory' will appear. Locate the 'Favorite Filters' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Favorite Filters gadget will appear on your dashboard as follows, ready for you to configure:

   a. 'Show issue counts' — select whether, for each of your favorite filters, you wish to display the number of issues that match the filter. Note that choosing 'Yes' may impact your dashboard's performance.
   b. 'Refresh Interval' — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).
4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

The Favorite Filters gadget is added by default to the 'System Default' dashboard.

The 'Favorite Filters' gadget has replaced the 'List All Filters' portlet.

Adding the Filter Results Gadget

The Filter Results gadget displays the results of a specified issue filter on the dashboard. It can be configured to display a maximum number of issues from the collection returned from the specified filter.

What does it look like?

The 'Filter Results' gadget should appear as follows on the dashboard:
Adding the 'Filter Results' Gadget to your Dashboard

1. Go to your JIRA dashboard and click Add Gadget.
2. The Gadget Directory will appear. Locate the Filter Results gadget and click the Add it Now button. Then click the Finished button at the bottom of the Gadget Directory.
3. The Filter Results gadget will appear on your dashboard as follows:
a. **Saved Filter** — start typing the name of the filter, or click the **Advanced Search** link to search for a filter/select one of your favorite filters/select a filter that you have created.

b. **Number of Results** — type the maximum number of issues that you want the gadget to display per page.

c. **Fields to display** — select the issue fields to display as columns. Drag and drop to re-order.

d. **Refresh Interval** — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the **Save** button.
To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the FishEye Charts Gadget**

The FishEye Charts gadget displays two charts showing statistics about your sourcecode repository:

- Lines of code
- Commit activity

What does it look like?

The FishEye Charts gadget should appear as follows on the dashboard:

![FishEye Charts gadget](image)

Your JIRA administrator must have configured the FishEye plugin on your JIRA server (Not applicable to JIRA Cloud), if you want to add the FishEye Charts gadget to your dashboard.

**Adding the 'FishEye Charts' gadget to your Dashboard**

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'FishEye Charts' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The 'FishEye Charts' gadget will appear on your dashboard as follows, ready for you to configure:
a. 'FishEye URL' — type the URL of your FishEye server.
b. 'Repository' — type the name of your FishEye repository.
c. 'Path' — optionally type the path within your repository that contains the directory in which you are interested. Leave blank to include all directories in your repository.
d. 'Chart Type' — select from the following: 'Area', 'Change', 'Line' or 'Pie'.
e. ‘Stack Type’ — allows you to break the chart down by Subdirectory, File Extension and Author. For example, in a pie chart with an author stacktype, each slice would represent the LOC (lines of code) of a different author.

f. ‘Author(s)’ — optionally type the repository login name of the author(s) in whose code you are interested. Leave blank to include all authors.

g. ‘File Extension(s)’ — optionally type the file extensions(s) in which you are interested. Leave blank to include all file types.

h. ‘Refresh Interval’ — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the ‘Save’ button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the FishEye Recent Changesets Gadget

The FishEye Recent Changesets gadget displays a number of recent changesets from a FishEye repository.

What does it look like?

The FishEye Recent Changesets gadget should appear as follows on the dashboard:

Adding the ‘FishEye Recent Changesets’ gadget to your Dashboard

1. Go to your JIRA dashboard and click ‘Add Gadget’.
2. The ‘Gadget Directory’ will appear. Locate the ‘FishEye Recent Changesets’ gadget and click the ‘Add it Now’ button. Then click the ‘Finished’ button at the bottom of the Gadget Directory.
3. The ‘FishEye Recent Changesets’ gadget will appear on your dashboard as follows, ready for you to configure:

Your JIRA administrator must have configured the FishEye plugin on your JIRA server (Not applicable to JIRA Cloud), if you want to add the FishEye Recent Changesets gadget to your dashboard.
a. 'FishEye URL' – type the URL of your FishEye server.
b. 'Repository' – type the name of your FishEye repository.
c. 'Path' – optionally type the path within your repository that contains the directory in which you are interested. Leave blank to include all directories in your repository.
d. 'Number of Results' – type the number of commits that you want the gadget to display.
e. 'Refresh Interval' – select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the In Progress Gadget

The Issues in Progress gadget displays all issues that are currently in progress and assigned to you.

What does it look like?

The Issues in Progress gadget should appear as follows on the dashboard:
Adding the 'Issues in Progress' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Issues in Progress' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Issues in Progress gadget will appear on your dashboard as follows, ready for you to configure:

   a. 'Number of Results' — type the maximum number of issues that you want the gadget to display per page.
   b. 'Fields to display' — select the fields that you want the gadget to display.
c. **Refresh Interval** — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Introduction Gadget**

The **Introduction** gadget displays a configurable introduction message on the dashboard.

What does it look like?

The **Introduction** gadget should appear as follows on the dashboard when logged into JIRA:

```
Introduction
Welcome to JDOG - JIRA Team Dogfood
Not sure where to start? Check out the JIRA 101 guide and Atlassian training course.
You can customize this text in the Administration section.
```

**Adding the Introduction gadget to your Dashboard**

1. Go to your JIRA dashboard and click **Add Gadget**.
2. The 'Gadget Directory' will appear. Locate the **Introduction** gadget and click the **Add it Now** button. Then click the **Finished** button at the bottom of the Gadget Directory.
3. The Introduction gadget will appear on your dashboard.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Configuring the Introduction gadget**

The text/html displayed in the **Introduction** gadget is configured by your JIRA administration, through the JIRA configuration page. You may also click on the link in the displayed text box (shown above) to display this page:

```
Settings
Application Title: JDOG - JIRA Team Dogfood
The application title will be used to name this installation.
Mode: 
JIRA can operate in two modes:
1. Public: Anyone can sign up and post issues.
2. Private: Only administrators can create new users.
Maximum Authentication Attempts Allowed: 3
The maximum authentication attempts that are allowed before CAPTCHA is shown to a user. If you leave it blank then CAPTCHA will never be shown and users will have unlimited authentication attempts.
CAPTCHA on signup: On / Off
Share a CAPTCHA image or sign up to help prevent spam/bots signing up (only valid if mode is Public).
Base URL: https://jobg.atlassian.net
This is the base URL of this installation of JIRA. All links created (by emails etc) will be prefixed by the URL.
Email from: [Value]
Specifies the From header format in notification emails. Available values are [Username], [Spinnaker] and [Spinnaker hostname].
Default value is [JIRA] ([value]), evaluating to e.g. "John Doe (JIRA) <john@example.com>". The actual address ([email],[email]) cannot be specified here - it is determined by the mail server or handled.
Introduction:
A short introduction message displayed on the dashboard. You can include HTML markup.
```

**Adding the Issue Statistics Gadget**

The **Issue Statistics** gadget displays the collection of issues returned from a specified project or saved filter, grouped by a specified field.
For instance, a filter can be created to return all open issues from all projects. The gadget can then be configured to display these issues broken down by a field (e.g. Assignee).

What does it look like?

The Issue Statistics gadget should appear as follows on the dashboard:

![Issue Statistics gadget](image)

Adding the 'Issue Statistics' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Issue Statistics' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Issue Statistics gadget will appear on your dashboard as follows, ready for you to configure:
a. ‘Project or Saved Filter’ — start typing the name of the project or filter, or click the ‘Advanced Search’ link to search for a project or filter.
b. ‘Statistic Type’ — select the field (e.g. Assignee; Component; Priority; Resolution; etc) on which
the issues will be grouped.
c. 'Sort By' — select how to sort the values of your selected field:
   • 'Natural' — this will use the field's native sorting order, e.g. for the "Assignee" field, the
     assignee names would be sorted alphabetically.
   • 'Total' — this will sort by the number of issues that match each value, e.g. for the "Assignee" field, the assignee names would be sorted by the number of issues assigned to each person.
d. 'Sort Direction' — select whether the field values should be sorted in Ascending or Descending
   order.
e. 'Show Resolved Issue Statistics' — select whether the graph will include resolved issues (i.e. issues that have a Resolution).
f. 'Refresh Interval' — select how often you want the gadget to update (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

The "Issue Statistics" gadget has replaced the "Filter Statistics" portlet.

Adding the Pie Chart Gadget

The 'Pie Chart' gadget displays issues returned from a specified project or issue filter, grouped by a specified field. For example, an issue filter can be created to retrieve all open issues for a particular version of a particular project. The 'Pie Chart' gadget can then be used to display these issues grouped by a specified field (e.g. Assignee).

What does it look like?

The 'Pie Chart' gadget will appear as follows on the dashboard:
Adding the 'Pie Chart' Gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Pie Chart' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Pie Chart gadget will appear on your dashboard as follows, ready for you to configure:

   ![Pie Chart Gadget]

   a. 'Project or Saved Filter' — start typing the name of the project or filter, or click the 'Advanced Search' link to search for a project or filter.
   b. 'Statistic Type' — select the field on which the pie chart will be based.
   c. 'Refresh Interval' — select how often you want the gadget to update the chart (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:

   ![Internet Options]

   2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:
3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

Adding the Projects Gadget

The Projects gadget provides information and various filters related to specified project(s) within JIRA.

What does it look like?

The Projects gadget should appear as follows on the dashboard:

The ‘menu’ icon provides links to the following, for each project:
• **Summary** — Shows recent activity in the project, plus a list of issues that are due soon.
• **Issues** — Shows summaries of: all issues in a project, grouped by Status; and unresolved issues, grouped by Assignee, Priority, Version and Component.
• **Versions** — Shows recent versions for a given project.
• **Components** — Shows all components in a given project.
• **Builds** — Shows recent Bamboo builds for a given project.
• **Source** — Shows recent FishEye changesets for a given project.
• **Reviews** — Shows recent Crucible code for a given project.

The ‘filter’ icon 📦 provides links to the following issue filters in the Issue Navigator, for each project:

- All
- Resolved recently
- Outstanding
- Added recently
- Unscheduled
- Updated recently
- Assigned to me
- Most important
- Reported by me

Adding the ‘Projects’ gadget to your Dashboard

1. Go to your JIRA dashboard and click ‘Add Gadget’.
2. The ‘Gadget Directory’ will appear. Locate the ‘Projects’ gadget and click the ‘Add it Now’ button. Then click the ‘Finished’ button at the bottom of the Gadget Directory.
3. The Projects gadget will appear on your dashboard as follows, ready for you to configure:

- **Projects** and **Categories** — select one or more projects (or ‘All Projects’) to display in the gadget. (Note: ‘Categories’ will only be shown if some have been defined in your JIRA system.)
- **View** — select either ‘Collapsed’, ‘Brief’ or ‘Detailed’ to specify how much information to display per project.
- **Number of Columns** — select how the gadget will be formatted (1 column, 2 columns or 3 columns).
- **Refresh Interval** — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).
4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the Quick Links Gadget

The Quick Links gadget displays a number of useful links to frequently-used searches and operations.

What does it look like?

The Quick Links gadget should appear as follows on the dashboard:

```
Quick Links

My Unresolved Reported Issues | Votes | Watches
Browse Projects | Search for Issues | Create Issue | Administration
```

Adding the Quick Links gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Quick Links' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the Recently Created Chart Gadget

The 'Recently Created Chart' gadget displays a bar chart showing the rate at which issues are being created, as well as how many of those created issues are resolved. The report is based on your choice of project or issue filter, and your chosen units of time (ie. hours, days, weeks, months, quarters or years).

What does it look like?

The 'Recently Created Chart' gadget will appear as follows on the dashboard:
1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Recently Created Chart' gadget and click the 'Add it'

Click the 'more detail' link to go to the full-size report and data table.
Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.

3. The Recently Created Chart gadget will appear on your dashboard as follows, ready for you to configure:

![Recently Created Chart gadget](image)

- 'Project or Saved Filter' — start typing the name of the project or filter, or click the 'Advanced Search' link to search for a project or filter.
- 'Period' — select the timeframe on which the chart will be based: 'Hourly' / 'Daily' / 'Weekly' / 'Quarterly' / 'Yearly'
- 'Days Previously' — type the number of days’ worth of data (counting backwards from today) to be included in the chart.
- 'Refresh Interval' — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

### Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:

![Internet Options](image)

2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:
3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.

Adding the Resolution Time Gadget

The 'Resolution Time' gadget displays a bar chart showing the average time taken to resolve issues. This is useful to show you the trends in resolution time. The report is based on your choice of project or issue filter, and your chosen units of time (i.e. hours, days, weeks, months, quarters or years). The 'Resolution Time' is the difference between an issue's Resolution Date and Created date. If a Resolution Date is not set, the issue won't be counted in this gadget. The Resolution Date is the last date that the system Resolution field was set to any non-empty value.

What does it look like?

The 'Resolution Time' gadget will appear as follows on the dashboard:
Adding the 'Resolution Time' Gadget to your Dashboard

To add the 'Resolution Time' gadget to your dashboard:

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Resolution Time' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Resolution Time gadget will appear on your dashboard as follows, ready for you to configure:
a. 'Project or Saved Filter' — start typing the name of the project or filter, or click the 'Advanced Search' link to search for a project or filter.
b. 'Period' — select the timeframe on which the chart will be based: 'Hourly' / 'Daily' / 'Weekly' / 'Quarterly' / 'Yearly'
c. 'Days Previously' — enter the number of days' worth of data (counting backwards from today) to be included in the chart.
d. 'Refresh Interval' — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:
2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:

3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.
Adding the Road Map Gadget

The **Road Map** gadget shows **versions** which are due for release within a specified period of time, and a summary of progress made towards completing the issues in those versions.

What does it look like?

The **Road Map** gadget should appear as follows on the dashboard:

![Road Map gadget example]

You can:

- Click the name of a project to browse the project.
- Click the name of a version to browse the version.
- Click the progress bar (shown in red and/or green) to view the version's issues in the **Issue Navigator**.

Adding the 'Road Map' Gadget to your Dashboard

1. Go to your JIRA dashboard and click ‘Add Gadget’.
2. The ‘Gadget Directory’ will appear. Locate the ‘Road Map’ gadget and click the ‘Add it Now’ button. Then click the ‘Finished’ button at the bottom of the Gadget Directory.
3. The Road Map gadget will appear on your dashboard as follows, ready for you to configure:
a. ‘Projects’ — select one or more projects (or 'All Projects') whose versions you wish to display in the gadget.
b. ‘Days’ — specify the period of time (in days) for which you wish to view versions due for release.
c. ‘Number of Results’ — type the maximum number of versions you wish the gadget to display per page.
d. ‘Refresh Interval’ — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Text Gadget**

The Text gadget displays your specified HTML text on the dashboard.

This gadget is only available if your JIRA administrator has enabled it. It is disabled by default because it is a potential security risk, as it can contain arbitrary HTML which could potentially make your JIRA system vulnerable to XSS attacks.

To enable the text gadget: Choose ![Add-ons](https://jira.atlassian.com/plugins/browse/AJIRA-GADGETS) > Add-ons. The ‘Find add-ons’ screen shows add-ons available via the Atlassian Marketplace. Choose Manage Add-ons to view the plugins currently installed on your JIRA site. Enable the Text module in the Atlassian JIRA - Plugins - Gadgets Plugin (You need to select the System add-ons from the drop-down).
If you cannot enable the text gadget, please contact Atlassian Support for assistance.

What does it look like?

The Text gadget should appear as follows on the dashboard:
Adding the 'Text' Gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Text' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Text gadget will appear on your dashboard as follows, ready for you to configure:

   - **Title** — type a heading for this gadget.
   - **Body** — type the body text; this may include HTML.
4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the Time Since Issues Gadget

The 'Time Since' gadget displays a bar chart showing the number of issues for which your chosen date field (e.g. 'Created', 'Updated', 'Due', 'Resolved', or a custom field) was set on a given date. 'Resolved' here is the system Resolution Date field, which is the last date that the system Resolution field was set to any non-empty value. The report is based on your choice of project or issue filter, and your chosen units of time (ie. hours, days, weeks, months, quarters or years).

What does it look like?

The 'Time Since' gadget will appear as follows on the dashboard:
Adding the ‘Time Since’ Gadget to your Dashboard

1. Go to your JIRA dashboard and click ‘Add Gadget’.
3. The Time Since gadget will appear on your dashboard as follows, ready for you to configure:

Click the 'more detail' link to go to the full-size report and data table.
a. 'Project or Saved Filter' — start typing the name of the project or filter, or click the 'Advanced Search' link to search for a project or filter.

b. 'Date Field' — select the date in which you are interested (e.g. 'Created', 'Updated', 'Due', 'Resolved', or a custom field of type 'Date').

*Note: only available if time tracking has been enabled by your JIRA administrator.

c. 'Period' — select the timeframe on which the report will be based: 'Hourly' / 'Daily' / 'Weekly' / 'Quarterly' / 'Yearly'

d. 'Days Previously' — enter the number of days' worth of data (counting backwards from today) to be included in the report.

e. 'Cumulative Totals?' — choose either:
   • 'Yes' to progressively add data to the preceding column; or
   • 'No' to show just a single value in each column.

f. 'Refresh Interval' — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Configuring your Internet Explorer cache settings

If you use Internet Explorer, you will need to configure your browser to be able to print pages with charts correctly:

1. Select 'Internet Options' from the 'Tools' menu:
2. The 'Internet Options' window will display. Click the 'Settings' button in the 'Temporary Internet files' (i.e. cache) section:

3. The 'Settings' window will display. Ensure that you have do not have the 'Every visit to the page' (i.e. no caching) option selected. If so, select the 'Automatically' option instead.
Adding the Two-Dimensional Filter Statistics Gadget

The **Two Dimensional Filter Statistics** gadget displays statistical data based on a specified issue filter, in a configurable table format.

For example, you could create a filter to retrieve all open issues in a particular project. You can then configure the gadget to display the statistical data on this collection of issues, in a table with configurable axes — e.g. Assignee versus Issue Type.

What does it look like?

The **Two Dimensional Filter Statistics** gadget should appear as follows on the dashboard:

![Two Dimensional Filter Statistics gadget](image)

Adding the Two Dimensional Filter Statistics gadget to your Dashboard

1. Go to your JIRA dashboard and click ‘Add Gadget’.
3. The Two Dimensional Filter Statistics gadget will appear on your dashboard as follows, ready for you to configure:
a. ‘Saved Filter’ — start typing the name of the filter, or click the ‘Advanced Search’ link to search for a filter/select one of your favourite filters/select a filter that you have created.

b. ‘X Axis’ — select an issue field¹ on which the X-axis will be based.

c. ‘Y Axis’ — select an issue field¹ on which the Y-axis will be based.

d. ‘Sort By’ — select how to sort the values of your selected field:
   - ‘Natural’ — this will use the field's native sorting order, e.g. for the "Assignee" field, the assignee names would be sorted alphabetically.
   - ‘Total’ — this will sort by the number of issues that match each value, e.g. for the "Assignee" field, the assignee names would be sorted by the number of issues assigned to each person.

e. ‘Sort Direction’ — select whether the field values should be sorted in Ascending or Descending order.

f. ‘Number of Results’ — type the maximum number of rows that you want the gadget to display per page

g. ‘Refresh Interval’ — select if you want the gadget to update automatically.

4. Click the ‘Save’ button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

¹ If choosing a custom field, please note that the following types of custom fields are supported by this gadget out-of-the-box: 'Group picker', 'Multi select', 'User picker', 'Select list' and 'Version picker'.

Adding the Voted Issues Gadget

The Voted Issues gadget shows issues for which you have voted.

What does it look like?
The **Voted Issues** gadget should appear as follows on the dashboard:

![Voted Issues Gadget](image)

Adding the 'Voted Issues' gadget to your Dashboard

1. Go to your JIRA dashboard and click **Add Gadget**.
2. The **Gadget Directory** will appear. Locate the **Watched Issues** gadget and click the **Add it Now** button. Then click the **Finished** button at the bottom of the Gadget Directory.
3. The Voted Issues gadget will appear on your dashboard as follows, ready for you to configure:

![Voted Issues Configuration](image)

   a. **Number of results** — specify the maximum number of issues you wish the gadget to display per page.
   b. **Fields to display** — select the issue fields to display as columns. Drag and drop to re-order.
   c. **Show total votes** — select this if you wish the gadget to display the number of people who have voted for each issue.
   d. **Show resolved issues** — select this if you wish the gadget to display all issues on which you have ever voted. Leave it unselected if you wish the gadget to only display unresolved issues.
   e. **Refresh Interval** — select how often you want the gadget to update the displayed activity (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the **Save** button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

**Adding the Watched Issues Gadget**

The **Watched Issues** gadget shows issues which you are **watching**.

What does it look like?
The **Watched Issues** gadget should appear as follows on the dashboard:

<table>
<thead>
<tr>
<th>Number</th>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRADEV-21102</td>
<td>JRADEV-21056</td>
<td>Need to run the Clirr report for JIRA 6.0 FINAL</td>
</tr>
<tr>
<td>JRADEV-21085</td>
<td>JRADEV-21056</td>
<td>Docs: Unhide Release Notes</td>
</tr>
<tr>
<td>JRADEV-20173</td>
<td>JRADEV-7360</td>
<td>Need to run the Clirr report for JIRA 6.0</td>
</tr>
<tr>
<td>JRADEV-20138</td>
<td>JRADEV-19841</td>
<td>ADG docs - User Guide Updates</td>
</tr>
<tr>
<td>JRADEV-18680</td>
<td>21 Feb</td>
<td>Master documentation issue for JIRA 5.2.7</td>
</tr>
<tr>
<td>JRADEV-18214</td>
<td>Warranty</td>
<td>&quot;Auto-update search results&quot; description in General Configuration is unhelpful</td>
</tr>
<tr>
<td>JRADEV-18121</td>
<td>Add section about web-resource loading in issue-nav and view-issue pages</td>
<td></td>
</tr>
<tr>
<td>JRADEV-7961</td>
<td>Please provide an index page for Clirr reports</td>
<td></td>
</tr>
<tr>
<td>JGTM-317</td>
<td>JIRA 6 - What's New Video final</td>
<td></td>
</tr>
<tr>
<td>ANGRY-300</td>
<td>ANGRY-120</td>
<td>The red bird needs some minor edits</td>
</tr>
</tbody>
</table>

Adding the 'Watched Issues' Gadget to your Dashboard

1. Go to your JIRA dashboard and click **Add Gadget**.
2. The **Gadget Directory** will appear. Locate the **Watched Issues** gadget and click the **Add it Now** button. Then click the **Finished** button at the bottom of the Gadget Directory.
3. The Watched Issues gadget will appear on your dashboard as follows, ready for you to configure:

   a. **Number of results** — type the maximum number of issues that you want the gadget to display per page.
   b. **Fields to display** — select the issue fields to display as columns. Drag and drop to re-order.
   c. **Refresh Interval** — select how often you want the gadget to update the displayed activity (never /
every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the Save button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the Heat Map Gadget

The Heat Map gadget displays the relative weighting of values of a specified field in issues returned from a specified project or saved filter.

For instance, the gadget can be configured to display a heatmap of the popularity of the different priorities of issues in a particular project.

What does it look like?

The Heat Map gadget should appear as follows on the dashboard:

```
<table>
<thead>
<tr>
<th>Heat Map: Angry Nerds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bug  Epic  Exception  Improvement New Feature Story Story Task  Technical task</td>
</tr>
<tr>
<td>There are 8 distinct 'issue Type' values in 261 issues</td>
</tr>
</tbody>
</table>
```

Adding the 'Heat Map' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Heat Map' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Heat Map gadget will appear on your dashboard.
   a. 'Project or Saved Filter' — start typing the name of the project or filter, or click the 'Advanced Search' link to search for a project or filter.
   b. 'Statistic Type' — select the field (e.g. Assignee; Priority; etc) on which the issues will be grouped.
   c. 'Refresh Interval' — select how often you want the gadget to update (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.

To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Adding the Labels Gadget

The Labels gadget displays a list of all the labels in a specified project.

What does it look like?

The Labels gadget should appear as follows on the dashboard:
Adding the 'Labels' gadget to your Dashboard

1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' will appear. Locate the 'Labels' gadget and click the 'Add it Now' button. Then click the 'Finished' button at the bottom of the Gadget Directory.
3. The Labels gadget will appear on your dashboard, ready for you to configure:

   a. 'Project' — select the name of the project in which you are interested.
   b. 'Labels' — select the field in which you are interested. The list will include the field 'Labels', plus any other custom fields of type 'Label' that have been defined by your JIRA administrator.
   c. 'Refresh Interval' — select how often you want the gadget to update (never / every 15 minutes / every 30 minutes / every hour / every two hours).

4. Click the 'Save' button.
To move the gadget to a different position on the dashboard, simply drag-and-drop. You can also change the look and behavior of the gadget.

Managing your User Profile

Your JIRA user profile is where you specify your JIRA settings (e.g. your email address, and the format in which you would like to receive email notifications). It also contains useful links to a number of personalised reports.

To view your JIRA user profile:

- Choose your user name at top right of the screen, then choose Profile.

Using the Summary link

The Summary page shows your personal details registered in JIRA, your personal JIRA preferences, the number of open issues assigned to you by project and a list of your recent activity.

Details

In the Details section on the Summary page, you can do the following:

- Click the edit icon at the top-right of the section to open the Edit Profile dialog box. From here, you can edit the following details:
  - Full Name – your display-name – that is, the name by which you are known in JIRA.
  - Email – the email address to which your JIRA notifications will be sent.
  - Password – you are required to enter your password to save changes to your Full Name and Email address.
  - Click the Update button to save your changes.

- Click the Avatar icon to add an avatar to your user profile.
If you have already added a user avatar to your JIRA profile, that (current) avatar will appear instead of icon above. Clicking your current avatar allows you to change it.

- Click the **Administer User** link to view or edit your **user details** in JIRA's administration area.
- This option is only available to if you are a **JIRA Administrator**.
- Click the **email address** to send an email to that address via your registered email client application.
- Click the **Change Password** link to **change your JIRA password**.
- Click the **Clear All Tokens** link to clear your 'Remember my login' tokens. This feature is useful if you have accessed JIRA in a public environment, selected the **Remember by login...** check box before logging in, but you may have forgotten to log out and do not wish others to access JIRA through your account. See **Clearing 'Remember my login' Tokens** for more information.
- Click the **View Project Roles** link to view or edit that user's **project roles** in JIRA's administration area.
- This option is only available to users who are **JIRA Administrators**.

**Note**
If your JIRA administrator has configured the user directory containing your account with external password management, the **Edit Profile** and **Change Password** links may not be available.

**Preferences**

In the **Preferences** section on the **Summary** page, you can do the following:

- Click the **edit** icon at the top-right of the section to open the **Updated User Preferences** dialog box:
Update User Preferences

- **Page Size**: 50
  Number of issues displayed per issue Navigator page

- **Email Type**: HTML
  Outgoing email format

- **Language**: English (United States) [Default]

- **Time Zone**: Australia
  (GMT+10:00) Sydney
  The time zone used when showing date time information.

- **My Changes**: Do not notify me
• From here, you can edit the following details:
  • **Page Size** – The number of issues displayed on each Issue Navigator page. This field is mandatory and the default value is 50.
  • **Email Type** – The format (text or HTML) in which JIRA sends its outgoing email notifications.
  • **Language** – Your preferred language.
  • **Time Zone** – Your preferred time zone.
  • **My Changes** – Choose between making JIRA send you email notifications about issue updates made by either both you and other people (Notify me) or other people only (i.e. Do not notify me).
  • **Filter & Dashboard Sharing / Sharing (in dialog box)** – Choose the default 'sharing' setting for when you create new filters and dashboards, which can be either shared with all other users (Public) or restricted to your viewing only (Private).
  • **Keyboard Shortcuts** – Choose between making JIRA’s Keyboard Shortcuts feature either Enabled or Disabled.
  • **Autowatch** – Choose between allowing JIRA to automatically make you a watcher of any issues that you create or comment on.

• Click **View Navigator Columns** to choose which fields appear in your Issue Navigator.

**Tip:** The global defaults for most of the user preferences above can be set by your JIRA administrator (Administration > User Preferences). Your preferences will override the global preferences, but if you haven’t explicitly changed any settings they will be inherited from the global settings.

### Assigned Open Issues per Project

In the **Assigned Open Issues per project** section on the **Summary** page, you can do the following:

- Click the name of the project (on the left) to display issues.
- Click the number of open issues (on the right) to display the Issue Navigator, which shows your list of open issues associated with the project on the left.

### Activity Stream

In the **Activity Stream** on the right of the **Summary** page, you can:

- Click any item to jump to an issue or other activity in which you have recently participated. Your Activity Stream can include:
  - Issues in your local JIRA Server system.
  - Issues in another JIRA Server system, provided your administrator has configured a **two-way Application Link**.
  - Activity from another Atlassian application, such as:
    - document updates (from Confluence)
    - code commits (from FishEye)
• code reviews (from Crucible)
• builds (from Bamboo)

Note that this requires your administrator to configure a two-way Application Link, unless you are using Atlassian OnDemand.
• Activity from remote applications. Your administrator will need to set this up via the REST API or the provider plugin API, or locally via Java().

• Click the RSS icon 📰 to generate an RSS feed of information that is relevant to you.
• Click the cog drop-down to refresh the displayed Activity Stream.

✅ The Activity Stream is also available as a gadget.

Filters

Click the Filters menu at the top of the Summary page. From this menu you can:

• Click Assigned to list all issues that are assigned to you, irrespective of their current status.
• Click Assigned & Open to list the issues that are assigned to you and are unresolved.
• Click Assigned & In Progress to list the issues that are assigned to you and whose current status is In Progress.
• Click Reported to list the issues that were created by you, irrespective of their current status.
• Click Reported & Open to list the issues that were created by you and are unresolved.
• Click Voted to view the list of issues for which you have voted, irrespective of their current status.
• Click Voted & Open to view the list of issues for which you have voted and are unresolved.
• Click Watched to view the list of issues that you are watching, irrespective of their current status.
• Click Watched & Open to view the list of issues that you are watching and are unresolved.

Using the Tools menu

Click the 'Tools' menu in the top right to open it. From this menu you can click View OAuth Access Tokens to view and edit your OAuth Tokens.

Adding a User Avatar

A user avatar is used as the icon for your profile to illustrate your comments on an issue and your Hover Profile.

Choosing a User Avatar

You can choose your user avatar from the ones pre-packaged with JIRA or upload your own. If the JIRA instance is configured to allow Gravatars then you will also be able to choose your Gravatar from the list of available avatars.

To choose your user avatar:

1. Choose your user name at top right of the screen, then choose Profile.

2. In the Details section, click the Avatar icon 🧑‍💻 to open the Select a User Avatar dialog box.

If you have already added a user avatar to your JIRA profile, that (current) avatar will appear instead of the icon above. Clicking your current avatar allows you to change it.
JIRA comes pre-packaged with its own set of user avatars, which appear in the first few rows of this dialog box.

3. From this point, you can choose one of JIRA’s pre-packaged user avatars, upload your own custom avatar or choose a user avatar which you have previously uploaded:
   - **To choose one of JIRA’s pre-packaged user avatars or one which you have previously uploaded:**
     - Click the user avatar on this dialog box. Your JIRA user account will use this avatar immediately.
     - User avatars which you have previously uploaded to JIRA will appear after JIRA’s pre-packaged user avatars on this dialog box.
   - **To upload a new or custom user avatar:**
     - a. Click the **Browse** button and in the resulting dialog box, browse for and choose an image
file.

b. Click and drag the centre of the superimposed square, whose content will eventually be cropped to become your new user avatar.

If desired, drag the corners of the square to re-size the area of the superimposed square. (You may need to re-centre the square again.)

c. Click the **Confirm** button to create your new custom user avatar. Your JIRA user account will use this avatar immediately.

**Please Note:**
- Your cropped image is re-sized to 48x48 pixels before it is saved in JIRA as your new custom user avatar.
- A separate 16x16 pixel version of your custom user avatar will be generated for use in comments.
- Custom user avatars can only be selected by the user who uploaded them.

To use a Gravatar:

If Gravatar has been enabled, your Gravatar (i.e. the Gravatar associated with the email address in your user profile) will be shown along with the JIRA built-in avatars and any avatars that you have previously uploaded. To change your Gravatar, log in to [Gravatar.com](http://Gravatar.com) and follow the instructions on that site.

### Allowing OAuth Access

**On this page:**

- About OAuth Access Tokens
- Issuing OAuth Access Tokens
- Revoking OAuth Access Tokens
  - OAuth Access Token Table Details

#### About OAuth Access Tokens

OAuth access tokens allow you to:

- Use a JIRA gadget on an external, OAuth-compliant web application or website (also known as a 'consumer')
- Grant this gadget access to JIRA data which is restricted or privy to your JIRA user account.

Before this can happen, your JIRA administrator must establish an OAuth relationship with this external web application or site by approving it as an OAuth consumer. For example, if you want to add a JIRA gadget to your Bamboo homepage and allow this gadget to access your restricted JIRA data, then your JIRA administrator must first approve Bamboo as an OAuth consumer.

Next, the JIRA gadget on the 'consumer' is granted access to your JIRA data via an 'OAuth access token', which acts as a type of 'key'. As long as the consumer is in possession of this access token, the JIRA gadget will be able to access JIRA data that is both publicly available and privy to your JIRA user account. You can revoke this access token at any time from your JIRA user account, otherwise, all access tokens expire after seven days. Once the access token is revoked or has expired, the JIRA gadget will only have access to publicly available data on your JIRA site.

An **OAuth access token will only appear in your user profile if the following conditions have been met:**

1. Your JIRA Administrator has established an application link using OAuth between your JIRA site and the consumer. JIRA Administrators should refer to [Linking to Another Application](#).
2. You have accessed a JIRA gadget on a consumer and have allowed this gadget access to your JIRA data. See [Issuing OAuth Access Tokens](#), below for details on this process.

**Screenshot: Viewing your OAuth Access Tokens**
**OAuth Access Tokens**

You have allowed the following gadgets/applications to access JIRA data using your account:

<table>
<thead>
<tr>
<th>Consumer</th>
<th>Consumer Description</th>
<th>Issued on</th>
<th>Expires on</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created vs Resolved Chart</td>
<td>Atlassian Refimpl at <a href="http://localhost:8080/dashboards">http://localhost:8080/dashboards</a></td>
<td>02/10/2009</td>
<td>09/10/2009</td>
<td>Revoke OAuth Access Token</td>
</tr>
</tbody>
</table>

Issuing OAuth Access Tokens

An OAuth access token is issued by JIRA to provide one of its gadgets on a consumer, access to your JIRA data (that is, data which is restricted to your JIRA user account).

To allow a JIRA gadget on a consumer, access your JIRA data,

1. When you are using a JIRA gadget on a consumer (such as Bamboo) and this gadget requires access to your JIRA data, you will first be prompted to log in to JIRA (if you have not already done so).
2. Once you have logged in to JIRA, you will be prompted with a 'Request for Access' message:

   ![Screenshot: Request for Access Message](image)

   **Request for Access**

   The application Bamboo would like to access your Atlassian JIRA account on your behalf. If you trust this application and would like to allow it access, click the 'Approve Access' button. An example of such access is a gadget running on another server.

   By approving this request for access, you are allowing the application to read and update data using your username. The application will not have access to your password.

   You can revoke this access at any time by going to the OAuth Access Tokens section of your user profile. [Learn more](#)

   ![Approve Access Deny Access](image)

   At this point, JIRA is preparing to issue the JIRA gadget (on the consumer) with an OAuth access token.

3. To grant the gadget access to your JIRA data, click the 'Approve Access' button. The consumer application will receive the OAuth access token from your JIRA site. This access token is specific to this gadget and as long as the token resides with the gadget, your gadget will have access to your JIRA data.
Revoking OAuth Access Tokens

You can revoke an OAuth access token to deny a JIRA gadget on a consumer access to JIRA data which is restricted to your JIRA user account. You can only revoke OAuth access tokens that you have allowed JIRA to issue previously.

To prevent a JIRA gadget on a consumer, from accessing your JIRA data,

1. Choose your user name at top right of the screen, then choose Profile.
2. Click the 'Tools' menu and select the 'View OAuth Access Tokens' menu item.
3. The 'OAuth Access Tokens' page will be displayed.

Screenshot: Viewing your OAuth Access Tokens

<table>
<thead>
<tr>
<th>Consumer</th>
<th>Consumer Description</th>
<th>Issued on</th>
<th>Expires on</th>
<th>Actions</th>
</tr>
</thead>
</table>

Your list of OAuth access tokens is presented in a tabular format, with each access token presented in separate rows and each property of these tokens presented in a separate columns. Refer to the OAuth Access Token Table Details section below for more information about this table.

4. Locate the JIRA gadget and its associated consumer application whose OAuth access token you wish to revoke and click its 'Revoke OAuth Access Token' link in the 'Actions' column.
5. You may be prompted to confirm this action. If so, click the 'OK' button.

The page at http://localhost:8090 says:

If you revoke the access token, the application Activity Stream will no longer be able to access data using your account.

Hint: If this application accesses your data via a gadget, you can restore the permission later by clicking the lock icon on the gadget.

Click 'OK' to revoke the access token.

The gadget's access token is revoked and the JIRA gadget on the consumer will only have access to publicly available JIRA data.

OAuth Access Token Table Details

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Consumer</th>
<th>The name of the JIRA gadget that was added on the consumer.</th>
</tr>
</thead>
</table>
| Consumer Description | A description of this consumer application. This information would have been obtained from the consumer's own OAuth settings when an OAuth relationship was established between JIRA and that consumer.  
If the consumer is another Atlassian application, this information is obtained from the Consumer tab's 'Description' field of the OAuth Administration settings. The application's administrator can customize this Consumer Info detail. |
| Issued On | The date on which the OAuth access token was issued to the consumer by JIRA. This would have occurred immediately after you approved this gadget access to your JIRA data (privy to your JIRA user account). |
| Expires On | The date when the OAuth access token expires. This is seven days after the 'Issued On' date. When this date is reached, the access token will be automatically removed from this list. |
| Actions | The functionality for revoking the access token. |

### Changing your Password

To change your JIRA password:

1. Choose your user name at top right of the screen, then choose Profile.
2. In the Details section, click the 'Change Password' link. The Change Password dialog box opens.
3. Type your old password into the Current Password field, and type your new password into the New Password and Confirm Password fields.
4. Click the 'Update' button.

If your JIRA administrator has configured the user directory containing your account with external password management, the 'Change Password' link will not be available.

### Choosing a Language

The default language is set by your JIRA administrator (see Configuring JIRA Options), but you can personalise your JIRA account to use a language of your choice.

#### To choose a language:

1. Choose your user name at top right of the screen, then choose Profile.
2. In the 'Preferences' section, click the edit icon at the top-right to open the Updated User Preferences dialog box.
3. Select your language from the Language drop-down list.
4. Click the Update button.

### Using Hover Profile

**Hover Profile** is a convenient popup balloon that provides quick access to key information about other JIRA users throughout the JIRA interface and issues they have been working on.

#### On this page:

- Accessing Hover Profile
- Using the Hover Profile Popup Balloon

### Accessing Hover Profile

When you move or hover your mouse over a user's username or full name on:

- an issue view,
- any issue listed in the Issue Navigator, or
- any of the project browser screens,
an interactive popup balloon appears.

**Screenshot: The Hover Profile popup balloon**

![](image)

**Please Note:** The Hover Profile popup balloon is not available on user names which appear on activity streams and dashboard gadgets throughout the JIRA interface.

Using the Hover Profile Popup Balloon

The top part of the Hover Profile popup balloon shows the user's full name, avatar, email address and time zone, as defined in their user profile. You can email a user from their Hover Profile by clicking their email address link, which opens up a new email message in your email client with that email address in the To: field.

The lower part of the Hover Profile popup balloon also provides easy access to the following information about a user, via the following links:

- **Activity** — the user's recent activity on the JIRA site.
- **Click More**, then:
  - **Profile** — the user's user profile page.
  - **Current Issues** — the user's list of unresolved issues (via the Issue Navigator).
  - **Administer User** *(only visible to JIRA Administrators who have the JIRA Users permission)* — the user's details in JIRA's user management area of the administration console.

Choosing a Time Zone

The default time zone is set by your JIRA administrator (see Configuring JIRA Options), but you can personalise your JIRA account to use a time zone of your choice. This will affect all time-date fields throughout JIRA.

If the time zone specified in your JIRA user profile doesn't match the time zone of the computer you are working on, JIRA will prompt you to ask if you want to change the time zone setting in your JIRA user profile.

**To choose a time zone:**

1. Choose your user name at top right of the screen, then choose Profile.
2. In the 'Preferences' section, click the edit icon 🖊 at the top-right to open the Updated User Preferences dialog box.
3. Select your region (or country) and time zone from the Time Zone drop-down list.
4. Click the Update button.
5. All time fields in JIRA will now be displayed in your local time zone.

   **Date fields**, which have no time component, such as due dates, release dates (associated with versions) and custom date fields, solely record date information (and no time zone-related information) so are not affected by time zone settings.

Changing your JIRA Home Page

Your JIRA home page is the JIRA page you are presented with immediately after you log in.

You can configure the following JIRA pages as your JIRA home page:

- The Dashboard
- The Issue Navigator
- The Rapid Board *(available if you have the JIRA Agile add-on installed in JIRA)*
To configure your JIRA home page:

1. Click on your profile icon at the top right of the screen.
2. Select the appropriate home page option within the My JIRA Home section:
   - Dashboard
   - Issue Navigator
   - Agile (i.e. the JIRA Agile Rapid Board — this option is only available if you have the JIRA Agile add-on installed in JIRA)
   
   Your page will be reloaded the JIRA home page you selected.
3. (Optional) To verify that your JIRA home page has been reset, log out and log back in to JIRA again. You should be taken directly to the JIRA home page you selected in the previous step.

Requesting Add-ons

The Atlassian Marketplace website offers hundreds of add-ons that the administrator of your Atlassian application can install to enhance and extend JIRA. If the add-on request feature is enabled for your JIRA instance, you can submit requests for add-ons from the Marketplace to your JIRA administrator.

The ‘Atlassian Marketplace for JIRA’ page presents an integrated view of the Marketplace website from within the JIRA user interface. The page offers the same features as the Marketplace website, such as add-on search and category filtering, but tailors the browsing experience to JIRA.

This in-product view of the Marketplace gives day-to-day users of the Atlassian applications, not just administrators, an easy way to discover the add-ons that can help them work. When you find an add-on of interest, you can submit a request with just a few clicks.

Submitting an add-on request

To browse for add-ons in the Atlassian Marketplace, follow these steps:

1. From anywhere in the application, open your profile menu and choose Atlassian Marketplace.
2. In the Atlassian Marketplace page, use the search box to find add-ons or use the category menus to browse or filter by add-ons by type, popularity, price or other criteria. You can see what your fellow users have requested by choosing the Most Requested filter.
3. When you find an add-on that interests you, click Request to generate a request for your administrator.
4. Optionally, type a personal message to your administrators in the text box. This message is visible to administrators in the details view for the add-on.
5. When ready, click Submit Request.
6. Click Close to dismiss the 'Success!' message dialog box.

At this point, a notification appears in the interface your administrators use to administer add-ons. Also your request message will appear in the add-on details view, visible from the administrator's 'Find New Add-ons' page. From there, your administrator can purchase the add-on, try it out or dismiss requests.

Updating an add-on request

After submitting the request, you can update your message at any time. Click the Update Request button next to the listing in the ‘Atlassian Marketplace’ page to modify the message to your administrator.

The administrator is not notified of the update. However, your updated message will appear as you have modified it in the details view for the add-on immediately.

Project navigation options

JIRA 6.4 has been released with a preview of our new project navigation experience. The default setting is to allow all users to toggle between the new experience and old experience through your user profile drop-down menu. Your JIRA Administrator has the option to turn this toggle off for all users, and to select if they want the new navigation experience on or off.

To toggle between options:

1. Select your user profile icon to display the drop-down.
2. Select Disable new project navigation to turn it off.
3. Select Enable new project navigation to turn it on.
If you don't see these options, your JIRA Administrator has set your default setting already, and you won't be able to change it.

**Data collection policy**

**Why does JIRA collect usage data?**

We’re proud that JIRA is one of the most advanced and configurable issue trackers on the planet and we will continue to deliver innovative new features as quickly as we can. In order to prioritize the features we deliver, we need to understand how our customers use JIRA, what's important, what's not, and what doesn't work well. The collection of usage data allows us to measure the user experience across many thousands of users and deliver features that matter.

**What data is collected?**

The type of data we collect is covered in our Privacy Policy. Please read it, as we've tried to avoid legal jargon and make it as straightforward as possible.

To view a sample of data that might be collected from your specific installation:

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose > **System** > **Advanced** > **Analytics**.
3. Select the **Sample Data** link.

Data is always collected in JIRA Cloud.

**How is data collected from Server installations?**

Older versions of JIRA (before 6.3.3) and some Atlassian add-ons for JIRA had their own options for analytics that collected information via Google Analytics. These approaches have been deprecated and the relevant Google Analytics profiles have been deleted.

Any analytics being sent from older versions of JIRA Server or JIRA add-ons are no longer being received.

Analytics are now collected using the Atlassian Analytics add-on. The add-on collects analytics events in a log file which is located in the JIRA home directory under the analytics-logs sub directory. The logs are periodically uploaded using an encrypted session and then deleted. If the JIRA installation is unable to connect to the Internet, no logs are ever uploaded.

Enabling/disabling data collection in JIRA Server
You can switch off analytics collection at any time:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System > Advanced > Analytics.

Atlassian add-ons for JIRA that collect usage data

The following Atlassian JIRA add-ons previously had their own usage data collection settings and used Google Analytics to collect the data. These approaches have all been deprecated in favor of Atlassian Analytics. The relevant Google Analytics profiles have been deleted so any down-level versions of these plugins that still send data will not actually cause any data to be received by Atlassian.

- JIRA Agile
- JIRA Capture
- JIRA Service Desk
- JIRA Importers
- InProduct Translation

JIRA Administrator's Guide

This manual contains information on administering your JIRA system. If you are looking for specific information regarding installing or upgrading JIRA, please refer to the JIRA installation and upgrade guide.

Getting Help

Configuring the Layout and Design

- Customizing the Look and Feel
- Choosing a Default Language
  - Translating JIRA
- Configuring the Default Issue Navigator
- Configuring the Default Dashboard
  - Using Dashboard Gadgets
  - Adding a Gadget to the Directory
  - Subscribing to Another Application's Gadgets
- Configuring an Announcement Banner
- Enabling Logout Confirmation
- Creating Links in the Application Navigator
- Configuring Issue Table Columns
- Configuring Project Navigation

User and Group Management

- Managing Users
- Managing Groups
- Configuring User Directories
  - Configuring the Internal Directory
  - Connecting to an LDAP Directory
    - Configuring an SSL Connection to Active Directory
    - Reduce the number of users synchronised from LDAP to JIRA
  - Connecting to an Internal Directory with LDAP Authentication
  - Connecting to Crowd or Another JIRA Server for User Management
  - Managing Multiple Directories
Synchronising Data from External Directories
Managing Nested Groups
Diagrams of Possible Configurations for User Management
User Management Limitations and Recommendations
Allowing Other Applications to Connect to JIRA for User Management
Migrating Users between User Directories

Viewing User Sessions
User access logging
Clearing 'Remember my login' Tokens
Disabling Remember My Login on this Computer
Enabling Public Signup and CAPTCHA
Changing the User Default Settings

Project Management
Defining a Project
Editing a Project Key
Changing the Project Key Format
Simple Issue Tracking project
Software Development project
Managing Project Role Membership
Defining a Component
Managing Versions
Running a Bamboo Build when Releasing a Version
Creating Release Notes

Configuring Security
Configuring Issue-level Security
Managing Project Permissions
Managing Project Roles
Managing Global Permissions
Configuring Secure Administrator Sessions
Preventing Security Attacks
JIRA Cookies
JIRA Admin Helper
Password Policy for JIRA

Configuring Fields and Screens
Configuring Built-in Fields
Defining Issue Type Field Values
Associating Issue Types with Projects
Defining Priority Field Values
Defining Resolution Field Values
Defining Status Field Values
Translating Resolutions, Priorities, Statuses and Issue Types
Adding a Custom Field
Configuring a Custom Field
Creating Help for a Custom Field
Specifying Field Behavior
Associating Field Behavior with Issue Types
Configuring Renderers
Defining a Screen
Associating a Screen with an Issue Operation
Associating Screen and Issue Operation Mappings with an Issue Type

Configuring Workflow
Activating workflow
Configuring workflow schemes
Working in text mode
Sharing your workflow
Advanced workflow configuration
Adding a custom event
• Configuring the initial status
• Configuring JIRA with HipChat
• Using validators with custom fields
• Using XML to create a workflow
• Workflow properties
  • DRAFT_CB - Workflow properties
  • Configuring workflow triggers
• DRAFT 6.4 OD11 - Configuring Workflow

Configuring Email
• Configuring Email Notifications
  • Configuring JIRA's SMTP Mail Server to Send Notifications
  • Creating a Notification Scheme
  • Customizing Email Content
• Creating Issues and Comments from Email
  • Configuring JIRA to Receive Email from a POP or IMAP Mail Server

Migrating from Other Issue Trackers
• Importing Data from Bugzilla
• Importing Data from FogBugz for Your Server
• Importing Data from FogBugz On Demand
• Importing Data from Mantis
• Importing Data from Pivotal Tracker
• Importing Data from Trac
• Importing Data from CSV
  • Commonly Asked CSV Questions and Known Issues
    • How to Import CSV Data with PVCS Command
• Importing Data from Redmine
• Importing Data from Bitbucket
• Importing Data from Github
• Importing Data from JSON
• DRAFT - Migrating from Other Issue Trackers

Moving or Archiving Individual Projects
• Archiving a Project
• Splitting a JIRA instance

Integrating JIRA with Code Development Tools
• Version matrix for code development tools
• Integrating JIRA with Stash
• Integrating JIRA with Bamboo
• Integrating JIRA with FishEye
• Integrating JIRA with Subversion
• Integrating JIRA with Perforce

Configuring Global Settings
• Configuring Time Tracking
• Configuring JIRA Options
  • Configuring Advanced Settings
• Setting Properties and Options on Startup
  • Recognized System Properties for JIRA
• Advanced JIRA Configuration
  • Changing the constraints on historical time parameters in gadgets
  • Changing the Default Order for Comments from Ascending to Descending
  • Limiting the number of issues returned from a search view such as an RSS feed
• Configuring File Attachments
• Configuring Issue Cloning
• Configuring Issue Linking
• Configuring the Whitelist
• Configuring Sub-tasks
• Managing Shared Filters
• Managing Shared Dashboards
• Linking to Another Application

Server Administration
• Finding your Server ID
• Increasing JIRA Memory
• Using the Database Integrity Checker
• Precompiling JSP pages
• Logging and Profiling
  • Logging email protocol details
• Restoring Data
  • Restoring a Project from Backup
• Optimizing Performance
• Backing Up Data
  • Automating JIRA Backups
  • Preventing users from accessing JIRA during backups
• Search Indexing
  • Re-Indexing after Major Configuration Changes
• Using robots.txt to hide from Search Engines
• Updating your JIRA License Details
• Viewing your System Information
• Monitoring Database Connection Usage
• Viewing JIRA’s Instrumentation Statistics
• Generating a Thread Dump
• Finding the JIRA Support Entitlement Number (SEN)
• Performance Testing Scripts
• Auditing in JIRA
• Lockout recovery process

Appendix A - Extending JIRA
• Managing Add-ons
• Using the Issue Collector
  • Advanced Use of the JIRA Issue Collector
• Listeners
• Services
• Jelly Tags
• JIRA Toolkit (Customer Support Extensions)
• Developer Guides
• Building JIRA from Source
  • How to Make a JIRA Patch
• API Documentation
• Managing Webhooks

Please see the JIRA User’s Guide for an introduction to the concepts of issues and projects.

Getting Help

On this page:
• Where to Start
• Raising a Support Request
  • To raise a support request via your JIRA system
  • To raise a support request via the internet
• Creating a Support Zip
• Providing logs when you cannot log in to JIRA

Where to Start

If you encounter any problems using or setting up JIRA, please let us know — we’re here to help!

You may want to first search the following:
1. The Atlassian Answers site (JIRA Forum), where Atlassian staff and JIRA users can answer your questions.
2. The JIRA Knowledge Base.

If you need further assistance, please raise a support request (see below).

Alternatively, if you feel you have encountered a bug in JIRA, or wish to request a feature, please file an issue. It is a good idea to first scan JIRA's popular issues — this helps to prevent duplicates.

Looking for other helpful information? You can receive news, product information and code tips via our newsletter, blogs and forums. Stay in touch with us here.

Raising a Support Request

You can raise a support request either in JIRA or via the internet, as described below:

To raise a support request via your JIRA system

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose > System. Select Atlassian Support Tools from the left panel in the System page.
3. Click Support Request to display this form:

   - **To**: Atlassian Support Team
   - **Contact Email**: captain.planet@example.com
   - **Summary**
   - **Priority**: Moderate loss of application functionality or performance resulting in multi-
   - **Description**

Support Data to Attach

Attaching logs and configuration information to your Support Request helps our eng faster and more complete response. Usernames and passwords are removed from files automatically (usernames will still appear in log files).

- **Application Properties**
- **Thread Dump**
- **JIRA Configuration Files**
- **Tombstone Configuration Files**
- **Cache Configuration Files**
- **JIRA Application Logs**
- **Tombstone Logs**

4. Once you have submitted your support request, you will receive email updates about its progress. You can also view the status of your support request by visiting the Atlassian Support System.

OR:

To raise a support request via the internet

Looking for other helpful information? You can receive news, product information and code tips via our newsletter, blogs and forums. Stay in touch with us here.
1. Please visit the Atlassian Support System and create a support request. You will need to create an account, if you don't have one already.
2. Please provide as much information as possible, including any error messages that are appearing on the console or in the logs. Please also mention the operating system, database and version of JIRA you are using.

Sometimes it is necessary to adjust JIRA’s logging levels to get a more detailed error message or a stack trace. Please see the logging section of the documentation for information on how to do this.

Creating a Support Zip

If you have created a support request via the internet, you may want to create a ‘Support Zip’ (which contains information about your JIRA system) and attach it to the support request. This will assist our support engineers in troubleshooting the issue.

To create a Support Zip:

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose System > System. Select Atlassian Support Tools from the left panel in the System page.
3. Click Support Zip. The Support Zip page will be displayed.
4. Leaving all the boxes ticked, click the Create button at the bottom of the screen.

The Support Zip will generate and can be found in your JIRA HOME/export directory.

You can now go to your support request and attach the Support Zip.

Providing logs when you cannot log in to JIRA

If you are unable to log in to JIRA, you can still create a compressed file (zip or tar.gz) with the following logs:

1. Latest JIRA logs: $JIRA_HOME/log/atlassian-jira.log
2. Application server (Tomcat) log files:
   - UNIX: $JIRA_INSTALL/logs/catalina.out
   - Windows: $JIRA_INSTALL/logs/stdout and stderr

If you cannot locate these files, compress the contents of the following directories and attach them to your support request:

1. $JIRA_INSTALL/logs
2. $JIRA_HOME/log

Configuring the Layout and Design

The following pages contain information on configuring the layout and design of JIRA:

- Customizing the Look and Feel
- Choosing a Default Language
- Configuring the Default Issue Navigator
- Configuring the Default Dashboard
- Configuring an Announcement Banner
- Enabling Logout Confirmation
- Creating Links in the Application Navigator
- Configuring Issue Table Columns
- Configuring Project Navigation

You may also wish to extend JIRA’s functionality by installing and/or enabling new plugins. Read the Managing Add-ons documentation for further information.
Customizing the Look and Feel

This page tells you how to customize your JIRA installation to match your company's environment. One of the easiest things you can do to get started is to update your JIRA color scheme to match your company's logo (shown below).

- **Upload from File** – click **Browse** to search for and upload a new image for the logo.
- **Upload from URL** – use one of the following conventions:
  - A URL beginning with 'http://' or 'https://' is treated by JIRA as an absolute URL/path.
  - A URL beginning with a forward slash '/' is treated as a path relative to the `<jira-application-dir>` subdirectory of your JIRA Installation Directory.

Tip: If you use a JIRA WAR distribution, it is recommended that you add your logo images to the `edit-webapp` subdirectory of your JIRA Installation Directory prior to building your WAR distribution file. For details on building JIRA WAR distributions, refer to the application server-specific documentation in the Installing JIRA WAR section.

If the JIRA logo does not appear after changing it to a custom one, ensure that the URL specified uses the correct case as this may be case-sensitive.

If you don't like the change, simply click **Undo**.

On this page:
- Look and feel configuration
- Logo and Favicon colors
- Gadget colors
- Date/Time Formats

Related pages:
- Configuring the Default Issue Navigator
- Configuring the Default Dashboard

Look and feel configuration

You can easily customize JIRA's look and feel to suit your needs:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🌛 > System. Select User Interface > Look and Feel.
   
   Keyboard shortcut: `g + g` + start typing **look and feel**
3. The **Look and Feel** configuration page will be displayed as follows:

*Screenshot: Look and Feel Configuration*

![Look and Feel Configuration](image)

**Logo, Site Title and Favicon**

**Colours**

To apply a color scheme that matches your logo, click here.

<table>
<thead>
<tr>
<th>Color Name</th>
<th>Colour Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Background Colour</td>
<td>#205081</td>
</tr>
<tr>
<td>Header Highlight Background Colour</td>
<td>#29bca3</td>
</tr>
<tr>
<td>Header Separator Colour</td>
<td>#2e3d54</td>
</tr>
<tr>
<td>Header Text Colour</td>
<td>#ffffff</td>
</tr>
<tr>
<td>Header Text Highlight Colour</td>
<td>#9adbff</td>
</tr>
<tr>
<td>Menu Item Highlight Background Colour</td>
<td>#328ce6</td>
</tr>
<tr>
<td>Menu Item Highlight Text Colour</td>
<td>#328ce6</td>
</tr>
<tr>
<td>Button Background Colour</td>
<td>#3b7bc4</td>
</tr>
<tr>
<td>Button Text Colour</td>
<td>#3b7bc4</td>
</tr>
<tr>
<td>Link Active Colour</td>
<td>#328ce6</td>
</tr>
<tr>
<td>Heading Colour</td>
<td>#292929</td>
</tr>
<tr>
<td>Link Colour</td>
<td>#328ce6</td>
</tr>
</tbody>
</table>

**Gadget Colours**

<table>
<thead>
<tr>
<th>Colour Name</th>
<th>Colour Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colour 1 (Default)</td>
<td>#369</td>
</tr>
<tr>
<td>Colour 2</td>
<td>#900925</td>
</tr>
<tr>
<td>Colour 3</td>
<td>#94525</td>
</tr>
<tr>
<td>Colour 4</td>
<td>#469290</td>
</tr>
</tbody>
</table>
Day/Time Formats

Documentation on datetime formats can be found online.

<table>
<thead>
<tr>
<th>Format Type</th>
<th>Format Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Format</td>
<td>h:mm a</td>
</tr>
<tr>
<td>Date Format</td>
<td>EEEE h:mm a</td>
</tr>
<tr>
<td>Complete Date/Time Format</td>
<td>dd/MM/yyyy h:mm a</td>
</tr>
<tr>
<td>Day/Month/Year Format</td>
<td>dd/MM/yyyy</td>
</tr>
</tbody>
</table>

Use ISO8601 standard in Date Picker
Turning on will cause Monday to be the first day of week in the Date Picker, as specified by the ISO8601 standard.

Refresh Client Resources

If you have applied patches or made other support changes it can be necessary to cause all browser clients of JIRA to refresh fresh copies of web resources.

Clicking this link will ensure users see those updates.

Logo and Favicon

The logo appears in the top left corner of every JIRA page while the favicon appears typically to the left of your browser’s URL field and on browser tabs displaying a page on your JIRA site. You can easily replace the default JIRA logo and/or favicon with an image of your choice.

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview (Logo)</td>
<td>A preview of your JIRA site’s current logo is shown here.</td>
</tr>
<tr>
<td>Favicon Preview (Favicon)</td>
<td>A preview of your JIRA site’s current favicon is shown here.</td>
</tr>
</tbody>
</table>

colors

The following options control the appearance of the entire JIRA user interface.

Editing colors

To edit the colors, click on the individual colors and follow this procedure.

1. Click on the color box for an element.
2. This opens up the color display where you can create customized colors or enter specific color values:
3. To save your changes, click **Update**.
4. If you are unhappy with a color change, click the **Revert** button that displays in the row where you've made the change:

### Usage Notes

- The colors you specify for each of the following options can be anything that is valid for both a font tag, and a stylesheet's 'color:' attribute.
- When specifying a color, you can use the pop-up color chooser, or specify your own (eg. `'#FFFFFF', 'red')
- To return to the original color scheme, just clear any values that you have set.

#### Gadget colors

These seven colors are the seven options from which users can select when changing the color of a gadget's frame on their JIRA dashboard. Color 1 is the default frame color for newly-added gadgets.

**Please note:**

- The colors you specify for each of the eight options can be anything that is valid for both a font tag, and a stylesheet's 'color:' attribute.
- When specifying a color, you can use the pop-up color chooser, or specify your own (eg. `'#FFFFFF', 'red')
- To return to the original color scheme, just clear any values that you have set.

#### Date/Time Formats

The **Look and Feel page** allows you to customize the way times and dates are presented to users throughout
the JIRA user interface.

When specifying dates and times, they should be based on the Java `SimpleDateFormat`.

When you are not in edit mode on the 'Look and Feel' page, the examples in the rightmost column of the Date/Time Formats section show you how the various formats will appear in JIRA.

Relative time is used in date/time formats

Issue date/time fields show a relative instead of absolute date/time format (for example: Yesterday 12:00 PM instead of 20 May 2013 12:00 PM). You can still see the absolute date/time by hovering over the field.

The date/time format reverts to absolute after a week.

Configuring date picker formats

Be aware that these options are different from the Date/Time Formats configuration options on the Look and Feel page, which only customize JIRA's presentation of times and dates to users.

The date or date/time formats for date pickers are defined by a pair of properties (one for Java and the other for JavaScript). The two properties in this Java/JavaScript pair must match in order for the date (or date/time) picker they define to function correctly.

- For Java formats, specify date/time formats based on the Java `SimpleDateFormat`.
- For JavaScript formats, specify date/time formats based on the Unix date format.

Here are some example US-based date configurations:

<table>
<thead>
<tr>
<th>Preferred Date</th>
<th>Value of the jira.date.picker.java.format property</th>
<th>Value of the jira.date.picker.javascRIPT.format property</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010-10-01</td>
<td>yyyy-MM-dd</td>
<td>%Y-%m-%d</td>
<td>ISO 8601 format</td>
</tr>
<tr>
<td>Oct/1/10</td>
<td>MMM/d/yy</td>
<td>%b/%e/%y</td>
<td></td>
</tr>
<tr>
<td>10/01/10</td>
<td>MM/dd/yy</td>
<td>%m/%d/%y</td>
<td></td>
</tr>
<tr>
<td>Oct 1, 2010</td>
<td>MMM d, yyyy</td>
<td>%b %e, %Y</td>
<td></td>
</tr>
<tr>
<td>10/01/2010</td>
<td>MM/dd/yyyy</td>
<td>%m/%d/%Y</td>
<td></td>
</tr>
</tbody>
</table>

Here are some examples of date/time configurations:

<table>
<thead>
<tr>
<th>Preferred Date/Time</th>
<th>Value of the jira.date.timepicker.java.format property</th>
<th>Value of the jira.date.timepicker.javascRIPT.format property</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010-10-15 08:50</td>
<td>yyyy-MM-dd HH:mm</td>
<td>%Y-%m-%d %H:%M</td>
</tr>
<tr>
<td>15/Oct/10 8:50 AM</td>
<td>dd/MMM/yy h:mm</td>
<td>%d/%b/%y %l:%M %p</td>
</tr>
<tr>
<td>10/15/10 08:50 AM</td>
<td>MM/dd/yy hh:mm</td>
<td>%m/%d/%y %I:%M %p</td>
</tr>
</tbody>
</table>

Choosing a Default Language

Overview

Most user-visible pages in JIRA are now internationalized. Chinese, Czech, Danish, English, French, German, Italian, Norwegian, Polish, Portuguese (Brazilian), Russian, Japanese, Slovak and Spanish translations are available (at time of writing), with more in development.
When JIRA is first installed, the default language may be chosen by clicking on a flag:

On this page:
- Overview
- Changing the default language
- Per-user language selection
- Overriding the default translations of Issue Types, Resolutions, Statuses and Priorities
- Related Topics

Changing the default language

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose ⚙ > System. Select General Configuration to open the Administration page. (Keyboard shortcut: 'g' + 'g' + start typing 'general configuration')
3. Click the 'Edit Configuration' button at the end of the page, then select the appropriate language in the dropdown box next to 'Default language'.

Any additional languages you have installed will appear in the list. See Translating JIRA.
Individual users can choose their own language, which will override the default language (see above).

Overriding the default translations of Issue Types, Resolutions, Statuses and Priorities

Should you wish, you can easily specify your own translations for the values of the following JIRA issue fields:

- Issue Type
- Priority
- Status
- Resolution

Your specified translations will override the values specified in the JIRA translation.

Related Topics

- Translating JIRA

Translating JIRA

This page contains information about translating JIRA into languages other than English.

On this page:

- Atlassian Translations – a collaborative environment for creating translations of JIRA
- What translations of JIRA are currently available?
- What about translations of the documentation?

Atlassian Translations – a collaborative environment for creating translations of JIRA

The Atlassian Translations site provides a collaborative environment for customers to translate JIRA. (Refer to the instructions for more information). At present there are thousands of accepted translations across a number of languages. We need your help to make this even better! If you are looking at updating or creating a language pack please use Atlassian Translations and tell us about your experience. You can log in with your My Atlassian account. To provide feedback or submit an existing language pack for import please contact The Internationalisation Team.

There is also a plugin currently in Beta release that allows you to translate most JIRA items on the fly: InProduct Translations.

What translations of JIRA are currently available?

Currently, JIRA ships with a number of translations in the most commonly-requested languages. You can easily update these via the Universal Plugin Manager — please see Managing JIRA's Plugins.

As a JIRA administrator, you can choose the default language from the list of installed languages: see Choosing a Default Language for the latest list.

Individual users can also choose their preferred language from the same list: see Choosing a Language.

What about translations of the documentation?

We do not currently offer translations of the JIRA documentation into other languages. However, we do offer a page where people can contribute the guides they have written in languages other than English: JIRA Documentation in Other Languages.

Configuring the Default Issue Navigator

JIRA lets you change the columns of the table of search results for any search results displayed using the List view (as opposed to the Detail View). Click Columns at top right of the issue table to open the column configuration dialog, shown below.
Column Configuration Dialog

This displays the list of the columns used in the current table of results. Choose the columns you want with checkboxes and click **Done** to finish. Notice that the Filter option is greyed out, this is because the the issue table results are not coming from a filter. See Changing the column configuration for your own filters for an example of using this dialog to set the displayed columns for your own filters.

**Sorting and rearranging columns**

- To sort issues, just click on a column header.
- To rearrange the column layout, press and hold the mouse button to enter "column drag mode."

**My Defaults, Filter, and System**

If the currently selected button is **My Defaults**, this indicates that the columns you are seeing are from your user account preferences. **Filter** is an available option whenever the issue search results come from a saved filter. If you are a JIRA Admin, you will also see the **System** tab, where you can change the columns for all users who have not set their own defaults.

JIRA administrators can configure the columns that appear in the Issue Navigator for all users that do not have personal column filters defined. When administrators are configuring default columns, their permissions are ignored, so that they can add a project-specific custom field from a project that they do not have permissions to browse. The field would never be actually shown to users that do not have permissions to see it.
Configuring the Default Dashboard

The default dashboard is the screen that all JIRA users see the first time they login. Any users who have not added any dashboard pages as favourites also see the default dashboard.

JIRA allows Administrators to configure the default dashboard. The gadgets on the default dashboard can be re-ordered, switched between the left and right columns, additional gadgets can be added, and some gadgets can be configured. The layout of the dashboard (e.g. number of columns) can also be configured.

All changes made to the default dashboard will also change the dashboards of all users currently using the default. However, gadgets that users do not have permissions to see will not be displayed to them. For example, the 'Administration' gadget, although it may exist in the default dashboard configuration, will not be visible to non-admin users.

On this page:
- Adding and Configuring Gadgets on the Default Dashboard
- See Also

Adding and Configuring Gadgets on the Default Dashboard

JIRA's default dashboard is limited to only one dashboard page. However, users can add multiple pages to their own dashboards if they wish.

1. Log in as a user with the JIRA Administrators global permission.
2. Choose System > User Interface > System Dashboard to open the Configure System Dashboard page.
   ☑️ Keyboard shortcut: g + g + start typing system dashboard
3. On the 'Configure System Dashboard' page, you can do the following:
   - To move the current gadgets to a different position on the default dashboard, simply drag-and-drop them.
   - To re-configure the existing gadgets, please see Changing the Look and Behavior of a Gadget.
   - To choose a different layout for the default dashboard, please see Customizing the Dashboard.

See Also

- Using Dashboard Gadgets
- Adding a Gadget to the Directory
- Subscribing to Another Application's Gadgets
- Customizing the Dashboard

Using Dashboard Gadgets

On this page:
- About gadgets
- Pre-installed gadgets
- Extension gadgets
- Creating new gadgets

About gadgets

JIRA provides the ability to display summary information about project/issue data on the dashboard, through the use of 'gadgets'. Each gadget can be configured to display project and issue details relevant to particular users. Gadgets can be added to the dashboard — providing a central location for quick access to this information.
Pre-installed gadgets

JIRA provides a set of standard gadgets out-of-the-box:

<table>
<thead>
<tr>
<th>Gadget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream Gadget</td>
<td>The <strong>Activity Stream</strong> gadget displays a summary of your recent activity.</td>
</tr>
<tr>
<td>Administration Gadget</td>
<td>The <strong>Administration</strong> (Guide for JIRA Administrators) gadget displays checklist of common administration tasks and links to administrative functions and documentation.</td>
</tr>
<tr>
<td>Assigned To Me Gadget</td>
<td>The <strong>Assigned To Me</strong> gadget displays all open issues in all projects assigned to the current user viewing the dashboard.</td>
</tr>
<tr>
<td>Average Age Gadget</td>
<td>The <strong>Average Age</strong> gadget displays a bar chart showing the average number of days that issues have been unresolved.</td>
</tr>
<tr>
<td>Bamboo Charts Gadget *</td>
<td>The <strong>Bamboo Charts</strong> gadget displays various charts and plan statistics from a particular Bamboo server.</td>
</tr>
<tr>
<td>Bamboo Plan Summary Chart Gadget *</td>
<td>The <strong>Bamboo Plan Summary</strong> gadget displays a graphical summary of a build plan.</td>
</tr>
<tr>
<td>Bamboo Plans Gadget *</td>
<td>The <strong>Bamboo Plans</strong> gadget displays a list of all plans on a Bamboo server, and each plan’s current status.</td>
</tr>
<tr>
<td>Bugzilla ID Search Gadget</td>
<td>The <strong>Bugzilla ID Search</strong> gadget allows the user to search all JIRA issues for references to Bugzilla IDs.</td>
</tr>
<tr>
<td>Calendar Gadget *</td>
<td>The <strong>Issue Calendar</strong> gadget shows issues and versions in a calendar format based on their due date. Calendars can be based on an issue filter or on a project.</td>
</tr>
<tr>
<td>Clover Coverage Gadget *</td>
<td>The <strong>Clover Coverage</strong> gadget displays the Clover coverage of plans from a particular Bamboo server.</td>
</tr>
<tr>
<td>Created vs Resolved Gadget</td>
<td>The <strong>Created vs Resolved</strong> gadget displays a difference chart showing the issues created vs resolved over a given period.</td>
</tr>
<tr>
<td>Crucible Charts Gadget *</td>
<td>The <strong>Crucible Charts</strong> gadget displays various charts showing statistical summaries of code reviews.</td>
</tr>
<tr>
<td>Favorite Filters Gadget</td>
<td>The <strong>Favorite Filters</strong> gadget displays a list of all the issue filters that have currently been added by you as a favorite filter.</td>
</tr>
<tr>
<td>Filter Results Gadget</td>
<td>The <strong>Filter Results</strong> gadget displays the results of a specified issue filter.</td>
</tr>
</tbody>
</table>

Adding Atlassian gadgets to external websites

You can also add Atlassian gadgets to compatible external websites, like iGoogle. For instructions on how to do this, please refer to [Adding an Atlassian Gadget to iGoogle and Other Web Sites](#).
### JIRA Gadget Descriptions

<table>
<thead>
<tr>
<th>Gadget Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FishEye Charts Gadget *</td>
<td>The <strong>FishEye Charts</strong> gadget displays two charts showing showing statistics about a given sourcecode repository.</td>
</tr>
<tr>
<td>FishEye Recent Changesets Gadget *</td>
<td>The <strong>FishEye Recent Changesets</strong> gadget displays a number of recent changesets from a FishEye repository.</td>
</tr>
<tr>
<td>In Progress Gadget</td>
<td>The <strong>In Progress</strong> gadget displays all issues that are currently in progress and assigned to the current user viewing the dashboard.</td>
</tr>
<tr>
<td>Introduction Gadget</td>
<td>The <strong>Introduction</strong> gadget displays a configurable introduction message on the dashboard.</td>
</tr>
<tr>
<td>Issue Statistics Gadget</td>
<td>The <strong>Issue Statistics</strong> gadget displays the collection of issues returned from a specified filter, broken down by a specified field.</td>
</tr>
<tr>
<td>Pie Chart Gadget</td>
<td>The <strong>Pie Chart</strong> gadget displays issues from a project or issue filter, grouped by a statistic type, in pie-chart format. The issues can be grouped by any statistic type (e.g. Status, Priority, Assignee, etc).</td>
</tr>
<tr>
<td>Projects Gadget</td>
<td>The <strong>Projects</strong> gadget provides information and various filters related to a specified project(s).</td>
</tr>
<tr>
<td>Quick Links Gadget</td>
<td>The <strong>Quick Links</strong> gadget displays a number of useful links to issues associated with the current user.</td>
</tr>
<tr>
<td>Recently Created Issues Gadget</td>
<td>The <strong>Recently Created Issues</strong> gadget displays a bar chart showing the rate at which issues are being created, as well as how many of those created issues are resolved.</td>
</tr>
<tr>
<td>Resolution Time Gadget</td>
<td>The <strong>Resolution Time</strong> gadget displays a bar chart showing the average resolution time (in days) of resolved issues.</td>
</tr>
<tr>
<td>Road Map Gadget</td>
<td>The <strong>Road Map</strong> gadget shows versions which are due for release within a specified period of time, and a summary of progress made towards completing the issues in those versions.</td>
</tr>
<tr>
<td>Text Gadget *</td>
<td>The <strong>Text</strong> gadget displays a configurable HTML text on the dashboard.</td>
</tr>
<tr>
<td>Time Since Issues Gadget</td>
<td>The <strong>Time Since Issues</strong> gadget displays a bar chart showing the number of issues that something has happened to within a given time period. The 'something has happened' is based on a date field that you choose, such as 'Created', 'Updated', 'Due', 'Resolved' or a custom field.</td>
</tr>
<tr>
<td>Two Dimensional Filter Statistics Gadget</td>
<td>The <strong>Two Dimensional Filter Statistics</strong> gadget displays statistical data based on a specified filter in a configurable table format.</td>
</tr>
<tr>
<td>Voted Gadget</td>
<td>The <strong>Voted Issues</strong> gadget shows issues for which you have voted.</td>
</tr>
<tr>
<td>Watched Gadget</td>
<td>The <strong>Watched Issues</strong> gadget shows issues which you are watching.</td>
</tr>
</tbody>
</table>

*See the big list of all Atlassian gadgets for more ideas.*

*This gadget will only be available if you have installed/configured the relevant plugin.*

**Extension gadgets**
Other gadgets are available as plugins on the Atlassian Marketplace. If you wish to use these plugins, you need to first install them (using the instructions provided with each plugin) then enable them.

**Creating new gadgets**

New gadgets can be created by writing an XML descriptor file, packaged as an Atlassian plugin. See Writing an Atlassian Gadget for more information.

**RELATED TOPICS**

The big list of Atlassian gadgets

Adding a Gadget to the Directory

The JIRA gadget directory displays all the gadgets that are available for JIRA users to add to their dashboard.

You need to have administrator privileges to add a gadget to the directory. If you have permission to add gadgets to and remove gadgets from the directory itself, you will see the 'Add Gadget to Directory' and 'Remove' buttons on the 'Add Gadget' screen, as shown below.

---

**Security implications**

Add only gadgets from sources that you trust. Gadgets can allow unwanted or malicious code onto your web page and into your application. A gadget specification is just a URL. The functionality it provides can change at any time.

There are two types of gadgets: those that must be installed as plugins, and those that can be added as simple gadget URLs.

**Adding a Gadget that is Not a Plugin**

If the gadget is hosted on another server and can be added to the directory as a simple URL, then you can simply add it via your dashboard's 'Add Gadget' option.

**To add a gadget to your directory,**
First you need to find the URL for the gadget's XML specification file. Gadget authors and publishers make their gadget URLs available in different ways. Below are the instructions for an Atlassian gadget and a Google gadget.

- Follow the steps below if you need to find the URL for a gadget that is published by an Atlassian application, such as JIRA or Confluence: A gadget's URL points to the gadget's XML specification file. Gadget URLs are shown on the 'Gadget Directory' screen that is displayed when you click 'Add Gadget'. In general, a gadget's URL looks something like this:

  http://example.com/my-gadget-location/my-gadget.xml

If the gadget is supplied by a plugin, the URL will have this format:

  http://my-app.my-server.com:port/rest/gadgets/1.0/g/my-plugin.key/my-gadget/my-path/my-gadget.xml

For example:

  http://mycompany.com/jira/rest/gadgets/1.0/g/com.atlassian.streams.streams-jira-plugin:activitystream-gadget/gadgets/activitystream-gadget.xml

To find a gadget's URL in JIRA:

- Go to your dashboard by clicking the 'Dashboards' link at the top left of the screen.
- Click 'Add Gadget' to see the list of gadgets in the directory.
- Find the gadget you want, using one or more of the following tools:
  - Use the scroll bar on the right to move up and down the list of gadgets.
  - Select a category in the left-hand panel to display only gadgets in that category.
  - Start typing a key word for your gadget in the 'Search' textbox. The list of gadgets will change as you type, showing only gadgets that match your search term.
- Right-click the 'Gadget URL' link for that gadget and copy the gadget's URL into your clipboard.

To find a gadget's URL in Confluence:

- Open the 'Browse' menu and click 'Confluence Gadgets' to see the list of available Confluence gadgets.
- Find the gadget you want.
- Right-click the 'Gadget URL' link for that gadget and copy the gadget's URL into your clipboard.

- Follow the steps below if you need to find the URL for a Google gadget:
  a. Go to the Google gadget directory. (You can also get there by clicking 'Add Stuff' from your iGoogle home page.)
  b. Search for the gadget you want.
  c. Click the link on the gadget to open its home page.
  d. Find the 'View source' link near the bottom right of the page. Right-click the link and copy its location to your clipboard. This is the gadget's URL.

2. Now you can add the gadget to your directory. Go to the dashboard by clicking the 'Dashboard' link or the 'Home' link at the top left of the screen.
3. The dashboard will appear. Click 'Add Gadget'.
4. The 'Add Gadget' screen appears, showing the list of gadgets in your directory. Click 'Add Gadget to Directory'.
   - You will only see this button if you have administrator permissions for your dashboard.
5. The 'Add Gadget to Directory' screen appears. Type or paste the gadget URL into the text box.
6. Click 'Add Gadget'.
7. The gadget appears in your gadget directory. (It will be highlighted for a short time, so that you can see it easily.)

Adding a Gadget that must be Installed as a Plugin
If the gadget must be installed as a plugin, you cannot add it via the gadget directory user interface. Instead, you will need to follow the instructions for adding a plugin, as described in Managing JIRA’s Plugins.

Once you have installed your plugin, the gadget will automatically appear in the directory.

RELATED TOPICS

The big list of Atlassian gadgets

Subscribing to Another Application’s Gadgets

Security Implications
Add only gadgets from sources that you trust. Gadgets can allow unwanted or malicious code onto your web page and into your application. A gadget specification is just a URL. The functionality it provides can change at any time.

If you have administrator privileges, you can configure your application to subscribe to gadgets from other Atlassian applications. This feature allows administrators to make all the gadgets from one application available in another application, without having to enable each gadget individually via the gadget URL.

To make use of this feature, you will need two or more applications that support the feature.

The gadgets included are those provided by the other application or via plugins installed into that application. They do not include external gadgets that the other application has added to its directory.

To subscribe to gadgets from another application,

1. Go to the dashboard by clicking the ‘Dashboard’ link or the ‘Home’ link at the top left of the screen.
2. The dashboard appears. Click ‘Add Gadget’.
3. The ‘Add Gadget’ screen appears, showing the list of gadgets in your directory. See the gadget directory screenshot below. Click ‘Gadget Subscriptions’.
   You will only see this button if you have administrator permissions for your dashboard, and if your application supports gadget subscriptions.
4. The ‘Gadget Subscriptions’ screen appears, showing the applications to which your application already subscribes. Click ‘Add Subscription’.
5. The ‘Add Subscription’ screen appears. See the screenshot below. Enter the base URL of the application you want to subscribe to. For example, http://example.com/jira or http://example.com/confluence.
6. Click ‘Finished’ to add the subscription.

Screenshot: Gadget directory with ‘Gadget Subscriptions’ button
Screenshot: Adding a gadget subscription
RELATED TOPICS

The big list of Atlassian gadgets

Configuring an Announcement Banner

Administrators can configure an announcement banner to display pertinent information on all JIRA pages. The banner can be used to relate important information (e.g. scheduled server maintenance, approaching project deadlines, etc.) to all users. Further, the banner visibility level can be configured to display to all users or just logged-in users.

If you are using downloadable JIRA, the banner can be configured to contain HTML text. If you are using JIRA Cloud, you can only use wiki markup in the banner.

On this page:

- Configuring an Announcement Banner
- Banner Visibility Mode

⚠️ Some functionality described on this page behaves differently in JIRA Cloud.
Configuring an Announcement Banner

1. Log in as a user with the JIRA Administrators global permission.
2. Choose "System" > "User Interface" > "Announcement Banner" in the System panel below. **Keyboard shortcut:** `g + g +` start typing `announcement banner`
3. Enter the required text in the Announcement field.
4. Select the required Visibility Level for the banner.
5. Click the Set Banner button.

Depending on the visibility level selected, the banner will become visible throughout JIRA.

*Screenshot: Configuring the Announcement Banner*

Banner Visibility Mode

The announcement banner visibility level can be configured to specify to whom the banner will be displayed. There are two modes:

- **Public** — the banner is visible to everyone
- **Private** — the banner is visible to logged-in users only

Enabling Logout Confirmation

Administrators can configure JIRA to prompt users with a confirmation before logging them out.

By default, JIRA will not prompt users to confirm logging out. To change this:

1. Log in as a user with the `JIRA Administrators` global permission.
2. Choose "System" > "General Configuration" to open the Administration page. **Keyboard shortcut:** `g` + `g` + start typing `general configuration`
3. Locate the 'Options' section:
By default, JIRA will not prompt users to confirm logging out by default. To change this, click the Edit Settings button at the top of the page. 

The Never and Always settings are self-explanatory. When set to Cookie, your JIRA users will only be prompted if they have logged in using a cookie (i.e. by selecting the 'Remember my login on this computer' check box before they click the 'Log In' button).

Creating Links in the Application Navigator

You can add custom links in the application navigator, to make it easier for users to navigate to frequently used information.

What is the application navigator?

The application navigator is the control in the top left of the JIRA header that displays a menu of links to other applications. It is only displayed to users if there is more than one link. You can customize the links that appear in the application navigator, as well as making certain links only visible for specific users.

Screenshot: Application navigator
Adding links to the application navigator

If applications are linked to your JIRA instance via application links, those applications will automatically appear in the application navigator. If you don't have any applications linked, the application navigator icon ( ) will appear only for administrators. After links have been set up, the application navigator icon will automatically be visible to all users.

2. Create links by entering a name and the URL on the page.

After you’ve created a link, it will appear in the application navigator for all your applications after a few minutes (up to 10). Or, if you want links to appear immediately, you can navigate to the application navigator administration page in each application and refresh the page.

If you want to make a link appear in the application navigator for only specific users, use the Groups box to specify which groups can see the link. To hide the link from all users, select the Hide check box (for example, if you want to temporarily hide the link without deleting it entirely).

When you make a link visible for a specific group, the link visibility is only set up in the application where you are configuring the link. For example, if you change the visibility in the JIRA administration screen and you also want it to be visible to the same users in Confluence, you must make the same changes in the Confluence administration settings.

To modify links that were created and are managed in other applications (for example, in a different JIRA application), edit the link in that application. You cannot delete links to linked applications, you must delete the application link instead.

Configuring Issue Table Columns

JIRA lets you change the columns of the table of search results for any search results displayed using the List view (as opposed to the Detail View). Click Columns at top right of the issue table to open the column configuration dialog, shown below.
**Column Configuration Dialog**

This displays the list of the columns used in the current table of results. Choose the columns you want with checkboxes and click **Done** to finish. Notice that the Filter option is greyed out, this is because the the issue table results are not coming from a filter. See *Changing the column configuration for your own filters* for an example of using this dialog to set the displayed columns for your own filters.

**Sorting and rearranging columns**

- To sort issues, just click on a column header.
- To rearrange the column layout, press and hold the mouse button to enter "column drag mode."

**My Defaults, Filter, and System**

If the currently selected button is **My Defaults**, this indicates that the columns you are seeing are from your user account preferences. **Filter** is an available option whenever the issue search results come from a saved filter. If you are a JIRA Admin, you will also see the **System** tab, where you can change the columns for all users who have not set their own defaults.

JIRA administrators can configure the columns that appear in the Issue Navigator for all users that do not have personal column filters defined. When administrators are configuring default columns, their permissions are ignored, so that they can add a project-specific custom field from a project that they do not have permissions to browse. The field would never be actually shown to users that do not have permissions to see it.
Changing the column configuration for your own filters

If you are searching using a saved filter and if the filter is owned by you, use the Filter button to customize the columns displayed when users see results from that filter. When sharing a filter with other users, it's sometimes helpful to choose the relevant columns for those results. For example, if your filter searches for issues that are open bugs, you may decide to remove the columns for status and issue type for that filter since they will all be the same. Filters don't always have columns configured, but when they do, those columns will be shown unless the user chooses to use their defaults using the My Defaults button.

For any JIRA filters that you own, you can change the displayed columns as follows.

1. Click on the name of a JIRA filter you own.
2. Click the Columns button at top right of the currently displayed columns. This opens the column configuration dialog.
3. Select or deselect checked items in the list.
4. Click Done when you are finished.

Troubleshooting

If you cannot find a column, please make sure that you haven't run in to any of the following restrictions:

- You can only see columns for issue fields that have not been hidden and that you have permissions to see.
- It is possible to add any of the existing custom fields to the column list, as long as the fields are visible and you have the right permissions.
- Some custom fields, even if selected, do not appear in the Issue Navigator for all issues. For example, project-specific custom fields will be shown only if the filter has been restricted to that project only. Issue type custom fields will only appear if the filter has been restricted to that issue type.

Configuring Project Navigation

We're rolling out a new project navigation experience in JIRA. By default, the new navigation will be switched on for users, but if you decide you're not ready for the change, you can opt to turn it off.

JIRA Administrators have three options:

1. Allow individual users to turn project navigation on or off (default)
2. Enable project navigation for all users
3. Disable project navigation for all users

The option that suits your needs should be selected:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose System > User Interface > Project navigation.
   - Keyboard shortcut: g + g + start typing project navigation
3. Choose your option and select Submit.

Your option will be saved, and applied immediately for all users. If you select to allow your users to toggle
between the new project navigation experience and the old one, they will be able to do so on an individual basis.

User and Group Management

The following pages contain information about user and group management in JIRA:

- Managing Users
- Managing Groups
- Configuring User Directories
- Viewing User Sessions
- Clearing ‘Remember my login’ Tokens
- Enabling Public Signup and CAPTCHA
- Changing the User Default Settings

Managing Users

On this page:

- Viewing users
- Adding users
  - Who can see a user?
  - Creating a user
  - Inviting users
- Assigning a user to a group
- Assigning a user to a project role
- Changing a user's name or email address
- Changing a user's password
- Changing a username
- Adding a property to a user
- Deactivating a user
- Deleting a user
- Notes

Viewing Users

To view a list of JIRA users:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🌐 > User Management.

Keyboard shortcut: g + g + start typing users

3. To restrict the list of users shown, use the Filter form at the top of the page.
4. To view details and login information about a user in the list, click their Username or Email Address.
Adding users

Users can be created via any of the following methods:

- Add the user directly into JIRA — see Creating a user below. You can create one user at a time, using this method.
- Invite users via email — see Inviting Users below. You can invite multiple users at the same time, using this method.
- Allow users to sign up — see Enabling Public Signup.
- Automatically create users when issue/comment creation emails are received from unknown email addresses — You can use a mail handler to allow JIRA to create issues or comments via emails received. The handler can also be configured to create new users based on the sender’s email address. See Creating Issues and Comments from Email.
- Connect to an Internal Directory with LDAP Authentication — see Copying Users on First Login.

ℹ️ Please Note: If you have a user limited license (e.g. starter license) and have reached your user limit, any further users created will not have permission to log in to JIRA.

Who can see a user?

Any JIRA user can see another JIRA user’s full name and username, for example, see Mark Lassau. The email address visibility is controlled by a configuration item; see “User email visibility” on the Configuring JIRA Options documentation page.

Group membership and the ability to edit users is only available to administrators.

Any JIRA user can see their own details, including group memberships, update their own password, and change certain user preferences (for example, time zone and language).

Creating a user

To create a user:

1. Open the User browser (see Viewing Users above) and click the Create User button to open the ‘Create New User’ dialog box.
2. Enter the Username, Password, Full Name and Email address.
3. Optionally, select the Send Notification Email check box to send the user an email containing:
   - their login name; and
   - a link from which to set their password (this link is valid for 24 hours).
4. Click the Create button.

Inviting users

You can invite one or more users to JIRA via email. Note, JIRA’s SMTP mail server must be configured to send notifications before you can invite users via email.

To invite users to JIRA:

1. Open the User browser (see Viewing Users above) and click the Invite Users button to open the ‘Invite Users’ dialog box.
2. Enter the email addresses of the users that you want to invite. Enter each address on a new line or separate addresses using commas.
   Note, you cannot invite users by sending an invitation to a mailing list.
3. Click the Send button to send the invitations.
   - Each invitation can only be used to create a user under the email address that it was sent to, and can only be used once.
   - Each invitation will expire seven days after the day it was sent.
   - Your user license count will not be affected until users accept the invitation and the users are created.
   - Users that are created via the invitation will be added to the 'jira-users' group.

Assigning a user to a group
When a user is created, they will be added to any groups that are set up to have new users automatically added to them.

**To change a user’s group membership:**

1. Locate the user in the User browser (see Viewing Users above) and click the Groups link in the Operations column.
   This will display two lists; the one on the left shows all Available Groups, and the one on the right shows the Current Groups to which the user currently belongs.
2. Choose a group(s) and click the Join selected groups or Leave selected groups buttons to add/remove the user from the selected groups.

**Please Note:** If you have a user limited license (e.g. starter license) and have reached your user limit, you will not be able to assign any further users to groups with login permissions (i.e. jira-users permission) without first reducing the number of users with login permissions.

Assigning a user to a project role

Assigning a user to a **project role** enables them to fulfil a particular function in a particular project.

**To assign a user to a project role:**

1. To view a user’s project role membership, locate the user in the User browser (see Viewing Users above) and click the Project Roles link in the Operations column. This will display a table showing all the projects and project roles that exist in JIRA, and the user’s current project role membership for each project:

   ![Project Roles Table]

2. Click the Edit Project Roles button. The check boxes will then be available for you to select (to add the user to a project role) or clear (to remove the user from a project role).

Changing a user’s name or email address

**To change a user’s name or email address:**

1. Locate the user in the User browser (see Viewing Users above) and click their Edit link in the Operations column.
2. In the resulting form, make the required changes the user’s Full Name and/or Email address.
   ![Warning Icon] Do not clear the Active check box unless you want to deactivate this user.
3. Click Update to confirm the change.

Changing a user’s password
To change a user’s password:

1. Locate the user in the User browser (see Viewing Users above) and click their Username. This displays the user's details, below which are several links.
2. Choose Actions > Set Password.
3. Enter and confirm the new password.
4. Click the Update button.

Changing a username

ℹ️ This feature is only available for downloadable instances of JIRA. It is not available in JIRA On Demand.

JIRA Administrators can edit any Username in the JIRA Internal Directory (this is often referred to as the "rename user" feature). This ability is important to have if you wish to connect JIRA to an LDAP directory that does not follow the same username conventions. You also may want to do this if a staff member wishes to change their surname. Once the Username is changed in the internal directory, all parts of the JIRA interface display the updated Username.

Note: The Username is for the JIRA Internal Directory, and should not be confused with the user's display name, or Full Name, in the JIRA system.

There are some important exceptions that will prevent you from using this feature, of which you should be aware:

- Only JIRA Administrators can perform this function.
- JIRA cannot update external users – for example, users that are coming from an LDAP server or Crowd instance – it can only update users stored in the JIRA Internal Directory. (However, JIRA can update JIRA users stored in an "Internal Directory with LDAP Authentication.")
- If you are using your JIRA instance as a JIRA User Server for other applications, e.g., Confluence, you will not be able to use this feature. If you aren’t sure about this, check under User Management > JIRA User Server to confirm that no external applications have been configured to use JIRA as a Crowd Server.

Using a JIRA User Server for other applications

When JIRA is being used as a User Server for other applications, e.g. Confluence, we don’t allow a user rename on the JIRA server as this would not be recognised on the other server. (And the other application would think that user was deleted and a new user was added.)

If you are happy to accept this behavior, then you can set a flag to allow the rename, as documented in the Knowledge Base article: Cannot rename users despite upgrading/installing JIRA 6

We are hoping to add the ability to detect renames from a remote Crowd or JIRA server sometime soon, see JIRA-32200.

To change a username:

1. Locate the user in the User browser (see Viewing Users above) and click their Username. This displays the user's details, below which are several links.
2. Choose Actions > Edit Details.
3. Edit the Username.
4. Click the Update button.

Adding a property to a user

A 'Property' is an extra piece of information about a user that you can store in JIRA. A Property consists of a Key of your choice (eg. 'Phone number', 'Location') plus a corresponding Value (eg. '987 654 3210', 'Level Three'). Other than adding property data to the specified user, User Properties do not have an effect anywhere else in the project. Plugins, however, can frequently use this data.

To create a new Property for a user:
1. Locate the user in the User browser (see Viewing Users above) and click their Username. This displays the user's details in a box.

2. Choose Actions > Edit Properties. The Edit User Properties screen will be displayed:

3. Enter the new Key and its Value, then click the Add button.

Deactivating a user

JIRA administrators can ‘deactivate’ a JIRA user, which disables that user's access to JIRA. This avoids the need for a JIRA administrator to delete the user's account from the system.

This feature is useful when a JIRA user leaves an organisation because a deactivated user's history of JIRA activity is preserved on the system. If a user with a deactivated JIRA account rejoins the organisation at some point in the future, their JIRA user account can be re-activated.

To deactivate a user account:

1. Locate the user in the User browser (see Viewing Users above) and click their Edit link in the Operations column.

2. In the resulting form, clear the Active check box.

3. Click Update to confirm the change.

   To re-enable the user again, repeat the steps above but instead, select the Active check box.

While a JIRA user account has been deactivated, that user:

- Will no longer be able to log in to JIRA.
- Cannot be assigned issues or added as a watcher to issues (whenever issues are created or edited). However:
  - A user who was assigned, was watching or had reported any issues in JIRA before their account is deactivated, will still appear as the respective assignee, watcher or reporter of those issues. This situation remains until another user is specified as the assignee or reporter of these issues, or the deactivated user is removed as a watcher from them.
  - A user who voted on any issues in JIRA before their account is deactivated, will continue to appear as a voter on these issues.
- Will continue to appear on the JIRA user interface with '(Inactive)' displayed after their name, where applicable.
- Can still be used to filter issues in a JIRA search query. Please note the user will not be displayed in the Issue Navigator's Basic mode, so you'll need to use the Advanced mode to search for them.
- Will not receive any email notifications from JIRA, even if they continue to remain the assignee, reporter, or watchers of issues.
- Will not count towards your JIRA user license limit. Refer to the JIRA Users global permission explanation on Managing Global Permissions for more information.
- Will not be able to create or update issues through the JIRA mail handler.

Please Note:

- Users who are project or component leads cannot be deactivated. To deactivate these users, assign other users as the relevant project or component leads first.
- Any JIRA site's users who are configured in an external Atlassian Crowd user directory and deactivated in Crowd, will be deactivated in JIRA.
- With the exception of JIRA users configured with 'delegated LDAP authentication', JIRA does not deactivate users who are configured and deactivated/disabled in an external Microsoft Active Directory or LDAP-based user directory.

Deleting a user

Rather than deleting a user, we recommend that you deactivate their account instead (as described above). Deactivating a user's account will prevent that account from being used and prevent anyone from being able to log in to JIRA using that account. However, it will preserve that user's history of activity on JIRA.

To delete a user:

1. Locate the user in the User browser (see Viewing Users above) and click the Delete link in the Operations column.
The confirmation screen that follows will summarise any involvement of that user in the system by showing current issues assigned to and reported by that user, etc. These connections between the user and other parts of the system may prevent the deletion of that user.

2. Take any actions required to disassociate the user with JIRA. These may include:
   - Reassigning any issues assigned to the user.
   - Bulk-editing the issues created by the user and change the 'Reporter' to someone else. You'll need the 'Modify Reporter' permission to do this. You will also need to allow editing of closed issues if some of the issues the user created are closed and you do not wish to reopen them.
   - Changing the owner of shared dashboards owned by the user. See Managing Shared Dashboards.
   - Changing the project lead for any projects that the user is a lead of.

3. If there are no issues assigned to, or reported by the user, and the user has not commented on any issues, the confirmation screen will display a Delete button. Click this to proceed with the deletion.

Please Note:

- You cannot delete a user from JIRA if they have performed any of the following actions:
  - reported or been assigned to any issues
  - commented on any issues
- The filters and dashboards of a user will be deleted when the user is deleted, regardless of whether the filters or dashboards are shared with other users.
- Any numbers of issues which have been reported by or assigned to the user you are attempting to delete, are respectively hyperlinked to a list of the individual issues (in the Issue Navigator).

Notes

- If you are using External User Management, you will not be able to create, edit or delete users from within JIRA; but you can still assign users to project roles, and create/edit/delete user properties.
- If you have JIRA connected to either a delegated LDAP directory or an LDAP directory set to 'Read Only' (see Connecting to an LDAP Directory for details), you will not be able to change a user password from within JIRA.
- **Multiple user directories:** You may define multiple user directories in JIRA, so that JIRA looks in more than one place for its users and groups. For example, you may use the default JIRA internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where JIRA looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories.

Managing Groups

A JIRA group is a convenient way to manage a collection of users. Users can belong to many groups. Groups are used throughout JIRA; for example, they can:

- be granted global permissions.
- be used in project permission schemes.
- be used in email notification schemes.
- be used in issue security levels.
- be given access to issue filters.
- be given access to dashboards.
- be used in workflow conditions.
- belong to project roles *.

* Project roles are somewhat similar to groups, the main difference being that group membership is global whereas project role membership is project-specific.
JIRA’s default groups

When you install JIRA, three groups are automatically created:

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira-administrators</td>
<td>Typically contains people who are JIRA system administrators. By default, this group:</td>
</tr>
<tr>
<td></td>
<td>is a member of the 'Administrators' project role.</td>
</tr>
<tr>
<td></td>
<td>has the 'JIRA Administrators' and the 'JIRA System Administrators' global permissions.</td>
</tr>
<tr>
<td></td>
<td>If you need to give these permissions to separate people, you will need to create an additional group and grant the permissions separately, as described in 'About JIRA System Administrators' and 'JIRA Administrators'.</td>
</tr>
<tr>
<td>jira-developers</td>
<td>Typically contains people who perform work on issues. By default, this group:</td>
</tr>
<tr>
<td></td>
<td>is a member of the 'Developers' project role.</td>
</tr>
<tr>
<td></td>
<td>has the 'Browse Users', 'Create Shared Filter' and 'Manage Group Filter Subscriptions' global permissions.</td>
</tr>
<tr>
<td>jira-users</td>
<td>Typically contains every JIRA user in your system. By default, this group:</td>
</tr>
<tr>
<td></td>
<td>is a member of the 'Users' project role.</td>
</tr>
<tr>
<td></td>
<td>has the 'JIRA Users' and 'Bulk Change' global permissions.</td>
</tr>
</tbody>
</table>

You can create and delete groups according to your organisation's requirements.

**Please Note:** If you are using External User Management, you will not be able to create, delete or edit groups or group membership from within JIRA; and 'Automatic Group Membership' (see below) will not apply. However, you can still assign groups to project roles.

Viewing groups

**To see what groups exist, and where they are used:**

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose **User Management**. Select **Groups** to open the Groups page.
3. To see which permission schemes, email notification schemes, issue security levels and saved filters are using this group, click the group name.

**Screenshot: the Group Browser**
The 'Filter Group' form restricts the list of groups shown to those that match the 'Name Contains', with a specified maximum per page. Click the Filter button to refresh the list with the restricting filter.

Adding a group

To create a group, enter the new group Name in the Add Group form in the Group Browser and click the Add Group button.

Deleting a group

Before deleting a group it is recommended that you check whether the group is being used by any permission schemes, email notification schemes, issue security levels or saved filters. See 'Viewing groups' (above).

To delete a group, click the Delete link for that group in the Group Browser. The confirmation screen that follows explains that users will be removed from the group through its deletion.

Be aware of the impact this may have on users in that group. For example, if that group membership was the sole conveyor of a permission for a user, then the user will no longer have that permission.

Editing group membership

To edit a group's membership, click the Edit Members link in the row for that group in the Group Browser. This takes you to a form allowing you to add users to or remove them from the group.

Please Note:

- If the group has the 'JIRA System Administrators' global permission, you cannot edit its membership unless you have the 'JIRA System Administrators' global permission.
- If you have a user limited license (e.g. personal license) and have reached your user limit, you will not be able to assign any further users to groups with login permissions (i.e. jira-users permission) without first reducing the number of users with login permissions.
Automatic group membership

To automatically add newly-created users to a particular group, you can either:

- Grant the group the 'JIRA Users' global permission. See Granting global permissions for instructions.
- Specify the group name in the 'Default Group Memberships' option when Connecting to an LDAP Directory. See Adding Users to Groups Automatically for instructions.

Notes

- **Multiple user directories:** You may define multiple user directories in JIRA, so that JIRA looks in more than one place for its users and groups. For example, you may use the default JIRA internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where JIRA looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

  See Managing Multiple Directories.

- **Nested groups:** Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups. See Managing Nested Groups.

Configuring User Directories

A user directory is a place where you store information about users and groups. User information includes the person's full name, username, password, email address and other personal information. Group information includes the name of the group, the users that belong to the group, and possibly groups that belong to other groups.

The internal directory stores user and group information in the JIRA database. You can also connect to external user directories, and to Atlassian Crowd and JIRA as directory managers.

**On this page:**
- Configuring User Directories in JIRA
- Connecting to a Directory
- Updating Directories

Configuring User Directories in JIRA

To configure your user directories:

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose > User Management > User Directories.

   Keyboard shortcut: 'g' + 'g' + start typing 'directories'.

Connecting to a Directory

You can add the following types of directory servers and directory managers:

- JIRA's internal directory. See Configuring the Internal Directory.
- Various other LDAP directory servers. See Connecting to an LDAP Directory.
- An LDAP directory for delegated authentication. See Connecting to an Internal Directory with LDAP Authentication.
You can add as many external user directories as you need. Note that you can define the order of the directories. This determines which directory JIRA will search first, when looking for user and group information. See Managing Multiple Directories.

Updating Directories

Limitations when Editing Directories

You cannot edit, disable or remove the directory your user belongs to. This precaution is designed to prevent administrators from locking themselves out of the application by changing the directory configuration in a way that prevents them logging in or removes their administration permissions.

This limitation applies to all directory types. For example:

- You cannot disable the internal directory if your user is an internal user.
- You cannot disable or remove an LDAP or a Crowd directory if your user comes from that directory.

In some situations, reordering the directories will change the directory that the current user comes from, if a user with the same username happens to exist in both. This behaviour can be used in some cases to create a copy of the existing configuration, move it to the top, then remove the old one. Note, however, that duplicate usernames are not a supported configuration.

You cannot remove the internal directory. This precaution aligns with the recommendation below that you always keep an administrator account active in the internal directory.

Recommendations

The recommended way to edit directory configurations is to log in as an internal user when making changes to external directory configuration.

⚠️ We recommend that you keep either an administrator or system administrator user active in your internal directory for troubleshooting problems with your user directories.

Enabling, Disabling and Removing Directories

You can enable or disable a directory at any time. If you disable a directory, your configuration details will remain but the application will not recognise the users and groups in that directory.

You have to disable a directory before you can remove it. Removing a directory will remove the details from the database.

Screenshot: Configuring user directories
User Directories

The table below shows the user directories currently configured for JIRA.

The order of the directories is the order in which they will be searched for users and groups. Changes to users and groups will be made in the first directory where JIRA has permission to make changes. It is recommended that users only exist in a single directory.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Type</th>
<th>Order</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA Internal Directory</td>
<td>Internal</td>
<td></td>
<td>Disable Edit Synchronise</td>
</tr>
<tr>
<td>LDAP server</td>
<td>OpenLDAP (Read-Write)</td>
<td></td>
<td>Last synchronised at 17/01/11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10:31 AM (took 72s).</td>
</tr>
</tbody>
</table>

Add Directory

RELATED TOPICS

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Multiple Directories
- Synchronising Data from External Directories
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Allowing Other Applications to Connect to JIRA for User Management
- Migrating Users between User Directories

User and Group Management

Configuring the Internal Directory

The internal directory stores user and group information in the JIRA database. The internal directory is enabled by default at installation. When you create the first administrator during the setup procedure, that administrator's username and other details are stored in the internal directory.
If needed, you can configure one or more additional user directories. This is useful if you want to grant access to users and groups that are stored in a corporate directory or other directory server.

### Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
</tbody>
</table>

### Diagram of Possible Configuration

![Diagram above: JIRA using its internal directory for user management.](image)

### RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Multiple Directories
- Synchronising Data from External Directories
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Allowing Other Applications to Connect to JIRA for User Management
- Migrating Users between User Directories
Connecting to an LDAP Directory

You can connect your JIRA application to an LDAP directory for authentication, user and group management.

Overview

An LDAP directory is a collection of data about users and groups. LDAP (Lightweight Directory Access Protocol) is an Internet protocol that web applications can use to look up information about those users and groups from the LDAP server.

We provide built-in connectors for the most popular LDAP directory servers:

- Microsoft Active Directory
- Apache Directory Server (ApacheDS)
- Apple Open Directory
- Fedora Directory Server
- Novell eDirectory
- OpenDS
- OpenLDAP
- OpenLDAP Using Posix Schema
- Posix Schema for LDAP
- Sun Directory Server Enterprise Edition (DSEE)
- A generic LDAP directory server

When to use this option: Connecting to an LDAP directory server is useful if your users and groups are stored in a corporate directory. When configuring the directory, you can choose to make it read only, read only with local groups, or read/write. If you choose read/write, any changes made to user and group information in the application will also update the LDAP directory.

Connecting to an LDAP Directory in JIRA

To connect JIRA to an LDAP directory:

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose > User Management > User Directories.
   - Keyboard shortcut: ‘g’ + ‘g’ + start typing ‘directories’.
3. Add a directory and select one of these types:
   - 'Microsoft Active Directory' – This option provides a quick way to select AD, because it is the most popular LDAP directory type.
   - 'LDAP' – You will be able to choose a specific LDAP directory type on the next screen.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User
Directories' screen. Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

For details see Managing Multiple Directories.

Notes:

- For this configuration, every time user logs in (i.e. first and subsequent times), the user’s data in JIRA will be updated from the user's data in LDAP. This includes username, display name, email and group memberships. However for group memberships, only the following applies:
  - direct groups only (i.e. not nested groups) are synchronised from LDAP.
  - only groups that are already present in JIRA are synchronised, i.e. groups are not added/removed, and group hierarchies are not synchronised.

Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a meaningful name to help you identify the LDAP directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Example Company Staff Directory</td>
</tr>
<tr>
<td></td>
<td>• Example Company Corporate LDAP</td>
</tr>
<tr>
<td>Directory Type</td>
<td>Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for many of the options on the rest of screen. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Active Directory</td>
</tr>
<tr>
<td></td>
<td>• OpenDS</td>
</tr>
<tr>
<td></td>
<td>• And more.</td>
</tr>
<tr>
<td>Hostname</td>
<td>The host name of your directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• ad.example.com</td>
</tr>
<tr>
<td></td>
<td>• ldap.example.com</td>
</tr>
<tr>
<td></td>
<td>• opends.example.com</td>
</tr>
<tr>
<td>Port</td>
<td>The port on which your directory server is listening. Examples:</td>
</tr>
<tr>
<td></td>
<td>• 389</td>
</tr>
<tr>
<td></td>
<td>• 10389</td>
</tr>
<tr>
<td></td>
<td>• 636 (for example, for SSL)</td>
</tr>
<tr>
<td>Use SSL</td>
<td>Check this if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting.</td>
</tr>
<tr>
<td>Username</td>
<td>The distinguished name of the user that the application will use when connecting to the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• cn=administrator,cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>• cn=user,dc=domain,dc=name</td>
</tr>
<tr>
<td></td>
<td>• <a href="mailto:user@domain.name">user@domain.name</a></td>
</tr>
<tr>
<td></td>
<td><strong>Ensure that this is an administrator user for the LDAP engine. For example, in Active Directory the user will need to be a member of the built-in Administrators group.</strong></td>
</tr>
<tr>
<td>Password</td>
<td>The password of the user specified above.</td>
</tr>
</tbody>
</table>

**Note:** Connecting to an LDAP server requires that this application log in to the server with the username and password configured here. As a result, this password cannot be one-way hashed - it must be recoverable in the context of this application. The password is currently stored in the database in plain text without obfuscation. To guarantee its security, you need to ensure that other processes do not have OS-level read permissions for this application's database or configuration files.
### Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base DN</td>
<td>The root distinguished name (DN) to use when running queries against the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>- o=example,c=com</td>
</tr>
<tr>
<td></td>
<td>- cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>For Microsoft Active Directory, specify the base DN in the following format: <code>dc=domain1,dc=local</code>. You will need to replace the <code>domain1</code> and <code>local</code> for your specific configuration. Microsoft Server provides a tool called <code>idp.exe</code> which is useful for finding out and configuring the the LDAP structure of your server.</td>
</tr>
<tr>
<td>Additional User DN</td>
<td>This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN. Example:</td>
</tr>
<tr>
<td></td>
<td>- ou=Users</td>
</tr>
<tr>
<td>Additional Group DN</td>
<td>This value is used in addition to the base DN when searching and loading groups. If no value is supplied, the subtree search will start from the base DN. Example:</td>
</tr>
<tr>
<td></td>
<td>- ou=Groups</td>
</tr>
</tbody>
</table>

### Permission Settings

**Note:** You can only assign LDAP users to local groups when ‘External Management User Management’ is not selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens.</td>
</tr>
<tr>
<td>Read Only, with Local Groups</td>
<td>LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens. However, you can add groups to the internal directory and add LDAP users to those groups. <strong>Note for Confluence users:</strong> Users from LDAP are added to groups maintained in Confluence's internal directory the first time they log in. This is only done once per user. There is a known issue with Read Only, with Local Groups in Confluence that may apply to you. See <a href="#">CONF-28621 - User Loses all Local Group Memberships if LDAP Sync is Unable to find the User, but the User appears again in subsequent syncs</a> OPEN</td>
</tr>
<tr>
<td>Read/Write</td>
<td>LDAP users, groups and memberships are retrieved from your directory server. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to your LDAP directory server. Please ensure that the LDAP user specified for the application has modification permissions on your LDAP directory server.</td>
</tr>
</tbody>
</table>

### Adding Users to Groups Automatically

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
### Default Group Memberships

Option available in Confluence 3.5 and later, and JIRA 4.3.3 and later. This field appears if you select the 'Read Only, with Local Groups' permission. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas.

**In Confluence 3.5 to Confluence 3.5.1:** Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally.

**In Confluence 3.5.2 and later, and JIRA 4.3.3 and later:** The first time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally. On subsequent logins, the username will not be added automatically to any groups. This change in behaviour allows users to be removed from automatically-added groups. In Confluence 3.5 and 3.5.1, they would be re-added upon next login.

Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name.

**Examples:**

- `confluence-users`
- `confluence-users,jira-users,jira-developers`

### Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Manage User Status Locally</td>
<td>If true, you can activate and deactivate users in Crowd independent of their status in the directory server.</td>
</tr>
<tr>
<td>Use Paged Results</td>
<td>Enable or disable the use of the LDAP control extension for simple paging of search results. If paging is enabled, the search will retrieve sets of data rather than all of the search results at once. Enter the desired page size – that is, the maximum number of search results to be returned per page when paged results are enabled. The default is 1000 results.</td>
</tr>
<tr>
<td>Follow Referrals</td>
<td>Choose whether to allow the directory server to redirect requests to other servers. This option uses the node referral (JNDI lookup <code>java.naming.referal</code>) configuration setting. It is generally needed for Active Directory servers configured without proper DNS, to prevent a 'javax.naming.PartialResultException: Unprocessed Continuation Reference(s)' error.</td>
</tr>
</tbody>
</table>
| Naive DN Matching | If your directory server will always return a consistent string representation of a DN, you can enable naive DN matching. Using naive DN matching will result in a significant performance improvement, so we recommend enabling it where possible. This setting determines how your application will compare DNs to determine if they are equal.  
  - If this checkbox is selected, the application will do a direct, case-insensitive, string comparison. This is the default and recommended setting for Active Directory, because Active Directory guarantees the format of DNs.  
  - If this checkbox is not selected, the application will parse the DN and then check the parsed version. |
Enable incremental synchronisation if you only want changes since the last synchronisation to be queried when synchronising a directory.

⚠️ Please be aware that when using this option, the user account configured for synchronisation must have read access to:

- The `uSNChanged` attribute of all users and groups in the directory that need to be synchronised.
- The objects and attributes in the Active Directory deleted objects container (see Microso ft's Knowledge Base Article No. 892806 for details).

If at least one of these conditions is not met, you may end up with users who are added to (or deleted from) the Active Directory not being respectively added (or deleted) in the application.

This setting is only available if the directory type is set to "Microsoft Active Directory".

### User Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Object Class</td>
<td>This is the name of the class used for the LDAP user object. Example:</td>
</tr>
<tr>
<td></td>
<td>• <code>user</code></td>
</tr>
<tr>
<td>User Object Filter</td>
<td>The filter to use when searching user objects. Example:</td>
</tr>
<tr>
<td></td>
<td>• <code>(&amp; (objectCategory=Person) (sAMAccountName=*))</code></td>
</tr>
<tr>
<td></td>
<td>More examples can be found <a href="#">here</a> and <a href="#">here</a>.</td>
</tr>
<tr>
<td>User Name Attribute</td>
<td>The attribute field to use when loading the username. Examples:</td>
</tr>
<tr>
<td></td>
<td>• <code>cn</code></td>
</tr>
<tr>
<td></td>
<td>• <code>sAMAccountName</code></td>
</tr>
<tr>
<td></td>
<td>NB: In Active Directory, the 'sAMAccountName' is the 'User Logon Name (pre-Windows 2000)' field. The User Logon Name field is referenced by 'cn'.</td>
</tr>
<tr>
<td>User Name RDN Attribute</td>
<td>The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:</td>
</tr>
<tr>
<td></td>
<td>• <code>cn</code></td>
</tr>
</tbody>
</table>
| User First Name Attribute | The attribute field to use when loading the user's first name. Example:  
|                          | • givenName |
| User Last Name Attribute | The attribute field to use when loading the user's last name. Example:  
|                          | • sn |
| User Display Name Attribute | The attribute field to use when loading the user's full name. Example:  
|                          | • displayName |
| User Email Attribute | The attribute field to use when loading the user's email address. Example:  
|                          | • mail |
| User Password Attribute | The attribute field to use when loading a user's password. Example:  
|                          | • unicodePwd |
| User Unique ID Attribute | The attribute used as a unique immutable identifier for user objects. This is used to track username changes and is optional. If this attribute is not set (or is set to an invalid value), user renames will not be detected — they will be interpreted as a user deletion then a new user addition.  
|                          | This should normally point to a UUID value. Standards-compliant LDAP servers will implement this as 'entryUUID' according to RFC 4530. This setting exists because it is known under different names on some servers, e.g. 'objectGUID' in Microsoft Active Directory. |

**Group Schema Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group Object Class       | This is the name of the class used for the LDAP group object. Examples:  
|                          | • groupOfUniqueNames  
|                          | • group |
| Group Object Filter      | The filter to use when searching group objects. Example:  
|                          | • (&(objectClass=group)(cn=*)) |
| Group Name Attribute     | The attribute field to use when loading the group's name. Example:  
|                          | • cn |
| Group Description Attribute | The attribute field to use when loading the group's description. Example:  
|                            | • description |

**Membership Schema Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group Members Attribute  | The attribute field to use when loading the group's members. Example:  
|                          | • member |
User Membership Attribute

The attribute field to use when loading the user's groups. Example:

- `memberOf`

Use the User Membership Attribute, when finding the user's group membership

Check this if your directory server supports the group membership attribute on the user. (By default, this is the 'memberOf' attribute.)

- If this checkbox is selected, your application will use the group membership attribute on the user when retrieving the list of groups to which a given user belongs. This will result in a more efficient retrieval.
- If this checkbox is not selected, your application will use the members attribute on the group ('member' by default) for the search.
- If the Enable Nested Groups checkbox is selected, your application will ignore the Use the User Membership Attribute option and will use the members attribute on the group for the search.

Use the User Membership Attribute, when finding the members of a group

Check this if your directory server supports the user membership attribute on the group. (By default, this is the 'member' attribute.)

- If this checkbox is selected, your application will use the group membership attribute on the user when retrieving the members of a given group. This will result in a more efficient search.
- If this checkbox is not selected, your application will use the members attribute on the group ('member' by default) for the search.

Diagrams of Some Possible Configurations

Diagram above: JIRA connecting to an LDAP directory.
Atlassian applications allow the use of SSL within our products, however Atlassian Support does not provide assistance for configuring it. Consequently, Atlassian cannot guarantee providing any support for it.

- If assistance with conversions of certificates is required, please consult with the vendor who provided the certificate.
- If assistance with configuration is required, please raise a question on Atlassian Answers.

If you want to configure a read/write connection with Microsoft Active Directory, you will need to install an SSL certificate, generated by your Active Directory server, onto your JIRA server and then install the certificate into your JVM keystore.
On this page:
- Prerequisites
- Step 1. Install the Active Directory Certificate Services
- Step 2. Obtain the Server Certificate
- Step 3. Import the Server Certificate

There's a Confluence SSL plugin that facilitates this process.

Updating user, group, and membership details in Active Directory requires that your Atlassian application be running in a JVM that trusts the AD server. To do this, we generate a certificate on the Active Directory server, then import it into Java's keystore.

Prerequisites

To generate a certificate, you need the following components installed on the Windows Domain Controller to which you're connecting.

<table>
<thead>
<tr>
<th>Required Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Information Services (IIS)</td>
<td>This is required before you can install Windows Certificate Services.</td>
</tr>
<tr>
<td>Windows Certificate Services</td>
<td>This installs a certification authority (CA) which is used to issue certificates. Step 1, below, explains this process.</td>
</tr>
<tr>
<td>Windows 2000 Service Pack 2</td>
<td>Required if you are using Windows 2000</td>
</tr>
</tbody>
</table>

Step 1. Install the Active Directory Certificate Services

If Certificate Services are already installed, skip to step 2, below. The screenshots below are from Server 2008, but the process is similar for Server 2000 and 2003.

1. Log in to your Active Directory server as an administrator.
2. Click **Start**, point to **Administrative Tools**, and then click **Server Manager**.
3. In the **Roles Summary** section, click **Add Roles**.
5. On the **Select Role Services** page, select the **Certification Authority** check box, and then click **Next**.
6. On the **Specify Setup Type** page, click **Enterprise**, and then click **Next**.
7. On the **Specify CA Type** page, click **Root CA**, and then click **Next**.
8. On the **Set Up Private Key** and **Configure Cryptography for CA** pages, you can configure optional configuration settings, including cryptographic service providers. However, the default values should be
9. In the **Common name for this CA** box, type the common name of the CA, and then click **Next**.
10. On the Set Validity Period page, accept the default values or specify other storage locations for the certificate database and the certificate database log, and then click Next.
11. After verifying the information on the Confirm Installation Selections page, click Install.
12. Review the information on the results screen to verify that the installation was successful.
Step 2. Obtain the Server Certificate

The steps above describe how to install the certification authority (CA) on your Microsoft Active Directory server. Next, you will need to add the Microsoft Active Directory server’s SSL certificate to the list of accepted certificates used by the JDK that runs your application server.

The Active Directory certificate is automatically generated and placed in root of the C:\ drive, matching a file format similar to the tree structure of your Active Directory server. For example: c:\ad2008.ad01.atlassian.com_ad01.crt.

You can also export the certificate by executing this command on the Active Directory server:

```
certutil -ca.cert client.crt
```

You might still fail in being authenticated with the certificate file above. In this case, Microsoft's LDAP over SSL (LDAPS) Certificate page might help. Be noted that you need:

1. to choose “No, do not export the private key” in step-10 of Exporting the LDAPS Certificate and Importing for use with AD DS section
2. to choose “DER encoded binary X.509 (.CER)” in step-11 of Exporting the LDAPS Certificate and Importing for use with AD DS section. This file will be used in the following step.

Step 3. Import the Server Certificate

For an application server to trust your directory’s certificate, the certificate must be imported into your Java runtime environment. The JDK stores trusted certificates in a file called a keystore. The default keystore file is called cacerts and it lives in the jre\lib\security sub-directory of your Java installation.

In the following examples, we use server-certificate.crt to represent the certificate file exported by your directory server. You will need to alter the instructions below to match the name actually generated.

Once the certificate has been imported as per the below instructions, you will need to restart the application to
pick up the changes.

Windows

1. Navigate to the directory in which Java is installed. It's probably called something like C:\Program Files\Java\jdk1.5.0_12.

   ```
   cd /d C:\Program Files\Java\jdk1.5.0_12
   ```

2. Run the command below, where server-certificate.crt is the name of the file from your directory server:

   ```
   keytool -import -keystore .\jre\lib\security\cacerts -file server-certificate.crt
   ```

3. keytool will prompt you for a password. The default keystore password is changeit.

4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

   Enter keystore password: changeit
   Owner: CN=ad01, C=US
   Issuer: CN=ad01, C=US
   Serial number: 15563d6677a4e9e4582d8a84be683f9
   Certificate fingerprints:
   Trust this certificate? [no]: yes
   Certificate was added to keystore

You may now change 'URL' to use LDAP over SSL (i.e. ldaps://<HOSTNAME>:636/) and use the 'Secure SSL' option when connecting your application to your directory server.

UNIX

1. Navigate to the directory in which the Java used by JIRA is installed. If the default JAVA installation is used, then it would be

   ```
   cd $JAVA_HOME
   ```

2. Run the command below, where server-certificate.crt is the name of the file from your directory server:

   ```
   sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt
   ```

3. keytool will prompt you for a password. The default keystore password is changeit.

4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:
Password:
Enter keystore password: changeit
Owner: CN=ad01, C=US
Issuer: CN=ad01, C=US
Serial number: 15563d6677a4e9e4582d8a84be683f9
Valid from: Tue Aug 21 01:10:46 ACT 2007 until: Tue Aug 21 01:13:59
ACT 2012
Certificate fingerprints:
   SHA1:
Trust this certificate? [no]: yes
Certificate was added to keystore

You may now change ‘URL’ to use LDAP over SSL (i.e. ldaps://<HOSTNAME>:636/) and use the ‘Secure SSL’ option when connecting your application to your directory server.

Mac OS X

1. Navigate to the directory in which Java is installed. This is usually
   
   cd /Library/Java/Home

2. Run the command below, where server-certificate.crt is the name of the file from your directory server:
   
   sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt

3. keytool will prompt you for a password. The default keystore password is changeit.
4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

Password:
Enter keystore password: changeit
Owner: CN=ad01, C=US
Issuer: CN=ad01, C=US
Serial number: 15563d6677a4e9e4582d8a84be683f9
Valid from: Tue Aug 21 01:10:46 ACT 2007 until: Tue Aug 21 01:13:59
ACT 2012
Certificate fingerprints:
   SHA1:
Trust this certificate? [no]: yes
Certificate was added to keystore

You may now change ‘URL’ to use LDAP over SSL (i.e. ldaps://<HOSTNAME>:636/) and use the ‘Secure SSL’ option when connecting your application to your directory server.

RELATED TOPICS
  Connecting to an LDAP Directory
  Configuring User Directories
Reduce the number of users synchronised from LDAP to JIRA

If you have connected JIRA to an LDAP directory for authentication, user and group management, you may want to configure JIRA to synchronise a subset of users from LDAP rather than all users. There are two reasons for why you might make this change:

- Improving performance — If you have performance issues during synchronisation process, you may be able to improve this by synchronising a subset of data instead. See this knowledge base article for more information: Performance Issues with Large LDAP Repository - 100,000 users or more.
- Reducing your user count (not recommended) — You can synchronise a subset of users to JIRA from LDAP to reduce your user count. This will allow you to count less users against your JIRA license. However, synchronising a subset of users to JIRA from LDAP is not the recommended method for reducing your user count in JIRA.

Procedure

The procedure for configuring JIRA to synchronise a different number of users from LDAP depends on how you initially set up your LDAP directory. For example, if you have all your JIRA users in one organisational unit and your non-JIRA users in another organisational unit, then you can simply configure JIRA to only synchronise users against a particular DN (distinguished name). However, if your setup is not so simple (e.g. you have your JIRA users and non-JIRA users in the same node), you will need to define an LDAP filter to synchronise the relevant users. Both of these methods are outlined below.

Synchronising against Base DN, Additional User DN and Additional Group DN

1. Log in as a user with the JIRA Administrators global permission.
2. Select Administration > Users > User Directories.
   - Keyboard shortcut: g + g + start typing directories.
3. Update the Base DN field, and optionally the Additional User DN and/or Additional Group DN to query against the directory server as desired.
   - For example, if you have configured all of your JIRA users in the jira-users organisational unit only, for your company at mycompany.example.com, your configuration would look like this:
     - Base DN — dc=mycompany,dc=example,dc=com
     - Additional Group DN — ou=jira-users

Defining an LDAP filter

1. Log in as a user with the JIRA Administrators global permission.
   Select Administration > Users > User Directories.
   - Keyboard shortcut: g + g + start typing directories
2. Update User Object Filter and/or Group Object Filter fields as desired. The syntax for LDAP filters is not simple and your query will depend on how you have set up your LDAP directory.
   - For example, if you have configured only JIRA groups to have 'jira' in the CN, you can use a wildcard search in your filter to find them by setting the Group Object Filter = (objectCategory=group)(cn= *jira*)

   More information on defining LDAP filters is available in the pages linked in the Related Topics section below.

Related topics:

- Performance Issues with Large LDAP Repository - 100,000 users or more
- Unable to Create Issues Due to Exceeded License
- How to write LDAP search filters
- MSDN guide to LDAP search filter syntax
- Connecting to an Internal Directory with LDAP Authentication

You can connect your JIRA application to an LDAP directory for delegated authentication. This means that JIRA will have an internal directory that uses LDAP for authentication only. There is an option to create users in the internal directory automatically when they attempt to log in, as described in the settings section.

Overview
An internal directory with LDAP authentication offers the features of an internal directory while allowing you to store and check users' passwords in LDAP only. Note that the 'internal directory with LDAP authentication' is separate from the default 'internal directory'. On LDAP, all that the application does is to check the password. The LDAP connection is read only. Every user in the internal directory with LDAP authentication must map to a user on LDAP, otherwise they cannot log in.

When to use this option: Choose this option if you want to set up a user and group configuration within your application that suits your needs, while checking your users' passwords against the corporate LDAP directory. This option also helps to avoid the performance issues that may result from downloading large numbers of groups from LDAP.

Connecting JIRA to an Internal Directory with LDAP Authentication

To connect to an internal directory but check logins via LDAP:

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose > User Management > User Directories.  
   Keyboard shortcut: 'g' + 'g' + start typing 'directories'.
3. Add a directory and select type 'Internal with LDAP Authentication'.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. We recommend that the 'Internal Directory with LDAP Authentication' is at the top of the list. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   For details see Managing Multiple Directories.
7. Add your users and groups in JIRA. See Managing Users and Managing Groups.

Server Settings

Note: The option to select a directory type is available only in JIRA 4.3.3 and later.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name that will help you to identify the directory. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Internal directory with LDAP Authentication</td>
</tr>
<tr>
<td></td>
<td>• Corporate LDAP for Authentication Only</td>
</tr>
</tbody>
</table>
| Directory Type | Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for some of the options on the rest of screen. Examples:  
• Microsoft Active Directory  
• OpenDS  
• And more. |
| Hostname | The host name of your directory server. Examples:  
• ad.example.com  
• ldap.example.com  
• opensds.example.com |
| Port | The port on which your directory server is listening. Examples:  
• 389  
• 10389  
• 636 (for example, for SSL) |
| Use SSL | Check this box if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting. |
| Username | The distinguished name of the user that the application will use when connecting to the directory server. Examples:  
• cn=administrator,cn=users,dc=ad,dc=example,dc=com  
• cn=user,dc=domain,dc=name  
• user@domain.name |
| Password | The password of the user specified above. |

**Copying Users on First Login**

*Note:* The option to copy users on first login is available only in JIRA 4.3.3 and later. It currently copies the data across whenever a user logs in, as per the bug

[JIRA-27541](https://issues.atlassian.com/browse/JIRA-27541) - Delegated LDAP copy user on first login problem [RESOLVED](https://issues.atlassian.com/browse/JIRA-27541). |

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy User on Login | This option affects what will happen when a user attempts to log in. If this box is checked, the user will be created automatically in the internal directory that is using LDAP for authentication when the user first logs in and their details will be synchronised on each subsequent log in. If this box is not checked, the user's login will fail if the user wasn't already manually created in the directory.  
If you check this box the following additional fields will appear on the screen, which are described in more detail below:  
• Default Group Memberships  
• Synchronise Group Memberships  
• User Schema Settings (described in a separate section below) |
### Default Group Memberships
This field appears if you check the **Copy User on Login** box. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas. Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added to the internal directory that is using LDAP for authentication.

Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name.

**Examples:**
- confluence-users
- bamboo-users, jira-users, jira-developers

### Synchronise Group Memberships
This field appears if you select the **Copy User on Login** checkbox. If this box is checked, group memberships specified on your LDAP server will be synchronised with the internal directory each time the user logs in.

If you check this box the following additional fields will appear on the screen, both described in more detail below:
- Group Schema Settings (described in a separate section below)
- Membership Schema Settings (described in a separate section below)

### Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Base DN</strong></td>
<td>The root distinguished name (DN) to use when running queries against the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>- o=example,c=com</td>
</tr>
<tr>
<td></td>
<td>- cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>- For Microsoft Active Directory, specify the base DN in the following format: dc=domain1,dc=local. You will need to replace the domain1 and local for your specific configuration. Microsoft Server provides a tool called ldp.exe which is useful for finding out and configuring the the LDAP structure of your server.</td>
</tr>
<tr>
<td><strong>User Name Attribute</strong></td>
<td>The attribute field to use when loading the username. Examples:</td>
</tr>
<tr>
<td></td>
<td>- cn</td>
</tr>
<tr>
<td></td>
<td>- sAMAccountName</td>
</tr>
</tbody>
</table>

### User Schema Settings (Used when Copying Users on First Login)

**Note:** The **user schema settings** are available only in JIRA 4.3.3 and later.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Additional User DN</strong></td>
<td>This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN. Example:</td>
</tr>
<tr>
<td></td>
<td>- ou=Users</td>
</tr>
<tr>
<td><strong>User Object Class</strong></td>
<td>This is the name of the class used for the LDAP user object. Example:</td>
</tr>
<tr>
<td></td>
<td>- user</td>
</tr>
<tr>
<td><strong>User Object Filter</strong></td>
<td>The filter to use when searching user objects. Example:</td>
</tr>
<tr>
<td></td>
<td>- (&amp;(objectCategory=Person)(sAMAccountName=*))</td>
</tr>
<tr>
<td>User Name RDN Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:</td>
<td></td>
</tr>
<tr>
<td>* cn *</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User First Name Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The attribute field to use when loading the user's first name. Example:</td>
<td></td>
</tr>
<tr>
<td>* givenName *</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Last Name Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The attribute field to use when loading the user’s last name. Example:</td>
<td></td>
</tr>
<tr>
<td>* sn *</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Display Name Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The attribute field to use when loading the user’s full name. Example:</td>
<td></td>
</tr>
<tr>
<td>* displayName *</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Email Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The attribute field to use when loading the user’s email address. Example:</td>
<td></td>
</tr>
<tr>
<td>* mail *</td>
<td></td>
</tr>
</tbody>
</table>

**Group Schema Settings (Used when enabling Synchronise Group Memberships)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Object Class</td>
<td>This is the name of the class used for the LDAP group object. Examples:</td>
</tr>
<tr>
<td>* groupOfUniqueNames *</td>
<td></td>
</tr>
<tr>
<td>* group *</td>
<td></td>
</tr>
<tr>
<td>Group Object Filter</td>
<td>The filter to use when searching group objects. Example:</td>
</tr>
<tr>
<td>* (&amp;(objectClass=group)(cn=*)) *</td>
<td></td>
</tr>
<tr>
<td>Group Name Attribute</td>
<td>The attribute field to use when loading the group’s name. Example:</td>
</tr>
<tr>
<td>* cn *</td>
<td></td>
</tr>
<tr>
<td>Group Description Attribute</td>
<td>The attribute field to use when loading the group’s description. Example:</td>
</tr>
<tr>
<td>* description *</td>
<td></td>
</tr>
</tbody>
</table>

**Diagrams of Possible Configurations**
Diagram above: JIRA connecting to an LDAP directory for authentication only.

Diagram above: JIRA connecting to an LDAP directory for authentication only, with each user copied to the internal directory when they first log in to JIRA.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
• Managing Multiple Directories
• Synchronising Data from External Directories
• Managing Nested Groups
• Diagrams of Possible Configurations for User Management
• User Management Limitations and Recommendations
• Allowing Other Applications to Connect to JIRA for User Management
• Migrating Users between User Directories

Connecting to Crowd or Another JIRA Server for User Management

You can connect your JIRA application to Atlassian Crowd or to another JIRA server (version 4.3 or later) for management of users and groups, and for authentication (verification of a user’s login).

**On this page:**

- Connecting JIRA to Crowd
- Connecting JIRA to Another JIRA Server
- Diagrams of Some Possible Configurations

**Connecting JIRA to Crowd**

Atlassian Crowd is an application security framework that handles authentication and authorisation for your web-based applications. With Crowd you can integrate multiple web applications and user directories, with support for single sign-on (SSO) and centralised identity management. The Crowd Administration Console provides a web interface for managing directories, users and their permissions. See the [Crowd Administration Guide](#).

**When to use this option:** Connect to Crowd if you want to use the full Crowd functionality to manage your directories, users and groups. You can connect your Crowd server to a number of directories of all types that Crowd supports, including custom directory connectors.

**To connect JIRA to Crowd:**

1. Go to your [Crowd Administration Console](#) and define the JIRA application to Crowd. See the Crowd documentation: [Adding an Application](#).
2. Log in to JIRA as a user with the ‘JIRA Administrators’ global permission.
3. Choose > User Management > User Directories. **Keyboard shortcut:** `g` + `g` + start typing ‘directories’.  
4. Add a directory and select type ‘Atlassian Crowd’. Enter the settings as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   For details see [Managing Multiple Directories](#).
7. If required, configure JIRA to use Crowd for single sign-on (SSO) too. See the Crowd documentation: [Integrating Crowd with Atlassian JIRA](#).

**Notes:**

- If you have JIRA-Crowd-LDAP, every time user logs in (i.e. first and subsequent times), the user's data in JIRA/Crowd will be updated from the user's data in LDAP. This includes username, display name, email and group memberships. However for group memberships, only the following applies:
  - direct groups only (i.e. not nested groups) are synchronised from LDAP.
  - only groups that are already present in JIRA are synchronised, i.e. groups are not added/removed, and group hierarchies are not synchronised.

**Settings in JIRA for the Crowd Directory Type**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

---

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this Crowd server amongst your list of directory servers. Examples: Crowd Server, Example Company Crowd</td>
</tr>
<tr>
<td>Server URL</td>
<td>The web address of your Crowd console server. Examples: <a href="http://www.example.com:8095/crowd/">http://www.example.com:8095/crowd/</a>, <a href="http://crowd.example.com">http://crowd.example.com</a></td>
</tr>
<tr>
<td>Application Name</td>
<td>The name of your application, as recognised by your Crowd server. Note that you will need to define the application in Crowd too, using the Crowd administration Console. See the Crowd documentation on adding an application.</td>
</tr>
<tr>
<td>Application Password</td>
<td>The password which the application will use when it authenticates against the Crowd framework as a client. This must be the same as the password you have registered in Crowd for this application. See the Crowd documentation on adding an application.</td>
</tr>
</tbody>
</table>

**Crowd Permissions**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd and can only be modified via Crowd. You cannot modify Crowd users, groups or memberships via the application administration screens.</td>
</tr>
<tr>
<td>Read/Write</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to Crowd. Please ensure that the application has modification permissions for the relevant directories in Crowd. See the Crowd documentation: Specifying an Application's Directory Permissions.</td>
</tr>
</tbody>
</table>

**Advanced Crowd Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Before enabling nested groups, please check to see if the user directory or directories in Crowd support nested groups. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Synchronisation Interval (minutes)</td>
<td>Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where ‘x’ is the number specified here. The default value is 60 minutes.</td>
</tr>
</tbody>
</table>

**Connecting JIRA to Another JIRA Server**

Subject to certain limitations, you can connect a number of Atlassian web applications to a single JIRA server for centralised user management.

**When to use this option**: You can only connect to a server running JIRA 4.3 or later. Choose this option as an alternative to Atlassian Crowd, for simple configurations with a limited number of users.

Let's assume that you have two JIRA servers, called for example 'JIRA site 1' and 'JIRA site 2'. You want JIRA site 2 to manage your users and groups. JIRA site 1 will delegate user management to JIRA site 2.

**To connect JIRA site 1 to use JIRA site 2 for user management:**

1. Configure JIRA site 2 to recognise JIRA site 1:
   - Log in to JIRA site 2 as a user with the 'JIRA Administrators' global permission.
   
   Keyboard shortcut: 'g' + 'g' + start typing 'jira user'.

   Add an application.

   Enter the application name and password that JIRA site 1 will use when accessing JIRA site 2.

   Enter the IP address or addresses of JIRA site 1. Valid values are:
   
   - A full IP address, e.g. 192.168.10.12.
   - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to CIDR notation on Wikipedia and RFC 4632.

   Save the new application.

2. Configure JIRA site 1 to delegate user management:

   Log in to JIRA site 1 as a user with the 'JIRA Administrators' global permission.

   Choose > User Management > User Directories.

   Keyboard shortcut: 'g' + 'g' + start typing 'directories'.

   Add a directory and select type 'Atlassian JIRA'.

   Enter the settings as described below. When asked for the application name and password, enter the values that you defined in the settings on JIRA site 2.

   Save the directory settings.

   Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

   For details see Managing Multiple Directories.

### Settings for the JIRA Directory Type

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this JIRA server amongst your list of directory servers. Examples:</td>
</tr>
<tr>
<td></td>
<td>- JIRA Server</td>
</tr>
<tr>
<td></td>
<td>- My Company JIRA</td>
</tr>
<tr>
<td>Server URL</td>
<td>The web address of your JIRA server. Examples:</td>
</tr>
<tr>
<td></td>
<td>- <a href="http://www.example.com:8080">http://www.example.com:8080</a></td>
</tr>
<tr>
<td></td>
<td>- <a href="http://jira.example.com">http://jira.example.com</a></td>
</tr>
<tr>
<td>Application Name</td>
<td>The name used by your application when accessing the JIRA server that acts as user manager. Note that you will also need to define your application to that JIRA server, via the 'Other Applications' option in the 'Users, Groups &amp; Roles' section of the 'Administration' menu.</td>
</tr>
<tr>
<td>Application Password</td>
<td>The password used by your application when accessing the JIRA server that acts as user manager.</td>
</tr>
</tbody>
</table>

### Permissions for the JIRA Directory Type

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from the JIRA server that is acting as user manager. They can only be modified via that JIRA server.</td>
</tr>
</tbody>
</table>

### Advanced Settings for the JIRA Directory Type

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
Enable Nested Groups

Enable or disable support for nested groups. Before enabling nested groups, please check to see if nested groups are enabled on the JIRA server that is acting as user manager. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.

Synchronisation Interval (minutes)

Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where 'x' is the number specified here. The default value is 60 minutes.

Diagrams of Some Possible Configurations

Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.
Diagram above: One JIRA site connecting to another for user management. JIRA site 2 does the user management, storing the user data in its internal directory.
Diagram above: A number of applications connecting to JIRA (site 2) for user management, with JIRA in turn connecting to an LDAP server.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Multiple Directories
- Synchronising Data from External Directories
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Allowing Other Applications to Connect to JIRA for User Management
- Migrating Users between User Directories

Managing Multiple Directories

This page describes what happens when you have defined more than one user directory in JIRA. For example, you may have an internal directory and you may also connect to an LDAP directory server and/or other types of user directories. When you connect to a new directory server, you also need to define the directory order.
Avoid duplicate usernames across directories. If you are connecting to more than one user directory, we recommend that you ensure the usernames are unique to one directory. For example, we do not recommend that you have a user jsmith in both 'Directory1' and 'Directory2'. The reason is the potential for confusion, especially if you swap the order of the directories. Changing the directory order can change the user that a given username refers to.

Here is a summary of how the directory order affects the processing:
- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

On this page:
- Configuring the Directory Order
- Effect of Directory Order
  - Login
  - Permissions
  - Updating Users and groups

Configuring the Directory Order

You can change the order of your directories as defined to JIRA. Select 'User Directories' from the JIRA administration menu and click the blue up- and down-arrows next to each directory.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Type</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA Internal Directory</td>
<td>Internal</td>
<td></td>
</tr>
<tr>
<td>LDAP server</td>
<td>OpenLDAP (Read-Write)</td>
<td></td>
</tr>
</tbody>
</table>

Notes:
- Please read the rest of this page to understand what effect the directory order will have on authentication (login) and permissions in JIRA, and what happens when you update users and groups in JIRA.

Effect of Directory Order

This section summarises the effect the order of the directories will have on login and permissions, and on the updating of users and groups.

Login

The directory order is significant during the authentication of the user, in cases where the same user exists in multiple directories. When a user attempts to log in, the application will search the directories in the order specified, and will use the credentials (password) of the first occurrence of the user to validate the login attempt.

Permissions

The directory order is significant when granting the user permissions based on group membership. If the same username exists in more than one directory, the application will look for group membership only in the first directory where the username appears, based on the directory order.

Example:
- You have connected two directories: The Customers directory and the Partners directory.
- The Customers directory is first in the directory order.
- A username jsmith exists in both the Customers directory and the Partners directory.
- The user jsmith is a member of group G1 in the Customers directory and group G2 in the Partners directory.
- The user jsmith will have permissions based on membership of G1 only, not G2.
Updating Users and groups

If you update a user or group via the application's administration screens, the update will be made in the first directory where the application has write permissions.

Example 1:

- You have connected two directories: The Customers directory and the Partners directory.
- The application has permission to update both directories.
- The Customers directory is first in the directory order.
- A username `j smith` exists in both the Customers directory and the Partners directory.
- You update the email address of user `j smith` via the application's administration screens.
- The email address will be updated in the Customers directory only, not the Partners directory.

Example 2:

- You have connected two directories: A read/write LDAP directory and the internal directory.
- The LDAP directory is first in the directory order.
- All new users will be added to the LDAP directory. It is not possible to add a new user to the internal directory.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Multiple Directories
- Synchronising Data from External Directories
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Allowing Other Applications to Connect to JIRA for User Management
- Migrating Users between User Directories

Synchronising Data from External Directories

For certain directory types, JIRA stores a cache of directory information (users and groups) in the application database, to ensure fast recurrent access to user and group data. A synchronisation task runs periodically to update the internal cache with changes from the external directory.

On this page:

- Affected Directory Types
- How it Works
- Finding the Time Taken to Synchronise
- Manually Synchronising the Cache
- Configuring the Synchronisation Interval

Affected Directory Types

Data caching and synchronisation apply to the following user directory types:

- **LDAP** (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read only.
- **LDAP** (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read only, with local groups.
- **LDAP** (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read/write.
- Atlassian Crowd.
- Atlassian JIRA.

Data caching and synchronisation do not occur for the following user directory types:

- **LDAP** (Microsoft Active Directory and all supported LDAP directories) where permissions are set to authentication only, with local groups.
- Internal Directory with LDAP Authentication.
Internal Directory.

How it Works

Here is a summary of the caching functionality:

- The caches are held in the application database.
- When you connect a new external user directory to the application, a synchronisation task will start running in the background to copy all the required users, groups and membership information from the external directory to the application database. This task may take a while to complete, depending on the size and complexity of your user base.
- Note that a user will not be able to log in until the synchronisation task has copied that user’s details into the cache.
- A periodic synchronisation task will run to update the database with any changes made to the external directory. The default synchronisation interval, or polling interval, is one hour (60 minutes). You can change the synchronisation interval on the directory configuration screen.
- You can manually synchronise the cache if necessary.
- If the external directory permissions are set to read/write: Whenever an update is made to the users, groups or membership information via the application, the update will also be applied to the cache and the external directory immediately.
- All authentication happens via calls to the external directory. When caching information from an external directory, the application database does not store user passwords.
- All other queries run against the internal cache.

Finding the Time Taken to Synchronise

The ‘User Directories’ screen shows information about the last synchronisation operation, including the length of time it took.

Manually Synchronising the Cache

You can manually synchronise the cache by clicking ‘Synchronise’ on the ‘User Directories’ screen. If a synchronisation operation is already in progress, you cannot start another until the first has finished.

Configuring the Synchronisation Interval

You can set the ‘Synchronisation Interval’ on the directory configuration screen. The synchronisation interval is the period of time to wait between requests for updates from the directory server.

The length you choose for your synchronisation interval depends on:

- The length of time you can tolerate stale data.
- The amount of load you want to put on the application and the directory server.
- The size of your user base.

If you synchronise more frequently, then your data will be more up to date. The downside of synchronising more frequently is that you may overload your server with requests.

If you are not sure what to do, we recommend that you start with an interval of 60 minutes (this is the default setting) and reduce the value incrementally. You will need to experiment with your setup.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
Connecting to Crowd or Another JIRA Server for User Management
Managing Multiple Directories
Synchronising Data from External Directories
Managing Nested Groups
Diagrams of Possible Configurations for User Management
User Management Limitations and Recommendations
Allowing Other Applications to Connect to JIRA for User Management
Migrating Users between User Directories

Managing Nested Groups

Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.

This page describes how JIRA handles nested groups that exist in one or more of your directory servers.

Enabling Nested Groups

You can enable or disable support for nested groups on each directory individually. Select 'User Directories' from the JIRA administration menu, edit the directory and select 'Enable Nested Groups'. See Configuring User Directories.

Notes:

- Before enabling nested groups for a specific directory type in JIRA, please make sure that your directory server supports nested groups.
- Please read the rest of this page to understand what effect nested groups will have on authentication (login) and permissions in JIRA, and what happens when you update users and groups in JIRA.

Effect of Nested Groups

This section summarises the effect nested groups will have on login and permissions, and on the viewing and updating of users and groups.

Login

When a user logs in, they will be allowed access to the application if they belong to an authorised group or any of its sub-groups.

Permissions

The user will be allowed access to a function if they belong to a group that has the necessary permissions, or if they belong to any of its sub-groups.

Viewing Lists of Group Members

If you ask to view the members of a group, you will see all users who are members of the group and all users belonging its sub-groups, consolidated into one list. We call this a 'flattened' list.

You cannot view or edit the nested groups themselves. You will not be able to see that one group is a member of another group.
Adding and Updating Group Memberships

If you add a user to a group, the user is added to the named group and not to any other groups.

If you try to remove a user from a flattened list, the following will happen:

- If the user is a member of the top group in the hierarchy (tree) of groups contained in the flattened list, the user will be removed from the group.
- Otherwise, you will see an error message stating that the user is not a direct member of the group.

**Examples**

**Example 1: User is Member of Sub-Group**

Let's assume that the following two groups exist in your directory server:

- staff
- marketing

Memberships:

- The marketing group is a member of the staff group.
- User jsmith is a member of marketing.

You will see that jsmith is a member of both marketing and staff. You will not see that the two groups are nested. If you assign permissions to the staff group, then jsmith will get those permissions.

**Example 2: Sub-Groups as Members of the 'jira-developers' group**

In an LDAP directory server, we have groups 'engineering-group' and 'techwriters-group'. We want to grant both groups developer-level access to our JIRA site.

- Add a group called 'jira-developers'.
- Add the 'engineering-group' as a sub-group of 'jira-developers'.
- Add the 'techwriters-group' as a sub-group of 'jira-developers'.

Group memberships are now:

- jira-developers — sub-groups: engineering-group, techwriters-group
- engineering-group — sub-groups: dev-a, dev-b; users: pblack
- dev-a — users: jsmith, sbrown
- dev-b — users: jsmith, dblue
- techwriters-group — users: rgreen

When JIRA requests a list of users in the 'jira-developers' group, it will receive the following list:

- pblack
- jsmith
- sbrown
- dblue
- rgreen

*Diagram: Sub-groups as members of the 'jira-developers' group*
Example 3: Sub-Groups as Members of the ‘confluence-users’ group

In an LDAP directory server, we have groups ‘engineering-group’ and ‘payroll-group’. We want to grant both groups access to our Confluence site.

- Add a group called ‘confluence-users’.
- Add the ‘engineering-group’ as a sub-group of ‘confluence-users’.
- Add the ‘payroll-group’ as a sub-group of ‘confluence-users’.

Group memberships are now:

- confluence-users — sub-groups: engineering-group, payroll-group
- engineering-group — sub-groups: dev-a, dev-b; users: pblack
- dev-a — users: jsmith, sbrown
- dev-b — users: jsmith, dblue
- payroll-group — users: rgreen

When Confluence requests a list of users in the ‘confluence-users’ group, it will receive the following list:

- pblack
- jsmith
- sbrown
- dblue
- rgreen
Notes

- Possible impact on performance. Enabling nested groups may result in slower user searches.

- Definition of nested groups in LDAP. In an LDAP directory, a nested group is defined as a child group entry whose DN (Distinguished Name) is referenced by an attribute contained within a parent group entry. For example, a parent group ‘Group One’ might have an objectClass=group attribute and one or more member=DN attributes, where the DN can be that of a user or that of a group elsewhere in the LDAP tree:

```plaintext
member=CN=John Smith,OU=Users,OU=OrgUnitA,DC=sub,DC=domain
member=CN=Group Two,OU=OrgUnitBGroups,OU=OrgUnitB,DC=sub,DC=domain
```

RELATED TOPICS

Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Multiple Directories
- Synchronising Data from External Directories
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Allowing Other Applications to Connect to JIRA for User Management
- Migrating Users between User Directories
Diagrams of Possible Configurations for User Management

The aim of these diagrams is to help people understand each directory type at a glance. We have kept the diagrams simple and conceptual, with just enough information to be correct.

Some things that we do not attempt to show:

- In most cases, we do not attempt to show that you can have multiple directory types mapped to JIRA at the same time. We illustrate that fact in just the first two LDAP diagrams.
- We have not included a diagram for Confluence's legacy connection to JIRA database.
- We do not attempt to show all of the possible configurations and layered connections that are available now that you can use JIRA as a directory manager.

On this page:
- JIRA Internal Directory
- JIRA with Read/Write Connection to LDAP
- JIRA with Read-Only Connection to LDAP, with Local Groups
- JIRA Internal Directory with LDAP Authentication
- JIRA with LDAP Authentication, Copy Users on First Login
- One JIRA Site Connecting to Another
- Confluence and JIRA Connecting to Crowd
- A Number of Applications Connecting to JIRA

**JIRA Internal Directory**

![Diagram of JIRA Internal Directory]

Diagram above: JIRA using its internal directory for user management.

**JIRA with Read/Write Connection to LDAP**
Diagram above: JIRA connecting to an LDAP directory.

**JIRA with Read-Only Connection to LDAP, with Local Groups**

Diagram above: JIRA connecting to an LDAP directory with permissions set to read only and local groups.
**JIRA Internal Directory with LDAP Authentication**

Diagram above: JIRA connecting to an LDAP directory for authentication only.

**JIRA with LDAP Authentication, Copy Users on First Login**

Diagram above: JIRA connecting to an LDAP directory for authentication only, with each user copied to the internal directory when they first log in to JIRA.

*One JIRA Site Connecting to Another*
Diagram above: One JIRA site connecting to another for user management. JIRA site 2 does the user management, storing the user data in its internal directory.

Confluence and JIRA Connecting to Crowd
Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.

A Number of Applications Connecting to JIRA
Diagram above: A number of applications connecting to JIRA (site 2) for user management, with JIRA in turn connecting to an LDAP server.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Multiple Directories
- Synchronising Data from External Directories
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Allowing Other Applications to Connect to JIRA for User Management
- Migrating Users between User Directories

User Management Limitations and Recommendations

This page describes the optimal configurations and limitations that apply to user management in JIRA.
General Recommendations

- Avoid duplicate usernames across directories. If you are connecting to more than one user directory, we recommend that you ensure the usernames are unique to one directory. For example, we do not recommend that you have a user jsmith in both 'Directory1' and 'Directory2'. The reason is the potential for confusion, especially if you swap the order of the directories. Changing the directory order can change the user that a given username refers to.

- Be careful when deleting users in remote directories. If you are connecting to an LDAP directory, a Crowd directory or a remote JIRA directory, please take care when deleting users from the remote directory. If you delete a user that is associated with data in JIRA, this will cause problems in JIRA. We recommend that you perform all user management in JIRA, because the JIRA UI will prevent the deletion of a user if there are issues assigned to the user, reported by the user or the user is a project lead.

Recommendations for Connecting to LDAP

Please consider the following limitations and recommendations when connecting to an LDAP user directory.

Optimal Number of Users and Groups in your LDAP Directory

The connection to your LDAP directory provides powerful and flexible support for connecting to, configuring and managing LDAP directory servers. To achieve optimal performance, a background synchronisation task loads the required users and groups from the LDAP server into the application's database, and periodically fetches updates from the LDAP server to keep the data in step. The amount of time needed to copy the users and groups rises with the number of users, groups, and group memberships. For that reason, we recommended a maximum number of users and groups as described below.

This recommendation affects connections to LDAP directories:

- Microsoft Active Directory
- All other LDAP directory servers

The following LDAP configurations are not affected:

- Internal directories with LDAP authentication
- LDAP directories configured for 'Authentication Only, Copy User On First Login'

Please choose one of the following solutions, depending on the number of users, groups and memberships in your LDAP directory.

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 10 000 (ten thousand) users, 1000 (one thousand) groups, and 20 (twenty) groups per user</td>
<td>Choose the ‘LDAP’ or ‘Microsoft Active Directory’ directory type. You can make use of the full synchronisation option. Your application’s database will contain all the users and groups that are in your LDAP server.</td>
</tr>
<tr>
<td>More than the above</td>
<td>Use LDAP filters to reduce the number of users and groups visible to the synchronisation task.</td>
</tr>
</tbody>
</table>

Our Test Results

We performed internal testing of synchronisation with an AD server on our local network consisting of 10 000 users, 1000 groups and 200 000 memberships.

We found that the initial synchronisation took about 5 minutes. Subsequent synchronisations with 100 modifications on the AD server took a couple of seconds to complete.

Please keep in mind that a number of factors come into play when trying to tune the performance of the
synchronisation process, including:

- **Size of userbase.** Use LDAP filters to keep this to the minimum that suits your requirements.
- **Type of LDAP server.** We currently support change detection in AD, so subsequent synchronisations are much faster for AD than for other LDAP servers.
- **Network topology.** The further away your LDAP server is from your application server, the more latent LDAP queries will be.
- **Database performance.** As the synchronisation process caches data in the database, the performance of your database will affect the performance of the synchronisation.
- **JVM heap size.** If your heap size is too small for your userbase, you may experience heavy garbage collection during the synchronisation process which could in turn slow down the synchronisation.

**Redundant LDAP is Not Supported**

The LDAP connections do not support the configuration of two or more LDAP servers for redundancy (automated failover if one of the servers goes down).

**Specific Notes for Connecting to Active Directory**

When the application synchronises with Active Directory (AD), the synchronisation task requests only the changes from the LDAP server rather than the entire user base. This optimises the synchronisation process and gives much faster performance on the second and subsequent requests.

On the other hand, this synchronisation method results in a few limitations:

1. **Externally moving objects out of scope or renaming objects causes problems in AD.** If you move objects out of scope in AD, this will result in an inconsistent cache. We recommend that you do not use the external LDAP directory interface to move objects out of the scope of the sub-tree, as defined on the application's directory configuration screen. If you do need to make structural changes to your LDAP directory, manually synchronise the directory cache after you have made the changes to ensure cache consistency.
2. **Synchronising between AD servers is not supported.** Microsoft Active Directory does not replicate the uSNCNChanged attribute across instances. For that reason, we do not support connecting to different AD servers for synchronisation. (You can of course define multiple different directories, each pointing to its own respective AD server.)
3. **Synchronising with AD servers behind a load balancer is not supported.** As with synchronising between two different AD servers, Microsoft Active Directory does not replicate the uSNCNChanged attribute across instances. For that reason, we do not support connecting to different AD servers even when they are load balanced. You will need to select one server (preferably one that is local) to synchronise with instead of using the load balancer.
4. **You must restart the application after restoring AD from backup.** On restoring from backup of an AD server, the uSNCNChanged timestamps are reverted to the backup time. To avoid the resulting confusion, you will need to flush the directory cache after a Active Directory restore operation.
5. **Obtaining AD object deletions requires administrator access.** Active Directory stores deleted objects in a special container called cn=Deleted Objects. By default, to access this container you need to connect as an administrator and so, for the synchronisation task to be aware of deletions, you must use administrator credentials. Alternatively, it is possible to change the permissions on the cn=Deleted Objects container. If you wish to do so, please see [this Microsoft KB Article](#).
6. **The User DN used to connect to AD must be able to see the uSNCNChanged attribute.** The synchronisation task relies on the uSNCNChanged attribute to detect changes, and so must be in the appropriate AD security groups to see this attribute for all LDAP objects in the subtree.

**Recommendations for Connecting to Another JIRA Server**

Please consider the following limitations and recommendations when connecting to a JIRA server for user management.

**Single Sign-On Across Multiple Applications is Not Supported**

When you connect to JIRA for user management, you will not have single sign-on across the applications connected in this way. JIRA, when acting as a directory manager, does not support SSO.

**Custom Application Connectors are Not Supported**

JIRA, Confluence, FishEye, Crucible and Bamboo can connect to a JIRA server for user management. Custom
application connectors will need to use the new REST API.

Custom Directories are Not Supported

Earlier versions of JIRA supported OSUser Providers. It was therefore possible write a special provider to obtain user information from any external user directory. This is no longer the case.

Load on JIRA instance

If your JIRA instance is already under high load, then using it as a User Server will increase that load.

JIRA OnDemand not supported

You cannot use JIRA OnDemand to manage standalone users. OnDemand users and users within your self-hosted Atlassian applications need to be managed separately.

Recommendations

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>If all the following are true:</td>
<td>Your environment meets the optimal requirements for using JIRA for user management.</td>
</tr>
<tr>
<td>• If your JIRA instance is not under high load.</td>
<td></td>
</tr>
<tr>
<td>• You want to share user and group management across just a few applications, such as one JIRA server and one Confluence server, or two JIRA servers.</td>
<td></td>
</tr>
<tr>
<td>• You do not need single sign-on (SSO) between JIRA and Confluence, or between two JIRA servers.</td>
<td></td>
</tr>
<tr>
<td>• You do not have custom application connectors. Or, if you do have them, you are happy to convert them to use the new REST API.</td>
<td></td>
</tr>
<tr>
<td>• You are happy to shut down all your servers when you need to upgrade JIRA.</td>
<td></td>
</tr>
</tbody>
</table>

If one or more of the following are true:                      | We recommend that you install Atlassian Crowd for user management and SSO. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• If your JIRA instance is already under high load.</td>
<td></td>
</tr>
<tr>
<td>• You want to share user and group management across more than 5 applications.</td>
<td></td>
</tr>
<tr>
<td>• You need single sign-on (SSO) across multiple applications.</td>
<td></td>
</tr>
<tr>
<td>• You have custom applications integrated via the Crowd SOAP API, and you cannot convert them to use the new REST API.</td>
<td></td>
</tr>
<tr>
<td>• You are not happy to shut down all your servers when you need to upgrade JIRA.</td>
<td></td>
</tr>
</tbody>
</table>
If you are considering creating a custom directory connector to define your own storage for users and groups...

Please see if one of the following solutions will work for you:

- If you have written a custom provider to support a specific LDAP schema, please check the supported LDAP schemas to see if you can use one of them instead.
- If you have written a custom provider to support nested groups, please consider enabling nested groups in the supported directory connectors instead.
- If you have written a custom provider to connect to your own database, please consider loading the data into the application's database instead.
- If you need to keep the custom directory connection, please consider whether Atlassian Crowd meets your requirements. See the documentation on Creating a Custom Directory Connector.

### RELATED TOPICS

- Connecting to an LDAP Directory
- Connecting to Crowd or Another JIRA Server for User Management
- Configuring User Directories
- Allowing Other Applications to Connect to JIRA for User Management

You can allow other applications to connect to your JIRA server for management of users and groups, and for authentication (verification of a user's login). Examples of such applications: Atlassian Confluence, FishEye/Crucible, Bamboo, or another JIRA server.

**On this page:**

- Allowing an Application to Connect to JIRA for User Management
- Diagrams of Some Possible Configurations
- Related topics

### Allowing an Application to Connect to JIRA for User Management

Subject to certain limitations, you can connect a number of Atlassian web applications to a single JIRA server for centralised user management.

**When to use this option:** You can only connect to a server running JIRA 4.3 or later. Choose this option as an alternative to Atlassian Crowd, for simple configurations with a limited number of users.

**To configure an application to connect to JIRA as a user server:**

1. **Add the application in JIRA:**
   a. Log in to JIRA as a user with the 'JIRA Administrators' global permission.
   c. Add an application.
   d. Enter the **application name** and **password** that the application will use when accessing your JIRA server.
   e. Enter the **IP address** or addresses of the application. Valid values are:
      - A full IP address, e.g. 192.168.10.12.
      - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to [CIDR notation on Wikipedia](https://en.wikipedia.org/wiki/CIDR_notation) and RFC 4632.
   f. Save the new application.
2. **Set up the JIRA user directory in the application:**
   For example, see [Connecting Confluence to JIRA for User Management](https://confluence.atlassian.com/jirawikihow/connecting-confluence-to-jira-for-user-management) or [Connecting JIRA to Another JIRA Server](https://confluence.atlassian.com/jirawikihow/connecting-jira-to-another-jira-server):
   a. Log in to the application that is going to connect to JIRA for user management.
b. Go to the application's 'User Directories' administration area.

c. Add a new directory of type 'Atlassian JIRA'.

d. Define the directory order (see Managing Multiple Directories).

3. Create any groups in JIRA that are required by the application. For example, see Connecting Confluence to JIRA for User Management.

Diagrams of Some Possible Configurations

![Diagram](image)

Diagram above: Confluence connecting to JIRA for user management.
Diagram above: One JIRA site connecting to another for user management. JIRA site 2 does the user management, storing the user data in its internal directory.

RELATED TOPICS

Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Multiple Directories
- Synchronising Data from External Directories
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Allowing Other Applications to Connect to JIRA for User Management
- Migrating Users between User Directories
Migrating Users between User Directories

Organizations will often migrate to or from LDAP engines, such as Active Directory or OpenLDAP, as they grow or acquire new companies, and need to migrate users into the same LDAP engine. As changes occur outside of JIRA, they will also need to be reflected within the JIRA User Directories:

- JIRA can have multiple User Directories (e.g. JIRA Internal, Delegated LDAP, LDAP Connector).
- The difference between the two is a connector will periodically synchronise user details against LDAP and can add/delete users and groups during that process. A delegated directory can only add users/groups upon the user's first login. You can easily identify this by looking for the Synchronize option.
- Each directory will have unique users, groups and group memberships. This means there can be multiple users of the same username with different group memberships.
- Project Roles are global across all User Directories.
- If you have the same user in multiple directories, the effect of directory order will apply. This means that if you add a new user directory and then change the order, so it is before your existing directory, your users will be selected from that directory first.
- When deactivating a user in LDAP, it will be deactivated in JIRA.
- When deleting a user in LDAP, it will be deleted in JIRA if it is not needed, or deactivated if it is (e.g. the user has comments).
- You can set up a User Directory with different permissions settings that will allow you to administer the groups in either LDAP, JIRA, or both.

This guide describes how to migrate users between the different User Directories as described in Configuring User Directories.

On this page:
- Using the 'Migrate users from one directory to another' functionality
- Migrating Users by Changing the Directory Order
- Migrating Users Manually

Using the 'Migrate users from one directory to another' functionality

This functionality allows for the following scenarios:

- Migrate all users from JIRA Internal to Delegated LDAP
- Migrate all users from Delegated LDAP to JIRA Internal
- Migrate all users from Delegated LDAP to Delegated LDAP

However, it cannot be used for any of the following scenarios:

- Migrating a specific set of users or one single user from one directory to another
- Connector User Directories — these can be easily identified, as they have a Synchronize option
- Migrating groups only
- Migrating users without their groups

It also has the following features:

- If you, the currently logged-in user, are in the directory to be migrated from, your user data will not be migrated.
- Users and groups will not be migrated if they already exist in the target directory. For example, consider a user that exists in JIRA Internal and JIRA Delegated LDAP but has different groups in JIRA Internal: when migrating from JIRA Internal to the JIRA Delegated LDAP, that user will be skipped and the groups will not be migrated.

To migrate users:

1. Set up a new Delegated LDAP directory as per Connecting to an Internal Directory with LDAP Authentication.
2. Create an JIRA System Administrator in the JIRA Internal Directory, for example localadmin.
3. Log in as that user and perform the migration steps below. This will allow for all other users to be migrated.
4. If the username needs to be changed as part of the migration, rename them (see Managing Users for instructions).
5. Log in as a user with the 'JIRA System Administrators' global permission.
7. Choose Additional Configuration & Troubleshooting (section) > Migrate users from one directory to another. This option will not appear if there are no valid directories to migrate from/to.

8. Select the from and to directories and migrate the users:

9. You will be shown a message telling you whether the migration was successful or not. In these example screenshots, only 61 out of 62 users could be migrated, as the user doing the migration was logged into the JIRA Internal Directory.
**Migrating Users by Changing the Directory Order**

This method is only applicable if moving users from the JIRA Internal Directory into an LDAP Connector and when LDAP will manage all their groups. Migrating users in this method will not move across any groups as the groups are separate from the JIRA Internal Directory to the LDAP Connector.

1. Add the LDAP Connector as detailed in **Connecting to an LDAP Directory**.
2. Move the new User Directory so that it is ordered before the JIRA Internal Directory:

   ![Diagram showing directory order](image)

   When users login, they will login to the LDAP Connector rather than the JIRA Internal Directory provided the usernames are identical.

**Migrating Users Manually**

If the user migration does not fall into the above scenario, you can migrate users by modifying the database. See this knowledge base article for instructions on how to do this: **Migrate Local Group Memberships Between Directories**. When is completed, JIRA will handle this in product.

**Viewing User Sessions**

JIRA provides a list of users who are currently accessing JIRA. This is useful if you need to know who to contact before planned downtime, for example.

**Viewing Current User Sessions**

To view a list of current JIRA user sessions:

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose > System. Select **Security > User Sessions** to open the Current User Sessions in JIRA page.
   
   ![Keyboard shortcut: 'g' + 'g' + start typing 'user sessions'](image)
The session id shown is also used in the JIRA access log and atlassian-jira.log.

It is possible to have "sessions" for computers that are not logged in. For example, when someone accesses JIRA without logging in, a unique session is created without a username (this is shown as 'Not Available' in the 'User' column).

To administer a user, click a username to go to the user's Profile, then select 'Administer User' from the 'Tools' menu.

User access logging

Occasionally one wishes to get an overall picture of which users are accessing which pages in JIRA. Application servers are able to log the requested URL, but (it seems) they cannot determine the currently logged in user (probably because they run before the Seraph filter has a chance to set request.getRemoteUser()).

Similar to Confluence, JIRA 3.3 and above has a built-in URL logging mechanism, which shows the user and URL invoked:

Please note, as of JIRA 4.1, some of this functionality is now available via the Administration interface. See Viewing User Sessions for more details.
Here you can see user 'joe' enable access logging, then log out, and view the dashboard anonymously.

Usage in JIRA 3.x

URL logging is disabled in JIRA by default. To turn it on:

1. Choose 🔄 > System. Select Troubleshooting and Support > Logging & Profiling to open the Logging page, which lists all defined log4j categories (as package names) and their current logging levels.
2. Change the log level for AccessLogFilter from WARN to INFO. To make this change permanent, you would need to edit the corresponding section in WEB-INF/classes/log4j.properties on disk, changing:

   log4j.additivity.com.atlassian.jira.web.filters = false

   to:

   log4j.category.com.atlassian.jira.web.filters.AccessLogFilter = INFO, console, filelog
   log4j.additivity.com.atlassian.jira.web.filters = false
and then restart JIRA.

**Usage in JIRA 4.x**

URL logging is disabled in JIRA by default. To turn it on:

1. Choose ⚙ > System. Select Troubleshooting and Support > Logging & Profiling to open the Logging page, which lists all defined log4j categories (as package names) and their current logging levels.
2. Click the 'Enable' link on 'HTTP Access Logging' and 'SOAP Access Logging'.

### HTTP Access Logging

Turn this on to have JIRA log all HTTP requests to an access log. This information will be sent to 'atlassian-jira-http-access.log'.

The HTTP access log is currently turned **OFF**.
- [ ] Enable the HTTP access log.

### SOAP Access Logging

Turn this on to have JIRA log all SOAP requests to an access log. This information will be sent to the console and 'atlassian-jira-soap-access.log'.

The SOAP access log is currently turned **OFF**.
- [ ] Enable the SOAP access log.

### SQL Logging

Turn this on to have JIRA log all SQL requests. This information will be sent to the console and 'atlassian-jira-sql-access.log'.

Turning on SQL logging will slow down your system and should only be done for troubleshooting purposes.

The SQL log is currently turned **OFF**.
- [ ] Enable the SQL log.

Note, the user access logs are not outputted to the atlassian-jira.log file, the http logs are written to `<JIRA Data folder>/log/atlassian-jira-http-access.log` and SOAP logs are written to `<JIRA Data folder>/log/atlassian-jira-soap-access.log`

**Application Server Access Logs**

JIRA’s application server (Apache Tomcat) can also produce access logs. These are enabled by default in JIRA and result in logs/access_log.<date>.log files being generated in your JIRA Installation Directory. If you are using JIRA WAR, this feature may be enabled in the `conf/server.xml` file (of the Tomcat application server installation running JIRA) by adding the following line before `</Context>`:

```xml
<Vave className="org.apache.catalina.valves.AccessLogValve" pattern="%h %l %u %t
 quot;rgb" quot; %s %b %T %S resolveHosts="false" />
```

You will need to restart JIRA for the changes to take effect.

The [Apache Tomcat Access Log Valve documentation](https://tomcat.apache.org/tomcat-5user-doc/5.5/tomcat-juli-user-doc.html#Using_Access_Log) describes each of the above parameters.
This will generate logs that include the IP address, like:

```
127.0.0.1 - - [19/Oct/2006:12:38:09 +0800] "GET / HTTP/1.1" 302 - 0.240
127.0.0.1 - - [19/Oct/2006:12:38:09 +0800] "GET / HTTP/1.1" 302 - 0.243
127.0.0.1 - - [19/Oct/2006:12:38:16 +0800] "GET /styles/global.css HTTP/1.1" 200 548 0.213 39F9C7F048F7F060A4B9883A7348082D
127.0.0.1 - - [19/Oct/2006:12:38:24 +0800] "GET /styles/global.css HTTP/1.1" 200 548 0.213 39F9C7F048F7F060A4B9883A7348082D
```

### Clearing 'Remember my login' Tokens

**Introduction**

When a user logs in to a JIRA site, they have the option of making JIRA remember their login on a specific computer and browser, by selecting the 'Remember my login...' check box before they click the 'Log In' button. Upon doing so, a 'Remember my login' token is stored by the JIRA server and a cookie containing this token is set in the user's browser.

A user who revisits a JIRA site from the same computer and browser, will automatically be logged in if JIRA detects that one of the user's 'Remember my login' tokens has a matching token contained in one of that browser's cookies. If the user logs out of JIRA, the 'Remember my login' token (which matches the relevant browser cookie) is cleared from the JIRA server.

To maximise and maintain the security of your JIRA site, JIRA provides features for:

- clearing 'Remember my login' tokens associated with individual user accounts and
- clearing all 'Remember my login' tokens stored by your JIRA site.

These features are especially useful in situations where users have been accessing your JIRA site in a public environment, selected the 'Remember by login...' check box before logging in, but have forgotten to log out.
Clearing 'Remember my login' Tokens from a User Profile

A JIRA user can clear all of their own 'Remember my login' tokens from JIRA through their user profile. To do this:

1. Visit your User Profile.
2. In the Details section, click the 'Clear All Tokens' link. The Remember my login message box appears.

   Screenshot: 'Remember my login' message box

   ![Remember My Login]

   When you log in and select 'Remember my login...', JIRA remembers this using a token so you do not have to enter your login details again from the same browser.

   Click Clear All Tokens to remove them.

3. Click the 'Clear All Tokens' button. All tokens associated with your user account will be removed from the JIRA server.

Clearing a User's 'Remember my login' Tokens from the Administration Console

JIRA administrators can clear all 'Remember my login' tokens associated with a user's account through the JIRA administration console. To do this:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🌐 > User Management.
   ✅ Keyboard shortcut: 'g' + 'g' + start typing 'users'
3. Click the Username or Email Address of the user whose 'Remember my login' tokens you wish to remove. Details about that user and their login information is displayed.
   ✅ To restrict the list of users shown in the User Browser, use the Filter form at the top of the User Browser. Specifying (part of) the user's email and/or group, then clicking the 'Filter' button, will reduce the list to only those users who match those criteria.
4. Click the 'Remember My Login' link to display that user's Remember My Login page.

   Screenshot: A User's 'Remember My Login' Page
5. Click the 'Clear All' button to remove all 'Remember my login' tokens associated with this user account from the JIRA server.

Clearing all 'Remember my login' Tokens from the JIRA site

JIRA administrators can also clear all 'Remember my login' tokens from their JIRA site through JIRA's administration console. To do this:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System. Select Security > Remember My Login to open the Remember My Login for All Users page. 

   **Keyboard shortcut:** 'g' + 'g' + start typing 'remember my login'

   **Screenshot:** The 'Remember My Login for All Users' Page

3. Click the 'Clear All' button to remove all 'Remember my login' tokens from the JIRA server.

Disabling Remember My Login on this Computer

To remove the Remember my login on this computer option on the login page, follow the instructions below:

**Option 1 (recommended)**
The check box for this option can be disabled by setting the jira.option.allowcookies property to false in your jira-config.properties file.

   **You will need to restart JIRA in order for this change to take effect.**

**Option 2**
Edit the ./atlassian-jira/includes/loginform.jsp file.

Enabling Public Signup and CAPTCHA

About Public Signup and CAPTCHA

For some organisations it is appropriate to enable signup, which allows visitors to immediately create their own JIRA user accounts. If signup is not enabled, then only a JIRA administrator can create new user accounts.

For example, enabling signup can be useful if you are using JIRA as a support system and have a very large number of potential users, of which only some will need to log support tickets.
For security reasons, even if you enable signup, it is still necessary for users to have the appropriate project permissions before they can see or create issues. Note that you can use automatic group membership to add all new users to appropriate groups.

If your JIRA server is accessible from outside your organisation's firewall, and you have enabled signup, then you may want to also enable CAPTCHA. CAPTCHA helps ensure that only real humans (and not automated spam systems) can sign themselves up to JIRA. When CAPTCHA is enabled, visitors will need to recognise a distorted picture of a word (see example below), and must type the word into a text field. This is easy for humans to do, but very difficult for computers.

### Enabling Public Signup

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose > System. Select General Configuration to open the Administration page.
   - Keyboard shortcut: 'g' + 'g' + 'general configuration'
3. Click 'Edit Configuration' at the end of the page.
4. In the 'Mode' drop-down, select 'Public'.
5. Click the 'Update' button at the bottom of the screen.
6. Log out of JIRA, then click the 'Log In' link at the top right of the screen and verify that the 'Sign Up' link is displayed at the bottom of the login screen:

   ![Login Screen](image)

### Enabling CAPTCHA

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose > System. Select General Configuration to open the Administration page.
   - Keyboard shortcut: 'g' + 'g' + 'general configuration'
3. Click 'Edit Configuration' at the end of the page.
4. Locate 'CAPTCHA on signup' and select 'On'.
5. Click the 'Update' button at the bottom of the screen.
6. Log out of JIRA, click the 'Log In' link at the top right of the screen, then click the 'Sign Up' link and verify that a random sequence of letters is displayed at the bottom of the 'Sign Up' screen — e.g. "winzers" in the following screenshot:

   ![CAPTCHA Screen](image)
Changing the User Default Settings

Overview

Administrators can change the default user settings which are applied to user accounts on creation. Changing the default settings will also change the preferences for existing users that are still using the default user settings (i.e. have not changed it themselves). These settings can be changed by the user on an individual basis. See Managing your User Profile.

Note: An administrator can force the user to use a specific Email format by clicking the Apply link. The user will then be unable to edit this setting.

Changing the User Default Settings

1. Log in as a user with the JIRA Administrators global permission.
2. Select 🔄 > System > Default User Preferences to open the User Default Settings page.
3. Click the Edit default values button. The User Default Settings window displays.
4. Make the changes you wish to apply. A summary of the available changes is listed below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email format</td>
<td>Outgoing email notifications from JIRA can be sent as HTML or text format.</td>
</tr>
</tbody>
</table>
### Issues per page
This will set the number of issues displayed on each Issue Navigator page. Enter a value between 1 and 1000.

### Default access
Choose the default access setting for when you create new filters and dashboards, which can be either shared with all other users (Public) or restricted to your viewing only (Private).

### Notify users of their own changes
Choose between making JIRA send you email notifications about issue updates made by either both you and other people (Notify me) or other people only (i.e. Do not notify me).

### Autowatch own issues
Choose between allowing JIRA to automatically make you a watcher of any issues that you create or comment on.

5. Click the Update button. Your changes have been applied.

**Note:** The first time you access the User Default Settings window the Email format is set to text. This will be applied if you click Update. Ensure you have selected the correct Email format you wish to apply.

### Project Management

- **Defining a Project**
  - Editing a Project Key
    - Changing the Project Key Format
  - Simple Issue Tracking project
  - Software Development project
- **Managing Project Role Membership**
- **Defining a Component**
- **Managing Versions**
  - Running a Bamboo Build when Releasing a Version
  - Creating Release Notes

#### Defining a Project

This page tells you how to add a new project or configure an existing project. You must be a JIRA administrator to add/configure a project.

A JIRA project is a collection of issues. Your team could use a JIRA project to coordinate the development of a product, track a project, manage a help desk, and more, depending on your requirements.

### On this page:
- Creating a project
- Configuring a project
- A note about project administrators

#### Creating a project

**To create a new project in JIRA:**

1. Click Projects (in header) > Create project.
2. Follow the wizard to create the project.

About the project types:

- **JIRA Classic:** This project type creates the default JIRA project. The project will use the shared JIRA default schemes. Note, if you create a project using any of the other project types, project-specific schemes (i.e. issue type scheme, workflow scheme, screen scheme and issue type screen scheme) will be created for that project.
- **Project Management:** This project type also creates the default JIRA project, but with project-specific schemes.
- **Simple Issue Tracking:** This project provides you with a quick and easy way to get JIRA up and running for simple issue tracking. For details on working with this project, see Simple Issue Tracking project.
- **Software Development:** This project provides you with a template to use for software development.
details on working with this project, see Software Development project.

About the project details:

- The **project key** will be used as the prefix of this project's issue keys (e.g. 'TEST-100'). Choose one that is descriptive and easy to type.
- The **project lead** is a unique project role. Choose the person who manages the project as the project lead. If there is only one user in your JIRA system, the Project Lead will default to that person and this field will not be available.

Configuring a project

**To configure a project in JIRA:**

1. Navigate to the administration page for the project:
   - Choose 🌐 > Projects., or
   - Navigate to the desired project's summary and click the Project Administration button at the bottom of the project navigation sidebar.
2. Use the tabs on the left to navigate between the different project settings. Read the sections below for a description of each setting.

---

### Project details

Click **Edit Project** at the top of the **Project Summary** page and edit the project details as desired. Note the following:

- **Editing the project key:** This is not a simple task. Read this page before you edit the project key: [Editing a Project Key](#).
- **Using HTML in the project description:** You can include HTML, but make sure all your tags are closed. Please be aware that this is completely unfiltered HTML and as such, it is susceptible to cross site scripting attacks.
- **Choosing a project avatar:** If you don't want to use a project avatar, you can upload a transparent pixel.

**About project categories:**

The project category is not edited in the Edit Project dialog. Instead, click the link next to the Category field (under the project name) on the project Administration page. Categories can be viewed/created via **Administration > Projects > Project Categories**.

Why are categories useful? JIRA can search for all the issues in a particular project category (e.g. category = "buildeng" in an advanced search), and can display projects sorted by the project category. A JIRA project can only belong to one category. Please note that a project category is not part of a project hierarchy. Also, JIRA does not support sub-projects or parent projects.

### Issue types

JIRA enables you to keep track of different types of things — bugs, tasks, helpdesk tickets, etc — by using different **issue types**. You can view the issue types that have been specified for your project, and the fields and workflow configured for each issue type. If you have the **JIRA Administrators** (global permission), you can also configure the issue types.

Click either **Issue Types** in the left menu or one of the issue types under it, e.g. **Bug, Task, Story**, etc:

- **Issue Types:** Click this to view which issue types apply to this project, (i.e. the issue type scheme). You can also view the workflow, fields and screens for the issue type in the project, but it is easier to do this by clicking one of the issue types.
  - If you are a JIRA administrator, click the **Actions** menu to edit the issue types in the current scheme or use a different scheme for your project.
- **One of the issue types (e.g. Bug, Task, Story):** Click this to view the workflow (Workflow tab)/screen (View tab) for the issue type in the project.
  - If you are a JIRA administrator, you can also configure the workflow (via the workflow designer) and the fields for the issue type (screen designer) via the tabs.
Workflows

Your JIRA issues can follow a process that mirrors your team's practices. A workflow defines the sequence of steps (or statuses) that an issue will follow, e.g. Open, In Progress, Resolved. You can configure how issues will transition between statuses, e.g. who can transition them, under what conditions, and which screen will be displayed for each transition.

- **Workflow Scheme** — the project's workflow scheme determines which workflows (issue state transitions) apply to issue types in this project.

Screens

JIRA allows you to display particular pieces of issue information at particular times, by defining screens. A screen is simply a collection of fields. You can choose which screen to display when an issue is being created, viewed, edited, or transitioned through a particular step in a workflow.

- **Screen Scheme** — the project's screen scheme determines which screens are displayed for different issue operations (view, edit, create);
- **Issue Type Screen Scheme** — the project's issue type screen scheme determines which screens are displayed for different issue operations (view, edit, create), for different issue types.

Fields

JIRA enables you to define field behavior: each field can be required/optional, rich text/plain text, hidden/visible. You define this behavior by using a field configuration.

- **Field Configuration Scheme** — the project's field configuration scheme determines which field configuration applies to issue types in this project. (A field configuration determines each field's overall visibility, requiredness, formatting (wiki/rich-text or plain) and help-text).

Settings

- **Application Links** (Configure Project Links) — if you have linked your JIRA instance to other Atlassian applications, like Confluence, FishEye or other JIRA instances, you will be able to link this JIRA project to areas of those applications that contain information relating to your project or team. For example, Confluence spaces, FishEye repositories, JIRA projects (in another JIRA instance), etc. This allows you to take advantage of integration points between these applications. See Linking to Another Application for information about application links and project links.

Roles

Different people may play different roles in different projects — the same person may be a leader of one project but an observer of another project. JIRA enables you to allocate particular people to specific roles in your project.

- **Project Lead** — user fulfilling the role of project leader. Used as the 'Default Assignee' (see below), and potentially elsewhere in JIRA (e.g. in permission schemes, notification schemes, issue security schemes and workflows).
- **Default Assignee** — the user to whom issues in this project are initially assigned when created. Can be either the "Project Lead" (above), or, if Allow unassigned issues is set to 'On' in JIRA's general configuration, 'Unassigned'. There are also default component assignees. By default, new projects also have their 'Default Assignee' set to 'Unassigned.' You can change this here if you want to set it to be a specific role, i.e. 'Project Lead.'
- **Project Roles** — members are users/groups who fulfill particular functions for this project. Project roles are used in permission schemes, notification schemes, issue security schemes and workflows.

Versions

If you are using JIRA to manage the development of a product, you may want to define different versions to help you track which issues relate to different releases of your product (e.g. 1.0, 1.1, 1.2, 2.0 beta, 2.0). JIRA can help you manage, release and archive your versions. Versions can also have a Release Date, and will automatically be highlighted as "overdue" if the version is unreleased when this date passes.

- **Versions** — versions defined in the project. See the version management page for details.
Components

You may want to define various components to categorise and manage different issues. For a software development project, for example, you might define components called "Database", "Usability", "Documentation" (note that issues can belong to more than one component). You can choose a Default Assignee for each component, which is useful if you have different people leading different sub-teams in your project.

- Components — logical groups that this project’s issues can belong to. See the component management page for details.

Permissions

JIRA allows you to control who can access your project, and exactly what they can do (e.g. "Work on Issues", "Comment on Issues", "Assign Issues"), by using project permissions. You can also control access to individual issues by using security levels. You can choose to grant access to specific users, or groups, or roles (note that roles are often the easiest to manage).

- Permission Scheme — the project's permission scheme determines who has permission to view or change issues in this project.
- Issue Security Scheme — the project's issue security scheme determines what visibility levels issues in this project can have (see issue-level security).

Notifications

JIRA can notify the appropriate people when a particular event occurs in your project (e.g. "Issue Created", "Issue Resolved"). You can choose specific people, or groups, or roles to receive email notifications when different events occur. (Note that roles are often the easiest to manage.)

- Notification Scheme — the project's notification scheme determines who receives email notifications of changes to issues in this project.
- Email — specifies the 'From' address for emails sent from this project. Only available if an SMTP email server has been configured in JIRA.

⚠️ Please note, the Default Notification Scheme (shipped with JIRA) is associated with all new projects by default. This means that if you have an outgoing (SMTP) mail server set up, that email notifications will be sent as soon as there is any activity (e.g. issues created) in the new project.

Development tools

The Development tools section gives you an overview of the development tools that are connected and which users can use the integration features between them:

- View permission - This section lists which users can see the development tools integration features (like the Create Branch link) on the view issue screen, as well as other development-related information, like commits, reviews and build information. This ability is controlled by the "View Development Tools" project permission.
- Applications - This section shows which development tools are connected to JIRA via application links and are eligible to use the development tool features in JIRA.

A note about project administrators

A project administrator in JIRA is someone who has the project-specific Administer Projects project permission, but not necessarily the JIRA Administrator global permission.

Without the JIRA Administrator global permission, however, project administrators can do the following:

- Edit the project name
- Edit the project description
- Edit the project avatar image
- Edit the project URL
- Edit the project lead
- Edit project role membership
- Define project components
- Define project versions
- View, but not select nor edit the project's schemes (notification scheme, permission scheme, etc)
Changing the project category of a JIRA project requires JIRA Administrator global permission.

### Editing a Project Key

Editing a project key is not a trivial task. You should choose key that will suit your long-term needs when creating a project, rather than rely on editing the project key after the project is created. However, there are situations where you need to change the key for an existing project, e.g. change of product name.

The instructions on this page show you how to change the project key and describe the implications of such a change. If you are a plugin developer, you should also read the developer notes below.

Before you begin

- Your desired project key must confirm to the project key format restrictions specified in JIRA. By default, the project key format must be at least 2 characters long and contain only uppercase letters.
- Perform this change during a low usage period — JIRA will start a background re-index when you save your updated project key. This can have a performance impact on your instance. Note, you cannot choose a 'Lock JIRA and rebuild index'. The background index will be faster anyway, as it is limited to issues for the project.
- Communicate changes to your users — Ensure that you are aware of the consequences of changing the project key, and have adequately prepared your users for the changes. See the Changes section below.

### Editing the project key

1. Navigate to the desired project in JIRA, and access the project administration screen. Choose Project Administration (bottom of the project navigation sidebar) if you’re on the Project summary screen.
2. Choose the Edit Project button.
3. Choose edit key next to the Key field.
4. Update the key and choose Update.

Post-update tasks

- Fix the project entity links — When you connected JIRA to another Atlassian application, entity links would have been automatically created between your JIRA projects and the relevant "projects" in other applications, e.g. Confluence spaces. If you change the key of a JIRA project, you will need to fix the project entity links as described on Creating Links Between Projects.
While editing the project key is a major change, in most cases, your JIRA project will work as you'd expect with a new key. There are a few cases that you should be aware of, which are listed below. We recommend reviewing these and advising your users accordingly.

- The old project key can be used in JQL queries — Users won't have to update issue filters that reference the old project key.
- If you use Confluence with JIRA, the JIRA issue macros in Confluence will continue to work. Please note, if you don’t see the change straight away, allow some time for the cache to refresh.
- You won’t be able to create a new project with the old project key. However, you can change the renamed project back to the old project key. If you delete the project, all associated keys will be freed and you’ll be able to re-use them.
- Links will work, whether they are inside JIRA or from external sources. However, link aliases will not be updated — For example, if you have a link to an issue ‘EXAMPLE-1’ in the description of an issue, and you change the project key ‘EXAMPLE’ to ‘DEMO’, then the alias ‘EXAMPLE-1’ will not be updated to ‘DEMO-1’. The link will still direct you to DEMO-1 though.
- If you are using the Activity Stream gadget with a global filter, you will need to update the filter after the project is renamed.
- All attachments will be accessible after the project key change. Please note however, that the directory that they are stored in (under the <JIRA Home>-data\attachments directory) will be retain the old project key. For example, if you change a project's key from TEST to DEMO, the attachments will be stored under <JIRA Home>-data\attachments\TEST.
- If you export a renamed project, then import it, it will have the updated project key, i.e. the original project key will not be retained. In fact, all historical keys for that project will be removed. There is a workaround for this that involves changing data directly in your database, see this Answers post.

**Related topics**

**Changing the maximum project key length** — You can change the maximum characters allowed for a project key. Navigate to the General Configuration page of the JIRA administration console, as described on Configuring JIRA Options, and change the Maximum project key size field.

**Notes for developers**

- REST API calls will still work with old project key — REST calls that specify an issue key will work with the old issue key after the project key has changed. For example, /rest/api/issue/EXAMPLE-100 will still work after the project key is changed from EXAMPLE to DEMO.
- We have created a new event, ProjectUpdatedEvent. This event is triggered any time a project's details are changed, including changing the project key.
- If you need to retrieve all issue keys and project keys (historical and current), you can do this via the following:
  - REST:
    * Get all project keys for a project: /rest/api/2/project/<project key>?expand=projectKeys
  - Java API:
    * Get all project keys: com.atlassian.jira.project.ProjectManager#getAllProjectKeys
    * Get all issue keys for an issue: com.atlassian.jira.issue.IssueManager#getAllIssueKeys

**Changing the Project Key Format**

JIRA provides the ability to specify the format of project keys within the system. This allows you to restrict the format of a project key, when a project key is created or edited.

A project key format is defined via a regular expression ‘rule’ that governs the valid project key format. By default, the JIRA project key configuration requires two or more uppercase alphabetical characters — based on the regular expression ([A-Z][A-Z]+).

**On this page:**

- Before you begin
- Configuring the project key format
- Related topics
Before you begin

- Ensure that you choose a supported project key format. Only formats that meet all of the following rules are supported:
  - The first character must be a letter,
  - All letters used in the project key must be from the Modern Roman Alphabet and upper case, and
  - Only letters, numbers or the underscore character can be used.

Examples:
- Examples of supported keys: PRODUCT_2013, R2D2, MY_EXAMPLE_PROJECT.
- Examples of unsupported keys: 2013PROJECT (first character is not a letter), PRODUCT-2012 (hyphens are not supported).

- You cannot configure the issue key pattern, as JIRA expects this key to conform to specific rules. By default, JIRA issue keys (or issue IDs) are of the format `<project key>-<issue number>`, e.g. ABC-123. For example, you can't show the issue number before the project key.
- If a number of issues have already been created in your JIRA installation, then changing the project key format is not recommended. If you must change the project key pattern after issues have already been created, use a regular expression that allows a more 'permissive' project key pattern than the current one (e.g. use a regular expression which will still be valid for existing project keys defined in your JIRA installation).
- If you use JIRA Agile and you are using the Classic Boards, do not change JIRA's default project key format as the Classic Boards only support this key format. If you are not using the Classic Boards, you can change to a supported project key format.

Configuring the project key format

The `jira.projectkey.pattern` property allows JIRA administrators to specify a Perl5 regular expression value that defines the rule for a valid project key. Further information on Perl5 is available [here](#).

This property and its regular expression value can be defined through the Advanced Settings page. This is described below.

**Step 1. Configure a pattern for your project key syntax**

1. Navigate to the JIRA Advanced settings page, as described on Configuring Advanced Settings.
2. Find the `jira.projectkey.pattern` property and click its value to modify it. Below is a list of common examples and patterns:

<table>
<thead>
<tr>
<th>Pattern Requested</th>
<th>Expression needed</th>
<th>Resulting Issue IDs</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>XXYY, where X indicates two fixed letters, Y represents two fixed digits</td>
<td><code>([A-Z]{2}[0-9]{2})</code></td>
<td>TQ09-01, TQ09-02, etc.</td>
<td><code>[A-Z]</code> Any character from A to Z, <code>2</code> Matches the preceding character 2 times exactly, <code>[0-9]</code> Any character (i.e.digit) from 0 to 9</td>
</tr>
<tr>
<td>XZ+, where X indicates one fixed letter, Z+ represents one or more letters, digits or underscore characters</td>
<td><code>([A-Z][A-Z_0-9]+)</code></td>
<td>ACAT_51-1, AAA5-1330, A_20_A091-15, etc.</td>
<td><code>[A-Z]</code> Any characters from A to Z, <code>[A-Z_0-9]</code> Any character from A to Z, 0 to 9 or the underscore character, <code>+</code> specifies <code>[A-Z_0-9]</code> as one or more characters from A to Z, 0 to 9 or the underscore character.</td>
</tr>
</tbody>
</table>

If you have integrated JIRA with Bamboo, do not change JIRA's default project key format as Bamboo only supports this key format.
Please Note:

- JIRA prepends the regular expression specified with `^` and closes it with `$` for an exact matching rule within the system.
- The project key only supports uppercase characters, as stated above. Hence, for simplicity, use uppercase characters in your expressions as JIRA will convert any lowercase characters to uppercase ones.

**Step 2. Test your regular expression**

A variety of tools allow searching using a Regular Expression. Most text editors will allow a Regular Expression search. There are also a variety of websites available to for testing a Regular Expression available from an Internet search.

**(Optional) Step 3. Customize the project key description and warning**

In addition to the project key format, you can also customize the following properties in the `jira-config.properties` file:

- `jira.projectkey.description` — a configurable description (to match the project key pattern) displayed on project creation
- `jira.projectkey.warning` — if JIRA detects that the project key entered does not match the `jira.projectkey.pattern`, it will throw the error message defined in `jira.projectkey.warning`. You can change this error message, so that when a user keys in the wrong format, they will be informed of the correct pattern to use.

Related topics

- **Changing the maximum project key length** — You can change the maximum characters allowed for a project key. Navigate to the General Configuration page of the JIRA administration console, as described on Configuring JIRA Options, and change the Maximum project key size field.
- Editing a Project Key
- Defining a Project
- Configuring Advanced Settings

**Simple Issue Tracking project**

This project provides you with a quick and easy way to get JIRA up and running for simple issue tracking.

This project is aimed at users who want to track their issues through a simple three-step workflow, while taking advantage of JIRA’s other powerful features. Later on, it’s easy to extend to other, more complex workflows provided by JIRA.

**On this page:**

- Getting started
- Details of this project template

**Related pages:**

- Defining a Project
- Migrating from Other Issue Trackers

**Getting started**

To create a Simple Issue Tracking project in JIRA, follow these instructions and be sure to select Simple Issue Tracking in Step 3.

1. Log in as a user with the JIRA Administrators global permission.
2. Choose Projects > Create Project.
3. Choose the type of project that you want to create.
4. Enter the project details. Note, choose the project key carefully, as it is not a simple task to change it after the project is created.
5. Choose Submit to add the new project.

**Details of this project template**
**Issue Types**

You get the following three issue types:

- **Parent types:** New Feature, Task
- **Sub-task type:** Sub-Task

JIRA auto-creates an issue type scheme called `<project key>`: Simple Issue Tracking issue type scheme.

**Simple Issue project workflow**

This is what the project workflow looks like:

```
Workflow description

The Simple Issue project workflow operates as follows:

- Three statuses: To Do, In Progress and Done
- Uses the resolution: Done

JIRA auto-creates a workflow scheme called `<project key>`: Simple Issue Tracking workflow scheme.

Workflow transitions

Transitions have the following properties:

- When the 'Start Progress' transition is used the issue gets **assigned** to the current user.
- When the 'Reopen and Start Progress' transition is used the issue gets **assigned** to the current user.
- When any 'Done' transition occurs the **resolution** is set to Done.
- When the 'Reopen' transition occurs the **resolution** field is cleared.
- There are no transition screens.
- No Assignee transition conditions (apart from the permission scheme).

**Software Development project**

This project provides you with a template to use for software development. It includes a simple workflow with statuses representing tasks that go through a development and review process. You can later customize this further to suit your team's evolving processes.
**Getting started**

To create a Software Development project in JIRA, follow these instructions and be sure to select **Software Development** in Step 3.

1. Log in as a user with the JIRA Administrators global permission.
2. Choose Projects > Create Project.
3. Choose the type of project that you want to create.
4. Enter the project details. Note, choose the project key carefully, as it is not a simple task to change it after the project is created.
5. Choose Submit to add the new project.

**Details of this project template**

**Issue Types**

You get the following issue types:

- Parent types: Story, Task, New Feature and Bug
- Sub-task types: Sub-Task

JIRA auto-creates an issue type scheme called `<project key>`: Software Development issue type scheme.

**Software Development project workflow**

This is what the project workflow looks like:

![Software Development project workflow diagram](image)

**Workflow description**

The Software Development project workflow operates as follows:
- Four statuses: To Do, In Progress, In Review and Done
- Uses the resolution: Done
- All indicates that you can transition from any status to the associated status

JIRA auto-creates a workflow scheme called <project key>: Software Development workflow scheme.

**Workflow transitions**

Transitions have the following properties:

- When the 'Start Progress' or 'Start Review' transition is used the issue gets assigned to the current user.
- When the 'Reopen and Start Progress' or 'Reopen and start review' transition is used the issue gets assigned to the current user and the resolution field is cleared.
- When any 'Done' transition occurs the resolution is set to Done.
- When the 'Reopen' transition occurs the resolution field is cleared.
- There are no transition screens.
- No Assignee transition conditions (apart from the permission scheme).

**Managing Project Role Membership**

A JIRA project role is a flexible way to associate users and/or groups with a particular project.

Unlike groups, which have the same membership throughout JIRA, project roles have specific members for each project. Users may play different roles in different projects.

* This page contains instructions for managing membership of existing project roles. For information on creating and using project roles, please see Managing project roles.

**On this page:**
- Viewing project role members
- Assigning a user to a project role
- Removing a user from a project role
- Assigning a group to a project role
- Removing a group from a project role

**Viewing project role members**

To see which users and groups belong to each project role for a particular project:

1. Log in to JIRA as a project administrator.
2. Choose ![Projects](#) > Projects, and click the name of a project. The 'Project Summary' page (see Defining a Project) for your selected project is shown.
3. Choose Roles in the left menu. The Roles page is displayed, from where you can manage the project role membership as described below.

**Screenshot: The 'Roles' page**

**Assigning a user to a project role**

1. Open the Roles page as described in 'Viewing project role members' above.
2. Hover over the Users column for the project role in which you are interested and click the yellow box which appears. The users and groups will become editable.
3. Type the name of the user(s) you wish to add to this project role.
   - The Browse Users global permission is required to search for users in the Users column. If you do not have this permission, you will need to specify the exact name of the user(s), followed by the 'Enter' key after each user specified.
4. Click the Update button.

Removing a user from a project role

1. Open the Roles page, as described in 'Viewing project role members' above.
2. Hover over the Users column for the project role in which you are interested and click the yellow box which appears. The users and groups will become editable.
3. Click the x next to the name of the user(s) you wish to remove from this project role.
4. Click the Update button.

Assigning a group to a project role

1. Open the Roles screen, as described in 'Viewing project role members' above.
2. Hover over the Groups column for the project role in which you are interested and click the yellow box which appears. The users and groups will become editable.
3. Type the name of the group(s) you wish to add to this project role.
   - The Browse Users global permission is required to search for groups in the Groups column. If you do not have this permission, you will need to specify the exact name of the group(s), followed by the 'Enter' key after each group specified.
4. Click the Update button.

Since group membership can only be edited by users with the JIRA Administrator global permission, project administrators may therefore prefer to assign users, rather than groups, to their project roles.

Removing a group from a project role

1. Open the Roles page, as described in 'Viewing project role members' above.
2. Hover over the Groups column for the project role in which you are interested and click the yellow box which appears. The users and groups will become editable.
3. Click the x next to the name of the group(s) you wish to remove from this project role.
4. Click the Update button.

A project role need not have any users or groups assigned to it, although project administrators should be careful with this. Depending on how a project role is used (e.g. if the project's permission scheme is using project roles), it is possible that not having anyone in a particular project role could make some project activities unavailable.

Defining a Component

Components are sub-sections of a project. They are used to group issues within a project into smaller parts.

Note that you can set a Default Assignee for a component. This will override the project's default assignee, for issues in that component.

On this page:
- Managing a project's components
- Adding a new component
- Editing a component's details
- Deleting a component
Managing a project’s components

1. Log in to JIRA as a project administrator.
2. Choose ➤ Projects, and click the name of a project. The Project Summary page is displayed (see Defining a Project).
   Keyboard shortcut: g + g + start typing project
3. Choose Components in the left menu. The Components page is displayed, showing a list of components and each component’s details. From here you can manage the project’s components as described below.

Screenshot: The ‘Components’ screen

Adding a new component

1. The Add Component form is located at the top of the ‘Components’ screen.
2. Enter the Name for the component. Optionally enter a Description and select a Component Lead and Default Assignee (see options below).

Selecting a Default Assignee

You can optionally set a Default Assignee for a component. This will override the project’s default assignee, for issues in that component.

If an issue has multiple components, and the default assignees of components clash, the assignee will be set to the default assignee of the component that is first alphabetically.

<table>
<thead>
<tr>
<th>Default Assignee Option</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Default</td>
<td>Issues matching this component will have the assignee set to the same default assignee as the parent project.</td>
<td></td>
</tr>
<tr>
<td>Project Lead</td>
<td>The assignee will be set to the project leader.</td>
<td>If the project leader is not permitted to be assigned to issues in the permission scheme this option will be disabled and will say &quot;Project Lead is not allowed to be assigned issues&quot;.</td>
</tr>
</tbody>
</table>
Component Lead

The assignee will be set to the component leader.

If the component leader is not permitted to be assigned to issues in the permission scheme this option will be disabled and will say "Component Lead is not allowed to be assigned issues". The Component Lead option will also not be available if the component does not have a lead assigned to the component. Instead under this option it will say "Component does not have a lead.".

Unassigned

The assignee of the issue will not be set on the creation of this issue.

This option will only be available if "Allow unassigned issues" is enabled in the General Configuration.

Editing a component's details

1. On the 'Components' screen, hover over the relevant component to display the pencil icon.
2. Edit the component's Name, Description, Lead and Default Assignee.
3. Click the Update button to save your changes.

Deleting a component

1. On the 'Components' screen, hover over the relevant component to display the Delete button.
2. You will be prompted to associate these issues with another component if you wish.

Managing Versions

Versions are points-in-time for a project. They help you schedule and organize your releases. Once a version is created, and issues are assigned to it, a Releases link will be available in your project navigation sidebar.

Versions can be:

- Added — create a new version against which issues can be aligned.
- Released — mark a version as released. If you have integrated JIRA with Bamboo, you can also trigger builds when releasing a version.
- Rescheduled — re-arrange the order of versions.
- Archived — hide an old version from the Releases report, and in the JIRA User Interface.
- Merged — combine multiple versions into one.

Managing a project's versions

1. Log in to JIRA as a project administrator.
2. Choose  ➕  Projects, and click the name of a project. The Project Summary page is displayed (see Defining a Project).
3. Choose Versions in the left sidebar. The Versions page is displayed, showing a list of versions.

Screenshot: The 'Versions' screen
Add a new version

1. The Add Version form is located at the top of the ‘Versions’ screen.
2. Enter the name for the version. The name can be:
   - simple numeric, e.g. "2.1", or
   - complicated numeric, e.g. "2.1.3", or
   - a word, such as the project's internal code-name, e.g. "Memphis".
3. Optional details such as the version description (text not HTML), start date and release date (i.e. the planned release date for a version) can be also be specified.
4. Click the Add button. You can drag the new version to a different position by hovering over the ‘drag’ icon at the left of the version name.

Add a start date

If specified, the Start Date is used by the Version Report. This gives you a more accurate report in cases where you might plan a version many weeks (or even months) in advance, but not actually commence work until closer to the release date.

Release a version

ℹ️ Before you begin: If you have integrated JIRA with Atlassian's Bamboo, you can trigger a Bamboo build to run automatically when releasing a version in JIRA. The version will only be released if the build is successful. See these alternate instructions: Running a Bamboo Build when Releasing a Version.

1. On the 'Versions' screen, hover over the relevant version to display the cog icon, then select Release from the drop-down menu.
2. If there are any issues set with this version as their 'Fix For' version, JIRA allows you to choose to change the 'Fix For' version if you wish. Otherwise, the operation will complete without modifying these issues.
ℹ️ To revert the release of a version, simply select Unrelease from the drop-down menu.

Archive a version

1. On the 'Versions' screen, hover over the relevant version to display the cog icon, then select Archive from the drop-down menu.
2. The version list indicates the version ‘archived’ status with a semi-transparent icon. The list of available operations is replaced with the 'Unarchive' operation. No further changes can be made to this version unless it is un-archived. Also it is not possible to remove any existing archived versions from an issue's affected and fix version fields or add any new archived versions.
To revert the archive of a version, simply select **Unarchive** from the drop-down menu.

**Merge multiple versions**

*Merger multiple versions* allows you to move the issues from one or more versions to another version.

1. On the 'Versions' screen, click the **Merge** link at the top right of the screen.
2. The 'Merge Versions' popup will be displayed. On this page are two select lists — both listing all un-archived versions.
   In the 'Merging From Versions' select list, choose the version(s) whose issues you wish to move. Versions selected on this list will be removed from the system. All issues associated with these versions will be updated to reflect the new version selected in the 'Merge To Version' select list. It is only possible to select one version to merge to.
3. Click the **Merge** button. If you are shown a confirmation page, click **Merge** again to complete the operation.

**Edit a version's details**

1. On the 'Versions' screen, hover over the relevant version to display the pencil icon.
2. This will allow you to edit the version's Name, Description and Release Date.
3. Click the **Update** button to save your changes.

**Delete a version**

1. On the 'Versions' screen, hover over the relevant version to display the cog icon, then select **Delete** from the drop-down menu.
2. This will bring you to the 'Delete Version: <Version>' confirmation page. From here, you can specify the actions to be taken for issues associated with the version to be deleted. You can either associate these issues with another version, or simply remove references to the version to be deleted.

**Reschedule a version**

*Rescheduling* a version changes its place in the order of versions.

- On the 'Versions' screen, click the **icon for the relevant version, and drag it to its new position in the version order.

**Running a Bamboo Build when Releasing a Version**

Releasing a new version of software usually involves a number of tasks, such as releasing the version in JIRA, building and testing, merging code, creating tags, creating branches, labelling builds, etc. If you have integrated JIRA with Atlassian's Bamboo, you can trigger these tasks to run automatically at the release of a version in JIRA.

When you release a JIRA version, you will have the option of selecting a Bamboo Plan and specifying which Stages in the Plan to run. Releasing the version will run the Plan in Bamboo. If the Plan is successful, the version will be released on JIRA. Otherwise, the version will not be released.

**Procedure**

To run a Bamboo build when releasing a version:

1. Log in to JIRA as a project administrator. (A project administrator is someone who has the **project-specific permission ‘Administer Project’**, but not necessarily the **global permission ‘JIRA Administrators’**.)
2. Navigate to Projects > the desired project > the desired version > Release.
   *If you are a JIRA administrator, ensure that you are not in ‘Administration’ mode, otherwise you will not...*
3. Release the version. The release build dialog will be displayed.
4. Enter the build details for the release:

<table>
<thead>
<tr>
<th>No Build</th>
<th>Choose this option if you do not want to run a Bamboo build, i.e. you only want to release the version in JIRA.</th>
</tr>
</thead>
</table>
| New Build | Choose this option, if you want to run a Bamboo build that has not been started:  
  * Using Plan — You can select any Plan in the linked Bamboo instance that you have permission to view (unless your administrator has configured basic HTTP authentication).  
  * Stages — You can select the Stages that you want to run for this release. Note, you cannot skip Stages.  
  * Build Variables — You can override any global variables or plan variables with your own parameters. See Running a Plan Build Manually in Bamboo. |
| Existing Build | Choose this option, if you want to run a Bamboo build that is in progress and has been paused at an optional Stage:  
  * Using Plan — You can select any Plan in the linked Bamboo instance that you have permission to view (unless your administrator has configured basic HTTP authentication).  
  * Stages — You can select the Stages that you want to run for this release. Note, you cannot re-run Stages that have been completed nor skip Stages.  
  * Build Variables — You can override any global variables or plan variables with your own parameters. See Running a Plan Build Manually in Bamboo. |

5. Click Release. The Bamboo build will run. If it is successful, the JIRA version will be released. If not, you can choose to run it again or select a different Plan.

Creating Release Notes

JIRA provides the functionality to create release notes for a specific version of a project. The release notes contain all issues within the specified project that are marked with a specific "Fix For" version. The release notes can also be generated in a number of formats (e.g. HTML, plain text, etc.) so as they can be included in various documents.

At present, two example format templates are provided - HTML and Text - using Velocity templates. Further format templates can be created and added to the system.

Generating Release Notes

1. On the top navigation bar, click the white triangle next to Projects. The projects dropdown will display.  
   Tip: You can access your current project directly by simply clicking the Projects link instead of the triangle.  
2. Click the project you wish to browse. If the project is not displayed in the dropdown, click View All Projects, which allows you to view a list of all accessible projects on your JIRA site, and select your project from there.  
3. Select Releases in the project navigation sidebar.  
4. Select the Version whose release notes you wish to generate by clicking on it.  
5. Click the 'Release Notes' link. The 'Release Notes' page will be displayed.  
6. Click the 'Configure Release Notes' link to configure the release notes. The 'Configure Release Notes' page will be displayed:  
   • Select the required project version for which the release notes will be generated in the 'Please select version' dropdown.  
   • Select the required format of the release notes — HTML and plain text format templates are provided in the 'Please select style' dropdown.  
7. Selecting the 'Create' button will generate the release notes using the specified template in the specified format. The release notes will be displayed on screen and can be copied and pasted to another application.

Configuring Security

When configuring security for your JIRA instance, there are two areas to address:
JIRA has a flexible security system which allows you to configure who can access JIRA, and what they can do/see within JIRA.

There are five types of security within JIRA:

1. **Global permissions** — these apply to JIRA as a whole (e.g. who can log in).
2. **Project permissions** — organised into permission schemes, these apply to projects as a whole (e.g. who can see the project's issues ('Browse' permission), create, edit and assign them).
3. **Issue security levels** — organised into security schemes, these allow the visibility of individual issues to be adjusted, within the bounds of the project's permissions.
4. **Comment visibility** — allows the visibility of individual comments (within an issue) to be restricted.
5. **Work-log visibility** — allows the visibility of individual work-log entries (within an issue) to be restricted. Does not restrict visibility of progress bar on issue time tracking.

---

**On this page:**

- Configuring permissions within JIRA
- Diagram: People and permissions
- Configuring security in the external environment
- Other security resources

**In this section:**

- Configuring Issue-level Security
- Managing Project Permissions
- Managing Project Roles
- Managing Global Permissions
- Configuring Secure Administrator Sessions
- Preventing Security Attacks
- JIRA Cookies
- JIRA Admin Helper
- Password Policy for JIRA

---

Diagram: People and permissions
Configuring security in the external environment

If your JIRA instance contains sensitive information, you may want to configure security in the environment in which your JIRA instance is running. Some of the main areas to consider are:

- File system — you should restrict access to the following directories (but note that the user which your JIRA instance is running as will require full access to these directories):
  - Index directory
  - Attachments directory

Other security resources

- User and Group Management
- JIRA Cookies
- Securing JIRA with Apache HTTP Server
- Configuring project specific security
- Tomcat security best practices
- Security Advisories
- Configuring Security

Configuring Issue-level Security

Issue security levels allow you to control who can see individual issues within a project (subject to the project's permissions).

An issue security level is a named collection of users. Issue security levels are created within issue security schemes, which are then associated with projects. Once an issue security scheme has been associated with a project, its security levels can be applied to issues in that project (note, sub-tasks will inherit the security level of their parent issue). Those issues will then only be accessible to members of that security level.

A security level's members may consist of:

- Individual users
- Groups
- Project roles
- Issue roles such as 'Reporter', 'Project Lead', and 'Current Assignee'
- 'Anyone' (eg. to allow anonymous access)
- A (multi-)user picker custom field.
- A (multi-)group picker custom field. This can either be an actual group picker custom field, or a (multi-)select-list whose values are group names.

Only users with the project-specific 'Set Issue Security' permission can apply a security level to an issue, regardless of whether they are members of the security level.
Why use issue security levels?

As an example, a company may have a public instance of JIRA running. Within this instance they may have several projects that external people (customers) can browse. However, it may not be appropriate to show all issues to the customers. To achieve this you could:

- Create an issue security scheme.
- Create an issue security level named ‘Private’ for this scheme.
- Add appropriate people to the ‘Private’ security level.
- Associate the issue security scheme with the relevant projects.
- Set the security level of specific issues to ‘Private’.

Creating an issue security scheme

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Issue Security Schemes to open the Issue Security Schemes page, which lists all the issue security schemes currently available in your JIRA installation.  
   
   Keyboard shortcut: g + g + start typing issue security schemes
3. Click the Add Issue Security Scheme button.

Add Issue Security Scheme

1. In the Add Issue Security Scheme form, enter a name for the issue security scheme, and a short description of the scheme. Then click the Add button.
2. You will return to the Issue Security Schemes page, which now contains the newly added scheme.

Adding a security level to an issue security scheme

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Issue Security Schemes to open the Issue Security Schemes page, which lists all the issue security schemes currently available in your JIRA installation.
3. Click the name of any scheme, or the link Security Levels (in the Operations column) to open the Edit Issue Security Levels page.

4. In the Add Security Level box, enter a name and description for your new security level and then click Add Security Level.

Screenshot 2: the 'Edit Issue Security Levels' page

---

Setting more than 10 issue security levels can impact performance in JIRA.

**Setting the Default Security Level for an issue security scheme**

You can choose to specify a Default Security Level for your issue security scheme.

The Default Security Level is used when issues are created. If the reporter of an issue does not have the permission ‘Set Issue Security’, then the issue’s security level will be set to the Default Security Level. If the project's issue security scheme does not have a Default Security Level, then the issue’s security level will be set to 'None'. (A security level of 'None' means that anybody can see the issue.)

1. Log in as a user with the JIRA Administrators global permission.

2. Choose  > Issues. Select Issue Security Schemes to open the Issue Security Schemes page, which lists all the issue security schemes currently available in your JIRA installation.

3. Click the name of any scheme or the link Security Levels to open the Edit Issue Security Levels page (above).
   - To set the 'default' security level for an issue security scheme, locate the appropriate Security Level and click its Default link (in the Operations column).
   - To remove the 'default' security level from an issue security scheme, click the ‘Change default security level to "None"' link (near the top of the page).

**Adding Users/Groups/Project Roles to a Security Level**

1. Log in as a user with the JIRA Administrators global permission.
Choose > Issues. Select Issue Security Schemes to open the Issue Security Schemes page, which lists all the issue security schemes currently available in your JIRA installation.

Keyboard shortcut: g + g + start typing issue security schemes

3. Click the name of any scheme or the link Security Levels to open the Edit Issue Security Levels page (above).

4. Locate the appropriate security level and click its Add link (in the Operations column), which opens the Add User/Group/Project Role to Issue Security Level page.

5. Select the appropriate user, group or project role, then click the Add button.

6. Repeat steps 4 and 5 until all appropriate users and/or groups and/or project roles have been added to the security level.

Assigning an issue security scheme to a project

1. Log in as a user with the JIRA Administrators global permission.

2. Choose > Projects. Select the name of the project of interest. The Project Summary page is displayed.

Keyboard shortcut: g + g + start typing projects

3. In the Permissions section of the Project Summary page, click the link corresponding to the Issues label to open the Associate Issue Security Scheme to Project page.

This will either be the name of the project's current issue security scheme, or the word None.

4. Select the issue security scheme that you want to associate with this project.

5. If there are no previously secured issues (or if the project did not previously have an issue security scheme), skip the next step.

6. If there are any previously secured issues, select a new security level to replace each old level. All issues with the security level from the old scheme will now have the security level from the new scheme. You can choose 'None' if you want the security to be removed from all previously secured issues.

7. Click the 'Associate' button to associate the project with the issue security scheme.

If the Security Level field is not displayed on the issue's screen after configuring the Issue-Level Security, use the Where Is My Field? tool to see why it is not being displayed.

If the Security Level field has been hidden on purpose, please see the limitations of doing so in Hiding or showing a field.

Deleting an issue security scheme

1. Log in as a user with the JIRA Administrators global permission.

2. Choose > Issues. Select Issue Security Schemes to open the Issue Security Schemes page, which lists all the issue security schemes currently available in your JIRA installation.

Keyboard shortcut: g + g + start typing issue security schemes

3. Click the Delete link (in the Operations column) for the scheme that you want to delete.

You cannot delete a issue security scheme if it is associated with a project. To do so, you must first remove any associations between the issue security scheme and projects in your JIRA installation — please refer to Assigning an Issue Security Scheme.

4. On the confirmation page, click Delete to confirm the deletion. Otherwise, click Cancel.

Copying an issue security scheme

1. Log in as a user with the JIRA Administrators global permission.

2. Choose > Issues. Select Issue Security Schemes to open the Issue Security Schemes page, which lists all the issue security schemes currently available in your JIRA installation.

Keyboard shortcut: g + g + start typing issue security schemes

3. Click the Copy link (in the Operations column) for the scheme that you want to copy. A new scheme will be created with the same security levels and the same users/groups/project roles assigned to them.

Your new scheme will be called 'Copy of ...'. You can edit your new scheme to give it a different name if you wish.
This table lists the different global permissions and the functions they secure:

<table>
<thead>
<tr>
<th>Global Permission</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA System Administrators</td>
<td>Permission to perform all JIRA administration functions. The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have the JIRA System Administrators permission, even if they do not also have the JIRA Administrators or JIRA Users permissions. A user with JIRA System Administrators will be able to log in to JIRA without the JIRA Users permission, but may not be able to perform all regular user functions (e.g. edit their profile) unless they also belong to a group that has the JIRA Users permission.</td>
</tr>
<tr>
<td>JIRA Administrators</td>
<td>Permission to perform most JIRA administration functions (see list of exclusions below). The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have the JIRA Administrators permission, even if they do not also have the JIRA System Administrators or JIRA Users permissions. A user with JIRA Administrators will be able to log in to JIRA without the JIRA Users permission, but may not be able to perform all regular user functions (e.g. edit their profile) unless they also belong to a group that has the JIRA Users permission.</td>
</tr>
<tr>
<td>JIRA Users</td>
<td>Permission to log in to JIRA. The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have this permission. If you want to reduce this count, see Updating your JIRA License Details. Granting the JIRA Users permission to a group results in all newly created users being automatically added to that group. The exception to this are groups that also have either the JIRA System Administrators or JIRA Administrators permissions, since JIRA prevents groups with these administrative-level global permissions from being granted the JIRA Users permission. Furthermore, it would be unwise to automatically grant these administrative-level global permissions to all new users.</td>
</tr>
<tr>
<td>Browse Users</td>
<td>Permission to view a list of all JIRA user names and group names. Used for selecting users/groups in popup screens. Enables auto-completion of user names in most 'User Picker' menus and popups. Note that the Assign User permissions also allows a limited version of this on a per-project basis.</td>
</tr>
<tr>
<td>Create Shared Objects</td>
<td>Permission to share a filter or dashboard globally or with groups of users. Also used to control who can create a JIRA Agile board.</td>
</tr>
<tr>
<td>Manage Group Filter Subscriptions</td>
<td>Permission to manage (create and delete) group filter subscriptions.</td>
</tr>
<tr>
<td>Bulk Change</td>
<td>Permission to execute the bulk operations within JIRA: - Bulk Edit - Bulk Move - Bulk Workflow Transition - Bulk Delete (*) (subject to project-specific permissions.) The decision to grant the Bulk Change permission should be considered carefully. This permission grants users the ability to modify a collection of issues at once. For example, in JIRA installations configured to run in Public mode (i.e. anybody can sign up and create issues), a user with the Bulk Change global permission and the Add Comments project permission could comment on all accessible issues. Undoing such modifications may not be possible through the JIRA application interface and may require changes made directly against the database (which is not recommended).</td>
</tr>
</tbody>
</table>
Managing Project Permissions

Project permissions are created within Permission Schemes, which are then assigned to specific projects.

Project permissions are able to be granted based on:

- Individual users
- Groups
- Project roles
- Issue roles such as 'Reporter', 'Project Lead' and 'Current Assignee'
- 'Anyone' (e.g. to allow anonymous access)
- A (multi-)user picker custom field.
- A (multi-)group picker custom field. This can either be an actual group picker custom field, or a (multi-)select-list whose values are group names.

The following table lists the different types of project permissions and the functions they secure. Note that project permissions can also be used in workflow conditions.

On this page:
- Permission Schemes
- Creating a Permission Scheme
- Associating a Permission Scheme with a Project
- Deleting a Permission Scheme
- Copying a Permission Scheme
- Global Permissions

<table>
<thead>
<tr>
<th>Project Permissions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer Projects</td>
<td>Permission to administer a project in JIRA. This includes the ability to edit project role membership, project components, project versions and some project details ('Project Name', 'URL', 'Project Lead', 'Project Description').</td>
</tr>
<tr>
<td>Browse Projects</td>
<td>Permission to browse projects, use the Issue Navigator and view individual issues (except issues that have been restricted via Issue Security). Many other permissions are dependent on this permission, e.g. the 'Work On Issues' permission is only effective for users who also have the 'Browse Projects' permission.</td>
</tr>
<tr>
<td>View Development Tools</td>
<td></td>
</tr>
<tr>
<td>View (Read-Only) Workflow</td>
<td>Permission to view the project's 'read-only' workflow when viewing an issue. This permission provides the 'View Workflow' link against the 'Status' field of the 'View Issue' page.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Issue Permissions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign Issues</td>
<td>Permission to assign issues to users. Also allows autocompletion of users in the Assign Issue drop-down. (See also Assignable User permission below)</td>
</tr>
<tr>
<td>Assignable User</td>
<td>Permission to be assigned issues. (Note that this does not include the ability to assign issues; see Assign Issue permission above).</td>
</tr>
<tr>
<td>Close Issues</td>
<td>Permission to close issues. (This permission is useful where, for example, developers resolve issues and testers close them). Also see the Resolve Issues permission.</td>
</tr>
<tr>
<td>Create Issues</td>
<td>Permission to create issues in the project. (Note that the Create Attachments permission is required in order to create attachments.) Includes the ability to create sub-tasks (if sub-tasks are enabled).</td>
</tr>
<tr>
<td>Permission</td>
<td>Explanation</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete Issues</td>
<td>Permission to delete issues. Think carefully about which groups or project roles you assign this permission to; usually it will only be given to administrators. Note that deleting an issue will delete all of its comments and attachments, even if the user does not have the Delete Comments or Delete Attachments permissions. However, the Delete Issues permission does not include the ability to delete individual comments or attachments.</td>
</tr>
<tr>
<td>Edit Issues</td>
<td>Permission to edit issues (excluding the 'Due Date' field — see the Schedule Issues permission). Includes the ability to convert issues to sub-tasks and vice versa (if sub-tasks are enabled). Note that the Delete Issue permission is required in order to delete issues. The Edit Issue permission is usually given to any groups or project roles who have the Create Issue permission (perhaps the only exception to this is if you give everyone the ability to create issues — it may not be appropriate to give everyone the ability to edit too). Note that all edits are recorded in the Issue Change History for audit purposes.</td>
</tr>
<tr>
<td>Link Issues</td>
<td>Permission to link issues together. (Only relevant if Issue Linking is enabled).</td>
</tr>
<tr>
<td>Modify Reporter</td>
<td>Permission to modify the 'Reporter' of an issue. This allows a user to create issues 'on behalf of' someone else. This permission should generally only be granted to administrators.</td>
</tr>
<tr>
<td>Move Issues</td>
<td>Permission to move issues from one project to another, or from one workflow to another within the same project. Note that a user can only move issues to a project for which they have Create Issue permission.</td>
</tr>
<tr>
<td>Resolve Issues</td>
<td>Permission to resolve and reopen issues. This also includes the ability to set the 'Fix For version' field for issues. Also see the Close Issues permission.</td>
</tr>
<tr>
<td>Schedule Issues</td>
<td>Permission to schedule an issue — that is, to edit the 'Due Date' of an issue. In older versions of JIRA this also controlled the permission to view the 'Due Date' of an issue.</td>
</tr>
<tr>
<td>Set Issue Security</td>
<td>Permission to set the security level on an issue to control who can access the issue. Only relevant if issue security has been enabled.</td>
</tr>
<tr>
<td>Transition Issues</td>
<td>Permission to transition (change) the status of an issue.</td>
</tr>
<tr>
<td>Voters &amp; Watchers Permissions</td>
<td>Permission to manage (i.e. view/add/remove users to/from) the watcher list of an issue.</td>
</tr>
<tr>
<td>Manage Watcher List</td>
<td>Permission to manage (i.e. view/add/remove users to/from) the watcher list of an issue. Also see the Manage Watcher List permission.</td>
</tr>
<tr>
<td>View Voters and Watchers</td>
<td>Permission to view the voter list and watcher list of an issue. Also see the Manage Watcher List permission.</td>
</tr>
<tr>
<td>Comments Permissions</td>
<td>Permission to add comments to issues. Note that this does not include the ability to edit or delete comments.</td>
</tr>
<tr>
<td>Add Comments</td>
<td>Permission to add comments to issues. Note that this does not include the ability to edit or delete comments.</td>
</tr>
<tr>
<td>Delete All Comments</td>
<td>Permission to delete any comments, regardless of who added them.</td>
</tr>
<tr>
<td>Delete Own Comments</td>
<td>Permission to delete comments that were added by the user.</td>
</tr>
<tr>
<td>Edit All Comments</td>
<td>Permission to edit any comments, regardless of who added them.</td>
</tr>
<tr>
<td>Edit Own Comments</td>
<td>Permission to edit comments that were added by the user.</td>
</tr>
</tbody>
</table>
### Attachments Permissions

<table>
<thead>
<tr>
<th>Permission</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Attachments</td>
<td>Permission to attach files to an issue. (Only relevant if attachments are enabled). Note that this does not include the ability to delete attachments.</td>
</tr>
<tr>
<td>Delete All Attachments</td>
<td>Permission to delete any attachments, regardless of who added them.</td>
</tr>
<tr>
<td>Delete Own Attachments</td>
<td>Permission to delete attachments that were added by the user.</td>
</tr>
</tbody>
</table>

### Time Tracking Permissions

<table>
<thead>
<tr>
<th>Permission</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work On Issues</td>
<td>Permission to log work against an issue, i.e. create a worklog entry. (Only relevant if Time Tracking is enabled).</td>
</tr>
<tr>
<td>Delete All Worklogs</td>
<td>Permission to delete any worklog entries, regardless of who added them. (Only relevant if Time Tracking is enabled). Also see the Work On Issues permission.</td>
</tr>
<tr>
<td>Delete Own Worklogs</td>
<td>Permission to delete worklog entries that were added by the user. (Only relevant if Time Tracking is enabled). Also see the Work On Issues permission.</td>
</tr>
<tr>
<td>Edit All Worklogs</td>
<td>Permission to edit any worklog entries, regardless of who added them. (Only relevant if Time Tracking is enabled). Also see the Work On Issues permission.</td>
</tr>
<tr>
<td>Edit Own Worklogs</td>
<td>Permission to edit worklog entries that were added by the user. (Only relevant if Time Tracking is enabled). Also see the Work On Issues permission.</td>
</tr>
</tbody>
</table>

### Permission Schemes

**What is a Permission Scheme?**

A permission scheme is a set of user/group/role assignments for the project permissions listed above. Every project has a permission scheme. One permission scheme can be associated with multiple projects.

**Why Permission Schemes?**

In many organisations, multiple projects have the same needs regarding access rights. (For example, only the specified project team may be authorised to assign and work on issues).

Permission schemes prevent having to set up permissions individually for every project. Once a permission scheme is set up it can be applied to all projects that have the same type of access requirements.

### Creating a Permission Scheme

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose **Issues** > **Permission Schemes** to open the Permission Schemes page, which displays a list of all permission schemes in your JIRA system and the projects that use each scheme. **Keyboard shortcut:** `g` + `g` + start typing 'permission schemes'
3. Click the 'Add Permission Scheme' link.
4. In the 'Add Permission Scheme' form, enter a name for the scheme, and a short description of the scheme. Click the 'Add' button.

**Screenshot: The 'Add Permission Scheme' form**
Adding Users, Groups or Roles to a Permission Scheme

1. Log in as a user with the 'JIRA Administrators' global permission.

2. Choose 🔄 > Issues. Select Permission Schemes to open the Permission Schemes page, which displays a list of all permission schemes in your JIRA system and the projects that use each scheme. 🔄 Keyboard shortcut: 'g' + 'g' + start typing 'permission schemes'

3. Locate the permission scheme of interest and click its name (or click the 'Permissions' link in the 'Operations' column) to show a list of permissions.

   Screenshot: Project Permissions

4. Click the 'Add' link in the 'Operations' column, which displays the 'Add Permission' page.

5. After selecting one or more permissions to add and who to add the selected permissions to, click the 'Add' button. The users/groups/roles will now be added to the selected permissions. Note that project roles are useful for defining specific team members for each project. Referencing project roles (rather than users or
groups) in your permissions can help you minimise the number of permission schemes in your system.

**Screenshot: Add Users To Permissions**

6. Repeat the last 2 steps until all required users/groups/roles have been added to the permissions.

**Deleting Users, Groups or Roles from a Permission Scheme**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **> Issues**. Select **Permission Schemes** to open the Permission Schemes page, which displays a list of all permission schemes in your JIRA system and the projects that use each scheme.
   
   \textbf{Keyboard shortcut:} \texttt{g + g +} start typing **permission schemes**
3. Locate the permission scheme of interest and click its name (or click the **Permissions** link in the 'Operations' column) to show the list of 'Project Permissions' (above).
4. Click the **Delete** link in the "Users / Groups / Roles" column next to the name of the user, group or project role you wish to delete.

**Associating a Permission Scheme with a Project**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **> Projects**.
   
   \textbf{Keyboard shortcut:} \texttt{g + g +} start typing **projects**
3. Select the project of interest to open the **Project Summary** administration page for that project. See Defining a Project for more information.
4. On the lower right, in the **Permissions** section, click the name of the current scheme (e.g. 'Default Permission Scheme') to display the details of the project's current permission scheme.
5. Click the **Actions** dropdown menu and choose 'Use a different scheme'.
6. On the 'Associate Permission Scheme to Project' page, which lists all available permission schemes, select the permission scheme you want to associate with the project.
7. Click the **Associate** button to associate the project with the permission scheme.

**Deleting a Permission Scheme**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **> Issues**. Select **Permission Schemes** to open the Permission Schemes page, which displays a list of all permission schemes in your JIRA system and the projects that use each scheme.
   
   \textbf{Keyboard shortcut:} \texttt{g + g +} start typing **permission schemes**
3. Click the Delete link (in the Operations column) for the scheme that you want to delete.
4. A confirmation screen will appear. To delete click Delete otherwise click Cancel.
5. The scheme will be deleted and all associated projects will be automatically associated with the Default Permission Scheme. (Note that you cannot delete the Default Permission Scheme.)

Copying a Permission Scheme

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose > Issues. Select Permission Schemes to open the Permission Schemes page, which displays a list of all permission schemes in your JIRA system and the projects that use each scheme.
   - Keyboard shortcut: g + g + start typing permission schemes
3. Click the Copy link (in the Operations column) for the scheme that you want to copy.
4. A new scheme will be created with the same permissions and the same users/groups/roles assigned to them.

Global Permissions

This table lists the different global permissions and the functions they secure:

<table>
<thead>
<tr>
<th>Global Permission</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA System Administrators</td>
<td>Permission to perform all JIRA administration functions. The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have the JIRA System Administrators permission, even if they do not also have the JIRA Administrators or JIRA Users permissions. A user with JIRA System Administrators will be able to log in to JIRA without the JIRA Users permission, but may not be able to perform all regular user functions (e.g. edit their profile) unless they also belong to a group that has the JIRA Users permission.</td>
</tr>
<tr>
<td>JIRA Administrators</td>
<td>Permission to perform most JIRA administration functions (see list of exclusions below). The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have the JIRA Administrators permission, even if they do not also have the JIRA System Administrators or JIRA Users permissions. A user with JIRA Administrators will be able to log in to JIRA without the JIRA Users permission, but may not be able to perform all regular user functions (e.g. edit their profile) unless they also belong to a group that has the JIRA Users permission.</td>
</tr>
<tr>
<td>JIRA Users</td>
<td>Permission to log in to JIRA. The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have this permission. If you want to reduce this count, see Updating your JIRA License Details. Granting the JIRA Users permission to a group results in all newly created users being automatically added to that group. The exception to this are groups that also have either the JIRA System Administrators or JIRA Administrators permissions, since JIRA prevents groups with these administrative-level global permissions from being granted the JIRA Users permission. Furthermore, it would be unwise to automatically grant these administrative-level global permissions to all new users.</td>
</tr>
<tr>
<td>Browse Users</td>
<td>Permission to view a list of all JIRA user names and group names. Used for selecting users/groups in popup screens. Enables auto-completion of user names in most <code>User Picker</code> menus and popups. Note that the Assign User permissions also allows a limited version of this on a per-project basis.</td>
</tr>
<tr>
<td>Create Shared Objects</td>
<td>Permission to share a filter or dashboard globally or with groups of users. Also used to control who can create a JIRA Agile board.</td>
</tr>
<tr>
<td>Manage Group Filter Subscriptions</td>
<td>Permission to manage (create and delete) group filter subscriptions.</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Bulk Change</strong></td>
<td>Permission to execute the <strong>bulk operations</strong> within JIRA:</td>
</tr>
<tr>
<td></td>
<td>- Bulk Edit *</td>
</tr>
<tr>
<td></td>
<td>- Bulk Move *</td>
</tr>
<tr>
<td></td>
<td>- Bulk Workflow Transition</td>
</tr>
<tr>
<td></td>
<td>- Bulk Delete * ([subject to project-specific permissions.])</td>
</tr>
</tbody>
</table>

⚠️ The decision to grant the **Bulk Change** permission should be considered carefully. This permission grants users the ability to modify a collection of issues at once. For example, in JIRA installations configured to run in **Public** mode (i.e. anybody can sign up and create issues), a user with the **Bulk Change** global permission and the **Add Comments** project permission could comment on *all* accessible issues. Undoing such modifications may not be possible through the JIRA application interface and may require changes made directly against the database (which is not recommended).

### Managing Project Roles

Project roles are a flexible way to associate users and/or groups with particular projects. Project roles also allow for delegated administration:

- JIRA administrators define JIRA's project roles — that is, all projects have the same project roles available to them.
- Project administrators assign members to project roles specifically for their project(s). A project administrator is someone who has the project-specific 'Administer Project' permission, but not necessarily the global 'JIRA Administrator' permission.

Project roles can be used in:

- permission schemes
- email notification schemes
- issue security levels
- comment visibility
- workflow conditions

Project roles can also be given access to:

- issue filters
- dashboards

### On this page:

- Using project roles
- JIRA's default project roles
- Viewing project roles
- Adding a project role
- Deleting a project role
- Editing a project role
- Assigning members to a project role
- Specifying 'default members' for a project role

Project roles are somewhat similar to **groups**, the main difference being that group membership is global whereas project role membership is project-specific. Additionally, group membership can only be altered by JIRA administrators, whereas project role membership can be altered by project administrators.

**About project leads and component leads** — Every project has a project lead and every project component has a component lead. These individual roles can be used in schemes, issues and workflows, just like project roles. You assign project/component leads when **Defining a Project** or **Defining a Component** respectively.
Using project roles

Project roles enable you to associate users with particular functions. For example, if your organisation requires all software development issues to be tested by a Quality Assurance person before being closed, you could do the following:

1. Create a project role called **Quality Assurance**.
2. Create a permission scheme called **Software Development**, in which you assign the ‘Close Issue’ permission to the **Quality Assurance** project role.
3. Associate the **Software Development** permission scheme with all software development projects.
4. For each software development project, add the appropriate Quality Assurance people to the **Quality Assurance** project role.

JIRA’s default project roles

When you install JIRA, three project roles are automatically created:

<table>
<thead>
<tr>
<th>Project Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Typically contains people who administer a given project.</td>
</tr>
<tr>
<td>Developers</td>
<td>Typically contains people who work on issues in a given project.</td>
</tr>
<tr>
<td>Users</td>
<td>Typically contains people who log issues in a given project.</td>
</tr>
</tbody>
</table>

You can create, edit and delete project roles according to your organisation's requirements.

Viewing project roles

To see what project roles exist, and where they are used:

1. Log in as a user with the ‘JIRA Administrators’ global permission.
2. Choose **System** > **Roles** to open the Project Role Browser page.
   - **Keyboard shortcut**: ‘g’ + ‘g’ + start typing ‘roles’
3. You will then see the Project Role Browser, which contains a list of all the project roles in your JIRA system:
   - **Screenshot: Project Role Browser**
   
4. To see where a project role is used, click the **View Usage** link. This will display a list of the project role's associated permission schemes, email notification schemes, issue security levels and workflow conditions.
5. Click any of the **View** links on the ‘View Usage for Project Role’ screen to see which users/groups are associated with a project role for a particular project.

Adding a project role
To define a new project role, enter its Name and a Description in the ‘Add Project Role’ form in the Project Role Browser (see ‘Viewing Project Roles’ above), and click the Add Project Role button. Note that project role names must be unique.

1. Click on Manage Default Members in the Operations column for the newly created Project Role.
2. Click Edit under Default Users to open this dialog:

![Assign Default Users to Project Role: QA dialog](image)

3. Select the User Picker icon to the right of the Add user(s) to project role field to open up this dialog:
4. Click the Select button at the bottom of this dialog when you are finished adding users and then click the Add button. You now see a list of users on the right that are now included in this Project Role.

Once a new project role is created, it is available to all projects. Project administrators can then assign members to the project role for their project (see Managing project role membership).

Deleting a project role

To delete a project role, locate the project role in the Project Role Browser (see 'Viewing Project Roles' above), and click the Delete link. The confirmation screen that follows lists any permission schemes, email notification schemes, issue security levels and workflow conditions that use the project role.

Note that deleting a project role will remove any assigned users and groups from that project role, for all projects. Be aware of the impact this may have; for example, if the project role membership was the sole conveyor of a permission for a user, then the user will no longer have that permission.

If a project role has been used to specify who can view a comment, deleting the project role will mean that no-one can see that comment any more.

Editing a project role

To edit the Name and Description of a project role, locate the project role in the Project Role Browser (see 'Viewing Project Roles' above), and click the Edit link.

Assigning members to a project role

A project role's members are assigned on a project-specific basis. To assign users/groups to a project role for a particular project, please see Managing project role membership.

To see/edit all the project roles to which a particular user belongs, for all projects, click the Project Roles link in the User Browser.

Specifying 'default members' for a project role

The default members for a project role are users and groups that are initially assigned to the project role for all
newly created projects. The actual membership for any particular project can then be modified by the project administrator.

The default members consist of the Default Users plus the Default Groups shown in the Project Role Browser (see 'Viewing Project Roles' above).

To add to the Default Users or the Default Groups for a project role, click the corresponding 'Edit' link.

For example, if a user called Susie needs to have administration permissions for all newly created projects, you could add her to the Default Users for the 'Administrator' project role as follows:

1. Open the Project Role Browser.
2. Click the Manage Default Members link.
3. Click the Edit link in the Administrators column (next to 'None selected').
4. In the 'Assign Default Users to Project Role' screen, click the User Picker icon.
5. Locate Susie in the 'User Picker' popup window, then click the Select button.
6. In the 'Assign Default Users to Project Role' screen, click the Add button.

Changing a project role's default members does not affect the actual project role members for projects already created.

Managing Global Permissions
Global permissions are system wide and are granted to groups of users.

See also project permissions, which apply to individual projects.

This table lists the different global permissions and the functions they secure:

<table>
<thead>
<tr>
<th>Global Permission</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA System Administrators</td>
<td>Permission to perform all JIRA administration functions. The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have the JIRA System Administrators permission, even if they do not also have the JIRA Administrators or JIRA Users permissions. A user with JIRA System Administrators will be able to log in to JIRA without the JIRA Users permission, but may not be able to perform all regular user functions (e.g. edit their profile) unless they also belong to a group that has the JIRA Users permission.</td>
</tr>
<tr>
<td>JIRA Administrators</td>
<td>Permission to perform most JIRA administration functions (see list of exclusions below). The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have the JIRA Administrators permission, even if they do not also have the JIRA System Administrators or JIRA Users permissions. A user with JIRA Administrators will be able to log in to JIRA without the JIRA Users permission, but may not be able to perform all regular user functions (e.g. edit their profile) unless they also belong to a group that has the JIRA Users permission.</td>
</tr>
</tbody>
</table>
### JIRA Users

Permission to log in to JIRA.

- The number of users that count towards your JIRA license is the sum of all users (including users in groups) that have this permission. If you want to reduce this count, see [Updating your JIRA License Details](#).

- Granting the **JIRA Users** permission to a group results in all newly created users being **automatically added** to that group. The exception to this are groups that also have either the **JIRA System Administrators** or **JIRA Administrators** permissions, since JIRA prevents groups with these administrative-level global permissions from being granted the **JIRA Users** permission. Furthermore, it would be unwise to automatically grant these administrative-level global permissions to all new users.

### Browse Users

Permission to view a list of all JIRA user names and group names. Used for selecting users/groups in popup screens. Enables auto-completion of user names in most 'User Picker' menus and popups.

Note that the **Assign User** permissions also allows a limited version of this on a per-project basis.

### Create Shared Objects

Permission to share a [filter](#) or [dashboard](#) globally or with groups of users. Also used to control who can [create a JIRA Agile board](#).

### Manage Group Filter Subscriptions

Permission to manage (create and delete) group filter subscriptions.

### Bulk Change

Permission to execute the [bulk operations](#) within JIRA:

- Bulk Edit
- Bulk Move
- Bulk Workflow Transition
- Bulk Delete

( subject to project-specific permissions.)

- The decision to grant the **Bulk Change** permission should be considered carefully. This permission grants users the ability to modify a collection of issues at once. For example, in JIRA installations configured to run in Public mode (i.e. anybody can sign up and create issues), a user with the **Bulk Change** global permission and the **Add Comments** project permission could comment on all accessible issues. Undoing such modifications may not be possible through the JIRA application interface and may require changes made directly against the database (which is not recommended).

### Granting global permissions

1. Log in as a user with the **JIRA Administrators** global permission (or the **JIRA System Administrators** global permission, if you need to grant the **JIRA System Administrators** global permission). By default, the user account created during the JIRA Setup Wizard has both of these global permissions.

2. Choose > System. Select **Global Permissions** to open the Global Permissions page, which lists JIRA's global permissions.

   - **Keyboard shortcut:** g + g + start typing **global permissions**
**Global Permissions**

These permissions apply to all projects. They are independent of project specific permissions. If you wish to set permissions on a set them up in the Permission Schemes.

**JIRA Permissions**

<table>
<thead>
<tr>
<th>Permissions</th>
<th>Users / Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>JIRA System Administrators</strong></td>
<td>syst View</td>
</tr>
<tr>
<td>Ability to perform all administration functions. There must be at least one group with this permission.</td>
<td>conf View</td>
</tr>
<tr>
<td>Note: People with this permission can always log in to JIRA.</td>
<td>jdog View</td>
</tr>
<tr>
<td><strong>JIRA Administrators</strong></td>
<td>jira-t View</td>
</tr>
<tr>
<td>Ability to perform most administration functions (excluding Import &amp; Export, SMTP Configuration, etc.).</td>
<td>jdog View</td>
</tr>
<tr>
<td>Note: People with this permission can always log in to JIRA.</td>
<td>jira-c View</td>
</tr>
<tr>
<td><strong>JIRA Users</strong></td>
<td>jira-c View</td>
</tr>
<tr>
<td>Ability to log in to JIRA. They are a 'user'. Any new users created will automatically join these groups, unless those groups have JIRA System Administrators or JIRA Administrators permissions.</td>
<td>jira-c View</td>
</tr>
<tr>
<td>Note: All users need this permission to log in to JIRA, even if they have other permissions.</td>
<td>jira-c View</td>
</tr>
<tr>
<td><strong>Browse Users</strong></td>
<td>jira-c View</td>
</tr>
<tr>
<td>Ability to select a user or group from a popup window as well as the ability to use the 'share' issues feature. Users with this permission will also be able to see names of all users and groups in the system.</td>
<td>jira-c View</td>
</tr>
</tbody>
</table>

The **Add Permission** box is shown at the bottom of the list (not displayed in the screen capture above).

3. In the **Permission** dropdown list, select the global permission you wish to grant.

4. In the **Group** dropdown list, either:
   - select the **group** to which you wish to grant the permission; or
   - if you wish to grant the permission to non logged-in users, select **Anyone**. This is **not** recommended for production systems, or systems that can be accessed from the public Internet such as JIRA.
Cloud.

**Please Note:**

- The **JIRA Users** permission (i.e. permission to log in) cannot be granted to **Anyone** (i.e. to non-logged-in users) since this would be contradictory.
- The **JIRA Users** permission cannot be granted to groups that have the **JIRA System Administrators** or **JIRA Administrators** permissions.
- If you have a user limited license (e.g. personal license) and have reached your user limit, you will not be able to grant the **JIRA Users** permission (i.e. permission to log in) to any further groups without first reducing the number of users with the **JIRA Users** permission.

Removing global permissions

1. Log in as a user with the **JIRA Administrators** global permission (or the **JIRA System Administrators** global permission, if you need to remove the **JIRA System Administrators** global permission).
   - By default, the user account created during the **JIRA Setup Wizard** has both of these global permissions.
2. Choose **Setup** > **System**. Select **Global Permissions** to open the Global Permissions page, which lists JIRA's global permissions.
   
   - **Keyboard shortcut:** `g + g +` start typing **global permissions**
   
   - For each global permission in JIRA (indicated on the left of this page), groups which currently have that permission are shown on the right (under the **Users / Groups** column).
3. Locate the global permission you want to remove from a group as well as the group you want to remove that permission from (under **Users / Groups**) and click the **Delete** link next to that group.

About 'JIRA System Administrators' and 'JIRA Administrators'

People who have the **JIRA System Administrators** permission can perform all of the administration functions in JIRA, while people who have only the **JIRA Administrators** permission cannot perform functions which could affect the application environment or network. This separation is useful for organisations which need to delegate some administrative privileges (e.g. creating users, creating projects) to particular people, without granting them complete rights to administer the JIRA system.

People who have the **JIRA Administrators** permission (and not the **JIRA System Administrators** permission) **cannot** do the following:

- Configure JIRA's SMTP mail server for notifications (but they can configure POP/IMAP mail servers for the receipt of email messages that create issue comments and new issues, and fully administer email notification schemes).
- Configure a CVS source code repository (but they can associate a project with a configured repository).
- Configure listeners.
- Configure services (except for POP/IMAP services).
- Change the index path (but they can reindex and optimise the index).
- Run the integrity checker.
- Access logging and profiling information.
- Access the scheduler.
- Export/backup JIRA data to XML.
- Import/restore JIRA data from XML.
- Import XML workflows into JIRA.
- Configure attachments (but they can set the size limits of attachments and enable thumbnails).
- Run Jelly scripts.
- Add gadgets to the Gadget Directory.
- Configure user directories (e.g. LDAP).
- Configure Application Links that use an authentication type other than OAuth.
- View user sessions.
- Access license details.
- Grant/revoke the **JIRA System Administrators** global permission.
- Edit (or Bulk Edit) groups that have the **JIRA System Administrators** global permission.
- Edit, change the password of or delete a user who has the **JIRA System Administrators** global permission.
- Upload and/or install an Add-on.
It is recommended that people who have the JIRA Administrators permission (and not the JIRA System Administrators permission) are not given direct access to the JIRA filesystem or database.

Separating 'JIRA System Administrators' from 'JIRA Administrators' in default JIRA installations

By default, the jira-administrators group has both the JIRA Administrators permission and the JIRA System Administrators permission. Also by default, the user account created during the JIRA Setup Wizard is a member of this jira-administrators group.

If you need some people to have only the JIRA Administrators permission (and not the JIRA System Administrators permission), you will need to use two separate groups, e.g.:

1. Create a new group (e.g. called jira-system-administrators).
2. Add to the jira-system-administrators group everyone who needs to have the JIRA System Administrators permission.
3. Grant the JIRA System Administrators permission to the jira-system-administrators group.
4. Remove the JIRA System Administrators permission from the jira-administrators group.
5. (Optional, but recommended for ease of maintenance) Remove from the jira-administrators group everyone who is a member of the jira-system-administrators group.

Troubleshooting permissions with the JIRA admin helper

The JIRA admin helper can help you diagnose why a user can or cannot see a certain issue. This tool is only available to JIRA administrators.

To diagnose why a user can or cannot see an issue:

1. Choose 🔄 at the top right of the screen. Then choose Add-ons > Admin Helper > Permission Helper. Keyboard shortcut: g + g + start typing 'Permission Helper'
2. Enter the username of the user (leave blank for anonymous users), an issue key (for example, an issue that the user can/cannot see) and the permission to check.
3. Click Submit.

Screenshot: Permissions helper (click to view larger image)

Configuring Secure Administrator Sessions

JIRA protects access to its administrative functions by requiring a secure administration session in order to use the JIRA administration screens. (This is also known as websudo.) When a JIRA administrator (who is logged into JIRA) attempts to access an administration function, they are prompted to log in again. This logs the administrator into a temporary secure session that grants access to the JIRA administration screens.

The temporary secure session has a rolling timeout (defaulted to 10 minutes). If there is no activity by the administrator in the JIRA administration screens for a period of time that exceeds the timeout, then the administrator will be logged out of the secure administrator session (note that they will remain logged into JIRA).
If the administrator does click an administration function, the timeout will reset.

Note that Project Administration functions (as defined by the 'Project Administrator' permission) do not require a secure administration session.

### On this page:

- Manually ending a Secure Administrator Session
- Disabling Secure Administrator Sessions
- Changing the Timeout
- Developer Notes

### Manually ending a Secure Administrator Session

An administrator can choose to manually end their secure session by clicking the 'drop access' link in the banner displayed at the top of their screen.

### Disabling Secure Administrator Sessions

Secure administrator sessions (i.e. password confirmation before accessing administration functions) are enabled by default. If this causes issues for your JIRA site (e.g. if you are using a custom authentication mechanism), you can disable this feature by specifying the following line in your `jira-config.properties` file:

```
jira.websudo.is.disabled = true
```

ℹ️ You will need to restart your JIRA server for this setting to take effect.

### Changing the Timeout

To change the number of minutes of inactivity after which a secure administration session will time out, specify the `jira.websudo.timeout` property (in your `jira-config.properties` file) whose value is the number of minutes of inactivity required before a secure administration session times out.

For example, the following line in your `jira-config.properties` file will end a secure administration session in 10 minutes:

```
jira.websudo.timeout = 10
```

ℹ️ You will need to restart your JIRA server for this setting to take effect.

### Developer Notes

If you have written a plugin that has webwork actions in the JIRA Administration section, those actions should have the `@WebSudoRequired` annotation added to the class (not the method or the package, unlike Confluence).

Please also see Developing against JIRA with Secure Administrator Sessions and Adding WebSudo Support to your Plugin.

### Preventing Security Attacks

This page provides guidelines which, to the best of our knowledge, will help prevent security attacks on your JIRA installation.

#### Use Strong Passwords

Administrators should use Strong Passwords
All your JIRA administrators, JIRA system administrators and administrators of all Atlassian products should have strong passwords. Ask your administrators to update their passwords to strong passwords.

Do not use passwords that are dictionary words. Use mixed-case letters, numbers and symbols for your administrator passwords and make sure they are sufficiently long (e.g. 14 characters). We encourage you to refer to the Strong Password Generator for guidelines on selecting passwords.

Using strong passwords greatly increases the time required by an attacker to retrieve your passwords by brute force, making such an attack impractical.

**Administrators should have Different Passwords for Different Systems**

As well as choosing a strong password, administrators should have *different* strong passwords for different systems.

This will reduce the impact the attacker can have if they do manage to obtain administrator credentials on one of your systems.

**Apply JIRA Security Patches**

Apply the patches found in any security advisories that we release for your version of JIRA.

These patches protect JIRA from recently detected privilege escalation and XSS vulnerabilities.

**Protect Against Brute Force Attack**

You can also actively protect your systems against repeated unsuccessful login attempts, known as "brute force" login attacks.

**Enable Brute Force Login Protection on your Web Server**

It is possible to also enable brute force login protection on your web server by detecting repeated authentication failures in application logs. Once repeated login failures have been detected, you can set up an automated system to ban access to your web server from that particular IP address.

For more information on how to configure an automated approach to this kind of login prevention, refer to Using Fail2Ban to limit login attempts.

**Restrict Network Access to Administrative Sections of Applications**

An Atlassian application's administration interface is a critical part of the application; anyone with access to it can potentially compromise not only the application instance but the entire machine. As well as limiting access to only users who really need it, and using strong passwords, you should consider limiting access to it to certain machines on the network.

For more information on how to implement Apache blocking rules to restrict access to administrative or sensitive actions in:

- JIRA, refer to Using Apache to Limit Access to the JIRA Administration Interface
- Confluence, refer to Using Apache to limit access to the Confluence administration interface

You can use a similar approach to protecting all Atlassian applications.

**Restrict File System Access by the Application Server**

The application server (e.g. Tomcat) runs as a process on the system. This process is run by a particular user and inherits the file system rights of that particular user. By restricting the directories that can be written to by the application server user, you can limit unnecessary exposure of your file system to the application.

For example, ensure that only the following directories can be written to by JIRA's application server:

- The following subdirectories of your JIRA Installation Directory for 'recommended' JIRA distributions (or for JIRA WAR distributions, the installation directory of the Apache Tomcat application running JIRA):
  - logs
  - temp
  - work
- Your JIRA Home Directory.
For detailed instructions, please see Tomcat security best practices.

**Disable Jelly**

Jelly is disabled in JIRA by default. If you need to use Jelly, you should enable it immediately prior to use and disable it immediately afterwards. See the JIRA Jelly Tags documentation for details.

### On this page:
- Use Strong Passwords
  - Administrators should use Strong Passwords
  - Administrators should have Different Passwords for Different Systems
- Apply JIRA Security Patches
- Protect Against Brute Force Attack
  - Enable Brute Force Login Protection on your Web Server
- Restrict Network Access to Administrative Sections of Applications
- Restrict File System Access by the Application Server
- Disable Jelly
- Configuring Tomcat to use HttpOnly Session ID Cookies
- See Also

---

**Configuring Tomcat to use HttpOnly Session ID Cookies**

'Recommended' (formerly Standalone) distributions of JIRA from version 4.1.2 enforce the HttpOnly flag on session ID cookies by default, as a means to minimise the risk of common XSS attacks. For more information about this feature, please refer to the JIRA Security Advisory 2010-06-18.

If you are running the JIRA WAR distribution on Tomcat (version 5.5.27+ or another application server that is unsupported), it is likely that JIRA's session ID cookies will not be transmitted with the HttpOnly flag. Hence, to mitigate the risk of common XSS attacks, we recommend that you configure your application server to transmit HttpOnly session ID cookies.

To configure your JIRA WAR distribution running on Tomcat to use HttpOnly Session ID Cookies:

1. Shutdown the JIRA service running on Tomcat and the Tomcat application server.
2. Open the context.xml file of the Tomcat installation running JIRA in a text editor.
   - This file is typically located in the conf subdirectory of the main Tomcat installation directory.
3. Add the following Manager element within the Context element of this file:

   ```xml
   ...<Context>
   ...
   <Manager useHttpOnly="true"/>
   ...
   </Context>
   ...
   ```

   To disable HttpOnly Session ID cookies, either remove this Manager element or change the value of its useHttpOnly parameter to false.
4. Save your changes to the context.xml file and restart JIRA.

**See Also**

If you suspect that your publicly accessible JIRA installation has been compromised by a security attack, please refer to our detection guide for more information on how to identify signs of attack.
JIRA Cookies

This page lists cookies stored in JIRA users’ browsers which are generated by JIRA itself. This page does not list cookies that may originate from 3rd-party JIRA plugins.

Authentication cookies

JIRA uses Seraph, an open source framework, for HTTP cookie authentication. JIRA uses two types of cookies for user authentication:

- The JSESSIONID cookie is created by the application server and used for session tracking purposes. This cookie contains a random string and the cookie expires at the end of every session or when the browser is closed.
- The ‘remember my login’ cookie (aka the ‘remember me’ cookie), seraph.rememberme.cookie, is generated by JIRA when the user selects the Remember my login on this computer check box on the login page.

You can read about cookies on the Wikipedia page about HTTP cookies.

On this page:

- Authentication cookies
- The 'remember my login' cookie
- Other JIRA cookies

The 'remember my login' cookie

The ‘remember my login’ cookie, seraph.rememberme.cookie, is a long-lived HTTP cookie. This cookie can be used to authenticate an unauthenticated session. JIRA generates this cookie when the user selects the Remember my login on this computer check box on the login page.

Cookie key and contents

By default, the cookie key is seraph.rememberme.cookie, which is defined by the login.cookie.key parameter in the <jira-application-dir>/WEB-INF/classes/seraph-config.xml file of your JIRA Installation Directory.

The cookie contains a unique identifier plus a securely-generated random string (i.e. token). This token is generated by JIRA and is also stored for the user in the JIRA database.

Use of cookie for authentication

When a user requests a web page, if the request is not already authenticated via session-based authentication or otherwise, JIRA will match the ‘remember my login’ cookie (if present) against the token (also if present), which is stored for the user in the JIRA database.

If the token in the cookie matches the token stored in the database and the cookie has not expired, the user is authenticated.

Life of 'remember my login' cookies

You can configure the maximum age of the cookie. To do that you will need to modify the <jira-application-dir>/WEB-INF/classes/seraph-config.xml file of your JIRA Installation Directory and insert the following lines below the other init-param elements:

```xml
<init-param>
  <param-name>autologin.cookie.age</param-name>
  <param-value>2592000</param-value> <!-- The value of 30 days in seconds -->
</init-param>
```

Other JIRA cookies

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
There are several cookies that JIRA uses for a variety of other purposes, such as to enhance JIRA’s security and to store basic presentation and browser capability states, including the type of search view that was last used and various other presentation states. JIRA users’ authentication details are not stored by these cookies.

<table>
<thead>
<tr>
<th>Cookie Key</th>
<th>Purpose</th>
<th>Cookie Contents</th>
<th>Expiry</th>
</tr>
</thead>
<tbody>
<tr>
<td>atlassian.xsrf.token</td>
<td>Helps prevent XSRF attacks. Ensures that during a user’s session, browser requests sent to a JIRA server originated from that JIRA server. For more information about XSRF checking by JIRA, see Form Token Checking on the Atlassian Developers site.</td>
<td>Your JIRA server’s Server ID, a securely-generated random string (i.e. token) and a flag indicating whether or not the user was logged in at the time the token was generated.</td>
<td>At the end of every session or when the browser is closed.</td>
</tr>
<tr>
<td>jira.issue.navigator.type</td>
<td>Tracks which type of search view was last used (i.e. simple or advanced searching).</td>
<td>A string indicating the state of your last search view.</td>
<td>Approximately 10 years from the date it is set or was last updated.</td>
</tr>
<tr>
<td>AJS.conglomerate.cookie</td>
<td>Tracks which general tabs were last used (e.g. in JIRA’s plugin manager) or expansion elements were last opened or closed.</td>
<td>One or more key-value strings which indicate the states of your last general tab views or expansion elements.</td>
<td>One year from the date it is set or was last updated.</td>
</tr>
<tr>
<td>UNSUPPORTED_BROWSER_WARNING</td>
<td>Acknowledges that the user has read a message displayed by JIRA indicating that the user’s browser is not supported by JIRA.</td>
<td>A string which indicates that the user has clicked a button acknowledging they have read the message stating they are using an unsupported browser.</td>
<td>At the end of every session or when the browser is closed.</td>
</tr>
<tr>
<td>AJS.thisPage</td>
<td>Indicates that the user's browser does not support local storage. This relates to a mechanism used by JIRA to store field information in search views when the user clicks their browser's back button.</td>
<td>A string which indicates that the user's browser does not support local storage.</td>
<td>At the end of every session or when the browser is closed.</td>
</tr>
</tbody>
</table>

**JIRA Admin Helper**

- **Field Helper**
- **Permission Helper**
- **Notification Helper**

The JIRA Admin Helper is a **free, bundled plugin** that answers questions like:

- Why isn’t my field showing up on view/edit/create screens?
- Why can/can’t a user see a certain issue?
- Why did/didn’t a user get a certain email notification?
The JIRA Admin Helper plugin is visible only to JIRA Administrators. When you are viewing an issue, it is available from the Admin menu.

Field Helper

If you’re logged in as a JIRA administrator, you can use the Field Helper – displayed as a Where is my field? link – to help you determine why a field is not appearing on a specific screen. The Field Helper works with custom fields as well as JIRA system fields.

The Where is my field? link is available on:

- Create Issue – in Configure Fields pop up
- Edit issue - in Configure Fields pop up
- View Issue - in More Actions menu
- Issue Navigator – in cog menu

Simply click on the link and then enter the field name in the search box!

Here's an example:

![Field Helper Example](image)

After you enter the name of the missing field, the Field Helper returns a form that explains why this field is not appearing:
You can then use this information to fix your screen by adding this field to your project and issue type.

Permission Helper

The JIRA Admin Helper can help you diagnose why a user can or cannot see a certain issue.

To diagnose why a user can or cannot see an issue:

1. Choose ⚒ at the top right of the screen. Then choose Add-ons > Admin Helper > Permission Helper.
1. **Keyboard shortcut:** `g + g` + start typing 'Permission Helper'

2. Enter the username of the user (leave blank for anonymous users), an issue key (for example, an issue that the user can/cannot see) and the permission to check.

3. Click **Submit.**

---

**Permission Helper**

Discover why a user does or does not have certain permissions...

**User:**

Begin typing to find a user, leave blank for Anonymous user

**Permission:**

Browse Projects

Begin typing to find a permission or press down to see all

---

**Notification Helper**

The Notification Helper can help figure out why a user didn't get an email notification when a comment was added. It's available from the view issue page, the issue navigator, and from JIRA Administration.

**To diagnose why a user didn't receive a notification:**

1. Choose **gear** at the top right of the screen. Then choose **Add-ons > Admin Helper > Notification Helper**

   **Keyboard shortcut:** `g + g` + start typing 'Notification Helper'

2. Enter the username of the user (leave blank for anonymous users) and select the Notification Event from the dropdown list.

3. Click **Submit.**

---

**Notification Helper**

Find out why users receive, or do not receive notifications for this issue

**User:rss**

Begin typing to find a user

**Notification Event:**

Issue Created

Begin typing to find a notification event or press down to see all
Password Policy for JIRA

Overview

The JIRA password policy enables JIRA Administrators to set limits and restrictions on the types of passwords their users can create. You can use this feature to create a more secure JIRA system for your company.

Note: The JIRA password policy is disabled by default. To turn it on and configure it, follow the instructions below. Also, this policy is only useful when JIRA users can change their own passwords. If JIRA is connected to an Active Directory, this policy should not be used.

Enabling the password policy

1. Log in as a user with the JIRA Administrators global permission.

   Choose the cog icon > System. Next, select Password Policy on the left.

   Keyboard shortcut: g + g + start typing password

   Select one of the following options:
   a. Disabled – The equivalent of having no password policy.
   b. Basic – Requires passwords to be at least 8 characters long and use at least 2 character types. Rejects passwords that are very similar to the previous password or the user's public information.
   c. Secure – Requires passwords to be at least 10 characters long and use at least 3 character types including at least 1 special character. Rejects passwords that are even slightly similar to the previous password or the user's public information.
   d. Custom – Lets you use your own settings.

2. Configure the following fields:
   a. Password Length – Set a minimum and maximum length for your passwords.
      i. Currently, you must set a maximum length if you enable the password policy and the maximum value allowed is 255.
   b. Character Variety – Use these fields to set requirements around the types of characters – uppercase letters, lowercase letters, special characters, and so on – that are required.
   c. Similarity Checks – See the section below for details on this feature.

3. Click the Update button at the bottom of the screen when you are ready.

Similarity Checks

This is a system check to make sure that your users aren't creating a new password that is too similar to the current password, the user's name or email address. It can be set to Ignored, Lenient, or Strict.

What is the difference between lenient and strict?

- Lenient checks for obvious similarities, like reversing the username or moving the front letter to the end.
- Strict checks for more subtle variations, like mixing up the letters or adding just one new character. It also performs a character frequency analysis.

Password FAQ

Question: Why would you ever want a maximum password length?

Answer: Maybe you shouldn't, but you may want to do this for security or other reasons. For example, if you are using a writable external user directory, then that external directory may have its own restrictions on the maximum password length that it allows.

Question: What is Character Variety and why should I use this?

Answer: Character variety refers to the different types of characters you can create on a keyboard: lowercase letters, uppercase letters, numbers, and special characters. Requiring different character types makes passwords harder to guess, but it might also make them harder to remember. Use your best judgment when setting these fields, keeping in mind your company's requirements as well as your user base.

Question: Does this policy affect existing passwords?

Answer: The policy is only enforced as passwords are changed; there is no way to detect whether or not existing passwords satisfy the policy or to force the users to update their passwords if the policy has been
changed. As a workaround, you can use this Crowd REST resource to forcibly change the users' passwords to something they won't know, thereby requiring them to reset it to get back in, and the password reset enforces the policy rules.

Configuring Fields and Screens

Overview

To help you tailor JIRA to your organization's needs, JIRA enables you to manipulate the display and behavior of issue fields ('Summary', 'Description', 'Issue Type', etc). You can:

- Change a field's description
- Make a field hidden or visible
- Make a field required or optional
- Add your own values for 'Issue Type', 'Priority', 'Resolution' and 'Status'
- Create new 'custom' fields
- Enable a rich text renderer for (some) fields
- Position fields on a screen
- Choose which screen should be displayed for each issue operation (e.g. 'Create Issue', 'Edit Issue') or workflow transition (e.g. 'Resolve Issue', 'Close Issue')
Concepts

Some key JIRA concepts include:

- **Field Configuration** — a set of definitions for all fields, comprising: each field's description; whether each field is hidden or visible; whether each field is required or optional; and what type of renderer to use for each text field.

- **Screen** — defines which fields are present on a screen, and their order. (Note that a hidden field can be present on a screen, but will still be invisible.)

- **Screen Scheme** — associates different screens with different issue operations (e.g. 'Create Issue', 'Edit Issue', 'View Issue').

- **Workflow** — defines the steps (i.e. statuses) and transitions to other steps that an issue moves through during its lifecycle. Screens can also be mapped to different transitions of a workflow.

- **Field Configuration Scheme** — associates Field Configurations with **issue types**, which in turn is applied to projects. This allows you to specify different behaviors for a field, for each type of issue in a given project.

- **Issue Type Screen Scheme** — associates Screen Schemes with **issue types**, which in turn is applied to projects. This allows you to specify different screens for a particular operation (e.g. 'Create Issue'), for each type of issue in a given project. For example, you could use one screen when creating an issue of type 'Bug', and a different screen when creating an issue of type 'Task'.

- **Workflow Scheme** — associates Workflows with **issue types**, which in turn is applied to projects. This allows you to specify different workflows for each type of issue in a given project.

- **Issue Type Scheme** — is applied to projects and defines (or restricts) which **issue types** are available to those projects.

If the Field Configuration Scheme, Issue Type Screen Scheme and Workflow Scheme associated with a given project contain associations with other issue types that are not specified in the project's Issue Type Scheme, then those other issue types will be ignored by the project since the project's Issue Type Scheme restricts what issue types the project can use.

Related topics

- Configuring Built-in Fields
  - Defining Issue Type Field Values
  - Associating Issue Types with Projects
  - Defining Priority Field Values
Configuring Built-in Fields

Each issue has a number of built-in fields, as shown in the sample issue in the JIRA User's Guide.

Some of the built-in fields can be customized as follows:

- Defining Issue Type Field Values
- Defining Priority Field Values
- Defining Resolution Field Values
- Defining Status Field Values
- Translating Resolutions, Priorities, Statuses and Issue Types

Defining Issue Type Field Values

JIRA ships with a set of default 'issue types' to help you get started. Everyone's needs are different and so JIRA also allows you to add, edit and delete your own custom issue types. The diagram on Configuring Fields and Screens shows how issue types relate to other entities in JIRA.

Note that you can also:

- Control the set of available issue types for each project — see Associating Issue Types with Projects.
- Control the display order of available issue types and the default issue type for each project — see Associating Issue Types with Projects.
  
  *Reordering* issue types changes the order in which they are displayed to the user who is creating an issue; and the default issue type is the one that is displayed in the selection-box (see Creating an Issue).

- Associate particular issue types with specific fields, screens and workflow — for details see Associating Field Behavior with Issue Types, Associating Screens with Issue Types and Activating workflow, respectively.

*Tip:* You can quickly configure the workflow/screen design of an existing issue type for a project via the project administration page. See Defining a Project for details.

On this page:
- Creating an issue type
- Deleting an issue type
- Editing an issue type

Creating an issue type

When creating a new issue type in JIRA, you can create either a new standard or sub-task issue type. However, to create a sub-task issue type, you must Enable sub-tasks.

You can also create sub-tasks on the Sub-Tasks page. See Creating a sub-task issue type for details.

To create a new issue type:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Issue Types to open the Issue Types page, which lists all issue types.

   *Keyboard shortcut:* `g` + `g` + start typing issue types
3. Click the **Add Issue Type** button to open the **Add New Issue Type** dialog box.

4. Complete the **Add New Issue Type** dialog box:
   - **Name** — enter a short phrase that best describes your new issue type.
   - **Description** — enter a sentence or two to describe when this issue type should be used.
   - **Type** — specify whether the issue type you are creating is a **Standard** issue type or a **Sub-Task** issue type. Sub-tasks are associated with individual **Standard** issues.
     - This option will not be available if **sub-tasks are disabled**.
   - **Icon URL** — supply the path of an image that has been placed somewhere inside `<jira-application-dir>/images/icons` of your **JIRA Installation Directory** or from an accessible URL.
5. Click the **Add** button to create your new issue type. 
   
   Your new issue type will be automatically added to the **Default Issue Type Scheme**. You may want to also add it to other issue type schemes — for more information, see [Managing Issue Type Schemes](#).

### Deleting an issue type

**Before you begin:**

- If any issues of the Issue Type you are about to delete exist in your JIRA installation, please ensure this Issue Type has the following requirements (to ensure JIRA prompts you to choose a new Issue Type for those issues):
  - the same Workflow in all **Workflow Schemes** that are associated with one or more projects.
  - the same Field Configuration in all **Field Configuration Schemes** that are associated with one or more projects.
  - the same Screen Scheme in all **Issue Type Screen Schemes** that are associated with one or more projects.

  - Alternatively, you can simply search for all issues that currently use the Issue Type which you are about to delete and perform a **Bulk Move** to change those issues to a different Issue Type.

**To delete an Issue Type:**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **> Issues**. Select **Issue Types** to open the Issue Types page, which lists all issue types. 
   - **Keyboard shortcut:** `g + g + start typing issue types`
3. Click the **Delete** link (in the **Operations** column) for the issue type that you wish to delete.
4. Complete the fields

### Editing an issue type

**To change the name, description or icon for an issue type:**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **> Issues**. Select **Issue Types** to open the Issue Types page, which lists all issue types. 
   - **Keyboard shortcut:** `g + g + start typing issue types`
3. Click the **Edit** link (in the **Operations** column) for the issue type that you wish to edit.
4. Edit the **Name**, **Description** and/or **Icon** as described above for Creating an issue type.

**Please Note:** To reorder an Issue Type, or set it as a default, see [Associating Issue Types with Projects](#). (Reordering issue types changes the order in which they are displayed to the user who is creating an issue; and the **default** issue type is the one that is displayed in the selection-box — see [Creating an Issue](#).)
Associating Issue Types with Projects

What is an 'issue type scheme'?

An 'issue type scheme' defines a subset of issue types, which:

- restricts the set of available issue types for a project, and
- controls the order of available issue types and the default issue type shown to your users for a project.

The 'default issue type' is the issue type displayed in the selection-box when a user creates an issue.

A single issue type scheme can be 're-used' across multiple projects, so that a group of similar projects (i.e. projects which might be used for similar purposes) can share the same issue type settings.

For example, all projects in your company may fit one of two 'purpose' categories:

- Development-related projects or
- Support-related projects.

Hence, you could create one scheme called Development Issue Type Scheme (with issue types Bug and Feature) and another called Support Issue Type Scheme (with issue types Development Query and Support Request).

You can then associate each of these schemes with the appropriate project(s), for which there may be a plethora.

This provides your users with a different set of issue types based on the project they decide to create issues in and furthermore reflects the purpose behind creating these issues.

Your future maintenance workload is minimised, because any change you make to an issue type scheme is made across all projects that are associated with the scheme. In the example above, adding a new issue type to all support-related projects only requires the simple step of adding the issue type to the Support Issue Type Scheme.

On this page:

- What is an 'issue type scheme'?
- Managing issue type schemes
  - Creating a new issue type scheme
  - Editing an issue type scheme
  - Associating an issue type scheme with projects
- Choosing a project's issue type scheme
- Using the Issue Type Migration Wizard

Managing issue type schemes

To access the 'Issue Type Schemes' page:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose Issues. Select Issue Types > Issue Type Schemes to open the Issue Type Schemes page, which displays all existing issue type schemes, their related issue types and their associated projects.

Keyboard shortcut: g + g + start typing issue type schemes
The Default Issue Type Scheme contains all the issue types that exist in your JIRA system. This scheme is associated with all newly created projects by default. If some of your issue types are not relevant to all of your projects, create one or more new issue type schemes (e.g. 'Development Issue Type Scheme' as described below) and associate these with the appropriate projects instead of using the Default Issue Type Scheme.

Creating a new issue type scheme

To create a new issue type scheme:

1. Go to the Issue Type Schemes tab (see above).
2. Click the Add Issue Type Scheme button to open the Add Issue Type Scheme page.
3. Enter the Scheme Name and Description for the new issue type scheme. Ensure that the name is meaningful as this will be visible to other administrators and will allow them to better reuse the scheme.

4. To add issue types to your scheme, drag and drop an issue type from the Available Issue Types list on the right to the Issue Types for Current Scheme list on the left:

5. If you need an issue type that does not currently exist, you can easily add this by using the Add New Issue Type button and dialog box.
   This will add the issue type to your JIRA system and also add it to Issue Types for Current Scheme.
6. To reorder the issue types, drag and drop them into the preferred positions. **Reordering** issue types changes the order in which they are displayed in the selection-box when a user creates an issue.

7. Set the **Default Issue Type** for the new scheme from the dropdown list.  
   **Please Note:**  
   - The 'default issue type' is the issue type displayed in the selection-box when a user creates an issue.  
   - The issue types in this list depend on the issues in the **Issue Types for Current Scheme** list on the left.  
   - The **None** option means that there is no default value. If this option is selected, the system will show the first Issue Type listed in the **Issue Types for Current Scheme**.  
   - The **Issue Type** is remembered as long as you keep creating issues in the same project. Once you change projects or log off the system, it goes back to the default value.

8. Click the **Save** button to create your issue type scheme.

**Editing an issue type scheme**

To edit an Issue Type scheme:

- Go to the **Issue Type Schemes** tab (see above).
- Click the **Edit** link (in the **Operations** column) to access and edit the relevant issue type scheme.

**Please Note:**  
- The process of editing a scheme is identical to the creation process. While editing your issue type scheme, you can set the default default issue type and reorder, add or remove issue types.  
- If an issue type scheme has been associated with one or more JIRA projects (below) and:  
  - issues of the issue types (defined by this issue type scheme) already exist in any of these JIRA projects and  
  - you then want to remove one or more of these issue types from this issue type scheme, you will be prompted to use the **Issue Type Migration Wizard** (below). This wizard will move your issues from the original issue type (which will no longer be applicable) to a valid one. If you cancel this process at any time, your changes will not be saved.

**Associating an issue type scheme with projects**

To associate an issue type scheme with one or more projects:

1. Go to the **Issue Type Schemes** tab (see above).
2. Click the **Associate** link (in the **Operations** column) for the relevant Issue Type scheme.
3. Using the multi-select **Project** box, choose the JIRA projects that you wish to apply your issue type scheme to.
4. Click the **Associate** button and all selected projects will change from their current scheme to the selected scheme.
1. **Please Note:** If a project you are attempting to associate your new issue type scheme with has issues with issue types which have not been added to this new issue type scheme, you will be asked to use the [Issue Type Migration Wizard](below) to migrate the issues to a new issue type (made available by the new issue type scheme).

### Choosing a project's issue type scheme

You may want to change a project to use a different set of issue types.

**This is effectively the same as associating an issue type scheme with projects (above), but is performed from a project's Project Summary administration page (and you cannot choose multiple projects in one action).**

### To change a project to use a different issue type scheme:

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose ![Projects](above), and click the name of a project.
   - **Keyboard shortcut:** `g + g + projects`  
   - In the **Issue Types** section, click the name of the current scheme to display the details of the project's issue type scheme.
3. Click the **Actions** dropdown menu and choose **Use a different scheme**.

![Dev Issue Type Scheme](below)

This opens the **Select Issue Type Scheme for project** page.

**Select Issue Type Scheme for project Sample Project**

Please associate the project **Sample Project** with an issue type scheme. If you know the name of the scheme you need, you can select an issue scheme directly. You can also select the issue type scheme to be the same as another project or create your own new scheme.

There are 0 issues in the project. The current scheme is **Default Issue Type Scheme**.

- **Choose an existing issue type scheme**
- **Choose a scheme the same as an existing project**
- **Create a new scheme and associate with current project**

**Issue Type Scheme:**  
- Development Issue Type Scheme  
- Default Issue Type Scheme

**Issue Types for Scheme:**  
- Bug
- Sub-task (sub-task)
- Improvement

**OK**

4. There are three ways you can select your issue type scheme. Select the radio button that is most relevant:
   - **Choose an 'existing issue type scheme'** — If you know the name of your scheme (e.g. 'Development Issue Type Scheme'), you can immediately choose it from the list. You will see a preview of issue types that would be available for your project as well as the description of the
scheme.

b. **Choose a scheme that is the 'same as an existing project'** — Select this option if you do not know the name of the scheme you would like to use, but you do know the name of the project whose set of issue types you wish to use for the project you are editing. You will be prompted to select a project and the scheme that is currently associated with the selected project will be used for your project as well.

c. **Create a new scheme and associate with current project** — Select this option if you cannot find any existing scheme that fits your needs and would like to quickly create a new scheme. Simply select the relevant issue types for your project and a new scheme will be created with the default name and order. You can edit the name, default value and order of the newly created scheme later.

5. If after you make your changes there are any issues in the selected project that will have obsolete issue types, they will have to be migrated with the **Issue Type Migration Wizard**.

**Using the Issue Type Migration Wizard**

The Issue Type Migration Wizard allows you to migrate issues from an obsolete issue type to a valid issue type. The wizard will be triggered whenever an action (e.g. editing a project's issue type scheme) results in an issue type becoming obsolete (not available in the scheme).

The wizard is similar to the **Bulk Move** function except for that you can't change the project of the issues. The major steps are:

1. Overview — provides a summary of the issues that will require migration
2. Choose Issue Type
3. Set new status
4. Set field values
5. Confirmation

Steps 2 to 4 will be repeated for each issue type that requires migration. After you have migrated all the issues you'll see a summary of changes that will occur. If you click the 'Confirm' button, the wizard will migrate your issues to the new issue types and then complete your action.

Please refer to the **Bulk Move documentation** for more information on status changes and setting of fields values.

**Defining Priority Field Values**

An issue's **priority** is its importance in relation to other issues. JIRA ships with a set of default priorities. You can modify these or add your own as follows.

**Defining a new priority**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose ✋ > **Issues**. Select **Priorities** to open the View Priorities page, which lists the currently-defined priorities and the **Add New Priority** form.

   ![Keyboard shortcut: g + g + start typing priorities](image)

   ![Keyboard shortcut: g + g + start typing priorities](image)
3. Complete the **Add New Priority** form towards the end of the page:

- **Name** — specify a word or two to describe your new priority. (This name will appear in the dropdown field when a user creates or edits an issue).
- **Description** — add a sentence or two to describe when this priority should be used.
- **Icon URL** — supply the path of a image that has been placed somewhere inside `<jira-application-dir>/images/icons` of your JIRA Installation Directory or from an accessible URL.
• **Priority Color** — specify a color to represent this priority. You can either type the HTML color code, or click the box at the right of the field to select from a color chart.

4. Click the **Add** button.

**Editing a priority**

1. Go to the **View Priorities** page as described in **Adding a priority** (above).
2. Click the **Edit** link (in the **Operations** column) corresponding to the priority you wish to edit.
3. Update the fields as described under **Defining a new priority** (above), then click the **Update** button.

**Re-ordering priorities**

Re-ordering priorities changes the order in which they appear in the drop-down list when a user creates or edits an issue.

1. Go to the **View Priorities** page as described in **Adding a priority** (above).
2. To re-order the priorities, click the arrows in the **Order** column:
   - Click the up-arrow to move a priority higher up in the list.
   - Click the down-arrow to move a priority lower down in the list.

**Deleting a priority**

1. Go to the **View Priorities** page as described in steps 1-4 of **Adding a priority** (above).
2. Click the **Delete** link (in the **Operations** column) corresponding to the priority you wish to delete.

**Defining Resolution Field Values**

Resolutions are the ways in which an issue can be closed. JIRA ships with a set of default resolutions, but you can add your own as follows.

**Defining a new resolution**

**Don't create a Resolution named "Unresolved"/"None"**

Any issue that has the Resolution field set is treated by JIRA as "resolved". The Issue Navigator displays Unresolved when no resolution is set for an issue. So adding a resolution named Unresolved/None and setting it in an issue will mean that the issue is seen by JIRA as resolved. This will lead to confusion and is not recommended.

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose ![> Issues](issues). Select **Resolutions** to open the View Resolutions page, which lists the standard resolutions, along with a form for adding new resolutions.

   **Keyboard shortcut**: `g + g` + start typing `resolutions`
3. Complete the **Add New Resolution** form at the bottom of the page:
   - **Name** — enter a short phrase that best describes your new resolution.
   - **Description** — enter a sentence or two to describe when this resolution should be used.

   The **View Resolutions** page can be used to edit, delete, set as default, and re-order the resolutions as they are displayed to the user who is resolving an issue.

### Defining Status Field Values

Statuses are used to represent the position of the issue in its workflow. A workflow represents a business process, represented as a set of stages that an issue goes through to reach a final stage (or one of the final stages). Each stage in the workflow (called a workflow step) is linked to an issue status, and an issue status can be linked to only one workflow step in a given workflow.

JIRA ships with a set of default statuses that are used by the default workflow. You can add your own statuses and customize the workflow. You can also re-order existing statuses, as well as change their names, descriptions and lozenges.

#### On this page:
- Defining a new status
- Re-ordering statuses
- Deleting a status

### Defining a new status

1. Log in as a user with the JIRA Administrators global permission.
2. Choose ☀️ > **Issues**. Select **Statuses** to open the 'Statuses' page, which lists all statuses in JIRA.
   - Keyboard shortcut: `g + g` + start typing *statuses*
3. Click **Add Status** and complete the 'Add Status' form:
   - **Name** — specify a short phrase that best describes your new status.
Description — add a sentence or two to describe what workflow step this status represents.
Category — choose a category that this status will be grouped into: 'To Do' (blue), 'In Progress' (yellow) or 'Done' (green). Categories help you identify where issues are in their lifecycle, particularly in places where a large number of issues are rolled up, e.g. Version Details page, Sprint Health Gadget. The category is also used to map statuses to columns in JIRA Agile, when creating a new board for an existing project.

Next steps:
Now you will need to associate your new status with a workflow 'step'. See Configuring Workflow.

Re-ordering statuses
You may want to change the order of statuses in JIRA in line with a particular workflow or to highlight key statuses. The order of statuses is reflected on screens (or parts of the screen) in JIRA, where issues are listed or grouped by status. These include the issues summary for a project, search results (when status is one of the columns), and a number of gadgets, like the Issue Statistics gadget (where the Statistic Type is 'Status').

1. Navigate to the 'Statuses' page (described in the 'Defining a new status' section above).
2. Use the up and down arrows in the Order column to re-order individual statuses.

Deleting a status
You can only delete statuses that not are being used in workflows, i.e. inactive statuses.

1. Navigate to the 'Statuses' page (described in the 'Defining a new status' section above).
2. Click Delete for the status that you want to delete.

Translating Resolutions, Priorities, Statuses and Issue Types
Further extending JIRA as an internationalizable issue manager, it is possible to easily specify a translated name and description for all values of the following 'issue constants':

- the Issue Type field (for either standard and sub-task issue types)
- the Status field
- the Resolution field
- the Priority field

This allows you to specify a translation set for each available language — providing each user with a more complete translation in their own chosen language. The translated field names and descriptions appear throughout JIRA, e.g. in reports, gadgets and all issue views.

Translating an issue constant
Each issue constant can be configured to have a translation set for each available language in your JIRA system. If no translation has been configured for a particular language, the default issue constant name and description are displayed.

To translated issue type constants:

1. Log in as a user with the JIRA Administrators global permission.
2. Click the Translate link located on the issue constant management page — i.e.
   - the Manage Issue Types page (for standard issue types - click any of the Translate links),
   - the Sub Tasks page (for sub-task issue types),
   - the View Statuses page,
   - the View Resolutions page or
   - the View Priorities page.

   The relevant issue constant Translation page displays the translation set for the currently selected language.
3. To view/update a translation set for a specific language, select the required language from the View Language Translations list at the top of the page and click the View button.
A translated name and description set can be specified for each type of issue constant.

4. Once all translations have been entered, the translation set can be saved by clicking the **Update** button at the end of the page.

**Note that:**
- The process can be repeated for all of the issue constants — i.e. Issue Type, Status, Resolution and Priority fields.
- The translated issue constant name and description will be displayed throughout JIRA, e.g. in reports, gadgets and all issue views.

The default issue constant name and description are displayed if a translation has not been specified.

### Adding a Custom Field

JIRA lets you add custom fields in addition to the **built-in fields**. When creating a custom field, you can choose between **Standard** and **Advanced** types. For standard types, a preview image is shown for each type, so you can see what you are creating in advance. This ensures that you get the custom field you want, much faster. To configure search templates or add contexts to custom fields, use the **Configure** option on each custom field.

JIRA ships with over 20 custom field types and you can find many more in the [Atlassian Marketplace](https://marketplace.atlassian.com) (e.g. the JIRA Toolkit). To build your own custom field types, see the [tutorial](https://jira-developer.atlassian.net/wiki/display/JT/JIRA+Developer+Documentation) at the JIRA Developer Documentation.

**Custom fields are always optional fields.** This means that you can create a new custom field without requiring existing issues to be changed. The existing issues will contain no value for the new custom field, even if a default value is defined.

#### Adding a field directly to an issue

JIRA Admins can add an existing field or create a custom field while in View Issue with the **Admin > Add field** option. You can even configure the options for that custom field without having to leave the screens you are presented with.

See this page for instructions on adding a field from View Issue: **Adding a field to an issue**.

#### Adding a field using the Add Custom Field button

1. Log in as a user with the **JIRA Administrators** global permission.
Choose 🚀 > Issues. Select Fields > Custom Fields to open the Custom Fields page.

💡 Keyboard shortcut: **g + g + start typing custom fields**

2. Click the **Add Custom Field** button. The following dialog is displayed:

By default, this dialog displays the **Standard**, or most common, choices for custom fields. Click on the **Advanced** option in the left navigation or use the search box if you don’t see the field you are looking for right away.

3. Select a field and click the **Next** button.

4. Configure the selection criteria for your field, as shown in the example below:
The **Field Name** will appear as the custom field's title in both entering and retrieving information on issues, whereas the **Field Description** is displayed beneath the data entry field when entering new issues and editing existing issues, but not when browsing issues.

5. Click the **Create** button when you are ready. You will be presented with a dialog that displays your field, in context, and you can select the display options at this point:
Anything you select here will be displayed in the issue you are editing.
6. Click Submit to finalize the process. You will now see your new custom field and selected criteria displayed in the issue, as shown here:

Next steps
If you wish to change the context or other variables in your custom field, see Configuring a Custom Field.
Configuring a Custom Field
You can modify each of the custom fields in your JIRA system by changing the following:

- **Name** — the label that appears to the left of the custom field when it is displayed to a user. See below.
- **Description** — the Help text that appears below the custom field when it is displayed in the Simple Search column. See below.
- **Search Template** — the mechanism for making a custom field searchable. See below.
- **Default Value** — the default value of the custom field when it is first displayed to a user. See below.
- **Options** (for Select and Multi-Select fields only) — the values from which a user can choose. See below.
- **User Filtering** (for User Picker fields only) — the set of users from which a user can choose. See below.
- **Context** — the combination of project(s) and issue type(s) for which a given Default Value and Options will apply. See below.

You can create multiple Contexts, allowing you to specify different Default Values and Options for different combinations of projects and/or issue types.

- **Screens** — the screen(s) on which the custom field will appear when an issue is created, edited or transitioned through workflow. See below (also see Defining a Screen).
**Renderers** — (for certain types of fields only) — see Configuring Renderers and Specifying Field Behavior.

**Hide/Show** — see Specifying Field Behavior.

**Required/Optional** — see Specifying Field Behavior.

On this page:
- Viewing custom fields
- Editing a custom field
- Configuring a custom field
  - Context
  - Adding a new context
  - Default value
  - Options
  - User Filtering
- Choosing screens
- Translating a custom field
- Troubleshooting custom fields

**Viewing custom fields**

To view the custom fields in your JIRA system:

1. Log in as a user with the JIRA Administrators global permission.

**Editing a custom field**

Editing a custom field allows you to change its Name (label), Description (Help text) and Search Template.

To edit a custom field:

1. Navigate to the Custom Fields page, locate the desired custom field and choose cog icon > Edit:
   - The Name is the label that appears to the left of the custom field when it is displayed to a user.
   - The Description is the Help text that appears below the custom field when it is displayed in the Simple Search column.
   - Search Templates are responsible for indexing a custom field as well as making it searchable via Simple Search and Advanced Search (note that custom fields are not searchable via Quick Search). Every custom field type has a preconfigured search template, but you may select a different template using this procedure.
2. Modify the fields as desired and click Update.

**Configuring a custom field**

The custom field context – also known as custom field configuration scheme is not related to the field configuration scheme – specifies the following for the custom field:

- Default Value
- Options
- The issue types and projects to which the default values and options apply

You can create multiple contexts if you need to associate different default values and options with particular projects or issue types.

Each custom field has a context named Default Configuration Scheme for ..., which is created automatically when you add your custom field.

**Context**

To change the project(s) and issue type(s) to which a given Default Value and Options apply:

1. Navigate to the Custom Fields page, locate the desired custom field and choose cog icon > Configure.
2. Locate the context named Default Configuration Scheme for ... and click the Edit Configuration link.
3. Under Choose applicable issue types, select the issue type(s) to which you want this Default Value and Options to apply. You can select any issue types if you wish.
4. Under Choose applicable contexts, select the project(s) to which you want this Default Value and Optio
Adding a new context

Adding a new context allows you to configure a custom field differently for different combinations of issue types and projects.

**To add a new context:**

1. Navigate to the Custom Fields page, locate the desired custom field and choose cog icon > Configure.
2. Click the Add new context link. The ‘Add configuration scheme context’ page will be displayed (see below).
   - Under ‘Add configuration scheme context’, enter a ‘Label’ and ‘Description’ for your new context — these are used for administrative purposes only and will not be shown to your end-users.
   - Under ‘Choose applicable issue types’, select the issue type(s) to which you want this Default Value and Options to apply. You can select Any issue types if you wish.
   - Under ‘Choose applicable contexts’, select the project(s) to which you want this Default Value and Options to apply. Note that this will apply to only issues with the selected issue type(s) as above.

A custom field can only have one context per JIRA project. So you cannot have multiple contexts for different issue types in the same project.

Default value

**To edit the default value that a custom field contains when it is first displayed to a user:**

1. Navigate to the Custom Fields page, locate the desired custom field and choose cog icon > Configure.
2. Locate the relevant context (there will usually only be one, named ‘Default Configuration Scheme for …’) and click the Edit Default Value link in the right-hand column. The ‘Set Custom Field Defaults’ page will be displayed and will be particular to the custom field type:
   - *(For a Select List or Multi-Select List)* Select the appropriate default value from the drop-down list.
   - To clear the default of a select field, click on the current default so it is no longer highlighted and then save, as described here: Unable to De-select Default Value for Multi Select Custom Field.
   - *(For a Cascading Select List)* Select the appropriate default values from the drop-down lists (one for each level).
   - *(For a Date field)* Specify a date, or tick the check-box to make the current date the default.
   - *(For other types of fields)* Type the appropriate default values from the drop-down lists (one for each level).

   Certain types of custom fields, such as calculated custom fields, may not allow for defaults to be selected and will not have the Edit Default Value link.

Options

You can specify option values for custom fields of the following types:

- Select lists
- Multi select lists
- Cascading selects lists
- Radio buttons
- Multi checkboxes

You can add, remove, re-order, sort the options alphabetically, and edit the text of an option value. You can also have HTML in an option value — be sure to use complete tag pairs, and check that the HTML will display correctly.

These options are case insensitive, so when using a select or multi-select list for a notification scheme, JIRA -ADMINISTRATORS will match the jira-administrators group. This means you cannot have both a JIRA-ADMINISTRATORS and a jira-administrators option, as they have the same name.

**To edit a custom field’s options:**

1. Navigate to the Custom Fields page, locate the desired custom field and choose cog icon > Configure.
2. Locate the relevant context (there will usually only be one, named ‘Default Configuration Scheme for …’), and click the Options link in the right-hand column. The ‘Edit Custom Field Options’ page will be displayed (see below). Here you can:
   - Select from the Edit parent select list drop-down to choose which list to edit. *(For a Cascading...*
Select List only)

- Click **Sort alphabetically** to automatically re-order the options alphabetically.
- Click the arrows in the **Order** column, or specify a number and click the **Move** button, to re-order the options manually.
- Click **Edit** to change the text of an option.
- Click **Disable** to hide an option so that it is no longer available for selection. Options that have been used cannot be removed (to preserve data integrity), but due to changing business requirements, they may become invalid over time and so you may wish to make them unavailable for new issues.
- Click **Delete** to remove an option. (This will only be possible for options that have not been used.)

**User Filtering**

You can limit the set of users available in your user picker field. The users can be limited to users in specific groups and/or project roles.

**To filter the users in a user picker field:**

1. Navigate to the **Custom Fields** page, locate the desired custom field and choose **cog icon > Configure**.
2. Click **Edit User Filtering**.
3. Click **Enable group or project role filtering**, then specify the groups and/or roles that you want to limit the user picker to.
   - The user picker will only show users that are in the groups and roles selected.
4. Click **Save**.

**Choosing screens**

**To choose the Screens on which a custom field will appear:**

1. Navigate to the **Custom Fields** page, locate the desired custom field and choose **cog icon > Screens**.
2. Select the check boxes of the screens on which you wish to display this custom field.
   - Note that field visibility depends on the **field configuration** (which is **not** related to the **custom field configuration scheme** described above). Refer to **Specifying Field Behavior** for more information.

**Translating a custom field**

You can translate the name and description of any custom field that you create into another language. You can only select from the language packs that are installed in JIRA.

**To translate the field and description of a custom field to another language:**

1. Navigate to the **Custom Fields** page, locate the desired custom field and choose **cog icon > Translate**.
2. Choose the language pack that this custom field translation will belong to (e.g. French) and enter the translated strings for the **Field Name** and **Description**.

**Troubleshooting custom fields**

**Using the JIRA admin helper**

The JIRA admin helper can help you diagnose why a custom field is not showing on your screens. This tool is only available to JIRA administrators.

**To diagnose why a custom field is not showing on the View Issue, Edit Issue or Create Issue screens:**

1. Navigate to the View Issue, Edit Issue or Create Issue screen where the field is not showing.
2. If you are viewing an issue, click **More Actions > Where is my field?** If you are creating or editing an issue, click **Configure Fields > Where is my field?**
3. Enter the name of the field.
4. Click **Submit**.

**Tip:** You can also access the “Where is my field?” dialog via the cog menu for each issue in the **issue navigator**.

**Changing the description of a custom field**
Not changing the description in a field configuration means that any changes you make to a custom field's description are not seen.

JIRA allows you to define a description of a custom field, and if the field configuration descriptions are left empty then the original description text will appear when you create or edit an issue, and as help text in the Issue Navigator. However you can also define different description texts in each field configuration and this will override the original field description text.

For example if a custom field "My Field" is defined with a description of "This is my field" and no field configuration changes are made, then the displayed text will be "This is my field" as expected. If field configurations are used and a description "This is my excellent field" is set for the custom field in the field description, then the displayed text will be "This is my excellent field".

Creating Help for a Custom Field

Customisations to JIRA, such as including Javascript in the Custom Field description are not included in the scope of Atlassian Support.

To provide online help for a custom field, use HTML or Javascript in the field's description. E.g. you can have a simple link to an external help page:

```html
<a href="http://www.mycompany.com/jirahelp/fieldhelp.html">get help</a>
```

Or using Javascript, you can have help text right in the field:

```html
QA Contact

Start typing to get a list of possible matches.

Qualify Assurance contact

where clicking the help icon makes hidden help text appear:

QA Contact

Start typing to get a list of possible matches.

Qualify Assurance contact

The QA contact is a member of the QA department responsible for taking this issue through testing. They will be transitions.
```

This can be done by entering the following as the field's description:
Quality Assurance contact

```javascript
function showHelp() {
    var listenersDiv = document.getElementById("qaFieldHelp");
    if (listenersDiv.style.display == 'none') {
        listenersDiv.style.display = '';
    } else {
        listenersDiv.style.display='none';
    }
}
</script>

<a href="#" onclick="showHelp(); return false;"><img src="/images/icons/ico_help.png"/></a>
<div id="qaFieldHelp" style="display:none">
    The QA Contact is a member of the QA department responsible for taking this issue through testing.
    They will be notified by email of this and subsequent issue state transitions.
</div>

(Incidentally, Javascript in descriptions can also be used to set field values.)

**Specifying Field Behavior**

A **field configuration** defines the behavior of all fields available in your JIRA installation, including JIRA's own 'fixed'/'built in' fields (known as 'system' fields) and custom fields.

For each field, a field configuration specifies:

- the **description** that appears under the field when an issue is edited
- whether the field is **hidden** or **visible**
- whether the field is **required** (i.e. the field will be validated to ensure it has been given a value) or **optional**
- (for text fields only) which **renderer** to use

When defining field behavior for one or more JIRA projects and the fields used by the issue types in these projects, you typically start by adding one or more new field configurations (see below). You then begin modifying the behavior of individual fields in these new field configurations.

- A new field configuration should be added for each project and issue type combination which requires specific fields to be present and/or fields that express unique behavior.

You can then associate each new field configuration with a different issue type through a 'field configuration scheme'. A field configuration scheme can then be associated with one or more projects.

This process of association gives you the flexibility of defining field behavior on a per project, per issue type basis. For more information, please see the [Overview Diagram](#).
Managing multiple field configurations

You can create multiple field configurations for use on separate projects and issue types.

- Multiple field configurations are organized into Field Configuration Schemes, which associate field configurations with issue types.
- A scheme can then be associated with one or more projects, allowing you to control fields on a per project, per issue type basis. See Associating Field Behavior with Issue Types for details.

About the 'Default Field Configuration'

When JIRA is installed, the Default Field Configuration is created automatically. All new projects are associated with this configuration. This configuration is also used for projects that are not associated with a Field Configuration Scheme.

It is not possible to delete the Default Field Configuration.

Adding a field configuration

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations.

Keyboard shortcut: g + g + start typing field configurations
3. Click the **Add New Field Configuration** button to open the **Add Field Configuration** dialog box.

4. Complete the **Add Field Configuration** dialog box:
   - **Name** — enter a short phrase that best describes your new field configuration.
   - **Description (optional but recommended)** — enter a sentence or two to describe when this field configuration should be used.

5. Click the **Add** button to add your new field configuration to JIRA. Once you have added your new field configuration, you can then begin modifying the behavior of its fields (below). You will be taken directly to the **View Field Configuration** page, where you can modify the behavior of fields in your new field configuration. See **Modifying field behavior (from step 4)** below for details.

### Editing a field configuration

1. Log in as a user with the **JIRA Administrators** global permission.

2. Choose :gear: > **Issues**. Select **Fields** > **Field Configurations** to open the View Field Configurations page, which lists all your field configurations. **Keyboard shortcut:** `g + g +` start typing field configurations

3. Click the **Edit** link next to the field configuration you wish to edit.

4. On the **Edit Field Configuration** page, edit the field configuration's **Name** and **Description**.

**Please note:** The **Default Field Configuration** cannot be edited.

### Deleting a field configuration

1. Log in as a user with the **JIRA Administrators** global permission.

2. Choose :gear: > **Issues**. Select **Fields** > **Field Configurations** to open the View Field Configurations page, which lists all your field configurations. **Keyboard shortcut:** `g + g +` start typing field configurations

3. Click the **Delete** link next to the field configuration you wish to delete. **i** You will be prompted to confirm this operation.

**Please note:**
- The **Default Field Configuration** cannot be deleted.
- You can only delete a field configuration that is not associated with a field configuration scheme. The **Delete** link will not be available for field configurations which are associated with one or more field configuration schemes.

### Copying a field configuration

1. Log in as a user with the **JIRA Administrators** global permission.

2. Choose :gear: > **Issues**. Select **Fields** > **Field Configurations** to open the View Field Configurations page, which lists all your field configurations. **Keyboard shortcut:** `g + g +` start typing field configurations

3. Click the **Copy** link next to the field configuration you wish to copy.

4. On the **Copy Field Configuration** page, specify the **Name** and **Description** for the field configuration to...
The (initial) field settings between the original and copied field configurations will be identical.

**Please Note:** a newly created field configuration will not take effect until you:

1. Associate your new field configuration to one or more issue types.
2. Associate that field configuration with one or more projects.

See [Associating Field Behavior with Issue Types](#) for more information.

### Modifying field behavior

To modify the behavior of fields in JIRA, you need to modify the field configurations that those fields have been defined in.

**To modify the behavior of a set of fields in a field configuration:**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **Issues** > **Fields** > **Field Configurations** to open the View Field Configurations page, which lists all your field configurations.
   - **Keyboard shortcut:** g + g + start typing field configurations
3. Locate the field configuration of interest and click the **Configure** link to open the View Field Configuration page, which lists all system and custom fields in your JIRA installation for that field configuration.

   **Please Note:**
   - The **Edit** link only allows you to change the **Name** and **Description** of the field configuration, not of individual fields.
   - Note that the **Edit** link is not available for the Default Field Configuration on the View Field Configuration page (listing all field configurations defined in your JIRA installation).
4. In the **Operations** column, you can perform the following actions for any field:
   - **Edit** — change the field's description (i.e. help text).
   - **Hide/Show** — hide the field from view or show it.
   - **Require/Optional** — set a field to be required (so that whenever a field is edited it must be given a value) or optional.
   - **Renderers** — change a field's renderer (see [Configuring Renderers](#) for more information).

   **Please Note:** a newly created field configuration will not take effect until you:

   1. Associate your new field configuration to one or more issue types and then
   2. Associate that field configuration with one or more projects.

   See [Associating Field Behavior with Issue Types](#) for more information.

### Editing a field's description

Fields can be given descriptions to better identify the meaning of the field. These descriptions are typically displayed under the fields they are associated through JIRA's user interface, for example, when creating an issue or editing it:

Preview: Sample description text shown beneath the 'Assignee' field

To edit the description of a field:

1. Follow the first three steps above (in **Modifying field behavior**) to access the field configuration whose field's description you wish to edit.
2. Click the **Edit** link next to the field you want to change and update the field's description.
3. Click the **Update** button to save your changes.

### Hiding or showing a field

If your organisation or project has no use for a particular field, you have the option to hide it. Hiding a field will
ensure that the the field does not appear on any screens (i.e. issue operation screens, workflow transition screens) where the field configuration applies.

**Please note:**

- Hiding a field in the field configuration is distinct from not adding a field to a screen. Fields hidden through the field configuration will be hidden in all applicable screens, regardless of whether or not they have been added to the screen.
- For fields that have a default value: If the field is hidden in the field configuration, then it will not receive a value when an issue is created, regardless of whether the field is present on the Create Issue screen(s). (The following fields can have a default value: Resolution, Status, Priority, Issue Type, Security Level and custom fields.)
- The fields Summary and Issue Type cannot be hidden and as such there is no Hide option available for these fields.

**To hide or show a field:**

1. Follow the first three steps above (in Modifying field behavior) to access the field configuration whose fields you wish to hide or show.
2. Do either of the following:
   - If you no longer want to expose a field through JIRA’s user interface, click the Hide link associated with that field.
     - You can make this field visible again at any time by clicking the Show link.
   - If you want to show a field (which is currently hidden) through JIRA's user interface, click the Show link associated with that field.
     - You can hide this field again at any time by clicking the Hide link.

**Making a field required or optional**

Certain fields within your organisation may be compulsory for issues. In this case you can set a field to be required, so that JIRA validates that the field has been given a value whenever an issue is edited. If a required field has not been given a value, JIRA will return an error informing the user that the field should be filled, e.g.:

**Screenshot: Sample validation of the 'Fix Version/s' field**

![Fix Version/s](../images/Fix_Version.png)

**Fix Version/s is required.**

**To make a field required or optional:**

1. Follow the first three steps above (in Modifying field behavior) to access the field configuration whose fields you wish to hide or show.
   - When viewing a field configuration (see above), fields which are already required have that indication next to their name.
2. Do either of the following:
   - To make a field mandatory when used through JIRA’s user interface, click the Required link associated with that field.
     - The text Required will appear next to the field’s name.
   - To make a field optional, click the Optional link associated with that field.
     - The Required text next to the field’s name will disappear.

**Please note:**

- Fields that are hidden cannot be set to required.
- If you make a field Required, ensure that the field is present on your Create Issue screen(s).
  - Note that you can have different field configurations for different projects and issue types (see Associating field behavior with Issue Types), so you need to ensure that all Required fields are present on the Create Issue screens for all associated projects and issue types (see Associating screens with Projects and Issue Types).
  - Be aware that there is a feature request (JIRA-5783) to make a field required for only one transition. If you are interested, please watch that issue for status updates.
Changing a field’s renderer

JIRA renderers affect how a JIRA field’s content is either displayed to the user (for text fields) or how a user enters field data (for multi-select fields), thereby enabling you to choose a style which best suits your organisation and your users.

JIRA currently ships with the following renderers:

- For text fields:
  - The Default Text Renderer, which displays plain text; and
  - The Wiki Style Renderer (utilising the Confluence wiki engine), which displays rich text (HTML).

To see how a ‘Wiki Style Renderer’ field will look when it is displayed to a user, please see Editing Rich-Text Fields.

- For multi-select fields:
  - The Autocomplete Renderer, which allows the user to start typing text which is then 'autocompleted', or to select from a dropdown list of options; and
  - The Select List Renderer, which simply provides a dropdown list of options.

For custom fields of type Multi Select, only the Select List Renderer is available. Furthermore, when modifying a field configuration, you will not be able to configure a Multi Select custom field’s renderer.

Before you change the renderer for a specific field, please read Configuring Renderers, paying particular attention to the Implications for JIRA operations section.

To change the renderer for a specific field:

1. Follow the first three steps above (in Modifying field behavior) to access the field configuration whose field's renderer you wish to change.

   When viewing a field configuration (see above), the Name column indicates which renderers are currently enabled for all renderable fields, with the current renderer shown in brackets immediately below its field name.

2. Click the Renderers link for the field you want to change. This will take you to a page where you will have the option to select a renderer from all configured and available renderers.

3. This page will warn you if there are issues that will be affected by the change. If no issues will be affected then the warning does not show. From this page, choose the renderer you wish to use and click Update.

Changing the renderer only affects how a JIRA field's content is displayed or how a user interacts with a multi-select field — it does not affect the issue data that exists in the system. Hence, you can therefore toggle between renderer types safely.

Associating Field Behavior with Issue Types

A field configuration scheme associates (or “maps”) field configurations to issue types in a project. In turn, a field configuration scheme can be associated with one or more projects.

This means that you can define different field configurations for each issue type that is available in a given project. For example, it is possible to have separate field configurations for the Bug the Improvement issue types (whose associations are defined in a field configuration scheme) for a project called 'Test'. Refer to the Overview Diagram for more information.

Because a field configuration scheme can be associated with more than one project (and associations between field configurations and issue types in a field configuration scheme are flexible), you can minimize your administrative workload as you can reuse the same field configuration for the same (or different) issue types across multiple projects.
Adding a field configuration scheme

1. Log in as a user with the JIRA Administrators global permission.

2. Choose 🏛 > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations.

   Keyboard shortcut: g + g + start typing field configuration schemes

3. Click the Add New Field Configuration Scheme button to open the Add New Field Configuration Scheme dialog box.

4. Complete the Add New Field Configuration Scheme dialog box:
   - Name — enter a short phrase that best describes your new field configuration scheme.
   - Description (optional but recommended) — enter a sentence or two to describe when this field configuration scheme should be used.

5. Click the Add button to add your new field configuration to JIRA.
   You will be taken directly to the Configure Field Configuration Scheme page, where you can start associating issue types with field configurations in your new field configuration scheme. See Modifying field behavior (from step 4) below for details.

Associating an issue type with a field configuration

1. Log in as a user with the JIRA Administrators global permission.

2. Choose 🏛 > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations.

   Keyboard shortcut: g + g + start typing field configuration schemes

3. Click the Configure link for the field configuration scheme in which to create an association between an a field configuration and an issue type. The Configure Field Configuration Scheme page will appear, showing the scheme's current mappings of field configurations to issue types.
   If you have not added any new field configurations since installing JIRA, you will only have JIRA’s Default Field Configuration to work with.

4. Click Associate an Issue Type with a Field Configuration. You will see this screen:
5. Select the desired issue type and field configuration and click the Add button.

Please note:

- An issue type can only have one association within a given configuration scheme.
- If an issue type does not have an association in the scheme, the field configuration associated with the Default entry in the scheme will be used for issues of that type.

Removing an association between an issue type and a field configuration

1. Log in as a user with the JIRA Administrators global permission.
2. Choose Gear > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations.
   Keyboard shortcut: g + g + start typing field configuration schemes
3. Click the Configure link for the field configuration scheme that contains the association between a field configuration and issue type you want to remove. The Configure Field Configuration Scheme page will appear, showing the scheme's current mappings of field configurations to issue types.
   Please note: If you have not added any field configurations since installing JIRA, you will only have JIRA's Default Field Configuration to work with.
4. Click the Remove link next to the issue type you wish to remove from the scheme.

Please note: The Default entry cannot be removed from the scheme.

Associating an issue type with a different field configuration

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations. 

   Keyboard shortcut: g + g + start typing field configuration schemes

3. Click the Configure link for the field configuration scheme contains an association between a field configuration and issue type you want to change. The Configure Field Configuration Scheme page will appear, showing the scheme’s current mappings of field configurations to issue types. 
   If you have not added any field configurations since installing JIRA, you will only have JIRA’s Default Field Configuration to work with.

4. Click the Edit link next to the issue type whose field configuration you wish to change.

5. Select the new Field Configuration you would like to associate with this issue type.

   ![Edit Field Configuration Scheme](image)

6. Click the Update button.

**Editing a field configuration scheme**

To change the name or description of a field configuration scheme:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations.

   Keyboard shortcut: g + g + start typing field configuration schemes

3. Click the Edit link next to the field configuration scheme whose name and description you wish to modify.
4. On the Edit Field Configuration Scheme page, edit the Name and Description of the field configuration scheme.
5. Click the Update button.

**Deleting a field configuration scheme**

To delete a field configuration scheme:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations.

   Keyboard shortcut: g + g + start typing field configuration schemes

3. Click the Delete link next to the field configuration scheme you wish to delete. You will be prompted to confirm your deletion.

   You can only delete a field configuration scheme that is not associated with a project. The Delete link will not be available for field configuration schemes which are associated with one or more projects.

**Copying a field configuration scheme**

To copy a field configuration scheme:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Fields > Field Configurations to open the View Field Configurations page, which lists all your field configurations.

   Keyboard shortcut: g + g + start typing field configuration schemes

3. Select Administration > Issues > Fields > Field Configuration Schemes (tab) to open the View Field Configuration Schemes page, which lists all your field configuration schemes (if any exist).

   Keyboard shortcut: g + g + start typing field configuration schemes

4. Click the Copy link next to the field configuration scheme you wish to copy.
5. On the subsequent page, specify the Name and Description of the field configuration scheme to be copied.
6. Click the **Copy** button.
   - The (initial) associations between field configurations and issue types in both the original and copied field configuration schemes will be identical.

**Associating a field configuration scheme with a project**

To make your JIRA projects use your field configuration(s), you need to associate these field configuration(s) with issue types in a field configuration scheme (above) and then associate this field configuration scheme with a project. (This association means that the field configuration scheme will be applied to the project.) Once this is done:

- The issues in this project will use the field configuration(s) 'mapped' to their issue type (defined by the field configuration scheme associated with the project)
  - but also:
    - The issue types available to this project are defined by the issue type scheme associated with the project.

Therefore, even though a project's field configuration scheme may associate various different field configurations with a large set of issue types, only a subset of these issue types (as defined by the project's issue type scheme) and hence, field configurations themselves, may be available in that project. In other words, the issue types available to a project are restricted by the project's issue type scheme.

- Note that newly created projects are not associated with any field configuration schemes and hence, use the **Default Field Configuration** for all issues.

**To associate a field configuration scheme with a project:**

1. Access the **Project Summary** administration page for your project (see Configuring a project).
2. In the **Fields** section of this page, click the name of the current field configuration scheme.
3. Click the **Actions** dropdown menu and choose **Use a different scheme**.
4. In the resulting page, select the scheme you want to associate with this project.
   - Selecting **None** will result in all issue types available to your project using JIRA's **Default Field Configuration**.
5. Click the **Associate** button. You will be returned to the **Project Summary** administration page, with the project now associated with the selected field configuration scheme.

**Configuring Renderers**

**Overview**

JIRA renderers affect how a JIRA field's content is either displayed to the user (for text fields) or how a user enters field data (for multi-select fields), thereby enabling you to choose a style which best suits your organisation and your users.

**JIRA currently ships with the following renderers:**

- For text fields:
  - The **Default Text Renderer**, which displays plain text; and
  - The **Wiki Style Renderer** (utilising the Confluence wiki engine), which displays rich text (HTML).
    - To see how a 'Wiki Style Renderer' field will look when it is displayed to a user, please see **Editing Rich-Text Fields**.
- For multi-select fields:
  - The **Autocomplete Renderer**, which allows the user to start typing text which is then 'autocompleted', or to select from a dropdown list of options; and
  - The **Select List Renderer**, which simply provides a dropdown list of options.
    - For custom fields of type **Multi Select**, only the Select List Renderer is available. Furthermore, when modifying a field configuration, you will not be able to configure a **Multi Select** custom field's renderer.

Renderers are configured on a per field basis. To configure a renderer for a particular field, see Specifying Field Behavior. Note that you can configure the same field differently for different projects and issue types — see Associating Field Behavior with Issue Types.

Renderers are implemented as JIRA plugins, meaning that any renderer can be easily added to or removed from use within JIRA. This includes any custom renderers that may be developed. For details see configuring.
Please read Implications for JIRA operations below before configuring renderers.

Renderers affect the rendering (view) of a field's value. This means that you can migrate to a different renderer without affecting your issue data; only the view will be changed. It also means that if you do not like the way your issues look using the new renderer, you can simply switch back with no impact on your issue data.

On this page:
- Overview
- Renderable Fields
- Renderer Types
  - Default Text Renderer
  - Wiki Style Renderer
  - Autocomplete and Select List Renderers
- Implications for JIRA operations
  - Bulk Move
  - Bulk Edit
  - Email Notifications
  - Excel View
  - RSS/XML View
  - Editing a Renderable Custom Field's Default Value
- Configuring Renderers
  - Applying a Renderer to a Field
  - Enabling a Renderer Plugin
  - Configuring a Renderer Plugin

**Renderable Fields**

Potentially any field within JIRA can be a renderable field, but this only really makes sense in the case of text-based fields (for the Default Text Renderer and the Wiki Style Renderer) and multi-select fields (for the Autocomplete Renderer and the Select List Rendered). The following table shows the JIRA fields that are renderable out-of-the-box:

<table>
<thead>
<tr>
<th>Field</th>
<th>Available Renderers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Wiki Style Renderer (default), Default Text Renderer.</td>
</tr>
<tr>
<td>Comment</td>
<td>Wiki Style Renderer (default), Default Text Renderer.</td>
</tr>
<tr>
<td>Environment</td>
<td>Wiki Style Renderer (default), Default Text Renderer.</td>
</tr>
<tr>
<td>Component</td>
<td>Autocomplete Renderer (default), Select List Renderer.</td>
</tr>
<tr>
<td>Affects Version</td>
<td>Autocomplete Renderer (default), Select List Renderer.</td>
</tr>
<tr>
<td>Fix Version</td>
<td>Autocomplete Renderer (default), Select List Renderer.</td>
</tr>
<tr>
<td>Custom field of type &quot;Free Text Field (unlimited text)&quot;</td>
<td>Wiki Style Renderer, Default Text Renderer.</td>
</tr>
<tr>
<td>Custom field of type &quot;Text Field&quot;</td>
<td>Wiki Style Renderer, Default Text Renderer.</td>
</tr>
</tbody>
</table>
Renderer Types

JIRA ships with the following renderers:

- for text fields: Wiki Style Renderer and Default Text Renderer
- for multi-select fields: Autocomplete Renderer and Select List Renderer

Default Text Renderer

The Default Text Renderer renders a field's content as plain text, with the following additional auto-linking feature: if the text contains text that resolves to a JIRA issue key then an HTML link will be generated that points to that issue. Below is a sample of how some description text looks when rendered through the Default Text Renderer.

```
Description

This relates to ANGRY-304
```

It is not possible to disable the Default Text Renderer plugin as it is required for the system to function properly. If a text field is setup to use a renderer that is later disabled, the field will revert to using the Default Text Renderer.

Wiki Style Renderer

The Wiki Style Renderer allows a user to enter wiki markup to produce html content, as described in 'Editing Rich-Text Fields' in the JIRA User's Guide.

This renderer uses the Confluence wiki renderer engine and therefore uses the Confluence wiki notation. The Confluence notation is easy to learn and allows for:

- Italic, bold and underlined text.
- Multiple levels of headings to organize your document.
- Bullets, numbering, tables and quotations.
- Images, screenshots, and emoticons.
- Powerful mini-applications using macros.
  A full notation guide can be found [here](#).

The Wiki Style Renderer can only be used with JDK 1.4 and up. The renderer will not run on JDK 1.3.

Please note that some fields may require further field behavior configurations to be enabled — see Choosing a Renderer.

Wiki Style Renderer Macro Support

The Wiki Style Renderer supports pluggable macros in the same way that Confluence does. Macros provide an easy and powerful extension point to the wiki markup language. JIRA ships with a number of macros as described in the JIRA User's Guide.

JIRA and Confluence can share macros, but keep in mind that many Confluence macros are very specific to the Confluence application and will therefore not run within JIRA. For example, the Children macro in Confluence shows links to all of a Page's child pages. JIRA has no concept of 'page' and therefore this macro will not function in JIRA.
Autocomplete and Select List Renderers

The Autocomplete and Select List Renderers let you start typing text, which is then autocompleted, or to select from a dropdown list of options.

Implications for JIRA operations

The fact that JIRA allows you to configure different renderers across different projects/issue types for the same field has implications for bulk operations. Also, since the Wiki Style Renderer inherently creates HTML as its end product, there are implications as to how this will behave when issue data is viewed outside JIRA's web front-end.

Bulk Move

When performing a bulk move operation you can either move issues to an environment (project/issue type) where the renderer types for the fields are the same or where they will be different.

If the renderer types are the same

If the renderer types for where you are moving to are the same then you will not notice any changes to the way the issues data is displayed once the move has occurred and the move operation will not prompt you with any warnings.

If the renderer types are different

When bulk moving issues to an environment (project/issue type) that has a different renderer type defined for one of the fields being affected by the move, if any of the issues have a non empty value associated with the field, the move operation will present you with a warning so that you are aware of the change. The warning does not affect the move operation in any way but it is there to alert you to the fact that the moved issues' affected fields may look different in their new project/issue type.

Bulk Edit

When performing a bulk edit operation the only renderable fields you may be able to bulk edit are instances of the Text Field, and Free Text Field (unlimited text) custom fields. The bulk edit operation does not allow you to bulk edit the description, environment, or comment fields.

You will only be allowed to bulk edit a renderable field if all the issues selected for edit use the same renderer type. If the renderer type differs for any of the selected issues you will be presented with an error message.

This is best illustrated with an example. Let's say you have two global custom fields, 'Custom text area' and 'Custom text field', whose types are as their names imply. Let's say you have project 'A' which is configured to use the Wiki Style Renderer for both of the fields. Let's say you also have a project 'B' which is configured to use the Default Text Renderer for the 'Custom text area' field and the Wiki Style Renderer for the 'Custom text field'. Let's also say that you have one issue in each project. If you were to perform a bulk edit operation on the two issues in these projects you will be presented with the screenshot below:
Email Notifications

JIRA allows for extensive configuration in relation to email notifications. JIRA can send out two types of emails, HTML and text (see Email Formatting).

HTML Emails

When using the Atlassian Wiki Renderer, the rendered content (i.e. exactly what you see on the 'View Issue' page) will be sent out in the emails. This will create emails which are as rich as the content makes it. If using the Wiki Style Renderer, this is the preferred type of email since it is a real representation of the wiki markup.

Text Emails

When using the Atlassian Wiki Renderer, the actual wiki markup (unrendered) will be displayed in text emails for fields that use the Wiki Style Renderer. This is obviously less readable than the rendered version of the markup, but because the markup's syntax is quite simple the text does remain easy to read.

Excel View

JIRA allows the Issue Navigator view to be exported to an Excel spreadsheet. If any of the fields being exported to Excel are using the Wiki Style Renderer, the value exported to the cell in Excel will be the original wiki markup. Attempting to display complex HTML within a cell in Excel adds rows and columns that make using the
The unrendered wiki markup will be shown in Excel cells for fields that use the Wiki Style Renderer.

**RSS/XML View**

JIRA allows the Issue Navigator view to be exported to RSS/XML. If a field is using the Default Text Renderer its values will be exported in a CDATA section within the generated XML. If a field is using the Wiki Style Renderer, its rendered value will be XML escaped and included in the generated XML. If the XML view is being used as an RSS feed, most RSS readers will render the generated HTML so you will see the rich content within your RSS reader.

If you would like to have this view feed out the raw values (unrendered) then you can send an additional request parameter 'rssMode=raw'. If the original link looks like this:

```
http://localhost:8080/browse/AAA-1?decorator=none&view=rss
```

Then the URL to have the raw values placed inside a CDATA should look like this:

```
http://localhost:8080/browse/AAA-1?decorator=none&view=rss&rssMode=raw
```

**Editing a Renderable Custom Field's Default Value**

When editing a renderable custom field's default value, even if it is only ever configured to use the Wiki Style Renderer you will not be presented with the Edit and Preview options. Unfortunately, in this context it is not possible to tell which renderer should be used for editing. However, if you enter a default value using wiki markup, then this will render correctly in environments (project/issue type) where the field has been configured to use the Wiki Style Renderer.

**Configuring Renderers**

**Applying a Renderer to a Field**

To enable a renderer for a particular field, edit the Field Configuration and choose the appropriate renderer for the field. For details, see Specifying Field Behavior.

**Enabling a Renderer Plugin**

Renderers within JIRA are implemented as JIRA plugins. The macros that the Wiki Style Renderer uses are also implemented as JIRA plugins. For general information on plugins please see the JIRA Plugin Guide.

Note that plugins are configured at a site-wide level — it is not possible to configure plugins at a project/issue type level.

**Configuring a Renderer Plugin**

Renderers and their dependant components, except for the Default Text Renderer, can be enabled/disabled as follows.

1. Choose 🔄 > Add-ons. The ‘Find add-ons’ screen shows add-ons available via the Atlassian Marketplace. Choose Manage Add-ons to view the plugins currently installed on your JIRA site.
2. Select Manage Add-ons and then search for ‘renderer’, filtering for System Add-ons, as shown here:
This screen displays all the configured renderers within JIRA.

- Click the Disable button to deactivate the renderer for the entire instance of JIRA.

Any fields still set up to use a disabled renderer will fall back to the default text renderer. When you attempt to edit the field, a warning message alerts you to the fact that you are configured to use a renderer that is not available.

When a renderer is disabled it will not be available for selection when changing a field's renderer. To enable the renderer, click the Enable button. Enabling or disabling a renderer has no effect on the renderer settings in the field configurations, so it is possible to disable and then re-enable a renderer without affecting any data.

**Configuring Macro Plugins for the Wiki Style Renderer**

The macros used by the Wiki Style Renderer can be enabled/disabled as follows.

1. Choose > Add-ons. The 'Find add-ons' screen shows add-ons available via the Atlassian Marketplace. Choose Manage Add-ons to view the plugins currently installed on your JIRA site.
2. Select Manage Add-ons and then search for 'renderer', filtering for System Add-ons.
3. Expand the Wiki Renderer Macros Plugin to display the following screen.
From this screen you will see all the configured macros within JIRA. If a macro is disabled then it will not be available to the wiki renderer. If you deploy any additional macros that you wish to use, they must be enabled here to be available to the wiki renderer. For more information on writing plugins please see the documentation on Writing Macros.

**Defining a Screen**

**Screens** group all available fields (or a subset of all available fields) defined in JIRA and organize them for presentation to a user. Through screens, you can control what fields are displayed to the user during issue
operations (e.g. Create Issue and Edit Issue dialog boxes) or workflow transitions (e.g. Resolve Issue dialog box), as well as define the order in which these fields are shown to them. A screen also allows you to split subsets of fields across multiple tabs.

When it comes to field visibility, screens functionally overlap slightly with field configurations. For example, on the Create Issue dialog box, users will only see issue fields that:

1. are present on the screen associated with the issue's Create Issue issue operation,
2. are also not hidden in the field configuration applicable to the issue (as defined by the project's field configuration scheme),
3. the user has permission to edit (e.g. the Due Date field can only be edited by users with the Schedule Issues project permission),

Hence, a field may be present on a screen used by a project, but if that field is hidden in the field configuration used by the project, that field will not be visible to the user when that screen in the project is displayed.

⚠️ If a particular field needs to be hidden at all times, it is easier to hide the field in the relevant field configuration than remove it from all screens. For more information please see the Overview.

Be aware that any newly created screen in JIRA is not usable by a JIRA project until it has been associated with either:

- An issue operation and issue type (via a screen scheme and then issue type screen scheme)
- A workflow transition.

See Activating a screen (below) for details.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a screen</td>
</tr>
<tr>
<td>Editing a screen's details</td>
</tr>
<tr>
<td>Copying a screen</td>
</tr>
<tr>
<td>Deleting a screen</td>
</tr>
<tr>
<td>Configuring a screen's tabs and fields</td>
</tr>
<tr>
<td>Activating a screen</td>
</tr>
</tbody>
</table>

JIRA ships with the Default Screen, Resolve Issue Screen and Workflow Screen, which are used as described below:

- **Default Screen** — used for the default issue operations for creating, editing or viewing an issue.
- **Resolve Issue Screen** — used for the transition view for the default Close Issue and Resolve Issue transitions, originating from the Open, In Progress and Reopened steps in JIRA's default workflow.
- **Workflow Screen** — used for the transition view for the default Reopen Issue transitions, originating from the Resolved and Closed steps and Close Issue transition, originating from the Resolved step in JIRA's default workflow.

The Workflow Screen defines a smaller set of fields than the Resolve Issue Screen.
JIRA's default workflow, showing transitions (arrows) and steps (blue boxes):

Adding a screen

To add a new screen to JIRA:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🌐 > Issues. Select Screens to open the View Screens page, which lists all screens that have been defined in JIRA.
   💡 Keyboard shortcut: g + g + type screens

3. Click the Add New Screen button to open the Add New Screen dialog box.
4. Complete the Add New Screen dialog box:
   - **Name** — enter a short phrase that best describes your new screen.
   - **Description** — enter a sentence or two to describe the situations screen will be used.
5. Click the Add button to add your new screen to JIRA.
You will be taken directly to the **Configure Screen** page, where you can add fields to your new screen. See the **Configuring a screen’s fields** section below for details.

### Editing a screen’s details

#### To change a screen’s name and/or description:

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose  > **Issues**. Select **Screens** to open the View Screens page, which lists all screens that have been defined in JIRA.
3. Click the **Edit** link next to the appropriate screen.
4. You will now be directed to the **Edit Screen** page where you can edit the name and/or description of the Screen.

![Edit Screen Form]

### Copying a screen

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose  > **Issues**. Select **Screens** to open the View Screens page, which lists all screens that have been defined in JIRA.
3. Click the **Copy** link next to the Screen you wish to copy. You will be directed to the **Copy Screen** page, where you can enter a name and a description for the new Screen.

![Copy Screen Form]

### Deleting a screen

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose  > **Issues**. Select **Screens** to open the View Screens page, which lists all screens that have been defined in JIRA.
3. Click the **Delete** link next to the screen you wish to delete. You will be prompted to confirm your deletion.

Screens that are associated with one or more **screen schemes**, or one or more **workflow transitions**, cannot be deleted.
Configuring a screen's tabs and fields

You can configure the fields that display on a particular screen by adding/removing fields, as well as reordering them. Tabs can also be used to help group related fields. Tabs are useful for organizing complex screens, as you can place less used fields onto separate tabs. You can also add, remove and reorder tabs, as well as rename them.

To configure a screen's tabs and fields:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🌐 > Issues. Select Screens to open the View Screens page, which lists all screens that have been defined in JIRA.
3. Click the Configure link (under the Operations column) next to the screen you want to add a field to, to open the Configure Screen page for that screen.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a tab</td>
<td>Click Add Tab. Enter the name of the new tab in the dialog that appears and click Add.</td>
</tr>
<tr>
<td>Move a tab</td>
<td>Hover over the dotted part of the tab (next to the tab name) and drag the tab to the desired position.</td>
</tr>
</tbody>
</table>
| Rename a tab     | 1. Hover over the tab name and click the pencil icon.  
|                  | 2. Enter the new name and click OK.                                                      |
| Delete a tab     | Hover over the tab name and click the X.                                                  |
| Add a field      | 1. Click the tab that you want to add the field to.  
|                  | 2. Type the name of the field in the dropdown displayed at the bottom of the current fields. Field suggestions will appear as you type.  
|                  | 3. Click Add Field to add it to the current tab.                                           |
| Move a field     | Hover over the dotted part of the field (next to the field name) and drag the field to the desired position. Move a field to a different tab by dragging it to the name of the tab and dropping it. |
| Delete a field   | Hover over the field and click the Delete button that appears.                           |

Tips on configuring screens
**Date fields on View Issue screen** — Fields of type 'Date' will always be displayed in the 'Dates' area of the default 'View Issue' screen, regardless of how you reorder them. This applies even if the dates are custom fields.

**System fields on View Issue screen** — System fields on the default 'View Issue' screen (e.g. Summary, Security Level, Issue Type, etc.) are fixed. This means that they will always appear on the 'View Issue' screen, even if you configure the Screen to move them onto a separate tab. Any custom fields (except 'Date' fields) that have been added to the 'View Issue' screen can be moved onto a separate tab. Note, this restriction only applies to the screen associated with the 'View Issue' operation.

**Timetracking** — You can add the ability to log work and/or specify/modify time estimates to a screen by adding the special Log Work and/or Time Tracking fields respectively. For more information about how this works for a user, please refer to Logging work and/or specifying time estimates on the same JIRA screen.

- If these fields cannot be found in the Add Field selection box and they have not already been added to the screen, check whether JIRA's Time Tracking feature has been enabled. These fields will not be available to add to any screen if Time Tracking is disabled.
- If any screens have the Log Work or Time Tracking fields and JIRA's Time Tracking feature is subsequently deactivated, those screens will retain these fields until you specifically remove them. However, the fields will not be visible to the user until Time Tracking is reactivated.

**Renaming standard JIRA fields** — You cannot rename the standard JIRA fields (e.g. Priority, Summary, etc) via the JIRA administration console. If you want to rename the standard JIRA fields, you will need to modify files in your JIRA installation. Please see this knowledge base article for instructions. Note, renaming standard JIRA fields is not supported.

### Activating a screen

To make a Screen available to users, you can **either**:

- Associate the Screen with an **issue operation** (e.g. 'Create Issue'), via a **Screen Scheme** — see Associating Screens with Issue Operations; or
- Associate the Screen with a **Workflow Transition** (e.g. 'Resolve Issue') — see Configuring Workflow.

### Associating a Screen with an Issue Operation

**What is a 'screen scheme'?**

A 'screen scheme' allows you to choose which screen will be shown to a JIRA user when they perform a particular issue operation. There are three issue operations for which you can choose a screen:

- **Create Issue** — the screen that is shown when an issue is being **created**.
- **Edit Issue** — the screen that is shown when an issue is edited.
- **View Issue** — the screen that is shown when a user views an issue.

In a screen scheme, you can specify the same screen (or choose different screens) for these issue operations. Once you have created your screen scheme, you will need to activate it by associating the screen scheme with issue types via an 'issue type screen scheme'. (In turn, issue type screen schemes are associated with JIRA projects.)

> Please be aware that although it is possible to associate any screen defined in your JIRA installation with either a screen scheme or a workflow transition view, screen schemes and workflow transition views are distinct and unrelated.
Adding a screen scheme

Depending on your requirements, you may want to create multiple Screen Schemes, and associate them with different projects/issue types.

To create a new screen scheme:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Screens > Screen Schemes to open the View Screen Schemes page.
   *Keyboard shortcut: g + g + type screen schemes
3. Click the Add New Screen Scheme button on the View Screen Schemes page.
4. Fill out the details for the new screen scheme on the form that is displayed.

Note: The default screen is used for issue operations that do not have a screen associated with them.

Editing a screen scheme's details

To change a screen scheme's name, description or default screen,

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Screens > Screen Schemes to open the View Screen Schemes page.
   *Keyboard shortcut: g + g + type screen schemes
3. The View Screen Schemes page is displayed. Click Edit next to the desired screen scheme.
4. You will now be directed to the Edit Screen Scheme page where you can edit the Screen Scheme's name and description and the Screen that is associated with the Default Entry of the scheme.

Deleting a screen scheme

Note that screen schemes that are associated with an Issue Type Screen Scheme cannot be deleted. You will first need to edit the Issue Type Screen Scheme and remove the Screen Scheme.

To delete a screen scheme,

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Screens > Screen Schemes to open the View Screen Schemes page.
   *Keyboard shortcut: g + g + type screen schemes
3. The View Screen Schemes page is displayed. Click the Delete link next to the desired Screen Scheme. You will be prompted to confirm your deletion.

Copying a screen scheme

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Screens > Screen Schemes to open the View Screen Schemes page.
   *Keyboard shortcut: g + g + type screen schemes
3. The View Screen Schemes page is displayed. Click Copy next to the Screen Scheme you wish to copy.
4. You will now be directed to the Copy Screen Scheme page. Enter the name and description of the new Screen Scheme and click the Copy button.

![Copy Screen Scheme](image)

---

### Configuring a screen scheme

**Associating a screen with an issue operation**

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Screens > Screen Schemes to open the View Screen Schemes page. **Keyboard shortcut: g + g + type screen schemes**

![View Screen Schemes](image)

3. Locate the screen scheme in which you are interested, and click the Configure link next to it. The Configure Screen Scheme page is displayed:

![Configure Screen Scheme](image)

4. Click **Associate an Issue Operation with a Screen** to open this window:
5. Do the following:
   a. Select the Issue Operation with which you wish to associate a Screen.
   b. Select the desired Screen.

**Important Notes**

1. There can only be one association for an issue operation per Screen Scheme. If all operations have been associated with a Screen, use the Edit link next to each operation to change the Screen it is associated with.
2. If an issue operation does not have a specific mapping to a Screen, the screen that is associated with the Default entry will be used for that operation. The Default entry cannot be deleted from a Screen Scheme. Click Edit next to the Default entry to change the Screen that is associated with it.
3. The View Issue operation only allows you to control the layout of custom fields in the middle of the View Issue page. It ignores all the non-custom fields on the Screen.

**Editing an association**

1. Log in as a user with the JIRA Administrators global permission.
2. Choose ☑ > Issues. Select Screens > Screen Schemes to open the View Screen Schemes page.
   - **Keyboard shortcut:** `g + g + type screen schemes`
3. The View Screen Schemes page is displayed.
4. Locate the Screen Scheme in which you are interested, and click the Configure link next to it. The Configure Screen Scheme page is displayed.
5. On the Configure Screen Scheme page, click Edit next to the issue operation you wish to edit. The Edit Screen Scheme Item page is displayed:
6. Select the desired screen and click **Update**.

**Deleting an association**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **_issues** > **Issues**. Select **Screens** > **Screen Schemes** to open the View Screen Schemes page.
3. The **View Screen Schemes** page is displayed.
4. Locate the Screen Scheme in which you are interested, and click the **Configure** link next to it. The **Configure Screen Scheme** page is displayed.
5. On the **Configure Screen Scheme** page, click the **Delete** link next to the issue operation you wish to remove.

**Activating a screen scheme**

To activate a Screen Scheme, you need to associate it with one or more projects and issue types, using **Issue Type Screen Schemes**. To activate a Screen Scheme:

1. Configure an **Issue Type Screen Scheme** to use the Screen Scheme.
2. Associate the **Issue Type Screen Scheme** with a project.

For details of both procedures, see **Associating screens with Issue Types**.

**Associating Screen and Issue Operation Mappings with an Issue Type**

**What is an 'issue type screen scheme'?**

An 'issue type screen scheme' associates a **screen scheme** (which defines mappings between screens and issue operations) with **issue types**. Hence, an issue type screen scheme allows you to specify different **screens** for different issue types when used for the same issue operation (e.g. 'Create Issue') in a given JIRA project. For more information please see the **overview diagram**.

By default, your JIRA system contains an issue type screen scheme called **Default Issue Type Screen Scheme**. You may want to edit this scheme or copy it to make a new one.

**Configuring an issue type screen scheme**

The configuration of an Issue Type Screen Scheme involves associating an issue type(s) with a particular Screen Scheme. For example, associating the 'Bug' issue type with the 'Default Screen Scheme' and then associating the 'Improvement' issue type with the 'Improvement Screen Scheme'.

### On this page:

- What is an 'issue type screen scheme'?  
- Configuring an issue type screen scheme  
  - Associating an issue type with a screen scheme  
  - Editing an association  
  - Deleting an association  
- Adding an issue type screen scheme  
- Editing an issue type screen scheme  
- Deleting an issue type screen scheme  
- Copying an issue type screen scheme  
- Associating an issue type screen scheme with a project

**Associating an issue type with a screen scheme**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **Issues.** Select **Screens > Issue Type Screen Schemes** to open the View Issue Type Screen Schemes page.

   **Keyboard shortcut:** `g + g +` start typing issue type screen schemes

3. Click the **Configure** link next to the desired Issue Type Screen Scheme, which opens the **Configure Issue Type Screen Scheme** page:

4. Click **Associate an issue Type with a Screen Scheme**, which displays this screen:

5. Select an **Issue Type** you wish to associate a Screen Scheme with.
6. Select the desired **Screen Scheme**.
7. Click the **Add** button and the new association will be added to the association list above.

**Please note**
- There can only be one association for each issue type. If all issue types have been associated with a Screen Scheme you can use the **Edit** link next to each entry to change the Screen Scheme that is associated with it.
- If there is no specific entry for an issue type, the Screen Scheme associated with the **Default** entry will be used.
Editing an association

1. Log in as a user with the JIRA Administrators global permission.
2. Choose   > Issues. Select Screens > Issue Type Screen Schemes to open the View Issue Type Screen Schemes page.
3. Click the Configure link next to the desired Issue Type Screen Scheme, which opens the Configure Issue Type Screen Scheme page (see above).
4. Click the Edit link next to the issue type you wish to edit, which displays the Edit Issue Type Screen Scheme Entry page.

![Edit Issue Type Screen Scheme Entry](image)

5. Select the screen whose association you wish to change, and click the Update button.

Deleting an association

1. Log in as a user with the JIRA Administrators global permission.
2. Choose   > Issues. Select Screens > Issue Type Screen Schemes to open the View Issue Type Screen Schemes page.
3. Click the Configure link next to the desired Issue Type Screen Scheme, which opens the Configure Issue Type Screen Scheme page (see above).
4. Click the Delete link next to the issue operation you wish to remove.

The Default entry is used for all issue types that do not have a specific entry in the scheme. It cannot be deleted.

Adding an issue type screen scheme

1. Log in as a user with the JIRA Administrators global permission.
2. Choose   > Issues. Select Screens > Issue Type Screen Schemes to open the View Issue Type Screen Schemes page.
3. Click the Add Issue Type Screen Scheme button to open this page:
4. Enter the name for the new scheme. You can optionally add a description.
5. Select a Screen Scheme for the Default entry in the new scheme. The Default entry will be used for issue types that do not have a specific mapping in the scheme.
6. Click the Add button. The screen will automatically update the Issue Type Screen Schemes list with the new Issue Type Screen Scheme.

**Editing an issue type screen scheme**

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 📁 > Issues. Select Screens > Issue Type Screen Schemes to open the View Issue Type Screen Schemes page.
   - Keyboard shortcut: 'g' + 'g' + start typing 'issue type screen schemes'
3. Click the Edit link next to the desired Issue Type Screen Scheme to open the Edit Issue Type Screen Scheme page, where you can edit the Issue Type Screen Scheme's name and description as well as the Screen Scheme of the Default entry.
4. Click the **Update** button, which returns you to the **View Issue Type Screen Schemes** page, with your updates now applied to the Issue Type Screen Schemes list.

**Deleting an issue type screen scheme**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **Admin > Issues**. Select **Screens > Issue Type Screen Schemes** to open the View Issue Type Screen Schemes page.
   - **Keyboard shortcut**: ‘g’ + ‘g’ + start typing ‘issue type screen schemes’
3. Click the **Delete** link next to the Issue Type Screen Scheme you wish to delete.

**Copying an issue type screen scheme**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **Admin > Issues**. Select **Screens > Issue Type Screen Schemes** to open the View Issue Type Screen Schemes page.
   - **Keyboard shortcut**: ‘g’ + ‘g’ + start typing ‘issue type screen schemes’
3. Click the **Copy** link next to the field screen you wish to copy, which opens the **Copy Issue Type Screen Scheme** page.
4. Enter the name and description of the new Issue Type Screen Scheme and click the **Copy** button.
Associating an issue type screen scheme with a project

Once you have created and configured an Issue Type Screen Scheme to your desired settings, you can now associate the scheme with a Project. This will apply your chosen Screen Scheme to each issue type within the selected project.

1. Log in as a user with the JIRA Administrators global permission.
2. Choose \( \text{Admin} \) > Projects, and click the name of a project.
3. Select the project you wish to configure by clicking on its name.
4. Select Screens, you should see something like this:

   ![Screen Scheme Image]

5. Click the Actions dropdown menu and choose Use a different scheme.

6. Select the Screen Scheme you wish to associate with this project.

7. Click the Associate button.

To control which issue types apply to a project, please see ‘Associating Issue Types with Projects’.
Configuring Workflow

A JIRA workflow is the set of statuses and transitions that an issue goes through during its lifecycle.

Workflows typically represent business processes.

On this page we'll learn about:

- Statuses and transitions
- Active and inactive workflows
- Workflow designer
- Creating a new workflow
- Configuring a workflow
- Further reading

JIRA ships with a built-in workflow called jira, which is the default system workflow. It cannot be edited, however you can copy this workflow to quickly start creating your own workflow. You can also create your own workflows from scratch, or import workflows from Atlassian Marketplace. You can associate each workflow with particular projects and, optionally, specific issue types, by using a workflow scheme.

This is JIRA's default workflow:

![Transactional Flow Diagram](image)

**Statuses and transitions**

A status represents the state of an issue at a particular point in a specific workflow. An issue can be in only one status at a given point in time.

When defining a status, you can optionally specify properties.

A transition is a link between two statuses that enables an issue to move from one status to another. In order for an issue to move between two statuses, a transition must exist.

A transition is a one-way link, so if an issue needs to move back and forth between two statuses, two transitions need to be created. The available workflow transitions for an issue are listed on the View issue screen.
Active and inactive workflows

There are slight differences between editing an inactive and an active workflow. We place restrictions on the modifications you can make to an active workflow, due to the impact the changes will have on projects and/or issue types that use this workflow.

Inactive

An inactive workflow is a workflow that is not currently being used by any projects. Because there are no issues currently transitioning through an inactive workflow, you can edit the workflow's steps and transitions directly. For details on this, see Working in text mode.

Active

An active workflow is a workflow that is currently being used by one or more projects.

When you edit an active workflow, JIRA first creates a draft of it, that you can then modify as you see fit. When you've finished, you can publish your draft and, optionally, save your original workflow as an inactive backup.

The following limitations apply when editing the draft for an active workflow:

- It is not possible to edit the workflow name (only the description) if a workflow is active.
- Workflow statuses cannot be deleted.
- If a status has no outgoing transitions (Global transitions are not considered), it cannot have any new outgoing transitions added, regular or global.
- The step ID cannot be changed. See Cannot Add Transitions or Delete Steps in Draft Workflows.

To make any of the modifications listed above, you need to copy the workflow (see Creating a workflow), modify the copy and then activate it.

Workflow designer

Workflow designer is a graphical tool that allows you to see the layout of your workflow and to create and edit a workflow's steps and transitions.

The JIRA workflow designer looks like this:
The workflow designer allows you to:

- Add a status or transition.
- Click and drag a status or transition to reposition it.
- Select a status or transition to edit its properties, rename it, or to delete it (from the workflow but not JIRA), from the properties panel. As status names are stored on the global level, renaming one would affect all of JIRA immediately, even if the workflow draft is not published.
- Add a global transition that allows every other status in the workflow to transition to the selected status. Select **Allow all statuses to transition to this one** in the properties panel for the transition.
- Change the screen that a transition uses. See **Working in text mode** for details.
- Configure advanced transition options, such as triggers, conditions, validators and post functions. See the **Advanced transition configuration** page.
- Set properties for a status or transition. Please see **Workflow properties** for details.

**Workflow designer tips**
• Statuses are global objects in JIRA. Changing the name of a status on one workflow also changes the name of the status on all workflows that use that status.
• Hover over a transition or a status to see the relevant transition labels.
• Zoom the diagram with your mouse wheel. Pan the diagram by clicking and holding the mouse while on white space, then moving your mouse across the diagram.
• You cannot clone transitions in the workflow designer.
• You cannot create annotations in the workflow designer.
• You cannot directly set the issue.editable property. To do this, simply add the issue.editable property to the status properties.

Creating a new workflow

There are a few ways you can start a new workflow to work on:

• Clone an existing workflow
• Create a new workflow
• Import a workflow

Clone an existing workflow

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Workflows to open the Workflows page, which displays all of the workflows in your system.

3. Copy an existing workflow using the Copy link in the Operations column (shown above).
   a. Enter a name and description for your workflow.
   b. Click the Copy button. The workflow opens in edit mode.

Once you have created your new workflow, you may customize it by adding or editing steps and transitions.

When you have finished customizing your workflow, see Activating workflow for details on how to use it with a JIRA project.

Create a new workflow

i For advanced administrators

1. Click Workflows in the left-hand nav panel, then Add Workflow at the top of the screen.
2. Enter a name and description for your workflow. Click Add.
   The workflow opens in edit mode and contains a step called Open and an incoming transition called Create.
3. Continue with your workflow customizations, by adding and editing steps and transitions.

Import a workflow

Please see the documentation on Importing from Atlassian Marketplace.

Configuring a workflow

• Editing a project’s workflow
• Setting the Resolution field
• Renaming workflow transition buttons
• Working in text mode

Editing a project's workflow

Whenever you create a new JIRA project, your project automatically uses the default workflow scheme. The scheme associates all available issue types in the project with the JIRA system workflow. Since neither the JIRA system workflow nor the default workflow scheme are editable, JIRA creates an editable copy of the system workflow and workflow scheme for your project.

To begin editing your project's workflow for the first time:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🏛️ > Projects, and click the name of a project.
3. On the Administration page for the project, click Workflows.
4. Click the ‘edit’ icon at the top-right of the box.

JIRA automatically does the following:

• Creates a draft copy of the system workflow named ‘Your Project Name Workflow (Draft)’.
• Creates a new workflow scheme for the workflow named ‘Your Project Name Workflow Scheme’.
• Associates any existing issues in your project with the new workflow.

You can now edit your draft workflow. Click on a status or transition to see editing options in the panel that appears.

When you are finished, click Publish Draft. The dialog allows you to publish your draft and, optionally, save your original workflow as an inactive backup.

Usage notes:

• If you have only a small number of existing issues in your JIRA project, this process is relatively quick.
• If you have many (e.g. thousands of) existing issues in your JIRA project, this process may take some time.
• Once this process begins, it cannot be paused or cancelled. Please avoid editing or transitioning any issues within your project while this process is taking place.

Setting the Resolution field

In JIRA, an issue is either Open or Closed, based on the value of its Resolution field — not its Status field!

• An issue is Open if its Resolution field has not been set.
• An issue is Closed if its Resolution field has a value (e.g. Fixed, Cannot Reproduce).

This is true regardless of the current value of the issue’s Status field (Open, In Progress, etc).

Therefore, if you need your workflow to force an issue to be Open or Closed, you will need to set the issue’s Resolution field during a transition. There are two ways to do this:

• Set the Resolution field automatically via a post function.
• Prompt the user to choose a Resolution via a screen. See Working in text mode for details on this.

Renaming workflow transition buttons

If you copied the system workflow and you wish to rename the workflow transition buttons on the View issue page, you must delete the following properties from all transitions in the copied workflow:

• jira.i18n.title
• jira.i18n.description

Otherwise, the default names (i.e. values of these properties) will persist. Read more about transition properties.

Working in text mode
Text mode is an advanced way of working with workflows, and it shows the difference between steps and statuses. In text mode, you work directly with steps. For details, see Working in text mode.

Further reading

Advanced workflow configuration

Activating workflow

Workflows need to be activated to use them in JIRA. Activating a workflow is the process of mapping the workflow to a workflow scheme, and then associating the workflow scheme with a project.

A workflow scheme defines a set of associations – or mappings – between a workflow and an issue type. Workflow schemes are associated with a project and make it possible to use a different workflow for every combination of project and issue type.

Some terminology:

- **Active** workflows are those that are currently being used. **Inactive** workflows are those that are not associated with any workflow schemes, or are associated with workflow schemes that are not associated with any projects.
- **Active** workflow schemes are those associated with projects. **Inactive** workflow schemes are not associated with any projects.

To configure a workflow scheme, see Configuring workflow schemes.

On this page:

- Activating a workflow
- Associating a workflow scheme with a project
- Disassociating a workflow scheme from a project

Related topics:

- Configuring workflow schemes
- Configuring Workflow
- Sharing your workflow

Activating a workflow

To activate a workflow:

1. Log in as a user with the **JIRA Administrators** global permission.
2. Create a workflow scheme or find an existing workflow scheme. See Configuring workflow schemes for instructions.
3. Configure the workflow scheme to use your workflow. See Configuring workflow schemes for instructions.
4. Associate your workflow scheme with a project, as described in the Associating a workflow scheme with a project section below.

Associating a workflow scheme with a project

To associate a workflow scheme with a project:

1. Log in as a user with the **JIRA Administrators** global permission.
   - In some cases, JIRA will drop you out of administration mode. To get back, click the **Administer Project** button on the top right.
2. Choose 🔄 > **Projects**, and click the name of a project. The **Project Summary** page is displayed.
   - Keyboard shortcut: **g + g** + start typing **projects**
Projects Summary screen

3. Click Workflows on the left of the Project Summary page (you can also click the More link in the Workflows section in the middle of the screen). The Workflows page is displayed, indicating the current workflow scheme used by the project.

4. Click the Switch Scheme link to display the Associate Workflow Scheme to Project page.

5. Select the relevant workflow scheme from the Scheme list and click the Associate button to begin the migration process.

   Each issue has to be in a valid status. The valid statuses for an issue are defined by its workflow. This means that when changing a workflow, you may need to tell JIRA the status for specific issues after the change.

Publish Workflows status mapping screen

6. Click Acknowledge to finish the process. A message displays letting you know that your workflows have been published.

Please Note:
You can associate a single workflow scheme with more than one project although, only one workflow scheme can be associated with a given project.

The issue type scheme associated with a project defines the issue types that are available to that project. If an issue type is not defined in the project's issue type scheme, its workflow is not used.

Disassociating a workflow scheme from a project

A JIRA project must always be associated with a workflow scheme, since all issues must move through a workflow, even if that workflow only consists of a single Create Issue transition.

All JIRA projects with workflows that haven't been modified (in any way) or that have not yet been associated with a different workflow scheme, use JIRA's system workflow. So, in this sense, disassociating a workflow scheme means reassociating your project's workflow with JIRA's default workflow scheme.

To dissociate a workflow scheme from a project:

1. Follow the instructions in Associating a workflow scheme with a project above.
2. When selecting the workflow scheme from the Scheme list, select the Default workflow scheme.
3. Click the Associate button.
4. Follow the wizard, which guides you through migrating all of the project's issues to the JIRA's system workflow.

Configuring workflow schemes

A workflow scheme defines a set of associations – or mappings – between a workflow and an issue type. Workflow schemes are associated with a project and make it possible to use a different workflow for every combination of project and issue type.

By default, projects use JIRA's system workflow. The default workflow scheme:

- Associates JIRA's system workflow jira with all issue types (available to the JIRA project).
- Appears as Default Workflow Scheme in JIRA (or just Default in the context of workflow scheme selection dropdown menu).

This page describes how to configure workflows and issue type workflow associations in the scheme.

To associate a workflow scheme with a project (part of activating a workflow), see Activating workflow.

On this page:

- Adding a workflow scheme
- Configuring workflows for a workflow scheme
- Editing, copying, and deleting workflow schemes

Related topics:

- Activating workflow
- Configuring Workflow
- Sharing your workflow

Adding a workflow scheme

1. Log in as a user with the JIRA Administrators global permission.
3. Click the Add Workflow Scheme button.
4. Enter the Name and Description of the new workflow scheme.
5. Click the Add button. The new workflow scheme is created.
6. Follow the instructions in Configuring workflows for a workflow scheme below.
If your scheme is associated with a project, follow the instructions in Configuring a workflow scheme associated with a project. Otherwise, follow the instructions in Configuring a workflow scheme outside of a project.

### Configuring a workflow scheme associated with a project

| JIRA’s default workflow scheme cannot be modified. If you attempt to modify it, a copy of the scheme is created with the name of the project you are administering. You cannot configure a workflow scheme shared by multiple projects using this method; follow the instructions in Configuring a workflow scheme outside of a project instead. |

To configure the workflow scheme associated with a project:

1. Log in as a user with the JIRA Administrators global permission.
   - Choose ![> Projects](#) > Projects, and click the name of a project.
   - **Keyboard shortcut:** `g + g + start typing projects`

2. Select a project from the displayed list.
3. Click **Workflows** on the left of the **Project Summary** page. The **Workflows** page is displayed, indicating the current workflow scheme used by the project.
4. Configure the issue types for the workflow scheme as desired.
   - This is not the same as editing the workflow (clicking the **Edit** button in the workflow diagram at the center of your screen). If you do that you will be asked to Publish your *draft workflow scheme*.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Instructions</th>
</tr>
</thead>
</table>
| Add a workflow to the scheme | a. Click **Add Workflow** and select **Import From Bundle** or **Add Existing**.  
  - After selecting **Import From Bundle** you can select a workflow From Atlassian Marketplace which lets you import a workflow from the Atlassian Marketplace. For more information, see the section called 'Importing a workflow from Atlassian Marketplace' in Sharing your workflow.  
  b. Select the desired workflow and issue types. |
| Edit a workflow | Hover over the desired workflow and click the **Edit** button. See Configuring Workflow for further instructions.  
  - **Note:** The **Edit** button only displays if you have edit permission. |
| Remove a workflow from the scheme | Click the cross icon under Operations to remove the workflow from the scheme. |

---

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Configure a workflow scheme outside of a project

You can use this procedure to edit any workflow scheme in the system, including those shared by multiple projects. The workflow scheme can be either active or inactive.

Before you begin:

- If your workflow scheme is associated with a project, you may want to follow the instructions above instead. When a workflow scheme is used by more than one project, you must use this configuration method.
- When a workflow scheme is active, it creates a draft workflow scheme when you edit it.

To configure the workflow scheme that is not associated with a project:

1. Log in as a user with JIRA Administrators global permission.
   - Choose > Issues. Select Workflow Schemes to open the Workflow Schemes page.
   - Keyboard shortcut: g + g + start typing workflow schemes
2. Click the Edit link under the Operations column for the desired workflow.
3. Edit your workflow scheme as described in the table below.
4. If your workflow is active, you need to publish it to make your changes active.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Instructions</th>
</tr>
</thead>
</table>
| Add a workflow to the scheme | 1. Click Add Workflow and select Import From Bundle or Add Existing.  
   - After selecting Import From Bundle you can select a workflow From Atlassian Marketplace which lets you import a workflow from the Atlassian Marketplace. For more information, see the section called "Importing a workflow from Atlassian Marketplace" in Sharing your workflow.  
   2. Select the desired workflow and issue types. |
| Remove a workflow from the scheme | Click the Remove link in the Operations column. |
| Change the issue types associated with a workflow | 1. Click the Assign link under Issue Types for the desired workflow.  
   2. Select the desired issue types in the dialog that appears.  
   3. Click Finish. |
<table>
<thead>
<tr>
<th>View a representation of a workflow</th>
<th>Click either the Text or Diagram link next to the Workflow name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove an issue type from the scheme</td>
<td>Click the x next to the name of the issue type to remove it.</td>
</tr>
</tbody>
</table>

**Editing, copying, and deleting workflow schemes**

1. Log in as a user with the **JIRA Administrators global permission**.

2. Choose ✉️ > **Issues**. Select **Workflow Schemes** to open the Workflow Schemes page.

   ✔️ **Keyboard shortcut:** `g + g + start typing workflow schemes`

<table>
<thead>
<tr>
<th>Operation</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the name and description of a workflow scheme</td>
<td>Click the <strong>Edit</strong> link. Use inline edit mode – click in the associated field – to update the name and description.</td>
</tr>
<tr>
<td>Copy a workflow scheme</td>
<td>Click the <strong>Copy</strong> link. A copy of the workflow scheme is created with the prefix &quot;Copy of (name of current workflow)&quot; and placed in the inactive workflow schemes.</td>
</tr>
</tbody>
</table>
| Delete a workflow scheme | Click the **Delete** link and confirm the deletion.  
   ❗️ You cannot delete an active workflow scheme. You must first disassociate it from all projects. |

**Working in text mode**

Text mode is an advanced way of working with workflows, and it shows the difference between steps and statuses. In text mode, you work directly with steps.

For all of the following procedures, you must be logged in as a user with the **JIRA Administrators global permission** and start from the Workflows page.

**To access the workflows page:**

Choose ✉️ > **Issues**. Select **Workflows** to open the Workflows page, which displays all of the workflows in your system.

Note that by default, inactive workflows are hidden at the bottom of your Workflow page. Expand the link to view them.

**Text edit mode:**

Make sure the **Text** button is selected, so that your workflow appears in **Text** edit mode. A list of existing steps that comprise the workflow and each step's **Linked Status** and **Outgoing Transitions** (under **Transitions (id)*/), is shown.

You should be starting from a screen that looks like this:
Basic procedures

Editing a step

To edit an existing step in a workflow:

Click the following link of any step:

- **Add Transition** — to add an Outgoing Transition to that step.
- **Delete Transitions** — to delete one or more Outgoing Transitions of that step.
- **Edit** — to edit the step’s **Step Name** or **Linked Status**.
- **View Properties** — to view and edit the step’s Properties.
- **Delete Step** — only available if the step has no Incoming Transitions.

Adding a step

The **Add New Step** form appears below the list of steps when you are editing an inactive workflow.

To add a new step to a workflow:

1. In the **Step Name** field, type a short name for the step.
2. In the **Linked Status** field, select the status that corresponds to this step. Each status can only correspond to one step in each workflow.
3. Click the **Add** button. Your new step appears in your workflow’s list of steps in Text edit mode.

If you do not see Add New Step, this means that all available statuses defined in your JIRA installation have been used in your workflow and you need to define a new status.
### Deleting a step

A step can only be deleted if it has no incoming transitions.

**To delete a step from a workflow:**

Click the `Delete Step` link that corresponds to the relevant step.

- This link is not displayed if the step has no incoming transitions or if it only has incoming **Global Transitions**.

### Adding a transition

**To add a transition to a workflow:**

1. Identify the step from which your new transition will originate and click the `Add Transition` link next to the step. The **Add Workflow Transition** page is displayed.

2. In the **Transition Name** field, type a short name for the transition.
   - This name will be shown to users on the relevant transition button on the View issue page.
3. *(Optional)* In the **Description** field, type a short description of the purpose of the transition.
4. In the **Destination Step** field, choose the step to which issues will move when this transition is executed.
5. In the **Transition View** field, select either:
   - **No view for transition** — choose this if you do not need to prompt the user for input before the transition is executed (i.e. the transition will occur instantly when the user clicks the transition).
   - The name of a screen that will be shown to users, asking for input before the transition is executed.
   - You can choose one of JIRA's default screens or any other screen you have created. If no existing
screen is suitable, you may wish to create a new screen for the transition.

**Editing or deleting a transition**

To edit or delete an existing transition of a workflow:

1. In the Transitions (id) column, click the link of the Outgoing Transition of the step you wish to edit. The Transition page is displayed.

   ![Workflow diagram]

   Transition: To Payroll review

   Transition is available to ALL steps in the workflow.

   Screen: None - it will happen instantly

   ![Workflow conditions, validators, and post functions]

   From this point, you can:

   - Click the buttons at the top of the page to Edit or Delete the transition.
     **Note:** You will only be able to delete a transition if this step has at least one outgoing transition indicated in the Workflow Browser section. In the image above, this is not the case.
   - Click View Properties to edit the transition’s properties. See Advanced workflow configuration for details.
   - Add a new condition, validator, or post function. See Advanced workflow configuration for details.

2. From this point, you can:

   - Click the buttons at the top of the page to Edit or Delete the transition.
     **Note:** You will only be able to delete a transition if this step has at least one outgoing transition indicated in the Workflow Browser section. In the image above, this is not the case.
   - Click View Properties to edit the transition’s properties. See Advanced workflow configuration for details.
   - Add a new condition, validator, or post function. See Advanced workflow configuration for details.

**Advanced procedures**

**Preventing issues from being edited**

You can use a workflow step's properties to prevent issues from being edited in a particular workflow step. For example, in a copied system workflow, Closed issues cannot be edited, even by users who have the Edit Issue project permission.

**Note:**

- Issues that cannot be edited cannot be updated using Bulk edit.
- You can only edit the properties of a workflow's step if that workflow is editable (i.e. if that workflow is either inactive or a draft of an active workflow).

**To stop issues from being editable in a particular workflow step or to set any property of a step:**

1. Click the View Properties link that corresponds to the relevant step.
2. In the Property Key field, type: jira.issue.editable (or any other Property Key you wish to add).
3. In the Property Value field, type: false (or any other Property Value you wish to add).
4. Click the Add button.

**Note:**
It is not possible to edit a step's properties on this page. To change any property's key or value, you must first delete the property you wish to change and then add the new, updated property.

It is possible to implement restrictions on steps using step properties. For more information, see Workflow properties.

Using a screen with a transition

When a user clicks a particular transition, a screen can be used to gather input from the user before the transition is executed.

Example: using a screen to set the Resolution field

For a particular step in a workflow, you might need to create a transition that moves the issue to a Closed status. To do this:

1. Create or edit your transition.
2. Select the **Resolve Issue Screen** in the **Transition View** field.

3. Click **Add** when you are finished editing the workflow transition. You will be back on the **Text** view screen of the project's workflow.

Sharing your workflow

The workflow sharing feature lets share your team's workflow with other teams in your organization on different JIRA instances, or external parties in other organizations via the Atlassian Marketplace. This way, you can easily share and use workflows others have published. You can also move a workflow from staging to production in your organization.
Exporting your workflow

If you’d like to share your JIRA Workflow with another JIRA instance or upload it to the Atlassian Marketplace, first download it as a .jwb (JIRA Workflow Bundle) file. Here’s how to proceed:

1. Choose " > Issues.
2. Find the workflow you wish to share by clicking on the Workflows section in the left-hand panel.
3. Click View or Edit under the Operations column.
4. Select Export > As Workflow. You will see this screen:

![Export Workflow screen](image)

*Export Workflow screen*

5. Click Next to continue.
6. In the Add Notes field add any special configuration notes; for example, information about plugins that should be installed. JIRA auto-populates these notes for you when it discards parts of your workflow (for example, plugins, post functions, conditions, validators).
7. Click Export and select a download location. Ensure the location is publicly accessible.

Uploading to Atlassian Marketplace

To share your workflow with other JIRA users, upload it to the Atlassian Marketplace. Another good resource is Step-by-step Paid-via-Atlassian Listing.

1. Create an account on Atlassian Marketplace.
2. Log in to the Atlassian Marketplace.
3. Click Manage listings from the site header.
4. Click Create add-on.
5. Fill out fields accordingly.
6. A few notes as you complete your submission:
   a. List your add-on as Public unless your workflow contains sensitive information. Private workflows
can't be uploaded to JIRA Cloud.

b. Upload or link to your .jwb bundle. 

Choose either Upload your add-on artifact or Provide a URL to your artifact:

- Upload your add-on artifact (
  jar, .obr, or .jwb).
- Provide a URL to your artifact (.jar, .obr, .jwb, Atlassian Connect.xml or JSON descriptor)
- My add-on isn't directly installable

c. The Summary field contains the information users see when searching the Marketplace.

d. The Category for your workflow must be Workflow Bundles.

Choosing Workflow Bundles ensures other JIRA users will have visibility to your workflow.

e. The Add-on key must be unique.

This is something that uniquely identifies your product; it will become the product URL.

Once you accept The Atlassian Marketplace Publisher Agreement, the system submits your add-on for review by Atlassian's Marketplace team.

Importing from Atlassian Marketplace

This procedure covers importing a workflow from Atlassian Marketplace.

2. Click on the Workflows section in the left-hand panel.
3. Click Import from Marketplace.

You'll see this screen:

This screen displays the available workflows, ordered by popularity (determined by the number of downloads).

4. Find the workflow you want and click the Select button.
5. Follow steps 5 through 8 of the Importing from a local instance procedure.

Importing from a local instance

This procedure covers importing a workflow from a local instance. For importing from Marketplace, see the procedure above, Importing from Atlassian Marketplace.
2. Click on the Workflows section in the left-hand panel.
3. Select Import > Import Workflow.

![Import Workflow option](image)

4. Select a workflow from your computer to upload and then click Next.
5. JIRA automatically generates a workflow name, but you can change this if you like. Click Next.
6. Next, you are presented with a screen that details your workflow statuses, as shown below. You can map the steps of the workflow to your existing workflow statuses or create new statuses at this point. When you are finished, click Next to continue.

![Map Workflow Statuses screen](image)

7. You will be presented with a screen that presents a summary of the workflow changes, as shown below. Click Import at the bottom of this screen to accept these changes and import the workflow.
8. Your workflow is imported and you are presented with a screen with additional configuration details. Click **Done** to exit this process.

   ![Preview of import screen](image)

   All custom fields will have brand new custom fields created. This is regardless of a custom field of the same name / type already existing. See: [JRA-37358](https://issues.atlassian.com/browse/JRA-37358) - Workflow import creates duplicate custom fields for the request to improve this.

Custom fields in workflow imports

If the workflow that you are importing contains custom fields that are disabled, the workflow importer will not create these fields unless they are enabled before importing. You will receive a warning about this. To fix this, you need to enable the missing custom fields before proceeding with the import.
1. Click on the highlighted **Custom Field Types & Searchers** plugin in the displayed warning. This opens the plugin in a new window and scrolls to the right place to make the necessary changes:

![Custom Field Types & Searchers window](image)

2. Click to expand the list of enabled modules.
3. Find the modules that are disabled and enable them.

After enabling the corresponding modules of the **Custom Field Types & Searchers** plugin, return to the summary page and proceed. You may need to refresh the page first.

For information on installing add-ons, see [Viewing installed add-ons](#).

---

**Advanced workflow configuration**

This page describes configuring transitions in JIRA workflows. For information about the basics of workflows – see [Configuring Workflow](#).

As a JIRA administrator, you can control the following aspects of a transition's behavior:

- **Triggers** – transition JIRA issues when certain events occur in a connected development tool, such as Atlassian's [Bitbucket](#) or Stash.
- **Conditions** – check that a transition should be performed by the user.
- **Validators** – check that any input to the transition (for example, by a user) is valid, *before* the transition is performed.
- **Post functions** – carry out additional processing, *after* a transition is performed.
- **Properties** – are key-value pairs that can be used to further customize transitions.

Also on this page:

- **Customize how transitions appear**
- **Global transitions**
- **Further reading**

**Triggers**

JIRA administrators can configure triggers in JIRA workflows that respond to events in your linked development tools. This allows you to set up your development tools and JIRA workflows so that, for example, when a developer creates a branch to start work on an issue in Atlassian's Bitbucket or Stash, the
issue will automatically be transitioned from 'Open' to 'In progress'.

If you haven’t set up a trigger before or you want to learn about triggers in more detail, see our guide on triggers here: Configuring workflow triggers. The guide also shows you how to configure a workflow with triggers, similar to this sample development workflow: Development Workflow with Triggers (from Atlassian Marketplace).

### Configure triggers

To see, or to set, triggers for a transition, edit the workflow that contains the transition, select the transition, then click Triggers in the properties panel for the transition.

> Not sure about that? Click here to see how...

**To add a trigger to a transition:**

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose > Issues. Select Workflows to open the Workflows page, which displays all of the workflows in your system.
3. Click Edit for the workflow that has the transition you wish to change.
4. In the Workflow Designer, select the transition:

![Workflow Diagram]

5. Click Triggers in the properties panel to show the triggers configured for the transition.

6. Click Add trigger on the Triggers tab to configure a trigger.

### Conditions

Conditions control whether a transition should be executed by the user. As examples, conditions can be used to:

- allow only the reporter to execute a transition.
- allow only users with a certain permission to execute a transition.
- allow execution only if code has, or has not, been committed against this issue.

If a condition fails, the user will not see the transition button on the ‘View issue’ page, and so will not be able to execute the transition.

Conditions cannot validate input parameters gathered from the user on the transition’s screen – you need a
The following sections describe:

- Adding a condition
- Grouping conditions

**Adding a condition**

To add a condition to a transition, edit the workflow that contains the transition, select the transition, then click **Conditions** in the properties panel for the transition.

To add a condition to a transition:

1. Log in as a user with the ‘JIRA Administrators’ global permission.
2. Choose **Issues**. Select **Workflows** to open the Workflows page, which displays all of the workflows in your system.
3. Click **Edit** for the workflow that has the transition you wish to change.
4. In the Workflow Designer, select the transition:

   ![Workflow Diagram]

5. Click **Conditions** in the properties panel.

On the **Conditions** tab, you can see any conditions that have already been set.

When you click **Add condition**, you can choose from the available conditions, and set any necessary parameters for the condition:
Additional conditions may be available from installed plugins. or you can create your own conditions using the plugin system; see the Workflow Plugin Modules for details.

Note that you can also edit the transition in 'text' mode.

**Grouping conditions**

You can construct complex conditions by grouping and nesting conditions.

Change any condition into a group by clicking the 'Add grouped condition' icon for the condition:

Now you can add further conditions to this new group, as described above.

You can toggle the logic for how the conditions in a group are applied between All and Any.

**Validators**

Validators check that any input made to the transition is valid before the transition is performed. Input can include that gathered from the user on the transition's screen.

If a validator fails, the issue does not progress to the destination status of the transition, and the transition's post functions are not executed.

**Adding a validator**

To add a validator to a transition, edit the workflow that contains the transition, select the transition, then click Validators in the properties panel for the transition.

Not sure about that? Click here to see how...
To add a validator to a transition:

1. Log in as a user with the ‘JIRA Administrators’ global permission.
2. Choose 🚀 > Issues. Select Workflows to open the Workflows page, which displays all of the workflows in your system.
3. Click Edit for the workflow that has the transition you wish to change.
4. In the Workflow Designer, select the transition:

   ![Workflow Designer](image)

   Properties panel displays information about the current selected transition

   Blue line indicates the currently selected transition

5. Click Validators in the properties panel.

On the Validators tab, you can see any validators that have already been set.

When you click Add validator you can choose from the available validators and set any necessary parameters for the validator.

Note that you can also edit the transition in 'text' mode.

Post functions

Post functions carry out any additional processing required after a transition is executed, such as:

- updating an issue's fields
- generating change history for an issue
- adding a comment to an issue
- generating an event to trigger email notifications

The following sections describe:

- Essential post functions
- Optional post functions
- Using post functions with the initial transition
- Using a post function to set a field
- Using a post function to send HipChat notifications
Using a post function to send email notifications

**Essential post functions**

Every JIRA transition has the following essential post functions, which are performed in this order:

1. Set issue status to the linked status of the destination workflow status.
2. Add a comment to an issue if one is entered during a transition.
3. Update change history for an issue and store the issue in the database.
4. Reindex an issue to keep indices in sync with the database.
5. Fire an event that can be processed by the listeners.

These essential post functions cannot be deleted from a transition or reordered. However, you can insert other (optional) post functions between them.

**Optional post functions**

JIRA includes several optional post functions that can be added to transitions.

**Click to see a list of option post functions...**

<table>
<thead>
<tr>
<th>Optional post function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign to Current User</td>
<td>Assigns the issue to the user who is executing the transition. <strong>This post function is ignored unless the user has the Assignable User permission. Create a condition to give the logged-in user this permission before executing the transition.</strong></td>
</tr>
<tr>
<td>Assign to Lead Developer</td>
<td>Assigns the issue to the component lead, if one exists, or project lead.</td>
</tr>
<tr>
<td>Assign to Reporter</td>
<td>Assigns the issue to the user who created the issue.</td>
</tr>
<tr>
<td>Create Perforce Job Function</td>
<td>Creates a Perforce Job (if required) after completing the workflow transition.</td>
</tr>
<tr>
<td>Notify HipChat</td>
<td>Sends a notification to one or more HipChat rooms. See Using a post function to send HipChat notifications for more information.</td>
</tr>
<tr>
<td>Trigger a Webhook</td>
<td>Triggers the specified webhook after completing the workflow transition. When you add this post function, you will be asked to specify a webhook. This webhook must already be defined in JIRA (see Managing Webhooks).</td>
</tr>
</tbody>
</table>
| Update Issue Field | Updates one of the issue's fields to a given value. Fields that can be updated include:  
  - Assignee  
  - Description  
  - Environment  
  - Priority  
  - Resolution  
  - Summary  
  - Original Estimate  
  - Remaining Estimate  
  **This post function cannot update custom fields and must be positioned after the other optional post functions.** |
Adding a post function

To add a post function to a transition, edit the workflow that contains the transition, select the transition, then click Post functions in the properties panel for the transition.  

To add a post function to a transition:

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose 🌍 > Issues. Select Workflows to open the Workflows page, which displays all of the workflows in your system.
3. Click Edit for the workflow that has the transition you wish to change.
4. In the Workflow Designer, select the transition:

5. Click Post functions in the properties panel.

On the Post functions tab, you can see any post functions that have already been set:
When you click **Add post function** you can choose from the available post functions, and set any necessary parameters.

Options for editing or deleting a post function, and for changing the execution order, are at the right of the tab (hover there to see them).

Note that you can also edit the transition in **'text' mode**.

**Using post functions with the initial transition**

You can add post functions to a workflow's initial transition when you need to perform processing tasks – such as setting a particular field's value – when an issue is created. The initial transition is called 'Create' (if you created a blank workflow) or 'Create Issue' (if you copied the system workflow).

JIRA includes the following **essential post functions** that are specific to a workflow's initial transition and that are performed in this order:

1. Create the issue.
2. Fire an event that can be processed by the listeners.

The following optional post functions are available specifically for the initial transition:

<table>
<thead>
<tr>
<th>Optional post function (initial transition only)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Comment</td>
<td>Adds a comment to an issue if one is entered during a transition.</td>
</tr>
<tr>
<td>Update Issue Status</td>
<td>Sets the issue's status to the linked status of the destination workflow status.</td>
</tr>
<tr>
<td>Store Issue</td>
<td>Stores updates to an issue (no change history is created).</td>
</tr>
</tbody>
</table>

Additionally, the standard optional post functions can also be added to an initial transition.

Optional post functions added to the Create transition must be placed before the ‘Create the issue originally’ post function.

If you wish, you can configure the initial status for your workflow to go to a different initial transition. See Configuring the initial status for details.

**Notes**

If you need to set the ‘Resolution’ field when creating an issue, add the ‘Update Issue Field’ post function after the ‘Create the issue’ post function and after that, use the ‘Store Issue’ post function. The ‘Store Issue’ post function is useful for setting the Resolution field during issue creation.

However, only use the Store Issue post function where necessary, since it:

- does not generate change history
- is unable to persist fields that have a one-to-many relationship with the issue (for example, 'Version' or 'Component')

**Using a post function to set a field**

You can use the ‘Update Issue Field’ post function to set the value of an issue’s field after a particular transition is executed.

For example, you might want a transition that moves the issue to a closed status to automatically set the ‘Resolution’ field.

**Example: Using a post function to set the Resolution field:**

1. Edit the workflow that has the transition, and drag between status ports to create a new transition:

2. Select either None or a screen that does not contain the Resolution field.
3. **Add a new post function** of type 'Update Issue Field' and:
   a. Select **Resolution** from the **Issue Field** list.
   b. Select a suitable resolution from the **Field Value** list.

To create a transition that clears the **Resolution** field, follow the same steps above for adding an 'Update Issue Field' post function to your transition. However, select **None** from the **Field Value** list.

The list of post functions for this transition includes the following statement:

- The **Resolution** of the issue will be **cleared**.

Each time one of these transitions is executed, the **Resolution** of the issue is automatically set or cleared, as specified in these post functions.

**Using a post function to send HipChat notifications**

You can use a 'Notify HipChat' post function to send a notification to one or more HipChat rooms whenever an issue passes through a transition with this post function. You can also add a **JQL query** to the 'Notify HipChat' post function to filter for the issues that will trigger the HipChat notification.

**To send HipChat notifications:**

1. Create or edit your transition.
2. Add a new post function of type 'Notify HipChat'.
3. On the 'Add Parameters to Function' page:
   a. Optionally, specify a **JQL query**. Only issues that match the query will send notifications.
   b. Leave this field empty to send notifications to **all** issues that pass through this transition.
   c. Select the HipChat rooms you want to link with your workflow transition.

**Using a post function to send email notifications**

Use the 'Fire an event that can be processed by the listeners' post function to fire the 'Generic Event', which is a built-in **JIRA event** that can be used to trigger the sending of **email notifications** after a particular transition is executed.

Alternatively, you could fire a custom event that you've created specifically for this transition.

When a transition is performed, JIRA will:
- Look up the notification scheme associated with the issue's project and identify the users associated with the fired event;
- Send an email notification to each user.

Example: Using a post function to fire the Generic Event to send email notifications:

1. Create or edit your transition.
2. Click the transition’s Post Functions tab and edit the 'Fire an event that can be processed by the listeners' post function.
3. Select Generic Event from the list of events.

Transition properties

Properties are key-value pairs that can be used to further customize transitions. For example, transition properties can help to extend a copied system workflow to allow language translations.

To view and edit the properties of a transition:

1. Select a transition in the diagram.
2. Click Properties in the Properties panel.
3. Either:
   - Add a new property to the transition.
   - Delete a property, by clicking the icon to the right of the property.

Note that you can also edit the transition in 'text' mode.

It is possible to implement restrictions on transitions using transition properties. For more information, see Workflow properties.

Customize how transitions appear

When viewing an issue, most of the operations and workflow transitions are available from a row of buttons at the top of the issue. To change the order of transition buttons:

To change the order of transition buttons, including additional transitions in the Workflow menu, add the
property key `opsbar-sequence` to each workflow transition that you wish to reorder. Each `opsbar-sequence` property key requires a property value that defines the order of the transition action on issue views.

1. Go to the transition’s properties, as described in Transition properties above.
2. Type `opsbar-sequence` into the Property Key field, under ‘Add New Property’.
3. Type a value in the Property Value field. The value must be a positive integer (starting at ‘0’); it defines the order of the transition buttons on issue views. Consider using a sequence of `opsbar-sequence` property values like 10, 20, 30... to allow new transitions to be easily added later.
4. Click Add.

Adding the `opsbar-sequence` property to a workflow transition does not change the order of these transitions in the workflow in Text edit mode. The addition of this property only affects the order of transitions on the View issue page.

Global transitions

Global transitions allow any status in a workflow to transition to a particular status.

You can add a global transition:

- When creating a new status (adding an existing status) – check the Add global transition to status option.
- By selecting a status and checking Allow all statuses to transition to this one in the properties panel for the status.

To create two global transitions that point to the same destination step:

1. From the workflow designer, create the first global transition as normal by selecting a step and checking “Allow all statuses to transition to this one”
2. Create the second global transition on any other step that does not currently have a global transition pointing to it
3. Then from text editor, select the second global transition that you created
4. Click on the ‘Edit’ button and change the ‘Destination Step’ to the same step that you selected for your first global transition, and then click ‘Update’
Adding a custom event

JIRA uses an event-listener mechanism to alert the system that something has happened, and to perform appropriate action (e.g. send an email notification) based on the event that has occurred. Every issue operation within JIRA is associated with a particular event - e.g. the Issue Created event is fired when an issue has been created.

Some events are fired by JIRA internally — e.g. an Issue Updated or Issue Moved event. Other events are fired from within workflow transition post-functions — e.g. an Issue Resolved event, or a Custom Event (see below).

On this page:
- Overview
- System Events
- Custom Events

Configuring Notifications for a Custom Event
- Adding a custom event
- Configuring the notification scheme to send mail
- Configuring a post function to fire the custom event

Overview

There are two types of events within JIRA:

- System — System events are used throughout JIRA internally, and cannot be added or deleted. You can, however, make them Inactive (see below).
- Custom — Custom events are used to generate an email notification (or invoke a listener) from a particular workflow transition's post-function. You can add/delete as many custom events as you need. Note that only inactive custom events can be deleted.

An event can be in either of the following states:

- Active — the event is associated with at least one notification scheme or workflow transition post-function.
- Inactive — the event is not associated with any notification schemes or workflow transition post-functions.

Note that the event state does not indicate whether the event is able to be fired. A custom event will only be fired if it is associated with a transition post-function for an active workflow (see Activating workflow).

System Events

JIRA’s built-in system events are:

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Created</td>
<td>An issue has been entered into the system.</td>
</tr>
<tr>
<td>Issue Updated</td>
<td>An issue has had its details changed.</td>
</tr>
<tr>
<td>Issue Assigned</td>
<td>An issue has been assigned to a new user.</td>
</tr>
<tr>
<td>Issue Resolved</td>
<td>An issue has been resolved (usually after being worked on and fixed).</td>
</tr>
<tr>
<td>Issue Closed</td>
<td>An issue has been closed. (Note that an issue may be closed without being resolved; see Status uses ).</td>
</tr>
<tr>
<td>Issue Commented</td>
<td>An issue has had a comment added to it.</td>
</tr>
</tbody>
</table>
### Issue Comment Edited:
An issue's comment has been modified.

### Issue Reopened:
An issue has been re-opened.

### Issue Deleted:
An issue has been deleted.

### Issue Moved:
An issue has been moved into this project.

### Work Logged On Issue:
An issue has had hours logged against it (i.e. a worklog has been added).

### Work Started On Issue:
The Assignee has started working on an issue.

### Work Stopped On Issue:
The Assignee has stopped working on an issue.

### Issue Worklog Updated:
An entry in an issue's worklog has been modified.

### Issue Worklog Deleted:
An entry in an issue's worklog has been deleted.

### Generic Event:
The exact nature of this event depends on the workflow transition post-function(s) which invoke it. As with Custom Events, you can use the Generic Event to generate an email notification (or invoke a listener) from a particular workflow transition's post-function (see Worklow and Notifications).

### Custom Events

You can fire a custom event from a custom transition post-function in a custom workflow. The appropriate listeners will be alerted of the custom transition by the firing of this event. For example, the associated notification scheme can be configured to notify users of the workflow transition based on the firing of this custom event.

#### Configuring Notifications for a Custom Event

Custom events are most commonly used to generate notifications for custom workflow transitions. For example, your organisation might need you to modify the default workflow by adding a workflow step called 'QA_Inspection' (e.g. between Resolve Issue and Close Issue). You would typically also need to generate an email notification to the QA team whenever an issue progresses to the 'QA_Inspection' step of the workflow.

There are three overall steps to achieve this:

1. Add a custom event to the system (e.g. 'Issue Awaiting QA').
2. Configure the notification scheme to send an email when the custom event is fired.
3. Configure the workflow transition post-function to fire the custom event.

#### Adding a custom event

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🛠 > System. Select Advanced > Events to open the View Events page.
   - Keyboard shortcut: `g` + `g` + start typing `events`
3. In the Add New Event form at the bottom of the page, add a Name and Description for the custom event.
4. In the Template field, select the default email template to be associated with the event.
5. Click the Add button.

The custom event must be associated with a default email notification template. A notification scheme configured to notify users of this event will use this email template when sending the notification.

The custom event will appear in the list of events defined within the system. Initially, the event will be marked as inactive as it is not associated with a notification scheme or workflow post-function.

Configuring the notification scheme to send mail

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Notifications Schemes to open the Notification Schemes page.
3. Select the notification scheme to edit, by clicking the notification scheme’s name or its Notifications link (under Operations).
4. Add the recipients for the custom event as required. See Creating a Notification Scheme for more information.

Configuring a post function to fire the custom event

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Workflows to open the Workflows page, which displays all of the workflows in your system.
3. Navigate to workflow transition post-function screen to be edited. See Configuring Workflow and Applying Post Functions to Transitions for more information.
4. Update the post function to fire the custom event.
5. Activate or associate the workflow (and scheme) with the appropriate project. See Activating workflow for more information.

- Overview
- System Events
- Custom Events

Configuring Notifications for a Custom Event

- Adding a custom event
- Configuring the notification scheme to send mail
- Configuring a post function to fire the custom event

Configuring the initial status

Use this procedure to configure the initial status for your workflow. You can start off with an active workflow, which you can then switch to draft mode, or any other workflow in your system.

1. Click on Open under the Step Name column to view or edit a step's properties:
2. Click on the **Create Issue** incoming transition:

![Workflow diagram](image1)

**Note:** If you happen to be in an active workflow, which you cannot edit, you will be asked to switch to a draft workflow to continue.

3. Click **Edit** to set the new destination step:

![Workflow diagram](image2)

4. Select a new **Destination Step**, and then click **Update** to save it:
5. Now, when a new issue is created, it goes straight to the **In Progress** step, as shown here:
By integrating JIRA with HipChat, you get the following features:

- Get notified in your HipChat rooms when things change in your JIRA projects. Select only the issue types and priorities you want to see.
- See a user's HipChat status and send JIRA notifications to your HipChat rooms.

Before you can configure HipChat notifications in JIRA, you need to integrate JIRA with HipChat Server using the HipChat for JIRA integration plugin for your version of JIRA Server.

**Linking JIRA and your HipChat site**

To do this:

1. Log in as a JIRA administrator or a Project Administrator.
2. Go to the JIRA administration console, and then System > Mail > HipChat integration.
4. Follow the instructions to link JIRA to your HipChat site.
5. Once integrated, you can connect your JIRA projects to your HipChat rooms.

**Connecting projects to HipChat rooms**

You can link JIRA projects with one or more a HipChat rooms so that when issues are created or go through transitions, notifications are sent to the HipChat rooms that you specify.

To do this:

1. You must be a logged in as a JIRA administrator or a Project Administrator.
2. Choose Projects.
3. Select a project.
4. In the Project Administration menu select HipChat Integration.
5. Choose a HipChat room and select Add.
6. Select the Issue Type and Priority.
7. Select the actions that will send a notification to your room. This can include when an issue is created or is transitioned.
8. Changes are saved automatically, continue browsing your project to continue.

Private rooms

Private rooms in HipChat are by invitation only. In order to in connect JIRA to a private room in HipChat you will need to log into HipChat from the HipChat Integration setup screen.

Once you log in, all of the private rooms that you are a member of will be displayed in the room selector drop down menu. When your JIRA project and room are integrated, everyone in the private room will be able to see the notifications that are sent to that room.

Discuss JIRA issues in HipChat rooms

You can focus your discussion by creating or selecting a HipChat room to discuss a JIRA issue. When JIRA is integrated with HipChat and you are in the JIRA issue screen, you can select to "Create a room" or "Choose a room" in the HipChat discussions panel. This will associate the current issue and the room and any changes to the issue will send a notification to that room.

JIRA issue preview

With JIRA issue preview enabled, if you enter an issue key as part of a message, or paste a URL for the issue in any room in HipChat, you can receive a preview of the issue. This way the entire room can see and be on the same page when discussing a JIRA issue, without ever having to leave the discussion.

Connectivity requirements for JIRA and/or HipChat Server customers

For this feature to work, HipChat needs to be able to talk to JIRA, which means that your JIRA instance must be addressable and accept inbound connections via HTTPS.

A note on JIRA permissions

If this feature is enabled for a project, a preview will be posted in HipChat for any issue key/URL for that project. If a project contains sensitive information you don't want shared in HipChat, make sure to disable this feature for this project.

Configuring JIRA issue previews

When configuring issue preview, if you are logged in as a JIRA Administrator you can enable or disable it for all projects. This setting can also be overridden by a Project Admin by individually enabling or disabling each project.

As a JIRA Administrator:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System > Mail > HipChat integration.
3. Select Advanced Settings.
4. Select the check box to enable or disable the Issue Preview globally.
5. Select Save to exit.

As a Project Administrator:

1. You must be a logged in as a Project Administrator.
2. Choose > Projects.
3. Select a project.
4. In the Project Administration menu select **HipChat Integration**.
5. Select **Advanced Settings**.
6. Select the check box to enable or disable Issue Preview for your current room.
7. Select **Save** to exit.

Using validators with custom fields

Use the 'Fields Required' workflow validator that is packaged in the **JIRA Suite Utilities**.

Please note the following caveats regarding validation of data by the 'Fields Required' workflow validator at the time of issue creation:

- fields that you set up as "required fields" are not flagged as such in the form to the end-user
- such fields can be cleared at a later time, which is not what you may have intended
- plugins such as JIRA Agile will not detect the requirement as implemented by the workflow validator, so may fail later during usage

The reason 3rd party tools are needed is because JIRA's interpretation of "required" from a project's Field Configuration on some custom field means that the field is now required across all screens available to that project, regardless if the screen doesn't actually display that particular field. 3rd party tools, like the JIRA Suite Utilities' "Fields Required" validator, are effectively a more granular means to control fields at the step or screen level at a project, instead of at the project level by the Project's Field Configuration.

Using XML to create a workflow

JIRA’s workflow editor generates OSWorkflow XML definition files that are stored in JIRA's database. If you need to take advantage of an OSWorkflow-based feature that is not available in JIRA's workflow editor, you can define the workflow in XML and then import it into JIRA as described below.

Once the XML workflow has been imported, JIRA’s workflow editor should be able to display most OSWorkflow definitions even if it does not support creating or editing them.

For example, conditional results of workflow transitions are displayed in the **Other** tab on the **View Workflow Transition** page.

The **Other** tab is only visible if a transition has elements that the editor does not directly support.

Importing an XML workflow into JIRA

**To import an XML workflow into JIRA:**

1. Log in as a user with the **JIRA System Administrators** global permission.
2. Choose **> Issues**. Select **Workflows** to open the Workflows page, which displays all of the workflows in your system.
3. Click the **Import from XML** button to open the **Import Workflow** dialog box.
4. In the **Name** field, type a name (usually 2-3 words) to identify your new workflow.
5. **(Optional)** In the **Description** field, type a detailed description of your new workflow.
6. For the **Workflow Definition** option, you can do either of the following:
   - **Upload an XML workflow definition file** — to do this, choose the **Provide a full path to an XML**
file... option and in the File Path field, type the full path to your XML workflow definition file. This path must be local one, so your XML workflow definition file must be located on your JIRA server.

- Paste the contents of an XML workflow definition file into JIRA — to do this, choose the Paste the workflow XML definition option, copy the contents of your XML workflow definition file and in the Workflow Definition (XML) field, paste this copied content.

7. Click the Import button.

Copying a workflow between systems

Sometimes it is useful to create a workflow in a test system and then copy it into a production system. To do this:

1. In the test system, export the workflow to XML by clicking the XML link next to the workflow in the list shown on the View Workflows page and save the output into a file.
2. In the production system, import the file via the 'import a workflow from XML' link as described above.

- When importing an XML workflow into JIRA:
  - JIRA's XML workflow definitions contain references to JIRA meta attributes. For example, the id of the linked JIRA status of each workflow step is stored as a 'jira.status.id' meta attribute in the step's definition. Therefore, when manually creating workflows in XML, please ensure that all referenced external entities exist before you import the workflow into JIRA.

- When copying a workflow between systems:
  - Please note that conditions, validators and post functions can have parameters that might be valid in one system and not in another. For example, different systems might contain different sets of values for the 'Resolution' field. This would be a problem if the 'Update Issue Field' post function is used to set the 'Resolution' field to a value that exists in one system but not the other.

Workflow properties

You can use workflow properties to implement restrictions on certain steps or transitions of a workflow (below).

- Please Note: Not everything on this page is recommended!
  - We do not recommend using all of these types of workflow properties as we cannot guarantee that some data and operations (e.g. bulk operations) will not be broken. Hence, use these types of workflow properties at your own risk!

  For details on how to implement workflow properties (i.e. step and transition properties) in your workflow, please refer to Configuring Workflow.

Available JIRA workflow properties

There are a few workflow properties which you can use in a transition or step of a workflow. Here are some helpful links:

- JIRA API Documentation - JiraWorkflow constant values

<table>
<thead>
<tr>
<th>Name</th>
<th>Values</th>
<th>Related Issues</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira.field.resolution.exclude</td>
<td>Resolution id</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configuring workflow triggers

Triggers are a powerful tool for keeping your JIRA issues synchronised with the information in your development tools (Stash, FishEye/Crucible, Bitbucket and GitHub). Instead of relying upon developers to manually update the status of issues after committing code, completing reviews, creating branches, etc, you can configure triggers in your workflow to automatically transition issues when these events occur in your development tools. For example, you could configure a trigger to automatically transition an issue from 'To Do' to 'In Progress' when a branch is created.

On this page:

- Before you begin
- Guide: setting up triggers
- Understanding triggers
- Troubleshooting

This page will help you get started using triggers. We will show you how to set up triggers in a workflow and demonstrate how an automatic transition works. We will also provide some guidelines on how to best configure a trigger and help you troubleshoot your triggers.

Before you begin

Before you can start using triggers, you need to connect your development tools to JIRA. At a minimum, you will need JIRA Server 6.3.3 (or later) or JIRA Cloud plus at least one of the following:

- Stash 3.2.0 (or later)
- FishEye/Crucible 3.5.2 (or later)
- GitHub Enterprise 11.10.290 (or later)
- Bitbucket
- GitHub

For instructions on how to connect these tools to JIRA, see...
Tip: If you integrate JIRA with the development tools above, you will enable a range of other features. These include development information shown on issues and the ability to create a branch when starting work on an issue. See Streamlining your development with JIRA for details.

Guide: setting up triggers

In this example, you will be configuring a JIRA workflow with triggers. By the end of this section, you will have an understanding of how to configure triggers and what a typical development workflow with triggers looks like.

- Introduction
- Step 1. Create/Edit a workflow
- Step 2. Add a trigger to a transition
- Step 3. Test the trigger
- Step 4. Add the rest of the triggers

Introduction

The screenshot and table below show a workflow and triggers similar to what you will be configuring. They reflect the typical interactions between JIRA and development tools in a software development lifecycle. JIRA (6.3.4), Stash (3.2.2) and FishEye/Crucible (3.5.2) are used for this example, but you can configure something similar using any of the supported development tools.

<table>
<thead>
<tr>
<th>Transition</th>
<th>Triggers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start progress (To Do (\rightarrow) In Progress)</td>
<td>Branch created (Stash) Commit created (Stash)</td>
</tr>
<tr>
<td>Start review (In Progress (\rightarrow) In Review)</td>
<td>Pull request created (Stash) Pull request reopened (Stash) Review started (Crucible)</td>
</tr>
<tr>
<td>Restart progress (In Review (\rightarrow) In Progress)</td>
<td>Pull request declined (Stash) Review rejected (Crucible) Review abandoned (Crucible)</td>
</tr>
<tr>
<td>Done (In Review (\rightarrow) Done)</td>
<td>Pull request merged (Stash) Review closed (Crucible)</td>
</tr>
</tbody>
</table>

Step 1. Create/Edit a workflow
The easiest way to create a software development workflow is to create a new project, choosing the Software Development project type. This will set up your new project with the software development workflow, which is identical to the one shown above.

If you already have a similar workflow, navigate to it and edit it: JIRA administration console > Issues > Workflows > Edit

Step 2. Add a trigger to a transition

We'll start by adding a 'Commit created' trigger to the 'Start progress' transition. Ensure that you are editing (not viewing) the workflow.

1. Select the Start progress transition in the workflow, i.e. the line from 'To Do' to 'In Progress'. A panel will display on the right, showing the details of the transition.

   Related topic: Why you shouldn't configure triggers on global transitions

2. Click Triggers in the panel. The 'Transition: Start Progress' screen will display with the 'Triggers' tab showing.

3. Click Add trigger, then select Commit created in the dialog that appears. A diagnostics window will display — you'll notice that the trigger will be added for all development tools that JIRA is connected to (Stash and FishEye/Crucible in this example).

   Related topic: How to enable different events for triggers

4. Click Add trigger to add the trigger. It will appear in a list at the bottom of the 'Triggers' tab. You can check whether it is working by clicking View Details.

That's it! Don't forget to publish your draft workflow.

Step 3. Test the trigger
Now that you have added the 'Commit created' trigger to the 'Start progress' transition, let's test it by making a commit.

1. Create an issue in your JIRA project. This project needs to be using the workflow that you just edited. The status of your new issue should be 'To Do'. Take note of the issue key, as you'll need it for the next step.

2. Commit some code to your Stash repository. You can commit anything, however you will need to include the issue key in your commit message. In this example, the issue key is TIS-1, which is referenced in the commit message shown in the screenshot.

3. Check your issue in JIRA again. The status should have changed from 'To Do' to 'In Progress'. If you click the **History** tab or **Activity** tab, you can see the automatic transition that changed the issue's status.

**Related topics:** Referencing a JIRA issue in a commit, branch, pull request, or review

---

**Understanding triggers**

The following topics explain how triggers work in more detail, so you can use them more effectively.
### Trigger events

Events (e.g. Commit created) are made available for triggers by integrating JIRA with particular development tools. The table below lists the events that are enabled for each development tool.

<table>
<thead>
<tr>
<th>Dev tool</th>
<th>Bitbucket, Stash, GitHub, GitHub Enterprise</th>
<th>Crucible</th>
<th>FishEye</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events</td>
<td>• Pull request created&lt;br&gt;• Pull request merged&lt;br&gt;• Pull request declined (Bitbucket and Stash only)&lt;br&gt;• Pull request reopened (Stash only)&lt;br&gt;• Commit created&lt;br&gt;• Branch created</td>
<td>• Review started&lt;br&gt;• Submitted for approval&lt;br&gt;• Review rejected&lt;br&gt;• Review abandoned&lt;br&gt;• Review closed&lt;br&gt;• Review summarized</td>
<td>• Commit created&lt;br&gt;• Branch created</td>
</tr>
</tbody>
</table>

### Triggers and global transitions

We recommend that you do not configure triggers for global transitions, unless you are confident that you understand exactly how the trigger will affect the behaviour of the issue.

A global transition allows any status in a workflow to transition to a particular status. This is represented in the workflow viewer/editor by a black lozenge pointing to the status that the global transition targets. For more information about global transitions, see [Advanced workflow configuration](#).

Configuring triggers for global transitions can often result in an issue unexpectedly transitioning to the target status for the global transition. For example, consider if you configured a 'Commit created' trigger for the global transition to the 'In Progress' status. Committing code can happen at many stages during an issue's lifecycle (e.g. writing the initial code, changing code after a review, etc). This could result in the issue incorrectly transitioning to 'In Progress' out of a number of statuses, like 'In Review' or 'Done'.

**Tip:** If you do use global transitions in your workflow, you will probably have multiple transitions into a status. This means that users will have multiple workflow options on an issue (e.g. both 'Start Progress' and 'In Progress'). To hide options, add the 'Hide transition from user' condition to the relevant transitions.

### Referencing a JIRA issue in a commit, branch, pull request, or review

The table below describes how to reference a JIRA issue in a commit, branch, pull request, or review, so that these events will trigger transitions for the issue (provided that you have set up triggers on the transitions).

<table>
<thead>
<tr>
<th>Event</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create commit</td>
<td>Include the issue key in the commit message.</td>
</tr>
<tr>
<td></td>
<td>For example, a commit message like this &quot;TIS-1 Initial commit&quot; will automatically transition the TIS-1 issue from 'To Do' to 'In Progress'.</td>
</tr>
<tr>
<td>Create branch</td>
<td>Include the issue key in the branch name, when you create the branch.</td>
</tr>
<tr>
<td></td>
<td>For example, if you name your branch &quot;TIS-2-feature&quot;, it will automatically transition the TIS-2 issue from 'To Do' to 'In Progress'.</td>
</tr>
<tr>
<td>Create/Reopen/Decline Merge pull request</td>
<td>Ensure that the pull request includes commits that reference the issue (in their commit messages).</td>
</tr>
<tr>
<td></td>
<td>For example, if you create a pull request that has &quot;TIS-3&quot; in the title, it will automatically transition the &quot;TIS-3&quot; issue from 'In Progress' to 'In Review'. If you reopen, decline or merge the pull request, it will also transition the &quot;TIS-3&quot; issue accordingly.</td>
</tr>
</tbody>
</table>
| Start/Reject/Abandon/Close review | Include the issue key in the review title, when you create the review.  
For example, if you name your review “TIS-4 New story” and start the review, it will automatically transition the TIS-4 issue from ‘In Progress’ to ‘In Review’. If you reject, abandon or close the review, it will also transition the “TIS-4” issue accordingly. |

**User mapping from the development tools to JIRA**

The following process describes how a development tool user is mapped to a JIRA user for workflow triggers. It applies to all events, however each development tool uses a different email address and username for the mapping (see the bullet point following the process description below).

- **Process:** The user initiating the event in the development tool is mapped to a JIRA user by matching the email address, then the username, i.e.  
  - *Single JIRA user with a matching email address* — Transition the issue as the JIRA user.  
  - *No JIRA users with a matching email address* — Transition the issue as an anonymous user.  
  - *Multiple users with a matching email address in JIRA* — Try to find a matching username in that group of users. If there is a JIRA user with a matching username, transition the issue as the JIRA user. If there is no matching username, transition the issue as an anonymous user.

- **Email address and username used for user mapping:**
  - **Stash**
    | Event(s)       | Email address and username used for user mapping |
    |----------------|-----------------------------------------------|
    | All pull request events | The Stash email address and username of the user who actioned the pull request. |
    | Commit created | The email address associated with the commit and the Stash username that the email address maps to. If the email address does not map to a username, the authors "name" from the commit will be used. |
    | Branch created | The Stash email address and username of the authenticated user that pushed the branch to Stash. |
  - **FishEye/Crucible**
    | Event(s)       | Email address and username used for user mapping |
    |----------------|-----------------------------------------------|
    | Commit created | The email address associated with the commit and the FishEye username that the email address maps to. If the email address does not map to a username, the authors "name" from the commit will be used. |
    | Branch created | This event is not mapped to a JIRA user. This means that the issue will be transitioned as an anonymous user. |
    | All review events | The Crucible email address and username of the authenticated user that actioned the review. |
  - **Bitbucket**
    | Event(s)       | Email address and username used for user mapping |
    |----------------|-----------------------------------------------|
    | All pull request events | The Bitbucket email address and username of the user who actioned the pull request. Note, the Bitbucket user needs to have made at least one commit (with that email address configured for their profile), otherwise the pull request cannot be mapped to a JIRA user. This means that the issue will be transitioned as an anonymous user. |
Commit created | Email address associated with the commit and the Bitbucket username that the email address maps to. If the email address does not map to a username, the authors "name" from the commit will be used.

Branch created | This event is not mapped to a JIRA user. This means that the issue will be transitioned as an anonymous user.

### GitHub / GitHub Enterprise

<table>
<thead>
<tr>
<th>Event(s)</th>
<th>Email address and username used for user mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull request created / Pull request merged</td>
<td>GitHub email address and username of the user who actioned the pull request. Note, the GitHub user needs to have made at least one commit (with that email address configured for their profile), otherwise the pull request cannot be mapped to a JIRA user. This means that the issue will be transitioned as an anonymous user.</td>
</tr>
<tr>
<td>Commit created</td>
<td>Email address associated with the commit and the GitHub username that the email address maps to. If the email address does not map to a username, the authors &quot;name&quot; from the commit will be used.</td>
</tr>
<tr>
<td>Branch created</td>
<td>This event is not mapped to a JIRA user. This means that the issue will be transitioned as an anonymous user.</td>
</tr>
</tbody>
</table>

### Event handling and event limits

In most cases, the processing of events from your development tools into automatic issue transitions should be seamless. However, sometimes there may be delays in issues transitioning or issues not transitioning at all, due to how events are handled or event limits.

- **Event handling** — Events are handled differently depending on whether the development tool connects to JIRA via the DVCS connector or an application link. This can affect whether events are delayed or lost when JIRA is unavailable:
  - **Bitbucket and GitHub**
    - Events from Bitbucket and GitHub are processed via the DVCS connector in JIRA. The DVCS connector processes events from Bitbucket and GitHub via two synchronization mechanisms: a webhook-triggered synchronization and a scheduled synchronization.
      - **Webhook-triggered synchronization:** the DVCS connector uses webhooks in Bitbucket and GitHub to post data to JIRA when an event occurs. This is the standard mechanism for processing events, which means that issues should be automatically transitioned almost immediately after a Bitbucket/GitHub event.
      - **Scheduled synchronization:** if JIRA cannot be contacted when a Bitbucket/GitHub event occurs, the event is stored by the DVCS connector and sent at the next scheduled synchronization (every 60 minutes, by default). This is a backup mechanism in case the webhook-triggered synchronization fails.
  - **Stash and FishEye/Crucible**
    - Events from Stash and FishEye/Crucible are processed via the application link. However, Stash and FishEye/Crucible are responsible for ensuring that events are sent, and they send them once at the time that the event occurs. This means that if JIRA is unavailable when the events are sent, the events will be lost.

- **Event limits** — Event limits are imposed on all of the development tools so that JIRA is not overloaded with too many events. Any events sent after the event limit is exceeded are lost. Event limits for each development tool are listed below:
  - **Bitbucket and GitHub**
    - **Webhook-triggered synchronization:** 10 branches; 100 commits
    - **Scheduled synchronization:** 600 branches (sync interval in minutes x 10); 6000 commits (sync interval in minutes x 100)
      - The event limits for scheduled synchronizations can be less than 600 branches and 6000 commits, if the synchronization interval is reduced, but never greater.
Stash
10 branches; 100 commits per synchronization
A further constraint that applies on top of the 10 branches and 100 commits limits is a 100,000 issue changed event limit. For example, if 100 commits each reference more than 1000 issue keys, the issue changed limit would be exceeded.

FishEye/Crucible
6000 events per synchronization

How triggers relate to other workflow operations/constraints

When a transition is triggered automatically, it ignores any conditions, validators or permissions configured on the transition.

However, post functions are still executed. You need to be careful that if your post function requires a user, that your transition will not be executed by an anonymous user (see user mapping section above).

Troubleshooting

If you are having problems setting up a trigger or getting a trigger to work, follow the steps below to troubleshoot your problem.

1. Use the trigger diagnostics
2. Check for common problems
3. Get help

1. Use the trigger diagnostics

Your first step in troubleshooting a trigger is to check the diagnostics for it in JIRA. The diagnostics can tell you if there is a problem with the connection to your development tools or whether an issue did not automatically transition as expected.

1. Navigate to the JIRA administration console > Issues > Workflows > Find your workflow and click View (Operations column)
2. In Text mode (not Diagram mode), click the desired transition.
3. On the transition screen (Triggers tab will be showing), click View details for the desired trigger to show the diagnostics information.

- The 'Trigger sources' section lists problems related to the integration between JIRA and your development tools. For example, whether you have the correct type of authentication configured.
- The 'Transition failures' section lists issues that have failed to automatically transition despite the trigger firing. For example, an anonymous user was mapped to the transition but the transition has a post function that requires a non-anonymous user.

2. Check for common problems

If you cannot resolve your problem with the information from the trigger diagnostics, check the list of common problems below for possible causes and solutions.

I cannot add a trigger to a transition:

Possible causes...

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA or your development tools are not the correct version</td>
<td>Install/Upgrade to the correct version. You must have JIRA 6.3.3+ and one of the following development tools to enable workflow triggers: Stash 3.2.0+, FishEye/Crucible 3.5.2+, Bitbucket, GitHub</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| Your development tools are not connected to JIRA correctly | Check the configuration of your connection:  
  • JIRA + Stash/FishEye/Crucible: You need to configure a two-way application link using Oauth with 2LO and 3LO.  
  • JIRA + Bitbucket/GitHub: You need to configure the DVCS connector correctly.  
  For more details, see |
| The trigger that you are trying to add has already been added to the transition | Do nothing.  
  All triggers are unique per transition, that is, you can only add a trigger to a transition once. |

### The issue does not transition:  
**Possible causes...**

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your project is not using the workflow that has been configured with triggers</td>
<td>Navigate to your project's summary &gt; Administration &gt; Workflows, and check that your project is using the workflow that you have configured with triggers.</td>
</tr>
<tr>
<td>You have not saved your workflow changes where the triggers were added</td>
<td>Navigate to the workflow that you added triggers to. Check that it has been published by viewing the workflow transitions and confirming that your triggers are present.</td>
</tr>
</tbody>
</table>
| JIRA cannot be reached by your DVCS | Wait an hour. If it still cannot be reached after an hour, check that the connection to your DVCS is configured correctly, see  
  If triggers are not configured or JIRA is not reachable from Bitbucket/GitHub, then the delay might be up to one hour, as there is still an hourly synchronization of commits/branches/pull requests happening regardless of the triggers configuration. For more information, see the Event handling and event limits section above. |
| Your DVCS repository is not linked to the synchronised DVCS account | Navigate to the JIRA administration console > Add-ons > DVCS Accounts and enable your repository.  
  If you have not configured Bitbucket or GitHub to autolink new repositories, you may have repositories that are not enabled (i.e. linked to your DVCS account). This means that events from the unlinked repository will not be sent to JIRA, hence the issue will not transition automatically, even if you have configured a trigger. |
| Your commits are too old | Only commits less than 21 days old will cause a transition. This is to prevent bulk uploads from causing bulk transitions.  
  If you want to work around this, you can change the 21 day constraint by editing the jira-config.properties file (in your JIRA home directory) and adding the following property:  
  jira.devstatus.commitcreated.age.timeout=P2D  
  where P2D is an example ISO-8601 duration representing 2 days. |
The operation is not permitted for anonymous users

Check that each user in your development tools maps to a JIRA user.

Certain issue operations will throw exceptions when the transition is performed by an anonymous user. These are:

- The CreateIssue event (this probably relates to 'Create' or 'Create Issue' transition in your workflow)
- Post functions that assume a user is performing the transition

A triggered transition is performed by an anonymous user if the event in the development tool cannot be mapped to a JIRA user. For more information, see the section on user mapping above.

The maximum number of automatic transitions permitted for an issue has been exceeded

Check that your workflow transitions do not end in an infinite loop.

By default, only 50 automatic transitions are permitted per issue. This is to prevent issues from becoming stuck in infinite loops. If your workflow actually requires more than 50 automatic transitions per issue, you can override this constraint by editing the `jira-config.properties` file (in your JIRA home directory) and adding/updating the following property:

```
jira.automatic.transitioning.issue.limit
```

Automatic issue transition events are incorrectly suppressed by the development tool

Change the repository/project settings to allow events to be sent.

You may have configured Stash (3.3 - 3.5) or FishEye (3.5+) repositories to suppress events sent to JIRA for workflow triggers, if duplicate events were being sent. Duplicate repository events may be sent to JIRA when you have the same repository indexed by multiple development tools. Note, JIRA will automatically remove duplicate commit events (JIRA 6.3.3+) and branch creation events (JIRA 6.3.11+) when processing workflow triggers.

You shouldn’t suppress repository events from Stash or FishEye, unless duplicate events are causing issues to transition incorrectly. See JIRA workflow triggers (FishEye documentation) for instructions.

The issue transitions but not as expected:

Possible causes...

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| You have configured a trigger on a global transition | Investigate how the trigger event affects issues in different statuses. Consider removing the trigger from the global transition.  
We recommend that you do not configure triggers for global transitions, unless you are confident that you understand exactly how the trigger will affect the behaviour of the issue. See Triggers and global transitions above for more information. |
| Workflow conditions, validators and permissions are intentionally ignored for automatic issue transitions | Do nothing.  
If you were expecting workflow conditions, validators or permissions to be applied to an automatic issue transition, then please note that none of these apply.  
Related to this, post functions do apply to automatic issue transitions. |
| Your workflow is shared across multiple projects | You may need to copy your workflow, if you want triggers to apply to the workflow for some projects but not others.  
Triggers apply to the workflow. If a workflow is shared across multiple projects, it will include all triggers that have been configured for it. |
Duplicate automatic issue transition events are being sent by multiple development tools

Change the repository/project settings in one (or more) of your development tools to prevent events from being sent.

Duplicate repository events may be sent to JIRA when you have the same repository indexed by multiple development tools. JIRA will automatically remove duplicate commit events (JIRA 6.3.3 and later) and branch creation events (JIRA 6.3.11 and later).

If you are not using the latest JIRA version and have duplicate repository events causing incorrect issue transitions, you can configure Stash (3.3 - 3.5) and FishEye (3.5+) repositories to suppress events sent to JIRA for workflow triggers. See JIRA integration (Stash documentation) or JIRA workflow triggers (FishEye documentation) for instructions.

The information recorded for the transition is not correct:

Possible causes...

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The users in your development tools do not map to users in JIRA</td>
<td>Check that each user in your development tools maps to a JIRA user. If users are not mapped correctly, then the user for the issue transition will be anonymous. For more information, see the section on user mapping above.</td>
</tr>
<tr>
<td>Known issue: The correct user is only shown on the 'History' and 'Activity' tabs for issues in JIRA, and in notification emails. In other notifications, e.g. 'Transitions' tab for issues, HipChat notifications, etc, an anonymous user is shown.</td>
<td>Do nothing This is a known issue that will be fixed in a future release.</td>
</tr>
</tbody>
</table>

3. Get help

If you still cannot resolve your problem, there are a number of other help resources available including our product forums, Atlassian Answers, and our support team. See Getting Help for details.

Configuring Email

- Configuring Email Notifications
- Creating Issues and Comments from Email

Configuring Email Notifications

JIRA can send email notifications to users when significant events occur (e.g. creation of an issue; completion of an issue).

Email notifications

Disabling email notifications

To disable email notifications for a project, you can remove the notification scheme from the project by editing the project and selecting 'None' as the project's notification scheme.

Alternatively, you can edit the notification scheme so that no emails are sent.
Configuring a project's email address

It is possible to configure a project's email address, which is the email address that notifications are sent from – i.e. the 'sender address'. This will also serve as the reply address for responses, which can work in conjunction with Creating Issues and Comments from Email.

By setting the Sender Address for a project, all notifications will be sent from this address. This setting is specific to the project selected and will not affect the configuration of the other projects. The From address specified in the SMTP Mail Server configuration is used as the default Sender Address for all projects.

The 'Sender Address' for a project can be configured as follows:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose ☰ > Projects, and click the name of a project. The ‘Project Summary’ page (see Defining a Project) for your selected project is shown.
   - Keyboard shortcut: g + g + start typing the name of your project
3. At the lower-right section of the ‘Project Summary’ page, locate the Notifications section and click the ‘pen’ icon to the right of the Email address.
4. In the resulting Project Email Address dialog box, enter a valid email address in the Sender Address field and click Update to complete the process. This email address will now be used as the 'sender' address in all email notifications sent by this project.

   **Note:** You can reinstate the default email address (as specified in the SMTP Mail Server configuration) by re-editing the Sender Address field (in the Project Email Address dialog box) but leaving it blank.

Email recipients

For each event notification, JIRA will only send the first encountered email intended for a recipient. Hence, in the case where a user is included in two or more recipient lists (e.g. the Project Lead and current reporter) for one event notification, the user will only receive the first encountered email notification. JIRA will log the fact that this user was on multiple recipient lists.

JIRA’s default setting is to not notify users of their own changes. This can be changed on a per user basis via their Profile Preferences.
Email HTML formatting

Each JIRA user can specify in their own profile preferences whether to send outgoing emails in either text or HTML format. JIRA Administrators can specify a default email format by choosing the cog icon at top right of the screen, then System -> User Default Settings.

The HTML email format can accommodate internationalized words in the 'Issue Details' section. However, due to Internet Security Settings, which prevent images from being automatically downloaded, the HTML email messages may not be correctly formatted. For example, the summary column on the left may appear too wide. It is possible to correct the formatting by accepting to download these images. On some email clients, it is possible to do this in two different ways:

1. **Per email message:**
   - Mozilla Thunderbird — by clicking on the 'Show Remote Content' button above the email.
   - Microsoft Outlook 2003 — by clicking on the 'Click here to download pictures. To help protect your privacy, Outlook prevented automatic download of some pictures in this message.' message above the email.
   - Microsoft Outlook 2000 — does not have this option, it always downloads images.
   - Microsoft Outlook Express 6 — by clicking on the 'Some pictures have been blocked to help prevent the sender from identifying your computer. Click here to download pictures.' message above the email.

2. **Configuring the email client:**
   - Mozilla Thunderbird 1.5 — Navigate to Tools > Options > Privacy > General tab and ensure that "Allow remote images if the sender is in my:" option is checked and note which address book is selected. Then return to the e-mail sent from JIRA, right-click on the sender's e-mail address and choose "Add to address book..." option, adding this contact to the same address book as was selected in the Privacy options.

Troubleshooting email notifications

**Using the JIRA admin helper**

The JIRA admin helper can help you diagnose why a user isn't receiving email notifications when they should be, or why a user is receiving email notifications when they shouldn't be. This tool is only available to JIRA administrators.

**To diagnose why a user is or is not receiving notifications for an issue:**

1. View the issue in JIRA.
2. Click Admin > Notification Helper.
3. Enter the username of the user.
4. Click Submit.

**Tip:** You can also access the Notifications Helper via the cog menu for each issue in the issue navigator, or by selecting the cog icon at top right of the screen, then Add-ons. Select Admin Helper > Notification Helper to open the following page.

✔ Keyboard shortcut: `g + g +` start typing 'Notification Helper
Configuring JIRA’s SMTP Mail Server to Send Notifications

On this page:
- Define or edit the SMTP mail server
- Specify a host name or JNDI location for your SMTP mail server
  - Specify the SMTP host details
  - Specify a ‘JNDI Location’
- Configuring a JNDI location
- Troubleshooting

To enable JIRA to send notifications about various events, you need to first configure an SMTP mail server in JIRA.

Define or edit the SMTP mail server

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose 🚀 > System. Select Mail > Outgoing Mail to open the SMTP Mail Server page.
   - Keyboard shortcut: `g + g +` start typing outgoing mail
   - If no SMTP mail server has been defined, then a Configure new SMTP mail server button will be shown on the page. If one has already been defined, then the SMTP mail server’s details will be shown on the page, along with a set of operation links at the right.
3. Click either the Configure new SMTP mail server button to define a new SMTP mail server, or the Edit link at the right to edit the existing SMTP mail server, which will open the Add/Update SMTP Mail Server page.
4. Complete the top section of this page as follows:

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>Specify an arbitrary name to identify this SMTP mail server configuration.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>(Optional) Specify an arbitrary description that describes the SMTP mail server. This description appears below the <strong>Name</strong> of the SMTP mail server on the <strong>SMTP Mail Server</strong> configuration page.</td>
</tr>
<tr>
<td><strong>From address</strong></td>
<td>Specify the email address used in the ‘sender address’ (or ‘from’) field of notification messages sent by JIRA, unless overridden in a project configuration. Only specify an email address for this field (e.g. <code>jira@example-company.com</code>). JIRA will use this value to construct the full ‘from’ header based on the current user (&quot;Jo e Bloggs (JIRA) <a href="mailto:jira@example-company.com">jira@example-company.com</a>&quot;). To change the ‘from’ header, go to <strong>Administration &gt; System &gt; General Configuration</strong> and (under <strong>Settings</strong>), edit the <strong>Email from</strong> field.</td>
</tr>
<tr>
<td><strong>Email prefix</strong></td>
<td>Specify the subject of emails sent from this server will use this string as a prefix. This is useful for your users so that they can filter email notifications from JIRA based on this prefix.</td>
</tr>
</tbody>
</table>

**Screenshot: Add (or Update) SMTP Mail Server**
Add SMTP Mail Server

Use this page to add a new SMTP mail server. This server will be used to send all outgoing mail from JIRA.

Name *
The name of this server within JIRA.

Description

From address *
The default address this server will use to send emails from.

Email prefix *
This prefix will be prepended to all outgoing email subjects.

Server Details
Enter either the host name of your SMTP server or the JNDI location of a javax.mail.Session object to use.

SMTP Host

Service Provider Custom

Protocol SMTP
Specify a host name or JNDI location for your SMTP mail server

The second part of the Add/Update SMTP Mail Server page specifies the Server Details of the SMTP mail server to which JIRA will send mail. There are two ways you can do this. Either:

- specify the SMTP host details of your SMTP mail server;
- specify the JNDI location of a javax.mail.Session object — that is, use JNDI to look up an SMTP mail server that you have preconfigured in your application server. This has the following advantages:
  - Better security: the mail details are not available to JIRA administrators through the JIRA administration interface and are not stored in JIRA backup files.
  - More SMTP options: for instance, you could switch to RSET instead of NOOP for testing connections by setting the mail.smtp.userset property.
  - Centralised management: mail details are configured in the same place as database details and may be configured through your application server administration tools.

Specify the SMTP host details

Most people configure JIRA’s SMTP mail server by specifying the SMTP host details of this mail server directly in JIRA.

1. In the SMTP host section of the Add/Update SMTP Mail Server page (above), complete the following form fields:

| Service Provider (not available when updating an existing SMTP mail server) | Choose between using your own SMTP mail server (i.e. Custom), or either Gmail (i.e. Google Apps Mail / Gmail) or Yahoo! (i.e. Yahoo! Mail Plus) as the service provider for your SMTP mail server. If you choose either Gmail or Yahoo! options and then switch back to Custom, some of the key fields in this section will automatically be populated with the relevant SMTP mail server settings for these service providers. |
| Protocol | Choose between whether your SMTP mail server is a standard (i.e. SMTP) or a secure (i.e. SECURE_SMTP ) one. |
| Host Name | Specify the hostname or IP address of your SMTP mail server. Eg. smtp.yourcompany.com |
SMTP Port

(Optional) The SMTP port number, usually 25 for SMTP or 465 for SMTPS, either of which are assumed if this field is left blank.

Timeout

(Optional) Specify the timeout period in milliseconds, which is treated as 10000 if this field is left blank. Specifying 0 or a negative value here will result in JIRA waiting indefinitely for the SMTP server to respond.

TLS

(Optional) Select this check box if your SMTP host uses the Transport Layer Security (TLS) protocol.

Username

(Optional) If your SMTP host requires authentication, specify the username of these authentication credentials here. (Most company servers require authentication to relay mail to non-local users.)

Password

(Optional) Again, if your SMTP host requires authentication, specify the password associated with the username you specified above.

When editing an existing SMTP mail server, select the Change Password checkbox to access and change this field.

⚠️ Please Note:
- If your server's startup script uses the `-Dmail system properties (e.g. mail.smtp.host or mail.smtp.port), they will override the settings that you specify in the above form. Additionally, if necessary you can manually specify the host name that JIRA reports itself as to the SMTP server by setting `-Dmail.smtp.localhost
- The SMTP must support the multipart content type. Without this mails will not be able to send.

2. (Optional) Click the Test Connection button to check that JIRA can communicate with the SMTP mail server you just configured.
3. Click the Add (or Update) button to save JIRA's SMTP mail server configuration.

Specify a 'JNDI Location'

As an alternative to specifying SMTP host details directly in JIRA, you can configure them in your application server, and then look up a preconfigured mail session via JNDI.

In the JNDI Location section of the Add/Update SMTP Mail Server page (above), specify the location of a javax.mail.Session object to use when sending email, in the JNDI Location field. This will begin with the prefix java:comp/env/

Configuring a JNDI location

The JNDI Location that you specify in JIRA will depend on JIRA's application server and configuration. JNDI locations are typically configured in the application server that runs JIRA. Hence, JIRA will need to be restarted after configuring a JNDI location for that configuration to be available in JIRA.

For example, in Tomcat 6 (the application server bundled with 'recommended' distributions of JIRA), your JNDI Location would be java:comp/env/mail/JiraMailServer and you would add the following section to the conf/server.xml of your JIRA Installation Directory, inside the <Context/> node:
<Context path="" docBase="${catalina.home}/atlassian-jira" reloadable="false">
...<Resource name="mail/JiraMailServer"
  auth="Container"
  type="javax.mail.Session"
  mail.smtp.host="mail.yourcompany.com"
  mail.smtp.port="25"
  mail.transport.protocol="smtp"
  mail.smtp.auth="true"
  mail.smtp.user="jirauser"
  password="mypassword"
  />
...
</Context>

Or if you do not require authentication (e.g. if you are sending via localhost, or only internally within the company):

<Context path="" docBase="${catalina.home}/atlassian-jira" reloadable="false">
...<Resource name="mail/JiraMailServer"
  auth="Container"
  type="javax.mail.Session"
  mail.smtp.host="localhost"
  mail.smtp.port="25"
  mail.transport.protocol="smtp"
  />
...
</Context>

If you happen to be running JIRA on an application server other than Apache Tomcat (which is not a supported JIRA configuration), a similar methodology for configuring a JNDI location to your SMTP mail server should apply to that application server. For details, please see the Transaction Factory documentation.

If you have problems connecting, add a mail.debug="true" parameter to the <Resource/> element (above), which will let you see SMTP-level 'debugging' details when testing the connection.

**Move the JavaMail Classes**

You will also need to ensure that the JavaMail classes (typically in JAR library files) are present in your application server's classpath and that these do not conflict with JIRA's JAR library files. This is necessary because the application server itself (not JIRA) is establishing the SMTP connection and as such, the application server can not see the JAR library files in JIRA's classloader.

Some operating systems may bundle the JavaMail classes with application servers (eg. Tomcat in Red Hat Enterprise Linux). This may conflict with JIRA's copy of the JavaMail classes, resulting in errors like:

```java
java.lang.NoClassDefFoundError: javax/mail/Authenticator
```

or:

```java
java.lang.IllegalArgumentException: Mail server at location [java:comp/env/mail/JiraMailServer] is not of required type javax.mail.Session.
```

Lighter application servers such as Apache Tomcat (including the one incorporated into the 'recommended' distributions of JIRA), do not always come with JavaMail.
To prevent any conflicts, check your application server’s lib/ directory:

- If the application server already contains mail-1.4.1.jar and activation-1.1.1.jar, then just remove mail-1.4.1.jar and activation-1.1.1.jar from the <jira-application-dir>/WEB-INF/lib/ subdirectory of the JIRA Installation Directory.
- If the application server does not contain mail-1.4.1.jar and activation-1.1.1.jar, then move the mail-1.4.1.jar and activation-1.1.1.jar from the <jira-application-dir>/WEB-INF/lib/ subdirectory of the JIRA Installation Directory into the lib/ subdirectory of the JIRA Installation Directory (for ‘recommended’ distributions of JIRA) or the lib/ subdirectory of the application server running JIRA.

SMTP over SSL

You can encrypt email communications between JIRA and your mail server via SSL, provided your mail server supports SSL.

Firstly, you will need to import the SMTP server certificate into a Java keystore. The process is described on the Connecting to SSL Services page.

⚠️ Important Note: Without importing the certificate, JIRA will not be able to communicate with your mail server.

Secondly, edit your mail server connection properties and specify starttls and SSLSocketFactory. From { $JIRA_INSTALL}/conf/server.xml (this example uses Gmail’s server):

```xml
<Resource name="mail/GmailSmtpServer" auth="Container" type="javax.mail.Session" mail.smtp.host="smtp.gmail.com" mail.smtp.port="465" mail.smtp.auth="true" mail.smtp.user="myusername@gmail.com" password="mypassword" mail.smtp.starttls.enable="true" mail.smtp.socketFactory.class="javax.net.ssl.SSLSocketFactory" />
```

Troubleshooting

A useful tip for debugging mail-related problems in JIRA is to set the -Dmail.debug=true property on startup. This will cause protocol-level details of JIRA’s email interactions to be logged. Additionally, turning up JIRA’s log level will show when the service is running and how mails are processed.

Common Problems

- If JIRA does not appear to be creating or sending emails or creating issues and comments from email, your JIRA installation could be experiencing OutOfMemory errors. Please check your log files for OutOfMemory errors. If there are OutOfMemory errors, please restart JIRA and investigate the errors.
- If you find some incoming emails simply disappear, check that you have not accidentally started a second copy of JIRA (eg. in a staging environment) which is downloading and deleting email messages. See the Restoring Data page for flags you should set to prevent mail being processed.
- If you receive ‘Mail Relay’ errors, make sure you have specified the Username and Password in the SMTP Host section of JIRA’s SMTP Mail Server configuration page.

Getting Help

If you cannot resolve a problem yourself, please create a support case in the ‘JIRA’ project and we will assist.

Creating a Notification Scheme

JIRA can generate email notifications for various events that happen throughout the lifecycle of an issue, including custom events. Notifications are defined within a notification scheme (see below), which associates
particular events with particular email recipients. The notification scheme is then assigned to a particular project.

You can use the same notification scheme for more than one project.

JIRA is pre-packaged with a notification scheme called Default Notification Scheme. This scheme is associated with all new projects by default. This means that if you have an outgoing (SMTP) mail server set up, that email notifications will be sent as soon as there is any activity (e.g. issues created) in the new project. However, you can disassociate this notification scheme from the project via the Project Summary page, as described below. You can also modify this scheme or if you prefer, create other notifications schemes for particular projects.

### Creating a notification scheme

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Notification Schemes to open the Notification Schemes page, which lists all the current notification schemes in your JIRA installation.

   **Keyboard shortcut:** `g + g + start typing notification schemes`

3. Start creating the new notification scheme, by doing either of the following:
   - Click the Copy link to copy an existing notification scheme. If you have a notification scheme whose event recipients are reasonably similar to what you require, creating a copy is the quickest way to add a new scheme.
   - OR
   - Click the Add Notification Scheme button. On the Add Notification Scheme page, enter a name for the notification scheme and a short description of the scheme.
   - Enter a name (or modify the existing one) for the notification scheme (e.g. 'Angry Nerds Notification scheme').
   - (Optional) Enter a description (or modify the existing one) for the notification scheme.
   - c. Click the Add button to create the notification scheme.

4. If you added a new notification scheme or you copied an existing one but have clicked the Edit link to modify the automatically generated name and/or description of the copied notification scheme:
   - a. Enter a name (or modify the existing one) for the notification scheme (e.g. 'Angry Nerds Notification scheme').
   - b. (Optional) Enter a description (or modify the existing one) for the notification scheme.
   - c. Click the Add button to create the notification scheme.

5. Add notifications/recipients as described below.

6. Associate your new notification scheme with a project as described below.

### Adding an event recipient to a notification scheme

To add a new recipient for a particular event to a notification scheme, you need to:

1. Identify the notification scheme used by the relevant project.
2. Add that recipient to the appropriate event in this notification scheme.

### To add a new recipient for a particular event:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Notification Schemes to open the Notification Schemes page, which lists all the current notification schemes in your JIRA installation.
Keyboard shortcut: g + g + start typing notification schemes

Screenshot 1: The 'Notification Schemes' page

3. Locate the notification scheme of interest and click its linked name to open the Edit Notifications page for that notification scheme.

The Edit Notifications page lists all of the events (mentioned below), along with the recipients who will receive notifications when each event occurs:

Screenshot 2: The 'Edit Notifications' page

4. Click the Add link in the appropriate event row (see the list of events below), which opens the Add Notification page, where you can choose who to notify (about the event) from the list of available recipients.
nts (see below).

Screenshot 3: The ‘Add Notification’ page

Add Notification

Notification Scheme: Copy of Default Notification Scheme

Please select the type of Notification you wish to add to scheme:

- Issue Created
- Issue Updated
- Issue Assigned
- Issue Resolved
- Issue Closed
- Issue Commented
- Issue Comment Edited

(Select the notifications that you want to assign)

- Current Assignee
- Reporter
- Current User
- Project Lead
- Component Lead
- Single User
- Group
- Project Role
- Single Email Address

Notifications will be sent only for public issues. Public issues are issues which hav
scheme that gives the ‘Browse Projects’ permission to ‘Anyone’/’any non-logged-in’

- All Watchers
- User Custom Field Value
- Group Custom Field Value

Start typing to get a list of possible matches.

Choose a group ⬤

Choose a project role ⬤

Choose a custom field ⬤

Add Cancel

5. Select the appropriate recipient (filling in any required information for your particular choice of recipient).

6. Click the Add button. You are taken back to the Edit Notifications page (see above), with the notification you just specified now listed against the appropriate issue event.

7. If you make a mistake, or you would like to remove who is being notified, simply click the Delete link beside the person/group/role.

Associating a notification scheme with a project

1. Log in as a user with the JIRA Administrators global permission.

2. Choose 🏛 > Projects, and click the name of a project.

Keyboard shortcut: g + g + start typing projects

3. At the lower-right of the Project Summary page, locate the Notifications section, click the name of the current scheme (e.g. Default Notification Scheme) or None (if the project is not yet associated with a scheme) to display details of the project's current notification scheme.

4. Click the Actions dropdown menu and choose Use a different scheme (or Select a scheme).

Screenshot 4: The Project Notifications page
5. On the subsequent Associate Notification Scheme to Project page, which lists all available notification schemes, select the notification scheme you want to associate with the project and click the Associate button.

**Events**

JIRA supports the following events, which can generate email notifications (as defined in a notification scheme).

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue Created:</td>
<td>An issue has been entered into the system.</td>
</tr>
<tr>
<td>Issue Updated:</td>
<td>An issue has had its details changed. This includes the deletion of an issue comment.</td>
</tr>
<tr>
<td>Issue Assigned:</td>
<td>An issue has been assigned to a new user.</td>
</tr>
<tr>
<td>Issue Resolved:</td>
<td>An issue has been resolved (usually after being worked on and fixed).</td>
</tr>
<tr>
<td>Event Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Issue Closed</td>
<td>An issue has been closed. (Note that an issue may be closed without being resolved; see Workflow).</td>
</tr>
<tr>
<td>Issue Commented</td>
<td>An issue has had a comment added to it.</td>
</tr>
<tr>
<td>Issue Comment Edited</td>
<td>An issue’s comment has been modified.</td>
</tr>
<tr>
<td>Issue Reopened</td>
<td>An issue has been re-opened.</td>
</tr>
<tr>
<td>Issue Deleted</td>
<td>An issue has been deleted.</td>
</tr>
<tr>
<td>Issue Moved</td>
<td>An issue has been moved into or out of this project.</td>
</tr>
<tr>
<td>Work Logged On Issue</td>
<td>An issue has had hours logged against it (i.e. a worklog has been added).</td>
</tr>
<tr>
<td>Work Started On Issue</td>
<td>The Assignee has started working on an issue.</td>
</tr>
<tr>
<td>Work Stopped On Issue</td>
<td>The Assignee has stopped working on an issue.</td>
</tr>
<tr>
<td>Issue Worklog Updated</td>
<td>An entry in an issue's worklog has been modified.</td>
</tr>
<tr>
<td>Issue Worklog Deleted</td>
<td>An entry in an issue's worklog has been deleted.</td>
</tr>
<tr>
<td>Generic Event</td>
<td>The exact nature of this event depends on the workflow transition(s) from it was fired.</td>
</tr>
<tr>
<td>Custom Event(s)</td>
<td>The exact nature of these events depends on the workflow transition(s) from which they were fired.</td>
</tr>
</tbody>
</table>

**Notes**

- JIRA does not have a specific notification event for the deletion of issue comments. When an issue's comment is deleted, JIRA sends out an email notification as an 'Issue Updated' event.

**Recipients**

The following types of recipients can receive email notifications.

<table>
<thead>
<tr>
<th>Recipient</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Assignee</td>
<td>The user to whom the issue is currently assigned.</td>
</tr>
<tr>
<td>Reporter</td>
<td>The user who originally created the issue.</td>
</tr>
<tr>
<td>Current User</td>
<td>The user who performed the action that has triggered this event.</td>
</tr>
<tr>
<td>Project Lead</td>
<td>The user who is managing the project to which the issue belongs.</td>
</tr>
<tr>
<td>Component Lead</td>
<td>The user who is managing the component to which the issue belongs.</td>
</tr>
<tr>
<td>Single User</td>
<td>A particular user in your JIRA system.</td>
</tr>
<tr>
<td>Group</td>
<td>A particular group in your JIRA system.</td>
</tr>
</tbody>
</table>
### Project Role

The members of a particular **project role** for this project.

- **Note**: It is recommended to use project roles (rather than groups) in your notifications as this can help minimise the number of notification schemes in your system.

### Single Email Address

Any email address that you wish to alert.

- **Note**: A Single Email Address notification will only be sent if the issue is publicly viewable (as the email address of a non-JIRA user could be specified, in which case a security check is not possible). Publicly viewable issues are issues which have a Permission scheme that gives the 'Browse Projects' permission to 'Anyone' (any non-logged-in users). The text template is used for notifications to a single email address.

### All Watchers

All users who are **watching** the issue.

### User Custom Field Value

The value of a **custom field** of type **User Picker** or **Multi User Picker** that may have been associated with issues.

- **An example of where this can be useful**: if you have a custom User field called Tester, you can have the tester notified when an issue is resolved.

### Group Custom Field Value

The value of a **custom field** of type **Group Picker** or **Multi Group Picker** that may have been associated with issues.

---

**Please Note:**

- Email notifications will only be sent to people who have permission to view the relevant issue — that is, people who:
  - have the **Browse Projects** project permission for the project to which the issue belongs; and
  - are members of any **Issue security levels** that have been applied to the issue.
- JIRA can only send email notifications if SMTP email has been enabled (see [Email Overview](#)).
- JIRA’s default setting is to not notify users of their own changes. This can be changed on a per user basis via their [Profile Preferences](#).

**Please also note:**

JIRA will send notification emails to both the **previous assignee** and the **current assignee**, whenever the assignee field changes.

However, earlier versions of JIRA only sent a notification email to the previous assignee *if* the operation that changed the event was the **Assign Issue** operation. It did not send a notification if the issue was edited in some other way.

The **jira.assignee.change.is.sent.to.both.parties** advanced JIRA option allows this legacy behavior to be re-instated, for those customers who prefer this behavior.

See [JIRA-6344](#) for more details.

### Customizing Email Content

JIRA generates emails in reaction to events using a templating engine. The templating engine is Apache’s **Velocity**. This is a relatively easy to use templating language that can pull apart java objects in useful ways. The mails are generated inside JIRA by invoking Velocity with a set of objects of relevance to the event.

**Please Note:**

- To change the columns in your filter subscriptions, you don’t need to customize the mail templates. See [Customizing your Issue Navigator](#).
- There’s a feature request to improve this at [JRA-7266](#), which you can vote on to improve its chances of being implemented.
- Bear in mind that the next time you upgrade JIRA – or need a new installation for any reason – you will have to manually copy any changes you have made to Velocity templates (as well as JSPs) into the new installation of JIRA. If the Velocity templates and/or JSPs have changed in the newer version, you will have to manually port your customizations into them (as opposed to copying these files directly over from your old JIRA installation to your upgraded one).

**Customizations to Velocity templates or other JIRA files are not included in the scope of Atlassian**
Email template locations

To customize email content, please follow this procedure.

1. Open up your JIRA distribution, and navigate to the following paths:
   - The WEB-INF/classes/templates/email/ of the `<jira-application-dir>` in your JIRA Installation Directory.
   - The jira/src/etc/java/templates/email/ in your extracted JIRA source directory.
2. Under this directory there are three directories: html, text and subject. The html subdirectory contains the templates used to create emails in html, while the text directory the plain text mail outs. The subject directory contains the templates used to generate the subject of the emails. The templates are named after the event that will trigger the email.
3. Bring the template up in your favorite text editor. Referring to the JIRA template documentation (particularly Velocity Context for Email Templates) and Velocity Users Guide, make the customizations you want.
4. Restart JIRA.

For new email templates:

1. Create your new mytemplate.vm files in the html, text and subject directories, based on the existing files in those directories
2. Add the templates to atlassian-jira/WEB-INF/classes/email-template-id-mappings.xml to make them valid choices for when you are adding a new event.

Note that since JIRA 4.1 each new template has to have a corresponding file in the subject directory.

Advanced customization

The Issue object is passed into the vm templates. Notice some of its implementation in /includes/summary-topleft.vm. As an example, calling $issue.getProject() would allow you to determine the project an issue comes from, and even create logic to show different information for emails from different projects.

Deploying Velocity templates without restarting JIRA

In a development instance, you can play with picking up velocity file changes without a restart. From `<jira-install>/atlassian-jira/WEB-INF/classes/velocity.properties`

1. Change class.resource.loader.cache from true to false
2. Remove the comment sign (#) from #velocimacro.library.autoreload=true

Making this change in production will eventually lead to JIRA not serving pages along with the ran out of parsers error in the log file.

See also Adding Custom Fields to Email.

Creating Issues and Comments from Email

JIRA can be configured to automatically create issues or comments on existing issues based on incoming messages received by a mail server or external mail service.

This is especially useful in a helpdesk or support scenario, where users send support queries via email that you wish to track with JIRA. Subsequent email messages about the issue (for example, responses to Email Notifications) can be automatically recorded as comments. Additionally, any attachments in the emails can automatically be attached to the issue (with appropriate configuration).

Configuring issue or comment creation from email
On this page:

- Configuring issue or comment creation from email
- Mail handlers
- Issue/comment creation
- Handy tips with mail handlers
- Best practices (pre-processing JIRA email messages)
- Troubleshooting

Step one: Configure a mail server/service

POP or IMAP email messages

To set up issue and comment creation from email, you will need to create a mail account for a POP or IMAP mail server that JIRA can access – typically, one mail account for each JIRA project. For example, for the 'ABC' project, you might establish an account abc-issues@example.com

JIRA will periodically scan for new email messages received by your mail account (via a service) and appropriately create issues or comments for any emails it finds (via a mail handler).

JIRA’s mail handlers can also optionally create new user accounts for senders not previously seen. See the Create a new issue or add a comment to an existing issue section for more details.

Note — how JIRA handles messages on a mail server/service:

- For mail accounts, JIRA scans email messages received by your mail account’s ‘Inbox’ folder. However, for IMAP mail servers, you can specify a different folder within your mail account.
- If JIRA successfully processes a message, JIRA deletes the message from your mail account (on a POP or IMAP mail server) or file system (i.e. for file system messages).
- If JIRA does not successfully process a message, the message will remain either in your mail account or on the file system.

Step two: Configure a mail handler

Once you have configured JIRA to receive messages from a mail server/service, you configure JIRA to handle these messages through a ‘mail handler’.

To configure a JIRA mail handler:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose System > System. Select Mail > Incoming Mail to open the Incoming Mail page.
3. Click the Add incoming mail handler button (or the Edit link next to an existing mail handler) in the Mail Handlers section to open the Mail Handler dialog box.
4. Specify a Name that describes what your mail handler will do — for example, ‘Create issues or comments from Example Company’s IMAP mail server’.

5. Select the mail Server that you configured in step one (above). This is either a POP or IMAP mail server or the Local Files option for an external mail service that writes messages to the file system.

6. Specify the Delay (in minutes) between the mail handler’s running time. This effectively defines the frequency with which JIRA scans the Server that you specified in the previous step.

7. Choose the type of mail Handler from dropdown list. For more information, refer to the Mail Handlers section below.

8. If you chose either an IMAP mail server or the Local Files option in the Server field, then a Folder Name field appears below the Handler dropdown list:
   - For an IMAP mail server, if you want mail handler to scan for new messages from a folder other than the ‘Inbox’ in your mail account, specify the name of that folder here.
   - For the Local Files option, if your file messages are being written to a subdirectory within the import/mail subdirectory of the JIRA Home Directory, specify the subdirectory structure (within import/mail) here.

9. Click Next to continue with specifying the remaining options specific to mail Handler you selected above.
For more information, refer to the Mail Handlers section below.

10. *(Optional)* Click the **Test** button to test your mail handler. If you are using Local Files as the server, copy a saved email that contains a "Subject: " line to the configured directory. JIRA will remove this file after it is parsed, or log a message about why an issue could not be created. You may have to specify the project, issuetype and reporterusername properties as a minimum configuration.

A sample email file might look like this:

```plaintext
To: jira@example.com
From: some-jira-user@example.com
Subject: (TEST-123) issue summary title here
Body of the email goes here
```

11. Click the **Add / Save** button to save your mail handler.

**Note — the relationship between JIRA mail handlers and services:**

**Mail handlers**

JIRA provides the following default mail handlers:

- Create a new issue or add a comment to an existing issue
- Add a comment from the non quoted email body
- Add a comment with the entire email body
- Create a new issue from each email message
- Add a comment before a specified marker or separator in the email body

For more information about how these mail handlers create issues and comments in JIRA, refer to Issue/Comment creation (below).

Also refer to the Handy tips with mail handlers (below) for tips on tweaking mail handlers to allow JIRA to handle the following types of email messages:

- Email sent from people without a JIRA user account.

**Create a new issue or add a comment to an existing issue**

This message handler creates a new issue, or adds a comment to an existing issue. If the subject contains an issue key, the message is added as a comment to that issue. If no issue key is found, a new issue is created in the default project.

**To configure a 'Create a new issue or add a comment to an existing issue' mail handler:**

1. If you have not already done so, begin configuring your mail handler *(above)*.
2. On the **Create a new issue or add a comment to an existing issue** dialog box, complete the following fields/options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project</strong></td>
<td>Specify the project key of the default project to which new issues are created by this handler — for example, JIRA.</td>
</tr>
<tr>
<td><strong>Issue Type</strong></td>
<td>Choose the default issue type for new issues.</td>
</tr>
</tbody>
</table>

**Note:**

- This field is only relevant for issue creation, not for issue commenting.
- If an email message contains an issue key in its subject line and that issue key exists in your JIRA installation, the handler will add the email message content as a comment on the issue, regardless of which project the issue is in.
<table>
<thead>
<tr>
<th>Strip Quotes</th>
<th>Select this check box to remove quoted text from from an email message's body (e.g. from previous email replies) before the body's content is added to the JIRA issue's comment.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you find this feature is not working correctly, you can use the workaround explained here:</td>
</tr>
<tr>
<td></td>
<td><img src="https://jira.atlassian.com/browse/JIRA-28444" alt="JIRA-28444" /> - “Add a comment from a non quoted email body” does not set the Strip Quotes to be TRUE [RESOLVED]</td>
</tr>
<tr>
<td>Catch Email Address</td>
<td>If specified, only email messages whose To:,Cc:,Bcc: lines contain the recipient specified in this field will be processed — for example, <a href="mailto:issues@mycompany.com">issues@mycompany.com</a></td>
</tr>
<tr>
<td></td>
<td>Upon specifying an address here, all email messages whose To:,Cc:,Bcc: lines contain addresses other than the Catch Email Address are ignored. This is useful if you have multiple aliases for the same mail account (e.g. <a href="mailto:foo-support@example-co.com">foo-support@example-co.com</a> and <a href="mailto:bar-support@example-co.com">bar-support@example-co.com</a> aliases for <a href="mailto:support@example-co.com">support@example-co.com</a>) for multiple mail services (e.g. each one to create issues in separate JIRA projects).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> in practice, this option is rarely useful and should not be confused with the more common Default Reporter. You can only specify one catch email address and one issue type per mail handler.</td>
</tr>
<tr>
<td>Bulk</td>
<td>This option only affects 'bulk' email messages whose header has either its Precedence: field set to bulk or its Auto-Submitted field set to no. Such messages would typically be sent by an automated service. When such an email message is received, the following action will be performed, based on the option you choose:</td>
</tr>
<tr>
<td></td>
<td>a. Ignore the email and do nothing.</td>
</tr>
<tr>
<td></td>
<td>b. Forward the email (i.e. to the address set in the Forward Email text field).</td>
</tr>
<tr>
<td></td>
<td>c. Delete the email permanently.</td>
</tr>
<tr>
<td></td>
<td>It is generally a good idea to set bulk=forward and set a Forward Email address, to prevent mail loops between JIRA and another automated service (e.g. another JIRA installation).</td>
</tr>
<tr>
<td>Forward Email</td>
<td>If specified, then if this mail service is unable to handle an email message it receives, an email message indicating this problem will be forwarded to the email address specified in this field.</td>
</tr>
<tr>
<td>Create Users</td>
<td>Select this check box if you want JIRA to create new user accounts from any received email messages whose From: field contains an address that does not match one associated with an existing JIRA user account. This allows the creator of the email message to be notified of subsequent updates to the issue, which can be achieved by configuring the relevant project’s notification scheme to notify the Reporter of updates.</td>
</tr>
<tr>
<td></td>
<td>The username and email address of these newly created JIRA user accounts will be the email addresses specified in the From: fields of these received messages. The password for these new JIRA users is randomly generated and an email message is sent their addresses informing them about their new JIRA user account.</td>
</tr>
<tr>
<td></td>
<td>Users created this way will be added to the ‘jira-users’ group and given application access to JIRA (and therefore take up a license).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> this option is not compatible with Default Reporter field option below and as such, choosing the Create Users option will hide the Default Reporter option.</td>
</tr>
</tbody>
</table>
**Default Reporter**

Specify the username of a default reporter, which will be used if the email address in the From field of any received messages does not match the address associated with that of an existing JIRA user — for example, a JIRA username such as `emailed-reporter`.

*Note:*
- This option is not available if the Create Users check box is selected.
- Please ensure that the user specified in this field has the Create Issues project permission for the relevant Project (specified above) as well as the Create Comments project permission for the other relevant projects to which this mail handler should add comments.
- When an issue is created and this option is specified, the email message's From: field address is appended in a brief message at the end of the issue's Description field, so that the sender can be identified.

**Notify Users**

Clear this check box if you do not want JIRA to send out an email message notifying users whose accounts have been created by the Create Users option above.

*Note: this option only functions if the Create Users check box has been selected.*

**CC Assignee**

Select this check box if you want JIRA to automatically assign the issue created to a JIRA user:

- Who's email address (registered with their JIRA account) matches the first matching address encountered in the To:, Cc: and Bcc: field of the email message received.
- Who also has the Assignable User project permission for the relevant Project (specified above).

**CC Watchers**

Select this check box if you want JIRA to automatically add JIRA users to the issue created, where those users' email addresses (registered with their JIRA accounts) match addresses encountered in the To:, Cc: or Bcc: fields of the email message received.

*Please note that when an issue is created, new JIRA users created by the Create Users option (above) cannot also be added to the issue's watchers list by this CC Watchers option. JIRA users must already exist in JIRA's userbase, and must have an email address.*

3. Test and save your mail handler (above).

### Add a comment from the non quoted email body

This message handler creates a comment, but only uses the 'non quoted' lines of the body of the email message. A quoted line is any line that starts with a '>' or '|' symbol and such lines of text will not be added to the comment. The issue to which the comment is added is chosen from the first issue key found in the email subject. The author of the comment is taken from the address of the email message's From: field.

**To configure an 'Add a comment from the non quoted email body' mail handler:**

1. If you have not already done so, begin configuring your mail handler (above).
2. On the Add a comment from the non quoted email body dialog box, complete the following fields/options:
| **Catch Email Address** | If specified, only email messages whose **To**: **Cc**: **Bcc**: lines contain the recipient specified in this field will be processed — for example, issues@mycompany.com. Upon specifying an address here, all email messages whose **To**: **Cc**: **Bcc**: lines contain addresses other than the Catch Email Address are ignored. This is useful if you have multiple aliases for the same mail account (e.g. foo-support@example-co.com and bar-support@example-co.com aliases for support@example-co.com) for multiple mail services (e.g. each one to create issues in separate JIRA projects).

**Note**: in practice, this option is rarely useful and should not be confused with the more common Default Reporter. You can only specify one catch email address and one issue type per mail handler. |
|---|---|
| **Bulk** | This option only affects 'bulk' email messages whose header has either its Precedence: field set to bulk or its Auto-Submitted field set to no. Such messages would typically be sent by an automated service. When such an email message is received, the following action will be performed, based on the option you choose:

a. Ignore the email and do nothing.
b. Forward the email (i.e. to the address set in the Forward Email text field).
c. Delete the email permanently. |
| **Forward Email** | If specified, then if this mail service is unable to handle an email message it receives, an email message indicating this problem will be forwarded to the email address specified in this field. |
| **Create Users** | Select this check box if you want JIRA to create new user accounts from any received email messages whose From: field contains an address that does not match one associated with an existing JIRA user account. This allows the creator of the email message to be notified of subsequent updates to the issue, which can be achieved by configuring the relevant project's notification scheme to notify the Reporter of updates.

The username and email address of these newly created JIRA user accounts will be the email address specified in the From: field of the message. The password for the new user is randomly generated, and an email is sent to the new user informing them about their new account in JIRA. Users created this way will be added to the 'jira-users' group and given application access to JIRA (and therefore take up a license).

**Note**: this option is not compatible with Default Reporter field option below and as such, choosing the Create Users option will hide the Default Reporter option. |
| **Default Reporter** | Specify the username of a default reporter, which will be used if the email address in the From: field of any received messages does not match the address associated with that of an existing JIRA user — for example, a JIRA username such as emailed-reporter

**Note**:

- This option is not available if the Create Users check box is selected.
- Please ensure that the user specified in this field has the Create Issues project permission for the relevant Project (specified above) as well as the Create Comments project permission for the other relevant projects to which this mail handler should add comments. |
| **Notify Users** | Clear this check box if you do not want JIRA to send out an email message notifying users whose accounts have been created by the Create Users option above.

**Note**: this option only functions if the Create Users check box has been selected. |

3. Test and save your mail handler (above).

*Add a comment with the entire email body*

This message handler creates a comment based on the entire body of the email message received. The issue to
which the comment is added is chosen from the first issue key found in the email subject. The author of the comment is taken from the address of the email message's **From**: field.

**To configure an 'Add a comment with the email body' mail handler:**

1. If you have not already done so, begin configuring your mail handler (**above**).
2. On the **Add a comment with the entire email body** dialog box, complete the following fields/options:

| **Catch Email Address** | If specified, only email messages whose **To**:; **Cc**:; **Bcc**: lines contain the recipient specified in this field will be processed — for example, `issues@mycompany.com`  
Upon specifying an address here, all email messages whose **To**:; **Cc**:; **Bcc**: lines contain addresses other than the **Catch Email Address** are ignored. This is useful if you have multiple aliases for the same mail account (e.g. `foo-support@example-co.com` and `bar-support@example-co.com`) for multiple mail services (e.g. each one to create issues in separate JIRA projects). **Note**: in practice, **this option is rarely useful** and should not be confused with the more common **Default Reporter**. You can only specify one catch email address and one issue type per mail handler. |
| **Bulk** | This option only affects 'bulk' email messages whose header has either its **Precedence**: field set to **bulk** or its **Auto-Submitted** field set to **no**. Such messages would typically be sent by an automated service. When such an email message is received, the following action will be performed, based on the option you choose:  
a. Ignore the email and do nothing.  
b. Forward the email (i.e. to the address set in the **Forward Email** text field).  
c. Delete the email permanently. |
| **Forward Email** | If specified, then if this mail service is unable to handle an email message it receives, an email message indicating this problem will be forwarded to the email address specified in this field. |
| **Create Users** | Select this check box if you want JIRA to create new user accounts from any received email messages whose **From**: field contains an address that does not match one associated with an existing JIRA user account. This allows the creator of the email message to be notified of subsequent updates to the issue, which can be achieved by configuring the relevant project's **notification scheme** to notify the **Reporter** of updates.  
The username and email address of these newly created JIRA user accounts will be the email address specified in the **From**: field of the message. The password for the new user is randomly generated, and an email is sent to the new user informing them about their new account in JIRA.  
Users created this way will be added to the 'jira-users' group and given application access to JIRA (and therefore take up a license). **Note**: this option is not compatible with **Default Reporter** field option below and as such, choosing the **Create Users** option will hide the **Default Reporter** option. |
| **Default Reporter** | Specify the username of a default reporter, which will be used if the email address in the **From**: field of any received messages does not match the address associated with that of an existing JIRA user — for example, a JIRA username such as `emailed-reporter`. **Note:**  
- This option is not available if the **Create Users** check box is selected.  
- Please ensure that the user specified in this field has the **Create Issues** project permission for the relevant **Project** (specified above) as well as the **Create Comments** project permission for the other relevant projects to which this mail handler should add comments. |
3. Test and save your mail handler (above).

**Create a new issue from each email message**

This message handler creates a new issue for each incoming message.

### To configure an 'Create a new issue from each email message' mail handler:

1. If you have not already done so, begin configuring your mail handler (above).
2. On the **Create a new issue from each email message** dialog box, complete the following fields/options:

<table>
<thead>
<tr>
<th>Project</th>
<th>Specify the project key of the default project to which new issues are created by this handler — for example, JRA.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>- This field is only relevant for issue creation, not for issue commenting.</td>
</tr>
<tr>
<td></td>
<td>- If an email message contains an issue key in its subject line and that issue key exists in your JIRA installation, the handler will add the email message content as a comment on the issue, regardless of which project the issue is in.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>Choose the default issue type for new issues.</td>
</tr>
<tr>
<td>Catch Email Address</td>
<td>If specified, only email messages whose <strong>To</strong>: <strong>Cc</strong>: <strong>Bcc</strong> lines contain the recipient specified in this field will be processed — for example, <a href="mailto:issues@mycompany.com">issues@mycompany.com</a></td>
</tr>
<tr>
<td>Note:</td>
<td>- Upon specifying an address here, all email messages whose <strong>To</strong>: <strong>Cc</strong>: <strong>Bcc</strong> lines contain addresses other than the <strong>Catch Email Address</strong> are ignored. This is useful if you have multiple aliases for the same mail account (e.g. <a href="mailto:foo-support@example-co.com">foo-support@example-co.com</a> and <a href="mailto:bar-support@example-co.com">bar-support@example-co.com</a> aliases for <a href="mailto:support@example-co.com">support@example-co.com</a>) for multiple mail services (e.g. each one to create issues in separate JIRA projects).</td>
</tr>
<tr>
<td></td>
<td>- In practice, <strong>this option is rarely useful</strong> and should not be confused with the more common Default Reporter. You can only specify one catch email address and one issue type per mail handler.</td>
</tr>
<tr>
<td>Bulk</td>
<td>This option only affects 'bulk' email messages whose header has either its <strong>Precedence</strong>: field set to <strong>bulk</strong> or its <strong>Auto-Submitted</strong> field set to <strong>no</strong>. Such messages would typically be sent by an automated service. When such an email message is received, the following action will be performed, based on the option you choose:</td>
</tr>
<tr>
<td></td>
<td>a. Ignore the email and do nothing.</td>
</tr>
<tr>
<td></td>
<td>b. Forward the email (i.e. to the address set in the <strong>Forward Email</strong> text field).</td>
</tr>
<tr>
<td></td>
<td>c. Delete the email permanently.</td>
</tr>
<tr>
<td>Forward Email</td>
<td>If specified, then if this mail service is unable to handle an email message it receives, an email message indicating this problem will be forwarded to the email address specified in this field.</td>
</tr>
</tbody>
</table>
### Create Users
Select this check box if you want JIRA to create new user accounts from any received email messages whose **From:** field contains an address that does not match one associated with an existing JIRA user account. This allows the creator of the email message to be notified of subsequent updates to the issue, which can be achieved by configuring the relevant project's **notification scheme** to notify the **Reporter** of updates.

The username and email address of these newly created JIRA user accounts will be the email address specified in the **From:** field of the message. The password for the new user is randomly generated, and an email is sent to the new user informing them about their new account in JIRA.

Users created this way will be added to the 'jira-users' group and given application access to JIRA (and therefore take up a license).

**Note:** this option is not compatible with **Default Reporter** field option below and as such, choosing the **Create Users** option will hide the **Default Reporter** option.

### Default Reporter
Specify the username of a default reporter, which will be used if the email address in the **From:** field of any received messages does not match the address associated with that of an existing JIRA user — for example, a JIRA username such as `emailed-reporter`.

**Note:**
- This option is not available if the **Create Users** check box is selected.
- Please ensure that the user specified in this field has the **Create Issues** project permission for the relevant **Project** (specified above) as well as the **Create Comments** project permission for the other relevant projects to which this mail handler should add comments.
- When an issue is created and this option is specified, the email message's **From:** field address is appended in a brief message at the end of the issue's **Description** field, so that the sender can be identified.

### Notify Users
Clear this check box if you do not want JIRA to send out an email message notifying users whose accounts have been created by the **Create Users** option above.

**Note:** this option only functions if the **Create Users** check box has been selected.

### CC Assignee
Select this check box if you want JIRA to automatically assign the issue created to a JIRA user:

- Who's email address (registered with their JIRA account) matches the first matching address encountered in the **To:** , then **Cc:** and then **Bcc:** field of the email message received.
- Who also has the **Assignable User** project permission for the relevant **Project** (specified above).

### CC Watchers
Select this check box if you want JIRA to automatically add JIRA users to the issue created, where those users' email addresses (registered with their JIRA accounts) match addresses encountered in the **To:**; **Cc:** or **Bcc:** fields of the email message received.

Please note that when an issue is created, new JIRA users created by the **Create Users** option (above) **cannot also be added** to the issue's watchers list by this **CC Watchers** option. JIRA users must already exist in JIRA's userbase, and must have an email address.

### Add a comment before a specified marker or separator in the email body
This message handler creates a comment from the body of an email message - but ignores any part of the body past a marker or separator that matches a specified regular expression (regex).

For mail systems like Lotus Notes and Outlook, the core content of an email message is separated from other (e.g. replied or forwarded) content in the body by some predictable text string like ‘---- Original Message...’
Hence, use this message handler, which can take any valid regex, to filter core from extraneous content from various different mail systems.

Also note that the issue to which the comment is added is chosen from the first issue key found in the email subject.

The **Add a comment before a specified marker or separator in the email body** mail handler has the following behavior with respect to received email messages:

- If the regex pattern (specified in the mail handler) is found, the text in the email message body before the first regex pattern match is used for the comment and the remainder of the body is discarded.
- If the regex pattern (specified in the mail handler) is not found, the entire text in the email message body is used for the comment.
- If no regex pattern is specified in the mail handler, the entire text in the email message body is used for the comment.
- If the regex expression specified in the mail handler is erroneous, the entire text in the email message body is used for the comment.

To configure an 'Add a comment before a specified marker or separator in the email body' mail handler:

1. If you have not already done so, begin configuring your mail handler (above).
2. On the **Add a comment before a specified marker or separator in the email body** dialog box, complete the following fields/options:

<table>
<thead>
<tr>
<th>Split Regex</th>
<th>Specify a regular expression matching the text that separates the content of the email message mail body from other (replied or forwarded) content in the body.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Please Note:</strong></td>
<td></td>
</tr>
<tr>
<td><em>The regex must begin and end with a delimiter character, typically '/'.</em></td>
<td></td>
</tr>
<tr>
<td><em>Commas are not allowed in a regex, as they are used to separate each mail handler field/option when they are integrated into a JIRA service and there is not (as yet) an escape syntax.</em></td>
<td></td>
</tr>
<tr>
<td>For example:</td>
<td></td>
</tr>
<tr>
<td><code>/-----\s*Original Message\s*-----/</code></td>
<td></td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td><code>/_____________*/</code></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Catch Email Address</th>
<th>If specified, only email messages whose <strong>To:</strong> , <strong>Cc:</strong> , <strong>Bcc:</strong> lines contain the recipient specified in this field will be processed — for example, <a href="mailto:issues@mycompany.com">issues@mycompany.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Upon specifying an address here, all email messages whose <strong>To:</strong> , <strong>Cc:</strong> , <strong>Bcc:</strong> lines contain addresses other than the Catch Email Address are ignored. This is useful if you have multiple aliases for the same mail account (e.g. <a href="mailto:foo-support@example-co.com">foo-support@example-co.com</a> and <a href="mailto:bar-support@example-co.com">bar-support@example-co.com</a> aliases for <a href="mailto:support@example-co.com">support@example-co.com</a>) for multiple mail services (e.g. each one to create issues in separate JIRA projects).</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> In practice, this option is rarely useful and should not be confused with the more common Default Reporter. You can only specify one catch email address and one issue type per mail handler.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bulk</th>
<th>This option only affects 'bulk' email messages whose header has either its <strong>Precedence:</strong> field set to <strong>bulk</strong> or its <strong>Auto-Submitted</strong> field set to <strong>no</strong>. Such messages would typically be sent by an automated service. When such an email message is received, the following action will be performed, based on the option you choose:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Ignore the email and do nothing.</td>
<td></td>
</tr>
<tr>
<td>b. Forward the email (i.e. to the address set in the Forward Email text field).</td>
<td></td>
</tr>
<tr>
<td>c. Delete the email permanently.</td>
<td></td>
</tr>
</tbody>
</table>
### Forward Email
If specified, then if this mail service is unable to handle an email message it receives, an email message indicating this problem will be forwarded to the email address specified in this field.

### Create Users
Select this check box if you want JIRA to create new user accounts from any received email messages whose **From:** field contains an address that does not match one associated with an existing JIRA user account. This allows the creator of the email message to be notified of subsequent updates to the issue, which can be achieved by configuring the relevant project's notification scheme to notify the **Reporter** of updates.

The username and email address of these newly created JIRA user accounts will be the email address specified in the **From:** field of the message. The password for the new user is randomly generated, and an email is sent to the new user informing them about their new account in JIRA.

Users created this way will be added to the 'jira-users' group and given application access to JIRA (and therefore take up a license).

**Note:** this option is not compatible with **Default Reporter** field option below and as such, choosing the **Create Users** option will hide the **Default Reporter** option.

### Default Reporter
Specify the username of a default reporter, which will be used if the email address in the **From:** field of any received messages does not match the address associated with that of an existing JIRA user — for example, a JIRA username such as `emailed-reporter`.

**Note:**
- This option is not available if the **Create Users** check box is selected.
- Please ensure that the user specified in this field has the **Create Issues** project permission for the relevant Project (specified above) as well as the **Create Comments** project permission for the other relevant projects to which this mail handler should add comments.

### Notify Users
Clear this check box if you do not want JIRA to send out an email message notifying users whose accounts have been created by the **Create Users** option above.

**Note:** this option only functions if the **Create Users** check box has been selected.

3. Test and save your mail handler (above).

### Issue/comment creation
The following points describe how JIRA processes each incoming email message and determines how its content gets added as either a comment to an existing issue or a new issue altogether.

- The **subject** of an email message is examined for an existing issue key:
  - If an issue key is found in the **subject**, the content of the email message's **body** is processed and added as a comment to the issue with that issue key.
  - If an issue key is NOT found in the **subject**, the **in-reply-to header** is examined:
    - If the email message is found to be a reply to another email message from which an issue was previously created, the **body** is processed and added as a comment to that issue.
    - If the email message is NOT found to be a reply, a new issue is created.

For example, an email message to a mail account `foo@example-co.com` on a POP or IMAP mail server configured against a JIRA server will be processed as follows:

- **Issue Creation:**
  - The **subject** of the email message will become the issue summary.
    - **Warning:** Since all issues require a summary, each email message intended for issue creation should include a **subject**.
  - The **body** of the email message will be the issue description.
  - A bug will be created for project 'JRA' with the above information. (This is essentially based on the
mail handler configuration above).

- Any attachments to the email message will become attachments to the issue (assuming attachments have been enabled in JIRA).
  - To ensure compatibility with various operating systems, any of the following characters in the filename will be replaced with an underscore character: \, /, ", %, :, $, ?, *, <, |, >.
  - If the incoming email is set to a high priority, the corresponding issue will be created with a higher priority than the default priority that is set in your JIRA system.

- Comment Creation:
  - The body of the email will become a comment on the issue.
  - Any attachments to the email will become attachments to the issue (assuming attachments have been enabled in JIRA).

Handy tips with mail handlers

To allow JIRA to handle email messages sent from people without a JIRA user account:

1. Create an 'anonymous'/dummy mail account on your mail server/service (above).
2. Create an equivalent 'anonymous'/dummy JIRA user account, whose Email field matches the mail account you created in the previous step.
3. When configuring your mail handler(s) (above) to handle messages from this mail account, set the Default Reporter to this 'anonymous'/dummy JIRA user account.

Best practices (pre-processing JIRA email messages)

For JIRA production servers, we recommend that setting up the following email message pre-processing:

**Back up messages to a folder**

- Since JIRA mail handlers remove successfully processed email messages from your mail server, ensure that your mail is sent to a backup folder so that a record of what mail JIRA processed is available.

**Set up filters to avoid mail loops**

- If your mail folder contains replies to JIRA's email notifications, set up rules that filter out auto-replies and bounces.
  - If you do not do this, there is a strong possibility of mail loops between JIRA and autoresponders like 'out of office' notifications. JIRA sets a 'Precedence:bulk' header (unless you have disabled this) and an 'Auto-Submitted' header on outgoing email, but some autoresponders ignore it.
  - There is no bulletproof way of detecting whether an email is a bounce or autoreply. The following rules (in procmail format) will detect most autoreplies:

```
^From:.*mailer-daemon@
^Auto-Submitted:.auto-
^Content-Type:\ multipart/report;\ report-type=delivery-status
^Subject:\ Delivery\ Status\ Notification
^Subject:\ Undeliverable
^Subject:\ Returned Mail:
^From:\ System\ Administrator
^Precedence:\ auto_reply
^Subject:.*autoreply
^Subject:.*Account\ signup
```
  - Even with these rules, you may encounter autoreplies with nothing in the headers to distinguish it from a regular mail, In these cases you will just need to manually update the filters to exclude that sender.

**Set up filters for large attachments**

- Set up a filter to catch email with huge attachments. JIRA uses the standard JavaMail library to parse email, and it quickly runs out of memory on large attachments (e.g. > 50 MB given 512 MB heap). As the un-handled mail is not deleted, it will be reprocessed (causing another OutOfMemoryError) each time the
mail service runs. In practice this problem is rarely seen, because most mail servers are configured to not accept email with huge attachments. Unless you are sure your mail server will not pass a huge attachment on to JIRA, it is best to configure a filter to prevent JIRA encountering any huge attachments.

**Set up spam filters**

- Set up spam filtering rules, so JIRA does not have to process (and possibly create issues from) spam.

**Troubleshooting**

Whenever you create a new (or edit an existing) mail handler (above), a **Test** button is available to allow you to test your mail handler's configuration to ensure it works as expected.

**Common problems**

### Configuring JIRA to Receive Email from a POP or IMAP Mail Server

To enable JIRA to **create comments and issues from email**, you need to first configure JIRA to receive email from a POP or IMAP mail server as described below.

**Add or edit a POP or IMAP mail server**

1. Log in as a user with the JIRA Administrators global permission.
2. Choose 🏛️ > **System**. Select Mail > Incoming Mail to open the Incoming Mail page.
   **Keyboard shortcut: g + g + start typing incoming mail**
3. Click either the **Configure new POP / IMAP mail server** button to define a new POP / IMAP mail server, or the **Edit** link at the right of an existing POP / IMAP mail server configuration, which will open the **Add/Update POP / IMAP Mail Server** page.
4. Complete the fields on this page as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Specify a short, arbitrary name to identify your POP or IMAP mail server configuration. You could possibly just specify the email address of the POP / IMAP mail server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>(Optional) Specify an arbitrary description that describes the POP or IMAP mail server configuration and/or what it is used for. For example, 'Email Issue Creation/Comments for &lt;Project&gt;'. This description appears below the Name of the POP / IMAP mail server on the POP / IMAP Mail Servers configuration page.</td>
</tr>
<tr>
<td>Service Provider (not available when updating an existing POP / IMAP mail server)</td>
<td>Choose between using your own POP / IMAP mail server (i.e. Custom), Gmail POP / IMAP (i.e. Google Apps Mail / Gmail [POP3 / IMAP]) or Yahoo! POP (i.e. Yahoo! MailPlus) as the service provider for your POP / IMAP mail server. If you choose any of the Gmail or Yahoo! options and then switch back to Custom, some of the key fields in this section will automatically be populated with the relevant POP / IMAP mail server settings for these service providers.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Choose between whether your POP / IMAP mail server is a standard (i.e. POP or IMAP) or a secure (i.e. SECURE_POP or SECURE_IMAP) one. <strong>⚠️</strong> JIRA Cloud does not support self-signed certificate.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Specify the hostname or IP address of your POP / IMAP mail server. Eg. pop.yourcompany.com or imap.yourcompany.com</td>
</tr>
</tbody>
</table>

**Common problems**

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### POP / IMAP Mail Server Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>POP / IMAP port</strong></td>
<td>(Optional) The port to use to retrieve mail from your POP / IMAP account. Leave blank for default. Defaults are: POP: 110; SECURE_POP: 995; IMAP: 143; SECURE_IMAP: 993.</td>
</tr>
<tr>
<td><strong>Timeout</strong></td>
<td>(Optional) Specify the timeout period in milliseconds, which is treated as 10000 if this field is left blank. Specifying 0 or a negative value here will result in JIRA waiting indefinitely for the POP / IMAP server to respond.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>The username used to authenticate your POP / IMAP account.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The password for your POP / IMAP account.</td>
</tr>
</tbody>
</table>

1. If you are setting up a new POP / IMAP mail server, enter the required information in the fields above.
2. If you are editing an existing POP / IMAP mail server, select the **Change Password** check box to access and change the password.
3. Click the **Test Connection** button to check that JIRA can communicate with the POP / IMAP mail server you just configured.
4. Click the **Add** button to save the POP / IMAP mail server configuration.

### Migrating from Other Issue Trackers

When migrating from another issue tracking application to JIRA, you may wish to take your data with you. Depending on what issue tracker you are migrating from, we recommend using the relevant instructions (linked below) to import data from your other issue tracker into JIRA.

Our website highlights some top reasons why people migrate from other issue trackers to JIRA.
Built-in importers

The JIRA Importers plugin, which is bundled with JIRA, allows you to import data from the importers listed below.

**Note:** Not all of these importers are available for JIRA Cloud.

- Bitbucket
- Bugzilla
- FogBugz for Your Server
- FogBugz On Demand (SaaS)
- Mantis
- Pivotal Tracker (SaaS)
- Trac
- Redmine
- JSON

CSV importer

If you are migrating from a system for which JIRA does not provide a built-in importer, you may be able to import your data into JIRA via CSV format instead. Your system must be able to export your data into a CSV (comma-separated value) file. You can then import the CSV file into JIRA using JIRA’s CSV importer:

- Importing Data from CSV

There is also a workaround for importing comments.

Third-party import tools

Third-party tools created by Atlassian Experts are also available for the following:

- HEAT
  - Go2Group’s Migration scripts
- HP Quality Center
  - Go2Group’s JaM
  - Orasi Software’s JIRA Bridge for HP Quality Center
- IBM ClearQuest
  - See: JIRA Cookbook - Migration off IBM Rational ClearQuest
  - Appfire’s Enterprise Migration Utility for JIRA
  - Clearvision’s Affinity
  - Go2Group’s ClearCase Add on for JIRA or Go2Group's ConnectALL
- IBM DOORS
  - Go2Group’s ConnectALL
- Microsoft Team Foundation Server
  - Appfire’s Enterprise Migration Utility for JIRA
  - Go2Group’s ConnectALL
- Rally
  - Appfire’s Enterprise Migration Utility for JIRA
  - Go2Group’s Migration scripts
- Redmine (now supported)
  - Go2Group’s Migration scripts
Requests for non-supported importers

We are also tracking requests to add other systems to our built-in importers. We encourage users to vote and comment on the systems they are interested in:

- Rally
- Gemini
- GitHub
- Code Spaces

Other non-supported methods

There are also a few other non-supported options to get your data into JIRA:

- Write a Jelly script that will import your data. JIRA ships with some Jelly tags that make operations like creating issues in JIRA easy.
- JIRA ships with an RPC plugin that enables limited remote access to JIRA. It is available through REST, SOAP and XML-RPC interfaces. We recommend using the REST interface when possible as it will be our primary focus in the future. The JIRA RPC Services page provides a starting point for all your remote procedure call needs. We'd also be happy to accept code contributions to the project, see the RPC Endpoint Plugin Module for more information.
- It is possible to use whatever tools you feel comfortable with, to import the data directly into JIRA's database. JIRA's database schema is described in XML format in the `WEB-INF/classes/entitydefs/entitymodel.xml` file under the JIRA web application. When using this approach please take care to maintain database integrity.
- Finally as a last resort our built-in importer can be extended to support other systems, there is a very limited starting guide for those interested in taking this avenue.

Other references

- Commercial migrations by Atlassian Experts. A number of partners (e.g. ServiceRocket, formerly Customware and others) have provided custom migrations from Remedy, TeamTrack, ClearQuest, GNATS and Bugzilla in the past.
- Ask for help on the JIRA Development Forum.
- ClearQuest Import Forums Discussion
- Migrating Unfuddle tickets to JIRA
- Comparison of JIRA with other issue trackers

Importing Data from Bugzilla

The JIRA Importers plugin, which is bundled with JIRA, allows you to import data from Bugzilla by connecting to a live Bugzilla database.

Our main website highlights some top reasons why people migrate from Bugzilla to JIRA.
Version 4.1 or later of the JIRA Importers plugin is compatible with Bugzilla 2.20 to 4.0.2. Users of older Bugzilla versions will need to first upgrade the Bugzilla database tables to a supported version, using Bugzilla's `checkse tup.pl` script. The JIRA Importers plugin requires that your Bugzilla database is MySQL, PostgreSQL or Microsoft SQL Server.

- JIRA is able to import data from Bugzilla 2.20 only if it's using a supported database – in this case, MySQL 5.1 or higher.
- JIRA does not bundle the MySQL driver anymore. If the Bugzilla data is located in a MySQL database, follow the instructions at Connecting JIRA to MySQL to install the MySQL database driver before attempting to import from Bugzilla.

The Bugzilla import process consists of simply running the Bugzilla Import Wizard (below).

- You can choose to map individual fields and field values during the import process, some of which are mandatory.
- At the end of the Bugzilla Import Wizard, you will be given the option of creating a Bugzilla configuration file, which contains the settings you configured whilst running through the Bugzilla Import Wizard. This is useful if you need to test your Bugzilla import on a test JIRA server first before performing the import on a production system.

**Please Note:**

- JIRA's character encoding is set to UTF-8 by default. If, however, your JIRA installation's character encoding is set to something other than UTF-8, you may encounter problems with importing data from Bugzilla. For more information, please refer to [JIM-5 - Slanted Quotes Cause UI to Break After Importing from Bugzilla](#). Importing Bugzilla data into a non-UTF-8 JIRA installation is not supported.

### On this page:

- Running the Bugzilla Import Wizard
- Tips for importing Bugzilla data into JIRA fields

Running the Bugzilla Import Wizard

If your JIRA installation has existing data, then before you begin, back up your existing JIRA data.

1. Before you begin, please backup your JIRA data.
2. In your Bugzilla system, run the Bugzilla 'Sanity Check' to ensure your data is error-free.
3. Log in to JIRA as a user with the JIRA Administrators global permission.
4. Choose > System. Select Import & Export > External System Import to open the Import external projects page.

   **Keyboard shortcut:** `g + g` + start typing `external system import`
5. Select the **Import** button associated with the **Bugzilla** option to open the **Bugzilla Import Wizard: Setup**.
6. On the **Bugzilla Import Wizard: Setup** page, complete the following fields/options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bugzilla URL</strong></td>
<td>Specify the URL of your Bugzilla site. This is the URL you would normally use to access Bugzilla through a web browser.</td>
</tr>
<tr>
<td><strong>Specify credentials</strong></td>
<td>Select this check box if you want to import Bugzilla issues into JIRA, which require user credentials on your Bugzilla site to access them. Selecting this check box reveals/hides the Bugzilla Login and Bugzilla Password fields, into which you should specify these user credentials.</td>
</tr>
<tr>
<td></td>
<td>If your Bugzilla site requires credentials and you do not specify them here, Bugzilla “Big File” attachments will not be imported.</td>
</tr>
</tbody>
</table>
| **Database Type**            | Select the type of database that your Bugzilla installation uses:  
|                              | - PostgreSQL  
|                              | - Microsoft SQL Server  
|                              | - MySQL                                                                                                                                   |
| **Hostname**                 | Specify the hostname or IP address of the server running your Bugzilla site’s database server.                                                                                                           |
| **Port**                     | Specify the TCP/IP port that the Bugzilla site’s database server is listening on.  
|                              | - This field is automatically populated with the default port value based on the Database Type you choose above.                                                                                 |
| **Database**                 | Specify the name of your Bugzilla database (into which Bugzilla saves its data).  
|                              | - This database name can usually be found in the ‘localconfig’ file in Bugzilla’s root directory, for example, /etc/bugzilla/                                                                            |
| **Username**                 | Specify the database user that Bugzilla uses to connect to its database.  
|                              | - This database user can usually be found in the ‘localconfig’ file in Bugzilla’s root directory, for example, /etc/bugzilla/                                                                           |
| **Password**                 | Specify the password of the database user (above) that Bugzilla uses to connect to its database.  
|                              | - This password can usually be found in the ‘localconfig’ file in Bugzilla’s root directory, for example, /etc/bugzilla/                                                                             |
| **Use an existing configuration file** | Leave this check box cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between fields in Bugzilla and those in JIRA.  
|                              | - **Note:**  
|                              |   - If you select this option, you will be asked to specify an **Existing Configuration File**.                                                      |
|                              |   - If you do not select this option, then at the end of the Bugzilla Import Wizard, JIRA will create a configuration file which you can use for subsequent Bugzilla imports (for re-use at this step of the Bugzilla Import Wizard). |
| **JDBC connection parameters** | The Bugzilla Import Wizard will construct a JDBC-based database URL from the Bugzilla database server details you specify above. JIRA uses this URL to connect to and import issues from Bugzilla. If you need to specify any additional connection parameters to your Bugzilla database, specify them here.  
| (in expanded Advanced tab)   | - If you chose MySQL (above), the Bugzilla Import Wizard will add several additional connection parameters by default.                                                                                       |

7. Click the **Next** button to proceed to the **Setup project mappings** step of the Bugzilla Import Wizard.
8. On the **Setup project mappings** page, select which Bugzilla projects you wish to import into JIRA.

- All Bugzilla projects are selected by default, so clear the check boxes under **Import** of the Bugzilla projects you do not wish to import into JIRA.
For Bugzilla projects you wish to import into JIRA, click in **Select a project** and then do either of the following:

- Start typing the name (or key) of a project that already exists in JIRA or use the dropdown menu to select an existing JIRA project.
- Select **Create New** from the dropdown menu and in the resulting **Add A New Project** dialog box, type the following:
  - A new project **Name**
  - A new project **Key**
    - This will be used as the prefix for all issue IDs in your JIRA project.
  - **The Project Lead**

9. Click the **Next** button to proceed to the **Setup custom fields** step of the Bugzilla Import Wizard.

10. On the **Setup custom fields** page, for each **External field** in Bugzilla which the Bugzilla Import Wizard cannot match to an existing JIRA field, you can choose to either:

- have the Bugzilla Import Wizard automatically create new **custom fields in JIRA** based on the names of Bugzilla's fields. This is the default option - whereby the names of the JIRA custom fields to be automatically created appear in the **JIRA field** dropdown lists.
- create your own **custom fields in JIRA** to map data from Bugzilla's fields. To do this, choose **Other** from the **JIRA field** dropdown list and specify the name of your custom field in the new field appearing immediately below **Other**.
  - For more information about matching Bugzilla fields to JIRA fields, see **Tips for importing Bugzilla data into JIRA fields**.

11. Click the **Next** button to proceed to the **Setup field mappings** step of the Bugzilla Import Wizard.

12. On the **Setup field mappings** page, if there **External fields** in Bugzilla whose values you wish to modify **before** they are imported into JIRA, select the **Map field value** check boxes next to the appropriate fields.

- Please note that it is mandatory to map Bugzilla's **bug_status** (i.e. **Status**) field to specific JIRA **Status** field values as the JIRA **Status** field is an integral part of JIRA workflows.

- Other **External fields** in Bugzilla which are likely to appear on the **Setup field mappings** page are:

<table>
<thead>
<tr>
<th>External field in Bugzilla</th>
<th>Not choosing the 'Map field value' check box</th>
</tr>
</thead>
<tbody>
<tr>
<td>login_name</td>
<td>The Bugzilla Import Wizard will automatically map Bugzilla usernames to JIRA usernames (lowercase).</td>
</tr>
<tr>
<td>priority</td>
<td>The Bugzilla Import Wizard will automatically create missing values in JIRA and will ensure that the issues are migrated with the correct priority (e.g. &quot;Normal&quot; in Bugzilla to newly-created &quot;Normal&quot; in JIRA).</td>
</tr>
<tr>
<td>resolution</td>
<td>The importer will create corresponding Resolutions in JIRA instead of using the existing ones.</td>
</tr>
</tbody>
</table>

- Select the appropriate JIRA **Workflow Scheme** in that will be used by the Bugzilla issues you will import into your JIRA project.
  - If you are importing your Bugzilla issues into an existing JIRA project, ensure that you choose the JIRA workflow scheme used by that existing JIRA project.

13. Click the **Next** button to proceed to the **Setup value mappings** step of the Bugzilla Import Wizard.

14. On the **Setup value mappings** page, specify JIRA field values for each Bugzilla field value (as detected by the Bugzilla Import Wizard).

- Any fields whose **Map field value** check boxes were selected in the previous step of the Bugzilla Import Wizard will be presented on this page, including the mandatory **bug_status** Bugzilla field.

15. Click the **Next** button to proceed to the **Setup links** step of the Bugzilla Import Wizard.

16. On the **Setup links** page, specify the JIRA link type for each Bugzilla link type (as detected by the Bugzilla Import Wizard). To learn more about JIRA link types, please see **Configuring Issue Linking**.

17. Click the **Begin Import** button when you are ready to begin importing your Bugzilla data into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.
Note:
- If you experience problems with the import (or you are curious), click the download a detailed log link to reveal detailed information about the Bugzilla Import Wizard process.
- If you need to import data from another Bugzilla product/project or site with the same (or similar) settings to what you used through this procedure, click the save the configuration link to download a Bugzilla configuration file, which you can use at the first step of the Bugzilla Import Wizard.

Congratulations, you have successfully imported your Bugzilla projects into JIRA! If you have any questions or encounter any problems, please contact Atlassian support.

Tips for importing Bugzilla data into JIRA fields

During the import process, the following data is copied from the Bugzilla database into JIRA:

<table>
<thead>
<tr>
<th>In Bugzilla</th>
<th>In JIRA</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Project</td>
<td>Bugzilla data is imported on a per-project basis. You can either specify an existing JIRA project as the target, or the importer will automatically create a project(s) for you at time of import. (For more information about JIRA projects, please see Defining a Project.)</td>
</tr>
<tr>
<td>External Project</td>
<td>Project Category</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Affects Version</td>
<td>You can choose to have the importer automatically create your Bugzilla component(s) in JIRA, or choose to have bugs imported into no component in JIRA.</td>
</tr>
<tr>
<td>Component</td>
<td>Component</td>
<td></td>
</tr>
<tr>
<td>Milestone</td>
<td>Fix Version</td>
<td>Versions are imported from Bugzilla (if you choose) and are set to the Un-Released and Un-Archived state.</td>
</tr>
<tr>
<td>Bug</td>
<td>Issue</td>
<td>Every Bugzilla bug becomes a JIRA issue of type 'Bug', with one exception: a Bugzilla issue with severity 'Enhancement' becomes a JIRA issue of type 'Improvement' and priority 'Major'.</td>
</tr>
<tr>
<td>ID</td>
<td>External issue ID</td>
<td>Each imported issue will be given a new JIRA ID, and the old Bugzilla ID will be saved into a JIRA custom field called 'External issue ID'. This custom field is searchable, so you can search for JIRA issues by their old Bugzilla ID. If you don't need this custom field, delete it or 'hide' it (as described in Specifyin Field Behavior).</td>
</tr>
<tr>
<td>Summary</td>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>Comments</td>
<td></td>
</tr>
<tr>
<td>Attachments</td>
<td>Attachments</td>
<td>Attachments are extracted from the Bugzilla database and saved to disk. To specify the location on disk, see Configuring File Attachments.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
<td>You can choose to map one of either the Bugzilla Priority field or the Bugzilla Severity field (see above) to the built-in JIRA Priority field, and the other to a custom field. (Alternatively, you can choose to map both the Bugzilla Priority field and the Bugzilla Severity field to JIRA custom fields.) When importing into the JIRA Priority field, you can configure mapping of specific Bugzilla values to specific JIRA values.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Severity</td>
<td>You can choose to map one of either the Bugzilla Priority field (above) or the Bugzilla Severity field to the built-in JIRA Priority field, and the other to a custom field. (Alternatively, you can choose to map both the Bugzilla Priority field and the Bugzilla Severity field to JIRA custom fields.) When importing into the JIRA Priority field, you can configure mapping of specific Bugzilla values to specific JIRA values.</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>You can configure mapping of specific Bugzilla values to specific JIRA values.</td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>You can configure mapping of specific Bugzilla values to specific JIRA values.</td>
<td></td>
</tr>
<tr>
<td>Duplicates</td>
<td>You can configure mapping of specific Bugzilla link types to JIRA link types.</td>
<td></td>
</tr>
<tr>
<td>Depends on</td>
<td>You can configure mapping of specific Bugzilla link types to JIRA link types.</td>
<td></td>
</tr>
<tr>
<td>Blocks</td>
<td>You can configure mapping of specific Bugzilla link types to JIRA link types.</td>
<td></td>
</tr>
<tr>
<td>Work History</td>
<td>Each Bugzilla worklog report will appear in JIRA as a separate worklog entry.</td>
<td></td>
</tr>
<tr>
<td>Estimated</td>
<td>See Configuring Time Tracking.</td>
<td></td>
</tr>
<tr>
<td>Remaining</td>
<td>See Configuring Time Tracking.</td>
<td></td>
</tr>
<tr>
<td>Logged</td>
<td>See Configuring Time Tracking.</td>
<td></td>
</tr>
<tr>
<td>Votes</td>
<td>If a user has voted one or more times for a Bugzilla issue, a JIRA vote is stored for that user.</td>
<td></td>
</tr>
<tr>
<td>CC List</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>You can choose to have the importer automatically create JIRA users for any Bugzilla users who do not already exist in JIRA.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Users who interacted with the Bugzilla system will be created as active accounts in JIRA. Other users will be imported into a special group called &quot;bugzilla-import-unused-users&quot; and will be deactivated.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Passwords from Bugzilla are not imported for v2.16+ of Bugzilla (as they are hashed in the database). Users from Bugzilla will need to get their passwords emailed to them the first time they log into JIRA.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Users with no real name stored in Bugzilla will get the portion of their email address (login name) before the &quot;@&quot; character as their Full Name in JIRA.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before commencing the import (this way, votes etc can be imported correctly).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will be displayed showing a list of users that can't be created.</td>
<td></td>
</tr>
<tr>
<td>Status Whiteboard</td>
<td>A JIRA custom field called 'Status Whiteboard' will be created.</td>
<td></td>
</tr>
<tr>
<td>Other fields</td>
<td>If your Bugzilla system contains any custom fields, you can choose to map them to specific JIRA custom field(s). If your custom fields don't yet exist in JIRA, the importer can automatically create them for you.</td>
<td></td>
</tr>
</tbody>
</table>
Importing Data from FogBugz for Your Server

The JIRA Importers plugin, which is bundled with JIRA, allows you to import data from FogBugz for Your Server by connecting to a live FogBugz for Your Server database.

Our main website highlights some top reasons why people migrate from FogBugz to JIRA. Version 4.2 or later of the JIRA Importers plugin is compatible with Fogbugz for Your Server versions 7.3.6 to 8.7.60. The JIRA Importers plugin requires that your Fogbugz for Your Server database is MySQL, Microsoft SQL Server or Microsoft SQL Server Express.

The FogBugz for Your Server import process consists of simply running the FogBugz Import Wizard (below):

- You can choose to map individual fields and field values during the import process, some of which are mandatory.
- At the end of the FogBugz Import Wizard, you will be given the option of creating a Fogbugz configuration file, which contains the settings you configured whilst running through the FogBugz Import Wizard. This is useful if you need to test your Fogbugz import on a test JIRA server first before performing the import on a production system.

These instructions refer to a FogBugz for Your Server, which is an installable implementation of FogBugz that operates behind your firewall. To import from a FogBugz On Demand (SaaS) issue tracker site, please follow the instructions for here.

On this page:
- Running the FogBugz for Your Server Import Wizard
- Tips for importing FogBugz for Your Server data into JIRA fields

Running the FogBugz for Your Server Import Wizard

1. Before you begin, please backup your JIRA data.
2. Log in to JIRA as a user with the JIRA Administrators global permission.
3. Choose 🔄 > System. Select Import & Export > External System Import to open the Import external projects page.
   - Keyboard shortcut: g + g + start typing external system import
Import external projects

- **Bugzilla**: Import projects and issues directly from a Bugzilla database into JIRA. Supports version from 2.20 to 4.0.2
- **FogBugz for Your Server**: Import projects and issue directly from a FogBugz database into JIRA. Supports version from 7.3.6 to 8.7.60
- **FogBugz On Demand**: Import projects and issues directly from a FogBugz On Demand into JIRA.
- **Pivotal Tracker**: Import projects and issues directly from Pivotal Tracker into JIRA. Supports version from 1.1.8 to 1.2.8
- **Mantis**: Import projects and issue directly from a Mantis database into JIRA.
- **Trac**: Import projects and issues directly from a zipped Trac.
- **JSON Beta**: Import project and issues from a JSON file into JIRA.
4. Select the **Import** button associated with the **FogBugz for Your Server** option to open the **FogBugz Import Wizard: Setup** page.

5. On the **FogBugz Setup** page, complete the following fields/options:

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Select the type of database that your FogBugz for Your Server installation uses:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Hostname or IP address of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>TCP Port Number for the database server.</td>
</tr>
<tr>
<td>Database</td>
<td>Database to connect to.</td>
</tr>
<tr>
<td>Username</td>
<td>The username used to access the database.</td>
</tr>
<tr>
<td>Password</td>
<td>The password used to access the database.</td>
</tr>
<tr>
<td>Use an existing configuration file</td>
<td>If you have used this importer before, you may have saved a previous configuration file. You can use that here to save time.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Passwords will not be imported. Users will have to create new password at first login.</td>
</tr>
</tbody>
</table>
Hostname  Specify the hostname or IP address of the server running your FogBugz site's database server.

Port  Specify the TCP/IP port that the FogBugz site's database server is listening on. This field is automatically populated with the default port value based on the Database Type you choose above.

Database  Specify the name of your FogBugz database (into which FogBugz for Your Server saves its data). If you need to specify an instance ID for your database, do so using the syntax `fogbugz:instance=sqlexpress` (where `fogbugz` is the name of your FogBugz database and `sqlexpress` is your FogBugz database's instance ID. The database name can usually be found in the Windows registry. See [http://bugs.movabletype.org/help/topics/setup/WindowsWhatSetupDoes.html](http://bugs.movabletype.org/help/topics/setup/WindowsWhatSetupDoes.html) and then search for 'Initialize Registry Settings' (for details on how to access the relevant registry keys and values).

Username  Specify the database user that FogBugz uses to connect to its database.

Password  Specify the password of the database user (above) that FogBugz uses to connect to its database.

Use an existing configuration file  Leave this check box cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between fields in FogBugz for Your Server and those in JIRA.

Note:
- If you select this option, you will be asked to specify an Existing Configuration File.
- If you do not select this option, then at the end of the FogBugz Import Wizard, JIRA will create a configuration file which you can use for subsequent imports (for re-use at this step of the FogBugz Import Wizard).

JDBC connection parameters (in expanded Advanced tab)  The FogBugz Import Wizard will construct a JDBC-based database URL from the FogBugz database server details you specify above. JIRA uses this URL to connect to and import issues from FogBugz for Your Server. If you need to specify any additional connection parameters to your FogBugz database, specify them here.

If you chose MySQL (above), the FogBugz Import Wizard will add several additional connection parameters by default.

6. Click the Next button to proceed to the Set up project mappings step of the FogBugz Import Wizard.
7. On the Set up project mappings page, select which FogBugz projects you wish to import into JIRA.
8. All projects are selected by default, so clear the check boxes under Import of the FogBugz projects you do not wish to import into JIRA.
For FogBugz projects you wish to import into JIRA, click in Select a project and then do either of the following:
- Start typing the name (or key) of a project that already exists in JIRA or use the dropdown menu to select an existing JIRA project.
- Select Create New from the dropdown menu and in the resulting Add A New Project dialog box, type the following:
  - A new project Name
  - A new project Key
  - This will be used as the prefix for all issue IDs in your JIRA project.
  - The Project Lead.
9. Click the Next button to proceed to the Set up custom fields step of the FogBugz Import Wizard.
10. On the Set up custom fields page, for each External field in FogBugz which the FogBugz Import Wizard cannot match to an existing JIRA field, you can choose to either:
- have the FogBugz Import Wizard automatically create new custom fields in JIRA based on the names of FogBugz's fields. This is the default option - whereby the names of the JIRA custom fields to be automatically created appear in the JIRA field dropdown lists.
- create your own custom fields in JIRA to map data from FogBugz's fields. To do this, choose Other from the JIRA field dropdown list and specify the name of your custom field in the new field appearing immediately below Other.
11. Click the Next button to proceed to the **Set up field mappings** step of the FogBugz Import Wizard.

12. On the **Set up field mappings** page, if there **External fields** in FogBugz whose values you wish to modify before they are imported into JIRA, select the **Map field value** check boxes next to the appropriate fields.

   Please note that it is mandatory to map FogBugz’s **sStatus** (i.e. **Status**) field to specific JIRA **Status** field values as the JIRA **Status** field is an integral part of JIRA workflows.

   - Other **External fields** in FogBugz which are likely to appear on the **Set up field mappings** page are:

     | External field in FogBugz | Not choosing the 'Map field value' check box |
     |---------------------------|---------------------------------------------|
     | **sCategory**             | The FogBugz Import Wizard will automatically create missing issue types in JIRA and will ensure that the issues are migrated with the correct issue type. |
     | **sCustomerEmail**        | The FogBugz Import Wizard will not map values for this field. |
     | **sComputer**             | The FogBugz Import Wizard will not map values for this field. |
     | **sFullName**             | The FogBugz Import Wizard will automatically map FogBugz usernames to JIRA usernames (lowercase). |
     | **sPriority**             | The FogBugz Import Wizard will automatically create missing values in JIRA and will ensure that the issues are migrated with the correct priority (e.g. "Normal" in FogBugz to newly-created "Normal" in JIRA). |
     | **sStatus** (Resolution)  | The importer will create corresponding Resolutions in JIRA instead of using the existing ones. |

   - Select the appropriate JIRA **Workflow Scheme** in that will be used by the FogBugz issues you will import into your JIRA project.

     If you are importing your FogBugz issues into an existing JIRA project, ensure that you choose the JIRA workflow scheme used by that existing JIRA project.

13. Click the Next button to proceed to the **Set up value mappings** step of the FogBugz Import Wizard.

14. On the **Set up value mappings** page, specify JIRA field values for each FogBugz field value (as detected by the FogBugz Import Wizard).

   Any fields whose **Map field value** check boxes were selected in the previous step of the FogBugz Import Wizard will be presented on this page, including the mandatory **sStatus** FogBugz field.

15. Click the Next button to proceed to the **Set up links** step of the FogBugz Import Wizard.

16. On the **Set up links** page, specify the JIRA link type for each FogBugz link type (as detected by the FogBugz Import Wizard). To learn more about JIRA link types, please see Configuring Issue Linking.

17. Click the **Begin Import** button when you are ready to begin importing your FogBugz data into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.

   **Note:**

   - If you experience problems with the import (or you are curious), click the **download a detailed log** link to reveal detailed information about the FogBugz Import Wizard process.
   - If you need to import data from another FogBugz product/project or site with the same (or similar) settings to what you used through this procedure, click the **save the configuration** link to download a FogBugz configuration file, which you can use at the first step of the FogBugz Import Wizard.

Congratulations, you have successfully imported your FogBugz projects into JIRA! If you have any questions or encounter any problems, please contact Atlassian support.

**Tips for importing FogBugz for Your Server data into JIRA fields**

During the import process, the following data is copied from the FogBugz Server database into JIRA:

<table>
<thead>
<tr>
<th>In FogBugz</th>
<th>In JIRA</th>
<th>Import Notes</th>
</tr>
</thead>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| Project | Project | FogBugz data is imported on a per-project basis. You can either specify an existing JIRA project as the target, or the importer will automatically create a project(s) for you at time of import. (For more information about JIRA projects, please see Defining a Project.) |
| Area | Component | You can choose to have the importer automatically create your FogBugz components in JIRA, or choose to have bugs imported into no component in JIRA. |
| Milestone | Fix Version | Versions are imported from FogBugz (if you choose). After importing, you can manually set appropriate versions to the Released state in JIRA if you wish. |
| Case | Issue | Every FogBugz case becomes a JIRA issue. |
| Case ID | Bug Import ID | Each imported issue ('case') will be given a new JIRA ID, and the old FogBugz ID will be saved into a JIRA custom field called 'Bug Import ID'. This custom field is searchable, so you can search for JIRA issues by their old FogBugz ID. If you don't need this custom field, delete it or 'hide' it (as described in Specifyin g Field Behavior). |
| Summary | Summary | |
| Comments | Comments | FogBugz allows for links to other issues to be automatically generated by using the format "bug issueId" or "case issue id". After import, any string matching this pattern will be rewritten to their new JIRA key. For example, a comment "Please see case 100" may be rewritten to "Please see IMP-100". |
| Attachments | Attachments | Attachments are extracted from the FogBugz database and saved to disk. Any e-mail issues will be parsed for attachments and the e-mail text saved as a comment. The dates and user attaching the attachments will be retained. To specify the location on disk, see Configuring File Attachments. |
| Category | Issue Type | You can configure mapping of specific Case Categories to specific Issue Types. |
| Priority | Priority | You can configure mapping of specific FogBugz values to specific JIRA values. |
| Status | Status | You can configure mapping of specific FogBugz values to specific JIRA values, provided you create your workflows in JIRA before running the importer. |
| Resolution | Resolution | You can configure mapping of specific FogBugz values to specific JIRA values. |
| Duplicates BugRelations | Links | You can configure mapping of specific FogBugz link types to JIRA link types. |
| Computer | Computer | The FogBugz Computer field is imported into a JIRA Custom Field called 'Computer'. |
| Customer Email | Customer Email | The FogBugz Customer Email field is imported into a JIRA Custom Field called 'Customer Email'. |
You can choose to have the importer automatically create JIRA users for any FogBugz users who do not already exist in JIRA.

- Users who interacted with the FogBugz system will be created as active accounts in JIRA. Other users will be imported into a special group called "fogbugz-import-unused-users" and will be deactivated.
- Passwords from FogBugz are not imported (as they are hashed in the database). Users from FogBugz will need to get their passwords emailed to them the first time they log into JIRA.
- Users with no real name stored in FogBugz will get the portion of their email address (login name) before the "@" character as their Full Name in JIRA.
- If you don't specify any particular mappings, the user name will be created from the first letter of the first name and the last name, all in lowercase.
- If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before commencing the import.
- If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will be displayed showing a list of users that can't be created.

### Other fields

If your FogBugz system contains any custom fields, you can choose to map them to specific JIRA custom field(s). If your custom fields don't yet exist in JIRA, the importer can automatically create them for you.

Please note that the FogBugz Custom Field plugin is not supported.

### Importing Data from FogBugz On Demand

The JIRA Importers plugin, which is bundled with JIRA, allows you to import data from FogBugz On Demand, a 'Software as a Service' (SaaS) issue tracker product.

Our main website highlights some top reasons why people migrate from FogBugz to JIRA. Version 3.1 or later of the JIRA Importers Plugin is required.

These instructions refer to FogBugz On Demand, which is a SaaS implementation of FogBugz. To import from the installable FogBugz for Your Server implementation of FogBugz, please follow the instructions for here.

On this page:

- Running the FogBugz On Demand Import Wizard
- Tips for importing FogBugz On Demand data into JIRA fields

### Running the FogBugz On Demand Import Wizard

**Before you begin:** If your JIRA installation has existing data — Back up your existing JIRA data.

**Tip:** FogBugz On Demand supports hierarchical issues. During the FogBugz On Demand Import Wizard, you are given the option to recreate this issue hierarchy through JIRA issue links. Hence, before commencing the FogBugz On Demand Import Wizard, you may wish to configure an custom issue link to replicate this hierarchy — for example:

- **Name** — 'Hierarchy'
- **Outward Link Description** — 'parent of'
- **Inward Link Description** — 'child of'

**To import issues FogBugz On Demand:**

1. Log in to JIRA as as a user with the JIRA Administrators global permission.
2. Choose **Settings** > **System**. Select **Import & Export** > **External System Import** to open the Import external projects page.

   **Keyboard shortcut:** `g + g +` start typing external system import
3. Select the **Import** button associated with the FogBugz On Demand option to open the **Connect with FogBugz** page.

4. On the **Connect with FogBugz** page, complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FogBugz On Demand URL</td>
<td>Specify the URL of your FogBugz On Demand site. This is the URL you would normally use to access FogBugz On Demand through a web browser. This is usually of the format <code>http://myfogbugzondemand.fogbugz.com</code></td>
</tr>
<tr>
<td>FogBugz Username</td>
<td>Specify the user account that JIRA will use to access issues on your FogBugz On Demand site.</td>
</tr>
<tr>
<td>FogBugz Password</td>
<td>Specify the password of the user (above).</td>
</tr>
</tbody>
</table>

5. Click the **Next** button to proceed to the **Setup project mappings** step of the FogBugz On Demand Import Wizard.

6. On the **Setup project mappings** page, select which FogBugz On Demand projects you wish to import.
7. All FogBugz On Demand projects are selected by default, so clear the check boxes under **Import** of the FogBugz On Demand projects you do not wish to import into JIRA. For FogBugz On Demand projects you wish to import into JIRA, click in **Select a project** and then do either of the following:
   - Start typing the name (or key) of a project that already exists in JIRA or use the dropdown menu to select an existing JIRA project.
   - Select **Create New** from the dropdown menu and in the resulting **Add A New Project** dialog box, type the following:
     a. A new project Name
     b. A new project Key
        - This will be used as the prefix for all issue IDs in your JIRA project.
     c. The **Project Lead**

8. Click the **Next** button to proceed to the **Setup field mappings** step of the FogBugz On Demand Import Wizard.

9. On the **Setup field mappings** page, if there **External fields** in FogBugz On Demand whose values you wish to modify before they are imported into JIRA, select the **Map field value** check boxes next to the appropriate fields.
   - Please note that it is mandatory to map FogBugz On Demand's **sStatus** (i.e. **Status**) field to specific JIRA **Status** field values as the JIRA **Status** field is an integral part of JIRA workflows.
     - The FogBugz On Demand field **sStatus (Resolution)** (i.e. **Resolution**), which will be mapped to the JIRA **Resolution** field, may also appear on this page.
     - Select the appropriate JIRA **Workflow Scheme** in that will be used by the FogBugz On Demand issues you will import into your JIRA project.
       - If you are importing your FogBugz On Demand issues into an existing JIRA project, ensure that you choose the JIRA workflow scheme used by that existing JIRA project. Otherwise, your import may not complete successfully.

10. Click the **Next** button to proceed to the **Setup value mappings** step of the FogBugz On Demand Import Wizard.

11. On the **Setup value mappings** page, specify JIRA field values for each FogBugz On Demand field value (as detected by the FogBugz On Demand Import Wizard).
   - Any fields whose **Map field value** check boxes were selected in the previous step of the FogBugz On Demand Import Wizard will be presented on this page, including the mandatory **sStatus** FogBugz On Demand field.

12. Click the **Next** button to proceed to the **Setup links** step of the FogBugz On Demand Import Wizard.

13. On the **Setup links** page, specify how want to map FogBugz On Demand's Parent / Subcase relationships through a JIRA issue links. To learn more about JIRA link types, please see Configuring Issue Linking.

   - You may wish to choose the 'Hierarchy' custom issue link you created before running the FogBugz On Demand Import Wizard.

14. Click the **Begin Import** button when you are ready to begin importing your FogBugz On Demand data into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.
   - **Note:** If you experience problems with the import (or you are curious), click the download a detailed log link to reveal detailed information about the FogBugz On Demand Import Wizard process.

Congratulations, you have successfully imported your FogBugz On Demand projects into JIRA! If you have any questions or encounter any problems, please contact Atlassian support.

### Tips for importing FogBugz On Demand data into JIRA fields

The import process converts FogBugz On Demand data as follows:

**Importing Data from Mantis**

The JIRA Importers plugin, which is bundled with JIRA, allows you to import data from Mantis by connecting to a live Mantis database.

- Our main website highlights some top reasons why people **migrate from Mantis to JIRA**.

- Version 4.2 or later of the JIRA Importers plugin is compatible with Mantis versions 1.1.8 to 1.2.8. The JIRA Importers plugin requires that your Mantis database is MySQL, PostgreSQL or Microsoft SQL Server. We have also received reports that the JIRA Importers plugin works with Oracle and DB2 databases. However, we have
not tested this plugin against these databases.)

The Mantis import process consists of simply running the Mantis Import Wizard (below).

- You can choose to map individual fields and field values during the import process, some of which are mandatory.
- At the end of the Mantis Import Wizard, you will be given the option of creating a Mantis configuration file, which contains the settings you configured whilst running through the Mantis Import Wizard. This is useful if you need to test your Mantis import on a test JIRA server first before performing the import on a production system.

On this page:
- Running the Mantis Import Wizard
- Tips for importing Mantis data into JIRA fields

Running the Mantis Import Wizard

1. Before you begin, please backup your JIRA data.
2. Log in to JIRA as as a user with the JIRA Administrators global permission.
3. Choose > System. Select Import & Export > External System Import to open the Import external projects page.
   Keyboard shortcut: g + g + start typing external system import
4. Select the Import button associated with the Mantis option to open the Mantis Import Wizard: Setup page.
5. On the Mantis Import Wizard: Setup page, complete the following fields/options:

| Mantis URL | Specify the URL of your Mantis site. This is the URL you would normally use to access Mantis through a web browser. |
| Specify credentials | Select this check box if you want to import Mantis issues into JIRA, which require user credentials on your Mantis site to access them. Selecting this check box reveals/hides the Mantis Login and Mantis Password fields, into which you should specify these user credentials. |
| Database Type | Select the type of database that your Mantis installation uses: PostgreSQL, Microsoft SQL Server, MySQL |
| Hostname | Specify the hostname or IP address of the server running your Mantis site's database server. |
| Port | Specify the TCP/IP port that the Mantis site's database server is listening on. This field is automatically populated with the default port value based on the Database Type you choose above. |
| Database | Specify the name of your Mantis database (into which Mantis saves its data). The database name, username and user password can usually be found in the Mantis file config_inc.php. (Typically, the default username is "root" and the default password is empty). See also http://www.mantisbt.org/manual/manual.configuration.database.php |
| Username | Specify the database user that Mantis uses to connect to its database. |
| Password | Specify the password of the database user (above) that Mantis uses to connect to its database. |
### Use an existing configuration file

Leave this check box cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between fields in Mantis and those in JIRA.

**Note:**
- If you select this option, you will be asked to specify an Existing Configuration File.
- If you do not select this option, then at the end of the Mantis Import Wizard, JIRA will create a configuration file which you can use for subsequent Mantis imports (for re-use at this step of the Mantis Import Wizard).

### JDBC connection parameters

The Mantis Import Wizard will construct a JDBC-based database URL from the Mantis database server details you specify above. JIRA uses this URL to connect to and import issues from Mantis. If you need to specify any additional connection parameters to your Mantis database, specify them here.

**Tip:** If you chose MySQL (above), the Mantis Import Wizard will add several additional connection parameters by default.

---

6. Click the **Next** button to proceed to the **Set up project mappings** step of the Mantis Import Wizard.

7. On the **Set up project mappings** page, select which Mantis projects you wish to import into JIRA.

   **Tip:** All Mantis projects are selected by default, so clear the check boxes under **Import** of the Mantis projects you do not wish to import into JIRA.

   For Mantis projects you wish to import into JIRA, click in **Select a project** and then do either of the following:
   - Start typing the name (or key) of a project that already exists in JIRA or use the dropdown menu to select an existing JIRA project.
   - Select **Create New** from the dropdown menu and in the resulting **Add A New Project** dialog box, type the following:
     * A new project **Name**
     * A new project **Key**
     * This will be used as the prefix for all issue IDs in your JIRA project.
   - The **Project Lead**.

8. Click the **Next** button to proceed to the **Set up custom fields** step of the Mantis Import Wizard.

   **Tip:** This step will almost always appear because at least one Mantis field is not likely match an existing JIRA field.

9. On the **Set up custom fields** page, for each **External field** in Mantis which the Mantis Import Wizard cannot match to an existing JIRA field, you can choose to either:

   * have the Mantis Import Wizard automatically create new custom fields in JIRA based on the names of Mantis's fields. This is the default option - whereby the names of the JIRA custom fields to be automatically created appear in the JIRA field dropdown lists.
   * create your own custom fields in JIRA to map data from Mantis's fields. To do this, choose Other from the JIRA field dropdown list and specify the name of your custom field in the new field appearing immediately below Other.

10. Click the **Next** button to proceed to the **Set up field mappings** step of the Mantis Import Wizard.

11. On the **Set up field mappings** page, if there are **External fields** in Mantis whose values you wish to modify before they are imported into JIRA, select the **Map field value** check boxes next to the appropriate fields.

   **Tip:** Please note that it is mandatory to map Mantis's **status** (i.e. **Status**) field to specific JIRA **Status** field values as the JIRA **Status** field is an integral part of JIRA workflows.

   * Other **External fields** in Mantis which are likely to appear on the **Set up field mappings** page are:

<table>
<thead>
<tr>
<th>External field in Mantis</th>
<th>Not choosing the 'Map field value’ check box</th>
</tr>
</thead>
<tbody>
<tr>
<td>username</td>
<td>The Mantis Import Wizard will automatically map Mantis usernames to JIRA usernames (lowercase).</td>
</tr>
<tr>
<td>priority</td>
<td>The Mantis Import Wizard will automatically create missing values in JIRA and will ensure that the issues are migrated with the correct priority (e.g. &quot;Normal&quot; in Mantis to newly-created “Normal” in JIRA).</td>
</tr>
</tbody>
</table>
• Select the appropriate JIRA Workflow Scheme in that will be used by the Mantis issues you will import into your JIRA project.

   If you are importing your Mantis issues into an existing JIRA project, ensure that you choose the JIRA workflow scheme used by that existing JIRA project.

12. Click the Next button to proceed to the Set up value mappings step of the Mantis Import Wizard.
13. On the Set up value mappings page, specify JIRA field values for each Mantis field value (as detected by the Mantis Import Wizard).

   Any fields whose Map field value check boxes were selected in the previous step of the Mantis Import Wizard will be presented on this page, including the mandatory status field.

14. Click the Next button to proceed to the Set up links step of the Mantis Import Wizard.
15. On the Set up links page, specify the JIRA link type for each Mantis link type (as detected by the Mantis Import Wizard). To learn more about JIRA link types, please see Configuring Issue Linking.
16. Click the Begin Import button when you are ready to begin importing your Mantis data into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.

   Note:
   • If you experience problems with the import (or you are curious), click the download a detailed log link to reveal detailed information about the Mantis Import Wizard process.
   • If you need to import data from another Mantis product/project or site with the same (or similar) settings to what you used through this procedure, click the save the configuration link to download a Mantis configuration file, which you can use at the first step of the Mantis Import Wizard.

Congratulations, you have successfully imported your Mantis projects into JIRA! If you have any questions or encounter any problems, please contact Atlassian support.

Tips for importing Mantis data into JIRA fields

During the import process, the following data is copied from the Mantis database into JIRA:

<table>
<thead>
<tr>
<th>In Mantis</th>
<th>In JIRA</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Project</td>
<td>Mantis data is imported on a per-project basis. You can either specify an existing JIRA project as the target, or the importer will automatically create a project(s) for you at time of import. (For more information about JIRA projects, please see Defining a Project.)</td>
</tr>
<tr>
<td>Sub Project</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Component</td>
<td>You can choose to have the importer automatically create your Mantis components in JIRA, or choose to have bugs imported into no component in JIRA.</td>
</tr>
<tr>
<td>Version</td>
<td>Fix Version</td>
<td>Versions are imported from Mantis (if you choose). After importing, you can manually set appropriate versions to the Released state in JIRA if you wish.</td>
</tr>
<tr>
<td>Bug</td>
<td>Issue</td>
<td>Every Mantis bug becomes a JIRA issue of type ‘Bug’.</td>
</tr>
<tr>
<td>ID</td>
<td>Bug Import ID</td>
<td>Each imported issue will be given a new JIRA ID, and the old Mantis ID will be saved into a JIRA custom field called ‘Bug Import ID’. This custom field is searchable, so you can search for JIRA issues by their old Mantis ID. If you don’t need this custom field, delete it or ‘hide’ it (as described in Specifying Field Behavior).</td>
</tr>
<tr>
<td>Summary</td>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
<td>Within text, Mantis links (e.g. #1234) are converted to JIRA links (e.g. TST-123).</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments</td>
<td>Within text, Mantis links (e.g. #1234) are converted to JIRA links (e.g. TST-123).</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Attachments</td>
<td>Attachments</td>
<td>Attachments are extracted from the Mantis database and saved to disk. To specify the location on disk, see Configuring File Attachments.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority (or a custom field)</td>
<td>You can choose to map one of either the Mantis Priority field or the Mantis Severity field (see below) to the built-in JIRA Priority field, and the other to a custom field. (Alternatively, you can choose to map both the Mantis Priority field and the Mantis Severity field to JIRA custom fields.) When importing into the JIRA Priority field, you can configure mapping of specific Mantis values to specific JIRA values.</td>
</tr>
<tr>
<td>Severity</td>
<td>Priority (or a custom field)</td>
<td>You can choose to map one of either the Mantis Priority field (see above) or the Mantis Severity field to the built-in JIRA Priority field, and the other to a custom field. (Alternatively, you can choose to map both the Mantis Priority field and the Mantis Severity field to JIRA custom fields.) When importing into the JIRA Priority field, you can configure mapping of specific Mantis values to specific JIRA values.</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
<td>You can configure mapping of specific Mantis values to specific JIRA values, provided you create your workflows in JIRA before running the importer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The JIRA ‘Status’ field is integral to JIRA workflow. To learn more, please see What is Workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To create a JIRA workflow, please see Configuring Workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To create a JIRA workflow scheme (which you can then associate with appropriate projects and Issue Types), please see Activating workflow.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution</td>
<td>You can configure mapping of specific Mantis values to specific JIRA values.</td>
</tr>
<tr>
<td>Relationships</td>
<td>Links</td>
<td>You can configure mapping of specific Mantis relationship types to JIRA link types.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In JIRA, you can configure different types of links (please see Configuring Issue Linking).</td>
</tr>
<tr>
<td>CC List</td>
<td>Watchers</td>
<td>You can choose to have the importer automatically create JIRA users for any Mantis users who do not already exist in JIRA.</td>
</tr>
<tr>
<td>User</td>
<td>User</td>
<td>You can choose to have the importer automatically create JIRA users for any Mantis users who do not already exist in JIRA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Users who interacted with the Mantis system will be created as active accounts in JIRA. Other users will be imported into a special group called &quot;mantis-import-unused-users&quot; and will be deactivated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Passwords from Mantis are not imported (as they are hashed in the database). Users from Mantis will need to get their passwords emailed to them the first time they log into JIRA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Users with no real name stored in Mantis will get the portion of their email address (login name) before the &quot;@&quot; character as their Full Name in JIRA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are using External User Management the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before commencing the import.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will be displayed showing a list of users that can't be created.</td>
</tr>
<tr>
<td>Other fields</td>
<td>Custom fields</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>If your Mantis system contains any custom fields, you can choose to map them to specific JIRA custom field(s). If your custom fields don’t yet exist in JIRA, the importer can automatically create them for you.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Importing Data from Pivotal Tracker**

The JIRA Importers plugin, which is bundled with JIRA, allows you to import data from Pivotal Tracker, a ‘Software as a Service’ (SaaS) issue tracker product.

ℹ️ Our main website highlights some top reasons why people migrate from Pivotal Tracker to JIRA.

Version 2.5 or later of the JIRA Importers Plugin is required.

**On this page:**
- Preparing Pivotal Tracker for data import into JIRA
- Running the Pivotal Tracker Import Wizard
- Tips for importing Pivotal Tracker data into JIRA fields

**Preparing Pivotal Tracker for data import into JIRA**

In Pivotal Tracker, please ensure you have switched on **Allow API Access** in your Pivotal Project’s Settings.

![Pivotal Tracker settings](image)

**Running the Pivotal Tracker Import Wizard**

**Before you begin:** If your JIRA installation has existing data — **Back up** your existing JIRA data.

1. Log in to JIRA as as a user with the **JIRA Administrators** global permission.
2. Choose **⌘ + G** > **System**. Select **Import & Export > External System Import** to open the Import external projects page.
   - **Keyboard shortcut:** `g + g` + start typing **external system import**
3. Select the **Import** button associated with the Pivotal Tracker option to open the **Connect with Pivotal Tracker** page.
4. On the Connect with Pivotal Tracker page, specify the following:

<table>
<thead>
<tr>
<th>Pivotal Username or Email</th>
<th>Specify the user account that JIRA will use to access issues on your Pivotal Tracker site.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pivotal Password</td>
<td>Specify the password of the user (above).</td>
</tr>
<tr>
<td>Map user names (in expanded Advanced tab)</td>
<td>Select this check box if you want to modify the name details of Pivotal Tracker users (which would be associated with Pivotal Tracker issues) when these users are created in JIRA.</td>
</tr>
</tbody>
</table>
| Use an existing configuration file (in expanded Advanced tab) | Leave this check box cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between fields in Pivotal Tracker and those in JIRA.  

**Note:**
- If you select this option, you will be asked to specify an **Existing Configuration File**.
- If you do not select this option, then at the end of the Pivotal Tracker Import Wizard, JIRA will create a configuration file which you can use for subsequent Pivotal Tracker imports (for re-use at this step of the Pivotal Tracker Import Wizard). |

5. Click the Next button to proceed to the Setup project mappings step of the Pivotal Tracker Import Wizard.

6. On the Setup project mappings page, select which Pivotal Tracker projects you wish to import into JIRA.

   - All Pivotal Tracker projects are selected by default, so clear the check boxes under Import of the Pivotal Tracker projects you do not wish to import into JIRA.
   - For Pivotal Tracker projects you wish to import into JIRA, click in Select a project and then do either of the following:
     - Select Create New from the dropdown menu and in the resulting Add A New Project dialog box, type the following:
       - A new project Name.
       - A new project Key.  
       - This will be used as the prefix for all issue IDs in your JIRA project.
       - The Project Lead.
   - Start typing the name (or key) of a project that already exists in JIRA or use the dropdown menu to select an existing JIRA project.

   **Tip:** Only JIRA projects that use the **PT Workflow Scheme** (which is created with your first Pivotal Tracker import into JIRA) can be chosen from the Select a project list. The **PT Workflow Scheme** consists of the:
   - **PT Workflow** — mapped to all standard issue types.
   - **PT Subtask Workflow** — mapped to JIRA's sub-task issue type.

   **Tip:** If you have not yet performed a Pivotal Tracker import into JIRA but you would like to import your Pivotal Tracker issues into an existing JIRA project, consider doing the following:
   - Use the Pivotal Tracker Import Wizard to import your issues into a new JIRA project. Upon doing so, JIRA will create the **PT Workflow Scheme** and **PT Issue Type Scheme**. The **PT Issue Type Scheme** consists of additional issue types that do not exist in a default JIRA installation, such as **Chore** and **Release**.
   - **(Optional) Delete this project if you do not intend to use it any further.**
   - Apply the **PT Workflow Scheme** and **PT Issue Type Scheme** to the existing JIRA project you want to import your Pivotal Tracker issues into. (See Configuring a project for details.)
   - Re-use the Pivotal Tracker Import Wizard to import your issues into this existing JIRA project.

7. Click the Next button to proceed to the Setup user mappings step of the Pivotal Tracker Import Wizard.

   **Tip:** If you did not select Map user names option above, skip to step 8. (The Next button will not be available.)
8. On the **Setup user mappings** step of the Pivotal Tracker Import Wizard, in the **Target value in JIRA** field:
   - Specify the **username** of a JIRA user to match Pivotal Tracker users to existing JIRA users.
   - Leave blank to add the Pivotal Tracker user's name details 'as is'. The user's Full Name in JIRA is derived from the Pivotal Tracker's username value and the JIRA username is derived from this Full Name (made lower-case).
   - Specify the **Full Name** in JIRA to change a Pivotal Tracker's user's name details. The JIRA username is derived from this Full Name (made lower-case).

9. Click the **Begin Import** button when you are ready to begin importing your Pivotal Tracker data into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.

**Note:**
- If you experience problems with the import (or you are curious), click the **download a detailed log** link to reveal detailed information about the Pivotal Tracker Import Wizard process.
- If you need to import data from another Pivotal Tracker project or site with the same (or similar) settings to what you used through this procedure, click the **save the configuration** link to download a Pivotal Tracker configuration file, which you can use at the **first step** of the Pivotal Tracker Import Wizard.

Congratulations, you have successfully imported your Pivotal Tracker project(s) into JIRA! If you have any questions or encounter any problems, please contact [Atlassian support](https://help.atlassian.com).

**Tips for importing Pivotal Tracker data into JIRA fields**

The import process converts Pivotal Tracker data as follows:

<table>
<thead>
<tr>
<th>Pivotal Tracker</th>
<th>JIRA</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Project</td>
<td>Each Pivotal Tracker project is imported into a new JIRA project. You can optionally import into an existing project if you have used the importer before.</td>
</tr>
<tr>
<td>Story</td>
<td>Issue</td>
<td>Pivotal Tracker story types are recreated in JIRA.</td>
</tr>
<tr>
<td>Summary</td>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>Comments</td>
<td></td>
</tr>
<tr>
<td>Attachments</td>
<td>Attachments</td>
<td>Attachments are extracted from the Pivotal Tracker database and saved to disk. The dates and user attaching the attachments will be retained.</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
<td>JIRA will recreate the Pivotal Tracker workflow and statuses during import.</td>
</tr>
<tr>
<td>Labels</td>
<td>Labels</td>
<td>Pivotal Tracker labels with spaces are imported with underscores (JIRA does not support spaces in labels).</td>
</tr>
<tr>
<td>Story ID</td>
<td>Story ID and Story URL</td>
<td>JIRA will create these as custom fields.</td>
</tr>
<tr>
<td>Iterations</td>
<td>Fix Version/s</td>
<td>Past iterations in Pivotal are imported as released versions in JIRA.</td>
</tr>
<tr>
<td>Story Estimates</td>
<td>Story Points</td>
<td>You will need to configure this custom field in JIRA after the import. If you are using JIRA Agile, you may wish to activate issue ranking. This can be done either before or after importing your Pivotal Tracker data.</td>
</tr>
</tbody>
</table>

---

*Created in 2015 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](http).*
### Time Tracker

<table>
<thead>
<tr>
<th>Time Tracking</th>
<th>Time Tracking</th>
<th>If you use time tracking in Pivotal this data will be automatically imported into a new JIRA issue type called 'Chore' with a Summary field value of &quot;Placeholder for imported time tracking data&quot;.</th>
</tr>
</thead>
</table>

### User

<table>
<thead>
<tr>
<th>User</th>
<th>User</th>
<th>The importer will automatically create JIRA users for any Pivotal Tracker users who do not exist in JIRA.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• Passwords from Pivotal Tracker are not imported (as they are hashed in the database). Users from Pivotal Tracker will need to get their passwords emailed to them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before commencing the import.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will be displayed showing a list of users that can't be created.</td>
</tr>
</tbody>
</table>

### User Roles

<table>
<thead>
<tr>
<th>User Roles</th>
<th>Project Roles</th>
<th>Viewer = User ; Member = Developers ; Owner = Administrators</th>
</tr>
</thead>
</table>

## Importing Data from Trac

The JIRA Importers plugin, which is bundled with JIRA, allows you to import data from Trac from a compressed Trac environment.

Our main website highlights some top reasons why people migrate from Trac to JIRA.

Version 2.6.1 or later of the JIRA Importers Plugin is compatible with Trac version 0.12.2.

### On this page:
- Preparing Trac data for import into JIRA
- Running the Trac Import Wizard
- Tips for importing Trac data into JIRA fields

### Preparing Trac data for import into JIRA

**Compress your Trac environment:**

1. Access your Trac environment.
2. If you use SQLite (the Trac default), PostgreSQL or MySQL for your Trac database, ensure your database URL (defined in Trac's `conf/trac.ini` file) is also reachable from JIRA server (using 'localhost' or a UNIX socket will not work).
3. Zip the contents of Trac Environment without any leading directories.

### Running the Trac Import Wizard

**Before you begin:** If your JIRA installation has existing data — Back up your existing JIRA data.

1. Log in to JIRA as as a user with the JIRA Administrators global permission.
2. Select Administration > System > Import & Export > External System Import > Import button associated with the Trac option to open the Trac Import Wizard: Setup page.

   ✔ Keyboard shortcut: `g + g +` start typing external system import

3. On the Trac Import Wizard: Setup page, select your compressed Trac environment file, which you prepared above.

4. Leave the Use an existing configuration file check box cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between fields in Trac and those in JIRA.
   - If you select this option, you will be asked to specify an Existing Configuration File.
   - If you do not select this option, then at the end of the Trac Import Wizard, JIRA will create a configuration file which you can use for subsequent Trac imports (for re-use at this step of the Trac Import Wizard).
5. Click the **Next** button to proceed to the **Setup project mappings** step of the Trac Import Wizard.

6. On the **Setup project mappings** page, select which Trac projects you wish to import into JIRA.
   - Start typing the name (or key) of a project that already exists in JIRA or use the dropdown menu to select an existing JIRA project.
   - Select **Create New** from the dropdown menu and in the resulting **Add A New Project** dialog box, type the following:
     1. A new project **Name**.
     2. A new project **Key**.
        - This will be used as the prefix for all issue IDs in your JIRA project.
     3. The **Project Lead**.

7. Click the **Next** button to proceed to the **Setup custom fields** step of the Trac Import Wizard.
   - This step will almost always appear because at least one Trac field is not likely match an existing JIRA field.

8. **Custom Fields:** If your Trac system contains any custom fields, you can either choose to import into an existing JIRA custom field or have the importer automatically create a new custom field in JIRA.

9. Regardless of whether you specify mapping, the importer will automatically create a JIRA custom field for each extra Trac field, unless you un-check the 'Create new custom fields' option on the final 'Import Data' screen (see Screenshot 2 below).

10. **Field Value Mappings:**
    - 'Priority' field — If you don't specify mappings, the importer will automatically create missing values in JIRA and will ensure that the issues are migrated with the correct priority.
    - **Usernames** — If you don't specify mapping, the importer will automatically map Trac usernames to JIRA usernames (lowercase).
      - Regardless of whether you specify mapping, JIRA will automatically create usernames for missing users.
    - 'Status' field — It is mandatory to map the Trac 'Status' field to specific values of the JIRA 'Status' field, as the JIRA 'Status' field is integral to JIRA workflow (to learn more, please see What is Workflow and Configuring Workflow).
    - 'Resolution' field — If you don't specify mapping, the importer will create corresponding Resolutions in JIRA instead of using the existing ones.
    - 'Maximum issues and failures' — If you wish, specify a maximum number of failed issues after which the importer will stop. If you want the import to continue regardless of any failures, leave this field blank. If your Trac instance has a large number of issues, it's generally a good idea to run first the importer on a limited number of issues (e.g. 100), then manually inspect the imported issues to confirm whether your configuration file was specified correctly. When the results are satisfactory, you can run the import with no limit.

11. The importer will display updates as the import progresses, then a success message when the import is complete. You can download the import log if you wish.

Congratulations, you have successfully imported your Trac projects into JIRA! If you have any questions or encounter any problems, please contact [Atlassian support](https://support.atlassian.com/

**Tips for importing Trac data into JIRA fields**

The import process converts Trac data as follows:

<table>
<thead>
<tr>
<th>In Trac</th>
<th>In JIRA</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Environment</td>
<td>Project</td>
<td>Each Trac Environment is imported as a JIRA project. You can either specify an existing JIRA project as the target, or the importer will automatically create a project for you at time of import.</td>
</tr>
<tr>
<td>Ticket Type</td>
<td>Issue Type</td>
<td>You can configure mapping of Trac Ticket Types to specific JIRA Issue Types.</td>
</tr>
<tr>
<td>Ticket #</td>
<td>External ID</td>
<td>The Trac Ticket number is captured in a JIRA custom field. The import is not designed to have the JIRA issue number match the Trac ticket number.</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
<td>You can configure mapping of specific Trac values to specific JIRA values.</td>
</tr>
<tr>
<td>Summary</td>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td><strong>Versions</strong></td>
<td><strong>Versions</strong></td>
<td>Versions are imported from Trac (if you choose), and are set to the Un-Released and Un-Archived state.</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Component</strong></td>
<td><strong>Components</strong></td>
<td>You can choose to have the importer automatically create your Trac components in JIRA, or choose to have bugs imported into no component in JIRA.</td>
</tr>
<tr>
<td><strong>Comments</strong></td>
<td><strong>Comments</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td><strong>Priority (or a custom field)</strong></td>
<td>You can choose to map one of either the Trac Priority field or the Trac Severity field (see below) to the built-in JIRA Priority field, and the other to a custom field. (Alternatively, you can choose to map both the Trac Priority field and the Trac Severity field to JIRA custom fields.) When importing into the JIRA Priority field, you can configure mapping of specific Trac values to specific JIRA values.</td>
</tr>
<tr>
<td><strong>Severity</strong></td>
<td><strong>Priority (or a custom field)</strong></td>
<td>You can choose to map one of either the Trac Priority field or the Trac Severity field (see below) to the built-in JIRA Priority field, and the other to a custom field. (Alternatively, you can choose to map both the Trac Priority field and the Trac Severity field to JIRA custom fields.) When importing into the JIRA Priority field, you can configure mapping of specific Trac values to specific JIRA values.</td>
</tr>
<tr>
<td><strong>Milestone</strong></td>
<td><strong>Milestone</strong></td>
<td>JIRA will create this as a custom field.</td>
</tr>
<tr>
<td><strong>Attachments</strong></td>
<td><strong>Attachments</strong></td>
<td>Attachments are extracted from the Trac Environment and saved to disk. To specify the location on disk, see Configuring File Attachments.</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td><strong>Resolution</strong></td>
<td>You can configure mapping of specific Trac values to specific JIRA values.</td>
</tr>
<tr>
<td><strong>CC</strong></td>
<td><strong>Watcher</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Keywords</strong></td>
<td><strong>Labels</strong></td>
<td></td>
</tr>
</tbody>
</table>
| **User** | **User** | The importer will automatically create JIRA users for any Trac users who do not exist in JIRA.  
- Passwords from Trac are not imported. Users from Trac will need to get their passwords emailed to them.  
- If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before commencing the import.  
- If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will be displayed showing a list of users that can't be created. |
| **Other fields** | **Custom fields** | If your Trac system contains any custom fields, you can choose to map them to specific JIRA custom fields. If your custom fields don't yet exist in JIRA, the importer can automatically create them for you. |

**Importing Data from CSV**

The JIRA Importers plugin, which is bundled with JIRA, allows you to import your data from a comma-separated value (CSV) file. CSV files are text files representing tabulated data and are supported by most applications that handle tabulated data (for e.g. Microsoft Excel, databases, etc.).

The CSV import feature allows you to import issues from an external (issue tracking) system which:

- JIRA does not provide a dedicated import tool for and  
- Can export its data in a structured/tabulated format (preferably CSV).

Our main website highlights some top reasons why people migrate from such an external issue tracking system to JIRA.

The CSV import process consists of:
Preparing your CSV file

Preparing your CSV file

The JIRA Importers plugin assumes that your CSV file is based off a default Microsoft Excel-styled CSV file. Fields are separated by commas and any content that must be treated literally, such as commas and new lines/’carriage returns’ themselves are enclosed in quotes.

**CSV file requirements**

In addition to being ‘well-formed’, CSV files have the following requirements.

*Each CSV file must possess a heading row with a Summary column*  
The CSV file import wizard (below) uses a CSV file’s header row to determine how to map data from the CSV file’s 2nd row and beyond to fields in JIRA.  
The header row should avoid containing any punctuation (apart from the commas separating each column) or the importer may not work correctly.  
The header row must contain a column for ‘Summary’ data.

*Commas (as column/field separators) cannot be omitted*  
For example, this is valid:

```plaintext
Summary, Assignee, Reporter, Issue Type, Description, Priority
"Test issue", admin, admin, 1, ,
```

... but this is not valid:

```plaintext
Summary, Assignee, Reporter, Issue Type, Description, Priority
"Test issue", admin, admin, 1
```

*Encapsulating JIRA data structure in your CSV file*  
Capturing data that spans multiple lines
Use double-quote marks (") in your CSV file to capture data that spans multiple lines. For example, upon import, JIRA will treat the following as a valid CSV file with a single record:

```
Summary, Description, Status
"Login fails", "This is on a new line", Open
```

**Treating special characters literally**

Use double-quote marks (") around a section of text to treat any special characters in that section literally. Once this data is imported into JIRA, these special characters will be stored as part of JIRA's field data. Examples of special characters include carriage returns/enter characters (as shown in the example above), commas, etc.

To treat a double quote mark literally, you can 'escape' them with another double quote mark character. Hence, the CSV value:

- "Clicking the "Add" button results in a page not found error"
- once imported, will be stored in JIRA as:
- Clicking the "Add" button results in a page not found error

**Aggregating multiple values into single JIRA fields**

You can import multiple values into a JIRA field that accepts multiple values (e.g. Fix (for) Version, Affects Version, Component, Labels). To do this, your CSV file must specify the same column name for each value you wish to aggregate into the mapped JIRA field. The number of column names specified must match the maximum number of values to be aggregated into the mapped field. For example:

```
IssueType, Summary, FixVersion, FixVersion, FixVersion, Component, Component
bug, "First issue", v1, , , Component1,
bug, "Second issue", v2, , Component1, Component2
bug, "Third issue", v1, v2, v3, Component1,
```

In the above example, the **Component** field of the second issue and the **Fix Version** field of the third issue will generate multiple values in appropriate JIRA fields upon import.

Be aware that only a limited number of JIRA fields support multiple values. The CSV importer will not allow you to import aggregated data into JIRA fields which only support a single value.

**Importing attachments**

You can attach files to issues created from your CSV file. To do this, specify the URL of your attachment in an 'Attachments' column within your CSV file.

```
Assignee, Summary, Description, Attachment, Comment
Admin, "Issue demonstrating the CSV attachment import", "Please check the attached image below.", "https://jira-server:8080/secure/attachment/image-name.png", "01/01/2012 10:10;Admin; This comment works"
Admin, "CSV attachment import with timestamp, author and filename", "Please check the attached image below.", "01/01/2012 13:10;Admin;image.png;file://image-name.png", "01/01/2012 10:10;Admin; This comment works"
```

URLs for attachments support the HTTP and HTTPS protocols and can be any location that your JIRA server must be able to access. You can also use the FILE protocol to access files in the import/attachments subdirectory of your JIRA Home Directory.

**Creating sub-tasks**

You can create sub-tasks of issues through a CSV file import, by encapsulating this structure in your CSV file.
To do this:

- Your CSV file requires two additional columns whose headings should be named similarly to Issue Id and Parent Id.
- Ensure each regular (non sub-task) issue is given a unique (sequential) number in the Issue Id column. Do not include any value in the Parent Id fields for regular issues.
- To create a sub-task of a regular issue in your CSV file, reference the unique Issue Id number of the regular issue in the Parent Id column. Do not include any value in the Issue Id fields for sub-tasks.

For example:

| IssueType, Summary, FixVersion, FixVersion, FixVersion, Component, Component, Issue Id, Parent Id, Reporter |
|-----------------------------------------------|--------------------------------------------------|--------------------------------------------------|--------------------------------------------------|--------------------------------------------------|--------------------------------------------------|--------------------------------------------------|--------------------------------------------------|--------------------------------------------------|--------------------------------------------------|
| Bug, "First issue", v1, , , Component1, , 1, , jbloggs                                             |
| Bug, "Second issue", v2, , , Component1, Component2, 2, , fferdinando                             |
| Bug, "Third issue", v1, v2, v3, Component1, Component2, 3, , fferdinando                          |
| Sub-task, "Fourth issue", v1, v2, , Component2, , 2, , jbloggs                                 |

In the example above, the fourth issue will be sub-task of the second issue upon import, assuming you match the 'Issue ID' and 'Parent ID' fields in your CSV file to the Issue Id and Parent Id JIRA fields, respectively during the CSV file import wizard.

Importing issues into multiple JIRA projects

You can import issues from your CSV file into different JIRA projects through a CSV file import. To do this:

- Your CSV file requires two additional columns whose headings should be named similarly to Project Name and Project Key.
- Ensure that every issue represented in your CSV file contains the appropriate name and key in these columns for the JIRA projects to which they will be imported.

The project name and key data is the minimum JIRA project data required for importing issues from a CSV file into specific JIRA projects.

| IssueType, Summary, Project Name, Project Key |
|-----------------------------------------------|--------------------------------------------------|--------------------------------------------------|
| bug, "First issue", Sample, SAMP                  |
| bug, "Second issue", Sample, SAMP                  |
| task, "Third issue", Example, EXAM                |

In the example above, the first and second issues will be imported into the 'Sample' project (with project key 'SAMP') and the third issue will be imported into the 'Example' project (with project key 'EXAM'), assuming you match the 'Project Name' and 'Project Key' fields in your CSV file to the Project name and Project key JIRA fields, respectively during the CSV file import wizard.

How to handle unresolved issues

For fields mapping to Resolution, Priority and Issue Type, you will get a select list with the available values in JIRA. In addition, you can quickly create values that do not exist in JIRA by clicking the green plus symbols.

For fields mapping to Status, you will get the select list with JIRA's available values, but no plus symbol for creating new status values.

For these four fields, there are two special options in the select list in addition to JIRA's available values:

- 'Import as blank' — this causes the JIRA value to be blank for that field. Note that, if you are importing Unresolved issues, you should create a field mapping for the Resolution field and set the value 'Unresolved' to 'Import as blank'.
- 'No mapping' — this attempts to import the value in the CSV file as-is. Note that using 'No mapping' for a field value will result in a failed import if the value is not valid for that JIRA field. For fields mapping to Status and Issue Type, default values are used when the 'Import as blank' option is selected.

Importing worklog entries

Your CSV file can contain worklog entries. For example:
To track time spent, you need to use seconds.

**Importing to multi select custom fields**

Your CSV file can contain multiple entries for the one Multi Select Custom Field. For example:

```
Summary,Multi Select,Multi Select,Multi Select
Sample issue,Value 1,Value 2,Value 3
```

This will populate the Multi Select Custom Field with multiple values.

**Importing cascading choice custom fields**

You can import values to a cascading choice custom field using the following syntax:

```
Summary, My Cascading Custom Field
Example Summary, Parent Value -> Child Value
```

The ‘->’ separator allows you to import the hierarchy.

**NOTE:** Currently JIRA does not support importing multi-level cascading select fields via CSV ([JIRA-34202](https://jira.atlassian.com/browse/JIRA-34202) - Allow CSV import to support Multi-Level Cascading Select fields [OPEN](https://jira.atlassian.com/browse/JIRA-34202)).

**Updating existing issues**

From version 4.3 of JIRA Importers plugin you can update existing issues. Your CSV file needs to contain a column that during the import wizard is mapped to Issue Key. If an issue exists for a given key it will be updated. For example:

```
issue key,summary,votes,labels,labels
TT-1,Original summary,1,label1,label2
TT-1,,7,label-1,label-2
TT-1,Changed summary,,
TT-2,Original summary 2,1,label-1,label-2
TT-2,<<!clear!>>,<<!clear!>>,<<!clear!>>,
```

First row will create an issue, second row will set votes to 7, and add two labels. Following row will change the summary. Issue TT-2 will be created with two labels, the second row will remove those labels with a special marker <<!clear!>>.

⚠️ Importing a CSV to update existing issues will **reset columns to their default values** if they are not specified in the CSV.

**Running the CSV file import wizard**

**Before you begin:** If your JIRA installation has existing data — Back up your existing JIRA data.

1. Log in to JIRA as a user with the JIRA Administrators global permission.
2. Select Administration > System > Import & Export > External System Import > Import button associated with the Comma-separated values (CSV) option to open the CSV File import page.
3. On the CSV File import page, select your CSV Source File. If you want to change the file's encoding and CSV delimiter format, click the Advanced heading to reveal this option (as shown in the above screenshot).

   **Note:**
   - The file will be imported using the File encoding you specify here (which is UTF-8 by default).
   - If your CSV file uses a different separator character other than a comma, specify that character in the CSV Delimiter field.

4. Leave the Use an existing configuration file check box cleared if you do not have a configuration file or if you want to create a new configuration file. Configuration files specify a mapping between column names in your CSV file's header row and fields in your JIRA installation.

   **Note:**
   - If you select this option, you will be asked to specify an Existing Configuration File.
   - If you do not select this option, then at the end of the CSV file import wizard, JIRA will create a configuration file which you can use for subsequent CSV imports (at this step of the CSV file import wizard).

5. Click the Next button to proceed to the Setup project mappings step of the CSV file import wizard.

6. On the Setup project mappings page, you can either import all your issues into either one JIRA project (new or existing), or multiple JIRA projects (by ensuring that your CSV file includes the minimum JIRA project data required — i.e. the JIRA project name and key). Complete the following fields/options:

<table>
<thead>
<tr>
<th>Import to JIRA Project</th>
<th>Choose either of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Select a project and then do either of the following:</td>
</tr>
<tr>
<td></td>
<td>• Start typing the name (or key) of a project that already exists in JIRA or use the dropdown menu to select an existing JIRA project.</td>
</tr>
<tr>
<td></td>
<td>• Select Create New from the dropdown menu and in the resulting Add A New Project dialog box, type the following:</td>
</tr>
<tr>
<td></td>
<td>a. A new project Name</td>
</tr>
<tr>
<td></td>
<td>b. A new project Key</td>
</tr>
<tr>
<td></td>
<td>c. The Project Lead.</td>
</tr>
<tr>
<td></td>
<td>• Defined in CSV. Ensure that every issue in your CSV file includes data for the JIRA Project Name and Project Key.</td>
</tr>
<tr>
<td></td>
<td>✔️ This option is useful if you want to import issues from your CSV file into multiple JIRA projects. See Importing issues into multiple JIRA projects for details.</td>
</tr>
</tbody>
</table>

| E-mail Suffix for New Users | Enter the email address domain for any new users specified in the CSV file which will be added to JIRA during the import. |

| Date format in import file | Specify the date format used in your CSV file. Use the syntax that complies with the Java SimpleDateFormat. |

7. Click the Next button to proceed to the Setup field mappings step of the CSV file import wizard.

8. On the Setup field mappings page, specify each CSV Field (determined by your CSV file's header row) you want to import into your chosen JIRA project by selecting their check boxes under the Import column on the left.

   **Please Note:**
   - At least one of these fields must contain data for JIRA's Summary field.
   - If your CSV file contains more than one of the same field name specified in its header row, the CSV file import wizard will aggregate these into a single field, which will be marked by a⚠️ symbol at this step of the wizard.

9. In the JIRA field column, select the JIRA fields you want to match to fields defined in your CSV file (i.e. each CSV Field you selected in the previous step). For more information about matching CSV fields to JIRA fields, see Tips for importing CSV data into JIRA fields below.

   **Please Note:**
   - The Summary field must be specified for one of your JIRA fields and the Next button will remain unavailable until you do so.
   - For CSV fields which have been aggregated by the CSV file import wizard, you will only be able to select JIRA Fields that support multiple values.
• If you are importing sub-tasks, remember to match the Issue ID and Parent ID fields in JIRA to those in your CSV file.
• If you are importing issues into multiple projects, ensure that you selected Defined in CSV during the Setup project mappings step above and remember to match the Project Name and Project Key fields in JIRA to those in your CSV file.

10. To modify the values of any fields' data in the CSV file before they are imported into JIRA, select the Map field value check boxes next to the appropriate fields.
11. Click the Next button to proceed to the Setup value mappings step of the CSV file import wizard.
12. On the Setup value mappings page, specify the JIRA field values for each CSV file field value (which has been detected by the CSV file import wizard).

Please Note:
• Any fields whose Map field value check boxes were selected in the previous step of the CSV file import wizard will be presented on this page.
• Leave a field cleared or clear any content within it if you wish to import the value ‘as is’.
• You can create new Priority, Resolution and Issue Type values in JIRA (i.e. based on the data in your CSV file) by clicking the Add new ... link (e.g. Add new issue type 'subtask' shown in the screenshot above) next to the appropriate field.
• If you are importing a username-based CSV field (e.g. Reporter or Assignee) and you do not select the Map field value check box for this field in the previous step of the CSV file import wizard, then the importer will automatically map imported usernames from the CSV file to (lowercase) JIRA usernames.
• Regardless of whether or not you select the Map field value check box, JIRA will automatically create usernames based on the data in your CSV file if they have not already been defined in JIRA.

13. Click the Begin Import button when you are ready to begin importing your CSV data into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.

Note:
• If you experience problems with the import (or you are curious), click the download a detailed log link to reveal detailed information about the CSV file import process.
• If you need to import another CSV file with the same (or similar) settings to what you used through this procedure, click the save the configuration link to download a CSV configuration file, which you can use at the first step of the CSV file import wizard.

Congratulations, you have successfully imported your CSV data into JIRA! If you have any questions or encounter any problems, please contact Atlassian support.

Tips for importing CSV data into JIRA fields

Below are some helpful tips when importing data from your CSV file into specific JIRA fields:

<table>
<thead>
<tr>
<th>JIRA Field</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>CSV data is imported on a per-project basis. You can either specify an existing JIRA project(s) as the target, or the importer will automatically create a new project(s) for you at time of import.</td>
</tr>
<tr>
<td>Summary</td>
<td>This is the only required field.</td>
</tr>
<tr>
<td>Issue Key</td>
<td>You can set the issue key for an imported issue. If an issue with a given key already exists in JIRA, it will be updated instead.</td>
</tr>
<tr>
<td>Component(s)</td>
<td>You can import issues with multiple components by entering each component in a separate column.</td>
</tr>
<tr>
<td>Affects Version(s)</td>
<td>You can import issues with multiple 'Affects Versions' by entering each version in a separate column.</td>
</tr>
<tr>
<td>Fix Version(s)</td>
<td>You can import issues with multiple 'Fix Versions' by entering each version in a separate column.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comment Body</td>
<td>You can import issues with multiple comments by entering each comment in a separate column.</td>
</tr>
<tr>
<td>Date Created</td>
<td>Please use the date format specified on the second step of the CSV import wizard.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>Please use the date format specified on the second step of the CSV import wizard.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Please use the date format specified on the second step of the CSV import wizard.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>If not specified in your CSV file, imported issues will be given the default (i.e. first) Issue Type as specified in your JIRA system. You can also create new JIRA values on-the-fly during the import process.</td>
</tr>
<tr>
<td>Labels</td>
<td>You can import issues with multiple labels by entering each label in a separate column.</td>
</tr>
<tr>
<td>Priority</td>
<td>If not specified in your CSV file, imported issues will be given the default (i.e. first) Priority as specified in your JIRA system. You can also create new JIRA values on-the-fly during the import process.</td>
</tr>
<tr>
<td>Resolution</td>
<td>If not specified in your CSV file, imported issues will be given the default (i.e. first) Resolution as specified in your JIRA system. You can also create new JIRA values on-the-fly during the import process.</td>
</tr>
<tr>
<td>Status</td>
<td>Can only be mapped to existing workflow statuses in JIRA. If not specified in your CSV file, imported issues will be given the default (i.e. first) Status as specified in your JIRA system.</td>
</tr>
<tr>
<td>Original Estimate</td>
<td>The value of this field needs to be specified as number of seconds.</td>
</tr>
<tr>
<td>Remaining Estimate</td>
<td>The value of this field needs to be specified as number of seconds.</td>
</tr>
<tr>
<td>Time Spent</td>
<td>The value of this field needs to be specified as number of seconds.</td>
</tr>
<tr>
<td>Users</td>
<td>You can choose to have the importer automatically create JIRA users for any values of the Assignee or Reporter field.</td>
</tr>
<tr>
<td></td>
<td>• Users will be created as active accounts in JIRA. Users will need to get their passwords emailed to them the first time they log into JIRA.</td>
</tr>
<tr>
<td></td>
<td>• Users with no real name will get the portion of their email address (login name) before the &quot;@&quot; character as their Full Name in JIRA.</td>
</tr>
<tr>
<td></td>
<td>• If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before commencing the import.</td>
</tr>
<tr>
<td></td>
<td>• If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will be displayed showing a list of users that can't be created.</td>
</tr>
<tr>
<td></td>
<td>• If Assignee and Reporter are not mapped, then no usernames are created.</td>
</tr>
<tr>
<td>Other fields</td>
<td>If you wish to import any other fields, you can choose to map them to specific JIRA custom field(s). If your custom fields don't yet exist in JIRA, the importer can automatically create them for you. If your custom field is a date field, please use the date format specified on the second step of the CSV import wizard.</td>
</tr>
</tbody>
</table>

### Commonly Asked CSV Questions and Known Issues

This page answers some of the commonly asked CSV questions our technical support staff have encountered. If you are not able to find an answer from this page and our issue tracker, feel free to create a support issue.
The importer fails at date fields, why?

If you are seeing error message similar to this:

```
[00:55:28] FAILED: Customfield value 01/Nov/06 12:00 AM is invalid
[00:55:28]
com.atlassian.jira.issue.customfields.impl.FieldValidationException: Invalid date format. Please enter the date in the format "MMM/dd/yy".
at com.atlassian.jira.issue.customfields.converters.DatePickerConverter.getTimestamp(DatePickerConverter.java:57)
at com.atlassian.jira.issue.customfields.impl.DateCFType.getSingularObjectFromString(DateCFType.java:46)
at com.atlassian.jira.imports.importer.impl.DefaultJiraDataImporter.importIssues(DefaultJiraDataImporter.java:531)
at com.atlassian.jira.imports.importer.impl.DefaultJiraDataImporter.doImport(DefaultJiraDataImporter.java:104)
at com.atlassian.jira.imports.importer.impl.ImporterThread.run(ImporterThread.java:21)
```

There are a few possible reasons:

- The format of dates is not correctly set in the import configuration file. The date format for custom fields must match the "Date format in input file" which has a default format of yyyyMMddHHmmss.
- JIRA system date fields such as Created, Updated and Due Date use "yyyy-MM-dd HH:mm:ss" but may need an offset adding.
- Date Picker and Date Time Picker formats are not consistent, e.g.

```
jira.date_picker.java.format=dd/MMM/yy
jira.date_time_picker.java.format=MMM/dd/yy hh:mm a
```

should be corrected to,

```
jira.date_picker.java.format=dd/MMM/yy
jira.date_time_picker.java.format=dd/MMM/yy hh:mm a
```

Why does the importer always ask me to map values to column (at Step 3 of 5)?

It is because you have selected Map Field Value for the particular columns. To use the values from the CSV, you need just to map the column to the Corresponding JIRA field, otherwise, select the Map field value checkbox.

Known Issues

- Why couldn't I import from cascading select fields?
  This is an open issue being tracked at JIM-231. Feel free to comment and vote on it.

- Why couldn't I import component/version Custom Fields?
  This issue is being tracked at JIM-233. Feel free to comment on it.

Known JBoss issue

There is a known problem that prevents the CSV Importer from being used with JIRA instances running on
JBoss 4.x. This is due to a compatibility issue between the JBoss 4.x commons-collections.jar and the JIRA commons-collections.jar. The workaround is to replace the commons-collections.jar in JBoss 4.x with the more recent JIRA version. Please see JRA-6473 for further details.

How to Import CSV Data with PVCS Command

The content on this page relates to platforms which are not supported for JIRA. Consequently, Atlassian can not guarantee providing any support for it. Please be aware that this material is provided for your information only and using it is done so at your own risk.

Importing from PVCS is not supported yet, but there is a feature request being tracked here. The above problem occurs when the pvcs command is not configured in the CSV configuration.

Resolution

In order to import the author of the comment and the date of the comment successfully, there are a few required conditions:

- Append the settings in the csv configuration file which you have saved the configuration through wizard

```settings.advanced.mapper.comment : com.atlassian.jira.imports.csv.mappers.PvcsComment```

- For the latest plugin version 2.6.1, please use the configuration below:

```settings.advanced.mapper.comment : com.atlassian.jira.plugins.importer.imports.csv.mappers.PvcsComment```

- Username (Example: eddie) must exists in JIRA
- The format of the comment should be as below:

"QA Note on Close: eddie: 4/28/2004 11:54:35 AM: Closing this defect as it is no longer relevant"

Importing Data from Redmine

The JIRA Redmine Importer plugin allows you to import data from the Redmine Issue Tracker product into your local JIRA site.

Version 5.0.2 or later of the JIRA Importers Plugin is compatible with Redmine versions 1.3.0+ and 2.0+.

Before you begin

Import your Redmine data

The JIRA Redmine Importer plugin provides a wizard that walks you through the process of importing data and integrating it with JIRA. To access the import wizard:

1. Log into JIRA as a user with the JIRA Administrators global permission.
2. Choose ➔ System. Select Import & Export > External System Import to open the Import external projects page.
   - Keyboard shortcut: g + g + start typing redmine
3. Select the Import button associated with the Redmine option.
4. Complete the fields as prompted in the wizard.
If you are importing your Redmine issues into an existing JIRA project, you must choose the JIRA workflow scheme used by that existing JIRA project when you are prompted to select the workflow scheme. Otherwise, your import may not complete successfully.

Please note that it is mandatory to map Redmine status field to a specific JIRA status field and Redmine tracker field to a JIRA issue type field since these JIRA fields are an integral part of JIRA workflows.

Tips for importing Redmine On Demand data into JIRA fields

The import process converts Redmine data as follows:

<table>
<thead>
<tr>
<th>In Redmine</th>
<th>In JIRA</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Project</td>
<td>Redmine data is imported on a per-project basis. You can either specify an existing JIRA project as the target, or the importer will automatically create a project(s) for you at time of import. (For more information about JIRA projects, please see Defining a project.)</td>
</tr>
<tr>
<td>Target</td>
<td>Affects Version</td>
<td>Redmine target version is mapped to JIRA &quot;affects version&quot;.</td>
</tr>
<tr>
<td>Version</td>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
<td>You can configure mapping of specific Redmine values to specific JIRA values.</td>
</tr>
<tr>
<td>Summary</td>
<td>Subject</td>
<td>Redmine subject is imported as the JIRA issue summary.</td>
</tr>
<tr>
<td>Worklog</td>
<td>Worklog</td>
<td>See Configuring Time Tracking.</td>
</tr>
<tr>
<td>Author</td>
<td>Reporter</td>
<td>Redmine issue author is mapped as JIRA Issue Reporter.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Attachments</td>
<td>Attachments are extracted from Redmine and saved. Information on the date the file was attached and the user who attached it is retained, as well. To specify the location where the attachments are stored, see Configuring File Attachments.</td>
</tr>
<tr>
<td>Tracker</td>
<td>Issue Type</td>
<td>You can configure the mapping of specific trackers to specific JIRA issue types.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
<td>You can configure the mapping of specific Redmine values to specific JIRA values.</td>
</tr>
</tbody>
</table>
| Status     | Status      | You can configure the mapping of specific Redmine values to specific JIRA values, provided you create your workflows in JIRA before running the importer.  
  - The JIRA status field is integral to JIRA workflow. To learn more, see What is Workflow.  
  - To create a JIRA workflow, see Configuring Workflow.  
  - To create a JIRA workflow scheme (which you can then associate with appropriate projects and Issue Types), see Activating workflow. |
| Category   | Component/s | This mapping is hard-coded and cannot be changed. |
The importer will automatically create JIRA users for any Redmine users who do not already exist in JIRA.

- Users who interacted with the Redmine system will be created as active accounts in JIRA. Other users will be imported into a special group called "redmine-import-unused-users" and will be deactivated.
- Passwords from Redmine are not imported. Users from Redmine must have their passwords emailed to them the first time they log into JIRA.
- If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before starting the import.
- If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will open and list the users that can't be created.

If your Redmine system contains any custom fields, you can choose to map them to specific JIRA custom field(s). If your custom fields don't yet exist in JIRA, the importer can automatically create them for you.

Importing Data from Bitbucket

The JIRA Bitbucket Importer plugin allows you to import data from Bitbucket into your local JIRA site.

Before you begin

Import your Bitbucket data

The JIRA Bitbucket Importer plugin provides a wizard that walks you through the process of importing data and integrating it with JIRA. After you've installed it, run the wizard to import your Bitbucket data:

1. Log into JIRA as a user with the JIRA Administrators global permission.
2. Choose > System. In the Import & Export section, select Bitbucket Import.
3. Complete the fields as prompted in the wizard. Depending on how your sites are configured, you might be redirected to Bitbucket in order to set the authorization needed to export data.

If you are importing Bitbucket issues into an existing JIRA project, you must choose the JIRA workflow scheme used by that existing JIRA project when you are prompted to select the workflow scheme. Otherwise, your import may not complete successfully.

In addition, you must map Bitbucket statuses to JIRA statuses in order for JIRA workflows to work with the issues.

Tips for importing Bitbucket data into JIRA fields

The import process converts Bitbucket data as follows:

<table>
<thead>
<tr>
<th>In Bitbucket</th>
<th>In JIRA</th>
<th>Import Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository</td>
<td>Project</td>
<td>Bitbucket data is imported on a per-project basis. You can either specify an existing JIRA project as the target, or the importer will automatically create one or more projects during the import. (For more information about JIRA projects, please see Defining a project.)</td>
</tr>
<tr>
<td>Title</td>
<td>Summary</td>
<td>Bitbucket subject is imported as the JIRA issue summary.</td>
</tr>
<tr>
<td>Worklog</td>
<td>Worklog</td>
<td>See Configuring Time Tracking.</td>
</tr>
<tr>
<td>Reporter</td>
<td>Reporter</td>
<td>Bitbucket issue author is mapped as JIRA Issue Reporter.</td>
</tr>
</tbody>
</table>
### Attachments

Attachments are extracted from Bitbucket and saved. Information on the date the file was attached and the user who attached it is retained, as well. To specify the location where the attachments are stored, see Configuring File Attachments.

<table>
<thead>
<tr>
<th>Kind</th>
<th>Issue Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
</tr>
</tbody>
</table>

- You can configure the mapping of specific kinds to specific JIRA issue types.
- You can configure the mapping of specific Bitbucket values to specific JIRA issue types.
- You can configure the mapping of specific Bitbucket values to specific JIRA values.
- The JIRA status field is integral to JIRA workflow. To learn more, see What is Workflow.
- To create a JIRA workflow, see Configuring Workflow.
- To create a JIRA workflow scheme (which you can then associate with appropriate projects and Issue Types), see Activating workflow.

### User

You can choose to have the importer automatically create JIRA users for any Bitbucket users who do not already exist in JIRA.

- Users who interacted with the Bitbucket system will be created as active accounts in JIRA. Other users will be imported into a special group called "bitbucket-import-unused-users" and will be deactivated.
- Passwords from Bitbucket are not imported. Users from Bitbucket must have their passwords emailed to them the first time they log into JIRA.
- If you are using External User Management, the import process will not be able to create JIRA users; instead, the importer will give you a list of any new users that need to be created. You will need to create the users in your external user repository before starting the import.
- If you have a user-limited license (e.g. personal license), and the number of required users is larger than the limit, then the import will be stopped. A page will open and list the users that can't be created.

### Importing Data from Github

The **JIRA Importers plugin**, which is bundled with JIRA, allows you to import data from **GitHub** by connecting to a live GitHub database.

The GitHub importer is compatible with JIRA 6.1 and above.

- Our main website highlights some top reasons why people **migrate from GitHub to JIRA**.

The GitHub import process consists of running the GitHub Import Wizard, which will step you through the process to connect to GitHub, and map and import your data to JIRA. The GitHub importer will connect to GitHub using your GitHub username and password (which you must provide) or with a **Personal Access Token**.

If you are using GitHub Enterprise, you will also have to provide your GitHub Enterprise URL (which you can obtain in GitHub under your Enterprise Settings). The GitHub importer will be able to access and import data from your personal and public repositories, and any other repositories that you have starred, so you should make sure you’ve starred any other repositories you want to import data from. You don’t have to select all your personal, public and starred repositories, the GitHub importer will display all repositories it can access and you can pick and choose which ones you want to import. If your GitHub instance has 2 factor authentication, you will be required to either provide the 6 digit access code that you will be sent, or a back-up code.

- If you have attachments in GitHub and you want to import these too, you must ensure you have **attachments enabled in JIRA**. Attachments are enabled by default.

### Running the GitHub Import Wizard

If your JIRA installation has existing data, then before you begin, **back up** your existing JIRA data.

1. Log in to JIRA as a user with the JIRA Administrators **global permission**.
2. Choose **⚙️ System**. Select **Import & Export > External System Import** to open the Import external
1. Start by clicking the projects page.

2. To create a new project, select Create New from the drop-down menu and in the resulting Add A New Project dialog box, type the following:
   a. A new project Name
   b. A new project Key
   c. The Project Lead

3. After selecting the Import button associated with the GitHub option to open the GitHub Import Wizard.

4. On the GitHub Setup page, select which type of GitHub you are using. If you are using GitHub Enterprise, you will also be required to provide your GitHub Enterprise URL. You also need to provide either your GitHub username and password, or a GitHub Personal Access Token. Note if you have used the GitHub import wizard before and saved a previous configuration file, you can select the configuration file here to speed up your import.

5. Click Next.
   - If you have 2 factor authentication on your GitHub account, you will be prompted to enter your 6 digit code now, and then click Next.

The Authentication page displays, verifying your authentication has been successful.

6. Click Next. The Map projects page displays, and will show a list of all your public and private repositories, as well as any repositories you have starred.

7. On the Map projects page, select the repositories you want to import data from, and where you want to import it to.
   - All GitHub projects are initially set to "Don’t import this project". To import a repository, you must either select an existing compatible project to import the data to, or create a new project.

8. Click Next. The Fetching Data page will display, updating you on the progress of your import.

9. The Labels page will display when your import has completed. As GitHub only uses labels, you can now map the labels to an issue type and/or a resolution. You do not have to map every label, and if you would like to create JIRA labels to correspond to the GitHub labels you have not mapped, ensure the “Add JIRA labels...” tick box is checked.

10. Click Next. The Workflow status mapping page displays, and allows you to select which workflow you wish to apply to your imported GitHub repository. You must also select what to map your GitHub open and closed issues to. The default is open to open and closed to closed, but you can select from the issue states available in your JIRA workflow.

11. Click Begin import.

12. Success! You have completed importing your GitHub data to JIRA. If there were any errors or warnings, these will be displayed to make you aware that you may need to check some details.

**Note:**
- If you experience problems with the import (or you are curious), click the download a detailed log link to reveal detailed information about the GitHub Import Wizard process.
- If you need to import data from another GitHub repository with the same (or similar) settings to what you used through this procedure, click the save the configuration link to download a GitHub configuration file (this will be a text file), which you can use at the first step of the GitHub Import Wizard.
- Before performing another import to the same project, you will want to remove the External issue ID field created in the previous import. Otherwise, the importer will associate existing imported issues with the next import, and will skip importing new issues up to the existing ID. For example, if you import 50 issues at first, they will be assigned IDs from 1 to 50. In the next imports, first 50 issues will be skipped, as their IDs will have already existed in JIRA.

Congratulations, you have successfully imported your GitHub repository data into JIRA! If you have any
Importing Data from JSON

Version 4.3 or later of the JIRA Importers plugin, which is bundled with JIRA, allows you to import data from a JSON (JavaScript Object Notation) file.

JSON files are easy to read and encapsulate more structure and information than CSV files.

The JSON import feature allows you to import issues from an external (issue tracking) system which:

- JIRA does not provide a dedicated import tool for and
- Can export its data in a JSON format.

You may also wish to prepare your JSON file manually.

⚠️ Please note that the import format used by the JIRA Importers plugin is more basic than the import format available when using the JIRA REST API.

Creating a JSON file for Import

If your current issue tracking system is unable to export in the JSON format, you may wish to create the file manually. To prepare the JSON file, you should use the standard JSON format, and follow the pattern detailed below.

```json
{
    "users": [
        {
            "name": "alice",
            "fullname": "Alice Foo"
        },
        {
            "name": "bob",
            "fullname": "Bob Bar"
        }
    ],
    "links": [
        {
            "name": "sub-task-link",
            "sourceId": "2",
            "destinationId": "1"
        },
        {
            "name": "Duplicate",
            "sourceId": "3",
            "destinationId": "2"
        }
    ],
    "projects": [
        {
            "name": "A Sample Project",
            "key": "ASM",
            "description": "JSON file description",
            "versions": [
```
{  
  "name": "1.0",
  "released": true,
  "releaseDate": "2012-08-31T15:59:02.161+0100"
},
{  
  "name": "2.0"
}

"components": [
  
  "Component",
  "AnotherComponent"
],
"issues": [
{  
  "priority": "Major",
  "description": "Some nice description here
Maybe _italics_ or *bold*?",
  "status": "Closed",
  "reporter": "alice",
  "labels": [  "impossible", "to", "test" ],
  "watchers": [  "bob" ],
  "issueType": "Bug",
  "resolution": "Resolved",
  "created": "2012-08-31T17:59:02.161+0100",
  "updated": "P-1D",
  "affectedVersions": [  "1.0" ],
  "summary": "My chore for today",
  "assignee": "bob",
  "fixedVersions": [  "1.0", "2.0" ],
  "components": [  "Component", "AnotherComponent" ],
  "externalId": "1",
  "history": [
    {  
      "author": "alice",
      "created": "2012-08-31T15:59:02.161+0100",
      "items": [
        {  
          "fieldType": "jira",
          "field": "status",
          "from": "1",
          "fromString": "Open",
          "to": "5",
          "toString": "Resolved"
        }
      ]
    }
  ],
  "customFieldValues": [
    {  
      "fieldName": "Story Points",
      "fieldType": "com.atlassian.jira.plugin.system.customfieldtypes:float",
      "value": "15"
    },
    {  
      "fieldName": "Business Value",
      "fieldType": "com.atlassian.jira.plugin.system.customfieldtypes:float",
      "value": "34"
    }
  ],
  "attachments": [  
  ]}


```json
{
    "name" : "battarang.jpg",
    "attacher" : "admin",
    "created" : "2012-08-31T17:59:02.161+0100",
    "description" : "This is optimus prime"
}
},
{
    "status" : "Open",
    "reporter" : "bob",
    "issueType" : "Sub-task",
    "created" : "P-3D",
    "updated" : "P-1D",
    "summary" : "Sub-task",
    "externalId" : "2"
},
{
    "status" : "Closed",
    "reporter" : "alice",
    "issueType" : "Sub-task",
    "created" : "P-3D",
    "updated" : "P-1D",
    "resolution" : "Duplicate",
    "summary" : "Duplicate Sub-task",
    "externalId" : "3"
}
]
Custom Fields

The JSON Importers plugin supports custom fields. Below is a list of custom fields that come bundled with JIRA. If you have installed any additional plugins that have custom fields, these fields will also be supported, however they are not included in this list.

**Bundled Custom Fields List**

1. com.atlassian.jira.plugin.system.customfieldtypes:textfield
2. com.atlassian.jira.plugin.system.customfieldtypes:textarea
3. com.atlassian.jira.plugin.system.customfieldtypes:datepicker
4. com.atlassian.jira.plugin.system.customfieldtypes:datetime
5. com.atlassian.jira.plugin.system.customfieldtypes:float
6. com.atlassian.jira.plugin.system.customfieldtypes:select
7. com.atlassian.jira.plugin.system.customfieldtypes:radiobuttons
8. com.atlassian.jira.plugin.system.customfieldtypes:project
9. com.atlassian.jira.plugin.system.customfieldtypes:multiversion
10. com.atlassian.jira.plugin.system.customfieldtypes:version
11. com.atlassian.jira.plugin.system.customfieldtypes:userpicker
12. com.atlassian.jira.plugin.system.customfieldtypes:url
13. com.atlassian.jira.plugin.system.customfieldtypes:multiselect
14. com.atlassian.jira.plugin.system.customfieldtypes:multicheckboxes
15. com.atlassian.jira.plugin.system.customfieldtypes:multusercontent
16. com.atlassian.jira.plugin.system.customfieldtypes:multigrouppicker
17. com.atlassian.jira.plugin.system.customfieldtypes:grouppicker
18. com.atlassian.jira.plugin.system.customfieldtypes:cascadingselect
19. com.atlassian.jira.plugin.system.customfieldtypes:readonlyfield
20. com.atlassian.jira.plugin.system.customfieldtypes:labels

The custom field example below shows some syntax for adding custom fields, including an example of a cascading custom field. If the custom field is not listed above, the "fieldType" can be obtained from the Custom Fields configuration page, by inspecting the source HTML. The "value" is specific to each custom field, and you can find this by inspecting the Edit Issue page's source HTML.
Custom Field Example

```json
"customFieldValues": [
    //Custom Fields which accepts single values:
    {
        "fieldName": "My Awesome Text Field (single line)",
        "fieldType": "com.atlassian.jira.plugin.system.customfieldtypes:textfield",
        "value": "some text"
    },
    {
        "fieldName": "My Awesome Select List (single choice)",
        "fieldType": "com.atlassian.jira.plugin.system.customfieldtypes:select",
        "value": "some select"
    },
    //Custom Fields which accepts multiple values:
    {
        "fieldName": "My Awesome Checkboxes",
        "fieldType": "com.atlassian.jira.plugin.system.customfieldtypes:multicheckboxes",
        "value": [ "multiple", "checkboxes" ]
    },
    {
        "fieldName": "My Awesome User Picker (multiple users)",
        "fieldType": "com.atlassian.jira.plugin.system.customfieldtypes:multiuserpicker",
        "value": [ "admin", "fred" ]
    },
    //Custom Fields which accepts Options in hierarchy. That's only cascading select from standard JIRA pool.
    {
        "fieldName": "My Awesome Select List (cascading)",
        "fieldType": "com.atlassian.jira.plugin.system.customfieldtypes:cascadingselect",
        "value": {
            "": "Parent Value",
            "1": "Child Value"
        }
    }
]
```

Specific JSON File Examples

Further specific JSON file examples include:

<table>
<thead>
<tr>
<th>Supported Field</th>
<th>Notes</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Users

This example covers a full user. In this example, two groups have been specified. If a group does not exist already, the JIRA Importers plugin will create it.

```json
"users": [  
    {  
      "name": "someuser",  
      "groups": [ "jira-users",  
        "my-custom-group" ],  
      "active": true,  
      "email": "user1@example.com",  
      "fullname": "User 1"  
    }  
]
```

### Project Key and Issue Key

You can assign a key to both the project and the issue. These keys can be different. This example will create a project with one issue, "SAM-123".

```json
{  
  "projects": [  
    {  
      "name": "Sample data",  
      "key": "SAM",  
      "issues": [  
        {  
          "key": "SAM-123",  
          "status": "Open",  
          "reporter": "admin",  
          "summary": "Parent case",  
          "externalId": "123"  
        }  
      ]  
    }  
  ]
}
This example shows how you can import multiple comments for an issue.

```
{
  "projects": [
    {
      "name": "Sample data",
      "key": "SAM",
      "issues": [
        {
          "status": "Open",
          "reporter": "admin",
          "summary": "Parent case",
          "externalId": "1",
          "comments": [
            {
              "body": "This is a comment from admin 5 days ago",
              "author": "admin",
              "created": "2012-08-31T17:59:02.161+0100"
            },
            {
              "body": "This is a comment from admin 1 day ago",
              "author": "admin",
              "created": "2012-08-31T17:59:02.161+0100"
            }
          ]
        }
      ]
    }
  ]
}
```
**Worklogs**

This example shows the syntax to import worklog detail.

```json
"worklogs": [
  {
    "author": "admin",
    "comment": "Worklog",
    "startDate": "2012-08-31T17:59:02.161+0100",
    "timeSpent": "PT1M"
  },
  {
    "author": "admin",
    "startDate": "2012-08-31T17:59:02.161+0100",
    "timeSpent": "PT3H"
  }
]
```

**Component**

Components can be specified in a JSON file in two ways, by providing a name, or by providing an object. This example shows both. The JIRA Importers plugin will always create a new component with "Default Assignee" switched to "Project Default", as you are unable to specify a "Default Assignee".

```json
"components": [
  "Component", //Component specified only by name
  { // Component specified by object
    "name": "SomeName",
    "lead": "admin",
    "description": "Some description"
  }
]
```
Issues with Time Tracking

Time Tracking detail can be imported with an issue. This example shows you an issue with Time Tracking detail. The "original Estimate", "timeSpent", and "estimate" values must be in Period format (Format ISO_8601 - Durations). The "startDate" value accepts both the DateTime and Period format.

Please ensure Time Tracking is enabled in JIRA before you start your import, otherwise the data will be ignored by the JIRA Importers plugin during the import.

**Issues with Time Tracking**

```
{"issues": [
  {
    "summary": "My Example Time Tracking issue",
    "externalId": "1",
    "originalEstimate": "P1W3D",
    "timeSpent": "PT4H",
    "estimate": "P2D",
    "worklogs": [
      {
        "author": "admin",
        "comment": "Worklog",
        "startDate": "P-1D", //can be a Period or DateTime
        "timeSpent": "PT1M"
      },
      {
        "author": "admin",
        "startDate": "2014-01-14T17:00:00.000+0100",
        "timeSpent": "PT3H"
      }
    ]
  }
]}
```

Dates can be represented in SimpleDateFormat "yyyy-MM-dd'T'HH:mm:ss.SSSZ" (example output: "2012-08-31T15:59:02.161+0100") or you can use relative dates like "P-1D" (which means one day ago).

Running the JSON File Import Wizard

**Before you begin:** If your JIRA installation has existing data — **Back up** your existing JIRA data.

1. Log in to JIRA as as a user with the JIRA Administrators global permission.
2. Choose ➤ > System. Select Import & Export > External System Import to open the Import external projects page.
   - **Keyboard shortcut:** `g + g + start typing external system import`
3. Select the import from JSON button associated with the JSON option to open the JSON File import page.
5. Click the **Begin Import** button when you are ready to begin importing your JSON file into JIRA. The importer will display updates as the import progresses, then a success message when the import is complete.

**Note:** If you experience problems with the import (or you are just curious), click the **download a detailed log** link to view detailed information about the JSON file import process. This information can also be useful if you
encounter any errors with your import.

Congratulations! You have successfully imported your JSON projects into JIRA! If you have any questions or encounter any errors, please contact Atlassian support.

Moving or Archiving Individual Projects

Over time, your organisation's requirements may change. This can lead to needing to:

- Archive a completed or obsolete project.
- Split a large JIRA instance into several JIRA instances, with particular projects in each.
- Restore a single project from a backup file into a JIRA instance.
- Restore an entire JIRA instance, from a backup into a new empty JIRA instance.

Archiving a Project

It is sometimes necessary to archive an old project, while retaining the project's data for future auditing purposes. There are a number of ways to achieve this:

- **Online archiving**
  - 'Hiding' a project
  - Making a project 'Read-Only'
  - Accessing an archived online project

- **Offline archiving**
  - Archiving a project offline
  - Accessing an archived offline project
  - Restoring a deleted project

**Online archiving**

Archiving a project online means keeping all of the project's issue data in your live JIRA instance. The advantage of archiving a project online is that you can easily make the project accessible again if required.

There are two ways to archive a project online:

- **'Hiding' a project**
  A 'hidden' project will still be visible via the 'Administration' menu, but it will no longer appear in the 'Browse Projects' list, and no-one will be able to search, view or modify any of the project's issues.

  1. Create a new permission scheme. Leave all of the permissions empty.
  2. Associate the new permission scheme with the project that you wish to hide (see Assigning a Permission Scheme to a Project).

- **Making a project 'Read-Only'**
  If you make a project read-only, the project will be visible via the 'Administration' menu, and will appear in the 'Browse Projects' list. The project's issues will be searchable and viewable, but no one will be able to modify them.

  1. Create a new permission scheme. Grant the 'Browse Project' permission to everyone who needs to be able to search or browse the project, or view its issues. Leave all of the other permissions empty.
  2. Associate the new permission scheme with the project that you wish to hide (see Assigning a Permission Scheme to a Project).

  3. To prevent workflow transitions from happening you will need to update the workflow and add a condition to each transition. The conditions should check that a user has the Edit Issues permission.

**Accessing an archived online project**

If you archived a project online, by hiding it or making it read-only, then all of the project's data can be made accessible very easily. Simply associate the project with a permission scheme where the appropriate permissions (e.g. 'Edit Issue', 'Assign Issue', 'Resolve Issue', etc) are assigned to the appropriate people.

**Offline archiving**
Archiving a project offline means creating an XML backup, then deleting the project and all of its issue data from your live JIRA instance. The project will no longer be available via the 'Administration' menu or the 'Browse Projects' list, and its issues will no longer exist in your live JIRA system.

The disadvantage of offline archiving is that there is no easy way to restore a deleted project to your live JIRA instance.

If there is a possibility that you will need to restore the project into your live JIRA instance at some point in the future, then online archiving is recommended. Offline archiving should only be done if you are certain you will never need to restore this project to a live JIRA instance (i.e. you will only ever restore the data to a non-production instance).

**Archiving a project offline**

1. Create a global XML backup of your entire live JIRA instance.
2. Import the XML backup into a test JIRA instance. Make sure that the test JIRA instance uses a separate database from your live JIRA instance, as the import will overwrite all data in the database.
3. In your test JIRA instance, verify that you can view the issues of the project that you are archiving.
4. In your live JIRA instance, select Projects from the Administration menu, then click the Delete link to delete the project and all of its issues. Please note that deleting the Project will result in all the attachments also getting deleted from the JIRA A Home Directory. Please ensure that the attachments are copied to the test instance before deleting the project.

**Accessing an archived offline project**

1. Import the XML backup into a test JIRA instance. Make sure that the test JIRA instance uses a separate database from your live JIRA instance, as the import will overwrite all data in the database.

**Restoring a deleted project**

() If you wish to restore a project from a backup file, please refer to the instructions in the Restoring a Project from Backup documentation. Note that the JIRA version and database type must be consistent with when the archive was created.

**Archiving issues**

Archiving issues is also possible. The basic method would be to filter for issues that you want to archive then bulk move them into a separate project which can then be archived by using one of the methods above.

**Splitting a JIRA instance**

Occasionally an organisation may need to split its existing JIRA instance into two separate instances. For example, there might be a requirement to have some particular projects in one JIRA instance, and other projects in a second instance.

**Note**

This process requires two separate server licenses.

**To split a JIRA instance:**

1. Back up your database, using your database backup procedures, and verify the backup.
2. Back up your attachments directory and verify the backup.
3. Install JIRA on your new server.

**Please Note:**

- The JIRA version number on your new server must be the same as (or higher than) the version number on your existing server.
- Do not use the same JIRA Home Directory for the two JIRA instances. Specify a new JIRA home directory for the JIRA on your new server.
- Do not connect the two JIRA instances to the same external database instance.
4. Create an XML backup from your existing JIRA server, as described in Backing up data.
5. Import the XML backup file into your new server, as described in Restoring data.
6. Copy the attachments directory from your existing server to your new server, and configure your new server to use its own directory (for details please see Enabling File Attachments).
7. At this point you should have two JIRA instances with the same users, projects, issues and attachments. Log in to both instances and perform some random searches to verify that the data is identical in both instances.
8. Delete the non-required projects from each JIRA instance.
9. Generate new Server ID for the newly installed JIRA instance as described in the article Changing Server ID. This step is needed if you plan to create Application Links between the JIRA instances.

**Integrating JIRA with Code Development Tools**

If you connect JIRA to a compatible development tool, JIRA will provide you with a range of functionality and information related to your development work.

**Features**

These are the features that you will enable, if you connect JIRA to the development tools listed below. We recommend that you use the latest version of each application. If you are not using the latest versions, see the version matrix to find out which features are available.

<table>
<thead>
<tr>
<th>Development panel on issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Development panel is shown on the View Issue screen that provides the following functionality:</td>
</tr>
<tr>
<td>• <strong>Bitbucket or Stash</strong>: view and create branches, view and create pull requests, view commits</td>
</tr>
<tr>
<td>• <strong>FishEye/Crucible</strong>: view commits, view branches, view and create reviews</td>
</tr>
<tr>
<td>• <strong>Bamboo</strong>: view the status of builds and deployments</td>
</tr>
<tr>
<td>• GitHub or GitHub Enterprise: view commits, branches and pull requests</td>
</tr>
</tbody>
</table>

For more information about using the Development panel, see Streamlining your development with JIRA.

**Making it work**

Check that you have a compatible version of a development tool on the version matrix, then follow the relevant instructions below to connect your code development tool to JIRA.

**Connecting Bitbucket, GitHub or GitHub Enterprise to JIRA**

Connections to Bitbucket, GitHub and GitHub Enterprise are done via the DVCS connector add-on that is bundled with JIRA.

• Follow the instructions on Linking Bitbucket and GitHub accounts to JIRA to set up the connection.

**Connecting Stash, FishEye, Crucible or Bamboo to JIRA**

Connections to Stash, FishEye/Crucible and Bamboo use application links.

• When you create a new application link between JIRA and an instance of Stash, FishEye, Crucible or Bamboo, 2-legged (2LO) and 3-legged OAuth (3LO) are enabled by default. 2LO is required for information from any of those applications to be included in the summaries in the Development panel; 3LO checks that a user has authenticated with the other applications before they get to see the information in any of the details dialogs.
If you are upgrading from existing instances of JIRA, Stash, FishEye, Crucible or Bamboo:

You may need to reconfigure the application link(s) between JIRA and the other applications. To enable the integration features, each application link must use 2-legged OAuth for both incoming and outgoing authentication.

1. Choose > Add-ons. Select Application Links in the left menu.
2. Choose Edit for the application link.
3. On the Outgoing Authentication tab, click OAuth. Ensure that Allow 2-legged OAuth is checked. Repeat for the Incoming Authentication tab. The application link update process will involve logging you into the other application for a short time to configure that end of the link, before returning you to JIRA.

Connecting other code development tools to JIRA

You can connect tools to JIRA, other than the ones listed on the version matrix. These tools do not enable the same integration features, but connecting them to JIRA does enable other functionality. See the pages below for instructions on how to connect these applications to JIRA and information about the functionality that is enabled.

- Integrating JIRA with FishEye (older versions, not on version matrix)
- Integrating JIRA with Stash (older versions, not on version matrix)
- Integrating JIRA with Bamboo (older versions, not on version matrix)
- Integrating JIRA with Subversion
- Integrating JIRA with Perforce

If your other applications are running on the same machine as JIRA (already installed), you need to ensure that the URL paths are different for the applications and JIRA. This will differentiate the applications and avoid authentication/session issues with OAuth and Application Links. For example, if you were running FishEye and JIRA, you would change the default paths to:

http://localhost:8080/

This can be done for FishEye/Crucible as follows:

1. Edit the config.xml in your FishEye/Crucible data directory.
2. Add the context attribute to the web-server element:

   `<web-server context="/fisheye">`

Troubleshooting

- JIRA Development panel displays error even though other app is of correct version

Version matrix for code development tools

Oops, this page should redirect to Installing Atlassian Tools for Integration with JIRA.

Integrating JIRA with Stash

Atlassian Stash is the on-premises Git repository management solution for enterprise teams. It allows everyone in your organisation to easily collaborate on your Git repositories.

If you integrate Stash with JIRA, you will enable the following features:

- See the related branch, commit and pull request information in a JIRA issue (or commits on the Source tab for older Stash versions)
- Create Git branches from within JIRA and JIRA Agile
- Transition JIRA issues from within Stash
Use JIRA issue keys in Stash markdown
See the details for JIRA issues in Stash
See, in Stash, the JIRA issues related to Stash commits and pull requests

Making it work

The procedure for connecting Stash to JIRA is described on Integrating JIRA with Code Development Tools. For additional information, see the Stash documentation:

- **JIRA integration**

**Integrating JIRA with Bamboo**

Atlassian Bamboo continuous integration capabilities can be combined with JIRA to give you a unified view of your software development project. If you integrate Bamboo with JIRA, you will enable the following features:

- The Development panel on issues (or Builds tab for older Bamboo versions)
- Browse a project's Bamboo builds
- Browse a version's Bamboo builds
- Trigger Bamboo builds when releasing a JIRA version
- View deployments in JIRA
- Gadgets for your JIRA dashboards: Bamboo Charts, Bamboo Plan Summary, Bamboo Plans

Making it work

The procedure for connecting Bamboo to JIRA is described on Integrating with Code Development Tools. For additional information, see the Bamboo documentation:

- **Integrating Bamboo with JIRA**

**Integrating JIRA with FishEye**

Atlassian FishEye allows you to track in JIRA the source code and changesets that correspond to your stories in JIRA, when you are using FishEye with your source-control repository. Integrating JIRA with Atlassian's Crucible allows you to view information about your code reviews in JIRA.

If you integrate FishEye/Crucible with JIRA, you will enable the following features:

- The Development panel on issues (or Source tab for older FishEye versions/Reviews tab for older Crucible versions)
- Browse a Project's FishEye changesets
- Browse a Project's Crucible reviews
- Gadgets for your JIRA dashboards: FishEye Charts, FishEye Recent Changesets, Crucible Charts

Starting in JIRA 6.2.2 the Source and Reviews tabs are only displayed if JIRA is unable to display the associated information in the Development Tools panel.

Making it work

The procedure for connecting FishEye/Crucible to JIRA is described on Integrating with Code Development Tools. For additional information, see the FishEye and Crucible documentation:

- Linking FishEye to JIRA / JIRA Integration in FishEye
- Linking Crucible to JIRA / JIRA Integration in Crucible

**Integrating JIRA with Subversion**
JIRA’s Subversion integration lets you see Subversion commit information relevant to each issue. Subversion integration can be implemented either by using Atlassian FishEye or the Subversion add-on. The FishEye integration offers greater scalability, insight and flexibility into your source code and related integration with JIRA, however both solutions allow you to link JIRA to related code changes in Subversion.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>User</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>#11</td>
<td>Fri Nov 12 17:30:39 EST 2004</td>
<td>Mike</td>
<td>Big, very exciting commit for TEST-3! Files Changed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADD trunk/moved.txt (from/trunk/copiedocument.txt #10)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DEL trunk/copiedocument.txt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADD trunk/NewFile.java</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DEL trunk/mydocument.txt</td>
</tr>
</tbody>
</table>

Commits will appear in this tab if the commit log mentions the issue key (‘TEST-3’ above).

Integrating JIRA with Perforce
Perforce is supported by Atlassian FishEye, providing comprehensive integration with JIRA including real-time notifications of code changes plus web-based reporting, visualisation, search and code sharing. For details, please see Integrating JIRA with FishEye.

The original Perforce Plugin for JIRA is deprecated and has been superseded by the JIRA FishEye Plugin, which is included with JIRA and provides Perforce integration (see the documentation).

Configuring Global Settings
- Configuring Time Tracking
- Configuring JIRA Options
- Setting Properties and Options on Startup
- Recognized System Properties for JIRA
- Advanced JIRA Configuration
  - Changing the constraints on historical time parameters in gadgets
  - Changing the Default Order for Comments from Ascending to Descending
  - Limiting the number of issues returned from a search view such as an RSS feed
- Configuring File Attachments
- Configuring Issue Cloning
- Configuring Issue Linking
- Configuring the Whitelist
- Configuring Sub-tasks
- Managing Shared Filters
- Managing Shared Dashboards
- Linking to Another Application

Configuring Time Tracking
JIRA’s Time Tracking feature enables users to record the time they spend working on issues (see Logging Work on an Issue).

⚠️ Note: Before users can specify time estimates and log work, they must be granted the Work On Issues permission for the relevant project(s).

Disabling Time Tracking
Time Tracking is ON by default (as shown in screenshot 1 below). However, this feature can be disabled from the Time Tracking administration page.

Time tracking will be OFF by default if your JIRA installation was upgraded from a version prior to 4.2 that had time tracking either disabled or never enabled.

To disable Time Tracking:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System. Select Issue Features > Time Tracking to open the Time Tracking page.
3. Click the 'Deactivate' button to turn Time Tracking OFF.

You will not lose any existing Time Tracking data by disabling/re-enabling Time Tracking.

To enable Time Tracking:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System. Select Issue Features > Time Tracking to open the Time Tracking page.
3. Click the 'Activate' button to turn time tracking ON.

Time tracking add-ons for JIRA in the Atlassian Marketplace extend JIRA’s time tracking power. Check them out here.
Configuring Time Tracking Settings

To edit JIRA’s **Time Tracking** settings, it must first be disabled. Once you have changed the settings, you will then need to re-enable Time Tracking so that users can log work on issues.

ℹ️ You will not lose any existing Time Tracking data by disabling/re-enabling Time Tracking.

**To configure Time Tracking settings:**

1. Log in as a user with the [JIRA Administrators global permission](https://confluence.atlassian.com/display/JIRA/Administrators+Global+Permission).
2. Choose **Environment** > **System**. Select **Issue Features** > **Time Tracking** to open the Time Tracking page. **Keyboard shortcut:** ‘g’ + ‘g’ + type ‘time t’
3. If Time Tracking is ON (refer to the indication at the top of the **Time Tracking** screen), click the ‘Deactivate’ button to turn Time Tracking OFF.
4. The Time Tracking settings will now be editable as shown in the following screenshot.

   ![Screenshot 2: Time Tracking is OFF](image)
Configure Time Tracking settings by editing the following fields:

- **'Hours per day'** — enter a suitable value (e.g. 8). You can enter fractions if you wish.
- **'Days per week'** — enter a suitable value (e.g. 5). You can enter fractions if you wish.
- **'Time format'** — select `pretty/days/hours`. This will determine the format of the 'Time Spent' field when an issue is displayed.
- **'Default Unit'** — select `minutes/hours/days/weeks`. This will be applied whenever your users log work on an issue without specifying a unit.
- **'Legacy Mode'** — select this check box if you prefer to use JIRA's time tracking features as they operated prior to JIRA version 4.2. For more details about this option, please see About 'Legacy Mode' (below).
- **'Copy Comment To Work Description'** — select this check box to ensure that any content entered into a Comment field while logging work as part of an issue operation, is also copied across to the Work Description.

When 'Copy Comment To Work Description' is enabled, your user's work log entries will be visible only to members of the project role or group selected in the padlock icon dropdown on their issue operation screen. If 'Copy Comment To Work Description' is disabled, your user's work log entries will be visible to anyone by default.

6. Click the 'Activate' button to turn time tracking ON.
   If the permission schemes used by your project(s) already have the appropriate Work On Issues permissions, then there is no need to proceed any further. However, if you need to configure these permissions, proceed with the remaining steps below:

7. Click the 'permission scheme' link as shown in screenshot 1 (above). The 'Permissions Scheme' page will be displayed.

8. Click the 'Permissions' link of the permission scheme associated with the project(s) where you wish to specify Work On Issues permissions. The 'Edit Permissions' page is displayed for your chosen permission scheme.

See Managing Project Permissions for details about the various permissions.

9. Check whether the row labelled 'Work On Issues' contains the appropriate users, groups or project roles who need to specify time estimates or log work. If it does not, click the 'Add' link in the 'Operations' column:

   **Screenshot 3: Time Tracking Permissions**

10. Select the users, groups or project roles to whom you want to allow time tracking and work logging on
issues.
11. Click the 'Add' button.
12. If it is needed to enter the 'Original Estimate' during issue creation or during issue editing, ensure that the field 'Time Tracking' is added to the relevant screens associated with those operations. Refer Associating a Screen with an Issue Operation for more details.

About 'Legacy Mode'

- If Legacy Mode is disabled, your users will be able to change the Original Estimate value irrespective of any work being logged on an issue. Legacy Mode is disabled by default on new installations of JIRA version 4.2 or later.
- If Legacy Mode is enabled, your users can only specify an Original Estimate before they start logging work on an issue. This value cannot be changed once any work has been logged, unless all work logs for that issue are first deleted.
- By default,
  - Legacy Mode is disabled if your JIRA 4.2 installation was conducted cleanly (that is, without upgrading from an earlier version of JIRA).
  - Legacy Mode is enabled if you upgraded JIRA from a version prior to 4.2.
- With Legacy Mode enabled, if you change the Remaining Estimate field in a workflow post function the Original Estimate is also cleared. This issue is tracked at [JIRA-25031 - Time Tracking Legacy Mode and Workflow Post Functions Error](https://issues.atlassian.com/browse/JIRA-25031)
- Please refer to the Logging Work on an Issue and the JIRA 4.2 Release Notes for more information about logging work and modifying time estimates.

Related Topics

- Please see the section Adding Time Tracking capabilities to a screen on the Defining a Screen page.

Configuring JIRA Options

JIRA has a number of configuration options that allow your JIRA server to be customized for use within your organization. These options can be accessed and edited on JIRA's 'General Configuration' page.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing JIRA's General Configuration</td>
</tr>
<tr>
<td>General Settings</td>
</tr>
<tr>
<td>Internationalization</td>
</tr>
<tr>
<td>Options</td>
</tr>
</tbody>
</table>

Editing JIRA's General Configuration

To access and edit options on the 'General Configuration' page:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System. Select General Configuration to open the Administration page.
3. Scroll to the end of the page and click the Edit Configuration button to edit the three sections as described below:
   - Settings
   - Internationalization
   - Options

The Advanced Settings button is only visible if you have the JIRA System Administrators global permission.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>This is the title that will be displayed on the JIRA login page and the dashboard. It helps identify your installation and its purpose.</td>
</tr>
<tr>
<td></td>
<td>! Also see logo, which is displayed on every JIRA page.</td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td>JIRA can operate in two modes:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Public</strong> — Anyone can sign themselves up with self-registration and create issues (within the bounds of your JIRA system's permissions).</td>
</tr>
<tr>
<td></td>
<td>- <strong>Private</strong> — Useful for internal issue-tracking systems where you do not want public users to login. Self-signup is disabled; only Administrators can create new users.</td>
</tr>
<tr>
<td>Default: <strong>Public</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Maximum</strong></td>
<td>The maximum authentication attempts that are allowed before CAPTCHA is shown to a user. If you leave it blank then CAPTCHA will never be shown and users will have unlimited authentication attempts. It is recommended that you set this to a small number (e.g. below 5).</td>
</tr>
<tr>
<td><strong>Authentication</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Attempts Allowed</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Default:</strong></td>
<td><strong>3</strong> (for new installations of JIRA)</td>
</tr>
<tr>
<td><strong>CAPTCHA on signup</strong></td>
<td>If you are running JIRA in Public mode (see above), it is strongly recommended that you enable CAPTCHA. This will show a CAPTCHA image on signup to prevent spambots from signing up.</td>
</tr>
<tr>
<td>Default: <strong>ON</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Base URL</strong></td>
<td>The base URL of this JIRA installation. You can only configure JIRA to respond to a single URL and this setting must match the URL that your users request for accessing your JIRA site. You cannot (for example) have a different hostname or URL for internal and external users. This is especially important for JIRA 4.0.x or higher, as any mismatch between this Base URL setting and the URL requested by your JIRA users will cause problems with dashboard gadgets. This URL is also used in outgoing email notifications as the prefix for links to JIRA issues.</td>
</tr>
<tr>
<td><strong>Email from</strong></td>
<td>Specifies the From: header format in notification emails. Default is of the form &quot;John Doe (JIRA) <a href="mailto:jira@company.com">jira@company.com</a>&quot;. Available variables are '${fullname}', '${email}' and '${email.hostname}'. Note that the actual address (e.g. '<a href="mailto:jira@company.com">jira@company.com</a>') cannot be specified here.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Introduction</strong></td>
<td>A short introduction message displayed on the dashboard. ! Also see the announcement banner, which is displayed on every JIRA page. You can include HTML, but ensure all tags are correctly closed.</td>
</tr>
</tbody>
</table>

### Internationalization

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Indexing</strong></td>
<td>JIRA uses Lucene, a high-performance text search engine library, in full-text searches for issues stored in JIRA. This option is designed to enhance JIRA's search indexing and issue searching features for issues entered in the languages available in this list. Hence, choose the language that matches the language used in your issues.</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Setting</strong></td>
<td>Choosing a specific language in this list has the following effects when conducting searches in JIRA (with respect to your chosen language):</td>
</tr>
<tr>
<td></td>
<td>• Reserved words in text fields will not be indexed.</td>
</tr>
<tr>
<td></td>
<td>• Stemming of words in all JIRA fields will be active.</td>
</tr>
<tr>
<td></td>
<td>If multiple languages are used in your issues (or you wish to disable the two effects above), choose Other.</td>
</tr>
<tr>
<td></td>
<td>! You will need to re-index JIRA if you change this value.</td>
</tr>
<tr>
<td><strong>Installed</strong></td>
<td>This section lists all language packs available within the JIRA system.</td>
</tr>
<tr>
<td><strong>languages</strong></td>
<td></td>
</tr>
</tbody>
</table>
Default language | The language used throughout the JIRA interface (as selected from the list displayed in Installed Languages above). Users can override the default language by using the Language setting in their user profile.
---|---
Default user time zone | This is the time zone used throughout the JIRA interface. Users can override the default time zone by using the Time Zone setting in their user profile. (To choose the time format see Configuring the Layout and Design.) Date fields, which have no time component, such as due dates, release dates (associated with versions) and custom date fields, solely record date information (and no time zone-related information) so are not affected by time zone settings.

### Options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow users to vote on issues</td>
<td>Controls whether voting is enabled in JIRA. Voting allows users to indicate a preference for issues they would like to be completed or resolved. See also the 'View Voters and Watchers' permission. Default: ON</td>
</tr>
<tr>
<td>Allow users to watch issues</td>
<td>Controls whether watching is enabled in JIRA. Users can 'watch' issues which they are interested in. Users watching an issue will be notified of all changes to it. See also the 'View Voters and Watchers' and 'Manage Watcher List' permissions. Default: ON</td>
</tr>
<tr>
<td>Maximum project name size</td>
<td>Controls the maximum number of characters allowed for a project name. Changing this value will not affect the names of existing projects. Default: 80</td>
</tr>
<tr>
<td>Maximum project key size</td>
<td>Controls the maximum number of characters allowed for a project key. Changing this value will not affect the keys of existing projects. You can set this to any value between 2 and 255, inclusive. Default: 10</td>
</tr>
<tr>
<td>Allow unassigned issues</td>
<td>When turned ON, the default assignee for the project is Unassigned. When turned OFF, issues must always be assigned to someone - by default, the assignee will be the Project Lead as defined for each project. Default: ON</td>
</tr>
<tr>
<td>External user management</td>
<td>When turned ON, you will no longer be able to create, edit or delete users/groups from within JIRA (or via email or import); but you can still assign users/groups to project roles, and create/edit/delete user properties. Additionally, JIRA will not display options for users to change their password, or edit their profile. Generally you would only turn this ON if you are managing all your users from outside JIRA. Default: OFF</td>
</tr>
<tr>
<td>Logout confirmation</td>
<td>Controls whether to obtain user's confirmation when logging out: NEVER COOKIE - prompt for confirmation if the user was automatically logged in (via a cookie). ALWAYS Default: NEVER</td>
</tr>
<tr>
<td>Use gzip compression</td>
<td>Controls whether to compress the web pages that JIRA sends to the browser. It is recommended that this be turned ON, unless you are using mod_proxy. Default: OFF</td>
</tr>
<tr>
<td>Accept remote API calls</td>
<td>Controls whether to allow remote client access (via XML-RPC or SOAP) to this JIRA installation, for authenticated users. Default: OFF</td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| User email visibility | Controls how users’ email addresses are displayed in the user profile page.  
- PUBLIC - email addresses are visible to all.  
- HIDDEN - email addresses are hidden from all users.  
- MASKED - the email address is masked (e.g. ‘user@example.com’ is displayed as ‘user at example dot com’).  
- LOGGED IN USERS ONLY - only users logged in to JIRA can view the email addresses.  
*Default: PUBLIC*
|---|---|
| Comment visibility | Determines what will be contained in the list that is presented to users when specifying comment visibility and worklog visibility.  
- Groups & Project Roles - the list will contain groups and project roles.  
- Project Roles only - the list will only contain project roles.  
*Default: Project Roles only*
|---|---|
| Exclude email header 'Precedence: bulk' | Controls whether to prevent the Precedence: Bulk header on JIRA notification emails. This option should only be enabled when notifications go to a mailing list which rejects ‘bulk’ emails. In normal circumstances, this header prevents auto-replies (and hence potential mail loops).  
*Default: OFF*
|---|---|
| Issue Picker Auto-complete | Provides auto-completion of issue keys in the 'Issue Picker' popup screen. Turn OFF if your users' browsers are incompatible with AJAX.  
*Default: ON*
|---|---|
| JQL Auto-complete | Provides auto-completion of search terms when users perform an advanced (JQL) search. Turn OFF if you prefer not to use this feature, or are experiencing a performance impact.  
*Default: ON*
|---|---|
| Internet Explorer MIME Sniffing Security Hole Workaround Policy | Attachment viewing security options for cross-site site scripting vulnerabilities present in Internet Explorer 7 and earlier. Changes the default browser action for attachments in JIRA. Options are:  
- Insecure: inline display of attachments - allows all attachments to be displayed inline. Only select this option if you fully understand the security risks.  
- Secure: forced download of all attachments for all browsers - force the download of all attachments. This is the most secure option, but is less convenient for users.  
- Work around Internet Explorer security hole - forced download of high-risk attachments (IE-only Workaround) - for IE browsers, force the download of attachments that IE would mistakenly detect as an HTML file. Declared HTML attachments are also never displayed inline. Use this option to reduce the risk of attacks to IE users via attachments.  
*Default: Work around Internet Explorer security hole*
|---|---|
| Contact Administrators Form | Provides an email form for users to fill in when they click the 'Contact Administrators' link (which appears when appropriate in JIRA, e.g. on Login panels and pages).  
Can be used with or without the custom 'Contact Administrators Message' below. Users with the JIRA Administrators global permission (not JIRA System Administrators - see JRA-27454 for details) will be notified as a result of this feature being used.  
*Default: OFF*
|---|---|
| Contact Administrators Message | Displays a custom message when users click the 'Contact Administrators' link (which appears when appropriate in JIRA, e.g. on Login panels and pages). The 'Contact Administrators Message' will be displayed at the top of the 'Contact Administrators Form', only if the form is enabled (see above).  
|---|---|
| Allow Gravatars | Enables users to use Gravatars in their user profile instead of JIRA-specific avatars. Users will not be able to use JIRA-specific avatars if Gravatars are enabled, and vice versa.  
*Default: OFF* |
### Configuring Advanced Settings

JIRA has a small number of commonly edited advanced configuration options, which are stored in the JIRA database. These options can be accessed and edited from the Advanced Settings page. You must be a JIRA System Administrator to do this.

**Editing JIRA’s advanced settings**

To access and edit options on the 'Advanced Settings' page:

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose齿轮 > System. Select General Configuration to open the Administration page.
   - Keyboard shortcut: `g g general configuration`
3. Click the Advanced Settings button on the 'General Configuration' page to display this page:
### Advanced Settings

The following are advanced options. Do not change them unless you know exactly what you are doing.

<table>
<thead>
<tr>
<th>Key</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira.attachment.number.of.zip.entries</td>
<td>30</td>
</tr>
<tr>
<td>jira.attachment.prefix</td>
<td>CLONE</td>
</tr>
<tr>
<td>jira.data-picker/java.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
<tr>
<td>jira.data-picker/javascript.format</td>
<td>0/1/2/3/4/y</td>
</tr>
</tbody>
</table>

4. Edit the value of a **Key/Property** by clicking its value on the right of the page and modifying the existing
value.

Refer to the following Topics for more information about the Keys (above):

<table>
<thead>
<tr>
<th>Key</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira.attachments.number.of.zip.entries</td>
<td>Configuring the number of files shown in the content of ZIP-format files on issues</td>
</tr>
<tr>
<td>jira.clone.prefix</td>
<td>Configuring the cloned issue summary field prefix</td>
</tr>
<tr>
<td>jira.date_picker.java.format</td>
<td>Configuring date picker formats</td>
</tr>
<tr>
<td>jira.date_picker.javascript.format</td>
<td></td>
</tr>
<tr>
<td>jira.date.time_picker.java.format</td>
<td></td>
</tr>
<tr>
<td>jira.date.time_picker.javascript.format</td>
<td></td>
</tr>
<tr>
<td>jira.issue.actions.order</td>
<td>Changing the Default Order for Comments from Ascending to Descending</td>
</tr>
<tr>
<td>jira.projectkey.pattern</td>
<td>Changing the Project Key Format</td>
</tr>
<tr>
<td>jira.table.cols.subtasks</td>
<td>Configuring sub-task fields displayed on parent issues</td>
</tr>
<tr>
<td>jira.view.issue.links.sort.order</td>
<td>Configuring the order of linked issues displayed on the 'view issue' page</td>
</tr>
</tbody>
</table>

5. Click the Update button (which will appear in the Operations column on the right) to save the new value in the JIRA database.

Please Note:
- Any changes you make to these properties/keys become effective immediately.
- Click the General Settings button to return to the General Configuration page.

Related information

There are a handful of other advanced configuration options (which are of little interest to most JIRA system administrators) whose default values can be customized in the jira-config.properties file located in the JIRA Home Directory, which you may want to edit. For details, please see Advanced JIRA configuration.

Setting Properties and Options on Startup

This page describes how to set Java properties and options on startup for JIRA.

On this page:
- Linux
- Windows (starting from .bat file)
- Windows Service
  - Setting Properties for Windows Services via Command Line
  - Setting Properties for Windows Services via the Windows Registry
- Verifying Your Settings
- List of Startup Parameters

**Linux**

To Configure System Properties in Linux Installations,

1. From `<jira-install>/bin` (or `<Tomcat-home>/bin` for JIRA WAR installations), open `setenv.sh`.
2. Find the section `JVM_SUPPORT_RECOMMENDED_ARGS=
3. Refer to the list of parameters below.

Add all parameters in a space-separated list, inside the quotations.

**Windows (starting from .bat file)**
To Configure System Properties in Windows Installations When Starting from the .bat File,

1. From `<jira-install>/bin` (or `<Tomcat-home>/bin` for JIRA WAR installations), open `setenv.bat`.
2. Find the section `set JVM_SUPPORT_RECOMMENDED_ARGS=`
3. Refer to the list of parameters below.

Add all parameters in a space-separated list, inside the quotations.

Windows Service

There are two ways to configure system properties when starting Running JIRA as a Service, either via command line or in the Windows Registry

**Setting Properties for Windows Services via Command Line**

1. Identify the name of the service that JIRA is installed as in Windows (Control Panel > Administrative Tools > Services):

   ![Service Configuration](image)

   In the above example, the **SERVICENAME** is: JIRA231112155942

2. Open the command window from Start >> Run >> type in 'cmd' >> Enter
3. cd to the bin directory of your JIRA Installation Directory (or the bin directory of your Tomcat installation if your are running JIRA WAR).
4. Run:

```
tomcat7w //ES//%SERVICENAME%
```

In the above example, it would be `tomcat7w //ES//JIRA231112155942`

5. Click on the Java tab to see the list of current start-up options:

```
\[Image of Java tab with properties settings\]
```

6. Append any new option on its own new line by adding to the end of the existing Java Options. Refer to the list of parameters below.

---

**Setting Properties for Windows Services via the Windows Registry**

In some versions of Windows, there is no option to add Java variables to the service. In these cases, you must add the properties by viewing the option list in the registry.
To Set Properties for Windows Services via the Windows Registry,

1. Go to Start >> Run, and run "regedit32.exe".

2. Find the Services entry:
   - **32-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Apache Software Foundation >> Procrun 2.0 >> JIRA
   - **64-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Wow6432Node >> Apache Software Foundation >> Procrun 2.0 >> JIRA

3. To change existing properties, especially increasing Xmx memory, double-click the appropriate value.

4. To change additional properties, double-click options.

5. Refer to the list of parameters below. Enter each on a separate line.

Verifying Your Settings
To verify what settings are in place, check the `<jira-home>/logs/atlassian-jira.log` or `catalina.out` file. A section in the startup appears like this:

```
JVM Input Arguments:
-Djava.util.logging.config.file=/usr/local/jira/conf/logging.properties
-XX:MaxPermSize=256m -Xms256m -Xmx384m -Djava.awt.headless=true
-Datlassian.standalone=JIRA
-Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER=true
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager
-Djava.endorsed.dirs=/usr/local/jira/endorsed -Dcatalina.base=/usr/local/jira
-Dcatalina.home=/usr/local/jira -Djava.io.tmpdir=/usr/local/jira/temp
```

This display is also available by viewing your System Information.

### List of Startup Parameters

<table>
<thead>
<tr>
<th>Memory Property</th>
<th>Notes</th>
<th>Related</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Xmx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Xms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XX:MaxPermSize</td>
<td>These properties are pre-existing. See related pages for instructions.</td>
<td>Increase Memory</td>
</tr>
<tr>
<td>-agentlib:yjpagent=onexit=memory,dir=/path/to/write/snapshots</td>
<td></td>
<td>Profiling Memory and CPU Usage with YourKit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mail Property</th>
<th>Notes</th>
<th>Related</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Datlassian.mail.senddisabled</td>
<td>Set to 'true' to disable mail. In <code>Linux setenv.sh</code>, there is a pre-existing flag to uncomment.</td>
<td>Migrating JIRA to Another Server</td>
</tr>
<tr>
<td>-Datlassian.mail.fetchdisabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Datlassian.mail.popdisabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Dmail.debug</td>
<td>If set to &quot;true&quot;, logs statements related to mail</td>
<td>Configuring JIRA's SMTP Mail Server to Send Notifications</td>
</tr>
<tr>
<td>-Dmail.mime.decodetext.strict</td>
<td></td>
<td>Unable or Box From</td>
</tr>
<tr>
<td>-Dmail.imap.auth.plain.disable</td>
<td></td>
<td>Authen Conn</td>
</tr>
<tr>
<td>-Dmail.imaps.auth.plain.disable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Dmail.imap.starttls.enable</td>
<td>'javax.mail.MessagingException No login methods supported' Due to IMAP over SSL</td>
<td></td>
</tr>
<tr>
<td>-Dmail.mime.decodeparameters</td>
<td>Sets mail handler to work correctly with emails from RFC 2231-compliant mail clients.</td>
<td>Install JIRA</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Encoding Property

<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
<th>Related Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Dfile.encoding</td>
<td>Set to utf-8 for encoding consistency</td>
<td>Integrating JIRA with CVS and ViewCVS</td>
</tr>
</tbody>
</table>

### Other Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
<th>Related Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Duser.timezone</td>
<td></td>
<td>Incorrect Times Displayed in JIRA</td>
</tr>
<tr>
<td>-Dsvnkit.http.methods</td>
<td>Values include Basic, Digest, Negotiate, NTLM</td>
<td>JIRA : 'java.lang.SecurityException: Unable to locate a login configuration'</td>
</tr>
<tr>
<td>-Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER</td>
<td>true</td>
<td>OutOfMem JIRA-1</td>
</tr>
<tr>
<td>-ea/-da</td>
<td>Enable/Disable assertions</td>
<td>java.lang.Sendi</td>
</tr>
<tr>
<td>-Djava.net.preferIPv4Stack</td>
<td></td>
<td>Socke 'InvalidHost Address'</td>
</tr>
<tr>
<td>-Djavax.net.ssl.trustStore</td>
<td></td>
<td>Conn Unabl 'javax.net.ssl.SSLException'</td>
</tr>
<tr>
<td>-Djava.awt.headless</td>
<td>Ships with true by default. Allows thumbnail generation.</td>
<td></td>
</tr>
<tr>
<td>-Dhttp.proxyHost -Dhttp.proxyPort</td>
<td></td>
<td>Outbound Proxy Server hostname and port</td>
</tr>
<tr>
<td>-Dhttps.proxyHost -Dhttps.proxyPort</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Recognized System Properties for JIRA

JIRA supports some configuration and debugging settings that can be enabled through Java system properties. System properties are usually set by passing the `-D` flag to the Java virtual machine in which JIRA is running. See Setting Properties and Options on Startup.

List of Startup Parameters

<table>
<thead>
<tr>
<th>Memory Property</th>
<th>Notes</th>
<th>Related Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Xmx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Xms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XX:MaxPermSize</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-agentlib:yjpagent=onexit=memory,dir=/path/to/write/snapshots</td>
<td></td>
<td>Profiling Memory and CPU Usage with YourKit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mail Property</th>
<th>Notes</th>
<th>Related Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Datlassian.mail.senddisabled</td>
<td>Set to 'true' to disable mail. In Linux setenv.sh, there is a pre-existing flag to uncomment.</td>
<td>Migrating JIRA to Another Server</td>
</tr>
<tr>
<td>-Datlassian.mail.fetchdisabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Datlassian.mail.popdisabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Dmail.debug</td>
<td>If set to &quot;true&quot;, logs statements related to mail</td>
<td>Configuring JIRA's SMTP Mail Server to Send Notifications</td>
</tr>
<tr>
<td>-Dmail.mime.decodetext.strict</td>
<td></td>
<td>Unable to Decode Mail Subject or Body when Creating Issue From Email</td>
</tr>
<tr>
<td>-Dmail.imap.auth.plain.disable</td>
<td></td>
<td>Authenticate Failed Error when Connecting to Exchange</td>
</tr>
<tr>
<td>-Dmail.imaps.auth.plain.disable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-Dmail.imap.starttls.enable</td>
<td></td>
<td>'javax.mail.MessagingException: No login methods supported' Due to IMAP over SSL</td>
</tr>
<tr>
<td>-Dmail.mime.decodeparameters</td>
<td>Sets mail handler to work correctly with emails from RFC 2231-compliant mail clients.</td>
<td>Install JIRA</td>
</tr>
<tr>
<td>-Dmail.smtp.localhost</td>
<td></td>
<td>Problems Sending Email from JIRA - EHLO requires domain address</td>
</tr>
<tr>
<td>Encoding Property</td>
<td>Notes</td>
<td>Related Pages</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-Dfile.encoding</td>
<td>Set to utf-8 for encoding consistency</td>
<td>Integrate ViewCVS, Character Encoding, Quest International Encoding, SQL Issues, JIRA Encryption, Internationalization and Encoding, SQL Exception while Updating Issues or Importing Data in JIRA with MySQL Due to Encoding, International Characters in Notification Email Subject Lines Are Being Replaced with Question Mark</td>
</tr>
<tr>
<td>-Duser.timezone</td>
<td></td>
<td>Incorrect Times Displayed in JIRA</td>
</tr>
<tr>
<td>-Dsvnkit.http.methods</td>
<td>Values include Basic, Digest, Negotiate, NTLM</td>
<td>JIRA: java.lang.SecurityException Unable to locate a login configuration Subversion Plugin Displays 'An unknown error occurred - actions == null' Due to SVN Authentication</td>
</tr>
<tr>
<td>-Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER</td>
<td>true</td>
<td>OutOfMemory Due to Tomcat Memory Leak JIRA-10145</td>
</tr>
<tr>
<td>-ea/-da</td>
<td>Enable/Disable assertions</td>
<td>java.lang.SwingException</td>
</tr>
<tr>
<td>-Djava.net.preferIPv4Stack</td>
<td></td>
<td>Socke 'Invalid address available'</td>
</tr>
<tr>
<td>-Djavax.net.ssl.trustStore</td>
<td></td>
<td>Connecting to SSL services Unable to Send Email 'javax.net.ssl.SSLException' Due to SMTP Server via SSL</td>
</tr>
<tr>
<td>-Dhttp.proxyHost</td>
<td>Outbound Proxy Server hostname and port</td>
<td>Outbound Proxy Server hostname and port How to Configure an Outbound HTTP and HTTPS Proxy for JIRA</td>
</tr>
<tr>
<td>-Dhttp.proxyPort</td>
<td></td>
<td>Applications due to JIRA</td>
</tr>
<tr>
<td>-Dhttps.proxyHost</td>
<td></td>
<td>Applications due to JIRA</td>
</tr>
<tr>
<td>-Dhttps.proxyPort</td>
<td></td>
<td>Applications due to JIRA</td>
</tr>
<tr>
<td>-Dorg.apache.catalina.SESSION_COOKIE_NAME</td>
<td></td>
<td>Logging into Another Atlassian Application Logs Me Out of Confluence</td>
</tr>
</tbody>
</table>
Advanced JIRA Configuration

JIRA has a number of advanced configuration options, each of which is defined as an individual property (or 'key' associated with a value). These key-value pairs are stored in one of three areas for use by JIRA:

- The JIRA Database
- The jira-config.properties file
- The jpm.xml file

The JIRA Database

The values of a small number of most commonly edited advanced configuration options are stored in the JIRA database. These values can be edited from the Advanced Settings page of JIRA's administration area. To access the values for editing:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose ➔ System. Select General Configuration to open the Administration page. See Configuring Advanced Settings for details.

Once any of these properties' values are changed, they become effective immediately.

The jira-config.properties file

Custom values for JIRA's remaining advanced configuration options (i.e. not stored in the JIRA database) are stored as individual key-value pairs in a file called jira-config.properties (located in the JIRA Home Directory). Typically, these options are of little interest to most JIRA system administrators. While these key-value pairs can be edited, JIRA must be restarted for any changed values to take effect.

Example contents to demonstrate format

```text
jira.projectkey.warning = testwarning
jira.projectkey.description = testdescription
```

Information about editing the jira-config.properties file can be found here: [How to edit the jira-config.properties file](#).

The jpm.xml file

Default values for all* of JIRA's available advanced configuration options are stored in a file called jpm.xml (located in the <jira-application-dir>/WEB-INF/classes subdirectory of the JIRA Installation Directory). These default values are only used by JIRA if a property's value has not already been customized in either the JIRA database (via JIRA's 'Advanced Settings' page) or the jira-config.properties file.

The jpm.xml file should not be edited because any values that you customize in it will not be migrated automatically during subsequent JIRA upgrades. To change the value of a property for an advanced configuration option in JIRA, override the value of this property by redefining it in either:

- The JIRA database (via JIRA's 'Advanced Settings' page).
- The jira-config.properties file.

* JIRA recognises a small number of properties, which can be set in your jira-config.properties file but have no definition in the jpm.xml file. These properties:
- typically represent advanced configuration options that are disabled when they are not defined in your `jira-config.properties` file and
- when not specified in your `jira-config.properties` file, typically affect JIRA’s behavior differently to when they are specified in your `jira-config.properties` file with no value.

Making changes to the `jira-config.properties` file

To make changes to the `jira-config.properties` file:

1. Shut down JIRA (for example, by executing either the `/bin/stop-jira.sh` or `/bin/stop-jira.bat` file in your JIRA Installation Directory, or by stopping the JIRA service).
2. Open the `jira-config.properties` file (located at the root of your JIRA Home Directory) in a text editor.
   - This file may not exist if you are using a new JIRA installation or an upgraded JIRA installation where your previous JIRA version(s) had never been customized. If this file does not exist, create it using a text editor.
3. Edit the appropriate properties in this file.
   - **Editing tips:**
     - To determine the default value of a property whose value you wish to redefine, search for that property in the `<jira-application-dir>/WEB-INF/classes/jpm.xml` file (of your JIRA Installation Directory). The default value is defined in the `<default-value/>` sibling element of the relevant property's `<key/>` element.
     - To override a property's default value in `<jpm.xml>` (which is not already defined in your `jira-config.properties` file or available on the 'Advanced Settings' page):
       - a. Copy the value of the relevant property's `<key/>` element from the `<jpm.xml>` file to the `jira-config.properties` file.
       - b. In the `jira-config.properties` file, add an '=' after that property's key, followed by your custom value.
     - To disable a custom property's value in the `jira-config.properties` file, either 'comment out' the property with a preceding '#' symbol or remove the property from the file.
4. Save your modifications to the `jira-config.properties` file.
5. Restart JIRA.

See also

Setting Properties and Options on Startup — for changes like setting available memory, disabling email, enabling Jelly, etc.

Changing the constraints on historical time parameters in gadgets

A number of JIRA gadgets show historical data from your JIRA server.

You can generally configure the time constraints on this data via gadget parameters, such as those parameters defining how far back should data be retrieved. For instance, the 'Time Since Issues' gadget allows you to specify how far back issue data should be retrieved via the 'Days Previously' parameter.

For performance reasons, however, the JIRA server can impose an overriding maximum limit on historical data retrieved by gadgets. Hence, if you tried entering a 'Days Previously' value greater than 300 in the 'Time Since Issues' gadget, a validation message will be shown. You will not be permitted to save your configuration changes without changing the 'Days Previously' value to a lower one.

These maximum limits imposed by the JIRA server are defined by the following advanced configuration options in JIRA and can be customized in your `jira-config.properties` file (located in the JIRA Home Directory):

```properties
jira.chart.days.previous.limit.yearly=36500
jira.chart.days.previous.limit.quarterly=22500
jira.chart.days.previous.limit.monthly=7500
jira.chart.days.previous.limit.weekly=1750
jira.chart.days.previous.limit.daily=300
jira.chart.days.previous.limit.hourly=10
```
To update these properties:

1. Shut down your JIRA server.
2. Edit your jira-config.properties file in your JIRA Home Directory.
   - See Making changes to the jira-config.properties file for more information.
3. Locate these properties.
   - If any of these properties do not exist in your jira-config.properties file, add them to the file.
4. Update the values of these properties as desired.
5. Save your changes to the jira-config.properties file.
6. Restart your JIRA server.

Changing the Default Order for Comments from Ascending to Descending

To change the default order from Ascending to Descending so that the latest comments are shown first, follow these steps:

1. Access JIRA's 'Advanced Settings' page. (See Configuring Advanced Settings for more information.)
2. Edit the value of the jira.issue.actions.order property by clicking the existing value and changing it from asc to desc
3. Click the 'Update' button to save the new value in the JIRA database.

Limiting the number of issues returned from a search view such as an RSS feed

JIRA allows you to view search results in several different formats, including Word, Excel, RSS or XML.

A search view that returns too many issues can take a long time for JIRA to complete and can use a large amount of memory. It can be a factor in OutOfMemoryErrors in JIRA.

An large RSS feed of search results can be particularly problematic, because:

- the user's RSS reader will continue to make the request periodically (for example, every hour)
- since the RSS reader makes the request, not the user directly, the user is unaware that the request takes a long time or is failing

You can use the following three properties in jira-config.properties to limit the number of issues returned by a search view.

See Making changes to jira-config.properties for the details of how to make and apply changes to your jira-config.properties file.

**jira.search.views.default.max**

The jira.search.views.default.max property sets a 'soft' limit on the number of issues returned. It has a default value of 1000. You can set it to 100 (for example), by specifying the following in your jira-config.properties file:

```
jira.search.views.default.max = 100
```

For an RSS or XML view, JIRA applies the limit by appending the tempMax parameter to the URL of the search view. For example:


In the above example, JIRA will limit the number of issues returned to 200 (in this example).

However users can override this 'soft' default by removing the tempMax parameter from the URL or by increasing the value of tempMax.

**jira.search.views.max.limit**

The jira.search.views.max.limit property sets a 'hard' limit on the number of issues returned. It has a default value of 1000. You can set this property's value to 200 (for example), by specifying the following in your jira-config.properties file:
jira.search.views.max.limit = 200

If a user makes an issue view request that would return more than 200 issues (in this example), JIRA does not return the issues but instead returns a 403 (Forbidden) error. While the user might not be happy, it prevents JIRA from consuming lots of resources and possibly running out of memory.

Make sure you set the value of `jira.search.views.max.limit` to greater than or equal to the 'soft' limit set by `jira.search.views.default.max`. Otherwise all search views that would return issues limited by the default 'soft' limit will instead return a 403 (Forbidden) error.

`jira.search.views.max.unlimited.group`

You may have a requirement for most users to have the limit imposed on them, but a few users to be exempt from the limit. One example of this is if your JIRA instance is Internet facing. You may want external (Internet) users to have the limit imposed on them, but for internal users to be able to produce unlimited search views. You can use the `jira.search.views.max.unlimited.group` property to achieve this.

The `jira.search.views.max.unlimited.group` property is disabled by default, by being either absent from your `jira-config.properties` file or present but disabled with a preceding '#'. If you enable this property in your `jira-config.properties` file, you must specify a valid group for its value or leave it empty. For example:

```
jira.search.views.max.unlimited.group = jira-administrators
```

Users exempted from the limit via this technique will still have to add the `tempMax` parameter to the URL for an RSS or XML view, as described above, in order to exceed the `jira.search.views.default.max` soft limit.

**Configuring File Attachments**

When file attachments are enabled, your users will be allowed to attach files and screenshots to JIRA issues. This requires space on the server for storing the attachments.

File attachments are enabled by default. If you wish, you can configure the way JIRA handles attachments, or disable this feature altogether.

**Note:**

- your users must also have the Create Attachments permissions to attach files to issues
- to allow users to attach a file when creating a new issue, you need to ensure that the Attachment field is not hidden within the field configuration(s) associated with the specific issue type(s).

**Configuring attachment settings**

1. Log in as a user with the JIRA System Administrators or JIRA Administrators global permission. If you do not have the JIRA System Administrators global permission, you will not be able to enable or disable file attachments.
2. Choose 🛠 > System. Select Advanced > Attachments to open the Attachment page, which states whether attachments are on or off. Keyboard shortcut: g + g + start typing attachments

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
3. Click the **Edit Settings** button, which opens the **Edit Attachment Settings** dialog box:
4. In the **Attachment Path** field, choose the **Use Default Directory** option. If you see more attachment path options than what is shown in the screenshot above, please refer to the note below.

   As mentioned above, if you have not logged in as a user with the **JIRA System Administrators** global permission, then this option will not be available to you.

5. In the **Attachment Size** field, specify the maximum attachment size. The default is 10485760 bytes (10 MB). The maximum attachment size is 2147483647 bytes (2 GB).
6. *(Optional)* In the **Enable Thumbnails** field, ensure that **ON** is selected if you wish to display image file attachments as thumbnails (or miniature previews) when viewing an issue. When this setting is enabled, JIRA automatically creates thumbnails of the following types of image attachments:
   - GIF
   - JPEG
   - PNG
   Please refer to the info note below for more information about thumbnails. If you use Linux, please refer to the Linux note below.
7. *(Optional)* In the **Enable ZIP Support** field, ensure that **ON** is selected if you wish to view the contents of zip files attached to an issue and allow all files attached to an issue to be downloaded as a single ZIP file.
8. Click the **Update** button to update JIRA's attachment settings.
To attach files to issues, the appropriate users, groups or project roles must first be assigned the **Create Attachments** permission for the relevant project(s).
To allow these users or group/project role members to delete their own attached files from issues, they must also be assigned the **Delete Own Attachments** permission for these projects too.
There is no need to proceed any further if:
- the permission schemes used by your project(s) already have the **Create Attachments** (and **Delete Own Attachments**) permission, or
- your project(s) use JIRA's built-in Default Permission Scheme.
However, if you wish to configure these permissions, proceed with the steps in the section below.

### Configuring create/delete attachment permissions

1. Choose ![ ] > **Issues**. Select **Permission Schemes** to open the Permission Schemes page, which displays a list of all permission schemes in your JIRA system and the projects that use each scheme.
   
   Keyboard shortcut: `g g` start typing permission schemes
2. For each relevant permission scheme:
   a. Click the **Permissions** link associated with the relevant permission scheme to edit that scheme's permissions.

   ![Permission Schemes](image)

   b. On the **Edit Permissions** page, locate **Create Attachments** within the **Attachment Permissions** section and click the **Add** link.
   c. In the user selection options on the right of the **Add New Permission** page, select the relevant (groups of) users or roles and then click the **Add** button.
To allow these users or group/project role members to delete their own attachments, do not forget to assign them the **Delete Own Attachments** permission too.

**More information about thumbnails:**

- You can configure the Issue Navigator column layout to display the thumbnails in an Images column.
- All thumbnail images are stored in JPEG format in the attachments directory, together with the original attachments. The thumbnail images are denoted by `_thumb_` in their file names.

**Thumbnail image generation on Linux:**

- Your system must have X11 support. This [web page](#) details the minimum set of libraries needed to use JDK 1.4.2 under RedHat Linux 9.0.
- The following java system property must be set: `-Djava.awt.headless=true`
Configuring Issue Cloning

JIRA’s issue cloning behavior can be modified by JIRA system administrators.

Configuring cloned issue linking behavior

By default, when an issue is cloned, JIRA will automatically create a link between the original and cloned issue using the pre-existing link type name ‘Cloners’.

You can change this default behavior by editing the `jira.clone.linktype.name` property of your `jira-config.properties` file.

> If this property does not exist in your `jira-config.properties` file, add it to the file.

- If this property has a value, JIRA will use the pre-existing link type whose name is the value specified for this property.
- If this property has no value, JIRA will not create links between original and cloned issues.

Configuring the cloned issue summary field prefix

By default, the ‘Summary’ field of a cloned issue is prefixed with the string ‘CLONE - ’ to indicate that the issue is a clone.

To change this prefix or prevent the addition of prefixes on cloned issues:

1. Access JIRA’s Advanced Settings page. (See Configuring Advanced Settings for more information.)
2. Edit the value of the `jira.clone.prefix` property by clicking the existing value and specifying a different prefix for the ‘Summary’ field of cloned issues.
   > Specifying no value prevents a prefix being added to the ‘Summary’ field of cloned issues.
3. Click the ‘Update’ button to save the new value in the JIRA database.

About issue linking

Issue linking allows you to create an association between issues on either the same or different JIRA servers. For instance, an issue may duplicate another, or its resolution may depend on another’s. New installations of JIRA come with four default types of links:

- relates to / relates to
- duplicates / is duplicated by
- blocks / is blocked by
- clones / is cloned by (this is used when issues are cloned)

Issue linking also allows you to:

- Create an association between a JIRA issue and a Confluence page.
- Link a JIRA issue to any other web page.

You can add, edit or delete link types to suit your organisation, as described below.

> Note:

- Your users must have the Link Issues permission before they can link issues.
- Issue linking must be enabled in order for your users to be able to link issues. Issue linking is enabled by default. If your organisation does not require the ability to link issues, you can disable it globally for all users as described below.

Adding a link type
To create a new link type, e.g. 'Causes':

1. Log in as a user with the JIRA Administrators global permission.
2. Choose \( \mathcal{H} \) > System. Select Issue Features > Issue Linking to open the Issue Linking page.
   - Keyboard shortcut: g + g + start typing issue linking
3. In the 'Add New Link Type' form at the end of the page:
   - Enter 'Causes' in the Name text field.
   - Enter 'causes' in the Outward Link Description text field.
   - Enter 'is caused by' in the Inward Link Description text field.
4. Click the Add button.
5. This returns to the Issue Linking page, with a new section listing the Causes link type.

![Screenshot: the 'Issue Linking' administration page](image)

Editing or deleting a link type

It is recommended that you do not edit or delete the Clones link type, as this is used to automatically link issues when they are cloned.

To edit or delete a link type:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose \( \mathcal{H} \) > System. Select Issue Features > Issue Linking to open the Issue Linking page.
   - Keyboard shortcut: g + g + start typing issue linking
3. Locate the link type you wish to edit or delete, and click the link type's associated Edit/Delete link in the Operations column.

Disabling issue linking

To disable issue linking for your entire JIRA site, for all users:

1. Log in as a user with the JIRA Administrators global permission.
   - Keyboard shortcut: g + g + start typing issue linking
3. A status message indicates whether issue linking is enabled. If issue linking is enabled, click the Deactivate button. The Issue Linking page reloads, stating that linking is disabled.

Configuring the Whitelist

JIRA administrators can choose to allow incoming and outgoing connections and content from specified sources by adding URLs to the whitelist.

JIRA will display an error if content has been added that is not from an allowed source, and prompt the user to add the URL to the whitelist.
Application Links are automatically added to the whitelist. You do need to manually add them.

Add allowed URLs to the whitelist

To add a URL to the whitelist:

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose 🔔 > System. Select Security > Whitelist to open the Whitelist page.
   - Keyboard shortcut: g + g + type wh
3. On the Whitelist page, enter the URL or expression you want to allow.
4. Choose the Type of expression (see Expression Types below for examples).
5. Choose Allow Incoming if you need to allow CORS requests (see below).
6. Choose Add.

Your URL or expression appears in the whitelist.

To test that your whitelisted URL is working as expected you can enter a URL in the Test a URL field. Icons will indicate whether incoming and / or outgoing traffic is allowed for that URL.

Expression Types

When adding a URL to the whitelist, you can choose from a number of expression types.
<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain name</td>
<td>Allows all URLs from the specified domain.</td>
<td><a href="http://www.example.com">http://www.example.com</a></td>
</tr>
<tr>
<td>Exact match</td>
<td>Allows only the specified URL.</td>
<td><a href="http://www.example.com/thispage">http://www.example.com/thispage</a></td>
</tr>
<tr>
<td>Wildcard Expression</td>
<td>Allows all matching URLs. Use the wildcard * character to replace one or more characters.</td>
<td>http://*example.com</td>
</tr>
<tr>
<td>Regular Expression</td>
<td>Allows all URLs matching the regular expression.</td>
<td>http(s)?://www.example.com</td>
</tr>
</tbody>
</table>

**Allow Incoming**

*Allow Incoming* enables CORS requests from the specified origin. The URL must match the format `scheme://host[:port]`, with no trailing slashes (`:port` is optional). So `http://example.com` would not allow CORS requests from the domain `example.com`.

**Disabling the whitelist**

The whitelist is enabled by default. You can choose to disable the whitelist however this will allow all URLs, including malicious content, and is not recommended.

To disable the whitelist:

1. Log in as a user with the [JIRA System Administrators] global permission.
2. Choose [System] > [Security] > [Whitelist] to open the Whitelist page. **Keyboard shortcut:** `g + g + wh`
3. On the [Whitelist] page, click the [Turn off whitelist] button.
4. Choose [Confirm].

All URLs will now be allowed. Unless your instance is running in an environment without internet access, we do not recommend disabling the whitelist.

**Configuring Sub-tasks**

*Sub-Task issues* are generally used to split up a parent issue into a number of tasks which can be assigned and tracked separately. (For details, see Creating a Sub-Task.)

Sub-Tasks have all the same fields as standard issues, although note that their 'issue type' must be one of the *Sub-Task issue types* (see below) rather than one of the standard issue types.

If Sub-Tasks are enabled and you have defined at least one Sub-Task issue type, your users will be able to:

- create sub-tasks.
- convert issues to sub-tasks (and vice versa).

**On this page:**

- Disabling sub-tasks
- Enabling sub-tasks
- Defining sub-task issue types
- Blocking issue workflows by sub-task status
- Configuring sub-task fields displayed on parent issues

**Disabling sub-tasks**

Sub-tasks are enabled by default. However, this feature can be disabled from the [Sub-Tasks] administration page.

*Sub-Tasks will be disabled by default if your JIRA installation was upgraded from a version prior to 4.2 that had Sub-Tasks disabled.*
To disable sub-tasks:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Issue Types > Sub-Tasks to open the Sub-Tasks page.
3. Click the 'Disable' Sub-Tasks link. The page reloads and informs you that sub-tasks are now disabled.

**Please Note:** Sub-tasks cannot be disabled if one or more sub-tasks exists in the system. You must remove any existing sub-tasks (or convert them to standard issues) before you can disable this feature.

Enabling sub-tasks

Sub-tasks can be enabled from the Sub-Tasks administration screen.

To enable sub-tasks:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Issue Types > Sub-Tasks to open the Sub-Tasks page.
3. Click the 'Enable' Sub-Tasks link. The page will reload and inform you that the sub-tasks are now enabled.

A default sub-task issue type is automatically available for use. You can edit it by clicking its Edit link in the Operations column.

Defining sub-task issue types

Sub-tasks must be assigned one of the Sub-Task issue types, which are different to standard issue types. Please note that at least one sub-task issue type must be defined in JIRA for users to be able to create sub-tasks.

Sub-task issue types can be customized on the Sub-Tasks administration page (described above). The Sub-Tasks administration page also allows you to create, edit (i.e. the name, description or icon) and translate your Sub-Task issue types.

Creating a sub-task issue type

To create a new sub-task issue type:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > Issues. Select Issue Types > Sub-Tasks to open the Sub-Tasks page.
3. Click Add New Sub-Task Issue Type button to open the Add New Sub-Task Issue Type dialog box.
4. Complete the following:
   - **Name** — enter a short phrase that best describes your new sub-task issue type.
   - **Description** — enter a sentence or two to describe when this sub-task issue type should be used.
   - **Icon URL** — supply the path of an image that has been placed somewhere inside `<jira-installation-dir>/images/icons` of your JIRA Installation Directory or from an accessible URL.

Editing a sub-task issue type
To edit a sub-task issue type:

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **Issues** > **Issue Types** > **Sub-Tasks** to open the Sub-Tasks page.
3. Choose the **Edit** link (in the **Operations** column) for the sub-task issue type that you wish to edit.
4. Edit the **Name**, **Description** and/or **Icon** as described above for **Creating a sub-task issue type**.

Deleting a sub-task issue type

You can only delete sub-task issue types through the **Manage Issue Types** page. For details, please see **Deleting an Issue Type**.

Blocking issue workflows by sub-task status

It is possible to restrict the progression of an issue through workflow depending on the status of the issue’s Sub-Tasks. For example, you might need to restrict an issue from being resolved until all of its Sub-Tasks are resolved. To achieve this, you would create a custom workflow and use the **Sub-Task Blocking Condition** on the workflow transitions that are to be restricted by the Sub-Tasks’ status.

Configuring sub-task fields displayed on parent issues

**JIRA system administrators** can define which fields of sub-tasks are displayed in the **Sub-Tasks** section on the 'view issue' page of a parent issue (which contains one or more sub-tasks). This is done by editing the value of the `jira.table.cols.subtasks` property on JIRA's **Advanced Settings** page.

Specify which fields you want to show in the **Sub-Tasks** section of a parent issue's 'view issue' page by entering the appropriate 'value' for each field in a comma-separated list. The `jira.table.cols.subtasks` property can accept the values indicated in right-hand column of the **IssueFieldConstants** page (of JIRA's API documentation).

**Please Note:**

- The order of each value in this list determines the order of their representative fields in the **Sub-Tasks** section of a parent issue's 'view issue' page.
- The **summary** field is a mandatory value which assumes first position in this property's value.

Managing Shared Filters

A **filter** is a saved issue search. JIRA users can create and manage their own filters (see **Using Filters**) and filter subscriptions (see **Receiving Search Results via Email**).

A **shared filter** is a filter whose creator has shared that filter with other users. When a shared filter is created by a user, that user:

- Initially 'owns' the shared filter.
- Being the owner, can edit and modify the shared filter.

JIRA administrators can change the ownership of any user's shared filter, which allows the shared filter to be edited and modified by its new owner.

**On this page:**

- Changing the Ownership of a Shared Filter
- Deleting a Shared Filter

Changing the Ownership of a Shared Filter

Before changing the ownership of a shared filter, ensure that you inform the shared filter's current owner of your intentions.

**To change the ownership of a shared filter:**

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose † > System. Select Shared Filters to open the Search Shared Filters page.

   Keyboard shortcut: 'g' + 'g' + start typing 'shared filters'

   Search Shared Filters
   Find and modify filters that are shared with any group or role.

   Search
   Searches in the filter's name and description.
   Search

<table>
<thead>
<tr>
<th>Name</th>
<th>Owner</th>
<th>Shared With</th>
<th>Popl</th>
</tr>
</thead>
<tbody>
<tr>
<td>0. JIRA Release Tracking</td>
<td>Paul</td>
<td>• Shared with all users 1</td>
<td>1</td>
</tr>
<tr>
<td>4.1 Todo</td>
<td>Nick</td>
<td>• Shared with all users 0</td>
<td>0</td>
</tr>
<tr>
<td>4.1 Triaged</td>
<td>Paul</td>
<td>• Shared with all users 3</td>
<td>3</td>
</tr>
<tr>
<td>4.1 Triaged NON-UI</td>
<td>Paul</td>
<td>• Shared with all users 2</td>
<td>2</td>
</tr>
<tr>
<td>4.1 Triaged UI</td>
<td>Paul</td>
<td>• Shared with all users 1</td>
<td>1</td>
</tr>
</tbody>
</table>

3. Enter your search criteria into the 'Search' field and click the 'Search' button. A list of shared filters matching your search criteria is shown below. Each shared filter indicates its:
   - Current owner — this is originally the user who created the shared filter
   - List of shares applied to the shared filter by its owner
   - Popularity — the number of users who have selected that shared filter as a 'favorite'.

4. Click the 'cog' icon to the right of the shared filter whose ownership you wish to change and select 'Change Owner'.

5. In the 'Change Owner' dialog box, enter the username (or name) of the user who will become the new owner of the shared filter.

6. Select the appropriate user from the dropdown list and click the 'Change Owner' button.

**Please Note:**

- A shared filter can only be edited by the shared filter’s owner. The owner of a shared filter can only modify that filter's shares and search criteria too. See Saving Searches ('Issue Filters') for more information.
- You cannot change the ownership of a shared filter to a user who:
  - already has a shared filter with exactly the same name, or
  - does not have permission to view the shared filter.

Deleting a Shared Filter

Before deleting a shared filter, then out of common courtesy, ensure that you inform the current owner of the shared filter of your intentions.

To delete a shared filter:

1. Log in as a user with the JIRA Administrators global permission.

2. Choose † > System. Select Shared Filters to open the Search Shared Filters page.

   Keyboard shortcut: 'g' + 'g' + start typing 'shared filters'
3. Enter your search criteria into the 'Search' field and click the 'Search' button. A list of shared filters matching your search criteria is shown below. Each shared filter indicates its:
   - Current owner — this is originally the user who created the shared filter
   - List of shares applied to the shared filter by its owner
   - Popularity — the number of users who have marked that shared filter as a 'favorite'.

4. Click the 'cog' icon to the right of the shared filter you wish to delete and select 'Delete Filter'. The 'Delete Filter' dialog box is shown.
   - The number of users who have marked the shared filter as a favorite is specified in this dialog box.
   - If any subscriptions are associated with this shared filter, a numbered link is provided leading to a page which indicates the shared filter's current subscribers.

5. If you are happy to proceed, click the 'Delete' button to complete the action.

RELATED TOPICS

- Saving Searches ('Issue Filters')
- Receiving Search Results via Email

Managing Shared Dashboards

A dashboard is a customizable page that can display many different types of information, depending on your areas of interest. JIRA users can create and manage their own dashboards (see Managing Multiple Dashboard Pages).

A shared dashboard is a dashboard whose creator has shared that dashboard with other users. When a shared dashboard is created by a user, that user:
   - Initially 'owns' the shared dashboard.
   - Being the owner, can edit and modify the shared dashboard.

JIRA administrators can change the ownership of any user's shared dashboard, which allows the shared dashboard to be edited and modified by its new owner.
Changing the Ownership of a Shared Dashboard

Before changing the ownership of a shared dashboard, ensure that you inform the shared dashboard's current owner of your intentions.

To change the ownership of a shared dashboard:

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose **System** > **Shared Dashboards** to open the Search Shared Dashboards page. **Keyboard shortcut: 'g' + 'g' + start typing 'shared dashboards'**

   ![Search Shared Dashboards](image)

   3. Enter your search criteria into the 'Search' field and click the 'Search' button. A list of shared dashboards matching your search criteria is shown below. Each shared dashboard indicates its:
      - Current owner — this is originally the user who created the shared dashboard
      - List of shares applied to the shared dashboard by its owner
      - Popularity — the number of users who have selected that shared dashboard as a 'favorite'.

4. Click the 'cog' icon to the right of the shared dashboard whose ownership you wish to change and select **'Change Owner'**.
5. In the 'Change Owner' dialog box, enter the username (or name) of the user who will become the new owner of the shared dashboard.
6. Select the appropriate user from the dropdown list and click the **'Change Owner'** button.

**Please Note:**

- A shared dashboard can only be edited by the shared dashboard's owner. The owner of a shared dashboard can only modify that dashboard's shares and gadgets too. See [Managing Multiple Dashboard Pages](#) and [Customizing the Dashboard](#) for more information.
- You cannot change the ownership of a shared dashboard to a user who:
  - already has a shared dashboard with exactly the same name, or
  - does not have permission to view the shared dashboard.

Deleting a Shared Dashboard

Before deleting a shared dashboard, ensure that you inform the shared dashboard's current owner of your
intentions.

To delete a shared dashboard:

1. Log in as a user with the **JIRA Administrators** global permission.
2. Choose ☐ > **System**. Select **Shared Dashboards** to open the Search Shared Dashboards page. **Keyboard shortcut: 'g' + 'g' + start typing 'shared dashboard'**

3. Enter your search criteria into the 'Search' field and click the 'Search' button. A list of shared dashboards matching your search criteria is shown below. Each shared dashboard indicates its:
   - Current owner — this is originally the user who created the shared dashboard
   - List of shares applied to the shared dashboard by its owner
   - Popularity — the number of users who have marked that shared dashboard as a 'favorite'.
4. Click the 'cog' icon to the right of the shared dashboard you wish to delete and select **Delete Dashboard**. The 'Delete Dashboard' confirmation message box is shown.
   - The number of users who have marked the shared dashboard as a favorite is specified in this message box.
5. If you are happy to proceed, click the 'Delete' button to complete the action.

**RELATED TOPICS**

- Managing Multiple Dashboard Pages
- Customizing the Dashboard

**Linking to Another Application**

Application Links (sometimes called "AppLinks") is a bundled plugin that allows you to link Atlassian applications to each other. Linking two applications allows you to share information and access one application's functions and resources from within the other.

Linking JIRA to other applications allows you to include information from these systems in JIRA projects and issues. For example, if you link JIRA to Confluence, you can include pointers to wiki pages when creating or editing issues. Another common use case is to link FishEye with JIRA; this allows you to view source code and changesets that correspond to your stories in JIRA. In addition to Atlassian applications, you can also link to external applications; for example, you might use a plugin that allows you to share ZenDesk or Salesforce data via an application link.

1. Log in to JIRA as a user with the **JIRA Administrators** permissions.
2. Choose ☐ > **Add-ons**. Select **Application Links** in the left menu.
3. In the **Application URL** box, supply the URL of the application you want to link to and then select **Create new link**.
4. Use the wizard to finish configuring the link. If the application you are linking to does not have the Application Links plugin, you must supply additional information to set up a link with OAuth authentication.

When you complete the wizard, the Application Links plugin will create the link between your applications using...
the most secure authentication method that is supported between the two application types. After the link has been set up, it will appear on the "Configure Application Links" page. You can use this page to change the configuration of application links to make them more secure or to change the link settings:

- To edit the settings of the application link (for example, to change the authentication type of the link), select Edit.
- If you've set up multiple links to the same type of application (for example, multiple JIRA servers), you can use the Make Primary link to specify which application is the default instance. See Making a Primary Link for Links to the Same Application Type for more information.
- After you've linked applications, you also connect the areas of those applications that contain information relating to your project or team (for example, you can connect a project's Confluence space with a JIRA project). These types of links are called project links.

**Server Administration**

- Finding your Server ID
- Increasing JIRA Memory
- Using the Database Integrity Checker
- Precompiling JSP pages
- Logging and Profiling
- Restoring Data
- Optimizing Performance
- Backing Up Data
- Search Indexing
- Using robots.txt to hide from Search Engines
- Updating your JIRA License Details
- Viewing your System Information
- Monitoring Database Connection Usage
- Viewing JIRA's Instrumentation Statistics
- Generating a Thread Dump
- Finding the JIRA Support Entitlement Number (SEN)
- Performance Testing Scripts
- Auditing in JIRA
- Lockout recovery process

**Finding your Server ID**

When creating a JIRA license, you'll be prompted to enter JIRA's Server ID. In this page you'll see how to retrieve this information from JIRA.

You can locate your Server ID of your JIRA installation in one of two places:

- **JIRA administration console** — if your JIRA installation is up and running already
- **JIRA Setup Wizard** — if you are installing JIRA for the first time

**JIRA administration console**

If your JIRA installation is up and running already, you can locate your Server ID in your JIRA administration console.

**To access the License Information page and view the Server ID:**

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose > System. Select License on the left menu to open the license information page.
   
   **Keyboard shortcut:** g + g + type License
3. The **Server ID** is displayed below the **License Type** information.

*Screenshot: License Details*
JIRA Setup Wizard

If you are installing JIRA for the first time, you can locate your Server ID under step 3 (Specify your License Key) of the JIRA Setup Wizard.

Screenshot: Setup Wizard

Increasing JIRA Memory

Java applications like JIRA and Confluence run in a "Java virtual machine" (JVM), instead of directly within an operating system. When started, the Java virtual machine is allocated a certain amount of memory, which it makes available to applications like JIRA. By default, Java virtual machines are allocated 64 MB of memory, no matter how many gigabytes of memory your server may actually have available. 64 MB is inadequate for
medium to large JIRA installations, and so this needs to be increased. Seeing OutOfMemoryErrors in the logs is symptomatic of this.

This page addresses how to increase Heap Space memory. Confirm that you’re not receiving Perm Gen or GC Overhead errors.

On this page:
- Step 1: Diagnosis
- Step 2: Increase Available Memory
- Step 3: Verify Your Settings

Step 1: Diagnosis

Expand to see diagnosis section

Assess Root Cause

Often, there is a root cause for OutOfMemory Errors that may be better to address than just increasing memory. See JIRA Crashes Due to ‘OutOfMemoryError Java heap space’ for a discussion.

Determine JIRA usage patterns

To determine the JIRA usage patterns:

Choose > System. Select Troubleshooting and Support > System Info to open the System Info page. Then scroll down the page to view the Java VM Memory Statistics section and look at the memory graph during times of peak usage:

This server has been allocated a maximum of 768 MB and a minimum of 256 MB (typically defined in the setenv script which is executed by running the start-jira script). If you are trying to see whether your settings are being picked up by JIRA, this is where to look. Here, you can see that JIRA has reserved 742 MB, of which 190 MB is actually in use. If this JIRA instance were running out of memory, it would have reserved the maximum available (768 MB), and would be using an amount close to this.

Determine available system memory
On Windows

From the Close Programs Dialogue (Press ctrl-alt-delete), select the Performance tab:

```
"Windows Task Manager"
```

The amount marked Available is the amount in kilobytes you have free to allocate to JIRA. On this server we should allocate at most 214 MB.

On Linux

Run `cat /proc/meminfo` to view the memory usage.

Setting the -Xmx above the available amount on the server runs the risk of OutOfMemoryErrors due to lack of physical memory. If that occurs the system will use swap space, which greatly decreases performance.

**Guidance**

As a rule of thumb, if you have fewer than 5000 issues, JIRA should run well with the default 768 MB. Granting JIRA too much memory can impact performance negatively, so it is best to start with 768 MB and make modest increases as necessary. As another data point, 40,000 works well with 768 MB to 1 GB.

Step 2: Increase Available Memory

**Linux**

Expand to see Linux instructions

To increase heap space memory in Linux installations:

1. In your `<JIRA Installation Directory>/bin` (or `<Tomcat Installation Directory>/bin` for JIRA WAR installations), open the `setenv.sh` file.
2. Find the sections `JVM_MINIMUM_MEMORY` and `JVM_MAXIMUM_MEMORY`.
3. See Diagnosis above and enter the appropriate values.

**Windows (starting from .bat file)**

Expand to see Windows .bat file instructions

To Configure System Properties in Windows Installations When Starting from the .bat File:

1. In your `<JIRA Installation Directory>/bin` (or `<Tomcat Installation Directory>/bin` for JIRA WAR installations), open the `setenv.bat` file.
2. Find the section `set JVM_MINIMUM_MEMORY` and `set JVM_MAXIMUM_MEMORY`.
3. See Diagnosis above and enter the appropriate values.

**Windows Service**

Expand to see Windows Service instructions
There are two ways to configure system properties when starting **Running JIRA as a Service**, either via command line or in the Windows Registry.

### Setting Properties for Windows Services via Command Line

1. Identify the name of the service that JIRA is installed as in Windows (Control Panel > Administrative Tools > Services):

   ![Service Configuration](image)

   In the above example, the **SERVICENAME** is: JIRA120312230938

2. Open the command window from Start > Run > type in 'cmd' > press 'Enter'

3. `cd` to the `bin` subdirectory of your JIRA Installation Directory (or the `bin` subdirectory of your Tomcat installation directory if you are running the JIRA WAR distribution).

   For Example:

   ```
   cd C:\Program Files\Atlassian\JIRA\bin
   ```
4. For JIRA 5.1 or below:

   \[\text{tomcat6w} \//\text{ES}\\%\text{SERVICENAME}\%\]

For JIRA 5.2 or above:

   \[\text{tomcat7w} \//\text{ES}\\%\text{SERVICENAME}\%\]

   \[\text{In the above example, it would be} \text{tomcat6w} \//\text{ES}\\%\text{JIRA120312230938}\%\]

5. Click on the Java tab to see the list of current start-up options:

   ![Java tab screenshot](image)

6. Set the maximum memory allocation here

   \[\text{Setting Properties for Windows Services via the Windows Registry}\]

   In some versions of Windows, there is no option to add Java variables to the service. In these cases, you must add the properties by viewing the option list in the registry.
To Set Properties for Windows Services via the Windows Registry,

1. Go to Start > Run, and run "regedit32.exe".

2. Find the Services entry:
   - **32-bit**: HKEY_LOCAL_MACHINE > SOFTWARE > Apache Software Foundation > Procrun 2.0 > JIRA
   - **64-bit**: HKEY_LOCAL_MACHINE > SOFTWARE >Wow6432Node > Apache Software Foundation > Procrun 2.0 > JIRA

3. To change existing properties, especially increasing Xmx memory, double-click the appropriate value.

4. To change additional properties, double-click options.

5. Modify the memory allocations here.
Step 3: Verify Your Settings

Expand to see verification instructions

To verify what settings are in place, check the `<JIRA Home Directory>/logs/atlassian-jira.log` or `catalina.out` file. A section in the startup appears like this:

```
JVM Input Arguments :
-Djava.util.logging.config.file=/usr/local/jira/conf/logging.properties
-XX:MaxPermSize=256m -Xms256m -Xmx384m -Djava.awt.headless=true
-Datlassian.standalone=JIRA
-Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER=true
-Dmail.mime.decodeparameters=true
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager
-Djava.endorsed.dirs=/usr/local/jira/endorsed -Dcatalina.base=/usr/local/jira
-Dcatalina.home=/usr/local/jira -Djava.io.tmpdir=/usr/local/jira/temp
```

Look for `Xmx` (maximum) and `Xms` (minimum) settings.

This display is also available by Viewing your System Information.

Using the Database Integrity Checker

Searching for common data inconsistencies, the Database Integrity Checker attempts to ensure that all JIRA data is in a consistent state.

This is useful in a number of situations, e.g.

- Before migrating a project to a new workflow
- An external program is modifying JIRA's database
- Troubleshooting a server crash

If an error is encountered, most of the integrity checks provide a 'repair' option which attempts to reset the data to a stable state.

Using the Integrity Checker

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose 🚀 > System. Select Troubleshooting and Support > Integrity Checker to open the Integrity Checker page.
   
   ✅ Keyboard shortcut: 'g' + 'g' + type 'integ'
The integrity checker has a number of ‘integrity checks’ that look for common inconsistencies in JIRA’s stored data.

3. Select one or more items whose data you would like to check the integrity of and click the ‘Check’ button.
4. After the selected checks run, the preview screen will be shown.
   The screen provides details about the existing data inconsistencies. If any inconsistencies were found, the 'Fix' button will also appear on the page. The messages in red describe inconsistencies that the check will correct if it is chosen and the 'Fix' button is clicked. Messages that appear in yellow are warnings that the check will not correct; JIRA will auto-recover from these inconsistencies when an action is taken on an issue.
   Select any inconsistencies that you would like to correct, then click the 'Fix' button.
   **Please Note:** We strongly recommend taking a backup of your data before correcting any data inconsistencies.
5. If any inconsistencies were found and you chose to correct them, you will be presented with a summary screen describing all the corrective actions that have taken place.

**Precompiling JSP pages**

If you decided to go the extra mile and extend JIRA’s build process to precompile JSP pages, keep in mind that the "include" directory in the JIRA web application needs to be excluded from precompilation. The reason for this is that the JSP files in the "include" directory are not proper JSP files, but are includes that are only meant to be compiled as part of larger JSP pages.

For example, to exclude the JSP pages in the "include" directory when using Maven use the <exclude> sub-element of the <ant:jspc> task, as shown:
Logging and Profiling

Logging

JIRA uses a powerful logging module called log4j for runtime logging.

Log file location

The logs are written to the log subdirectory of your JIRA Home Directory (or elsewhere if you have configured a different location). You can view the location of the atlassian-jira.log in the 'File Paths' section of the System Information page.

- Security-related information (e.g. login, logout, session creation/destruction, security denials) is written to atlassian-jira-security.log.

Changing the location of the log

In the log4j.properties file (located in the JIRA Installation Directory):

1. Change the following line:

   ```properties
   log4j.appender.filelog=com.atlassian.jira.logging.JiraHomeAppender
   ```

   ...to this:

   ```properties
   log4j.appender.filelog=org.apache.log4j.RollingFileAppender
   ```

2. Change the following line to point to the new location of the log file:

   ```properties
   log4j.appender.filelog.File=atlassian-jira.log
   ```

On this page:
- Logging
- Profiling
Logging levels

There are five logging levels available in log4j: 'DEBUG', 'INFO', 'WARN', 'ERROR' and 'FATAL'. Each logging level provides more logging information that the level before it:

- 'DEBUG'
- 'INFO'
- 'WARN'
- 'ERROR'
- 'FATAL'

'DEFAULT' provides the most verbose logging and 'FATAL' provides the least verbose logging. The default level is 'WARN', meaning warnings and errors are displayed. Sometimes it is useful to adjust this level to see more detail. **Please be aware:** the 'DEBUG' setting may cause user passwords to be logged.

The default logging levels can be changed either:

- **temporarily** — your change to the logging level will not persist after you next restart JIRA, or
- **permanently** — your change to the logging level will persist, even after you restart JIRA.

For example, when troubleshooting, you might temporarily change the logging level from 'WARNING' to 'INFO' so as to get a more detailed error message or a stack trace. If you are unsure of which logging categories to adjust, the most helpful information generally comes from the log4j.rootLogger category and the log4j.<category>.com.atlassian categories.

Temporarily changing the logging level

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose **System** > **Troubleshooting and Support** > **Logging & Profiling** to open the Logging page, which lists all defined log4j categories (as package names) and their current logging levels. 
   - Keyboard shortcut: 'g' + 'g' + start typing 'logging & profiling'
3. To change logging level of a category, click linked logging level associated with the relevant package name. To turn off logging of a category, click the 'OFF' link associated with the relevant package name.

Permanently changing the logging level

1. Edit the log4j.properties file (located in the JIRA Installation Directory).
2. Locate the section:

   ```
   log4j.logger.com.atlassian = WARN, console, filelog
   log4j.additivity.com.atlassian = false
   ```

   and make your desired changes (e.g. change the WARN to DEBUG).

   **Please Note:** The log4j.properties file that ships with JIRA has the default logging levels specified. For more information about log4j (e.g. how to define new logging categories), and about the format of the log4j.properties file, please refer to the documentation on the log4j site.

   3. **(Only if you are running JIRA WAR)** Rebuild and redeploy the web application.
4. Restart JIRA.

   **Please Note:** If your application server configures logging itself, you may need to remove the log4j.properties file. You may also need to remove the entire log4j.jar file to get logging to work.

Profiling

If you are experiencing performance issues with JIRA, it is often helpful to see where the slow-downs occur. To do this you can enable profiling as described below, and then analyse the performance traces that JIRA will produce for every request. An example of a profiling trace is shown below:
Profiling can be enabled either

- **temporarily** — profiling will be enabled until you next restart JIRA, or
- **permanently** — profiling will remain enabled, even after you restart JIRA.

**Temporarily enabling profiling**

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose Troubleshooting and Support > Logging & Profiling to open the Logging page, which lists all defined log4j categories (as package names) and their current logging levels.
3. Scroll to the 'Profiling' section at the end of the page. This section will inform you whether profiling is currently turned 'ON' or 'OFF' and will provide you with 'Disable' or 'Enable' profiling links respectively.
   - To turn Profiling 'ON', click the 'Enable profiling' link. JIRA will start generating profiling traces in its log.
   - To turn Profiling 'OFF', click the 'Disable profiling' link.

**Permanently enabling profiling**

1. In your JIRA installation directory, edit either the atlassian-jira/WEB-INF/web.xml file (or if you are using the JIRA WAR distribution, the webapp/WEB-INF/web.xml file).
2. Find the following entry:

   ```xml
   <filter>
     <filter-name>profiling</filter-name>
     <filter-class>com.atlassian.jira.web.filters.JIRAProfilingFilter</filter-class>
     <init-param>
       <!-- specify the which HTTP parameter to use to turn the filter on or off -->
       <!-- if not specified - defaults to "profile.filter" -->
       <param-name>activate.param</param-name>
       <param-value>jira_profile</param-value>
     </init-param>
     <init-param>
       <!-- specify whether to start the filter automatically -->
       <!-- if not specified - defaults to "true" -->
       <param-name>autostart</param-name>
       <param-value>false</param-value>
     </init-param>
   </filter>
   
3. Modify the autostart parameter to be **true** instead of **false**. That is:
4. Save the file. Profiling will be enabled when you restart JIRA.

If you are running JIRA WAR, re-build and re-deploy the JIRA web application using the build script and the instructions for your application server (i.e. Apache Tomcat).

Logging email protocol details

To assist in resolving email issues, it can be useful to know exactly what is passing over the wire between JIRA and SMTP, POP or IMAP servers. This page describes how to enable protocol-level logging.

To do this

Set `-Dmail.debug=true` and restart JIRA. Refer to Setting Properties and Options on Startup for details on how to do this.

Output

In the logs, you should then see JavaMail initialize the first time a mail operation is run:

```plaintext
DEBUG: JavaMail version 1.3.2
DEBUG: java.io.FileNotFoundException: /usr/local/jdk1.6.0/jre/lib/javamail.providers (No such file or directory)
DEBUG: !anyLoaded
DEBUG: not loading resource: /META-INF/javamail.providers
DEBUG: successfully loaded resource: /META-INF/javamail.default.providers
DEBUG: Tables of loaded providers
DEBUG: Providers Listed By Class Name:
{com.sun.mail.smtp.SMTPSSLTransport=javax.mail.Provider[TRANSPORT,smtps, com.sun.mail.smtp.SMTPSSLTransport, Sun Microsystems, Inc],
com.sun.mail.smtp.SMTPTransport=javax.mail.Provider[TRANSPORT,smtp,com.sun.mail.smtp.SMTPTransport, Sun Microsystems, Inc],
com.sun.mail.imap.IMAPSSLStore=javax.mail.Provider[STORE,imaps,com.sun.mail.imap.IMAPSSLStore, Sun Microsystems, Inc],
com.sun.mail.imap.IMAPStore=javax.mail.Provider[STORE,imap,com.sun.mail.imap.IMAPStore, Sun Microsystems, Inc],
com.sun.mail.pop3.POP3SSLStore=javax.mail.Provider[STORE,pop3s,com.sun.mail.pop3.POP3SSLStore, Sun Microsystems, Inc],
com.sun.mail.pop3.POP3Store=javax.mail.Provider[STORE,pop3,com.sun.mail.pop3.POP3Store, Sun Microsystems, Inc],
com.sun.mail.imap.IMAPStore=javax.mail.Provider[STORE,imap,com.sun.mail.imap.IMAPStore, Sun Microsystems, Inc],
com.sun.mail.pop3.POP3Store=javax.mail.Provider[STORE,pop3,com.sun.mail.pop3.POP3Store, Sun Microsystems, Inc],
com.sun.mail.smtp.SMTPSSLTransport=javax.mail.Provider[TRANSPORT,smtps, com.sun.mail.smtp.SMTPSSLTransport, Sun Microsystems, Inc],
com.sun.mail.smtp.SMTPTransport=javax.mail.Provider[TRANSPORT,smtp,com.sun.mail.smtp.SMTPTransport, Sun Microsystems, Inc],
com.sun.mail.imap.IMAPSSLStore=javax.mail.Provider[STORE,imaps,com.sun.mail.imap.IMAPSSLStore, Sun Microsystems, Inc],
com.sun.mail.imap.IMAPStore=javax.mail.Provider[STORE,imap,com.sun.mail.imap.IMAPStore, Sun Microsystems, Inc],
com.sun.mail.pop3.POP3SSLStore=javax.mail.Provider[STORE,pop3s,com.sun.mail.pop3.POP3SSLStore, Sun Microsystems, Inc],
com.sun.mail.pop3.POP3Store=javax.mail.Provider[STORE,pop3,com.sun.mail.pop3.POP3Store, Sun Microsystems, Inc],
```
Microsystems, Inc],
smtp=javax.mail.Provider[TRANSPORT,smtp,com.sun.mail.smtp.SMTPTransport,
Sun Microsystems, Inc])
DEBUG: successfully loaded resource:
/META-INF/javamail.default.address.map
DEBUG: !anyLoaded
DEBUG: not loading resource: /META-INF/javamail.address.map
DEBUG: java.io.FileNotFoundException: /usr/local/jdk1.6.0/jre/lib/javamail.address.map (No such file or
directory)
DEBUG: getProvider() returning
javax.mail.Provider[STORE,pop3,com.sun.mail.pop3.POP3Store,Sun
Microsystems, Inc]
DEBUG POP3: connecting to host "localhost", port 110, isSSL false
S: +OK Dovecot ready.
C: USER pop-test
S: +OK
C: PASS pop-test
[Filter: profiling] Using parameter [jira_profile]
[Filter: profiling] defaulting to off [autostart=false]
[Filter: profiling] Turning filter off [jira_profile=off]
S: +OK Logged in.
C: STAT
S: +OK 2 1339
C: NOOP
S: +OK
C: TOP 1 0
S: +OK
Return-path: <pop-test@atlassian.com>
Envelope-to: pop-test@localhost
Delivery-date: Wed, 28 Feb 2007 16:28:26 +1100
Received: from pop-test by teacup.atlassian.com with local (Exim 4.63)
   (envelope-from <pop-test@atlassian.com>)
   id 1HMHMY-0007gB-8O
   for pop-test@localhost; Wed, 28 Feb 2007 16:28:26 +1100
Date: Wed, 28 Feb 2007 16:28:26 +1100
From: Jeff Turner <jeff@atlassian.com>
To: pop-test@localhost
Subject: Testing to me - Wed Feb 28 16:28:23 EST 2007
Message-ID: <20070228052826.GA29514@atlassian.com>
MIME-Version: 1.0
Content-Type: text/plain; charset=us-ascii
Content-Disposition: inline
1. Disabling email sending/receiving

If you are restoring production data into a test JIRA instance for experimentation purposes, you probably want to disable JIRA's email interaction features before you begin:

- **Disable email notifications** — if JIRA is configured to send emails about changes to issues, and you want to make test modifications to the copy, you should start JIRA with the `-Datlassian.mail.sendd isabled=true` flag.
- **Disable POP/IMAP email polling** — if JIRA is configured to poll a mailbox (to create issues from mails), you will likely want to disable this polling on your test installation. This is done by setting the `-Datlassian.mail.fetchdisabled=true` flag.

Exactly how to set these flags is dependent on your particular application server, but for JIRA, this is done by setting the `DISABLE_NOTIFICATIONS` environment variable before starting JIRA (note, use `startup.sh` instead of `startup.bat` if you are not using Windows):
You could also try un-commenting the `DISABLE_NOTIFICATIONS=" -Datlassian.mail.senddisabled=true -Datlassian.mail.fetchdisabled=true -Datlassian.mail.popdisabled=true"` line from your `/bin/setenv.bat` file (`/bin/setenv.sh` if you are not using Windows) and then running startup.

2. Restoring XML data

These instructions assume that you are restoring JIRA data from an **XML backup**. If you used **native database tools** to back up your JIRA data, the restore process will be tool-specific and so these instructions (i.e. stage 2 of 3) do not apply to you.

1. Log in as a user with the 'JIRA System Administrators' global permission.

2. Choose > System. Select **Import & Export > Restore System** to open the Restore JIRA data from Backup page.

   ![Keyboard shortcut: 'g' + 'g' + 'rest']

   - In the 'File name' field, type the file name of the zipped XML backup file generated by JIRA.
   - Ensure that this backup file has been moved or copied to the location specified below this field.
   - The **Index Path** field indicates where JIRA will restore the search index data from the zipped XML backup file. This location (which cannot be modified) matches the index path specified in the zipped XML backup file. If, however, this backup file does not specify an index path, JIRA will restore the search index to the `caches/indexes` subdirectory of the JIRA Home Directory.
   - **Please Note:**
     - The contents of the index directory may be deleted by the restore process.
     - The index directory should only contain JIRA index data.
   - Click the 'Restore' button and wait while your JIRA data is restored.

   - Once the data has been restored, JIRA will inform you that you have been logged out. This happens because all JIRA users which existed in JIRA prior to JIRA's data being restored will have been deleted and replaced by users stored in the JIRA export file.
   - It is recommended that you avoid passing through a proxy when performing an XML restore, especially if your JIRA instance is very large. Using a proxy may cause timeout errors.

3. Restoring attachments

   If you created a backup of the attachments directory, you will need to restore the backup into a directory where JIRA can access it.
If you use a custom directory for storing your attachments, ensure that JIRA has read and write permissions to this directory and its subdirectories.

The process of restoring the attachments backup depends on the way it was created. Usually you can use the same tool to restore the backup as the one that was used to create it (see Backing up attachments).

If you are restoring the attachments into a different location (i.e. a different directory path) from where they were previously located (e.g. this will be the case when moving servers), please follow the instructions provided in Configuring attachments to change the location of the attachments directory so that JIRA can find the restored attachments.

Restoring a Project from Backup

At this moment, Project Import functionality does not include Active Objects data and so it is not possible to move JIRA Agile and JIRA Service Desk project data between instances.

This page describes how to restore a single project from a backup file into your JIRA instance. This also includes instructions on how to migrate a project from JIRA Cloud to JIRA Server (see the Restoring a project from JIRA Cloud to JIRA Server section below).

This feature is particularly useful if you do not wish to overwrite the existing projects or configuration of your JIRA instance by importing the entire backup. Your backup file must have been created using JIRA’s backup tool. You cannot import a project from a backup using your native database tools.

If you wish to restore a project from a backup file into a new empty JIRA instance, we highly recommend that you do not use the Project Import tool. Restoring the entire backup file into the new instance and then deleting unwanted projects is much simpler in this scenario, as you will retain the configuration settings from your backup. Instructions on moving a project to a new instance are available on the splitting a JIRA instance page. Projects can be deleted via the 'Projects' page in JIRA, which is accessed from the "Administration" menu.

**On this page:**
- Before you begin
  - Project Import Restrictions
- Restoring a project from JIRA Cloud to JIRA Server
- Restoring your project
  - Preparing your target JIRA Server instance
  - Project Import
  - Need Help?

**Before you begin**

Restoring a project from a backup is not a trivial task. You may be required to change the configuration of your target JIRA instance to accommodate the project import. Additionally, the Project Import data mapping can be resource intensive on your hardware and may take a long time to complete, if you are importing a large project. Note, the Project Import tool will lock out your instance of JIRA during the actual data import (not during the validations), so please ensure that your instance does not need to be accessible during this time.

We strongly recommend that you perform a full backup of your target JIRA instance before attempting to restore a project into it.

**Project Import Restrictions**

The Project Import tool will only import a project between identical instances of JIRA. That is;

- The version of JIRA in which your backup was created must be identical to the version of your target
JIRA instance, e.g. if your backup file was created in JIRA 4.0, then your target instance of JIRA must be version 4.0.

- If your instance of JIRA had any custom field plugins (e.g. JIRA Toolkit) installed when the backup file was created and the custom field was used in your project, then your target instance of JIRA must have the same version of the plugins installed for the Project Import tool to automatically work.

- Project Import functionality does not currently include Active Objects data. This means data such as JIRA Agile sprints and Service Desk customer portals will not be included.

If any of these restrictions apply and you still wish to restore your project from backup, you will need to create a compatible backup file before importing your project by following the appropriate instructions below.

**JIRA versions do not match**

- If your backup file was created in an earlier version of JIRA than your target instance of JIRA:
  1. Set up a test JIRA instance, which is the same version as your target instance of JIRA. Make sure that the test JIRA instance uses a separate database and index from your target JIRA instance.
  2. Import the backup file into a test JIRA instance. (This will completely overwrite the test instance.)
  3. Create a new backup file from your test JIRA instance. You can now use this backup to import a specific project into your target production instance.

- If your backup file is from a later version of JIRA than your target instance of JIRA:
  1. Upgrade the version of your target instance of JIRA to match the version of JIRA in which the backup was created.

**Custom fields plugin versions do not match**

- If the custom fields plugin from your backup is an earlier version than the custom fields plugin in your target instance of JIRA:
  1. Import the backup file into a test JIRA instance. Make sure that the test JIRA instance uses a separate database and index from your target JIRA instance, as the import will overwrite all data in the database.
  2. In your test JIRA instance, upgrade your version of your custom fields plugin to match the version of the plugin in your target instance of JIRA.
  3. Create a new backup file from your test JIRA instance.

- If the custom fields plugin from your backup is a later version than the custom fields plugin in your target instance of JIRA:
  1. Upgrade the custom fields plugin version of your target instance of JIRA to match the version of JIRA in which the backup was created.

**Restoring a project from JIRA Cloud to JIRA Server**

You cannot import a project directly from JIRA Cloud to JIRA Server — the importer will display errors about version mismatches. If you want to restore a project from JIRA Cloud to JIRA Server, follow the steps below:

1. Install a new JIRA Server instance (in addition to the one that you want to import your project into). This will be a temporary instance that is used to store a full JIRA import from JIRA Cloud. Ensure that the version of this temporary instance matches the version of the JIRA instance that you want to import your project into, e.g. JIRA 6.2.
2. Do a full JIRA migration from JIRA Cloud to the temporary JIRA Server instance. See Migrating from JIRA Cloud to JIRA Server.
3. Export the entire JIRA Server instance.
4. Import the project into your desired JIRA Server instance, by following the instructions in the Restoring your project section below.
5. (optional) Delete the temporary JIRA Server instance, once the project has completed.

**Restoring your project**

The Project Import tool will attempt to map the data in your backup file into your target JIRA Server instance. If the project you are restoring does not exist in your target JIRA Server instance, it will create and populate the project with data from your backup. If the project already exists and is empty, it will attempt to populate the data from your backup into the project.
You may wish to carry out the following setup tasks to ensure that your target JIRA Server instance is prepared to receive a project import beforehand. This can improve the time taken to validate the data mappings to your target JIRA Server instance.

If you are confident that your JIRA Server instance is set up appropriately, you can skip straight to the Project Import tool instructions. If there are any problems mapping the data from your backup file to your target JIRA Server instance, the Project Import tool will present validation errors for you to address.

### Preparing your target JIRA Server instance

The Project Import tool does not automatically add missing project entities (e.g. user groups, issue priorities, custom field types) or fix incorrect associations (e.g. issue types in workflow schemes), so some manual work is required to set up your target JIRA Server instance so that your project can be restored. If the Project Import wizard cannot find a valid target location for any of the backup project data, it will not be able to restore the project. The instructions below describe the setup activities that address the most common data mapping problems that occur when restoring a project from a backup.

We recommend that you perform as much of the configuration of your target JIRA Server instance as possible, prior to starting the project import. However, if you do not have the information available to complete these setup activities beforehand, the Project Import wizard will inform you of any problems that need your attention. Alternatively, you can import the backup file into a test JIRA Server instance to check the configuration.

#### 1. Setting up the project

If you have a project in your target JIRA Server instance that you wish to restore data into, you will need to ensure that the project is empty, i.e.

- no issues — read the [Quick Search page](#) to find out how to find all issues in a project
- no components — read the [Component Management page](#) to find out how to view a summary of a project's components
- no versions — read the [Version Management page](#) to find out how to view a summary of a project's versions

#### 2. Setting up users and groups

The following types of users are considered mandatory for a project to be imported:

- reporter, assignee, component lead or project lead.

The following users are considered to be optional for a project to be imported:

- comment author/editor, work log author/editor, a user in a custom field (user picker), voter, watcher, change group author (i.e. someone who has changed an issue), attachment author, user in a project role.

The Project Import will attempt to create missing users if they are associated with the project. However, if the Project Import tool cannot create missing mandatory users in your target JIRA Server instance, then you will not be permitted to import the project. This may occur if you have [External User Management](#) enabled in your target JIRA Server instance — you will need to disable External User Management or create the missing users manually in your external user repository before commencing the import.

Please note that if you do not have enough information about the users in your backup file, the Project Import wizard will provide a link to a table of the missing users on a new page as well as a link to an XML file containing the missing users (on the new page). The table of users will display a maximum of 100 users, but the XML file will always be available.

---

Why should I create an empty project in my target JIRA instance?

It is important to note that the primary task of the Project Import tool is to restore the data from your backup project into your target JIRA Server instance. While the Project Import tool can create a project if one does not exist in your target JIRA Server instance, it does not recreate any configuration settings that affect the data (e.g. screen schemes). If you wish to retain any configuration settings from your original project, we recommend that you create an empty project in your target instance with the necessary configuration settings before importing the data from your backup project.
3. Setting up custom fields

As described previously, the versions of your custom field plugins must match between your backup and your target instance of JIRA for your project to be imported. You need to ensure that you have set up your custom fields correctly in your target JIRA instance, as follows:

- **Custom Field Type** — If you do not have a particular custom field type (e.g. cascading select) installed on your target JIRA, then all custom field data in your backup project that uses that custom field type will not be restored. However, your project can still be restored.
  
  For example, say you have a custom field, 'Title', which is a 'Cascading Select' field type and was used in your backup project (i.e. there is saved data for this field). If you do not have the 'Cascading Select' custom field type installed on your target JIRA, then all data for custom field 'Title' (and all other cascading select custom fields) will not be restored.

- **Custom Field Configuration** — If you do have a particular custom field type (e.g. multi select) installed on your target JIRA, then you must configure all of the custom fields (of that custom type) in your target JIRA to match the equivalent custom fields in your backup project. Additionally, if your custom field has selectable options, then any options used (i.e. there is saved data for these options) in your backup project must exist as options for the custom field in your target JIRA.

  For example, say you have a custom multi select field named, 'Preferred Contact Method', in your backup project with options, 'Phone', 'Email', 'Fax'. Only the 'Phone' and 'Email' were actually used in your backup project. In this scenario, you need to set up your target JIRA instance as follows:
  
  - There must be a field named, 'Preferred Contact Method', in your target JIRA instance.
  - 'Preferred Contact Method' must be a multi select custom field type.
  - 'Preferred Contact Method' must have the options, 'Phone' and 'Email' at a minimum, since they were used in your backup project. Please note, 'Preferred Contact Method' in your target JIRA could also have additional options like 'Fax', 'Post', 'Mobile', etc, if you choose.

  If you have not configured your existing custom field correctly, you will not be permitted to import your backup project until you correct the configuration errors in your target JIRA. You may wish to refer to the custom fields documentation for more information on the custom field types and custom field configuration.

- **Compatibility with the Project Import tool** — Custom fields also need to be compatible with the Project Import tool for the custom field data to be imported. Custom fields created prior to JIRA v4.0 cannot be imported by the Project Import tool. The custom field developer will need to make additional code changes to allow the Project Import tool to restore the custom field data. If any of the custom fields used in your backup file are not compatible with the Project Import tool, the Project Import wizard will warn you and the related custom field data will not be imported. All the target JIRA system custom fields and the custom fields included in JIRA plugins supported by Atlassian (e.g. JIRA Toolkit, Charting Plugin, Labels Plugin, Perforce Plugin) are compatible with the Project Import tool.

4. Setting up workflows, system fields, groups and roles

In addition to custom fields, you need to correctly configure the project workflow, issue attributes (e.g. issue types) and groups/roles in your target JIRA instance for your project to be restored successfully. Please ensure that you have reviewed the constraints on each of the following:

**Workflows and Workflow Schemes:**

- The project import process does not import workflows or workflow schemes. If you wish to retain a customized workflow from your backup, you will need to create a new workflow in your target JIRA instance and manually edit the new workflow (e.g. create steps and transitions) to reflect your old workflow (note, the default JIRA workflow is not editable). You will then have to add this workflow to a workflow scheme to activate it.

  Read more about creating and editing workflows in the JIRA Workflow and Activating Workflows documents. Please note that you may be required to create and edit a new workflow and workflow scheme to satisfy constraints on workflow entities from your backup, as described in the sections below, even if you do not wish to recreate the exact same workflow.

**Do not** use the JIRA functionality for exporting and importing workflow XML definitions, to copy your backup workflow to your target JIRA instance. The workflow import/export tools do not include workflow screens in the process. Hence, you will be required to manually edit the workflow definitions post-import to match up new screens to the workflow, which is more work than it is worth.
Issue Types:

- If an issue type has been used in your backup project (i.e. there are issues of this issue type), you must set up the same issue type in your target JIRA project. You may want to consider setting up Issue Types for the project instead of globally.
- Workflow schemes — If you have associated an issue type with a particular workflow scheme in your backup project, you must ensure that the same association exists in your target JIRA. See the above section on 'Workflow and Workflow Schemes' for further information on how to set up a workflow in your target JIRA instance.
- Custom field configuration schemes — custom field configuration schemes can be used to apply a custom field configuration to specific issue types. If you have configured a custom field differently for different issue types in your backup project, you may wish to set up a custom field configuration scheme to apply the same custom field configuration to the same issue types in your target JIRA instance. This will help ensure that you do not have a custom field for an issue type that is configured incorrectly (e.g. missing an option, if it has multiple selectable options), as described in the 'Setting up custom fields' section above.

Statuses:

- If an issue status has been used in your backup project (i.e. there are issues with the status), you must set up the same status in your target JIRA project.
- Workflow schemes — If you have linked a status into a particular workflow scheme in your backup project, you must ensure that the same association exists in your target JIRA. See the above section on 'Workflow and Workflow Schemes' for further information on how to set up a workflow in your target JIRA instance.

Security Levels:

- If an issue security level has been used in your backup project (i.e. there are issues with this security level), it must be set up in your target instance of JIRA. If you did not create an existing empty project, we recommend that you do so and set up the appropriate security levels for the project (via an issue security scheme).
- Issue Security schemes — Not applicable. It does not matter which users, groups or project roles are assigned to which security levels, as long as the appropriate security levels exist (please see the constraints on security levels in the 'Setting up entities and types' section).

Priority:

- If an issue priority has been used in your backup project (i.e. there are issues with this priority), it must be set up in your target instance of JIRA.

Resolution:

- If an issue resolution has been used in your backup project (i.e. there are issues with this resolution), it must be set up in your target instance of JIRA.

Issue Link Type:

- If an issue link type has been used in your backup project (i.e. there are issues associated by this link type), it must be set up in your target instance of JIRA.

Project Role:

- If a project role has been used in your backup project (i.e. there are users/groups assigned to this project role), it must be set up in your target instance of JIRA.
  (Note: The Project Import tool will copy across the project role membership from your backup project to your target JIRA instance, if you choose. See the Project Import section for further details).

Group:

- If a user group has been used in your backup project (i.e. there are users in this group), it must be set up in your target instance of JIRA.
5. Setting up links

The Project Import tool will automatically create all issue links between issues within your backed up project. It will also try to create links between the backup project and another project, as long as the other project already exists in your target JIRA instance with the relevant issue keys. If the source/target of a link cannot be found (i.e. the entire project or the particular issue may be missing), the link will not be created although the project will still be imported.

Note that the Project Import tool will create issue links between projects in either direction (source to target, or target to source). This means that if you import two projects from the same backup file, the second project import will create all of the links between the two projects that were missing from the first project import.

Once you have completed as many of the setup tasks as you are able to, run the Project Import tool.

### Project Import

Restoring your project is a four step process:

1. Specify the backup file
2. Select a project
3. Review data mapping validations
4. Verify the restored project

If you start the Project Import tool, we strongly recommend that you complete all steps of the wizard before performing any other activities in JIRA. Please be aware that it can take some time to validate the data mappings and then import the project.

You will most likely need to navigate away from the Project Import wizard to correct your JIRA configuration, as advised by validation errors in the wizard. If you have to navigate to other pages in JIRA to correct your JIRA configuration or for other activities, you should:

- **(recommended)** open a separate session of JIRA in a new browser window/tab. When you return to the Project Import wizard in the original browser window/tab, you can use the 'Refresh validations' button on the validation screen to re-validate the data mappings; or,
- wait until the progress bar completes for the step you are currently in, before navigating elsewhere in JIRA. The state of the Project Import wizard will be saved until you log out of JIRA, your user session expires or you commence a different project import. You can resume your project import by returning to the Project Import page (via the main Administration menu) and selecting the 'resume' link on the first page of the wizard.

1. Specify the backup file

A note about schemes

The project import process does not directly affect schemes, although entities and types associated with schemes may be affected as described above. Please note that the following schemes are not affected at all by the project import:

- **Permission schemes** — Not applicable. Permissions schemes do not need to match between the backup and target instance of JIRA.
- **Notification schemes** — Not applicable. Notification schemes do not need to match between the backup and target instance of JIRA.
- **Screen schemes** — Not applicable. Screen schemes do not need to match between the backup and target instance of JIRA.
- **Issue type screen schemes** — Not applicable. Issue type screen schemes do not need to match between the backup and target instance of JIRA.
- **Field Configuration schemes** — Not applicable. Please note that if a field was configured as optional in your backup project and is configured as a required field in your target JIRA instance, then the project will still be imported even if the field is empty. However, this field will be enforced as mandatory the next time a user edits an issue containing the field.
To start the Project Import tool,

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose System > Import & Export > Project Import to open the Project Import wizard page.
3. Specify the path and name of your backup file in the 'File name' field. Your backup file must be an XML or ZIP file (as exported by JIRA).
4. Copy the attachments from the path where you have backed up the attachments to the 'Backup Attachment Path' shown in the import window. This path is under the JIRA Home Directory of the instance. Please note that if file attachments are not enabled in your target JIRA instance you will not see the path to which you need to copy the attachments from the backup. **Note:** You can choose to not copy the attachments to the 'Backup Attachment Path'. If so, you will be able to restore your project from backup, however it will have no attachments associated with it. Please note, you cannot restore your attachments separately if you do not restore them as part of the project import, as the database entries for the attachments will be missing.

2. Select a project to restore
1. Select a project to restore from the 'Projects from Backup' dropdown. This dropdown will list all of the projects contained in your backup file.

2. If you have a valid project to restore from your backup, and your target JIRA instance has an existing empty project, then the 'Overwrite Project Details' option will display. Select the 'Overwrite Project Details' option if you want to overwrite the project details of the existing empty project with the project details from your backup. The project details are the Name, URL, Project Lead, Default Assignee and Description of the project, as well as any project role members set up on your project. If there is no existing empty project in your target instance of JIRA, this option will be checked and disabled as the Project Import will create the project with project details from your backup file.

3. Review data mapping validations
1. The Project Import wizard will attempt to validate the data mappings required to import your project from the backup file. You can review the validations at this step of the wizard and modify your target JIRA instance as required.

   - A tick symbol (✅) means that there are no problems with mapping these entities.
   - An exclamation mark symbol (⚠️) means that there are problems with the data mapping that you should review before importing the project, but the project can still be imported. For example, a missing optional user that cannot be created automatically by the Project Import tool.
   - A cross symbol (❌) means that there are problems with the data mapping that must be fixed before you can import the project. For example, an Issue Type that is used in the backed up project is missing in your target JIRA instance.

2. The ‘Preparing your target JIRA instance’ section on this page lists the common data mapping errors.
3. Once you have resolved the data validation errors as required, click ‘Import’ to commence the import of data from your backup file.

The Project Import tool will lock out your instance of JIRA during the actual data import (not during the validations), so please ensure that your instance does not need to be accessible during this time.

4. Verify the restored project
1. Once the Project Tool has finished running, click 'OK' to navigate to the restored project. You should verify that the issues, components and versions have been restored correctly. You should also check that any custom field data and links have been restored correctly.

2. Check that your attachments were correctly restored from your attachments backup directory.

The Project Import tool will add an entry to every imported issue's Change History, showing when the issue was imported. Note that old entries in the Change History, from before the import, are retained for historical purposes only. Old entries may contain inconsistent data, since the configuration of the old and new JIRA systems may be different.

What if something went wrong?

- If your project import did not complete, you can refer to the JIRA log file. The Project Import tool will log details of the operation to this file, including any unexpected errors and exceptions. e.g. database locked out, disk full... etc.
- If your project import completed but did not restore your project as expected, you may wish to attempt to fix the problem manually in your target JIRA instance. You may also wish to try deleting the project in your target JIRA instance and re-importing it from backup, paying special note to any warning validations (e.g. users that will not be added automatically).

If you cannot resolve the problem yourself, you can contact us for assistance. Please see the 'Need help' section below for details.

Need Help?

Need further help? You can raise a support request in the JIRA project at https://support.atlassian.com for assistance from our support team. Please attach to the support case:

- the backup file you are trying to import projects from, and
- the following information from your target JIRA instance:
  - your log file
  - an XML backup of your target JIRA instance
  - a copy and paste of the entire contents of the System Info page (accessed via the System Info tab), so that we know the details of your JIRA configuration.

You can anonymise the XML backups, if your data contains sensitive information.

Optimizing Performance

For more information about optimising performance in JIRA, please refer to our Crashes and Performance...
1. Backing up database contents

There are two possibilities: native database backup tools, or JIRA's XML backup utility.

For production use, it is strongly recommended that for regular backups, you use native database backup tools instead of JIRA's XML backup service.

When JIRA is in use, XML backups are not guaranteed to be consistent as the database may be updated during the backup process. JIRA does not report any warnings or error messages when an XML backup is generated with inconsistencies and such XML backups will fail during the restore process. Native database backup tools offer a much more consistent and reliable means of storing (and restoring) data while JIRA is active.

Caveat: if you are migrating your instance, we recommend that you create an XML backup (per the directions in this guide) where possible. In certain cases, such as very large instance sizes, this may not be possible due to the system requirements for an XML backup.

Using native database backup tools

All serious databases come with tools to back up and restore databases (the 'MS' in RDBMS). We strongly recommend these tools in preference to the XML backup option described below, as they:

- ensure integrity of the database by taking the backup at a single point in time
- are much faster and less resource-intensive than JIRA's XML backup.
- integrate with existing backup strategies (e.g. allowing one backup run for all database-using apps).
- may allow for incremental (as opposed to 'full') backups, saving disk space.
- avoid character encoding and format issues relating to JIRA's use of XML as a backup format.

See the documentation for your database on how to set up periodic backups. This typically involves a cron job or Windows scheduled task invoking a command-line tool like `mysqldump` or `pg_dump`.

Using JIRA's XML backup utility

To perform a once-off backup, e.g. before an upgrade, follow the steps below.

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose System > Import & Export > Backup System to open the Backup JIRA data page. Keyboard shortcut: 'g' + 'g' + type 'backup'

   Screenshot: The Backup JIRA Data Page
As shown in the screenshot above, the backup will be stored within the export subdirectory of the JIRA Home Directory.

3. In 'File name' field, type the name of the backup file.
   - Ensure that JIRA has the necessary file system permissions to write to this location. See the relevant procedures in the JIRA Installation and Upgrade Guide for details on creating a dedicated operating system account to run JIRA.

4. Click the 'Backup' button and wait while your JIRA data is backed up.
   - JIRA will save your XML backup as a zipped archive file.

5. When the backup is complete, a message will be displayed, confirming that JIRA has written its data to the file you specified.

2. Backing up the data directory

The data directory is a sub-directory of your JIRA Home Directory. It contains application data for JIRA, e.g. if you have attachments enabled, all files attached to JIRA issues are stored in the data\attachments directory (not in the database).

To back up the data directory, you need to create a snapshot of the data directory (including all files and subdirectories), then back up the snapshot. Note that the directory structure under the data directory must be preserved in the snapshot.

Creating this snapshot is an operating system-specific task, e.g.:

- On MS Windows, a batch script copying the directory can be written and scheduled periodically (Programs > Accessories > System Tools > Scheduled Tasks).
- On Linux/Solaris, it is best to write a small shell script, placed in /etc/cron.daily, backing up files to a directory like /var/backup/jira. It is best to copy an existing script in /etc/cron.daily to ensure local conventions (file locations, lockfiles, permissions) are adhered to.

Your "attachments" directory may be located elsewhere

If you have put your attachments directory in a custom location (see Configuring File Attachments) rather than inside the data directory, you will also need to back up your attachments directory using the snapshot method described above.
Automating JIRA Backups

JIRA can be configured to automatically create an XML backup of JIRA data on a routine basis.

ℹ️ Please Note:

- The XML backup includes all data in the database. However, it **does not include** your attachments directory, JIRA Home Directory or JIRA Installation Directory, which are stored on the filesystem.
- You can also perform XML backups manually. See **Backing Up Data** for details.
- Be aware that after installing JIRA and running the setup wizard, a backup service will automatically be configured to run every 12 hours.

For production use or large JIRA installations, it is **strongly recommended** that you use native database-specific tools instead of the XML backup service. XML backups are not guaranteed to be consistent, as the database may be updated during the backup process. Inconsistent backups are created successfully without any warnings or error messages, but fail during the restore process. Database-native tools offer a much more consistent and reliable means of storing data.

To configure automated JIRA backups:

1. Log in as a user with the **JIRA System Administrators** global permission.
2. Select **Administration > System > Advanced > Services** (tab) to open the **Services** page, which lists the current services running on this system. By default, there should be at least one 'Mail Queue Service' running, which cannot be deleted.

✔️ **Keyboard shortcut**: `g + g +` start typing `services`

3. In the **Add Service** form towards the end of the page, complete the following fields:
- **Name** — a descriptive name for the backup service, such as Backup Service.
- **Class** — the appropriate fully-qualified class name for the Backup service using either of the following methods:
  - Select the Backup service from the list of JIRA's Built-in Services. To do this:
    a. Click the Built-in Services link below the Class field to expand the list of JIRA's built-in service classes.
    b. Click the Backup service link. The Class field will automatically be populated with the following class text string 'com.atlassian.jira.service.services.export.ExportService'.
  - Type the fully-qualified class name 'com.atlassian.jira.service.services.export.ExportService' into the Class field.
- **Delay** — enter the number of minutes between backups. A good default for this would be 720 minutes (12 hours) or 1440 minutes (24 hours). **Please Note:** The interval specified in the Backup Service Delay (mins) is the time when the next backup job will run since the last server restart. Backup services cannot be scheduled to run at a specific time of day - please see JRA-1865 for more on this.

4. Click the **Add Service** button. The **Edit Service** page is displayed.

5. Complete the following items on this page:
   - For the **Date format** field, specify the format which JIRA will use to name the individual backup files. This format can be anything that SimpleDateFormat can parse. A good default is 'yyyyMMdd-MMM-dd-HHmm', which would generate files named like this: '2007-Mar-05-1322'.
   - For the **Delay** field, modify the number of minutes between backups if necessary.
   - If the **Use Default Directory** check box is displayed, see the note below.

6. Click the **Update** button. Your backup service is now configured. XML backups will be performed according to the schedule you specified in the **Delay** field.
   - For every successful backup, a zipped file of your XML backup will be saved in the backup directory.
   - If a scheduled backup fails for any reason, the zipped XML backup file will be saved into the 'corrupted' directory, which is directly under your nominated backup directory. A file explaining the reason for the failure will be written to the 'corrupted' directory. This file will have the same name as the backup file, but with the extension '.failure.txt'. **Please Note:** JIRA will create the 'corrupted' directory if required - you do not need to create it.

---

**About custom backup directories**

The **Use Default Directory** check box (not shown in screenshot above) is for legacy JIRA installations (prior to JIRA 4.2), which have backup services that use custom directories.

If you are using JIRA 5.1.0 or earlier, the **Use Default Directory** will always be displayed, as the option of using custom directories has been deprecated. If you are using JIRA 5.1.1 or later, the **Use Default Directory** check box will only be displayed if you upgraded from a version of JIRA prior to 4.2 and you are editing an existing backup service which used a custom directory.

- If you are not using a legacy backup service with a custom directory, select the the **Use Default Directory** check box. If you do not, your backup service may not work correctly.
- If you are using a legacy backup service with a custom directory, you can choose between using...
Preventing users from accessing JIRA during backups

For production use, it is strongly recommended that for regular backups, you use native database backup tools instead of JIRA’s XML backup service.

When JIRA is in use, XML backups are not guaranteed to be consistent as the database may be updated during the backup process. JIRA does not report any warnings or error messages when an XML backup is generated with inconsistencies and such XML backups will fail during the restore process. Native database backup tools offer a much more consistent and reliable means of storing (and restoring) data.

If you perform an XML backup (e.g. when upgrading JIRA via a test environment or migrating JIRA to another server), you can follow one of these methods to prevent users from accessing JIRA and minimise inconsistencies in the backup file:

- **Recommended method:**
  - If you have an Apache or other web/proxy server sitting in front of JIRA, then you can stop Apache from proxying to JIRA, and serve a static HTML page with a nice message along the lines of “JIRA is undergoing maintenance”. Note:
    - The administrator must be able to access JIRA directly (not through Apache) to perform the XML backup.
    - This method does not require JIRA to be restarted.

- **Alternative method 1:**
  1. Shut down JIRA, configure it to listen on a different port and restart. Do this by editing the `server.xml` file (or the `jira.xml` file in your Apache Tomcat installation running JIRA WAR). Change the following section:

     ```xml
     <Connector port="8080"
       maxHttpHeaderSize="8192" maxThreads="150"
       minSpareThreads="25" maxSpareThreads="75" useBodyEncodingForURI="true"
       enableLookups="false" redirectPort="8443" acceptCount="100"
       connectionTimeout="20000" disableUploadTimeout="true" />
     ```

    - Note: If you have enabled HTTPS, then you would need to edit the HTTPS Connector section as well.
  2. Restart JIRA and do the XML backup.
  3. Shut down JIRA, change all the settings back, then re-start JIRA.

- **Alternative method 2:**
  - If you have a firewall in front of JIRA, you could stop requests from getting through or change the port number that it uses. Note:
    - The administrator will need to log in to JIRA on the temporary port number (or access it from behind the firewall), to perform the XML backup.
    - This method does not require JIRA to be restarted.

Before you start:
Whichever method you choose, we recommend setting an Announcement Banner to warn your users that JIRA will be unavailable for a period of time.

Search Indexing

In order to provide fast searching, JIRA creates an index of the text entered into issue fields. This index is stored in the default directory or your custom directory (cannot be edited). Note, if you choose the default directory option, you will not be able to choose the custom directory option.

The default directory location is the `export` subdirectory of the JIRA Home Directory.

In order to provide fast searching, JIRA creates an index of the text entered into issue fields. This index is stored in the default directory or your custom directory (cannot be edited). Note, if you choose the default directory option, you will not be able to choose the custom directory option.

The default directory location is the `export` subdirectory of the JIRA Home Directory.
on the file system, and updated whenever issue text is added or modified. It is sometimes necessary to regenerate this index manually; for instance if issues have been manually entered into the database, or the index has been lost or corrupted.

See Re-Indexing after Major Configuration Changes for more information on when you should re-index.

Re-indexing JIRA

1. Log in as a user with the 'JIRA Administrators' global permission.
2. Choose ☰ > System, Select Advanced > Indexing to open the Indexing page.
   Keyboard shortcut: 'g' + 'g' + type 'index'
3. This page allows you to choose one of the following two re-indexing options:
   - **Background re-index** — This will re-index all issues in the background.
   - **Lock JIRA and rebuild index** — This will delete and rebuild all indices, including the comment and change history indices.

**Screenshot: Re-indexing JIRA**

<table>
<thead>
<tr>
<th>Re-Indexing</th>
<th>Background re-index</th>
<th>This will take longer but will allow users to access JIRA during the re-index.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lock JIRA and rebuild index</td>
<td>JIRA will be unavailable to all users until the re-index is complete. This is faster, but may still take a while depending on the size of your instance and hardware.</td>
</tr>
<tr>
<td>Index path</td>
<td>/data/jirastudio/jira/home/caches/indexes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Re-Index</td>
<td></td>
</tr>
</tbody>
</table>

**Which re-indexing option should I use?**

The **Background re-index** option should be used in the majority of circumstances, particularly following changes to the configuration. It will generally take significantly longer to perform than the **Lock JIRA and rebuild index** option, but it allows JIRA to remain usable while it is being done. There will however be a performance impact on JIRA as a whole. We recommend that you perform this option during a low usage period. The actual impact of running the **Background re-index** option will depend upon the customer's particular hardware and software installation as well as how many issues are in the system.

The **Lock JIRA and rebuild index** should be used when:

- the indices are corrupt, which may be caused by a system or disk failure or
- it is more important to have the re-index completed quickly than to have JIRA continuously available. The **Lock JIRA and rebuild index** option may be in the order of twice as fast as a background re-index.

The following table summarises the differences between the two options:

<table>
<thead>
<tr>
<th>Background re-index</th>
<th>Lock JIRA and rebuild index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slower to complete.</td>
<td>Faster to complete (may be up to twice as fast).</td>
</tr>
<tr>
<td>JIRA can be used by users during re-index.</td>
<td>JIRA cannot be used by users during re-index.</td>
</tr>
<tr>
<td>Can be cancelled at any time.</td>
<td>Cannot be cancelled once started.</td>
</tr>
</tbody>
</table>

**Backing up and recovering your index**

Enabling index recovery will cause a snapshot of the indexes to be taken periodically. This allows you to recover your index quickly, rather than rebuilding the index, if there is a failure. This is particularly useful if you have a large JIRA installation and you cannot afford for it to be offline for long. If you have a small JIRA instance, it may
not be worth enabling index recovery, as it rebuilding the index won’t take much time.

Whether a full index rebuild is faster than recovering from a snapshot depends on a number of factors, including how recent the snapshot being recovered was taken. Large and complex installations should test this process on a development/testing server before relying on it in production.

To enable index recovery:

1. Navigate to the Indexing page (as described above).
2. Click Edit Settings to enable index recovery and choose the frequency of snapshots.
   - Snapshots are stored in the <yourjirahome>/export/indexsnapshots directory.

To recover an index:

1. Navigate to the Indexing page (as described above).
2. Enter the name of the previously saved index in File name and click Recover.
   - JIRA will not be available during the recovery of the index.
   - If changes were made to the configuration that required a re-index after the snapshot was taken, then you will need to do a background re-index after the recovery. Note, JIRA will be available after the recovery.

Additional information

- JIRA will retain the last three snapshots at any time (in <yourjirahome>/export/indexsnapshots). Older snapshots will be automatically deleted. Note, snapshots may occupy considerable disk space and may need to be moved to offline storage or deleted as appropriate.
- The snapshot process is a relatively lightweight process and does not place much of a load on the system.
- The process of taking a snapshot will require temporary disk space equivalent to the index size. The resulting snapshots will each be about 25% the size of the index.
- All issues will be re-indexed appropriately during the recovery, including issues that were added, updated or deleted after the snapshot was taken.
- You can use the index recovery process to bring your index up to date, if you need to restore your JIRA database. The index snapshot must pre-date the database backup being restored.

Re-indexing a single project

If you have made a configuration change that affects a single project, you can re-index just that project. See Re-indexing after Major Configuration Changes for more information on when you should re-index.

To re-index a single project:

1. Navigate to the desired project and click the Administration tab.
2. Click Actions > Re-index project to start re-indexing the project.

Re-Indexing after Major Configuration Changes

Once issues have been created, modifying the configuration of your JIRA instance can result in the search index becoming out-of-sync with JIRA’s configuration. Configuration details such as the following can affect the search index:

- Field Configuration Schemes
- Custom Fields
- Plugins
- Time Tracking

If you make changes to any of these areas of configuration, you might see the following message in your Administration view:
USERFULLNAME made configuration changes to 'SECTION' at TIME. It is recommended that you perform a re-index. It is recommended that you perform a re-index. For more information, please click the Help icon. To perform the re-index now, please go to the 'Indexing' section.

Note: So that you only have to re-index once, you may wish to complete any other configuration changes before performing the re-index.

All users that have access to the Administration Tab will see this message (JIRA Administrators, System Administrators, Project Administrators). The above message means that configuration changes have been made to JIRA, but have not yet been reflected in the search index. Until JIRA's search index has been rebuilt, it is possible that some search queries from JIRA will return incorrect results. For example:

- If a plugin containing a custom field is enabled after being disabled, search queries which specify that the custom field should be empty will return no issues instead of all issues.
- If a Field Configuration is modified by altering the visibility of a particular field so that it is now visible, search queries which specify that field may also return erroneous results (depending on which field is being modified and what query is being executed).

The way to resolve the discrepancy is to rebuild JIRA's search index. This can take anywhere from seconds to hours, depending on the number of issues and comments in your JIRA instance. While re-indexing is taking place, your instance will be unavailable to all users unless you chose Background Indexing. For these reasons, it is recommended that you:

- Make all your necessary configuration changes in one go before starting the re-index process; and
- Start the re-index process in a time period of low activity for your instance.

Using robots.txt to hide from Search Engines

The robots.txt protocol is used to tell search engines (Google, MSN, etc) which parts of a website should not be crawled.

For JIRA instances where non-logged-in users are able to view issues, a robots.txt file is useful for preventing unnecessary crawling of the Issue Navigator views (and unnecessary load on your JIRA server).

Editing robots.txt

JIRA (version 3.7 and later) installs the following robots.txt file at the root of the JIRA web app ($JIRA-INST ALL/atlassian-jira):

```
# robots.txt for JIRA
# You may specify URLs in this file that will not be crawled by search engines
# (Google, MSN, etc)
#
# By default, all SearchRequestViews in the IssueNavigator (e.g.: Word, XML, RSS, etc) and all IssueViews
# (XML, Printable and Word) are excluded by the /sr/ and /si/ directives below.
User-agent: *
Disallow: /sr/
Disallow: /si/
```

Alternatively, if you already have a robots.txt file, simply edit it and add Disallow: /sr/ and Disallow: /si/.

Publishing robots.txt

The robots.txt file needs to be published at the root of your JIRA internet domain, e.g. jira.mycompany.com/robots.txt.
Updating your JIRA License Details

When you upgrade or renew your JIRA license, you will receive a new license key. You will need to update your JIRA server with the new license key.

You can access your license key via http://my.atlassian.com

To update your JIRA license key:

1. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
2. Choose > System. Select License to view your existing JIRA license details.
3. Paste your new license into this box.
4. Click the 'Add' button to update the JIRA installation with the new license.

Do you have a user-limited license?

If you have a user-limited license (such as a starter license), then the user limit of your license will be displayed on the 'License Details' page. This field is periodically refreshed, but you can retrieve the latest user limit by clicking the 'Refresh' button.

Need more information about licensing or want to find out more about starter licenses? Please see the Licensing FAQ and Starter Licenses page.

Reducing your user count

You may want to reduce your user count in JIRA if you have exceeded your user count or if you want to change
to a lower-tier license to reduce costs.

The recommended method for reducing your user count in JIRA is to remove users from all groups with the 'JIRA Users' global permission. This is described in the following knowledge base article: Unable to Create Issues Due to Exceeded License.

Alternatively, if you have connected JIRA to an LDAP directory, you may want configure JIRA to synchronise a subset of users from LDAP rather than all users. This is described in Reduce the number of users synchronised from LDAP to JIRA. However, this can be a complicated procedure and we recommend that you do not use this method unless necessary.

⚠ Note, if you exceed the user count allowed by your JIRA license, your users will not be able to create issues.

Viewing your System Information

JIRA provides you with detailed information about your system configuration, as described in the table below. This information can be useful when modifying, troubleshooting or upgrading your system.

Viewing your JIRA System Information

1. Log in as a user with the 'JIRA Administrators' global permission.

2. Choose 🛠 > System. Select Troubleshooting and Support > System Info to open the System Info page.

   Keyboard shortcut: 'g' + 'g' + type 'system i'

   The following categories of information is shown on the 'System Info' page:

   - Warnings
   - System Info
   - Java VM Memory Statistics
   - JIRA Info
   - License Info
   - Configuration Info
   - Database Statistics
   - File Paths
   - Listeners
   - Services
   - Plugins
   - System Properties
   - Trusted Applications

Warnings

Any warnings about known issues with your configuration will be displayed here.

System Info

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base URL</td>
<td>The base URL of this JIRA installation. It is used in outgoing email notifications as the prefix for links to JIRA issues. It can be changed as described in Configuring JIRA Options.</td>
</tr>
<tr>
<td>System Date</td>
<td>The JIRA server’s system date.</td>
</tr>
<tr>
<td>System Time</td>
<td>The JIRA server’s system time.</td>
</tr>
<tr>
<td>Current Working Directory</td>
<td>For a description of the JIRA Working Directory, please see Important Directories and Files.</td>
</tr>
<tr>
<td>Java Version</td>
<td>The JIRA server's Java version.</td>
</tr>
<tr>
<td>Java Vendor</td>
<td>The JIRA server's Java vendor.</td>
</tr>
<tr>
<td><strong>JVM Version</strong></td>
<td>The JIRA server's JVM version.</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td><strong>JVM Vendor</strong></td>
<td>The JIRA server's JVM version.</td>
</tr>
<tr>
<td><strong>JVM Implementation Version</strong></td>
<td>The JIRA server's JVM implementation version.</td>
</tr>
<tr>
<td><strong>Java Runtime</strong></td>
<td>The JIRA server's Java runtime environment.</td>
</tr>
<tr>
<td><strong>Java VM</strong></td>
<td>The JIRA server's Java Virtual Machine.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>The operating system login name which JIRA runs under.</td>
</tr>
<tr>
<td><strong>User Timezone</strong></td>
<td>The JIRA server's timezone.</td>
</tr>
<tr>
<td><strong>User Locale</strong></td>
<td>The JIRA server's locale. Unless the default language is modified in JIRA's General Configuration, the User Locale will dictate the default language.</td>
</tr>
<tr>
<td><strong>System Encoding</strong></td>
<td>The JIRA server's system encoding.</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>The JIRA server's operating system.</td>
</tr>
<tr>
<td><strong>OS Architecture</strong></td>
<td>The JIRA server's operating system architecture (e.g. i386).</td>
</tr>
<tr>
<td><strong>Application Server Container</strong></td>
<td>The application server in which your JIRA instance is running (see Supported Platforms for a list of supported application servers).</td>
</tr>
<tr>
<td><strong>Database type</strong></td>
<td>The type of database to which your JIRA instance is connected (see Supported Platforms for a list of supported databases).</td>
</tr>
<tr>
<td><strong>Database JNDI address</strong></td>
<td>The JNDI address of the database to which your JIRA instance is connected. (For more details, see Connecting JIRA to a Database.)</td>
</tr>
<tr>
<td><strong>Database URL</strong></td>
<td>The URL of the database to which your JIRA instance is connected. (For more details, see Connecting JIRA to a Database.)</td>
</tr>
<tr>
<td><strong>Database version</strong></td>
<td>The version of the database to which your JIRA instance is connected (see Supported Platforms for a list of supported database versions).</td>
</tr>
<tr>
<td><strong>Database driver</strong></td>
<td>The driver which your JIRA instance is using to connect to its database. (For more details, see Connecting JIRA to a Database.)</td>
</tr>
<tr>
<td><strong>External user management</strong></td>
<td>‘ON’ / ‘OFF’ indicates whether JIRA’s users are being managed externally or internally to JIRA (e.g. via Crowd).</td>
</tr>
<tr>
<td><strong>Crowd integration</strong></td>
<td>‘YES’ / ‘NO’ indicates whether Atlassian’s Crowd identity management system has been integrated with this instance of JIRA. For more information please see the chapter titled ‘Integrating JIRA with Crowd’ in the Crowd documentation.</td>
</tr>
<tr>
<td><strong>JVM Input Arguments</strong></td>
<td>A list of any variables that are being passed to your application server when it starts up. For more information, see Setting Properties and Options on Startup.</td>
</tr>
<tr>
<td><strong>Modified Files</strong></td>
<td>A list of any files in your JIRA installation that have been modified as part installation or customisation of JIRA.</td>
</tr>
<tr>
<td><strong>Removed Files</strong></td>
<td>A list of any files that have been removed from your JIRA installation.</td>
</tr>
</tbody>
</table>

**Java VM Memory Statistics**
Java applications, such as JIRA, run in a "Java virtual machine" (JVM) instead of directly within an operating system. When started, the Java virtual machine is allocated a certain amount of memory, which it makes available to applications like JIRA. The following table shows the JVM memory data for your JIRA instance.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total Memory</strong></td>
<td>The total amount of memory allocated to the JVM that is available to this instance of JIRA. For more details, see Increasing JIRA Memory.</td>
</tr>
<tr>
<td><strong>Free Memory</strong></td>
<td>The amount of free JVM memory currently available to this instance of JIRA.</td>
</tr>
<tr>
<td><strong>Used Memory</strong></td>
<td>The amount of JVM memory currently being used by this instance of JIRA.</td>
</tr>
<tr>
<td><strong>Total PermGen Memory</strong></td>
<td>The total amount of PermGen (Permanent Generation) memory available to this instance of JIRA.</td>
</tr>
<tr>
<td><strong>Free PermGen Memory</strong></td>
<td>The amount of free PermGen (Permanent Generation) memory currently available to this instance of JIRA.</td>
</tr>
<tr>
<td><strong>Used PermGen Memory</strong></td>
<td>The amount of PermGen (Permanent Generation) memory currently being used by this instance of JIRA.</td>
</tr>
<tr>
<td><strong>Memory Graph</strong></td>
<td>A bar graph showing the available versus free JVM memory. You can click the 'Force garbage collection' link to start a clean-up. Note that this is generally not needed (even if the graph shows 100% utilisation) unless you want to examine JIRA's baseline heap usage.</td>
</tr>
<tr>
<td><strong>PermGen Memory Graph</strong></td>
<td>A bar graph showing the available versus free PermGen (Permanent Generation) memory.</td>
</tr>
<tr>
<td><strong>Non-Heap Memory Graph (includes PermGen)</strong></td>
<td>A bar graph showing the available versus free non-heap memory (including PermGen memory).</td>
</tr>
</tbody>
</table>

You can click the 'More Information...' link at the bottom of this table to view an additional section titled 'Memory Pool Info' (which lists detailed information about the various parts of memory that the Java virtual machine uses to store its data, and is generally only useful to Atlassian's support engineers.)

**JIRA Info**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Uptime</strong></td>
<td>The period of time since your JIRA instance was last started.</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td>The 'edition' of JIRA you are running. (Note: from JIRA 4.0 onwards, only 'Enterprise' edition is available. Prior to JIRA 4.0, there were three editions: 'Standard', 'Professional' and 'Enterprise'.)</td>
</tr>
<tr>
<td><strong>Version</strong></td>
<td>The version of JIRA you are running. (Note: for the latest version, please see JIRA Releases.)</td>
</tr>
<tr>
<td><strong>Build Number</strong></td>
<td>The build number of your JIRA version. This is generally only useful to Atlassian's support engineers.</td>
</tr>
<tr>
<td><strong>Build Date</strong></td>
<td>The date on which your JIRA version was built. This is generally only useful to Atlassian's support engineers.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Atlassian Partner</td>
<td>Indicates whether your distribution of JIRA was built by an Atlassian partner company. Blank indicates that it was built directly by Atlassian.</td>
</tr>
<tr>
<td>Installation Type</td>
<td>Indicates whether JIRA has been installed as a 'recommended' distribution or as a 'WAR' distribution.</td>
</tr>
<tr>
<td>Server ID</td>
<td>This number is calculated automatically by JIRA, based on your license number.</td>
</tr>
<tr>
<td>Last Upgrade</td>
<td>The time at which your JIRA installation was last upgraded, and from which version it was upgraded from (if applicable). Click the 'More Information...' link to see a list of all upgrades that have been performed on your JIRA system from version 4.1 onwards.</td>
</tr>
<tr>
<td>Installed Languages</td>
<td>A list of all language packs available within the JIRA system. (Note: to install additional languages, see Translating JIRA.)</td>
</tr>
<tr>
<td>Default Language</td>
<td>The language used throughout the JIRA interface. To change the default language, see Configuring JIRA Options. Note that users can override the default language by using the Language setting in their user profile.</td>
</tr>
</tbody>
</table>

**License Info**

⚠️ To edit your license details, please see Updating your JIRA License Details. Note that you will require the 'JIRA System Administrators' global permission.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Purchased</td>
<td>The date on which this system's JIRA license was originally purchased. Note: you can verify this information by visiting <a href="http://my.atlassian.com">http://my.atlassian.com</a></td>
</tr>
<tr>
<td>License Type</td>
<td>For information about the different types of JIRA licences, please see <a href="http://www.atlassian.com/software/jira/licensing.jsp">http://www.atlassian.com/software/jira/licensing.jsp</a></td>
</tr>
<tr>
<td>Maintenance Period End Date</td>
<td>For information about JIRA support and maintenance, please see <a href="http://www.atlassian.com/software/jira/licensing.jsp">http://www.atlassian.com/software/jira/licensing.jsp</a></td>
</tr>
<tr>
<td>Maintenance Status</td>
<td>For information about JIRA support and maintenance, please see <a href="http://www.atlassian.com/software/jira/licensing.jsp">http://www.atlassian.com/software/jira/licensing.jsp</a></td>
</tr>
<tr>
<td>Support Entitlement Number (SEN)</td>
<td>For information about JIRA support and maintenance, please see <a href="http://www.atlassian.com/software/jira/licensing.jsp">http://www.atlassian.com/software/jira/licensing.jsp</a></td>
</tr>
</tbody>
</table>

**Configuration Info**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments Enabled</td>
<td>'true' / 'false' indicates whether or not users can attach files and screenshots to issues in this JIRA system (subject to project permissions). For more information, see Configuring File Attachments.</td>
</tr>
<tr>
<td>Issue Voting Enabled</td>
<td>'true' / 'false' indicates whether or not users can vote on issues in this JIRA system (subject to project permissions). For more information, see Configuring JIRA Options.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Issue Watching Enabled</td>
<td>'true' / 'false' indicates whether or not users can <strong>watch issues</strong> in this JIRA system (subject to project permissions). For more information, see Configuring JIRA Options.</td>
</tr>
<tr>
<td>Unassigned Issues Enabled</td>
<td>'true' / 'false' indicates whether or not issues can be 'unassigned' (i.e. assigned to noone) in this JIRA system. For more information, see Configuring JIRA Options.</td>
</tr>
<tr>
<td>Sub-Tasks Enabled</td>
<td>'true' / 'false' indicates whether or not 'sub-task' issues can be created in this JIRA system. For more information, see Configuring Sub-tasks.</td>
</tr>
<tr>
<td>Issue Linking Enabled</td>
<td>'true' / 'false' indicates whether or not issues can be linked to each other within this JIRA system. For more information, see Configuring Issue Linking.</td>
</tr>
<tr>
<td>Time Tracking Enabled</td>
<td>'true' / 'false' indicates whether or not time (work) can be logged on issues in this JIRA system. For more information, see Configuring Time Tracking.</td>
</tr>
<tr>
<td>Time Tracking Hours Per Day</td>
<td>The number of hours per working day for which work that can be logged on issues in this JIRA system. For more information, see Configuring Time Tracking.</td>
</tr>
<tr>
<td>Time Tracking Days Per Week</td>
<td>The number of days per week for which work that can be logged on issues in this JIRA system. For more information, see Configuring Time Tracking.</td>
</tr>
<tr>
<td>Database Statistics</td>
<td>The information in this section can help determine how much resource (e.g. memory) your JIRA system requires.</td>
</tr>
<tr>
<td><strong>Setting</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Issues</td>
<td>The number of <strong>issues</strong> that have been created in this JIRA system.</td>
</tr>
<tr>
<td>Projects</td>
<td>The number of <strong>projects</strong> that have been created in this JIRA system.</td>
</tr>
<tr>
<td>Custom Fields</td>
<td>The number of <strong>custom fields</strong> that have been created in this JIRA system.</td>
</tr>
<tr>
<td>Workflows</td>
<td>The number of <strong>workflows</strong> that have been created in this JIRA system.</td>
</tr>
<tr>
<td>Users</td>
<td>The number of <strong>user IDs</strong> that have been created in this JIRA system.</td>
</tr>
<tr>
<td>Groups</td>
<td>The number of <strong>groups</strong> that have been created in this JIRA system.</td>
</tr>
</tbody>
</table>

**File Paths**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location of JIRA Home</td>
<td>The path to your <strong>JIRA Home Directory</strong>. For information about changing the location, see Setting your JIRA Home Directory.</td>
</tr>
<tr>
<td>Location of entityengine.xml</td>
<td>The path to your <strong>Entity Engine</strong>. For database-specific information about configuring your entityengine.xml file, see Connecting JIRA to a Database.</td>
</tr>
<tr>
<td>Location of atlassian-jira.log</td>
<td>The path to the JIRA log file. (Note that, if you are requesting support, the support engineers will generally need your application server log file as well as your JIRA log file.) For information about changing the logging level, see Logging and Profiling; note that you will require the <strong>'JIRA System Administrators'</strong> global permission.</td>
</tr>
</tbody>
</table>
Location of indexes

The path to your JIRA search indexes (not your database indexes). For information about moving the indexes, please see Search Indexing; note that you will require the ‘JIRA System Administrators’ global permission.

Listeners

This section lists all the listeners that are installed in this JIRA system. For more information, please see Listeners. Note that you will require the ‘JIRA System Administrators’ global permission in order to register a listener.

Services

This section lists all the services that are installed in this JIRA system. For more information, please see Services. Note that you will require the ‘JIRA System Administrators’ global permission in order to register a service.

Plugins

This section lists all plugins that are installed in this JIRA system. For more information, please see Managing JIRA's Plugins.

System Properties

The information in this section is specific to the application server and Java version you are using, and is generally only useful to Atlassian's support engineers.

Trusted Applications

This section lists all ‘trusted application’ (i.e. applications that JIRA will allow to access specified functions on behalf of any user — without the user logging in to JIRA). To edit the trusted applications for this JIRA system, please see Configuring Trusted Applications. Note that you will require the ‘JIRA System Administrators’ global permission.

Monitoring Database Connection Usage

JIRA provides a view of its database connection usage. This provides information on the activity of the connection pool, as well as the frequency of reads/writes to the database. You can use this information to tune your database connections for better performance.

The instructions on this page describe how to navigate to the database connection usage information in the JIRA administration console, and how to interpret the information. If you want to make changes to your database connection pool settings using this information, see this related topic: Tuning Database Connections.

On this page:
- Accessing the Database Monitoring Page
- Interpreting the database monitoring graphs

Related pages:
- Tuning Database Connections
- Enterprise Resources

Accessing the Database Monitoring Page

To access the Database Monitoring page:

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose Add-ons > Database Monitoring to display the Database Monitoring page.
   ✔️ Keyboard shortcut: g + g + start typing database monitoring
Interpreting the database monitoring graphs

Connection Pool graph

The 'Connection Pool' graph shows the activity in the connection pool for the last 6 hours.
This graph shows the number of active and idle connections, as well as the maximum and minimum for the period.

- The scale of the vertical axis is equal to the maximum number of connections.
- The readings are averages over a period of 5 minutes.

This information can help you to optimise database connection usage. For example, if the number of active connections is consistently or frequently near to the maximum available, then you may need to raise the maximum connections available in the pool. Conversely, if the number of active connections is consistently low compared to the maximum available, then you may want to lower the maximum connections available in the pool. For more information on how to tune database connections, see Tuning Database Connections.

Reads / Writes graph

The 'Reads / Writes' graph shows the frequency of reads and writes to the database over a period of time. It can be helpful to correlate database usage with connection pool usage. Whenever JIRA needs to access (i.e. read from or write to) the database, a database connection is required. If there are regular spikes in the reads / writes, you may need to consider raising the maximum connections available in the pool.

Viewing JIRA's Instrumentation Statistics

JIRA provides an Instrumentation page, which displays a variety of statistics on a wide range of internal properties within JIRA that have been 'instrumented' (i.e. recorded) for presentation through JIRA's administration area.

This page is mostly useful to help Atlassian Support provide assistance with your support queries, especially if they ask you to quote the statistics of one or more properties listed on this page.

To access JIRA’s 'Instrumentation' page:

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose 🚀 > System. Select Troubleshooting and Support > Instrumentation to display the Instrumentation page.
   ✅ Keyboard shortcut: g + g + start typing instrumentation
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value</th>
<th>Invocation</th>
<th>Time (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>cache.CachingFieldConfigContextPersister.evictionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.CachingFieldConfigContextPersister.hitCount</td>
<td>Counter</td>
<td>1,314</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.CachingFieldConfigContext Persister.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.CachingFieldConfigContextPersister.loadSuccessCount</td>
<td>Counter</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.CachingFieldConfigContextPersister.missCount</td>
<td>Counter</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.CachingFieldConfigContextPersister.size</td>
<td>Gauge</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.CachingFieldConfigContextPersister.totalLoadTime</td>
<td>Counter</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultFieldLayoutManager.evictionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultFieldLayoutManager.hitCount</td>
<td>Counter</td>
<td>14,533</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultFieldLayoutManager.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultFieldLayoutManager.loadSuccessCount</td>
<td>Counter</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultFieldLayoutManager.missCount</td>
<td>Counter</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultFieldLayoutManager.size</td>
<td>Gauge</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultFieldLayoutManager.totalLoadTime</td>
<td>Counter</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultIssueLinkManager.evictionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultIssueLinkManager.hitCount</td>
<td>Counter</td>
<td>1,936</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultIssueLinkManager.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultIssueLinkManager.loadSuccessCount</td>
<td>Counter</td>
<td>602</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultIssueLinkManager.missCount</td>
<td>Counter</td>
<td>602</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultIssueLinkManager.size</td>
<td>Gauge</td>
<td>602</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultIssueLinkManager.totalLoadTime</td>
<td>Counter</td>
<td>4,701</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultPermissionSchemeManager.evictionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultPermissionSchemeManager.hitCount</td>
<td>Counter</td>
<td>17,824</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultPermissionSchemeManager.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultPermissionSchemeManager.loadSuccessCount</td>
<td>Counter</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultPermissionSchemeManager.missCount</td>
<td>Counter</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultPermissionSchemeManager.size</td>
<td>Gauge</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultPermissionSchemeManager.totalLoadTime</td>
<td>Counter</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultUserPropertyManager.evictionCount</td>
<td>Counter</td>
<td>38</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultUserPropertyManager.hitCount</td>
<td>Counter</td>
<td>713.077</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultUserPropertyManager.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultUserPropertyManager.loadSuccessCount</td>
<td>Counter</td>
<td>43</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultUserPropertyManager.missCount</td>
<td>Counter</td>
<td>43</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultUserPropertyManager.size</td>
<td>Gauge</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.DefaultUserPropertyManager.totalLoadTime</td>
<td>Counter</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metric</td>
<td>Type</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------</td>
<td>---------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.JiraOsgiContainerManager.evtctionCount</td>
<td>Counter</td>
<td>80</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.JiraOsgiContainerManager.hitCount</td>
<td>Counter</td>
<td>34914</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.JiraOsgiContainerManager.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.JiraOsgiContainerManager.loadSuccessCount</td>
<td>Counter</td>
<td>86</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.JiraOsgiContainerManager.missCount</td>
<td>Counter</td>
<td>86</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.JiraOsgiContainerManager.size</td>
<td>Gauge</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.JiraOsgiContainerManager.totalLoadTime</td>
<td>Counter</td>
<td>134</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.directives.evtctionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.directives.hitCount</td>
<td>Counter</td>
<td>419353</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.directives.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.directives.loadSuccessCount</td>
<td>Counter</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.directives.missCount</td>
<td>Counter</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.directives.size</td>
<td>Gauge</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.directives.totalLoadTime</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.evictionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.hitCount</td>
<td>Counter</td>
<td>419353</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.loadExceptionCount</td>
<td>Counter</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.loadSuccessCount</td>
<td>Counter</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.missCount</td>
<td>Counter</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.size</td>
<td>Gauge</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cache.VelocityTemplateCache.totalLoadTime</td>
<td>Counter</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>concurrent.users</td>
<td>Gauge</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>db.conns</td>
<td>Operation</td>
<td>112352</td>
<td>105812269</td>
<td></td>
</tr>
<tr>
<td>db.conns.borrowed</td>
<td>Gauge</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>db.reads</td>
<td>Operation</td>
<td>103234</td>
<td>2238</td>
<td></td>
</tr>
<tr>
<td>db.write</td>
<td>Operation</td>
<td>4569</td>
<td>406</td>
<td></td>
</tr>
<tr>
<td>dbcp.maxActive</td>
<td>Gauge</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dbcp.numActive</td>
<td>Gauge</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dbcp.numidle</td>
<td>Gauge</td>
<td>19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>entity.customfields.total</td>
<td>Gauge</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>entity.groups.total</td>
<td>Gauge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>entity.issues.total</td>
<td>Gauge</td>
<td>301</td>
<td></td>
<td></td>
</tr>
<tr>
<td>entity.projects.total</td>
<td>Gauge</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>entity.users.total</td>
<td>Gauge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>entity.workflows.total</td>
<td>Gauge</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>http.session.objects</td>
<td>Gauge</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>http.sessions</td>
<td>Gauge</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>index.write</td>
<td>Operation</td>
<td>9</td>
<td>13829</td>
<td></td>
</tr>
</tbody>
</table>
Generating a Thread Dump

Occasionally, JIRA may appear to 'freeze' during execution of an operation. During these times, it is helpful to retrieve a thread dump — a log containing information about currently running threads and processes within the Java Virtual Machine. Taking thread-dumps is a non-destructive process that can be run on live systems. This document describes the steps necessary to retrieve a thread dump.

The steps necessary to retrieve the thread dump are dependant on the operating system JIRA is running in — please follow the appropriate steps below.

On this page:
- Windows Environment
- Linux/Unix/OS X Environment
- Analysis Tools
Windows Environment

**JIRA running from startup.bat**

1. In the **Command Console** window where JIRA is running, open the properties dialog box by right clicking on the title bar and select "Properties".
2. Select the **Layout** tab.
3. Under **Screen Buffer Size**, set the **Height** to 3000.

![Command Console Properties Dialog](image)

4. Click **OK**.
5. With the same command console in focus, press **CTRL-BREAK**. This will output the thread dump to the command console.
6. Scroll back in the command console until you reach the line containing “Full thread dump”.
7. Right click the title bar and select **Edit -> Mark**. Highlight the entire text of the thread dump.
8. Right click the title bar and select **Edit -> Copy**. The thread dump can then be pasted into a text file.
JIRA running as a Windows Service

Using jstack

The JDK ships with a tool named jstack for generating thread dumps.

1. Identify the process. Launch the task manager by, pressing Ctrl + Shift + Esc and find the Process ID of the Java (JIRA) process. You may need to add the PID column using View -> Select Columns...

2. Run jstack <pid> to Capture a Single Thread Dump. This command will take one thread dump of the process id <pid>, in this case the pid is 22668:

C:\Users\Administrator>jstack.exe -l 22668 > threaddump.txt

This will output a file called threaddump.txt to your current directory.
Linux/Unix/OS X Environment

**Using jstack and top**

Please see Troubleshooting Performance Issues with Thread Dumps for a way to combine both top and jstack to provide the CPU output of individual threads along with their stack trace.

**Linux/Unix Alternative: Command Line**

1. Identify the java process that JIRA is running in. This can be achieved by running a command similar to:

   ```
   ps -ef | grep java
   ```

   The process will appear similarly as follows:

   ```
   keithb     910   873  1 17:01 pts/3    00:00:18 /usr/java/jdk/bin/java
   -Xms128M -Xmx256M
   -Xms128M -Xmx256M -Djava.awt.headless=true
   -Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager
   -Djava.awt.headless=true
   -Djava.endorsed.dirs=/tmp/atlassian-jira-enterprise-3.6-standalone/common/endorsed
   -classpath :
   ```

2. In order to retrieve the thread dump, execute the command

   ```
   kill -3 <pid>
   ```

   where `pid` is the process id — in this case, 910.

3. The thread dump will be written to the Tomcat console output. The console output is redirected to the `logs/catalina.out` file, which can be found in the JIRA Installation Directory for JIRA Standalone / Installer, or for JIRA WAR, under the Tomcat installation directory.

**Linux/Unix Alternative: Generating Thread Dumps using jstack**

If you have trouble using `kill -3 <pid>` to obtain a thread dump, try using jstack a java utility that will output stack traces of Java threads for a given process.

1. Identify the java process that JIRA is running in. This can be achieved by running a command similar to:

   ```
   ps -ef | grep java
   ```

2. The process will appear similarly as follows:

   ```
   ```

   common issues with jstack:

   - You must run jstack as the same user that is running JIRA.
   - If you get the error "Not enough storage is available to process this command", download the 'psexec' utility from here, then run the following command using:

     ```
     psexec -s jstack <pid> >> threaddumps.txt
     ```

   - If the jstack executable is not in your $PATH, then please look for it in your <JDK_HOME>/bin directory
   - If you receive java.lang.NoClassDefFoundError: sun/tools/jstack/JStack check that tools.jar is present in your JDK's lib directory. If it is not, download a full version of the JDK.
Run jstack <pid> to Capture a Single Thread Dump
This command will take one thread dump of the process id <pid>, in this case the pid is 22668, and log output to the file JIRAthreaddump.txt

```
adam@jiratrack:~$ jstack 22668 > JIRAthreaddump.txt
```

Take Multiple Thread Dumps
Typically you'll want to take several dumps about 10 seconds apart, in which case you can generate several dumps and output the stack traces to a single file as follows:

```
adam@jiratrack:~$ jstack 22668 >> JIRAthreaddump.txt
adam@jiratrack:~$ jstack 22668 >> JIRAthreaddump.txt
adam@jiratrack:~$ jstack 22668 >> JIRAthreaddump.txt
```

If you are connecting to the server through RDP, jstack might fail with following error:
```
Not enough storage is available to process this command
```

You will need to open a RDP session in console mode: mstsc /admin

Analysis Tools

Try TDA or Samurai to inspect your thread dump.

**TDA**

1. Download TDA
2. CD to the directory where the JAR exists
3. Run:

```
java -jar -Xmx512M ~/tda-bin-1.6/tda.jar
```
4. Open your catalina.out file, containing the thread dump

**Issue processing thread dump with TDA (NumberFormatException)**

Should you get an error on TDA console like:

```java
Exception in thread "AWT-EventQueue-0" java.lang.NumberFormatException:
For input string: "5 os_prio=0"
  at java.lang.NumberFormatException.forInputString(NumberFormatException.java:65)
  at java.lang.Long.parseLong(Long.java:441)
  at java.lang.Long.<init>(Long.java:702)
  at com.pironet.tda.utils.ThreadsTableModel.getValueAt(ThreadsTableModel.java:80)
  at com.pironet.tda.utils.TableSorter.getValueAt(TableSorter.java:285)
  at javax.swing.JTable.getValueAt(JTable.java:2717)
  at javax.swing.JTable.prepareRenderer(JTable.java:5719)
  at javax.swing.plaf.basic.BasicTableUI.paintCell(BasicTableUI.java:2114)
  at javax.swing.plaf.basic.BasicTableUI.paintCells(BasicTableUI.java:2016)
  at javax.swing.plaf.basic.BasicTableUI.paint(BasicTableUI.java:1812)
  at javax.swing.JComponent.paintComponent(JComponent.java:778)
  at javax.swing.JComponent.paint(JComponent.java:1054)
  at javax.swing.JComponent.paintChildren(JComponent.java:887)
  at javax.swing.JComponent.paint(JComponent.java:1063)
  at javax.swing.JViewport.paint(JViewport.java:731)
  at javax.swing.JComponent.paintChildren(JComponent.java:887)
  at javax.swing.JComponent.paint(JComponent.java:1063)
  at javax.swing.JComponent.paintChildren(JComponent.java:887)
  at javax.swing.JSplitPane.paintChildren(JSplitPane.java:1047)
  at javax.swing.JComponent.paint(JComponent.java:1063)
  at javax.swing.JComponent.paintToOffscreen(JComponent.java:5230)
  at javax.swing.BufferStrategyPaintManager.paint(BufferStrategyPaintManager.java:295)
  at javax.swing.RepaintManager.paint(RepaintManager.java:1249)
  at javax.swing.JComponent._paintImmediately(JComponent.java:5178)
  at javax.swing.JComponent.paintImmediately(JComponent.java:4989)
  at javax.swing.RepaintManager$3.run(RepaintManager.java:808)
  at javax.swing.RepaintManager$3.run(RepaintManager.java:796)
  at java.security.AccessController.doPrivileged(Native Method)
  at java.security.ProtectionDomain$1.doIntersectionPrivilege(ProtectionDomain.java:76)
  at javax.swing.RepaintManager.paintDirtyRegions(RepaintManager.java:796)
  at javax.swing.RepaintManager.paintDirtyRegions(RepaintManager.java:769)
  at javax.swing.RepaintManager.prePaintDirtyRegions(RepaintManager.java:718)
```
at
javax.swing.RepaintManager.access$1100(RepaintManager.java:62)
at
javax.swing.RepaintManager$ProcessingRunnable.run(RepaintManager.java:1677)
at
java.awt.event.InvocationEvent.dispatch(InvocationEvent.java:312)
at
java.awt.EventQueue.dispatchEventEventImpl(EventQueue.java:733)
at
java.awt.EventQueue.access$200(EventQueue.java:103)
at
java.awt.EventQueue$3.run(EventQueue.java:694)
at
java.awt.EventQueue$3.run(EventQueue.java:692)
at
java.security.AccessController.doPrivileged(Native Method)
at
java.security.ProtectionDomain$1.doIntersectionPrivilege(ProtectionDomain.java:76)
at
java.awt.EventQueue.dispatchEvent(EventQueue.java:703)
at
java.awt.EventDispatchThread.pumpOneEventForFilters(EventDispatchThread.java:242)
at
java.awt.EventDispatchThread.pumpEventsForFilter(EventDispatchThread.java:161)
at
java.awt.EventDispatchThread.pumpEventsForHierarchy(EventDispatchThread.java:150)
at
java.awt.EventDispatchThread.pumpEvents(EventDispatchThread.java:146)
Apply the following command on the thread dump(s) to fix the thread header format to make it processable:

```
sed -i 's/prio=[0-9]\{1,2\} os_prio=[0-9]\{1,2\}\{1,2\}/prio=5/g' <filename>
```

For Mac:

```
  sed -i '' 's/prio=[0-9]\{1,2\} os_prio=[0-9]\{1,2\}\{1,2\}/prio=5/g' <filename>
```

Check the known thread dump knowledge base articles:

- Searching, Indexing, and Filters Troubleshooting
- Poor Performance Due to Limited Database Connection Pooling
- JIRA Deadlocks when Running Tomcat 6.0.24
- OutOfMemory or Poor Performance due to XML View of a Filter
- JIRA Performance Tuning
- JIRA Crashes Due to OutOfMemoryError Java heap space

Finding the JIRA Support Entitlement Number (SEN)

There are three ways to find your Support Entitlement Number (SEN).

See Finding Your Support Entitlement Number in the support space for more general information about how Atlassian Support uses this number.

Method 1: Check in the JIRA administration interface

Access the JIRA license page, as described on Updating your JIRA License Details. The JIRA license page will show your Support Entitlement Number (SEN).

Method 2: Check my.atlassian.com

Your Support Entitlement Number is available from the licenses page after logging in to http://my.atlassian.com:
Method 3: Check your Atlassian invoice

Your Support Entitlement Number (SEN) also appears on the third page of your Atlassian Invoice.

Performance Testing Scripts

Please be aware that the content on this page is not actively maintained and Atlassian **can not guarantee providing any support for it**. Furthermore, the performance testing scripts which you can download from Atlassian’s public Maven repository (via the link on this page) are no longer supported.

This page is provided for your information only and using it is done so at your own risk. Instead of using these scripts, we would recommend our JIRA Performance Testing with Grinder page.

This page contains scripts and hints for testing usage load on your JIRA installation.

When setting up a new JIRA installation, it is useful to understand how it will perform under your anticipated load before users begin accessing it. Scripts that generate ‘request’ (or usage) load are provided in our public Maven repository (link **below**). Using these scripts, you can find out where you may need to consider improving your configuration to remove bottlenecks.

While this kind of testing is not an exact science, the tools and processes described here are intended to be straightforward and configurable, and provide you with an extensible way to assess load testing.

The performance tests described on this page utilise JMeter. While it is not necessary to know JMeter, briefly reading through the **JMeter documentation** is recommended as it may help you resolve any JMeter-specific issues.

It is rarely the case that these scripts will perform representative testing for you ‘out of the box’. However, it should be possible to build an appropriate load test by configuring or extending these scripts.

**Load testing scripts should not be used on a production JIRA installation!**

While we recommend using a copy of your production data for testing usage load, the load testing
Likewise, when making changes to your JIRA installation to remove performance bottlenecks, it is useful to assess the impact of these changes in a test JIRA installation before implementing them in production.

On this page:
- Prerequisites
- Quick, just tell me how to run these tests!
- Performance Tests

Prerequisites

You will need the following:

- A JIRA installation, set up and running with an administrator user. The scripts assume that the username/password combination of this user is 'admin'/'admin'.
- It is recommended that you test with a production quality database, such as one listed on the Supported Platforms page. Do not use HSQLDB.
- Apache JMeter (currently version 2.3.4). If you intend to do high load testing, please use our modified version of JMeter instead (which requires Java 1.6).
- The load testing scripts and resources which are available in our public Maven repository — Please choose the version that most closely matches your JIRA version and download the ZIP or Gzip file in that directory. If in doubt, download the ZIP file archive.

Users have reported problems using the Windows built-in unzip utility to extract these archives. If you encounter such a problem, please use a third party file archiving and extraction program (for example, 7-Zip) to extract these performance tests.

Quick, just tell me how to run these tests!

If you do not want to read the rest of this document, here are the main points:

1. Create the setup test data:

   ```bash
   <jmeter location>/bin/jmeter -n -t jmeter-test-setup.jmx -Jadmin.user=<username> -Jadmin.pass=<password>
   ```

2. Run the fixed load test:

   ```bash
   <jmeter location>/bin/jmeter -n -t jmeter-test-fixedload.jmx
   ```

The remainder of this document is just an elaboration of those two steps.

For information on how to use JMeter please refer to the JMeter documentation.

Performance Tests
JIRA performance tests are made up of two parts:

- **Setup test** — runs first and prepares the JIRA installation for a subsequent **fixed load test**
- **Fixed load test** — simulates a number of users accessing the JIRA installation.

### Setup Test

The **setup test** is responsible for:

- Creating projects
- Creating users
- Creating and commenting on (and optionally resolving) issues.

### Running the setup test:

After extracting the performance test zip file, change into the `performanceTest` directory. From this directory, run the performance setup test:

```
<jmeter location>/bin/jmeter -n -t jmeter-test-setup.jmx -Jadmin.user=<username>
-Jadmin.pass=<password>
```

where `<jmeter.location>` is the base directory of JMeter

**i** If you omit the `-n` switch, JMeter will run as a GUI. You may then start the test from within the GUI.

As seen above with the `admin.user` and `admin.pass` parameters, JMeter supports `-Jparameter=value` command arguments in order to control execution. The following parameters control the setup test execution:

#### Configuration Control

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira.host</td>
<td>localhost</td>
<td>The hostname or address of the JIRA installation.</td>
</tr>
<tr>
<td>jira.port</td>
<td>8000</td>
<td>The network port that the JIRA installation is running on.</td>
</tr>
<tr>
<td>jira.context</td>
<td>/</td>
<td>JIRA webapp context.</td>
</tr>
<tr>
<td>admin.user</td>
<td>admin</td>
<td>Administrator username.</td>
</tr>
<tr>
<td>admin.pass</td>
<td>admin</td>
<td>Administrator password.</td>
</tr>
<tr>
<td>script.base</td>
<td>.</td>
<td>The location of the performance tests. This should only be set if you run the tests from outside the scripts directory.</td>
</tr>
<tr>
<td>remove.data</td>
<td>false</td>
<td>Running the script with this enabled will remove the users and projects created by the test.</td>
</tr>
</tbody>
</table>

#### User Control

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>create.users.enable</td>
<td>true</td>
<td>Create users in the target JIRA installation. Use false if you already have the users created elsewhere.</td>
</tr>
<tr>
<td>browseissue.max</td>
<td>250</td>
<td>The number of users to be created for browsing the JIRA installation (aka &quot;browseissue&quot; users).</td>
</tr>
<tr>
<td>createissue.max</td>
<td>250</td>
<td>The number of users to be created for creating issues (aka &quot;createissue&quot; users).</td>
</tr>
<tr>
<td>editissue.max</td>
<td>250</td>
<td>The number of users to be created for editing issues (aka &quot;editissue&quot; users).</td>
</tr>
</tbody>
</table>
search.max 250 The number of users to be created for searching issues (aka "search" users).

useraction.max 250 The number of users to be created for browsing user information (aka "useraction" users).

browseissue.groupname none The group to which "browseissue" users will be placed. Use none for no group.

createissue.groupname jira-developers The group to which "createissue" users will be placed. Use none for no group.

editissue.groupname jira-developers The group to which "editissue" users will be placed. Use none for no group.

search.groupname none The group to which "search" users will be placed. Use none for no group.

useraction.groupname jira-developers The group to which "useraction" users will be placed. Use none for no group.

## Project Control

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>create.projects.enable</td>
<td>true</td>
<td>Create projects. Use false if you want to use existing projects (in existing data).</td>
</tr>
<tr>
<td>project.max</td>
<td>20</td>
<td>The number of projects to create in the system.</td>
</tr>
</tbody>
</table>

## Issue Control

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>create.issues.enable</td>
<td>true</td>
<td>Creates issues in the target JIRA installation. Use false if you do not want the test to create sample issues.</td>
</tr>
<tr>
<td>issue.max</td>
<td>3000</td>
<td>The number of issues to be created.</td>
</tr>
<tr>
<td>issue.comment.enable</td>
<td>true</td>
<td>Controls whether or not comments are added to issues.</td>
</tr>
<tr>
<td>issue.comment.max</td>
<td>10</td>
<td>If issue.comment.enable is true, then the number of actual comments created on an issue is chosen randomly between 0 and this value.</td>
</tr>
<tr>
<td>issue.close</td>
<td>true</td>
<td>Controls whether or not issues will be closed automatically after being created.</td>
</tr>
<tr>
<td>issue.close.percentage</td>
<td>60</td>
<td>If issue.close is enabled, then this value defines the percentage of issues closed.</td>
</tr>
<tr>
<td>issue.setupload.threads</td>
<td>10</td>
<td>The number of threads used for creating the issues.</td>
</tr>
<tr>
<td>issue.setupload.pause</td>
<td>50</td>
<td>The amount of time (in milliseconds) for which a simulated user will 'sleep' between each request during issue creation.</td>
</tr>
<tr>
<td>resource.dir</td>
<td>resources</td>
<td>The directory which contains the CSV data resources.</td>
</tr>
</tbody>
</table>

## Test Output

Once you have chosen your target settings, run JMeter and you should get output similar to the following:
jmeter -n -t jmeter-test-setup.jmx
Created the tree successfully using jmeter-test-setup.jmx
Starting the test @ Mon Oct 26 23:53:28 CDT 2009 (1256619208435)
Generate Summary Results + 931 in 31.3s = 29.7/s Avg: 26 Min:
13 Max: 3256 Err: 0 (0.00%)
Generate Summary Results + 2948 in 180.0s = 16.4/s Avg: 31 Min:
8 Max: 1162 Err: 0 (0.00%)
Generate Summary Results = 3879 in 211.4s = 18.3/s Avg: 29 Min:
8 Max: 3256 Err: 0 (0.00%)
Generate Summary Results + 5048 in 179.9s = 28.1/s Avg: 44 Min:
7 Max: 936 Err: 0 (0.00%)
Generate Summary Results = 8927 in 391.4s = 22.8/s Avg: 37 Min:
7 Max: 3256 Err: 0 (0.00%)
Generate Summary Results + 3114 in 180.1s = 17.3/s Avg: 41 Min:
7 Max: 805 Err: 0 (0.00%)
Generate Summary Results = 12041 in 571.3s = 21.1/s Avg: 38 Min:
7 Max: 3256 Err: 0 (0.00%)
Generate Summary Results + 4956 in 179.8s = 27.6/s Avg: 45 Min:
7 Max: 1844 Err: 0 (0.00%)
Generate Summary Results = 16997 in 751.4s = 22.6/s Avg: 40 Min:
7 Max: 3256 Err: 0 (0.00%)
Generate Summary Results + 313 in 17.1s = 18.3/s Avg: 37 Min:
7 Max: 165 Err: 0 (0.00%)
Generate Summary Results = 17310 in 768.5s = 22.5/s Avg: 40 Min:
7 Max: 3256 Err: 0 (0.00%)
Tidying up ... @ Tue Oct 27 00:06:17 CDT 2009 (1256619977181)
... end of run

This output will be updated every 3 minutes, showing the most recent activity as well as a summary for the whole test.

Result Logs
In addition to this summary data, which is output on the command line, log files are created for both the successful (jmeter-results-setup.jtl) and unsuccessful (jmeter-assertions-setup.jtl) results. These log files are saved in JTL format (which is based on XML). There are a number of parsers which will generate graphs from these log files. For more information, see the JMeter wiki page on Log Analysis.

Fixed Load Test
Once the setup test has successfully run, the fixed load test can be run. This test will simulate a number of users accessing the JIRA installation.

This test has a number of parameters for tweaking the behavior if the test. By default, the test has the following behavior and strategy:

- Several groups of users, all running concurrently for a fixed amount of time, each with a small delay between requests.
  - ‘Edit Issue’ (editissue) users browse a project and then attempt to find an issue. They will then comment, edit or change the workflow of that issue.
  - ‘User Action’ (useraction) users create filters, view watches and votes.
  - ‘Browse Issue’ (browseissue) users browse projects and issues.
  - ‘RSS’ users browse project and then periodically fetch the RSS feed for that project.
  - ‘Create Issues’ (createissue) users add new issues to the instance.
  - ‘Search Issues’ (search) users search for issues using the quick search textbox.

There is no execution of JavaScript by the JMeter client. JavaScript performance will depend on several factors such as your browser and workstation speed. JMeter does not measure this.
Running the fixed load test:

```bash
<jmeter location>/bin/jmeter -n -t jmeter-test-fixedload.jmx
```

As with the setup test (above), this command will run the **fixed load test** with the default values. Similarly, it is possible to control the execution of JMeter with `-J` parameters. The fixed load test has the following available parameters:

**Configuration Control**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira.host</td>
<td>localhost</td>
<td>The hostname or address of the JIRA installation.</td>
</tr>
<tr>
<td>jira.port</td>
<td>8000</td>
<td>The network port that the JIRA installation is running on.</td>
</tr>
<tr>
<td>jira.context</td>
<td>/</td>
<td>JIRA webapp context.</td>
</tr>
<tr>
<td>admin.user</td>
<td>admin</td>
<td>Administrator username.</td>
</tr>
<tr>
<td>admin.pass</td>
<td>admin</td>
<td>Administrator password.</td>
</tr>
<tr>
<td>script.base</td>
<td>.</td>
<td>The location of the performance tests. This should only be set if you run the tests from outside the scripts directory.</td>
</tr>
<tr>
<td>script.runtime</td>
<td>1800</td>
<td>The amount of time to run for (in seconds).</td>
</tr>
<tr>
<td>resource.dir</td>
<td>resources</td>
<td>The subdirectory which contains the resource CSV files. Replace this if you wish to customize the backend data.</td>
</tr>
</tbody>
</table>

**Edit Issue**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>editissue.threads</td>
<td>5</td>
<td>The number of simultaneous 'Edit Issue' users to simulate.</td>
</tr>
<tr>
<td>editissue.pause</td>
<td>15000</td>
<td>The pause between each 'Edit Issue' user request (in milliseconds).</td>
</tr>
<tr>
<td>workflow.matchname</td>
<td>(Close</td>
<td>A regular expression to match the workflow to action.</td>
</tr>
<tr>
<td></td>
<td>Resolve)</td>
<td></td>
</tr>
<tr>
<td>editworkflow.percentage</td>
<td>20</td>
<td>The percentage of 'Edit Issue' user requests that will attempt to change the issue workflow.</td>
</tr>
<tr>
<td>addcomment.percentage</td>
<td>60</td>
<td>The percentage of 'Edit Issue' user requests that will attempt to add a comment to an issue.</td>
</tr>
<tr>
<td>editissue.percentage</td>
<td>20</td>
<td>The percentage of 'Edit Issue' user requests that will attempt to edit an issue.</td>
</tr>
<tr>
<td>editissue.issuestoown</td>
<td>5</td>
<td>The number of issues the test attempts to assign to an 'Edit Issue' user.</td>
</tr>
</tbody>
</table>

**User Actions**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>useraction.threads</td>
<td>1</td>
<td>The number of simultaneous 'User Action' users to simulate.</td>
</tr>
<tr>
<td>useraction.pause</td>
<td>40000</td>
<td>The pause between each 'User Action' user request (in milliseconds).</td>
</tr>
</tbody>
</table>
### Create Issues

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>issue.create.threads</td>
<td>3</td>
<td>The number of simultaneous 'Create Issue' users to simulate.</td>
</tr>
<tr>
<td>issue.create.pause</td>
<td>15000</td>
<td>The pause between each 'Create Issue' user request (in milliseconds).</td>
</tr>
<tr>
<td>issue.comment.max</td>
<td>2</td>
<td>The maximum number of comments on an issue. The actual number is chosen randomly between 0 and this value.</td>
</tr>
</tbody>
</table>

### Search For Issues

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>search.threads</td>
<td>2</td>
<td>The number of simultaneous 'Search' users to simulate.</td>
</tr>
<tr>
<td>search.pause</td>
<td>15000</td>
<td>The pause between each 'Search' user request (in milliseconds).</td>
</tr>
</tbody>
</table>

### RSS

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>browserss.threads</td>
<td>10</td>
<td>The number of simultaneous 'RSS' users to simulate.</td>
</tr>
<tr>
<td>browserss.pause</td>
<td>60000</td>
<td>The pause between each 'RSS' user request (in milliseconds).</td>
</tr>
</tbody>
</table>

### Browse Issues and Projects

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>browseissue.threads</td>
<td>40</td>
<td>The number of simultaneous 'Browse Issue' users to simulate.</td>
</tr>
<tr>
<td>browseissue.pause</td>
<td>3000</td>
<td>The pause between each 'Browse Issue' user request (in milliseconds).</td>
</tr>
<tr>
<td>userprofile.percentage</td>
<td>10</td>
<td>The percentage of 'Browse Issue' user requests that will attempt to browse a user profile.</td>
</tr>
<tr>
<td>browsedashboard.percentage</td>
<td>20</td>
<td>The percentage of 'Browse Issue' user requests that will attempt to browse the dashboard.</td>
</tr>
</tbody>
</table>

### Test Output

Once you have chosen your target settings, run JMeter and you should get output similar to the following:
jmeter -n -t jmeter-test-fixedload.jmx
Created in 2015 by Atlassian. Licensed under a
Creative Commons Attribution 2.5 Australia License.

---

<table>
<thead>
<tr>
<th>Testing Details</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created the tree successfully using jmeter-test-fixedload.jmx</td>
<td></td>
</tr>
<tr>
<td>Starting the test @ Wed Oct 28 01:13:22 CDT 2009 (1256710402435)</td>
<td></td>
</tr>
<tr>
<td>Waiting for possible shutdown message on port 4445</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 568 in 97.9s = 5.8/s Avg: 62 Min:</td>
<td></td>
</tr>
<tr>
<td>1 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 3861 in 179.4s = 21.5/s Avg: 39 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 494 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 4429 in 277.4s = 16.0/s Avg: 42 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 7356 in 180.0s = 40.9/s Avg: 37 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 481 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 11785 in 457.3s = 25.8/s Avg: 39 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 10841 in 180.1s = 60.2/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 995 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 22626 in 637.4s = 35.5/s Avg: 39 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 11821 in 180.3s = 65.6/s Avg: 37 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 507 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 34447 in 817.3s = 42.1/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 11904 in 180.9s = 65.8/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 658 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 46351 in 997.4s = 46.5/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 11697 in 180.3s = 64.9/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 488 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 58048 in 1177.4s = 49.3/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 11731 in 180.0s = 65.2/s Avg: 39 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 810 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 69779 in 1357.4s = 51.4/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 11646 in 180.0s = 64.7/s Avg: 39 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 776 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 81425 in 1537.4s = 53.0/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 11810 in 180.0s = 65.6/s Avg: 39 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 798 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 93235 in 1717.3s = 54.3/s Avg: 38 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results + 5453 in 109.1s = 50.0/s Avg: 42 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 858 Err: 0 (0.00%)</td>
<td></td>
</tr>
<tr>
<td>Generate Summary Results = 98888 in 1826.4s = 54.0/s Avg: 39 Min:</td>
<td></td>
</tr>
<tr>
<td>0 Max: 1534 Err: 0 (0.00%)</td>
<td></td>
</tr>
</tbody>
</table>

This output will be updated every 3 minutes, showing the most recent activity as well as a summary for the whole test.

**Result Logs**

As above, there will be output on the command line and log files will be created for both the successful (jmeter
JIRA 6.4 Documentation

-created-results-setup.jtl) and unsuccessful (jmeter-assertions-setup.jtl) results. These log files are saved in the JTL format (based on XML). There are a number of parsers which will generate graphs from these logs files. For more information, see the JMeter wiki page on Log Analysis.

**Auditing in JIRA**

**About auditing in JIRA**

The auditing feature tracks key activities in JIRA. These activities are recorded in an audit log that can be viewed in the JIRA administration console. This can be a handy tool in helping you diagnose problems in JIRA or used for security purposes.

The following information is audited by JIRA:

- user management
- group management
- project changes
- permission changes
- workflow changes
- notification scheme changes
- custom field changes
- component changes
- version changes

The audit log is not intended to record all activity in JIRA, as can be seen above. For example, it does not track issue updates or pages that are viewed by a user. Rather, the audit log is intended to record configuration changes that can impact users and projects. The full list of events recorded by JIRA can be seen below.

**On this page:**

- About auditing in JIRA
- Viewing the audit log
- Hiding external directory user events (LDAP/Crowd events)
- Modifying the audit log retention period
- Exporting the audit log
- Auditing and the REST API

**Viewing the audit log**

To view the audit log in JIRA:

1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System > Audit Log.
3. The following events are audited:

<table>
<thead>
<tr>
<th>Category</th>
<th>Events</th>
</tr>
</thead>
<tbody>
<tr>
<td>User management</td>
<td>user added, user removed, user changed</td>
</tr>
<tr>
<td>Group management</td>
<td>group added, group removed, user added to group, user removed from group</td>
</tr>
<tr>
<td>Project changes</td>
<td>project created, project removed, project updated, project category changed, project avatar changed</td>
</tr>
<tr>
<td>Category</td>
<td>Changes</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Permission changes</td>
<td>scheme created, scheme copied, scheme removed, scheme edited, scheme assigned to a project, scheme unassigned from a project, permission added to scheme, permission removed from scheme, global permission added to a group, global permission removed from a group</td>
</tr>
<tr>
<td>Workflow changes</td>
<td>scheme created, scheme copied, scheme removed, scheme edited, scheme assigned to a project, scheme unassigned from a project, workflow created, workflow copied, workflow removed, workflow renamed, workflow draft published</td>
</tr>
<tr>
<td>Notification changes</td>
<td>scheme created, scheme copied, scheme removed, scheme edited, scheme added to project, scheme removed from project, notification added to scheme, notification removed from scheme</td>
</tr>
<tr>
<td>Custom field changes</td>
<td>custom field created, custom field updated, custom field removed, scheme added to project, scheme removed from project</td>
</tr>
<tr>
<td>Component changes</td>
<td>component created, component edited, component deleted</td>
</tr>
<tr>
<td>Version changes</td>
<td>version created, version edited, version deleted, version merged, version archived/unarchived, version released/unreleased</td>
</tr>
</tbody>
</table>

**Notes:**

- The date and time displayed by the audit log is based on the timezone of the host JIRA server, and not on the viewer's timezone.
- The audit log cannot be sorted. Try exporting the data and opening it in a spreadsheet to manipulate the data.

**Hiding external directory user events (LDAP/Crowd events)**

By default, the audit log will display all recorded events. However, you can choose to hide external directory user events (those triggered by LDAP or Crowd) from view. These events are still recorded, and will still be available for export.

1. Log in as a user with the **JIRA System Administrators** global permission.
2. Choose 
   ![Open System Settings](image)
   > System > Audit Log.
   - **Keyboard shortcut:** `g + g +` type Audit log
3. Select Actions > Audit Log Settings.
4. Check the **Hide events from external user directories** check box to hide the user events.

**Modifying the audit log retention period**

Auditing is always enabled in JIRA. However, you can configure how long audit events are retained.

1. Log in as a user with the **JIRA System Administrators** global permission.
2. Choose 
   ![Open System Settings](image)
   > System > Audit Log.
   - **Keyboard shortcut:** `g + g +` type Audit log
3. Select Actions > Audit Log Settings.
4. Choose your retention period.

**Exporting the audit log**

You can export the audit log as a text file. When you export the audit log, all the events are included in the export, even if you currently have filtered the audit log results in the page.

1. Log in as a user with the **JIRA System Administrators** global permission.
2. Choose 
   ![Open System Settings](image)
   > System > Audit Log.
   - **Keyboard shortcut:** `g + g +` type Audit log
3. Select Export.
Auditing and the REST API

The audit log can also be accessed via the REST API. You may use this to:

- Export the audit log
- Add events to the audit log triggered by external plugins

For more information on using the REST API, please refer to the JIRA REST documentation for your appropriate version of JIRA within the developer documentation here.

Lockout recovery process

Place holder for 7.0 to provide link

Appendix A - Extending JIRA

JIRA is very flexible, and has a number of extension points where JIRA's data can be queried or its functionality extended. This page provides an overview of the mechanisms available for extending JIRA.

ℹ️ JIRA Add-ons: For information on installing or enabling existing add-ons, please read the Managing JIRA Add-ons documentation. To learn about creating your own add-ons, see developing add-ons with the Atlassian Plugin SDK.

Note that an add-on that specifically plugs into the architecture of an Atlassian application such as JIRA is sometimes called a plugin, although the terms ‘plugin’ and ‘add-on’ are often used interchangeably.

<table>
<thead>
<tr>
<th>Custom Field Types</th>
<th>JIRA comes with various custom field types defined. New types can be written and plugged into JIRA. See the How to create a new Custom Field Type tutorial for more information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Formats</td>
<td>JIRA comes with many options to change the look and feel of features in the system. User formats, a feature that can be customized by add-ons. You can write your own User Format add-on to change the display of user details in JIRA, e.g. display a profile picture. See the User Format Plugin Module for more information.</td>
</tr>
<tr>
<td>Gadgets</td>
<td>New gadgets can be created by writing an XML descriptor file, packaged as an Atlassian plugin. See Writing an Atlassian Gadget for more information.</td>
</tr>
<tr>
<td>Reports</td>
<td>JIRA comes with various reports built-in. Using the plugin system, new reports can be written, providing new ways of viewing and summarizing JIRA's data.</td>
</tr>
</tbody>
</table>
| Workflow functions and conditions | JIRA's issue workflow (states and state transitions an issue can go through) can be customized through the web interface (see the workflow documentation). The workflow engine provides hooks where you can plug in your own behavior:
  - Run arbitrary Java when a certain transition occurs, via post-functions.
  - Limit visibility of transitions to certain users, via conditions.
  - Validate input on transition screens (e.g. in comments), via validators.

See the How to create Custom Workflow Elements for JIRA guide for details on how to write your own workflow post-functions, conditions and validators. Once written, these can be packaged as plugins and reused. |
One the 'View Issue' page, some issue information (comments, change history) is displayed. Likewise, the 'Browse Project' page contains separate sections, listed on the far left, for different types of project information:

By writing a plugin, you can add new issue or project sections (that will be listed in the left panel) to JIRA. For instance, you may wish to display project/issue data pulled in from an external source. This is how the JIRA Subversion plugin works. See the plugin guide for more information on writing these plugin types.

JIRA has a complete event subsystem which fires events whenever anything happens. For example, an ISSUE_CREATED event is fired whenever an issue is created. A listener is just a class which implements a JiraListener interface and is called whenever events occur in JIRA. Using those events, you can then perform any action you want. For example the email sent by JIRA is driven by the MailListener. This is useful when you want to drive or affect external systems from events which occur within JIRA - usually used to push data into outside systems. For more information, see the listeners documentation.

Services are classes which implement the JiraService interface. When installed, you specify an update period and JIRA will call the run() method of your service periodically. A sample service is provided called POPCommentService. This service checks a particular POP mailbox periodically and if it finds messages, tries to extract an issue key from the subject. If the subject contains a key, the body of the mail is added as a comment to the message. Services are useful when you want to periodically pull data into JIRA from outside systems. For more information, see the services guide.

JIRA has a growing SOAP and XML-RPC interface. This enables you to drive JIRA automatically from external systems. For example you can have a Java program, Perl script or C# client add issues to JIRA. See the JIRA RPC Services overview for general information. For building RPC clients, check out the Creating a JIRA SOAP Client and Creating an XML-RPC Client tutorials. New RPC endpoints can also be added to JIRA as plugins - see the RPC Endpoint Plugin Module.

JIRA has a full set of Java APIs that can be used to update information with in JIRA. You can view the API here. JIRA commercial customers get full access to the JIRA source (see bottom of the downloads page), so you can modify JIRA itself if necessary. See the Building JIRA from Source page for more information.

Managing Add-ons

An add-on is an installable component that supplements or enhances the functionality of JIRA in some way. For example, the JIRA Calendar Plugin is an add-on that shows the due dates for issues and versions in calendar format. Other add-ons are available for connecting JIRA to Bamboo, developing for JIRA, and accessing Atlassian support from JIRA.
JIRA comes with many pre-installed add-ons (called system add-ons). You can install more add-ons, either by acquiring an add-on from the Atlassian Marketplace or by uploading an add-on from your file system. This means that you can install add-ons that you have developed yourself. For information about developing your own add-ons for JIRA, see the JIRA Developer documentation.

To enable various JIRA Gadgets (for example, the Text Gadget), please refer to this section: Configuring the Default Dashboard.

On this page:
- About Add-ons
- About the Universal Plugin Manager

You may notice that the terms 'add-on' and 'plugin' both appear in the Atlassian documentation and tools. While the terms are often used interchangeably, there is a difference. A plugin is a type of add-on that can be installed into an Atlassian host application. Plugins are what developers create with the Atlassian SDK. But there are other types of add-ons as well. For example, the JIRA client is an add-on that runs as a separate program rather than as a plugin to JIRA. This documentation uses the term 'add-on' most often.

About the Universal Plugin Manager

The Universal Plugin Manager (UPM) is itself an add-on that you use to administer add-ons from the JIRA Administration Console. UPM works across Atlassian applications, providing a consistent interface for administering add-ons in JIRA, Confluence, Crucible, Fisheye, Stash or Bamboo.

UPM comes pre-installed in recent versions of all Atlassian applications, so you do not normally need to install it yourself. However, like other add-ons, the UPM software is subject to regular software updates. Before administering add-ons in JIRA, therefore, you should verify your version of the UPM and update it if needed.

You can update UPM, or any add-on, from the UPM's own add-on administration pages. In addition to updating UPM, you can perform these tasks from the administration pages:

- Install or remove add-ons
- Configure add-on settings
- Discover and install new add-ons from the Atlassian Marketplace
- Enable or disable add-ons and their component modules, including "safe mode"

If the add-on request feature is enabled in your Atlassian application, non-administrative users can also discover add-ons on the Atlassian Marketplace. Instead of installing the add-ons, however, these users have the option of requesting the add-ons from you, the administrator of the Atlassian application.

For more information on administering the add-on request feature or performing other common add-on administration tasks, see the Universal Plugin Manager documentation. For an end-user's view of requesting add-ons in JIRA, see Requesting Add-ons.

Using the Issue Collector

What is an 'issue collector'?

The issue collector allows you to easily embed a JIRA feedback form into your own web site. This form is typically accessed by clicking a 'trigger' tab exposed along the edge of pages in your web site.

When used by people visiting your web site click this trigger tab and submit the resulting JIRA feedback form, an issue is conveniently created in JIRA.

Visitors to your web site do not require a user account in JIRA to use the JIRA feedback form.

Accessing JIRA’s issue collectors
In JIRA, issue collectors are configured (and hence organised) on a per-project basis.

**To access all issue collectors configured in JIRA:**

1. Log in as a user with the **JIRA Administrators global permission**.

2. Choose ⚙ > Add-ons. Select **Issue Collectors** to open the Issue Collectors page, which shows a list of all existing issue collectors in your JIRA system.

   ✔️ Keyboard shortcut: `g + g` start typing **issue collectors**

3. Click the name of a project to access a more detailed list of issue collectors belonging to that project or click the name of an issue collector to access detailed information about it. On the issue collector page (containing detailed information), you can access:
   - An activity graph, showing the number of issues created via this issue collector (Y-axis) on a daily basis (X-axis).
   - A list of recent issues in reverse chronological order, which have been created via this issue collector.

   **On this page:**
   - What is an 'issue collector'?
   - Accessing JIRA's issue collectors
   - Adding an issue collector
   - Embedding an issue collector into your web site
   - Editing an issue collector
   - Copying an issue collector
   - Disabling or deleting an issue collector
   - Known Limitations

**Related pages:**
- Advanced Use of the JIRA Issue Collector

**To access issue collectors belonging to a specific project:**

1. Log in to JIRA as a project administrator or a user with the **JIRA Administrators global permission**. A project administrator is someone who has the **Administer Project** project-specific permission, but not necessarily the **JIRA Administrators global permission**.

2. Choose ⚙ > Projects, and click the name of a project.

   ✔️ Keyboard shortcut: `g + g` start typing **project**

3. On the left of the **Project Summary** page, click the **Issue Collectors** tab. The **Issue Collectors** page is displayed, listing any issue collectors that have already been set up in your project.

4. Click the name of an issue collector to access detailed information about it — in particular, its recent activity and details on how to embed the issue collector into your web site.

**Adding an issue collector**

1. Log in to JIRA as a **project administrator** or a user with the **JIRA Administrators global permission**.
2. Choose ✚ > Projects, and click the name of a project.  
   ![Keyboard shortcut: g + g + start typing project]
3. On the left of the Project Summary page, click the Issue Collectors tab. The Issue Collectors page is displayed, listing any issue collectors that have already been set up in your project.
4. Click the Add Issue Collector button to open the Add Issue Collector page.
5. In the top section of the Add Issue Collector page, specify the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Specify the name of the issue collector, as you want it to appear throughout the JIRA user interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Specify a description for the issue collector. This description will appear adjacent to the Name of your issue collector, throughout the JIRA user interface.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>Select the type of issue that you want created in JIRA when visitors to your web site submit your issue collector's JIRA feedback form.</td>
</tr>
<tr>
<td>Issue Reporter</td>
<td>Specify the username that will be the default reporter of JIRA issues created when visitors to your web site submit your issue collector's JIRA feedback form.</td>
</tr>
</tbody>
</table>
| Match Reporter? | Select either of the following:  
  - **Always use Issue Reporter** — select this option to ensure that the default Issue Reporter you specify above, will always be the reporter of issues created by submission of the JIRA feedback form on your web site.  
  - **Attempt to match user session of submitter or submitter email address** — select this option if you want the reporter of an issue created by submission of the JIRA feedback form on your web site, to be a JIRA user:  
    - Who is logged in to JIRA when they submit a JIRA feedback form on your web site (in the same browser session).  
    - Who's email address matches the email address specified in the E-mail field of the JIRA feedback form.  
  Please note that if the JIRA user does not have the Create Issues project permission in your JIRA project, the default Issue Reporter you specify above will be used as the issue's reporter. |
| Collect Browser Info | Select this option to collect meta-information about your browser’s statistics, which will be incorporated into issues created by submission of the JIRA feedback form on your web site. |

6. In the middle section of the Add Issue Collector page (entitled Trigger), specify the following:

| Trigger Text | Specify a short, brief phrase that will appear on the trigger tab on your web site. |
| Trigger Style | Choose the style in which trigger tab will appear on your web site. Custom will not display a trigger but will add additional javascript to the generated script, so you can create a custom trigger on your web page. |

7. In the lower section of the Add Issue Collector page (entitled Issue Collector Form), specify the following:
### Template
Choose from the options provided. Typically, your choice would reflect the type of issue being created (i.e. chosen above). You can choose:

- **A predefined template for your JIRA feedback form** — either **Got Feedback?** or **Raise a Bug**.
- **Custom** to create a custom JIRA feedback form, which allows you to specify your own wording on the dialog box as well as add or remove other fields on the form and change their positions on the form.
  - Please note that if a field is *required* for the chosen issue type but that field has:
    - No specified a default value, the field will automatically appear on the form. This field's position can be changed on the form, although it cannot be removed.
    - A default value but the field is not added to the form, then the field's default value is used when an issue is created via the issue collector.
    - Not all fields of types of fields can be added to the form, since some fields cannot be displayed to anonymous users. The fields types that can be displayed are:
      - **Standard Fields**: Summary, Description, Components, AffectsVersion, Environment, Priority, Attachment
      - **Custom Field Types**: Date Time, Radio Buttons, Multi-Checkbox, Multi-Select, Number, Select List, URL field, Version Picker, Cascading Select, Project Picker, Single Version Picker, Text Field, Free Text Field

### Message
Type a message, which appears in the blue 'information' panel along the top of the dialog box.

---

8. Click the **Submit** button to save your changes.

### Embedding an issue collector into your web site

After clicking the **Submit** button (above) to save your new issue collector, a page containing code snippets is displayed. Use the code and information provided to embed your new issue collector into your web site.

- **If you accidentally click away from this page**, you can easily retrieve the information that was on it by accessing your issue collector's details (above) and scrolling to the end of the page.

- **Embedding this Issue Collector**

  - Code to insert:
    ```javascript
    /com.atlassian.jira.collector.plugin.jira-issue-collector-plugin:issulector.js?collectorId=2f75d437"></script>
    ```

- **More Instructions**

### Editing an issue collector

Editing an issue collector should not require any changes to web pages that include the issue collector, unless you change the **Trigger Style** to or from a custom trigger. Changing the **Trigger Style** to or from a custom trigger will change the generated javascript, so you may need to change what you embed in any web page that includes the issue collector.

To **edit an existing issue collector**:

1. Log in to JIRA as a **project administrator** or a user with the **JIRA Administrators global permission**.
2. Access the relevant project's list of issue collectors (above).
3. In the Operation dropdown for the issue collector you would like to edit, select **Edit** to open the **Edit Issue Collector** page.
4. Update the issue collector, as desired.
5. Click **Update** to save your changes.

**Copying an issue collector**

Copying an issue collector will create an entirely new issue collector and will not affect any existing issue collectors. You will need to embed it in whatever web pages you would like, just as if you had created a new issue collector.

**To copy an existing issue collector:**

1. Log in to JIRA as a **project administrator** or a user with the **JIRA Administrators global permission**.
2. Access the relevant project's list of issue collectors (above).
3. In the Operation dropdown for the issue collector you would like to edit, select **Copy** to open the **Add Issue Collector** page.
4. All the information from the copied issue collector will be the same as the copied issue collector with the exception of the name (which will be "Copy of " + the original name of the copied issue collector).
5. Update the issue collector, if desired.
6. Click **Submit** to save your changes.

**Disabling or deleting an issue collector**

**To disable or delete an issue collector:**

1. Access the relevant project's list of issue collectors (above).
2. On the list of the project's issue collectors, click **Disable** or Delete to respectively disable or delete the associated issue collector.

   > While an issue collector is disabled, its trigger tabs will still be visible on pages of your web site(s) to which the issue collector code has been added until a user refreshes the page. However, clicking these triggers results in a message indicating that the issue collector is currently out of action.

**Known Limitations**

**Placing the Issue Collector plugin within a frameset will not close the prompt window automatically.**

This is a known limitation for Issue Collector plugin and has been tracked at

[JRA-29886 - Issue Collector Cannot Be Closed When Placed Inside a Frameset](https://issues.jira.com/browse/JRA-29886)

**Advanced Use of the JIRA Issue Collector**

**Customizing the JIRA issue collector**

The JIRA issue collector can be used without any additional JavaScript beyond the single line generated in the issue collector administration screens in JIRA. However, you can also customize the JIRA issue collector in a number of different ways:

- Set up a custom trigger, so the feedback form launches from a different link or button than the packaged triggers provided.
- Set the default values of fields for your users, using JavaScript.
- Specify the values of fields on the issue, which are not shown in the feedback form.

This page assumes you are already familiar with **Using the Issue Collector**.

**Warning**: The JavaScript exposed by the issue collector is not considered a stable API and may change with new JIRA releases.
### Setting up a custom trigger

#### Configuring your collector to use a custom trigger

If you want to use a different trigger, or button, to launch the issue collector on your website, configure your issue collector as described below:

1. Add a new issue collector, or edit an existing issue collector.
2. Scroll down to section Trigger and select the option 'Custom'.
3. You don't need to set any Trigger Text as this will be overridden by your custom trigger.

**Screenshot: Using a custom trigger for an issue collector**

The code snippet below shows a sample HTML page with the generated issue collector JavaScript.

```
The issue collector script generated by JIRA for adding a custom trigger is slightly different to the script generated for the standard triggers, because it includes the JavaScript function for the custom trigger.

Customization of the issue collector is done by creating/extending the global object ATL_JQ_PAGE_PROPS. This allows you to add a custom trigger, set default values for fields and more.

**Note:** In JIRA 5.1 (and version 1.1 of the Issue Collector plugin), the issue collector administrative interface let you define the custom trigger function UI, and you did not need to include it in the JavaScript on the page. In version 1.2 of the Issue Collector, the custom trigger JavaScript is a part of the generated JavaScript that you should copy and paste into your web page.

The code snippet below shows a sample HTML page with the generated issue collector JavaScript.

In the example below, we've added a simple button in HTML, and made that button launch the issue collector. This is done simply by replacing 'myCustomTrigger' in the generated JavaScript with the HTML id of the button ('feedback-button')
Adding the custom trigger function manually

The custom trigger JavaScript will be included in the JavaScript generated by the Issue Collector. However, this section provides details on how you could do it without pasting in the additional lines of generated JavaScript.
To add a custom trigger, add the property `triggerFunction` in the global object ` ATL_JQ_PAGE_PROPS`. `triggerFunction` needs to be defined as a function and takes one argument which is the function for displaying the issue collector.

You can invoke the issue collector from any element on your page by adding a click handler in `triggerFunction` as shown below. In this example, we will be calling the issue collector from our `#feedback-button` anchor tag defined in the above HTML markup. You can assign multiple triggers for the same issue collector by adding more click handlers.

```javascript
window.ATL_JQ_PAGE_PROPS = $.extend(window.ATL_JQ_PAGE_PROPS, {

  // ==== custom trigger function ====
  triggerFunction : function( showCollectorDialog ) {
    $('#feedback-button').on( 'click', function(e) {
      e.preventDefault();
      showCollectorDialog();
    });

    // add any other custom triggers for the issue collector here
  }
});
```

The `triggerFunction` will be invoked by the Issue Collector after the `(document).ready()` phase.

Setting field values from JavaScript

Setting field values

The issue collector gives you the option to set field values for any of the fields on the issue type. This is done by adding the property `fieldValues` in the global object ` ATL_JQ_PAGE_PROPS`. There are different methods for setting default values for different field types. The code samples below show a visual representation of a field in JIRA and its relevant markup, and how to set a default value for that field type. Use a DOM inspection tool such as Firebug in the JIRA Issue Create Screen to extract the field names and values relevant to your issue collector. Please note that the Issue Collector is not supposed to be a replacement for the JIRA REST API. If you require a more customized solution, make use of the JIRA REST API to create JIRA issues from external websites. The JIRA Travel App is a good example of how you can build a front end interface with JIRA as the back end.

Visible fields (setting default field values)

If you set the value of a field that is visible on the issue collector feedback form, the fields will already be filled in with that value when the form opens.

Hidden fields

There might be cases where you might want to set a field value without actually displaying the field on the Issue Collector. In this case, simply use the same method as above to set the field values via JavaScript. The fields will not be shown as they were not added in the form template but their values will still be present in issues created with the Issue Collector.

JavaScript for Setting field values

Setting field values is done by specifying field name / value pairs within the "fieldValues" block of `window.ATL_JQ_PAGE_PROPS`. If you already have a custom trigger defined, you can simply add to the definition of `window.ATL_JQ_PAGE_PROPS` like the example below.

Note the names of the fields are always the names of the field in the JIRA Create Issue Screen, not any overridden names you may have provided in the issue collector form.
Examples of how to set specific field types

Text field example

Setting the value for a text field, like the issue Summary, is straightforward. Here's the markup for a text field like Summary in the issue Collector (you do not need to add this, this is simply to show the representation that the Issue Collector contains):

```
<div class="field-group">
...
<input class="text long-field" id="summary" name="summary" type="text" value="">
...
</div>
```

And here's how you set the value of the field in JavaScript:

```
fieldValues : {
  summary : 'This is the default summary value'
}
```

Select list example with issue priority

Setting the value for a select list field, such as the issue priority, requires a little more effort, because you need to know the HTML element id for the choice you want to select. Here's the markup for the Priority field in the issue Collector (you do not need to add this, this is simply to show the representation that the Issue Collector contains):
<div class="field-group">
...<input id="priority-field" class="text aui-ss-field ajs-dirty-warning-exempt" autocomplete="off">
...
<select class="select" id="priority" name="priority" style="display: none; " multiple="multiple">
<option class="imagebacked" data-icon="/images/icons/priority_blocker.gif" value="1">Blocker</option>
<option class="imagebacked" data-icon="/images/icons/priority_critical.gif" value="2">Critical</option>
...
</select>
...
</div>

And here's how you set the value of the field in JavaScript:

```javascript
fieldValues : {
  'priority' : '2'
}
```

### Multi-select or checkboxes example

<table>
<thead>
<tr>
<th>Browser</th>
<th>All Browsers</th>
<th>Chrome</th>
<th>Firefox 8.0.x</th>
<th>FireFox 7.0</th>
<th>IE 10</th>
</tr>
</thead>
</table>

Setting the value for a multi-select (like the Browser field) or checkbox requires that you provide an array of values. Like the select list, you need to know the values to set, by looking at the markup on the Create Issue Screen.

```html
<div class="field-group">
...<select class="select" id="customfield_10110" multiple="multiple" name="customfield_10110" size="5">
<option value="-1" selected="selected">None</option>
<option value="10039">All Browsers</option>
<option value="10037">Chrome</option>
...<option value="10037">Chrome</option>
...
</select>
...
</div>
```

And here's how you set the value of the field in JavaScript: the field values must be set as an array of values, even if there is only one value.

```javascript
fieldValues : {
  'customfield_10110' : [ '10039', '10037' ]
}
```

### Custom fields
Setting a value for a custom field is exactly the same as any other field in JIRA. Since multiple custom fields can share the same name, custom fields will be referenced by "customfield_" + the Id of the custom field in JIRA. This ID can be seen in the HTML markup for the Create Issue Screen in JIRA, but can also be determine by looking at the URLs on the custom fields screen in JIRA administration. Here’s what the JavaScript would look like for setting a custom field whose id in JIRA was 11111:

```javascript
fieldValues : {
  'customfield_11111'   : 'San Francisco'
}
```

Cascading selects

Setting a value for a cascading select is done in two steps - one for the parent value and one for the child. Below is an example of setting the value of a cascading select field.

```javascript
fieldValues : {
  'customfield_12345'   : 'Australia',
  'customfield_12345:1' : 'Sydney'
}
```

Special Case Fields

Environment field

By default the Issue Collector puts user context such as the URL, User-Agent and screen resolution in the environment field. There might be cases where you wish to include more information in the environment field. In this case, you can add the property `environment` in the global object `ATL_JQ_PAGE_PROPS`. This allows you to add key value pairs that will appear on the environment field in the JIRA issue.

```javascript
window.ATL_JQ_PAGE_PROPS = $.extend(window.ATL_JQ_PAGE_PROPS, {
  // ==== custom trigger function ====
  triggerFunction : function( showIssueCollector ) {
    ...
  },
  // ==== default field values ====
  fieldValues : {
    ...
  },
  // ==== Special field config for environment ====
  environment : {
    'Custom env variable'  : $('#build-no').text(),
    'Another env variable' : '#007'
  }
});
```

Restricted fields

Some fields that require a user to be logged into JIRA cannot be set through JavaScript. Assignee is an example of a field that cannot be set via JavaScript.

Dynamic functions

`Environment` and `fieldValues` properties can also be a function returning a JSON object that will be executed immediately when the collector trigger is shown (not just before opening the collector form). This might come in handy when you might wish to capture contextual information relevant to the user.
Embedding multiple issue collectors

If you want to have two different forms appear on the same web page, you will need to create two different issue collectors in JIRA. To set custom triggers, or set field values on those issue collectors requires a few changes to your page:

1. Include the generated JavaScript for both of your issue collectors in the page.
2. Find the id of each collector. This can be done one of two ways:
   a. The parameter of the script is "collectorId=<8 character id>". That's the ID you want.
   b. Go to the Issue Collector page in the Admin section and click on the Issue Collector you wish to embed. Copy the collectorId from the URL.

   https://<JIRA_URL>/secure/ViewCollector!default.jspa?projectKey=<PROJECT_KEY>&colle ctorId=<copy this part here>

Then, create separate namespaces for each of the issue collectors in the ATL_JQ_PAGE_PROPS object.
Embedding the Issue Collector

Embedding the Issue Collector in your Confluence Site

The Issue Collector can be embedded into Confluence using the HTML Include Macro. Note that using the HTML Include Macro would require you to embed the Issue Collector code separately on each page.

The Issue Collector was previously embeddable in Confluence via a User Macro, allowing you to create a re-usable Issue Collector macro that other Confluence users can embed into their pages. This option is currently unavailable due to a known bug: CONF-26104 - Some JavaScripts are not executed if included in User Macro

Embedding the Issue Collector is not currently supported in Confluence Cloud.

JIRA

The Issue Collector can be embedded in the Announcement Banner on a JIRA page by embedding the above script and HTML markup for your custom trigger in the Announcement Banner configuration screen. If you wish to change the location of your custom trigger, this can be easily done via jQuery. The following snippet shows how you can add the custom trigger onto the footer of all JIRA pages.

You cannot embed an Issue Collector in your JIRA Cloud instance since HTML markup is disabled for the Announcement Banner.

```
window.ATL_JQ_PAGE_PROPS = $.extend(window.ATL_JQ_PAGE_PROPS, {
    // ==== custom trigger function ====
    triggerFunction : function( showIssueCollector ) {
        // button markup - relevant css can be added via the style attribute
        var feedbackButton = "<a id='feedback-button'>Got Feedback?</a>";
        // embed the button in the footer
        $('.footer-link').append(feedbackButton);
        $('#feedback-button').click(function(e) {
            ...
        });
    }
});
```

Please note that embedding the Issue Collector requires you to enable HTML markup for the Announcement Banner.

**Full Source Code**
This source code shows how to embed two different issue collectors on the same page with custom triggers.

```html
<body>

<h2>JIRA Issue Collector Demo</h2>

<a href="#" id="feedback-button" class='btn btn-primary btn-large'>Report feedback</a>

<!-- JIRA Issue Collector - append this at the bottom of <body> -->

<!-- We will customize JIRA in the following script tag -->

<script type="text/javascript">

// safely use jquery here since the issue collector will load it for you
$(document).ready(function() {

    window.ATL_JQ_PAGE_PROPS = $.extend(window.ATL_JQ_PAGE_PROPS, {

    // ==== feedback collector ====
    '<collectorId_1>' : {

        // === custom trigger function ===
        triggerFunction : function( showCollectorDialog ) {
            $('#feedback_button').click( function(e) {
                e.preventDefault();
                showCollectorDialog();
            });
        }

        // === default and hidden field values ===
        , fieldValues : {
            // default values
            summary : 'Feedback for new website designs'
            , description : 'The font doesn\'t quite look right'

            // hidden field value
            , priority : '2'
        }

    }

    // ==== bug collector ====
    , '<collectorId_2>' : {

        // === custom trigger function ===
        triggerFunction : function( showCollectorDialog ) {
            $('#bug_button').click( function(e) {
                e.preventDefault();
                showCollectorDialog();
            });
        }

        // === additional environment details ===
        , environment : function() {

    }

</script>
</body>
```
var env_info = {};

if (window.ADDITIONAL_CUSTOM_CONTEXT) {
    env_info['Additional Context Information'] = window.ADDITIONAL_CUSTOM_CONTEXT;
}

return env_info;

// === default field values ===

fieldValues: function() {

    var values = {};

    var error_message = $('.error_message');
    if (error_message.length !== 0) {

        // record error message from the page context rather than asking the user to enter it
        values['summary'] = error_message.children('.summary').text();
        values['description'] = error_message.children('.description').text();

    }

    return values;

};
Is localization of an issue collector possible?

You can create an issue collector 100% localized to the default language of your JIRA instance. Beyond that, complete localization of the issue collector is not possible.

The strings and text in the issue collector feedback form of the issue collector is a combination of:

1. The issue collector strings set by the JIRA Administrator
2. Either the default language setting for JIRA, or the language preference of the user if they are logged in to JIRA.

- All users will see the names of the fields as they are set by the JIRA Administrator. These are not affected by the default language of JIRA, and are not affected by the default language of logged in JIRA users.
- All users will see the field descriptions as they are set in the JIRA Administration UI.
- For everything else:
  - Anonymous users will see everything else in the default JIRA language.
  - Logged in users will see everything else in the feedback form in the language specified by their JIRA profile.

Because of the above, you cannot create a single issue collector that will present itself entirely in the language of the end user.

However, if you want to create an issue collector that will present itself to anonymous users in the default language of your JIRA instance, you should:

1. Use the custom feedback template for the Issue Collector
2. Change the field labels in JIRA, and the labels for name and email, to the words you want to use in the default JIRA language.

The language setting of the browser will not impact the text in the feedback form.

Listeners

Listeners are unique to JIRA, and a very powerful way to extend it.

JIRA has a complete event subsystem which fires events whenever anything happens inside the application. For example an ISSUE_CREATED event is fired whenever an issue is created.

A Listener is a class that implements one of the Listener interfaces. It is then called whenever events occur in JIRA. Using those events, you can then perform any action you want. For example the email sent by JIRA is driven by the MailListener.

Listeners are most useful when you want to drive or affect external systems from events which occur within JIRA.

On this page:
- Listener Interfaces
- Example Listeners
- Registering a Listener
- Editing Listener Properties
- Removing a Listener
- Custom Events
- See Also

Listener Interfaces

JIRA has the following concrete Listeners (which extend the base JiraListener interface):
Example Listeners

The examples provided may be freely used and modified for use in your own environment. The source of all examples is available and should give you good overview of how simple it is to write your own listeners. Both example listeners are included with JIRA 2.1, and both implement UserEventListener and IssueEventListener.

- **DebugListener** ([source](#)) — This is a very simple listener that prints events and their content to System.out whenever they are received. To test this listener, add a listener with the class `com.atlassian.jira.event.listeners.DebugListener`.
- **MailListener** ([source](#)) — This listener is how mail notifications are currently sent from within JIRA, and a good example of a more complex listener. It basically listens for events, and turns them into email notifications using Velocity templates to generate the mail bodies. This listener is usually always turned on in JIRA — see Email Notifications for more details. If you want to write more complex or more specific notifications, you can disable the internal MailListener and add your own.

Other examples of useful tasks that can be accomplished with listeners are:

- **Send SMS or IM notifications** — A listener could easily send notifications for various events via SMS or instant messenger (e.g. ICQ or AIM) - or anywhere that you have a Java library to send messages.
- **Group notifications** — A listener could notify certain groups of issue changes, depending on the content of the issue. For example any issue containing "windows" in the environment could notify your "windows-developers" group.

Registering a Listener

For custom-written listener classes, make sure your listener class is in the classpath where JIRA can see it — the best locations are usually the `<jira-application-dir>/WEB-INF/classes` or `<jira-application-dir>/WEB-INF/lib` subdirectories within of your JIRA Installation Directory (as JAR files).

To register a listener:

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Choose ![Configuration icon] > System. Select Advanced > Listeners to open the Listeners page. Use Keyboard shortcut: 'g' + 'g' + 'lis' to open the Listeners page.
3. In the 'Add Listener' form at the bottom of the page, complete the following fields:
   - 'Name' — an appropriately descriptive name for the listener.
   - 'Class' — the fully-qualified class name of your listener.
To use one of JIRA's built-in listener classes, first click the 'Built-in Listeners' link to expand the list of listener classes and then click the name of the specific class in the list. The fully-qualified class name of the built-in listener will be added to the 'Class' field.

4. Click the 'Add' button and the listener will now be added to the list of listeners above.

Editing Listener Properties

If your listener accepts parameters or properties, you can edit these by clicking the 'Edit' link associated with your listener (on the 'Listeners' page in JIRA's Administration area).

When defining your own Listener, there is a method `getAcceptedParams` to overload for defining the parameter names which are passed as an array of String objects. The `init` method is given a `Map` with the configured values (the JavaDoc is outdated). The `com.atlassian.jira.event.listeners.DebugParamListener` class is a good example of doing this with two parameters.

Removing a Listener

To remove a listener, click the 'Delete' link associated with that listener (on the 'Listeners' page in JIRA's Administration area).

Custom Events

With the ability to add custom events to JIRA, the Listener must be updated to deal with the event as appropriate. This is possible by providing an implementation for the method `customEvent(IssueEvent event)` in the Listener. For example, the MailListener implementation passes the custom event on for notification processing. The DebugListener logs that the custom event has been fired.

See Also

- Plugin Tutorial - Writing event listeners with the atlassian-event library — this describes how to write listeners using the Atlassian Events library (see JIRA-specific Atlassian Events), rather than the JIRA Listener Events described above.
Services
A service is a class that runs periodically within JIRA. Since a service runs inside JIRA, it has the ability to use all of the JIRA API — and, as it is written in Java, it can use any Java libraries.

Services are useful because they enable you to integrate with external systems by pulling data into JIRA periodically. JIRA comes with a number of pre-written services, and custom services can be written and plugged in at runtime. If you want a service to perform typical operations on JIRA issues (eg. close a list of issues meeting certain criteria), then the Jelly Service can be configured to run a custom Jelly script.

Writing a new service?
If you are not extending a built-in JIRA service, you should strongly consider writing your new service using the SAL API. Please see our Plugin Tutorial - Scheduling Events via SAL for more information.

Registering a service

For custom-written services, make sure your service class is in the classpath where JIRA can see it — the best locations are usually the <jira-application-dir>/WEB-INF/classes or <jira-application-dir>/WEB-INF/lib subdirectories within of your JIRA Installation Directory (as JAR files).

To set up a JIRA service:

1. Log in as a user with the JIRA System Administrators global permission.
2. Choose > System. Select Advanced > Services to open a page showing all the configured services.

   ✔ Keyboard shortcut: g + g + start typing services

3. In the Add Service form at the bottom of the page, complete the following fields:
   - Name — a descriptive name for this service.
   - Class — the fully-qualified class name of your service. This is likely to have the form com.atlassian.jira.service.services.type.TypeService
     See Sample services for provided service class names.
   - Delay — the delay (in minutes) between service runs.

   To use one of JIRA’s built-in service classes, first click the Built-in Services link to expand the list of service classes and then click the name of the specific class in the list. The fully-qualified class name of the built-in service will be added to the Class field.

   ✔ Delay — the delay (in minutes) between service runs.

   For example, to add a debugging service, click the Built-in Services link followed by the Debugging Service link:

4. After completing the fields on the Add Service form, click the Add Service button. This opens the Edit Service page, where you can configure your new service’s options.

   ✔ Your service’s options will vary depending on the type (i.e. class) of service you chose.
5. After completing the remaining options on the **Edit Service** page, click the **Update** button to save your new service's options.

**Editing service properties**

**To edit a service’s properties:**

1. Log in as a user with the **JIRA System Administrators** global permission.
2. Choose `>` **System**. Select **Advanced > Services** to open a page showing all the configured services.
   - *Keyboard shortcut:* `g + g +` start typing **services**
3. Click the **Edit** link associated with the service whose properties you wish to edit.

For example, to change the interval at which email is sent from JIRA, edit the **Mail Queue Service** and change the **Delay** from the default value of 1 minute.

**Removing a service**

**To remove a service:**

1. Log in as a user with the **JIRA System Administrators** global permission.
2. Choose `>` **System**. Select **Advanced > Services** to open a page showing all the configured services.
   - *Keyboard shortcut:* `g + g +` start typing **services**
3. Click the **Delete** link associated with the service you wish to remove.

**Built-in services**

**Export service**

The Export Service is useful for periodically backing up JIRA. It exports all data from JIRA every time it is run, into a directory supplied as a parameter. The export files are timestamped, thus the service can act as a backup system.

To test this service, add a service with the class `com.atlassian.jira.service.services.export.ExportService`. JIRA sets up an ExportService in new JIRA installations (once the setup wizard has been completed). Hence, you may find you already have one.

You can find this class within the following directory of an expanded JIRA source archive (which can be downloaded by JIRA customers from https://my.atlassian.com):

<source-installation-directory>/jira-project/jira-components/jira-core/src/main/java/com/atlassian/jira/service/services/export

**Jelly service**

**Jelly** is a scripting language which allows tasks in JIRA to be automated. The Jelly Service periodically runs a Jelly script. For example, you could use this to periodically run a search request, loop through the results and add a comment, change the issue state (see the **Jelly examples**).

If you are considering writing a custom service, often a periodically invoked Jelly script may be an easier alternative.

In Linux, the input-file and output-file properties are relative to your system's `/` folder. Please be careful to select a path that JIRA will have access to.
You can find this class within the following directory of an expanded JIRA source archive (which can be downloaded by JIRA customers from https://my.atlassian.com):

\(<\text{source-installation-directory}>/jira-project/jira-components/jira-core/src/main/java/com/atlassian/jira/jelly/service\)

**Mail handler services**

JIRA mail handler services are not configurable through JIRA's **Services** page (with the exception of being able to be removed). For more information about configuring a mail handler in JIRA, including the creation of custom mail handlers, please refer to [Creating Issues and Comments from Email](#).

**Custom services**

If you are a JIRA developer who wishes to write your own JIRA service, please note that JIRA Service classes must all extend `com.atlassian.jira.service.JiraService`. Most do so by extending `com.atlassian.jira.service.AbstractService` or some more specialised subclass.

**Jelly Tags**

Jelly is a scripting and templating language from Apache's Jakarta project. It is similar to Ant, in that scripts are XML, and each tag maps to a Java class, but has a more sophisticated internal pipeline model for tag interaction, much like JSP taglibs. See the Jelly website for more details.

JIRA comes with a number of Jelly tags implementing core operations in JIRA. This provides a scriptable interface to JIRA. There are many possible uses for JIRA Jelly tags, the most common being importing data into JIRA from other systems, and automating common administrative tasks (see the examples below).

**Enabling Jelly**

JIRA’s Jelly support is **disabled** by default, as Jelly, in principle, allows running arbitrary Java code on the server under the Tomcat account. In some environments this may be considered a **security risk**, depending on who is allowed to configure and run Jelly scripts (a ‘JIRA System Administrators’ permission is required). We recommend to use Jelly only when you absolutely cannot do without it and disable Jelly support when you do not need it any more.

To enable Jelly, set the `jira.jelly.on` system property when starting your application server. System properties are set with parameters to the `java` command, e.g. `java -Djira.jelly.on=true ...` (You can set this parameter in the setenv.sh (Linux) or setenv.bat (Windows) file in your /bin folder)

How to set this property depends on your application server. For example, set the environment variable `JAVA_OPTS=-Djira.jelly.on=true`, or when running JIRA as a service, set the `service JVM parameter`.

**Running a Jelly script**

**To run a Jelly script once:**

1. Log in as a user with the 'JIRA System Administrators' **global permission**.
2. Choose ` développer System` > **System**. Select **Advanced** > **Jelly Runner** to open the Jelly Runner page. **Keyboard shortcut:** 'g' + 'g' + type 'jel'
3. Paste your Jelly script into the text area.

**To run a Jelly script periodically:**

- Configure a **service** with the following class: `com.atlassian.jira.jelly.service.JellyService`

**Restricting Jelly**

To remove the interface for pasting scripts in:

1. Edit `atlassian-jira/secure/admin/views/jelly_runner.jsp`
2. Add the `disabled` attribute to the textarea, e.g.

\(<\text{ui:textarea label="text('admin.jellyrunner.jelly.script.xml')"}>\)
This prevents text being pasted into the Jelly Runner page. Note that this is only an interface change and it will be still possible to run Jelly scripts by submitting an HTTP request with the right content.

On this page:
- Enabling Jelly
- Running a Jelly script
- Restricting Jelly
- Writing a Jelly script
- Beta Tags
- Sample scripts

Writing a Jelly script
- jira:AddActorsToDefaultProjectRole
- jira:AddActorsToProjectRole
- jira:AddComment
- jira:AddComponent
- jira:AddFieldToScreen
- jira:AddPermission
- jira:AddUserToGroup
- jira:AddVersion
- jira:AssignIssue
- jira:AttachFile
- jira:CreateCustomField
- jira:CreateGroup
- jira:CreateIssue
- jira:CreatePermissionScheme
- jira:CreateProject
- jira:CreateProjectRole
- jira:CreateUser
- jira:DeleteProjectRole
- jira:GetDefaultRoleActors
- jira:GetProjectRole
- jira:GetProjectRoleActors
- jira:IsProjectRoleNameUnique
- jira:LinkIssue
- jira:Login
- jira:RemoveActorsFromDefaultProjectRole
- jira:RemoveActorsFromProjectRole
- jira:RemoveUser
- jira:RunSearchRequest
- jira:SelectComponentAssignees
- jira:TransitionWorkflow
- jira:UpdateProjectRole

Scripts are generally of the form:

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <!-- Add your own Jelly XML here -->
</jiraJelly>
```

There are also a few extra tags that can be accessed by using the following outer tag, instead of the one above (these are tags that were formerly restricted):
In addition to the JIRA tags, you can use tags from the `email`, `http`, `soap`, `sql` and `core` Jelly taglibs. More can be added by the user if necessary.

Many of JIRA's Jelly tags set context variables, so subsequent tags can refer to their output by dereferencing the context variable (e.g. `$(jira.new.username)`). Other tags let you explicitly specify the name of a variable to store some output in, e.g., `<jira:CreateUser>` has `issueKeyVar` and `issueIdVar` parameters:

```xml
<jira:CreateIssue project-key="TP" summary="Issue One" issueKeyVar="issuekey" issueIdVar="issueid"/>
Raised issue ${issuekey} with id ${issueid}
```

Note that the variable is only set after the tag is closed, not inside the tag.

⚠️ **Please Note:** Due to this variable interpolation, if your text contains anything of the form `$(something)`, you need to escape this as $$(something) to prevent the ‘variable’ being expanded to a blank string.

When specifying the value of an attribute, note the following special characters must be escaped.

<table>
<thead>
<tr>
<th>Special Character</th>
<th>Escaped equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>ampersand (&amp;)</td>
<td>&amp;</td>
</tr>
<tr>
<td>apostrophe or single quote (')</td>
<td>'</td>
</tr>
<tr>
<td>double quote (&quot;)</td>
<td>&quot;</td>
</tr>
<tr>
<td>less than (&lt;)</td>
<td>&lt;</td>
</tr>
<tr>
<td>greater than (&gt;)</td>
<td>&gt;</td>
</tr>
</tbody>
</table>

The list of currently available tags:

`jira:AddActorsToDefaultProjectRole`

This tag will add ‘actors’ to the default membership for a given project role. Actors can be defined as groups or users, i.e. you can add both users and groups to a project role.

**Attributes**
### Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>This is the id of the project role.</td>
</tr>
<tr>
<td>actors</td>
<td>string</td>
<td></td>
<td>A comma delimited list of either users or groups</td>
</tr>
<tr>
<td>actortype</td>
<td>string</td>
<td></td>
<td>This defines the type ‘actor’ you are sending to the tag. Currently this field can contain either 'atlassian-user-role-actor' for users, or 'atlassian-group-role-actor' for groups.</td>
</tr>
</tbody>
</table>

### Examples

#### Adding a list of default users or groups to a project role

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
    <jira:AddActorsToDefaultProjectRole projectroleid="1" actors="fred,admin,tom" actortype="atlassian-user-role-actor" />
</jiraJelly>
```

### jira:AddActorsToDefaultProjectRole

This tag will add ‘actors’ to a given project role for a particular project. Actors can be defined as groups or users, i.e. you can add both users and groups to a project role.

### Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>This is the id of the project role.</td>
</tr>
<tr>
<td>actors</td>
<td>string</td>
<td></td>
<td>This a comma delimited list of either user names or group names</td>
</tr>
<tr>
<td>actortype</td>
<td>string</td>
<td></td>
<td>This defines the ‘actor’ type. Currently this field can contain either 'atlassian-user-role-actor' for users, or 'atlassian-group-role-actor' for groups.</td>
</tr>
<tr>
<td>projectkey</td>
<td>string</td>
<td></td>
<td>This is the key of the project you wish to add users or groups to for the specified role.</td>
</tr>
</tbody>
</table>

### Examples

#### Adding a list of users or groups to a project role

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
    <jira:AddActorsToProjectRole projectroleid="1" actors="jira-administrators,jira-users" projectkey="MKY" actortype="atlassian-group-role-actor" />
</jiraJelly>
```

### jira:AddComment

This function adds a comment to an Issue.

### Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>issue-key</td>
<td>string</td>
<td></td>
<td>The issue to add the comment to (required).</td>
</tr>
<tr>
<td><strong>attribute</strong></td>
<td><strong>type</strong></td>
<td><strong>default value</strong></td>
<td><strong>description</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>----------</td>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>commenter</td>
<td>string</td>
<td>Currently logged in user</td>
<td>Username of the user to make the comment (Must have browse and comment permissions).</td>
</tr>
<tr>
<td>comment</td>
<td>string</td>
<td></td>
<td>Comment to be added to the issue (required).</td>
</tr>
<tr>
<td>groupLevel</td>
<td>string</td>
<td>none</td>
<td>Name of group that can see this comment. NOTE: If this is specified you can not specify the roleLevel parameter.</td>
</tr>
<tr>
<td>roleLevel</td>
<td>string</td>
<td>none</td>
<td>Name or Id of Project Role that can see this comment. NOTE: If this is specified you can not specify the groupLevel parameter.</td>
</tr>
<tr>
<td>created</td>
<td>string</td>
<td>Current Date/Time</td>
<td>Date/Time the Comment was created in format yyyy-MM-dd h:mm:ss.0</td>
</tr>
<tr>
<td>updated</td>
<td>string</td>
<td>Current Date/Time</td>
<td>Date/Time the Comment was last updated in format yyyy-MM-dd hh:mm:ss.0. This can be used if you are trying to import a comment with specific pre-existing values.</td>
</tr>
<tr>
<td>editedBy</td>
<td>string</td>
<td>Currently logged in user</td>
<td>Username of the user who last updated the comment. This can be used if you are trying to import a comment with specific pre-existing values.</td>
</tr>
<tr>
<td>tweakIssueUpdateDate</td>
<td>boolean</td>
<td>true</td>
<td>If an updated date is provided, the issue's updated date will be updated with that value. If the tweakIssueUpdateDate parameter is set to false, the issue's updated timestamp will be left untouched.</td>
</tr>
</tbody>
</table>

**Examples**

**Create comment**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:AddComment comment="Issue comment" issue-key="ABC-1" groupLevel="admin-group"/>
</JiraJelly>
```

**Create Issue and Comment**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateIssue project-key="TP" issueType="Bug" summary="Issue summary" issueKeyVar="key"/>
  <jira:AddComment issue-key="${key}" comment="A comment on ${key}"/>
</JiraJelly>
```

**jira:AddComponent**

Adds a component to a project.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>project-key</td>
<td>string</td>
<td></td>
<td>The key of the project you want to add the component to (not required if nested inside atag).</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td></td>
<td>Name of the component (required).</td>
</tr>
</tbody>
</table>
description | string | Description of the component.
componentLead | string | The username of the Component's lead. Leave blank for no lead.

Examples

Create Component

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:AddComponent project-key="ABC" name="Comp 1" description="Comp 1 description"/>
</jiraJelly>
```

Create Component in a Project

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateProject key="ABC" name="A Project" lead="logged-in-user">
    <jira:AddComponent name="Comp 1"/>
  </jira:CreateProject>
</jiraJelly>
```

Create Component with a Component Lead

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:AddComponent project-key="ABC" name="Comp 1" description="Comp 1 with lead" componentLead="user-name"/>
</jiraJelly>
```

`jira:AddFieldToScreen`

Adds a field to a specific tab on a screen. Can also specify in which position to insert the field.

Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ffldId</td>
<td>string</td>
<td></td>
<td>Field ID of the field to add (required). e.g. &quot;description&quot;, &quot;duedate&quot;, etc.</td>
</tr>
<tr>
<td>screen</td>
<td>string</td>
<td></td>
<td>Screen ID or Name (required). e.g. &quot;1&quot; or &quot;Default Screen&quot;.</td>
</tr>
<tr>
<td>tab</td>
<td>string</td>
<td>0</td>
<td>Tab ID or Name. e.g. &quot;0&quot; or &quot;Field Tab&quot;.</td>
</tr>
<tr>
<td>fieldPosition</td>
<td>int</td>
<td>last position</td>
<td>Position to insert the field into. Range of values is from 1 to the number of fields on the screen.</td>
</tr>
</tbody>
</table>

Examples

Add Fields to a Screen
Create a new Customfield and Add it to a Screen

```
<jira:CreateCustomField fieldType="cascadingselect"
fieldScope="issuetype"
fieldName="Issue cascadingselect Bug"
issueType="Bug"
description="Bank have requested Y2K fixes to be sent as an EBF."
searcher="cascadingselectsearcher"
customFieldIdVar="customField">
    <jira:AddCustomFieldSelectValue value="Parent 1" />
    <jira:AddCustomFieldSelectValue value="Parent 2" />
    <jira:AddCustomFieldSelectValue value="Child 1" />
    <jira:AddCustomFieldSelectValue value="Child 2" />
</jira:CreateCustomField>
</jira:AddFieldToScreen screen="Default Screen" fieldId="${customField.getId()}"/>
```

**jira:AddPermission**

Grants permissions within a permission scheme. Often nested within a JIRADOC:CreatePermissionScheme tag.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| permissions | required string | A comma-separated list of permissions to grant: 

**String — Permission**
- Project — Administer projects
- Browse — Browse projects
- Create — Create issues
- Edit — Edit issues
- ScheduleIssue — Schedule issues
- Move — Move issues
- Assign — Assign issues
- Assignable — Assignable user
- Resolve — Resolve issues
- Close — Close issues
- ModifyReporter — Modify reporter
- Comment — Add comments
- CommentEditAll — Edit all comments
- CommentEditOwn — Edit own comments
- CommentDeleteAll — Delete all comments
- CommentDeleteOwn — Delete own comments
- Delete — Delete issues
- Work — Work on issues
- WorklogEditAll — Edit all worklogs
- WorklogEditOwn — Edit own worklogs
- WorklogDeleteOwn — Delete own worklogs
- WorklogDeleteAll — Delete all worklogs
- Link — Link issues
- Attach — Create attachments
- AttachDeleteAll — Delete all attachments
- AttachDeleteOwn — Delete own attachments
- ViewVersionControl — View version control
- ViewVotersAndWatchers — View voters and watchers
- ManageWatcherList — Manage watcher list
- SetSecurity — Set issue security level |
| type | string | Type of recipient for the permission:
- group
- projectrole
- user
- lead
- assignee
- reporter
- userCF
- groupCF |
| group | string | If type is 'group' (or type is unspecified), specifies the group name to grant permissions to. |
| projectroleid | int | If type is 'projectrole', specifies the id of the projectrole to grant permissions to. |
| user | string | If type is 'user', specifies the user name to grant permissions to. |
| userCF | string | If type is 'userCF', specifies the id of a User custom field, e.g. 'customfield_10000', identifying the user to be granted the permission. |
| groupCF | string | If type is 'groupCF', specifies the id of a group-selecting custom field (e.g. a select-list with group names as values) whose members should be granted this permission. E.g. 'customfield_10000'. |

**Examples**

Grant permissions to jira-users and jira-developers in a new permission scheme
Grant issue reporters the ability to edit/delete their own issues, in a new permission scheme

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.enterprise.JiraTagLib">
    <jira:CreatePermissionScheme name="New Permission Scheme">
        <jira:AddPermission type="reporter" permissions="Delete, Edit"/>
    </jira:CreatePermissionScheme>
</JiraJelly>
```

Make projects using default permission scheme visible to certain users

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.enterprise.JiraTagLib">
    <jira:AddPermission schemeId="0" permissions="Browse" type="user" user="johnc"/>
    <jira:AddPermission schemeId="0" permissions="Browse" type="user" user="ebf"/>
</JiraJelly>
```

Granting a group selector custom field’s members the ability to assign/be assigned the issue.

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
    <jira:AddPermission schemeId="10164" type="groupCF" groupCF="customfield_10000" permissions="Assign, Assignable"/>
</JiraJelly>
```

**jira:AddUserToGroup**

Makes a user a member of a Group. Adds the username and/or group name into the context if specified.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>username</td>
<td>string</td>
<td></td>
<td>Username to add to Group (required if not in atag).</td>
</tr>
<tr>
<td>group-name</td>
<td>string</td>
<td></td>
<td>Group to add User to (required if not in atag). Note: if the group has the 'JIRA System Administrators' global permission, and the logged-in user does not, an error message will be displayed and the operation will not succeed.</td>
</tr>
</tbody>
</table>

Username is set in the context if specified in the tag. Group name is set in the context if specified in the tag. h4.

**Examples**

**Add User to Group**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
    <jira:AddUserToGroup username="new-user" group-name="new-group"/>
</JiraJelly>
```
Add New User to Group

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateUser username="new-user" password="password" confirm="password"
    fullname="Full name" email="test@test.com">
    <jira:AddUserToGroup group-name="new-group"/>
  </jira:CreateUser>
</JiraJelly>
```

Add User to New Group

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateGroup group-name="new-group">
    <jira:AddUserToGroup username="new-user"/>
  </jira:CreateGroup>
</JiraJelly>
```

Add New User to New Group

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateUser username="new-user" password="password" confirm="password"
    fullname="Full name" email="test@test.com">
    <jira:CreateGroup group-name="new-group">
      <jira:AddUserToGroup/>
    </jira:CreateGroup>
  </jira:CreateUser>
</JiraJelly>
```

**jira:AddVersion**

Adds a version to a project.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>project-key</td>
<td>string</td>
<td></td>
<td>The key of the project you want to add the component too (not required if nested inside atag).</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td></td>
<td>Name of the version (required).</td>
</tr>
<tr>
<td>description</td>
<td>string</td>
<td></td>
<td>The description of the version.</td>
</tr>
<tr>
<td>releaseDate</td>
<td>string</td>
<td></td>
<td>The release date of the version.</td>
</tr>
<tr>
<td>schedule</td>
<td>string</td>
<td></td>
<td>Schedule of the version.</td>
</tr>
</tbody>
</table>

**Examples**

**Create a Version**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:AddVersion project-key="ABC" name="Ver 1"/>
</JiraJelly>
```

**Create a Version in a Project**
**jira:AssignIssue**

Assigns an issue to a user.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>key</td>
<td>string</td>
<td></td>
<td>Key of the issue to assign.</td>
</tr>
<tr>
<td>assignee</td>
<td>string</td>
<td></td>
<td>User to assign issue to.</td>
</tr>
</tbody>
</table>

**Examples**

**Create and assign issue**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
    <jira:CreateIssue project-key="TST" summary="My issue summary"
        issueKeyVar="keyvar"/>
    <jira:AssignIssue key="${keyvar}" assignee="testuser"/>
</JiraJelly>
```

**jira:AttachFile**

Attaches a file to an issue.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>key</td>
<td>string</td>
<td></td>
<td>Key of the issue to attach the file to. (Required)</td>
</tr>
<tr>
<td>filepath</td>
<td>string</td>
<td></td>
<td>Path (on the server) of the file to attach. (Required)</td>
</tr>
<tr>
<td>option</td>
<td>string</td>
<td>add</td>
<td>Behavior when a file with same name is already attached. (Optional). The options are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- skip — do not attach file if a file with this name is already attached.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- override — overwrite existing attached file</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- add — add the file as another attachment</td>
</tr>
<tr>
<td>created</td>
<td>string</td>
<td>Current Date/Time</td>
<td>Date/Time the attachment was created, in format yyyy-MM-dd hh:mm:ss.0 (Optional)</td>
</tr>
</tbody>
</table>

**Examples**

**Adding an attachment**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
    <jira:CreateProject key="ABC" name="A Project" lead="logged-in-user">
        <jira:AddVersion name="Ver 1"/>
    </jira:CreateProject>
</JiraJelly>
```
**jira:CreateCustomField**

The tag creates a new Custom Field. Only System custom fields can be added with Jelly tags.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fieldType</td>
<td>string</td>
<td></td>
<td>Field type as appears as the key in the plugin descriptor</td>
</tr>
<tr>
<td>fieldScope</td>
<td>string</td>
<td></td>
<td>One of global, project or issuetype</td>
</tr>
<tr>
<td>fieldName</td>
<td>string</td>
<td></td>
<td>Name of custom field</td>
</tr>
<tr>
<td>projectKey</td>
<td>string</td>
<td></td>
<td>Key of the related project. Only valid for scope &quot;project&quot;</td>
</tr>
<tr>
<td>issueType</td>
<td>string</td>
<td></td>
<td>Issue type. Only valid for scope &quot;issuetype&quot;</td>
</tr>
<tr>
<td>description</td>
<td>string</td>
<td></td>
<td>Description of the field to be displayed when adding a value</td>
</tr>
<tr>
<td>searcher</td>
<td>string</td>
<td></td>
<td>A valid related custom field searcher</td>
</tr>
<tr>
<td>customFieldIdVar</td>
<td>string</td>
<td></td>
<td>The name of the variable to place the new custom field.</td>
</tr>
</tbody>
</table>

**Examples**

**Create Cascading Custom Field**

The *jira:AddCustomFieldSelectValue* subtag can be used to add values for select lists. They can also be nested for Cascading Select Lists.
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
<jira:CreateCustomField fieldType="cascadingselect" fieldScope="issuetype" fieldName="Issue cascadingselect Bug" issueType="Bug" description="Bank have requested Y2K fixes to be sent as an EBF." searcher="cascadingselectsearcher">
  <jira:AddCustomFieldSelectValue value="Parent 1" /></jira:AddCustomFieldSelectValue>
  <jira:AddCustomFieldSelectValue value="Parent 2">
    <jira:AddCustomFieldSelectValue value="Child 1" /></jira:AddCustomFieldSelectValue>
    <jira:AddCustomFieldSelectValue value="Child 2" /></jira:AddCustomFieldSelectValue>
    <jira:AddCustomFieldSelectValue value="Parent 3" /></jira:AddCustomFieldSelectValue>
  </jira:CreateCustomField>
</JiraJelly>

**jira:CreateGroup**

Creates a Group in JIRA.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group-name</td>
<td>string</td>
<td></td>
<td>Name of group to create (required).</td>
</tr>
</tbody>
</table>

**Context Variables**

<table>
<thead>
<tr>
<th>Context Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jelly.group.name</td>
<td>string</td>
<td>Name of group being created.</td>
</tr>
</tbody>
</table>

**Examples**

Create Group

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
<jira:CreateGroup group-name="new-group"/>
</JiraJelly>
```

**jira:CreateIssue**

This tag creates a new issue in JIRA and places the issue id in the context.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>project-key</td>
<td>string</td>
<td></td>
<td>Key of the project to add the issue to (required if not nested in atag).</td>
</tr>
<tr>
<td>issueType</td>
<td>string</td>
<td>First issue type</td>
<td>The string name of the Issue Type this issue should be created for (e.g. Bug).</td>
</tr>
<tr>
<td>summary</td>
<td>string</td>
<td></td>
<td>Summary of the issue being created (required).</td>
</tr>
<tr>
<td>Field</td>
<td>Type</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>priority</td>
<td>string</td>
<td>The string name of the Priority (e.g. Major).</td>
<td></td>
</tr>
<tr>
<td>components</td>
<td>string</td>
<td>The string name of the Component.</td>
<td></td>
</tr>
<tr>
<td>versions</td>
<td>string</td>
<td>The string name of the Affected Version.</td>
<td></td>
</tr>
<tr>
<td>fixVersions</td>
<td>string</td>
<td>The string name of the Fix For Version.</td>
<td></td>
</tr>
<tr>
<td>assignee</td>
<td>string</td>
<td>The username of the user to assign this issue to (logged in user requires the assign issue permission and user specified requires the assignable permission). Set to &quot;-1&quot; for Automatic assignment.</td>
<td></td>
</tr>
<tr>
<td>reporter</td>
<td>string</td>
<td>The username of the user who is reporting this issue. The user is logged in and then the issue is created. The user is logged out again when the Create Issue tag closes. If the logged in user does not have Modify Reporter privilege, then the default value of this attribute is the username of the logged in user. If, however, the logged in user does have Modify Reporter privilege, there is not a default value, and this attribute is mandatory. See JIRA-12984 for further explanation. (Broken? See JIRA-5620.)</td>
<td></td>
</tr>
<tr>
<td>environment</td>
<td>string</td>
<td>Description of the environment.</td>
<td></td>
</tr>
<tr>
<td>description</td>
<td>string</td>
<td>Detailed description of the issue.</td>
<td></td>
</tr>
<tr>
<td>duedate</td>
<td>string</td>
<td>Due date of the issue. The format required is the current JIRA date format. Note: As the default JIRA date format is locale-specific (e.g. 12/Jan/05), you may wish to use the yyyy-mm-dd ISO format instead. To do this, set the following properties on JIRA's 'Advance d Settings' page: * jira.date.picker.java.format to value yyyy-MM-dd * jira.date.picker.javascript.format to value %Y-%m-%e</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>string</td>
<td>Current Date/Time</td>
<td></td>
</tr>
<tr>
<td>updated</td>
<td>string</td>
<td>Current Date/Time</td>
<td></td>
</tr>
<tr>
<td>issueIdVar</td>
<td>string</td>
<td>The name of the variable to place the ID of the new Issue.</td>
<td></td>
</tr>
<tr>
<td>issueKeyVar</td>
<td>string</td>
<td>The name of the variable to place the Key of the new Issue.</td>
<td></td>
</tr>
<tr>
<td>duplicateSummary</td>
<td>string</td>
<td>Setting this attribute to 'ignore' will allow Issue with the same summary to be created.</td>
<td></td>
</tr>
<tr>
<td>security-level</td>
<td>string</td>
<td>Sets the security level of an issue. Value is the name of a level, e.g. 'Secret'.</td>
<td></td>
</tr>
</tbody>
</table>

**Examples**

**Create Issue**
Create Issue from Project
This example is more complicated as a permission scheme is required for the project before an issue can be created.

Create Issue with Custom Field values
Use the subtag `jira:AddCustomFieldValue`

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>long</td>
<td>ID of the custom field with the customfield_prefix</td>
</tr>
<tr>
<td>value</td>
<td>string</td>
<td>string representation of the custom field value. Note that this may be different to the displayed value (e.g. The project picker uses the project id as the String value but displays the project name)</td>
</tr>
<tr>
<td>key</td>
<td>string</td>
<td>Key is used for multi-dimensional data. Currently, only Cascading selects supports its use. Omit to specify the value of parent, use &quot;1&quot; as the value for child</td>
</tr>
<tr>
<td>name</td>
<td>String</td>
<td><strong>deprecated</strong> Name of the custom field.</td>
</tr>
</tbody>
</table>
Using the name attribute has been deprecated. While it will work in 3.0 its use is discouraged.

Note:

- To view the `<customFieldId>`,
  1. Navigate to Administration -> Issue Fields -> Custom Fields
  2. Hover your cursor over the "Configure" link of the custom field
  3. You can view the `<customFieldId>` in the status bar of your browser
- To view the "Parent Option Id" and "Child Option Id" for Cascading Select fields,
  1. Navigate to Administration -> Issue Fields -> Custom Fields -> Configure -> Edit Options -> Edit
  2. You can view the `<selectedParentOptionId>` ("Parent Option Id") and `<selectedValue>` ("Child Option Id") in the status bar of your browser

`jira:CreatePermissionScheme`

Creates a Permission Scheme

Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>required string</td>
<td></td>
<td>Name of the permission scheme.</td>
</tr>
<tr>
<td>description</td>
<td>string</td>
<td></td>
<td>Permission scheme description.</td>
</tr>
</tbody>
</table>

Context Variables

<table>
<thead>
<tr>
<th>Context Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jelly.permission.scheme.id</td>
<td>string</td>
<td>Id of the created permission scheme</td>
</tr>
</tbody>
</table>

`jira:CreateProject`

This tag creates a new project in JIRA and places the project id in the context.

Attributes
## Create Project

### Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>key</td>
<td>string</td>
<td>The project key used to create Issue Keys (required).</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>The name of the project (required).</td>
<td></td>
</tr>
<tr>
<td>lead</td>
<td>string</td>
<td>The username of the user that is the project lead (required).</td>
<td></td>
</tr>
<tr>
<td>url</td>
<td>string</td>
<td>The URL of the site for this project.</td>
<td></td>
</tr>
<tr>
<td>description</td>
<td>string</td>
<td>The description of this project.</td>
<td></td>
</tr>
</tbody>
</table>

### Context Variables

<table>
<thead>
<tr>
<th>Context Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jelly.project.id</td>
<td>string</td>
<td>Id of the Project that was created.</td>
</tr>
<tr>
<td>jelly.project.key</td>
<td>string</td>
<td>Key of the Project that was created.</td>
</tr>
</tbody>
</table>

### Examples

#### Create Project

```
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateProject key="ABC" name="A Project" lead="a-user">
    <!-- other jelly tags -->
  </jira:CreateProject>
</jiraJelly>
```

### jira:CreateProjectRole

This tag will create a project role with the given name and description.

### Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>string</td>
<td>The name for the project role you will be creating</td>
<td></td>
</tr>
<tr>
<td>description</td>
<td>string</td>
<td>The description for the project role you will be creating</td>
<td></td>
</tr>
</tbody>
</table>

### Context Variables

<table>
<thead>
<tr>
<th>Context Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jelly.role.id</td>
<td>Long</td>
<td>The id of the project role</td>
</tr>
<tr>
<td>jelly.role.name</td>
<td>string</td>
<td>The name of the project role</td>
</tr>
<tr>
<td>jelly.role.description</td>
<td>string</td>
<td>The description of the project role</td>
</tr>
</tbody>
</table>

### Examples

#### Creating a new project role

```
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateProjectRole name="lion-tamer" description="tames the lions">
    ${jelly.role.id} ${jelly.role.name} ${jelly.role.description}
  </jira:CreateProjectRole>
</jiraJelly>
```
**jira:CreateUser**

Creates a user in JIRA and places their username in the context.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>username</td>
<td>string</td>
<td></td>
<td>Username of the user being created (required).</td>
</tr>
<tr>
<td>password</td>
<td>string</td>
<td></td>
<td>User's password. If the password field is left blank, a random password will be auto-generated.</td>
</tr>
<tr>
<td>confirm</td>
<td>string</td>
<td></td>
<td>Confirmation of users password (required).</td>
</tr>
<tr>
<td>fullname</td>
<td>string</td>
<td></td>
<td>Descriptive name of the user (required).</td>
</tr>
<tr>
<td>email</td>
<td>string</td>
<td></td>
<td>Email address of the user (required).</td>
</tr>
<tr>
<td>sendEmail</td>
<td>boolean</td>
<td>false</td>
<td>If provided, specifies whether to send a confirmation email.</td>
</tr>
</tbody>
</table>

**Context Variables**

<table>
<thead>
<tr>
<th>Context Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jelly.new.username</td>
<td>string</td>
<td>Username of the user being created.</td>
</tr>
</tbody>
</table>

**Examples**

**Create User**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:CreateUser username="new-user" password="password" confirm="password" fullname="Full name" email="test@test.com"/>
</JiraJelly>
```

**jira:DeleteProjectRole**

This tag will delete the project role with the given id.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>The id of the project role you want to delete.</td>
</tr>
<tr>
<td>confirm</td>
<td>string</td>
<td></td>
<td>To delete the project role this value must be set to 'true'.</td>
</tr>
</tbody>
</table>

**Examples**

**Deleting a project role from JIRA**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:DeleteProjectRole projectroleid="1" confirm="true" />
</JiraJelly>
```

**jira:GetDefaultRoleActors**

This tag will return a ProjectRoleActors object for a given project role for a particular project. This object carries the members of a project role, i.e. users and/or groups. To get the collection of users in this object, use the
expression \${roleactors.users} where roleactors is the variable name of the object. For more information on the RoleActors object, consult the JIRA API.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>The id of the project role you want to query</td>
</tr>
<tr>
<td>var</td>
<td>string</td>
<td></td>
<td>The name of the variable you wish to have the returned role actors placed into</td>
</tr>
</tbody>
</table>

**Examples**

**Returning a List of role actors and iterating over the users in each of these actors.**

```
<jira:GetDefaultRoleActors projectroleid="1" var="roleactors">
    <core:forEach var="actor" items="\${roleactors.users}">
        ${actor.name}
    </core:forEach>
</jira:GetDefaultRoleActors>
```

**jira:GetProjectRole**

This tag will return the project role with the given id.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>The id of the project role you want to query</td>
</tr>
<tr>
<td>var</td>
<td>string</td>
<td></td>
<td>The name of the variable you wish to have the project role assigned to</td>
</tr>
</tbody>
</table>

**Examples**

**Returning a project role**

```
<jira:GetProjectRole projectroleid="1" var="role">
    ${role.name}
</jira:GetProjectRole>
```

**jira:GetProjectRoleActors**

This tag will return a ProjectRoleActors object for the given project role and project. This object is a placeholder for the internal members of a project role, i.e. users and/or groups. To get the collection of users in this object, use the expression \${roleactors.users} where roleactors is the variable name of the object. For more information on the RoleActors object, consult the JIRA API.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Type</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>projectkey</td>
<td>string</td>
<td></td>
<td>The key of the project you want to query</td>
</tr>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>The id of the project role you want to query</td>
</tr>
<tr>
<td>var</td>
<td>string</td>
<td></td>
<td>The name of the variable you want the returned 'role actors' object assigned to</td>
</tr>
</tbody>
</table>

**Examples**

**Return a list of users for a given 'Role Actors' object**

```xml
<jira:ProjectRoleActors projectkey="MKY" projectroleid="1" var="roleactors">
  <core:forEach var="actor" items="${roleactors.users}">
    ${actor.name}
  </core:forEach>
</jira:ProjectRoleActors>
```

**jira:isProjectRoleNameUnique**

This tag will return 'true' or 'false' to let you know if there is already a project role with the given name.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>string</td>
<td></td>
<td>The name of the project role</td>
</tr>
<tr>
<td>var</td>
<td>string</td>
<td></td>
<td>The name of the variable you want the returned result assigned to.</td>
</tr>
</tbody>
</table>

**Examples**

Determining if a project role is unique.

```xml
<jira:isProjectRoleNameUnique name="unique name" var="isUnique">
  ${isUnique}
</jira:isProjectRoleNameUnique>
```

**jira:LinkIssue**

This tag creates a link from one issue to another issue.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>key</td>
<td>string</td>
<td></td>
<td>The key of the issue to link from (origin of link - required)</td>
</tr>
<tr>
<td>linkKey</td>
<td>string</td>
<td></td>
<td>The key of the issue to link to (destination of link - required)</td>
</tr>
<tr>
<td>linkDesc</td>
<td>string</td>
<td></td>
<td>linkDesc is taken from the 'Inward Description' or the 'Outward Description' of the link. (required)</td>
</tr>
</tbody>
</table>

**Examples**
Create a Link between two existing issues

```xml
<jira:LinkIssue key="TST-1" linkKey="TST-2" linkDesc="duplicates"/>
</JiraJelly>
```

Create two issues and link them

```xml
<jira:CreateIssue project-key="HSP" assignee="-1" summary="Issue summary 1" reporter="admin" issueKeyVar="issuekey1"/>
<jira:CreateIssue project-key="NDT" assignee="-1" summary="Issue summary 2" reporter="admin" issueKeyVar="issuekey2"/>
<jira:LinkIssue key="${issuekey1}" linkKey="${issuekey2}" linkDesc="duplicates"/>
</JiraJelly>
```

`jira:Login`

This tag logs a user into JIRA using the username and password provided. Use this tag when you are running the Jelly script in a manner in which you are not logged in (for example, if you are running a JellyService instead of using the Jelly Runner), or if you want to run the Jelly script as a different user to the one you are logged in as.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>username</td>
<td>string</td>
<td></td>
<td>Username of the user to log in.</td>
</tr>
<tr>
<td>password</td>
<td>string</td>
<td></td>
<td>Password of the user to log in.</td>
</tr>
</tbody>
</table>

**Context Variables**

<table>
<thead>
<tr>
<th>Context Variable</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jelly.user</td>
<td>User</td>
<td>User logged in.</td>
</tr>
<tr>
<td>jelly.username</td>
<td>string</td>
<td>Username of the User logged in.</td>
</tr>
</tbody>
</table>

**Examples**

Login a user in with username and password and set in context

```xml
<jira:Login username="misc-user" password="password">
<!-- other jelly tags -->
</jira:Login>
</JiraJelly>
```

`jira:RemoveActorsFromDefaultProjectRole`

This tag will remove a list of role actors (i.e. users and/or groups) from the default membership of a given project role.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
</table>
### Project Role API

The JIRA Project Role API allows you to manipulate the default actors associated with a project role. You can remove individual users or groups from the default project role, or remove all users or groups associated with an existing project role.

#### Remove Default Actors

The `jira:RemoveActorsFromDefaultProjectRole` tag can be used to remove a list of role actors from a given project role for a given project.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>The id of the project role you wish to remove members from</td>
</tr>
<tr>
<td>actors</td>
<td>string</td>
<td></td>
<td>A comma delimited list of users or groups you wish to remove from the project role</td>
</tr>
<tr>
<td>actortype</td>
<td>string</td>
<td></td>
<td>The type of ‘actor’ you are working with. Currently the available options are ‘atlassian-group-role-actor’ or ‘atlassian-user-role-actor’</td>
</tr>
</tbody>
</table>

**Examples**

**Removing a list of groups from a default project role**

```xml
<jira:RemoveActorsFromDefaultProjectRole projectroleid="1" actors="jira-administrators, jira-users" actortype="atlassian-group-role-actor" />
```

**jira:RemoveActorsFromProjectRole**

This tag will remove a list of role actors from a given project role for a given project.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>The id of the project role you wish to remove members from</td>
</tr>
<tr>
<td>actors</td>
<td>string</td>
<td></td>
<td>A comma delimited list of users or groups you wish to remove from the project role</td>
</tr>
<tr>
<td>projectkey</td>
<td>string</td>
<td></td>
<td>The key of the project the project role is associated with</td>
</tr>
<tr>
<td>actortype</td>
<td>string</td>
<td></td>
<td>The type of ‘actor’ you are working with. Currently the available options are ‘atlassian-group-role-actor’ or ‘atlassian-user-role-actor’</td>
</tr>
</tbody>
</table>

**Examples**

**Removing a list of groups from a project role**

```xml
<jira:RemoveActorsFromProjectRole projectroleid="1" actors="jira-administrators, jira-users" projectkey="MKY" actortype="atlassian-group-role-actor" />
```

#### Remove User

The `jira:RemoveUser` tag can be used to remove an existing JIRA user by their username.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>string</td>
<td></td>
<td>Username of the user to remove (required).</td>
</tr>
</tbody>
</table>

**Examples**

**Remove User**

```xml
<jira:RemoveUser name="jira-administrator" />
```
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
<jira:RemoveUser name="existing-user"/>
</JiraJelly>

**jira:RunSearchRequest**

This tag runs a search request against JIRA using a predefined filter.
Note: This tag will return a GenericValue for each issue which matches the search request.
A GenericValue consists of key-value pairs, e.g.

```xml
[GenericEntity:Issue]
[created,2007-11-01 15:51:25.0]
[summary,Testing]
[component,null]
[workflowId,12530]
[timeoriginalestimate,null]
[fixfor,null]
[type,2]
[timespent,null]
[environment,Windows]
[resolution,null]
[status,1]
[updated,2007-11-01 15:51:25.0]
[timeestimate,null]
[id,11540]
[key,TSTA-5]
[duedate,null]
[description,Test]
[project,10063]
[reporter,admin]
[security,null]
[votes,0]
[assignee,null]
[priority,3]
```

To retrieve a value, e.g. key, you can call gv.getString("key"). For full details, see the OFBiz GenericValue API.

### Attributes

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>filterid</td>
<td>int</td>
<td></td>
<td>The id of the filter which will be used to run the search request.</td>
</tr>
<tr>
<td>size-var</td>
<td>string</td>
<td></td>
<td>The variable that will hold the number of issues returned from the search request.</td>
</tr>
<tr>
<td>var</td>
<td>string</td>
<td></td>
<td>The variable that will hold the issues returned from the search request.</td>
</tr>
</tbody>
</table>

### Examples

**Running a search request and iterating through the keys of the returned issues**
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib"
xmlns:core="jelly:core">
    <jira:RunSearchRequest filterid="10524" var="issues" size-var="issuecount"/>
    <core:forEach var="issue" items="${issues}">
        ${issue.key}
    </core:forEach>
</JiraJelly>

**jira:SelectComponentAssignees**

Selects the default assignees for newly created issues of the component.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>project-key</td>
<td>string</td>
<td></td>
<td>The key of the project you want to add the component to (required).</td>
</tr>
<tr>
<td>componentName</td>
<td>string</td>
<td></td>
<td>Name of the component (required).</td>
</tr>
<tr>
<td>assigneeType</td>
<td>string</td>
<td></td>
<td>Default assignee type (required).</td>
</tr>
</tbody>
</table>

**Assignee Types:**
- projectDefault
- componentLead
- projectLead
- unassigned

**Examples**

Select a Component Assignee

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.enterprise.JiraTagLib">
    <jira:SelectComponentAssignees project-key="ABC" componentName="Comp 1"
        assigneeType="componentLead"/>
</jiraJelly>
```

**jira:TransitionWorkflow**

- **Please Note:** This tag is not available in 3.3 and 3.3.1 — see JRA-7690 for details.

This tag executes a workflow transition on an issue.

Please keep in mind that if you are specifying field attribute/value pairs in your Jelly tag then these fields MUST be on the associated workflow transition screen. If the field is not on the screen then the value will not be set on the issue. For example, if you want to set the resolution attribute in your Jelly XML then your transition MUST have a screen associated with it that includes the resolution field on that screen.

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
</table>
JIRA 6.4 Documentation

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>string</td>
<td>Currently logged in user: Username of the user to execute the workflow transition. The user needs to have the adequate permissions to execute the transition. Please note that the permissions required also depend on the fields that are updated during the transition. (See other attributes below).</td>
</tr>
<tr>
<td>key</td>
<td>string</td>
<td>The key of the issue to execute the transition on.</td>
</tr>
<tr>
<td>workflowAction</td>
<td>string</td>
<td>The id or name of the workflow transition to execute. If the argument can be converted to a number it is assumed to be an id of the transition. Otherwise it is assumed to be a name.</td>
</tr>
<tr>
<td>resolution</td>
<td>string</td>
<td>The id or name of the resolution to set on the issue during the transition. Please note that the transition must expect the resolution to be updated, otherwise an error is generated if this attribute is supplied. If the argument can be converted to a number it is assumed to be an id of the resolution. Otherwise it is assumed to be a name.</td>
</tr>
<tr>
<td>assignee</td>
<td>string</td>
<td>The username of the user to assign an issue to during the transition. The &quot;user&quot; executing the transition must have permissions to assign issues if this attribute is supplied. Please note that the transition must expect the assignee to be updated, otherwise an error is generated if this attribute is supplied. Use value &quot;-automatic-&quot; to let JIRA assign the issue to the default assignee.</td>
</tr>
<tr>
<td>fixVersions</td>
<td>string</td>
<td>A comma separated list of version ids or names to set as “fix for” versions during the transition. The &quot;user&quot; executing the transition must have permissions to set “fix for” versions if this attribute is supplied. Please note that the transition must expect the “fix for” versions to be updated, otherwise an error is generated if this attribute is supplied. If a value in the provided comma separated list can be converted to a number it is assumed to be an id of a version. Otherwise it is assumed to be a name.</td>
</tr>
<tr>
<td>comment</td>
<td>string</td>
<td>The comment to add to the issue during the transition. The &quot;user&quot; executing the transition must have permissions to add comments and the transition must be expecting comments to be added during its execution for the comment to be added successfully.</td>
</tr>
<tr>
<td>groupLevel</td>
<td>string</td>
<td>The level for the comment. The level must be a name of a group the user is a member of. NOTE: If this is specified you can not specify the roleLevel parameter.</td>
</tr>
<tr>
<td>roleLevel</td>
<td>string</td>
<td>Name or Id of Project Role that can see this comment. NOTE: If this is specified you can not specify the groupLevel parameter.</td>
</tr>
</tbody>
</table>

Examples

**Execute Workflow Transition**

```xml
<jiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:TransitionWorkflow key="TST-6" user="testuser" workflowAction="Resolve issue"
                           resolution="fixed" fixVersions="version 1,version 3"
                           assignee="-automatic-"
                           comment="Test comment" groupLevel="jira-developers" />
</jiraJelly>
```

**jira:UpdateProjectRole**

This tag will update the name and description for a given project role id.

**Attributes**
<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>projectroleid</td>
<td>int</td>
<td></td>
<td>The id of the project role you want to query</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td></td>
<td>The name you want the project role updated with</td>
</tr>
<tr>
<td>description</td>
<td>string</td>
<td></td>
<td>The description you want the project role updated with</td>
</tr>
</tbody>
</table>

**Examples**

**Updating a project role**

```xml
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
  <jira:UpdateProjectRole projectroleid="123" name="unique name"
                           description="my project role is nice"/>
</JiraJelly>
```

**Beta Tags**

There are also a number of BETA tags that have not been fully tested or documented. The following list contains the tags and the attributes that can be passed to them:

- **AddIssueSecurity**
  - schemeld (required)
  - security (required)
  - type (required)

- **AddIssueSecurityLevel**
  - name (required)
  - description (required)
  - Output
    - jelly.issue.scheme.level.id

- **CreateIssueSecurityScheme**
  - name (required)
  - description (required)
  - Output
    - jelly.issue.scheme.id

- **LoadManager**
  - var (variable to put manager in)
  - manager (name of manager e.g. IssueManager)

- **LoadProject**
  - var (variable to put project in)
  - project-name (name of project)

- **RemoveGroup**
  - name (required)

- **RemovePermissionScheme**
  - schemeld (required)
  - confirm (required)

- **RemoveProject**
  - pId (required)

- **SelectProjectScheme**
  - projectKey (required)
  - permission-scheme (Name of permission scheme)or
  - issue-scheme (Name of issue security scheme)

- **StringContains**
  - value (String to look in)
  - possiblyContains (String to look for)
  - doesContain (true or false) if value contains possiblyContains == doesContain, the inside of the tag is executed.

If you would like more information on how to use the Beta tags, please read the source and/or post to the Atlassian forum.
Sample scripts

Creating a new Project

To properly partition projects, one needs a permission scheme per project, and project-specific groups to allocate permissions to. Setting up a new project can be a time-intensive process. The following sample Jelly scripts automate this:

This script might be used for a publicly visible project:

```xml
<?xml version="1.0"?>
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.enterprise.JiraTagLib"
xmlns:j="jelly:core">
  <j:set var="name" value="Test Project"/>
  <j:set var="key" value="TEST"/>
  <j:set var="lowerkey" value="test"/>
  <j:set var="lead_username" value="joe"/>
  <j:set var="lead_password" value="joe"/>
  <j:set var="lead_fullname" value="Joe Bloggs"/>
  <j:set var="lead_email" value="joe@example.com"/>
  <j:set var="url" value="http://example.com/TestProj"/>

  <jira:CreateUser username="${lead_username}" password="${lead_password}" confirm="${lead_password}"
    fullname="${lead_fullname}" email="${lead_email}"/>
  <jira:CreateGroup group-name="${lowerkey}-developers">
    <jira:AddUserToGroup username="${lead}"/>
  </jira:CreateGroup>

  <jira:CreateProject key="${key}" name="${name}" url="${url}" lead="${lead_username}"/>
  <jira:CreatePermissionScheme name="${name} permissions">
    <jira:AddPermission type="reporter" permissions="Close"/>
    <jira:AddPermission group="jira-administrators" permissions="Close,Delete" type="group"/>
    <jira:AddPermission group="jira-users" permissions="Create,Edit,Comment,Link,Attach" type="group"/>
    <jira:AddPermission group="${lowerkey}-developers" permissions="Project,ScheduleIssue,Move,Assign,Assignable,Resolve,Close,Work" type="group"/>
    <jira:AddPermission group="Anyone" permissions="Browse,ViewVersionControl" type="group"/>
  </jira:CreatePermissionScheme>

</JiraJelly>
```

This script is more complicated, with multiple groups per project:
<?xml version="1.0"?>
<!-- This script handles some of the administrative chores required when adding a new project to JIRA. It creates the project, groups, permission scheme, and gives groups the relevant permissions in the permission scheme. -->
    <!-- Name of the project to create -->
    <j:set var="name" value="Jelly Test Project"/>
    <!-- Key for the new project -->
    <j:set var="key" value="TEST"/>
    <!-- Existing user who will become the project lead (default assignee) -->
    <j:set var="admin" value="admin"/>

    <jira:CreateGroup group-name="${key}-users"/>
    <jira:CreateGroup group-name="${key}-developers"/>
    <jira:CreateGroup group-name="${key}-managers"/>
    <jira:CreateGroup group-name="${key}-bizusers"/>
    <jira:CreateGroup group-name="${key}-qa"/>

    <jira:CreateProject key="${key}" name="${name}" lead="${admin}"
        permission-scheme=${key} Permission Scheme">
    <jira:AddPermission type="reporter" permissions="Edit"/>
    <jira:AddPermission type="assignee" permissions="Resolve"/>
    <jira:AddPermission group="jira-administrators" permissions="Project,Delete" type="group"/>
    <jira:AddPermission group="${key}-users" permissions="Browse,Create,Comment,Attach" type="group"/>
    <jira:AddPermission group="${key}-developers" permissions="Move,Assignable,Link,ViewVersionControl" type="group"/>
    <jira:AddPermission group="${key}-managers" permissions="Edit,Assign,Assignable,Resolve,Close,Delete" type="group"/>
    <jira:AddPermission group="${key}-bizusers" permissions="Assignable" type="group"/>
    <jira:AddPermission group="${key}-qa" permissions="Assignable" type="group"/>
    <jira:AddPermission group="opsmgrs" permissions="Browse,Edit,Assignable,Comment" type="group"/>
    <jira:AddPermission group="dba-user-group" permissions="Browse,Assign,Assignable,Comment" type="group"/>
    <jira:AddPermission group="help-desk-group" permissions="Browse,Assign,Assignable,Comment" type="group"/>
    <jira:AddPermission group="webadmin-group" permissions="Browse,Assign,Assignable,Comment" type="group"/>
    <jira:AddPermission group="unix-admin-group" permissions="Browse,Assign,Assignable,Comment" type="group"/>
    <jira:SelectProjectScheme/>
    </jira:CreatePermissionScheme>
    </jira:CreateProject>
</JiraJelly>

For a list of projects, perform a project-specific operation.

This script iterates through a (comma-separated) list of projects, creates a project-specific group, and adds a user to that group.
Create a user, issue, and assign the issue to the user

The following script creates a user (called `new-user`), creates a new issue, adds the user to the `jira-developers` group and assigns the issue to the user. It illustrates the use of context variables.

```xml
<?xml version="1.0"?
<!-- Jelly script to create 'support' group per project -->
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib"
xmlns:util="jelly:util" xmlns:j="jelly:core">
<util:tokenize var="projects" delim=",”ARM,QWI,DWI,DBOR,DBSQ,LYX,MMM,MOI,TPAI,SEP,AMR,SLA,TP,TRBC,YRD</util:tokenize>
<j:forEach var="proj" items="${projects}"
><jira:CreateGroup group-name="${proj}-support"/>
<jira:AddUserToGroup username="jeff" group-name="${proj}-support"/>
</j:forEach>
</JiraJelly>
```

Assigning and Starting Progress

Here we create an issue, assign it to 'bob' (who must be in `jira-developers`), and start progress:

```xml
<?xml version="1.0"?
<!-- Jelly script to create 'support' group per project -->
<JiraJelly xmlns:jira="jelly:com.atlassian.jira.jelly.JiraTagLib">
<jira:CreateUser username="new-user" password="password" confirm="password"
 fullname="Full name" email="test@test.com"/>
Username is ${jelly.new.username}
<jira:CreateIssue project-key="TP" summary="New issue summary" issueKeyVar="ik"/>
<jira:AddUserToGroup username="new-user" group-name="jira-developers"/>
<jira:AssignIssue key="${ik}" assignee="${jelly.new.username}"/>
</JiraJelly>
```

Moving unreplied-to issues into an 'Inactive' state

When JIRA is used for interacting with customers, this script is useful for finding issues which are awaiting customer response, and haven't been responded to in a while. It moves such issues into an 'Inactive' state.

You would typically invoke this script periodically with the Jelly Service.
  <jira:Login username="customerssupport" password="XXXXXX">
    <log:warn>Running Inactivate issues service</log:warn>
    <core:set var="comment">This issue has not been updated for 5 business days.

If you have an update, please use "Add Comments For Vendor" action to let us know. If you need more time to gather information please let us know and we will 'freeze' this issue. If you have no other questions, please Close this issue.

If no update is received in the next 5 business days, this issue will be automatically closed.

Thank you,
The Support Team</core:set>
  </jira:Login>
</JiraJelly>

Where:

- **workflowStep** is the name of a workflow transition, e.g "Close Issue", "Start Progress", just as they appear in the left-hand menu on the issue screen.
- **workflowUser** is the user to run the transition as
- **filterid** is the id of a saved search (filter), which finds issues needing to be inactivated (transitioned). This ID can be discovered from the filter URL on the "Manage" tab in "Find issues".

The **JIRA Toolkit** is useful in conjunction with this script, to find issues awaiting customer response.

**JIRA Toolkit (Customer Support Extensions)**

As an extension to JIRA, Atlassian have developed a set of JIRA custom fields, collectively called the "JIRA Toolkit". It can be found online at the [Atlassian Plugin Exchange](https://plugins.atlassian.com).

These custom fields are particularly useful in customer-facing JIRA instances. They were initially developed for use in Atlassian's own JIRA Support installation at [http://support.atlassian.com](http://support.atlassian.com). See the [JIRA Toolkit documentation](https://support.atlassian.com/) for details.

**Developer Guides**

Please refer to the [JIRA Developer Documentation](https://developer.atlassian.com/).

**Building JIRA from Source**

Please be aware that the content on this page is is not included in our [Atlassian Support Offerings](https://www.atlassian.com/legal/support) and consequently Atlassian **can not guarantee providing any support for it**. Please be aware that this material is provided for your information only and using it is done so at your own risk.

If you’re looking to browse through the source code for reference, you can access it if you have a license.
Commercial users at any level receive access to JIRA’s source code (note, evaluation license holders are not permitted access to JIRA’s source code). This topic explains how to build this source code into a deployable JIRA application.

Building all of JIRA from source is only necessary if you need to make extensive modifications to JIRA’s source code and are using a WAR approach.

You should not need to rebuild JIRA if:

- You need to change many JSP files. JSP files are the template files for many JIRA webpages. They can also be more easily changed directly in the standalone JIRA installation directory.
- Create a JIRA plugin that adds functionality to JIRA. For more information, read the JIRA Plugin Guide. Changes and enhancements to JIRA’s functionality can often be made with JIRA plugins without requiring core JIRA source code modifications.
- Recompiling a small number of source files can be done using the instructions in the standalone external-source directory.

⚠️ There is a known issue where the Workflow Designer source is missing from the JIRA source code which is being tracked under [JIRA-29615](#) - Workflow Designer source is missing from the source code delivered with JIRA source code folder - please keep this is mind when building JIRA from source.

On this page:
- Building a JIRA WAR file from a JIRA Source release
- Developing using the IDE Connectors
- Obtaining the source of JIRA’s dependencies
- Compiling Single Class Patches

Building a JIRA WAR file from a JIRA Source release

1. Ensure you have JDK 1.7 or higher and have a Subversion client installed.
2. Download Maven 2.1.0 from the Apache archives of the Maven website.
   ⚠️ We have not yet tested building JIRA from source using Maven 3 at this time.
3. Extract Maven to an appropriate location on your operating system. For example, On Windows, extract to:

   C:\apache-maven-2.1.0

   On Mac/Linux, extract to:

   /usr/local/apache-maven-2.1.0

4. Set the M2_HOME environment variable. For example, On Windows:

   > set M2_HOME=C:\apache-maven-2.1.0

   Alternatively, the Windows environment variables can be configured by choosing My Computer >> Properties >> Advanced >> Environment Variables.

   On Mac/Linux:
5. Add Maven's bin directory to your path. For example,

**On Windows:**

```sh
> set PATH=%M2_HOME%\bin
```

You can set this via My Computer >> Properties >> Advanced >> Environment Variables again if you wish.

**On Mac/Linux:**

```sh
export PATH=$PATH:$M2_HOME/bin
```

6. Install all of the following restricted third party (.jar) libraries to your local Maven repository (.m2), ensuring that you download the version specified below. All of these libraries are required to successfully build JIRA from source. If any of these libraries are missing, the build process will fail.  

Due to licensing restrictions, we are unable to distribute these third party libraries from Atlassian's public Maven repository. If you have built previous versions of JIRA from source, you may already have some of these libraries in your local Maven repository.

<table>
<thead>
<tr>
<th>Libraries</th>
<th>Maven groupId and artifactId</th>
<th>Version</th>
<th>Download URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>activation</td>
<td>javax.activation:activation</td>
<td>1.0.2</td>
<td><a href="http://repository.jboss.org/nexus/service/local/reposit">http://repository.jboss.org/nexus/service/local/reposit</a></td>
</tr>
<tr>
<td>jms</td>
<td>javax.jms:jms</td>
<td>1.1</td>
<td><a href="http://repository.jboss.org/nexus/content/groups/publi">http://repository.jboss.org/nexus/content/groups/publi</a></td>
</tr>
<tr>
<td>jndi</td>
<td>jndi:jndi</td>
<td>1.2.1</td>
<td><a href="http://www.oracle.com/technetwork/java/javasebusinessi">http://www.oracle.com/technetwork/java/javasebusinessi</a></td>
</tr>
<tr>
<td>jta</td>
<td>jta:jta</td>
<td>1.0.1B</td>
<td><a href="http://www.oracle.com/technetwork/java/javasebusinessi">http://www.oracle.com/technetwork/java/javasebusinessi</a></td>
</tr>
<tr>
<td>mail</td>
<td>javax.mail:mail</td>
<td>1.3.2</td>
<td><a href="http://www.oracle.com/technetwork/java/javamail-1-3">http://www.oracle.com/technetwork/java/javamail-1-3</a></td>
</tr>
<tr>
<td>ojdbc6</td>
<td>com.oracle:ojdbc6</td>
<td>11.2.0.2.0</td>
<td><a href="http://www.oracle.com/technetwork/database/enterpr">http://www.oracle.com/technetwork/database/enterpr</a></td>
</tr>
</tbody>
</table>

To install these restricted third party libraries:

a. Download each one (from its link above) into a directory on your file system, for example, downloads in your home directory area.

⚠️ The jmxri, jmxtools, jndi, jta and mail libraries are downloaded as .zip files and before you can install these libraries into your local Maven repository, either:

- a key .jar file must be extracted from them or
- they need to be in .jar form.

i. For jmxri and jmxtools:

- On Windows:

```sh
export M2_HOME=/usr/local/apache-maven-2.1.0
```

- On Mac/Linux:

```sh
export PATH=$PATH:$M2_HOME/bin
```
Use Windows Explorer to enter the downloads directory and extract the jmxri.jar and jmxtools.jar files from the jmx-1_2_1-bin\lib subdirectory of the jmx-1_2_1-ri.zip file.

- **On Linux:**

```
cd $HOME/Downloads
unzip jmx-1_2_1-ri.zip jmx-1_2_1-bin/lib/jmxri.jar
jmx-1_2_1-bin/lib/jmxtools.jar
```

ii. **For jndi:**

- **On Windows:**

Use Windows Explorer to enter the downloads directory and extract the jndi.jar file from the lib subdirectory of the jndi-1_2_1.zip file.

- **On Mac/Linux:**

```
cd $HOME/Downloads
unzip jndi-1_2_1.zip lib/jndi.jar
```

iii. **For jta:**

- **On Windows:**

Use Windows Explorer to enter the downloads directory and rename the jta-1_0_1B-classes.zip file to jta-1_0_1B-classes.jar

- **On Mac/Linux:**

```
cd $HOME/Downloads
mv jta-1_0_1B.zip jta-1_0_1B.jar
```

iv. **For mail:**

1. **On Windows:**

Use Windows Explorer to enter the downloads directory and extract the mail.jar file from the javamail-1.3.2 subdirectory of the javamail-1.3.2.zip file.

2. **On Mac/Linux:**

```
cd $HOME/Downloads
unzip javamail-1.3.2.zip javamail-1.3.2/mail.jar
```

b. Once you have downloaded, expanded and renamed each of these libraries, install them into your local Maven repository. For example, in your downloads directory, enter the following commands:
7. Download the JIRA source archive from [http://www.atlassian.com/software/jira/JIRASourceDownloads.jsp](http://www.atlassian.com/software/jira/JIRASourceDownloads.jsp). You will need to log in as a user with a commercial license to access this page.

8. Extract the JIRA source archive to a location of your choice. This will create a subdirectory with the name `atlassian-jira-X.Y-source`, where X.Y is your version of JIRA. For example, C:\atlassian-jira-4.3-source

9. Change directory into this subdirectory and build JIRA by executing the following Maven 2 command. For example,

   **On Windows:**
   ```
   C:\atlassian-jira-4.3-source\> build.bat
   ```

   **On Mac/Linux:**
   ```
   > build.sh
   ```

   The build script will download several dependencies from Atlassian's public Maven repository.

   On rare occasions, however, the build process may fail and you may receive an error similar to the one encountered when an Atlassian product is unable to install a plugin from [Atlassian's public Maven repository](http://maven.atlassian.com/repository). This problem is caused by the JVM being unable to access its default 'cacerts' file, which contains a certificate that trusts Atlassian's public Maven repository.

   To resolve this problem:
   - Try one of the solutions mentioned in the Confluence Knowledge Base article: [Unable to Install Plugin Due to Maven SSL](https://confluence.atlassian.com/display/JIRAHOWTO/Unable+to+Install+Plugin+Due+to+Maven+SSL).
   - If that does not resolve the problem, you may have a 'jssecacerts' file which does not contain a certificate that trusts Atlassian's public Maven repository. If a 'jssecacerts' file is present in your JVM, the 'cacerts' file may be ignored.

10. A WAR file called `jira-webapp-dist-X.Y.war` (where X.Y is your version of JIRA), will be built in the `jira-project/jira-distribution/jira-webapp-dist/target` subdirectory of your extracted JIRA source directory.

    For example, if the subdirectory created above was `C:\atlassian-jira-4.3-source`, the WAR file
will be found in:
C:\atlassian-jira-4.3-source\jira-project\jira-distribution\jira-webapp-dist\target\jira-webapp-dist-4.3.war

An unpacked version of your JIRA source build can also be found in the jira-project/jira-distribution/jira-webapp-dist/target/jira-webapp-dist-X.Y subdirectory of your extracted JIRA source directory.

11. The WAR file generated can now be installed into your application server to run the JIRA application you just built. For more information, refer to the JIRA WAR Configuration Overview. For specific installation instructions, you can follow these procedures, skipping stages 1 and 3:
   - Installing JIRA on Tomcat 6.0 or 7.0

Developing using the IDE Connectors

Learn about the IDE Connectors from the IDE Connector Documentation.

Obtaining the source of JIRA’s dependencies

When building JIRA from source, Maven will fetch the binary (compiled) dependencies that it requires automatically during the build process, so you do not have to do it manually (with the exception of the third party libraries mentioned above).

It is worth noting that JIRA's source distribution not only ships with JIRA's source code, it also includes the source of the internal Atlassian projects that JIRA depends on (e.g. atlassian-bonnie, atlassian-core, etc.). The internal Atlassian dependencies for JIRA's source distribution are made available as Maven-based archives. There will be a Maven-based archive for each dependency, named <dependencyname-version>-sources.jar. The only buildable part of the source package is JIRA itself, not its dependencies.

Other dependencies are available on Atlassian's public repository. The source of these dependencies is usually available on the library’s website (try googling for the library name), or can be identified in the SCM information of the relevant library.

If you have any questions regarding the build process, try searching/posting to the Atlassian Answers, which is monitored by the development community, and by Atlassian as often as possible.

Compiling Single Class Patches

If you just want to compile one class (perhaps a service), we have a step-by-step guide for how to do this in IDEA. See How to Make a JIRA Patch for details.

How to Make a JIRA Patch

To make any substantial modifications or additions to JIRA’s source, you should read Building JIRA from Source. This implies building a WAR and deploying this to your Application Server.

Making a Single Class Patch

This guide describes how to make a source code modification to a single class file.

1. Download Maven 2.1.0 from the Apache archives of the Maven website.
2. Set your PATH and M2_HOME environment variables where you install Maven (and its /bin directory for the PATH).
3. Download JIRA source.
4. Changed directory into your extracted JIRA source directory and then into its jira-project subdirectory.
5. Run one of the following, depending on your preferred IDE:

   maven mvn idea:idea

   OR
6. Open the resulting project.
7. From your IDE, build the project.
8. From your IDE, open and compile a file. The compiled file will appear in the target/classes directory of the maven module that you are working on. If you are working with JIRA’s core classes, this is likely to be in /jira-project/jira-components/jira-core/target/classes

**Deploying the Patch**

To deploy a patch, drop the file in the classpath from `<jira-install>/WEB-INF/classes`. For example, if you compile the class:

```java
com.atlassian.jira.appconsistency.integrity.check.SearchRequestRelationCheck
```

...it will be available from:

```java
/jira-project/jira-components/jira-core/target/classes/com/atlassian/jira/appconsistency/integrity/check/SearchRequestRelationCheck.class
```

To deploy this class, place it in:

```java
<jira-install>/WEB-INF/classes/com/atlassian/jira/appconsistency/integrity/check/SearchRequestRelationCheck.class
```

...then restart JIRA.

**API Documentation**

The JIRA API docs are available online. They are most useful for:

- users writing Plugins, Listeners and Services
- users with commercial licenses who wish to modify JIRA
- partners embedding JIRA as a J2EE component

Where can I find the API documentation?

- The API documentation can be found here: [https://developer.atlassian.com/static/](https://developer.atlassian.com/static/) (see JIRA section).
- Information about each of the remote APIs (REST, XML-RPC, JSON-RPC) can be found here: JIRA Remote API Reference.
- Please note, the API documentation is not available for download.

**Other resources**

We also recommend that you refer to the developer resources available via this page: Development Resources.

Each of the "Preparing for..." pages provide helpful information for each JIRA version, such as change reports like this one: JIRA stable (Java) API changes for 6.0 (Clirr report).

**Managing Webhooks**

Webhooks are user-defined HTTP POST callbacks. They provide a lightweight mechanism for letting remote applications receive push notifications from JIRA, without requiring polling. For example, you may want any changes in JIRA bugs to be pushed to a test management system, so that they can be retested.
JIRA supports webhooks for all standard issue-related events (i.e. not custom events), e.g. issue_created, issue_assigned, etc. Issue events are pushed to a specified URL in JSON format. You can constrain the scope of the webhook by specifying the desired issue events and/or JQL.

Please read the JIRA Webhooks Overview page which contains detailed information on JIRA webhooks. This page only contains instructions on how to use the Webhooks user interface in the JIRA administration console.

On this page:
- Viewing webhooks in JIRA
- Managing webhooks via the JIRA administration console
- Extending your webhook
- Known issues

Viewing webhooks in JIRA

To view webhooks in JIRA,
1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System. Select Advanced > Webhooks to open the Webhooks page, which shows a list of all existing webhooks.
   😄 Keyboard shortcut: g + g + start typing webhooks
3. Click the summary of the webhook in the left 'Webhooks' column to display the details of the webhook.

Managing webhooks via the JIRA administration console

Webhooks can be registered (created), edited and deleted via the JIRA administration console, REST calls or the installation of a “Remote App”. The instructions on this page describe how to manage webhooks via the JIRA administration console. Please see the JIRA Webhooks Overview page for information on the other methods.

To manage webhooks in JIRA,
1. Log in as a user with the JIRA Administrators global permission.
2. Choose > System. Select Advanced > Webhooks to open the Webhooks page, which shows a list of all existing webhooks.
   😄 Keyboard shortcut: g + g + start typing webhooks
3. Create/register, edit or delete webhooks as desired.
- **Create** — Click Add a Webhook, enter the webhook details and click Create.
- **Edit** — Select the desired webhook in the summary list on the left, click Edit, update the webhook details and click Save.
- **Delete** — Select the desired webhook in the summary list on the left, and click Delete in the webhook details.
- **Disable** — Select the desired webhook in the summary list on the left, and click Disable in the webhook details. Disabling a webhook prevents the webhook from firing.
- **Enable** (disabled webhooks only) — Select the desired disabled webhook in the summary list on the left, and click Enable in the webhook details.

**Tips for managing a webhook**

- **Constraining the webhook to a set of issues/issue events** — By default, a webhook will fire for all events of all issues in a JIRA installation. You can constrain this to a set of issues and a set of issue events (or no issue events). To do this, specify the desired set of issues (via a JQL statement) and the set of issue events, when you create or edit a webhook. For example, the webhook in the screenshot above will only fire when bugs with an affected version of "1.0" are updated.
- **Omitting the JSON from the POST** — If you are integrating with a system where only a POST URL is required to trigger the action, and having a body with data breaks the integration, you can configure the webhook so that it does not send the JSON with the POST. To do this, select the Exclude details checkbox when editing your webhook.
- **Determining the changes in an 'Issue Updated' event** — A changelog is sent with the 'Issue Updated' event (excepting the issue_generic_event). You can listen for this event and check the changelog for the changes.

**Extending your webhook**

**Trigger your webhook from a workflow post function**

See Configuring Workflows.

Please note, if a webhook is associated with a post-function, you cannot be delete the webhook. You must disassociate it from the post-function first.

**Add an issue key variable to your webhook**

You can add an issue key variable to your webhook by inserting `${issue.key}` in your webhook URL. When the webhook fires for an issue, the issue key will be substituted for the variable in the URL.

For example, say you have the following web hook URL with the `${issue.key}` variable:

http://example.com/bamboo/rest/api/latest/queue/BAMBOO/${issue.key}

If the web hook is fired for a JIRA issue with the key JRA-1234, the URL that the web hooked is posted to will be:

http://example.com/bamboo/rest/api/latest/queue/BAMBOO/JRA-1234

**Known issues**

- Post function web hooks will not fire if added to the Create Issue workflow transition. We recommend that you configure your web hook to fire from the issue_created event instead.
- If you are using webhooks in JIRA Cloud, there is a known issue that restricts the port numbers that can be specified in the webhook URL. If you do not follow the guidelines below, then the webhook will not trigger.
  - If you are using HTTP and specify a port number in the webhook URL, the port number must be 80. Note, if you do not specify a port number, the webhook will work.
  - If you are using HTTPS and specify a port number in the webhook URL, the port number must be 443. Note, if you do not specify a port number, the webhook will work.

**JIRA Installation and Upgrade Guide**

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
The pages listed below contain information on installing and upgrading JIRA. You will be required to download JIRA to install or upgrade it. We recommend reading the specific page that applies to your situation to ensure you understand all the requirements and implications.

• JIRA Requirements
• Supported Platforms
• Installing JIRA
• Running the Setup Wizard
• Connecting JIRA to a Database
• Upgrading JIRA
• Migrating JIRA to Another Server
• Establishing Staging Server Environments for JIRA
• Important Directories and Files
• Tomcat security best practices
• Customizing Your JIRA Installation
• Deployment Planning Activity

You can also skip the installation process by using JIRA Cloud.

JIRA Requirements

JIRA is a ‘web application’, meaning it runs centrally on a server, and users interact with it through web browsers from any computer.

If you are considering running JIRA on VMware, please read Virtualizing JIRA (JIRA on VMware).

• JIRA Client/Server Software Requirements
  • 1. Browser
  • 2. Java
  • 3. Application Server
  • 4. Database
  • 5. Notes
• JIRA Server Hardware Recommendations
  • JIRA Server Hardware Recommendation for Evaluation
  • JIRA Server Hardware Recommendation for Production
• Next Steps

No hardware? No problem! Try using JIRA Cloud.

• No installation required, get started in 5 minutes
• Option to migrate to your own server later
• Choose from a set of supported add-ons to install

JIRA Client/Server Software Requirements

Please read the Supported Platforms page for JIRA, which lists the required server and client software supported by JIRA 6.4, including:

• Browsers (client-side)
• Java platforms (JDK/JRE) (server-side)
• Operating systems (server-side)
• Application servers (if you are installing the JIRA WAR distribution) (server-side)
• Databases (server-side)

Please also read the information below regarding server and client software requirements for JIRA.
1. Browser

If you have disabled JavaScript in your browser or are using a script blocking tool like NoScript, you must enable your browser to execute JavaScript from JIRA to access JIRA's full functionality.

2. Java

JIRA requires a Java Developers Kit (JDK) or Java Runtime Environment (JRE) platform to be installed on your server's operating system.

If you intend to use the Windows Installer or Linux Installer to install JIRA, there is no need to install and configure a separate JDK/JRE since these executable files will install and configure their own JRE to run JIRA.

If, however, you intend to install JIRA from an archive or you plan to install the JIRA WAR distribution, then you will first need to install a supported Java platform. (Refer to Supported Platforms for supported Java Platforms). For instructions on how to install a supported Java platform for JIRA, please refer to Installing Java.

Please Note:

- Currently, Oracle JDK/JRE (formerly Sun JDK/JRE) is available for Windows (32-bit + 64-bit), Linux (32-bit + 64-bit) and Solaris Platforms (32-bit + 64-bit).
- Mac OS X systems are packaged with a JDK optimised for their hardware and operating systems. However, these JDKs are not supported by JIRA.
- A JIRA installation running on a 64-bit Java platform may require additional memory (to run at a similar level of performance) to a JIRA installation running on a 32-bit Java platform. This is because a 64-bit Java platform's object references are twice the size as those for a 32-bit Java platform.

3. Application Server

JIRA is a web application that requires an application server. However, this requirement differs based on the type of JIRA distribution you intend to install:

- 'Recommended' JIRA distributions (installed using 'Windows Installer', 'Linux Installer' or from an 'Archive') are pre-configured with Apache Tomcat, which is a stable, lightweight and fast-performing application server. (There is no need to install a separate application server if you intend to install one of these recommended JIRA distributions.)
- The JIRA WAR distribution can be installed into an application server (supported by Atlassian), provided this application server is compatible with your operating system and Java platform. You must manually configure your JIRA WAR installation to operate with an existing application server installation.

4. Database

JIRA requires a relational database to store its issue data. JIRA supports most popular relational database servers, so we suggest using the one that you are most comfortable with administering. JIRA ships pre-configured with the HSQLDB database, which is suitable for evaluation purposes only, since HSQLDB is prone to database corruption.

Hence, if you intend to use JIRA in a production environment, we strongly recommend that you connect JIRA to an enterprise database (supported by Atlassian).

5. Notes

- Virus checking software are a common cause of performance problems. In particular, Symantec must be uninstalled from the server that you want to install JIRA on, as it is known to dramatically reduces JIRA performance (even stopping the services does not prevent it from slowing JIRA down).
- For more information, see this knowledge base article: Crashes and Performance Issues Troubleshooting

JIRA Server Hardware Recommendations

JIRA typically will not perform well in a tightly constrained, shared environment - examples include an A WS micro.t1 instance. Please be careful to ensure that your choice of hosting platform is capable of supplying sustained processing and memory capacity for the server.

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA Server Hardware Recommendation for Evaluation

During evaluation, JIRA will run well on any reasonably fast workstation computer (e.g., something purchased within the last two years). Memory requirements depend on how many projects and issues you will store, but 300MB – 1GB (of Java heap size) is enough for most evaluation purposes.

There are two ways to evaluate JIRA:

1. Start immediately with JIRA Cloud and then migrate to a local production server later, or simply continue to use JIRA Cloud.
2. Install JIRA Server on a local computer and then migrate this to a production server later.

JIRA Server Hardware Recommendation for Production

The JIRA Sizing Guide could help you choose a server with sufficient resources based on your use case and usage.

The hardware required to run JIRA in production depends on a number of different JIRA configurations (e.g., projects, issues, custom fields, permissions, etc) as well as the maximum number of concurrent requests that the system will experience during peak hours. Here are some general guidelines:

- For a small number of projects (10-20) with 1,000 to 5,000 issues in total and about 100-200 users, a recent server (multicore CPU) with 2 GB of available RAM and a reasonably fast hard drive (7200rpm or faster) should cater for your needs.
- For a greater number of issues adding more memory will help. We have reports that having 2GB of RAM to JIRA is sufficient for instances with around 200,000 issues. If in doubt, allocate more memory than you think you need.
- If your system will experience a large number of concurrent requests, running JIRA on a multicore CPU machine will increase the concurrency of processing the requests and therefore speed up the response time for your users.
- For reference we have a server that has a 2 Intel(R) Xeon(R) CPU E5520 @ 2.27GHz (16 logical cores) with 32GB of RAM. This server runs Apache, various monitoring systems, and two JIRA instances:
  - Our public JIRA site that has approximately: 145,000 issues, 255,000 comments, 120 custom fields, and 115 projects.
  - Our support JIRA site that has approximately: 285,000 issues, 2,500,000 comments, 75 custom fields, and 22 projects.

Please note that performance heavily depends on your dimensions and your usage pattern, much more than what is simply covered here. Therefore we have written a guide on the different methods you can use to scale JIRA in your environment.

A quick note that your JIRA database's size is predominantly dominated by these three large tables: change items, comments and issues stored in your JIRA instance. Also, the type of custom fields and the values they hold may also increase the size of your JIRA database, e.g., a free text custom field that is on every issue will grow the database size if the value of that field is large.

⚠️ Please Note: JIRA requires access to a local disk for certain functionality. If JIRA does not have read and write access to a local disk, searching and saving/accessing attachments will not work.

While some of our customers run JIRA on SPARC-based hardware, Atlassian only officially supports JIRA running on x86 hardware and 64-bit derivatives of x86 hardware.

Next Steps

Install JIRA.

Installing Java

Please skip these instructions if you are intend to use or have used the Windows Installer or Linux Installer to install JIRA, since these executable files will install and configure their own JRE to run JIRA. If you are trying to use a different Java/JRE instead of the version bundled with JIRA, please use the How to Use System JRE Instead of Embedded JRE guide.
On this page:

- 1. Installing Java
- 2. Setting the JAVA_HOME
   - Linux-based computers
   - Windows-based computers
- 3. Confirming that Java Works
- Next Step

1. Installing Java

JIRA requires Oracle's (formerly Sun's) Java Development Kit (JDK) or Java Runtime Environment (JRE) platform to run. Refer to Supported Platforms for details on the Java platform versions that JIRA supports.

Oracle's JDK/JRE can be downloaded from Oracle's website.

Linux distributions frequently have an open-source implementation of Java called GCJ installed. Do not use this Java platform — it is incomplete and JIRA will not run successfully on it.

You can test whether you have the correct Java platform by running java -version:

```
~$ java -version
java version "1.7.0_25"
Java(TM) SE Runtime Environment (build 1.7.0_25-b15)
Java HotSpot(TM) 64-Bit Server VM (build 23.25-b01, mixed mode)
```

2. Setting the JAVA_HOME

Once the JDK or JRE is installed, you will need to set the JAVA_HOME environment variable, whose value is the root directory of the JDK/JRE.

Some JDK/JRE installers set this automatically (check by typing 'echo %JAVA_HOME%' in a Windows command prompt, or 'echo $JAVA_HOME' in a Linux/UNIX console).

**Linux-based computers**

On many Linux-based computers, the JAVA_HOME environment variable is set in the `/etc/environment` file.

If JAVA_HOME is not defined in this file, you can set it using the following command at a shell prompt, when logged in with 'root' level permissions:

```
$ echo JAVA_HOME="path/to/JAVA_HOME" >> /etc/environment
```

If, however, JAVA_HOME is already defined in this file, open the `/etc/environment` file in a text editor and modify its value to the appropriate path/to/JAVA_HOME — that is:

```
JAVA_HOME="path/to/JAVA_HOME"
```

**Windows-based computers**

If this environment variable is not set on a Windows-based computer, you can set it in the Control Panel using the following procedure:

1. Open the Windows 'Advanced' system properties dialog box:
   - On Windows XP-based operating systems, right-click on the My Computer icon on your desktop (or via the Start menu), select 'Properties' and click the 'Advanced' tab.
   - On Windows 7-based operating systems, right-click the Computer icon on your desktop (or via the Start menu), select 'Properties', click 'Advanced system settings', select 'Properties' and click the 'Advanced' tab.
2. Click the Environment Variables button.
3. Click one of the New buttons (to define a new environment variable for your user account, or if available,
4. Type `JAVA_HOME` as the variable name and the directory where you installed Java.

The default path for the bundled JRE with JIRA is `C:\Program Files\Atlassian\JIRA\jre`. If using a 32-bit install in 64-bit system, this would be `C:\Program Files (x86)\Atlassian\JIRA\jre`.

5. After clicking the required 'OK' buttons to save your changes, your `JAVA_HOME` environment variable should be available in a new command prompt window. If not or if necessary, restart your computer.

3. Confirming that Java Works

Once the steps above have been done, it should be possible to open a Windows command prompt and type `%JAVA_HOME%\bin\java` -version (or `%JAVA_HOME%\bin\java -version` if your `%JAVA_HOME%` value contains spaces) and see output similar to this:

```
java version "1.7.0_25"
Java(TM) SE Runtime Environment (build 1.7.0_25-b15)
Java HotSpot(TM) 64-Bit Server VM (build 23.25-b01, mixed mode)
```

If you subsequently start JIRA and you receive an error like `Windows cannot find `-Xms128m'`, then you may not have correctly set `JAVA_HOME`. Please verify step 2 of the procedure above.

Next Step

Installing JIRA from an Archive File on Windows, Linux or Solaris

Supported Platforms
This page lists the supported platforms for **JIRA 6.4** only. If a particular platform or a particular platform's version is not noted on this page, then we do not support it for JIRA 6.4.

---

### Not using JIRA 6.4?

The information below does not apply to you. See the following pages instead:

- Supported Platforms for JIRA 6.3
- Supported Platforms for JIRA 6.2
- Documentation for older JIRA versions

---

Further information:

- Please also ensure you have read the JIRA Requirements page, since not all the platforms listed below may be required for your specific JIRA setup.
- Please read End of Support Announcements for JIRA for important information regarding the end of support for various platforms and browsers when used with JIRA.
- If you use JIRA Data Center, each node in your environment must meet these requirements. For more information, see JIRA Data Center.

---

### Supported platforms for JIRA 6.4

<table>
<thead>
<tr>
<th>Java platforms</th>
<th>Supported platform(s)</th>
<th>Supported version(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle JDK / JRE (formerly Sun JDK / JRE)</td>
<td>Java 7</td>
<td></td>
<td>There is a known issue with Java 1.8.0_25 and 1.8.0_31. We don't recommend running JIRA on these versions.</td>
</tr>
<tr>
<td></td>
<td>Java 8</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating systems</th>
<th>Supported platform(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td></td>
<td>JIRA is a pure Java-based application and should run on any supported operating system, provided that the JDK / JRE requirements are satisfied. Please see here for information on Anti-Virus in JIRA</td>
</tr>
<tr>
<td>Linux / Solaris</td>
<td></td>
<td>JIRA is a pure Java-based application and should run on any supported operating system, provided that the JDK / JRE requirements are satisfied. Atlassian only officially supports JIRA running on x86 hardware and 64-bit derivatives of x86 hardware. If you are installing JIRA from an archive, you should create a dedicated user account on the operating system to run JIRA, since JIRA runs as the user it is invoked under and therefore can potentially be abused. Although the JIRA Linux Installer is designed to install successfully on all 'flavours' of Linux, we only test the JIRA Linux Installer on CentOS Linux. If you encounter problems with the JIRA Linux Installer on your particular flavour of Linux, we recommend installing JIRA on Linux from an archive file. Network storage locations are not supported due to Lucene requirements (such as NFS mounts). Please see the IndexWriter docs for further info.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Virtualisation</th>
<th>Supported platform(s)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware</td>
<td></td>
<td>Please read our Virtualizing JIRA (JIRA on VMware) guide for information on the required configuration of VMware. We are unable to provide any support for VMware itself. All of the operating systems listed in the 'Operating systems' rows above are supported for VMware.</td>
</tr>
<tr>
<td><strong>Application servers</strong></td>
<td><strong>Mail servers</strong></td>
<td><strong>Databases</strong></td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Apache Tomcat</td>
<td></td>
<td>Oracle</td>
</tr>
<tr>
<td>• 7.0.55</td>
<td></td>
<td>• 11G with Oracle 11.2.x drivers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Using Advanced Compression Option (ACO) is not supported.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MySQL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 5.x (excluding 5.0) with the JDBC Connector/J 5.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• We support all 5 series GA releases, except for 5.0. This includes 5.1.x, 5.5.x and 5.6.x.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The MySQL driver is no longer bundled with JIRA, as of JIRA 5.2. Please see the JIRA 5.2 Upgrade Notes for reasons why we do not bundle this driver.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MySQL 5.0.x is not supported as it is essentially EOL and only covered under Oracle Sustaining Support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• We recommend running MySQL in strict mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• JIRA does not support 4 byte characters, regardless of MySQL version.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you must use 4 byte characters, we recommend you use PostgreSQL.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PostgreSQL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 9.3 with the PostgreSQL Driver 9.3.x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 9.2 with the PostgreSQL Driver 9.2.x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 9.1 with the PostgreSQL Driver 9.1.x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 9.0 with the PostgreSQL Driver 9.0.x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 8.4 with the PostgreSQL Driver 8.4.x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Express Editions are not supported.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microsoft SQL Server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2012 with the JTDS 1.2.4 driver</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2008 with the JTDS 1.2.4 driver</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2008 R2 with the JTDS 1.2.4 driver</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2005 with the JTDS 1.2.4 driver</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Express Editions are not supported.</td>
</tr>
</tbody>
</table>
JIRA ships with a built-in database (HyperSQL DataBase or HSQLDB). While this database is suitable for evaluation purposes, it is susceptible to data loss during system crashes. Hence, for production environments we **strongly recommend** that you configure JIRA to use an external database.

### Web Browsers

<table>
<thead>
<tr>
<th>Browser</th>
<th>Supported for evaluation use only</th>
<th>JIRA end of support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chrome</td>
<td>Latest stable version supported</td>
<td>Minimum screen resolution of 1024 x 768 (when browsers are maximised).</td>
</tr>
<tr>
<td>Microsoft Internet Explorer</td>
<td>9.0 10.0 11.0</td>
<td>Please refer to our Security Bugfix Policy on fixing browser issues.</td>
</tr>
<tr>
<td>Mozilla Firefox</td>
<td>Latest stable version supported</td>
<td>Minimum screen resolution of 1024 x 768 (when browsers are maximised).</td>
</tr>
<tr>
<td>Safari</td>
<td>Latest stable version supported on Mac OS X only</td>
<td>Please refer to our Security Bugfix Policy on fixing browser issues.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Mobile Safari (iOS, iPod touch and iPhone only) — Latest stable version</td>
<td>Mobile devices are only supported on the Mobile views.</td>
</tr>
<tr>
<td></td>
<td>Android — The default browser on Android 4.0.3 (Ice Cream Sandwich)</td>
<td></td>
</tr>
</tbody>
</table>

**End of Support Announcements for JIRA**

This page contains announcements of the end of support for various platforms and browsers used with JIRA. These are summarised for upcoming JIRA releases in the table below. Please see the following sections for the full announcements.

End of support matrix for JIRA

The table below summarises the end of support announcements for **upcoming** JIRA releases.

<table>
<thead>
<tr>
<th>Platform/Functionality</th>
<th>JIRA end of support</th>
</tr>
</thead>
<tbody>
<tr>
<td>HSQLDB</td>
<td>From JIRA 7.0 (announcement)</td>
</tr>
<tr>
<td>Oracle JDK 1.7</td>
<td>From JIRA 7.0 (announcement)</td>
</tr>
</tbody>
</table>
Oracle 11G  From JIRA 7.0 (announcement)
Internet Explorer 9  From JIRA 7.0 (announcement)
SOAP API (replaced with REST)  From JIRA 7.0 (announcement)
Jelly script  From JIRA 6.4 (announcement)
WAR download distribution  From JIRA 7.0 (announcement)
Microsoft SQL Server 2005  From JIRA 7.0 (announcement)

Why is Atlassian ending support for these platforms?
Atlassian is committed to delivering improvements and bug fixes as fast as possible. We are also committed to providing world class support for all the platforms our customers run our software on. However, as new versions of databases, web browsers, etc, are released, the cost of supporting multiple platforms grows exponentially, making it harder to provide the level of support our customers have come to expect from us. Therefore, we no longer support platform versions marked as end-of-life by the vendor, or very old versions that are no longer widely used.

End of support for HSQLDB
Announced February 2015
Atlassian will end support for HSQLDB (HyperSQL DataBase) in JIRA 7.0. End of support means that Atlassian will not fix bugs in HSQLDB past the support end date.

JIRA ships with a built-in database for evaluation purposes, and currently this is HSQLDB. As of JIRA 7.0, JIRA will ship with H2 (H2 Database Engine) as its built-in database.

HSQLDB (HyperSQL DataBase or HSQLDB) End of Support Notes:

- JIRA 6.4 will be the last major version of JIRA to officially support HSQLDB (HyperSQL DataBase) for evaluation use.
- JIRA 6.4.x and earlier versions will continue to work with HSQLDB (HyperSQL DataBase) for evaluation use. However, we will not fix bugs affecting HSQLDB (HyperSQL DataBase) past the support end date.
- JIRA 7.0 will not be tested with HSQLDB (HyperSQL DataBase).

End of support for Oracle JDK 1.7
Announced February 2015
Atlassian will end support for Java 7 (JRE and JDK 1.7) in JIRA 7.0. End of support means that Atlassian will not fix bugs in Java 7 (JRE and JDK 1.7) past the support end date.

We are ending support for Java 7 (JRE and JDK 1.7), as Oracle Corporation has announced the end of public updates for Java 7: Java SE 7 End of Public Updates Notice.

Java 7 (JRE and JDK 1.7) End of Support Notes:

- JIRA 6.4 will be the last major version of JIRA to officially support Java 7 (JRE and JDK 1.7).
- JIRA 6.4.x and earlier versions will continue to work with Java 7 (JRE and JDK 1.7). However, we will not fix bugs affecting Java 7 (JRE and JDK 1.7) past the support end date.
- JIRA 7.0 will not be tested with Java 7 (JRE and JDK 1.7).
- Java 8 (JRE and JDK 1.8) is supported, but not bundled with JIRA 6.4

End of support for Oracle 11G
Announced February 2015
Atlassian will end support for Oracle 11G in JIRA 7.0. End of support means Atlassian will not fix bugs related to Oracle 11G past the support end date, except for security-related issues.

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
We are making this decision as Oracle Corporation have ended support for Oracle 11G as of January 2015. Testing on Oracle 12C will conclude shortly and we’ll announce support soon.

Oracle 11G End of Support Notes

- JIRA 6.4 will be the last major release that supports Oracle 11G
- JIRA 6.4.x and earlier versions will continue to work on Oracle 11G
- JIRA 7.0 will not be tested against Oracle 11G

End of support for Internet Explorer 9

Announced February 2015

Atlassian will end support for Internet Explorer 9 in JIRA 7.0. End of support means that Atlassian will not fix bugs related to Internet Explorer 9 past the support end date, except for security-related issues.

We are making this decision to enable us to provide the best user experience to our customers, accelerate our pace of innovation, and give us the ability to utilize modern browser technologies.

Internet Explorer 9 (IE9) End of Support Notes

- JIRA 6.4 will be the last major release that supports Internet Explorer 9
- JIRA 6.4.x and earlier versions should continue to work on Internet Explorer 9
- JIRA 7.0 will not be tested against Internet Explorer 9
- Internet Explorer 10 and Internet Explorer 11 will continue to be supported in JIRA 7.0.x.

End of support for SOAP

Announced November 2014

Atlassian will end support for SOAP API in JIRA 7.0. The SOAP API’s have been replaced by REST API’s as Atlassian’s recommended and supported remote API.

SOAP End of Support Notes

- JIRA 6.4 will be the last major release that supports SOAP
- JIRA 6.4.x and earlier versions should continue to work with SOAP
- JIRA 7.0 will not include any SOAP API’s
- If you need an alternative that Atlassian supports, the REST API is fully supported by JIRA.

End of support for Jelly Scripts

Announced November 2014

Atlassian will end support for Jelly scripts in JIRA 6.4. If you are using Jelly scripts with JIRA, we suggest you move to Groovy Script Runner or utilise the JIRA Command Line Interface, which will provide you with more flexible options.

Jelly Script End of Support Notes

- JIRA 6.3 will be the last major release to support Jelly scripts
- JIRA 6.3.x and earlier versions should continue to work with Jelly scripts
- JIRA 6.4 will not include Jelly.
- If you need an alternative to Jelly scripts, Groovy Script Runner or the JIRA Command Line Interface are the suggested alternatives that work with JIRA.

End of support for WAR distribution

Announced August 2014

Atlassian will stop releasing the WAR distribution of JIRA in JIRA 7.0.

Why are we ending support for this?
- We are trying to reduce the amount of combinations and confusion around this for customers downloading a Server (BTF) edition
- The WAR edition is a bit more complex to install and gets more difficult as the installation ages.
and gets bigger - we want to reduce that complexity

- We can't and don't test every permutation of environments + app servers that a customer might deploy into, nor can we control what else might be in that environment, which can lead to a poor user experience
- We only support Tomcat - JIRA doesn't work on WLS or WebSphere anyways, other app servers - maybe.

Anything we release, we want to make sure users get a good experience in installation and usage and don't have to deal with app server quirks etc.

End of support for Microsoft SQL Server 2005

Announced June 2014

Atlassian will end support for Microsoft SQL Server 2005 in JIRA 7.0. End of support means that Atlassian will not fix bugs related to Microsoft SQL Server 2005 past the support end date.

We are making this decision in order to reduce our database testing and support, and help us speed up our ability to deliver market-driven features. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

Microsoft SQL Server 2005 End of Support Notes:

- JIRA 6.4 will be the last major version of JIRA to officially support Microsoft SQL Server 2005.
- JIRA 6.4.x and earlier versions should continue to work with Microsoft SQL Server 2005.
- JIRA 7.0 will not be tested against Microsoft SQL Server 2005.
- Microsoft SQL Server 2008 and 2008 R2 will continue to be supported in JIRA 7.0.x (see Supported Platforms).
- We will start supporting Microsoft SQL Server 2012 in JIRA 6.4.

Older announcements

- Click here to expand...

On this page (most recent announcements first):

- Deprecated plugins for JIRA (01 August 2013)
- Deprecated source control systems for JIRA (8 July 2013)
- End of support for characters other than letters, numbers and the underscore in JIRA's project key (13 May 2013, updated 6 August 2013)
- Deprecated Java platforms for JIRA (18 January 2013)
- End of support for project key format configuration (22 November 2012)
- Deprecated application servers for JIRA (27 August 2012)
- Deprecated databases for JIRA (24 July 2012)
- Deprecated web browsers for JIRA (6 April 2011)
- Deprecated databases for JIRA (6 April 2011)
- Deprecated web browsers for JIRA (27 September 2010)
- Deprecated databases for JIRA (13 August 2010)
- Deprecated application servers for JIRA (27 January 2010)
- Deprecated Java platforms for JIRA (27 January 2010)
- Deprecated web browsers for JIRA (11 December 2009)

End of support for PostgreSQL 8.3.x

Announced June 2014

Atlassian will end support for PostgreSQL 8.3.x in JIRA 6.3. We are planning on releasing JIRA 6.3 in mid-2014. End of support means that Atlassian will not fix bugs related to PostgreSQL 8.3.x past the support end date.

We are making this decision, as the PostgreSQL Global Development Group has already ended support for PostgreSQL 8.3 (in February 2013). If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

PostgreSQL 8.3.x End of Support Notes:

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA 6.2 will be the last major version of JIRA to officially support PostgreSQL 8.3.x.
JIRA 6.2.x and earlier versions should continue to work with PostgreSQL 8.3.x.
JIRA 6.3 will not be tested against PostgreSQL 8.3.x.
PostgreSQL 8.4 and 9.0 will continue to be supported in JIRA 6.3.x (see Supported Platforms).
We will start supporting PostgreSQL 9.1, 9.2 and 9.3 in JIRA 6.3.

End of support for Internet Explorer 8

Announced October 2013

Atlassian will end support for Internet Explorer 8 in JIRA 6.3. We are planning on releasing JIRA 6.3 in mid-2014. End of support means that Atlassian will not fix bugs related to Internet Explorer 8 past the support end date, except for security-related issues.

We are making this decision to enable us to provide the best user experience to our customers, accelerate our pace of innovation, and give us the ability to utilize modern browser technologies. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

Internet Explorer 8 End of Support Notes:

- JIRA 6.2 will be the last major version of JIRA to officially support Internet Explorer 8.
- JIRA 6.2.x and earlier versions should continue to work with Internet Explorer 8.
- JIRA 6.3 will not be tested against Internet Explorer 8.
- Internet Explorer 9 and 10 will continue to be supported in JIRA 6.3.x (see Supported Platforms).

Deprecated plugins for JIRA (01 August 2013)

This section announces the end of Atlassian support for the Voters and Watchers and Labels plugins. Atlassian will not fix bugs related to either the "Voters and Watchers" or the "Labels" plugins past the support end date. Note, these plugins are not bundled with JIRA. In case of both of these plugins, the respective functionality has been largely replaced as part of the JIRA core since version 4.2 (Voters and Watchers) and 4.1 (Labels).

We will stop supporting the following plugins:

- From JIRA 6.1, due in the second half of 2013, JIRA will no longer support the "Voters and Watchers" or the "Labels" plugins.

We made this decision in order to reduce our plugin support, to reduce testing time and help us speed up our ability to deliver market-driven features. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

"Voters and Watchers" and "Labels" plugins End of Support Notes:

- JIRA 6.0 will be the last major version of JIRA to officially support the "Voters and Watchers" and "Labels" plugins.
- JIRA 6.0.x and earlier versions should continue to work with the "Voters and Watchers" and "Labels" plugins.
- JIRA 6.1 will not be tested with the "Voters and Watchers" and "Labels" plugins.

Deprecated source control systems for JIRA (8 July 2013)

This section announces the end of Atlassian support for CVS/ViewCVS. At the support end date, all functionality related to CVS/ViewCVS integration will be removed from JIRA. Also, Atlassian will not fix bugs related to CVS/ViewCVS integration past the support end date. Note, this feature was never available in JIRA Cloud.

We will stop supporting the following source control system:

- From JIRA 6.1, due in the second half of 2013, JIRA will no longer include nor support CVS/ViewCVS integration.
We made this decision in order to reduce our source control system support, to reduce testing time and help us speed up our ability to deliver market-driven features. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**CVS/ViewCVS End of Support Notes:**

- JIRA 6.0 will be the last major version of JIRA to officially include and support CVS integration.
- JIRA 6.0.x and earlier versions should continue to work with CVS/ViewCVS.
- CVS/ViewCVS integration is available as an unsupported open source plugin for JIRA 6.1.x and later: [https://bitbucket.org/atlassian/jira-cvs-plugin/overview](https://bitbucket.org/atlassian/jira-cvs-plugin/overview).
- The JIRA CVS plugin has been created from the JIRA source code, so JIRA 6.1.x and later should work with CVS/ViewCVS without any additional setup.
- JIRA 6.1 will not be tested with CVS/ViewCVS.
- If you need an alternative that is supported by Atlassian, Atlassian's FishEye integrates with JIRA and supports CVS repository access.

End of support for characters other than letters, numbers and the underscore in JIRA's project key (13 May 2013, updated 6 August 2013)

This section announces the end of support for characters other than letters, numbers and the underscore in JIRA's project key in downloadable JIRA. Note, project key configuration was never allowed in JIRA Cloud.

**From JIRA 6.1, due in the second half of 2013, we will only support customized project keys that meet all of the conditions specified below:**

- Only letters, numbers or the underscore character can be used.
- The first character must be a letter from the Modern Roman Alphabet. All other letter characters in the key must also be from the Modern Roman Alphabet.
- The first and all other letter characters must be in upper case.

Examples of supported keys: PRODUCT_2013; R2D2; MY_EXAMPLE_PROJECT.

Examples of unsupported keys: 2013PROJECT (first character is not a letter); PRODUCT-2012 (hyphens are not supported).

We understand that some customers may be in the position where their current project keys do not meet the above requirements. We want to help these customers migrate to a supported format. To do this, we will implement the highly-voted feature request: Editing Project Keys (JIRA-2703). We have started work on this and should complete it for the JIRA 6.1 release. Please note, we will continue to provide the same level of support for your current customized project keys until this feature has been implemented.

**Why are you only supporting letters, numbers and the underscore character for customized project keys?**

We are only supporting letters, numbers and the underscore character, as supporting every possible character for customized project keys is a challenging task for JIRA plugins, integration with other Atlassian products, as well as core JIRA functionality. Hence, we will only be supporting the most commonly used characters. From your feedback and our research, letters and numbers are commonly used for customized project keys. Also, the underscore is by far the most commonly used separator character, with hyphens a distant second. However, we will not be supporting hyphens as they interfere with the separator that JIRA uses for issue numbers.

**End of support notes:**

- Please note that our previous announcement for the end of project key format configuration in JIRA 6.0 no longer applies. This is largely due to the great feedback provided by you, our customers.
- In JIRA 6.0, we will continue to support customized project keys, however we recommend that customers only use customized project keys if they meet the conditions specified above.
- Classic Boards in JIRA Agile are not compatible with the supported project key format noted above. You must use the default project key format. If you are not using the Classic Boards, you can change to a supported project key format.
Deprecated Java platforms for JIRA (18 January 2013)

This section announces the end of Atlassian support for Java 6 (JRE and JDK 1.6). End of support means that Atlassian will not fix bugs in Java 6 (JRE and JDK 1.6) past the support end date.

We will stop supporting the following Java platform:

- From JIRA 6.0, due towards the middle of 2013, JIRA will no longer support Java 6 (JRE and JDK 1.6).

We are ending support for Java 6 (JRE and JDK 1.6), as Oracle has announced the end of public updates for Java 6: Java SE 6 End of Public Updates Notice. We are committed to helping our customers understand this decision and to assist you in upgrading JIRA, (we recommend the JIRA Installer for the upcoming 6.0 release, which will bundle its own Java 7 environment).

Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

Java 6 (JRE and JDK 1.6) End of Support Notes:

- JIRA 5.2 will be the last major version of JIRA to officially support Java 6 (JRE and JDK 1.6).
- JIRA 5.2.x and earlier versions will continue to work with Java 6 (JRE and JDK 1.6). However, we will not fix bugs affecting Java 6 (JRE and JDK 1.6) past the support end date.
- JIRA 6.0 will not be tested with Java 6 (JRE and JDK 1.6).

End of support for project key format configuration (22 November 2012)

This announcement no longer applies. Please see this announcement regarding project key format customization instead.

Deprecated application servers for JIRA (27 August 2012)

This section announces the end of Atlassian support for project key format configuration in downloadable JIRA (note, project key configuration was never allowed in JIRA Cloud). End of support means that Atlassian will not fix bugs (past the support end date) that occur due to customization of the project key.

- From JIRA 6.0, due in the first half of 2013, JIRA will no longer support project key format configuration.

We are ending support for project key format configuration, as changing the product key format will break JIRA plugins, integration with other Atlassian products, as well as core JIRA functionality. We are committed to helping our customers understand this decision and guiding them back to use the standard project key format.

Deprecated application servers for JIRA (27 August 2012)

This section announces the end of Atlassian support for Tomcat 5.5.x for JIRA WAR. End of support means that Atlassian will not fix bugs in certain application servers past the support end date.

We will stop supporting the following application servers:

- From JIRA 5.2, due towards the end of 2012, JIRA will no longer support Tomcat 5.5.x.

We are ending support for Tomcat 5.5, as the Apache Tomcat team has announced the end of life (EoL) for version 5.5 as the 30th September 2012 (see announcement). We are committed to helping our customers understand this decision and assisting them in migrating to Tomcat 6.0.32 or later, if needed. Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

Tomcat 5.5.x End of Support Notes:

- JIRA 5.1 will be the last major version of JIRA to officially support Tomcat 5.5.x.
- Tomcat 6.0.32 will be supported in JIRA 5.2. We are planning on adding support for Tomcat 7.0.29 in JIRA 5.2.
- JIRA 5.1.x and earlier versions will continue to work with Tomcat 5.5.x. However, we will not fix bugs affecting Tomcat 5.5.x past the support end date.
- JIRA 5.2 will not be tested with Tomcat 5.5.x.

Deprecated databases for JIRA (24 July 2012)

This section announces the end of Atlassian support for certain database versions for JIRA. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will stop supporting the following database versions:

- From JIRA 5.2, due towards the end of 2012, JIRA will no longer support Postgres 8.2.

We are ending support for Postgres 8.2, as the PostgreSQL Global Development Group has already announced that the end of life (EoL) for version 8.2. We are committed to helping our customers understand this decision and to assist you in migrating to a different database, if needed. Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

PostgreSQL End of Support Notes:

- The PostgreSQL Global Development Group's support for PostgreSQL 8.2 ended on December 2011 (see the PostgreSQL versioning policy).
- JIRA 5.1 will be the last major version of JIRA to officially support PostgreSQL 8.2.
- PostgreSQL 8.3 and 8.4 will be supported in JIRA 5.2.
- JIRA 5.1.x and earlier versions will continue to work with PostgreSQL 8.2. However, we will not fix bugs affecting PostgreSQL 8.2 past the support end date.
- JIRA 5.2 will not be tested with PostgreSQL 8.2.

Deprecated web browsers for JIRA (6 April 2011)

This section announces the end of Atlassian support for certain web browsers for JIRA.

We will be ending support for older versions of web browsers as follows:

- JIRA 4.4.x will be the last versions of JIRA to support Internet Explorer 7.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

Internet Explorer 7 End of Support Notes:

- IE7, now 4+ years after its release, has less than 10% of browser market share. Microsoft has released IE8 and recently IE9.
- JIRA 4.4 (due mid 2011) will be the last major version of JIRA to officially support Internet Explorer 7.
- JIRA 4.4.x and earlier versions will continue to work with Internet Explorer 7. However, we will not fix bugs affecting this browser version past the last version of JIRA 4.4.x to be released.

Deprecated databases for JIRA (6 April 2011)

This section announces the end of Atlassian support for certain databases for JIRA.

We will be ending support for older versions of databases as follows:

- JIRA 4.4.x will be the last versions of JIRA to support Oracle 10.1, Oracle 10.2 and MySQL 5.0.
The details are below. Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

Oracle 10.1 & 10.2 End of Support Notes:

- Oracle Premier support for 10.2 ended on July 31, 2010.
- JIRA 4.4 (due mid 2011) will be the last major version of JIRA to officially support Oracle 10.1 and Oracle 10.2.
- JIRA 4.4.x and earlier versions will continue to work with Oracle 10.1 and Oracle 10.2. However, we will not fix bugs affecting Oracle 10.1 and Oracle 10.2 past the last version of JIRA 4.4.x to be released.

MySQL 5.0 End of Support Notes:

- MySQL support for MySQL 5.0 ended on December 31, 2009 (http://www.mysql.com/support/eol-notice.html).
- JIRA 4.4 (due mid 2011) will be the last major version of JIRA to officially support MySQL 5.0.
- JIRA 4.4.x and earlier versions will continue to work with MySQL 5.0. However, we will not fix bugs affecting MySQL 5.0 past the last version of JIRA 4.4.x to be released.

Deprecated web browsers for JIRA (27 September 2010)

This section announces the end of Atlassian support for certain web browsers for JIRA.

We will stop supporting older versions of web browsers as follows:

- From JIRA 4.3, due in Quarter 1 2011, JIRA will no longer support Safari 4 and Firefox 3.0.x.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browsers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safari 4</td>
<td>When JIRA 4.3 releases (due in Quarter 1 2011)</td>
</tr>
<tr>
<td>Firefox 3.0.x</td>
<td>When JIRA 4.3 releases (due in Quarter 1 2011)</td>
</tr>
</tbody>
</table>

- **General End of Support Notes:**
  - JIRA 4.2 (due Quarter 4 2010) will be the last JIRA version to officially support Safari 4 and Firefox 3.0.x.
  - 'Support End Date' means that JIRA 4.2 and previous released versions will continue to work with Safari 4 and Firefox 3.0.x. However, we will not fix bugs affecting these browser versions past the support end date.

- **Firefox End of Support Notes:**
  - The decision to end support for Firefox 3.0.x in JIRA 4.3 was made in line with Mozilla's support strategy, which indicates that Firefox 3.0.x will be maintained with security and stability updates until January 2010.

Deprecated databases for JIRA (13 August 2010)

This section confirms that Atlassian support for DB2 for JIRA ended in JIRA 4.0. End of support means that Atlassian will no longer fix bugs related to DB2.

We do not support the following databases:

- Atlassian ended support for DB2 at the release of JIRA 4.0 (October 2009), with the final support for these platforms in JIRA 3.13.

We made this decision in order to reduce our database support, to reduce testing time and help us
speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in migrating to a supported database, if needed.

Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

- **DB2 End of Support Notes:**
  - 'Support End Date' means that JIRA 3.13 and versions prior to JIRA 3.13 will continue to work with the DB2. However, we will not fix bugs affecting DB2 past the support end date.
  - JIRA 4.0 (released in October 2009) and later versions of JIRA have not been tested with DB2.

**Deprecated application servers for JIRA (27 January 2010)**

This section announces the end of Atlassian support for certain application server platforms for JIRA WAR/EAR. End of support means that Atlassian will not fix bugs in certain application servers past the support end date.

We will stop supporting the following application servers:

- From JIRA 4.1, due late Q1 2010, JIRA will no longer support JBoss application servers.
- From JIRA 4.2, due in Q3 2010, JIRA will no longer support Oracle WebLogic or IBM WebSphere.

We are reducing our application server platform support to reduce the amount of testing time and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assisting them in migrating to Tomcat, our supported Application Server. You have the option of installing the JIRA Standalone version which includes our supported Tomcat application server. For instructions, please see Switching Application Servers to Apache Tomcat.

Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**End of Life Announcement for Application Server Support**

<table>
<thead>
<tr>
<th>Application Servers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>JBoss 4.2.2</td>
<td>When JIRA 4.1 releases, due late Q1 2010</td>
</tr>
<tr>
<td>Oracle WebLogic 9.2</td>
<td>When JIRA 4.2 releases, due Q3 2010</td>
</tr>
<tr>
<td>IBM WebSphere 6.1</td>
<td>When JIRA 4.2 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

- **JBoss End of Support Notes:**
  - 'Support End Date' means that JIRA 4.0 and previous released versions will continue to work with JBoss Application Servers. However, we will not fix bugs affecting JBoss application servers.
  - JIRA 4.1 will not support JBoss application servers.

- **WebSphere and WebLogic End of Support Notes:**
  - Atlassian is targeting a support end of life for Oracle WebLogic and IBM WebSphere in Q3 2010, with the final support for these platforms in JIRA 4.1.
  - 'Support End Date' means that JIRA 4.1 and previous released versions will continue to work with the stated application servers. However, we will not fix bugs affecting Oracle WebLogic and IBM WebSphere application servers past the support end date.
  - JIRA 4.2 (due to release in Q3 2010) will only be tested with and support Tomcat 5.5 and 6.0.
  - If you have concerns with this end of support announcement, please email eol-announce ment at atlassian dot com.

Why is Atlassian doing this?

Atlassian is committed to delivering improvements and bug fixes as fast as possible. We are also
committed to providing world class support for all the platforms our customers run our software on. However, as the complexity of our applications grows, the cost of supporting multiple platforms increases exponentially. Each new feature has to be tested on several combinations of application servers, with setup and ongoing maintenance of automated tests. At times, 30% of the development team is busy coding solutions for edge cases in various application servers. Moving forward, we want to reduce the time spent there in order to increase JIRA development speed significantly.

We have chosen to standardise on Tomcat, because it is the most widely used application server in our user population. It is fast, robust, secure, well-documented, easy to operate, open source, and has a huge community driving improvements. It is the de facto industry standard, with several companies available that specialise in providing enterprise grade support contracts for it, ranging from customizations to 24/7 support.

Deprecated Java platforms for JIRA (27 January 2010)

This section announces the end of Atlassian support for certain Java Platforms for JIRA.

We will stop supporting the following Java Platforms:

- From JIRA 4.2, due Q3 2010, support for Java Platform 5 (JDK/JRE 1.5) will end.

We are ending support for Java Platform 5, in line with Sun's Java SE Support Road Map (i.e. "End of Service Life" for Java Platform 5 dated October 30, 2009). We are committed to helping our customers understand this decision and assisting them in updating to Java Platform 6, our supported Java Platform.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Java Platform Support

<table>
<thead>
<tr>
<th>Java Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Platform 5 (JDK/JRE 1.5)</td>
<td>When JIRA 4.2 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

- Java Platform 5 End of Support Notes:
  - Atlassian intends to end support for Java Platform 5 in Q3 2010.
  - 'Support End Date' means that JIRA 4.1.x and previous released versions will continue to work with Java Platform 5 (JDK/JRE 1.5). However, we will not fix bugs related to Java Platform 5 past the support end date.
  - JIRA 4.2 (due to release in Q3 2010) will only be tested with and support Java Platform 6 (JDK/JRE 1.6).
  - If you have concerns with this end of support announcement, please email eol-announcement at atlassian dot com.

 Deprecated web browsers for JIRA (11 December 2009)

This section announces the end of Atlassian support for certain web browsers for JIRA.

We will stop supporting older versions of web browsers as follows:

- JIRA 4.1 will be the last version of JIRA to support IE6. (From JIRA 4.0 to JIRA 4.1, all of the main functionality will work in IE 6. However, some of the visual effects will be missing.)

The details are below. Please refer to the Supported Platforms for more details regarding platform support for JIRA. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browsers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Internet Explorer 6 End of Support Notes:
- JIRA 4.1 (due late Q1 2010) will be the last version to officially support Internet Explorer 6.
- JIRA 4.2 is currently targeted to release Q3 2010 and will **not** support IE6.
- This decision was made in line with Microsoft's **Support Lifecycle policy**, which indicates the official end of support for Internet Explorer 6 on 13th July, 2010. Please note that released versions of JIRA up to and including JIRA 4.1 will continue working with IE6 just as they did before, but we will not fix bugs affecting Internet Explorer 6.
- You may be able to use Internet Explorer 6 for the most common use cases like viewing and editing content in JIRA 4.1 and earlier, but official support for this browser will end once you upgrade to JIRA 4.2.

Caveats in using Firefox 3.6.0 with JIRA

Overview

A **bug in Firefox 3.6.0** results in this browser version failing to submit form data to JIRA, resulting in data loss. For more information about this bug, please refer to the following links:

- Mozilla forum support posting
- Bug report in JIRA describing the symptoms
- Mozilla's own bug report

Symptoms

If you spend more than 5 minutes either creating or editing an issue in Firefox 3.6.0 and then attempt to submit the issue, you may lose all the data that you just entered or modified and the data changes will not be saved to JIRA. This Firefox 3.6.0 bug may also affect other JIRA screens on which form data has been left for more than 5 minutes.

This Firefox bug will affect you if the following points are true

- You are running Firefox 3.6.0 on Windows or Linux
- **AND**
- Your Firefox browser’s proxy settings have been set to any of the following options:
  - 'Auto-detect proxy settings for this network'
  - 'Manual proxy configuration'
  - 'Automatic proxy configuration URL'

Proxy server configurations for web browsers are typically required in networks where Internet access is monitored or controlled, such as some corporate environments. Your organisation may **require** that your web browser be configured through a proxy server for Internet access.

How can I prevent this bug affecting me?

**If you are using Firefox 3.6.0, there are two ways you can avoid this bug:**

1. Ensure Firefox's proxy settings have been set to 'No proxy'. (See below for details.)

2. Upgrade Firefox to version 3.6.2.

   Firefox did not officially release a '3.6.1' version.

To determine Firefox’s current proxy settings:

1. Click the **Tools** menu in Firefox and then the **Options** menu item, which opens the 'Options' dialog box.
2. Click **Advanced** and then select the **Network** tab.
3. Click the **Settings** button, which opens the 'Connection Settings' dialog box.
   - If 'No proxy' is selected in the 'Connection Settings' dialog box, then you do not need to take any
further action.

- If any of the other options (listed above) are selected, your network administrator may require that your web browser be configured through a proxy server for Internet access. Please consult your network administrator about this issue before making any further changes to these settings.

4. Click the 'Cancel' buttons to close the Firefox dialog boxes.

To set Firefox's proxy setting to 'No proxy':

1. Open Firefox's 'Connection Settings' dialog box (as described above).
2. Select the 'No proxy' option and click the 'OK' button.

Installing JIRA

Use this Installation Guide if you are installing JIRA for the first time. If you are upgrading JIRA, please refer to the Upgrade Guide.

Installing JIRA

To install JIRA, follow the instructions for your operating system:

- Installing JIRA on Windows
- Installing JIRA on Linux
- Installing JIRA on Solaris

Each of the instructions above install 'recommended' distributions of JIRA. Another JIRA distribution known as 'JIRA WAR' is also available for more advanced setups that require the building and deployment of JIRA to a separate application server installation. To install the JIRA WAR distribution, see Installing JIRA WAR.

Installing JIRA on Windows

This guide describes how to install a new JIRA installation on Windows using the automated 'Windows Installer'. If you are upgrading JIRA, please refer to the Upgrading JIRA guide.

You can also install JIRA from a 'zip' archive — see Installing JIRA from an Archive File on Windows, Linux or Solaris for details. This is useful if you want JIRA to use a pre-existing supported Java platform, since the Windows Installer installs its own JRE to run JIRA.

Please Note: Some anti-virus or other Internet security tools may interfere with the JIRA installation process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the JIRA installation.

There are two ways to install JIRA using the Windows Installer:

- Using the Installation Wizard
- Performing an Unattended Installation

On this page:

- Using the Installation Wizard
  1. Download and Run the JIRA 'Windows Installer'
  2. Starting JIRA
  3. Run the Setup Wizard
  4. Next Steps
- Performing an Unattended Installation
  - Download and Run the JIRA 'Windows Installer' in Unattended Mode

Using the Installation Wizard

Use the installation wizard if you are installing JIRA on your server for the first time or you wish to specify your installation options.

If you have previously installed JIRA using the installation wizard and wish to re-install JIRA again with the same installation options, you can re-install JIRA in 'unattended mode' without any user input required (see below for
1. Download and Run the JIRA 'Windows Installer'

To install JIRA as a service, the Windows Installer must be run using a Windows administrator account. While you can run the Windows Installer with a non-administrator account, your installation options will be much more limited.

1. Download the JIRA 'Windows Installer' (.exe) file from the JIRA Download page.
2. Run the '.exe' file to start the installation wizard.
   - If a Windows 7 (or Vista) 'User Account Control' dialog box requests if you want to allow the installation wizard to make changes to your computer, specify 'Yes'. If you do not, the installation wizard will have restricted access to your operating system and any subsequent installation options will be limited.
3. At the 'Upgrading JIRA?' step, choose between the 'Express Install' or 'Custom Install' options:
   - **Express Install** — If you choose this option, JIRA will be installed with default settings which are shown in the next step of the installation wizard. If you want to customize any of these options, click the 'Back' button and choose the 'Custom Install' option instead.
   - **Custom Install** — If you choose this option, JIRA will prompt you to specify the following options (which are presented during subsequent steps of the installation wizard and pre-populated with default values):
     - The 'Destination Directory' in which to install JIRA.
     - The JIRA Home directory (which must be unique for each JIRA installation).
     - The Windows 'Start' menu folder options.
     - The TCP ports (i.e. an HTTP and a Control port) that JIRA will run through.
   - If you are running the installer using an administrator account, you will be prompted to 'Install JIRA as a service' (recommended). You can also do this manually later, as described in Running JIRA as a Service.

   - If you installed JIRA as a service, you must start JIRA through the Windows 'Start' menu, since JIRA will not start if you run `start-jira.bat` at the Windows Command Prompt.
4. The installation wizard will install JIRA onto your operating system and will start JIRA automatically when the wizard finishes. JIRA will also be launched automatically in your browser window if you chose this option.

Please Note:

- If you chose to install JIRA as a service, the JIRA service will be run as the Windows 'SYSTEM' user account. To change this user account, see Changing the Windows user that the JIRA service uses.
- If you do not install JIRA as a service, then once started, JIRA will be run as the Windows user account under which JIRA was installed.
- If you use JIRA running on a Windows Server in production, we strongly recommend creating a dedicated user account (e.g. with username 'jira') for running JIRA.
  - For more information about creating a dedicated user account and defining which directories this account should have write access to, refer to our guidelines.
  - If your Windows Server is operating under a Microsoft Active Directory, ask your Active Directory administrator to create a dedicated user account that you can use to run JIRA (with no prior privileges).
- If JIRA is installed as a service, do not forget to change the user account that runs the JIRA service to your dedicated user account for running JIRA.

2. Starting JIRA

If JIRA is not already started, you can start JIRA using the appropriate Windows 'Start' menu shortcut or command prompt option.

Once JIRA is started, you can access JIRA from the appropriate Windows 'Start' menu shortcut or a browser on any computer with network access to your JIRA server.

2.1 Windows 'Start' Menu Shortcuts

The Installer will have created the following Windows 'Start' menu shortcuts:

- **Access JIRA** — opens a web browser window to access your JIRA application.
Your JIRA server must have been started for this shortcut to work.

- **Start JIRA Server** — starts up the Apache Tomcat application server which runs your JIRA installation, so that you can access JIRA through your web browser.
- **Stop JIRA Server** — stops the Apache Tomcat application server which runs your JIRA installation. You will not be able to access JIRA through your web browser after choosing this shortcut.
- **Uninstall JIRA** — uninstalls JIRA from your Windows operating system.

### 2.2 Starting and Stopping JIRA from a Command Prompt

Enter the `bin` subdirectory of your JIRA installation directory and run the appropriate file:

- `start-jira.bat` (to start JIRA)
- `stop-jira.bat` (to stop JIRA)

If you followed our guidelines for running JIRA with a dedicated user account, then to run JIRA as this user account (e.g. 'jira'), use the `runas` command to execute `start-jira.bat`. For example:

```
> runas /env /user:<DOMAIN>\jira start-jira.bat
```

(where `<DOMAIN>` is your Windows domain or computer name.)

### 2.3 Accessing JIRA from a Browser

You can access JIRA from any computer with network access to your JIRA server by opening a supported web browser on the computer and visiting this URL:

```
http://<computer_name_or_IP_address>:<HTTP_port_number>
```

where:

- `<computer_name_or_IP_address>` is the name or IP address of the computer on which JIRA is installed and
- `<HTTP_port_number>` is the HTTP port number specified when you installed JIRA (above).

If JIRA does not appear in your web browser, you may need to change the port that JIRA runs on.

### 3. Run the Setup Wizard

See **Running the Setup Wizard**.

### 4. Next Steps

- See **JIRA 101** to start creating Projects, creating Users, and customizing your JIRA instance.
- If you did not install JIRA as a service, you will need to **start JIRA manually** every time you restart your computer. To change your JIRA installation to run as a service, please see **Running JIRA as a Service**.
- To get the most out of JIRA, please see **Optimizing Performance**.

### Performing an Unattended Installation

If you have previously installed JIRA using the installation wizard (above), you can use a configuration file from this JIRA installation (called `response.varfile`) to re-install 'unattended mode' without any user input required.

Installing JIRA in unattended mode saves you time if your previous JIRA installation was used for testing purposes and you need to install JIRA on multiple server machines based on the same configuration.

**Please Note:**

- The `response.varfile` file contains the options specified during the installation wizard steps of your previous JIRA installation. Hence, do not uninstall your previous JIRA installation just yet.
- If you intend to modify the `response.varfile` file, please ensure all directory paths specified are absolute, for example, `sys.installationDir=C:\Program Files\Atlassian\JIRA`. Unattended installations will fail if any relative directory paths have been specified in this file.

Download and Run the JIRA 'Windows Installer' in Unattended Mode

---

*Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
1. Download the **JIRA 'Windows Installer'** (.exe) file from the **JIRA Download Center** to a suitable location.
2. Open the Windows command prompt and perform the remaining steps in the command prompt.
3. Copy the `response.varfile` file located in the `.install4j` subdirectory of your previous JIRA installation directory, to the same location as the downloaded 'Windows Installer' file.
   
   **Tip:** You can uninstall your previous JIRA installation after this step. Save your `response.varfile` if you need to install JIRA on multiple machines.
4. Change directory (cd) to the location of the 'Windows Installer' file and run the following command:

   ```
   atlassian-jira-X.Y.exe -q -varfile response.varfile
   ```

   Where:
   - X.Y — refers to the version of JIRA you are about to install.
   - -q — instructs the installer to operate in unattended mode (i.e. 'quietly').
   - -varfile response.varfile — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the `-varfile` option.

5. JIRA will start automatically when the silent installation finishes. Continue from step 2 **Starting JIRA** (above).

### Uninstalling JIRA from Windows

This page describes the procedure for uninstalling JIRA, which had been installed using the **Windows Installer**.

**Tip:** If you wish to re-install JIRA in 'unattended mode', do not uninstall your previous installation of JIRA just yet. See **Using the Silent Installation Feature** for more information.

### To uninstall JIRA from Windows:

1. Log in to Windows as the same user that was used to install JIRA with the **Windows Installer**.
2. Start the uninstaller by doing either of the following:
   - Click the Windows 'Start' menu -> 'All Programs' -> JIRA X.Y -> 'Uninstall JIRA X.Y' (where 'X.Y' refers to the installed version of JIRA that you are about to uninstall)
   - OR
   - Open the Windows Control Panel, choose 'Add or Remove Programs' (on Windows XP) or 'Programs and Features' on (Windows 7/Vista) and then uninstall 'JIRA X.Y' from the list of applications
   - OR
   - Open the Windows command prompt and do the following:
     a. Change directory `cd` to your JIRA installation directory
     b. Run the `uninstall.exe` file
3. Follow the prompts to uninstall JIRA from your computer.

**Please note:**
- The uninstaller will not delete the JIRA Home Directory.
- All log files that were generated while JIRA was running will not be deleted.
- All files within the JIRA Installation Directory will be deleted (with the exception of the Tomcat log folder located in the JIRA Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the `-q` option at the Windows command prompt — i.e. `uninstall.exe -q`

### Installing JIRA on Linux

This guide describes how to install a new JIRA installation on Linux using the automated 'Linux Installer'. If you are upgrading JIRA, please refer to the **Upgrading JIRA** guide.

**Tip:** You can also install JIRA from a 'zip' archive — see Installing JIRA from an Archive File on Windows, Linux or Solaris for details. This is useful if you want JIRA to use a pre-existing supported Java platform, since the Linux Installer installs its own JRE to run JIRA.

It is possible that any anti-virus or other Internet security tools installed on your Linux operating system may interfere with the JIRA installation process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the JIRA installation.
There are two ways to install JIRA using the Linux Installer:

- Using the Console Wizard
- Performing an Unattended Installation

On this page:
- Using the Console Wizard
  1. Download and Install the JIRA 'Linux Installer'
  2. Start JIRA
  3. Run the Setup Wizard
  4. Next Steps
- Performing an Unattended Installation
  - Download and Run the JIRA 'Linux Installer' in Unattended Mode

Using the Console Wizard

Use the console wizard if you are installing JIRA on your server for the first time or you wish to specify your installation options.

If you have previously installed JIRA using the installation wizard and wish to re-install JIRA again with the same installation options, you can re-install JIRA in 'unattended mode' without any user input required (see below for details).

1. Download and Install the JIRA 'Linux Installer'

   If you execute the Linux Installer with 'root' user privileges, the installer will create and run JIRA using a dedicated user account. You can also execute the Linux Installer without 'root' user privileges, although your installation options will be much more limited and a dedicated user account (to run JIRA) will not be created. To run JIRA as a service, the Linux Installer must be executed with 'root' user privileges.

   1. Download the appropriate JIRA 'Linux 64-bit / 32-bit Installer' (.bin) file from the JIRA Download page.

      • To access the 32-bit installer, you may need to click the 'Show all' link on the 'JIRA Download' page to access the other installation packages.
      • The difference between the 64-bit / 32-bit .bin installers relates to their bundled Java platforms that run JIRA. Bear in mind that a JIRA installation installed using the 64-bit installer may require additional memory (to run at a similar level of performance) to a JIRA installation installed using the 32-bit installer. This is because a 64-bit Java platform's object references are twice the size as those for a 32-bit Java platform.

   2. Open a Linux console and change directory (cd) to the '.bin' file's directory.

   3. Execute the '.bin' file to start the console wizard.

2. Open a Linux console and change directory (cd) to the '.bin' file's directory.

   If the '.bin' file is not executable after downloading it, make it executable, for example:

   chmod a+x atlassian-jira-X.Y.bin

   (where X.Y represents your version of JIRA)

3. Execute the '.bin' file to start the console wizard.

4. When prompted to choose between 'Express Install', 'Custom Install' or 'Upgrade an existing JIRA installation', choose either the 'Express Install' or 'Custom Install' options:

   - Express Install—If you choose this option, JIRA will be installed with default settings which are shown in the next step of the console wizard.

      Please Note:
      - If you are running the installer with 'root' user privileges, JIRA will be installed as a service.
      - If you want to customize any of these options:
        i. Enter 'e' to exit the console wizard.
        ii. Execute the console wizard again (step 3 above).
        iii. Choose the 'Custom Install' option instead.

   - Custom Install — If you choose this option, JIRA will prompt you to specify the following options (which are presented during subsequent steps of the console wizard and pre-populated with default values):

     • The 'Destination Directory' in which to install JIRA.
     • The JIRA Home directory (which must be unique for each JIRA installation).
5. The console wizard will install JIRA onto your operating system and will start JIRA automatically when the wizard finishes.

Please Note:

- If you executed the Linux Installer with 'root' user privileges, the Linux Installer creates a dedicated Linux user account with username 'jira' and no password, which is used to run JIRA. This account has only:
  - Full write access to your JIRA Home Directory.
  - Limited write access to your JIRA Installation Directory.
- The bundled installer expects the 'root' user to have the default umask (0022 or 002), if this is not set it can cause problems with the install as per JIRA-32435 - JIRA Linux Installer does not set files with correct permissions when a non-default umask is used.
- If you executed the Linux Installer without 'root' user privileges, be aware that JIRA can still be run with 'root' privileges. However, to protect the security of your operating system, this is not recommended.
- Depending on how big the JIRA instance may become, you may need to increase the maximum number of files available on the operating system. This is further covered in our Loss of Functionality due to Too Many Open Files Error KB - please review it for further information.

2. Start JIRA

If JIRA is not already started, you can start JIRA using the appropriate command at the Linux console.

Once JIRA is started, you can access JIRA from a browser on any computer with network access to your JIRA server.

2.1 Starting and Stopping JIRA manually

If JIRA was installed as a user with 'root' privileges, use the JIRA service in the Linux console. These commands will need to be executed as a user with 'root' privileges.

- service jira start (to start JIRA)
- service jira stop (to stop JIRA)

If JIRA was not installed as a user with 'root' privileges, in the Linux console, enter the bin subdirectory of your JIRA installation directory and execute the appropriate file:

If the below commands are used as a user with 'root' privileges, and JIRA was installed as another user (for example jira) it can cause permissions problems as detailed in JIRA Generates a FileNotFoundException due to Permission denied.

- start-jira.sh (to start JIRA)
- stop-jira.sh (to stop JIRA)

JIRA will be ready to access (from a browser window) when the following message appears in the application's log file:

******************************************************
... You can now access JIRA through your web browser.
******************************************************

2.2 Accessing JIRA from a Browser

You can access JIRA from any computer with network access to your JIRA server by opening a supported web browser on the computer and visiting this URL:

- http://<computer_name_or_IP_address>:<HTTP_port_number>
where:

- `<computer_name_or_IP_address>` is the name or IP address of the computer on which JIRA is installed and
- `<HTTP_port_number>` is the HTTP port number specified when you installed JIRA (above).

**Please Note:**
- If JIRA does not appear, you may need to change the port that JIRA runs on.
- Application server logs (i.e. for Apache Tomcat) will be written to the `logs/catalina-YYYY-MM-DD.log` file within the JIRA Installation Directory.

3. Run the Setup Wizard

See Running the Setup Wizard.

4. Next Steps

- See JIRA 101 to start creating Projects, creating Users, and customizing your JIRA instance.
- If you did not install JIRA to run as a service, you will need to start JIRA manually every time you restart your computer. To change your JIRA installation to run as a service, please see Starting JIRA Automatically on Linux.
- To get the most out of JIRA, please see Optimizing Performance.

Performing an Unattended Installation

If you have previously installed JIRA using the console wizard (above), you can use a configuration file from this JIRA installation (called `response.varfile`) to re-install JIRA in 'unattended mode' without any user input required.

Installing JIRA in unattended mode saves you time if your previous JIRA installation was used for testing purposes and you need to install JIRA on multiple server machines based on the same configuration.

**Please Note:**
- The `response.varfile` file contains the options specified during the installation wizard steps of your previous JIRA installation. Hence, do not uninstall your previous JIRA installation just yet.
- If you intend to modify the `response.varfile` file, please ensure all directory paths specified are absolute, for example, `sys.installationDir=/opt/atlassian/jira` Unattended installations will fail if any relative directory paths have been specified in this file.

**Download and Run the JIRA 'Linux Installer' in Unattended Mode**

1. Download the JIRA 'Linux Installer' (.bin) file from the JIRA Download Center to a suitable location.
2. Open a Linux console.
3. Copy (`cp`) the file `.install4j/response.varfile` located in your previous JIRA installation directory, to the same location as the downloaded 'Linux Installer' file.
   - You can uninstall your previous JIRA installation after this step. Save your `response.varfile` if you need to install JIRA on multiple machines.
4. Change directory (`cd`) to the location of the 'Linux Installer' file and execute the following command:

   ```
   atlassian-jira-X.Y.bin -q -varfile response.varfile
   ```

   Where:
   - `X.Y` — refers to the version of JIRA you are about to install.
   - `-q` — instructs the installer to operate in unattended mode (i.e. 'quietly').
   - `-varfile response.varfile` — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the `-varfile` option.
5. JIRA will start automatically when the silent installation finishes. Continue from step 2 Starting JIRA (above).
Uninstalling JIRA from Linux

This page describes the procedure for uninstalling JIRA, which had been installed using the Linux Installer.

If you wish to re-install JIRA in 'unattended mode', do not uninstall your previous installation of JIRA just yet. See Using the Silent Installation Feature for more information.

To uninstall JIRA from Linux:

1. Open a Linux console.
2. Change directory (cd) to your JIRA installation directory. For example:
   ```
   cd /opt/atlassian/jira/
   ```
3. Execute the command `uninstall`
   This command must be executed as the same user account that was used to install JIRA with the Linux Installer.
4. Follow the prompts to uninstall JIRA from your computer.

Please note:

- The uninstaller will not delete the JIRA Home Directory.
- All log files that were generated while JIRA was running will not be deleted.
- All files within the JIRA Installation Directory will be deleted (with the exception of the Tomcat log folder located in the JIRA Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the `--q` option — i.e. `uninstall --q`

Installing JIRA from an Archive File on Windows, Linux or Solaris

To install JIRA on Windows from a 'zip' archive file or Linux/Solaris from a 'tar.gz' archive file, follow the instructions on this page.

Before you begin

Please ensure that you have installed Java and set JAVA_HOME. Also refer to the Supported Platforms page for details about which Java (as well as other) platforms are supported by JIRA.

Linux distributions frequently have an open-source implementation of Java called GCJ installed. Do not use this Java platform — it is incomplete and JIRA will not run successfully on it.

On this page:

- Before you begin
- 1. Download and Extract the JIRA Archive File
- 2. Set the JIRA Home Directory in JIRA
- 3. Create a Dedicated User Account on the Operating System to Run JIRA
- 4. Start JIRA
- 5. Run the Setup Wizard
- Next Steps

1. Download and Extract the JIRA Archive File

1. Download the appropriate JIRA archive file for your operating system ('zip' for Windows or 'tar.gz' for Linux/Solaris), from the JIRA Download page.
   After selecting the appropriate operating system tab on the 'JIRA download' page, you may need to click the 'Show all' link to access the required installation package.
2. Extract the downloaded file.
   On Windows, we recommend using a file extraction tool such as 7-Zip.
   On Solaris, use GNU tar to extract JIRA instead of the Solaris' default tar utility as GNU tar handles long filenames better.
2. Set the JIRA Home Directory in JIRA

To set this, do one of the following:

- **Edit the `jira-application.properties` file and set the value of the 'jira.home' property to the desired location for your JIRA Home Directory (this location should be something different than the application directory, or you may run into problems later). If you are specifying this location's path on Windows, use double backslashes ("\") between subdirectories. For example, `X:\path\to\JIRA\Home`.
  - If you define an UNC path in Microsoft Windows, be sure to double escape the leading backslash: `\\machinename\path\to\JIRA\home`
  - See the JIRA Installation Directory page to find where this file is located.

- **Set an environment variable named `JIRA_HOME` in your operating system whose value is the location of your JIRA Home Directory. To do this:**
  - On Windows, do one of the following:
    - Configure this environment variable through the Windows user interface (typically through 'My Computer' or 'Computer')
    - At the command prompt, enter the following command (with your own JIRA Home path) before running JIRA from the command prompt:
      ```
      set JIRA_HOME=X:\path\to\JIRA\Home
      ```
      Please set your `JIRA_HOME` environment variable value using this format, where:
      - `X` is the drive letter where your JIRA Home Directory is located and
      - no spacing has been added around the equal sign (=)
    - Specify the command above in a batch file used to start JIRA.
  - On Linux/Solaris, do one of the following:
    - Enter the following command at a shell/console prompt (with your own JIRA Home path) before running JIRA:
      ```
      export JIRA_HOME=/path/to/jira/home
      ```
    - Specify the command above in a script used to start JIRA.

You can specify any location on a disk for your JIRA home directory. Please be sure to specify an absolute path.

Please note that you cannot use the same JIRA home directory for multiple instances of JIRA. We recommend locating your JIRA Home Directory completely independently of the JIRA Installation Directory (i.e. not nesting one within the other) as this will minimize information being lost during major operations (e.g. backing up and restoring instances).

3. Create a Dedicated User Account on the Operating System to Run JIRA

This step is optional if you are evaluating JIRA but should be mandatory for JIRA installations used in production.

A dedicated user should be created to run JIRA, as JIRA runs as the user it is invoked under and therefore can potentially be abused. For example:

- If your operating system is *nix-based (for example, Linux or Solaris), type the following in a console:
  ```
  $ sudo /usr/sbin/useradd --create-home --comment "Account for running JIRA" --shell /bin/bash jira
  ```
- If your operating system is Windows:
  1. Create the dedicated user account by either:
     - Typing the following at the Windows command line:
       ```
       > net user jira mypassword /add /comment:"Account for running JIRA"
       ```
       (This creates a user account with user name 'jira' and password 'mypassword'. You should choose your own password.)
     - Opening the Windows 'Computer Management' console to add your 'jira' user with its own password.
  2. *(Optional)* Use the Windows 'Computer Management' console to remove the 'jira' user's membership of all unnecessary Windows groups, such as the default 'Users' group.
  - If Windows is operating under a Microsoft Active Directory, ask your Active Directory administrator to create your 'jira' account (with no prior privileges).
Ensure that only the following directories can be written to by this dedicated user account (e.g. 'jira'):

- The following subdirectories of your JIRA Installation Directory for 'recommended' JIRA distributions (or for JIRA WAR distributions, the installation directory of the Apache Tomcat application running JIRA):
  - logs
  - temp
  - work
- Your JIRA Home Directory.

⚠️ Do not make the JIRA Installation Directory itself writeable by the dedicated user account.

ℹ️ See also Tomcat security best practices.

4. Start JIRA

Enter the bin subdirectory of your JIRA installation directory and execute the appropriate file to start running JIRA:

- start-jira.sh (on Linux/Solaris)
- start-jira.bat (on Windows)

ℹ️ To run JIRA as the dedicated user account (e.g. 'jira') created above:

- On Windows, use the runas command to run start-jira.bat. For example, runas /env /user:<DOMAIN>\jira start-jira.bat (where <DOMAIN> is your Windows domain or computer name.)
- On Linux, switch to the 'jira' account using the su command before running start-jira.sh (or use su to run start-jira.sh as the 'jira' account).

Wait until the following message appears in the application's log file:

```
******************************************************
... You can now access JIRA through your web browser.
******************************************************
```

You can access JIRA from any computer with network access to your JIRA server by opening a supported web browser on the computer and visiting this URL:

- http://<computer_name_or_IP_address>:<HTTP_port_number>

where:

- <computer_name_or_IP_address> is the name or IP address of the computer on which JIRA is installed and
- <HTTP_port_number> is the HTTP port number (8080 by default).

ℹ️ If JIRA does not appear in your web browser, you may need to change the port that JIRA runs on.

ℹ️ Logs will be written to logs/catalina.out.

If something goes wrong, please verify that Java is installed correctly. If the problem persists, please contact us — we’re happy to help.

5. Run the Setup Wizard

See Running the Setup Wizard.

Next Steps

- See JIRA 101 to start creating Projects, creating Users, and customizing your JIRA instance.
- If you like to set up JIRA to start automatically every time you restart your computer, please see Starting
JIRA Automatically on Linux or Running JIRA as a Service (for Windows).
- By default, JIRA installed from an archive uses the standard Tomcat port (i.e. 8080). If you need another application to run on that port, either now or in the future, please see Changing JIRA's TCP Ports.
- To get the most out of JIRA, please see Optimizing Performance.

Installing JIRA WAR

Atlassian will stop releasing the WAR distribution of JIRA in JIRA 7.0.

What is the JIRA WAR distribution?

JIRA is available in two types of *distributions*:
- ‘Recommended’ distributions (which include JIRA installations using the ‘Windows Installer’, ‘Linux Installer’ or from an ‘Archive File’)
  AND
- The ‘WAR’ distribution for advanced or highly configured JIRA installations.

<table>
<thead>
<tr>
<th>Recommended distributions</th>
<th>WAR distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require minimal setup</td>
<td>Requires manual configuration</td>
</tr>
<tr>
<td>Pre-packaged with the Apache Tomcat</td>
<td>Requires building and deployment to an existing application server installation</td>
</tr>
<tr>
<td>application server</td>
<td></td>
</tr>
<tr>
<td>Include the JIRA Configuration Tool</td>
<td>Does not include the JIRA Configuration Tool</td>
</tr>
<tr>
<td>Recommended for all users</td>
<td>Suitable only for system administrators</td>
</tr>
</tbody>
</table>

We recommend installing the ‘recommended’ distributions of JIRA over the WAR distribution — even for organisations with an existing application server environment.

To install a recommended distribution of JIRA, see Installing JIRA.

Installing JIRA WAR

To install JIRA WAR, follow the instructions for your application server:
- Installing JIRA on Tomcat 6.0 or 7.0

Additional Notes
- Read the JIRA WAR Configuration Overview. This contains important configuration information, regardless of your application server.
- Read Switching Application Servers to Apache Tomcat if you are currently running JIRA on a non-Tomcat application server. Please be aware of JIRA’s Supported Platforms page, which indicates what application servers are supported by JIRA.
- Also be aware that we do not recommend Deploying Multiple Atlassian Applications in a Single Tomcat Container.

JIRA WAR Configuration Overview

While the individual server install guides provide specific instructions, it is useful to have an overall conceptual overview of what the configuration process involves.

*Webapp layout*

After downloading and extracting the JIRA WAR web application archive, your are presented with a directory containing:
Directories are indicated by an appending slash symbol.

**Please be aware:** The `build.xml` file is an Ant file, which when invoked with the `build.sh`/`build.bat` script, will construct deployable web application archive (.war) files (for supported application servers). The `build.xml` file copies the contents of the `webapp` subdirectory of your JIRA Installation Directory and overwrites it with the contents of the sibling `edit-webapp` directory, when constructing its .war files. Thus, unless otherwise requested, never edit files within this `webapp` directory!

If a file needs editing, first copy it from `webapp/path/to/file` to `edit-webapp/path/to/file` subdirectories of your JIRA Installation Directory and edit it in the latter location.

**Database Configuration**

If you are setting up a new installation of JIRA WAR, the JIRA setup wizard will configure a direct JDBC connection to a new JIRA database. Upon completing the setup wizard, your database configuration will be defined and saved into a `dbconfig.xml` file located at the root of your JIRA Home Directory.

If you are upgrading JIRA WAR, please ensure a `dbconfig.xml` file (defining your appropriate database configuration) has been created at the root of your JIRA Home Directory before your new JIRA WAR installation is started. This is ensured if you follow the appropriate manual or migration procedures for upgrading JIRA. For specific database configuration details, refer to the appropriate Configure the database connection manually sections of the specific database connection instructions in the Connecting JIRA to a Database section of this documentation.

**Transaction Manager configuration**

J2EE-based applications also rely on a Transaction Manager to coordinate updates across multiple databases. While JIRA currently does not use this facility, JIRA’s underlying library (OfBiz) still requires a transaction manager object. As with database connections, this is provided by the application server as a `javax.transaction.UserTransaction` object, which is looked up via JNDI.

**Summing Up Database Configuration for JIRA WAR**

Hence, JIRA needs to know at least three things:

1. What type of database JIRA is dealing with.
2. The JNDI address of a Transaction Manager (a `javax.transaction.UserTransaction` object).

Points 1 and 2 are configured in the `entityengine.xml` file, as described in Configuring the Entity Engine for JIRA. An editable copy of the `entityengine.xml` file is located in `edit-webapp/WEB-INF/classes`.

Point 3 is configured in the `dbconfig.xml` file. The content of this file is generated after completing the JIRA setup wizard.

**User management configuration**

JIRA stores all user profiles in a database table. Occasionally, integration with external user management systems like LDAP is required. See The LDAP Integration guide for more information.

Configuring the Entity Engine for JIRA
The Entity Engine from the OFBiz project is what JIRA uses to persist data to a database. You can find out more about why we chose the EE at the bottom of this page. See the configuration overview for a conceptual overview of what is being done here.

On this page:

- Configuring the Entity Engine for JIRA
- Transaction Factory
- Altering the Entity Model
- Why we chose the Entity Engine

Configuring the Entity Engine for JIRA

The configuration of the Entity Engine is done through an XML file called `entityengine.xml`. This file is used to define parameters for persistence servers.

For JIRA WAR distributions, this file is located in the `edit-webapp/WEB-INF/classes/entityengine.xml` subdirectory of the JIRA Installation Directory.

Ensure that your `entityengine.xml` XML file is well-formed when making changes. Some application server configurations may "swallow" the error messages you should get in your log file if `entityengine.xml` is not well-formed and instead, report spurious error messages.

Transaction Factory

By default the Entity Engine tries to obtain a JTA transaction factory from the application server using JNDI. The code sample(s) below show the different values for Apache Tomcat application servers.

Tomcat 5.5:

```
<transaction-factory class="org.ofbiz.core.entity.transaction.JNDIFactory">
    <user-transaction-jndi jndi-server-name="default"
        jndi-name="java:comp/env/UserTransaction"/>
    <transaction-manager-jndi jndi-server-name="default"
        jndi-name="java:comp/env/UserTransaction"/>
</transaction-factory>
```

Altering the Entity Model

The Entity Model describes the table and column layout that JIRA uses in a database. It can be completely altered without changing any of the internal workings of JIRA.

The model provided should work with almost any database (care has been taken to ensure the column and table names are SQL compliant).

The entity model is configured through an XML file called `entitymodel.xml` (located in the `webapp/WEB-INF/classes/entitydefs/entitymodel.xml` subdirectory of JIRA WAR distribution's Installation Directory).

To edit this file, copy it to the `edit-webapp/WEB-INF/classes/entitydefs/entitymodel.xml` subdirectory and make changes there. When the WAR is built using `build.(sh|bat)`, the version of the file in the `edit-webapp` subdirectory will be used.

The format of the file is fairly self explanatory. Essentially, JIRA always refers to the entity-name and field-name attributes within the code. The type attribute of a `<field>` tag should always match the type attribute of a `<field-type-def>` tag in your `fieldtype-*.xml` files.

To change where entities and fields are persisted in your database, simply add or edit the attribute `table-name` (for entities) or `col-name` (for fields).

Why we chose the Entity Engine

We chose the EE over CMP or BMP entity beans because:
• it is more portable between application servers
• table schemas are automatically created and updated
• using the field type definitions, we can add support for new databases very quickly
• it is faster than most CMP implementations and has some nice caching features

This document deals with configuring the entity engine for JIRA (but should be applicable to most applications). For more details on the entity engine itself and it’s inner workings, see:

• OFBiz Entity Engine Guide describes the theory behind the entity engine, its architecture and usage patterns
• OFBiz Entity Engine configuration guide describes all of the entity engine configuration options, whereas this document just describes configuring the entity engine for JIRA

Installing JIRA on Tomcat 6.0 or 7.0
This guide describes how to install the JIRA WAR distribution on Tomcat 6.0 or Tomcat 7.0, a popular open-source server from the Apache project. Tomcat can be downloaded from the Apache site.

JIRA installations which have been installed using the 'Windows Installer', 'Linux Installer' or from an 'Archive File' are pre-configured to use their own dedicated Tomcat application server. To install JIRA using one of these recommended distributions, follow the Installing JIRA guide instead of the instructions below.

Before you begin
Please read the following important notes before you begin installing JIRA on Tomcat 6.0/7.0:

• Tomcat 6.0.24 contains a critical bug. Please use 6.0.32 instead.
• Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).

There are also a number of practical reasons why we do not support deploying multiple Atlassian applications in a single Tomcat container. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

Finally, we recommend not deploying any other applications in the same Tomcat container that runs JIRA, especially if these other applications have large memory requirements or require additional libraries in Tomcat's lib subdirectory.

On this page:

• Before you begin
• 1. Download and extract the JIRA archive
• 2. Configure JIRA
• 3. Update your Tomcat installation’s libraries for JIRA
• 4. Build JIRA
• 5. Configure JIRA’s context in Tomcat
• 6. Modify Tomcat’s server.xml to handle internationalized characters correctly
• 7. Fix memory and mail handling settings in Tomcat
• 8. Start Tomcat
• 9. Run the setup wizard
• Troubleshooting
• User-contributed notes

1. Download and extract the JIRA archive

Download the JIRA WAR distribution archive from the JIRA Download page and extract its contents using a tool such as 7-zip for Windows or Linux's unzip or GNU tar tools.

✔ You may need to click the 'Show All' link on the download page to reveal the WAR distribution.

⚠ Avoid using Windows' built-in file extraction tool! This tool silently fails to extract files with long names
(see JRA-2153). Other users have also reported problems with WinRAR. On Solaris, use GNU tar to extract JIRA instead of the Solaris' default tar utility as GNU tar handles long filenames better.

The extracted directory is hereafter referred to as your JIRA Installation Directory.

A dedicated user should be created to run JIRA, as JIRA runs as the user it is invoked under and therefore can potentially be abused. For example:

- If your operating system is *nix-based (for example, Linux or Solaris), type the following in a console:

  ```
  $ sudo /usr/sbin/useradd --create-home --comment "Account for running JIRA" --shell /bin/bash jira
  ```

- If your operating system is Windows:
  1. Create the dedicated user account by either:
     - Typing the following at the Windows command line:
       ```
       > net user jira mypassword /add /comment:"Account for running JIRA"
       ```
       (This creates a user account with user name 'jira' and password 'mypassword'. You should choose your own password.)
     - Opening the Windows 'Computer Management' console to add your 'jira' user with its own password.
  2. (Optional) Use the Windows 'Computer Management' console to remove the 'jira' user's membership of all unnecessary Windows groups, such as the default 'Users' group.

    如果 Windows is operating under a Microsoft Active Directory, ask your Active Directory administrator to create your 'jira' account (with no prior privileges).

To maximise security, ensure that this user can only write to the logs, temp and work directories of your application server (Apache Tomcat) installation and your JIRA Home Directory.

2. Configure JIRA

2.1 Customizing your JIRA installation directory files

(This section is optional and recommended for experts only.)

2.1.1 How to customize files in your JIRA installation directory

If you wish to customize any files in the `<jira-application-dir>` (i.e. the webapp subdirectory) of your JIRA Installation Directory, please perform them in the sibling edit-webapp subdirectory only.

To edit a file within the webapp subdirectory, first copy it from the webapp/path/to/file subdirectory to the edit-webapp/path/to/file subdirectory of your JIRA Installation Directory and edit it in the latter location.

When building JIRA (below), .war files are constructed based on file contents copied from the webapp subdirectory of your JIRA Installation Directory, which are overwritten by file contents from the sibling edit-webapp directory. Thus, never edit files within this webapp directory!

Be aware that the more files you customize in your JIRA Installation Directory, the more difficult it will be to upgrade JIRA or migrate JIRA to another server, as your customizations will need to be migrated manually over to your new JIRA installation.

2.1.2 Configuring the entityengine.xml file

Ensure that the Transaction Factory has been specified correctly in JIRA's entityengine.xml file. For more information, see Configuring the Entity Engine for JIRA.

- In the entityengine.xml file (located in edit-webapp/WEB-INF/classes/ of the JIRA Installation Directory), ensure the `<transaction-factory>` tag contains:

  ```
  <transaction-factory class="org.ofbiz.core.entity.transaction.JNDIFactory">
      <user-transaction-jndi jndi-server-name="default" jndi-name="java:comp/env/UserTransaction"/>
      <transaction-manager-jndi jndi-server-name="default" jndi-name="java:comp/env/UserTransaction"/>
  </transaction-factory>
  ```

See Configuring the Entity Engine for JIRA for more information about configuring JIRA's database.
2.2 JIRA Home

- Edit the `jira-application.properties` file and set the value of the `'jira.home'` property to the desired location for your JIRA Home Directory (this location should be something different than the application directory, or you may run into problems later). If you are specifying this location's path on Windows, use double backslashes ("\") between subdirectories. For example, `X:\path\to\JIRA\Home`.

  - If you define an UNC path in Microsoft Windows, be sure to double escape the leading backslash: `\\machinename\path\to\JIRA\home`

  - See the JIRA Installation Directory page to find where this file is located.

- Set an environment variable named `JIRA_HOME` in your operating system whose value is the location of your JIRA Home Directory. To do this:
  - On Windows, do one of the following:
    - Configure this environment variable through the Windows user interface (typically through 'My Computer' or 'Computer')
    - At the command prompt, enter the following command (with your own JIRA Home path) before running JIRA from the command prompt:
      ```
      set JIRA_HOME=X:\path\to\JIRA\Home
      ```
      Please set your JIRA_HOME environment variable using this format, where:
      - `X` is the drive letter where your JIRA Home Directory is located and no spacing has been added around the equal sign (`=`)
      - Specify the command above in a batch file used to start JIRA.
  - On Linux/Solaris, do one of the following:
    - Enter the following command at a shell/console prompt (with your own JIRA Home path) before running JIRA:
      ```
      export JIRA_HOME=/path/to/jira/home
      ```
    - Specify the command above in a script used to start JIRA.

You can specify any location on a disk for your JIRA home directory. Please be sure to specify an absolute path.

Please note that you cannot use the same JIRA home directory for multiple instances of JIRA. We recommend locating your JIRA Home Directory completely independently of the JIRA Installation Directory (i.e. not nesting one within the other) as this will minimize information being lost during major operations (e.g. backing up and restoring instances).

For more information about setting up your JIRA Home Directory, please see Setting your JIRA Home Directory.

3. Update your Tomcat installation's libraries for JIRA

3.1 JDBC drivers

Your Tomcat installation requires an appropriate JDBC driver to allow JIRA to communicate with the database. To add this JDBC driver to Tomcat, refer to the appropriate instructions:

- Copy the PostgreSQL JDBC Driver to Tomcat
- Copy the MySQL JDBC Driver to Tomcat
- Copy the Oracle JDBC Driver to Tomcat
- Copy the SQL Server 2005 JDBC Driver to Tomcat
- Copy the SQL Server 2008 JDBC Driver to Tomcat
- Copy the HSQL JDBC Driver to Tomcat

  - If you intend to use the HSQL database, the HSQL JDBC driver is already included with the other JIRA library files that will be added to Tomcat in the following step.

3.2 Other JIRA libraries for Tomcat

Tomcat does not come with some libraries required to run JIRA. To fix this, download the relevant archive depending on your Tomcat version (see below), extract and copy the `.jar` library files from this archive to the `lib` subdirectory of your Tomcat installation directory.

- Tomcat 7 JARs: http://www.atlassian.com/software/jira/downloads/binary/jira-jars-tomcat-distribution-6.4-m12-tomcat-7x.zip

**Please Note:**

- Be sure to remove existing versions of these .jar library files before copying over new ones.
- To prevent exceptions related to logging, please ensure that the following files are present in Tomcat's `lib` directory. Also ensure that these files are not present in the `webapp/WEB-INF/lib` subdirectory of the JIRA Installation Directory. If any of the following files are present in the `webapp/WEB-INF/lib` subdirectory of the JIRA Installation Directory, remove them before building the deployable JIRA WAR file as described in the next step.

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>jcl-over-slf4j-x.y.z.jar</td>
</tr>
<tr>
<td>jul-to-slf4j-x.y.z.jar</td>
</tr>
<tr>
<td>log4j-x.y.z.jar</td>
</tr>
<tr>
<td>slf4j-api-x.y.z.jar</td>
</tr>
<tr>
<td>slf4j-log4j12-x-y-z.jar</td>
</tr>
</tbody>
</table>

4. **Build JIRA**

Now build JIRA by running `build.bat` (Windows) or `./build.sh` (Linux/Solaris) on the command line in the JIRA Installation Directory. This will produce the deployable WAR file in the `dist-tomcat/tomcat-6` subdirectory of the JIRA Installation Directory.

5. **Configure JIRA’s context in Tomcat**

A JIRA 'context' now needs to be set up in Tomcat. To do this, add the below configuration to the Tomcat `server.xml` file. The value of `docBase` will need to be modified to point to the JIRA WAR file.

```
<Context path="/jira" docBase="path/to/atlassian-jira-5.x.war" debug="0"
  useHttpOnly="true">
  <Resource name="UserTransaction" auth="Container"
type="javax.transaction.UserTransaction"
    factory="org.objectweb.jotm.UserTransactionFactory" jotm.timeout="60"/>
  <Manager pathname=""/>
</Context>
```

- If installing JIRA in Windows, make sure that the paths you specify for the location of the WAR file and database are full paths with drive letters (e.g. `C:\path\to\atlassian-jira-5.x.war`).
- If installing on Linux, ensure the path does not use any special characters.

⚠️ These details can also be configured in `conf/Catalina/localhost/jira.xml` (you may need to create the `jira.xml` file if it does not exist) however they cannot be configured in both `server.xml` and `jira.xml` if they are, it will cause significant problems with the JIRA instance.

6. **Modify Tomcat’s `server.xml` to handle internationalized characters correctly**

In order for JIRA to correctly display internationalized characters in user and group names, you need to modify the `conf/server.xml` file in your Tomcat installation directory by specifying the `URIEncoding="UTF-8"` property within the connector definition for your HTTP protocol.

The connector definition is specified by the following element in your `server.xml` file:

```
<Connector port="8080" protocol="HTTP/1.1"
  connectionTimeout="20000"
  redirectPort="8443"URIEncoding="UTF-8" />
```
<Connector port="8080" protocol="HTTP/1.1"
    connectionTimeout="20000"
    redirectPort="8443"/>

You should modify this element by specifying the `URIEncoding="UTF-8"` attribute:

```xml
<Connector port="8080" protocol="HTTP/1.1"
    connectionTimeout="20000"
    redirectPort="8443" URIEncoding="UTF-8"/>
```

**Please Note:**

- Since this property must be specified at the connector level for your application server, this setting will affect all other web applications deployed to the same application server installation running JIRA. While this setting should not adversely affect these other web applications, you should be aware of this point.
- JIRA will run fine without this property set. However, you will run into issues if a user or group is created which contains international characters. Hence, it is recommended that you set this property.

7. **Fix memory and mail handling settings in Tomcat**

Memory and mail handling settings need to be modified in Tomcat to avoid the following issues:

- **Tomcat effectively leaks memory by caching JSPs.** This can result in `OutOfMemoryError` errors if large pages (such as RSS or Excel pages) are requested.
- JIRA requires more memory than what Tomcat provides by default. This may lead to `OutOfMemoryError` errors when running JIRA if these memory settings are not increased.
- For JIRA's mail handler to avoid problems with RFC 2231-compliant mail clients, set the `mail.mime.decodeparameters` startup parameter in Tomcat to `true`.

To prevent these issues, follow the appropriate instructions for your operating system below.

*For Windows*

If Tomcat is not installed as a service:

- Edit Tomcat's `bin/setenv.bat` file (or create this file if it does not exist) and add the following to this file:

  ```batch
  set CATALINA_OPTS=%CATALINA_OPTS%
  -Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER=true
  -Dmail.mime.decodeparameters=true -Xms128m -Xmx512m -XX:MaxPermSize=256m
  ```

If Tomcat is installed and running as a service:

1. Right-click Tomcat's system tray icon and select 'Configure' from the resulting popup menu, which opens the 'Apache Tomcat 6 Properties' dialog box:

2. In this dialog box, click on the 'Java' tab and specify the following values:
## Java Options (append to the existing value)

- `-Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER=true`
- `-Dmail.mime.decodeparameters=true`

### Initial memory pool

128 MB

### Maximum memory pool

512 MB

Your configuration should be similar to the screenshot below:

![Apache Tomcat 6 Properties](image)

For Linux/Solaris

Edit Tomcat's `bin/setenv.sh` file (or create this file if it does not exist) and add the following to this file:

```bash
export CATALINA_OPTS="$CATALINA_OPTS
-Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER=true
-Dmail.mime.decodeparameters=true -Xms128m -Xmx512m -XX:MaxPermSize=256m"
```

For other environments and more information on memory settings, see Increasing JIRA Memory.

### Start Tomcat

(Only required if Tomcat is not running as a service.)

JIRA should now be ready to run in Tomcat. To start up JIRA, start (or restart) the Tomcat server with Tomcat's `bin/startup.sh` or `bin/startup.bat` scripts.

### Run the setup wizard

Point your browser to `http://localhost:8080/jira`

You should now see the Setup Wizard, which will take you through the JIRA's setup procedure, including a configuration step for your database connection.

### Troubleshooting

*Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
It is easy to make a mistake in this process. First, check that you have followed the process described above:

- Have you made changes to `edit-webapp/WEB-INF/classes/entityengine.xml` in your JIRA installation directory (step 2 above) and re-run the build script (step 3 above), but your `entityengine.xml` changes were not picked up? If so, delete the `webapps/jira` subdirectory of your Tomcat installation directory and then restart JIRA. (In some circumstances, Tomcat does not correctly re-expand the web application.)
- If you are using an external database, did you copy the correct JDBC driver jar file to the `lib` subdirectory of your Tomcat installation directory? (Refer to step 4 above.)
- Have you updated your Tomcat installation's libraries for JIRA by copying across the additional jar files downloaded in step 4 above? Check if `objectweb-datasource-x.y.z.jar` is present in the `lib` subdirectory of Tomcat's installation directory.
- Is the path to your built `.war` file within `server.xml` of your Tomcat installation directory correct? (Refer to step 5 above.)
- Have you copied your built `.war` file to Tomcat's `webapps` directory? This is almost guaranteed to cause problems - please move this `.war` file elsewhere and delete any JIRA subdirectories created in Tomcat's `webapps` directory which Tomcat may have created (after Tomcat is initially started).
- Have you configured JIRA's context and other custom settings centrally in Tomcat's `conf/Catalina/localhost/jira.xml` file instead of the `conf/server.xml` file of your Tomcat installation directory? Although this is fine, be sure that you do not also have details in the `server.xml` file present.
- The log files are usually vital to debugging problems. On Windows, these will appear in the console window that loads when running `startup.bat`, or in one of the log files in Tomcat's `logs` directory. On Linux/Solaris, logs will appear in a log file in `logs`, usually `logs/*` (not just `logs/catalina.out`). Check the log file for errors after startup.
- If you experience high memory usage / memory leaks (e.g. OutOfMemoryError), you may wish to set the system property `-Dorg.apache.jasper.runtime.BodyContentImpl.LIMIT_BUFFER=true` in the `setenv.sh` / `setenv.bat` file. For more information please see JIRA-10145. (Refer to step 7 above.)
- If the connection to your database is dropping out (in particular with MySQL), you will need to set up Tomcat to survive connection closures.

**Please be aware:** The `build.xml` file is an Ant file, which when invoked with the `build.sh / build.bat` script, will construct deployable web application archive (.war) files (for supported application servers). The `build.xml` file copies the contents of the `webapp` subdirectory of your JIRA Installation Directory and overwrites it with the contents of the sibling `edit-webapp` directory, when constructing its .war files. Thus, unless otherwise requested, never edit files within this `webapp` directory!

If a file needs editing, first copy it from `webapp/path/to/file` to `edit-webapp/path/to/file` subdirectories of your JIRA Installation Directory and edit it in the latter location.

If you are stuck, then please consider installing one of the 'recommended' distributions of JIRA.

**User-contributed notes**

Do you have experiences to share with Tomcat 6.0.x/7.0.x and JIRA? We welcome your thoughts. Please see the user-contributed Tomcat 6.0.x and 7.0.x notes.

**Tomcat 6.0 notes**

This page has general notes on installing JIRA on Tomcat 6.0.x. It supplements the official Tomcat installation docs.

**Add your notes**

**Switching Application Servers to Apache Tomcat**

To move JIRA from a non-Tomcat application server to Apache Tomcat, use one of the following methods:

**Note**

Regardless of which method you use, back up your data first and make sure you test JIRA on the new server before deploying it in production.

**Method 1. Export and import the database**
Follow the Migrating JIRA to Another Server instructions, installing the new version of JIRA on your new application server.

**Method 2. Use your existing database**

If you are using the same version of JIRA on the old and new (Apache Tomcat) application server, you do not have to export and re-import your JIRA database (as described in the instructions for Migrating JIRA to Another Server). You can use your existing database with the new application server.

However, you cannot simply copy the WAR file or expanded WAR directory from an existing JIRA WAR installation in the old application server to the new application server. **This will not work.**

**To switch to a new (Apache Tomcat) application server, follow these instructions:**

1. Install JIRA on the new application server. (Refer to the instructions for your version of Apache Tomcat in the Installing JIRA WAR section.)
2. Check that the JNDI location of the UserTransaction as declared in the entityengine.xml file is correct for Apache Tomcat.
3. From System Info, check the modified files to see what customisations, if any, exist from the original installation. Consider these changes in your new server.
4. Make sure you shut down the old server before you start up the new one.
5. If you are running the new application server on a different machine to the old one, carry out the following actions as soon as you start the new server:
   - Re-index your data.
   - Make sure that the attachment path is valid for the new server.

**Deploying Multiple Atlassian Applications in a Single Tomcat Container**

Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration:

- You may not be able to start up all of the applications in the container, due to class conflicts (in 3rd party libraries bundled with our application) that result from the Atlassian applications sharing a single JVM in the Tomcat container.
- You will not be able to determine the startup order of the applications. Hence, you may experience problems such as JIRA starting before Crowd, rather than vice versa.
- Memory problems are also common as one application may allocate all of the memory in the Tomcat JVM to itself, starving the other applications.

We also do not support deploying multiple Atlassian applications to a single Tomcat container for a number of practical reasons. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

Finally, we recommend not deploying any other applications to the same Tomcat container that runs the Atlassian application, especially if these other applications have large memory requirements or require additional libraries in Tomcat's lib subdirectory.

**Installing JIRA Data Center**

**Before you start:**

Before you install JIRA Data Center, please review this pre-requisite information:

- Understand how JIRA Data Center works.
- Understand the node requirements:
  - Each JIRA node must run on its own machine (physical or virtual), with a separate machine for the shared services. The shared services machine must be accessible by each node.
  - Normal JIRA supported platforms and requirements apply to each node.
  - Each node does not need to be identical, but for consistent performance we recommend they are as close as possible.
  - Nodes must run the exact same JIRA version and must be located in the same data center.
  - Nodes must be configured with the same timezone and keep...
the current time synchronized. Using ntpd or some similar service is a good way to arrange this.

- Install and configure a load balancer of your choice:
  - The load balancer must support "cookie based session affinity."

You can optionally cluster the load balancer, database, and shared file systems.

After you install JIRA Data Center or add a new node to your environment, use the health check tools to check that your instance is configured and operating correctly.

Installing JIRA Data Center

This illustration shows the general method of installing a JIRA clustered instance:

![Diagram of JIRA Data Center setup]

This install guide assumes that you already have a JIRA instance, already have a load balancer, and are able to set up a network file share system.

Before upgrading from an earlier version of JIRA, back up your data. Refer to Automating JIRA Backups.

1. Upgrade your JIRA instance to 6.3 or later

See JIRA Installation and Upgrade Guide.

JIRA clustering is only available from 6.3 onwards and you must purchase a JIRA Data Center license to use the clustering functionality of JIRA Data Center. Please contact our sales team for information about purchasing a JIRA Data Center license.

2. Set up the JIRA file storage location on shared storage

In this step, you need to set up a shared home directory that is writable by the JIRA instance and any future nodes.

There are multiple ways to do this, but the simplest is to use an NFS share. The mechanics of setting one is unique from installation to installation and is outside the scope of this document.

Assuming that the final mount point for this shared storage location is /data/jira/sharedhome:

- Ensure that directory can be read and written by other potential nodes
- Copy the following directories into /data/jira/sharedhome: (some of them may be empty)
  - data
  - plugins
  - logos
  - import
  - export
3. **Configure your existing JIRA instance to work in a cluster**

Set up the following on your existing JIRA instance:

1. Put a `cluster.properties` file in the local JIRA home directory, with contents as follows:

   - **Expand for example**
   
   **Example cluster.properties file**

   ```
   # This ID must be unique across the cluster
   jira.node.id = node1
   # The location of the shared home directory for all JIRA nodes
   jira.shared.home = /data/jira/sharedhome
   
   See [Cluster.properties file parameters](#) for more information.
   ```

2. If using the Apache load balancer, set the Apache node name by appending the following setting to the same variable (replacing `node1` with the node name used in the load balancer configuration):

   ```
   -DjvmRoute=node1
   ```

4. **Add the first node to your load balancer**

JIRA Data Center relies on a load balancer to balance traffic between the nodes. Many larger installations of JIRA already have a reverse proxy configured, and many reverse proxies have the ability to perform load balancing as well. We’ve provided a sample Apache httpd configuration to serve as an example, but please check with your proxy vendor for specific information.

   - **Sample httpd configuration with mod_balancer**

```bash
$ cp -R /path/to/jira-local-home/{data,plugins,logos,import,export} /data/jira/sharedhome
```
5. Add a new JIRA node to the cluster

1. Copy the JIRA installation directory to a new host. Atlassian recommends that your configuration deviates from the first installation as little as possible to ease the burden of documentation and deployment (e.g. installation paths, users, file permissions, etc).
2. Ensure that the new host can access the shared home directory (e.g. ensure that you can read the contents of the shared JIRA directory and have write access to it)
3. Copy the local home directory from the first node to this new node.
4. Alter the cluster.properties file to reference the new node id. All node ids must be unique among nodes.
5. Start the new node and monitor for startup problems.

After adding JIRA to the load balancer, ensure that basic functionality is working after restarting the JIRA instance by navigating to the instance, logging in, and noting any broken links or malfunctioning JIRA functionality.

Be sure to check that the base server URL is configured properly (to the load balancer public URL).
6. Ensure that issue creation, search, attachments, and customizations work as expected.

6. Connect this new node to the load balancer

Verify that the new node is in the cluster and receiving requests by checking the logs on each node to ensure both are receiving traffic and also check that updates done on one node are visible on the other.

Repeat steps 5 and 6 for each node.

Cluster.properties file parameters

You can set the following parameters in the `cluster.properties` file:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Description/value</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira.node.id</td>
<td>Yes</td>
<td>This unique ID must match the username and the <code>BalancerMember</code> entry in the Apache config</td>
</tr>
<tr>
<td>jira.shared.home</td>
<td>Yes</td>
<td>The location of the shared home directory for all JIRA nodes</td>
</tr>
<tr>
<td>ehcache.peer.discovery</td>
<td>No</td>
<td>Describes how nodes find each other: default - JIRA will automatically discover nodes. Recommended automatic - Will use EhCache's multicast discovery. This is the historical default method used by ehCache, but can be problematic for customers to configure and is no longer recommended by Atlassian for use with JIRA clustering</td>
</tr>
<tr>
<td>ehcache.listener.hostName</td>
<td>No</td>
<td>The hostname of the current node for cache communication. JIRA Data Center will resolve this this internally if the parameter isn't set. If you have problems resolving the hostname of the network you can set this parameter.</td>
</tr>
<tr>
<td>ehcache.listener.port</td>
<td>No</td>
<td>The port the node is going to be listening to (default = 40001) if multiple nodes are on the same host or this port is not available, you might need to set this manually.</td>
</tr>
<tr>
<td>ehcache.listener.socketTimeoutMillis</td>
<td>No</td>
<td>By default this is set to the Ehcache default</td>
</tr>
</tbody>
</table>

If you set `ehcache.peer.discovery = automatic` then you need to set the following parameters:

- `ehcache.multicast.address`
- `ehcache.multicast.port`
- `ehcache.multicast.timeToLive`
- `ehcache.multicast.hostName`

Refer to the Ehcache documentation for more information on these parameters.

Configuring Your JIRA Installation

The pages listed below contain information on how to configure and fine-tune your JIRA installation:
Using the JIRA Configuration Tool

The **JIRA Configuration Tool** is an application (included with all JIRA distributions except JIRA WAR) that offers server-level JIRA configuration through a convenient GUI. This tool allows you to do the following:

- Configure your JIRA Home Directory
- Configure your database connection
- Tune your database connection
- Configure the webserver, including the TCP ports that JIRA runs through and SSL configuration.

**On this page:**
- Starting the JIRA Configuration Tool
- Configuring the JIRA Home Directory
- Configuring the database connection
- Configuring JIRA's web server
- Tuning JIRA's database connections

**Please Note:**
- The JIRA Configuration Tool requires a Java platform to be installed and configured on your operating system. If you need to install a Java platform to run this tool, we recommend using a Java platform supported by JIRA — refer to JIRA Requirements for details.
- If you use the JIRA WAR distribution or have a console-only connection to your JIRA server, you will need to perform these server-level configurations manually.
- Whenever you configure or reconfigure JIRA's server-level settings using this tool, **JIRA must be restarted** so it can recognise these changes.

**Starting the JIRA Configuration Tool**

The `JAVA_HOME` environment variable must be set to use the JIRA configuration tool. If it has not been set already, follow the instructions in Installing Java to set it.

**To start the JIRA configuration tool:**

- **Windows:** Open a command prompt and run `config.bat` in the `bin` sub-directory of the JIRA Installation Directory.
- **Linux/Unix:** Open a console and execute `config.sh` in the `bin` sub-directory of the JIRA Installation Directory.

This may fail with the error as described in our **Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set** KB article. Please refer to it for the workaround.

The JIRA configuration tool can be run with a graphical user interface or via a command-line interface using the `-c` or `--console` argument. The following sections show the graphical user interface, but the functionality is the same regardless of the interface.

**Configuring the JIRA Home Directory**

Your **JIRA Home Directory** allows you to set the folder that JIRA uses to store its various data files.

**To set your JIRA Home Directory using the JIRA Configuration Tool:**

1. Click the **JIRA Home** tab.
2. In the **JIRA Home Directory** field, type the full file path into the text field, or click the **Browse** button to browse for the location of your JIRA Home Directory.
3. Click the 'Save' button. Your changes are saved to the `jira-application.properties` file located in
the `<jira-application-dir>` subdirectory of your JIRA Installation Directory. For more information, please see Setting your JIRA Home Directory.

### Screenshot: JIRA configuration tool — ‘JIRA Home’ tab

#### Configuring the database connection

To configure JIRA’s database connection using the JIRA configuration tool, follow the appropriate procedure for your database type:

- Connecting JIRA to PostgreSQL
- Connecting JIRA to MySQL
- Connecting JIRA to Oracle
- Connecting JIRA to SQL Server 2005
- Connecting JIRA to SQL Server 2008
- Connecting JIRA to HSQLDB

### Screenshot: JIRA configuration tool — ‘Database’ tab
**Configuring JIRA’s web server**

The JIRA configuration tool can also be used to configure JIRA’s web server, specifically the TCP ports and the SSL configuration. Follow the relevant instructions linked below:

- Changing JIRA’s TCP Ports
- Running JIRA over SSL or HTTPS

*Screenshot: JIRA configuration tool — ‘Web Server’ tab*
**Tuning JIRA’s database connections**

For more information about the functionality of the **Advanced** tab, see *Tuning Database Connections*.

*Screenshot: JIRA configuration tool — 'Advanced' tab*
Running JIRA as a Service

For long-term use, JIRA should be configured to automatically restart when the operating system restarts. For Windows servers, this means configuring JIRA to run as a Windows service.

If you are running JIRA on Linux and want to start it automatically, please refer to Starting JIRA Automatically on Linux instead.

Running JIRA as a Windows service has other advantages. When started manually a console window opens and there is a risk of someone accidentally shutting down JIRA by closing this window. Also, the JIRA logs are properly managed by the Windows service (found in logs\stdout*.log in your JIRA Home Directory, and rotated daily).
There are two ways to install JIRA as a service: via the installer, and manually.

**On this page:**
- Installing as a Service with the Installer
  - Manually Setting up JIRA to Run as a Service
- Removing the JIRA service
- Changing the Windows user that the JIRA service uses
- Specifying the startup order of multiple services
- Locating the name of a service
- Troubleshooting

**Installing as a Service with the Installer**

The easiest way to get JIRA installed as a Windows service is by clicking the 'Install JIRA as Service' check box when running the Windows Installer:

You will need full Administrator rights on your Windows operating system for this installation process to complete successfully.

**Manually Setting up JIRA to Run as a Service**

You can still set up JIRA to run as a service, if any of the following situations apply to you:

- You did not use the Windows Installer.
- You used the Windows Installer, but did not initially install JIRA as a service.

**Please Note:**

- These instructions do not apply to installations of the JIRA WAR distribution. To run a JIRA WAR installation as a service, refer to the relevant JIRA WAR installation instructions for Apache Tomcat 6.0 or 7.0.
- On any Windows operating system with User Account Control (UAC) such as Windows Vista or Windows 7, you must either disable UAC or run ‘cmd.exe’ as an administrator (e.g. by right-clicking on ‘cmd.exe’ and selecting “Run as administrator”) in order to execute the script in the procedure below. If UAC is
enabled, simply logging in to Windows with an Administrator account will not be sufficient.

To set up JIRA to run as a service:

1. Open a Command Prompt.
2. Change directory (‘cd’) to the JIRA installation directory and then into this directory’s ‘bin’ subdirectory.
   - If a directory in the path has spaces (e.g. ‘C:\Program Files\..’), please convert it to its eight-character equivalent (e.g. ‘C:\Progra-1\.’).
3. Ensure the JAVA_HOME variable is set to the root of your Java platform’s installation directory.
   - To find out the current value of the JAVA_HOME variable, enter `echo %JAVA_HOME%` at the command prompt.
4. Run the following command:

```
service.bat install JIRA
```

Here is a screenshot of the process:

![Command Prompt screenshot showing the installation of JIRA as a service](image)

JIRA should now be set up to run as a service.

5. In addition, to have the JIRA service start automatically when the operating system starts, run:

```
tomcat7 //US//JIRA --Startup auto
```

The JIRA service will automatically start up the next time the operating system reboots. The JIRA service can be manually started with the command `net start JIRA` and stopped with `net stop JIRA`.

To see what parameters the JIRA service is starting with, go to Start -> Run and run `regedt32 .exe` and then:

- For Windows 32 bit edition navigate to HKEY_LOCAL_MACHINE -> SOFTWARE -> Apache Software Foundation -> Prorcun 2.0 -> JIRA<time stamp>
- For Windows 64 bit edition navigate to HKEY_LOCAL_MACHINE -> SOFTWARE -> Wow6432Node -> Apache Software Foundation -> Prorcun 2.0 -> JIRA<time stamp>

6. Additional JIRA setup options (optional):

```
For JIRA 5.2 and above run these tomcat7 commands, but for JIRA 5.1 or below run the tomcat6 command instead
```

- To increase the maximum memory JIRA can use (the default will already be 256MB), run:
where service_name is the name of your JIRA service, e.g. JIRA123487934298.

- To add a JVM parameter, for example pass a parameter to enable JIRA's Jelly support, run:

```
tomcat7 //US//service_name ++JvmOptions="-Djira.jelly.on=true"
```

where service_name is the name of your JIRA service, e.g. JIRA123487934298.

- If you are running JIRA and Confluence in the same JVM, increase the MaxPermSize size to 128 MB:

```
tomcat7 //US//service_name ++JvmOptions="-XX:MaxPermSize=128m"
```

where service_name is the name of your JIRA service, e.g. JIRA123487934298.

- Occasionally, it may be useful to view JIRA's Garbage Collection information. This is especially true when investigating memory issues. To turn on the Verbose GC (garbage collection) logging, execute the following command in the command prompt:

```
tomcat7 //US//service_name ++JvmOptions="-Xloggc:path\to\logs\atlassian-gc.log"
```

where service_name is the name of your JIRA service, e.g. JIRA123487934298. The path (denoted by path\to) refers to the directory in which JIRA is currently installed. For example:

```
tomcat7 //US//service_name ++JvmOptions="-Xloggc:c:\jira\logs\atlassian-gc.log"
```

where service_name is the name of your JIRA service, e.g. JIRA123487934298.

See the Tomcat documentation for further service options.

**Removing the JIRA service**

If JIRA was installed through the Windows installer, go to the 'Control Panel' in Windows, click 'Add or Remove Programs' and remove JIRA. This will remove the service too.

If you installed the service manually (see above) it can be uninstalled with:

```
service.bat remove JIRA
```

Alternatively, if the above does not work, use tomcat7 //DS//JIRA.

**Changing the Windows user that the JIRA service uses**

If you are using mapped network drives for JIRA's backup directory, attachments directory, index directory or the %CATALINA_HOME% directory, you need to ensure that JIRA can write to these drives. That is, these directories all need to be writeable by the user which the JIRA service is running as. This may mean that you need to change the Windows user that the JIRA server uses.
Note that you must also specify these network drives by UNC and not letter mappings, e.g. `\backupserver\jira` not `z:\jira`.

To change the Windows user that the JIRA service uses, navigate to the service in Windows, i.e. 'Control Panel' -> 'Administrative Tools' -> 'Services'. Locate the 'Atlassian JIRA' service, right-click and view the 'Preferences'.

Go to the 'Log On' tab and change the user as desired.

**Specifying the startup order of multiple services**

If you have services that depend on each other, it is important that they are started in the correct order. Common examples include:

- If you are running both JIRA and Crowd, it is important to start Crowd first, so that Crowd is running before people try to login to JIRA.
- If the database JIRA connects to is hosted on the same server as JIRA, and is started via a Windows service, the JIRA service will only start successfully if the database service has already started first.

To set up start up dependency rules, open a command prompt and enter the following command:

```
C:\Documents and Settings\Developer>sc config [JIRA service] depend=[database service]
```

*Please note the space character after `depend=`.*

- `[JIRA service]` is the name of the JIRA service you are running, e.g. JIRA051007111904.
- `[database service]` is the name of the database service you are running, e.g. MSSQLSERVER.

If you wish, you can also set up dependency rules by editing the system registry. Please see [http://support.microsoft.com/kb/193888](http://support.microsoft.com/kb/193888) for details on how to do this.
Locating the name of a service

If you do not know the exact name of your JIRA service or your database service, you can find out what they are by following the steps below:

1. Navigate to 'Control Panel' > 'Administrative Tools' > 'Services'.
2. The 'Services' window should appear:

![Services window](image1)

3. Right-click on the service you wish to find out the name of, and select 'Properties' from the popup menu:

![Properties menu](image2)

4. The 'Service name' should appear in the 'General' tab:

![Service name](image3)
Troubleshooting

- Java 6 is not supported by JIRA 6.0 and later. Problems may occur when trying to setup JIRA to run as a Windows service with JDK 1.6. The problem is due to failure to locate "MSVCR71.DLL", which can be found in %JAVA_HOME%/bin. There are two options to resolve this problem:
  - Add %JAVA_HOME/bin to PATH, then restart the JIRA server.
  - Copy MSVCR71.DLL to system path, C:\WINDOWS\SYSTEM32 or C:\WINNT\SYSTEM32
- Take note of the username that the service is running as, and be sure to modify the /temp and /work directories in your install directory so that this user has read and write permissions.
- You cannot run JIRA as a service on a 64-bit operating system if you require allocating more than 1.5GB of memory, due to 32-bit JDK memory limitations and 64-bit JDK/Tomcat service issues.
Starting JIRA Automatically on Linux

On Linux/Solaris, the best practice is to install, configure and run each service (including JIRA) as a dedicated user with only the permissions they require.

To install, configure and get JIRA to start automatically on Linux/Solaris:

1. Create a `jira` user account which will be used to run JIRA. For example, enter the following at a Linux/Solaris console:

   ```
   sudo useradd --create-home -c "JIRA role account" jira
   ```

2. Create a directory into which JIRA will be installed. For example:

   ```
   sudo mkdir /opt/atlassian/jira
   sudo chown jira: /opt/atlassian/jira
   ```

3. Log in as the `jira` user to install JIRA:

   ```
   sudo su - jira
   ```

4. Assuming you downloaded the JIRA from a 'tar.gz' archive, you need to extract it:

   ```
   cd /opt/atlassian/jira
   tar zxvf /tmp/atlassian-jira-X.Y.tar.gz
   ln -s atlassian-jira-X.Y/ current
   ```

5. Edit `current/atlassian-jira/WEB-INF/classes/jira-application.properties` and set `jira.home=/var/atlassian/application-data/jira`

6. Then back as root, create the file `/etc/init.d/jira` (code shown below), which will be responsible for starting up JIRA after a reboot (or when manually invoked).

```bash
#!/bin/bash
JIRA=/var/atlassian/application-data/jira
EXEC=/opt/atlassian/jira/bin/jira

# Run in the correct user's home directory
cd $JIRA

# Log in to JIRA
su - jira

# Run JIRA
$EXEC
```
#!/bin/sh -e
# JIRA startup script
#chkconfig: 2345 80 05
#description: JIRA

# Define some variables
# Name of app ( JIRA, Confluence, etc )
APP=jira
# Name of the user to run as
USER=jira
# Location of application's bin directory
BASE=/opt/atlassian/jira/current
# Location of Java JDK
export JAVA_HOME=/usr/lib/jvm/java-6-sun

case "$1" in
  # Start command
  start)
    echo "Starting $APP"
    /bin/su -m $USER -c "cd $BASE/logs && $BASE/bin/startup.sh &> /dev/null"
    ;;
  # Stop command
  stop)
    echo "Stopping $APP"
    /bin/su -m $USER -c "$BASE/bin/shutdown.sh &> /dev/null"
    echo "$APP stopped successfully"
    ;;
  # Restart command
  restart)
    $0 stop
    sleep 5
    $0 start
    ;;
*)
  echo "Usage: /etc/init.d/$APP {start|restart|stop}"
  exit 1
  ;;
esac
exit 0

7. Make the init script executable:

    chmod +x /etc/init.d/jira

8. Place symlinks in the run-level directories to start and stop this script automatically.

   a. For Debian-based systems:

       update-rc.d jira defaults

   The following commands will be executed to place symlinks in the run-level directories:
Adding system startup for /etc/init.d/jira ...
/etc/rc0.d/K20jira -> ../init.d/jira
/etc/rc1.d/K20jira -> ../init.d/jira
/etc/rc6.d/K20jira -> ../init.d/jira
/etc/rc2.d/S20jira -> ../init.d/jira
/etc/rc3.d/S20jira -> ../init.d/jira
/etc/rc4.d/S20jira -> ../init.d/jira
/etc/rc5.d/S20jira -> ../init.d/jira

b. For RedHat-based systems:

the init.d script contains chkconfig settings

sudo /sbin/chkconfig --add jira

9. Ensure the script is executed in the correct order, in particular after the database startup script.

Thank you for this information
Thank you to Matthew Block and Pete Toscano for the original comments that we based this information on.

Starting JIRA automatically on FreeBSD

*nix-based operating system administration is outside the scope of Atlassian support. This document is provided for information-purposes only.

On *nix-based BSD operating systems, the best practice is to install, configure and run each service (including JIRA) as a dedicated user with only the permissions they require.

To run JIRA automatically on FreeBSD:

1. As root, create the file /usr/local/etc/rc.d/jira.sh (code shown below), which will be responsible for starting up JIRA after a reboot (or when manually invoked). If you are not using postgresql for your database, change the REQUIRE line to whatever is in the PROVIDE line in your database init script.
#!/bin/sh
#
# Startup script for JIRA on FreeBSD
#
# This goes in /usr/local/etc/rc.d and gets run at boot-time.
#
# PROVIDE: jira
# REQUIRE: postgresql
# KEYWORD: shutdown

# Add the following lines to /etc/rc.conf to enable jira:
#
jira_enable="YES"
jira_enable="$\{jira_enable-NO\}"

. /etc/rc.subr

name="jira"
rcvar=`set_rcvar`
start_cmd="$\{name\}_start"
stop_cmd="$\{name\}_stop"

jira_start()
{
    echo -n " Starting JIRA"
su - atlassian -c '/home/atlassian/jira/bin/startup.sh'
}

jira_stop()
{
    echo -n " Stopping JIRA"
su - atlassian -c '/home/atlassian/jira/bin/shutdown.sh'
}

load_rc_config $name
run_rc_command "$1"

2. Make the init script executable:

    chmod +x /usr/local/etc/rc.d/jira.sh

3. Make the init script readonly:

    chmod -w /usr/local/etc/rc.d/jira.sh

4. Add the following line to /etc/rc.conf

    jira_enable="YES"

More information can be found in this article.

Running the Setup Wizard
The JIRA Setup Wizard helps you configure the basic settings for your new JIRA server. These include the
server language, database, license key, administrator accounts and mail notifications.

To get started, access your new JIRA server in a browser, after you have installed JIRA. Your server will be available at the following URL, if you are using the default port: \[http://<jira-server-name>:8080\].

ℹ️ The JIRA Setup Wizard will only display the first time after you install JIRA. Once you have completed it, you cannot run it again. However, every setting configured in the Setup Wizard can be configured via the JIRA administration console.

On this page:
- Step 1. Configure the language and database
- Step 2. Configure the application properties
- Step 3. Specify your license key
- Step 4. Set up the administrator account
- Step 5. Configure email notifications
- Next steps

Step 1. Configure the language and database

Screenshot: Configuring the server language and database connection for a new JIRA server

Set the server language

Choose the language you would like the JIRA user interface to appear in by selecting the preferred **Server Language**.

Please Note:

- As soon as you choose a language from the **Server Language** dropdown list, the JIRA user interface will switch to that language.
- Be aware that some languages may have more comprehensive translations than others.

Configure a database for JIRA

Choose between connecting JIRA to the bundled database or your own database.

<table>
<thead>
<tr>
<th>Database Connection</th>
<th>Recommended for</th>
<th>Instructions</th>
<th>Notes</th>
</tr>
</thead>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Step 2. Configure the application properties

**Screenshot: Configuring the application properties for a new JIRA server**

Configure the Title, Mode and Base URL

<table>
<thead>
<tr>
<th>Setting</th>
<th>Instructions</th>
<th>Notes</th>
</tr>
</thead>
</table>

- Choose a database. See our list of [supported databases](#) first.
- Configure the database connection. If you need help, see the guides on [Connecting JIRA to a Database](#). Note, the fields displayed on this screen are identical to those on the JIRA Configuration Tool.
- Your external database must be a newly-created (or empty) database.
- Database connection pool — You cannot configure your database connection pool size through the Setup Wizard. You can do this subsequently using the JIRA Configuration Tool or manually (described on each specific database configuration guide).
- MySQL database — The MySQL driver is not bundled with JIRA (see [Connecting JIRA to MySQL](#)). You need to copy the driver into the lib folder of your JIRA installation and restart JIRA/JIRA service before completing the Setup Wizard.
<table>
<thead>
<tr>
<th>Application Title</th>
<th>Choose a title that helps identify your installation and its purpose.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The application title will be displayed on the JIRA login page and the dashboard.</td>
</tr>
<tr>
<td></td>
<td>• After you have completed the Setup Wizard, you may also want to configure the logo and color scheme of your installation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mode</th>
<th>Choose a mode that suits how you use your issue tracker.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Setting the mode to public enables public signup. Note, that allowing anyone to sign up can cause you to exceed the user limit on your JIRA license.</td>
</tr>
<tr>
<td></td>
<td>• A public issue tracker can be useful for gathering feedback and bug reports directly from customers. A private issue tracker may be more suitable for tracking the development progress of your team.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Base URL</th>
<th>Specify the base URL that users will use to access your JIRA site.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• You can only configure JIRA to respond to a single URL and this setting must match the URL that your users request for accessing your JIRA site. You cannot (for example) have a different hostname or URL for internal and external users. Any mismatch between this Base URL setting and the URL requested by your JIRA users will cause problems with dashboard gadgets.</td>
</tr>
<tr>
<td></td>
<td>• This URL is also used in outgoing email notifications as the prefix for links to JIRA issues.</td>
</tr>
</tbody>
</table>

**Further information:**

- If you need to change these settings after setting up JIRA, you can configure them via the JIRA administration console. For details, see Configuring JIRA Options.
- JIRA will store your automated backups, file attachments and indexes in your JIRA Home Directory.

(Optional) Import data into your JIRA installation

If you have an existing XML backup of a JIRA site, you can import it into your new JIRA installation at this point by clicking the top import data link. The 'Import Existing Data' page will display — see Restoring Data for further instructions.

Please also note:

- Your XML backup file must be located in the import subdirectory of your JIRA Home Directory.
- Your existing JIRA license details will be restored from your XML backup file, unless you specify different one in the License field of the 'Import Existing Data' page.

**Step 3. Specify your license key**

*Screenshot: Creating a my.atlassian.com account and license key*

*Screenshot: Generating a license key for an existing my.atlassian.com account*
You are required to enter a JIRA license key before you can use JIRA. If you don’t have a JIRA license key, you can get the Setup Wizard to create an evaluation license for you, as shown above. Evaluation license keys will allow you to use a fully functional installation of JIRA for 30 days.

License keys for Atlassian products are linked to your account at my.atlassian.com. If you don’t have a my.atlassian.com account, you can create one and get the Setup Wizard to create an evaluation license for you, as shown above.

Some customers have encountered Javascript and CSS errors on the ‘Specify Your License Key’ page. See this knowledge base article: JIRA Setup Wizard Fails with Errors on Licence Key Setup Page.

Step 4. Set up the administrator account

Screenshot: Setting up a JIRA system administrator account
Enter the details for the administrator account for the JIRA installation. The account will be granted the **JIRA system administrator permission**.

You can create additional JIRA system administrator and JIRA administrator accounts after you have set up JIRA.

**Step 5. Configure email notifications**

*Screenshot: Setting up email notifications for JIRA*

This step is optional. You can configure email notifications after you have set up JIRA if you wish.
If you want to configure email notifications at this stage, you will need to set up a connection to a mail server. See this page for further instructions: Configuring JIRA’s SMTP Mail Server to Send Notifications

✔ Congratulations, you have completed setting up your new JIRA installation!

Next steps

The Welcome screen will lead you through creating demonstration project for your new JIRA installation, or you can opt to set it up yourself.

For more information on getting started with JIRA, see the JIRA 101 guide.

Detailed information on using and administering JIRA can be found in the rest of the JIRA documentation:

- JIRA User's Guide
- JIRA Administrator's Guide

Connecting JIRA to a Database

JIRA requires a relational database to store its issue data.

If you are setting up a completely new JIRA installation, the JIRA Setup Wizard will configure a database connection for you to either JIRA’s internal HSQL database or an external database.

JIRA’s internal HSQL database is suitable for evaluation purposes. However, HSQL databases are prone to corruption. For production installations of JIRA, we strongly recommend that you connect JIRA to another supported database. This allows you to take advantage of your database system’s own backup and recovery features.

The following are more detailed instructions for configuring a connection to a JIRA database:

- Connecting JIRA to PostgreSQL
- Connecting JIRA to MySQL
- Connecting JIRA to Oracle
- Connecting JIRA to SQL Server 2005
- Connecting JIRA to SQL Server 2008
- Connecting JIRA to SQL Server 2012

Which Database?

Your choice of database can significantly affect your subsequent experience of JIRA administration. If you have a choice of databases, please first read our list of supported databases.

If you are looking for a low-cost solution, consider using PostgreSQL or MySQL as both of these are open source (free) software.

Upgrading JIRA or Migrating JIRA to Another Server?

If you are upgrading JIRA manually or migrating JIRA to another server and do not have access to a pre-existing dbconfig.xml file, you will need to re-configure your database connection. This results in a dbconfig.xml file (being created in the JIRA Home Directory of your new JIRA installation), whose content defines your JIRA database connection.

The options for re-configuring your database connection depend on what JIRA distribution you are using:

| 'Recommended' distributions: | If you installed JIRA using the 'Windows Installer', 'Linux Installer' or from an 'Archive File', you can re-configure your database connection either with the JIRA Configuration Tool or manually. |

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
**WAR distribution:** If you have set up a JIRA WAR installation, you need to manually configure your database connection.

Specific instructions for configuring database connections either using the JIRA Configuration Tool or manually are provided in the specific instructions for each database (listed above).

**Data Migration**

To transfer your issue data from one database to another, please refer to the instructions for Switching databases.

**Connecting JIRA to PostgreSQL**

These instructions will help you connect JIRA to a PostgreSQL database. A version of these instructions specific to Linux and JIRA is available.

Before you begin

- Check whether your version of PostgreSQL is supported. See Supported Platforms.
- If you are Migrating JIRA to Another Server, create an export of your data as an XML backup. You will then be able to transfer data from your old database to your new database, as described in Switching databases.
- Shut down JIRA before you begin, unless you are running the Setup Wizard.

**On this page:**

- Before you begin
- 1. Create and configure the PostgreSQL database
- 2. Copy the PostgreSQL JDBC driver to your application server (JIRA WAR only)
- 3. Configure your JIRA server to connect to your PostgreSQL database
- 4. Start JIRA
- Installation notes

1. Create and configure the PostgreSQL database

1. Create a database user (login role) which JIRA will connect as (e.g. jiradbuser).
   **Remember this database user name,** as it will be used to configure JIRA's connection to this database in subsequent steps.

2. Create a database for JIRA to store issues in (e.g. jiradb) with Unicode collation.
   **Remember this database name,** as it will be used to configure JIRA's connection to this database in subsequent steps.

   ```sql
   CREATE DATABASE jiradb WITH ENCODING 'UNICODE' LC_COLLATE 'C' LC_CTYPE 'C'
   TEMPLATE template0;
   ```

   Or from the command-line:

   ```bash
   $ createdb -E UNICODE -l C -T template0 jiradb
   ```

2. Ensure that the user has permissions to connect to the database, and to create and write to tables in the database.

2. Copy the PostgreSQL JDBC driver to your application server (JIRA WAR only)
1. **Skip this step** if you installed a 'Recommended' distribution of JIRA, which includes the PostgreSQL JDBC driver. The JIRA WAR distribution does not include this driver.

2. Download the PostgreSQL JDBC driver from [http://jdbc.postgresql.org/download.html](http://jdbc.postgresql.org/download.html). (Obtain the JDBC 4 driver that matches your database version.)

3. Add the PostgreSQL JDBC driver jar to the `lib/` directory of your application server.

4. **Configure your JIRA server to connect to your PostgreSQL database**

There are three ways to configure your JIRA server to connect to your PostgreSQL database:

- **Using the JIRA setup wizard** (not applicable to JIRA WAR) — Use this method, if you have just installed JIRA and are setting it up for the first time. Your settings will be saved to the `dbconfig.xml` file in your JIRA Home Directory.

- **Using the JIRA configuration tool** (not applicable to JIRA WAR) — Use this method, if you have an existing JIRA instance. Your settings will be saved to the `dbconfig.xml` file in your JIRA Home Directory.

- **Manually** — Only use this method if you have a JIRA WAR instance or you have a console-only connection to your JIRA server. You will be required to manually update the `dbconfig.xml` file in your JIRA Home Directory.

**Instructions for each configuration method:**

<table>
<thead>
<tr>
<th>JIRA setup wizard</th>
<th>The JIRA setup wizard will display when you access JIRA for the first time in your browser.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. In the first screen, 'Configure Language and Database', set <strong>Database Connection</strong> to <strong>My own database</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Set <strong>Database Type</strong> to <strong>PostgreSQL</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Fill out the fields, as described in the <strong>Database connection fields</strong> section below.</td>
</tr>
<tr>
<td></td>
<td>4. Test your connection and save.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>JIRA configuration tool</th>
<th>1. Run the JIRA configuration tool as follows:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows: Open a command prompt and run <code>config.bat</code> in the <code>bin</code> sub-directory of the JIRA Installation Directory.</td>
</tr>
<tr>
<td></td>
<td>Linux/Unix: Open a console and execute <code>config.sh</code> in the <code>bin</code> sub-directory of the JIRA Installation Directory.</td>
</tr>
<tr>
<td></td>
<td>This may fail with the error as described in our <strong>Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error</strong> KB article. Please refer to it for the workaround.</td>
</tr>
<tr>
<td></td>
<td>2. Navigate to the <strong>Database</strong> tab and set <strong>Database type</strong> to <strong>PostgreSQL</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Fill out the fields, as described in the <strong>Database connection fields</strong> section below.</td>
</tr>
<tr>
<td></td>
<td>4. Test your connection and save.</td>
</tr>
<tr>
<td></td>
<td>5. Restart JIRA.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Manually</th>
<th>1. Locate the <code>dbconfig.xml</code> file at the root of your JIRA Home Directory.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this file does not exist, create the file, copy and paste the example XML code (<strong>shown below</strong>) into this file.</td>
</tr>
<tr>
<td></td>
<td>2. Update the file, as described in the <strong>Database connection fields</strong> section below. Escape any 's characters by adding 'amp;' to the end of each one.</td>
</tr>
<tr>
<td></td>
<td>* Note, the <code>&lt;database-type/&gt;</code> element must specify your type of database, e.g. <code>postgresql2</code> if you are using PostgreSQL 9.2. If you forget to do this and you start JIRA, your database tables may be created incorrectly. See <strong>Incorrect database type specified</strong> if this happens to you.</td>
</tr>
<tr>
<td></td>
<td>3. Save the file and restart JIRA.</td>
</tr>
</tbody>
</table>

**Database connection fields**
<table>
<thead>
<tr>
<th>Setup Wizard / Configuration Tool</th>
<th>dbconfig.xml</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:postgresql://dbserver:5432/jiradb&lt;/url&gt;</code></td>
<td>The name or IP address of the machine that the PostgreSQL server is installed on.</td>
</tr>
<tr>
<td>Port</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:postgresql://dbserver:5432/jiradb&lt;/url&gt;</code></td>
<td>The TCP/IP port that the PostgreSQL server is listening on. You can leave this blank to use the default port.</td>
</tr>
<tr>
<td>Database</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:postgresql://dbserver:5432/jiradb&lt;/url&gt;</code></td>
<td>The name of your PostgreSQL database (into which JIRA will save its data). You should have created this in Step 1 above.</td>
</tr>
<tr>
<td>Username</td>
<td>Located in the <code>&lt;username&gt;</code> tag (see bold text in example below): <code>&lt;username&gt;jiradbuser&lt;/username&gt;</code></td>
<td>The user that JIRA uses to connect to the PostgreSQL server. You should have created this in Step 1 above.</td>
</tr>
<tr>
<td>Password</td>
<td>Located in the <code>&lt;password&gt;</code> tag (see bold text in example below): <code>&lt;password&gt;jiradbuser&lt;/password&gt;</code></td>
<td>The user’s password — used to authenticate with the PostgreSQL server.</td>
</tr>
<tr>
<td>Schema</td>
<td>Located in the <code>&lt;schema-name&gt;</code> tag (see bold text in example below): <code>&lt;schema-name&gt;public&lt;/schema-name&gt;</code></td>
<td>The name of the schema that your PostgreSQL database uses. PostgreSQL 7.2 and later require a schema to be specified in the <code>&lt;schema-name/&gt;</code> element. If your PostgreSQL database uses the default 'public' schema, this should be specified in the <code>&lt;schema-name/&gt;</code> element as shown below. Ensure that your database schema name is lower-case, as JIRA cannot work with PostgreSQL databases whose schema names contain upper-case characters.</td>
</tr>
</tbody>
</table>

Sample dbconfig.xml file

For more information about the child elements of `<jdbc-datasource/>` beginning with pool in the dbconfig.xml file above, see Tuning Database Connections.
4. Start JIRA

You should now have JIRA configured to connect to your PostgreSQL database. The next step is to start it up!

- If you are using a 'recommended' distribution of JIRA, start it up and watch the logs for any errors.
- If you are using the JIRA WAR distribution, rebuild and redeploy the webapp in your application server.

✔ Congratulations, you now have JIRA connected to your PostgreSQL database.

Installation notes

Please see JIRA and PostgreSQL for topics related to JIRA and PostgreSQL.

Connecting JIRA to MySQL

These instructions will help you connect JIRA to a MySQL database. A version of these instructions specific to Linux and JIRA is available.

Before you begin

- Check whether your version of MySQL is supported. See Supported Platforms.
- If you are Migrating JIRA to Another Server, create an export of your data as an XML backup. You will then be able to transfer data from your old database to your new database, as described in Switching databases.
- If you plan to set up Confluence and JIRA on the same MySQL server, please read the Confluence MySQL setup guide and configure your MySQL server to suit Confluence as well as JIRA. Note that the Confluence requirements are more strict than JIRA’s, so you should configure MySQL to suit Confluence. This configuration will work for JIRA too.
- Shut down JIRA before you begin, unless you are running the Setup Wizard.
On this page:
- Before you begin
- 1. Create and configure the MySQL database
- 2. Copy the MySQL JDBC driver to your application server
- 3. Configure your JIRA server to connect to your MySQL database
- 4. Start JIRA
- Installation notes

1. Create and configure the MySQL database

1. Create a database user which JIRA will connect as (e.g. `jiradbuser`).
   **Remember this database user name, as it will be used to configure JIRA’s connection to this database in subsequent steps.**

2. Create a database for JIRA to store issues in (e.g. `jiradb`). The database must have a character set of UTF8. Enter the following command from within the MySQL command client.
   **Remember this database name, as it will be used to configure JIRA’s connection to this database in subsequent steps.**

   ```sql
   CREATE DATABASE jiradb CHARACTER SET utf8 COLLATE utf8_bin;
   ```

   (if you want your database to be named `jiradb`).

3. Ensure that the user has permission to connect to the database, and permission to create and populate tables. These can be provided with the following:

   ```sql
   GRANT SELECT,INSERT,UPDATE,DELETE,CREATE,DROP,ALTER,INDEX on <JIRADB>.* TO '<USERNAME>'@'<JIRA_SERVER_HOSTNAME>' IDENTIFIED BY '<PASSWORD>'; flush privileges;
   ```

   **Tip:**
   To confirm if the permissions were granted successfully, log into the DB server with the JIRA DB user and run the command below:

   ```sql
   SHOW GRANTS FOR <USERNAME>@<JIRA_SERVER_HOSTNAME>;
   ```

2. Copy the MySQL JDBC driver to your application server

If you are **upgrading JIRA and you are using the recommended MySQL driver** (Connector/J JDBC driver v5.1), you can skip the instructions in this section. The JIRA upgrade task will automatically copy over your existing driver to the upgraded installation.

**To copy the MySQL JDBC driver to your application server:**

1. Get the MySQL driver:
   - If you are **installing JIRA**, download the recommended MySQL Connector/J JDBC driver v5.1. You can download either the `.tar.gz` or the `.zip` file by selecting the `Platform Independent` option. Extract the jar for the driver (e.g. `mysql-connector-java-5.x.x-bin.jar`) from the archive.
   - If you are **upgrading JIRA and you are not using the recommended MySQL driver** (JDBC
1. Back up the driver from your JIRA installation before you upgrade. The driver will be in the `<JIRA installation directory>/lib/` directory.

2. Copy the MySQL JDBC driver jar to the `<JIRA installation directory>/lib/` directory for your new/upgraded installation. If you are installing JIRA using the Windows installer, you will need to do this step after running the Windows installer, but **before running the Setup Wizard**.

3. Restart JIRA / JIRA service.

4. If you are installing JIRA, skip the rest of the instructions on this page and access JIRA in your browser to run the Setup Wizard instead.

**Please note:**

- We recommend the Connector/J driver from MySQL (linked above). A user has reported experiencing problems with the Resin JDBC driver for MySQL.

3. Configure your JIRA server to connect to your MySQL database

There are three ways to configure your JIRA server to connect to your MySQL database:

- **Using the JIRA setup wizard** (not applicable to JIRA WAR) — Use this method, if you have just installed JIRA and are setting it up for the first time. Your settings will be saved to the `dbconfig.xml` file in your JIRA Home Directory.
- **Using the JIRA configuration tool** (not applicable to JIRA WAR) — Use this method, if you have an existing JIRA instance. Your settings will be saved to the `dbconfig.xml` file in your JIRA Home Directory.
- **Manually** — Only use this method if you have a JIRA WAR instance or you have a console-only connection to your JIRA server. You will be required to manually update the `dbconfig.xml` file in your JIRA Home Directory.

**Instructions for each configuration method**

**JIRA setup wizard**

The JIRA setup wizard will display when you access JIRA for the first time in your browser.

1. In the first screen, 'Configure Language and Database', set **Database Connection** to My own database.
2. Set **Database Type** to MySQL.
3. Fill out the fields, as described in the **Database connection fields** section below.
4. Test your connection and save.

**JIRA configuration tool**

1. Run the JIRA configuration tool as follows:
   - **Windows**: Open a command prompt and run `config.bat` in the `bin` sub-directory of the JIRA Installation Directory.
   - **Linux/Unix**: Open a console and execute `config.sh` in the `bin` directory.
ub-directory of the JIR
A Installation Directory.

This may fail with
the error as described
in our Unable to Start
JIRA Config Tool due
to No X11 DISPLAY
variable was set error
KB article. Please refer
to it for the
workaround.

2. Navigate to the Database tab
and set Database type to My
SQL.

3. Fill out the fields, as described
in the Database connection
fields section below.

4. Test your connection and
save.

5. Restart JIRA.

Manually

1. Locate the dbconfig.xml fil-
e at the root of your JIRA
Home Directory.
   - If this file does not
     exist, create the file,
copy and paste the
example XML code (sh
own below) into this
file.

2. Update the file, as described
in the Database connection
fields section below. Escape
any ’&’ characters by adding ’
amp;’ to the end of each one.
   - Note, the <database-
type/> element must
specify your type of
database, e.g. mysql.
If you forget to do this
and you start JIRA,
your database tables
may be created
incorrectly. See In-cor-
correct database type
specified if this
happens to you.

3. Save the file and restart JIRA.

Database connection fields

| Setup Wizard / Configuration Tool | dbconfig.xml |

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Hostname</th>
<th>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:mysql://dbserver:3306/jiradb?useUnicode=true&amp;amp;characterEncoding=UTF8&amp;amp;sessionVariables=storage_engine=InnoDB&lt;/url&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:mysql://dbserver:3306/jiradb?useUnicode=true&amp;amp;characterEncoding=UTF8&amp;amp;sessionVariables=storage_engine=InnoDB&lt;/url&gt;</code></td>
</tr>
<tr>
<td>Database</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:mysql://dbserver:3306/jiradb?useUnicode=true&amp;amp;characterEncoding=UTF8&amp;amp;sessionVariables=storage_engine=InnoDB&lt;/url&gt;</code></td>
</tr>
<tr>
<td>Username</td>
<td>Located in the <code>&lt;username&gt;</code> tag (see bold text in example below): <code>&lt;username&gt;jiradbuser&lt;/username&gt;</code></td>
</tr>
<tr>
<td>Password</td>
<td>Located in the <code>&lt;password&gt;</code> tag (see bold text in example below): <code>&lt;password&gt;jiradbuser&lt;/password&gt;</code></td>
</tr>
</tbody>
</table>

Sample `dbconfig.xml` file

- For more information about the child elements of `<jdbc-datasource/>` beginning with `pool` in the `dbconfig.xml` file above, see Tuning Database Connections.
- Both the JIRA setup wizard and database configuration tool also add the element `<validation-query>select 1</validation-query>` to this file, which is usually required when running JIRA with default MySQL installations. See Surviving Connection Closures for more information.
- The database URL in the example below assumes a UTF-8 database — i.e. that your database was
created using a command similar to `create database jiradb character set utf8;` If you do not specify character set utf8 when creating this database, you risk getting 'Data truncation: Data too long for column' errors when importing data or corruption of non-supported characters. See [storing non-ASCII characters in MySQL](#) for details.

- The collation order of `COLLATE utf8_bin` is recommended for JIRA. More discussion of this can be seen at [JIRA-21503](#) - JIRA is not fully compatible with case insensitive collation [RESOLVED](#).
- The database URL in the example below contains the `sessionVariables=storage_engine=InnoDB` parameter. We strongly recommend adding this parameter to avoid data corruption. See the Installation Notes section below for more information.
- For MySQL, the schema name `<schema-name>` is not used and should not be specified. If you provide a schema name, you could run into the problem described in the knowledge base article [Incorrect MySQL Schema Used](#).

```xml
<?xml version="1.0" encoding="UTF-8"?>
<jira-database-config>
    <name>defaultDS</name>
    <delegator-name>default</delegator-name>
    <database-type>mysql</database-type>
    <jdbc-datasource>
        <url>jdbc:mysql://dbserver:3306/jiradb?useUnicode=true&amp;characterEncoding=UTF8&amp;sessionVariables=storage_engine=InnoDB</url>
        <driver-class>com.mysql.jdbc.Driver</driver-class>
        <username>jiradbuser</username>
        <password>password</password>
        <pool-min-size>20</pool-min-size>
        <pool-max-size>20</pool-max-size>
        <pool-max-wait>30000</pool-max-wait>
        <pool-max-idle>20</pool-max-idle>
        <pool-remove-abandoned>true</pool-remove-abandoned>
        <pool-remove-abandoned-timeout>300</pool-remove-abandoned-timeout>
        <validation-query>select 1</validation-query>
        <min-evictable-idle-time-millis>60000</min-evictable-idle-time-millis>
        <time-between-eviction-runs-millis>300000</time-between-eviction-runs-millis>
        <pool-test-on-borrow>false</pool-test-on-borrow>
        <pool-test-while-idle>true</pool-test-while-idle>
        <validation-query-timeout>3</validation-query-timeout>
    </jdbc-datasource>
</jira-database-config>
```

4. Start JIRA

You should now have JIRA configured to connect to your MySQL database. The next step is to start it up!

- If you are using a 'recommended' distribution of JIRA, start it up and watch the logs for any errors.
- If you are using the JIRA WAR distribution, rebuild and redeploy the webapp in your application server.

![✓ Congratulations, you now have JIRA connected to your MySQL database.](#)

Installation notes

See JIRA and MySQL. Please also take note of the following:

**Known issues and troubleshooting**

- **Hostnames in permissions are compared as strings** - If you grant permission in MySQL to a hostname such as `localhost` then you must use the `same` string for the connecting to the database.
from JIRA. So using 127.0.0.1 won't work even though it resolves to the same place. This mistake produces warnings about not finding tables because the JDBC connection did not have permission to create the new tables when JIRA was set up.

- **Connection closures** — If you are using a MySQL database with any of the following, you may experience problems with your connections dropping out (see JIRA-15731 for details). Please read Surviving Connection Closures for information on how to address this.
  - JIRA 3.13 or above,
  - version 5.5.25 or higher of Tomcat 5,
  - version 6.0.13 or higher of Tomcat 6,

- **Special characters for database password** — JIRA is not able to interpret special characters for database password. Please refer to additional hints about setting password for database [here](#).

- **Using the InnoDB storage engine** — The default storage engine used by MySQL Server versions prior to 5.5 is MyISAM. Hence, a JIRA database running on a default configuration of a MySQL Server earlier than version 5.5, could experience table creation problems (JIRA-24124), which may result in data corruption in JIRA. We strongly recommend specifying the sessionVariables=storage_engine=InnoDB parameter in your database URL (as stated above). Doing so ensures that tables written to JIRA's MySQL database will use the InnoDB storage engine, which supports 'database transactions' required by JIRA.

- **Binary logging** — Be aware that JIRA uses the 'READ-COMMITTED' transaction isolation level with MySQL, which currently only supports row-based binary logging. If you require MySQL’s binary logging features, you must configure MySQL's binary logging format to be 'row-based'. If not, you may encounter problems when creating issues in JIRA. For more information, please refer to JIRA Cannot Create Issues when Using MySQL with Binary Logging.

- **4 byte characters** — Please note that JIRA does not support using MySQL with 4 byte characters.

**Connecting JIRA to Oracle**

These instructions will help you connect JIRA to an Oracle database.

**Before you begin**

- Check whether your version of Oracle is supported. See Supported Platforms.
- If you are Migrating JIRA to Another Server, create an export of your data as an XML backup. You will then be able to transfer data from your old database to your new database, as described in Switching databases.
- Shut down JIRA before you begin, unless you are running the Setup Wizard.

**On this page:**

- Before you begin
- 1. Configure Oracle
- 2. Copy the Oracle JDBC Driver to Your Application Server (JIRA WAR Only)
- 3. Configure Your JIRA Server to Connect to Your Oracle Database
- 4. Start JIRA
- Installation notes

1. **Configure Oracle**

   1. Ensure that you have a database instance available for JIRA (either create a new one or use an existing one).
   2. Within that database instance, create a user which JIRA will connect as (e.g. jiradbuser).
      
      **Remember this database user name**, as it will be used to configure JIRA's connection to this database in subsequent steps.
      
      ```
      create user <user> identified by <user_pass> default tablespace <tablespace_name> quota unlimited on <tablespace_name>;
      ```

      **Note:**
      
      - When you create a user in Oracle, Oracle will create a 'schema' automatically.
When you create a user, the tablespace for the table objects must be specified.

3. Ensure that the user has the following permissions:

```sql
grant connect to <user>;
grant create table to <user>;
grant create sequence to <user>;
grant create trigger to <user>;
```

If the incorrect permissions are applied it's possible the JIRA instance will not work properly as described in [JIRA XML Backup and Restore fails with error: Could not find column <column_name> in previously parsed query](JIRA XML Backup and Restore fails with error: Could not find column <column_name> in previously parsed query). Please use these permissions only.

4. Ensure your database is configured to use the same character encoding as JIRA. The recommended encoding is AL32UTF8 (the Oracle equivalent of Unicode UTF-8).

2. Copy the Oracle JDBC Driver to Your Application Server (JIRA WAR Only)

⚠ **Skip this step** if you installed a 'Recommended' distribution of JIRA, which includes the Oracle JDBC driver. The JIRA WAR distribution does not include this driver.

1. Download the Oracle JDBC driver (from Oracle's site).
2. Add the appropriate Oracle JDBC driver jar (ojdbc6.jar for JDK 1.6) to the lib/ directory.

Please note that a number of the Oracle JDBC driver versions cannot be used with JIRA or are inherently unstable. The known issues with Oracle drivers are as follows:

- **We recommend** that you use the 11.2.x version of the driver for all versions of Oracle (it is backwards compatible). Many other versions of the driver have been noted to have problems, such as:
  - Version 10.2.0.3.0 of the 10g Release 2 JDBC driver has been noted to produce occurrences of error ORA-01461. The Oracle Support site has further details on this Oracle server issue, although you will need an Oracle support account to access this site.
  - Version 10.2.0.1.0 of the 10g Release 2 JDBC driver hangs with some databases.
  - The 10g Release 1 JDBC driver (10.1.0.4) does not hang, but throws ArrayIndexOutOfBoundsExceptions.

- Note, that JDK 1.6 is not supported for JIRA from JIRA 6.0 and later. However, you should be able to use the Oracle JDBC driver for JDK 1.6 with JDK 1.7.

3. Configure Your JIRA Server to Connect to Your Oracle Database

There are three ways to configure your JIRA server to connect to your Oracle database:

- **Using the JIRA setup wizard** (not applicable to JIRA WAR) — Use this method, if you have just installed JIRA and are setting it up for the first time. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.

- **Using the JIRA configuration tool** (not applicable to JIRA WAR) — Use this method, if you have an existing JIRA instance. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.

- **Manually** — Only use this method if you have a JIRA WAR instance or you have a console-only connection to your JIRA server. You will be required to manually update the dbconfig.xml file in your JIRA Home Directory.

**Instructions for each configuration method**

**JIRA setup wizard**

The JIRA setup wizard will display when you access JIRA for the first time in your browser.

1. In the first screen, 'Configure Language and Database', set
1. Run the JIRA configuration tool as follows:
   - **Windows**: Open a command prompt and run `config.bat` in the `bin` sub-directory of the JIRA Installation Directory.
   - **Linux/Unix**: Open a console and execute `config.sh` in the `bin` sub-directory of the JIRA Installation Directory.
   \( i \) This may fail with the error as described in our Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error KB article. Please refer to it for the workaround.

2. Navigate to the **Database** tab and set **Database type** to **Oracle**.

3. Fill out the fields, as described in the **Database connection fields** section below.

4. Test your connection and save. Any custom settings specified while manually configuring JIRA with Oracle (e.g., adding the `<connection-properties>SetBigStringTryClob=true</connection-properties>`) will be deleted. You will need to reinstate them manually.

5. Restart JIRA.

### Manually

1. Locate the `dbconfig.xml` file at the root of your JIRA Home Directory.
   - If this file does not exist, create the file, copy and paste the

---

**Database Connection to My own database.**

2. Set **Database Type** to **Oracle**.

3. Fill out the fields, as described in the **Database connection fields** section below.

4. Test your connection and save.
example XML code (shown below) into this file.

2. Update the file, as described in the Database connection fields section below. Escape any 's' characters by adding 'amp;' to the end of each one.

- Note, the <database-type/> element must specify your type of database, e.g. oracle 10g. If you forget to do this and you start JIRA, your database tables may be created incorrectly. See Incorrect database type specified if this happens to you.

3. Save the file and restart JIRA.

**Database connection fields**

<table>
<thead>
<tr>
<th>Setup Wizard / Configuration Tool</th>
<th>dbconfig.xml</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Located in the &lt;url&gt; tag (bold text in example below): <code>&lt;url&gt;jdbc:oracle:thin:@dbserver:1521:ORCL&lt;/url&gt;</code></td>
<td>The name or IP address of the machine that the Oracle server is installed on.</td>
</tr>
<tr>
<td>Port</td>
<td>Located in the &lt;url&gt; tag (bold text in example below): <code>&lt;url&gt;jdbc:oracle:thin:@dbserver:1521:ORCL&lt;/url&gt;</code></td>
<td>The TCP/IP port that the Oracle server is listening on. The default port number for Oracle is '1521'.</td>
</tr>
<tr>
<td>SID</td>
<td>Located in the &lt;url&gt; tag (bold text in example below): <code>&lt;url&gt;jdbc:oracle:thin:@dbserver:1521:ORCL&lt;/url&gt;</code></td>
<td>The Oracle &quot;System Identifier&quot;. The default value for most Oracle servers is 'ORCL'. If you are using the Oracle Express Edition, this will be 'XE'.</td>
</tr>
<tr>
<td>Username</td>
<td>Located in the &lt;username&gt; tag (see bold text in example below): <code>&lt;username&gt;jiradbuser&lt;/username&gt;</code></td>
<td>The user that JIRA uses to connect to the Oracle server. You should have created this in Step 1 above.</td>
</tr>
<tr>
<td>Password</td>
<td>Located in the &lt;password&gt; tag (see bold text in example below): <code>&lt;password&gt;jiradbuser&lt;/password&gt;</code></td>
<td>The user's password — used to authenticate with the Oracle server.</td>
</tr>
</tbody>
</table>

**Sample dbconfig.xml file**

For more information about the child elements of `<jdbc-datasource/>` beginning with pool in the dbconfig .xml file above, see Tuning Database Connections.
<?xml version="1.0" encoding="UTF-8"?>

<jira-database-config>
  <name>defaultDS</name>
  <delegator-name>default</delegator-name>
  <database-type>oracle10g</database-type>
  <jdbc-datasource>
    <url>jdbc:oracle:thin:@dbserver:1521:ORCL</url>
    <driver-class>oracle.jdbc.OracleDriver</driver-class>
    <username>jiradbuser</username>
    <password>password</password>
    <pool-min-size>20</pool-min-size>
    <pool-max-size>20</pool-max-size>
    <pool-max-wait>30000</pool-max-wait>
    <pool-max-idle>20</pool-max-idle>
    <pool-remove-abandoned>true</pool-remove-abandoned>
    <pool-remove-abandoned-timeout>300</pool-remove-abandoned-timeout>
    <validation-query>select 1 from dual</validation-query>
    <min-evictable-idle-time-millis>60000</min-evictable-idle-time-millis>
    <time-between-eviction-runs-millis>300000</time-between-eviction-runs-millis>
    <pool-test-while-idle>true</pool-test-while-idle>
    <pool-test-on-borrow>false</pool-test-on-borrow>
  </jdbc-datasource>
</jira-database-config>

4. Start JIRA

You should now have JIRA configured to connect to your Oracle database. The next step is to start it up!

- If you are using a 'recommended' distribution of JIRA, start it up and watch the logs for any errors.
- If you are using the JIRA WAR distribution, rebuild and redeploy the webapp in your application server.

✔ Congratulations, you now have JIRA connected to your Oracle database.

Installation notes

Please see JIRA and Oracle.

Known issues and troubleshooting

- If you start experiencing problems when dealing with custom workflows or working with issues that have long descriptions, comments or custom field values, try adding the element <connection-properties>SetBigStringTryClob=true</connection-properties> as a child of the </jdbc-datasource> element in your dbconfig.xml file. Adding this connection property may overcome these problems. Be aware that you will need to restart JIRA for this setting to take effect.

Connecting JIRA to SQL Server 2005

These instructions will help you connect JIRA to a Microsoft SQL Server 2005 database.

Before you begin

- Check whether your version of SQL Server is supported. See Supported Platforms. Note, SQL Server Express is not supported; however, it is possible to set up JIRA to work with this database. As it's not supported, we have no docs available for this configuration.
- If you are Migrating JIRA to Another Server, create an export of your data as an XML backup. You will
then be able to transfer data from your old database to your new database, as described in Switching databases.

- Shut down JIRA before you begin, unless you are running the Setup Wizard.

## On this page:

- Before you begin
- 1. Create and Configure the SQL Server Database
- 2. Copy the SQL Server JDBC Driver to Your Application Server (JIRA WAR Only)
- 3. Configure Your JIRA Server to Connect to Your SQL Server 2005 Database
- 4. Start JIRA
- Installation notes

### 1. Create and Configure the SQL Server Database

1. Create a database for JIRA to store issues in (e.g. jiradb).
   **Remember your database name,** as it will be used to configure JIRA's connection to this database in subsequent steps.
   - Collation type must be **case-insensitive**, **accent-insensitive**, and **language neutral** for example, 'SQL_Latin1_General_CP437_CI_AI' is a case-insensitive, accent-insensitive and language neutral collation type. If your SQL Server installation's collation type settings have not been changed from their defaults, check the collation type settings.
   - SQL Server uses Unicode encoding to store characters. This is sufficient to prevent any possible encoding problems.

2. Create a database user which JIRA will connect as (e.g. jiradbuser).
   **Remember your database user name,** as it will be used to configure JIRA's connection to this database in subsequent steps.
   - This database user should **not** be the database owner, but **should** be in the db_owner role.

3. Create an empty 'schema' in the database (e.g. jiraschema) for the JIRA tables.
   **Remember this database schema name,** as it will be used to configure JIRA's connection to this database in subsequent steps.
   - A 'schema' in SQL Server 2005 is a distinct namespace used to contain objects and is **different** from a traditional database schema. You are not required to create any of JIRA's tables, fields or relationships (JIRA will create these objects in your empty schema when it starts for the first time). You can read more on SQL Server 2005 schemas in the relevant Microsoft documentation.

4. Ensure that the database user has permission to connect to the database, and create and populate tables in the newly-created schema.
   - If you are having difficulties setting up your JIRA database for SQL Server, additional information is available in the Setting Up a SQL Server 2005 database for JIRA document.

5. Ensure that TCP/IP is enabled on SQL Server and listening on the correct port (which is 1433 for a default SQL Server installation).
   **Remember this port number,** as it will be used to configure JIRA's connection to this database in subsequent steps.
   - Read the Microsoft documentation for information on how to enable a network protocol (TCP/IP) and how to configure SQL server to listen on a specific port.

6. Ensure that SQL Server is operating in the appropriate authentication mode.
   - By default, SQL Server operates in 'Windows Authentication Mode'. However, if your user is not associated with a trusted SQL connection, i.e. 'Microsoft SQL Server, Error: 18452' is received during JIRA startup, you will need to change the authentication mode to 'Mixed Authentication Mode'. Read the Microsoft documentation on authentication modes and changing the authentication mode to 'Mixed Authentication Mode'

7. Turn off the SET NOCOUNT option (see the Error caused by SET NOCOUNT in MS SQL Server for an explanation). To turn off SET NOCOUNT:
   - Open SQL Server Management Studio and navigate to Tools > Options > Query Execution > SQL Server > Advanced. The following screenshot displays the configuration panel for this setting in MSSQL Server 2005. Ensure that the SET NOCOUNT option is **not selected**.
• Access the **Query Console** by right clicking on the newly created database and selecting ‘**New Query**’. Execute the following command to set the isolation level.

```sql
ALTER DATABASE THE-NEW-DATABASE-CREATED-FOR-JIRA SET READ_COMMITTED_SNAPSHOT ON
```

2. Copy the SQL Server JDBC Driver to Your Application Server (JIRA WAR Only)

**⚠️ Skip this step** if you installed a ‘Recommended’ distribution of JIRA, which includes the SQL Server JDBC driver. The JIRA **WAR** distribution does not include this driver.

1. Download the SQL Server JDBC driver (v1.2.4) from JTDS.

   *Microsoft have their own JDBC driver but we **strongly recommend avoiding it** after receiving many reports of intermittent disconnections (JIRA-5760 and JIRA-6872), workflow problems (JIRA-8443) and Chinese character problems (JRA-5054).*

2. Add the SQL Server JDBC driver jar (jtds-1.2.4.jar) to the `<Tomcat install>/lib/` directory.

3. Configure Your JIRA Server to Connect to Your SQL Server 2005 Database

There are three ways to configure your JIRA server to connect to your SQL Server database:

- **Using the JIRA setup wizard** (not applicable to JIRA **WAR**) — Use this method, if you have just installed JIRA and are setting it up for the first time. Your settings will be saved to the `dbconfig.xml` file in your JIRA Home Directory.

- **Using the JIRA configuration tool** (not applicable to JIRA **WAR**) — Use this method, if you have an existing JIRA instance. Your settings will be saved to the `dbconfig.xml` file in your JIRA Home Directory.

- **Manually** — Only use this method if you have a JIRA **WAR** instance or you have a console-only connection to your JIRA server. You will be required to manually update the `dbconfig.xml` file in your JIRA Home Directory.

**Instructions for each configuration method**
JIRA setup wizard

The JIRA setup wizard will display when you access JIRA for the first time in your browser.

1. In the first screen, 'Configure Language and Database', set Database Connection to My own database.
2. Set Database Type to SQL Server.
3. Fill out the fields, as described in the Database connection fields section below.
4. Test your connection and save.

JIRA configuration tool

1. Run the JIRA configuration tool as follows:
   - **Windows**: Open a command prompt and run config.bat in the bin sub-directory of the JIRA Installation Directory.
   - **Linux/Unix**: Open a console and execute config.sh in the bin sub-directory of the JIRA Installation Directory.
     This may fail with the error as described in our Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error KB article. Please refer to it for the workaround.
2. Navigate to the Database tab and set Database type to SQL Server.
3. Fill out the fields, as described in the Database connection fields section below.
4. Test your connection and save.
5. Restart JIRA.

Manually

1. Locate the dbconfig.xml file at the root of your JIRA Home Directory.
   - If this file does not exist, create the file, copy and paste the
example XML code (shown below) into this file.

2. Update the file, as described in the Database connection fields section below. Escape any 's' characters by adding 'amp; to the end of each one.

   • Note, the <database-type/> element must specify your type of database, e.g. mssql. If you forget to do this and you start JIRA, your database tables may be created incorrectly. See Incorrect database type specified if this happens to you.

3. Save the file and restart JIRA.

Database connection fields

<table>
<thead>
<tr>
<th>Setup Wizard / Configuration Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hostname</strong></td>
<td>Located in the &lt;url&gt; tag (bold text in example below): &lt;url&gt;jdbc:jdbc:sqlserver://dbserver:1433/jiradb&lt;/url&gt; The name or IP address of the machine that the SQL Server server is installed on.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Located in the &lt;url&gt; tag (bold text in example below): &lt;url&gt;jdbc:jdbc:sqlserver://dbserver:1433/jiradb&lt;/url&gt; The TCP/IP port that the SQL Server server is listening on. You can leave this blank to use the default port.</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>Located in the &lt;url&gt; tag (bold text in example below): &lt;url&gt;jdbc:jdbc:sqlserver://dbserver:1433/jiradb&lt;/url&gt; The name of your SQL Server database (into which JIRA will save its data). You should have created this in Step 1 above.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>Located in the &lt;username&gt; tag (see bold text in example below): &lt;username&gt;jiradbuser&lt;/username&gt; The user that JIRA uses to connect to the SQL Server server. You should have created this in Step 1 above.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Located in the &lt;password&gt; tag (see bold text in example below): &lt;password&gt;jiradbuser&lt;/password&gt; The user's password — used to authenticate with the SQL Server server.</td>
</tr>
<tr>
<td><strong>Schema</strong></td>
<td>Located in the &lt;schema-name&gt; tag (see bold text in example below): &lt;schema-name&gt;dbo&lt;/schema-name&gt; The name of the schema that your SQL Server database uses. You should have created this in Step 1 above.</td>
</tr>
</tbody>
</table>

Sample dbconfig.xml file

For more information about the child elements of <jdbc-datasource/> beginning with pool in the dbconfig
4. Start JIRA

You should now have JIRA configured to connect to your SQL Server database. The next step is to start it up!

- If you are using a 'recommended' distribution of JIRA, start it up and watch the logs for any errors.
- If you are using the JIRA WAR distribution, rebuild and redeploy the webapp in your application server.

✔ Congratulations, you now have JIRA connected to your SQL Server database.

Installation notes

Please see JIRA and MS SQL Server 2005.

Connecting JIRA to SQL Server 2008

These instructions will help you connect JIRA to a Microsoft SQL Server 2008 database.

Before you begin

- Check whether your version of SQL Server is supported. See Supported Platforms. Note, SQL Server Express is not supported, however, it is possible to set up JIRA to work with this database.
- If you are Migrating JIRA to Another Server, create an export of your data as an XML backup. You will then be able to transfer data from your old database to your new database, as described in Switching databases.
- Shut down JIRA before you begin, unless you are running the Setup Wizard.

```xml
<?xml version="1.0" encoding="UTF-8"?>

<jira-database-config>
  <name>defaultDS</name>
  <delegator-name>default</delegator-name>
  <database-type>mssql</database-type>
  <schema-name>dbo</schema-name>
  <jdbc-datasource>
    <url>jdbc:jtds:sqlserver://dbserver:1433/jiradb</url>
    <driver-class>net.sourceforge.jtds.jdbc.Driver</driver-class>
    <username>jiradbuser</username>
    <password>password</password>
    <pool-min-size>20</pool-min-size>
    <pool-max-size>20</pool-max-size>
    <pool-max-wait>30000</pool-max-wait>
    <pool-max-idle>20</pool-max-idle>
    <pool-remove-abandoned>true</pool-remove-abandoned>
    <pool-remove-abandoned-timeout>300</pool-remove-abandoned-timeout>
    <validation-query>select 1</validation-query>
    <min-evictable-idle-time-millis>60000</min-evictable-idle-time-millis>
    <time-between-eviction-runs-millis>300000</time-between-eviction-runs-millis>
    <pool-test-while-idle>true</pool-test-while-idle>
  </jdbc-datasource>
</jira-database-config>
```
On this page:
- Before you begin
- 1. Create and Configure the SQL Server Database
- 2. Copy the SQL Server JDBC Driver to Your Application Server (JIRA WAR Only)
- 3. Configure Your JIRA Server to Connect to Your SQL Server 2008 Database
- 4. Start JIRA
- Installation notes

1. Create and Configure the SQL Server Database

1. Create a database for JIRA to store issues in (e.g. jiradb).
   **Remember your database name**, as it will be used to configure JIRA’s connection to this database in subsequent steps.
   - Collation type must be **case-insensitive**, **accent-insensitive**, and **language neutral** for example, 'SQL_Latin1_General_CP437_CI_AI' is a case-insensitive, accent-insensitive, and language neutral collation type. If your SQL Server installation’s collation type settings have not been changed from their defaults, check the collation type settings.
   - SQL Server uses Unicode encoding to store characters. This is sufficient to prevent any possible encoding problems.

2. Create a database user which JIRA will connect as (e.g. jiradbuser).
   **Remember your database user name**, as it will be used to configure JIRA’s connection to this database in subsequent steps.
   - This database user should **not** be the database owner, but **should** be in the db_owner role.

3. Create an empty ‘schema’ in the database (e.g. jiraschema) for the JIRA tables.
   **Remember this database schema name**, as it will be used to configure JIRA’s connection to this database in subsequent steps.
   - A ‘schema’ in SQL Server 2008 is a distinct namespace used to contain objects and is **different** from a traditional database schema. You are not required to create any of JIRA’s tables, fields or relationships (JIRA will create these objects in your empty schema when it starts for the first time).

4. Ensure that the database user has permission to connect to the database, and create and populate tables in the newly-created schema.

5. Ensure that TCP/IP is enabled on SQL Server and listening on the correct port (which is 1433 for a default SQL Server installation).
   **Remember this port number**, as it will be used to configure JIRA’s connection to this database in subsequent steps.
   - Read the Microsoft documentation for information on how to enable a network protocol (TCP/IP) and how to configure SQL server to listen on a specific port.

6. Ensure that SQL Server is operating in the appropriate authentication mode.
   - By default, SQL Server operates in ‘Windows Authentication Mode’. However, if your user is not associated with a trusted SQL connection, i.e. ‘Microsoft SQL Server, Error: 18452’ is received during JIRA startup, you will need to change the authentication mode to ‘Mixed Authentication Mode’. Read the Microsoft documentation on authentication modes and changing the authentication mode to ‘Mixed Authentication Mode’

7. Turn off the SET NOCOUNT option. (The JIRA on MS SQL Server document provides details on the errors that occur if SET NOCOUNT is set.) To turn off SET NOCOUNT:
   - Open SQL Server Management Studio and navigate to **Tools > Options > Query Execution > SQL Server > Advanced**. The following screenshot displays the configuration panel for this setting in MSSQL Server 2008. Ensure that the **SET NOCOUNT** option is **not selected**: 
You will also need to access the **Server > Properties > Connections > Default Connections** properties box and clear the **no count** option.
• Access the **Query Console** by right clicking on the newly created database and selecting 'New Query'. Execute the following command to set the isolation level.

```
ALTER DATABASE THE-NEW-DATABASE-CREATED-FOR-JIRA SET READ_COMMITTED_SNAPSHOT ON
```

2. Copy the SQL Server JDBC Driver to Your Application Server (JIRA WAR Only)

- **Skip this step** if you installed a ‘Recommended’ distribution of JIRA, which includes the SQL Server JDBC driver. The JIRA WAR distribution does not include this driver.

  1. Download the SQL Server JDBC driver (v1.2.4) from jTDS.

  - Microsoft have their own JDBC driver but we have not tested JIRA with it. Previous versions of the MS JDBC driver have been known to cause issues: (JRA-5760 and JRA-6872), workflow problems (JRA-8443) and Chinese character problems (JRA-5054).

  2. Add the SQL Server JDBC driver jar (jtds-1.2.4.jar) to the lib/ directory.

3. Configure Your JIRA Server to Connect to Your SQL Server 2008 Database

There are three ways to configure your JIRA server to connect to your SQL Server database:

- **Using the JIRA setup wizard** (not applicable to JIRA WAR) — Use this method, if you have just installed JIRA and are setting it up for the first time. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.

- **Using the JIRA configuration tool** (not applicable to JIRA WAR) — Use this method, if you have an existing JIRA instance. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.

- **Manually** — Only use this method if you have a JIRA WAR instance or you have a console-only connection to your JIRA server. You will be required to manually update the dbconfig.xml file in your JIRA Home Directory.

**Instructions for each configuration method**

**JIRA setup wizard**

The JIRA setup wizard will display when you access JIRA for the first time in your browser.

1. In the first screen, 'Configure Language and Database', set **Database Connection** to My own database.
2. Set **Database Type** to SQL Server.
3. Fill out the fields, as described in the Database connection fields section below.
4. Test your connection and save.

**JIRA configuration tool**
1. Run the JIRA configuration tool as follows:
   - **Windows**: Open a command prompt and run `config.bat` in the `bin` sub-directory of the JIRA Installation Directory.
   - **Linux/Unix**: Open a console and execute `config.sh` in the `bin` sub-directory of the JIRA Installation Directory.  
     This may fail with the error as described in our Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error KB article. Please refer to it for the workaround.

2. Navigate to the Database tab and set Database type to SQL Server.
3. Fill out the fields, as described in the Database connection fields section below.
4. Test your connection and save.
5. Restart JIRA.

**Manually**

1. Locate the `dbconfig.xml` file at the root of your JIRA Home Directory.
   - If this file does not exist, create the file, copy and paste the example XML code (shown below) into this file.
2. Update the file, as described in the Database connection fields section below. Escape any ‘&’ characters by adding ‘&’ to the end of each one.
   - Note, the `<database-type/>` element must specify your type of database, e.g. `mssql`. If you forget to do this and you start JIRA, your database tables may be created incorrectly. See Incorrect database type specified if this happens to you.
3. Save the file and restart JIRA.

### Database connection fields

<table>
<thead>
<tr>
<th>Setup Wizard / Configuration Tool</th>
<th>dbconfig.xml</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hostname</strong></td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:jtds:sqlserver://dbserver:1433/jiradb&lt;/url&gt;</code></td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:jtds:sqlserver://dbserver:1433/jiradb&lt;/url&gt;</code></td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:jtds:sqlserver://dbserver:1433/jiradb&lt;/url&gt;</code></td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>Located in the <code>&lt;username&gt;</code> tag (see bold text in example below): <code>&lt;username&gt;jiradbuser&lt;/username&gt;</code></td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Located in the <code>&lt;password&gt;</code> tag (see bold text in example below): <code>&lt;password&gt;jiradbuser&lt;/password&gt;</code></td>
</tr>
<tr>
<td><strong>Schema</strong></td>
<td>Located in the <code>&lt;schema-name&gt;</code> tag (see bold text in example below): <code>&lt;schema-name&gt;dbo&lt;/schema-name&gt;</code></td>
</tr>
</tbody>
</table>

**Sample dbconfig.xml file**

For more information about the child elements of `<jdbc-datasource/>` beginning with `pool` in the `dbconfig.xml` file above, see Tuning Database Connections.
<jira-database-config>
  <name>defaultDS</name>
  <delegator-name>default</delegator-name>
  <database-type>mssql</database-type>
  <schema-name>jiraschema</schema-name>
  <jdbc-datasource>
    <url>jdbc:jtds:sqlserver://dbserver:1433/jiradb</url>
    <driver-class>net.sourceforge.jtds.jdbc.Driver</driver-class>
    <username>jiradbuser</username>
    <password>password</password>
    <pool-min-size>20</pool-min-size>
    <pool-max-size>20</pool-max-size>
    <pool-max-wait>30000</pool-max-wait>
    <pool-max-idle>20</pool-max-idle>
    <pool-remove-abandoned>true</pool-remove-abandoned>
    <pool-remove-abandoned-timeout>300</pool-remove-abandoned-timeout>
    
    <validation-query>select 1</validation-query>
    <min-evictable-idle-time-millis>60000</min-evictable-idle-time-millis>
    <time-between-eviction-runs-millis>300000</time-between-eviction-runs-millis>
    
    <pool-test-while-idle>true</pool-test-while-idle>
    <pool-test-on-borrow>false</pool-test-on-borrow>
  </jdbc-datasource>
</jira-database-config>

4. Start JIRA

You should now have JIRA configured to connect to your SQL Server database. The next step is to start it up!

- If you are using a 'recommended' distribution of JIRA, start it up and watch the logs for any errors.
- If you are using the JIRA WAR distribution, rebuild and redeploy the webapp in your application server.

✔ Congratulations, you now have JIRA connected to your SQL Server database.

Installation notes

Please see [JIRA and MS SQL Server 2008](#).

Connecting JIRA to SQL Server 2012

These instructions will help you connect JIRA to a Microsoft SQL Server 2012 database.

Before you begin

- Check whether your version of SQL Server is supported. See [Supported Platforms](#). Note, SQL Server Express is not supported, however, it is possible to set up JIRA to work with this database.
- If you are [Migrating JIRA to Another Server](#), create an export of your data as an XML backup. You will then be able to transfer data from your old database to your new database, as described in [Switching databases](#).
- Shut down JIRA before you begin, unless you are running the Setup Wizard.
1. Create and Configure the SQL Server Database

1. Create a database for JIRA to store issues in (e.g. jiradb).

   **Remember your database name**, as it will be used to configure JIRA's connection to this database in subsequent steps.
   - Collation type must be **case-insensitive**, **accent-insensitive**, and **language neutral** for example, 'SQL_Latin1_General_CP437_CI_A' is a case-insensitive, accent-insensitive, and language neutral collation type. If your SQL Server installation's collation type settings have not been changed from their defaults, check the collation type settings.
   - SQL Server uses Unicode encoding to store characters. This is sufficient to prevent any possible encoding problems.

2. Create a database user which JIRA will connect as (e.g. jiradbuser).

   **Remember your database user name**, as it will be used to configure JIRA's connection to this database in subsequent steps.
   - This database user should **not** be the database owner, but **should** be in the db_owner role.
   - This user should be a SQL user and not a Windows user nor an Active Directory ID.

3. Create an empty 'schema' in the database (e.g. jiraschema) for the JIRA tables.

   **Remember this database schema name**, as it will be used to configure JIRA's connection to this database in subsequent steps.
   - A 'schema' in SQL Server 2012 is a distinct namespace used to contain objects and is **different** from a traditional database schema. You are not required to create any of JIRA's tables, fields or relationships (JIRA will create these objects in your empty schema when it starts for the first time).
   - You can read more on SQL Server 2012 schemas in the relevant **Microsoft documentation**.

4. Ensure that the database user has permission to connect to the database, and create and populate tables in the newly-created schema.

5. Ensure that TCP/IP is enabled on SQL Server and listening on the correct port (which is 1433 for a default SQL Server installation).

   **Remember this port number**, as it will be used to configure JIRA's connection to this database in subsequent steps.
   - Read the Microsoft documentation for information on how to enable a network protocol (TCP/IP) and how to configure SQL server to listen on a specific port.

6. Ensure that SQL Server is operating in the appropriate authentication mode.

   - By default, SQL Server operates in 'Windows Authentication Mode’. However, if your user is not associated with a trusted SQL connection, i.e. 'Microsoft SQL Server, Error: 18452' is received during JIRA startup, you will need to change the authentication mode to 'Mixed Authentication Mode'. Read the Microsoft documentation on authentication modes and changing the authentication mode to 'Mixed Authentication Mode'.

7. Turn off the SET NOCOUNT option. (The JIRA on MS SQL Server document provides details on the errors that occur if SET NOCOUNT is set.) To turn off SET NOCOUNT:
   - Open **SQL Server Management Studio** and navigate to Tools > Options > Query Execution > SQL Server > Advanced. The following screenshot displays the configuration panel for this setting in MSSQL Server 2012. Ensure that the **SET NOCOUNT** option is **not selected**.
You will also need to right-click on the server to access the Properties > Connections > Default Connections properties box and clear the no count option.
### Connections

**Maximum number of concurrent connections (0 = unlimited):**

[ ]

[ ] Use query governor to prevent long-running queries

[ ]

**Default connection options:**

- [ ] arithmetic
- [ ] ignore
- [ ] quoted identifier
- [ ] no count
- [ ] ANSI NULL Default On
- [ ] ANSI NULL Default Off
- [ ] concat null yields null

### Remote server connections

- **Allow remote connections to this server**
- **Remote query timeout (in seconds, 0 = no timeout):**
  600
- [ ] Require distributed transactions for server-to-server communication

---

*Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
2. Copy the SQL Server JDBC Driver to Your Application Server (JIRA WAR Only)

⚠️ Skip this step if you installed a ‘Recommended’ distribution of JIRA, which includes the SQL Server JDBC driver. The JIRA WAR distribution does not include this driver.

1. Download the SQL Server JDBC driver (v1.2.4) from jTDS.
   ⚠️ Regarding Microsoft's official JDBC driver: Microsoft has its own JDBC driver but we have not tested JIRA with it. Previous versions of the MS JDBC driver have been known to cause issues: (JRA-5760 and JRA-6872), workflow problems (JRA-8443) and Chinese character problems (JRA-5054). The latest version haven't been tested yet, so official support cannot be guaranteed.
2. Add the SQL Server JDBC driver jar (jtds-1.2.4.jar) to the lib/ directory.

3. Configure Your JIRA Server to Connect to Your SQL Server 2012 Database

There are three ways to configure your JIRA server to connect to your SQL Server database:

- **Using the JIRA setup wizard** (not applicable to JIRA WAR) — Use this method, if you have just installed JIRA and are setting it up for the first time. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.
- **Using the JIRA configuration tool** (not applicable to JIRA WAR) — Use this method, if you have an existing JIRA instance. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.
- **Manually** — Only use this method if you have a JIRA WAR instance or you have a console-only connection to your JIRA server. You will be required to manually update the dbconfig.xml file in your JIRA Home Directory.

**Instructions for each configuration method**

**JIRA setup wizard**

The JIRA setup wizard will display when you access JIRA for the first time in your browser.

1. In the first screen, 'Configure Language and Database', set **Database Connection** to **My own database**.
2. Set **Database Type** to **SQL Server**.
3. Fill out the fields, as described in the **Database connection fields** section below.
4. Test your connection and save.

**JIRA configuration tool**
1. Run the JIRA configuration tool as follows:
   - **Windows**: Open a command prompt and run `config.bat` in the `bin` sub-directory of the JIRA Installation Directory.
   - **Linux/Unix**: Open a console and execute `config.sh` in the `bin` sub-directory of the JIRA Installation Directory.
     This may fail with the error as described in our Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error KB article. Please refer to it for the workaround.

2. Navigate to the Database tab and set **Database type** to SQL Server.

3. Fill out the fields, as described in the Database connection fields section below.

4. Test your connection and save.

5. Restart JIRA.

Manually

1. Locate the `dbconfig.xml` file at the root of your JIRA Home Directory.
   - If this file does not exist, create the file, copy and paste the example XML code (shown below) into this file.

2. Update the file, as described in the Database connection fields section below. Escape any `&` characters by adding `&` to the end of each one.
   - Note, the `<database-type/>` element must specify your type of database, e.g. `mssql`. If you forget to do this and you start JIRA, your database tables may be created incorrectly. See Incorrect database type specified if this happens to you.
3. Save the file and restart JIRA.

### Database connection fields

<table>
<thead>
<tr>
<th>Setup Wizard / Configuration Tool</th>
<th>dbconfig.xml</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:jtds:sqlserver://dbserver:1433/jiradb&lt;/url&gt;</code></td>
<td>The name or IP address of the machine that the SQL Server server is installed on.</td>
</tr>
<tr>
<td>Port</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:jtds:sqlserver://dbserver:1433/jiradb&lt;/url&gt;</code></td>
<td>The TCP/IP port that the SQL Server server is listening on. You can leave this blank to use the default port.</td>
</tr>
<tr>
<td>Database</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:jtds:sqlserver://dbserver:1433/jiradb&lt;/url&gt;</code></td>
<td>The name of your SQL Server database (into which JIRA will save its data). You should have created this in Step 1 above.</td>
</tr>
<tr>
<td>Username</td>
<td>Located in the <code>&lt;username&gt;</code> tag (see bold text in example below): <code>&lt;username&gt;jiradbuser&lt;/username&gt;</code></td>
<td>The user that JIRA uses to connect to the SQL Server server. You should have created this in Step 1 above.</td>
</tr>
<tr>
<td>Password</td>
<td>Located in the <code>&lt;password&gt;</code> tag (see bold text in example below): <code>&lt;password&gt;jiradbuser&lt;/password&gt;</code></td>
<td>The user's password — used to authenticate with the SQL Server server.</td>
</tr>
<tr>
<td>Schema</td>
<td>Located in the <code>&lt;schema-name&gt;</code> tag (see bold text in example below): <code>&lt;schema-name&gt;dbo&lt;/schema-name&gt;</code></td>
<td>The name of the schema that your SQL Server database uses. You should have created this in Step 1 above.</td>
</tr>
</tbody>
</table>

#### Sample dbconfig.xml file

For more information about the child elements of `<jdbc-datasource/>` beginning with `pool` in the `dbconfig.xml` file above, see Tuning Database Connections.
<jira-database-config>
  <name>defaultDS</name>
  <delegator-name>default</delegator-name>
  <database-type>mssql</database-type>
  <schema-name>jiraschema</schema-name>
  <jdbc-datasource>
    <url>jdbc:jtds:sqlserver://dbserver:1433/jiradb</url>
    <driver-class>net.sourceforge.jtds.jdbc.Driver</driver-class>
    <username>jiradbuser</username>
    <password>password</password>
    <pool-min-size>20</pool-min-size>
    <pool-max-size>20</pool-max-size>
    <pool-max-wait>30000</pool-max-wait>
    <pool-max-idle>20</pool-max-idle>
    <pool-remove-abandoned>true</pool-remove-abandoned>
    <pool-remove-abandoned-timeout>300</pool-remove-abandoned-timeout>
    <validation-query>select 1</validation-query>
    <min-evictable-idle-time-millis>60000</min-evictable-idle-time-millis>
    <time-between-eviction-runs-millis>300000</time-between-eviction-runs-millis>
    <pool-test-while-idle>true</pool-test-while-idle>
  </jdbc-datasource>
</jira-database-config>

4. Start JIRA

You should now have JIRA configured to connect to your SQL Server database. The next step is to start it up!

- If you are using a 'recommended' distribution of JIRA, start it up and watch the logs for any errors.
- If you are using the JIRA WAR distribution, rebuild and redeploy the webapp in your application server.

⚠️ Congratulations, you now have JIRA connected to your SQL Server database.

Connecting JIRA to HSQLDB

These instructions will help you connect JIRA to an HSQL database.

Before you begin

**Do not use HSQLDB in production**

JIRA ships with a built-in HSQLDB (HyperSQL DataBase) database. While this database is suitable for evaluation purposes, it is susceptible to data loss during system crashes. Hence, for production environments we **strongly recommend** that you configure JIRA to use an **external database**. See our list of supported databases on [Supported Platforms](https://confluence.atlassian.com/display/JIRA/Supported+Platforms).

- If you are [Migrating JIRA to Another Server](https://confluence.atlassian.com/display/JIRA/Migrating+JIRA+to+Another+Server), create an export of your data as an XML backup. You will then be able to transfer data from your old database to your new database, as described in [Switching databases](https://confluence.atlassian.com/display/JIRA/Switching+Databases).
1. Copy the HSQLDB Driver to Your Application Server (JIRA WAR Only)

⚠️ **Skip this step** if you installed a *Recommended* distribution of JIRA, which includes the HSQL JDBC driver. The JIRA WAR distribution does not include this driver.

1. Download the HSQLDB JDBC driver — hsqldb-1.8.0.5.jar for JIRA 3.7+, or hsqldb-1.7.1-patched.jar for JIRA 3.6.5 and earlier. We **strongly recommend** upgrading to 3.7 if you wish to use hsqldb, as hsqldb 1.7.x is prone to data corruption.
2. Add the HSQLDB JDBC driver jar to the lib/ directory.

4. Configure Your JIRA Server to Connect to Your HSQL Database

There are three ways to configure your JIRA server to connect to your HSQL database:

- **Using the JIRA setup wizard** (not applicable to JIRA WAR) — Use this method, if you have just installed JIRA and are setting it up for the first time. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.
- **Using the JIRA configuration tool** (not applicable to JIRA WAR) — Use this method, if you have an existing JIRA instance. Your settings will be saved to the dbconfig.xml file in your JIRA Home Directory.
- **Manually** — Only use this method if you have a JIRA WAR instance or you have a console-only connection to your JIRA server. You will be required to manually update the dbconfig.xml file in your JIRA Home Directory.

**Instructions for each configuration method**

**JIRA setup wizard**

The JIRA setup wizard will display when you access JIRA for the first time in your browser.

1. In the first screen, 'Configure Language and Database', set Database Connection to Database bundled with JIRA.
2. Go to the next step in the setup wizard. The setup wizard will set up the bundled HSQL database automatically.

**JIRA configuration tool**

1. Run the JIRA configuration tool as follows:
   - **Windows**: Open a command prompt and run config.bat in the bin sub-directory of
the JIRA Installation Directory.

- **Linux/Unix**: Open a console and execute `./config.sh` in the `bin` sub-directory of the JIRA Installation Directory. This may fail with the error as described in our Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error KB article. Please refer to it for the workaround.

2. Navigate to the **Database** tab and set **Database type** to **HSQL**.

3. Test your connection and save. The JIRA configuration tool will configure your bundled HSQL database automatically. This tool adds the following elements to the `dbconfig.xml`, which are normally required when running JIRA with HSQLDB:

   `<min-evictable-idle-time-millis>4000</min-evictable-idle-time-millis>
   <time-between-eviction-runs-millis>5000</time-between-eviction-runs-millis>`

4. Restart JIRA.

**Manually**

1. Locate the `dbconfig.xml` file at the root of your JIRA Home Directory.
   - If this file does not exist, create the file, copy and paste the example XML code (shown below) into this file.

2. Update the file, as described in the **Database connection fields** section below. Escape any 's' characters by adding ' &amp;' to the end of each one.
   - Note, the `<database-type/>` element must specify your type of database, e.g. hsql. If you forget to do this...
and you start JIRA, your database tables may be created incorrectly. See Incorrect database type specified if this happens to you.

3. Save the file and restart JIRA.

**Database connection fields**

<table>
<thead>
<tr>
<th>Field name</th>
<th>dbconfig.xml</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:hsqldb:C:\Data\JIRA 5.2.7/database/jiradb&lt;/url&gt;</code></td>
<td>The name or IP address of the machine that the HSQL server is installed on.</td>
</tr>
<tr>
<td>Database</td>
<td>Located in the <code>&lt;url&gt;</code> tag (bold text in example below): <code>&lt;url&gt;jdbc:hsqldb:C:\Data\JIRA 5.2.7/database/jiradb&lt;/url&gt;</code></td>
<td>The name of your HSQL database (into which JIRA will save its data).</td>
</tr>
<tr>
<td>Username</td>
<td>Located in the <code>&lt;username&gt;</code> tag (see bold text in example below): <code>&lt;username&gt;sa&lt;/username&gt;</code></td>
<td>The user that JIRA uses to connect to the HSQL server. You should have created this in Step 1 above.</td>
</tr>
<tr>
<td>Password</td>
<td>Located in the <code>&lt;password&gt;</code> tag (see bold text in example below): <code>&lt;password&gt;</code></td>
<td>The user's password — used to authenticate with the HSQL server.</td>
</tr>
<tr>
<td>Schema</td>
<td>Located in the <code>&lt;schema-name&gt;</code> tag (see bold text in example below): <code>&lt;schema-name&gt;PUBLIC&lt;/schema-name&gt;</code></td>
<td>The name of the schema that your HSQL database uses.</td>
</tr>
</tbody>
</table>

**Sample dbconfig.xml file**

For more information about the child elements of `<jdbc-datasource/>` beginning with pool in the dbconfig.xml file above, see Tuning Database Connections.
4. Start JIRA

You should now have JIRA configured to connect to your HSQL database. The next step is to start it up!

- If you are using a 'recommended' distribution of JIRA, start it up and watch the logs for any errors.
- If you are using the JIRA WAR distribution, rebuild and redeploy the webapp in your application server.

**Additional Notes**

- Running SQL commands in a HSQL database

**Tuning Database Connections**

JIRA uses a database connection pool, based on Apache Commons DBCP (DataBase Connection Pool), to manage JIRA’s access to its underlying database.

In earlier JIRA versions, the database connection pool was handled purely through the Apache Tomcat application server running JIRA. However, from JIRA version 4.4, JIRA’s dbconfig.xml file provides a set of database connection pool settings to Tomcat, which in turn are used by Tomcat to manage JIRA’s database connection pool. From JIRA version 5.1, the number database connection pool settings defined in JIRA’s dbconfig.xml file substantially increased.

The information on this page can help you tweak JIRA’s database connection pool settings. You can do this by using the [JIRA Configuration Tool](https://www.atlassian.com/software/jira/docs/atlassian-jira/configuration) or by directly editing JIRA’s dbconfig.xml file, as described [here](https://www.atlassian.com/software/jira/docs/atlassian-jira/configuration).

The **Advanced** tab of the JIRA Configuration Tool makes it easier to both configure and control JIRA’s database connection pool. The **Database Monitoring** page (accessible to JIRA system administrators) provides a visual tool for monitoring JIRA’s database connection usage.

---

### On this page:

- Connection pool architecture
- Tuning JIRA’s database connections
  - Connection pool settings
  - Monitoring the connection pool
Connection pool architecture

Whenever JIRA needs to access (i.e. read from or write to) its database, a database connection is required.

A database connection is a large and complex object that handles all communication between JIRA and its database. As such, database connections are time consuming to establish and consume a significant amount of memory on both the client (the JIRA application) and database server.

To avoid the impact of creating a new database connection for each database access request made by JIRA, a pool of pre-established database connections is maintained. Each new database access request made by JIRA uses a connection from this pool of pre-established connections, as required. Hence:

1. When JIRA starts up, a minimum number of database connections are established in the pool between JIRA and its database.
2. When JIRA needs to access its database, JIRA:
   a. requests a database connection from the pool
   b. uses this database connection to read from and/or write to its database
   c. returns the database connection to the pool when finished.

If the frequency of JIRA's database access requests begin to exceed the number of available database connections in the pool, extra connections are automatically created to handle the load.

Conversely, if the frequency of JIRA's database access requests begin to drop below the number of available database connections in the pool, connections can be automatically closed to release resources back to the system.

Modern databases can handle large numbers of connections relatively easily and with sufficient memory, many hundred. On the client side, however, these connections can consume a significant amount memory. Hence, it is generally best to limit the number of connections to a much smaller number while having a sufficient number for the application to rarely need to wait for a connection when it needs one.

Tuning JIRA's database connections

To tune JIRA’s database connections:

1. Shut down your JIRA installation.
2. Do either of the following:
   - If you are using a "Recommended" distribution of JIRA, use the JIRA Configuration Tool to tune JIRA's database connections.
     a. Start the JIRA Configuration Tool:
        - **Windows**: Open a command prompt and run `config.bat` in the `bin` sub-directory of the JIRA Installation Directory.
        - **Linux/Unix**: Open a console and execute `config.sh` in the `bin` sub-directory of the JIRA Installation Directory.
          - This may fail with the error as described in our Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error KB article. Please refer to it for the workaround.
          - **Please Note**: You may need to set the `JAVA_HOME` environment variable to run the JIRA Configuration Tool. See Installing Java for details.
     b. Once the JIRA Configuration Tool is running, click its Advanced tab.
c. Refer to **Connection pool settings** below for more information about the options on this tab. To specify a value for one of these options, ensure its leftmost check box has been selected first.

   Some options above are simple check boxes (i.e. in the centre of the JIRA Configuration Tool). Selecting these check boxes sets the values of their associated options to 'true'. Conversely, clearing these check boxes sets the values of their associated options to 'false'.

   d. Click the **Save** button to save your changes, which will be stored as elements in your `dbconfig.xml` file.

   - Alternatively, edit the `dbconfig.xml` file at the root of your JIRA Home Directory.

   a. Refer to **Connection pool settings** below for more information about the elements you can add to your `dbconfig.xml` file to fine tune JIRA's database connection.

   b. Save your edited `dbconfig.xml` file.

3. Restart your JIRA installation.

---

**Connection pool settings**
<table>
<thead>
<tr>
<th>JIRA Configuration Tool 'Advanced' tab option</th>
<th>Element in dbconfig.xml</th>
<th>Explanation</th>
<th>Recommendations / Notes</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum Size</strong></td>
<td>pool-max-size</td>
<td>The maximum number of database connections that can be opened at any time.</td>
<td>This value should be sufficiently large enough that JIRA rarely needs to wait for a database connection to become available when JIRA requires one. See Monitoring below for suggestions on how to set this parameter.</td>
<td>20</td>
</tr>
<tr>
<td><strong>Maximum Idle</strong></td>
<td>pool-max-idle</td>
<td>The maximum number of database connections that are allowed to remain idle in the pool.</td>
<td>Specifying a negative number sets no limit on the number of database connections that can remain idle. If the value of <strong>Minimum Idle/Size</strong> (below) is the same as that of <strong>Maximum Size</strong> (above), which is the case by default, then this setting has no effect.</td>
<td>Value of <strong>Maximum Size</strong></td>
</tr>
<tr>
<td><strong>Minimum Idle/Size</strong></td>
<td>pool-min-size</td>
<td>The minimum number of idle database connections that are kept open at any time.</td>
<td>Having this value set to that of <strong>Maximum Size</strong> (above), which is the case by default, means the pool will always have a fixed number of connections and idle connections will never be closed. On very large JIRA installations, there may be some benefit in specifying a lower value for this setting than that of <strong>Maximum Size</strong>, to conserve resources.</td>
<td>Value of <strong>Maximum Size</strong></td>
</tr>
<tr>
<td><strong>Initial Size</strong></td>
<td>pool-initial-size</td>
<td>The initial number of database connections opened in the pool.</td>
<td>This setting is not usually configured (other than the default value of 0), since a number of database connections are quickly created when JIRA starts up.</td>
<td>0 (when not specified in config.xml)</td>
</tr>
<tr>
<td><strong>Maximum Wait Time</strong></td>
<td>pool-max-wait</td>
<td>The length of time (in milliseconds) that JIRA is allowed to wait for a database connection to become available (whilst there are no free ones available in the pool), before returning an error.</td>
<td>Specifying a value of ‘-1’ means that Tomcat will wait indefinitely. You should specify a time here which is long enough to allow for any contention spikes, but short enough that users will receive a meaningful error rather than just getting no response or a browser time out.</td>
<td>30000</td>
</tr>
</tbody>
</table>

**Advanced settings**

Generally, changing the settings below are not usually required. Refer to the Apache DBCP documentation if required.

| **Pool Statements** | pool-prepared-statements | Enable the pooling of prepared statements for the database connection pool. | Prepared statements allow the pre-compilation of commonly used SQL statements, which can dramatically improve performance if the statements are executed multiple times. | false (when not specified in config.xml) |
| **Maximum Open Statements** | max-open-prepared-statements | The maximum number of open statements that can be allocated from the statement pool at the same time. | Specify zero for no limit. | 0 (when not specified in config.xml) |
| **Validation Query** | **validation-query** | The SQL query that will be used to validate connections from this pool. If specified, this query MUST be an SQL SELECT statement that returns at least one row. | See [Surviving Connection Closures](dbconfig.xml#surviving-connection-closures) for more information. | select 1 (for MySQL) (otherwise, not specified in config.xml) |
| **Validation Query Timeout** | **validation-query-timeout** | The length of time (in seconds) that the system should wait for a validation query to succeed before it considers the database connection broken. | The length of time should be quite short as the validation query should be designed to do a minimum amount of work. If you specify a Validation Query for MySQL then you should specify a value for the Validation Query Timeout too. If not, a value of "-1" is assumed, which results in the system waiting indefinitely until a validation query succeeds against a broken database connection, which it never will. **⚠️** This should only be done for MySQL. Using a Validation Query Timeout on any database other than MySQL will cause significant problems with the JIRA instance. | 3 (for MySQL) (otherwise, not specified in config.xml) |
| Test On Borrow | pool-test-on-borrow | Tests if the database connection is valid when it is borrowed from the database connection pool by JIRA. If the database connection is broken, it is removed from the pool. | This value should always be ‘false’ as JIRA borrows a connection for each database operation. ✓ If you continue to have problems with database connections closing, try setting this option to ‘true’. However, this should only be used as a last resort and only in the event that decreasing the value of **Time Between Eviction Runs** has not reduced or prevented problems with database connections closing. | true (when not specified in `config.xml`) |

| Test On Return | pool-test-on-return | Tests if the database connection is valid when it is returned to the database connection pool by JIRA. If the database connection is broken, it is removed from the pool. | This value should always be ‘false’ as JIRA returns borrowed connections for each database operation. | false (when not specified in `config.xml`) |
| **Test While Idle** | **pool-test-while-idle** | Periodically tests if the database connection is valid when it is idle. If the database connection is broken, it is removed from the pool. | This should be set to 'true' for MySQL. By default, MySQL database servers close database connections if they are not used for an extended period of time. This causes problems with JIRA installations (which use MySQL databases) that are largely inactive for long periods, e.g. overnight. Setting this to 'true' will work around this behavior.

**Test While Idle** only needs to be specified if you have specified a Validation Query above. | true (for MySQL)  
false (when not specified in config.xml) |
| Time Between Eviction Runs | time-between-eviction-runs-millis | The number of milliseconds to sleep between runs of the idle object eviction thread. When non-positive, no idle object eviction thread will be run. The eviction thread will remove idle database connections when the number of idle connections exceeds **Minimum Idle/Size** (above). This should be set to a positive but largish value for MySQL so the evictor runs and tests connections. A reasonable value would be 300000 (5 minutes).

- ✔️ If you continue to have problems with database connections closing, try setting this option to a lower value.

| Minimum Evictable Idle Time | min-evictable-idle-time-millis | The minimum amount of time an object may sit idle in the database connection pool before it is eligible for eviction by the idle object eviction (if any).

- 60000 (for MySQL)
- 4000 (for HSQLDB)
- (otherwise, not specified in config.xml) |
| Remove Abandoned | pool-remove-abandoned | Flag to remove abandoned database connections if they exceed the Removed Abandoned Timeout (be low).
If an internal failure occurs, it is possible that JIRA may borrow a connection and never return it. If this happens too often, then the pool may run short of database connections, causing JIRA's performance to degrade or JIRA to fail altogether.
This value should be set to 'true'.
This will allow the pool to recover any abandoned connections and prevent this affecting system performance. | true |

| Remove Abandoned Timeout | pool-remove-abandoned-timeout | The length of time (in seconds) that a database connection can be idle before it is considered abandoned. | 300 |

* Please Note:

- JIRA writes elements with their default values (in the right-hand column of the table above) to the `dbconf ig.xml` file after:
  - You have run through the JIRA Setup Wizard or
  - You use the Advanced tab of the JIRA Configuration Tool to configure/tune your database connection — even when the leftmost check boxes of options associated with these elements have not been selected.
- The exception to this are elements whose values have '(when not specified in `dbconfig.xml`)’ indicated below them. These elements are:
  - Not written to the `dbconfig.xml` file after running through the JIRA Setup Wizard.
  - Only written to the `dbconfig.xml` file by:
    - Manually writing them into this file.
    - Using the Advanced tab of the JIRA Configuration Tool, selecting the leftmost check boxes of the options associated with these elements and specifying values for these options.
1. When '(when not specified in dbconfig.xml)' is indicated below a default value in the right-hand column of the table above, then this default value is assumed, even when it is not present in the dbconfig.xml file.

2. Monitoring the connection pool

JIRA provides a view of its database connection usage via the 'Database Monitoring' page. See Monitoring Database Connection Usage for more information.

3. Surviving Connection Closures

When a database server reboots or a network failure has occurred, all connections in the database connection pool are broken. To overcome this issue, JIRA would normally need restarting (or for JIRA WAR distributions, the application server running JIRA would need restarting).

However, database connections in the database connection pool can be validated by running a simple SQL query. If a broken database connection is detected in the pool, a new one is created to replace it.

To do this, you need to specify an optional <validation-query/> element (in the dbconfig.xml file of your JIRA Home Directory), whose content is the query which validates connections in the database connection pool. See the following procedure for details.

4. Ensuring JIRA validates connections to its database

To ensure JIRA validates database connections in the database connection pool:

1. Shut down JIRA (or the Tomcat installation running JIRA).
2. Edit the dbconfig.xml file at the root of your JIRA Home Directory or use the Advanced tab of the JIRA Configuration Tool to configure the relevant settings.
3. Configure the validation query for your type of database:
   1. If editing the dbconfig.xml file, add the <validation-query/> element with the appropriate validation query for your type of database, as shown in the example below for MySQL. (See Determining the Validation Query below for details.)
If using the JIRA Configuration Tool, on the Advanced tab, select the Validation Query check box and enter the appropriate validation query for your type of database. (See Determining the Validation Query below for details.)

4. Specify a validation query timeout for your validation query, whose value is the appropriate length of time (in seconds) that the system should wait for a validation query to succeed before the system considers the database connection broken:
   - If editing the dbconfig.xml file, add the `<validation-query-timeout/>` element with the appropriate length of time (in seconds). ! This should only be done for MySQL.
   - If using the JIRA Configuration Tool, on the Advanced tab, select the Validation Query Timeout check box and enter the appropriate length of time (in seconds).

5. You may wish to specify the following options, which relate to the above validation query options (see Tuning Database Connections - Connection pool settings section for details):

<table>
<thead>
<tr>
<th>JIRA Configuration Tool 'Advanced' tab option</th>
<th>Element in dbconfig.xml</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test While Idle</td>
<td>pool-test-while-idle</td>
</tr>
<tr>
<td>Time Between Eviction Runs</td>
<td>time-between-eviction-runs-millis</td>
</tr>
<tr>
<td>Minimum Evictable Idle Time</td>
<td>min-evictable-idle-time-millis</td>
</tr>
</tbody>
</table>

6. Save your edited dbconfig.xml file (or click the Save button if using the JIRA Configuration Tool).
7. Restart JIRA (or the Tomcat installation running JIRA).

**Please Note:** If you continue to have problems with connections closing, you may need to set the time-bet
ween-eviction-runs-millis parameter to a lower value or as a last resort, set test-on-borrow to true. For more information about test-on-borrow, see Tuning Database Connections - Connection pool settings section.

Determining the Validation Query and Timeout

Different database types have slightly different SQL syntax requirements for their validation query. The validation query should be as simple as possible, as this is run every time a connection is retrieved from the pool. The validation query timeout should only be set for MySQL.

The following validation queries are recommended for the following types of databases:

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Validation Query</th>
<th>Validation Query Timeout</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL</td>
<td><code>select 1</code></td>
<td>3</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td><code>select 1</code></td>
<td>N/A</td>
</tr>
<tr>
<td>Oracle</td>
<td><code>select 1 from dual</code></td>
<td>N/A</td>
</tr>
<tr>
<td>PostgreSQL</td>
<td><code>select version();</code></td>
<td>N/A</td>
</tr>
</tbody>
</table>

⚠️ If the Validation Query Timeout is used on any database other than MySQL it will cause significant problems with the JIRA instance.

Result

You should now be able to recover from a complete loss of all connections in the database connection pool without the need to restart JIRA or the application server running JIRA.

⚠️ Performance Considerations:

- Setting this option has a performance impact. The overall decrease in performance should be minimal, as the query itself is quick to run. In addition, the query will only execute when you make a connection. Thus, if the connection is kept for the duration of a request, the query will only occur once per request.
- If you are running a large JIRA installation, you may wish to assess the performance impact of this change before implementing it.

Switching Databases

JIRA's data can be migrated from one database to:

1. A different database on the same database server,
2. The same database type on a different server (e.g. from one PostgreSQL server to another PostgreSQL server) or
3. A different type of database server (e.g. from a MySQL server to a PostgreSQL server).

⚠️ For migrating JIRA to another server, please refer to the Migrating JIRA to Another Server document instead.

To do this, follow the appropriate procedure:

- Migrating JIRA's data to the same type of database (covers scenarios 1 and 2 above)
- Migrating JIRA's data to a different type of database server (covers scenario 3 above)

Migrating JIRA's data to the same type of database

Use this procedure to migrate JIRA's data to:

- A different database on the same database server, or
- The same database type on a different database server (e.g. from one PostgreSQL server to another PostgreSQL server).

To migrate JIRA's data to the same type of database:

1. Use your database server's native tools to either:
   - Copy your JIRA database to a new database on the same database server installation, or
- Copy/migrate your JIRA database to a new database of the same type on a different database server installation.

**Please Note:**
- If you are unable to do either of these tasks, use the Migrating JIRA's database to a different type of database server procedure (below) instead.
- You could use this procedure to migrate JIRA's data to a different type of database server (e.g. MySQL to PostgreSQL). However, you would need to find tools that support these processes. Furthermore, Atlassian does not provide support for this strategy.

2. Once your new database has been populated with JIRA's data, shut down your JIRA server.
4. Reconfigure your JIRA server's connection to your database:
   - If you installed a 'Recommended' distribution of JIRA, you can use the JIRA Configuration Tool (by running bin/config.sh (for Linux/Solaris) or bin\config.bat (for Windows) in your JIRA Installation Directory), which provides a convenient GUI that allows you to reconfigure JIRA's database connection settings.
   - If any of the following points applies to your situation, you need to manually configure the dbconfig.xml file in your JIRA Home Directory. Refer to the appropriate database configuration guide in the Connecting JIRA to a Database section for the manual configuration instructions.
     - You are using JIRA WAR
     - You have a console-only connection to your JIRA server
     - You would prefer to configure your database connection manually (for custom configuration purposes).

**Migrating JIRA's data to a different type of database server**

Use this procedure to migrate JIRA's data to a different type of database server (e.g. from a MySQL server to a PostgreSQL server).

- You can also use this procedure if your JIRA installation is currently using the internal HSQL database (which is only supported for evaluating JIRA) and you need to switch your JIRA installation across to using a supported database (which are supported for JIRA installations used in a production environment).

1. Create an export of your data as an XML backup. See Backing Up Data for details.
2. Create a new database on your new database server to house JIRA's data. See the appropriate database configuration guide in the Connecting JIRA to a Database section for the database creation instructions.
3. Shut down your JIRA server.
5. Delete the dbconfig.xml file in your JIRA Home Directory.
6. Restart JIRA and you should see the first step of the JIRA Setup Wizard for configuring your database connection.
7. Configure JIRA's connection to your new database (created in step 2 above) and click the 'Next' button.
8. On the 'Application Properties' setup page, click the 'import your existing data' link and restore your data from the XML backup created in step 1 above.
Upgrading JIRA

There are several different ways to upgrade JIRA, and the method you choose to use depends on which version of JIRA you use and the type of environment you use it in. Use this table to determine which steps to follow to complete your JIRA upgrade:

If you need to move JIRA to a new server or use it in a new environment that has a different operating system, different database type or different location of attachment or index files, follow the instructions for Migrating JIRA to Another Server.

<table>
<thead>
<tr>
<th>Required Uptime (SLA)</th>
<th>Hardware/Software Change</th>
<th>Operating System</th>
<th>JIRA Package</th>
<th>Current JIRA Version</th>
<th>Upgrade Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>High / Mission Critical</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Any</td>
<td>Upgrading JIRA with a Fallback Method</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td><strong>This method is recommended for enterprise environments where extended or unplanned downtime might negatively impact the business.</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>For information on upgrading to JIRA Data Center, please see Installing JIRA Data Center.</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Low – Medium</th>
<th>Neither operating system, database or home directory will be changed.</th>
<th>MS Windows / Linux</th>
<th>Standalone</th>
<th>4.3.0 or later</th>
<th>Upgrading JIRA Using a Rapid Upgrade Method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If you use JIRA in a non-mission critical environment, depending on your specific installation details, you use either the safe (no downtime) or manual method to upgrade.</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>If you are upgrading from JIRA 4.3.0 or later, you also have the option to use the upgrade capabilities built into the installer to perform a rapid upgrade of your existing JIRA installation - this method is the fastest way to upgrade - however due to its in-place upgrade method, having recent backups is crucial for this option.</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>MS Windows / Linux</th>
<th>Standalone</th>
<th>4.3.0 or later</th>
<th>Upgrading JIRA Using a Rapid Upgrade Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2.x or earlier</td>
<td>WAR</td>
<td>Any</td>
<td>Upgrading JIRA Manually</td>
<td></td>
</tr>
</tbody>
</table>

| | solaris | Any | Any | Upgrading JIRA Manually |

If you plan to skip multiple major versions of JIRA when you upgrade, please review the Skipping Major Versions when Upgrading JIRA for important information on the recommended way to skip versions.

### Upgrading JIRA Manually

This page describes how to upgrade JIRA installations that don't support the rapid upgrade method or fallback method. You should use this method to upgrade JIRA if you meet any of the following criteria:

- You use a WAR distribution of JIRA version 4.0.0 or later.
- You use JIRA 4.0.0 or later on Solaris.
- You use JIRA 4.0.0 – 4.2.x on Windows or Linux.
- You use JIRA prior to 4. Note that these versions will require an upgrade to JIRA 4.4.5 before moving on with newer versions.

See Upgrading JIRA for more information on the methods you can use to upgrade JIRA.

### On this page:

- 1. Before you start
- 2. Backing up
- 3. Setting up your new JIRA installation
- 4. Post upgrade checks and tasks

#### 1. Before you start

1. **Read about the new version** - Review the release notes and upgrade notes for the version of JIRA that you are upgrading to. See Production Releases. If you plan to skip a few JIRA versions during your upgrade, we **strongly recommend** that you read the upgrade guides for all major versions between your current version and the version to which you are upgrading. Refer to Important Version-Specific Upgrade Notes for quick links to these guides.

2. **Check your license** - Verify that your license support period is still valid. Upgrading to a version prior to
JIRA 6.4 on an expired license could lead to the error described in After upgrade JIRA shows 500 error page with message User has no unique key mapping.

3. Check for known issues - Use the JIRA Knowledge Base to search for any issues in the new version that will affect you.

4. Check for compatibility:
   - Confirm that your operating system, database, other applicable platforms and hardware still comply with the requirements for JIRA 6.4. The End of Support Announcements for JIRA page also has important information regarding platform support for future versions of JIRA.
   - If you have installed JIRA plugins (i.e. not included with JIRA), verify that they will be compatible with the version of JIRA you are upgrading to. You can find a plugin's compatibility information using Checking add-on compatibility with application updates or from the plugin's home page on the Atlassian Plugin Exchange.
   - Some anti-virus or other Internet security tools may interfere with the JIRA upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool before proceeding with the JIRA upgrade.

We strongly recommend performing your upgrade in a test environment first. Do not upgrade your production JIRA server until you are satisfied that your test environment upgrade has been successful.

   - If you have any problems with your test environment upgrade which you cannot resolve, create an issue at our support site so that we can assist you.
   - If you have any problems during the upgrade of your production JIRA server, do not allow your users to start using this server. Instead:
     - Continue to use your old JIRA server — this will help ensure that you do not lose production data.
     - Also create an issue at our support site so that we can help you resolve the problems with your upgrade.

2. Backing up

Before you begin the JIRA upgrade, we strongly recommend that you back up your existing JIRA installation.

2.1 Stop users from updating JIRA data

During the upgrade process, you'll export JIRA's database from your existing JIRA installation (via an XML backup) and then restore this backup into a new JIRA installation. To ensure that the data in the XML backup is consistent with the latest data in the system, you must temporarily restrict access to JIRA so users can't update the data. Refer to the Preventing users from accessing JIRA during backups page for more information.

⚠️ Be aware! Inconsistent XML backups cannot be restored!

2.2 Back up your database

Perform an XML backup of your existing JIRA installation's external database. For large JIRA installations, this process may require several hours to complete.

The 'embedded database' is the HSQLDB database supplied with JIRA for evaluation purposes only. If you accidentally use the HSQLDB database in a production system, perform an XML backup of this database and continue on with this procedure.

2.3 Back up your JIRA Home directory

1. Shut down JIRA.
2. Locate the JIRA Home directory. You can find information about the location of the directory by navigating to the <jira-application-dir>/WEB-INF/classes/jira-application.properties file in your JIRA Installation Directory. Alternatively, you can open the JIRA Configuration Tool to see the directory that is set as your JIRA Home.
3. Navigate to the directory specified in the configuration file and create a backup of it in another directory.
4. Delete the file <jira-home>/dbconfig.xml as soon as the backup is complete.

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
2.4 Back up your attachments and index directories if located outside your JIRA Home directory

If the attachments and index directories are located outside of your JIRA Home Directory, you must back them up separately. These pages describe how to find out where these directories are located in your implementation:

- Your attachments directory — Refer to Configuring File Attachments page in the documentation for your version of JIRA.
- Your index directory — Refer to Search Indexing page in the documentation for your version of JIRA.

Also refer to Backing Up Data for more information about backing up attachments in JIRA.

2.5 Back up your JIRA Installation directory

The 'JIRA Installation Directory' is the directory into which the JIRA application files and libraries were extracted when JIRA was installed.

3. Setting up your new JIRA installation

If you are running a 'mission-critical' JIRA server, we highly recommend performing the remaining steps of this guide in a test environment (e.g. using a separate test JIRA database and a copy of your JIRA Home directory) before performing the upgrade in production.

3.1 Install the new version of JIRA

Download and extract the JIRA distribution you require to a new directory. Do not overwrite your existing JIRA installation. Ensure this has been shut down and install the new JIRA version to a new location.

Follow the installation instructions for either:

- Installing JIRA (just Step one), or
- Installing JIRA WAR (Steps one through seven)

If you are using JIRA WAR, remember to build your new JIRA web application and deploy it to your server. For specific instructions, refer to the JIRA WAR installation page for your application server within the Installing JIRA WAR section.

3.2 Point your new JIRA to (a copy of) your existing JIRA Home directory

If your new JIRA 6.4 installation is on a new server, copy the backup of your existing JIRA Home Directory from the old server to the new server before proceeding.

To set up a "recommended" (not WAR) distribution:

1. Open the JIRA Configuration Tool.
2. Click the JIRA Home tab.
3. Update the JIRA Home Directory field:
   - If your JIRA 6.4 installation is on a new server, update the JIRA Home Directory field to the path of your copied JIRA Home directory.
   - If your JIRA 6.4 installation is on the same server, update the JIRA Home Directory field to the path of your existing JIRA Home directory.

For more information about this directory, see JIRA Home Directory.

To set up a WAR distribution:

2. Update the jira.home property in this file to the path of the new JIRA Home Directory:
   - If your JIRA 6.4 installation is on a new server, update the jira.home property to the path of your copied JIRA Home directory.
   - If your JIRA 6.4 installation is on the same server, update the jira.home property to the path of your existing JIRA Home directory.

For more information about this directory, see JIRA Home Directory.
3. Remove the "#" at the beginning of the jira.home line (so that JIRA no longer regards this line as a comment).
4. Save your updated jira-application.properties file.
You can also set your JIRA Home Directory’s location by defining an operating system environment variable JIRA_HOME. This value of this variable takes precedence over the value of the jira.home property in the jira-application.properties file in your JIRA Installation Directory. See Setting your JIRA Home Directory for details.

3.3 Connect the new version of JIRA to a new, empty database

Create a new, empty database that your new JIRA installation will use to store its data.

Follow the appropriate ‘Connecting JIRA to...’ instructions for your database from stage 2, although from stage 4 of that procedure, be aware of the yellow note below:

- Connecting JIRA to PostgreSQL
- Connecting JIRA to MySQL
- Connecting JIRA to Oracle
- Connecting JIRA to SQL Server 2005
- Connecting JIRA to SQL Server 2008

If you are using a database (called jiradb, for example) with your existing JIRA installation and the database for your new JIRA installation is running on the same machine or database server, create your new database with a different name (e.g. something intuitive like jiradb_440 for JIRA 4.4.0). However, ensure the new database has identical access permissions to the old JIRA database. Consult your database administrator if you need assistance with this.

You do not need to create a new database if you are using the embedded HSQL database.

3.4 Migrate your existing JIRA configurations over to your new JIRA installation

If you have modified properties in configuration files of your existing JIRA installation, make the same modifications in your new JIRA installation. However, because the properties in the configuration files may have changed between versions, you cannot simply copy the configuration files from your existing installation and replace the equivalent files in the new installation.

For each file you have modified in your existing JIRA installation, you need to manually edit each equivalent file in your new JIRA installation and re-apply your modifications. If a file is not present in your new JIRA installation (for example, osuser.xml in recent JIRA versions), then simply copy that file over to your new JIRA installation.

The table below lists the most commonly modified files and their locations within your JIRA Installation Directory:

<table>
<thead>
<tr>
<th>File</th>
<th>Location in ‘recommended’ (formerly ‘Standalone’) JIRA distributions</th>
<th>Location in JIRA WAR</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### jira-application.properties
- **Location of the JIRA Home**

Any custom property values defined in the `jira-application.properties` file of your existing JIRA 4.3.x (or earlier) installation must be migrated across to the `jira-application.properties` file of your new JIRA 6.4 installation before you start your new JIRA installation.

Upon starting your new JIRA installation, any custom property values in the `jira-application.properties` file will automatically be migrated across to either the database `jira-config.properties` file. The only property of the `jira-application.properties` file subsequently used by JIRA is `jira.home`.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>jira-application.properties</code></td>
<td>atlassian-jira/WEB-INF/classes</td>
<td>JIRA Configuration</td>
</tr>
<tr>
<td></td>
<td>webapp/WEB-INF/classes</td>
<td>Advanced JIRA in JIRA 4.3.x and Configuration</td>
</tr>
</tbody>
</table>

### Version-Specific Upgrade Notes

The version-specific upgrade notes contain details on properties which may have changed in these commonly modified files.

In addition to the files above, you should also consider and/or perform the following configurations as part of the upgrade process:

- **Using JIRA with Atlassian's Crowd?** — If you are using Crowd with JIRA, configure your new JIRA to talk to Crowd as described in Integrating Crowd with JIRA.
  - Remember to configure Crowd to grant JIRA’s new hostname/IP access: Specifying an Application’s Address or Hostname.

- **Allocating additional memory to JIRA** — If you had previously allocated additional memory to JIRA, do the same for your new JIRA instance. For more information refer to Increasing JIRA Memory.

- **Plugins** — For any plugins that you had installed in your old JIRA, download the plugin version for your new version of JIRA from the [http://plugins.atlassian.com](http://plugins.atlassian.com) site.

- **Character encoding** — Ensure that character encoding (i.e. locale) is the same on the new and old
locations. Your new version of JIRA may not function correctly if attachments are moved between two system with incompatible encoding.

- **Customisations** — If you had made any customisations (code, templates or configuration files), copy over compatible versions of these changes to the new JIRA. (The developers within your organisation who made the customisations to your old version will need to build and test equivalent changes for the new version, and provide you with the files to copy to your upgraded JIRA installation.)
- **(Optional) Running JIRA on a different port** — If your new JIRA is installed on the same machine as your old JIRA, you may wish to make sure it runs on a different port (in case you ever need to restart your old JIRA). See Changing JIRA’s TCP Ports for details.

### 3.5 Start your new version of JIRA

1. Verify that your old JIRA installation is shut down — if this JIRA server is still operating, shut it down.
2. If you installed the JIRA WAR distribution within Tomcat, delete the Tomcat work directory before restarting JIRA. If you do not do this, users may encounter errors when they try to display JIRA pages.
3. Start up your new version of JIRA. For:
   - ‘Recommended’ distributions — follow the Starting JIRA instructions.
   - WAR distributions — follow the instructions for starting JIRA for your application server within the Installing JIRA WAR section.

   During the startup process, your new JIRA installation will create any required database indexes. If you created any custom database indexes, please check them afterwards and remove any that duplicate the indexes added by JIRA.

### 3.6 Import your old JIRA data into your new JIRA

After you have started your new JIRA installation, import the data from your old instance into the new instance. You will need the backup file of data from your old JIRA that you created earlier in these instructions (above).

To import your old JIRA data into your new JIRA:

1. Log in as a user with the ‘JIRA System Administrators’ global permission.
2. Select Administration > System > Import & Export > Restore System (tab) to open the ‘Restore JIRA data from Backup’ page.

   **Keyboard shortcut: ‘g’ + ‘g’ + type ‘rest’**

3. In the **File name** field, specify the XML backup file you created previously during the export process (above). That zipped file should contain two xml files: activeobjects.xml and entities.xml. Both of these files must be included in the zipped file for the import process to work.
4. Restore the attachments directory that you backed up previously, into the attachments directory of your new JIRA. (See Restoring Data.)

   Avoid passing through a proxy when performing an XML restore, especially if your JIRA instance is very large. Using a proxy may cause timeout errors.
5. Access JIRA via your web browser again and log in using a username from your previous JIRA installation.
6. Take a quick look around your JIRA site to confirm that your projects and issues are present and everything looks normal. You should see the new JIRA version number in the page footer.

### 4. Post upgrade checks and tasks

It is strongly recommended that you perform the following checks and tasks after you have started your new instance of JIRA:

1. Check your server logs for error messages, even if JIRA appears to be running correctly. If there are any errors there that you cannot resolve, create a support case in https://support.atlassian.com, attach your log file and we will advise you on the errors.
2. If you were previously using **External User Management**, enable it in the new JIRA instance.
3. If you changed machines when upgrading, change the paths to the indexes, attachments and backup directories, from within the **Administration** section of JIRA.
4. Enable email, if you disabled it during testing.
5. If you migrated any customisations from your old JIRA to the new JIRA, ensure that they are tested thoroughly.
   a. If you had downloaded plugins for the new version of JIRA, **install the downloaded JAR file(s)** in your new JIRA version and carry out any other required installation for the plugin.
   b. If the plugin has a properties file, apply the same changes to it as you had in the old properties file (don't just copy over the old properties file).
6. Once you have confirmed that the new server is working correctly, ensure that the production license is updated for the new server ID, as follows:
   a. Log in to [https://my.atlassian.com](https://my.atlassian.com).
   b. Locate the appropriate license.
   c. Edit the Server ID, as per the new production Server ID, and save it.
   d. Update the production license in the new server.

**Congratulations! You have completed your JIRA migration/upgrade.**

**See Also**

- Disabling Auto-Export
- Restoring Data
- Upgrading JIRA
- Switching Application Servers to Apache Tomcat
- Switching Databases

### Upgrading JIRA with a Fallback Method

This page describes how to upgrade JIRA 4.4.x or later in a way that allows you to safely roll back to your previous system if the upgrade process takes longer than expected or if you encounter issues. This method is especially useful for enterprise environments and for organisations where JIRA is mission-critical for the business. You can also use this method so you have a fallback option if you are performing a complex system change, such as changing the operating system that will run JIRA, the database that will store JIRA's data or the location of JIRA's index and/or attachments paths.

Because this process is designed to provide the safest possible upgrade method, it requires advanced knowledge of database administration tasks. We recommend you have the following resources and/or skill sets available for your upgrade:

- **Database Administrator** - for general production-level database administration (*i.e. run backups, create, remove, restore, etc.*)
- **JIRA Application Administrator** - for general application administration and upgrade management (*i.e. JIRA SME, user with System Administrator privileges and deep understanding of application and associated dependencies within your organization.*)
- **Systems/Network Administrator** - for managing systems and networks (*i.e. proxy servers, DNS changes, monitoring, VM's, hardware, etc.*)

This upgrade process also requires you to make backups of your database, which can be time-consuming. Customers with large JIRA environments should plan for four hours of downtime. If you know your system takes several hours to re-index, you might want to allocate more than four hours for the upgrade.

See **Upgrading JIRA** for more information on the methods you can use to upgrade JIRA.

This graphic illustrates the process described in this document. For simplicity, the illustration shows how you can perform an upgrade using two different pieces of hardware. However, you can just as easily install JIRA in different directories on the same server to test and perform an upgrade. In this case, simply ensure that you use separate installation and database directories during the testing.
Before You Start

1. **Read about the new version** - Review the release notes and upgrade notes for the version of JIRA that you are upgrading to. See [Production Releases](https://confluence.atlassian.com/jira-6-4-documentation#ProductionReleases). If you plan to skip a few JIRA versions during your upgrade, **we strongly recommend** that you read the upgrade guides for all major versions between your current version and the version to which you are upgrading. Refer to [Important Version-Specific Upgrade Notes](https://confluence.atlassian.com/jira-6-4-documentation#ImportantVersion-SpecificUpgradeNotes) for quick links to these guides.

2. **Check your license** - Verify that your license support period is still valid. Upgrading to a version prior to JIRA 6.2.4 on an expired license could lead to the error described in [After upgrade JIRA shows 500 error page with message User has no unique key mapping](https://confluence.atlassian.com/jira-6-4-documentation#AfterupgradeJIRASHOES500ERRORPAGEWITHMESSAGEUserhasnowuniquekeymapping).

3. **Check for known issues** - Use the [JIRA Knowledge Base](https://confluence.atlassian.com/jira-6-4-documentation#JIRAKnowledgeBase) to search for any issues in the new version that will affect you.

4. **Check for compatibility**:  
   - Confirm that your operating system, database, [other applicable platforms](https://confluence.atlassian.com/jira-6-4-documentation#OtherApplicablePlatforms) and hardware still comply with the [requirements](https://confluence.atlassian.com/jira-6-4-documentation#Requirements) for JIRA 6.4. The [End of Support Announcements for JIRA](https://confluence.atlassian.com/jira-6-4-documentation#EndofSupportAnnouncementsfornJIRA) page also has important information regarding platform support for future versions of JIRA.
   - If you have installed JIRA plugins (i.e. not included with JIRA), verify that they will be compatible with the version of JIRA you are upgrading to. You can find a plugin's compatibility information using [Checking add-on compatibility with application updates](https://confluence.atlassian.com/jira-6-4-documentation#Checkingaddoncompatibilitywithapplicationupdates) or from the plugin's home page on the [Atlassian Plugin Exchange](https://plugins.atlassian.com).
   - Some anti-virus or other Internet security tools may interfere with the JIRA upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool before proceeding with the JIRA upgrade.

If you have any problems during the upgrade process, create an issue at our [support site](https://confluence.atlassian.com/jira-6-4-documentation#SupportSite) so that we can help you resolve the problems with your upgrade. We strongly recommend that you perform the below procedure first as a test only. This will allow you to note any complications (e.g. with customized settings or add-ons) ahead of
time so that you can minimize the downtime of the system.

1. Prepare Your Production Instance for Upgrade

When you begin preparing to upgrade, it's best practice to halt any major changes to your production system (such as plugin upgrades, customisations, etc.). Keeping your production system as stable as possible will make testing the upgrade version simpler.

It's also a good idea to let your users know about planned downtime, either through email or by using JIRA's announcement banner.

2. Set Up a Proxy Server

Before beginning the upgrade process set up a reverse proxy, such as a load balancer. The proxy server allows you to redirect users to a different JIRA server without having to wait for a DNS change - this change will be invisible to the end-user. If, at any point during the upgrade process, you encounter issues you can't resolve and you need to rollback to your existing JIRA instance, simply restart your existing JIRA instance and reconfigure the proxy server to point to the old server.

If you use monitoring, API calls (such as SOAP, REST, or CLI), or scripts associated with your production server, update them with the new proxy information.

Please see the following documentation for further information on configuring Apache:

- Integrating JIRA with Apache
- Integrating JIRA with Apache using SSL

3. Pre-Stage and Test the New Version of JIRA

1. If you want to use a copy of your production data when you test the upgraded JIRA system, make a copy of your production database using your native database backup tools. See Backing Up Data. You can alternatively skip this step and use a new database for testing.

2. Install the version of JIRA you want to upgrade to onto a system you can use for testing (use either a test server or a separate directory on an existing system). This will become your new production system after you complete the upgrade process. Follow the instructions here to install a new version of JIRA: Installing JIRA.

3. Migrate any customisations you use in your production system. Follow the instructions in step 3.4 (Migrate your existing JIRA configurations over to your new JIRA installation) in the "Migrating JIRA to Another Server" page.

4. Connect the new version of JIRA to the copy of the production database (not the existing production database) or a new testing database. See Connecting JIRA to a Database.

5. Start the new version of JIRA. See this Knowledge Base article about how to test mail settings without accidentally sending notifications to users from the test system: How to Prepare a Development Server's Mail Configuration.

6. Install any plugins that you use in your existing production version of JIRA. Some plugins have different compatibility for different JIRA versions, so this step will ensure that your plugins are updated for this new JIRA version.

7. Re-index JIRA so the new plugin information is captured in the index.

8. Check out the features and functionality you use in the new version to understand how they behave and how any changes will impact your team. It can be very helpful to have a group of users look at the new system and carry out their usual tasks to make sure they won't run into any issues when the new version is in production.

When you are ready to begin the process of migrating your production data to this new version, shut down JIRA (for example, by executing either the /bin/stop-jira.sh or \bin\stop-jira.bat file in your JIRA Installation Directory, or by stopping the JIRA service).

4. Disable the Old JIRA Production Instance and Start the New Instance

Before disabling your old JIRA production instance, identify the location of your attachments and index directories. If they are located outside of your JIRA Home Directory, you will back them up manually later during the upgrade process. These pages describe how to find out where these directories are located in your
environment:

- Your attachments directory — Refer to the Configuring File Attachments page for your version of JIRA.
- Your index directory — Refer to the Search Indexing page for your version of JIRA.

If your attachments and index directories are located outside of the JIRA Home directory, note their location so you can easily find them later.

After you've located the attachments and index directories, disable the old JIRA production instance so you can perform a database backup:

1. Shut down your old production JIRA instance (for example, by executing either the `./bin/stop-jira.sh` or `\bin\stop-jira.bat` file in your JIRA Installation Directory, or by stopping the JIRA service).
2. Using your database's native backup tools, perform a backup of the data in your old production JIRA instance. See Backing Up Data.
3. Set the newest copy of the production database as the new database for production.

Make sure that the database set up for the new production version of JIRA is clearly distinguishable from the database backup of your old production JIRA, and that the new production instance is not configured to connect to the old production database.

4. Synchronise the JIRA attachment directories:
   a. Locate the JIRA Home directory. You can find information about the location of the directory by navigating to the `<jira-application-dir>/WEB-INF/classes/jira-application.properties` file in your JIRA Installation Directory. Alternatively, you can open the JIRA Configuration Tool to see the directory that is set as your JIRA Home.
   b. Navigate to the directory specified in the configuration file and create a backup of it in another directory.
   c. If the attachments and index directories are located outside of your JIRA Home Directory, you must back them up separately. (See the beginning of this task for information on how to find these files.)
      Also refer to Backing Up Data for more information about backing up attachments in JIRA.
   d. Replace the JIRA Home directory (and the attachment and index directories, if separate from the JIRA Home directory) in the new JIRA production environment with the backups you made of the old production directories.

5. Start the new version of JIRA in your new production environment. When you start this version, JIRA will upgrade your data and may perform a re-index. When the re-indexing is complete, verify that your data is present and that there are no issues with the system.

The re-indexing may take up to several hours, depending on the size of your instance. If you know that your instance takes a long time to index, make sure to plan your scheduled downtime accordingly.

6. Reconfigure the proxy server you set up in step 2 so that the new version of JIRA becomes your production instance. Make sure to let your users know about the new instance (including the new domain name) and any changes that might affect them.

If you experience any issues in the new production environment, you can simply revert the proxy server settings and re-instate your old production instance until you can resolve the issue.

9. Post Upgrade Checks and Tasks

It is strongly recommended that you perform the following checks and tasks after you have started your new instance of JIRA:

1. Check your server logs for error messages, even if JIRA appears to be running correctly. If there are any errors there that you cannot resolve, create a support case in https://support.atlassian.com, attach your log file and we will advise you on the errors.
2. If you were previously using External User Management, enable it in the new JIRA instance.
3. If you changed machines when upgrading, change the paths to the indexes, attachments and backup...
directories, from within the Administration section of JIRA.

4. Enable email, if you disabled it during testing.

5. If you migrated any customisations from your old JIRA to the new JIRA, ensure that they are tested thoroughly.
   a. If you had downloaded plugins for the new version of JIRA, install the downloaded JAR file(s) in your new JIRA version and carry out any other required installation for the plugin.
   b. If the plugin has a properties file, apply the same changes to it as you had in the old properties file (don't just copy over the old properties file).

6. Once you have confirmed that the new server is working correctly, ensure that the production license is updated for the new server ID, as follows:
   b. Locate the appropriate license.
   c. Edit the Server ID, as per the new production Server ID, and save it.
   d. Update the production license in the new server.

Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading JIRA. This can be done via the 'Plugin Repository' in your Administration Console. It is recommended that you re-index JIRA after upgrading your plugins.

Congratulations! You have completed your JIRA migration/upgrade.

Upgrading JIRA Using a Rapid Upgrade Method

This page describes how to upgrade JIRA 4.3.0 or later in the quickest way possible. This method can save you time since it does not require you to set up a separate test instance before you upgrade (that is, you upgrade JIRA "in-place"). However, it does assume that your JIRA instance is not mission critical and that users or the business won't be negatively affected when JIRA is unavailable during the upgrade.

You should use this method to upgrade JIRA if you are upgrading from the recommended (not WAR) JIRA distribution 4.3.0 or later on Windows or Linux. See Upgrading JIRA for more information on the methods you can use to upgrade JIRA.

On this page:
- Before You Start
- 1. Checking for Customizations
- 2. Backing Up Your External Database
- 3. Performing the Upgrade
- 4. Post Upgrade Checks and Tasks

Before You Start

1. Read about the new version - Review the release notes and upgrade notes for the version of JIRA that you are upgrading to. See Production Releases. If you plan to skip a few JIRA versions during your upgrade, we strongly recommend that you read the upgrade guides for all major versions between your current version and the version to which you are upgrading. Refer to Important Version-Specific Upgrade Notes for quick links to these guides.

2. Check your license - Verify that your license support period is still valid. Upgrading to a version prior to JIRA 6.2.4 on an expired license could lead to the error described in After upgrade JIRA shows 500 error page with message User has no unique key mapping.

3. Check for known issues - Use the JIRA Knowledge Base to search for any issues in the new version that will affect you.

4. Check for compatibility:
   - Confirm that your operating system, database, other applicable platforms and hardware still comply with the requirements for JIRA 6.4. The End of Support Announcements for JIRA page also has important information regarding platform support for future versions of JIRA.
   - If you have installed JIRA plugins (i.e. not included with JIRA), verify that they will be compatible with the version of JIRA you are upgrading to. You can find a plugin's compatibility information using Checking add-on compatibility with application updates or from the plugin's home page on the Atlassian Plugin Exchange.
   - Some anti-virus or other Internet security tools may interfere with the JIRA upgrade process and
prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool before proceeding with the JIRA upgrade.

1. Checking for Customizations

Using the rapid upgrade method allows the installer to automatically perform many of the upgrade tasks for you. However, if you have made customizations to your JIRA installation, you must migrate customized files manually to the upgraded installation. The installer checks for and migrates automatically:

- Legacy database configurations defined as a datasource within the application server (used in JIRA 4.3.x and earlier) to the new database configuration used in JIRA 4.4 and later. See JIRA 4.4 Upgrade Notes for details.
- TCP port values in your existing JIRA installation's server.xml file. Other configurations or customizations in this file are not migrated.
- Custom values in your existing JIRA installation's jira-application.properties and setenv.sh/setenv.bat files. 
  
  In the setenv.sh/setenv.bat file, only the following values are migrated:
  
  - JVM_SUPPORT_RECOMMENDED_ARGS
  - JVM_MINIMUM_MEMORY
  - JVM_MAXIMUM_MEMORY
  - JIRA_MAX_PERM_SIZE

During the upgrade process, the installer detects and notifies you of any files (other than jira-application.properties and setenv.sh/setenv.bat) in the atlassian-jira subdirectory of your existing JIRA installation directory which had been deleted, added or modified from a 'default' JIRA installation. If you have made customizations to your seraph-config.xml file or any other file customizations in your JIRA installation directory which are not handled by the upgrade wizard, you must migrate these to the upgraded JIRA installation manually.

The upgrade feature also re-uses your existing JIRA Home Directory so that any key data stored in this directory from your previous JIRA installation will be retained after the JIRA upgrade.

Please Note:

- The upgrade process requests that you conduct a backup of your database using your database's backup utilities. If your database does not support online backups, you can stop the upgrade process, shut down JIRA, perform your database backup and then restart the upgrade process to continue on.
- The installer automatically backs up the Installation and Home directories of the existing JIRA installation. If your attachments and index files are located outside your JIRA Home Directory, you must manually back up these files. These pages describe how to find out where these directories are located in your environment:
  
  - Your attachments directory — Refer to the Configuring File Attachments page for your version of JIRA.
  - Your index directory — Refer to the Search Indexing page for your version of JIRA.

2. Backing Up Your External Database

After you launch the upgrade wizard, but before it begins the upgrade, it asks you to back up your external database. You can back up the database using your database's native backup tools, however, note the following:

- If your database's native backup tools support online backups (i.e. backups that would typically create a "snapshot" of your JIRA database while the database is still in use), you can leave the upgrade wizard running while you perform the database backup and then continue on with the wizard after verifying that the database backup was created correctly.
- If your database's native backup tools do not allow you to perform an online backup of your JIRA database, you should:
  1. Quit the upgrade wizard when it prompts you to back up the database.
  2. Prevent users from updating your existing JIRA data (to ensure structural consistency of your database backup) by temporarily restricting access to JIRA. Refer to the Preventing users from accessing JIRA during backups page for more information.
3. Use your database’s native backup tools to perform an "offline backup" of your JIRA database and verify that this backup was created correctly.

4. Re-start the Linux / Windows Installer to start the upgrade wizard again and continue from where you left off.
   - JIRA's 'internal' database is HSQLDB, which should be used for evaluating JIRA only. If you happen to accidentally use the HSQLDB database for a production system, quit the upgrade wizard when it prompts you about the backup and use the Migrating JIRA to Another Server procedure to upgrade JIRA.

⚠️ Inconsistent database backups may not restore correctly! If you are unfamiliar with your database's native backup/restore facilities, then before proceeding, test your database backup's integrity by:
   - restoring the database backup to a different (test) system and
   - connecting a test instance of your current JIRA version to this restored database.

3. Performing the Upgrade

Refer to the appropriate upgrade instructions below for your operating system:
   - Windows
   - Linux

Upgrading JIRA on Windows

1. Download the 'JIRA Windows Installer' (.exe) file (for the new version of JIRA) from the JIRA Download page.
2. Shut down JIRA.
3. Run the '.exe' file to start the upgrade wizard.
   - If a Windows 7 (or Vista) 'User Account Control' dialog box asks you to allow the upgrade wizard to make changes to your computer, specify Yes. If you do not, the installation wizard will have restricted access to your operating system and any subsequent installation options will be limited.
4. At the 'Upgrading JIRA?' step, choose the Upgrade an existing JIRA installation option.
5. In the Existing JIRA installation directory field, specify the JIRA Installation Directory of your JIRA installation to be upgraded.
   - The upgrade wizard will attempt to find an existing JIRA installation and use its location to pre-populate this field. However, always verify this location, particularly if you have multiple JIRA installations running on the same machine.
6. During subsequent steps of the upgrade wizard, you will be prompted to specify or do the following options:
   a. At the 'Back up JIRA directories' step, ensure the Back up these directories option is selected. This creates 'zip' archive file backups of your existing JIRA Installation and JIRA Home Directories in their respective parent directory locations.
      - Please Note:
        - Choosing this option is strongly recommended!
        - At this point, the upgrade wizard notes any customizations in your existing JIRA Installation Directory which it cannot automatically migrate to your upgraded JIRA installation. If you are informed of any files containing such customizations, please make a note of these files as you will need to manually migrate their customizations (which are not mentioned in the overview above) to your upgraded JIRA installation. One relatively common customization that the upgrade wizard cannot automatically migrate is an SSL configuration defined in the server.xml file of the JIRA Installation Directory.
   b. At the 'Upgrade Check List' step, back up your external database and check that any non-bundled plugins will be compatible with your upgraded JIRA version. You may have already backed up your database (in step 2: Backing Up Your External Database).
   c. After the 'Upgrade Check List' step, the existing JIRA installation will be shut down if it is still running. The upgrade wizard will then:
      i. Back up your existing JIRA installation.
      ii. Delete the contents of the existing JIRA Installation Directory.
      iii. Install the new version of JIRA to the existing JIRA Installation Directory.
      iv. Start your new (upgraded) JIRA installation.
      - If you noted any files that contain customizations which must be migrated manually to your upgraded JIRA installation (above), then:
        1. Stop the upgraded JIRA installation.
2. Migrate the customizations from these files into the upgraded JIRA Installation Directory.

3. Restart the upgraded JIRA installation.

7. At the last step of the upgrade wizard, select the option to launch the upgraded JIRA installation in a browser so you can check the upgrade.

Congratulations, you have completed upgrading your JIRA installation on Windows!

Upgrading JIRA on Linux

1. Download the appropriate ‘JIRA ‘Linux 64-bit / 32-bit Installer’ (.bin) file that suits your operating system (for the new version of JIRA) from the JIRA Download page.

2. Shut down JIRA.

3. Open a Linux console and change directory (cd) to the '.bin' file's directory.
   
   If the '.bin' file is not executable after downloading it, make it executable, for example:
   
   chmod a+x atlassian-jira-X.Y.bin
   
   (where X.Y represents your version of JIRA)

4. Execute the '.bin' file to start the upgrade wizard.

5. When prompted to choose between creating a new JIRA installation or upgrading an existing installation, choose the Upgrade an existing JIRA installation option.

6. Specify the JIRA Installation Directory of your JIRA installation to be upgraded.

   The upgrade wizard will attempt to find an existing JIRA installation and will provide its location as a choice. However, always verify this location, particularly if you have multiple JIRA installations running on the same machine.

7. During subsequent steps of the upgrade wizard, you will be prompted to specify or do the following options:

   a. Choose the option to back up JIRA's directories. This creates 'zip' archive file backups of your existing JIRA Installation and JIRA Home Directories in their respective parent directory locations.

   Please Note:
   
   - Choosing this option is strongly recommended!
   - At this point, the upgrade wizard notes any customizations in your existing JIRA Installation Directory which it cannot automatically migrate to your upgraded JIRA installation. If you are informed of any files containing such customizations, please make a note of these files as you will need to manually migrate their customizations (which are not mentioned in the over view above) to your upgraded JIRA installation. One relatively common customization that the upgrade wizard cannot automatically migrate is an SSL configuration defined in the conf/server.xml file of the JIRA Installation Directory.

   b. At the 'Upgrade Check List' step, back up your external database. You may have already backed up your database (in step 2 Backing Up Your External Database).

   c. After the 'Upgrade Check List' step, the existing JIRA installation will be shut down if it is still running. The upgrade wizard will then:

      i. Back up your existing JIRA installation.
      
      ii. Delete the contents of the existing JIRA installation directory.
      
      iii. Install the new version of JIRA to the existing JIRA installation directory.
      
      iv. Starts your new (upgraded) JIRA installation.

      If you noted any files that contain customizations which must be migrated manually to your upgraded JIRA installation (above), then:

      1. Stop the upgraded JIRA installation.
      
      2. Migrate the customizations from these files into the upgraded JIRA Installation Directory.

      3. Restart the upgraded JIRA installation.

8. The last step of the upgrade wizard provides you with a link to launch the upgraded JIRA installation in a browser, so you can check the upgrade.

Congratulations, you have completed upgrading your JIRA installation on Linux!

4. Post Upgrade Checks and Tasks

Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading JIRA. This can be done via the Plugin Repository in your Administration Console.
Congratulations! You have completed your JIRA upgrade.

Skipping Major Versions When Upgrading JIRA

To upgrade from early versions of JIRA (3.x or earlier) to newer versions, you must upgrade to JIRA 4.4.5 before upgrading to a later version.

Follow these steps to skip major versions as you upgrade JIRA:

1. **Prepare**: Read the upgrade guides for all the major versions between your current version and the version to which you are upgrading. You can read about important changes between versions in the Important Version-Specific Upgrade Notes.

2. **Upgrade to an interim version** (*JIRA 3.x or earlier only*): Upgrade to JIRA 4.4.5 following these Upgrading JIRA with a Fallback Method instructions.

3. **Upgrade to the new version**: Upgrade to the new version of JIRA following these appropriate instructions. Use the table on Upgrading JIRA page to determine which method is appropriate for your environment.

Disabling Auto-Export

When upgrading JIRA, one points the new JIRA installation at the old JIRA database. JIRA will automatically make any structural database modifications required to support new JIRA features.

To be safe, JIRA first tries to create an XML backup of your data at the point just before the upgrade. This would allow you to ‘roll back’ to the old JIRA version, should anything go wrong.

Sometimes the automatic XML backup procedure fails, often resulting from characters in the database which cannot be represented in XML — such as non-displayable control characters that have been ‘cut-and-pasted’ into a JIRA field.

<table>
<thead>
<tr>
<th>Time</th>
<th>Level</th>
<th>Type</th>
<th>Description</th>
<th>Exception</th>
</tr>
</thead>
<tbody>
<tr>
<td>2004-06-11 09:59:22</td>
<td>EventLevel: error</td>
<td>EventType: export-illegal-xml</td>
<td>Illegal XML characters in date prevent successful export before the upgrade. To disable the export on upgrade, start JIRA with the flag -Djira.autoexport=false</td>
<td>Illegal XML characters found in data. Cannot export data before upgrade.</td>
</tr>
</tbody>
</table>

In these circumstances, you can force the upgrade to proceed by editing your jira-config.properties file (in the JIRA Home Directory) and setting the property jira.autoexport=false.** See Making changes to the jira-config.properties file for more information.

After having successfully upgraded JIRA, it is best to remove this property (or disable it with a ‘#’) as it should no longer be required.

If you have any upgrade problems not covered here or in the upgrade documentation, please contact us — we’re happy to help.

Rolling Back a JIRA Upgrade

The ‘roll back’ procedures on this page describe how to restore your previous version of JIRA in the unlikely event that you encounter an issue with your JIRA upgrade. Please follow the procedure below that relates to the upgrade procedure you used. Note that any data changed since the last backup will not be present after rolling...
If you upgraded JIRA using the Migrating JIRA to Another Server procedure, your previous JIRA installation should still be 'intact' (assuming you haven't deleted it) and there should not be a need to perform any 'roll back'.

Rolling Back a JIRA Upgrade Conducted Using the Upgrade Wizard

Use this procedure to roll back a JIRA upgrade conducted using the upgrade wizard.

Prior to rolling back your JIRA upgrade, ensure that you have the following backups from your previous JIRA version:

- The JIRA database (generated by your database's own backup tools).
- The JIRA Home Directory.
- The JIRA Installation Directory.

To roll back your JIRA upgrade conducted using the upgrade wizard:

1. Stop the JIRA upgrade or the upgraded JIRA server if it is running.
2. Use your database server's tools to restore the JIRA database backup you had created.
3. Delete the contents of the JIRA Installation Directory.
4. Restore the backed-up JIRA Installation Directory to the same location in the previous step.
5. Delete the contents of the JIRA Home Directory.
6. Restore the backed-up JIRA Home Directory to the same location in the previous step.
7. Start JIRA (by running the `start-jira.sh` or `start-jira.bat` file in the `bin` subdirectory of your restored JIRA installation directory).

On Windows based systems if JIRA was installed as a service, restart the Atlassian JIRA service from the Control Panel. The JIRA service entry will be retained even if there is an error during upgrade in order to facilitate the rollback.

Rolling Back a JIRA Upgrade Conducted Manually

Use this procedure to roll back a JIRA upgrade conducted using the manual JIRA upgrade procedure (involving an 'in-place' database upgrade). The intended result of this procedure is to restore your previous JIRA installation to its original state (consisting of the restored database as well as the JIRA Installation and Home directories in their original locations).

Prior to rolling back your JIRA upgrade, ensure that you have the following backups from your previous JIRA version:

- The JIRA database (generated by your database's own backup tools).
- The JIRA Home Directory.
- The JIRA Installation Directory.

To roll back your JIRA upgrade conducted manually with an 'in-place' database upgrade:

1. Stop the JIRA upgrade or the upgraded JIRA server if it is running.
2. Use your database server's tools to restore the JIRA database backup you had created.
3. If you had deleted the JIRA Installation Directory of your previous JIRA version, restore the backed-up JIRA Installation Directory to its original location.
4. Delete the contents of the JIRA Home Directory.
5. Restore the backed-up JIRA Home Directory to the same location in the previous step.
6. Start JIRA (by running the `start-jira.sh` or `start-jira.bat` file in the `bin` subdirectory of your restored JIRA installation directory).

Migrating JIRA to Another Server

This document describes how to migrate/upgrade to JIRA 6.4 on different server hardware or in a different server environment that entails one or more of the following:

- a new operating system that will run JIRA,
- new locations for storing your index and/or attachments, or
- a new database or database system that will store JIRA's data.

If you are upgrading to a newer version of JIRA during the migration, please see Upgrading JIRA for information...
on the pre-requisite tasks you need to complete before upgrading.

On this page:
- 1. Before You Start
- 2. Backing Up
  - 2.1 Stop users from updating JIRA data
  - 2.2 Back up your database
  - 2.3 Back up your JIRA Home directory
  - 2.4 Back up your attachments and index directories if located outside your JIRA Home directory
  - 2.5 Back up your JIRA Installation directory
- 3. Setting up your New JIRA Installation
  - 3.1 Install the new version of JIRA
  - 3.2 Point your new JIRA to (a copy of) your existing JIRA Home directory
  - 3.3 Connect the new version of JIRA to a new, empty database
  - 3.4 Migrate your existing JIRA configurations over to your new JIRA installation
  - 3.5 Start your new version of JIRA
  - 3.6 Import your old JIRA data into your new JIRA
- 4. Post Migration Checks and Tasks

1. Before You Start
- **Check your license** - Verify that your license support period is still valid.
- **Check for known issues** - Use the JIRA Knowledge Base to search for any issues in the new version that will affect you.
- **Check for compatibility**:
  - Confirm that your operating system, database, other applicable platforms and hardware still comply with the requirements for JIRA 6.4. The End of Support Announcements for JIRA page also has important information regarding platform support for future versions of JIRA.
  - If you have installed JIRA Add-ons (i.e. not included with JIRA), verify that they will be compatible. You can find a add-on's compatibility information from the the add-on's home page on the Atlassian Marketplace. You can also follow the procedure outlined here: Checking add-on compatibility with application updates to have the Universal Add-on Manager help you with this.

We strongly recommend performing your migration in a test environment first. Do not migrate your production JIRA server until you are satisfied that your test environment upgrade has been successful.

- If you have any problems with your test environment which you cannot resolve, create an issue at our support site so that we can assist you.
- If you have any problems during the migration of your production JIRA server, do not allow your users to start using this server. Instead:
  - Continue to use your old JIRA server — this will help ensure that you do not lose production data.
  - Also create an issue at our support site so that we can help you resolve the problems with your migration.

Some anti-virus or other Internet security tools may interfere with the migration and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the JIRA migration.

2. Backing Up

2.1 Stop users from updating JIRA data

During the upgrade process, you'll export JIRA's database from your existing JIRA installation (via an XML backup) and then restore this backup into a new JIRA installation. To ensure that the data in the XML backup is consistent with the latest data in the system, you must temporarily restrict access to JIRA so users can't update the data. Refer to the Preventing users from accessing JIRA during backups page for more information.
1. Be aware! Inconsistent XML backups cannot be restored!

2.2 Back up your database

Perform an XML backup of your existing JIRA installation’s external database. For large JIRA installations, this process may require several hours to complete.

The 'embedded database' is the HSQLDB database supplied with JIRA for evaluation purposes only. If you accidentally use the HSQLDB database in a production system, perform an XML backup of this database and continue on with this procedure.

2.3 Back up your JIRA Home directory

1. Shut down JIRA.
2. Locate the JIRA Home directory. You can find information about the location of the directory by navigating to the <jira-application-dir>/WEB-INF/classes/jira-application.properties file in your JIRA Installation Directory. Alternatively, you can open the JIRA Configuration Tool to see the directory that is set as your JIRA Home.
3. Navigate to the directory specified in the configuration file and create a backup of it in another directory.
4. Delete the file <jira-home>/dbconfig.xml as soon as the backup is complete.

2.4 Back up attachments and index directories if located outside your JIRA Home directory

If the attachments and index directories are located outside of your JIRA Home Directory, you must back them up separately. These pages describe how to find out where these directories are located in your implementation:

- Your attachments directory — Refer to Configuring File Attachments page in the documentation for your version of JIRA.
- Your index directory — Refer to Search Indexing page in the documentation for your version of JIRA.

Also refer to Backing Up Data for more information about backing up attachments in JIRA.

2.5 Back up your JIRA Installation directory

The 'JIRA Installation Directory' is the directory into which the JIRA application files and libraries were extracted when JIRA was installed.

3. Setting up your New JIRA Installation

If you are running a 'mission-critical' JIRA server, we highly recommend performing the remaining steps of this guide in a test environment (e.g. using a separate test JIRA database and a copy of your JIRA Home directory) before performing the upgrade for production use.

3.1 Install the new version of JIRA

First, you must start with a fresh installation of JIRA, either the current version or a newer one. If you are upgrading JIRA during this process, please see Upgrading JIRA for information on the pre-requisite tasks you need to complete before upgrading.

Download and extract the JIRA distribution you require, to a new directory. Do not overwrite your existing JIRA installation. Ensure this has been shut down and install the new JIRA version to a new location.

Follow the installation instructions for either:

- Installing JIRA (recommended), or
- Installing JIRA WAR

If you are using JIRA WAR, remember to build your new JIRA web application and deploy it to your server. For specific instructions, refer to the JIRA WAR installation page for your application server within the Installing JIRA WAR section.

3.2 Point your new JIRA to (a copy of) your existing JIRA Home directory
If your new JIRA 6.4 installation is on a new server, copy the backup of your existing JIRA Home Directory from the old server to the new server before proceeding.

To set up a "recommended" (not WAR) distribution:

1. Open the JIRA Configuration Tool.
2. Click the JIRA Home tab.
3. Update the JIRA Home Directory field:
   - If your JIRA 6.4 installation is on a new server, update the JIRA Home Directory field to the path of your copied JIRA Home directory.
   - If your JIRA 6.4 installation is on the same server, update the JIRA Home Directory field to the path of your existing JIRA Home directory.

For more information about this directory, see JIRA Home Directory.

To set up a WAR distribution:

1. Edit the jira-application.properties file located within the <jira-application-dir>/WEB-INF/classes subdirectory of your new JIRA 6.4 Installation Directory.
2. Update the jira.home property in this file to the path of the new JIRA Home Directory:
   - If your JIRA 6.4 installation is on a new server, update the jira.home property to the path of your copied JIRA Home directory.
   - If your JIRA 6.4 installation is on the same server, update the jira.home property to the path of your existing JIRA Home directory.

For more information about this directory, see JIRA Home Directory.

3. Remove the '#' at the beginning of the line (so that JIRA no longer regards this line as a comment).
4. Save your updated jira-application.properties file.

You can also set your JIRA Home Directory's location by defining an operating system environment variable JIRA_HOME. This value of this variable takes precedence over the value of the jira.home property in the jira-application.properties file in your JIRA Installation Directory. See Setting your JIRA Home Directory for details.

3.3 Connect the new version of JIRA to a new, empty database

Create a new, empty database that your new JIRA installation will use to store its data.

Follow the appropriate 'Connecting JIRA to...' instructions for your database from stage 2, although from stage 4 of that procedure, be aware of the yellow note below:

- Connecting JIRA to PostgreSQL
- Connecting JIRA to MySQL
- Connecting JIRA to Oracle
- Connecting JIRA to SQL Server 2005
- Connecting JIRA to SQL Server 2008

If you are using a database (called jiradb, for example) with your existing JIRA installation and the database for your new JIRA installation is running on the same machine or database server, create your new database with a different name (e.g. something intuitive like jiradb_440 for JIRA 4.4.0). However, ensure the new database has identical access permissions to the old JIRA database. Consult your database administrator if you need assistance with this.

You do not need to create a new database if you are using the embedded HSQL database.

3.4 Migrate your existing JIRA configurations over to your new JIRA installation

If you have modified properties in configuration files of your existing JIRA installation, make the same modifications in your new JIRA installation. However, because the properties in the configuration files may have changed between versions, you cannot simply copy the configuration files from your existing installation and replace the equivalent files in the new installation.

For each file you have modified in your existing JIRA installation, you need to manually edit each equivalent file in your new JIRA installation and re-apply your modifications. If a file is not present in your new JIRA
installation (for example, osuser.xml in recent JIRA versions), then simply copy that file over to your new JIRA installation.

The table below lists the most commonly modified files and their locations within your JIRA Installation Directory:

<table>
<thead>
<tr>
<th>File</th>
<th>Location in 'recommended' (formerly 'Standalone') JIRA distributions</th>
<th>Location in JIRA WAR</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira-application.properties</td>
<td>atlassian-jira/WEB-INF/classes</td>
<td>webapp/WEB-INF/classes</td>
<td>Location of the JIRA Home and Directory. Advanced JIRA in JIRA 4.3.x and Configuration earlier. Any custom property values defined in the jira-application.properties file of your existing JIRA 4.3.x (or earlier) installation must be migrated across to the jira-application.properties file of your new JIRA 6.4 installation before you start your new JIRA installation. Upon starting your new JIRA installation, any custom property values in the jira-application.properties file will automatically be migrated across to either the JIRA or database file.</td>
</tr>
<tr>
<td>setenv.bat (Windows) or setenv.sh (Linux)</td>
<td>bin</td>
<td>Application server's bin directory</td>
<td>Increasing JIRA Memory.</td>
</tr>
<tr>
<td>osuser.xml (not required if upgrading from JIRA 4.3.0 or later)</td>
<td>atlassian-jira/WEB-INF/classes</td>
<td>webapp/WEB-INF/classes</td>
<td>Modified LDAP with JIRA integrated Crowd, or if you are using a custom form of external user management or user authentication.</td>
</tr>
<tr>
<td>seraph-config.xml</td>
<td>atlassian-jira/WEB-INF/classes</td>
<td>webapp/WEB-INF/classes</td>
<td>Modified Crowd.</td>
</tr>
<tr>
<td>server.xml</td>
<td>conf</td>
<td>Application server's conf directory</td>
<td>Modified JIRA if y the JIR. If y Wh do dat ear.</td>
</tr>
</tbody>
</table>

The version-specific upgrade notes contain details on properties which may have changed in these commonly modified files.

In addition to the files above, you should also consider and/or perform the following configurations as part of the upgrade process:

- **Using JIRA with Atlassian's Crowd?** — If you are using Crowd with JIRA, configure your new JIRA to talk to Crowd as described in Integrating Crowd with JIRA.
- Remember to configure Crowd to grant JIRA's new hostname/IP access: Specifying an Application's Address or Hostname
- Allocating additional memory to JIRA — If you had previously allocated additional memory to JIRA, do the same for your new JIRA instance. For more information refer to Increasing JIRA memory.
- Plugins — For any plugins that you had installed in your old JIRA, download the plugin version for your new version of JIRA from the http://plugins.atlassian.com site.
- Character encoding — Ensure that character encoding (i.e. locale) is the same on the new and old locations. Your new version of JIRA may not function correctly if attachments are moved between two systems with incompatible encoding.
- Customisations — If you had made any customisations (code, templates or configuration files), copy over compatible versions of these changes to the new JIRA. (The developers within your organisation who made the customisations to your old version will need to build and test equivalent changes for the new version, and provide you with the files to copy to your upgraded JIRA installation.)
- (Optional) Running JIRA on a different port — If your new JIRA is installed on the same machine as your old JIRA, you may wish to make sure it runs on a different port (in case you ever need to restart your old JIRA). See Changing JIRA's TCP Ports for details.

3.5 Start your new version of JIRA

1. Verify that your old JIRA installation is shut down — if this JIRA server is still operating, shut it down.
2. If you installed the JIRA WAR distribution within Tomcat, delete the Tomcat work directory before restarting JIRA. If you do not do this, users may encounter errors when they try to display JIRA pages.
3. Start up your new version of JIRA. For:
   - 'Recommended' distributions — follow the Starting JIRA instructions.
   - WAR distributions — follow the instructions for starting JIRA for your application server within the Installing JIRA WAR section.
   - During the startup process, your new JIRA installation will create any required database indexes. If you created any custom database indexes, please check them afterwards and remove any that duplicate the indexes added by JIRA.

Do not restart your old JIRA installation...

If your new JIRA 6.4 installation is on the same server as your old one, it may still be configured to use the same JIRA Home directory as your new JIRA installation. Running two separate JIRA installations which share a common JIRA Home directory can lead to serious data corruption.

Nevertheless, we recommend that you do not delete any aspect (or backed up component) of your old JIRA installation, until you are satisfied that your upgraded JIRA installation is functioning as expected.

3.6 Import your old JIRA data into your new JIRA

After you have started your new JIRA installation, import the data from your old instance into the new instance. You will need the backup file of data from your old JIRA that you created earlier in these instructions (above).

To import your old JIRA data into your new JIRA:

1. Log in as a user with the 'JIRA System Administrators' global permission.
2. Select Administration > System > Import & Export > Restore System (tab) to open the 'Restore JIRA data from Backup' page.
   - Keyboard shortcut: 'g' + 'g' + type 'rest'
3. In the File name field, specify the XML backup file you created previously during the export process (above). That zipped file should contain two xml files: activeobjects.xml and entities.xml. Both of these files must be included in the zipped file for the import process to work.
4. Restore the attachments directory that you backed up previously, into the attachments directory of your new JIRA. (See Restoring Data.)
   - Avoid passing through a proxy when performing an XML restore, especially if your JIRA instance is very large. Using a proxy may cause timeout errors.
5. Access JIRA via your web browser again and log in using a username from your previous JIRA installation.
6. Take a quick look around your JIRA site to confirm that your projects and issues are present and everything looks normal. You should see the new JIRA version number in the page footer.
4. Post Migration Checks and Tasks

It is strongly recommended that you perform the following checks and tasks after you have started your new instance of JIRA:

1. Check your server logs for error messages, even if JIRA appears to be running correctly. If there are any errors there that you cannot resolve, create a support case in https://support.atlassian.com, attach your log file and we will advise you on the errors.
2. If you were previously using External User Management, enable it in the new JIRA instance.
3. If you changed machines when upgrading, change the paths to the indexes, attachments and backup directories, from within the Administration section of JIRA.
4. Enable email, if you disabled it during testing.
5. If you migrated any customisations from your old JIRA to the new JIRA, ensure that they are tested thoroughly.
   a. If you had downloaded plugins for the new version of JIRA, install the downloaded JAR file(s) in your new JIRA version and carry out any other required installation for the plugin.
   b. If the plugin has a properties file, apply the same changes to it as you had in the old properties file (don't just copy over the old properties file).
6. Once you have confirmed that the new server is working correctly, ensure that the production license is updated for the new server ID, as follows:
   b. Locate the appropriate license.
   c. Edit the Server ID, as per the new production Server ID, and save it.
   d. Update the production license in the new server.

Congratulations! You have completed your JIRA migration/upgrade.

See Also

Disabling Auto-Export
Restoring Data
Upgrading JIRA
Switching Application Servers to Apache Tomcat
Switching Databases
Migrating from JIRA Cloud to JIRA Server

This page is for people who are currently using a JIRA Cloud site and wish to move to a JIRA site that is hosted on their own servers. If you want to move a project, not your entire site, then see Restoring a Project from Backup (note, the instructions on that page take into account the version mismatch between JIRA Server and JIRA Cloud).

Summary

You will need to download and install the latest production release of JIRA Server. Please check https://www.atlassian.com/software/jira/download for the latest version. Once you have installed the latest production version, you then move your data from your hosted JIRA Cloud site into your new JIRA Server site.

On this page:
- Summary
- Before you begin
- Instructions
- Version matrix for imports

Before you begin

JIRA Cloud is regularly updated with the absolute latest features and improvements — it is essentially running on the most up to date version of JIRA. If you want to migrate from JIRA Cloud to a site installed from the latest JIRA Server download, please be aware of the following information before you begin:

Known issues

Read the following known issues before you start your migration:
• **Tempo data loss**: If you have made changes to the Tempo scheduler in JIRA Cloud after March 24 (JIRA 6.3-OD-01 upgrade), these changes will be lost when you migrate to a JIRA Server instance. This is due to changes that we have made to the scheduler data in JIRA Cloud that are not available in JIRA 6.2.x. To address this issue, choose one of the following options:
  
  - Do not make changes to the Tempo scheduler in JIRA Cloud after March 24. Wait until you have migrated to JIRA Server before making changes.
  - Keep a record of any changes that you make to the Tempo scheduler in JIRA Cloud after March 24 and make those same changes in Tempo after you migrate to JIRA Server.
  - (Not for production sites) Migrate to a JIRA 6.3 EAP instance

• **Changes to Time Zones**: If your JIRA Server system time zone is different to the JIRA Cloud system time zone, there may be a mismatch when the instance is restored. Please see [JRA-26039](https://jira.atlassian.com/browse/JRA-26039) - Verify the system timezone when an XML backup is restored for the workaround to this.

**Feature loss**

If you migrate from JIRA Cloud to a site installed from the standard JIRA Server download, you will likely find a few features missing. This is because we have introduced features from the upcoming JIRA Server version into JIRA Cloud. For example, the latest JIRA Server production release for download is JIRA 6.2.x. JIRA 6.3 is currently under development. Some of the JIRA 6.3 features have been made available in JIRA Cloud, but will not become available for JIRA Server until the final JIRA 6.3 version is released.

**JIRA license**

Your Atlassian Cloud license cannot be used in a site installed from the standard JIRA Server download. You will need to generate a new "JIRA" license from [https://my.atlassian.com](https://my.atlassian.com) for your site installed from the standard JIRA Server download.

You can reuse your licenses for plugins in your site installed from the standard JIRA Server download. The licenses for Atlassian plugins and Gliffy for JIRA can be viewed on [https://my.atlassian.com](https://my.atlassian.com). You will need to contact your vendor for the licenses for all other third-party plugins.

**Migrating other Cloud applications**

The instructions on this page only apply to JIRA. If you are migrating other Cloud applications (e.g. Confluence Cloud to a site installed from the standard Confluence Server download), please see this page: [Backing up and exporting data](https://confluence.atlassian.com/administer_backing-up-and-exporting-data-26039).

Note, if you are migrating JIRA Cloud and other applications (e.g. Confluence Cloud) to a site hosted on your own servers, you will also lose a number of integration features that are native to Cloud (e.g. [Creating Links]). These can be re-enabled by configuring application links between your applications. See [Configuring Application Links](https://confluence.atlassian.com/configuring-application-links-26039) and [Quick Start: Application Links](https://confluence.atlassian.com/quick-start-application-links-26039) for instructions. Contact support if you need assistance.

**Instructions**

1. Generate a backup of your JIRA Cloud data
2. Install JIRA Server from a standard download
3. Import your JIRA Cloud data into your JIRA Server installation
4. Copy across attachments
5. Change the system administrator password
6. Check which plugins are installed on your JIRA Cloud site
7. Install plugins (add-ons)

1. **Generate a backup of your JIRA Cloud data**
   
   1. Log in to your JIRA Cloud site as an administrator.
   2. Generate an XML export from your JIRA Cloud data by following the instructions in [Exporting issues](https://jira.atlassian.com/wiki/display/JIRA6/Exporting+issues). This includes instructions on how to back up your attachments.
      
      Note, the export process will strip your Cloud license and plugin licenses out of the XML, they will not be available when importing into the installed site, but they will remain available in JIRA Cloud.
   3. Download the backup file from your Cloud WebDAV directory (also described in [Exporting issues](https://jira.atlassian.com/wiki/display/JIRA6/Exporting+issues)).

2. **Install JIRA Server from a standard download**
   
   You must use the latest version of JIRA Server.

2. Follow the instructions in Installing JIRA until you are instructed to run the setup wizard, then see step 4 below.

3. Import your JIRA Cloud data into your JIRA Server installation

Follow the instructions in Running the Setup Wizard until you have configured a database (described in step 1 of Running the Setup Wizard). We recommend that you use PostgreSQL for your database, although you can use any of the supported databases. If you already have some data in your JIRA Server installation, this step will overwrite it. See Restoring Data for more information.

```plaintext
For instances with large backups (2Gigabyte and up), we recommend importing the attachments separate from the Issue and user data. To do this:
1. Unzip the backup file.
2. Compress the activeobjects.xml and the entities.xml files only.
3. Import that compressed file.
```

4. Copy across attachments

If you included your attachments in the export:

1. Extract the backup file that was downloaded.
2. Copy across the contents of the attachments folder to the $JIRA_HOME/data/attachments directory for the JIRA Server version.
3. Change the ownership of all files and folders under this directory to the user running JIRA and the corresponding user group.
   - For Linux this could be done using the command `sudo chown -R jira:jira $JIRA_HOME/data/attachments`
   - For Windows, please refer to this Techotopia documentation.

5. Change the system administrator password

1. Log in to your new JIRA Server site, using the following credentials:
   - Username: sysadmin
   - Password: sysadmin
2. Change the password immediately after logging in.

6. Check which plugins are installed on your JIRA Cloud site

Any plugins that you are currently using with JIRA Cloud will need to be installed in your JIRA Server installation. For example, JIRA Agile, Tempo, etc.

Choose ☐ > Add-ons. The 'Find add-ons' screen shows add-ons available via the Atlassian Marketplace. Choose Manage Add-ons to view the plugins currently installed on your JIRA site. Choose Manage Add-ons and note the plugins listed under the User-installed Plugins section. You will need to note the plugin names and versions.

7. Install plugins (add-ons)

For each plugin that you noted in the previous step, install it in your JIRA Server installation. You must install a version of the plugin that is equal to or later than the plugin version that was installed on JIRA Cloud. Atlassian does not provide support for data that is downgraded as a result of installing an older version of a plugin.

See Managing Add-ons for instructions on how to install a plugin. You will need to manually add the plugin license keys.

The Support Tools Plugin that comes bundled with JIRA will get disabled after completion of the migration. Look it up under "All add-ons" in the Manage add-ons section to re-enable it.
The following table tells you which version of JIRA Server to use, when migrating from JIRA Cloud. The version number is dependent on when you exported your data from JIRA Cloud.

ℹ️ *We recommend that you use the latest JIRA Server version unless otherwise specified below. Only use the versions listed below if you cannot use the latest JIRA Server version.*

<table>
<thead>
<tr>
<th>Date when export was made</th>
<th>Version of JIRA Server to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prior to 3 Dec 2012</td>
<td>Contact support for assistance</td>
</tr>
<tr>
<td>3 Dec 2012 — 16 Dec 2012</td>
<td>5.2.1</td>
</tr>
<tr>
<td>17 Dec 2012 — 20 Jan 2013</td>
<td>5.2.2</td>
</tr>
<tr>
<td>21 Jan 2013 — 6 Feb 2013</td>
<td>5.2.5</td>
</tr>
<tr>
<td>7 Feb 2013 — current</td>
<td>Use the latest version available</td>
</tr>
</tbody>
</table>

### Establishing Staging Server Environments for JIRA

This document describes best practices for an enterprise environment setup for JIRA:

- Best-practice recommendations for procedural governance around rolling out changes
- Recommendations for development / staging / production architecture
- Technical steps for how to deploy non-production servers

**Assumptions:**
- For this document we are assuming that as an administrator, you would rather script changes. Therefore we have omitted UI-based changes or separate tools such as the database configuration tool in favour of specifying file system locations.

**On this page:**
- 1. Architecture Strategy
- 2. Governance Strategy
- 3. How to Refresh a Staging Server
  - 3.1 Create a complete production backup
  - 3.2 Copy your complete production backup to a staging environment
  - 3.3 Modify your staging environment for the unique configurations
  - 3.4 Restart your Staging Server
  - 3.5 Post-Startup Modifications

⚠️ **Please Note:**
- The procedures described in this document will work with JIRA version 4.0 and later.
- Please read the entire document before bringing a staging server live. There are risks associated with connecting to production instances that require attention, which are called out in the document.

#### 1. Architecture Strategy

Often systems administration teams will have an established architecture for enterprise applications, including staging environments and failover setups. We offer these recommendations in this section not to supplant or change those company-wide strategies, but rather to help illustrate what some of the considerations will be with Atlassian products in staging environments.

**Definitions**

For the purpose of this document, we'll assume the following definitions:

- **Production**: your live instance, expecting minimal downtime and well tested changes.
1. **Staging**: a pre-production environment, where the systems administration team can establish exact procedures prior to rollout.

2. **Development**: a free-for-all environment where users can play with cutting-edge or risky changes.

**Recommendation**

If Atlassian products are critical systems, we recommend this 3-tier strategy for development, staging, and production.

- The staging environment is primarily for system administrators to test changes and upgrades before going into production.
- The development environment is for different business units to test changes on their own, before requesting a production rollout.

**2. Governance Strategy**

In addition to an architecture, we also recommend establishing a governance strategy for changes. This could include:

- Create a strategy for deploying and testing plugin installation requests. Note that some plugins that are extremely useful in some environments are not appropriate for high-volume critical systems.
- Publish a timeline for refreshing the development environment, so users know when to remove their changes.
- Set up a source control repository to house any file system changes, so you can track when changes were made and by whom, historically. If you don't have one already established, Bitbucket is an option. In addition to file system customizations, record your procedures for upgrades, staging refresh (see below) and any other scripted changesets in your source control.

**Tip**: JIRA has a tool to manage any changes in your installation. Check the System Information page in the UI for "modified files." This will tell you which files have been customized in your installation directory.

- For changes such as creating new workflows (that require administrative access), you have two options:
  1. Create an administrative user which has temporary access to administrative functions, on a per-request basis. Add this user to the appropriate groups so they can perform the necessary administrative functions. When the user has completed their administrative functions, remove the user from these groups.
  2. Keep your development server devoid of production data and give more administrative privilege on this server. Require end-users to document specific workflow or scheme setups, then repeat these steps in production.

**3. How to Refresh a Staging Server**

We're assuming that you have an existing staging installation. If not, you can use these instructions to set up your staging environment now.

Take care to make sure your staging server setup does not interfere with your production environment. Read the tips below before launching your staging (or development) server.

**3.1 Create a complete production backup**

1. **Back up your home directory.** See [Setting your JIRA Home Directory](#) for the location of your production home directory.
   
   Back up your production attachments and index directories if located outside your JIRA Home directory. If you're unsure where these are stored, refer to [Configuring File Attachments](#) and [Search Indexing](#) to determine these locations.
   
   Refer to [Backing Up Data](#) for more information about backing up attachments in JIRA.

2. **Back up your installation directory.** The 'JIRA Installation Directory' is the directory into which the JIRA application files and libraries were extracted when JIRA was installed.

3. **Back up your production database.** Use your native backup tools to take a snapshot of your production database.

**3.2 Copy your complete production backup to a staging environment**
1. Shut down your staging server.
2. Restore your installation and home directories on the staging server.
3. Point the newly restored installation directory to the newly restored JIRA Home directory.
   a. Edit the `jira-application.properties` file located within the `<jira-application-dir>/WEB-INF/classes` subdirectory of your new Installation Directory JIRA Installation Directory.
   b. Update the `jira.home` property in this file to the path of the new JIRA Home Directory to the path of your copied JIRA Home directory.
   c. Save your updated `jira-application.properties` file.
   ✔️ You can also set your JIRA Home Directory's location by defining an operating system environment variable JIRA_HOME. This value of this variable takes precedence over the value of the `jira.home` property in the `jira-application.properties` file in your JIRA Installation Directory. See Setting your JIRA Home Directory for details.
4. Restore your database to a staging database.
   ❗️ If you are using a database (called jiradb for example) with your existing JIRA installation and the database for your new JIRA installation is running on the same machine or database server, create your new database with a different name (e.g. something intuitive like jiradb_440 for JIRA 4.4.0). Oracle does not support schema names with periods or underscores. Ensure the new database has identical access permissions to the old JIRA database.

3.3 Modify your staging environment for the unique configurations

1. Configure your database connection to point to your staging database. Edit the `dbconfig.xml` file at the root of your JIRA Home Directory, or the datasource in `<jira-install>/conf/server.xml` for older versions.
   ✔️ This is extremely important! Make sure your staging environment is not pointing to your production database.
2. There are two options to handling email:
   a. Disable mail on your staging server. If you need to perform some initial tests on your new JIRA installation, you can enable its email access to prevent unintended emails being sent. You can leave emails on, if you're wanting to test email functionality. If you choose to do keep emails enabled, watch particularly for:
      i. Create or comment handlers, which can pull mail from your production mail servers. You can disable these from Administration > Advanced > Services, or delete them from 'serviceconfig' table in the database.
      ii. Filter subscriptions, as your users will receive notifications for filters they're subscribed to. Delete filter subscriptions from the 'filtersubscription' table in the database.
      iii. Notifications on tickets that are updated. For these, dissociate any notification schemes to projects you wish to test without email notifications.
   b. Keep email enabled and configure your staging instance to test email:
      i. See the guide here: How to Prepare a Development Server's Mail Configuration

3.4 Restart your Staging Server

You are now ready to restart your server. Once you've restarted, perform the following checks to verify you've done the above steps safely:

1. Ensure the database is not pointing to production. To check this, see Viewing your System Information. Check the 'Database URL' to ensure it's pointing to the right place.
2. Ensure emails are disabled or configured for dev server. Also when Viewing your System Information, check the 'JVM Input Arguments' for the line 'atlassian.mail.senddisabled'. If you configured the email for a dev server as described above, this line will not be there.

3.5 Post-Startup Modifications

1. Modify the Site Colors. See Customizing the Look and Feel. This is a good practice for users to identify that they're on the staging server.
2. Modify the Site Base URL. See Configuring JIRA Options and change the Site URL to the staging URL.
3. Consider the URL Whitelist. You may wish to change some of the approved URLs. See Configuring the Whitelist.
4. Apply a Development License. See our licensing FAQ to generate a license for the staging server. Refer to Updating your JIRA License Details to apply it.
5. Reconfigure applinks. If you are connecting to other servers via applinks, you'll need to change the server ID for those instances.
If you leave applinks in place, it's possible to have your production instance point back to the staging server, if a link is generated.

a. Confluence: How to change the server ID of Confluence
b. JIRA: Changing Server ID for Test Installations

6. **Disable HipChat integration.** If you have integrations which notify HipChat in any of your JIRA workflows, then you will need to remove the token from the HipChat integration configuration in **Administration > Mail > HipChat Configuration**, to prevent HipChat notifications being sent from the staging environment.

### Important Directories and Files

**On this page:**
- JIRA Installation Directory
  - Important Files and Directories
    - `<jira-application-dir>/atlassian-jira/WEB-INF/classes/jira-application.properties`
    - `<jira-application-dir>/atlassian-jira/WEB-INF/classes/jpm.xml`
    - `<jira-application-dir>/atlassian-jira/WEB-INF/lib/`
    - `<jira-application-dir>/atlassian-jira/WEB-INF/classes/log4j.properties`
    - `<jira-application-dir>/atlassian-jira/WEB-INF/classes/entityengine.xml`
    - `conf/server.xml`
    - Memory Settings
- JIRA Home Directory
  - Important Files
    - `dbconfig.xml`
    - `jira-config.properties`
  - Important Subdirectories
    - `data`
    - `export`
    - `log`
    - `plugins`
    - `caches`
    - `tmp`

### JIRA Installation Directory

The 'JIRA Installation Directory' is the directory into which the JIRA application files and libraries have been extracted, either:

- by the **Windows** or **Linux** installers, or
- by extracting the contents of a JIRA installation archive or WAR distribution archive file (i.e. a `.tar.gz` or `.zip` file).

JIRA does not modify or store any data in this directory.

### Important Files and Directories

The directories/files described below are found under different sub-directories of the 'JIRA Installation Directory', depending on whether you have installed a 'recommended' or WAR distribution of JIRA. Please substitute the following directories for the `<jira-application-dir>` placeholder (used throughout the rest of this section), as follows:

- **'Recommended' distributions** — the `atlassian-jira` subdirectory of the 'JIRA Installation Directory' installed using the 'Windows Installer', 'Linux Installer' or from an 'Archive File'.
- **WAR distribution** — the `webapp` subdirectory of the 'JIRA Installation Directory'.

**Please Note:** To edit files in this `webapp` directory, first copy them to the `edit-webapp` subdirectory (if they are not already present in `edit-webapp`) and edit the copies in `edit-webapp`.
Refer to the 'Webapp Layout' section of the JIRA WAR Configuration Overview for details. Copies of the jira-application.properties and entityengine.xml file are already available in the edit-webapp sub-directory.

<jira-application-dir>/atlassian-jira/WEB-INF/classes/jira-application.properties

This file tells JIRA where to find the JIRA Home Directory. Be aware that your JIRA Home Directory defined in this file can be overridden. See Setting your JIRA Home Directory for more information.

<jira-application-dir>/atlassian-jira/WEB-INF/classes/jpm.xml

This file stores the default values for JIRA's advanced configuration settings and should not be modified. The default values of properties in this file are customized (i.e. overridden) by redefining them in either the jira-config.properties file (in your JIRA Home Directory) or the JIRA database (via the JIRA administration area). See Advanced JIRA Configuration for more information.

<jira-application-dir>/atlassian-jira/WEB-INF/lib/

This is the directory where plugins built on Atlassian's Plugin Framework 1 (i.e. 'Plugins 1' plugins) are stored. If you are installing a new 'Plugins 1' plugin, you will need to deploy it into this directory. 'Plugins 2' plugins should be stored in the JIRA Home Directory.

<jira-application-dir>/atlassian-jira/WEB-INF/classes/log4j.properties

JIRA's logging configuration file. See Logging and Profiling.

The actual log files generated by JIRA can be found in the following locations:

- **JIRA application log** — bin/atlassian-jira.log
- **Application server log** — generally the application server log file can be found under the logs directory. However, this can vary depending on the application server you are running. Please see Where are the application server logs? for further details.

<jira-application-dir>/atlassian-jira/WEB-INF/classes/entityengine.xml

This file configures the OFBiz Entity Engine which JIRA uses to store persist data in a datasource. See Configuring the Entity Engine for JIRA.

The sub-directories/files described below are found under the root of the JIRA Installation directory.

conf/server.xml

This file is used for JIRA SSL configuration. See Running JIRA over SSL or HTTPS.

Memory Settings

The file used to edit JAVA_OPTS memory settings will depend on the method used to install JIRA, as well as the operating system used for your installation.

For example, if you are running JIRA on Tomcat in Windows (manual startup), you would update the following file:
bin\setenv.bat

whereas for JIRA on Tomcat in Linux/Unix, you would update this file:
bin/setenv.sh

See Increasing JIRA Memory for further details.

JIRA Home Directory
The ‘JIRA Home Directory’ contains key data that help define how JIRA works. This document outlines the purpose of the various files and subdirectories within the JIRA Home Directory.

If JIRA was installed using the automated Windows or Linux installers, the default location of the JIRA Home Directory is:

- C:\Program Files\Atlassian\Application Data\JIRA (on Windows) or
- /var/atlassian/application-data/jira (on Linux)

If you install JIRA from an archive file, the JIRA Home Directory can be any suitable location that is accessible by your JIRA installation. Typical example locations might be:

- C:\jira\home (on Windows) or
- /var/jira-home (on Linux or Solaris)

However, avoid locating the JIRA Home Directory inside the JIRA Installation Directory.

For information on specifying the location of the JIRA Home Directory, please see Setting your JIRA Home Directory.

Important Files

dbconfig.xml

This file (located at the root of your JIRA Home Directory) defines all details for JIRA's database connection. This file is typically created by running the JIRA Setup Wizard on new installations of JIRA or by configuring a database connection using the JIRA Configuration Tool.

You can also create your own dbconfig.xml file. This is useful if you need to specify additional parameters for your specific database configuration, which are not generated by the Setup Wizard or JIRA Configuration Tool. For more information, refer to the 'manual' connection instructions of the appropriate database configuration guide in the Connecting JIRA to a Database section.

jira-config.properties

This file (also located at the root of your JIRA Home Directory) stores custom values for most of JIRA's advanced configuration settings. Properties defined in this file override the default values defined in the jpm.xml file (located in your JIRA Installation Directory). See Advanced JIRA Configuration for more information.

In new JIRA installations, this file may not initially exist and if so, will need to be created manually. See Making changes to the jira-config.properties file for more information. This file is typically present in JIRA installations upgraded from version 4.3 or earlier, whose advanced configuration options had been customized (from their default values).

Important Subdirectories

data

This directory contains application data for your JIRA instance, including attachments (for every version of each attachment stored in JIRA).

export

JIRA will place its automated backup archives into this directory.

log

JIRA will place its logs into this directory. (Note: if the JIRA home directory is not configured, then the logs will be placed into the current working directory instead).

The logs will only start showing up once the first log message is written to them. For example, the internal access log will not be created until JIRA starts writing to it.

You can change the location of the log file using log4j.properties as described in the documentation on Logging and Profiling.
plugins

This is the directory where plugins built on Atlassian's Plugin Framework 2 (i.e. 'Plugins 2' plugins) are stored. If you are installing a new 'Plugins 2' plugin, you will need to deploy it into this directory under the installed-plugins sub-directory.

'Plugins 1' plugins should be stored in the JIRA Installation Directory. This directory is created on JIRA startup, if it does not exist already.

caches

This is where JIRA stores caches including:

- Lucene indexes - see Searching, Indexing, and Filters Troubleshooting
- OSGi framework caches

These files are vital for JIRA performance and should not be modified or removed externally while JIRA is running.

See Search Indexing for further details.

tmp

Any temporary content created for various runtime functions such as exporting, importing, file upload and indexing is stored under this directory.

You can remove files from this directory while JIRA is running, but we recommend that you shut down JIRA first before altering the contents of this directory.

JIRA Installation Directory

The 'JIRA Installation Directory' is the directory into which the JIRA application files and libraries have been extracted, either:

- by the Windows or Linux installers, or
- by extracting the contents of a JIRA installation archive or WAR distribution archive file (i.e. a .tar.gz or .zip file).

JIRA does not modify or store any data in this directory.

Important Files and Directories

The directories/files described below are found under different sub-directories of the 'JIRA Installation Directory', depending on whether you have installed a 'recommended' or WAR distribution of JIRA. Please substitute the following directories for the <jira-application-dir> placeholder (used throughout the rest of this section), as follows:

- 'Recommended' distributions — the atlassian-jira subdirectory of the 'JIRA Installation Directory' installed using the 'Windows Installer', 'Linux Installer' or from an 'Archive File'.
- The default installation directory on Linux is:

  /opt/atlassian/jira/

- WAR distribution — the webapp subdirectory of the 'JIRA Installation Directory'.

  Please Note: To edit files in this webapp directory, first copy them to the edit-webapp subdirectory (if they are not already present in edit-webapp) and edit the copies in edit-webapp. Refer to the 'Webapp Layout' section of the JIRA WAR Configuration Overview for details. Copies of the jira-application.properties and entityengine.xml file are already available in the edit-webapp sub-directory.

<jira-application-dir>/atlassian-jira/WEB-INF/classes/jira-application.properties

This file tells JIRA where to find the JIRA Home Directory.
Be aware that your JIRA Home Directory defined in this file can be overridden. See Setting your JIRA Home Directory for more information.

```
<jira-application-dir>/atlassian-jira/WEB-INF/classes/jpm.xml
```

This file stores the default values for JIRA's advanced configuration settings and should not be modified. The default values of properties in this file are customized (i.e. overridden) by redefining them in either the jira-config.properties file (in your JIRA Home Directory) or the JIRA database (via the JIRA administration area). See Advanced JIRA Configuration for more information.

```
<jira-application-dir>/atlassian-jira/WEB-INF/lib/
```

This is the directory where plugins built on Atlassian's Plugin Framework 1 (i.e. 'Plugins 1' plugins) are stored. If you are installing a new 'Plugins 1' plugin, you will need to deploy it into this directory. 'Plugins 2' plugins should be stored in the JIRA Home Directory.

```
<jira-application-dir>/atlassian-jira/WEB-INF/classes/log4j.properties
```

JIRA's logging configuration file. See Logging and Profiling.

The actual log files generated by JIRA can be found in the following locations:

- **JIRA application log** — bin/atlassian-jira.log
- **Application server log** — generally the application server log file can be found under the logs directory. However, this can vary depending on the application server you are running. Please see Where are the application server logs? for further details.

```
<jira-application-dir>/atlassian-jira/WEB-INF/classes/entityengine.xml
```

This file configures the OFBiz Entity Engine which JIRA uses to store persist data in a datasource. See Configuring the Entity Engine for JIRA.

The sub-directories/files described below are found under the root of the JIRA Installation directory.

```
conf/server.xml
```

This file is used for JIRA SSL configuration. See Running JIRA over SSL or HTTPS.

**Memory Settings**

The file used to edit JAVA_OPTS memory settings will depend on the method used to install JIRA, as well as the operating system used for your installation.

For example, if you are running JIRA on Tomcat in Windows (manual startup), you would update the following file:

```
bin\setenv.bat
```

whereas for JIRA on Tomcat in Linux/Unix, you would update this file:

```
bin/setenv.sh
```

See Increasing JIRA Memory for further details.

**JIRA Home Directory**

The 'JIRA Home Directory' contains key data that help define how JIRA works. This document outlines the purpose of the various files and subdirectories within the JIRA Home Directory.

If JIRA was installed using the automated Windows or Linux installers, the default location of the JIRA Home Directory is:

- **C:\Program Files\Atlassian\Application Data\JIRA** (on Windows) or
- **/var/atlassian/application-data/jira** (on Linux)

If you install JIRA from an archive file, the JIRA Home Directory can be any suitable location that is accessible by your JIRA installation. Typical example locations might be:
C:\jira\home (on Windows) or
/var/jira-home (on Linux or Solaris)

However, avoid locating the JIRA Home Directory inside the JIRA Installation Directory.

For information on specifying the location of the JIRA Home Directory, please see Setting your JIRA Home Directory.

Important Files

dbconfig.xml
This file (located at the root of your JIRA Home Directory) defines all details for JIRA’s database connection. This file is typically created by running the JIRA Setup Wizard on new installations of JIRA or by configuring a database connection using the JIRA Configuration Tool.

You can also create your own dbconfig.xml file. This is useful if you need to specify additional parameters for your specific database configuration, which are not generated by the Setup Wizard or JIRA Configuration Tool. For more information, refer to the ‘manual’ connection instructions of the appropriate database configuration guide in the Connecting JIRA to a Database section.

jira-config.properties
This file (also located at the root of your JIRA Home Directory) stores custom values for most of JIRA’s advanced configuration settings. Properties defined in this file override the default values defined in the jpm.xml file (located in your JIRA Installation Directory). See Advanced JIRA Configuration for more information.

In new JIRA installations, this file may not initially exist and if so, will need to be created manually. See Making changes to the jira-config.properties file for more information. This file is typically present in JIRA installations upgraded from version 4.3 or earlier, whose advanced configuration options had been customized (from their default values).

Important Subdirectories

data
This directory contains application data for your JIRA instance, including attachments (for every version of each attachment stored in JIRA).

export
JIRA will place its automated backup archives into this directory.

log
JIRA will place its logs into this directory. (Note: if the JIRA home directory is not configured, then the logs will be placed into the current working directory instead).

The logs will only start showing up once the first log message is written to them. For example, the internal access log will not be created until JIRA starts writing to it.

You can change the location of the log file using log4j.properties as described in the documentation on Logging and Profiling.

plugins
This is the directory where plugins built on Atlassian’s Plugin Framework 2 (i.e. ’Plugins 2’ plugins) are stored. If you are installing a new ’Plugins 2’ plugin, you will need to deploy it into this directory under the installed-plugins sub-directory.

’Plugins 1’ plugins should be stored in the JIRA Installation Directory.

This directory is created on JIRA startup, if it does not exist already.

Caches
This is where JIRA stores caches including:

- Lucene indexes - see Searching, Indexing, and Filters Troubleshooting
- OSGi framework caches

These files are vital for JIRA performance and should not be modified or removed externally while JIRA is running.

See Search Indexing for further details.

tmp

Any temporary content created for various runtime functions such as exporting, importing, file upload and indexing is stored under this directory.

You can remove files from this directory while JIRA is running, but we recommend that you shut down JIRA first before altering the contents of this directory.

Setting your JIRA Home Directory

The JIRA Home Directory contains key data that help define how JIRA works. You must have a JIRA home directory specified for your JIRA instance before you can start it. This document describes how to specify the location of the JIRA home directory for your JIRA instance.

One JIRA home per JIRA instance

You can only have one JIRA Home Directory per JIRA installation. If you have multiple JIRA installations, you will need to set up a JIRA Home Directory for each installation. A lock is placed at the root level of a JIRA Home Directory when it is created to ensure that it can only used by one JIRA installation.

You only need to specify the location of the root directory for your JIRA home. The sub-directories will be created automatically when JIRA is started or when you use a function in JIRA that requires a particular sub-directory.

On this page:

- How do I set my JIRA home?
- What location should I specify for my JIRA home?
- How do I change my JIRA home?
- What is stored in the JIRA Home Directory?
- Notes

How do I set my JIRA home?

There are a few methods available for specifying the location of your JIRA Home Directory in JIRA. However, please be aware of the notes below before your specify this location.

Recommended Methods

The recommended methods for specifying the location of your JIRA Home Directory in JIRA are to:

- Use the JIRA Configuration Tool to change the location of your JIRA Home Directory. The JIRA Configuration Tool is not available in JIRA WAR distributions.
- Edit the jira-application.properties file and set the value of the 'jira.home' property to the desired location for your JIRA Home Directory (this location should be something different than the application directory, or you may run into problems later). If you are specifying this location's path on Windows, use double backslashes ("\") between subdirectories. For example, X:\\path\\to\\JIRA\\Home.
- If you define an UNC path in Microsoft Windows, be sure to double escape the leading backslash: \\
\machinename\\path\\to\\JIRA\\home
- See the JIRA Installation Directory page to find where this file is located.
- Set an environment variable named JIRA_HOME in your operating system whose value is the location of your JIRA Home Directory. To do this:
  - On Windows, do one of the following:
• Configure this environment variable through the Windows user interface (typically through 'My Computer' or 'Computer')
• At the command prompt, enter the following command (with your own JIRA Home path) before running JIRA from the command prompt:
  ```
  set JIRA_HOME=X:\path\to\JIRA\Home
  ```
  Please set your JIRA_HOME environment variable using this format, where:
  • X is the drive letter where your JIRA Home Directory is located and no spacing has been added around the equal sign ('=')
• Specify the command above in a batch file used to start JIRA.
• On Linux/Solaris, do one of the following:
  • Enter the following command at a shell/console prompt (with your own JIRA Home path) before running JIRA:
    ```
    export JIRA_HOME=/path/to/jira/home
    ```
  • Specify the command above in a script used to start JIRA.

⚠️ Please Note: If you have specified different values for a 'jira.home' property in the jira-application.properties file and a JIRA_HOME environment variable, the value of the JIRA_HOME environment variable takes precedence.

Alternative Method

Alternatively, you can specify the location of your JIRA Home Directory as property within your application server:

• Configure a new web context property called 'jira.home' for your application server. To do this, you need to define this web context property inside a `<parameter/>` element (as a child of the `<context/>` element) in your server.xml file (or jira.xml file for JIRA WAR).
  The server.xml file is located within the conf subdirectory of your JIRA Installation Directory and for JIRA WAR, the jira.xml file is typically located within the conf/Catalina/localhost subdirectory of the Apache Tomcat installation running JIRA:

  ```xml
  <Context ...>
    ...
    <Parameter name="jira.home" value="c:/jira/home"/>
    ...
  </Context>
  ```

⚠️ Please Note: A 'jira.home' web context property defined in your application server overrides the value of the 'jira.home' property defined in your jira-application.properties file. However, a JIRA_HOME environment variable defining your JIRA Home Directory will override either of these 'jira.home' values.

What location should I specify for my JIRA home?

You can specify any location on a disk for your JIRA home directory. Please be sure to specify an absolute path.

Please note that you cannot use the same JIRA home directory for multiple instances of JIRA. We recommend locating your JIRA Home Directory completely independently of the JIRA Installation Directory (i.e. not nesting one within the other) as this will minimize information being lost during major operations (e.g. backing up and restoring instances).

How do I change my JIRA home?

To change the location of your JIRA home directory,

1. Set your JIRA home to the new location, using your preferred method as described in "How do I set my JIRA home?" (above).
2. Restart JIRA.

What is stored in the JIRA Home Directory?
The following page describes the data stored in the JIRA Home Directory: JIRA Home Directory.

Notes

- If you are using the Windows installer, you do not need to configure the JIRA Home Directory separately as you will be prompted to specify this location during the installation process.
- If you installed a 'Recommended' distribution of JIRA, you do not need to do this — please see the JIRA Configuration Tool instead.
- If you are using JIRA WAR, you need to set your JIRA home before you build JIRA.
- The JIRA installer may not be able to create the home due to permission problems, if this is the case please see JIRA is Unable to Start due to Could not create necessary subdirectory.
- If you are using a custom path for your indexes and attachments (upgraded JIRA with an XML backup from a JIRA version prior to 4.2) you will have to manually configure these paths to use the default path based on the JIRA Home Directory. Otherwise, your indexes and attachments will continue to use the custom path defined previously. Configure these in their respective pages (Configuring File Attachments and Search Indexing page)
- If configuring the JIRA Home Directory in jira-application.properties doesn't work, refer to Changing JIRA Home Directory in jira-application.properties doesn't work and make sure all other configurations which takes precedence are not configured

Tomcat security best practices

The following outlines some basic techniques to secure an Apache Tomcat instance. This is a basic must-do list and should not be considered comprehensive. For more advanced security topics see the “Further Information” section below.

- User Permissions
  - Unix/Linux cheat-sheet
  - Windows cheat-sheet
- Tomcat Installation Permissions
  - Unix/Linux cheat-sheet
  - Windows cheat-sheet
- Web-Application Installation Permissions
  - Unix/Linux cheat-sheet
  - Windows cheat-sheet
- Further Information

User Permissions

Tomcat should never be run as a privileged user (root on UNIX or Administrator or Local System on Windows).

Tomcat should be run as a low-privilege user. Ideally it should be run as a user created only for the purpose of running one application.

In practice this means you can't run it on port 80. If you need to run Tomcat on port 80, you should put it behind a webserver such as Apache; see Integrating JIRA with Apache for an example configuration.

Unix/Linux cheat-sheet

- Create a JIRA user:
  sudo adduser jira-tomcat
- Run Tomcat as a specific user:
  sudo -u jira-tomcat $(CATALINA_HOME)/bin/catalina.sh run

Windows cheat-sheet

- Create an unprivileged account (if your host is part of an Active Directory there may be already a template for service users). The user should have "Log on as a service" rights assigned to it.
- Make sure the Apache Tomcat service is set to run as that user. If Tomcat was installed using the JIRA Windows Installer, the system tray utility lets you set this via Configuration -> Log On:
Tomcat Installation Permissions

The Tomcat installation directory (sometimes referred to as CATALINA_HOME) should be installed as a user that is different to the one it will be run as. Under Linux, unpacking the Tomcat distribution as root is the simplest method of doing this.

Unfortunately, Tomcat does require write access to some directories in the distribution directory, but they should be enabled only as needed.

Tomcat ships with some default admin applications in its webapps directory. Unless you need these they should be disabled.

**Unix/Linux cheat-sheet**

- Unpack Tomcat as root:
  ```bash
  sudo tar xzvf apache-tomcat-6.0.20.tar.gz
  ```
- Remove the default webapps:
  ```bash
  sudo rm -rf apache-tomcat-6.0.20/webapps/*
  ```
- Remove write permissions:
  ```bash
  sudo chmod -R go-w apache-tomcat-6.0.20
  ```
- Allow write on needed directories only:
  ```bash
  cd apache-tomcat-6.0.20/; sudo chown -R jira-tomcat work/ temp/ logs/
  ```

**Windows cheat-sheet**

Note: If your host is part of a Domain/Active Directory, consult your Windows system administrator sysadmins to get the right permissions.

- Unpack and install Tomcat, and update the permissions on CATALINA_HOME to be writeable by Administrators and System only. The Tomcat service user should have read, execute and directory traverse privileges
• Under CATALINA_HOME, the work, temp and logs directories need write and delete access for the
Tomcat user. Make sure it does not have permissions to change permission or take ownership.

Web-Application Installation Permissions

The directory you unpack the application WAR into should not be writable by the Tomcat user (i.e. `jira-tomcat` in the examples above). Again, the simplest method to do this is to unpack the WAR as root.

Unix/Linux cheat-sheet

- Unpack the war as root:
  ```
  sudo unzip confluence-webapp-3.2.war
  ```

Windows cheat-sheet

- Unpack the war as your user and confirm that the Tomcat user does not have write access to the webapp.

Further Information

- Securing Tomcat at OWASP.
- Critical Steps to Secure Tomcat on Windows NT/2K/XP
- Tomcat Security FAQ

Customizing Your JIRA Installation

- Changing JIRA's TCP Ports
- Running JIRA over SSL or HTTPS
- Installing Confluence and JIRA Together
- Integrating JIRA with a Web Server
- Securing JIRA with Apache HTTP Server
- How To Disable SSLv3 to Mitigate Against POODLE Exploit for JIRA
Changing JIRA's TCP Ports

Why Change JIRA's TCP Ports?

By default, JIRA uses TCP listening port 8080 (including default Apache Tomcat installations running JIRA WAR) and hence, JIRA is typically available at http://<yourserver>:8080.

If, however, an existing service running on your machine is claiming port 8080, there will be a conflict and JIRA will fail to start. You may see errors like this:

```
LifecycleException: Protocol handler initialization failed:
java.net.BindException: Address already in use:8080
```

This can be fixed by changing JIRA to use another TCP listening port (eg. 8100) and shutdown port (eg. 8015).

Changing JIRA’s TCP Ports

Before you change JIRA’s TCP ports, read the following:

- **Which port number should I choose?** If you are not sure which port number to choose, use a tool such as `netstat` to determine which port numbers are free to use by JIRA. The highest port number that can be used is 65535 because it is the highest number which can be represented by an unsigned 16 bit binary number. The Internet Assigned Numbers Authority (IANA) lists the registration of commonly used port numbers for well-known Internet services, it’s advisable to avoid any of those ports.

- **A note about firewalls:** When you choose a port number for JIRA, bear in mind that your firewall may prevent people from connecting to JIRA based on the port number. Organisations with a local network protected by a firewall typically need to consider modifying their firewall configuration whenever they install a web-based application (such as JIRA) that is running on a new port or host. Even personal laptop and desktop machines often come with firewall software installed that necessitates the same sort of change as described above. If JIRA does not need to be accessed from outside the firewall, then no firewall configuration changes will be necessary.

- **If you are using JIRA WAR**, please be aware that changing JIRA’s TCP ports of the Tomcat installation running JIRA will affect any other web applications deployed to the same Tomcat installation.

You can change JIRA’s TCP ports by using the JIRA configuration tool or by manually editing the `server.xml` file. If you installed JIRA using the ‘Windows Installer’, ‘Linux Installer’ or from an ‘Archive File’, you can use the JIRA configuration tool. The JIRA WAR distribution does not include this tool.

Changing JIRA’s TCP Ports using the JIRA Configuration tool

1. Start the JIRA configuration tool, see Using the JIRA Configuration Tool for instructions on where to find the tool.
2. Click the Web Server tab.
3. In the HTTP Port field, enter the new TCP listening port number.
4. In the Control Port field, enter the new TCP shutdown port number.
5. Click the Save button. Your changes are saved to the `server.xml` file located in the `conf` subdirectory of your JIRA Installation Directory.

Changing JIRA’s TCP Ports by editing the `server.xml` file

Edit the `server.xml` file in the `conf` subdirectory of the JIRA Installation Directory (or of the Apache Tomcat installation that runs your JIRA WAR installation). The start of the file looks like:
For example, change the shutdown port from "8005" to "8015" and the listening port (i.e. in the `<connector/>` element) from "8080" to "8100". (See below to decide which TCP port numbers should be used for JIRA.)

Then, restart JIRA and point a browser to http://<yourserver>:8100

If you are running on a Unix server and bind the ports below 1024 (such as port 80 for example), you will need to start JIRA as root in order to successfully bind to the port.

**RELATED TOPICS**

Changing Confluence's listening ports

Running JIRA over SSL or HTTPS

Atlassian applications allow the use of SSL within our products, however Atlassian Support does not provide assistance for configuring it. Consequently, Atlassian cannot guarantee providing any support for it.

- If assistance with conversions of certificates is required, please consult with the vendor who provided the certificate.
- If assistance with configuration is required, please raise a question on Atlassian Answers.

The instructions on this page describe how to configure JIRA to enable access via HTTPS (HTTP over SSL) by configuring Apache Tomcat with HTTPS. This procedure only covers the common installation types of JIRA. It is by no means a definitive or comprehensive guide to configuring HTTPS and may not be applicable to your specific setup.

**Why should you enable HTTPS access to JIRA?**

HTTPS is a good way to safeguard your JIRA data and user logins from being intercepted and read by outsiders.

Before you begin

Please note the following before you begin:

- Atlassian Support will refer SSL support to the Certificate Authority (CA) that issues the Certificate. The SSL-related instructions on this page are provided as a reference only.
- For JIRA installations installed using Windows Installer:
  - The 'Windows Installer' installs its own Java Runtime Environment (JRE) Java platform, which is used to run Tomcat. When updating SSL certificates, please do so in this JRE installation.
  - In this document, the term `<jira-install-dir>` refers to the JIRA Installation Directory itself.
Generate the Java KeyStore

In this section, you will create a Java Key Store (JKS) which will hold your SSL certificates. The SSL certificates are required in order for SSL to work in JIRA. In the SSL world, certificates fall into two major categories:

<table>
<thead>
<tr>
<th>Certificate</th>
<th>Description</th>
<th>When to Use</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self-signed</td>
<td>These are certificates that have not been digitally signed by a CA, which is a method of confirming the identity of the certificate that is being served by the web server. They are signed by themselves, hence the name self-signed.</td>
<td>Test, dev or internal servers only.</td>
<td>1 - 13</td>
</tr>
<tr>
<td>CA-signed</td>
<td>A certificate that has had its identity digitally signed by a Certificate Authority (CA). This will allow browsers and clients to trust the certificate.</td>
<td>Production servers.</td>
<td>1 - 21</td>
</tr>
</tbody>
</table>

Digital Certificate that are issued by trusted 3rd party CAs (Certification Authority) provide verification that your website does indeed represent your company, thereby verifying your company's identity. Many CAs simply verify the domain name and issue the certificate, whereas other such as VeriSign verifies the existence of your business, the ownership of your domain name, and your authority to apply for the certificate, providing a higher standard of authentication.

Some of the most well known CAs are:
- Verisign
- DigiCert
- Thawte

We recommend using a CA-signed certificate.

If you're unable to install Portecle on the server or prefer the command line please see our Command Line Installation section below.

1. Download and install the Portecle app onto the server that runs JIRA.
   ! This is a third-party application and is not supported by Atlassian.
2. Run the App as an Administrator, so it will have the appropriate permissions. Also, ensure the `<JAVA_HOME>` variable is pointing to the same version of Java that JIRA uses. See our Setting JAVA_HOME docs for further information on this.
If running on a Linux/UNIX server, X11 will need to be forwarded when connecting to the server (so you can use the GUI), as below:

```bash
ssh -X user@server
```

3. Select the **Create a new Keystore** option:
4. Select the type **JKS** and OK:
5. Select the **Generate Key Pair** button:
6. Select the RSA algorithm and your preferred Key Size - the standard is currently 2048:
7. Make sure the **Signature Algorithm** is "SHA256withRSA" and then edit the certificate details, as per the below example and select OK:

**The Common Name MUST match the server’s URL, otherwise errors will be displayed in the browser.**

If you would like to use SHA256withRSA, please use the appropriate Signature Algorithm, and refer to: Security tools report the default SSL Ciphers are too weak

8. Choose an alias for the certificate - for example jira.
9. Enter a password for the KeyStore (the default password used is typically changeit).
10. The Key Pair Generation will report as successful, as per the below example:
11. Save the KeyStore in `<JIRA_HOME>/jira.jks`, ensuring the use the same password in step 11. This can be done by File > Save Keystore.

If using a self-signed certificate certificate, proceed to Configuring your web server using the JIRA configuration tool, otherwise continue on.

12. We need to generate a Certificate Signing Request for the CA to sign and confirm the identity of the certificate. To do so, right click on the certificate and choose **Generate CSR**. Save it in `<JIRA_HOME>/jira.csr`.
13. Submit the Certification Request (CSR) to a Certificate Authority for signing. They will provide a signed certificate (CA reply) and a set of root/intermediate CA certificates.
14. Import the root and/or intermediate CA certificates with **Import Trusted Certificate**, repeating this step for each certificate.
15. Import the signed certificate by right clicking on the jira certificate and selecting **Import CA Reply**.
16. Select the certificate provided by the CA, which should be jira.crt. This will respond with CA Reply Import successful.
17. Verify this by checking **Tools > Keystore Report**. It should display the certificate as a child of the root certificates.
18. Save the KeyStore and proceed to the next section.

Configuring your web server using the JIRA configuration tool

In this section, you will finish setting up SSL encryption for JIRA, by configuring your web server using the JIRA configuration tool. For more information on the JIRA configuration tool, see Using the JIRA Configuration Tool.

To configure your web server using the JIRA configuration tool:

1. Run the JIRA configuration tool, as follows:
   - **Windows**: Open a command prompt and run `config.bat` in the `bin` sub-directory of the JIRA Installation Directory.
   - **Linux/Unix**: Open a console and execute `config.sh` in the `bin` sub-directory of the JIRA Installation Directory.
   - This may fail with the error as described in our Unable to Start JIRA Config Tool due to No X11 DISPLAY variable was set error KB article. Please refer to it for the workaround.
2. Click the **Web Server** tab.
   - *Screenshot: JIRA configuration tool — ‘Web Server’ tab*
3. Fill out the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Control Port
Leave as default. You can change the port number if you wish. See [Changing JIRA's TCP Ports](#).

### Profile
A profile is a preset web server configuration. You can pick from the four following values:
- Disabled
- HTTP only
- HTTP & HTTPS (redirect HTTP to HTTPS)
- HTTPS only

To run JIRA over HTTPS, you must pick either 'HTTP & HTTPS' or 'HTTPS'. Pick 'HTTP & HTTPS' if you want to run JIRA over HTTPS but you have users that access JIRA via HTTP. If you pick 'HTTP & HTTPS', users who try to access JIRA via HTTP will be redirected to the HTTPS address.

### HTTP port
Leave as default (8080). You can change the port number if you wish. See [Changing JIRA's TCP Ports](#). This will be disabled if you set the **Profile** to 'HTTPS only'.

### HTTPS port
Leave as default (8443). You can change the port number if you wish. See [Changing JIRA's TCP Ports](#).

### Keystore path
Specify the location of the keystore of your certificate. This will have been chosen when the keystore was saved in step 13 and should be `<JIRA_HOME>/jira.jks`.

### Keystore password
Specify the password for your keystore. If you generated a self-signed certificate, this is the password you specified for the key and keystore when generating the certificate in step 13.

### Keystore alias
Each entry in the keystore is identified by an alias. We recommend using `jira` for this certificate as in step 10.

4. Click the **Check Certificate in Key Store** button to validate the following:
   - Test whether the certificate can be found in the key store.
   - Test whether keystore password works.
   - Test whether key can be found using key alias.

5. Click the **Save** button to save your changes.

---

**Advanced configuration**

### Running more than one instance on the same host
When running more than one instance on the same host, it is important to specify the `address` attribute in the `<JIRA_INSTALLATION>/conf/server.xml` file because by default the connector will listen on all available network interfaces, so specifying the address will prevent conflicts with connectors running on the same default port. See the Tomcat Connector documentation for more about setting the address attribute in [The HTTP Connector](http://tomcat.apache.org/tomcat-7.0-doc/connector.html) Apache Tomcat 7 docs.

---

**Command Line Installation**

Create the Keystore
1. Generate the Java KeyStore (JKS):

   ```bash
   <JAVA_HOME>/keytool -genkeypair -alias jira -keyalg RSA -sigalg SHA256withRSA -keystore <JIRA_HOME>/jira.jks
   ```

   Instead of first and last name, enter the server URL, excluding "https://" (e.g.: jira.atlassian.com).

2. Enter an appropriate password (e.g.: changeit).

3. Create the CSR for signing, using the password from step 2:

   ```bash
   <JAVA_HOME>/keytool -certreq -keyalg RSA -alias jira -keystore <JIRA_HOME>/jira.jks -file jira.csr
   ```

4. Submit the CSR to the CA for signing. They will provide a signed certificate and a root and/or intermediate CA.

   ⚠️ If the certificate will not be signed, skip to step 7.

5. Import the root and/or intermediate CA:

   ```bash
   <JAVA_HOME>/keytool -import -alias rootCA -keystore <JIRA_HOME>/jira.jks -trustcacerts -file root.crt
   ```

6. Import the signed certificate (this is provided by the CA):

   ```bash
   <JAVA_HOME>/keytool -import -alias jira -keystore <JIRA_HOME>/jira.jks -file jira.crt
   ```

7. Verify the certificate exists within the keystore.

   ```bash
   <JAVA_HOME>/keytool -list -alias jira -keystore <JIRA_HOME>/jira.jks
   ```

   This must be a `PrivateKeyEntry`, if it is not the certificate setup has not successfully completed. For example:

   ```
   jira, Jan 1, 1970, PrivateKeyEntry,
   Certificate fingerprint (MD5):
   ```

Update Tomcat with the Keystore
1. Create a backup of `<JIRA_INSTALL>/conf/server.xml` before editing it.
2. Edit the HTTPS connector so that it has the parameters that point to the key store:

```xml
<Connector port="8443"
    maxHttpHeaderSize="8192" SSLEnabled="true"
    maxThreads="150" minSpareThreads="25"
    enableLookups="false" disableUploadTimeout="true"
    acceptCount="100" scheme="https" secure="true"
    clientAuth="false" sslProtocol="TLS"
    useBodyEncodingForURI="true"
    keyAlias="jira" keystoreFile="<JIRA_HOME>/jira.jks"
    keystorePass="changeit" keystoreType="JKS"/>
```

Ensure to put the appropriate path in place of `<JIRA_HOME>` and change the port as needed.

3. Edit the HTTP connector so that it redirects to the HTTPS connector:

```xml
<Connector acceptCount="100" connectionTimeout="20000"
    disableUploadTimeout="true" enableLookups="false"
    maxHttpHeaderSize="8192" maxThreads="150" minSpareThreads="25"
    port="8080" protocol="HTTP/1.1" redirectPort="<PORT_FROM_STEP_1>"
    useBodyEncodingForURI="true"/>
```

Ensure the `<PORT_FROM_STEP_1>` is change to the appropriate value. In this example it would be 8443.

4. Save the changes to `server.xml`.
5. If redirection to HTTPS will be used (this is recommended), edit the `<JIRA_INSTALL>/atlassian-jira/WEB-INF/web.xml` file and add the following section at the end of the file, before the closing `</web-app>`. In this example, all URLs except attachments are redirected from HTTP to HTTPS.

```xml
<security-constraint>
    <web-resource-collection>
        <web-resource-name>all-except-attachments</web-resource-name>
        <url-pattern>*.jsp</url-pattern>
        <url-pattern>*.jspx</url-pattern>
        <url-pattern>/browse/*</url-pattern>
    </web-resource-collection>
    <user-data-constraint>
        <transport-guarantee>CONFIDENTIAL</transport-guarantee>
    </user-data-constraint>
</security-constraint>
```

6. Restart JIRA after you have saved your changes.

You can also redirect users from HTTP URLs to HTTPS URLs by choosing the 'HTTP & HTTPS' profile in the JIRA configuration tool. However, if you want to only redirect certain pages to HTTPS, you can do this manually. To do this, select the 'HTTPS only' profile in the JIRA configuration tool and save the configuration.

**Troubleshooting**

Here are some troubleshooting tips if you are using a self-signed key created by Portecle, as described above. When you enter "https://localhost:<port number>" in your browser, if you get a message such as "Cannot establish a connection to the server at localhost:8443", look for error messages in your `logs/catalina.out`
og file. Here are some possible errors with explanations.

- **SSL + Apache + IE problems**: Some people have reported errors when uploading attachments over SSL using IE. This is due to an IE bug, and can be fixed in Apache by setting:

```
BrowserMatch ".*MSIE.*"
nokeepalive ssl-unclean-shutdown
downgrade-1.0 force-response-1.0
```

Google has plenty more on this.

- **Can’t find the keystore**:

```
java.io.FileNotFoundException: /home/user/.keystore (No such file or directory)
```

This indicates that Tomcat cannot find the keystore. The keytool utility creates the keystore as a file called `.keystore` in the current user’s home directory. For Unix/Linux the home directory is likely to be `/home/<username>`. For Windows it is likely to be `C:\Documents And Settings\<UserName>`.

Make sure you are running JIRA as the same user who created the keystore. If this is not the case, or if you are running JIRA on Windows as a service, you will need to specify where the keystore file is in `conf/server.xml`. Add the following attribute to the connector tag you uncommented:

```
keystoreFile="<location of keystore file>"
```

This can also happen ("Cannot find /root/.keystore") if you add a `keystoreFile` attribute to the `http` connector in `server.xml` instead of the `https` connector.

- **Certificate reply and certificate in keystore are identical**:

```
keytool error: java.lang.Exception: Certificate reply and certificate in keystore are identical
```

This error will happen if you have identical names or fingerprints, which is the result of attempting to recreate the cert in your existing keystore. If you need to recreate or update the Cert, you may remove the existing keystore and creating a fresh, new keystore. In this case, creating a new keystore and adding the related certs will fix the issue. The default path for it in this documentation is `$JAVA_HOME/jre/lib/security/cacerts`

- **Incorrect password**:

```
java.io.IOException: Keystore was tampered with, or password was incorrect
```

You used a different password than "changeit". You must either use "changeit" for both the keystore password and for the key password for Tomcat, or if you want to use a different password, you must specify it using the `keystorePass` attribute of the Connector tag, as described above.

- **Passwords don’t match**:
You specified a different value for the keystore password and the key password for Tomcat. Both passwords must be the same.

- **Wrong certificate:**

```java
javax.net.ssl.SSLException: No available certificate corresponds to the SSL cipher suites which are enabled.
```

If the Keystore has more than one certificate, Tomcat will use the first returned unless otherwise specified in the SSL Connector in `conf/server.xml`.

Add the `keyAlias` attribute to the Connector tag you uncommented, with the relevant alias, for example:

```xml
<Connector port="8443" maxHttpHeaderSize="8192"
  maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
  enableLookups="false" disableUploadTimeout="true"
  useBodyEncodingForURI="true"
  acceptCount="100" scheme="https" secure="true"
  clientAuth="false" sslProtocol="TLS"
  keystoreFile="/opt/local/.keystore"
  keystorePass="removed"
  keyAlias="tomcat"/>
```

- **Using Apache Portable Runtime:**

APR uses a different SSL engine, and you will see an exception like this in your logs

```plaintext
SEVERE: Failed to initialize connector
[Connector[HTTP/1.1-8443]]
LifecycleException: Protocol handler initialization failed:
java.lang.Exception: No Certificate file specified or invalid file format
```

The reason for this is that the APR Connector uses OpenSSL and cannot use the keystore in the same way. You can rectify this in one of two ways:

- Use the Http11Protocol to handle SSL connections — Edit the server.xml so that the SSL Connector tag you just uncommented specifies the Http11Protocol instead of the APR protocol

```xml
  maxHttpHeaderSize="8192" SSLEnabled="true"
  keystoreFile="${user.home}/.keystore"
  maxThreads="150" enableLookups="false"
  disableUploadTimeout="true"
  acceptCount="100" scheme="https" secure="true"
  clientAuth="false" sslProtocol="TLS"
  useBodyEncodingForURI="true"/>
```

- Configure the Connector to use the APR protocol — This is only possible if you have PEM
encoded certificates and private keys. If you have used OpenSSL to generate your key, then you will have these PEM encoded files - in all other cases contact your certificate provider for assistance.

```xml
<Connector
    port="8443" maxThreads="200"
    scheme="https" secure="true" SSLEnabled="true"
    SSLCertificateFile="${user.home}/certificate.pem"
    SSLCertificateKeyFile="${user.home}/key.pem"
    clientAuth="optional" SSLProtocol="TLSv1"/>
```

- **Enabling Client Authentication**: To enable client authentication in Tomcat, ensure that the value of the `clientAuth` attribute in your `Connector` element of your Tomcat's `server.xml` file is `true`.

```xml
<Connector
    ...
    clientAuth="true"
    ...
/>
```

For more information about `Connector` element parameters, please refer to the SSL Configuration HOW-TO Tomcat 7 documentation.

- **Using StartCom Certificate**: Unable to get Application Link to work properly with certain features such as Gadgets and Macros not working over SSL. There is a known bug in JIRA-33643 with a workaround to manually import root certificates to Java certificates store.

### Installing Confluence and JIRA Together

For information on Atlassian's recommendation on JIRA and Confluence installation, see Installing Confluence and JIRA Together.

You may also wish to read Integrating JIRA and Confluence for helpful information on integrating JIRA and Confluence.

⚠️ **Do not deploy multiple Atlassian applications in a single Tomcat container** — Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).

There are also a number of practical reasons why we do not support deploying multiple Atlassian applications in a single Tomcat container. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

Finally, we recommend not deploying any other applications in the same Tomcat container that runs JIRA, especially if these other applications have large memory requirements or require additional libraries in Tomcat's `lib` subdirectory.

### Integrating JIRA with a Web Server

The following pages contain information on integrating JIRA with a web server.

- Integrating JIRA with IIS
- Integrating JIRA with Apache

**Integrating JIRA with IIS**

The content on this page relates to platforms which are not supported by JIRA. Consequently, Atlassian cannot guarantee providing any support for it. Please be aware that this material is provided for your information only and using it is done so at your own risk.

This page describes how to configure Microsoft's IIS web server and JIRA such that IIS forwards requests on to JIRA, and responses back to the user. This is useful if you already have IIS running serving web pages (e.g. http
://mycompany.com), and wish to integrate JIRA as just another URL (e.g. http://mycompany.com/jira).

JIRA is written in Java, and needs a Java Application Server (servlet container) to run. As IIS does not provide services of a Java Application Server, it is not possible to deploy JIRA directly into IIS. It is possible, however, to configure IIS to proxy requests for JIRA to an application server where JIRA is deployed. Therefore, if your main website is running in IIS, it is possible to integrate JIRA into this website.

If you need to integrate JIRA with IIS, JIRA needs to be deployed into a Java application server (such as Apache Tomcat), which provides IIS integration capability.

If you are running JIRA against an application server other than Apache Tomcat, please consult that application server's documentation to determine whether it is possible (and how) to integrate the application server with IIS.

To integrate JIRA with IIS you will need to:

1. Configure JIRA and test that it works on its own
2. Configure Tomcat to accept proxied requests from IIS
3. Configure IIS to forward JIRA requests to Tomcat
4. (Optional) Configure IIS to forward Confluence requests to Tomcat (if you are using both Confluence and JIRA).

1. **Configure JIRA**

   1. Follow the JIRA installation guide to install and configure JIRA; or deploy the WAR distribution into Apache Tomcat. Note that JIRA can be installed on the same machine as IIS, but this is not necessary.
   2. Change the context path of the JIRA web application:
      To allow IIS to proxy requests to JIRA, JIRA web application must be deployed with a context path (e.g. the /jira in http://localhost:8080/jira (http://localhost:8080*/jira*)) in Tomcat. The context path must be set to the path in the URL that IIS will use to proxy requests. For example, if your website is running with address www.example.com in IIS, and you would like to make JIRA available under www.example.com/jira, you will need to set JIRA's context path to "/jira" in Tomcat.
      To do this, edit the conf/server.xml file (or the jira.xml file if you are using the WAR distribution of JIRA). Change the path attribute of the Context element to "/jira".
   3. Restart JIRA after changing the context path.
   4. Set the 'Base URL' to include the context path (see Configuring JIRA Options).
   5. Turn JIRA's GZip compression OFF (since there will be no benefit from GZip compression once proxying is implemented).
   6. Test that JIRA works correctly by pointing your web browser directly at Tomcat (e.g. http://localhost:8080/jira) and going through JIRA's Setup Wizard. If you have completed the Setup Wizard previously, try creating an issue or editing one. Please ensure that no errors occur.

2. **Configure Tomcat to accept proxied requests**

   **HTTP/1.1 Connector**
   If you are using the HTTP/1.1 Connector, you will need to add the following attributes to the Connector port in Tomcat's server.xml:

   ```xml
   proxyName="mycompany.com" proxyPort="80"
   ```

   Please refer to the Integrating JIRA with Apache for reference.

   1. **Enable AJP/1.3 Connector** in Tomcat: To allow Tomcat to accept requests for JIRA from IIS, edit the conf/server.xml file and ensure that the AJP/1.3 Connector is enabled (i.e. not commented out). To enable the AJP/1.3 Connector in a JIRA remove the comment symbols around the following section in the conf/server.xml file:

   ```xml
   <Connector port="8009" enableLookups="false" redirectPort="8443"
   protocol="AJP/1.3" />
   ```

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
The above example configures Tomcat to listen for proxied IIS requests on port 8009. If this port is already in use on the machine where JIRA is running, please change to another port.

2. Restart Tomcat and ensure that no errors regarding used ports appear in the logs or in the Tomcat Console.

3. Ensure that the AJP Connector is listening on the specified port (8009 by default). One way to do this is to use the "netstat -na" command in the command window and see if port 8009 is listed in the output:

![Command Prompt]

```
C:\dev\jira\atlassian-jira-enterprise-3.3-standalone\bin>netstat -na
TCP 0.0.0.0:8009 0.0.0.0:0 LISTENING
```

3. **Configure IIS to forward requests to JIRA**

On the machine where IIS is deployed:

1. Download the ISAPI Redirect DLL from the [Apache site](http://example.com). When downloading, choose the version of Windows that IIS is running on (either win32 or win64), and then choose the latest available jk version.

   The file to download is named `isapi_redirect_X.X.X.dll`, where 'X.X.X' is the version number. You will need to remove the version number from the DLL file (i.e. it needs to be named `isapi_redirect.dll`).

2. Place the DLL and the associated properties files in an installation directory. For the purpose of this document, we will assume the directory is `C:\tomcat_iis_connector`. Place the `isapi_redirect.dll` in this directory. Then download the `isapi_redirect.properties` file and place this in the same directory as the `isapi_redirect.dll` file.

3. Create a directory called 'conf' in your installation directory (`C:\tomcat_iis_connector\conf`). Download the files `uriworkermap.properties` and `workers.properties.minimal` and place them in the `C:\tomcat_iis_connector\conf` directory.

4. Create a directory called 'logs' (`C:\tomcat_iis_connector\logs`). This is where the logs associated with the `isapi_redirect.dll` execution will be placed.

5. In the "C:\tomcat_iis_connector" directory you may need to modify the `isapi_redirect.properties` file. The `isapi_redirect.properties` file tells the connector where to find its configuration files and where the DLL can be found in relation to the IIS server. There are 5 properties in this file:
   a. `extension_uri` — the path to the virtual directory that contains the `isapi_redirect.dll`
   b. `log_file` — the path to write the log file to
   c. `log_level` — the level at which the logs should be generated
   d. `worker_file` — the path to your `workers.properties.minimal` file in your installation
   e. `worker_mount_file` — the path to your `uriworkermap.properties` file in your installation.

   If you are installing the connector in `C:\tomcat_iis_connector` and you follow the instructions below about setting up the virtual directory for the `isapi_redirect.dll`, then you should not have to...
change any properties in the provided file.

6. In the "c:\tomcat_iis_connector\conf" directory you may need to modify the uriworkermap.properties and the workers.properties.minimal files.

The provided files contain the changes mentioned here and should work if you completely follow this document. **If you have deviated from this document, then you will need to modify these files as described below.**

The workers.properties.minimal file tells IIS where (IP address and port) Tomcat is running. The uriworkermap.properties tells IIS what requests to proxy to Tomcat.

To edit these files:

a. Edit the uriworkermap.properties and ensure that it contains the following mapping for JIRA.
   
   ```
   /jira/*=worker1
   ```

   The mapping (e.g. `/jira/`) *must be the same as the context path that JIRA has been deployed with in Tomcat as described in the Configure JIRA section of this document.

b. Edit the workers.properties.minimal file and modify the worker.ajp13w.host property if necessary. This property should be set to the host name or the IP address of the machine where Tomcat (with JIRA) is running. If Tomcat is running on the same machine as IIS then you can leave the property set to localhost. If you have specified a host name as the value of this property, please ensure that the IIS machine can correctly resolve it to the appropriate IP address.

c. If you have modified the port for the AJP Connector you will need to modify the worker.ajp13w.port property. Here is an example of the file with Tomcat running on the same machine as IIS and using the default port (8009) for AJP:

   ```
   worker.list=worker1
   
   # Defining a worker named worker1 and of type ajp13.
   # Note that the name and the type do not have to match.
   #
   worker.worker1.type=ajp13
   worker.worker1.host=localhost
   worker.worker1.port=8009
   ```

7. Open Control Panel, then Administrative Tools and open Internet Information Services.

8. **IIS 7.0 only:** If you are using IIS 7.0,you will need to install two required service roles, ISAPI Extensions and ISAPI Filters:
   
a. Navigate to Start Menu > All Programs > Administration Tools > Service Manager.
   
b. Select 'Web Server (IIS)' in Server Manager > Roles.
   
c. Click 'Add Role Services' and follow the Wizard.

9. Add an ISAPI Filter to IIS, as described below:
   
   **IIS 6.0 or earlier:**
   
a. Right-click on Default Web Site (or the Web Site that should be responsible for proxying requests to JIRA), and click on Properties.
   
b. Click the ISAPI Filters tab.
   
c. Check if there is a Filter that points to the isapi_redirect.dll file and that it is in the right location. If not, click Add and create one. Enter tomcat as the Filter Name and enter the location of the isapi_redirect.dll file for the executable.
   
d. Click Apply and then OK.

   **IIS 7.0:**
   
a. Click the Default Web Site (or the Web Site that should be responsible for proxying requests to JIRA), and click on ISAPI Filters.
b. Click the ISAPI Filters icon.
c. Check if there is a Filter that points to the isapi_redirect.dll file and that it is in the right location. If not, click Add and create one. Enter tomcat as the Filter Name and enter the location of the isapi_redirect.dll file.
d. Click OK.

10. Create a virtual directory for JIRA in IIS.
   a. Right-click on Default Web Site (or the Web Site that should be responsible for proxying requests to JIRA), choose New and then Virtual Directory.
   b. Go through the creation wizard. Set the alias as the value of the Context Path (without slashes) that was set in the Configure JIRA section of this document (see above). In our example this is jira.
   c. This can point to any directory.
   d. Complete the wizard.

The reason for creating a virtual directory is so that requests without the trailing slash still work. For example, if you are deploying JIRA under http://www.example.com/jira/ without the virtual directory, then requests to http://www.example.com/jira will fail.

11. Create a virtual directory for access to the isapi_redirect.dll in IIS, as described below:
   - IIS 6.0 or earlier:
     a. Right-click on Default Web Site (or the Web Site that should be responsible for proxying requests to JIRA), choose New and then Virtual Directory.
     b. Go through the creation wizard. Set the alias to be jakarta.
     c. This must point to the directory in which the isapi_redirect.dll is installed. In our example this is C:\tomcat_iis_connector.
     d. Complete the wizard, making sure that you grant the ‘Execute’ permission for the Virtual Directory by checking the ‘Execute’ checkbox.
   - IIS 7.0:
     a. Right-click on Default Web Site (or the Web Site that should be responsible for proxying requests to JIRA), and choose Add Virtual Directory.
     b. Set the alias to be jakarta.
     c. Physical Path must point to the directory in which the isapi_redirect.dll is installed. In our example this is C:\tomcat_iis_connector.
     d. Click the ‘jakarta’ Virtual Directory and double-click ‘Handler Mappings’.
     e. Click ‘Edit Feature Permissions’ in the Action panel on the right-hand side.
     f. Check the ‘Execute’ permission checkbox.

This Virtual Directory is needed for the connector to work. The alias that you give the directory needs to be the same as the path set in the isapi_redirect.properties file, extension_uri property. In our example this value is: /jakarta/isapi_redirect.dll.

12. If using IIS 6.0 or 7.0, you will need to add the dll as a Web Service Extension, as described below.
   - IIS 6.0:
     a. Right-click on Web Service Extensions and choose Add a new Web Service Extension...
     b. Enter tomcat for the Extension Name and then add the isapi_redirect.dll file to the required files.
     c. Select the Set extension status to Allowed check-box, then click OK.
   - IIS 7.0:
     a. Navigate to the servers and highlight your server.
     b. Navigate to ‘ISAPI and CGI Restrictions’.
     c. Add and allow the isapi_redirect.dll extension.

13. You will need to restart the IIS Service. To do this, browse to Control Panel, click Administrative Tools, click on Services, find the IIS Admin Service and click restart.

14. You are done! To test the configuration, point your web browser at IIS and append JIRA's context path to the URL. For example, if your website is running under the address of http://www.example.com and you have deployed JIRA with the context path of jira, point your browser at http://www.example.com/jira.
4. Configure IIS to forward requests to Confluence as well as JIRA

You can configure IIS so that it forwards requests to both JIRA and Confluence.

The following instructions describe how to forward from IIS to separate instances of JIRA and Confluence, running in separate Tomcat servers. The instructions assume that you have already set up IIS to forward to JIRA as described in section 3 above. The instructions also assume that you have already installed Confluence as per the Confluence Installation Guide.

The instructions describe how to make JIRA available under www.example.com/jira as described above, and Confluence available under www.example.com/confluence.

1. If JIRA and Confluence are running on the same machine, ensure that Confluence is listening on a different port to JIRA:
   a. Edit the conf/server.xml file (or the jira.xml file if you are using the WAR/EAR distribution of Confluence).
   b. At the top of the file, change the port attribute of the Server element to a different port to the value for JIRA. For example, change it from 8005 to 8006.
   c. Still in the Server element, Change the port attribute of the Connector sub-element to a different port to the value for JIRA. For example, change it from 8080 to 8090.
2. Change the Confluence context path:
   a. Edit the conf/server.xml file (or the jira.xml file if you are using the WAR/EAR distribution of Confluence).
   b. Change the path attribute of the Context element to "/confluence".
3. Restart Confluence after changing the ports and the context path, and test that Confluence works correctly by pointing your web browser at http://localhost:8090/confluence.
4. Configure Confluence to accept proxied requests: Remove the comments around the AJP/1.3 Connector section in the Confluence conf/server.xml or jira.xml file and change the port attribute to a value different to the value for JIRA. For example, change it from 8009 to 8010.
5. Restart Confluence and ensure that no errors regarding used ports appear in the logs or in the Tomcat console.
6. Edit the uriworkermap.properties file and add the following mapping:

   /confluence/**=worker2

   The file should now contain the following mappings:

   /jira/**=worker1
   /confluence/**=worker2

7. Edit the workers.properties.minimal file:
   Change the line starting with worker.list to the following:

   worker.list=worker1,worker2

   Add the following lines to the end of the file (assuming the host is on the same machine as IIS and you changed the AJP/1.3 Connector port for Confluence to 8010):

   worker.worker2.type=ajp13
   worker.worker2.host=localhost
   worker.worker2.port=8010

   The workers.properties.minimal file should now look like the following:
worker.list=worker1,worker2

# Defining a worker named worker1 and of type ajp13.
# Note that the name and the type do not have to match.
# worker.worker1.type=ajp13
worker.worker1.host=localhost
worker.worker1.port=8009

worker.worker2.type=ajp13
worker.worker2.host=localhost
worker.worker2.port=8010

8. Create a virtual directory for Confluence in IIS. Set the alias to confluence. It can point to any directory.
9. Restart the IIS Service.
10. You are done! Confluence should now be available under www.example.com/confluence, and JIRA should still be available under www.example.com/jira.

Troubleshooting

- Whenever I go to JIRA in my browser, a login panel pops up. I enter a valid username and password for JIRA, but the panel pops up again. Make sure that you have Anonymous Access set on the jira virtual directory in IIS. It will be set to that if you have followed the above instructions. To check this:
  1. In 'Internet Information Services', right click the jira virtual directory and choose 'Properties'.
  2. Click the 'Directory Security' tab.
  3. Click the 'Edit...' button in the 'Anonymous access and authentication control' section.
  4. Make sure that the 'Anonymous access' tick box is selected, and make sure that nothing is selected in the 'Authenticated access' section. Do not select 'Basic authentication'. Do not select 'Integrated Windows authentication'.

- Whenever I go to JIRA in Internet Explorer, a login panel pops up. I enter a valid username and password for JIRA, but the panel pops up again. This doesn't happen, however, in another browser such as Firefox or Safari. I can successfully log in to JIRA in those browsers. Make sure that you have Internet Explorer's User Authentication set to Anonymous login. To check this:
  1. In Internet Explorer, click the 'Tools' menu and select 'Internet Options'.
  2. Click the 'Security' tab.
  3. Select the security zone that the JIRA server is in.
  4. Click the 'Custom level...' button.
  5. Scroll right down to the bottom to the 'User Authentication' section.
  6. Select 'Anonymous logon' (if it is not already selected).
  7. Click the 'OK' button on this screen, and again on the next screen.
  8. Restart Internet Explorer.

- When I try to navigate to my JIRA instance at http://localhost/jira in my browser, it prompts me to download a file with nonsensical information, rather than showing me my JIRA instance. Make sure that you have granted the 'Execute' permission to your Virtual Directory for JIRA in IIS. See step 11 of the '3. Configure IIS to forward requests to JIRA' section in this document for detailed instructions.

Known Issues

- 64 bit IIS: If you are running a 64 bit OS, please use a 64 bit version of the Tomcat IIS connector.
- Customer submitted solution: If you must use a 32 bit IIS connector, you can do so by clicking Application Pools > Advanced Settings > Allow 32bit applications.
- Customer submitted solution: You need to set the ISAPI extension on the website.

Integrating JIRA with Apache
This page describes how to integrate Apache HTTP Server (also referred to as \texttt{httpd}) with JIRA, utilising \texttt{mod_proxy} so that Apache operates as a reverse-proxy over HTTP. If HTTPS configuration is required, please see our integrating JIRA with Apache using SSL documentation. Configuring Apache allows for running JIRA on non-standard HTTP port (such as 8080) and users will be able to access JIRA over standard HTTP as their traffic will be routed through the proxy.

Apache can be configured to allow access to JIRA in any of the following methods:

- Directly on its own domain: \texttt{http://jira.com}
- As a subdomain of another domain: \texttt{http://jira.atlassian.com}
- It can also be accessed on a context path on either a domain or subdomain: \texttt{http://atlassian.com/jira}

This documentation will cover a straightforward implementation of \texttt{mod_proxy} using the above three configurations. If a more complication solution is required, refer to the Apache HTTP Server Version Documentation, consult with the Apache SME within your organisation and if need be raise a question on Atlassian Answers or look at getting in touch with one of our Atlassian Experts.

Expand for an example of a common Apache configuration

1. JIRA is running on port 8080 on a server within the LAN that cannot be accessed externally (the router/firewall is not forwarding port 8080 to it).
2. Apache is set up on another server (or the same server as JIRA) that can be accessed externally on HTTP (80).
3. Apache is then accessed over HTTP on the appropriate URL (\texttt{VirtualHost}), routing the traffic to and from the JIRA server.

### On this page:

- **Step 1: Configure Tomcat**
- **Step 2: Configure Apache HTTP Server**
  - 2.1 Enable the Proxy Modules
  - 2.2. Configure Apache to use those Modules
- **Step 3: Configure JIRA**
- **Troubleshooting**
  - Hijacked Sessions
  - Permission Denied Errors enabling mod_proxy (and mod_jk) on Linux distros that use SELinux
  - Running Mac OS X
  - Too many redirects
  - General Problems
  - 403 Forbidden error
- **See Also**

### Step 1: Configure Tomcat

1. Stop JIRA.
2. Edit Tomcat's \texttt{server.xml} to include the required JIRA context path. The below example uses \texttt{path="/jira"} - this means JIRA is accessible on \texttt{http://jiraserver:8080/jira} given the default JIRA port is used.

This step is only required if JIRA will be accessed on a context path, for example \texttt{http://atlassian.com/jira}. If this is not required, this step can be skipped.
<Engine defaultHost="localhost" name="Catalina">
  <Host appBase="webapps" autoDeploy="true" name="localhost"
   unpackWARs="true">
    <Context docBase="${catalina.home}/atlassian-jira
    path="/jira" reloadable="false" useHttpOnly="true">
      <!--
      Note, you no longer configure your database driver or
      connection parameters here.
      These are configured through the UI during application
      setup.
      -->
      <!--->
    <Resource auth="Container"
     factory="org.objectweb.jotm.UserTransactionFactory" jotm.timeout="60"
     name="UserTransaction" type="javax.transaction.UserTransaction"/>
    <Manager pathname=""/>
   </Context>
  </Host>
</Engine>

Ensure the path value is set with a prepending forward slash (/). For example, path="/jira" rather than path="jira".

3. Edit Tomcat’s server.xml to include a separate connector to proxy the requests. This requires the proxyName & proxyPort attributes. Replace them with the appropriate domain and port of the proxy, as in the below example:

   <Service name="Catalina">
     <!-- Apache Proxy Connector -->
     <Connector acceptCount="100" connectionTimeout="20000"
      disableUploadTimeout="true" enableLookups="false" maxHttpHeaderSize="8192"
      maxThreads="150" minSpareThreads="25" port="8080" protocol="HTTP/1.1"
      redirectPort="8443" useBodyEncodingForURI="true"
      proxyName="jira.atlassian.com" proxyPort="80"/>
     <!-- Standard HTTP Connector -->
     <Connector acceptCount="100" connectionTimeout="20000"
      disableUploadTimeout="true" enableLookups="false" maxHttpHeaderSize="8192"
      maxThreads="150" minSpareThreads="25" port="8081" protocol="HTTP/1.1"
      redirectPort="8443" useBodyEncodingForURI="true"/>
   </Service>

   The proxyName parameter should be set to the FQDN that the JIRA server will be accessed on - for example jira.example.com if accessing it on http://jira.example.com or example.com if accessing it on http://www.example.com/jira. It should not include the context path.

4. Start JIRA.
5. Test that JIRA is accessible on the normal connector, using a context path if applicable - for example http://jiraserver:8081/jira.
6. Test that the new connector is working by accessing JIRA on the appropriate proxy connector, for example http://jiraserver:8080/. This should redirect to the proxy FQDN (in this example, http://jira.atlassian.com), which will fail as the proxy is not yet configured. The test is to ensure Tomcat is set up to correctly redirect to the proxy.

Step 2: Configure Apache HTTP Server

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
The installation of Apache and configuration of a DNS is not covered in this documentation. Additionally, it is assumed that Apache 2.2 has been installed and DNS entries have been configured for the JIRA domain. As Apache’s configuration is specific to the operation system that is used, only some distributions and their configurations are currently documented.

2.1 Enable the Proxy Modules

Debian/Ubuntu

Expand to see Debian/Ubuntu instructions

1. Enable the module with the following:

```
$ sudo a2enmod proxy_http
Considering dependency proxy for proxy_http:
Enabling module proxy.
Enabling module proxy_http.
To activate the new configuration, you need to run:
    service apache2 restart
```

2. Restart Apache.

Windows/Other OS

Expand to see Windows/Other OS instructions

1. Locate and edit the `httpd.conf` file, adding the below lines:

```
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_connect_module modules/mod_proxy_connect.so
LoadModule proxy_http_module modules/mod_proxy_http.so
```

2. Restart Apache.

2.2 Configure Apache to use those Modules

Debian/Ubuntu

Expand to see Debian/Ubuntu instructions

1. Switch into user root.
2. Backup the existing site or create a new one. Creating a new site is not covered within this documentation (copying the default should be sufficient).
3. Modify the existing site within `APACHE_INSTALL/sites-available`, for example default.
4. Add the following inside the `VirtualHost`, replacing `jiraserver` with the hostname of the JIRA server and also modifying the port if required.

```
# JIRA Proxy Configuration:
<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

ProxyRequests        Off
ProxyPreserveHost    On
ProxyPass            / http://jiraserver:8080/
ProxyPassReverse     / http://jiraserver:8080/
```

Missing a forward slash at the end of the URL will cause proxy errors - ensure this is in place!

The configuration above is for Apache 2.2. In Apache 2.4 you should replace `Order deny, allow` to `Require all granted`
Using a context path:

```xml
# JIRA Proxy Configuration:
<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

ProxyRequests Off
ProxyPreserveHost On
ProxyPass /jira http://jiraserver:8080/jira
ProxyPassReverse /jira http://jiraserver:8080/jira
```

- The path used must be identical to the Tomcat context path. For example, forwarding `/jira` to `/jira520` cannot be done without considerable rewrite rules that are not always reliable.

5. *(Optional):* Enable the site with the following:

```bash
# a2ensite jira
Enabling site jira.
To activate the new configuration, you need to run:
    service apache2 reload
```

- This is only required if a new site has been created in favour of using the default.

6. Reload the Apache configuration.

7. Test by accessing JIRA through Apache, for example `http://jira.com` or `http://atlassian.com/jira`.

**Windows/Other OS**

- Expand to see Windows/Other OS instructions

1. Locate and edit the `httpd.conf` file.
2. Add the following inside the `VirtualHost`, replacing `jiraserver` with the hostname of the JIRA server and also modifying the port if required.

**On its own domain or subdomain:**

```xml
# JIRA Proxy Configuration:
<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

ProxyRequests Off
ProxyPreserveHost On
ProxyPass / http://jiraserver:8080/
ProxyPassReverse / http://jiraserver:8080/
```

- Missing a forward slash at the end of the URL will cause proxy errors - ensure this is in place!

The configuration above is for Apache 2.2. In Apache 2.4 you should replace `Order deny, allow` with `Require all granted`.

---

*Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Using a context path:

```xml
# JIRA Proxy Configuration:
<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

ProxyRequests          Off
ProxyPreserveHost       On
ProxyPass               /jira       http://jiraserver:8080/jira
ProxyPassReverse       /jira       http://jiraserver:8080/jira
```

The path used must be identical to the Tomcat context path. For example, forwarding `/jira` to `/jira520` cannot be done without considerable rewrite rules that are not always reliable.

The configuration above is for Apache 2.2. In Apache 2.4 you should replace Order deny, allow from all to Require all granted

3. Restart Apache.
4. Test by accessing JIRA through Apache, for example `http://jira.com` or `http://atlassian.com/jira`.

**Step 3: Configure JIRA**

1. Set **gzip compression** to OFF as in Configuring JIRA Options. GZIP compression is known to cause performance issues using a reverse-proxy, especially if the proxy is also compressing the traffic.
2. Set the **Base URL** to be the FQDN that JIRA will be accessed on, for example `http://jira.atlassian.com`. This is also located in Configuring JIRA Options.
   - **JIRA** can only be configured to respond to a single URL and the Base URL (as in Configuring JIRA Options) must match the URL end-users are accessing. Misconfiguration of this may cause significant problems within JIRA such as the Activity Stream and Dashboard Gadgets failing to function correctly.
3. Test by accessing JIRA on the FQDN (e.g.: `http://jira.atlassian.com`), ensuring that JIRA is accessible and all dashboard gadgets correctly display.

**Troubleshooting**

**Hijacked Sessions**

Some users have reported problems with user sessions being hijacked when the mod_cache module is enabled. If these problems are encountered, try disabling the mod_cache module.

This module is enabled by default in some Apache HTTP Server version 2 distributions.

**Permission Denied Errors enabling mod_proxy (and mod_jk) on Linux distros that use SELinux**

Users have reported 'permission denied' errors when trying to get mod_proxy (and mod_jk) working. Disabling SELinux (`/etc/selinux/config`) apparently fixes this.

**Running Mac OS X**

Disable `webperfcache`, which proxies port 80 by default. A user reported this as the likely cause of JIRA session problems, in the form of users' identities becoming mixed up, as below.

Additionally we do not recommend using Max OS X as it is not supported, as in our Supported Platforms.

The OSX Servers enable webperfcache by default for Virtual Hosts, which for static content would be great, but for dynamic sites (which ALL of ours are) it is Evil and causes many issues.
Of note recently was the jira session issue. Also see:–
Unfortunately even if you disable webperfcache for a site, if there is a single site enabled then all sites will still proxy through webperfcache with resulting session problems.

Too many redirects

Both Tomcat & Apache are redirecting, when only one should be. Disable redirection in Tomcat (revert any changes as in Running JIRA over SSL or HTTPS) and check that there is only one redirection in Apache.

General Problems

1. Clear the browser cache and try again.
2. Ensure that JIRA works as expected when running directly from Tomcat and bypassing Apache. For example, accessing http://jiraserver:8080 instead of http://jira.atlassian.com.
3. Increase the LogLevel for Apache to debug and restart it.
4. Attempt to access JIRA and check the Apache Log Files for any errors.
5. Raise a question on Atlassian Answers for assistance.

403 Forbidden error

Add the RequestHeader unset Authorization line to the apache configuration page to disable authorization headers.

```
<Location /jira>
    RequestHeader unset Authorization
    ProxyPreserveHost On
    ProxyPass http://jiraserver/jira
    ProxyPassReverse http://jiraserver/jira
</Location>
```

See Also

- Integrating JIRA with Apache using SSL
- Configuring Apache Reverse Proxy Using the AJP Protocol
- For more advanced mod_webapp configurations (eg. SSL), see this mod_proxy guide.
- Apache Virtual Host documentation

Configuring Apache Reverse Proxy Using the AJP Protocol

Atlassian applications allow the use of reverse-proxies within our products, however Atlassian Support does not provide assistance for configuring them. Consequently, Atlassian can not guarantee providing any support for them.

If assistance with configuration is required, please raise a question on Atlassian Answers.

This page describes how to integrate Apache HTTP Server (also referred to as httpd) with JIRA, utilising mod_proxy_ajp so that Apache operates as a reverse-proxy. AJP is a wire protocol and is an optimized version of the HTTP protocol to allow a standalone web server such as Apache to talk to Tomcat.

This protocol can be used in favour of HTTP/1.1 as in either of the following Apache configurations:

- Integrating JIRA with Apache
- Integrating JIRA with Apache using SSL
Step 1: Configure Tomcat

1. Stop JIRA.
2. Enable the AJP Connector on the Tomcat container hosting JIRA by uncommenting the following element in $JIRA_INSTALL/conf/server.xml:

   ```xml
   <Connector port="8009" URIEncoding="UTF-8" enableLookups="false" protocol="AJP/1.3" />
   ```

3. Start JIRA.
4. Test that JIRA is accessible on the standard HTTP connector, for example http://jiraserver:8080. This is to ensure that Tomcat has successfully restarted.

Step 2: Configure Apache HTTP Server

The installation of Apache and configuration of a DNS is not covered in this documentation. Additionally, it is assumed that Apache 2.2 has been installed and DNS entries have been configured for the JIRA domain. As Apache's configuration is specific to the operation system that is used, only some distributions and their configurations are currently documented.

2.1 Enable the Proxy Modules

**Debian/Ubuntu**

Expand to see Debian/Ubuntu instructions

1. Enable the module with the following:

   ```bash
   $ sudo a2enmod proxy_ajp
   Considering dependency proxy for proxy_ajp:
   Module proxy already enabled
   Enabling module proxy_ajp.
   To activate the new configuration, you need to run:
   service apache2 restart
   ```

2. Restart Apache.

**Windows/Other OS**

Expand to see Windows/Other OS instructions

1. Locate and edit the httpd.conf file, adding the below lines:
2. Restart Apache.

2.2. Configure Apache to use those Modules

1. Switch into user root.
2. Backup the existing site or create a new one. Creating a new site is not covered within this documentation (copying the default should be sufficient).
3. Modify the existing site within $APACHE_INSTALL/sites-available, for example default (HTTP) or default-ssl (HTTPS).
4. Add the following inside the VirtualHost, replacing jiraserver with the hostname of the JIRA server and also modifying the port if required.

```
# JIRA AJP Proxy Configuration:
<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

ProxyRequests           Off
ProxyPass               /       ajp://jiraserver:8009/
ProxyPassReverse        /       ajp://jiraserver:8009/
```

i Missing a forward slash at the end of the URL will cause proxy errors - ensure this is in place!

5. (Optional): Enable the site with the following:

```
# a2ensite jira
Enabling site jira.
To activate the new configuration, you need to run:
    service apache2 reload
```

i This is only required if a new site has been created in favour of using the default.

6. If using HTTP, skip to step 8. For HTTPS, the certificates need to be installed by copying the certificate and private key to the appropriate directories and the following will also need to be added to the site:

```
SSLProxyEngine          On
```

7. Include them in the Apache configuration, within the VirtualHost as below:

```
SSLCertificateFile    /etc/ssl/certs/jira.crt
SSLCertificateKeyFile /etc/ssl/private/jira.key
```

8. Reload the Apache configuration.
9. Test by accessing JIRA through Apache, for example http://jira.com or http://atlassian.com/jira.

Windows/Other OS

Expand to see Windows/Other OS instructions

1. Locate and edit the httpd.conf file.
2. Add the following inside the VirtualHost, replacing jiraserver with the hostname of the JIRA
server and also modifying the port if required.

```
# JIRA AJP Proxy Configuration:
<Proxy *>  
  Order deny,allow 
  Allow from all 
</Proxy>  
ProxyRequests Off 
ProxyPass / ajp://jiraserver:8009/ 
ProxyPassReverse / ajp://jiraserver:8009/
```

ℹ️ Missing a forward slash at the end of the URL will cause proxy errors - ensure this is in place!

3. **If using HTTP, skip to step 5.** For HTTPS, the certificates need to be installed by copying the certificate and private key to the appropriate directories and the following will also need to be added to the site:

```
SSLProxyEngine On
```

4. Include them in the Apache configuration, within the `VirtualHost` as below:

```
SSLCertificateFile /etc/ssl/certs/jira.crt 
SSLCertificateKeyFile /etc/ssl/private/jira.key
```

5. Restart Apache.

### 2.3 Redirect HTTP to HTTPS

This is an optional step and is only required if using HTTPS. It can be done by using `mod_rewrite` (this module may require enabling), add the following to the HTTP `VirtualHost`:

```
RewriteEngine On  
RewriteCond %{HTTPS} off 
RewriteRule (.*) https://%{HTTP_HOST}%{REQUEST_URI}
```

#### Step 3: Configure JIRA

1. Set **Use gzip compression** to **OFF** as in Configuring JIRA Options. GZIP compression is known to cause performance issues using a reverse-proxy, especially if the proxy is also compressing the traffic.
2. Set the **Base URL** to be the FQDN that JIRA will be accessed on, for example [http://jira.atlassian.com](http://jira.atlassian.com). This is also located in Configuring JIRA Options.  
   ⚠️ JIRA can only be configured to respond to a single URL and the Base URL (as in Configuring JIRA Options) must match the URL end-users are accessing. Misconfiguration of this may cause significant problems within JIRA such as the Activity Stream and Dashboard Gadgets failing to function correctly.
3. Test by accessing JIRA on the FQDN (e.g.: [http://jira.atlassian.com](http://jira.atlassian.com)), ensuring that JIRA is accessible and all dashboard gadgets correctly display.

#### Troubleshooting

#### Hijacked Sessions

Some users have reported problems with user sessions being hijacked when the `mod_cache` module is enabled. If these problems are encountered, try disabling the `mod_cache` module.

ℹ️ This module is enabled by default in some Apache HTTP Server version 2 distributions.

### Permission Denied Errors enabling `mod_proxy` (and `mod_jk`) on Linux distros that use SELinux
Users have reported ‘permission denied’ errors when trying to get mod_proxy (and mod_jk) working. Disabling SELinux (/etc/selinux/config) apparently fixes this.

Running Mac OS X

Disable webperfcache, which proxies port 80 by default. A user reported this as the likely cause of JIRA session problems, in the form of users’ identities becoming mixed up, as below. Additionally we do not recommend using Max OS X as it is not supported, as in our Supported Platforms.

The OSX Servers enable webperfcache by default for Virtual Hosts, which for static content would be great, but for dynamic sites (which ALL of ours are) it is Evil and causes many issues. Of note recently was the jira session issue. Also see :-
Unfortunately even if you disable webperfcache for a site, if there is a single site enabled then all sites will still proxy through webperfcache with resulting session problems.

Too many redirects

Both Tomcat & Apache are redirecting, when only one should be. Disable redirection in Tomcat (revert any changes as in Running JIRA over SSL or HTTPS) and check that there is only one redirection in Apache.

General Problems

1. Clear the browser cache and try again.
2. Ensure that JIRA works as expected when running directly from Tomcat and bypassing Apache. For example, accessing http://jiraserver:8080 instead of http://jira.atlassian.com.
3. Increase the LogLevel for Apache to debug and restart it.
4. Attempt to access JIRA and check the Apache Log Files for any errors.
5. Raise a question on Atlassian Answers for assistance.

403 Forbidden error

Add the RequestHeader unset Authorization line to the apache configuration page to disable authorization headers.

```xml
<Location /jira>
   RequestHeader unset Authorization
   ProxyPreserveHost On
   ProxyPass http://jiraserver/jira
   ProxyPassReverse http://jiraserver/jira
</Location>
```

This page describes how to integrate Apache HTTP Server (also referred to as httpd) with JIRA, utilising mod_proxy & mod_ssl so that Apache operates as a reverse-proxy over HTTPS. If a HTTP configuration is required, please see our Integrating JIRA with Apache documentation. Configuring Apache allows for running JIRA on non-standard HTTP port (such as 8080) and users will be able to access JIRA over standard HTTPS as their traffic will be routed through the proxy and encrypted outside of the network.
Apache can be configured to allow access to JIRA in any of the following methods:

- Directly on its own domain: https://atlassian.com/
- As a subdomain of another domain: https://jira.atlassian.com
- It can also be accessed on a context path on either a domain or subdomain: https://atlassian.com/jira

This means the SSL certificate will be managed within Apache and not Tomcat, additionally the connection between Apache and Tomcat will not be encrypted. However, the connection between the browser and the outside network will be encrypted. This is suitable for configurations where the JIRA server is within the same network as the Apache server and is illustrated below:

```
Client Browser -> HTTPS -> Apache Proxy -> HTTP -> Tomcat (JIRA)
```

This is a common configuration for networks with multiple SSL certificates and/or web applications as they are all managed in one location (Apache).

If a more complicated solution is required, refer to the Apache HTTP Server Version Documentation, consult with the Apache SME within your organisation and if need be raise a question on Atlassian Answers or look at getting in touch with one of our Atlassian Experts.

Expand for an example of a common Apache configuration

1. JIRA is running on port 8080 on a server within the LAN that cannot be accessed externally (the router/firewall is not forwarding port 8080 to it).
2. Apache is set up on another server (or the same server as JIRA) that can be accessed externally on HTTPS (443).
3. Apache is then accessed over HTTPS on the appropriate URL (VirtualHost), routing the traffic to and from the JIRA server.

### On this page:
- Before you begin
- Step 1: Configure Tomcat
- Step 2: Configure Apache HTTP Server
  - 2.1 Enable the Proxy Modules
  - 2.2 Configure Apache to use those Modules
  - 2.3 Redirect HTTP to HTTPS
- Step 3: Configure JIRA
- Troubleshooting
  - Hijacked Sessions
  - Permission Denied Errors enabling mod_proxy (and mod_jk) on Linux distros that use SELinux
  - Running Mac OS X
  - Too many redirects
  - General Problems
  - 403 Forbidden error
- See Also

### Before you begin

⚠️ It is expected that the SSL certificate has been signed by a CA and is in the PEM format prior to configuring Apache. For assistance preparing and generating SSL certificates, please consult with a SSL Vendor (for example, GoDaddy, Verisign, RapidSSL).

Identifying whether to use a domain, subdomain or context path largely depends on the type of SSL certificate provided and also any business rules around website configurations. For SSL to function without error, the domain must match the Common Name (CN) of the certificate.

Expand for further information on configuring the FQDN to match the certificate’s CN

This table indicates which URLs will work with the certificate CN and also makes a recommendation on the URL to use.
### JIRA FQDN

<table>
<thead>
<tr>
<th>JIRA FQDN</th>
<th>Common Name</th>
<th>Valid</th>
<th>Recommend JIRA FQDN</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="https://jira.atlassian.com">https://jira.atlassian.com</a></td>
<td>jira.atlassian.com</td>
<td>✔</td>
<td><a href="https://jira.atlassian.com">https://jira.atlassian.com</a></td>
</tr>
<tr>
<td><a href="https://atlassian.com">https://atlassian.com</a></td>
<td>jira.atlassian.com</td>
<td>✗</td>
<td><a href="https://jira.atlassian.com">https://jira.atlassian.com</a></td>
</tr>
</tbody>
</table>

A certificate that has a CN with an asterisk (*) in it is a wildcard certificate and can support any subdomain of that domain. If you are uncertain about the URL to use, please consult with your System Administrator and the SSL vendor that provided the certificate.

---

### Step 1: Configure Tomcat

1. Stop JIRA.
2. *(Optional: If JIRA does not require a context path, skip this step.)*

Edit Tomcat's `server.xml` to include the required JIRA context path. The below example uses `path="/jira"` - this means JIRA is accessible on `http://jiraserver:8080/jira` given the default JIRA port is used.

```xml
<Engine defaultHost="localhost" name="Catalina">
    <Host appBase="webapps" autoDeploy="true" name="localhost" unpackWARs="true">
        <Context docBase="${catalina.home}/atlassian-jira" path="/jira" reloadable="false" useHttpOnly="true">
            <!--
            Note, you no longer configure your database driver or connection parameters here.
            These are configured through the UI during application setup.
            
            -->
            <Manager pathname=""/>
        </Context>
    </Host>
    <Manager name="manager"/>
</Engine>
```

ℹ️ Ensure the `path` value is set with a prepending forward slash (`/`). For example, `path="/jira"` rather than `path="/jira"`.

3. Edit Tomcat's `server.xml` to include a separate connector to proxy the requests. This requires the `scheme`, `proxyName`, `proxyPort` & `secure` attributes. Replace them with the appropriate domain and port of the proxy, as in the below example:
1. Enable the module with the following:

```
$ sudo a2enmod proxy_http ssl
```

```
Considering dependency proxy for proxy_http:
Enabling module proxy.
Enabling module proxy_http.
Enabling module ssl.
See /usr/share/doc/apache2.2-common/README.Debian.gz on how to configure SSL and create self-signed certificates.
To activate the new configuration, you need to run:
    service apache2 restart
```

2. Restart Apache.
1. Locate and edit the `httpd.conf` file, adding the below lines if they do not already exist:

```
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_connect_module modules/mod_proxy_connect.so
LoadModule proxy_http_module modules/mod_proxy_http.so
LoadModule ssl_module modules/mod_ssl.so
```

2. Restart Apache.

2.2. Configure Apache to use those Modules

Debian/Ubuntu

Expand to see Debian/Ubuntu instructions

1. Switch into user `root`.
2. Backup the existing site or create a new one. Creating a new site is not covered within this documentation (copying the default should be sufficient).
3. Modify the existing site within `/etc/Apache2/sites-available`, for example `default-ssl`.
4. Add the following inside the `VirtualHost`, replacing `jiraserver` with the hostname of the JIRA server and also modifying the port if required.

**On its own domain or subdomain:**

```
# JIRA Proxy Configuration:
<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

SSLProxyEngine On
ProxyRequests Off
ProxyPreserveHost On
ProxyPass / http://jiraserver:8080/
ProxyPassReverse / http://jiraserver:8080/
```

ℹ️ Missing a forward slash at the end of the URL will cause proxy errors - ensure this is in place!

Using a context path:

```
# JIRA Proxy Configuration:
<Proxy *>
    Order deny,allow
    Allow from all
</Proxy>

SSLProxyEngine On
ProxyRequests Off
ProxyPreserveHost On
ProxyPass /jira http://jiraserver:8080/jira
ProxyPassReverse /jira http://jiraserver:8080/jira
```

ℹ️ The path used must be identical to the Tomcat context path. For example, forwarding `/jira` to `/jira520` cannot be done without considerable rewrite rules that are not always reliable.

5. Enable the site with the following:
6. Copy the certificate and private key to the appropriate directories.
7. Include them in the Apache configuration, within the VirtualHost as below:

```
SSLCertificateFile   /etc/ssl/certs/jira.crt
SSLCertificateKeyFile /etc/ssl/private/jira.key
```

8. *(OPTIONAL)*: Configuration of SSLCertificateChainFile will contain the intermediate certificates provided by the CA vendor who signed it. Please follow consult with the CA vendor to verify if this is required.

```
SSLCertificateChainFile /etc/ssl/certs/jiraintermediate.crt
```

9. Reload the Apache configuration.
10. Test by accessing JIRA through Apache, for example http://jira.com or http://atlassian.com/jira.

**Windows/Other OS**

Expand to see Windows/Other OS instructions

1. Locate and edit the httpd.conf file.
2. Add the following inside the VirtualHost, replacing jiraserver with the hostname of the JIRA server and also modifying the port if required.

**On its own domain or subdomain:**

```
# JIRA Proxy Configuration:
<Proxy *
  Order deny,allow
  Allow from all
</Proxy>

SSLProxyEngine       On
ProxyRequests         Off
ProxyPreserveHost    On
ProxyPass            / http://jiraserver:8080/
ProxyPassReverse     / http://jiraserver:8080/
```

ℹ️ Missing a forward slash at the end of the URL will cause proxy errors - ensure this is in place!

**Using a context path:**
# JIRA Proxy Configuration:

```
<Proxy>*</Proxy>
Order deny,allow
Allow from all
</Proxy>
```

SSLProxyEngine On
ProxyRequests Off
ProxyPreserveHost On
ProxyPass /jira http://jiraserver:8080/jira
ProxyPassReverse /jira http://jiraserver:8080/jira

The path used must be identical to the Tomcat context path. For example, forwarding `/jira` to `/jira520` cannot be done without considerable rewrite rules that are not always reliable.

3. Copy the certificate and private key to the appropriate directories.
4. Include them in the Apache configuration, within the `VirtualHost` as below:

```
SSLCertificateFile /etc/ssl/certs/jira.crt
SSLCertificateKeyFile /etc/ssl/private/jira.key
```

5. *(OPTIONAL):* Configuration of `SSLCertificateChainFile` will contain the intermediate certificates provided by the CA vendor who signed it. Please follow consult with the CA vendor to verify if this is required.

```
SSLCertificateChainFile /etc/ssl/certs/jiraintermediate.crt
```

6. Restart Apache.
7. Test by accessing JIRA through Apache, for example `http://jira.com` or `http://atlassian.com/jira`.

## 2.3 Redirect HTTP to HTTPS

This can be done with either of the following:

- Set up the HTTP `VirtualHost` to forward to the same Tomcat Connector. Tomcat will redirect to HTTPS using the `scheme`, `proxyName` & `proxyPort` parameters. This can be done as in our [Integrating JIRA with Apache](https://confluence.atlassian.com/jiradoctor/integrating-jira-with-apache-319687033.html)
documentation.
- Using `mod_rewrite` (this module may require enabling), add the following to the HTTP `VirtualHost`:

```
RewriteEngine On
RewriteCond %{HTTPS} off
RewriteRule (.*) https://%{HTTP_HOST}%{REQUEST_URI}
```

**Step 3: Configure JIRA**

1. Set **GZIP compression** to **OFF** as in Configuring JIRA Options. GZIP compression is known to cause performance issues using a reverse-proxy, especially if the proxy is also compressing the traffic.
2. Set the **Base URL** to be the FQDN that JIRA will be accessed on, for example `https://jira.atlassian.com`. This is also located in Configuring JIRA Options. **Attention:** JIRA can only be configured to respond to a single URL and the Base URL (as in Configuring JIRA Options) must match the URL end-users are accessing. Misconfiguration of this may cause significant problems within JIRA such as the Activity Stream and Dashboard Gadgets failing to function correctly.
3. Test by accessing JIRA on the FQDN (e.g.: `https://jira.atlassian.com`), ensuring that JIRA is accessible and all dashboard gadgets correctly display.

---

Created in 2015 by Atlassian. Licensed under a **Creative Commons Attribution 2.5 Australia License**.
Troubleshooting

Hijacked Sessions

Some users have reported problems with user sessions being hijacked when the `mod_cache` module is enabled. If these problems are encountered, try disabling the `mod_cache` module.

This module is enabled by default in some Apache HTTP Server version 2 distributions.

Permission Denied Errors enabling `mod_proxy` (and `mod_jk`) on Linux distros that use SELinux

Users have reported `permission denied` errors when trying to get `mod_proxy` (and `mod_jk`) working. Disabling SELinux (/etc/selinux/config) apparently fixes this.

Running Mac OS X

Disable `webperfcache`, which proxies port 80 by default. A user reported this as the likely cause of JIRA session problems, in the form of users' identities becoming mixed up, as below.

Additionally we do not recommend using Max OS X as it is not supported, as in our Supported Platforms.

The OSX Servers enable `webperfcache` by default for Virtual Hosts, which for static content would be great, but for dynamic sites (which ALL of ours are) it is Evil and causes many issues.

Of note recently was the jira session issue. Also see:-


Unfortunately even if you disable `webperfcache` for a site, if there is a single site enabled then all sites will still proxy through `webperfcache` with resulting session problems.

Too many redirects

Both Tomcat & Apache are redirecting, when only one should be. Disable redirection in Tomcat (revert any changes as in Running JIRA over SSL or HTTPS) and check that there is only one redirection in Apache.

General Problems

1. Clear the browser cache and try again.
2. Ensure that JIRA works as expected when running directly from Tomcat and bypassing Apache. For example, accessing http://jiraserver:8080 instead of http://jira.atlassian.com.
3. Increase the `LogLevel` for Apache to debug and restart it.
4. Attempt to access JIRA and check the Apache Log Files for any errors.
5. Raise a question on Atlassian Answers for assistance.

403 Forbidden error

Add the `RequestHeader unset Authorization` line to the apache configuration page to disable authorization headers.

```xml
<Location /jira>
    RequestHeader unset Authorization
    ProxyPreserveHost On
    ProxyPass http://jiraserver/jira
    ProxyPassReverse http://jiraserver/jira
</Location>
```

See Also

- Integrating JIRA with Apache
- Configuring Apache Reverse Proxy Using the AJP Protocol
- For more advanced `mod_webapp` configurations (eg. SSL), see this `mod_proxy` guide.
- Apache Virtual Host documentation

Troubleshooting Apache

Hijacked Sessions

Some users have reported problems with user sessions being hijacked when the `mod_cache` module is enabled. If these problems are encountered, try disabling the `mod_cache` module.
This module is enabled by default in some Apache HTTP Server version 2 distributions.

Permission Denied Errors enabling mod_proxy (and mod_jk) on Linux distros that use SELinux

Users have reported ‘permission denied’ errors when trying to get mod_proxy (and mod_jk) working. Disabling SELinux (/etc/selinux/config) apparently fixes this.

Running Mac OS X

Disable webperfcache, which proxies port 80 by default. A user reported this as the likely cause of JIRA session problems, in the form of users’ identities becoming mixed up, as below. Additionally we do not recommend using Max OS X as it is not supported, as in our Supported Platforms.

The OSX Servers enable webperfcache by default for Virtual Hosts, which for static content would be great, but for dynamic sites (which ALL of ours are) it is Evil and causes many issues. Of note recently was the jira session issue. Also see :-


Unfortunately even if you disable webperfcache for a site, if there is a single site enabled then all sites will still proxy through webperfcache with resulting session problems.

Too many redirects

Both Tomcat & Apache are redirecting, when only one should be. Disable redirection in Tomcat (revert any changes as in Running JIRA over SSL or HTTPS) and check that there is only one redirection in Apache.

General Problems

1. Clear the browser cache and try again.
2. Ensure that JIRA works as expected when running directly from Tomcat and bypassing Apache. For example, accessing http://jiraserver:8080 instead of http://jira.atlassian.com.
3. Increase the LogLevel for Apache to debug and restart it.
4. Attempt to access JIRA and check the Apache Log Files for any errors.
5. Raise a question on Atlassian Answers for assistance.

403 Forbidden error

Add the RequestHeader unset Authorization line to the apache configuration page to disable authorization headers.

```html
<Location /jira>
  RequestHeader unset Authorization
  ProxyPreserveHost On
  ProxyPass http://jiraserver/jira
  ProxyPassReverse http://jiraserver/jira
</Location>
```

Securing JIRA with Apache HTTP Server

The following outlines some basic techniques to secure a JIRA instance using Apache HTTP Server. These instructions are basic to-do lists and should not be considered comprehensive. For more advanced security topics see the “Further Information” section below.

- Using Apache to Limit Access to the JIRA Administration Interface
- Using Fail2Ban to limit login attempts (JIRA 4.1 has login-rate limiting, but Fail2Ban can be useful for older versions and more advanced security setups.)

Further information

- Integrating JIRA with Apache

Using Apache to Limit Access to the JIRA Administration Interface

Limiting Administration to Specific IP Addresses

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
The JIRA administration interface is a critical part of the application; anyone with access to it can potentially compromise not only the JIRA instance but the entire machine. As well as limiting access to users who really need it, and using strong passwords, you should consider limiting access to it to certain machines on the network or internet. If you are using an Apache HTTP Server, this can be done with Apache's `Location` functionality as follows.

1. **Create a file that defines permission settings**

   This file can be in the Apache configuration directory or in a system-wide directory. For this example we'll call it "sysadmin_ips_only.conf". This file should contain the following:

   ```
   Order Deny,Allow
   Deny from All
   # Mark the Sysadmin's workstation
   Allow from 192.168.12.42
   ```

2. **Add the file to your Virtual Host**

   In your Apache Virtual Host, add the following lines to restrict the administration actions to the Systems Administrator:

   ```
   <LocationMatch Administrators.jspa>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch DeleteAttachment>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AcknowledgeTask>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch ActivateWorkflow>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch ActivateWorkflowStep2>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddIssueSecurity>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddIssueSecurityScheme>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddLevel>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddNotification>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddNotificationScheme>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddPermission>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddPermissionScheme>
     Include sysadmin_ips_only.conf
   </LocationMatch>
   <LocationMatch AddPopMailServer>
   ```
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddProject>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddProjectCategory>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddRepository>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddSmtpMailServer>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddUser>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowSchemeEntity>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowTransition>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowTransitionCondition>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowTransitionConditionParams>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowTransitionFunctionParams>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowTransitionPostFunction>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowTransitionValidator>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AddWorkflowTransitionValidatorParams>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AssociateFieldToScreens>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AssociateIssueTypeSchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch AssociateIssueTypeSchemesWithDefault>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch BugzillaImport>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch BulkEditUserGroups>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CloneWorkflow>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureCache>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureCsvMapping>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureCustomField>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureFieldLayout>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureFieldLayoutScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureFieldScreen>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureFieldScreenScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureFogBugzMapping>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureIssueTypeScreenScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureLogging>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ConfigureOptionSchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CopyFieldLayout>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CopyFieldLayoutScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CopyIssueSecurityScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CopyNotificationScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CopyPermissionScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CopyWorkflowScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CreateCustomField>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CreateDraftWorkflow>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CsvImporter>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch CurrentUsersList>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteCustomField>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteGroup>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteIssueSecurity>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteIssueSecurityLevel>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteIssueSecurityScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteIssueType>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteLinkType>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteMailServer>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteNotification>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteNotificationScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteOptionScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeletePermission>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeletePermissionScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeletePriority>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteProject>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteProjectCategory>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteProjectRole>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteRepository>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteResolution>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteStatus>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteSubTaskIssueType>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteTrustedApplication>
  Include sysadmin_ips_only.conf
</LocationMatch>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteUser>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteUserProperty>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteWorkflowScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteWorkflowSchemeEntity>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteWorkflowStep>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteWorkflowTransitionCondition>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteWorkflowTransitionPostFunction>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteWorkflowTransitions>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DeleteWorkflowTransitionValidator>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch DisableSubTasks>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditAnnouncementBanner>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditApplicationProperties>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditAttachmentSettings>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditBasicConfig>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditCustomField>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditCustomFieldDefaults>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditCustomFieldOptions>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditDefaultFieldLayoutItem>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldLayout>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldLayoutItem>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldLayoutItemRenderer>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldLayoutItemRendererConfirmation>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldLayoutScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldScreen>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldScreenScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditFieldScreenSchemeItem>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditIssueSecurities>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditIssueSecurityScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditIssueType>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditIssueTypeScreenScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditLinkType>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditListener>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditLookAndFeel>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditNotifications>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditNotificationScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditPermissions>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditPermissionScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditPriority>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditProjectCategory>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditProjectRole>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditResolution>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditService>
  Include sysadmin_ips_only.conf
</LocationMatch>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditStatus>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditSubTaskIssueTypes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditTrustedApplication>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditUser>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditUserDefaultSettings>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditUserGroups>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditUserProjectRoles>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditUserProperties>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditUserProperty>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflow>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflowScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflowSchemeEntities>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflowStep>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflowTransition>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflowTransitionConditionParams>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflowTransitionPostFunctionParams>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EditWorkflowTransitionValidatorParams>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch EnterpriseSelectProjectRepository>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ExternalImport>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch FogBugzImport>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch GlobalPermissions>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch GroupBrowser>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ImportWorkflowFromXml>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch IndexAdmin>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch IndexOptimize>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch IntegrityChecker>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch JellyRunner>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch JiraSupportRequest>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch LDAPConfigurer>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ListEventTypes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ListWorkflows>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch MailQueueAdmin>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch MakeDefaultLevel>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ManageConfiguration>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ManageConfigurationScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ManageIssueTypeSchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ManageSubTasks>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch MantisImport>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch MigrateIssueTypes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectEmail>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportBackupOverviewProgress>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportMappingProgress>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportMissingMandatoryUsersCannotCreate>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportMissingMandatoryUsersExtMgmt>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportMissingOptionalUsersCannotCreate>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportMissingOptionalUsersExtMgmt>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportMissingUsersAutoCreate>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportProgress>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportResults>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportSelectBackup>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportSelectProject>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ProjectImportSummary>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch PublishDraftWorkflow>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch RepositoryTest>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ResetFailedLoginCount>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchedulerAdmin>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeComparisonPicker>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeComparisonTool>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeGroupToRoleMapper>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeGroupToRoleResult>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeGroupToRoleTransformer>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeMerge>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeMergePreview>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeMergeResult>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemePicker>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemePurgeToolPreview>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemePurgeToolResults>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemePurgeTypePicker>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeTools>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SchemeTypePicker>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectFieldLayoutScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectIssueTypeSchemeForProject>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectIssueTypeScreenScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectCategory>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectIssueSecurityScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectPermissionScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectRepository>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectSecuritySchemeStep2>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectWorkflowScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectWorkflowSchemeStep2>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectProjectWorkflowSchemeStep3>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SelectScreenScheme>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SendBulkMail>
<LocationMatch>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SendTestMail>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ServiceExecutor>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SetGlobalEmailPreference>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch SetPassword>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch TaskAdmin>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch TimeTrackingAdmin>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch TrackbackAdmin>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch UpdatePopMailServer>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch UpdateRepository>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch UpdateSmtpMailServer>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch UserBrowser>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewApplicationProperties>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewAttachmentSettings>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewCustomFields>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewDefaultProjectRoleActors>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewFieldLayouts>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewFieldLayoutSchemes>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewFieldScreens>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewFieldScreenSchemes>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewGroup>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewIssueColumns>
<LocationMatch>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewIssueFields>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewIssueSecuritySchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewIssueTypes>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewIssueTypeScreenSchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewLicense>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewLinkTypes>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewListeners>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewLogging>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewLookAndFeel>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewMemoryInfo>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewNotificationSchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewPermissionSchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewPlugins>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewPriorities>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewProjectCategories>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewProjectRoles>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewProjectRoleUsage>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewResolutions>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewServices>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewStatuses>
  Include sysadmin_ips_only.conf
</LocationMatch>

<LocationMatch ViewSystemInfo>
Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewTranslations>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewTrustedApplications>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewUpgradeHistory>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewUser>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewUserDefaultSettings>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewUserProjectRoles>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowSchemes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowStep>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowStepMetaAttributes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowSteps>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowTransition>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowTransitionConditionalResult>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowTransitionMetaAttributes>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch ViewWorkflowXml>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch XmlBackup>
  Include sysadmin_ips_only.conf
</LocationMatch>
<LocationMatch XmlRestore>
Using Fail2Ban to limit login attempts

JIRA 4.1 includes a rate-limiting mechanism, but older versions and other applications such as Confluence need external help from a tool such as Fail2Ban.

What is Fail2Ban?

We need a means of defending sites against brute-force login attempts. Fail2Ban is a Python application which trails logfiles, looks for regular expressions and works with Shorewall (or directly with iptables) to apply temporary blacklists against addresses that match a pattern too often. This can be used to limit the rate at which a given machine hits login URLs for Confluence.

⚠️ The information on this page does not apply to Confluence Cloud.

Prerequisites

- Requires Python 2.4 or higher to be installed
- Needs a specific file to follow, which means your Apache instance needs to log your Confluence access to a known logfile. You should adjust the configuration below appropriately.

How to set it up

This list is a skeletal version of the instructions

- There's an RPM available for RHEL on the download page, but you can also download the source and set it up manually
- Its configuration files go into /etc/fail2ban
- The generic, default configuration goes into .conf files (fail2ban.conf and jail.conf). Don't change these, as it makes upgrading difficult.
-Overrides to the generic configuration go into .local files corresponding to the .conf files. These only need to contain the specific settings you want overridden, which helps maintainability.
- Filters go into filter.d — this is where you define regexps, each going into its own file
- Actions go into action.d — you probably won't need to add one, but it's handy to know what's available
- "jails" are a configuration unit that specify one regexp to check, and one or more actions to trigger when the threshold is reached, plus the threshold settings (e.g. more than 3 matches in 60 seconds causes that address to be blocked for 600 seconds)
- Jails are defined in jail.conf and jail.local. Don't forget the enabled setting for each one — it can be as bad to have the wrong ones enabled as to have the right ones disabled.

Running Fail2Ban

- Use /etc/init.d/fail2ban {start|stop|status} for the obvious operations
- Use fail2ban-client -d to get it to dump its current configuration to STDOUT. Very useful for troubleshooting.
- Mind the CPU usage; it can soak up resources pretty quickly on a busy site, even with simple regexp
- It can log either to syslog or a file, whichever suits your needs better

Common Configuration

jail.local
# The DEFAULT allows a global definition of the options. They can be override
# in each jail afterwards.

[DEFAULT]

# "ignoreip" can be an IP address, a CIDR mask or a DNS host. Fail2ban will not
# ban a host which matches an address in this list. Several addresses can be
# defined using space separator.
# ignoreip = <space-separated list of IPs>

# "bantime" is the number of seconds that a host is banned.
bantime  = 600

# A host is banned if it has generated "maxretry" during the last
# "findtime"
# seconds.
findtime  = 60

# "maxretry" is the number of failures before a host get banned.
maxretry  = 3

[ssh-iptables]
enabled  = false

[apache-shorewall]
enabled  = true
filter   = cac-login
action   = shorewall
logpath  = /var/log/httpd/confluence-access.log
bantime  = 600
maxretry = 3
findtime = 60
backend  = polling

Configuring for Confluence

The following is an example only, and you should adjust it for your site.

filter.d/confluence-login.conf

[Definition]

failregex = <HOST>*"GET /login.action

ignoreregex =

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Configuring for JIRA

The following is an example only, and you should adjust it for your site.

**filter.d/jira-login.conf**

```
[Definition]
failregex = <HOST>.*"GET /login.jsp
ignoreregex =
```

**How To Disable SSLv3 to Mitigate Against POODLE Exploit for JIRA**

If JIRA is running behind a proxy that handles SSL for it then the following information does not apply. Instead you will need to modify the configuration of the proxy that is in front of JIRA to disable SSLv3.

**Use Case**

If you have enabled the SSL connector for JIRA using `<jira_install>/conf/server.xml`, the default settings do not block SSLv3 connections which can be exploited by the POODLE fallback attack. There are two changes that need to be made to the SSL connector. By default, the SSL connector sets `sslProtocol="TLS"` which starts both TLS connectors and SSLv3 connectors. You can tell if you are affected by opening `<jira_install>/conf/server.xml` and find the SSL connector, example follows:

```
<Connector port="8443" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" disableUploadTimeout="true"
    acceptCount="100" scheme="https" secure="true"
    clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
    URIEncoding="UTF-8" keystorePass="<MY_CERTIFICATE_PASSWORD>"/>
```

**Resolution**
• Edit the SSL connector in `server.xml` as follows:

```xml
<Connector port="8443" maxHttpHeaderSize="8192"
          maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
          enableLookups="false" disableUploadTimeout="true"
          acceptCount="100" scheme="https" secure="true"
          clientAuth="false" sslProtocols="TLSv1,TLSv1.1,TLSv1.2"
          sslEnabledProtocols="TLSv1,TLSv1.1,TLSv1.2"
          SSLEnabled="true"
          URIEncoding="UTF-8"
          keystorePass="<MY_CERTIFICATE_PASSWORD>"/>
```

• In older versions of Tomcat (up to 6.0.32) the property `sslEnabledProtocols` didn't exist. If you're running JIRA 5.2.11 or older, please edit the SSL connector as follows instead:

```xml
<Connector port="8443" maxHttpHeaderSize="8192"
          maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
          enableLookups="false" disableUploadTimeout="true"
          acceptCount="100" scheme="https" secure="true"
          clientAuth="false" sslProtocols="TLSv1,TLSv1.1,TLSv1.2"
          SSLEnabled="true"
          URIEncoding="UTF-8"
          keystorePass="<MY_CERTIFICATE_PASSWORD>"/>
```

• At this point you can start JIRA and use something like `SSLScan` to verify that connections can only be made through TLS and not SSLv3.

• **Java 7 (or higher) is required** to use TLSv1.1 and TLSv1.2.

• Use "sslProtocols" attribute if you are supporting more than one protocol.

---

**Deployment Planning Activity**

Planning for rolling out our products or capacity planning for large instances is better suited for service offerings other than Atlassian Support. We will refer this kind of activity to our Experts network. This includes establishing specific upgrade and deployment plans for existing installations.

We suggest customers run the Performance Testing Scripts available for products to see how well their software instance performs given the hardware configuration in use and expected workload. Using this data, the instance can then be tuned for performance should there be any issues encountered.

It is also recommended that you closely monitor your production instance to ensure that performance does not degrade as your instance grows in size.

Atlassian does not provide benchmarking data at this time.

Should you require any assistance, it is best to take advantage of our public forums or contact our Experts.

**JIRA Releases**

**Latest production releases**

Please view the release notes to get up-to-date information about the improvements made in each release.

If upgrading from a previous version of JIRA please pay attention to the Upgrade Notes/Guide of the latest version, including those for each important version of JIRA you are 'skipping' (between your current JIRA version that the JIRA version you are upgrading to).

---

*Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
The features of each major JIRA release, up to and including the latest major version, can be found in the JIRA Release Summary.

For full details on each of the JIRA releases, please read the release notes for the previous releases listed below.

Previous releases

See the complete list of Releases Notes and Upgrade Guides for information about older releases.

Getting notified about new releases

We announce all new JIRA releases, including major and minor production versions and EAP milestones in our knowledge base.

To get the RSS feed of new releases:

1. Go to the JIRA knowledge base: https://confluence.atlassian.com/display/JIRAKB/JIRA+Knowledge+Base+Home
2. Click the RSS 2.0 icon in the Technical Announcements section.

If you are just interested in major production releases, you can watch this page: https://confluence.atlassian.com/display/JIRA/JIRA+Release+Summary

JIRA Release Summary

This page shows the highlights of the major JIRA releases.

For an overview of each major and minor release of JIRA and links to the release notes for each of these releases, please refer to the Production Releases page.

JIRA 6.3.3 - 11 August 2014

- Triggers in JIRA workflows that respond to events in your linked development tools
- Bulk issue creation
- Inline image rendering
- Improved search performance
- JIRA Data Center health checks
- More in the release notes

JIRA 6.3 - 9 July 2014

- Data Center released offering high availability, scalability and performance
- Inline issue create for Agile teams
- 'On the fly' component and versioning creation for admins
- Enhanced auditing capabilities
- Increased data import options
- More in the release notes

JIRA 6.2 – 25 February 2014

- New Development panel for issues
- Enhanced workflow designer
- Simple issue type configuration
- New status lozenges
- Auditing
- Creator recorded for every issue
- Back up and recover indexes
- Re-index individual projects
• More in release notes

JIRA 6.1 – 24 September 2013

• New workflow designer
• New project templates
• Intuitive custom field configuration — Standard and Advanced field types, Add field from View Issue screen
• Edit project key
• Change usernames in LDAP
• JIRA password policy
• More integration with your coding tools — Create branch from JIRA and JIRA Agile
• GreenHopper renamed to JIRA Agile, Bonfire renamed to JIRA Capture
• More in release notes

JIRA 6.0 – 21 May 2013

• New JIRA look and feel that follows the Atlassian Design Guidelines
• Detail view and view issue improvements
• JIRA mobile
• Workflow sharing
• New project templates
• New administration gadget
• Editable usernames
• Global workflow schemes
• Ability to translate custom fields
• More in release notes

JIRA 5.2 — 12 November 2012

• Instant search — new instant search bar and search results, shared filters on the issue navigator, pre-built system filters
• Background reindexing
• SSL configuration via JIRA configuration tool
• Downloadable tools — improved data generator and HTTP requests log analyser
• New enterprise guides — federating JIRA and scaling GreenHopper
• Webhooks for issues
• Redesigned project workflows configuration
• Demonstration project
• Inline help tips
• And more — streamlined Browse Project user interface, JIRA admin helper, copy/edit issue collectors, UPM 2.7 with plugin requests, column ordering for standard JIRA gadgets, compatibility with Confluence Workbox Notifications, Java 7 and Tomcat 7 support
• More in release notes

JIRA 5.1 — 9 July 2012

• Inline editing and fewer page reloads
• Enterprise scale and performance improvements
• Issue collector
• Project administration improvements — easier workflow editing
• Deactivate users
• ‘Autowatch’ issues you create or comment on
• Remote and local JIRA issue link improvements
• Get started faster — welcome page, automatically suggested project keys and invite users
• Automatic time zone detection
• Notify on my actions now disabled by default
• Configurable JIRA home page
• User Gravatar support
• More in release notes

JIRA 5.0 — 22 February 2012

• Remote issue links
• Share issues and mention users
• Rapid create and edit issues
• Search for issues based on their history
• Activity streams now show activity from other applications
• Manage other users’ shared filters and dashboards
• Administration user interface improvements
• REST API (with tutorials) for working with issues in JIRA
• Stable Java API
• New troubleshooting and debugging tools
• New email handler wizard
• Enhancements to the 'view issue' page
• JIRA Add-Ons (Plugins and Integrations)
• More in release notes

JIRA 4.4 — 2 August 2011

• User Time Zones
• Visual Workflow Designer
• Workflow Viewer on the 'View Issue' Screen
• Search (JQL) Enhancements
• Improved Setup Wizard with Database Configuration
• Improved JIRA Standalone Installer/Uninstaller and Automated Upgrade
• New-Look Administration Area
• Simplified Project Administration
• New Email Style
• Issue Linking when Resolving an Issue
• Editable Options for Custom Fields
• Multiple File Selection and Upload from the 'File Upload' Dialog Box
• New-look Activity Stream
• Graph of Vote History
• More in release notes

JIRA 4.3 — 16 March 2011

• Full Integration with LDAP and Active Directory
• New Plugin Management System
• Improved Importer
• JIRA Now Supports 'In-place Database Upgrades'
• Search for Issue Changes, Relative Dates and Relative Versions with JQL
• Quick Search Enhancements
• Revamped User Avatars
• Improvements to Issue Links
• Remembered Assignees
• Security Enhancements
• Application Links: Connecting Applications Together
• REST API Improvements
• More in release notes

JIRA 4.2 — 21 October 2010

• Keyboard Shortcuts and 'Operations Dialog'
• Editable 'Original Estimate'
• 'Log Work' Fields Available When Resolving Issues
• Labels
- User Avatars
- Viewable ZIP Files
- REST API (Alpha)
- More in release notes

JIRA 4.1 — 8 April 2010
- New-look 'View Issue'
- Streamlined Keyboard Shortcuts
- Customisable Email Subject
- Image Gallery
- ZIP Download of Attachments
- List of Logged-in Users
- JIRA Standalone ships with JIRA Configuration Tool, Database Drivers and Tomcat 6.0
- More in release notes

JIRA 4.0 — 6 October 2009
- Advanced Searching
- Dashboard Gadgets
- Activity Streams
- New-look "Browse Project"
- Charting Now Comes Standard
- New-look Header
- Issue Actions in the Issue Navigator
- Project Icons
- Default Unit for Time Tracking
- "History" is now permanent
- Engine Room
- More in release notes

JIRA 3.13 — 9 September 2008
- Shareable dashboards
- Improved filter sharing
- Favourite filters and dashboards
- Restoring projects
- Editable active workflows
- Enhanced sub-task quick creation
- Personal licenses
- New plugins
- Progress bar for long-running operations
- Application improvements
- More in release notes

JIRA 3.12 — 7 December 2007
- 'Trusted' Confluence
- 'JIRA System Administrators' permission
- FishEye plugin now bundled with JIRA
- Improvements to the Subversion plugin
- Improvements to the 'Project Statistics' and 'Filter Statistic' portlets
- New post function for workflows: 'Assign to Current User'
- Enhanced language support for searching
- Visual SourceSafe plugin
- More in release notes

JIRA 3.11 — 25 September 07
- Sub-task progress shown within issues
- Issue Navigator offers sub-task aggregates
- Time Tracking reports now include sub-tasks
- Multi-project 'Road Map' portlet
- Performance improvements
- Indexing improvements
- JIRA Labels Plugin
- More in release notes

JIRA 3.10 — 9 July 2007

- Editable Worklogs
- Start Date for Worklogs
- New way to browse Components
- New way to browse Versions
- Auto-complete 'User-picker' and 'Issue-picker'
- More in release notes

JIRA 3.9 — 8 May 2007

- Ability to convert sub-tasks to issues (and vice versa)
- Convenient new scheduler for filter subscriptions
- Separate permissions for 'Delete Comment', 'Delete Attachment' and 'Delete Issue'
- Performance Improvements for Project Roles
- More in release notes

JIRA 3.8 — 13 March 2007

- Editable comments
- Self-installer for JIRA
- CAPTCHA for new account signup
- Integration with Crowd
- Improvements to the Bugzilla importer
- DHTML-loading of Issue screens
- More in release notes

JIRA 3.7 — 18 December 2006

- Project Roles - assign users and groups to roles on a per project basis
- Chart View - view charts in Issue Navigator using the JIRA Charting plugin
- RSS Improvements
- User Properties - record arbitrary information to the user profile (admin only)
- SVN project panel plugin - provides a summary of all commits made against a particular project or a project version
- More in release notes

JIRA 3.6 — 18 April 2006

- Custom Events - extension point for notification and workflow schemes
- Group Picker Custom Field - searchable in the issue navigator
- Per-issue Group Notifications and Permissions - based on the group picker custom field
- "I'm Feeling Lucky" Quick Search
- Collapsible Fields - control the level of detail of environment, description, individual comment fields and any textarea custom field
- Nestable Conditions - construct complex workflow conditions using nested conditions with AND or OR statements
- More in release notes
JIRA 3.5 — 01 February 2006

- Bulk Workflow Transition
- FogBugz Importer
- Charting Plugin
- MS Word Export
- JIRA Page Linker Plugin - linking a JIRA issue with a Confluence URL
- Component Lead Notification Type
- Bulk Assignment of Users to Groups
- More in release notes

JIRA 3.4 — 15 November 2005

- Issue Types Per Project
- Renderers - Confluence markup in JIRA text-based fields such as description and comments
- Issue Operation Plugin
- Announcement Banner
- RSS Support Improvements - live bookmarking with supported browsers
- Change Parent of Sub-Task
- Multi-user Custom Field
- More in release notes

JIRA 3.3 — 05 August 2005

- Multiple Project Filters - execute a search across multiple projects
- Bulk Move
- User Custom Field as Notification Target
- Extended Search Capabilities - search by date range for 'Created' and 'Updated' system fields and the custom field 'Date Time'
- JIRA Standalone ships with Tomcat 5.5
- More in release notes

JIRA 3.2 — 27 May 2005

- Field screens - configuration of field position and visibility for each issue operation and in Professional and Enterprise editions for each workflow transition screen
- Contextual custom fields - shared between projects and issue types
- Extended Bulk Edit Capabilities - Due Date, Reporter, Issue Security Level, Issue Type
- Improved internationalisation - Issue Constant Translations (Priorities, Statuses, Issue Types and Resolutions)
- Improved performance - quicker searching in the issue navigator and reports generation
- Smart Query
- Excel View
- More in release notes

JIRA 3.1 — 14 February 2005

- CSV Importer Wizard
- Add Comment on 'View Issue' field
- Webwork Plugin Type
- Assign Issues by Mail (via the CC field) using the Create Issue Handler
- More in release notes

JIRA 3.0 — 12 October 2004

- Workflow editor and configurable workflows
- Sub-tasks
- Plugin System
- Pluggable Custom Fields
• Dashboard Overhaul
• Issue cloning
• More in release notes

Production Releases

This page lists release notes and upgrade guides from past versions of JIRA.

If upgrading from a previous version of JIRA please pay attention to the Upgrade Guide of the version you are upgrading to, and any version of JIRA that you are ‘skipping’ during the upgrade.

You can also view lists of the Release Notes or Upgrade Guides separately.

• JIRA 6.4 Release Notes
  • JIRA 6.4 Upgrade Notes
  • JIRA 6.4.1 Release Notes
  • JIRA 6.4.2 Release Notes
  • JIRA 6.4.3 Release Notes
  • JIRA 6.4.4 Release Notes

• JIRA 6.3 Release Notes
  • JIRA 6.3.15 Release Notes
  • JIRA 6.3.14 Release Notes
  • JIRA 6.3.13 Release Notes
  • JIRA 6.3.12 Release Notes
  • JIRA 6.3.11 Release Notes
  • JIRA 6.3.10 Release Notes
  • JIRA 6.3.9 Release Notes
  • JIRA 6.3.8 Release Notes
  • JIRA 6.3.7 Release Notes
  • JIRA 6.3.6 Release Notes
  • JIRA 6.3.5 Release Notes
  • JIRA 6.3.3 Release Notes
  • JIRA 6.3.4 Release Notes
  • JIRA 6.3.1 Release Notes
  • JIRA 6.3 Upgrade Notes

• JIRA 6.2 Release Notes
  • JIRA 6.2 Upgrade Notes
  • JIRA 6.2.7 Release Notes
  • JIRA 6.2.6 Release Notes
  • JIRA 6.2.5 Release Notes
  • JIRA 6.2.4 Release Notes
  • JIRA 6.2.3 Release Notes
  • JIRA 6.2.2 Release Notes
  • JIRA 6.2.1 Release Notes

• JIRA 6.1 Release Notes
  • JIRA 6.1 Upgrade Notes
  • JIRA 6.1.9 Release Notes
  • JIRA 6.1.8 Release Notes
  • JIRA 6.1.7 Release Notes
  • JIRA 6.1.6 Release Notes
  • JIRA 6.1.5 Release Notes
  • JIRA 6.1.4 Release Notes
  • JIRA 6.1.3 Release Notes
  • JIRA 6.1.2 Release Notes
  • JIRA 6.1.1 Release Notes

• JIRA 6.0 Release Notes
  • JIRA 6.0 Upgrade Notes
  • JIRA 6.0.8 Release Notes
  • JIRA 6.0.7 Release Notes
  • JIRA 6.0.6 Release Notes
  • JIRA 6.0.5 Release Notes
  • JIRA 6.0.4 Release Notes
- JIRA 6.0.3 Release Notes
- JIRA 6.0.2 Release Notes
- JIRA 6.0.1 Release Notes
- JIRA 5.2 Release Notes
  - JIRA 5.2 Upgrade Notes
  - JIRA 5.2.11 Release Notes
  - JIRA 5.2.10 Release Notes
  - JIRA 5.2.9 Release Notes
  - JIRA 5.2.8 Release Notes
  - JIRA 5.2.7 Release Notes
  - JIRA 5.2.6 Release Notes
  - JIRA 5.2.5 Release Notes
  - JIRA 5.2.4.1 Release Notes
  - JIRA 5.2.4 Release Notes
  - JIRA 5.2.3 Release Notes
  - JIRA 5.2.2 Release Notes
  - JIRA 5.2.1 Release Notes
- JIRA 5.1 Release Notes
  - JIRA 5.1 Upgrade Notes
  - JIRA 5.1.8 Release Notes
  - JIRA 5.1.7 Release Notes
  - JIRA 5.1.6 Release Notes
  - JIRA 5.1.5 Release Notes
  - JIRA 5.1.4 Release Notes
  - JIRA 5.1.3 Release Notes
  - JIRA 5.1.2 Release Notes
  - JIRA 5.1.1 Release Notes
- JIRA 5.0 Release Notes
  - JIRA 5.0 Upgrade Notes
  - JIRA 5.0.7 Release Notes
  - JIRA 5.0.6 Release Notes
  - JIRA 5.0.5 Release Notes
  - JIRA 5.0.4 Release Notes
  - JIRA 5.0.3 Release Notes
  - JIRA 5.0.2 Release Notes
  - JIRA 5.0.1 Release Notes
- JIRA 4.4 Release Notes
  - JIRA 4.4 Upgrade Notes
  - JIRA 4.4.5 Release Notes
  - JIRA 4.4.4 Release Notes
  - JIRA 4.4.3 Release Notes
  - JIRA 4.4.2 Release Notes
  - JIRA 4.4.1 Release Notes
- JIRA 4.3 Release Notes
  - JIRA 4.3 Upgrade Guide
  - JIRA 4.3.4 Release Notes
  - JIRA 4.3.3 Release Notes
  - JIRA 4.3.2 Release Notes
  - JIRA 4.3.1 Release Notes
- JIRA 4.2 Release Notes
  - JIRA 4.2 Upgrade Guide
  - JIRA 4.2.4 Release Notes
  - JIRA 4.2.3 Release Notes
  - JIRA 4.2.2 Release Notes
  - JIRA 4.2.1 Release Notes
- JIRA 4.1 Release Notes
  - JIRA 4.1 Upgrade Guide
  - JIRA 4.1.2 Release Notes
  - JIRA 4.1.1 Release Notes
- JIRA 4.0 Release Notes
  - JIRA 4.0 Upgrade Guide
  - JIRA 4.0.2 Release Notes
• JIRA 4.0.1 Release Notes
• JIRA 3.13 Release Notes
  • JIRA 3.13 Upgrade Guide
  • JIRA 3.13.5 Release Notes
  • JIRA 3.13.4 Release Notes
  • JIRA 3.13.3 Release Notes
  • JIRA 3.13.2 Release Notes
  • JIRA 3.13.1 Release Notes
• JIRA 3.12 Release Notes
  • Additional JIRA 3.12 features (for internal use only)
  • JIRA 3.12 Upgrade Guide
  • JIRA 3.12.3 Release Notes
  • JIRA 3.12.2 Release Notes
  • JIRA 3.12.1 Release Notes
• JIRA 3.11 Release Notes
  • JIRA 3.11 Upgrade Guide
  • Plugins that need to be updated for 3.11
• JIRA 3.10 Release Notes
  • JIRA 3.10 Upgrade Guide
  • JIRA 3.10.2 Release Notes
  • JIRA 3.10.1 Release Notes
• JIRA 3.9 Release Notes
  • JIRA 3.9 Upgrade Guide
  • JIRA 3.9.3 Release Notes
  • JIRA 3.9.2 Release Notes
  • JIRA 3.9.1 Release Notes
• JIRA 3.8 Release Notes
  • Feedback for DHTML-loading of Issue screens
  • JIRA 3.8 Upgrade Guide
  • JIRA 3.8.1 Release Notes
• JIRA 3.7 Release Notes
  • Issue Operations plugin
  • JIRA 3.7 Upgrade Guide
  • JIRA 3.7.4 Release Notes
  • JIRA 3.7.3 Release Notes
  • JIRA 3.7.2 Release Notes
  • JIRA 3.7.1 Release Notes
• JIRA 3.6 Release Notes
  • JIRA 3.6 Upgrade Guide
  • JIRA 3.6.5 Release Notes
  • JIRA 3.6.4 Release Notes
  • JIRA 3.6.3 Release Notes
  • JIRA 3.6.2 Release Notes
  • JIRA 3.6.1 Release Notes
• JIRA 3.5 Release Notes
  • JIRA 3.5 Upgrade Guide
  • JIRA 3.5.3 Release Notes
  • JIRA 3.5.2 Release Notes
  • JIRA 3.5.1 Release Notes
• JIRA 3.4 and 3.4.1 Release Notes
  • JIRA 3.4 and 3.4.1 Upgrade Guide
  • JIRA 3.4.3 Release Notes
  • JIRA 3.4.2 Release Notes
  • JIRA 3.4.1 Release Notes
• JIRA 3.3 Release Notes
  • JIRA 3.3 Upgrade Guide
  • JIRA 3.3.3 Release Notes
  • JIRA 3.3.2 Release Notes
  • JIRA 3.3.1 Release Notes
• JIRA 3.2 Release Notes
  • JIRA 3.2 Upgrade Guide
  • 3.2 performance benchmarks
JIRA 6.4 helps your teams work together faster and more effectively

In JIRA 6.4 we’ve introduced several key concepts and features to ensure that you and your teams can work easily and more efficiently together. We’ve greatly improved our HipChat and JIRA integration experience so that teams can now broadcast filtered JIRA notifications directly into HipChat rooms, ensuring the entire team can stay in sync with real-time information. We have also introduced new tools, such as the Release Hub, which makes the release management smoother through providing visibility into the status of a release and potential areas that need troubleshooting. Faster and more intuitive onboarding, an easier to manage workspace, and a workflow validator enable teams to work more efficiently within their projects.

JIRA + HipChat

We’ve made integrating JIRA and HipChat easier than ever! Now you can connect to HipChat Rooms and filter notifications from within your Project Administration screen with a single click. There’s no need to access the project workflow, which means project admins can set up and add notifications to their HipChat rooms themselves, even private rooms. Issue transitions, status updates and more can be sent as notifications, so that your team never misses an update!

Learn more...

Download latest version

JIRA 6.4 Upgrade Notes
Release Hub

The Versions page has been totally redesigned in this release. We've created a Release Hub that harnesses the information in JIRA and your development tools to make release management easier from day one. Don't waste your time digging through issues, commits and pull requests. Now you can check the progress of your release, spot problems early, and determine what is likely to ship, at a glance.

Learn more...

Workflow validation

Ever created a workflow and started using it, only to discover you can't find some of your statuses? Or that you seem to have hit a dead-end when transitioning your issue? JIRA will now validate your workflow as you create it, informing you when you have a status that has no incoming or outgoing transitions, or if you have permission errors when you import a workflow.

Learn more...
New sidebar preview

We’ve been working hard on improving JIRA’s user interface, and in JIRA 6.4 we’re giving you a preview of what we’ve been working on. We wanted to make accessing your project’s information as efficient as possible, so we’ve introduced a navigation sidebar to sit alongside your workspace. This makes it easier to access all project information from one view, and helps you work more efficiently, especially if you also use JIRA Agile. We’ve also added project shortcuts to the sidebar, which now allow you to add links to online resources that are shared with anyone who has access to your project. We’re also collecting feedback on this new experience, and would love to hear from you on how we can improve your project navigation experience even further.

Learn more...

Performance improvements

In JIRA 6.4, we’ve improved performance in areas such as creating and editing issues, selecting and displaying projects, and selecting assignees or groups. The improvements are available in all JIRA instances, but are most noticeable in large JIRA installations containing a large number of projects and issues.

Enterprise — Disaster Recovery

JIRA has become business critical in many enterprises. JIRA Data Center 6.4 customers will be able to configure a cold single or multi node standby site in a geographically separate location. This feature will help enterprises ensure business continuity for JIRA in the event of a major infrastructure or environmental failure. The features introduced in JIRA Data Center 6.4 to support disaster recovery include:

- **Index replication**: Configurable replication of your index to a JIRA standby system allows you to optimize your Recovery Time Objective (RTO)
- **File replication**: Replicate different types of files to your standby system from JIRA, without having to use an external tool. The files include attachments, installed plugins, and more.
- **Health checks**: To give you confidence of your new ability switch to your standby JIRA instance, you can check the health of its database, search index and attachments, without running SQL queries.

Read the guide...

And more!

Of course, that’s not all we’ve done in this release. We’re working really hard on legacy features and functions, and either improving their performance, or removing them from JIRA if they’re no longer valid. We’ve removed Scheme Tools and the News gadget, and we’ve been working on other gadgets to improve their load times and performance on your dashboard.

As stated above, we’re making the move to an enhanced navigation experience. While users can toggle between the new and old experience, we do realise that JIRA Administrators may prefer to have their JIRA instance set to one state so they can provide support to their users. We’ve implemented a switch which lets you select what state you’d prefer your users to access. Learn more...
Another notable improvement has been how JIRA handles bulk editing of multi-select fields, like Version and Components. Now, you’re able to select whether you want to clear or add to all the existing values, replace all the existing values with a specific value or set of values, or simply remove a specific value or set of values. Learn more...

Click here to read about more JIRA 6.4 features.

- **Access log analyzer 2.0** - Problem solving is hard, and as such we try to share our tools as much as is practically possible. We’ve released our Access log analyzer 2.0 which will help analyze the JIRA request logs. Learn more...

- **Simple Wiki editor** - Ever wanted to add more than just plain text to your JIRA comments and descriptions but could never remember the Wiki markup? Now you don’t have to, just highlight the text you want to change and click the relevant button in the toolbar, and JIRA will apply the markup for you. Learn more...

- **Paste images** - Previously if you had an attachment or image on your clipboard, you had to save it and add it to a JIRA comment or description as an attachment. Now, you can simply copy it directly to JIRA by using your keyboard shortcut or selecting "Copy" from the right-click menu.

- **Express setup** - Installing and configuring JIRA can be a complex task, especially if it's your first time using JIRA. We’ve recognized this, and we’ve simplified the JIRA setup process. JIRA can now be installed and up and running in under three minutes!

- **Agile integration and performance** - The JIRA development team have also been working hard on the integration and performance of JIRA and JIRA Agile. There have been improvements in performance of JIRA, and the most notable of these can be seen when starting and closing sprints in Agile, and when using the View on Board link in the Agile panel.

- **Persistent custom fields** - When you’re creating an issue and check "Create another", the custom field values you entered will be now retained for the next issue you create. When you close the Create issue dialog, the custom values will be reset.

- **Project-specific schemes for new projects** - Creating a new project now creates a project-specific issue type scheme, workflow scheme and issue type screen scheme for that project. This change applies to all project types, except for the 'JIRA Classic' project type, which still uses the shared default JIRA schemes when used to create a new project.

- **Updated priorities and resolutions** - JIRA 6.4 ships with a new set of priorities, and a new resolution. The old default priorities of Blocker, Critical, Major, Minor and Trivial will be replaced with Highest, High, Medium, Low and Lowest. If you are upgrading an installation of JIRA, or importing existing data, JIRA will respect your original priorities and they will continue to be available instead of the new priorities. The new priorities will only become available and therefore the default in new installations. We’re also shipping with a new resolution of Won't Do. This resolution will only become available when you create a software development project in JIRA and is exactly the same as the current Won't Fix resolution, apart from the name.

- **ADG 2.0** - We’re also shipping our most up to date Atlassian Design Guidelines as part of the 6.4 release. This means that users will see changes in components of the user interface, such as how confirmation messages are displayed and a subtle change in color scheme. There is no functional change imposed by ADG 2.0.

<table>
<thead>
<tr>
<th>Pre-ADG 2.0</th>
<th>Post ADG 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.jpg" alt="Pre-ADG example" /></td>
<td><img src="image2.jpg" alt="Post ADG example" /></td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).
Click here to read important support and end of support announcements...

- Oracle 11G will no longer be supported from JIRA 7.0
- Jelly scripts are no longer supported in JIRA 6.4
- Atlassian will stop releasing a WAR distribution of JIRA from JIRA 7.0
- Internet Explorer 9 will not be supported from JIRA 7.0
- Microsoft SQL Server 2005 will no longer be supported from JIRA 7.0
- Java 7 (JRE and JDK 1.7) will no longer be supported from JIRA 7.0

Please see End of Support Announcements for JIRA for a full list of end of support announcements.

The JIRA 6.4 team

In memoriam

On the 30th July 2014, Rosie Dabinett (née Jameson) passed away after a brave battle with cancer. Rosie was the first and longest serving technical writer for JIRA. She inspired us all and left us too soon.

Vale Rosie. We miss you.

Development
Abhinav Kishore
Adam Jakubowski
Ahmed Mahmoud
Albert Kavelar
Aleksander Mierzwicki
Alex Rantos
Andreas Knecht
Andrew Semple
Andrew Swan
Antoine Büsch
Arkadiusz Gowacki
Bartomiej Lewandowski
Ben Morgan
Ben Sayers
Ben Wong
Bradley Ayers
Brenden Bain
Bruce Templeton
Brydie McCoy
Charles O’Farrell
Chris Darroch
Chris Fuller
Christopher Nortje
Chris Mountford
Dariusz Kordonski
Dariusz Szuksztol
David Tang
Eduardo Soares
Edward Zhang
Eric Dalglish
Eric Sukmajaya
Filip Rogaczewski
Gareth Williams
Gilmore Davidson
Piotr Klimkowski
Przemek Borkowski
Richard Cordova
Robert Chattfield
Robert Smart
Roman Tekhov
Sean Curtis
Sebastian Pawlak
Sergio Cinos
Shafqat Bhuiyan
Stanislav Dvorscak
Sunny Kalsi
Symphony Wong
Tang Hai Ngoc Son
Theodora Tse
Tianyu Pu
Tomasz Sroka
Tran Bao Nhat
Trevor Campbell
Vincent Wong
Wojciech Urbanski
Zehua Liu

Sydney Support
Bejoy Jaison
Chung Park Chan
Daniel Watania
David Currie
David Mason
Diallo Abdoulaye
Hazwan Ariffin
Matthew Hunter
Mauro Badii
Melissa Klingler
Michael Andreacchio
Nick Mason
Paul Greig
Sam Omidi
Seam Mee Tan

Amsterdam Support
Alex Conde
Bastiaan Jansen
Dora Wierzbicka
Ivan Maduro
Mick Nassette
Miranda Rawson
Peter Koczyn
Ruchi Tandon
Shannon Mackie
Theodore Tzidamis
Yilin Mo

Brazil Support
Andre Quadros Petry
Benito Picarelli
Bruno Rosa
Clarissa Gauterio
Danilo Conrad
Eric Kieling
Felipe Willig
Jorge Dias
Lucas Lima
Luciano Fagundes
Marcus Silveira
Matheus Fernandes
Ricardo Carracedo
Pedro Cora
Pedro Souza
Pietro Schaff
Tiago Kolling Comasseto

**Kuala Lumpur Support**
Ahmad Danial
Ahmad Faisal
Ala Al-Shargabi
Anna Monica Cardino
Azwandi Mohd Aris
Daryl Chuah
Daniel Leng
Immanuel Siagian
Janet Albion
Joe Wai Tye
John Chin Kim Loong
Julian Rahmadiputra
Kumar Ramajillu
Muhammad Fahd
Razaq Omar
Richie Gee
Taiwo Akindele
Vicky Kharisma
Viet Dung Nguyen
Voon Kiat Gan
Yew Teck En
Zulfadli Noor Sazali

**San Francisco Support**
Boris Berenberg
David Chan
David Maye
David Nicholson
Earl McCutcheon
Gary Sackett
Ivan Tse
James Giles
Jason Worley
Jeff Curry
John Garcia
Jordan Robison
Justin Burke
Kyler Johnson
Mary Avalos
Michael Thai
Osman Afridi
Pelle Kirkeby
Rick Bal
Thomas Garske
Tim Evans
Turner Benard

**General Manager**
Bryan J. Rollins

**JIRA Leadership team Operations**
Manager
Roy Krishna

HR Business Partner
Kellie Egan

Product Management
Anu Bharadwaj
Bartek Gatz
Ben Wirtz
Dave Meyer
Eve Stankiewicz
Jason Lim
Jason Wong
Kerrod Williams
Martin Jopson
Martin Suntinger
Megan Cook
Otto Ruettinger
Rutger Coolen
Tom Kotecki

Product Marketing Management
Aileen Horgan
Aimie Smith
Angela Blair
Dan Radigan
Jake Brereton
Junie Dinda
Ken Olofsen
Laura Daly
Sheri Atienza

Program Manager
Simone Houghton

Head of Development
Nick Menere

Development Management
Graham Carrick
Marty Henderson
Michael Tokar
Pawel Farid
Phan Thuc Anh
Wojciech Seliga

Design
Becc Roach
Benjamin Humphrey
Dean Hudson
Jay Rogers
Jerome Cordiez
Krzysztof Piwowar
Liam Greig
Ross Chaldecott

Quality Assistance
Kiran Shekhar
Michal Kujalowicz
Patrick Mali
Penny Wyatt
Peter Obara
JIRA 6.4 Upgrade Notes

Please follow the instructions in the general Upgrading JIRA guide, as well as the JIRA 6.4 specific instructions below. The general guide contains important tasks that are essential for getting your upgraded JIRA installation to work correctly and, if necessary, migrating existing configurations.

This page also describes known issues as well as changes you should be aware of before deciding whether or not to upgrade to JIRA 6.4.

On this page:

- Information for JIRA developers
- Upgrading to JIRA 6.4 from JIRA 6.2.x
- Upgrading to JIRA 6.4 from JIRA 6.1.x or earlier

Information for JIRA developers

See Preparing for 6.4 for important information that could affect your add-ons or scripts. Also, see our Java API policy for JIRA.

Upgrading to JIRA 6.4 from JIRA 6.2.x

- End of support for Jelly Scripts

End of support for Jelly Scripts

JIRA 6.4 does not support Jelly scripts. If you are using Jelly scripts with JIRA, we recommend you move to Groovy Script Runner or the JIRA Command Line Interface, which will provide you with more flexible options. For more information, please see this page.

Upgrading to JIRA 6.4 from JIRA 6.1.x or earlier

In addition to the points listed above, please read the Important Version-Specific Upgrade Notes for every version of JIRA you are skipping.

Note, you cannot upgrade from JIRA 4.3.x or earlier, directly to JIRA 6.4. You must upgrade to an interim version first. See Skipping Major Versions When Upgrading JIRA.

JIRA 6.4.1 Release Notes

31 March 2015

The Atlassian JIRA team announces the release of JIRA 6.4.1. This point release contains several updates and fixes. We’re also pleased to announce that we’ve added a new onboarding flow that'll give JIRA (and JIRA Agile) users a personalized onboarding experience.
The new onboarding experience will assist you in selecting an avatar, teach you a little about projects and issues, and get you working faster, sooner.

Upgrading to JIRA 6.4.1 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.4 yet?

Take a look at all the new features in the JIRA 6.4 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.4.1 Upgrade Notes.

Updates and fixes in this release

JIRA 6.4.1 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-42576</td>
<td>Tempo products are disabled on JIRA 6.4 after restart</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42566</td>
<td>JIRA 6.4 as a Crowd Server does not work with Stash 3.4.3 or higher</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42555</td>
<td>Upgrade JIRA 6.4 to UPM 2.18.2</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40941</td>
<td>Images with very large dimensions cause thumbnail generation to OOME the instance</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42259</td>
<td>CSV Import with date field fails to import when dates are within the last 7 days</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-41186</td>
<td>Search Crucible does not work from JIRA Project Overview</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39817</td>
<td>Contact Administrator feature contacting disabled administrator</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-35359</td>
<td>rest metadata call on JAC wrongly claims that assignee field is a required field</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-29690</td>
<td>User email showing in suggestions section with visibility set to hidden</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-28519</td>
<td>JIRA dies with OutOfMemoryException when rendering issues with numerous and/or large comments</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-15773</td>
<td>&quot;Project Roles&quot; header in &quot;Viewable by&quot; select list in Attach Screenshot screen is not translated</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-43219</td>
<td>Attaching differing mime types simultaneously causes Error rendering 'com.atlassian.jira.jira-view-issue-plugin:attachmentmodule'.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42775</td>
<td>Datetime format is not correct when using Java 8</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42774</td>
<td>Attachments are broken in the moved issues, due to project key changes</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42674</td>
<td>Issues tab on Project page breaks with some Project Keys</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42572</td>
<td>Background blinks when installing/updating add-on</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.4.1 Upgrade Notes

Upgrading from JIRA 6.4.x to 6.4.1

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.3.x and earlier

In addition to the above, please read the JIRA 6.4 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.4.2 Release Notes

16 April 2015

The Atlassian JIRA team announces the release of JIRA 6.4.2. This point release contains several updates and fixes.

Upgrading to JIRA 6.4.2 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.4 yet?

Take a look at all the new features in the JIRA 6.4 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.4.2 Upgrade Notes.

Updates and fixes in this release

JIRA 6.4.2 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-15980</td>
<td>Lotus Notes HTML and email handler</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-43372</td>
<td>Importing data from GitHub not working if account uses two-factor authentication</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-43227</td>
<td>Pressing ESC to dismiss Style menu orphans tipsies</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-42783</td>
<td>Pressing ESC on description wikimarkup editor dropdown discards changes.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-42565</td>
<td>Bump UPM version in JIRA from 2.18.2 to 2.18.3</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-42512</td>
<td>Guide for JIRA Administrators gadget shows error &quot;limit of 0 users that are allowed to log in to JIRA&quot;</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-42354</td>
<td>SQL exception can be experienced when trying to move an issue in projects that are deleted and re-created</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-41688</td>
<td>Try JIRA Agile dialog is broken when text is long</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-41226</td>
<td>Comments From Email Trigger Notifications for &quot;Issue Updated&quot; Instead of &quot;Issue Commented&quot; Event</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-38966</td>
<td>Priorities description are not updated on the local Help windows</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-34817</td>
<td>Notification not being sent by email from the Project Notification scheme</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-30852</td>
<td>Mention replies should work like JIRA notification replies</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-28946</td>
<td>IllegalStateException: The current project has not been set.</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
14 issues

JIRA 6.4.2 Upgrade Notes

Upgrading from JIRA 6.4.x to 6.4.2

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.3.x and earlier

In addition to the above, please read the JIRA 6.4 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.4.3 Release Notes

28 April 2015

The Atlassian JIRA team announces the release of JIRA 6.4.3. This point release contains several updates and fixes.

Upgrading to JIRA 6.4.3 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.4 yet?

Take a look at all the new features in the JIRA 6.4 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.4.3 Upgrade Notes.

Updates and fixes in this release

JIRA 6.4.3 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-42811</td>
<td>Webhooks Screen Blank, Create Webhooks Fails with 500 Error, NPE</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-41207</td>
<td>Incoming mails have an incorrect creator set</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42976</td>
<td>Workflow designer validation is by default disabled in JIRA 6.4</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42934</td>
<td>ReplicatedIndexOperation consumes massive space in JIRA data export</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42861</td>
<td>IndexRecoverLauncher can lock JIRA if index is corrupt</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42321</td>
<td>New priority icons are being attached to JIRA issues upon replies to issue created notifications</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38275</td>
<td>Newly Created Project Falls During Creation Causing Project Not Able to be Used or Deleted</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-36542</td>
<td>Editing Custom Fields’ check box selection</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-43134</td>
<td>Admin &gt; Add Link does nothing</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-43133</td>
<td>Translations missing in inline issue create</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42897</td>
<td>Update 6.4 Stable to bundle Service Desk 2.3.5</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40607</td>
<td>JIRA can't handle ‘-v’ in usernames</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40192</td>
<td>JIRA's email FROM field is sending from a wrong address</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-28444</td>
<td>“Add a comment from a non quoted email body” does not set the Strip Quotes to be TRUE</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

14 issues
JIRA 6.4.3 Upgrade Notes

Upgrading from JIRA 6.4.x to 6.4.3

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.3.x and earlier

In addition to the above, please read the JIRA 6.4 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.4.4 Release Notes

12 May 2015
The Atlassian JIRA team announces the release of JIRA 6.4.4. This point release contains several updates and fixes.

Upgrading to JIRA 6.4.4 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.4 yet?
Take a look at all the new features in the JIRA 6.4 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.4.4 Upgrade Notes.

Updates and fixes in this release

JIRA 6.4.4 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-43340</td>
<td>Setup soy templates included on every page</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-43343</td>
<td>Second tip from project sidebar help can't be dismissed</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-43224</td>
<td>Update 6.4 Stable to bundle Issue Nav Components 6.5.5</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-43061</td>
<td>&quot;Show more&quot; link does not work in &quot;Two Dimensional Filter Statistics&quot; gadget</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-43033</td>
<td>Import data from Fogbugz wrongly creates a &quot;Computer&quot; custom field</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42946</td>
<td>Filter Results gadget's column configuration is lost after upgrade</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42928</td>
<td>Unable to manage watchers from the Service Desk Queue in JIRA 6.4.1</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42768</td>
<td>&quot;Watchers&quot; frame sometimes not displayed</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42660</td>
<td>Activity Stream Throws No Activity Was Found Message Consistently</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42639</td>
<td>Instant setup wizard renders successful setup statuses when JIRA gets locked</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42420</td>
<td>Import CSV field &quot;Original Estimate&quot; does not import</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-41318</td>
<td>PermissionQueryFactory can cause performance issues when JIRA's caches are cold</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40872</td>
<td>Unable to Import Project from Bitbucket</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40377</td>
<td>Issuetype Avatar not shown in email notification</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39970</td>
<td>Jira needs to check the collation of the DB before it starts</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

15 issues

JIRA 6.4.4 Upgrade Notes
Upgrading from JIRA 6.4.x to 6.4.4

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.3.x and earlier

In addition to the above, please read the JIRA 6.4 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3 Release Notes

Accelerate your teams

JIRA 6.3 helps your teams work more effectively and efficiently

In JIRA 6.3, we’ve introduced several key concepts and features to ensure that this version of JIRA is the most robust and efficient yet. With JIRA Data Center, we have improved availability for mission critical instances. Our Github importer, inline version and component creation, and auditing options make JIRA easier to administer. And your teams will be more productive with features like inline issue creation and streamlined user interface.

We’re still working on further JIRA integration with your favorite Atlassian coding tools, and further improvements to your team’s visibility and control of their code is coming soon! Watch this page....

High availability now available with JIRA Data Center

We’ve built upon all the features that make JIRA great for your business at scale and created a new offering specifically for organizations that require high availability for mission critical JIRA instances. These features are enabled through the clustering capability in JIRA Data Center 6.3:

- High availability - Active-active clustering of JIRA means minimal downtime for your teams. In addition, replication of the index across each node means that you’re safe from data loss due to corruption
- Scalability - It’s easy to scale your JIRA environment as your business grows; simply add another node to maintain the performance required by your business
- Performance - You can use any form of load-balancing technology – hardware or software – to intelligently distribute load across your Data Center cluster

You can access these features in JIRA 6.3 by purchasing a JIRA Data Center license. Read more about JIRA Data Center here...
Create issues in the moment...

Sitting in a planning meeting and want to create an issue in the moment? Easy! With inline issue creation and JIRA Agile, you can now create an issue from within your Scrum board during planning. Simply click on the Create issue link, select the issue type and enter a brief summary, then hit the Create issue button. The issue is created and automatically added to your backlog. It couldn't be simpler!

Learn more...

'On the fly' version and component creation

Project administrators can now add versions and components from within the Fix Version/s, Affected Version/s and Component/s fields. Previously, project administrators needed to add a version or component via the appropriate screen on the project's administration page. Now, project administrators are able to create a version or component by typing it in the appropriate field, and selecting it from the drop-down list. When you begin typing text that JIRA does not recognize as existing, it will add it to the bottom of the drop-down list and add (New Version) or (New Component). Selecting the new version or component will automatically create it within your project for future use.
Enhanced auditing capabilities

We first introduced the **audit log** in JIRA 6.1 late last year. In this release, we’ve added some new features to the audit log to make it more efficient and easier to use:

- When a role is removed (deleted) from JIRA, previously the audit log would log an event for every project that it was removed from. Now, the audit log will only log the event that the role has been removed from JIRA.
- We have given administrators the option to hide logged events from external user directories, such as LDAP and Crowd. These events are still recorded, just hidden from view, and are still available for export and through the REST API.

Increased data import options

The newly released GitHub importer allows you to connect to your GitHub account, regardless of whether it’s a private or enterprise account, and import any public, private or starred repository configurations into JIRA. You can map the GitHub labels to issue types, to resolutions, or import them as JIRA labels. The import process supports importing attachments, and also provides you with a detailed log of your import so that you can troubleshoot any issues.

Learn more...
And more!

Of course, that's not all we've done in this release! We've been working hard to improve the user experience, and to make sure that whatever Atlassian product you use, you recognize that great Atlassian "feel".

Click here to read more about JIRA 6.3 features..

- **Consistency across products** - To further align JIRA with our other products, we've changed the Create issue button to simply Create and the Quick Search bar to Search.
- **Transition permission** - JIRA now has a new Transition Issues project permission that gives administrators more control over what users can do in JIRA.
- **HTML5 Attachment support** - JIRA now supports image capture and attachment using HTML5 in supported browsers.
- **Updates to Admin screen** - We've made some minor changes to the location of some of the JIRA administration features. The functionality of the features hasn't changed, but we believe their new location will make them more intuitive to find.

Click here to see what features we've moved, and where to!

<table>
<thead>
<tr>
<th>Feature</th>
<th>Now located in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roles administration console</td>
<td>System tab in a new &quot;Security&quot; section</td>
</tr>
<tr>
<td>Global permissions administration console</td>
<td>System tab in a new &quot;Security&quot; section</td>
</tr>
<tr>
<td>Default user preferences administration console</td>
<td>System tab in the &quot;User interface&quot; section</td>
</tr>
<tr>
<td>Shared filters administration console</td>
<td>System tab in a new &quot;User-created assets&quot; section</td>
</tr>
<tr>
<td>Shared dashboards administration console</td>
<td>System tab in a new &quot;User-created assets&quot; section</td>
</tr>
</tbody>
</table>

Click here to read an important end of support announcement...

Atlassian will stop releasing WAR distribution of JIRA in JIRA 7.0. Please see End of Support Announcements for JIRA for a full list of end of support announcements.

The JIRA 6.3 team

**Development**

Adam Jakubowski
Aleksander Mierzwicki
Andreas Knecht
Andrew Swan
Antoine Büsch
Arkadiusz Gowacki
Ben Sayers
Ben Wong
Brad Baker
Bradley Ayers
Brenden Bain
Brydie McCoy
Charles O'Farrell
Chris Darroch
Chris Doble
Trevor Campbell
Wojciech Urbanski
Zehua Liu

Sydney Support
Bejoy Jaison
Chung Park Chan
Daniel Watania
David Currie
David Mason
Matthew Hunter
Mauro Badii
Melissa Klingler
Michael Andreacchio
Nick Mason
Paul Greig

Amsterdam Support
Alex Conde
Bastiaan Jansen
Dora Wierzbicka
Ivan Maduro
Mick Nassette
Miranda Rawson
Peter Koczan
Ruchi Tandon
Shannon Mackie
Theodore Tzidamis
Yilin Mo

Brazil Support
Andre Quadros Petry
Benito Picarelli
Bruno Rosa
Clarissa Gauterio
Danilo Conrad
Eric Kieling
Felipe Willig
Jorge Dias
Lucas Lima
Luciano Fagundes
Marcus Silveira
Matheus Fernandes
Ricardo Carracedo
Pedro Cora
Pedro Souza
Pietro Schaff
Tiago Kolling Comasseto

Kuala Lumpur Support
Ahmad Danial
Ahmad Faisal
Ala Al-Shargabi
Anna Monica Cardino
Azwandi Mohd Aris
Daryl Chuah
Daniel Leng
Immanuel Siagian
Janet Albion
Joe Wai Tye
John Chin Kim Loong
Julian Rahmadiputra
Kumar Ramajillu
Muhammad Fahd
Razaq Omar
Richie Gee
Taiwo Akindele
Vicky Kharisma
Viet Dung Nguyen
Voon Kiat Gan
Yew Teck En
Zulfadli Noor Sazali

San Francisco Support
Boris Berenberg
David Chan
David Maye
David Nicholson
Earl McCutcheon
Gary Sackett
Ivan Tse
James Giles
Jason Worley
Jeff Curry
John Garcia
Jordan Robison
Justin Burke
Kyler Johnson
Mary Avalos
Michael Thai
Osman Afridi
Pelle Kirkeby
Rick Bal
Thomas Garske
Tim Evans
Turner Benard

General Manager

Bryan J. Rollins

Product Management
Anu Bharadwaj
Bartek Gatz
Iwona Stankiewicz
Jason Wong
Josh Devenny
Martin Jopson
Megan Cook
Roy Krishna
Tom Kotecki

Product Marketing Management
Caroline Nyce
Dan Radigan
Jake Brereton
Aileen Horgan
Angela Blair
Ken Olofsen

Program Manager
Simone Houghton

Head of Development
Paul Slade
JIRA 6.3.15 Release Notes

3 February 2015
The Atlassian JIRA team announces the release of JIRA 6.3.15. This point release contains several updates and fixes. We’re particularly happy to announce that from this release, when you create a new issue and check “Create another”, the custom field values you entered will be retained for the next issue you create. When you close the Create issue dialog, the custom values will be reset. This resolves [JIRA-39981](#) - Custom fields not pre-populated after creating an issue with the ‘create another’ option

Upgrading to JIRA 6.3.15 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.3 yet?
Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA
If you are upgrading, please read the JIRA 6.3.15 Upgrade Notes.

Updates and fixes in this release
JIRA 6.3.15 includes the following updates and bug fixes:
### JIRA 6.4 Documentation

### JIRA 6.3.15 Upgrade Notes

**Upgrading from JIRA 6.3.x to 6.3.15**

Please follow the instructions in the [general upgrading JIRA documentation](#).

**Upgrading from JIRA 6.2.x and earlier**

In addition to the above, please read the [JIRA 6.3 Upgrade Notes](#) and as well as [Skipping Major Versions When Upgrading JIRA](#) if you are skipping any major JIRA versions.

**JIRA 6.3.14 Release Notes**

**20 January 2015**

The Atlassian JIRA team announces the release of JIRA 6.3.14. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.14 is free to all customers with active JIRA software maintenance.

**Don’t have JIRA 6.3 yet?**

Take a look at all the new features in the [JIRA 6.3 Release Notes](#) and see what you are missing out on!

[Download latest version](#)

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the [JIRA 6.3.14 Upgrade Notes](#).

**Updates and fixes in this release**

JIRA 6.3.14 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-41578</td>
<td>JIRA Agile and Service Desk pages constantly refresh for users with space in a username</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-41517</td>
<td>JIRA Agile Getting Started keeps refreshing when username contains special characters</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40989</td>
<td>Gadgets such as “Issue Statistics” and “Pie Chart” handle “Irrelevant” or “None” issue results extremely poorly which can easily result in “Out of Memory” and JIRA application failure requiring restart</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.4 Documentation

11 issues

JIRA 6.3.14 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.14

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.13 Release Notes

07 January 2015
The Atlassian JIRA team announces the release of JIRA 6.3.13. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.13 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.13 Upgrade Notes.

Known Issue with Usernames containing spaces

We do not recommend upgrading to JIRA 6.3.13 for customers using Service Desk or JIRA Agile which are having Usernames with spaces. Please refer to this issue JRA-41578 - JIRA Agile and Service Desk pages constantly refresh for users with space in a username for upcoming fix information.

Updates and fixes in this release

JIRA 6.3.13 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JIRA-41046</td>
<td>Logging work sends email even if not configured in notification scheme</td>
<td>↑</td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40785</td>
<td>Search may not return all results if number of results is small and index size is large</td>
<td>↑</td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40379</td>
<td>JIRA Evaluation licenses from my.atlassian.com do not work for datacenter</td>
<td>↑</td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-41187</td>
<td>Spelling on Bulk Transition is incorrect</td>
<td>↓</td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA 6.3.13 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.13

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.12 Release Notes

09 December 2014

The Atlassian JIRA team announces the release of JIRA 6.3.12. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.12 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.12 Upgrade Notes.

Updates and fixes in this release

JIRA 6.3.12 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-40793</td>
<td>&quot;Content injection&quot; issue in gadgets</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-40262</td>
<td>java.lang.NoSuchMethodError exception when accessing Sidebar Dark Feature in JIRA Agile</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-39131</td>
<td>Cannot generate license during JIRA setup on Safari and Firefox</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-37905</td>
<td>Activity stream in the user profile times out easily on larger instances</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-29105</td>
<td>Single Level Group By Report does not display headline correctly if grouped by status</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-27779</td>
<td>LDAP sync problems when &quot;ldap.roles.disabled&quot; is to &quot;false&quot;</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-41124</td>
<td>Two Dimensional Filter - Totals not clickable if irrelevant issues are found.</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-40713</td>
<td>Unable to click Status to filter in gadgets (two dimensional filter, issue statistics etc)</td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA 6.3.12 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.12

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.11 Release Notes

25 November 2014

The Atlassian JIRA team is proud to announce the release of JIRA 6.3.11. This point release contains several updates and fixes, and we've also included a new feature to assist in our current drive for development tool integration.

Highlights

"Deduping" of branch creation events for JIRA workflow triggers

Previously, JIRA workflow triggers would transition issues incorrectly, if duplicate branch creation events were sent (duplicate branch creation events are often caused by having a repository indexed by multiple development tools). To ensure accurate issue transitions, you would need to suppress events in selected repositories in Stash and/or FishEye.

In this release, JIRA will remove duplicate branch creation events ("deduping") when processing workflow triggers. The deduping is done by comparing branch names. This makes it much simpler for you to configure workflow triggers, as you don't need to figure out which repositories need to have their events suppressed.

Note, if you don't want JIRA to remove duplicate branch creation events, you can disable deduping: see this knowledge base article. Also, please note that as a result of this improvement, we will be removing the 'JIRA workflow triggers' configuration options from FishEye and Stash in future versions of these products. Keep an eye on the Stash release notes and FishEye release notes for updates.

Upgrading to JIRA 6.3.11 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.11 Upgrade Notes.
## Updates and fixes in this release

JIRA 6.3.11 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-40757</td>
<td>JIRA upgrade fails when DB contains rows in QuartzScheduledJobDetails, FATAL upgrade failure with SQLException ... from com.atlassian.jira.upgrade.tasks.UpgradeTask_Build6302</td>
</tr>
<tr>
<td></td>
<td>JRA-37385</td>
<td>Bamboo application does not show on Bamboo Configuration page</td>
</tr>
<tr>
<td></td>
<td>JRA-40651</td>
<td>Update 6.3 Stable to bundle Service Desk 2.1</td>
</tr>
<tr>
<td></td>
<td>JRA-40633</td>
<td>Error when comment contains N-1 characters and a newline and character limit is set to N</td>
</tr>
<tr>
<td></td>
<td>JRA-40191</td>
<td>Updating 2LO and 2LOi flags on incoming authentication does not update corresponding outgoing authentication on opposite site of link and vice versa</td>
</tr>
<tr>
<td></td>
<td>JRA-39801</td>
<td>Please amend the tooltip text for the &quot;permalink&quot; icon in JIRA to something that it actually does</td>
</tr>
<tr>
<td></td>
<td>JRA-38999</td>
<td>Attach screenshot form contains hard-coded English strings</td>
</tr>
<tr>
<td></td>
<td>JRA-36605</td>
<td>When unfavouriting an issue filter that you're currently using, it disappears!</td>
</tr>
</tbody>
</table>

8 issues

### JIRA 6.3.11 Upgrade Notes

**Upgrading from JIRA 6.3.x to 6.3.11**

Please follow the instructions in the general upgrading JIRA documentation.

**Upgrading from JIRA 6.2.x and earlier**

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

### JIRA 6.3.10 Release Notes

**11 November 2014**

The Atlassian JIRA team announces the release of JIRA 6.3.10. This point release contains several updates and fixes. We're also pleased to announce that we've resolved JRA-29328 - Editing Assignee should trigger 'Issue Assigned' event so that JIRA will now trigger an Issue Assigned event whenever an issue is assigned or reassigned. This particular issue has been live since August 2012, and has been voted for 157 times.

Upgrading to JIRA 6.3.10 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 6.3 yet?**

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

### Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.10 Upgrade Notes.

### Updates and fixes in this release

JIRA 6.3.10 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-39677</td>
<td>JIRA leaks database connections while indexing</td>
</tr>
<tr>
<td></td>
<td>JRA-40539</td>
<td>Not able to disabled a plugin V1</td>
</tr>
<tr>
<td></td>
<td>JRA-29328</td>
<td>Editing Assignee should trigger 'Issue Assigned' event</td>
</tr>
</tbody>
</table>
9 issues

JIRA 6.3.10 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.10

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.9 Release Notes

28 October 2014

The Atlassian JIRA team announces the release of JIRA 6.3.9. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.9 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.9 Upgrade Notes.

Updates and fixes in this release

JIRA 6.3.9 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-40583</td>
<td>JIRA together with the issue search plugin is leaking lucene file descriptors</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40310</td>
<td>Changing assignees in transition screen is taking into account the permission property of the CURRENT status, not the DESTINATION status</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40269</td>
<td>Manually triggering a user directory synchronization breaks subsequent synchronizations</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40092</td>
<td>Content Spoofing in the /issues/?filter</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40088</td>
<td>WorkflowTransitionUtilImpl doesn't always use user set by setUsername/setUserKey</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40069</td>
<td>HipChat configuration page returns error 500 if create issue transition has HipChat post function</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40934</td>
<td>Problem dragging more than one file at once to be attached</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40430</td>
<td>Refresh option on Issue Navigator missing</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40307</td>
<td>Project Re-Indexing incorrectly removes index warning.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40297</td>
<td>NPE in Upgrade task of JIRA-34394: Vulnerable to data corruption</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.3.9 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.9

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.8 Release Notes

13 October 2014

The Atlassian JIRA team announces the release of JIRA 6.3.8. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.8 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

13 issues

JIRA 6.3.9 Documentation

RESOLVED JRA-38905 Issue navigator refresh button missing in list view (only available from the bottom of the list)

RESOLVED JRA-33870 No dirty form warning for quick create when refreshing page

RESOLVED JRA-27644 Outgoing mail: Read timed out results in duplicate notifications

Highlight

Re-designed Statuses page

The Status administration page has been streamlined and is now much easier to read and use. As an added bonus, we’ve implemented a highly-voted feature request: the ability to define the order of statuses (JRA-5189).

Go to Issues > Statuses in your administration console to try it out.

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.8 Upgrade Notes.

Updates and fixes in this release

Download latest version

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA 6.3.8 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JIRA-5189</td>
<td>Define status order</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40219</td>
<td>Excessive locking in lucene threads can lead to scalability problems in high concurrency environments</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40154</td>
<td>JIRA health check leaks a Lucene index</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40225</td>
<td>OutOfMemoryError / Huge Memory Requirements by the JIRA Inline Issue Create Plugin</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-32607</td>
<td>Bulk Edit Out Of Memory Exception</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40398</td>
<td>Cannot migrate from JIRA Cloud 6.4 to 6.3.7 Server</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40138</td>
<td>Import issues from CSV should require Bulk Change permission</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40124</td>
<td>Assignable Users are no longer assignable for an issue if they don't belong to the Issue Security Level permissions</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40042</td>
<td>Warranty - Import issues from CSV feature redirects non-admin users to the login page</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40585</td>
<td>Assignable Users are not assignable for an issue if they don't belong to the Issue Security Level permissions</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40244</td>
<td>Index stops functioning because org.apache.lucene.store.AlreadyClosedException is not handled correctly</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40117</td>
<td>CachingFieldConfigContextPersister exhibits performance problems</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40108</td>
<td>com.google.template.soy.tofu.SoyTofuException: In template JIRA.Templates.Auditing.recordsPage: In 'print' tag, expression &quot;$records&quot; evaluates to undefined.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-40000</td>
<td>Mail handler behavior on complete/incomplete attachment processed</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-39998</td>
<td>Atlassian Analytics should not download any whitelists/blacklists unless analytics is enabled</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-39873</td>
<td>Workflow Sharing Plugin does not export associated screen and custom field</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-39787</td>
<td>&quot;The workflow designer may not behave correctly&quot; error cannot be closed</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-39012</td>
<td>Setup Wizard layout is broken in languages different than English</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-31120</td>
<td>JIRA admin helper refers to all users as &quot;him&quot; when talking about groups</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

19 issues

JIRA 6.3.8 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.8

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.7 Release Notes

30 September 2014

The Atlassian JIRA team announces the release of JIRA 6.3.7. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.7 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA
If you are upgrading, please read the JIRA 6.3.7 Upgrade Notes.

Updates and fixes in this release

JIRA 6.3.7 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-40105</td>
<td>Application Navigator js error prevents all handlers after that from running</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39836</td>
<td>BlobStore plugin dark features in OnDemand causes Attachments to display a 500 error in JIRA when migrating from OD to Server</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39467</td>
<td>Issue indexing is very slow when JIRA Agile 6.4.3 or higher is installed on Oracle database</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40079</td>
<td>Javascript error in Agile boards when Application Navigator has links in it</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39975</td>
<td>Complete legal and licensing notices not found in the licenses directory</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-35138</td>
<td>Duplicate issues created by mail handler on arbitrary exceptions</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-29558</td>
<td>Media files not rendering</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-28051</td>
<td>Customised priority description is not displayed in the priority help window if the priority name is not customised</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39895</td>
<td>Update 6.3 Stable to bundle Service Desk 2.0.2</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39676</td>
<td>JIRA throws &quot;java.lang.IllegalArgumentException: Illegal group reference&quot; when database saves value with &quot;$&quot; sign</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39669</td>
<td>Space at end of username entered during setup causes 500</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39426</td>
<td>Attachments field is cleared out on project/issue type switching</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39389</td>
<td>Workflow designer is slow to respond in a workflow with large number of transitions</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-25209</td>
<td>JIRA displays an erroneous error message when user votes</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-22873</td>
<td>Hardcoded English text in custom fields code</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

15 issues

JIRA 6.3.7 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.7

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.6 Release Notes

16 September 2014
The Atlassian JIRA team announces the release of JIRA 6.3.6. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.6 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.6 Upgrade Notes.
Updates and fixes in this release

JIRA 6.3.6 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-39307</td>
<td>Show minimum required privileges on login screen</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-39902</td>
<td>Migrating data from JIRA Cloud to JIRA Server will not work if data set has issue properties</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-42552</td>
<td>Unable to link JIRA issue to Confluence page (500 Internal Server Error)</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39940</td>
<td>Fix concurrency issue in bulk edit</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39769</td>
<td>JIRA leaks DB connections</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-40046</td>
<td>Jira performs JQL search while opening any issue from last search</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39764</td>
<td>jiraissue.reporter needs to be indexed</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39264</td>
<td>Unable to link JIRA issue to Confluence page (500 Internal Server Error)</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38407</td>
<td>Permissions based on Customfields do not work in all cases</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-32546</td>
<td>Bulk operation with over 300 issues time out and display Down for Maintenance page while is still running in the background</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-24051</td>
<td>Deleting a user does not remove the user from its LDAP group</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39717</td>
<td>The JIRA Credits page still shows JIRA 6.0</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39612</td>
<td>Changing issue security scheme causes timeout in ondemand</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-35996</td>
<td>Duplicate items added to Application Navigator menu through application links</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33035</td>
<td>Workflow properties on JIRA permission allow unassignable users to be assigned</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-27280</td>
<td>External user management option is on and users are still able to change their own passwords</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

17 issues

JIRA 6.3.6 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.6

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.5 Release Notes

09 September 2014

The Atlassian JIRA team announces the release of JIRA 6.3.5. This point release contains several updates and fixes. We’re also pleased to announce that for our users who integrate JIRA with HipChat, we’ve added a new page to the Administration section which allows easier configuration of HipChat notifications.

Upgrading to JIRA 6.3.5 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!
Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.5 Upgrade Notes.

Updates and fixes in this release

JIRA 6.3.5 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-39747</td>
<td>Upgrade JIRA 6.3-stable to UPM/PIP 2.17.13</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39736</td>
<td>Edit and Remove links on HipChat Notifications page point to the wrong workflow transition</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39723</td>
<td>Upgrade JIRA 6.3-stable to UPM/PIP 2.17.12</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39544</td>
<td>NPE in Upgrade task of JIRA-34394: Watch count gets out of sync when cloning issues</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39477</td>
<td>Import issues from CSV requires add-on update</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39444</td>
<td>A javascript error occurs on the view issue page and the helptip for Automatic Issue Transitioning is not shown</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33781</td>
<td>java.lang.IllegalArgumentException: No event type with id 17</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-26458</td>
<td>Synchronization of users that are added to a particular AD group that is configured to automatically become JIRA users doesn't work after the initial synch</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39687</td>
<td>Unable to create issues using mail handler when custom fields are not configured for any context</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39667</td>
<td>HipChat room picker doesn't load</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39635</td>
<td>Attach a screenshot is not working when launching from JIRA Agile</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39609</td>
<td>Update HipChat for JIRA plugin to 1.3.2</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39547</td>
<td>Upgrade JIRA 6.3-stable to UPM/PIP 2.17.10</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39532</td>
<td>In a Clustered JIRA ProjectImportResultsImpl is not serializable and causes NotSerializableExceptions when the task cache is replicated.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39526</td>
<td>JIRA 6.3.3 using bin installer throws Failed to deep scan error message during plugin system startup</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39363</td>
<td>Cannot filter by version picker custom field for more than one project</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39279</td>
<td>XSS using WebFragmentBuilder for WebItemProvider</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39101</td>
<td>Attach Screenshot not working in JIRA OnDemand (but it did before!) from Agile board (but works from open ticket)</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38693</td>
<td>Incorrect error message for filename errors for Attach Screenshot</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38160</td>
<td>screenshot applet does not cache-bust properly</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

Showing 20 out of 24 issues

JIRA 6.3.5 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.5

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3.3 Release Notes

Deep integration like never before

JIRA 6.3.3 now integrates deeper with your favorite code development tools

With JIRA 6.1, we started a journey to help your developers visualize not just their issues, but all their work; their branches, their commits, and their reviews. We've now added the ability to link issue workflow and your
development tools, giving increased visibility and allowing JIRA to automatically update issues as the work progresses.

But that's not all we've added in JIRA 6.3.3. We're still committed to improving efficiency and speed in JIRA, and we've added and improved features that'll allow you to be more productive. Download and say hello to faster, smarter development with JIRA 6.3.3 today.

**Workflow triggers**

JIRA’s workflow engine is now source-code aware, so you can focus on the real work while JIRA automatically updates issues for you.

Instead of having JIRA issue statuses lagging behind, and the team not knowing the true state of the project, JIRA administrators can now configure triggers in JIRA workflows that respond to events in your linked development tools. For example, when a developer creates a branch to start work on an issue in Stash, the issue will automatically be transitioned from 'Open' to 'In progress' in JIRA.

JIRA responds to events in Stash, Bitbucket, FishEye and Crucible, as well as GitHub and GitHub:Enterprise.

Currently available events include:

- Branch created
- Commit created
- Pull request created, merged, declined and reopened
- Review started, summarised, approved, rejected, abandoned, closed

Learn more...
Users can create issues in bulk

Previously, creating issues in bulk was only available to JIRA administrators. Now, we’ve given users the power and flexibility to not only import data to create issues in bulk, but to also edit issues in bulk via a Comma-Separated Value (CSV) file import. This gives users the ability to create and edit issues using files in a CSV format, as well as using exported CSV data from a variety of systems and databases.

Making sure JIRA users can create issues in bulk

The JIRA Importers plugin allows JIRA users to create issues in bulk. The JIRA Importers plugin must be version 6.2.3 or above for this functionality to be available. To manually upgrade the JIRA Importers plugin, please follow the steps detailed on [JIRA-39477](https://jira.apache.org/jira/browse/JIRA-39477) - Import Issues from CSV requires add-on update **RESOLVED**.
**Inline image rendering**

In our continued drive towards a more robust and efficient product, we’ve improved the way JIRA renders charts, removing the need to store temporary files on your system. Previously, JIRA would save a chart image in a temporary file on your system which it would then fetch to display in gadgets and reports. If for any reason the process was aborted, the partially rendered image remained in the temporary file. This could cause your temporary files to bloat, and in turn this would affect performance. By implementing a new method to render these images inline within the gadget or report, we’ve not only removed the need to store a temporary file for the image, but also streamlined the process by removing the need to make an additional request by JIRA. Working smarter means working faster.

![Created vs Resolved Chart: JIRA](image)

**Improved searching performance**

We’ve implemented a change in the behaviour of searching. When querying large numbers of projects and issues with custom fields, JIRA previously had to decide what custom fields should be returned, and how. This process could take quite a long time, and searches were slow. Now, JIRA... will return columns for all the custom fields available, even if there are no values on those given issues. This has improved search performance dramatically, and solved

---

**JRA-25721** - Large number of projects and customfields causes performance degradation on the issue navigator

---
**JIRA Data Center Health Checks**

New for JIRA Data Center is a robust set of health checks so you can easily check the status and health of your enterprise JIRA instance. You can access the health checks in the Atlassian Support Tools section of your instance administration.

**Known Issue with SQL Server**

We do not recommend that customers running JIRA with SQL Server 2005/2008/2012 upgrade to JIRA 6.3.3. Please watch this issue [JIRA-39495](#) for workaround and upcoming fix information.

**And more!**

- JIRA 6.3 announced support for Java 8, and with JIRA 6.3.3 we have updated our embedded Java Runtime Environment (JRE) from 1.7 to 1.8 in our installers.
- Please review the End of Support Announcements for JIRA page for information about upcoming changes in JIRA 7.0.
- JIRA 6.3.3 also includes the following update and bug fixes.

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-38789</td>
<td>Investigate browse project issue in cluster performance tests: &quot;tabHtml&quot; undefined in soy template</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-9367</td>
<td>Custom Fields Visibility in the Issue Navigator</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-38884</td>
<td>Remote DoS Exploit on JIRA</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39114</td>
<td>JIRA leaks open files after reindex'ing</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38785</td>
<td>Background re-index does not take a (read) lock on the index and this allows a foreground re-index to start while the background re-index is still running.</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

Showing 5 out of 60 issues

The JIRA team
Development

Adam Jakubowski
Aleksander Mierzwicki
Alex Rantos
Andreas Knecht
Andrew Swan
Antoine Büsch
Arkadiusz Gowacki
Ben Sayers
Ben Wong
Brad Baker
Bradley Ayers
Brenden Bain
Brydie McCoy
Carlos Khatchikian
Charles O’Farrell
Chris Darroch
Chris Doble
Chris Fuller
Christopher Nortje
Chris Mountford
Dariusz Kordonski
David Tang
Eduardo Soares
Edward Zhang
Eric Dalgliesh
Eric Sukmajay
Filip Rogaczewski
Gareth Williams
Gilmore Davidson
Graham Carrick
Grzegorz Taczyk
Ian Dick
Ian Grunert
Ignat Alexeyenko
Ivo Bosticky
Jaiden Ashmore
Jaime Sanchez
James Hatherly
James Hazelwood
James Winters
Jaime Sanchez
Jason Sheehy
Jeroen De Raedt
Jeshua Morrissey
Jimmy Kurniawan
Jonathan Raoult
Jonathon Creeneaune
Joshua Ali
Julius Hocman
Kayne Barclay
Krystian Brazulewicz
Luis Miranda
Lukasz Wlodarczyk
ukasz Pater
Maciej Nowakowski
Maciej Opala
Marcin Gardias
Markus Kramer
Martin Meinhold
Matt Harrison
Michael Elias
Michael Tokar
Michal Orzechowski
Mike Sharp
Miroslav Stencel
Nikolay Petrov
Norman Atashbar
Oliver Wessels
Oswaldo Hernandez
Patrick Teen
Pawel Bugalski
Pawel Niewiadomski
Pawel Skierczynski
Przemek Borkowski
Richard Cordova
Robert Smart
Roman Tekhov
Sean Curtis
Sergio Cinos
Stanislav Dvorscak
Sunny Kalsi
Symphony Wong
Trevor Campbell
Wojciech Urbanski
Zehua Liu

**Sydney Support**
Bejoy Jaison
Chung Park Chan
Daniel Watania
David Currie
David Mason
Matthew Hunter
Mauro Badii
Melissa Klingler
Michael Andreacchio
Nick Mason
Paul Greig

**Amsterdam Support**
Alex Conde
Bastiaan Jansen
Dora Wierzbicka
Ivan Maduro
Mick Nassette
Miranda Rawson
Peter Koczan
Ruchi Tandon
Shannon Mackie
Theodore Tzidamis
Yilin Mo

**Brazil Support**
Andre Quadros Petry
Benito Picarelli
Bruno Rosa
Clarissa Gauterio
Danilo Conrad
Diego Zarpelon
Eric Kieling
Felipe Willig
Jorge Dias
Luciano Fagundes
Marcus Silveira
Matheus Fernandes
Pedro Cora
Pedro Souza
Pietro Schaff

Kuala Lumpur Support
Ahmad Danial
Ahmad Faisal
Ala Al-Shargabi
Anna Monica Cardino
Azwandi Mohd Aris
Daryl Chuah
Daniel Leng
Immanuel Siagian
Janet Albion
Joe Wai Tye
John Chin Kim Loong
Julian Rahmadiputra
Kumar Ramajillu
Muhammad Fahd
Razaq Omar
Richie Gee
Taiwo Akindele
Vicky Kharisma
Viet Dung Nguyen
Voon Kiat Gan
Yew Teck En
Zulfadli Noor Sazali

San Francisco Support
Boris Berenberg
David Chan
David Maye
David Nicholson
Earl McCutcheon
Gary Sackett
Ivan Tse
James Giles
Jason Worley
Jeff Curry
John Garcia
Jordan Robison
Justin Burke
Kyler Johnson
Mary Avalos
Michael Thai
Osman Afridi
Pelle Kirkeby
Rick Bal
Thomas Garske
Tim Evans
Turner Benard
General Manager
Bryan J. Rollins

Product Management
Anu Bharadwaj
Bartek Gatz
Iwona Stankiewicz
Jason Wong
Josh Devenny

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA 6.3.3 Upgrade Notes

Please follow the instructions in the general Upgrading JIRA guide, as well as the JIRA 6.3.3-specific instructions below. The general guide contains important tasks that are essential for getting your upgraded JIRA installation to work correctly and, if necessary, migrating existing configurations.

This page also describes known issues as well as changes you should be aware of before deciding whether or
not to upgrade to JIRA 6.3.3.

On this page:

- Known Issue with SQL Server
- Information for JIRA developers
- Upgrading to JIRA 6.3.3 from JIRA 6.2.x
- Upgrading to JIRA 6.3.3 from JIRA 6.0.8 or earlier

Known Issue with SQL Server

We do not recommend that customers running JIRA with SQL Server 2005/2008/2012 upgrade to JIRA 6.3.3. Please watch this issue

JIRA-39495 - DVCS Connector failed with SQLException: Incorrect syntax near the keyword 'MERGE' RESOLVED for workaround and upcoming fix information.

Information for JIRA developers

See Preparing for 6.3 (this information is the same for JIRA 6.3.3) for important information that could affect your add-ons or scripts. Also, see our Java API policy for JIRA.

Upgrading to JIRA 6.3.3 from JIRA 6.2.x

- End of support for Internet Explorer 8 and PostGres 8.3
- Supported Platforms

End of support for Internet Explorer 8 and PostGres 8.3

JIRA 6.3.3 does not support Internet Explorer 8 (IE8) or PostGres 8.3. For more information, please see this page.

Supported Platforms

JIRA 6.3.3 had added support for Java 8, Microsoft SQL 2012, and PostGres 9.0 - 9.3. For more information, please see this page.

Upgrading to JIRA 6.3.3 from JIRA 6.0.8 or earlier

In addition to the points listed above, please read the Important Version-Specific Upgrade Notes for every version of JIRA you are skipping.

Note, you cannot upgrade from JIRA 4.3.x or earlier, directly to JIRA 6.3.3. You must upgrade to an interim version first. See Skipping Major Versions When Upgrading JIRA.

JIRA 6.3.4 Release Notes

19 August 2014

The Atlassian JIRA team announces the release of JIRA 6.3.4. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.4 is free to all customers with active JIRA software maintenance.

Making sure JIRA users can create issues via a CSV import

The JIRA Importers plugin allows JIRA users to create issues in bulk. The JIRA Importers plugin must be version 6.2.3 or above for this functionality to be available. To manually upgrade the JIRA Importers plugin, please follow the steps detailed on

JIRA-39477 - Import Issues from CSV requires add-on update RESOLVED.

Don't have JIRA 6.3 yet?

Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

For customers using Windows

We previously released Windows installers for JIRA 6.3.4 (32bit and 64bit) that incorrectly configured the memory settings too low for JIRA to run. If you installed one of these versions, you can do one of the
Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.3.4 Upgrade Notes.

Updates and fixes in this release

JIRA 6.3.4 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-42123</td>
<td>Optimise the version cache in JIRA</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-39495</td>
<td>DVCS Connector failed with SQLException: Incorrect syntax near the keyword 'MERGE'</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39624</td>
<td>JIRA 6.3.4 installer sets Xmx to 256m</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39535</td>
<td>Null Pointer Exception - VersionStore/Caching Version Store</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39037</td>
<td>Subtask of Subtask from Jira API</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38636</td>
<td>Upgrade JIRA to the latest minor Tomcat (7.0.54+) to fix security vulnerabilities</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38148</td>
<td>DefaultUserManager.getAllUsersFromCrowd performs poorly when &gt; 1 crowd directory is active</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39192</td>
<td>REST API allows to get worklog from issue without access rights to that issue</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-36368</td>
<td>JQL Issue functions have major performance issues</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30942</td>
<td>Custom field context default value not updated in Create Issue Screen when changing Projects/Issue Type field</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-24298</td>
<td>Able To Create Issue Type With Name That Duplicates Other Issue Type's Name</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39515</td>
<td>Warranty - Remove Google Analytics code from JIRA Mobile</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39479</td>
<td>JIRA 6.3.3 slow to show an issue</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39301</td>
<td>Content injection caused by failing to encode the url</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39258</td>
<td>Upgrade Team Calendars integration plugin to version 1.1.1</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39150</td>
<td>&quot;VersionCreateEvent&quot; not firing when the &quot;on the fly&quot; creation feature is used</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39006</td>
<td>JIRA Importers Plugin (JIM) getting java.lang.NoClassDefFoundError</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-34812</td>
<td>Export to excel (current fields) does not show all columns present in the issue navigator</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30152</td>
<td>Inactive users still receiving emails from &quot;Send email&quot; function</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

19 issues

JIRA 6.3.4 Upgrade Notes

Upgrading from JIRA 6.3.x to 6.3.4

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.
JIRA 6.3.1 Release Notes

15 July 2014
The Atlassian JIRA team announces the release of JIRA 6.3.1. This point release contains several updates and fixes.

Upgrading to JIRA 6.3.1 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.3 yet?
Take a look at all the new features in the JIRA 6.3 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA
If you are upgrading, please read the JIRA 6.3.1 Upgrade Notes.

Updates and fixes in this release
JIRA 6.3.1 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-38884</td>
<td>Remote DoS Exploit on JIRA</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38667</td>
<td>statTypes REST API exposes all statistics field names anonymously</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38028</td>
<td>Processing malformed PNG by incoming mail handler causes OOM and blocks queue</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-31734</td>
<td>NPE error when moving issue with subtask in case target project has a different workflow for the subtask</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38613</td>
<td>As an admin, I'd like the ability to disable Google Analytics events entirely</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33686</td>
<td>Incompatibility with Spanish Latin America language in Chrome</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-31607</td>
<td>Null pointer exception when updating the preference in the user profile</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30046</td>
<td>JIRA REST API makes it easy to harvest email addresses</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-17312</td>
<td>The &quot;Move&quot; operation may produce subtasks with invalid empty values in target project</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39117</td>
<td>The Project list disappears after clicking on the scroll bar</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39043</td>
<td>JIRA VM Memory statistics shows invalid values on Java 8</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38998</td>
<td>Do not create a session when hitting the root of the webapp</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38985</td>
<td>Improve logging in the deadlock detector to include a link to the KB article detailing it</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38950</td>
<td>Upgrade jira to atlassian-gzip in version 1.21 for performance improvements</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38939</td>
<td>Bump crowd to 2.8.0-OD-6-JIRA-02 version</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38883</td>
<td>AbstractVersion manager is inefficient when checking version permissions</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38881</td>
<td>Change of undocumented behaviour causes NPE to be thrown in some plugins</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38777</td>
<td>JIRA requests for Project Avatars Using Different URLs and Requests all in a Single Page load for View Project</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38678</td>
<td>XSS in FilterSubscription</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38642</td>
<td>This warning message isn’t very accurate, and actually quite confusing</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

Showing 20 out of 28 issues

JIRA 6.3.1 Upgrade Notes

Upgrading from JIRA 6.3 to 6.3.1
Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.2.x and earlier

In addition to the above, please read the JIRA 6.3 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.3 Upgrade Notes

Please follow the instructions in the general Upgrading JIRA guide, as well as the JIRA 6.3-specific instructions below. The general guide contains important tasks that are essential for getting your upgraded JIRA installation to work correctly and, if necessary, migrating existing configurations.

This page also describes known issues as well as changes you should be aware of before deciding whether or not to upgrade to JIRA 6.3.

On this page:

- Information for JIRA developers
- Upgrading to JIRA 6.3 from JIRA 6.2.x
- Upgrading to JIRA 6.3 from JIRA 6.0.8 or earlier

Information for JIRA developers

See Preparing for 6.3 for important information that could affect your add-ons or scripts. Also, see our Java API policy for JIRA.

Upgrading to JIRA 6.3 from JIRA 6.2.x

- End of support for Internet Explorer 8 and PostGres 8.3

End of support for Internet Explorer 8 and PostGres 8.3

JIRA 6.3 does not support Internet Explorer 8 (IE8) or PostGres 8.3. For more information, please see this page.

Upgrading to JIRA 6.3 from JIRA 6.0.8 or earlier

In addition to the points listed above, please read the Important Version-Specific Upgrade Notes for every version of JIRA you are skipping.

Note, you cannot upgrade from JIRA 4.3.x or earlier, directly to JIRA 6.3. You must upgrade to an interim version first. See Skipping Major Versions When Upgrading JIRA.

JIRA 6.2 Release Notes

Visualize development

Unify issues and source like never before

In JIRA 6.1, we started the journey towards seamless integration with your coding tools. We’re continuing this in JIRA 6.2, by providing more code-related information in your issues, that you can assess and action. Create a branch, see commits and pull requests, watch builds, and more!

This release also includes an improved workflow designer, simpler issue type configuration, new status lozenges, auditing, and more!

JIRA 6.2 Upgrade Notes

25 February 2014

Download latest version

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
New code integration features for issues

The new Development panel, which is shown on every issue, helps you to evaluate the development status of an issue at a glance. If you need to investigate further, click any item to display more details, or drill down into the development tool.

Connect to one of these compatible applications to enable the following:

- Bitbucket or Stash: view and create branches, view commits, view and create pull requests
- FishEye/Crucible (Git/Subversion/Perforce/CVS): view branches, view commits, view and create reviews
- Bamboo: view the status of builds and deployments
- GitHub/GitHub Enterprise: view branches, view commits, view and create pull requests

Learn more: Integrating with a development tool and Using the Development panel
Enhanced workflow designer

The **workflow designer** is faster and easier to use in this release. We've added a range of new features and made the user interface cleaner and less cluttered. You can now click to create transitions, reuse existing transitions, zoom (with the 'all' key or the +/- controls), drag and drop to retarget the destination of a transition, and more!

In fact, the workflow designer can do everything that we supported in the old 'classic' workflow designer, so we've given the 'classic' designer a well earned retirement and removed it from JIRA.

Learn more...

Simple issue type configuration

We've simplified **issue type configuration** in this release. Don't hunt around in JIRA administration to find the workflow or screen for an issue type. The issue types associated with a project are now tabs on the project's administration screen.

This approach makes it easier to understand how your projects are set up. Each tab also provides access to the workflow designer and screen designer (JIRA administrators only), so you can configure an issue type without leaving the project.

Learn more...
New status lozenges

This release introduces new "lozenges" to represent statuses in JIRA. We've switched from the old icon+text representation to make it easier for users to locate and identify statuses. The new status lozenges also conform to the Atlassian Design Guidelines (ADG). This blog post explains the background behind this change.

We no longer support custom images for status icons. However, you will be able to configure statuses to use any one of the slick new status colors (categories) in JIRA.

Learn more...

Auditing

JIRA now tracks and records a range of configuration changes in an audit log. This can help you diagnose problems in JIRA or can be used for security purposes. Find out when a user was added or removed, when a workflow scheme was modified, and more. Note, auditing is disabled by default — you will need to enable it to start tracking changes in JIRA.

This is the initial release of auditing. We're still working on a number of improvements that you'll see in future JIRA releases.

Learn more...
And more!

Of course, there’s more! You can read about the other JIRA 6.2 features below. A noteworthy one is that the creator of an issue is now automatically recorded for every issue. This is particularly useful, if you need to know the creator of an issue for compliance reasons. The creator is distinct from the reporter (which can still be configured to be an optional field). On upgrade to this release, JIRA will set the creator to the appropriate reporter in the change history, for existing issues.

The creator can be seen in the issue history. If the creator is the same as the reporter, the name of the creator will be shown in the Reporter field on the issue.

Click to view the other features and improvements in this release:

- **Back up and recover indexes** — Configure JIRA to take snapshots of indexes. Recover an index from a snapshot instead of rebuilding the index, if there is a failure. Learn more...
- **Re-index individual projects** — Re-index a single project, rather than re-indexing your entire JIRA instance. Learn more...
- **New ‘creator’ JQL field** — Find issues by their creator by using the new ‘creator’ JQL field. Learn more...
- **New ‘attachments’ JQL field** — Find issues that have attachments or issues that do not have attachments with the new ‘attachments’ JQL field. Just add the clause "attachments IS EMPTY" or "attachments IS NOT EMPTY" to your advanced search query. Learn more...
- **Filtering for User Picker custom field** — You can now limit the users that can be selected in a user picker custom field, to specified groups and/or project roles. Just configure your user picker custom field and choose the new Edit User Filtering link. Learn more...
- **Inline editing can now be disabled** — Inline editing, i.e. clicking to edit a field, can now be disabled for your JIRA site in the General Configuration options. It is still enabled by default.
- **Internet Explorer 11 is now supported**

The JIRA 6.2 team

*Development*

Adam Jakubowski
Aleksander Mierzwicki
Andreas Knecht
Andrew Swan
Antoine Büsch
Arkadiusz Gowacki
Ben Sayers
Ben Wong
Bradley Ayers
Brenden Bain
Brydie McCoy
Charles O’Farrell
Chris Darroch
Chris Doble
Chris Fuller
Chris Mountford
David Tang
Edward Zhang
Eric Dalgliesh
Filip Rogaczewski
Gilmore Davidson
Graham Carrick
Grzegorz Taczyk
Ian Grunert
Ignat Alexeyenko
Jaiden Ashmore
James Hatherly
James Hazelwood
James Winters
Jason Sheehy
Jeroen De Raedt
Jeshua Morrissey
Jimmy Kurniawan
Jonathan Raoul
Jonathon Creenaune
Joshua Ali
Julius Hocman
Kayne Barclay
Krystian Brazulewicz
Luis Miranda
Lukasz Wlodarczyk
ukasz Pater
Maciej Nowakowski
Maciej Opala
Marcin Gardias
Markus Kramer
Martin Henderson
Martin Jopson
Martin Meinhold
Michael Elias
Michael Tokar
Michal Orzechowski
Mike Sharp
Miroslav Stencel
Nick Menere
Nikolay Petrov
Oliver Wessels
Oswaldo Hernandez
Patrick Teen
Pawel Bugalski
Pawel Niewiadomski
Pawel Skierczynski
Pierre-Etienne Poirot
Przemek Borkowski
Robert Smart
Roman Tekhov
Sean Curtis
Sergio Cinos
Stanislav Dvorscak
Sunny Kalsi
Trevor Campbell
Wojciech Urbanski
Zehua Liu

Architecture

Mark Lassau
Matt Quail
Slawek Ginter

Support

Sydney support
Bejoy Jaison
David Currie
David Mason
Matthew Hunter
Mauro Badii
Michael Andreacchio
Michael Knight
Nick Mason
Paul Greig

**Amsterdam support**
Alex Conde
Bastiaan Jansen
Dora Wierzbicka
Ivan Maduro
John Inder
Mick Nassette
Miranda Rawson
Peter Koczan
Ruchi Tandon
Theodore Tzidamis
Yilin Mo

**Brazil support**
Andre Quadros Petry
Benito Picarelli
Bruno Rosa
Clarisssa Gauterio
Danilo Conrad
Eric Kieling
Felipe Willig
Jorge Dias
Lucas Lima
Luciano Fagundes
Marcus Silveira
Matheus Fernandes
Ricardo Carracedo
Pedro Cora
Pedro Souza
Pietro Schaff
Tiago Kolling Comasseto

**Kuala Lumpur support**
Abdoulaye Kindy Diallo
Ahmad Danial
Ahmad Faisal
Ala Al-Shargabi
Amanda Wei Sai Nan Wei
Azwandi Mohd Aris
Chung Park Chan
Daryl Chuah
Daniel Leng
Daniel Watania
Immanuel Slagian
Janet Albion
Joe Wai Tye
John Chin Kim Loong
Kumar Ramajillu
Muhammad Fahd
Razaq Omar
Richie Gee
Steven Trung Tran
Vicky Kharisma
Voon Kiat Gan
Yew Teck En  
Zulfadli Noor Sazali

**San Francisco support**  
Boris Berenberg  
David Chan  
David Maye  
David Nicholson  
Gary Sackett  
Ivan Tse  
Jason Worley  
Jeff Curry  
John Garcia  
Mary Avalos  
Osman Afridi  
Pelle Kirkeby  
Rick Bal  
Turner Benard

**Service Enablement**  
Chris Le Petit  
Patrick Hill

**Management**  

**Product management**  
Anu Bharadwaj  
Bartek Gatz  
Iwona Stankiewicz  
Josh Devenny  
Megan Cook  
Nick Strybosch  
Roy Krishna  
Tom Kotecki

**Product marketing management**  
Caroline Nyce  
Dan Chuparkoff  
Dan Radigan  
Jake Brereton

**Program manager**  
Simone Houghton

**Development manager**  
Paul Slade  
Wojciech Seliga

**General manager**  
Bryan J. Rollins

**Cross-product team**  

**Design**  
Becc Roach  
Benjamin Humphrey  
Jay Rogers  
Krzysztof Piwowar  
Ross Chaldecott

**Quality assistance**  
Kiran Shekhar  
Michal Kujalowicz  
Penny Wyatt  
Peter Obara

*Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
JIRA 6.2 Upgrade Notes

Please follow the instructions in the general Upgrading JIRA guide, as well as the JIRA 6.2-specific instructions below. The general guide contains important tasks that are essential for getting your upgraded JIRA installation to work correctly and, if necessary, migrating existing configurations.

This page also describes known issues as well as changes you should be aware of before deciding whether or not to upgrade to JIRA 6.2.

On this page:

- Information for JIRA developers
- Upgrading to JIRA 6.2 from JIRA 6.1.x
- Upgrading to JIRA 6.2 from JIRA 6.0.8 or earlier

Information for JIRA developers

See Preparing for 6.2 for important information that could affect your add-ons or scripts. Also, see our Java API policy for JIRA.

Upgrading to JIRA 6.2 from JIRA 6.1.x

- Advance notice: End of support for Internet Explorer 8 (post-JIRA 6.2)
- Images are now correctly shown in email notifications
- Labels and Popular Issues tabs removed from Project Overview
- Rename user and JIRA as a Crowd server
- For developers: Source distribution — Internal Atlassian dependencies are now Maven-based archives

Advance notice: End of support for Internet Explorer 8 (post-JIRA 6.2)

JIRA 6.2 will be the last major release that supports Internet Explorer 8 (IE8). For more information, please see this page.

Images are now correctly shown in email notifications

This release fixes a highly-voted bug where images would only be shown in email notifications, if the user is accessing their email in the same session that has been used to log into JIRA. For details, see JIRA-25705 - Images are not shown in email notifications

⚠️ This feature means that mail is now sent in a multipart content type. Please ensure the SMTP JIRA uses supports this.

Labels and Popular Issues tabs removed from Project Overview

The Labels and Popular Issues tabs are not used very much, so we have removed them to simplify the Project Overview page.

Rename user and JIRA as a Crowd server

In JIRA 6.0 and 6.1, the rename user function was disabled if you had JIRA configured as a Crowd server. In this release, the rename function is enabled by default, even if you have JIRA set up as a Crowd server.

If you want to disable rename user when JIRA is configured as a Crowd server, change jira.option.user.crowd.allow.rename to false in the advanced settings. For example, some client applications (depending on JIRA's Crowd server implementation) misinterpret renamed users as having been deleted and created again, so you may want to disable rename user.

For developers: Source distribution — Internal Atlassian dependencies are now Maven-based archives

The internal Atlassian dependencies for JIRA's source distribution are now Maven-based archives, rather than exports of the source repository for each dependency. There will be a Maven-based archive for each
dependency, named `<dependencyname-version>-sources.jar`. For more information, see Preparing for JIRA 6.2.

**Upgrading to JIRA 6.2 from JIRA 6.0.8 or earlier**

In addition to the points listed above, please read the Important Version-Specific Upgrade Notes for every version of JIRA you are skipping.

Note, you cannot upgrade from JIRA 4.3.x or earlier, directly to JIRA 6.2. You must upgrade to an interim version first. See Skipping Major Versions When Upgrading JIRA.

JIRA 6.2.7 Release Notes

**11 June 2014**

The Atlassian JIRA team announces the release of JIRA 6.2.7. This point release contains several updates and fixes.

Upgrading to JIRA 6.2.7 is free to all customers with active JIRA software maintenance.

**Don’t have JIRA 6.2 yet?**

Take a look at all the new features in the JIRA 6.2 Release Notes and see what you are missing out on!

> Download latest version

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 6.2.7 Upgrade Notes.

**Updates and fixes in this release**

JIRA 6.2.7 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-38332</td>
<td>Error trying to configure fields for create issue. Switching from all to custom</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38265</td>
<td>The Switching between the “All” and “Custom” fields in the create issue Page is Inconsistent</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-37861</td>
<td>Javascript error on JAC when attempting to set the visible fields in the create issue dialog</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-31699</td>
<td>Webhook won’t fire on Issue Created if a JQL is provided</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-28501</td>
<td>Deleting a custom field option that is used as default to a cascading select CF will make that custom field uneditable</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38399</td>
<td>Workflow Designer doesn’t expand common transition loops</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38398</td>
<td>Workflow Designer throws NPE if imported workflow links to missing statuses</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-27926</td>
<td>Create Sub-Task From Gadget Does Not List Sub-Task Issue Type</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

8 issues

JIRA 6.2.7 Upgrade Notes

Upgrading from JIRA 6.2.x to 6.2.7

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.1.x and earlier

In addition to the above, please read the JIRA 6.2 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.2.6 Release Notes

**27 May 2014**
The Atlassian JIRA team announces the release of **JIRA 6.2.6**. This point release contains several updates and fixes.

Upgrading to JIRA 6.2.6 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 6.2 yet?**

Take a look at all the new features in the **JIRA 6.2 Release Notes** and see what you are missing out on!

![Download latest version](#)

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the **JIRA 6.2.6 Upgrade Notes**.

**Updates and fixes in this release**

JIRA 6.2.6 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-24210</td>
<td>Allow &quot;Other&quot; in pie chart to be clickable</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38147</td>
<td>Favourite filters REST Resource is needlessly retrieving associated share users</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38146</td>
<td>UserMatcherPredicate matches users using lowercase in a poorly performing manner</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38145</td>
<td>OfBizUser should cache its hashcode to improve performance in large instances</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38144</td>
<td>Severe performance regression when searching using project versions</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39082</td>
<td>Development panel review is missing translation for comment column</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-38788</td>
<td>Dashboard gadget: Cannot add a pie chart of recent bugs by creator to a dashboard.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38331</td>
<td>I18nResolver strips whitespace from properties and breaks completely when loading empty strings</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38271</td>
<td>Plugin rest resources can not resolve text messages using I18nHelper</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38219</td>
<td>Voted Issues gadget isn't working anymore</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38197</td>
<td>User Picker is inefficient with lots of users</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38139</td>
<td>Uppercase names in JIRA browse users feature caused slowness</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-36424</td>
<td>Mixed case group names breaks the connection between JIRA and LDAP for User Management</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38674</td>
<td>Context path value is duplicated in the URL when selecting a shared artifact in JIRA</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38458</td>
<td>NPE in Set Up Wallboard Slideshow if session is invalidated</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38390</td>
<td>Update marketplace page for wallboards to indicate that the plugin is now bundled from 6.2.6 onwards</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38386</td>
<td>Upgrade UPM to 2.16.2</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38330</td>
<td>Upgrade UPM to 2.16.1</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38287</td>
<td>Get UPM 2.16 into JIRA 6.2 stable</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38263</td>
<td>Fix JIRA mail handler lines of code</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

Showing 20 out of 38 issues

JIRA 6.2.6 Upgrade Notes

**Upgrading from JIRA 6.2.x to 6.2.6**

Please follow the instructions in the **general upgrading JIRA documentation**.

**Upgrading from JIRA 6.1.x and earlier**

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
In addition to the above, please read the JIRA 6.2 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

**JIRA 6.2.5 Release Notes**

**13 May 2014**
The Atlassian JIRA team announces the release of **JIRA 6.2.5**. This point release contains several updates and fixes. We are particularly pleased to announce [JRA-31917 - Rewrite screenshot applet using not-java](https://jira.atlassian.com/browse/JRA-31917) has been completed and users can now attach a screenshot via HTML5 in supported browsers.

Upgrading to JIRA 6.2.5 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 6.2 yet?**
Take a look at all the new features in the JIRA 6.2 Release Notes and see what you are missing out on!

![Download latest version](https://atlassian.com)

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 6.2.5 Upgrade Notes.

**Updates and fixes in this release**

JIRA 6.2.5 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-38132</td>
<td>test compatibility of streams version 5.3.24 with jira stable</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-38046</td>
<td>Heavy use of Trusted Apps appears to be causing products to slow</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-35616</td>
<td>Read more link in comment of activity stream is not working</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-34780</td>
<td>Issue dropdown is slow to open</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38870</td>
<td>Application Blocked by Security Settings when try to Attach Screenshot</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38663</td>
<td>Date and Time not showing the &quot;Seconds&quot; correctly</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38349</td>
<td>Attaching Screenshot fails with ClassNotFoundException</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38288</td>
<td>Project Template Images not updated with latest statuses</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38244</td>
<td>Attach Screenshot throwing ClassNotFoundException com.atlassian.jira.screenshot.applet.ScreenshotApplet.class Error</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38240</td>
<td>Read more links in the activity stream on the Project summary page do not work</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38158</td>
<td>After successful screenshot upload, the cancel button causes a js exception</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38157</td>
<td>Release on 6.2.x and master.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38131</td>
<td>Windows 8 doesn’t allow the image to be uploaded via the Java applet.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38083</td>
<td>Exporting from OnDemand to Behind the Firewall breaks the Audit Log feature</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-37982</td>
<td>securityLevelToPermissionsCache maxSize is causing problems in some circumstances</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-36659</td>
<td>Previously selected project not remembered when opening Issue Navigator detail view and creating an issue from there</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-35747</td>
<td>Timestamp value in the issue does not show the timezone correctly</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-35223</td>
<td>Get exception Unable to retrieve gadget xml. HTTP error 504 when adding Confluence gadget to JIRA dashboard</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-31917</td>
<td>Rewrite screenshot applet using not-java</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-29795</td>
<td>Gadgets can’t be added or saved in Confluence page when gzip is enabled</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
Showing 20 out of 22 issues

JIRA 6.2.5 Upgrade Notes

Upgrading from JIRA 6.2.x to 6.2.5
Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.1.x and earlier
In addition to the above, please read the JIRA 6.2 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.4 Documentation

02 May 2014
The Atlassian JIRA team announces the release of JIRA 6.2.4. This point release contains several updates and fixes.

Upgrading to JIRA 6.2.4 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.2 yet?
Take a look at all the new features in the JIRA 6.2 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA
If you are upgrading, please read the JIRA 6.2.4 Upgrade Notes.

Updates and fixes in this release

JIRA 6.2.4 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-37644</td>
<td>Can't update expired license after upgrading JIRA</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-37152</td>
<td>Support for linking to translated CAC docs in JIRA</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-34479</td>
<td>CSV update changes Issue Type to default when not defined in import file</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38222</td>
<td>Project Key Edit is broken if the Project Lead Is A Renamed User</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38047</td>
<td>Fix the release build to correctly sign the applet</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-37920</td>
<td>Performance regression when checking Single User permissions</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-37813</td>
<td>Improve unsupported browser messages to indicate which browsers are supported</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-37812</td>
<td>Provide clear instructions when java is not installed for IE8/9/10 users</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-37805</td>
<td>Fix image paste support for Safari.</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-37789</td>
<td>Unclear Error and Warning messages during JIRA upgrade to version 6.2.1</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-37787</td>
<td>Write feature detection for image data clipboard paste.</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-37282</td>
<td>Regression - Project Edit Is Broken If Project Lead Is A Renamed User</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-36702</td>
<td>Can't change project key for project that has a lead with a changed username</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-36193</td>
<td>NullPointer on findIssue Rest call</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33600</td>
<td>Broken Links in Footer</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33102</td>
<td>Remove uninformative upgrade task messages from log output</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA 6.2.4 Upgrade Notes

**Upgrading from JIRA 6.2.x to 6.4**

Please follow the instructions in the general upgrading JIRA documentation.

**Upgrading from JIRA 6.1.x and earlier**

In addition to the above, please read the JIRA 6.2 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.2.3 Release Notes

**15 April 2014**

The Atlassian JIRA team announces the release of JIRA 6.2.3. This point release contains several updates and fixes.

Upgrading to JIRA 6.2.3 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 6.2 yet?**

Take a look at all the new features in the JIRA 6.2 Release Notes and see what you are missing out on!

[Download latest version](#)

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 6.2.3 Upgrade Notes.

**Updates and fixes in this release**

JIRA 6.2.3 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚸</td>
<td>JRA-37804</td>
<td>Getting 'com.atlassian.auiplugin:aui-sidebar' does not exist in logs of 6.2 stable</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-37652</td>
<td>Set Issue Creator when created by mail handler</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🚸</td>
<td>JRA-37352</td>
<td>JIRA Mobile Javascript broken</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🚸</td>
<td>JRA-33720</td>
<td>Indexing failure for issues that multiple options specified in a multiselect list, if the sequence value is null for any option</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td>🚸</td>
<td>JRA-37889</td>
<td>User Workload report has a broken link</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-37563</td>
<td>Browse Project AJAX Tab loading broken for old-style url</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-37289</td>
<td>BrowseProject.jspa links no longer work, breaking Confluence footer links</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🚸</td>
<td>JRA-37153</td>
<td>Remove &quot;opt-in&quot; analytics messages from JIRA</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🚸</td>
<td>JRA-37009</td>
<td>Content Spoofing in the ConvertIssue.jspa action</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-36857</td>
<td>Reindex all fails with an com.atlassian.jira.index.IndexingFailureException using Java 7</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-36555</td>
<td>Full LDAP does not respect &quot;User Membership Attribute&quot; during login</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-14641</td>
<td>Impossible to distinguish between a space and an underscore in a search query</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-9240</td>
<td>Searching exact word matches should not ignore &quot;common&quot; words</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td>🔻</td>
<td>JRA-38122</td>
<td>Error when attaching files in Details View of Issue Navigator</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.4 Documentation

Showing 20 out of 29 issues

JIRA 6.2.3 Upgrade Notes

Upgrading from JIRA 6.2.x to 6.2.3

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.1.x and earlier

In addition to the above, please read the JIRA 6.2 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.2.2 Release Notes

1 April 2014

The Atlassian JIRA team announces the release of JIRA 6.2.2. This point release contains several updates and fixes.

Upgrading to JIRA 6.2.2 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.2 yet?

Take a look at all the new features in the JIRA 6.2 Release Notes and see what you are missing out on!

Download latest version

Important notes

Grant "Browse Project" permission to "Current Assignee bug — fix reverted"

In JIRA 6.1.6, we introduced a fix for JRA-31720. After further investigation, we have decided to revert this fix due to performance issues (e.g. JRA-36699). This means that JIRA will revert to its original behaviour, which is described below:

- If you grant the "Browse Project" permission to "Current Assignee" in a project permission scheme, the project metadata (e.g. project name, project key, etc) will be visible to all users.

Unfortunately, this long-standing issue does not have a simple fix. Please watch JRA-31720 for further information. There is also a workaround described in this KB article.

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.2.2 Upgrade Notes.

Updates and fixes in this release

JIRA 6.2.2 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-38137</td>
<td>Current Assignee in Issue Security Level fired high numbers of SQL queries of different project to database</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-37822</td>
<td>Reindex all fails with an com.atlassian.jira.index.IndexingFailureException using Java 7</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-37689</td>
<td>Issue tabs don't work in IE9</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### 18 issues

#### JIRA 6.2.2 Upgrade Notes

**Upgrading from JIRA 6.2.x to 6.2.2**

Please follow the instructions in the general upgrading JIRA documentation.

**Upgrading from JIRA 6.1.x and earlier**

In addition to the above, please read the JIRA 6.2 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

#### JIRA 6.2.1 Release Notes

**18 March 2014**

The Atlassian JIRA team announces the release of **JIRA 6.2.1**. This point release contains several updates and fixes.

Upgrading to JIRA 6.2.1 is free to all customers with active JIRA software maintenance.

**Don’t have JIRA 6.2 yet?**

Take a look at all the new features in the JIRA 6.2 Release Notes and see what you are missing out on!

[Download latest version](#)

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 6.2.1 Upgrade Notes.

**Updates and fixes in this release**

JIRA 6.2.1 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-37107</td>
<td>Two Agile menus visible in JIRA 6.2 BTF</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-36857</td>
<td>Reindex all fails with an com.atlassian.jira.indexingFailureException using Java 7</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-36813</td>
<td>TerminalHistoryPredicate API concatenates with no blank</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-36699</td>
<td>Browse project searches are slow when JIRA has lots of projects</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-28134</td>
<td>Logs flooded with custom field type not found on plugin install</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-37806</td>
<td>Mapping of avatar data not correct during export or backup of JIRA data</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-37556</td>
<td>New workflow designer in Safari (latest) - the top-right popup window does not always appear when you click a status or transition.</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-36964</td>
<td>Can’t drag field between tabs on the screen designer</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-36521</td>
<td>Icon and message type on log in error incorrect</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-35955</td>
<td>Cancel link on bulk operation on step 4 is not working</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-35782</td>
<td>JIRA Mobile View does not work if the Description is Hidden in the Field Configuration</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-33216</td>
<td>Remove “Could not retrieve users for UserCF” error message during issue creation</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-32132</td>
<td>Internal Server Error if transition destination is undefined or the same state as the original status</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-29336</td>
<td>Mapping “Issue Key” field when using CSV import will cause attachments importing failure</td>
<td>RESOLVED</td>
</tr>
<tr>
<td>JRA-35262</td>
<td>Spelling mistake on Edit Application Properties</td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.2.1 Upgrade Notes

Upgrading from JIRA 6.2.x to 6.2.1

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.1.x and earlier

In addition to the above, please read the JIRA 6.2 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1 Release Notes

Accelerate change

Help your team embrace change with JIRA 6.1

JIRA 6.1 picks up where JIRA 6.0 left off, introducing more improvements that help you get work done faster. Features like the new workflow designer and intuitive custom field configuration, let you introduce change to your team without slowing them down.

We are also starting a new journey towards seamless JIRA integration with your coding tools. The new create branch functionality in JIRA 6.1 is the first improvement, with many more to come.

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
New workflow designer

The **new workflow designer** is fast, modern and easy to use. Built using HTML5, the latest HTML standard, it loads instantly and is incredibly responsive. On top of this, we've added features to help JIRA administrators build workflows more easily — design in full screen mode, snap lines to statuses (geometric snap lines), select a status to highlight transitions, and more.

Users also benefit from this feature: when viewing an issue, click **View Workflow** (next to the Status field) to show an accurate view of the workflow designer (one of our **highest voted feature requests**).

Learn more...

---

New project templates

JIRA 6.1 continues our work from previous releases to get you started faster. You can now choose from two new templates when creating a new project in JIRA. Get up and running quickly with the **Simple Issue Tracking project**, which has a simple three-step workflow that is easy to understand; or choose the **Software Development project**, which is configured to reflect a basic development and review process.

Learn more: [Simple Issue Tracking Project](#) and [Software Development Project](#)
Intuitive custom field configuration

We've made it easier to create custom fields and put them where you want. Viewing an issue and think that it needs a new field? Simply click **Admin > Add field** to choose an existing custom field or create a new one. The field is also added to the Create and Edit screens, so you can use it straight away.

Field types are now categorized into Standard and Advanced when creating a custom field. Standard types also offer a preview of the field, so you can see what you are creating in advance.

Learn more...
Enterprise enhancements

*Edit project key*

One of the most voted for feature requests has been implemented in this release: the ability to edit a project key. It's simple but powerful — just change a single field to edit the key for an existing project. JIRA will automatically update related data across all of your projects.

Learn more...

*Change usernames in LDAP*

JIRA now supports changing usernames when connected to an external LDAP user directory. This means that JIRA treats name changes in LDAP as renames, rather than deleting and adding a user (which did not work). For most LDAP implementations, this will work out of the box. In a small minority of cases, further configuration is required.

*JIRA password policy*

The JIRA password policy feature enables JIRA Administrators to set limits and restrictions on the types of passwords their users can create.

Learn more...
More integration with your coding tools

You've always been able to link commits from Bitbucket and Stash to JIRA issues, making it easy to understand which issues are fixed and the code changes involved. However, we're adding new features to expand the ways you can manage commits, builds, and deployments within the context of your planning resources in JIRA.

In this first release of these improvements, if you use Bitbucket or Stash to manage your code repositories, you'll be able to create code branches directly from issues in JIRA or JIRA Agile. The new **Create branch** link will open your connected repository application and launch the process of creating a branch for you. If you have multiple applications connected, then you can choose where you'd like to create the branch.

⚠️ **Note, the ability to create branches from JIRA in Stash requires Stash 2.8, which will be released next week on 1 October 2013 (watch this page for updates). You can create branches from JIRA in Bitbucket now.**
And more!

We're not stopping here! You will find plenty more 6.1 features listed below. The most notable of these are the name changes for JIRA add-ons: GreenHopper has been renamed to JIRA Agile and Bonfire has been renamed to JIRA Capture. This is part of a move to align these two add-ons more closely with JIRA. You will see associated user interface changes in JIRA in this release. Please be assured that your existing licenses and support entitlements are unchanged. This is a change of product name only. Read this blog post for more information.

Click to view the other features and improvements in this release:

- **Easier issue navigator column configuration** — Show exactly what you need when triaging issues. In this release, you can easily change the columns for search results displayed in List View. Simply click Columns (top right) to choose the desired columns, then drag and drop them where you want.

- **Improvements to workflow text mode** — In line with the updated workflow designer, we have also updated many of the pages in text mode. Specifically, the page that allows you to view a particular status or transition, as well as its post function, conditions and validators.

- **New default workflow and assignee** — We've made two changes to simplify the out-of-box experience for new projects in JIRA. First, the default workflow no longer requires a user to be the assignee to transition an issue from one status to another. Second, the default for Allow Unassigned Issues is now set to ON (for new instances only) and the Default Assignee is now set to 'Unassigned' when you create a new project. Together, these changes allow issues to be worked on by anyone, rather than have one person be the bottleneck.

  - **Please note...**

    - **Default workflow**: If you prefer the old default workflow behavior, you can change your workflow or import the Classic Default JIRA Workflow.
    - **Allow Unassigned Issues**: Existing instances keep the current default (Allow Unassigned Issues is set to OFF).

- **JIRA Redmine Importer now available** — We've added a JIRA Redmine Importer plugin that enables you to import data from Redmine directly into your local JIRA site. Learn more...

- **New look for email notifications** — Email templates for JIRA have been improved to reflect the Atlassian Design Guidelines look and feel. Learn more...

- **New whitelist for JIRA** — JIRA's whitelist is now more intuitive and easier to configure. Learn more...

- **Faster access to JIRA reports** — You can now access JIRA reports directly from its own tab under the Browse Project page.

---

The JIRA 6.1 team

*Development*

Adam Jakubowski
Aleksander Mierzwicki
Andreas Knecht
Andrew Swan
Antoine Büsch
Anund McKague
Ben Wong
Bradley Ayers
Brenden Bain
Chris Darroch
Chris Doble
Chris Fuller
Chris Mountford
David Tang
Edward Zhang
Eric Dalgliesh
Filip Rogaczewski
Gilmore Davidson
Ian Grunert
Ignat Alexeyenko
Jaiden Ashmore
James Hatherly
James Hazellwood
James Winters
Jeroen De Raedt
Jeshua Morrissey
Jimmy Kurniawan
Joanne Cranford
Jonathan Raoult
Jonathon Creennaune
Joshua Ali
Joshua Hansen
Justus Pendleton
Kayne Barclay
Luis Miranda
Lukasz Wlodarczyk
Maciej Nowakowski
Maciej Opala
Mark Lassau
Markus Kramer
Martin Henderson
Martin Jopson
Martin Meinhold
Michael Elias
Michael Ruffin
Michael Tokar
Michal Orzechowski
Mike Sharp
Nick Menere
Nikolay Petrov
Oswaldo Hernandez
Pawel Bugalski
Pawel Niewiadomski
Pawel Skierczynski
Pierre-Etienne Poirot
Przemek Borkowski
Robert Smart
Roman Tekhov
Scott Harwood
Sean Curtis
Sergio Cinos
Trevor Campbell
Wojciech Seliga
Wojciech Urbanski
Zehua Liu

Architecture
Brad Baker
Matt Quail
Slawek Ginter

Support
Sydney support
Christopher Shim
David Currie
David Mason
Matthew Hunter
Mauro Badii
Michael Andreacchio
Michael Knight
Nick Mason
Paul Greig
Renjith Pillai

Amsterdam support
Alex Conde
Bastiaan Jansen
Dora Wierzbicka
Ivan Maduro
John Inder
Mick Nassette
Miranda Rawson
Peter Koczan
Ruchi Tandon
Theodore Tzidamis
Yilin Mo

Brazil support
Andre Quadros Petry
Bruno Rosa
Clarissa Gauterio
Eric Kieling
Felipe Willig
Jeison Spaniol
Jorge Dias
Lucas Timm
Lucas Lima
Marcus Silveira
Marlon Aguiar
Matheus Fernandes
Ricardo Carracedo
Pedro Cora
Pedro Jardim
Pietro Schaf
Tiago Kolling Comasseto

Kuala Lumpur support
Abdoulaye Kindy Diallo
Ahmad Danial
Ahmad Faisal
Ala Al-Shargabi
Amanda Wei Sai Nan Wei
Azwandi Mohd Aris
Chung Park Chan
Daryl Chuah
Daniel Leng
Immanuel Siagian
Janet Albion
Joe Wai Tye
John Chin Kim Loong
Kumar Ramajillu
Muhammad Fahd
Razaq Omar
Richie Gee
Steven Trung Tran
Vicky Kharisma
Voon Kiat Gan
Yew Teck En
Zulfadli Noor Sazali

San Francisco support
Boris Berenberg
David Chan
David Maye
David Nicholson
Gary Sackett
Ivan Tse
Jason Worley
Jeff Curry
John Garcia
Mary Avalos
Osman Afridi
Pelle Kirkeby
Rick Bal
Turner Benard

Service Enablement
Chris Le Petit
Patrick Hill

Management

Product management
Bartek Gatz
Bryan Rollins
Carine Ma
Edwin Wong
Josh Devenny
Megan Cook
Roy Krishna
Shihab Hamid
Tom Kotecki

Product marketing management
Caroline Nyce
Dan Chuparkoff
Dan Radigan

Program Manager
Simone Houghton

Development manager
Paul Slade

Cross-product team

Design
Upgrading JIRA

Please follow the instructions in the general Upgrading JIRA guide, as well as the JIRA 6.1-specific instructions below. The general guide contains important tasks that are essential for getting your upgraded JIRA installation to work correctly and, if necessary, migrating existing configurations.

This page also describes known issues as well as changes you should be aware of before deciding whether or not to upgrade to JIRA 6.1.

This page includes:

- Information for JIRA developers
- Upgrading to JIRA 6.1 from JIRA 6.0.x
  - Atlassian analytics
  - Supported platforms changes
  - JIRA Administrators cannot delete users that have commented on issues
  - "View Issue Source Tab" permission renamed
  - Custom field creation changes
  - JIRA workflow designer changes
  - JIRA workflow transition changes
  - JIRA default workflow
  - Removal of JQL function "echo()"
- Known Issues
  - JIRA upgrade fails due to duplicate issue keys or project keys
  - Flowdock loses API token after project key is changed
  - Unable to scroll when viewing the 'View Issue' and 'Issue Navigator' pages on iPad
  - Do not use the new 'reindex' REST endpoint
  - 'JIRA Bamboo plugin' and 'Remotable Plugins 18n plugin' fail to load during JIRA startup
- Upgrading to JIRA 6.1 from JIRA 5.1.8 or earlier

Information for JIRA developers

Please see Preparing for 6.1 for information about changes to JIRA’s database, JIRA’s stable (Java) API, changes to core JIRA CSS styles, changes to JavaScript components that build UI, or changes to HTML markup patterns.

Upgrading to JIRA 6.1 from JIRA 6.0.x

Atlassian analytics

There is a new General Configuration option for JIRA that enables you to turn on/off Atlassian analytics; see Data collection policy for more information.

This option is not available for JIRA OnDemand.

Supported platforms changes
Project keys with characters other than letters, numbers and the underscore are no longer supported. See End of Support Announcements for JIRA for details.

CVS/ViewCVS functionality has been removed from JIRA and is no longer supported. See End of Support Announcements for JIRA for details.

"Voters and Watchers" and "Labels" plugins will not be supported in JIRA 6.1. Note, these plugins are not bundled with JIRA. See End of Support Announcements for JIRA for details.

**JIRA Administrators cannot delete users that have commented on issues**

If you are a JIRA administrator, you can delete a user from JIRA only if they have not performed any of the following actions:

- reported or been assigned to any issues
- commented on any issues

"View Issue Source Tab" permission renamed

The "View Issue Source Tab" project permission has been renamed to "View Development Tools".

**Custom field creation changes**

In JIRA 6.1, you no longer specify a Search Template during the custom field creation process. Similarly, all custom fields are created globally, so the context is set for you upon creation. You can change either of these settings later, if required, in your configuration settings.

**JIRA workflow designer changes**

Features which exist in the classic mode of the (Flash) workflow designer but not in the new workflow designer:

- Create common transitions
- Clone transitions
- Have global transitions with no result status
- Reassign the target of a transition (meaning that you cannot grab the arrow and make it point at a different status, you need to remove the transition and recreate it)

**JIRA workflow transition changes**

- Viewing All post-functions, conditions, and validators together has been removed.
- Workflow transition IDs are no longer displayed in the user interface. (You can still see it when viewing a workflow text mode.)

**JIRA default workflow**

The classic default JIRA system workflow prior to this JIRA release is now available on Atlassian Marketplace.

- **Classic Default JIRA Workflow**

If you import this workflow, you will need to add the 'Clear Resolution' post function back to the following three transitions:

- Start Progress
- Stop Progress
- Reopen Issue

To add a new post function, see this procedure.

**Removal of JQL function "echo()"**

The echo function is a testing function in JIRA. It has been removed from JIRA as it provides no user value. Existing filters that make use of this function will no longer work; please fix these filters, or remove them.

**Known Issues**

**JIRA upgrade fails due to duplicate issue keys or project keys**

Please see these knowledge base articles:

- Upgrading To JIRA 6.1 or later Fails Due To Duplicate Issue Keys
- Upgrading to JIRA 6.1 Fails Due To Duplicate Project Keys

**Flowdock loses API token after project key is changed**

After a project key is changed, the Flowdock plugin loses the 'Flowdock API token' for that JIRA project. To work around this problem, navigate to the 'Configure Flowdock integration in JIRA' page after the JIRA project has been renamed and add the token again. This issue applies to this JIRA EAP release and Flowdock v1.60.1 and earlier Flowdock versions.

**Unable to scroll when viewing the 'View Issue' and 'Issue Navigator' pages on iPad**

When viewing JIRA via an iPad, you will not be able to scroll on the 'View Issue' and 'Issue Navigator' pages. See this issue: [JIRA-33889](http://jira.atlassian.com/browse/JIRA-33889) - Unable to scroll on 'view issue' and 'issue navigator' pages with iOS [RESOLVED]

This has been fixed in JIRA 6.1.1, see release notes.

⚠️ Please note, iPad is not supported for JIRA and does not display the supported "mobile view". See Supported Platforms and this feature request:

[JIRA-34075](http://jira.atlassian.com/browse/JIRA-34075) - As a user, I want the iPad to be supported for non-admin functions [OPEN]

**Do not use the new 'reindex' REST endpoint**

In this release, we built a new REST endpoint that allows a reindex to be initiated via REST: `/rest/api/2/reindex`

However, there are known issues with this REST endpoint that can lead to index corruption or failure. We strongly recommend that you do not use this REST endpoint until a fix has been released. See this issue for further information: [JIRA-34921](http://jira.atlassian.com/browse/JIRA-34921) - Warranty - Reindexes triggered by REST fail [RESOLVED]

**'JIRA Bamboo plugin' and 'Remotable Plugins I18n plugin' fail to load during JIRA startup**

During a clean install or an upgrade, two plugins will fail to load: the 'JIRA Bamboo Plugin' and the 'Remotable Plugins I18n plugin'. See this issue:

[JIRA-34977](http://jira.atlassian.com/browse/JIRA-34977) - On a clean install of JIRA 6.1 I get plugin errors in the log [RESOLVED]

This has been fixed in JIRA 6.1.1, see release notes.

**Upgrading to JIRA 6.1 from JIRA 5.1.8 or earlier**

In addition to the points listed above, please read the Important Version-Specific Upgrade Notes for every version of JIRA you are skipping.

Please check the Application Links Version Matrix for dependencies compatibility verification.

**JIRA 6.1.9 Release Notes**

24 October 2014

The Atlassian JIRA team announces the release of **JIRA 6.1.9**. This point release contains several updates and fixes.

Upgrading to JIRA 6.1.9 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 6.1 yet?**

Take a look at all the new features in the [JIRA 6.1 Release Notes](http://www.atlassian.com/software/jira/press-kit/jira-6-1) and see what you are missing out on!
Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.9 Upgrade Notes.

Updates and fixes in this release

JIRA 6.1.9 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-40219</td>
<td>Excessive locking in lucene threads can lead to scalability problems in high concurrency environments</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39467</td>
<td>Issue indexing is very slow when JIRA Agile 6.4.3 or higher is installed on Oracle database</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-39770</td>
<td>Throwing UserNotFoundException results in performance degradation for large instances</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-21557</td>
<td>NextPreviousPager is bottleneck under highload</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

JIRA 6.1.9 Upgrade Notes

Upgrading from JIRA 6.1.x to 6.1.9

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.0.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1.8 Release Notes

21 May 2014

The Atlassian JIRA team announces the release of JIRA 6.1.8. This point release contains several updates and fixes. We are particularly pleased to announce the completion of JRA-36699 - Browse project searches are slow when JIRA has lots of projects which has resolved a performance and stability issue due to permission settings.

Upgrading to JIRA 6.1.8 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.1 yet?

Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

*Note to download an earlier version of JIRA, click on the button above and follow the link to the download archive.

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.8 Upgrade Notes.

Updates and fixes in this release

JIRA 6.1.8 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-38147</td>
<td>Favourite filters REST Resource is needlessly retrieving associated share users</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-38146</td>
<td>UserMatcherPredicate matches users using lowercase in a poorly performing manner</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.1.8 Upgrade Notes

Upgrading from JIRA 6.1.x to 6.1.8

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.1.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1.7 Release Notes

21 January 2014
The Atlassian JIRA team announces the release of JIRA 6.1.7. This point release contains several updates and fixes.

This is the last release in the 6.1.x release cycle.

Upgrading to JIRA 6.1.7 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.1 yet?

Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.7 Upgrade Notes.

Updates and fixes in this release

JIRA 6.1.7 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-26747</td>
<td>&quot;Release Version&quot; dialog doesn't respect Day/Month/Year format</td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>JRA-35476</td>
<td>Security Dialog in Screenshot Applet</td>
<td></td>
<td>18</td>
</tr>
<tr>
<td>JRA-33793</td>
<td>Perforce Job Integration is not working properly in JIRA 6 onwards</td>
<td></td>
<td>14</td>
</tr>
<tr>
<td>JRA-36571</td>
<td>Attach screenshot applet doesn't work in IE with Java update se7u51</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>JRA-36584</td>
<td>Missing required attributes in screenshot.jar/manifest file / Java 1.7.51</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>JRA-36582</td>
<td>Attach snapshots now not working</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>JRA-36589</td>
<td>Screenshot applet cannot be used with Java 7u51 plugin</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>JRA-36276</td>
<td>REST Call from one plugin to another</td>
<td></td>
<td>2</td>
</tr>
</tbody>
</table>
JIRA 6.4 Documentation

20 issues

JIRA 6.1.7 Upgrade Notes

Upgrading from JIRA 6.1 to 6.1.7

Follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.0.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1.6 Release Notes

14 January 2014
The Atlassian JIRA team announces the release of JIRA 6.1.6. This point release contains several updates and fixes.

Upgrading to JIRA 6.1.6 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.1 yet?
Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.6 Upgrade Notes.

Updates and fixes in this release

JIRA 6.1.6 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-33043</td>
<td>Unassigned user removal</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>JRA-34819</td>
<td>Preview button acts as submit when editing issue description.</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>JRA-29571</td>
<td>Session expiry pages may echo password in clear text</td>
<td></td>
<td>6</td>
</tr>
</tbody>
</table>
JIRA 6.1.6 Upgrade Notes

Important information for developers

- **'creator' column added to jiraissues table** — A new **creator** field was introduced in JIRA 6.1.6, and will also be in JIRA 6.2 when it is released. This field was implemented as a column in the **jiraissues** table in the JIRA database. Please note the following:
  - **New JIRA 6.1.6 (or 6.2) instances**: the **creator** field will be located after the **assignee** column
  - **Existing JIRA instances that are upgraded to 6.1.6 (or 6.2)**: the **creator** field will be inserted as the last column in **jiraissues** table

We strongly recommend that you do not rely on the order of columns in the tables of the JIRA database, but instead refer to the columns explicitly by name.

Upgrading from JIRA 6.1 to 6.1.6

Follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.0.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1.5 Release Notes

10 December 2013
The Atlassian JIRA team announces the release of **JIRA 6.1.5**. This point release contains several updates and fixes.

Upgrading to JIRA 6.1.5 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.1 yet?
Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

Download latest version

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.5 Upgrade Notes.

Updates and fixes in this release

JIRA 6.1.5 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-24112</td>
<td>Select and Multi Select Fields Width Don't Fit to Options Text Length on Create Issue Screen</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>JRA-24748</td>
<td>Long Text on Radio Button Custom Field Overlaps the Field Below</td>
<td></td>
<td>7</td>
</tr>
<tr>
<td>JRA-36034</td>
<td>JIRA Issue Detail view layout is broken in IE 8, Issue detail falling below the comment area</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>JRA-31921</td>
<td>Long text on Favorite Filters title are hidden on the Search Screen</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>JRA-24856</td>
<td>When the quartz worker dies, there's no warning that services are no longer being run</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>JRA-35919</td>
<td>IE8: Inline editing fields causes panels to disappear on view issue</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>JRA-35551</td>
<td>The display of AND/OR operator on conditions of transitions is wrong</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>JRA-34058</td>
<td>Sub-tasks are not displayed correctly when choosing too many columns to display</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>JRA-35490</td>
<td>The accept/cancel buttons are hidden when inline editing the issue summary</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>JRA-35610</td>
<td>JIRA 6.1 - Search List Display not showing correct column config</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>JRA-35897</td>
<td>Internet Explorer 11 identified as unsupported IE7, menus fall apart</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>JRA-36132</td>
<td>Misaligned / Misplaced Columns in Issue Navigator</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>JRA-35591</td>
<td>RESTful table helper looks broken while dragging a row</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>JRA-35964</td>
<td>Unsupported browser message not helpful when in Compat Mode</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>JRA-35885</td>
<td>Incorrect redirect on &quot;Import from Marketplace&quot; for workflows.</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>JRA-29405</td>
<td>Typo in radio button option when performing project link &quot;No, don't create a link from FishEye Repository &lt;example&gt; to Project Confluence as well&quot;</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-29455</td>
<td>Applinks causes an oauth failure with url escaped links</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-28641</td>
<td>When clicking on attachment file ICON it does not open the file</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35463</td>
<td>Warranty - Restful Table's dragged row renders funny in Chrome</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35758</td>
<td>Off alignment for JQL search result in IE</td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

Showing 20 out of 48 issues

JIRA 6.1.5 Upgrade Notes

Upgrading from JIRA 6.1 to 6.1.5

Follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.0.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1.4 Release Notes

26 November 2013
The Atlassian JIRA team announces the release of JIRA 6.1.4. This point release contains several updates and fixes.

Upgrading to JIRA 6.1.4 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 6.1 yet?**

Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

**Download latest version**

### Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.4 Upgrade Notes.

### Updates and fixes in this release

JIRA 6.1.4 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-25494</td>
<td>gadget link colors do not use Look and Feel</td>
<td></td>
<td>16</td>
</tr>
<tr>
<td>JRA-31343</td>
<td>Cannot set Field Values in page using issue collector.</td>
<td></td>
<td>9</td>
</tr>
<tr>
<td>JRA-34370</td>
<td>Field height of the &quot;Description&quot; field is damaged in the Issue Collector</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>JRA-35437</td>
<td>Activity streams generates links with template logic</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>JRA-31454</td>
<td>Cascading Select custom field with default value set to None</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>JRA-37998</td>
<td>Relocating column 'Links' makes it disappear</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-37039</td>
<td>JIRA issue collector description field too small when filled using javascript</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35690</td>
<td>Upgrade JIRA Workflow Designer to 6.1.0.11 on stable</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-36113</td>
<td>Web links on the 'Activity Stream' are broken</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35808</td>
<td>Version date fields overlap in project admin</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35817</td>
<td>Activity Stream does not display the name of the app link that caused a timeout to the client</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35150</td>
<td>Newly created project via project template can be transitioned by anonymous users</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35742</td>
<td>Upgrade Trusted Apps and Applinks to fix signature issues</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35544</td>
<td>Linked Issues column in the Issue Navigator can't be dragged and vanishes</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>JRA-35797</td>
<td>Privilege escalation</td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

15 issues

### JIRA 6.1.4 Upgrade Notes

**Upgrading from JIRA 6.1 to 6.1.4**

Follow the instructions in the general upgrading JIRA documentation.

**Upgrading from JIRA 6.0.x and earlier**

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

### JIRA 6.1.3 Release Notes

**12 November 2013**

The Atlassian JIRA team announces the release of JIRA 6.1.3. This point release contains several updates and fixes.
Upgrading to JIRA 6.1.3 is free to all customers with active JIRA software maintenance.

**Don’t have JIRA 6.1 yet?**

Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

[Download latest version](#)

### Highlights

Check out the full list of updates and fixes below. Here are a few of the highlights:

- The View Issue and Issue Navigator pages now scroll correctly on iPads. See: [JRA-33889](#) - Unable to scroll on 'view issue' and 'issue navigator' pages with iOS [RESOLVED]
- The screen designer now works correctly again. See: [JRA-35586](#) - Can NOT reorder fields on the screen designer in screen configurations [RESOLVED]
- AppLinks can now be created to JIRA on non-standard ports (other than 443). See: [JRA-34550](#) - Unable to create AppLink to JIRA on a non-standard HTTPS port (other than 443) [RESOLVED]
- JIRA instances with the HipChat plugin disabled will no longer show error messages when users hover over usernames. See: [JRA-29891](#) - HipChat Plugin errors "Can not forward a request to HipChat API" without HipChat being configured [RESOLVED]
- Gadgets that show a progress bar now render the progress bar correctly. See: [JRA-25481](#) - Progress bar does not display properly in Gadgets [RESOLVED]
- Issue filters will no longer break (i.e. fail to show issues) when you transition an issue in the Detail View. See: [JRA-34934](#) - Transitions in the Detail View are breaking the filters [RESOLVED]
- Fixed a memory leak. See: [JRA-34361](#) - Thumber and DefaultThumbnailManager are leaking native resources. [RESOLVED]

### Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.3 Upgrade Notes.

### Updates and fixes in this release

JIRA 6.1.3 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-34550</td>
<td>Unable to create AppLink to JIRA on a non-standard HTTPS port (other than 443)</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>JRA-29891</td>
<td>HipChat Plugin errors &quot;Can not forward a request to HipChat API&quot; without HipChat being configured</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>JRA-29414</td>
<td>rendering issue with Issue Collector popup box</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>JRA-35586</td>
<td>Can NOT reorder fields on the screen designer in screen configurations</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>JRA-25481</td>
<td>Progress bar does not display properly in Gadgets</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>JRA-33929</td>
<td>Issue Collector Submit and Cancel buttons hidden under IE9.10 until mouseover</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>JRA-34934</td>
<td>Transitions in the Detail View are breaking the filters</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>JRA-31576</td>
<td>Issue Collector problem with JQuery 1.9</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>JRA-24088</td>
<td>Activity stream gadget not picking up link colour</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>JRA-33889</td>
<td>Unable to scroll on 'view issue' and 'issue navigator' pages with iOS</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>JRA-28083</td>
<td>&quot;Estimated time&quot; inaccurate on &quot;Progress&quot; column of Filter Results gadget</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>JRA-35577</td>
<td>Drag and Drop in screen configuration doesn't work</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>JRA-35141</td>
<td>Attachments list rendered incorrectly - Issue Collector</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>JRA-26115</td>
<td>Link Colour and Link Active Colour in look and feel not being applied across all links</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>JRA-35523</td>
<td>Add UI toggle for &quot;can rename user even with JIRA as a Crowd Server&quot; advanced setting</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
JIRA 6.1.3 Upgrade Notes

Upgrading from JIRA 6.1 to 6.1.3

Follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.0.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1.2 Release Notes

29 October 2013

The Atlassian JIRA team announces the release of JIRA 6.1.2. This point release contains several updates and fixes.

Upgrading to JIRA 6.1.2 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.1 yet?

Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

Download latest version

Highlights

Check out the full list of updates and fixes below. Here are a few of the highlights:

- JIRA no longer reuses issue type IDs after they are deleted.
  - JRA-32277 - JIRA should not re-use issue type IDs after they are deleted [Atlassian]
  - [Atlassian] Resolved

- Issue Collector works in IE9 in standards mode.
  - JRA-32597 - Issue Collector breaks in IE9 in standards mode [Atlassian]
  - [Atlassian] Resolved

- JIRA's timezones now work as expected.
  - JRA-33737 - JIRA’s timezones are out of date - update joda-time [Atlassian]
  - [Atlassian] Resolved

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.1.2 Upgrade Notes.

Updates and fixes in this release

JIRA 6.1.2 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
</table>
JIRA 6.1.2 Upgrade Notes

Upgrading from JIRA 6.1 to 6.1.2

Follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 6.0.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.1.1 Release Notes

15 October 2013

The Atlassian JIRA team announces the release of JIRA 6.1.1. This point release contains several updates and fixes.

Upgrading to JIRA 6.1.1 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.1 yet?

Take a look at all the new features in the JIRA 6.1 Release Notes and see what you are missing out on!

Download latest version ➔

Highlights

This release is jam-packed full of bug fixes. We've fixed over 60 issues in this bugfix release, which is about three times the usual number. These include a number of highly voted issues as well as security fixes.

Check out the full list of updates and fixes below. Here are a few of the highlights:

- JIRA no longer inserts unwanted images when exporting issues to Excel. See:
JIRA 6.4 Documentation

- When doing an export from JIRA the report is inserting unwanted images. **RESOLVED**
- JIRA now supports the attachment of CMYK jpeg files. See: **RESOLVED**
- Previews for the 'Pie Chart' and 'Created v. Resolved' macro now work correctly when used in Confluence. See: **RESOLVED**
- Activity Streams should now use relative URLs for internal content, rather than the JIRA base URL. See: **RESOLVED**
- The JIRA mail handler should no longer create duplicate issues when the email is not processed correctly. See: **RESOLVED**
- Administrators are now able to turn outgoing email on or off (previously, only System Administrators were able to do this). System Administrator access is still required to configure outgoing mail servers. See: **RESOLVED**
- We now have a Bitbucket importer. For details see the documentation.

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the **JIRA 6.1.1 Upgrade Notes**.

**Updates and fixes in this release**

JIRA 6.1.1 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-3220</td>
<td>Ability to detect a changed username in Crowd or &quot;JIRA User Server&quot;</td>
<td><img src="https://example.com" alt="" /></td>
<td>Mar 20, 2013</td>
<td>Jul 31, 2014</td>
<td>Unassigned</td>
<td>Mark Lassau [Atlassian]</td>
<td></td>
</tr>
<tr>
<td>JRA-34888</td>
<td>NCC-J1-3 Administrator to System Administrator escalation</td>
<td><img src="https://example.com" alt="" /></td>
<td>Sep 18, 2013</td>
<td>Dec 02, 2013</td>
<td>Roman Tekhov [Atlassian]</td>
<td>David Black</td>
<td></td>
</tr>
<tr>
<td>JRA-35019</td>
<td>Changing a project key then moving an issue with attachments into that newly-changed project causes the attachments on the issue to become unavailable</td>
<td><img src="https://example.com" alt="" /></td>
<td>Sep 26, 2013</td>
<td>Feb 03, 2014</td>
<td>Pawel Niewiadomski [Atlassian] Nick Mason [Atlassian]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-34911</td>
<td>'Pie Chart' and 'Created v. Resolved' macro preview do not display when used in Confluence</td>
<td><img src="https://example.com" alt="" /></td>
<td>Sep 17, 2013</td>
<td>May 03, 2015</td>
<td>Roman Tekhov [Atlassian]</td>
<td>Paul Greig</td>
<td></td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
JIRA 6.1.1 Upgrade Notes

Upgrading from JIRA 6.1 to 6.1.1

Follow the instructions in the general upgrading JIRA documentation. In addition, note the following:

jira.clone.link.legacy.direction flag removed

In this release, we have removed the jira.clone.link.legacy.direction flag from the Advanced Settings in JIRA. This flag reversed the outward and inward descriptions for the link when an issue was cloned. The upgrade tasks for this release will point all links in the correct direction, i.e. descriptions will not be reversed.

Upgrading from JIRA 6.0.x and earlier

In addition to the above, please read the JIRA 6.1 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0 Release Notes

Meet the new JIRA


JIRA 6.0 is a completely new JIRA. The redesigned look and feel brings a whole new user experience to JIRA. It is modern and simple, clearing away the clutter so that you can get your work done faster.

This release also includes a new detail view for search results, faster issue viewing, a mobile interface for JIRA, workflow sharing, features to help you get started faster, enterprise improvements, and much more!

Download latest version

JIRA 6.0 Upgrade Notes

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
New JIRA look and feel

JIRA 6.0 introduces a modernised look and feel that follows the new Atlassian Design Guidelines. The new user experience doesn't just look great, it also helps you get your work done faster. Information is easier to find and common tasks are simpler.

The new JIRA look and feel is consistent with other Atlassian applications, so users will find it easy to use JIRA with Confluence, Bitbucket, Stash and other Atlassian products.

New detail view and view issue improvements

JIRA is optimised to let you quickly navigate lists of issues and take action on those items that need your immediate attention. The new detail view lets you view an issue within the context of the filter it is a part of, showing you both at the same time. We have also streamlined the interaction with the View Issue screen and removed page loads to speed things up.

Learn more...
JIRA mobile

Take JIRA everywhere! You can now view mobile-optimised versions of JIRA pages on your iPhone or Android phone. Simply browse to your JIRA server’s URL using your mobile browser to bring up the mobile interface for JIRA.

The JIRA mobile interface is designed for viewing and interacting with issues on the go — triage your tasks for the day on the train, assign an issue to someone during a meeting, mention them in a comment, and more.

Learn more...

Workflow sharing

The new Workflow Sharing feature lets you import a workflow directly from the Atlassian Marketplace, enabling you to use workflows that other people have published. You can also use this feature to move a workflow from staging to production in your own organisation or to share your own custom workflows.

Learn more...
Get started fast!

JIRA 6.0 continues the work that we began in JIRA 5.1 and 5.2 to get you started faster with JIRA. When you create a new project, you can now select from different types of projects including Scrum and Kanban. The new administration gadget provides a handy checklist of tasks to get JIRA set up quickly, as well as links to useful functions and documentation.

Select Project Type

- **Blank Project**: Start a project without any preconfigured settings.
- **Bug Tracking**: Capture, monitor and triage bugs.
- **Software Development**: View your development tasks (including integrated source and build info, if configured).
- **Project Management**: Track your project status via work logs, project dashboards, and reporting.
- **Agile Scrum**: Manage your product development with backlogs, stories, and sprints.
- **Agile Kanban**: Constrain work-in-progress and manage your task flow.

Import from external system  

**Next**  **Cancel**
Enterprise scale

**Improvements**

![](JIRA 6.4 Documentation)

- **Editable usernames** — The second most requested feature, as determined by customer votes, is here! JIRA Administrators can now edit any username in the JIRA Internal Directory. [Learn more...]
- **Global workflow schemes** — Now you can edit an active workflow scheme on a project: a draft is created, and the migration is handled through the normal migration process. [Learn more...]
- **Translate custom fields** — Customers whose users operate in different languages can now translate the names and descriptions of custom fields.
- **JIRA to JIRA issue copy** (Marketplace Plugin) — For customers with more than one JIRA server, you can copy an issue from one project to another, even if the projects aren't on the same JIRA instance. [Learn more...]

**Resources**

Enterprise Resources are best practice guides for running Atlassian applications at high levels. Here are some of our more recent offerings:

- **Getting Started with JIRA Scale**
  - JIRA Sizing Guide
  - Scaling JIRA
  - Federating JIRA - Managing Multiple Instances

And more!

There's plenty more JIRA 6.0 features below to get excited about, but we think that this one is pretty cool. The **Auto look and feel** feature was a [20% project](#) by one of our JIRA developers, Graeme Smith. With a single click, you can automatically apply a color scheme to JIRA that matches your company logo. Check out the example below:
Click to view the other features and improvements in this release:

> Learn more...
• **Stable search** — Now, when you search, your search results remain constant until you choose to refresh them. This provides you with a stable set of search results that you can work from when triaging issues.

• **Docking and undocking the filter panel** — You can now hide the filter panel to gain more screen real estate. Simply click **Undock** at the top right of the panel.

• **Bulk watch/unwatch feature** — You can now start or stop watching multiple issues using the watch / stop watching bulk operation. Learn more...

• **Browse Project Summary** — Starting a new project? You’ll be greeted by a more informative screen when you next browse your empty project's summary.

• **New plugin points for the User Profile page** — For the ecosystem developers, we have implemented new plugin points for the web panels in the User Profile page. Learn more...

• **Reports have moved** — We have moved reports from the dropdown menu on the Browse Project > Summary tab to a panel on the same tab, making them more accessible.

• **Relative time used in date/time formats** — Issue date/time fields show a relative instead of absolute date/time format (for example: Yesterday 12:00 PM instead of 20 May 2013 12:00 PM). You can still see the absolute date/time by hovering over the field.

• **Global autowatch configuration** — We’ve implemented a new JIRA option that allows administrators to disable the autowatch feature (introduced in JIRA 5.0.3) for all users. To configure autowatch for all users, navigate to Administration > User Preferences (in Users section) > Default autowatch.

• **Maximum project name size and maximum project key size configuration** — JIRA administrators will be able to set the maximum size for both the project name and project key in this release. Navigate to Administration > System > General Configuration and update Maximum project name size or Maximum project key size as desired.

• **Application Navigator with configurable links** — JIRA administrators can now configure links that appear in a handy dropdown menu in the JIRA header. Learn more...

• **More direct access to JIRA Administration**

  ![](image)

  The JIRA Admin page is no more. Instead of selecting Cog menu > JIRA Admin > Projects (for example), you skip the JIRA Admin page and select Cog menu > Projects, shown in the image to the right.

  Select the Cog menu to go straight to the Administration panel you are looking for. In this case, Cog menu > Projects.

  Click Search JIRA Admin to access the g + g shortcut menu.

  Click any option in the new Admin header to go to that page.

• **Supported platforms** — JIRA 6.0 supports Internet Explorer 10 and PostgreSQL 9.0. Learn more...
Special Thanks

Special thanks to our 3rd party developers that maintain open source plugins for OnDemand! These folks keep the great open source plugins that are a part of JIRA OnDemand up to date with each release, making sure you continue to get great use from our most popular plugins.

- JIRA Timesheet Report and Portlet Plugin – Andriy Zhdanov
- JIRA Suite Utilities – Beecom – Stefan Forstmoser
- JIRA Misc Workflow Extensions – David Fischer

The JIRA 6.0 team

*Development*

Adam Jakubowski  
Aleksander Mierzwicki  
Andreas Knecht  
Andrew Swan  
Antoine Büsch  
Anund McKague  
Ben Wong  
Brenden Bain  
Chris Darroch  
Chris Doble  
Chris Fuller  
Chris Mountford  
Dariusz Kordonski  
David Tang  
Edward Zhang  
Eric Dalgliesh  
Filip Rogaczewski  
Gilmore Davidson  
Ian Grunert  
Jaiden Ashmore  
James Hatherly  
James Hazelwood  
James Winters  
Jeroen De Raedt  
Jimmy Kurniawan  
Joanne Cranford  
Jonathan Raoult  
Jonathon Creennaue  
Joshua Ali  
Joshua Hansen  
Justus Pendleton  
Luis Miranda  
Lukasz Włodarczyk  
Maciej Nowakowski  
Mark Lassau  
Markus Kramer  
Martin Henderson  
Martin Jopson  
Martin Meinhold  
Michael Elias  
Michael Ruflin  
Michael Tokar  
Michal Orzechowski
Mike Sharp
Nick Menere
Nikolay Petrov
Oswaldo Hernandez
Pawel Niewiadomski
Robert Smart
Roman Tchek
Scott Harwood
Sean Curtis
Sergio Cinos
Slawek Ginter
Trevor Campbell
Wojciech Seliga
Wojciech Urbanski

Architecture
Matt Quail
Brad Baker

Support
Sydney support
Michael Andreacchio
David Currie
Renjith Pillai
Christopher Shim

Amsterdam support
Ruchi Tandon
Alex Conde
Yilin Mo
Peter Koczan
John Inder
Theodore Tzidamis

Brazil support
Eric Kieling
Pedro Cora
Matheus Fernandes
Lucas Timm
Marcus Silveira
Pietro Schaff
Tiago Kolling Comasseto
Andre Quadros Petry

Kuala Lumpur support
Kumar Ramajjulu
Voon Kiat Gan
Janet Albion
Richie Gee
Chung Park Chan
Ahmad Danial
Amanda Wei Sai Nan Wei
John Chin Kim Loong
Daryl Chuah
Daniel Leng
Joe Wai Tye
Immanuel Siagian
Vicky Kharisma
Ahmad Faisal
Yew Teck En
Zulfadli Noor Sazali
Ala Al-Shargabi

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Overview

Please follow the instructions in the general Upgrading JIRA guide, as well as the JIRA 6.0-specific instructions in the sections below. The general ‘Upgrading JIRA’ guide contains important tasks that are essential for getting your upgraded JIRA installation to work correctly and if necessary, migrating existing configurations.

This page also describes known issues as well as changes you should be aware of before deciding whether or not to upgrade to JIRA 6.0.
This page includes:

- Overview
- Known issues
  - Migrated pre-6.0 worklogs with mixed-case usernames are disassociated from authors
  - Get a sorted list of searchable fields is more than 160 times slower in JIRA 6 than in JIRA 5.2
- Upgrading to JIRA 6.0 from JIRA 5.2.x
  - Disabling inline edit no longer allowed
  - You may need to upgrade your GreenHopper version to work with JIRA 6.0
  - Cloners workarounds need to be disabled
  - JSON-P no longer supported
- Upgrading to JIRA 6.0 from JIRA 5.1.8 or earlier
- Information for JIRA developers

Known issues

**Migrated pre-6.0 worklogs with mixed-case usernames are disassociated from authors**

With the transition in JIRA 6 to user keys in lieu of user names, the pre-6.0 issue worklog is not being migrated correctly in the case of users who had LDAP-originating non-lowercase usernames. This results in the worklog entries not being associated with the user.

ℹ️ This will be fixed in an upcoming release.

[JIRA-33074](#) - Migrated pre-6.0 worklogs with mixed-case usernames are disassociated from authors [RESOLVED]

**Get a sorted list of searchable fields is more than 160 times slower in JIRA 6 than in JIRA 5.2**

This comes from the fact that translatable field names was introduced in JIRA 6, which means that JIRA has to get a property set for each field where the translated name is stored when it get the field's name. These property sets should be cached, but that is not currently happening.

ℹ️ This will be fixed in an upcoming release.

[JIRA-33065](#) - Searchable Fields Slow - Get a sorted list of searchable fields is more than 160 times slower [RESOLVED]

**Upgrading to JIRA 6.0 from JIRA 5.2.x**

**Disabling inline edit no longer allowed**

We've removed the ability to disable inline edit because the preferred way to edit issues is with inline editing and we want to encourage use of this feature. This option is no longer available in [JIRA Admin](#) (under System > General Configuration).

**You may need to upgrade your GreenHopper version to work with JIRA 6.0**

GreenHopper versions older than 6.2 will not be compatible with JIRA 6.0.

**Cloners workarounds need to be disabled**

Any customers upgrading to JIRA 6.0 that applied a workaround for the cloners link type – see [clone operation creates link in the wrong direction](#) for details – may need to reverse that workaround.

**JSON-P no longer supported**

JSON-P will not be supported in JIRA 6.0 for security reasons: it is possible for an attacker use this to view information in a JIRA instance that they do not have permission to see.

If you have built integrations that rely on JSON-P, you can override this by setting the `atlassian.allow.js` system property to `true`.

**Creating a new project: Select Project Type dialog known behaviour**

Please note, in JIRA 6.0, choosing Blank Project, Bug Tracking, Software Development or Project Management in the new Select Project Type dialog will create the same default JIRA project. We are in the process of developing pre-configured project templates for project types. We are considering custom workflows,
sample data, preset issue types, default fields, etc, for these templates. Your use of the dialog will give us with valuable data to help us build the right project types.

**Upgrading to JIRA 6.0 from JIRA 5.1.8 or earlier**

In addition to the points listed above, please read the Important Version-Specific Upgrade Notes for every version of JIRA you are skipping.

**Information for JIRA developers**

JIRA 6.0 is a major release for JIRA. As a result, there are a number of changes that may break add-ons. These include changes to JIRA's stable (Java) API, changes to core JIRA CSS styles, changes to JavaScript components that build UI, changes to HTML markup patterns. For details, please see: Preparing for 6.0.

**JIRA 6.0.8 Release Notes**

**3 September 2013**

The Atlassian JIRA team announces the release of **JIRA 6.0.8**. This point release contains several updates and fixes.

Upgrading to JIRA 6.0.8 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 6.0 yet?**

Take a look at all the new features in the **JIRA 6.0 Release Notes** and see what you are missing out on!

![Download latest version](image)

**Highlights**

- The performance of the issue navigator in Internet Explorer 8 has been significantly improved. See this issue: [JRA-29497](#).
- Temporary images when created when adding attachments to issues will now be cleaned up properly. See this issue: [JRA-21854](#).
- A number of gadget rendering problems have been fixed. See these issues: [JRA-34261](#), [JRA-34235](#).

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the **JIRA 6.0.8 Upgrade Notes**.

**Updates and fixes in this release**

JIRA 6.0.8 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JIRA-34869</td>
<td>&quot;Create Project&quot; dialog not coming up for fresh 6.0.8</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34512</td>
<td>Create Project fails without error on JIRA 6.0.7</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34648</td>
<td>Create Project Link Broken</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34328</td>
<td>Issue security / Project permission check failed after user renamed on JIRA 6</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34271</td>
<td>Performance of comment and change history searches is poor in large instances.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34235</td>
<td>The cog gadget in dashboards returns XML instead of rendering in the browser</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34218</td>
<td>Exact phrase searches should only match on the non-stemmed content of the target field</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34204</td>
<td>Internet Explorer 8 + 10 broken (Assigned to me gadget)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
JIRA 6.0.8 Upgrade Notes

Upgrading from JIRA 6.0.x to 6.0.8

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0.7 Release Notes

20 August 2013

The Atlassian JIRA team announces the release of JIRA 6.0.7. This point release contains several updates and fixes.

Upgrading to JIRA 6.0.7 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.0 yet?

Take a look at all the new features in the JIRA 6.0 Release Notes and see what you are missing out on!

Download latest version

Highlights

Simple Issue Tracking project

This project provides you with a quick and easy way to get JIRA up and running for simple issue tracking. For details on working with this project, see Simple Issue Tracking project.
Software Development project

This project provides you with a template to use for software development. For details on working with this project, see Software Development project.

Important fixes

- GreenHopper and Bonfire will soon be renamed to "JIRA Agile" and "JIRA Capture" respectively. See this blog post for details: [http://blogs.atlassian.com/2013/06/simplify/](http://blogs.atlassian.com/2013/06/simplify/). You will notice some of these name changes in this release of JIRA.
- We do not support Chrome Frame for Internet Explorer, however JIRA previously directed the browser to use it if it was available. JIRA no longer does this. See this issue: [JIRA-33941](http://issues.atlassian.com/browse/JIRA-33941) - X-UA Compatibility Meta Tag in JIRA 6 templates should come before any script tags
- Integrity checker preview breaks when issues have missing workflows. See this issue: [JIRA-4714](http://issues.atlassian.com/browse/JIRA-4714) - Integrity checker preview breaks when issues have missing workflows

This release also contains performance improvements.

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.0.7 Upgrade Notes.

Updates and fixes in this release

JIRA 6.0.7 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>JIRA-34211</td>
<td>Stemming should not be done on exact phrase text searches</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-34129</td>
<td>com.atlassian.sal.jira.user.DefaultUserManager#getUserRemoteUser() breaks interface contract for anonymous users</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-30652</td>
<td>Cannot translate date period for Instant Searcher's bar.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JIRA-4714</td>
<td>Integrity checker preview breaks when issues have missing workflows</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.0.7 Upgrade Notes

Upgrading from JIRA 6.0.x to 6.0.7

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0.6 Release Notes

6 August 2013
The Atlassian JIRA team announces the release of JIRA 6.0.6. This point release contains several updates and fixes.

Upgrading to JIRA 6.0.6 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.0 yet?
Take a look at all the new features in the JIRA 6.0 Release Notes and see what you are missing out on!

Download latest version

Highlights

- Issue searches using wildcards have been improved. See these issues:
  - JRA-19216 - Wildcard search does not work if prefix is over 14 characters and
  - JRA-6187 - wildcard search fails to find matches

- The create issue dialog has been improved. See these issues:
  - JRA-33652 - Attachment files are lost after changing project or issue type on create issue pop-up screen
  - JRA-27544 - When creating a bug and "create another is checked" the description and time tracking fields are not cleared when creating the bug

- Upgrade bug due a missing entry in the moved_issue_key table has been fixed. See this issue:
  - JRA-34024 - Upgrade to 6.0.5 Fails due to Missing moved_issue_key Entry

This release also contains a number of minor security fixes.

Upgrading from a previous version of JIRA
If you are upgrading, please read the JIRA 6.0.6 Upgrade Notes.

**Updates and fixes in this release**

JIRA 6.0.6 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-34653</td>
<td>As a User, I would like the Issue Navigator to auto complete users' Email and Username, in addition to their Real Name.</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-33103</td>
<td>JIRA to Programmatically disable IE compatibility mode</td>
<td></td>
<td>CLOSED</td>
</tr>
<tr>
<td></td>
<td>JRA-34024</td>
<td>Upgrade to 6.0.5 Fails due to Missing moved_issue_key Entry</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-32692</td>
<td>In JIRA setup page cannot enter license key</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33966</td>
<td>Race condition occurs between JIRA and plugins with it8n translation</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33765</td>
<td>The JIRA setup wizard fails to set an indexing language when the user does not change the default locale</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-6187</td>
<td>wildcard search fails to find matches</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-34161</td>
<td>Searches cannot find users that were deleted before upgrade</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-34003</td>
<td>Attachment field labels don't toggle the checkboxes</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33920</td>
<td>Unpleasant Changes on Gadgets on the latest releases</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33880</td>
<td>No project Id in version data of Rest request</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33849</td>
<td>Some of the REST resources in Navigator plugin are susceptible to XSRF attacks</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33843</td>
<td>Project Edit Is Broken If Project Lead Is A Renamed User</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33764</td>
<td>Set the correct indexing language for all bundled language packs</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-33652</td>
<td>Attachment files are lost after changing project or issue type on create issue pop-up screen</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-31209</td>
<td>View Problem with Very long Summary name that has no space</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-27544</td>
<td>When creating a bug and &quot;create another is checked&quot; the description and time tracking fields are not cleared when creating the bug</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-19216</td>
<td>Wildcard search does not work if prefix is over 14 characters</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

18 issues

JIRA 6.0.6 Upgrade Notes

Upgrading from JIRA 6.0.x to 6.0.6

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0.5 Release Notes

23 July 2013

The Atlassian JIRA team announces the release of JIRA 6.0.5. This point release contains several updates and fixes.

Upgrading to JIRA 6.0.5 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.0 yet?

Take a look at all the new features in the JIRA 6.0 Release Notes and see what you are missing out on!
Highlights

- Administrators can now configure the level of stemming applied when indexing JIRA (English only). Stemming is the process of reducing derived words to their root or stem form. This can be used to improve the relevance of search results, depending on the content in JIRA. See this issue:

  - JRA-33739 - Stemming options for indexing in the english language [RESOLVED]
  
  This also resolves this long-standing related issue with 75 votes!

- JQL searches of more than 2,000 characters now work correctly on all browsers. See this issue:

  - JRA-31774 - JQL length limitation on Chrome and Firefox [RESOLVED]

  Please note however, that the JQL statement is part of the JIRA search page URL. Hence, a JQL statement may still be limited by the length of the URL allowed by the browser (e.g. 4,000 characters on Internet Explorer 8). See this issue:

  - JRA-33848 - Allow URLs on the issue navigator to work for any size JQL. [OPEN]

- This release also contains a number of security fixes.

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.0.5 Upgrade Notes.

Updates and fixes in this release

JIRA 6.0.5 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-34160</td>
<td>Reflected XSS in JIRA Admin Panel (Delete User)</td>
<td>Aug 05, 2013</td>
<td>Jul 22, 2014</td>
<td>Unassigned</td>
<td>Gjoko Krstic</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JRA-33678</td>
<td>Reflected XSS in JIRA Admin Panel (Delete User)</td>
<td>Jul 01, 2013</td>
<td>Jul 22, 2014</td>
<td>Eric Dalgliesh</td>
<td>Gjoko Krstic</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JRA-33492</td>
<td>Share dialog appears outside viewport in details view</td>
<td>Jun 14, 2013</td>
<td>Jul 23, 2013</td>
<td>Eric Dalgliesh</td>
<td>Luis Miranda</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JRA-31608</td>
<td>The base URL setting does not accept numeric characters in the top level label</td>
<td>Feb 07, 2013</td>
<td>Jun 30, 2014</td>
<td>Eric Dalgliesh</td>
<td>Yilin MO [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JRA-28172</td>
<td>Potential remote code execution via SOAP add attachments path traversal in SoapAttachmentHelperImpl.java</td>
<td>May 08, 2012</td>
<td>Jul 23, 2013</td>
<td>Eric Dalgliesh</td>
<td>Dan Hodson</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JRA-28034</td>
<td>EditUserProperty action doesn't validate the passed key parameter</td>
<td>May 01, 2012</td>
<td>Dec 30, 2013</td>
<td>Eric Dalgliesh</td>
<td>Martin Meinhold [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JRA-5567</td>
<td>Incorrect stemming causes some words to be unsearchable</td>
<td>Dec 29, 2004</td>
<td>May 03, 2015</td>
<td>Oswaldo Hernandez [Atlassian] Bugmaster</td>
<td>Jeff Turner [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JRA-36441</td>
<td>Path traversal in JIRA Importers plugin (Windows only)</td>
<td>Jan 10, 2014</td>
<td>Mar 17, 2015</td>
<td>Unassigned</td>
<td>Renan Battaglin</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td></td>
</tr>
<tr>
<td>JIRA-34008</td>
<td>ProjectRole Migration from 5.1.3 to 6.1-m03</td>
<td>Jul 23, 2013</td>
<td>Jul 24, 2013</td>
<td>Unassigned</td>
<td>Frédéric Cilia</td>
<td>↓ RESOLVED</td>
<td>Duplicate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA-33905</td>
<td>Upgrade DVCS plugin within JIRA</td>
<td>Jul 15, 2013</td>
<td>Jul 30, 2013</td>
<td>Eric Dalgliesh</td>
<td>David Chan</td>
<td>↓ RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA-33766</td>
<td>View application properties page does not display the end-user i18n message for the Indexing Language setting</td>
<td>Jul 08, 2013</td>
<td>Apr 22, 2015</td>
<td>Eric Dalgliesh</td>
<td>Oswaldo Hernandez [Atlassian] Bugmaster</td>
<td>↓ RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA-33761</td>
<td>Update iCal to fix the tests</td>
<td>Jul 08, 2013</td>
<td>Jul 23, 2013</td>
<td>Eric Dalgliesh</td>
<td>Eric Dalgliesh</td>
<td>↓ RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA-33650</td>
<td>Pressing 's' on the view issue page does not work after the share dialog is dismissed as a result of scrolling.</td>
<td>Jun 27, 2013</td>
<td>Jul 23, 2013</td>
<td>Eric Dalgliesh</td>
<td>Bradley Ayers</td>
<td>↓ RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Showing 20 out of 22 issues

JIRA 6.0.5 Upgrade Notes

Upgrading from JIRA 6.0.x to 6.0.5

Please follow the instructions in the general upgrading JIRA documentation. Please also take note of the following:

- **Known issue**: Upgrading to JIRA 6.0.5 fails due to missing entry in moved_issue_key table. We recommend that you upgrade to JIRA 6.0.6 or later instead. Otherwise, to work around this issue, disable auto-export. Please ensure that you back up your data before you upgrade, if you disable auto-export.
  
  See [JIRA-34024 - Upgrade to 6.0.5 Fails due to Missing moved_issue_key Entry](RESOLVED).

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0.4 Release Notes

9 July 2013

The Atlassian JIRA team announces the release of JIRA 6.0.4. This point release contains several updates and fixes.

Upgrading to JIRA 6.0.4 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.0 yet?

Take a look at all the new features in the JIRA 6.0 Release Notes and see what you are missing out on!

[Download latest version](#)

**Highlights**

- Custom mail handlers will now work correctly. See this issue:
### JIRA 6.4 Documentation

**Update from a previous version of JIRA**

If you are upgrading, please read the JIRA 6.0.4 Upgrade Notes.

**Updates and fixes in this release**

JIRA 6.0.4 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Re</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-32516</td>
<td>Admin XSS in Issue Navigator when Day/Month/Year Format contains markup</td>
<td>Apr 10, 2013</td>
<td>Jul 09, 2013</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Pawel Bugalski</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-32515</td>
<td>Admin XSS in Worklog when Complete Date/Time Format is containing markup</td>
<td>Apr 10, 2013</td>
<td>Jul 09, 2013</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Pawel Bugalski</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-36442</td>
<td>Path traversal in JIRA Issue Collector plugin (Windows only)</td>
<td>Jan 10, 2014</td>
<td>Mar 17, 2015</td>
<td></td>
<td></td>
<td>Unassigned</td>
<td>Renan Battaglin</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33604</td>
<td>Regression: Upgrading JIRA get index error: ORA-00972: identifier is too long when running JIRA with Oracle</td>
<td>Jun 24, 2013</td>
<td>Sep 26, 2014</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Daniel Leng</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-31322</td>
<td>REST session not terminated</td>
<td>Jan 16, 2013</td>
<td>Jan 30, 2014</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Chung Park Chan</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-30451</td>
<td>Mail Handler popup configuration seems to have lost the ability to access the 'com/atlassian/jira/plugins/mail/ServiceConfiguration' class</td>
<td>Nov 08, 2012</td>
<td>Mar 17, 2015</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>mk</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-29545</td>
<td>JIRA is appending charset=UTF-8 to images</td>
<td>Aug 30, 2012</td>
<td>Jan 27, 2015</td>
<td></td>
<td></td>
<td>Oswaldo Hernandez</td>
<td>James Winters</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-34947</td>
<td>Freeze in loading screen when create Project using Enter key</td>
<td>Sep 23, 2013</td>
<td>Dec 30, 2013</td>
<td></td>
<td></td>
<td>Unassigned</td>
<td>John Chin Kim Loong</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-34472</td>
<td>Sorting in 'Filter Results' gadget for Project does not work correctly</td>
<td>Aug 23, 2013</td>
<td>Aug 23, 2013</td>
<td></td>
<td></td>
<td>Unassigned</td>
<td>Zulfadli Noor Sazali</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33700</td>
<td>With the new ADG design we seem to be losing the number of issues we can display on the Issue Navigator</td>
<td>Jul 02, 2013</td>
<td>Jul 09, 2013</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Eric Dalglish</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33699</td>
<td>Text is cut off when Project Picker Custom Field item is selected from dropdown</td>
<td>Jul 02, 2013</td>
<td>Jul 09, 2013</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Eric Dalglish</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33698</td>
<td>Favourite filters do not use all of the available vertical space</td>
<td>Jul 02, 2013</td>
<td>Apr 01, 2014</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Eric Dalglish</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33697</td>
<td>Share buttons do not show share link if outgoing mail is disabled</td>
<td>Jul 02, 2013</td>
<td>Jul 09, 2013</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Eric Dalglish</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33696</td>
<td>When clicking browser's Back button with the Share dialog opened, it remains open</td>
<td>Jul 02, 2013</td>
<td>Jul 11, 2013</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Eric Dalglish</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33695</td>
<td>Quickview doesn't respect plugin panel weighting</td>
<td>Jul 02, 2013</td>
<td>Jul 09, 2013</td>
<td></td>
<td></td>
<td>Eric Dalglish</td>
<td>Eric Dalglish</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
<tr>
<td>JRA-33694</td>
<td>Mention's drop down does not get displayed</td>
<td>Jul 02, 2013</td>
<td>Jul 09, 2013</td>
<td></td>
<td></td>
<td>Eric</td>
<td>Eric</td>
<td></td>
<td>Resolved</td>
<td>Fix</td>
</tr>
</tbody>
</table>
Showing 20 out of 35 issues

JIRA 6.0.4 Upgrade Notes

Upgrading from JIRA 6.0.x to 6.0.4

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0.3 Release Notes

25 June 2013

The Atlassian JIRA team announces the release of JIRA 6.0.3. This point release contains several updates and fixes.

Upgrading to JIRA 6.0.3 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.0 yet?

Take a look at all the new features in the JIRA 6.0 Release Notes and see what you are missing out on!

Download latest version

Highlights

New default workflow behaviour

In order to be able to start progress on an issue, a user must have the 'Assignble User' permission. When a user starts progress on an unassigned issue, the issue gets automatically assigned to that user. Similarly, any user with this permission can stop progress on an issue, although in this case the issue does not get reassigned to the user doing so.

This is different from the classic default JIRA workflow in the following ways:

- Previously, when you started progress on an issue, it did not change the assignee to the current user. Whoever the assignee was at that time would remain as the issue's assignee.
- In the classic default JIRA system workflow, only the issue assignee was able to execute the 'Start Progress' and 'Stop Progress' transitions. Now, as long as you have 'Assignble User' permission, you can execute this step.

Classic JIRA workflow available from Atlassian Marketplace

The classic default JIRA system workflow prior to this JIRA release is now available on Atlassian Marketplace.

- Classic Default JIRA Workflow

If you import this workflow, you will need to add the 'Clear Resolution' post function back to the following three transitions:

- Start Progress
- Stop Progress
- Reopen Issue

To add a new post function, see this procedure.
All newly created issues are now unassigned by default
The default for 'Allow Unassigned Issues' is set to ON for new instances. The 'Default Assignee' is set to 'Unassigned' when you create a new project, see Defining a Project for details.

Existing instances keep the current default ('Allow Unassigned Issues' is set to OFF).

JIRA Redmine Importer now available
The JIRA Redmine Importer plugin allows you to import data from the Redmine Issue Tracker product into your local JIRA site. For more information, see Importing Data from Redmine.

Important Fixes

- We have improved the performance of the JIRA issue collector (see [JRA-31971](#JRA-31971) - Issue collector causes performance issues on host JIRA instance [RESOLVED](#RESOLVED)). Please be aware, if you edit an issue collector (e.g. change the trigger), there may be a delay of up to an hour until users see the updated issue collector in the target system, due to browser caching. Alternatively, the user can refresh the page in their browser to see the updated issue collector immediately.
- The date/time picker for JIRA now works correctly on all browsers (see [JRA-26265](#JRA-26265) - Date Time custom field doesn't calculate current time [RESOLVED](#RESOLVED)).
- There are a few minor security (XSS/XSRF) fixes in this release. Please see the list of fixes below for details.

Upgrading from a previous version of JIRA
If you are upgrading, please read the JIRA 6.0.3 Upgrade Notes.

Updates and fixes in this release
JIRA 6.0.3 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-33788</td>
<td>Basic search in Issue Navigator can't find by username to autocomplete in Assignee and Reporter field</td>
<td>Jul 09, 2013</td>
<td>Jul 31, 2014</td>
<td>Unassigned</td>
<td>Amanda Wei [Atlassian]</td>
<td>[RESOLVED]</td>
<td>Obsolete</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-33355</td>
<td>After logo upload, &quot;Undo&quot; link doesn't revert the colour scheme</td>
<td>Jun 03, 2013</td>
<td>Jun 25, 2013</td>
<td>Oswaldo Hernandez [Atlassian] Bugmaster</td>
<td>Graeme Smith [Atlassian]</td>
<td>[RESOLVED]</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-32739</td>
<td>Return to search link disappears after adding screenshot to issue</td>
<td>Apr 23, 2013</td>
<td>Mar 03, 2014</td>
<td>Unassigned</td>
<td>Jason Slubbings</td>
<td>[RESOLVED]</td>
<td>Cannot Reproduce</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Showing 20 out of 36 issues

JIRA 6.0.3 Upgrade Notes

Upgrading from JIRA 6.0.x to 6.0.3

Please follow the instructions in the general upgrading JIRA documentation.

Error message when using JIRA with Oracle 11g

If you have JIRA connected to Oracle 11g and upgrade to JIRA 6.0.3, you will see the following error message:

```
Error was: java.sql.SQLSyntaxErrorException: ORA-00972: identifier is too long
```

This error does not have any functional impact on JIRA and can be ignored. See this KB article for more details.

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0.2 Release Notes

12 June 2013

The Atlassian JIRA team announces the release of JIRA 6.0.2. This point release contains several updates and fixes.
Upgrading to JIRA 6.0.2 is free to all customers with active JIRA software maintenance.

Don't have JIRA 6.0 yet?

Take a look at all the new features in the JIRA 6.0 Release Notes and see what you are missing out on!

Download latest version

**Highlights**

- Complex issue filter relationships (where filters rely on other filters) should now work correctly (see [JRA-28270](#) - JQL Cycle Detection Regression (4.4 -> 5.0) [RESOLVED](#)).
- Webhooks should now pick up all issue events when a large number of issues are modified at the same time, i.e. bulk edit (see [JRA-33289](#) - Webhooks lose "hits" in the event of a bulk edit [RESOLVED](#)).
- The dashboard now conforms to Look and Feel changes correctly (see [JRA-21043](#) - Dashboard does not obey link "Look and feel" options [RESOLVED](#)).
- Project shortcuts now work on the View Issue page (see [JRA-33064](#) - Project shortcuts broken on view issue page [RESOLVED](#)).

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 6.0.2 Upgrade Notes.

**Updates and fixes in this release**

JIRA 6.0.2 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-33294</td>
<td>Add a log entry when outgoing mail has been enabled / disabled</td>
<td>May 29, 2013</td>
<td>Jul 31, 2014</td>
<td></td>
<td>Unassigned</td>
<td>Oswaldo Hernandez</td>
<td></td>
<td>CLOSED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-31419</td>
<td>REST JQL returns error messages without returning valid issues</td>
<td>Jan 24, 2013</td>
<td>Jan 08, 2015</td>
<td></td>
<td>Unassigned</td>
<td>Joshua Tjhin</td>
<td></td>
<td>CLOSED</td>
<td>Duplicate</td>
</tr>
<tr>
<td>JRA-23287</td>
<td>Searching for an issue key that doesn't exist with JQL should not cause a query/validation error.</td>
<td>Dec 16, 2010</td>
<td>Oct 07, 2014</td>
<td></td>
<td>Unassigned</td>
<td>Ryan Ackley</td>
<td></td>
<td>CLOSED</td>
<td>Duplicate</td>
</tr>
<tr>
<td>JRA-33597</td>
<td>Can't open closed issues</td>
<td>Jun 23, 2013</td>
<td>Jun 24, 2013</td>
<td></td>
<td>Unassigned</td>
<td>Alex</td>
<td></td>
<td>RESOLVED</td>
<td>Support Request</td>
</tr>
<tr>
<td>JRA-29446</td>
<td>A NullPointerException is thrown when the user navigates to the Issue Type Tab for a Project</td>
<td>Aug 22, 2012</td>
<td>Jun 12, 2013</td>
<td></td>
<td>Oswaldo Hernandez [Atlassian] Bugmaster</td>
<td>Janet Abion [Atlassian]</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JIRA</td>
<td>Views&gt;On Dashboard dialog does not scroll</td>
<td>Apr 18, 2011</td>
<td>Jun 19, 2013</td>
<td>Unassigned</td>
<td>Penny Wyatt</td>
<td>RESOLVED</td>
<td>Obsolete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------------</td>
<td>--------------</td>
<td>--------------</td>
<td>-------------</td>
<td>-------------</td>
<td>----------</td>
<td>----------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA</td>
<td>Kickass navigator performance is below par for some types of queries in large instances</td>
<td>Jun 05, 2013</td>
<td>Jun 12, 2013</td>
<td>Eric Dalgliesh</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA</td>
<td>Workflow Import from MPAC doesn't show all available workflows</td>
<td>Jun 05, 2013</td>
<td>Jun 05, 2013</td>
<td>Unassigned</td>
<td>Josh Devenny</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA</td>
<td>Moving subtasks around causes a page pop and the search context to be lost</td>
<td>Jun 05, 2013</td>
<td>Jun 05, 2013</td>
<td>Sergio Cinos [Atlassian]</td>
<td>Jaiden Ashmore [Atlassian]</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA</td>
<td>Plugins can't get access to their i18n keys during plugin enablement event</td>
<td>May 27, 2013</td>
<td>Jun 12, 2013</td>
<td>Oswaldo Hernandez [Atlassian]</td>
<td>Bugmaster</td>
<td>James Winters [Atlassian]</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>JIRA</td>
<td>Workflow export icons mixed up</td>
<td>May 15, 2013</td>
<td>Jun 12, 2013</td>
<td>Eric Dalgliesh</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA</td>
<td>DUE date searcher is giving incorrect results when asking for issues &quot;not overdue&quot;</td>
<td>May 14, 2013</td>
<td>Jun 12, 2013</td>
<td>Eric Dalgliesh</td>
<td>Brenden Bain [Atlassian]</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA</td>
<td>Issuekey in JQL search should have an option to not fail if issuekey doesn't exist</td>
<td>May 13, 2013</td>
<td>Oct 02, 2014</td>
<td>Oswaldo Hernandez [Atlassian]</td>
<td>Bugmaster</td>
<td>James Dunay [Atlassian]</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
</tbody>
</table>

Showing 20 out of 28 issues

JIRA 6.0.2 Upgrade Notes

Upgrading from JIRA 6.0.x to 6.0.2

Please follow the instructions in the general upgrading JIRA documentation. Error message when using JIRA with Oracle 11g

If you have JIRA connected to Oracle 11g and upgrade to JIRA 6.0.2, you will see the following error message:

Error was: java.sql.SQLException: ORA-00972: identifier is too long

This error does not have any functional impact on JIRA and can be ignored. See this KB article for more details.

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 6.0.1 Release Notes

28 May 2013

The Atlassian JIRA team announces the release of JIRA 6.0.1. This point release contains several updates and fixes.

Upgrading to JIRA 6.0.1 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 6.0 yet?

Take a look at all the new features in the JIRA 6.0 Release Notes and see what you are missing out on!

Download latest version

Highlights

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
- Worklog entries are now correctly associated with users that have non-lowercase usernames from LDAP (see \[JIRA-33074\] - Migrated pre-6.0 worklogs with mixed-case usernames are disassociated from authors \[RESOLVED\] ).
- JIRA now allows you to share an issue with yourself, even if you have opted to not be notified of your own changes (see \[JIRA-31689\] - Cannot share issue with yourself if notifications are disabled for your own changes \[RESOLVED\] ).

### Performance improvements:
- Retrieving a sorted list of searchable fields is now much faster, e.g. "Group" select list on "Timesheet" report (see \[JIRA-33065\] - Searchable Fields Slow - Get a sorted list of searchable fields is more than 160 times slower \[RESOLVED\] ).
- The IN operator for advanced searching is now up to 16 times faster for JIRA instances with a large number of projects (see \[JIRA-32402\] - The "in" operator cause performance issue when having a huge number of project \[RESOLVED\] ).
- You are now able to navigate back to the main create project dialog after choosing an option (see \[JIRA-33287\] - Add a 'Back' button to the create project dialog \[CLOSED\] ).

## Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 6.0.1 Upgrade Notes.

### Updates and fixes in this release

JIRA 6.0.1 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA-33287</td>
<td>Add a 'Back' button to the create project dialog</td>
<td></td>
<td>May 28, 2013</td>
<td>Oct 30, 2014</td>
<td>Unassigned</td>
<td>Roy Krishna [Atlassian]</td>
<td></td>
<td></td>
<td>CLOSED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JIRA-33074</td>
<td>Migrated pre-6.0 worklogs with mixed-case usernames are disassociated from authors</td>
<td></td>
<td>May 15, 2013</td>
<td>Nov 29, 2014</td>
<td>Unassigned</td>
<td>Scott Dudley [Arsenale]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JIRA-32738</td>
<td>Impossible to import a single project when it does not contain value for the related Greenhopper customfield</td>
<td></td>
<td>Apr 23, 2013</td>
<td>May 15, 2014</td>
<td>Paul Slade</td>
<td>Yilin MO [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JIRA-25479</td>
<td>Plugin/Version tag missing from export xml</td>
<td></td>
<td>Aug 23, 2011</td>
<td>May 15, 2014</td>
<td>Unassigned</td>
<td>Jeff DeCew</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Duplicate</td>
</tr>
<tr>
<td>JIRA-33187</td>
<td>Labels-Searcher doesn't work properly</td>
<td></td>
<td>May 22, 2013</td>
<td>May 24, 2013</td>
<td>Unassigned</td>
<td>Nils Hartmann</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Cannot Reproduce</td>
</tr>
<tr>
<td>JIRA-28421</td>
<td>Screen Jumps when I Click Action Button on Dashboard and Move My Mouse to the Action Box</td>
<td></td>
<td>May 29, 2012</td>
<td>Apr 20, 2015</td>
<td>Unassigned</td>
<td>Andromeda Sain [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Obsolete</td>
</tr>
<tr>
<td>JIRA-33704</td>
<td>what's new content/JIRA Welcome page) not working! JIRA is running behind proxy and configured with SSL</td>
<td></td>
<td>Jul 02, 2013</td>
<td>Oct 17, 2014</td>
<td>William Paoli [Atlassian]</td>
<td>Daryl Chuah</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>JIRA-33341</td>
<td>Some worklog display in user name instead of full name after JIRA upgraded from 5.1 to 6.0</td>
<td></td>
<td>May 31, 2013</td>
<td>Jun 16, 2013</td>
<td>Unassigned</td>
<td>Jimmy Shen</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Duplicate</td>
</tr>
<tr>
<td>JIRA-33251</td>
<td>Incoming and Outgoing mail server pages have misplaced buttons</td>
<td></td>
<td>May 27, 2013</td>
<td>May 28, 2013</td>
<td>Eric Dalgliesh</td>
<td>Chris Darroch [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JIRA-33224</td>
<td>JIRA wallboard Twitter gadget no longer works</td>
<td></td>
<td>May 24, 2013</td>
<td>Jun 18, 2013</td>
<td>Eric Dalgliesh</td>
<td>Martin Jopson [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JIRA-33223</td>
<td>permalink links don't take you to the comment</td>
<td></td>
<td>May 24, 2013</td>
<td>Jan 21, 2014</td>
<td>Unassigned</td>
<td>Eric Dalgliesh</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
<tr>
<td>JIRA-33222</td>
<td>&quot;No matches&quot; shown in search when matches actually exist</td>
<td></td>
<td>May 24, 2013</td>
<td>May 28, 2013</td>
<td>Eric Dalgliesh</td>
<td>Zehua Liu [Atlassian]</td>
<td></td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
JIRA 6.0.1 Upgrade Notes

Upgrading from JIRA 6.0 to 6.0.1

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 5.2.x and earlier

In addition to the above, please read the JIRA 6.0 Upgrade Notes and as well as Skipping Major Versions When Upgrading JIRA if you are skipping any major JIRA versions.

JIRA 5.2 Release Notes

12 November 2012

Find clarity faster

Focus on what matters most with JIRA 5.2

The completely redesigned JIRA search lets you quickly find and organise your issues, so you – and your team – can focus on what matters most. Getting the job done!

JIRA 5.2 also includes enterprise scale improvements, redesigned project workflows, new webhooks integration, help features for new users and much more.
Instant search

We made it easier to create and edit issues with inline editing in JIRA 5.1 and the create/edit issue dialog in JIRA 5.0. In this release, we’re making it easier for you to find issues fast.

The new instant search bar and search results let you build the right query the first time. Shared filters are easily accessible on the search page, helping each team member to track progress towards common goals. You can keep across your own priorities at a glance with pre-built system filters for the most common views in JIRA.

- **New system filters** — Easily filter for the most common views in JIRA: ‘My Open Issues’, ‘Reported by Me’, ‘Recently Viewed’ and ‘All Issues’.
- **Favourite filters on the navigator** — Quickly switch between views. Your favourite filters are now just a click away.
- **Intuitive filter management** — See who owns a filter at a glance and whether changes have been made.
- **New search bar** — Simply select the criteria you want in your search. Focus on the search criteria you care about and hide the rest.
- **Ad-hoc searches** — Search and refine on-the-fly with immediate results. Refresh your results without reloading your page.
- **Complex searches** — Create and execute complex searches with ease. The new search UI makes this simple, regardless of the number of projects, custom fields, or your JIRA configuration.

Read the documentation...
Enterprise scale Improvements

JIRA now has the option of **re-indexing issues in the background**, so your users can use JIRA as normal. We’ve also made a number of other performance improvements.

*Learn more...*

**Background re-index** — JIRA now has the option of re-indexing issues in the background. Performing a background re-index allows your users to use JIRA as normal. You won't need to schedule system-wide downtime just to perform a re-index.

**Performance improvements** — This release includes a multitude of performance improvements. You may not notice every tweak we've made, but it all adds up to a better user experience.

- Faster loading of the View Issue page — Smarter loading of attachment thumbnails and the speed to render wiki markup has been increased.
- **Issue search** — Faster results for searching (up to four times faster) when a project has an extremely large number of issue type or custom fields.
- **Searching with large "NOT IN" clauses** — Searches with clauses like "fixVersion not in releasedVersions()" are now at least ten times faster, depending on the data size.
- **Other areas of increased performance** — GreenHopper queries that use nested filters, managing project versions with an extremely large list (all browsers except Internet Explorer), and calculating the assignee field when performing large bulk edits.
- **Indexing** — More low level Lucene options exposed so you can tune Lucene to perform better in your specific environment.
- **Smarter use of memory** — Reduction in the memory required to interpret Velocity files, resulting in faster page loads.
- **Faster exports** — XML exports with Postgres and MySQL are no longer put into memory. They are now done in batches which allows JIRA to back up extremely large instances.
- **Faster imports** — The garbage collection profile has been improved, resulting in less memory churn and a better performing import process.
- **Notification table** — This table is no longer used and will automatically be deleted, resulting faster backups and imports as there is less data to migrate.

**Reduced Memory Usage**

- **More efficient Search Index caching** — Memory usage of searches has improved tenfold. This is particularly noticeable on very large instances that are very busy.
- **Removed the massive memory use of Postgres and MySQL in data export** — You no longer need to increase memory size to very large amount to get an export to work.
- **Smarter pooling of UI rendering resources** — This change saves 90MB of memory.

**SSL configuration via the JIRA configuration tool** — If you want to run JIRA over SSL or HTTPS, you won't need to tinker around in XML files anymore. The JIRA configuration tool has a new screen that lets you easily configure access via HTTPS. The configuration tool also validates your configuration, so you won't need to worry if you've mistakenly entered an invalid certificate. Read the documentation...
The JIRA data generator now supports more complex data requirements. We've also developed an HTTP requests log analyser to help you performance-tune your JIRA instance.

Improved JIRA Data Generator — In JIRA 5.1, we built the JIRA Data Generator as part of our Enterprise performance work. This tool helps customers create large JIRA data sets quickly, which is useful for testing how your instance will perform at a projected rate. We also released a set of performance test scripts that can be used to test against data sets created by the JIRA Data Generator. In this release, we've improved the JIRA Data Generator to support screen schemes and field configurations. The tool is not bundled with JIRA, but it is free and customers can get it from the Atlassian Marketplace: JIRA Data Generator.

HTTP Request Log Analyser — The new JIRA HTTP Request Log Analyser provides an analysis of the traffic on your JIRA instance, such as the maximum requests per minute, that can help you performance-tune your JIRA instance. We originally developed this tool to help our customers provide us with performance data for their JIRA instances. This tool is not bundled with JIRA, but it is available as a free download. We also have a summary of the results from our JIRA instances and from some anonymous customers.

Guides

We've written two new enterprise guides on federating JIRA and scaling GreenHopper. We've also published our investigations into custom field performance.

New guides — Federating JIRA - Managing Multiple Instances and Scaling JIRA Agile.

Enterprise resources — If you haven't browsed our enterprise resources before, you can find them here: Enterprise Resources. You'll find guides on scaling JIRA, establishing staging server environments for JIRA, garbage collection tuning, and more.

Custom field performance — In JIRA 5.1, we gave our Enterprise customers the Scaling JIRA guide which explains how customers can get the most out of JIRA in large deployments. This guide describes how there are many factors that affect JIRA performance, besides the total number of issues. One of these factors is custom fields. In this release, we've investigated how the configuration of custom fields can affect performance. You can view our findings in the updated Scaling JIRA guide.
Webhooks for issues

Managing information between systems is a challenge. Do you want to post notifications from JIRA to a chat room? Do you want bug changes to be pushed from JIRA to a test management system? Do you want to send an SMS when issues transition in your workflow?

Webhooks provide you with a lightweight mechanism for letting remote applications receive push notifications from JIRA. No polling required.

Learn more...

Simply register a webhook in JIRA with the URL where the callback should be sent. Any time any issue changes in JIRA, a JSON notification will be sent to the URL.

You can also refine webhooks to suit your needs:

- Constrain a webhook to fire for a set of issues and/or specific issue events.
- Use a variable to include the key of the issue that fired it.
- Configure a workflow post-function to fire a webhook.

Read the documentation...
Intuitive workflow administration

Change is necessary for innovation. In this release, we've redesigned project workflows configuration and screen design to help you quickly adapt JIRA to your team's needs.

Configuring project workflows is easier and faster. View diagrams for all workflows for a project on a single page. Review your changes in draft format before publishing.

You'll also find screen design much more intuitive. Drag-and-drop and autocomplete help make this complex task much simpler.

Learn more...

Following on from the improvements to workflow administration in JIRA 4.4 and project administration in JIRA 5.1, we're continuing to make editing workflows easier within your project. You'll still have the power and flexibility of JIRA workflows at your fingertips, but configuration is much more intuitive.

Project workflows are now shown as a visual representation — a diagram of each project workflow is displayed in a table, with the associated issue types alongside. The old text-based view of each workflow is still available as well, if you prefer.

Configuring project workflows is also much easier. Want to preview changes as a draft before publishing? Want to browse through diagrams of the workflows in the system when adding a workflow? Want to assign multiple issue types to a workflow in a single step? You can now do all of these tasks and more.

Read the documentation...

The screen designer has been overhauled in this release. Screens are as customisable as ever, however the user interface is faster and much simpler to use. You won't have to wrestle with controls when reordering — just drag and drop to move a field or tab. Autocomplete is now used when adding fields, making this process quicker and easier as well.

Read the documentation...
A helping hand for new users

For new installations, you now have the option of creating a demonstration project. This demonstration project contains a number of sample issues that explain some JIRA basics: searching for issues, keyboard shortcuts, and editing issues.

JIRA also has inline help tips to guide new users in getting the most out of JIRA, such as a handy message instructing users to create issues. Others include administrator-only tips for tasks like creating users and editing workflows.

And more!

There are plenty more features and improvements in this release, including:

- a streamlined Browse Project user interface to help you focus on the task at hand without distractions,
- the JIRA admin helper which helps you to troubleshoot notifications or find out why a users can/cannot view issues or custom fields,
- copying and editing of issue collectors,
- the universal plugin manager 2.7 including the request plugin feature,
- column ordering for standard JIRA gadgets,
- compatibility with Confluence Workbox Notifications, and
- platform improvements, including support for Java 7 and Tomcat 7.

Learn more...

Streamlined user interfaces for projects

We've been working hard to improve the user interface when you are browsing a project, so that you can concentrate on the task at hand without any distractions. The list of improvements are in the table below:
<table>
<thead>
<tr>
<th>UI Feature</th>
<th>Notes</th>
<th>Screenshot of new UI</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Create New Project</strong> button on the Browse Projects &gt; All Projects page</td>
<td>N/A</td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
<tr>
<td><strong>Browse Project &gt; Summary</strong> tab redesigned:</td>
<td></td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
<tr>
<td>• <strong>Administer Project</strong> button now available on the Browse Project page itself</td>
<td>• <strong>Administer Project</strong> button used to be on Browse Project &gt; Summary tab (now removed)</td>
<td></td>
</tr>
<tr>
<td>• <strong>Activity Stream</strong> only shows activity on JIRA issues and JIRA plugins</td>
<td>• <strong>Issues: Updated recently</strong> and <strong>Issue: Unresolved</strong> sections superseded by Activity Stream.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Issues: Updated recently</strong> section removed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Issue: Unresolved</strong> section removed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Versions: Unreleased</strong> section moved to different position on tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Show/hide toggle</strong> for additional versions removed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;<strong>Eyeball&quot; toggle</strong> replaced with smart switcher at bottom of list</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Standard issue filters</strong> directly available on Browse Project &gt; Issues page</td>
<td>Used to be in Filters dropdown on Browse Project &gt; Summary tab (now removed)</td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
<tr>
<td><strong>Standard issue filters</strong> directly available on Browse Version &gt; Issues page</td>
<td>Used to be in Filters dropdown on Browse Version &gt; Summary tab (now removed)</td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
<tr>
<td><strong>Standard issue filters</strong> directly available on Browse Component &gt; Issues page</td>
<td>Used to be in Filters dropdown on Browse Component &gt; Summary tab (now removed)</td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
<tr>
<td><strong>People</strong> section in Project Summary and page renamed to Roles</td>
<td>N/A</td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
<tr>
<td><strong>Project &gt; Popular Issues</strong> page redesigned</td>
<td>N/A</td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
<tr>
<td><strong>Project &gt; Labels</strong> page redesigned</td>
<td>N/A</td>
<td><img src="image" alt="Screenshot of new UI" /></td>
</tr>
</tbody>
</table>

**JIRA admin helper**

We've bundled the popular [JIRA admin helper plugin](https://www.atlassian.com/products/jira/admin-helper) in this release. This tool helps JIRA administrators to diagnose and fix any of the following problems:
• A custom field not showing on the View Issue, Edit Issue or Create Issue screens.
• A user being able to see an issue when they are not supposed to, or being unable to see an issue when they are supposed to.
• A user receiving a notification when they shouldn't have, or not receiving a notification when they should have.

Simply navigate to the issue and select the Where is my field?, Permission Helper or Notification Helper option from the More Actions menu. You can also access this via administration console (JIRA tab > Admin Helper).

Copying and editing issue collectors

In JIRA 5.1, we introduced the JIRA issue collector — letting you embed JIRA feedback forms in your websites that create issues in your JIRA instance. In this release, we've added the ability to edit and copy issue collectors. Tweak an existing issue collector or use it as the basis for an entirely new one.

Faster and more reliable mentions

We added mentions in JIRA 5.0, which gave JIRA users an easy way to share an issue with other users via email. This release includes a significant performance improvement to this feature. You'll notice that user names are suggested much more quickly, when you start typing after an '@' character. The suggested results are also more accurate and reliable.
Universal plugin manager 2.7

JIRA 5.2 now bundles the Atlassian Universal Plugin Manager 2.7.6 (we previously bundled UPM 2.1.5 in JIRA 5.1.8). This version of UPM includes the Request Plugin feature as well as user interface improvements. The Request Plugin feature provides users with a view of the Atlassian Plugin Marketplace in JIRA, allowing them to send requests for plugins to the JIRA system administrator. To find and request a plugin, click your user profile picture > Atlassian Marketplace in the JIRA header.

Column ordering for standard JIRA gadgets

Any customers who have followed this issue
- [JIRA-19083] - Allow ordering of fields in gadgets
- [CLOUD-4711] - Bundle Column Order Gadget Plugin
will be happy to know that our most recent Atlassian ShipIt has delivered column ordering for standard JIRA gadgets. In JIRA 5.2, you’ll be able to re-order columns for gadgets like the filter results gadget, by simply dragging and dropping.

Compatibility with Confluence Workbox Notifications

JIRA 5.2 is compatible with Confluence Workbox Notifications (introduced in Confluence 4.3). Read more in the Confluence 4.3 release notes.

Platform changes

We have made a number of platform changes in this release, including upgrading JIRA to run on Tomcat 7 and support for Java 7. Some of these changes affect the installation and upgrade process for JIRA.

Please read the upgrade guide for details.

JIRA 5.2 Upgrade Notes

Upgrading to JIRA 5.2 from JIRA 5.1.x

In this section:

- Application links can now be configured by administrators
- Default notification scheme associated with new projects
- Important information for Japanese customers
- Incomplete translations for some JIRA functionality
- JQL history has been removed from the new issue navigator
- JQL "contains" operator (~) now relates multiple words by AND rather than OR
- Known issue using Windows installer to upgrade
- MySQL driver no longer bundled with JIRA
- New 'lastViewed' JQL field
- Supported platforms changes
- Webhooks JQL filtering may not always match
- Filters that are longer than 2000 characters are not supported
- Information for JIRA developers
Please follow the instructions in the general Upgrading JIRA guide, as well as the JIRA 5.2-specific instructions in the sections below. The general 'Upgrading JIRA' guide contains important tasks that are essential for getting your upgraded JIRA installation to work correctly and if necessary, migrating existing configurations.

**Application links can now be configured by administrators**

In previous versions of JIRA, only system administrators could configure application links (e.g. link JIRA to Confluence). In this release, JIRA administrators also have access to application links configuration. JIRA administrators will be able to add, modify and remove application links and entity links. However, JIRA administrators will be restricted to using OAuth authentication for application links.

**Default notification scheme associated with new projects**

The Default Notification Scheme (shipped with JIRA) is now associated with all new projects by default. This means that if you have an outgoing (SMTP) mail server set up, email notifications will be sent as soon as there is any activity (e.g. issues created) in the new project. Existing projects are not affected.

**Important information for Japanese customers**

If you are using JIRA with Japanese chosen as the default language, please read the information on the page linked below before upgrading to JIRA 5.2:

- JIRA 5.2 Upgrade Note for Japanese Customers (Japanese version of the page: JIRA 5.2)

**Incomplete translations for some JIRA functionality**

Translations will be incomplete for a small set of JIRA functionality in this release. This mainly affects text for the new JIRA admin helper feature. Functionality that does not have translated text available will revert to English. Only the German translations will be 100% complete. We are aiming to provide full French and Spanish translations in JIRA 5.2.1.

**JQL history has been removed from the new issue navigator**

The new issue navigator no longer has a 'History' section when advanced searching. This section showed the JQL of advanced searches that had been run previously.

JQL History was not part of the new Issue Navigator scope of work, as we felt a lot of users would now be saving their filters which lessened the need for this functionality.

**JQL "contains" operator (-) now relates multiple words by AND rather than OR**

Previously, if you specified multiple words as the parameter for the "contains" operator (-) in JQL, the words would be logically related by an OR. This has been changed in this release, so that multiple words for a "contains" operator are related by an AND.

For example, if you enter summary ~ "issue collector" in an advanced search, it is now equivalent to entering summary ~ "issue" AND summary ~ "collector".

**Known issue using Windows installer to upgrade**

(JIRA 5.2.5 and earlier only) A known issue exists with the JIRA Windows installer where it will incorrectly use Tomcat 6 instead of Tomcat 7. This means that the JIRA service will not start after the upgrade. Please see this Knowledge Base article for details of the problem and workarounds.

**MySQL driver no longer bundled with JIRA**

The MySQL driver is no longer bundled with JIRA. In prior versions of JIRA, we shipped the MySQL driver under a commercial license from MySQL Americas, Inc. MySQL Americas, Inc. was acquired by Oracle Corporation as part of Oracle's acquisition of Sun Microsystems. Oracle no longer offers a commercial license for the MySQL driver on a standalone basis as part of a partner program.

Please note the following if you use JIRA with MySQL:

- **New installation** — If you are installing JIRA, the Setup Wizard will display an error if you try to select MySQL as the database. You must download the MySQL driver and copy it in the lib folder of your JIRA installation, as described in Connecting JIRA to MySQL. You will also need to restart JIRA/JIRA service. You will be able to complete the Setup Wizard when you next access JIRA in your browser.
- **Upgrade** — If you are upgrading JIRA and you are not using the recommended MySQL driver (JDBC Connector/J 5.1), you must back up the driver from your existing JIRA installation before the upgrade. You will need to copy it into the `lib` folder of your JIRA installation after it has been upgraded, as described in Connecting JIRA to MySQL. If you try to upgrade JIRA without doing this, JIRA will fail to start up after the upgrade (you will be able to see MySQL driver-related errors in the logs). If you are using the recommended MySQL driver (JDBC Connector/J 5.1), you do not need to do this. The driver will be automatically copied over during the upgrade process.

**New 'lastViewed' JQL field**

The new 'lastViewed' field in JQL (see documentation) lets you search for issues based on the date that they were last viewed/edited. This field is only available for Advanced Search, not Simple Search.

Please note, if you have currently configured your issue navigator to show a column named 'lastViewed' (i.e. you have custom field named 'lastViewed' that you are displaying in the issue navigator), you must rename it before upgrading. If not, the conflict in column names will cause problems with the issue navigator.

**Supported platforms changes**

- Java 7 and Tomcat 7.0.29 are now supported in JIRA 5.2. See Supported Platforms for details.
- Tomcat 5.5 is no longer supported in JIRA 5.2, as previously advised in this announcement.
- PostgreSQL 8.2 is no longer supported in JIRA 5.2, as previously advised in this announcement.
- Please also read this clarification on browser support for JIRA 5.2 and beyond.

**Webhooks JQL filtering may not always match**

When an issue is updated, two things are triggered — the issue is reindexed (to ensure the indexes are up to date) and a webhook is fired. If you are using a JQL-based webhook, it will need to confirm whether the issue that has just been updated meets the JQL criteria. The problem is that the reindex may occur after the webhook.

For example, if an issue currently meets the JQL criteria, but you update it so that it does not meet the criteria, the webhook may incorrectly fire anyway. This is because the webhook JQL matching may occur before the issue index is updated.

We are working to resolve this issue in a 5.2.x bugfix release and you can track the progress of the issue here.

**Filters that are longer than 2000 characters are not supported**

Filters that are longer than 2000 characters – criteria plus value – do not work in the JIRA 5.2.x Issue Navigator.

**Information for JIRA developers**

Please be aware of the following changes in JIRA 5.2, which are covered in more detail on the Preparing for JIRA 5.2 page:

- Changes to handling Message-IDs on notification emails
- Changes to rendering of block macros
- Newlines in issue Summary no longer allowed
- Easy way to re-use an existing Custom Field Searcher
- New ISSUE_COMMENT_DELETED_ID event

**Upgrading to JIRA 5.2 from JIRA 5.0.7 or earlier**

In addition to the points listed above, please read the Important Version-Specific Upgrade Notes for every version of JIRA you are skipping.

**JIRA 5.2 Upgrade Note for Japanese Customers**

We advise Japanese customers to read the following information before upgrading to JIRA 5.2, as well as the JIRA 5.2 Upgrade Notes.

Japanese translations are incomplete for the new issue navigator

If you are using JIRA with a Japanese chosen as the default language, then JIRA will incorrectly display a mixture of English and Japanese in some parts of the new issue navigator. Users who search for issues may be confused by the mixed language.

The following screenshots show examples of this problem (click to view full-size images):
This issue is being tracked [JIRA-30323 - Cannot translate new issue navigator.][RESOLVED]. We are aiming to fix this issue in JIRA 5.2.1, which is currently scheduled for 27 November 2012.

JIRA 5.2

**JIRA 5.2 Upgrade Notes**

JIRA

()
Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 5.2.11 Upgrade Notes.

Updates and fixes in this release

JIRA 5.2.11 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-30113</td>
<td>&quot;People and Dates Section&quot; of Issue View Screen Changed to 2 lines in Chrome after Jira 5.1.1</td>
<td>Oct 15, 2012</td>
<td>May 28, 2013</td>
<td>Unassigned</td>
<td>KhongMing KOK</td>
<td>Vassil Velichkov</td>
<td></td>
<td>RESOLVED</td>
<td>Obsolete</td>
</tr>
<tr>
<td>JRA-31549</td>
<td>FieldScreenTab configuration not saved consistently to database</td>
<td>Feb 03, 2013</td>
<td>May 08, 2013</td>
<td>Roman Tekhov [Atlassian]</td>
<td>Vassil Velichkov</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>JRA-30702</td>
<td>JIRA backup and restore does not handle map data stored by plugins correctly</td>
<td>Nov 26, 2012</td>
<td>Apr 19, 2013</td>
<td>Eric Dalgliesh</td>
<td>Trevor Campbell [Atlassian]</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>JRA-30748</td>
<td>Field names of 'Created Date' and 'Resolution Date' in issue nav are incorrect.</td>
<td>Nov 29, 2012</td>
<td>Apr 19, 2013</td>
<td>Eric Dalgliesh</td>
<td>Kan Ogawa</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>JRA-32803</td>
<td>URL encoding &quot;View Workflow&quot; link fail when workflow name contains &quot;&amp;&quot; character</td>
<td>Apr 26, 2013</td>
<td>Apr 29, 2013</td>
<td>Unassigned</td>
<td>Philipp Klauser</td>
<td></td>
<td>RESOLVED</td>
<td>Duplicate</td>
<td></td>
</tr>
<tr>
<td>JRA-31948</td>
<td>Upgrade Remote Apps to 0.4.518.6</td>
<td>Mar 05, 2013</td>
<td>Apr 19, 2013</td>
<td>Eric Dalgliesh</td>
<td>Don Brown [Atlassian]</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>JRA-31198</td>
<td>In mention e-mail notification issue link is broken</td>
<td>Jan 09, 2013</td>
<td>Apr 29, 2013</td>
<td>Eric Dalgliesh</td>
<td>Simone Houghton [Atlassian]</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>JRA-27809</td>
<td>&quot;View Workflow&quot; link does not work in case when workflow name contains special symbols</td>
<td>Apr 06, 2012</td>
<td>Oct 30, 2014</td>
<td>Eric Dalgliesh</td>
<td>Andrei</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
</tr>
</tbody>
</table>

8 issues

JIRA 5.2.11 Upgrade Notes

Upgrading from JIRA 5.2.x to 5.2.11

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

Upgrading from JIRA 5.1.x and earlier

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

JIRA 5.2.10 Release Notes

3 April 2013

The Atlassian JIRA team announces the release of JIRA 5.2.10. This point release contains several updates and fixes.

This will be the second-last release in the 5.2.x release cycle.

Upgrading to JIRA 5.2.10 is free to all customers with active JIRA software maintenance.

Don't have JIRA 5.2 yet?

Take a look at all the new features in the JIRA 5.2 Release Notes and see what you are missing out on!

Download Latest Version

Highlights
If you are upgrading from 5.1.x and earlier, JIRA will correctly ignore user preferences for JQL autocomplete in favour of the global JQL autocomplete setting (see [JIRA-30873 - JQL auto complete disabled on a user basis after upgrading to 5.2.x](#) ).

### Upgrading from a previous version of JIRA

If you are upgrading, please read the **JIRA 5.2.10 Upgrade Notes**.

### Updates and fixes in this release

**JIRA 5.2.10** includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-32503</td>
<td>Comment preview deletes current comment</td>
<td>Apr 09, 2013</td>
<td>Apr 10, 2013</td>
<td>Unassigned</td>
<td>Frederic Leitenberger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-32220</td>
<td>Performance - Description, Summary and Environment fields are being doubly indexed</td>
<td>Mar 20, 2013</td>
<td>Apr 08, 2013</td>
<td>Adam Jakubowski [Atlassian]</td>
<td>Eric Dalgliesh</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31793</td>
<td>JIRA attempts to apply group memberships when synchronising from a remote directory even if they already exist, causing a duplicate key violation</td>
<td>Feb 21, 2013</td>
<td>Mar 03, 2014</td>
<td>Adam Jakubowski [Atlassian]</td>
<td>Dave Mason [Atlassian]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31631</td>
<td>Upgrade Java to 6.43</td>
<td>Feb 11, 2013</td>
<td>Apr 03, 2013</td>
<td>Adam Jakubowski [Atlassian]</td>
<td>Eric Dalgliesh</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30873</td>
<td>JQL auto complete disabled on a user basis after upgrading to 5.2.x</td>
<td>Dec 07, 2012</td>
<td>May 03, 2015</td>
<td>Eric Dalgliesh</td>
<td>Pelle Kjerbye [Atlassian]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30513</td>
<td>Remove concatenation used to create view text / tooltip for date searchers</td>
<td>Nov 13, 2012</td>
<td>Apr 02, 2013</td>
<td>Roman Tekhov [Atlassian]</td>
<td>Jonathon Creenaune</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30455</td>
<td>Cancel link access key is not working when using the polish language pack from TAC</td>
<td>Nov 08, 2012</td>
<td>Mar 03, 2014</td>
<td>Adam Jakubowski [Atlassian]</td>
<td>Amanda Wei [Atlassian]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-24711</td>
<td>[Multi-line Text Editor] When clicking past the end of a line, the cursor is incorrectly placed at the start of the line</td>
<td>May 30, 2011</td>
<td>Apr 15, 2013</td>
<td>Unassigned</td>
<td>Daniel Laberge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-29879</td>
<td>The full name of the user is html escaped twice in the 'Edit Profile' administration page</td>
<td>Sep 26, 2012</td>
<td>Mar 03, 2014</td>
<td>Adam Jakubowski [Atlassian]</td>
<td>Andrew Brittan</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

16 issues
JIRA 5.2.10 Upgrade Notes

Upgrading from JIRA 5.2.x to 5.2.10

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

Upgrading from JIRA 5.1.x and earlier

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

21 March 2013

The Atlassian JIRA team announces the release of JIRA 5.2.9. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.9 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 5.2 yet?

Take a look at all the new features in the JIRA 5.2 Release Notes and see what you are missing out on!

[Download Latest Version]

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 5.2.9 Upgrade Notes.

Updates and fixes in this release

JIRA 5.2.9 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-23883</td>
<td>Validators used with Subtasks, when cloning the parent issues, causes inconsistencies</td>
<td>Mar 08, 2011</td>
<td>Nov 29, 2013</td>
<td>Eric Dalgliesh</td>
<td>Thiago Fagundes Prisco [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31656</td>
<td>An user without an email address fetched from a remote directory can not log in</td>
<td>Feb 12, 2013</td>
<td>Aug 10, 2013</td>
<td>Eric Dalgliesh</td>
<td>Peter Koczan [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-28224</td>
<td>Bad group list on comment visibility</td>
<td>May 10, 2012</td>
<td>Feb 09, 2014</td>
<td>Eric Dalgliesh</td>
<td>Paulo Vieira [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-28073</td>
<td>Import Results action / jsp is susceptible to XSRF</td>
<td>May 04, 2012</td>
<td>Mar 28, 2013</td>
<td>Eric Dalgliesh</td>
<td>David Black [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31204</td>
<td>NPE in EmailFormatterImpl.formatEmail - user picker and more not working</td>
<td>Jan 09, 2013</td>
<td>Jun 18, 2013</td>
<td>Eric Dalgliesh</td>
<td>Bjarni Thordarsonnsson [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30860</td>
<td>Permissions is spelt incorrectly in the project configuration summary page</td>
<td>Dec 06, 2012</td>
<td>Apr 11, 2013</td>
<td>Eric Dalgliesh</td>
<td>Don Willis [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-28217</td>
<td>Error message show up in the log file when user open Dashboard manage page without login</td>
<td>May 10, 2012</td>
<td>Nov 06, 2014</td>
<td>Eric Dalgliesh</td>
<td>Yilin MO [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30270</td>
<td>Defining a new priority that just contains a space for its name causes a huge exception to be generated</td>
<td>Oct 26, 2012</td>
<td>Jun 13, 2013</td>
<td>Eric Dalgliesh</td>
<td>Norman Abramovitz [Atlassian]</td>
<td>→ RESOLVED Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9 issues
JIRA 5.2.9 Upgrade Notes

Upgrading from JIRA 5.2.x to 5.2.9

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

Upgrading from JIRA 5.1.x and earlier

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

JIRA 5.2.8 Release Notes

7 March 2013
The Atlassian JIRA team announces the release of JIRA 5.2.8. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.8 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 5.2 yet?

Take a look at all the new features in the JIRA 5.2 Release Notes and see what you are missing out on!

Download Latest Version

Redesigned project summary for new projects

Starting a new project? You'll be greeted by a more informative screen when you next browse your empty project's summary.

The placeholder text provides guidance on what will appear on the summary, once the project has been populated. It also helps prompt users to get started creating issues and browsing the project.

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 5.2.8 Upgrade Notes.

Updates and fixes in this release

JIRA 5.2.8 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
</table>
**JIRA 5.2.8 Upgrade Notes**

**Upgrading from JIRA 5.2.x to 5.2.8**

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

**Upgrading from JIRA 5.1.x and earlier**

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

**JIRA 5.2.7 Release Notes**

**21 February 2013**

The Atlassian JIRA team announces the release of **JIRA 5.2.7**. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.7 is free to all customers with active JIRA software maintenance.

**Don’t have JIRA 5.2 yet?**

Take a look at all the new features in the **JIRA 5.2 Release Notes** and see what you are missing out on!
We’re continuing our work to help you get started faster. If you are setting up JIRA for the first time, you can now get a JIRA evaluation license without leaving the setup wizard. Just enter your my.atlassian.com account details (or create an account) in the setup wizard, and JIRA will generate an evaluation license for you.

Learn more...

Other highlights

- Synchronising JIRA with LDAP no longer fails for duplicate memberships (see JIRA-27353 - JIRA Sync Fails when detecting duplicate memberships [RESOLVED]).

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 5.2.7 Upgrade Notes.

Updates and fixes in this release

JIRA 5.2.7 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-30756</td>
<td>JIRA 5.2.1 Installer Service is NOT created in case of upgrade</td>
<td></td>
<td>Nov 29, 2012</td>
<td>May 01, 2014</td>
<td></td>
<td>Oswaldo Hernandez</td>
<td>Yilin MO [Atlassian]</td>
<td></td>
<td>RESOLVED</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>JIRA</th>
<th>Summary</th>
<th>Created</th>
<th>Updated</th>
<th>Resolved</th>
<th>Reporter</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-30699</td>
<td>JAVA_HOME System Variable</td>
<td>Nov 26, 2012</td>
<td>Apr 30, 2014</td>
<td>RESOLVED</td>
<td>Michal Orzechowski [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-29871</td>
<td>PropertyManager is not getting wired into the LdapShaPasswordEncoder, causing password change resulted in a NullPointerException</td>
<td>Sep 25, 2012</td>
<td>May 16, 2013</td>
<td>RESOLVED</td>
<td>Michal Orzechowski [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-27852</td>
<td>Security level no longer shows up with a red highlight on the view issue page</td>
<td>Apr 12, 2012</td>
<td>Feb 21, 2013</td>
<td>RESOLVED</td>
<td>Michal Orzechowski [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-27353</td>
<td>JIRA Sync Fails when detecting duplicate memberships</td>
<td>Mar 02, 2012</td>
<td>May 03, 2015</td>
<td>RESOLVED</td>
<td>Michal Orzechowski [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-20443</td>
<td>Interface defined in file with the wrong name</td>
<td>Feb 17, 2010</td>
<td>Sep 04, 2013</td>
<td>RESOLVED</td>
<td>Michal Orzechowski [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-32026</td>
<td>Created, Updated, and Resolved Date Time Field Format does not follow the System Default Language in XML</td>
<td>Mar 08, 2013</td>
<td>May 19, 2013</td>
<td>RESOLVED</td>
<td>Unassigned</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-31594</td>
<td>Error message shown when changing a filter owner to a non-existing user is hard coded to English</td>
<td>Feb 07, 2013</td>
<td>Feb 21, 2013</td>
<td>RESOLVED</td>
<td>Michal Orzechowski [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-31180</td>
<td>IP: do JRADEV-16876</td>
<td>Jan 08, 2013</td>
<td>Feb 21, 2013</td>
<td>RESOLVED</td>
<td>Unassigned</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-30186</td>
<td>Cannot reassign project specific filters if the original owner has been deleted</td>
<td>Oct 19, 2012</td>
<td>Apr 23, 2013</td>
<td>RESOLVED</td>
<td>Unassigned</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-24809</td>
<td>Wiki Style Renderer does not show the font in bold/italic when wiki link is within the bold/italic area (change in Wiki Renderer Behavior since JIRA 4.1.2)</td>
<td>Jun 10, 2011</td>
<td>Feb 26, 2013</td>
<td>RESOLVED</td>
<td>Ali Mohamed Jawad [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-24659</td>
<td>Italtics/bold etc doesn't work when an issue specification (like JIRA-12345) is between the underscores</td>
<td>May 23, 2011</td>
<td>Dec 12, 2013</td>
<td>RESOLVED</td>
<td>Unassigned</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-19888</td>
<td>Trying to create issue type name with more than 60 characters throws exception</td>
<td>Dec 01, 2009</td>
<td>Nov 26, 2013</td>
<td>RESOLVED</td>
<td>Michal Orzechowski [Atlassian]</td>
<td>Fixed</td>
</tr>
<tr>
<td>JRA-31717</td>
<td>Spelling mistake in german translation</td>
<td>Feb 15, 2013</td>
<td>Feb 18, 2013</td>
<td>RESOLVED</td>
<td>Matthias Hölzl</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

17 issues

JIRA 5.2.7 Upgrade Notes

Upgrading from JIRA 5.2.x to 5.2.7

Please follow the instructions in the general upgrading JIRA documentation.
Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

Upgrading from JIRA 5.1.x and earlier

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

JIRA 5.2.6 Release Notes

7 February 2013
The Atlassian JIRA team announces the release of JIRA 5.2.6. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.6 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 5.2 yet?

Take a look at all the new features in the JIRA 5.2 Release Notes and see what you are missing out on!

![Download Latest Version]

**Highlights**

- JIRA 5.2.6 now accepts imports from any JIRA OnDemand version from 3 Dec 2012 and later. See the migration guide.
- JIRA OnDemand exports can now be imported into JIRA instances that are already setup (see JRA-31239 - Remove Import From OD Data Restriction on an already setup JIRA Closed).
- Expired screenshot applet certificate error is now resolved (see JRA-31345 - Certificate for Screenshot Applet on latest JIRA version Expired Resolved).
- Mail notifications no longer fail when an LDAP user is removed but still listed as watcher (see JRA-30059 - Mail notification fails when LDAP user is removed but still listed as watcher Resolved).
- Users who are no longer in an AD/LDAP directory can now be removed from a Project Role within a Project (see JRA-25220 - AD/LDAP directory user who is no longer in that directory cannot be removed from Project Role within a Project Resolved).
- The clone operation has regained its sense of direction and now creates links in the correct direction (see JRA-24563 - Clone operation creates links in the wrong direction Resolved).

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 5.2.6 Upgrade Notes.

**Updates and fixes in this release**

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA</td>
<td>Issue Description</td>
<td>Created</td>
<td>Updated</td>
<td>Assignee</td>
<td>Resolution</td>
<td>Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>---------</td>
<td>---------</td>
<td>---------------------</td>
<td>------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-27018</td>
<td>Searching for text like a~1 breaks the current user’s issue search</td>
<td>Feb 02, 2012</td>
<td>Jun 19, 2013</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31850</td>
<td>Regression - The &quot;cloner&quot; relationship is inverted</td>
<td>Feb 26, 2013</td>
<td>Feb 11, 2015</td>
<td>Unassigned</td>
<td>RESOLVED</td>
<td>Duplicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31623</td>
<td>Issue Navigator Prompt “The JIRA server could not be contacted…” When Trying to Search in Customfield Date Picker</td>
<td>Feb 08, 2013</td>
<td>Feb 11, 2013</td>
<td>Unassigned</td>
<td>RESOLVED</td>
<td>Obsolete</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31606</td>
<td>Issue Nav plugin CSS broken in Chrome</td>
<td>Feb 07, 2013</td>
<td>Feb 13, 2013</td>
<td>Unassigned</td>
<td>RESOLVED</td>
<td>Obsolete</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31505</td>
<td>Transitions are not appearing in the SEARCH call on Rest API</td>
<td>Jan 30, 2013</td>
<td>Jan 15, 2013</td>
<td>Unassigned</td>
<td>RESOLVED</td>
<td>Duplicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31458</td>
<td>Webhooks does not appear to be initialised with custom events, throws NPE's for same</td>
<td>Jan 28, 2013</td>
<td>Jan 31, 2013</td>
<td>Unassigned</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31391</td>
<td>Update Team Calendars integration (a.k.a. Jira ical feed) to version 1.0.12</td>
<td>Jan 22, 2013</td>
<td>Mar 04, 2015</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31374</td>
<td>MailThreadManagerImpl can cause repeated OOMEs if inbound message has corrupt References header</td>
<td>Jan 21, 2013</td>
<td>Feb 07, 2013</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31101</td>
<td>The JIRA configuration tool does not expand abbreviated paths for the JIRA home</td>
<td>Dec 28, 2012</td>
<td>Feb 07, 2013</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30944</td>
<td>Deleting an LDAP user causes watchlist to hang</td>
<td>Dec 12, 2012</td>
<td>Feb 07, 2013</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30811</td>
<td>delete issue event does not play well with webhooks when using JQL filters</td>
<td>Dec 04, 2012</td>
<td>Feb 20, 2013</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30731</td>
<td>NullPointerException error is thrown in the logs when JIRA is sending custom event notifications</td>
<td>Nov 28, 2012</td>
<td>Sep 03, 2013</td>
<td>Ignat Alexeyenko</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-29481</td>
<td>Unable to remove deleted users in issue watcher list</td>
<td>Aug 24, 2012</td>
<td>Feb 07, 2013</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED</td>
<td>Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Showing 20 out of 25 issues
## Performance Improvements

- JIRA performance with FishEye integration is improved.

## Bug Fixes

- Page reload errors caused by a plugin passing a null into the macro are now fixed (see [JRA-30554](#) - Regression - /secure/EdiAction!default.jspa [velocity] Left side ($totalSize) of `=' operation has null value at templates/plugins/jira/macros.vm[line 8, column 16] RESOLVED).
- It's now safer to upgrade older versions of JIRA on Oracle (see [JRA-12304](#) - Oracle DB Text Columns Exceed 255 Character Limit on Import RESOLVED).

## Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 5.2.5 Upgrade Notes.

## Updates and fixes in this release

JIRA 5.2.5 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>T Created</th>
<th>Updated</th>
<th>Due</th>
<th>Assignee</th>
<th>Reporter</th>
<th>P</th>
<th>Status</th>
<th>Res</th>
</tr>
</thead>
<tbody>
<tr>
<td>JRA-30990</td>
<td>On the issue nav command+enter no longer opens the issue in a new window</td>
<td>Nov 07, 2012</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Wesley Walser</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30775</td>
<td>Regression - The Issue Navigator Charts are not showing what is reflected in the results of a search</td>
<td>Nov 30, 2012</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Ricardo Coutinho</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30919</td>
<td>Project Source tab is loading forever when having a huge number of project link with different repositories.</td>
<td>Dec 11, 2012</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Yilin MO [Atlassian]</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-25147</td>
<td>JIRA 4.4 introduced a possible NullPointerException in the DefaultWatcherManager</td>
<td>Jul 22, 2011</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Andreas Knecht</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-23947</td>
<td>Log Work Email contains raw velocity code in the URL for the worklog item.</td>
<td>Mar 16, 2011</td>
<td>Jul 18, 2013</td>
<td>Unassigned</td>
<td>Brenden Bain [Atlassian]</td>
<td>RESOLVED Dup</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31233</td>
<td>Ofbiz ALTER COLUMN messages should be logged at INFO level rather than WARN level</td>
<td>Jan 11, 2013</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Oswaldo Hernandez [Atlassian] Bugmaster</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31212</td>
<td>Upgrade to jira-fisheye-plugin 5.2.9</td>
<td>Jan 10, 2013</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31193</td>
<td>Don't auto-highlight entire field upon inline edit</td>
<td>Jan 08, 2013</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>philwiebe</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31179</td>
<td>Upgrade Team Calendars integration plugin to 1.0.11</td>
<td>Jan 08, 2013</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31100</td>
<td>Update Workbox plugins to 1.1.9</td>
<td>Dec 07, 2012</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-31098</td>
<td>Pie Chart Gadget showing incorrect totals for all contexts</td>
<td>Dec 27, 2012</td>
<td>Mar 18, 2015</td>
<td>Eric Dalgliesh</td>
<td>Adam Saint-Prix [Atlassian]</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JRA-30792</td>
<td>secure/IssueNavigator!executeAdvanced.jspa does not redirect to KA</td>
<td>Dec 03, 2012</td>
<td>Jan 21, 2013</td>
<td>Eric Dalgliesh</td>
<td>Eric Dalgliesh</td>
<td>RESOLVED Fixe</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
JIRA 5.2.5 Upgrade Notes

Upgrading from JIRA 5.2.x to 5.2.5

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

Upgrading from JIRA 5.1.x and earlier

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

JIRA 5.2.4.1 Release Notes

**10 January 2013**
The Atlassian JIRA team announces the release of **JIRA 5.2.4.1**. This version is functionally identical to JIRA 5.2.4.

See the JIRA 5.2.4 Release Notes for details on the release and installation/upgrade instructions.

JIRA 5.2.4.1 Upgrade Notes

JIRA 5.2.4.1 is functionally identical to JIRA 5.2.4.

See the JIRA 5.2.4 Upgrade Notes for instructions.

JIRA 5.2.4 Release Notes

**02 January 2013**
The Atlassian JIRA team announces the release of **JIRA 5.2.4**. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.4 is free to all customers with active JIRA software maintenance.

**Don’t have JIRA 5.2 yet?**

Take a look at all the new features in the JIRA 5.2 Release Notes and see what you are missing out on!

![Download Latest Version](image)

Removed ‘None’ option for Custom Fields

The following issue is fixed by upgrading to JIRA 5.2.4:

- If Select List is **Required** and has a **Default Value**, the ‘None’ option is **not displayed** when the Select List is edited.

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 5.2.4 Upgrade Notes.
**Updates and fixes in this release**

JIRA 5.2.4 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-31263</td>
<td>Long image attachments do not render correctly</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-31046</td>
<td>plugin installation via Admin Dashboard (GreenHopper, Bonfire) doesn't work on a fresh JIRA installation</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30994</td>
<td>High number of custom fields makes issue nav really slow in IE8</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30581</td>
<td>Runtime exceptions from translation modules can break the i18n cache</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-29363</td>
<td>Two Dimensional Filter Gadget not showing totals for all contexts at bottom of row/column</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-7687</td>
<td>Remove 'None' option if select list is required and has a default selected</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

6 issues

**JIRA 5.2.4 Upgrade Notes**

**Upgrading from JIRA 5.2.x to 5.2.4**

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

**Upgrading from JIRA 5.1.x and earlier**

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

**JIRA 5.2.3 Release Notes**

24 December 2012

The Atlassian JIRA team announces the release of **JIRA 5.2.3**. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.3 is free to all customers with active JIRA software maintenance.

**Don’t have JIRA 5.2 yet?**

Take a look at all the new features in the **JIRA 5.2 Release Notes** and see what you are missing out on!

[Download Latest Version](#)

**Fixed JQL limitations for webhooks**

We've fixed a number of known issues/limitations with JQL in webhooks in JIRA 5.2.2 and this release. In summary, the following issues will be fixed by upgrading to JIRA 5.2.3:

- currentUser() function now works correctly. Fixed in 5.2.2.
- A JQL query now returns the desired results when filtering for a field that changes frequently (see the 5.2 Upgrade Notes for a description of this issue). Fixed in 5.2.2.
- The ${issue.key} variable replacement now works in a webhook, when the webhook is used in a workflow post function. Fixed in this release.

**Upgrading from a previous version of JIRA**

If you are upgrading, please read the **JIRA 5.2.3 Upgrade Notes**.

**Updates and fixes in this release**

JIRA 5.2.3 includes the following updates and bug fixes:
<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-30716</td>
<td>Upgrade UPM to 2.7.10 - Offline mode is not disabling the requests</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30576</td>
<td>Ordering by Custom Field's name fails in the JQL</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30334</td>
<td>Sharing a search result with an email address from the new issue search shows a broken image</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30293</td>
<td>Duplicating issue when replying to e-mail</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-31146</td>
<td>Assignee selection - scrollbar disappears in IE9 when clicked</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30975</td>
<td>Column default sort order is incorrect</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30965</td>
<td>Wink Emoticon is generated incorrectly</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30668</td>
<td>Regression: Maximum jql error limit not enforced</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30490</td>
<td>Switch to advanced does not put the cursor in the JQL field</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30470</td>
<td>Search text filter gets improperly encoded when adjusting filter options</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30453</td>
<td>New sparkler criteria not taking effect if I do things quickly.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30408</td>
<td>Log in redirect in new Issue Nav does not return me to my search</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30597</td>
<td>Using enter to commit inline edit does not work for select list</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

13 issues

JIRA 5.2.3 Upgrade Notes

Upgrading from JIRA 5.2.x to 5.2.3

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

Upgrading from JIRA 5.1.x and earlier

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

JIRA 5.2.2 Release Notes

11 December 2012

The Atlassian JIRA team announces the release of JIRA 5.2.2. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.2 is free to all customers with active JIRA software maintenance.

Don’t have JIRA 5.2 yet?

Take a look at all the new features in the JIRA 5.2 Release Notes and see what you are missing out on!

![Download Latest Version](download_latest_version)

Administrators can now disable autowatch

We've implemented a new JIRA option that allows administrators to disable the autowatch feature (introduced in JIRA 5.0.3) for all users. To configure autowatch for all users, navigate to Administration > User Preferences (in Users section) > Default autowatch.

Users can choose to inherit the global autowatch setting or override it via their user Profile > Preferences > Autowatch setting.

Please note, if you are upgrading from an older version of JIRA, then all users who have not explicitly set their Autowatch setting will have it set to 'Inherit from global settings'.

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
**Upgrading from a previous version of JIRA**

If you are upgrading, please read the JIRA 5.2.2 Upgrade Notes.

**Updates and fixes in this release**

JIRA 5.2.2 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th></th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-28268</td>
<td>Provide administrators the ability to disable or default autowatch</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30593</td>
<td>Programmatically setting issueLinkType to non existing value makes indexing service throw NullPointerException and all issues disappear</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30590</td>
<td>NullPointerException error when moving issue between projects with different custom fields</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30575</td>
<td>'Road Map' title on Change Log screen</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30298</td>
<td>Regression: Searching for issues with invalid cascadingSelect option gives 500</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30489</td>
<td>Webhooks JQL filtering may not always match</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-28616</td>
<td>Issues tab empty under Browse project</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-26628</td>
<td>Adding comment fails with incorrect error message when the text content is too large</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>

8 issues

**JIRA 5.2.2 Upgrade Notes**

**Upgrading from JIRA 5.2.x to 5.2.2**

Please follow the instructions in the general upgrading JIRA documentation.

Please also read the Important Version-Specific Upgrade Notes for any JIRA 5.0.x versions you are skipping.

**Upgrading from JIRA 5.1.x and earlier**

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

**JIRA 5.2.1 Release Notes**

**28 November 2012**

The Atlassian JIRA team announces the release of JIRA 5.2.1. This point release contains several updates and fixes.

Upgrading to JIRA 5.2.1 is free to all customers with active JIRA software maintenance.

**Don't have JIRA 5.2 yet?**

Take a look at all the new features in the JIRA 5.2 Release Notes and see what you are missing out on!

```
Download Latest Version
```

**Reports have moved**

We have moved reports from the dropdown menu on the Browse Project > Summary tab to a panel on the same tab, so that they are more accessible.
New plugin points for the User Profile page

For the developers, we have implemented new plugin points for the web panels in the User Profile page. You can override the default 'Details', 'Preferences' and 'Assigned Open Issues per Project' web panels as well as add your own custom web panels.

Read the documentation...

Upgrading from a previous version of JIRA

If you are upgrading, please read the JIRA 5.2.1 Upgrade Notes.

Updates and fixes in this release

JIRA 5.2.1 includes the following updates and bug fixes:

<table>
<thead>
<tr>
<th>T</th>
<th>Key</th>
<th>Summary</th>
<th>P</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>JRA-30323</td>
<td>Cannot translate new issue navigator.</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30604</td>
<td>Regressions: Upgrading JIRA get index error: ORA-00972: identifier is too long when running JIRA with Oracle</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30518</td>
<td>JIRA 5.2 Installer Service is using Tomcat 6 instead of Tomcat 7</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30530</td>
<td>JIRA.InlineLayer is undefined in GreenHopper</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30436</td>
<td>Field Helper is accessible from Issue Nav and GreenHopper and gives incorrect answers</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30427</td>
<td>Losing Description of Sub-Tasks when moving parent issue to a project with a different text renderer</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30364</td>
<td>In new search UI, jq query for [text field] != [value] throws error</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30363</td>
<td>XSS in Issue Collector</td>
<td></td>
<td>RESOLVED</td>
</tr>
<tr>
<td></td>
<td>JRA-30318</td>
<td>Regression: Not in JQL operator displays incorrectly in basic mode</td>
<td></td>
<td>RESOLVED</td>
</tr>
</tbody>
</table>
JIRA 6.4 Documentation

20 issues

JIRA 5.2.1 Upgrade Notes

Upgrading from JIRA 5.2 to 5.2.1

Please follow the instructions in the general upgrading JIRA documentation.

Upgrading from JIRA 5.1.x and earlier

In addition to the above, please read the JIRA 5.2 Upgrade Notes and as well as the Important Version-Specific Upgrade Notes for the versions of JIRA you are skipping.

Security Advisories

As a public-facing web application, JIRA's application-level security is important. This document contains links to version-specific security advisories and related documents for the JIRA application.

This document is intended to provide information to system administrators about the security of the JIRA application. It does not address JIRA's internal security model — user management and permissions — except as it relates to the overall application security.

On this page:

- Finding and Reporting a Security Vulnerability
- Publication of JIRA Security Advisories
- Severity Levels
- Our Patch Policy
- Security Advisories

Finding and Reporting a Security Vulnerability

Atlassian's approach to reporting security vulnerabilities is detailed in How to Report a Security Issue.

Publication of JIRA Security Advisories

Atlassian's approach to releasing security advisories is detailed in Security Advisory Publishing Policy.

Latest security advisory:

- JIRA Security Advisory 2014-02-26
Severity Levels

Atlassian's approach to categorising security issues is detailed in Severity Levels for Security Issues.

Our Patch Policy

Atlassian's approach to releasing patches for security issues is detailed in Security Patch Policy.

Security Advisories

- JIRA Security Advisory 2014-02-26
- JIRA Security Advisory 2013-02-21
- JIRA Security Advisory 2012-08-28
- JIRA Security Advisory 2012-05-17
- JIRA Security Advisory 2011-09-27
- JIRA Security Advisory 2011-02-21
- JIRA Security Advisory 2010-12-06
- JIRA Security Advisory 2010-06-18
- JIRA Security Advisory 2010-04-16
- JIRA Security Advisory 2009-04-02
- JIRA Security Advisory 2008-12-09
- JIRA Security Advisory 2008-10-29
- JIRA Security Advisory 2008-08-26
- JIRA Security Advisory 2008-02-21
- JIRA Security Advisory 2007-12-24

JIRA Security Advisory 2011-02-21

This advisory announces a security vulnerability that has been found in all versions of JIRA prior to 4.2.2 and fixed in 4.2.2 and later versions. Enterprise Hosted customers should request an upgrade by filing a ticket at http://support.atlassian.com. JIRA Studio is not vulnerable to any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerability listed in this advisory has been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at http://support.atlassian.com.

In this advisory:
- Parameter-Based Redirection Vulnerability
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches

Parameter-Based Redirection Vulnerability

Severity

Atlassian rates this vulnerability as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank a vulnerability as critical, high, moderate or low. This vulnerability is not critical.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

Risk Assessment

Parameter-based redirection vulnerabilities allow an attacker to craft a JIRA URL in such a way that a user clicking on this URL will be redirected to a different web site. This can be used for phishing.

You can read more about link manipulation attacks at Wikipedia, and about phishing at Fraud.org and other places on the web.
Vulnerability

Some actions in JIRA redirect users to a new page after the action has been completed. It was possible to hand-craft an URL that would redirect to a site outside the current instance of JIRA. Starting with JIRA 4.2.2 all such redirections are limited to pages inside the current instance of JIRA.

All versions of JIRA prior to 4.2.2 are affected.

Risk Mitigation

We recommend upgrading your JIRA installation to fix this vulnerability. Please see the 'Fix' section below.

Fix

These issues have been fixed in JIRA 4.2.2 and later.

Patches

We have created a patch for the latest maintenance release 4.1.2 of JIRA for this vulnerability.

Please note that we have released a number of advisories about JIRA recently. We recommend that you review them and upgrade to the most recent release of the product or apply external security controls if you cannot. Most of the disclosed vulnerabilities are not critical and often present less risk when used in a corporate environment with no access from the Internet.

We usually provide patches only for vulnerabilities of critical severity, as an interim solution until you can upgrade. You should not expect that you can continue patching your system instead of upgrading. Our patches are often non-cumulative – we do not recommend that you apply multiple patches from different advisories on top of each other, but strongly recommend to upgrade to the most recent version regularly.

We recommend patching only when you can neither upgrade nor apply external security controls.

<table>
<thead>
<tr>
<th>Supported JIRA Version</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1.2</td>
<td>JRA-23842</td>
<td>patch-JRA-23842-4.1.2-a.zip</td>
<td>Download</td>
</tr>
</tbody>
</table>

Instructions on how to apply the patch are included in the zip file.

JIRA Security Advisory 2011-09-27

This advisory announces a number of security vulnerabilities that we have found in versions 4.2.x - 4.3.x of JIRA and fixed in version 4.4 of JIRA. You need to upgrade your existing JIRA installations to fix these vulnerabilities. Enterprise Hosted customers should request an upgrade by filing a ticket at http://support.atlassian.com, in the 'Enterprise Hosting Project'. JIRA Studio is not vulnerable to any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerabilities listed in this advisory have been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at http://support.atlassian.com/.

In this advisory:

- XSS Vulnerabilities in Labelling and Issue Linking
- XSS Vulnerability in Administration Interface of JIRA Bamboo Plugin

XSS Vulnerabilities in Labelling and Issue Linking

Severity

Atlassian rates the severity level of this vulnerability as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low. This vulnerability is not critical.
This is an independent assessment and you should evaluate its applicability to your own environment.

Risk Assessment

We have identified and fixed several cross-site scripting (XSS) vulnerabilities which may affect JIRA instances. XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a JIRA page. The attacker needs to have a valid user account in order to exploit this vulnerability.

You can read more about XSS attacks at cgisecurity, the Web Application Security Consortium and other places on the web.

Vulnerability

Issue linking:

- The way issue summaries were rendered when displaying issue links allows arbitrary JavaScript execution.
- Versions of JIRA 4.2.x to 4.3.x prior to 4.4 are affected.

Labelling:

- Certain issue labels could be created containing JavaScript, which then could be rendered on other pages.
- Versions of JIRA 4.2.x to 4.3.x prior to 4.4 are affected.

Risk Mitigation

We strongly recommend upgrading your JIRA installation to fix these vulnerabilities. Please see the 'Fix' section below.

Fix

These vulnerabilities have been fixed in JIRA 4.4 and later versions.

For a full description of the latest version of JIRA, see the release notes. You can download the latest version of JIRA from the download centre.

If you cannot upgrade to the latest version of JIRA, you can temporarily patch your existing installation of JIRA 4.3.x or JIRA 4.2.x using the patches listed below. We strongly recommend upgrading and not patching.

Patches

If you are running JIRA 4.3.x, you can apply the following patch to fix these vulnerabilities.

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
<th>Patch File Name</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking and Labelling</td>
<td>Attached to issue JR A-24773</td>
<td>JRA-24773-4.3.4-patch.zip</td>
<td>JRA-24773-4.3.4-patch-instructions.txt</td>
</tr>
</tbody>
</table>

If you are running JIRA 4.2.x, you can apply the following patch to fix these vulnerabilities.

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
<th>Patch File Name</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking and Labelling</td>
<td>Attached to issue JR A-24773</td>
<td>JRA-24773-4.2.4-patch.zip</td>
<td>JRA-24773-4.2.4-patch-instructions.txt</td>
</tr>
</tbody>
</table>

XSS Vulnerability in Administration Interface of JIRA Bamboo Plugin

Severity

Atlassian rates the severity level of this vulnerability as **high**, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low. This vulnerability
This is not critical. This is an independent assessment and you should evaluate its applicability to your own environment.

**Risk Assessment**

We have identified and fixed a cross-site scripting (XSS) vulnerability which may affect JIRA instances. XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a JIRA page. The attacker does not need a valid user account in order to exploit this vulnerability.

You can read more about XSS attacks at [cgisecurity](http://www.cgisecurity.com), the Web Application Security Consortium and other places on the web.

**Vulnerability**

JIRA administration interface (Bamboo plugin):

- There is a non-persistent XSS vector in the JIRA administration interface related to managing JIRA Bamboo settings.
- Versions of JIRA 4.3.x are affected.

**Risk Mitigation**

We strongly recommend upgrading your JIRA installation to fix this vulnerability. Please see the ‘Fix’ section below.

**Fix**

This vulnerability has been fixed in JIRA 4.4 and later versions.

For a full description of the latest version of JIRA, see the release notes. You can download the latest version of JIRA from the download centre.

If you cannot upgrade to the latest version of JIRA, you can upgrade only the Bamboo Plugin in your existing installation of JIRA 4.3.x or JIRA 4.2.x using the patches listed below. We strongly recommend upgrading full JIRA instance instead of a single plugin.

**Patches**

If you are running JIRA 4.3.x, use the plugin manager to upgrade the Bamboo plugin to a version equal to or greater than that specified in the file name below. Both Bamboo Plugin 4.2.x and 4.3.x support JIRA 4.3.x, see the compatibility matrix at [Plugin Exchange](http://plugins.atlassian.com).

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Plugin</th>
<th>Plugin version</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA Bamboo Plugin</td>
<td>Plugin Exchange</td>
<td>4.2.1 or</td>
<td>Updating a JIRA plugin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.3.3</td>
<td></td>
</tr>
</tbody>
</table>

If you are running JIRA 4.2.x, use the plugin manager to upgrade the Bamboo plugin to a version equal to or greater than that specified in the file name below. The vulnerability is not exploitable in JIRA 4.2.x, but we recommend upgrading the plugin anyway.

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
<th>Plugin version</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA Bamboo Plugin</td>
<td>Plugin Exchange</td>
<td>4.1.5</td>
<td>Updating a JIRA plugin</td>
</tr>
</tbody>
</table>

**Acknowledgement**

Our thanks to Dave B, who reported one of the vulnerabilities in this advisory. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

JIRA Security Advisory 2012-05-17
This advisory discloses a high severity security vulnerability that exists in all versions of JIRA up to and including 5.0.0.

- **Customers who have downloaded and installed JIRA** should upgrade their existing JIRA installations to fix this vulnerability. We also provide a patch that you will be able to apply to existing installations of JIRA to fix this vulnerability. However, we recommend that you upgrade your complete JIRA installation rather than applying the patch.
- **Enterprise Hosted customers** need to request an upgrade by raising a support request at http://support.atlassian.com in the "Enterprise Hosting Support" project.
- **JIRA Studio and Atlassian OnDemand customers** are not affected by any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerability listed in this advisory has been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at http://support.atlassian.com/

In this advisory:

- **High Severity XML Parsing Vulnerability**
  - **Severity**
  - **Description**
  - **Risk Mitigation**
  - **Fix**

**Severity**

Atlassian rates the severity level of this vulnerability as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low. This vulnerability is not critical.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Description**

We have identified and fixed a vulnerability in JIRA that results from the way third-party XML parsers are used in JIRA. This vulnerability allows an attacker who is an authenticated JIRA user to execute denial of service attacks against the JIRA server.

All versions of JIRA up to and including 5.0.0 are affected by this vulnerability. This issue can be tracked here: [JIRA-27719 - XML Vulnerability in JIRA](http://jira.atlassian.com/browse/JIRA-27719) [CLOSED]

The Tempo and Gliffy for JIRA plugins are also vulnerable to this exploit. If you are using these plugins with any version of JIRA, you will need to upgrade them (see 'Fix' section below) or disable them.

**Risk Mitigation**

We recommend that you upgrade your JIRA installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately, you should disable public access (such as anonymous access and public signup) to your JIRA installation until you have applied the necessary patch or upgraded.

**Fix**

**Upgrade (recommended)**

1. Upgrade to JIRA 5.0.1 or later which fixes this vulnerability. For a full description of this release, see the JIRA 5.0.1 Release Notes. You can download this version of JIRA from the download centre.
2. Upgrade the following JIRA third-party plugins, if you are using them. The table below describes which version of the plugin you should upgrade to, depending on your JIRA version. See Managing JIRA's...
Plugins for instructions on how to upgrade a plugin. In general, you should upgrade these plugins to the latest available version compatible with your version of JIRA.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>JIRA 5.0</th>
<th>JIRA 4.4</th>
<th>JIRA 4.3</th>
<th>JIRA 4.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gliffy plugin for JIRA</td>
<td>3.7.1</td>
<td>3.7.1</td>
<td>3.7.1</td>
<td>3.7.1</td>
</tr>
<tr>
<td>Tempo</td>
<td>7.0.3</td>
<td>6.5.0.2</td>
<td>6.4.3.1</td>
<td>6.4.3.1</td>
</tr>
</tbody>
</table>

Patches (not recommended)

We recommend patching only when you can neither upgrade nor apply external security controls. Patches are usually only provided for vulnerabilities of critical severity (as per our Security Patch Policy), as an interim solution until you can upgrade. You should not expect that you can continue patching your system instead of upgrading. Our patches are often non-cumulative — we do not recommend that you apply multiple patches from different advisories on top of each other, but strongly recommend upgrading to the most recent version regularly.

If for some reason you cannot upgrade to the latest version of JIRA, you must do all of the following steps to fix the vulnerability described in this security advisory.

1. Download the patch file for your version of JIRA. Note, the patches are only available for the point release indicated. If you are using an earlier point release for a major version, you must upgrade to the latest point release first.

2. Update the following files in your JIRA installation, as described below.
   - JIRA:
     a. Shut down JIRA.
     b. Replace `$JIRA_INSTALL/atlassian-jira/WEB-INF/classes/atlassian-bundled-plugins.zip` with the patch file downloaded in Step 1 above.
     c. Delete the `$JIRA_HOME/plugins/.bundled-plugins` directory.
     d. Restart JIRA.
   - JIRA WAR:
     a. Replace `$JIRA_WAR_INSTALL/webapp/WEB-INF/classes/atlassian-bundled-plugins.zip` with the patch file downloaded in Step 1 above.
     b. Regenerate the WAR file.
     c. Shut down JIRA.
     d. Install the new WAR you generated.
     e. Delete the `$JIRA_HOME/plugins/.bundled-plugins` directory.
     f. Restart JIRA.

3. Upgrade the following JIRA third-party plugins, if you are using them. The table below describes which version of the plugin you should upgrade to, depending on your JIRA version. See Managing JIRA's Plugins for instructions on how to upgrade a plugin. In general, you should upgrade these plugins to the latest available version compatible with your version of JIRA.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>JIRA 5.0</th>
<th>JIRA 4.4</th>
<th>JIRA 4.3</th>
<th>JIRA 4.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gliffy plugin for JIRA</td>
<td>3.7.1</td>
<td>3.7.1</td>
<td>3.7.1</td>
<td>3.7.1</td>
</tr>
<tr>
<td>Tempo</td>
<td>7.0.3</td>
<td>6.5.0.2</td>
<td>6.4.3.1</td>
<td>6.4.3.1</td>
</tr>
</tbody>
</table>

4. Verify that patches succeeded by checking plugin versions. Versions of Tempo and Gliffy are listed in the table above. For the JIRA patch (step 1 above) you need to verify the version of Atlassian REST plugin.
### JIRA Security Advisory 2012-08-28

This advisory discloses security vulnerabilities that we have found in JIRA and fixed in a recent version of JIRA.

- **Customers who have downloaded and installed JIRA** should upgrade their existing JIRA installations to fix this vulnerability.
- **Enterprise Hosted customers** need to request an upgrade by raising a support request at [http://support.atlassian.com](http://support.atlassian.com) in the "Enterprise Hosting Support" project.
- **Atlassian OnDemand customers** are not affected by any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerability listed in this advisory has been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at [http://support.atlassian.com/](http://support.atlassian.com/).

**In this advisory:**

- Privilege escalation vulnerability
- XSS Vulnerabilities
- XSRF Vulnerability
- Open Redirect Vulnerabilities

---

### Privilege escalation vulnerability

**Severity**

Atlassian rates the severity level of this vulnerability as **Critical**, according to the scale published in [Severity Levels for Security Issues](http://support.atlassian.com/). The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Description**

We have identified and fixed a privilege escalation vulnerability that affects JIRA instances, including publicly available instances (that is, Internet-facing servers). This vulnerability allows an attacker to bypass
administrator-only authorisation controls via specially crafted URLs. The attacker does not need to have an account on the affected JIRA server. As a result, the attacker will be able to execute a large number of administrative actions.

This vulnerability has been fixed in JIRA 5.0.7 and later. Patches are available for JIRA 4.3.4, 4.4.5 and 5.0.6. This issue can be tracked here: [JIRA-29403 - Privilege escalation vulnerability](https://jira.atlassian.com/browse/JIRA-29403) - RESOLVED

**Risk Mitigation**

If you cannot upgrade immediately, you can disable public access to your JIRA instance. You can also turn on S[ecure Administrator sessions](https://jira.atlassian.com/wiki/spaces/DOC/pages/15125246/Secure+Administrator+Sessions) (also known as WebSudo) which will significantly reduce the number of actions available to an attacker. WebSudo does not completely mitigate this vulnerability, as it does not protect non-administrative actions.

**Fix**

**Upgrade**

The vulnerability and fix versions are described in the 'Description' section above.

We recommend that you upgrade to JIRA 5.0.7 or later. For a full description of the latest version of JIRA, see the [release notes](https://jira.atlassian.com/wiki/spaces/DOC/pages/15125246/Release+Notes). You can download the latest version of JIRA from the [download centre](https://www.atlassian.com/software/jira/download).

If you cannot upgrade to the latest version of JIRA, you can temporarily patch your existing installation using the patch listed below. We strongly recommend upgrading and not patching.

**Patches**

<table>
<thead>
<tr>
<th>JIRA version</th>
<th>Patch File Name</th>
<th>Patch Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.4</td>
<td>JRA-29403-4.3.4-patch.zip</td>
<td>JRA-29403-4.3.4-patch-instructions.txt</td>
</tr>
<tr>
<td>4.4.5</td>
<td>JRA-29403-4.4.5-patch.zip</td>
<td>JRA-29403-4.4.5-patch-instructions.txt</td>
</tr>
<tr>
<td>5.0.6</td>
<td>JRA-29403-5.0.6-patch.zip</td>
<td>JRA-29403-5.0.6-patch-instructions.txt</td>
</tr>
</tbody>
</table>

Instructions on how to apply patches are listed in the table above.

**XSS Vulnerabilities**

**Severity**

Atlassian rates the severity level of these vulnerabilities as [High](https://jira.atlassian.com/wiki/spaces/DOC/pages/15125246/Severity+Levels+for+Security+Issues), according to the scale published in [Severity Levels for Security Issues](https://jira.atlassian.com/wiki/spaces/DOC/pages/15125246/Severity+Levels+for+Security+Issues). The scale allows us to rank the severity as critical, high, medium or low. This is an independent assessment and you should evaluate its applicability to your own IT environment. These vulnerabilities are not of Critical severity.

**Description**

We have identified and fixed nine cross-site scripting (XSS) vulnerabilities that affect JIRA instances, including publicly available instances (that is, Internet-facing servers). XSS vulnerabilities allow an attacker to embed their own JavaScript into a JIRA page.

You can read more about XSS attacks at [cgisecurity.com](http://www.cgisecurity.com), [The Web Application Security Consortium](https://www.wasc.org) and other places on the web.

These vulnerabilities affects JIRA 4.2 and above, and have been fixed in JIRA 5.1.1. This issue can be tracked here: [JIRA-29402 - Cross-Site Scripting Vulnerabilities](https://jira.atlassian.com/browse/JIRA-29402) - RESOLVED

**Risk Mitigation**

We strongly recommend upgrading your JIRA installation to fix these vulnerabilities. Please see the 'Fix' section below.

**Fix**
Upgrade

The vulnerabilities and fix versions are described in the 'Description' section above.

We recommend that you upgrade to JIRA 5.1.1 or later. For a full description of the latest version of JIRA, see the release notes. You can download the latest version of JIRA from the download centre.

Patches are not available for this vulnerability.

Our thanks to Nils Juenemann who reported three of the XSS vulnerabilities mentioned in this section. Our thanks also to Conrad Rolack and Brandon Sterne who each reported one XSS vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

XSOF Vulnerability

Severity

Atlassian rates the severity level of this vulnerability as Medium, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, medium or low. This is an independent assessment and you should evaluate its applicability to your own IT environment. This vulnerability is not of Critical severity.

Description

We have identified and fixed a cross-site request forgery (XSRF) vulnerability that affects JIRA instances, including publicly available instances (that is, Internet-facing servers).

This XSRF vulnerability relates to commenting on issues. An attacker might take advantage of the vulnerability to make other users post issue comments of his choice.

You can read more about XSRF attacks at http://www.cgisecurity.com/csrf-faq.html and other places on the web. This vulnerability affects JIRA 4.2 and above, and has been fixed in JIRA 5.1. This issue can be tracked here: [JIRA-29401 - Cross-Site Request Forgery vulnerability](http://www.cgisecurity.com/csrf-faq.html) [RESOLVED]

Risk Mitigation

We strongly recommend upgrading your JIRA installation to fix this vulnerability. Please see the 'Fix' section below.

Fix

Upgrade

The vulnerability and fix versions are described in the 'Description' section above.

We recommend that you upgrade to JIRA 5.1 or later. For a full description of the latest version of JIRA, see the release notes. You can download the latest version of JIRA from the download centre.

Patches are not available for this vulnerability.

Our thanks to João Paulo Lins of Tempest Security Intelligence, who reported the XSRF vulnerability mentioned in this section. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Open Redirect Vulnerabilities

Severity

Atlassian rates the severity level of these vulnerabilities as Medium, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment. These vulnerabilities are not of Critical severity.
Description

We have identified and fixed two open redirect vulnerabilities that affect JIRA instances, including publicly available instances (that is, Internet-facing servers).

Parameter-based redirection vulnerabilities allow an attacker to craft a JIRA URL in such a way that a user clicking on the URL will be redirected to a different web site. This can be used for phishing.

You can read more about link manipulation attacks at Wikipedia, and about phishing at Fraud.org and other places on the web.

These vulnerabilities affect JIRA 4.3.3 and above, and have been fixed in JIRA 5.1.1. This issue can be tracked here: JIRA-29400 - Open Redirect vulnerabilities

Risk Mitigation

We strongly recommend upgrading your JIRA installation to fix these vulnerabilities. Please see the 'Fix' section below.

Fix

Upgrade

The vulnerabilities and fix versions are described in the 'Description' section above.

We recommend that you upgrade to JIRA 5.1 or later. For a full description of the latest version of JIRA, see the release notes. You can download the latest version of JIRA from the download centre.

Patches are not available for this vulnerability.

Our thanks to João Paulo Lins of Tempest Security Intelligence, who reported one of the open redirect vulnerabilities mentioned in this section. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

JIRA Security Advisory 2013-02-21

This advisory discloses a critical severity security vulnerability that exists in all versions of JIRA up to and including 5.1.4.

- Customers who have downloaded and installed JIRA should upgrade their existing JIRA installations to fix this vulnerability. We also provide a patch that you will be able to apply to existing installations of JIRA to fix this vulnerability. However, we recommend that you upgrade your complete JIRA installation rather than applying the patch.
- Enterprise Hosted customers need to request an upgrade by raising a support request at http://support.atlassian.com in the “Enterprise Hosting Support” project.
- JIRA Studio customers will need to disable SOAP API (see Risk Mitigation below for details).
- Atlassian OnDemand customers are not affected by any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerability listed in this advisory has been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at http://support.atlassian.com/.

In this advisory:

- File Overwrite Vulnerability
- Risk Mitigation
- Fix

File Overwrite Vulnerability

Severity
Atlassian rates the severity level of this vulnerability as **critical**, according to the scale published in **Severity Levels for Security Issues**. The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Description**

We have identified and fixed a vulnerability in JIRA’s **SOAP API** that allows an attacker who has a valid JIRA account to overwrite any files that are writable by the OS user JIRA runs under. This may result in the attacker being able to execute arbitrary Java code in the context of JIRA server.

**NOTE:** This API is **OFF by default**, unless you have turned it on. In order to verify its state, check whether “Accept remote API calls” setting is OFF. This page describes configuring JIRA options: [https://confluence.atlassian.com/display/JIRA/Configuring+JIRA+Options#ConfiguringJIRAOptions-Options](https://confluence.atlassian.com/display/JIRA/Configuring+JIRA+Options#ConfiguringJIRAOptions-Options)

All versions of JIRA up to and including 5.1.4 are affected by this vulnerability. The vulnerability is fixed in JIRA 5.1.5 and later. This issue can be tracked here: [JRA-29786 - File overwrite via SOAP API](https://jira.atlassian.com/browse/JRA-29786)

**Risk Mitigation**

If you’re unable to upgrade or patch the instance: as a **workaround**, the remote API can be completely disabled by setting the **Accept remote API calls** value to OFF in the General Configuration (as in our [Configuring JIRA Options](https://confluence.atlassian.com/display/JIRA/Configuring+JIRA+Options#ConfiguringJIRAOptions-Options) documentation). However, this will disable all XML-RPC or SOAP calls and can consequently cause additional problems to other applications or scripts that rely upon the remote API.

Usage of SOAP has been deprecated as of JIRA 5.x, and this can be disabled without causing problems to JIRA. However versions of JIRA prior to 4.x may experience problems, such as integrating with other applications through AppLinks. REST calls will be unaffected.

If you want to continue using SOAP API interface, you need to either upgrade your JIRA or apply patches.

**Fix**

This section outlines the upgrades and/or patches for this vulnerability. The [Security Patch Policy](https://confluence.atlassian.com/display/JIRA/Security+Patch+Policy) describes when and how we release security patches and security upgrades for our products.

**Upgrade (recommended)**

The vulnerabilities and fix versions are described in the ’Description’ section above.

We recommend that you upgrade to the latest version of JIRA, if possible. For a full description of the latest version of JIRA, see the release notes. You can download the latest version of JIRA from the download centre.

If you cannot upgrade to the latest version of JIRA, you can temporarily patch your existing installation using the patch listed below. We strongly recommend upgrading and not patching.

**Patches (not recommended)**

We recommend patching only when you can neither upgrade nor apply external security controls. Patches are usually only provided for vulnerabilities of critical severity (as per our [Security Patch Policy](https://confluence.atlassian.com/display/JIRA/Security+Patch+Policy)), as an interim solution until you can upgrade. You should not expect that you can continue patching your system instead of upgrading. Our patches are often non-cumulative – we do not recommend that you apply multiple patches from different advisories on top of each other, but strongly recommend upgrading to the most recent version regularly.

If for some reason you cannot upgrade to the latest version of JIRA, you need do all of the steps described in the patch instructions to fix the vulnerability described in this security advisory.

Download the patch file for your version of JIRA. Note, the patches are only available for the point release indicated. If you are using an earlier point release for a major version, you must upgrade to the latest point release first. For example, if you have 5.0.6, then you need to upgrade to 5.0.7 before applying this patch.

<table>
<thead>
<tr>
<th>JIRA Version</th>
<th>Patch</th>
<th>Patch File Name</th>
</tr>
</thead>
</table>

Created in 2015 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).
Steps for applying the patches can be found inside the zip archive.

JIRA Security Advisory 2014-02-26

This advisory details critical security vulnerabilities that we have found in JIRA and fixed in recent versions of JIRA.

- **Customers who have downloaded and installed JIRA** should upgrade their existing JIRA installations or apply the patches to fix these vulnerabilities.
- **Atlassian OnDemand customers** have been upgraded with the fixes for the issues described in this advisory.

These vulnerabilities affect all versions of JIRA up to and including 6.1.3.

Atlassian is committed to improving product security. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

If you have questions or concerns regarding this advisory, please raise a support request at [http://support.atlassian.com](http://support.atlassian.com).

**Issue 1: Path traversal in JIRA Issue Collector plugin (Windows only)**

- **Severity**
- **Description**
- **Risk Mitigation**
- **Fix**

**Issue 2: Path traversal in JIRA Importers plugin (Windows only)**

- **Severity**
- **Description**
- **Risk Mitigation**
- **Fix**

**Issue 3: Privilege escalation**

- **Severity**
- **Description**
- **Risk Mitigation**
- **Fix**

**Issue 1: Path traversal in JIRA Issue Collector plugin (Windows only)**

*Severity*

Atlassian rates the severity level of this vulnerability as **critical**, according to the scale published in *Severity Levels for Security Issues*. The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

*Description*

We have identified and fixed a vulnerability in JIRA which allowed unauthenticated users to create files in any valid directory inside a JIRA install. In order to exploit this vulnerability, an attacker requires access to your JIRA web interface.

This issue only affects JIRA servers running on Windows OS. It is not exploitable on Linux and OSX systems.

The vulnerability affects all supported versions of JIRA up to and including 6.0.3. It has been fixed in 6.0.4. The issue is tracked in [JRA-36442](http://www.atlassian.com/software/jira/downloads/binary/patch-JRA-29786-5.1.4.zip) - Path traversal in JIRA Issue Collector plugin (Windows only) [RESOLVED].

Our thanks to Philippe Arteau of Groupe Technologies Desjardins who reported this vulnerability.

*Risk Mitigation*

If you are unable to upgrade or patch your JIRA server, you can disable the JIRA Issue collector plugin via the JIRA administration interface.
In case you require the plugin, do the following as a temporary workaround:

- Block access to your JIRA server web interface from untrusted networks, such as the Internet.

Fix

This vulnerability can be fixed by upgrading JIRA. Alternatively, you can upgrade only the vulnerable plugin.

The Security Patch Policy describes when and how we release security patches and security upgrades for our products.

Upgrading JIRA

Upgrade to JIRA 6.0.4 or a later version, which fixes this vulnerability. For a full description of these releases, see the JIRA Release Notes. You can download these versions of JIRA from the download centre.

If you cannot upgrade JIRA at the moment, you can upgrade only the Issue Collector plugin. See Managing JIRA's Plugins for instructions on how to upgrade a plugin. In general, you should upgrade this plugins to the latest available version compatible with your version of JIRA.

Issue 2: Path traversal in JIRA Importers plugin (Windows only)

Severity

Atlassian rates the severity level of this vulnerability as critical, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

Description

We have identified and fixed a vulnerability in JIRA which allowed unauthenticated users to create files in any valid directory inside a JIRA install. In order to exploit this vulnerability, an attacker requires access to your JIRA web interface.

This issue only affects JIRA servers running on Windows OS. It is not exploitable on Linux and OSX systems.

The vulnerability affects all supported versions of JIRA up to and including 6.0.4. It has been fixed in 6.0.5. The issue is tracked in [JRA-36441 - Path traversal in JIRA Importers plugin (Windows only)](JRA-36441 - Path traversal in JIRA Importers plugin (Windows only)) RESOLVED.

Risk Mitigation

If you are unable to upgrade or patch your JIRA server you can disable the JIRA Importers plugin via the JIRA administration interface.

In case you require the plugin, do the following as a temporary workaround:

- Block access to your JIRA server web interface from untrusted networks, such as the Internet.

Fix

This vulnerability can be fixed by upgrading JIRA. Alternatively, you can upgrade only the vulnerable plugin.

The Security Patch Policy describes when and how we release security patches and security upgrades for our products.

Upgrading JIRA

Upgrade to JIRA 6.0.4 or a later version, which fixes this vulnerability. For a full description of these releases, see the JIRA Release Notes. You can download these versions of JIRA from the download centre.

If you cannot upgrade JIRA at the moment, you can upgrade only the JIRA Importers plugin. See Managing JIRA's Plugins for instructions on how to upgrade a plugin. In general, you should upgrade this plugins to the latest available version compatible with your version of JIRA.
Issue 3: Privilege escalation

Severity

Atlassian rates the severity level of this vulnerability as critical, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

Description

We have identified and fixed a vulnerability in JIRA which allowed unauthenticated attackers to commit actions on behalf of any other authorised user. In order to exploit this vulnerability, an attacker requires access to your JIRA web interface.

The vulnerability affects all supported versions of JIRA up to and including 6.1.3. It has been fixed in 6.1.4. The issue is tracked in JIRA-35797 - Privilege escalation - CLOSED.

Risk Mitigation

If you are unable to upgrade or patch your JIRA server you can do the following as a temporary workaround:

- Block access to your JIRA server web interface from untrusted networks, such as the Internet.
- Turn on Secure Administrator Sessions, this prevents privilege escalation to administrative accounts. Non-privileged accounts will still be vulnerable.

Fix

This vulnerability can be fixed by upgrading JIRA. There is also a patch available for this vulnerability for the following supported versions of JIRA. If you have any questions, please raise a support request at http://support.atlassian.com. We recommend upgrading.

The Security Patch Policy describes when and how we release security patches and security upgrades for our products.

Upgrading JIRA

Upgrade to JIRA 6.1.4 or a later version, which fixes this vulnerability. For a full description of these releases, see the JIRA Release Notes. You can download these versions of JIRA from the download centre.

Patches

We recommend patching only when you cannot upgrade or cannot apply external security controls. Patches are usually only provided for vulnerabilities of critical severity (as per our Security Patch Policy) as an interim solution until you can upgrade. You should not continually patch your system instead of upgrading. Our patches are often non-cumulative — we do not recommend that you apply multiple patches from different advisories on top of each other, and we strongly recommend upgrading to the most recent version regularly.

If for some reason you cannot upgrade to the latest version of JIRA, you must upgrade to the last minor version of the release. For example, if you have JIRA 5.1.1, you will have to upgrade 5.1.8 and then apply the patch provided below to fix the vulnerability described in this advisory.

Download the patch package:

<table>
<thead>
<tr>
<th>Version</th>
<th>Patch Package</th>
<th>md5</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA 4.4.5</td>
<td>patch-JRA-35797-4.4.5-20140303.zip</td>
<td>47990989c958b4b7c51785075b84e12f</td>
</tr>
<tr>
<td>JIRA 5.0.7</td>
<td>patch-JRA-35797-5.0.7-20140303.zip</td>
<td>1f940b97ba8bc127f306eedad44bc55</td>
</tr>
</tbody>
</table>
1. Download the file patch-JRA-35797/patches/JRA-35797-6.0.8-patch.zip
2. In the `<jira_install>/atlassian-jira/WEB-INF/lib` directory delete the following files:
   - atlassian-gadgets-api-3.2.0-m26.jar
   - atlassian-gadgets-spi-3.2.0-m26.jar
   - atlassian-trusted-apps-core-2.5.2.jar
   - atlassian-trusted-apps-seraph-integration-2.5.2.jar
   - sal-api-2.10.2.jar
   - sal-spi-2.10.2.jar
3. Expand the zip file into `<jira_install_dir>/atlassian-jira/` overwriting the files there
4. Restart JIRA

If you are using the WAR distribution of JIRA:

1. Download the file patch-JRA-35797/patches/JRA-35797-6.0.8-patch.zip
2. In the `<jira_install_jir>/webapp/WEB-INF/lib` directory delete the following files:
   - atlassian-gadgets-api-3.2.0-m26.jar
   - atlassian-gadgets-spi-3.2.0-m26.jar
   - atlassian-trusted-apps-core-2.5.2.jar
   - atlassian-trusted-apps-seraph-integration-2.5.2.jar
   - sal-api-2.10.2.jar
   - sal-spi-2.10.2.jar
3. Expand the zip file to `<jira_install_dir>/webapp` overwriting the files there
4. Run `build.sh clean` on unix or `build.bat clean` on windows
5. Run `build.sh` on unix or `build.bat` on windows
6. Redeploy the JIRA web app into your application server
JIRA Knowledge Base
Tips of the Trade
Tips via Twitter
Guide to Installing an Atlassian Integrated Suite
The big list of Atlassian gadgets

Resources for Developers

- JIRA developer documentation: Atlassian Developers
- Reference documentation: Latest and earlier releases.
- Developer discussion forum: Atlassian Answers
- Real-time crash reports and user feedback for your iOS apps: JIRA Mobile Connect Developer Documentation

Downloadable Documentation

- JIRA documentation in PDF, HTML or XML formats
- Setting Up Local Online JIRA Documentation

Books

- Books about JIRA

Add-ons

- Atlassian Marketplace

Support

- Atlassian Support
- Support Policies

Training

- Atlassian Training

Mailing Lists

- Visit http://my.atlassian.com to sign up for mailing lists relating to Atlassian products, such as technical alerts, product announcements and developer updates.

Forums

- Atlassian Answers for JIRA
- Atlassian Answers for JIRA Development

Feature Requests

- Issue Tracker and Feature Requests for JIRA
- Policy for Implementing New Features

IDE Connectors

- Use the Atlassian Connector for Eclipse or the Atlassian Connector for IntelliJ IDEA to work with your JIRA issues, right there in your development environment. Do you use Bamboo, Crucible or FishEye too? With the connector you can manage your builds and code reviews within your IDE, or move quickly between the IDE and a FishEye view of your source repository. Hint: The Atlassian IDE Connectors are free.
Support Policies

Welcome to the support policies index page. Here, you'll find information about how Atlassian Support can help you and how to get in touch with our helpful support engineers. Please choose the relevant page below to find out more.

- Bug Fixing Policy
- New Features Policy
- Security Bugfix Policy

To request support from Atlassian, please raise a support issue in our online support system. To do this, see <a>Getting Help</a>. Our friendly support engineers will get right back to you with an answer.

Bug Fixing Policy

Summary

- Atlassian Support will help with workarounds and bug reporting.
- Critical bugs will generally be fixed in the next maintenance release.
- Non critical bugs will be scheduled according to a variety of considerations.

Raising a Bug Report

Atlassian Support is eager and happy to help verify bugs — we take pride in it! Please open a support request in our support system providing as much information as possible about how to replicate the problem you are experiencing. We will replicate the bug to verify, then lodge the report for you. We'll also try to construct workarounds if they're possible.

Customers and plugin developers are also welcome to open bug reports on our issue tracking systems directly. Use the appropriate project on <a>http://jira.atlassian.com</a> to report bugs for Atlassian products.

When raising a new bug, you should rate the priority of a bug according to our JIRA usage guidelines. Customers should watch a filed bug in order to receive e-mail notification when a "Fix Version" is scheduled for release.

How Atlassian Approaches Bug Fixing

Maintenance (bug fix) releases come out more frequently than major releases and attempt to target the most critical bugs affecting our customers. The notation for a maintenance release is the final number in the version (ie the 1 in 3.0.1).

If a bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions) then it will be fixed in the next maintenance release provided that:

- The fix is technically feasible (i.e. it doesn't require a major architectural change).
- It does not impact the quality or integrity of a product.

For non-critical bugs, the developer assigned to fixing bugs prioritises the non-critical bug according to these factors:

- How many of our supported configurations are affected by the problem.
- Whether there is an effective workaround or patch.
- How difficult the issue is to fix.
- Whether many bugs in one area can be fixed at one time.

The developers responsible for bug fixing also monitor comments on existing bugs and new bugs submitted in JIRA, so you can provide feedback in this way. We give high priority consideration to security issues.

When considering the priority of a non-critical bug we try to determine a 'value' score for a bug which takes into account the severity of the bug from the customer's perspective, how prevalent the bug is and whether roadmap features may render the bug obsolete. We combine this with a complexity score (i.e. how difficult the bug is). These two dimensions are used when developers self serve from the bug pile.
Further reading

See Atlassian Support Offerings for more support-related information.

New Features Policy

Summary

- We encourage and display customer comments and votes openly in our issue tracking system, http://jira.atlassian.com.
- We do not publish roadmaps.
- Product Managers review our most popular voted issues on a regular basis.
- We schedule features based on a variety of factors.
- Our Atlassian Bug Fixing Policy is distinct from this process.
- Atlassian provides consistent updates on the top 20 issues.

How to Track what Features are Being Implemented

When a new feature or improvement is scheduled, the 'fix-for' version will be indicated in the JIRA issue. This happens for the upcoming release only. We maintain roadmaps for more distant releases internally, but because these roadmaps are often pre-empted by changing customer demands, we do not publish them.

How Atlassian Chooses What to Implement

In every major release we aim to implement highly requested features, but it is not the only determining factor. Other factors include:

- **Customer contact**: We get the chance to meet customers and hear their successes and challenges at Atlassian Summit, Atlassian Unite, developer conferences, and road shows.
- **Customer interviews**: All product managers at Atlassian do customer interviews. Our interviews are not simply to capture a list of features, but to understand our customers' goals and plans.
- **Community forums**: There are large volumes of posts on answers, of votes and comments on jira.atlassian.com, and of conversations on community forums like groups on LinkedIn.
- **Customer Support**: Our support team provides clear insights into the issues that are challenging for customers, and which are generating the most calls to support.
- **Atlassian Experts**: Our Experts provide insights into real-world customer deployments, especially for customers at scale.
- **Evaluator Feedback**: When someone new tries our products, we want to know what they liked and disliked and often reach out to them for more detail.
- **In product feedback**: The JIRA Issue Collectors that we embed our products for evaluators and our Early Access Program give us a constant pulse on how users are experiencing our product.
- **Usage data**: Are customers using the features we have developed?
- **Product strategy**: Our long-term strategic vision for the product.
- Please read our post on Atlassian Answers for a more detailed explanation.

How to Contribute to Feature Development

Influencing Atlassian's release cycle

We encourage our customers to vote on issues that have been raised in our public JIRA instance, http://jira.atlassian.com. Please find out if your request already exists - if it does, vote for it. If you do not find it you may wish to create a new one.

Extending Atlassian Products

Atlassian products have powerful and flexible extension APIs. If you would like to see a particular feature implemented, it may be possible to develop the feature as a plugin. Documentation regarding the plugin APIs is available. Advice on extending either product may be available on the user mailing-lists, or at Atlassian Answers.

If you require significant customisations, you may wish to get in touch with our partners. They specialise in extending Atlassian products and can do this work for you. If you are interested, please contact us.

Further reading

See Atlassian Support Offerings for more support-related information.
Security Bugfix Policy

See Security @ Atlassian for more information on our security bugfix policy.

Local JIRA documentation

On this page:

- Why would I set up local online documentation?
- How to set up local online documentation for JIRA 4.0.x and later
  - Additional documentation spaces required
    - Why you need the additional documentation spaces
    - Determining the Version Required
    - List of Spaces Required
- How to set up local online documentation for JIRA 3.13.x and earlier
- Local field documentation

Why would I set up local online documentation?

You may wish to run the documentation locally, and have JIRA link to it. There are a few reasons you may wish to do this:

- JIRA’s interface contains links (❓) to help pages, some to pages within JIRA, but many to the online documentation on www.atlassian.com. For deployments in environments without an internet connection, a local copy of the documentation is desirable.
- If you have customized JIRA, you may wish to update the documentation to reflect your changes, or add new pages.
- You can change the look and feel of the documentation to integrate into your company’s intranet.

How to set up local online documentation for JIRA 4.0.x and later

1. Install Atlassian Confluence. (If you don’t already have Confluence, ask for a free Evaluation License. You can use ‘Anonymous’ access to allow your users to view the documentation.)
2. Download the JIRA Documentation’s XML source. Note that the Confluence version of the XML source needs to be the same major Confluence version as your local Confluence site.
3. Import the XML file into your Confluence site. (Note: if there is already a ‘JIRA’ space in your Confluence site, it will be overwritten.) For detailed instructions, see the Confluence documentation on Restoring a Space.
4. If you are importing the documentation for JIRA 4.1 or later, you will need to remove or adjust the customized header, footer and left-hand navigation bar in your new space. **Explanation**: When you create your new space from our XML source code, the space will inherit the Confluence ‘Documentation’ theme. The XML source code also includes the customizations we have made to the header, footer and left-hand navigation bar. These customizations include references to our Atlassian Documentation space. Since your Confluence site does not have that space, you will see errors like this in the left-hand navigation bar, header and footer in your new space:

   Unable to render (include) Couldn't find a space with key: ALLDOC

   To fix these errors, take one of the following steps:
   - Customize the navigation, header and footer sections to suit your Confluence site or environment. See our documentation on configuring the Documentation theme.
   - Or restore the default left-hand navigation bar, by removing all content from the navigation, header and footer sections and selecting the ‘Page Tree’ check box. See our documentation on configuring the Documentation theme.
   - Or change the theme of your space to the Confluence default theme or another theme of your choice.
5. Download the XML source code for the additional documentation spaces listed below and import them into your Confluence site too.
6. (Optional) If you want JIRA’s help links (❓) to point to your local documentation, you will need to:
   a. edit JIRA’s /WEB-INF/classes/help-paths.properties file and change the url-prefix li
ne so that it points to the 'JIRA' space in your local Confluence site, e.g.:

```
url-prefix=http://confluence.mycompany.com/display/JIRA/
```

b. restart JIRA.

Additional documentation spaces required

Why you need the additional documentation spaces

The JIRA documentation shares some content with other Atlassian products, such as Confluence. For the sake of efficiency, we reuse the same content across documentation spaces. You will notice that some of our pages contain an `include` macro that draws in content from another space.

For example, the following macro includes content from the Application Links (APPLINKS) space into the JIRA documentation space:

```
{include:APPLINKS:_securityTrustedApps}
```

You will need to import those documentation spaces into your Confluence site, to ensure that the reused content is accessible in your JIRA documentation.

Determining the Version Required

We supply different versions of the documentation, for each version of the software or plugin concerned. To see which version you need, take a look at the space key in the `include` macro concerned.

- If the space key has a number at the end, that number indicates the version. For example, `012` means version 1.2, and `011` means version 1.1.
- If the space key does not include a number, you need the latest version of the documentation.

Here is an example of an include macro that requires version 1.2 of the Application Links documentation:

```
{include:APPLINKS012:_securityTrustedApps}
```

This example requires the latest version of the Application Links documentation:

```
{include:APPLINKS:_securityTrustedApps}
```

List of Spaces Required

Retrieve the relevant version of the XML backups from these pages:

- Application Links
- Universal Plugin Manager
- User Management

How to set up local online documentation for JIRA 3.13.x and earlier

JIRA licensees can download the XML source for the documentation.

To build JIRA’s docs locally:

1. Download Apache Forrest 0.5.1 (`zip`, `tar.gz`), used to render the docs.
2. Download the JIRA Documentation's XML source (6.2Mb). Note: the download is restricted to JIRA license holders.
3. Follow the JIRA_DOCUMENTATION.txt instructions in the package.
Local field documentation

If you just want to document usage of a custom field, please see Creating Help for a Custom Field.

JIRA FAQ

- What does JIRA mean?
- How is JIRA pronounced?
- Licensing

For technical articles please see the JIRA Knowledge Base.

What does JIRA mean?

Like all good names in the software industry, it started as an in-house code name.

We originally used Bugzilla for bug tracking and the developers in the office started calling it by the Japanese name for Godzilla, Gojira (the original black-and-white Japanese Godzilla films are also office favorites). As we developed our own bug tracker, and then it became an issue tracker, the name stuck, but the Go got dropped - hence JIRA!

Further investigation into the name has revealed that Gorira is Japanese for "gorilla", whilst Kujira is Japanese for "whale". So Gojira is roughly translated to mean "gorilla the size of a whale"! (Thanks to yusuke_arclamp — Oct 2002)

For those who care - it sounds best if you yell it loudly, as though charging into battle. C'mon - try it!

Related

1. Talking that JIRA-slang language, or jiralang, if I may

How is JIRA pronounced?

We pronounce it 'JEEra', based on the pronunciation of 'Kujira' (see What does JIRA mean?)

Licensing

Please see our licensing FAQ

Related

JIRA 4.0 introduced new licensing — please see Licensing Changes.

How to display more versions in the project summary page in JIRA

The project summary page in is only showing limited amount of version in JIRA. Most probably is due to you are using JIRA version 4.x and below therefore we would recommend you to upgrade JIRA version 5 and above to have this feature which would show more version information in the project summary page.

How JIRA Documentation Updates are Published
Documentation is organised by major product version

As you can see from this web site, Atlassian's technical writers use Confluence to prepare and publish documentation for Atlassian's products.

The documentation for each major version of JIRA is housed in its own Confluence space. Examples of major versions of JIRA are '4.3.x', '4.4.x' or '5.0.x', where 'x' represents a minor version/release number. Any documentation relating to specific features in minor versions/releases of a major JIRA version are also housed in the documentation space for that major version.

While the names of spaces can be changed in Confluence, each space is identified by a unique 'space key', which remains static.

- When viewing a Confluence page, the 'space key' of the space to which the page belongs can be found immediately after the display/ part of that Confluence page's URL.

Traditional documentation publishing process

- This process is no longer being employed to publish JIRA documentation updates. All version numbers mentioned in this section are used solely for demonstrating this process and do not reflect our current online JIRA documentation.

Documentation for the latest official major version of JIRA (for example, JIRA 4.2.x) is housed in the Confluence space on this site with the 'JIRA' space key.

Documentation updates for the next major version of JIRA (for example, JIRA 4.3.0) are drafted in this same Confluence space (with the 'JIRA' space key). Each draft page created is hidden from public view by applying page viewing restrictions.

Just prior to the release of the next major version of JIRA, we begin 'branching' the documentation.

This documentation 'branching' process involves the following steps:

1. We create a copy of the 'JIRA' space on this site using Confluence's 'Copy Space' plugin. The copied space is given a space key which reflects the latest official major version of JIRA, based on the format 'JIRA0XY' (where X and Y reflect the first two numbers that constitute this major version of JIRA).

   - Documentation in the new 'JIRA0XY' space, which is initially hidden from public view via space permissions, will apply to the previous major version of JIRA once the next major version of JIRA is officially released.

2. Immediately after the next major version of JIRA is officially released, we perform the following sub-steps:
   a. The 'JIRA' space is renamed to reflect the new latest official major version of JIRA, for example, 'JIRA 4.3'.
   b. The 'JIRA0XY' space (for example, 'JIRA042') is revealed to the public by adjusting space permissions and we ensure it is renamed to reflect the previous major version of JIRA, for example, 'JIRA 4.2'.
   c. We publish the drafted content for what is now the new latest official major version of JIRA in the 'JIRA' space.

   - For more information about this process, please refer to 'From draft to published document' and 'Documentati on Release Management' in our blog series on 'Technical Writing in a Wiki'.

Recent documentation publishing process

Since the release of JIRA 4.3.0, we have modified the traditional documentation publishing process above.

Instead of waiting until the next major version of JIRA is officially released, we begin the 'branching' steps (above ) earlier during development of the next major version of JIRA. For the release of:

- JIRA 4.3.0 — we performed the branching steps just prior to the release of JIRA 4.3 Beta 1 and at sub-step 2a, the 'JIRA' space was renamed 'JIRA 4.3 Beta'.
• **JIRA 4.4.0** — we performed the branching even earlier (just prior to the release of JIRA 4.4 EAP 2) and at sub-step 2a, the 'JIRA' space was renamed 'JIRA 4.4 EAP'.
  • When JIRA 4.4 Beta 1 was released, we performed sub-step 2a again, by renaming the 'JIRA' space 'JIRA 4.4 Beta'.

**Implications of this new process**

Branching our documentation early during early development of the next major version of JIRA has the following implications:

• A dedicated documentation space for the latest official major version of JIRA becomes available. For instance, the 'JIRA 4.3' documentation space (with space key 'JIRA043') became available when JIRA 4.4 EAP 2 was released.
• The 'JIRA' space reflects JIRA documentation for the next major version of JIRA. For instance, the 'JIRA 4.4 EAP' documentation (with space key 'JIRA') became available when JIRA 4.4 EAP 2 was released.

Customers searching our documentation via Google may find that their Google search results selectively choose pages in the 'JIRA' space for the next major version of JIRA, as mentioned in JRA-24805.

**Why have we adopted this new process?**

Branching our documentation early offers the following important benefits:

• Customers who wish to try out early versions of the next major version of JIRA, as well as developers who wish to update their JIRA plugins for compatibility with that JIRA version will have access to documentation for that JIRA version (if available).
• Publishing documentation updates is easier since we work with live content in documentation spaces with 'EAP' or 'Beta' in their name, rather than working on draft pages which are hidden from public view.

✔ If you reach a JIRA documentation page for the next major version of JIRA (for example, via a Google search), most headers of these pages have a link that will lead you to the equivalent page for latest official major version of JIRA.

For more information about our reasons for adopting this new process, please refer to our response to JRA-24805.

**How to reference JIRA documentation from external sources**

If you wish to reference our JIRA documentation from an external source, you may wish to refer to version-specific pages of our documentation, by ensuring that you use the appropriate space key in your URL. For example:

- http://confluence.atlassian.com/display/JIRA042/Managing+Groups (for JIRA 4.2.x)
- http://confluence.atlassian.com/display/JIRA043/Managing+Groups (for JIRA 4.3.x)

Sometimes, if the functionality of a particular aspect of JIRA has changed, we may need to change the name of a page. For example, due to the significant changes in 'advanced JIRA configuration' in JIRA 4.4, we've had to change the name of:

- http://confluence.atlassian.com/display/JIRA043/Advanced+JIRA+configuration+with+jira-application.properties (for JIRA 4.3.x)
  to
- http://confluence.atlassian.com/display/JIRA/Advanced+JIRA+configuration (for JIRA 4.4.x)

We almost never change the names of pages in earlier versions of documentation (unless of course they are incorrect).

**Contributing to the JIRA Documentation**

Would you like to share your JIRA hints, tips and techniques with us and with other JIRA users? We welcome your contributions.

**On this page:**

- Tweeting your Hints and Tips – Tips via Twitter
- Blogging your Technical Tips and Guides – Tips of the Trade
- Contributing Documentation in Other Languages
• Updating the Documentation Itself
  • Getting Permission to Update the Documentation
  • Our Style Guide
  • How we Manage Community Updates

Tweeting your Hints and Tips – Tips via Twitter
Do you have hints and tips about your JIRA bug tracker to share with the world? Even more, would you like to see your hints appear on a page in the Atlassian documentation? Just tweet with the hash tag 

Blogging your Technical Tips and Guides – Tips of the Trade
Have you written a blog post describing a specific configuration of JIRA or a neat trick that you have discovered? Let us know, and we will link to your blog from our documentation.

Contributing Documentation in Other Languages
Have you written a guide to JIRA in a language other than English, or translated one of our guides? Let us know, and we will link to your guide from our documentation.

Updating the Documentation Itself
Have you found a mistake in the documentation, or do you have a small addition that would be so easy to add yourself rather than asking us to do it? You can update the documentation page directly.

Getting Permission to Update the Documentation
Please submit the Atlassian Contributor License Agreement.

Our Style Guide
Please read our short guidelines for authors.

How we Manage Community Updates
Here is a quick guide to how we manage community contributions to our documentation and the copyright that applies to the documentation:

• Monitoring by technical writers. The Atlassian technical writers monitor the updates to the documentation spaces, using RSS feeds and watching the spaces. If someone makes an update that needs some attention from us, we will make the necessary changes.

• Wiki permissions. We use wiki permissions to determine who can edit the documentation spaces. We ask people to sign the Atlassian Contributor License Agreement (ACLA) and submit it to us. That allows us to verify that the applicant is a real person. Then we give them permission to update the documentation.

• Copyright. The Atlassian documentation is published under a Creative Commons CC BY license. Specifically, we use a Creative Commons Attribution 2.5 Australia License. This means that anyone can copy, distribute and adapt our documentation provided they acknowledge the source of the documentation. The CC BY license is shown in the footer of every page, so that anyone who contributes to our documentation knows that their contribution falls under the same copyright.

RELATED TOPICS
Tips of the Trade
Author Guidelines
Atlassian Contributor License Agreement
Tips of the Trade

Below are some links to external blog posts and articles containing technical tips and instructions on setting up and using JIRA. This page presents an opportunity for customers and community authors to share information and experiences.

The references here are links to technical 'how to' guides written by bloggers who use JIRA. For feature tours, solution tours and other information about bug and issue trackers, please refer to the Atlassian website and to our evaluator resources.

Please be aware that these are external blogs and articles.
Most of the links point to external sites, and some of the information is relevant to a specific release of JIRA. Atlassian provides these links because the information is useful and relevant at the time it was written. Please check carefully whether the information is still relevant when you read it, and whether it is relevant to your version of JIRA. Unless explicitly stated, Atlassian does not offer support for third-party extensions or plugins. The information in the linked blog posts has not been tested or reviewed by Atlassian. We recommend that you test all solutions on a test server before trying them on your production site.

On this page:
- JIRA 4 Linux Administrator’s Guide and Workflow Management
- Install JIRA on RHEL5, Single Tomcat with AJP and MySQL
- JIRA Groups and JIRA Project Roles
- 'Send reminder on' custom field for Jira
- User Activity Statistics
- Showing custom fields in 'sub-task' columns
- Using User Properties
- Making it easier to maintain JIRA workflows
- Jira Workflow Report Update
- NetBeans 6.7 RC1 - and JIRA support (beta)
- JIRA To Omnifocus Script
- Update JIRA-issues with OmniFocus
- Git branches to handle contributor patches
- Setting issue security level by issue type
- Unique Issue ID Across Projects

### Installation

**JIRA 4 Linux Administrator’s Guide and Workflow Management**

- By: James Intriglia, on ‘Getting Things Done in a Virtual World’
- About — This article covers the following topics:
  - Installing JIRA on different flavours of Linux with additional sections on how to configure and administer JIRA
    (This is a PDF document, whose link can be found at the end of this page.)
  - JIRA workflow diagrams speeding up JIRA application development
- Date: May 2010
- Related documentation: JIRA Installation and Upgrade Guide

**Install JIRA on RHEL5, Single Tomcat with AJP and MySQL**

- By: Brett Ryan, on the 'JIRA Community Space'
- About: How to install JIRA on Red Hat Enterprise Linux 5, using Apache Tomcat behind an Apache HTTP Server with AJP and MySQL
- Date: 9 April 2010
- Related documentation: JIRA Installation and Upgrade Guide

⚠️ Please be aware that this guide contains advanced procedures that should only be attempted by individuals who are familiar with configuring Apache Tomcat, Apache HTTP Server and AJP on Linux.
## Administration

### JIRA Groups and JIRA Project Roles

- By: Matt Doar, on blog 'jiradev.blogspot.com'
- About: How to set up JIRA permissions for specific projects
- Date: 27 September 2010
- Related documentation: Managing Groups, Managing Project Roles

'Send reminder on' custom field for Jira

- By: Sam Haldane, on blog 'blog.samhaldane.com'
- About: How to set up JIRA to send issue reminders to users on specified dates
- Date: 17 August 2009
- Related documentation: Adding a Custom Field, Using Filters

### User Activity Statistics

- By: Zaccary Craven, on blog 'Tips and tricks for JIRA administrators'
- About: How to show a list of all usernames along with the number of times each user has created a comment
- Date: 19 January 2009
- Related documentation: Adding the Issue Statistics Gadget

### Showing custom fields in 'sub-task' columns

- By: Zaccary Craven, on blog 'Tips and tricks for JIRA administrators'
- About: How to show the values of subtask custom fields on your issue screens
- Date: 8 December 2008
- Related documentation: Custom fields

### Using User Properties

- By: Matt Doar, on blog 'Consulting Toolsmiths'
- About: How to add, display and filter the user properties with the JIRA Toolkit plugin
- Date: 20 February 2008
- Related documentation: Managing Users

## Workflow

### Making it easier to maintain JIRA workflows

- By: Matt Doar, on blog 'Consulting Toolsmiths'
- About: How to display the name of the screen used by each transition in a workflow in one place
- Date: 1 July 2009
- Related documentation: Configuring Workflow

### Jira Workflow Report Update

- By: Jamie Echlin, on the 'onresolve team blog'
- About: Visualising JIRA workflows, with hints about a common problem when defining resolutions in JIRA workflows
- Date: 19 December 2008
- Related documentation: Configuring Workflow
### Integration with Other Tools

**NetBeans 6.7 RC1 - and JIRA support (beta)**
- **By:** Fabrizio Giudici, on 'Fabrizio Giudici's Blog'
- **About:** How to get JIRA integration in NetBeans 6.7 RC1
- **Date:** 1 June 2009

**JIRA To Omnifocus Script**
- **By:** David Martinez, on blog 'Hackerdude'
- **About:** A script that logs into JIRA and creates OmniFocus tasks for each of the JIRA items that are assigned to you, so they sync to your Omnifocus for iPhone, you only have to keep track of one inbox, etc.
- **Date:** 4 March 2009

**Update JIRA-issues with OmniFocus**
- **By:** Alain Petignat, on blog 'sequenz'
- **About:** Updating JIRA fields (time estimate, due date and assignee) directly from OmniFocus
- **Date:** 12 April 2009

### Development

**Git branches to handle contributor patches**
- **By:** Julien Ponge, on "JPz'log"
- **About:** Managing patches in pending state via Git, SVN and JIRA
- **Date:** 4 December 2008

**Setting issue security level by issue type**
- **By:** Jamie Echlin, on the 'onresolve team blog'
- **About:** Two ways to set JIRA issue security levels by issue type
- **Date:** 5 August 2008
- **Related documentation:** Configuring Issue-level Security

**Unique Issue ID Across Projects**
- **By:** Surya Suravarapu, on 'Surya Suravarapu's Blog'
- **About:** A plugin that allows you to have unique issue IDs across all your JIRA projects
- **Date:** 14 July 2009
- **Related documentation:**
  - Changing the Project Key Format
  - Change History

---

**Have you written a technical tip for JIRA?**
Add a comment to this page, linking to your blog post or article. We will include it if the content fits the requirements of this page.

**Feedback?**
Your first port of call should be the author of the linked blog post. If you want to let us know how useful (or otherwise) a linked post is, please add a comment to this page.

---

**Other Sources of Information**

- JIRA documentation
- Evaluator resources
- Atlassian website
- Atlassian forums
- Atlassian blog
- JIRA plugins
- Tips via Twitter

This page displays a continuously-updated list of tweets from Atlassians and others, giving hints and tips about...
JIRA issue tracker. Anyone can write a tip and have it show on this page. The live Twitter stream shows recent tweets containing the word ‘JIRATips’ or the tag ‘#JIRATips’.

Want to join in? Just tweet with the tag ‘#JIRATips’ somewhere in the text. Then grab a badge for your blog.

- Viewing the Tweets in Twitter
- Adding a JIRA Tweets Badge to your Blog
- Adding your own Tip

Please be aware that anyone can tweet anything. Atlassian does not monitor the tips in this Twitter stream. Anyone can tweet anything they like. We display these tips because we believe most people will do the right thing and tweet good tweets. Please check that a tweet is relevant to you before following its advice.

Viewing the Tweets in Twitter

If you prefer, you can view the search in Twitter itself.

Adding a JIRA Tweets Badge to your Blog

Would you like to let other people know that you tweet your JIRA tips? Use the code samples below to add a badge to your blog or another social site.

Choose one of these options to add the badge:

- **Badge only**
  Copy the code below and paste it into your blog to include just the badge with a link to this documentation page:

  ```html
  ```

  This is what you will get:

  ![I tweet my JIRA tips. Do you?](http://atlss.in/JIRATips)

- **Badge and words**
  Copy the code below and paste it into your blog to include the badge and some words encouraging other people to tweet too:

  ```html
  Please be aware that anyone can tweet anything. Atlassian does not monitor the tips in this Twitter stream. Anyone can tweet anything they like. We display these tips because we believe most people will do the right thing and tweet good tweets. Please check that a tweet is relevant to you before following its advice.
  ```
This is what you will get:

Got a JIRA tip? Tweet it now then see it in the JIRA docs.

Adding your own Tip

Quick guide to tweeting a tip
Just tweet with the word ‘#JIRATips’ somewhere in the text. Your tweet will appear in the Twitter stream on this page.

Would you like to share your information and experiences via Twitter and have your tweet appear on this page? Awesome! Here are the full instructions.

To tweet a JIRA tip,

1. Go to Twitter.com in your browser.
2. If you already have a Twitter username, sign in to Twitter now. If you do not have a Twitter username, sign up for one and follow the Twitter instructions to confirm your account details.
3. Enter your tip into the Twitter text box labelled ‘What’s happening’. Note that your tip can contain a maximum of 140 characters:
   - Type the words for your tip.
   - If you want people to click through to a web page to see more details about your tip, enter a web address. If the web address is long, you can convert it to a shortened address at bit.ly or one of the other web services that offer URL shortening.
   - Include the key word #JIRATips somewhere in your tweet. This will ensure that your tip appears in the Twitter stream on this documentation page.
4. Click ‘Tweet’ to send your tweet.
5. Refresh this documentation page to see your tweet appear. It may take a few minutes, depending on the volume of tweets that Twitter is handling.

Other Sources of Information

Tips of the Trade
JIRA documentation
Evaluator resources
Atlassian website
JIRA Documentation in Other Languages

Below are some links to JIRA documentation written in other languages. In some cases, the documentation may be a translation of the English documentation. In other cases, the documentation is an alternative guide written from scratch in another language. This page presents an opportunity for customers and community authors to share documentation that they have written in other languages.

Please be aware that these are external guides.
Most of the links point to external sites, and some of the information is relevant to a specific release of JIRA. Atlassian provides these links because the information is useful and relevant at the time it was written. Please check carefully whether the information is still relevant when you read it, and whether it is relevant to your version of JIRA. The information in the linked guides has not been tested or reviewed by Atlassian.

On this page:
- Manual de administración JIRA 3.13
- The JIRA Guide - Volumen I - Guía del Usuario: v. 1.00
- Handleiding JIRA
- JIRA

### Spanish

**Manual de administración JIRA 3.13**
- By: Rocío Navarro Lacoba, published in the JIRA Community space on this wiki
- JIRA version: 3.13
- Date added: 25 November 2010
- Latest related English documentation: JIRA Administrator’s Guide

**The JIRA Guide - Volumen I - Guía del Usuario: v. 1.00**
- By: Enrico Maria Crisostomo, published on The Grey Blog
- Topic: A translation of the Atlassian JIRA User’s Guide with additional content, including examples and more in-depth explanations
- JIRA version: 4.4
- Date added: 26 March 2012
- Latest related English documentation: JIRA User’s Guide

### Dutch

**Handleiding JIRA**
- By: Bart Wesdorp of theFactor.e, published in the JIRA Community space on this wiki
- Topic: JIRA User Guide, a quick-start guide to JIRA.
- JIRA version: Based on JIRA 4.1.
- Date added: 8 December 2010
- Latest related English documentation: JIRA User’s Guide

### Japanese

**JIRA**
- By: Go2Group and Atlassian, on the Atlassian Japan wiki
- Topic: JIRA user’s guide, administrator’s guide and developer’s guide
- JIRA version: 4.0
- Date added: 14 December 2010
- Latest related English documentation: JIRA 6.4.x

Adding Your Own Guide to this Page
Have you written a guide for JIRA in another language? Add a comment to this page, linking to your guide. We will include it if the content fits the requirements of this page.

Giving Feedback about One of the Guides

If you have feedback on one of the guides listed above, please give the feedback to the author of the linked guide.

If you want to let us know how useful (or otherwise) one of these guides is, please add a comment to this page.

Other Sources of Information

- **JIRA documentation**
- **Atlassian website**
- **Atlassian blog**
- **JIRA plugins**

**Books about JIRA**

The books listed below are all written by Atlassian Experts and can help you understand more about how JIRA works under the covers.

- **JIRA Development Cookbook** (Packt) by Jobin Kuruvilla. Contains a wide range of recipes for JIRA administrators.
- **JIRA 5.2 Essentials** (Packt) by Patrick Li. Covers all major aspects of JIRA with screenshots.
- **Practical JIRA Administration** (O'Reilly) by Matthew B. Doar. Answers best-practice questions asked by customers.
- **Practical JIRA Plugins** (O'Reilly) by Matthew B. Doar. An introduction to writing JIRA plugins (add-ons).

**JIRA Agile Guide**

JIRA Agile 6.7 has been released! Read the release notes for more information on the features that have been added.

**JIRA Agile** is a JIRA add-on that adds a broad collection of agile project management capabilities to JIRA, and extends JIRA as a powerful platform for agile development teams. JIRA Agile simplifies the planning and organisation of tasks, workflows and reporting for agile teams.

Please refer to the JIRA Agile documentation for more information.

Streamlining your development with JIRA

<table>
<thead>
<tr>
<th>This page...</th>
<th>Set it up...</th>
<th>For JIRA Cloud...</th>
</tr>
</thead>
<tbody>
<tr>
<td>... describes how the Atlassian development tools work together with JIRA to give your team a fast and guided software development process.</td>
<td>... with our guide to help JIRA admins set up JIRA and the Atlassian tools, so they work together as advertised.</td>
<td>... see our guide to how JIRA and the Atlassian development tools work together in the cloud.</td>
</tr>
</tbody>
</table>
JIRA, Stash and Bamboo integrate to support common Git workflows, while making your team's progress easy to see and understand.

Add FishEye to get Subversion support, and connect Crucible for code reviews. And you can also use your repos hosted in Bitbucket.

Create a feature branch from JIRA when starting work on an issue
If you use Atlassian's Stash or Bitbucket to manage your Git repositories, your developers can create a code branch directly from an issue in JIRA or JIRA Agile. Clicking Create branch opens your DVCS application to begin the branch creation process. The process guides the developer in a number of ways at this crucial step:

- It displays the available repository applications where they can create the branch
- It starts with the developer's latest project and repository
- It suggests the branch to branch from
- It automatically adds the JIRA issue key to the new branch name.

Stash suggests a branch type and a matching prefix for the branch name, when you have a branch model configured. The branch model helps developers to conform to your process guidelines when creating branches. Read more about the Stash branch model.

**Automatically update workflow status**

Instead of having JIRA issue statuses lagging behind, and the team not knowing the true state of the project, JIRA administrators can now configure triggers in JIRA workflows that respond to events in your linked development tools. For example, when a developer creates a branch to start work on an issue in Stash, the issue will automatically be transitioned from 'Open' to 'In progress' in JIRA.

JIRA responds to events in Stash, Bitbucket, FishEye and Crucible, as well as GitHub and GitHub:Enterprise. Currently available events include:

- Branch created
- Commit created
- Pull request created, merged, declined and reopened
- Review started, summarised, approved, rejected, abandoned, closed
See all the branches made for a JIRA issue

The Development panel, seen above, shows how many branches are related to the issue, wherever they’re located (perhaps in multiple instances of Stash and FishEye, or hosted in Bitbucket).

To see details of those branches, simply click the **branches** link. You’ll see where each branch is located, and the status of any pull requests for the branches:

### FUSE-113: 8 branches

<table>
<thead>
<tr>
<th>Repository</th>
<th>Branch</th>
<th>Pull request</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>jira-development-status</td>
<td>FUSE-113-buils-detail-dialog</td>
<td>MERGED</td>
<td>Create pull request</td>
</tr>
<tr>
<td>jira-development-status</td>
<td>FUSE-113-post-bitlz-fixes</td>
<td>MERGED</td>
<td>Create pull request</td>
</tr>
<tr>
<td>jira-development-status</td>
<td>FUSE-113-qunit-test-stability</td>
<td>MERGED</td>
<td>Create pull request</td>
</tr>
<tr>
<td>jira-development-status</td>
<td>FUSE-113-stabilize-web-driver-tests</td>
<td>MERGED</td>
<td>Create pull request</td>
</tr>
</tbody>
</table>

Click a branch to go to it in Stash (or wherever it’s hosted), or hover over a pull request status lozenge to see a direct link to the PR.

Use the **Create pull request** link to display the repository and begin the process for creating a pull request. This is a great way to start a discussion about the code changes on a particular branch – before they get merged.

As long as the branch name includes the issue key, and uses the default JIRA issue key format, the branch is automatically included in the Development panel.

See all the work for a JIRA issue
The Development panel shows the number of commits that are related to a JIRA issue. It collects those from all the linked instances of Stash (or other linked repository applications such as Bitbucket and FishEye).

To see details for those commits, just click the commits link. You’ll see who made each commit, when they committed, and how many files were changed (commits are greyed out if they’ve already been merged):

Click through to see a particular commit in the repository where the commit was made.

A developer only needs to add the issue key to the commit message, using the default key format, for the commit to be automatically linked to the JIRA issue, and included in the commits summary in the Development panel for the issue.

See at a glance if builds are failing

The Development panel displays the most relevant status of all the Bamboo CI builds that are related to your JIRA issue. The status icon is:

- ✔ if all the different builds (for example, unit tests, functional tests, deploy to staging) succeeded.
- 🚫 if at least one run failed for any build by any linked instance of Bamboo.

To see details for those builds, just click the builds link. You’ll see the name of the build plan and how many tests have passed, or failed:
You can click through to see the build plan and the build result in Bamboo.

You can configure plan branches to be automatically created by Bamboo when a new branch is detected in the repository for the plan. Using plan branches ensures that commits to repository branches, and not just commits to master, get continuous integration testing. Because Bamboo does this automatically, there's no need to manually, and repetitively, configure a new Bamboo plan for every new branch in the repo. Read more about plan branches in Bamboo.

Bamboo can be configured to regularly poll the repo and to start a build when it finds changes. Alternatively, a repository change can trigger Bamboo to run the build, for example by using a post-receive web hook, such as this one. The web hook triggers the build plan (or plan branch) whenever a commit is made. Either way, the build result is passed to the JIRA issue and added to the summary in the Development panel. Note that Bamboo must be able to authenticate with Stash to check out source code.

A build is automatically linked to a JIRA issue if a commit involved in the build has the JIRA issue key in its commit message.

### Spot if work for an issue has been discussed and merged

The Development panel shows the most relevant status of the pull requests that are related to a JIRA issue. The pull request status is:

- **OPEN** if there is at least one open pull request.
- **MERGED** if there are no open pull requests, and at least one pull request has been merged.
- **DECLINED** if there are no open or merged pull requests, and at least one pull request has been declined.

To see details for all the pull requests, simply click the pull requests link. You'll see the status of each pull request, who the reviewers are, and who has yet to complete their review. You can also see the number of comments on a pull request:

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
<th>Status</th>
<th>Author</th>
<th>Reviewer</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>#125</td>
<td>FUSE-113 qunt test stability</td>
<td>MERGED</td>
<td></td>
<td></td>
<td>16/Dec/13 4:20 AM</td>
</tr>
<tr>
<td>#123</td>
<td>detail dialog for commits</td>
<td>MERGED</td>
<td></td>
<td></td>
<td>11/Dec/13 7:19 PM</td>
</tr>
<tr>
<td>#114</td>
<td>Build details dialog post-bltz fixes</td>
<td>MERGED</td>
<td></td>
<td></td>
<td>11/Dec/13 1:45 AM</td>
</tr>
<tr>
<td>#87</td>
<td>Builds detail dialog</td>
<td>MERGED</td>
<td></td>
<td></td>
<td>26/Nov/13 11:21 AM</td>
</tr>
</tbody>
</table>

Click on the title of a pull request to see it in Stash.

Once you are ready to merge a pull request, and when the reviewers have approved it, just follow the link to the PR in Stash.

Stash can be configured to automatically merge changes to newer release branches. This reduces the need for manual maintenance of repository branches, and allows bug fixes, for example, to be propagated to other branches where they should be applied. Read more about automatic merging in Stash.

A developer just needs to add the issue key to the title of the pull request, or have the key in the source branch name, for the PR to be automatically linked to the JIRA issue. Merge commits are not included.
See the status of code reviews at a glance

The Development panel shows the most relevant status of the Crucible reviews that are related to an issue. The review status is:

- **REVIEW** if there is at least one open review.
- **APPROVAL** if at least one review is ready for approval.
- **SUMMARIZE** if there are no open reviews, and at least one review has had all reviewers complete their reviews.
- **REJECTED** if at least one review has been abandoned.
- **CLOSED** if there are no open reviews or reviews ready to summarize, and at least one review has been closed.

To see details for those reviews, click the reviews link. You'll see the status of each review, who the author and reviewers are, who has yet to complete their review, and whether the review is overdue. You can also see the number of comments:

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
<th>Status</th>
<th>Author</th>
<th>Reviewers</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>CR-BAM-5695</td>
<td>FUSE-113 - filtering by permissions; 401 not authorise...</td>
<td>CLOSED</td>
<td></td>
<td></td>
<td>19/Nov/13 9:18 AM</td>
</tr>
<tr>
<td>CR-BAM-5681</td>
<td>FUSE-113 - &quot;latest <em>relevant</em>&quot; not just &quot;latest&quot;</td>
<td>CLOSED</td>
<td></td>
<td></td>
<td>18/Nov/13 12:13 PM</td>
</tr>
<tr>
<td>CR-BAM-5672</td>
<td>FUSE-113 - REST 4 build details (wip)</td>
<td>CLOSED</td>
<td></td>
<td></td>
<td>13/Nov/13 12:55 PM</td>
</tr>
</tbody>
</table>

You can easily click through to see a particular review in Crucible.

A developer just needs to add the issue key to the title of the review, or link the issue from the review, for the review to be automatically linked to the JIRA issue.

Check if work on the issue has deployed as expected

The Development panel shows the environments to which related Bamboo builds for a JIRA issue have been deployed.

To see the details of recent deployments, click the **Deployed** link. You'll see the deployment status and the release number and date:
Of course, you can click through to see more details in Bamboo.

A deployment is linked to a JIRA issue if a commit involved in the deploy has the issue key in its commit message. When those code changes are later built (see above), and the resulting artifact is deployed (either manually or automatically) the environment information is passed to the JIRA issue. This assumes that the Bamboo build plan is associated with a deployment project in Bamboo.

**Installing Atlassian Tools for Integration with JIRA**

The Atlassian development tools work together with JIRA to give your team a fast and guided software development process.

**Supported versions**

The matrix on this page shows the minimum application versions required to enable the integration features described on Integrating JIRA with Code Development Tools.

<table>
<thead>
<tr>
<th>JIRA</th>
<th>Stash</th>
<th>FishEye/Crucible</th>
<th>Bamboo</th>
<th>GitHub Enterprise</th>
<th>Bitbucket</th>
<th>GitHub</th>
<th>Features enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1.x</td>
<td>2.8.x</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Current</td>
<td>N/A</td>
<td>Development panel:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Bitbucket or Stash: create branches</td>
</tr>
</tbody>
</table>

This page... ... provides a guide to help admins configure JIRA and the Atlassian tools, so they work together as advertised.

For your JIRA server... ... see our overview of how the Atlassian development tools work together when installed on your servers.

For JIRA Cloud... ... see our overview of how the Atlassian development tools work together when hosted in the cloud.
### Development Tools configuration for administrators

The Development Tools section on the project administration screen gives you an overview of the development tools that are connected to your JIRA instance, and of the users who can use the integrations between JIRA and those tools.

#### View Permission

The View Permission section lists the user groups that can see the Development panel in a JIRA issue. The Development panel displays the Create Branch link, as well as summary information for your development process, such as the number and status of the related commits, pull requests, reviews and builds. The visibility of the panel is controlled by the "View Development Tools" project permission.

#### Applications

The Applications section lists the development tools that are connected to JIRA, and so shows which applications can take advantage of these integration features.

- In Cloud, any applications that are part of your Cloud subscription are linked together automatically; you don’t need to do anything to start using the development tool integration features.
- You can connect your JIRA Cloud to your own locally installed instances of the development tools, such as Stash, FishEye or Crucible, by setting up an application link (see below).
- You can connect your JIRA Cloud, or your locally installed instance of JIRA, to Bitbucket, GitHub or GitHub Enterprise using the DVCS Connector in JIRA.

Click Development Tools in the left navigation bar to manage these settings.
Making the integration work

In general:

- JIRA users only need the "View Development Tools" project permission to be able to see the Development panel. By default, anonymous users (those who are not logged in) don't have this permission, and so do not see the panel.
- A developer simply needs to supply a JIRA issue key, as follows, for the JIRA issue to be automatically linked:
  - Commits are linked automatically if the issue key is included in the commit message.
  - Branches are linked automatically if the issue key is included in the branch name.
  - Pull requests are linked automatically if the issue key is included in the pull request's title or in the source branch name.
  - Reviews are linked automatically if the issue key is included in the title of the review, or if the issue is linked from the review.
  - Builds and deployments are linked automatically if a commit involved in the build has the issue.
key in its commit message.

- JIRA must be connected with Stash, FishEye, Crucible or Bamboo using a 2-way application link that has both 2-legged and 3-legged authentication enabled. See the Application Links section below.
- JIRA must be connected with Bitbucket, GitHub or GitHub Enterprise using the DVCS Connector in JIRA. See Use the JIRA DVCS Connector.
- When using the supported versions of JIRA and the other applications, the Development panel replaces the Source, Commits and Builds tabs, as well as the Deployment panel, in a JIRA issue. So, for example, you won't see the Source tab, and commits in Stash will be accessible from the Development panel. However, if a connected application is older than the supported version, information from that application will continue to be displayed in those locations.
- The details dialogs, for example for commits, may display duplicates, although the number of unique items are reported at the top of the dialog and in the Development panel summary. Duplicate commits, for example, can arise from having both Stash and FishEye linked to JIRA, and FishEye in turn connected with Stash, so that FishEye indexes, and reports. Stash commits.
- Users who can see summarized data in the Development panel may not have permission to see in the details dialogs (for example, for branches, commits and pull requests) all the information that contributed to the summaries. That is, the details dialogs respect the access permissions that users have in the connected applications.
- Note that if commits linked to the JIRA issue are involved with a Bamboo build that fails, the first successful build that follows will be reported, even though the original commits are no longer involved with that build.

**Bitbucket**

The DVCS Connector plugin needs to be enabled and configured in JIRA before you'll see information from Bitbucket in the Development panel of a JIRA (or JIRA Agile) issue. See Use the JIRA DVCS Connector Add-on for details. Remember that you won't see Bitbucket information in the Commits tab at the bottom of the JIRA View Issue screen any more.

**Bamboo**

The Development panel replaces the Builds tab and the Deployments panel in the JIRA View Issue screen.

**FishEye-Crucible**

When FishEye and Crucible (versions 3.3 and later) are linked with JIRA, you'll see FishEye branches and commits, and Crucible reviews, summarized in the Development panel – click on the links to see details of those. You can start the creation of Crucible reviews from the Commits details dialog. Note that with FishEye and Crucible version 3.3 and later, you won't see the Commits and Reviews tabs anymore; however, if any older instances are connected to JIRA, those tabs will continue to be displayed. See Application links below.

**Stash**

When Stash 2.10 or later is linked with JIRA, you won't see the Source tab at the bottom of the JIRA View Issue screen any more.

The following system plugins are required. These are bundled and enabled by default in Stash 2.10 (and later):

- Atlassian Navigation Links Plugin (com.atlassian.plugins.atlassian-nav-links-plugin)
- Stash Dev Summary Plugin (com.atlassian.stash.stash-dev-summary-plugin).

See Application links below.

**GitHub**

You can configure the DVCS Connector plugin in JIRA in order to see branch, commits and pull request information in the Development panel of a JIRA issue.

---

**Application links**

Created in 2015 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
When you create a new application link between JIRA and an instance of Stash, FishEye, Crucible or Bamboo, 2-legged (2LO) and 3-legged OAuth (3LO) are enabled by default. 2LO is required for information from an application to be included in the summaries in the Development panel; 3LO requires a user to authenticate with the other application in order to see information in any of the details dialogs.

- Users who can see summarized data in the Development panel may not have permission to see all the information that contributed to those summaries in the details dialogs (for example, for branches, commits and pull requests). That is, the details dialogs respect the access permissions that users have in the connected applications.
- An older application link between JIRA and any of those applications will need to have 2-legged authentication enabled.

Click here to see how to enable 2-legged OAuth...

An existing application link between JIRA and Stash, FishEye, Crucible or Bamboo (that perhaps used Trusted Apps authentication) needs to have 2-legged authentication (2LO) enabled for both outgoing and incoming authentication, so that information from the application can be included in the Development panel summaries.

When updating an older application link to use OAuth, 3-legged authentication is applied by default, but you need to explicitly enable 2LO. Enable 2-legged authentication for the application link from within JIRA as follows:

1. Go to the JIRA admin area and click **Add-ons > Application Links.**
2. Click **Edit** for the app link with the other application.
3. For both **Outgoing Authentication** and **Incoming Authentication**:
   a. Click **OAuth**
   b. Check **Allow 2-legged OAuth**.
   c. Click **Update**.

The application link update process will involve logging you into the other application for a short time to configure that end of the link, before returning you to JIRA.

Managing your Portfolio with JIRA

**JIRA Portfolio**

JIRA Portfolio provides a single, accurate view for planning and managing initiatives across multiple teams and projects with ease. See our guide to how JIRA and JIRA Portfolio work together.

- Plan top-level business initiatives and break them down into lower level deliverables for development teams
- Track investments across strategic themes to ensure that those investments align with business priorities
- Generate realistic delivery forecasts with automatic scheduling algorithms
- View the progress of any initiative based on real-time, accurate data from JIRA
- Drive accurate and realistic capacity planning by defining teams and allocating work based on skills and availability
- Scope releases in a matter of clicks
- Make fast prioritization and tradeoff decisions to instantly see the impact of plan changes
- Minimize productivity loss by easily reacting to the ever-changing needs of your business in real time
Plan automatically

- Set priorities, estimates and target dates to instantly see when you can ship releases based on your commitments
- Automatically optimize your plan and get suggestions on ideal resource allocation to create a realistic forecast
- Account for dependencies, resources, parallel vs. sequential activities and the realistic number of people that can work on a single item to create an optimized roadmap
- Use themes to categorize your backlog items by strategic focus areas, value streams, or investment categories to see relative resource allocation between themes

Avoid bottlenecks

- Identify and avoid bottlenecks and potential holdups by accounting for dependencies across teams and projects
- Model skills and define who can do which type of work to avoid unrealistic resource loads
- Automatically account for team member availability including time off, training and inter-team commitments
Keep up to date

- Keep the long term plan in sync with reality by adjusting delivery dates, team member resources and dependencies using up to date data
- Changes are displayed in real-time across all projects, giving you a comprehensive view of your entire roadmap
- Having an up-to-date schedule gives your team a transparent understanding of what's next, lending clarity to your decision-making

Make realistic commitments

- Confidently make commitments for scope and ship dates by using your more reliable forecasts
- Adjust dependencies to quickly check the impact across all of your projects, for example, if a critical feature is taking longer than expected
Model changes

- Quickly visualize what different scenarios and decisions mean to your projects
- Evaluate new change requests by seeing the impact on scope, dates, resources and cost commitments
- Model different scenarios without affecting the underlying data in your JIRA projects

You can find more information about managing your portfolio here: JIRA Portfolio.

Hosted Pages By Label

This page is visible to atlassian-staff and should never be published. It is used to maintain documentation for this product that differs from the documentation for the hosted product.

[ Pages with content that is not applicable to OnDemand ] [ Pages with content that is partially applicable to OnDemand ]

Pages with content that is not applicable to OnDemand

Label = hostedna

- Adding an Application Link
- Configuring Trusted Applications Authentication for an Application Link
- Deleting an Application Link
• Making an Application Link the Primary Link
• Relocating an Application Link
• Configuring Project Links across Applications
• Upgrading an Application Link
• Making a Project Link the Primary Link
• Using robots.txt to hide from Search Engines
• Precompiling JSP pages
• Updating your JIRA License Details
• Viewing User Sessions
• Integrating with a Source Control System
• Limiting the number of issues returned from a search view such as an RSS feed
• Configuring Basic HTTP Authentication for an Application Link
• Configuring OAuth Authentication for an Application Link
• Editing an Application Link
• Deleting a Project Link
• Preventing Security Attacks
• Configuring Application Links
• Generating a Thread Dump
• Adding Project Links between Applications
• Integrating JIRA with Perforce
• Deprecated - Integrating JIRA with ClearCase
• Changing the constraints on historical time parameters in gadgets
• Configuring Authentication for an Application Link
• Configuring the Whitelist
• Using the Database Integrity Checker
• Moving or Archiving Individual Projects
• Configuring Secure Administrator Sessions
• Integrating with a Build Management System
• Integrating JIRA with Bamboo
• Importing Data from FogBugz for Your Server
• How to Make a JIRA Patch
• Integrating JIRA with CVS and ViewCVS
• Listeners
• Advanced JIRA Configuration
• Finding the JIRA Support Entitlement Number (SEN)
• Subscribing to Another Application's Gadgets
• Splitting a JIRA instance
• Archiving a Project
• Importing Data from Trac
• Adding a Gadget to the Directory
• Importing Data from Bugzilla
• Performance Testing Scripts
• Integrating JIRA with FishEye
- Preventing users from accessing JIRA during backups
- Automating JIRA Backups
- Importing Data from Mantis
- Building JIRA from Source
- Services
- Importing Data from FogBugz On Demand
- Optimizing Performance
- Logging and Profiling
- Configuring an SSL Connection to Active Directory
- Configuring JIRA to Receive Email from a POP or IMAP Mail Server
- Restoring Data
- Search Indexing
- Configuring JIRA's SMTP Mail Server to Send Notifications
- Importing Data from Pivotal Tracker
- Restoring a Project from Backup
- User access logging
- Backing Up Data
- JIRA Administrators FAQ
- Configuring the Internal Directory
- Migrating from Other Issue Trackers
- Logging email protocol details
- Connecting to Crowd or Another JIRA Server for User Management
- Managing Nested Groups
- Diagrams of Possible Configurations for User Management
- Allowing Other Applications to Connect to JIRA for User Management
- Managing Multiple Directories
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Configuring User Directories
- Importing Data from CSV
- User Management Limitations and Recommendations
- Synchronising Data from External Directories
- Increasing JIRA Memory

Pages with content that is partially applicable to OnDemand

Label = hostedpartial
- Configuring File Attachments
- Managing Add-ons
- JIRA Administrators FAQ
- Creating Issues and Comments from Email

JIRA 6.0 Atlassian Design Guidelines Award
Great plugin visual design? Get marketed as a part of JIRA 6.0

A major part of the breaking changes are a result of the Atlassian Design Guidelines (ADG), which is an opportunity to make your plugin shine with the new design of JIRA.

We’re looking for the best plugins which use the new ADG and look great inside JIRA 6. The 10 plugins that stand above the others will be a featured part of the JIRA 6 marketing and get broader visibility among the JIRA community.

Top 3 Winners

Featured Add-Ons Page

The three best ADG-styled plugins will receive highlighted placement of plugin logo, plugin description, and a Marketplace link in the Featured Add-ons page.

Insiders Email

Additionally, each of the top three plugins will receive a featured callout in either the June, July or August editions of the JIRA Insiders email which goes out to JIRA end users.

Top 10 Winners

Even if you’re not one of the top three plugins, there’s still an opportunity for prominent mention in JIRA 6 marketing. The top ten plugins will be featured in a blogpost covering the merits and great design of these JIRA 6.0 compatible plugins.

Finally, the top 10 may also receive an “Atlassian Design Guidelines Winner” banner on their Marketplace listing for the next 12 months.

How can you get in on this?

To qualify, your plugin needs to:

1. Implement the new Atlassian Design Guidelines
2. Be compatible with JIRA 6.0 Beta (available as of April 22)
   a. Note that JIRA 6.0 EAP releases 4+ contain the breaking changes in this release, so you can being compatibility work on your plugin immediately

To submit your plugin for consideration,

1. Record a video (high-def recommended to show off your design)
2. Create three of your best screenshots
3. A link to your plugin jar file (can be on marketplace or elsewhere since your 6.0 version is unlikely to be released already!)
4. Email the above to dchuparkoff@atlassian.com with the subject Atlassian Design Guidelines Contest

All entries must be received prior to May 15th, 2013.

Can’t get enough contests?

Questions?

Just post a comment on this page!